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Getting Bforartists
Download Bforartists
Bforartists is currently just available for download for MS-Windows as a ziplfile from the Bforartists page.
http://www.bforartists.de/content/download
Linux and OS X versions are planned. But not yet available.
What is also available is the source code. Which can either be found at the same download page as shown
above. Or at github.
https://github.com/Bforartists/Bforartists

Minimum Requirements
Check if your system meets the minimum or recommended requirements.
Always check that the graphics drivers are up to date, and that OpenGL is well supported.
Support for other hardware such as graphic tablets and 3D mice are covered later in Supported Hardware.
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Install Bforartists
The procedure for installing a binary, either the last stable release or a daily build, is the same. Follow the steps
for your operative system as listed below

Installing on Linux - Not yet!
Placeholder. The Linux version is not available yet

Download from Bforartists.de
Download the Linux version for your architecture and uncompress the file to the desired location (eg.
~/software or /usr/local).
Bforartists can now be launched by double-clicking the executable.
For easy access, you can configure your system by adding a menu entry or shortcut for Bforartists and associate
and open .blend files with Bforartists when opening from the file browser. These settings typically belong to
the Window Manager (KDE, Gnome, Unity).

Running from the terminal
To run Bforartists from the terminal without needing to be in the executable directory, add the extracted folder
to the environment PATH.
Add the following command to .bash_rc or .bash_profile with Bforartists’s binary:
export PATH=$/path/to/Bforartists-VERSION-linux-glibcVERSION-ARCH:$PATH

Tip
If you use daily builds and update Bforartists frequently, you can link or always rename your folder to
‘Bforartists’ and use this name for the PATH environment variable and for keeping the window manager menu
up to date.

Avoiding Alt+Mouse Conflict
Many Window Managers default to Alt-LMB for moving windows, which is a shortcut that Bforartists uses to
simulate a 3 button mouse. You can either have this feature disabled User Preferences ‣ Input ‣ Emulate 3
Button Mouse or you can change the Window Manager settings to use the Meta key instead (also called Super
or Windows key):
• KDE: System Settings > Window Behavior > Window Behavior > Window Actions , Switch ‘Alt’ for
‘Meta’ key
• Unity/Gnome: enter the following in a command line (effective at next login):
gsettings set org.gnome.desktop.wm.preferences mouse-button-modifier '<Super>'
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Installing on OSX - Not Yet!
Placeholder. The OS X version is not available yet
After downloading Bforartists for Mac-OSX, uncompress the file and drag Bforartists.app onto the
Applications folder.
Tip
Because Bforartists doesn’t use the standard OS menu system, you likely have a redundant menu-bar at the
top.
To remove it see this post on Macworld, but beware that it is somewhat complex. As an alternative: simply
make Bforartists full screen by Alt-F11 or by File ‣ Window ‣ Toggle Window Fullscreen.

Installing on MS-Windows
There is no Windows installer available yet.
Download the .zip file. Choose either 32 bit or 64 Bit version, dependand of your operating system.
Place the zip file where you want Bforartists to be. This can be everywhere at your system. Then extract the
zipfile. To start Bforartists you have to double click at the exe file inside the created folder now.
It is also recommend to make a shortcut towards this executable. So that you don't have to navigate to the folder
all the time when you want to start Bforartists. Place this shortcut at the desktop or the quickstart taskbar.

Note
With .zip you have to manually extract Bforartists to the desired folder, where you can double-click the
executable to run Bforartists.
There is no installer to place Bforartists on the menu, but there is also no need for administrator rights. With
this option it is possible to have multiple versions of Bforartists without conflicting, as they are not actually
installed on the system.

Configuring Peripheral
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Multi-Monitor Setup
Graphic Tablets
3D Mice

Configuration
Here are some quick preferences that you may wish to set as quickly as possible. The full list and explanation of
the preferences is in the section User Preferences.

Language
At File ‣ User Preferences ‣ System, enable International Fonts to choose the Language and what to
translate from Interface, Tooltips and New Data. See more at Internationalization

Input
If you have a compact keyboard without a separate number pad enable File ‣ User Preferences ‣ Emulate
Numpad.
If you don’t have a middle mouse button you can enable File ‣ User Preferences ‣ Emulate 3 Button Mouse.

File and Paths
At File ‣ User Preferences ‣ File you can set options such as what external Image Editor to use, such as
GIMP or Krita, and the Animation Player.
The Temp directory sets where to store files such as temporary renders and autosaves.
Tip
// at the start of a path in Bforartists means the directory of the currently opened .blend file, used to
reference relative-paths.

If you trust the source of your .blend files, you can enable Auto Run Python Scripts. This option is
meant to protect you from malicious Python scripts that someone can include inside a Bforartists file. This
would not happen by accident, and most users leave this option on to automatically run scripts such as Rigify
that controls the skeleton of a human rig.

Configuration and Data Paths
There are three different directories Bforartists may use, their exact locations are operating system dependent.
4
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LOCAL
Location of configuration and runtime data (for self contained bundle)
USER
Location of configuration files (normally in the user’s home directory).
SYSTEM
Location of runtime data for system wide installation (may be read-only).
For system installations both SYSTEM and USER directories are needed.
For locally extracted Bforartists distributions, the user configuration and data runtime data are kept in the same
sub-directory, allowing multiple Bforartists versions to run without conflict, ignoring the USER and SYSTEM
files.
Note
You may need to have the “show hidden files” option checked in your file browser settings.

Platform Dependant Paths
Here are the default locations for each system:

Linux
LOCAL
./2.79/

USER
$HOME/.config/Bforartists/2.79/

SYSTEM
/usr/share/Bforartists/2.79/

Note
The path ./2.79/ is relative to the Bforartists Executable & used for self contained bundles

Note
The USER path will use $XDG_CONFIG_HOME if its set:
$XDG_CONFIG_HOME/Bforartists/2.79/

Mac OSX
LOCAL
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./2.79/

USER
/Users/$USER/Library/Application Support/Bforartists/2.79/

SYSTEM
/Library/Application Support/Bforartists/2.79/

Note
OSX stores the Bforartists binary in ./Bforartists.app/Contents/MacOS/Bforartists, so the
local path to data & config is:
./Bforartists.app/Contents/MacOS/2.79/

MS-Windows
LOCAL
.\2.79\.

USER
C:\Documents and Settings\$USERNAME\AppData\Roaming\Bforartists Foundation\
Bforartists\2.79\

SYSTEM
C:\Documents and Settings\All Users\AppData\Roaming\Bforartists Foundation\
Bforartists\2.79\

Path Layout
This is the path layout which is used within the directories described above.
Where ./config/startup.blend could be ~/.Bforartists/2.79/config/startup.blend for example.
./autosave/ ...
Autosave blend file location. Windows only, temp directory used for other systems.
Search order: LOCAL, USER.
./config/ ...
Defaults & session info.
Search order: LOCAL, USER.
./config/startup.blend
Default file to load on startup.
./config/userpref.blend
Default preferences to load on startup.
6
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./config/bookmarks.txt
File selector bookmarks.
./config/recent-files.txt
Recent file menu list.
./datafiles/ ...
Runtime files.
Search order: LOCAL, USER, SYSTEM
./datafiles/locale/{language}/
Static precompiled language files for UI translation.
./datafiles/icons/*.png
Icon themes for Bforartistss user interface. Not currently selectable in the theme preferences.
./datafiles/brushicons/*.png
Images for each brush.
./scripts/ ...
Python scripts for the user interface and tools.
Search order: LOCAL, USER, SYSTEM.
./scripts/addons/*.py
Python add-ons which may be enabled in the user preferences, includes import/export format support,
render engine integration and many handy utilities.
./scripts/addons/modules/*.py
Modules for add-ons to use (added to Python’s sys.path).
./scripts/addons_contrib/*.py
Another add-ons directory which is used for community maintained add-ons (must be manually created).
./scripts/addons_contrib/modules/*.py
Modules for addons_contrib to use (added to Python’s sys.path).
./scripts/modules/*.py
Python modules containing our core API and utility functions for other scripts to import (added to
Python’s sys.path).
./scripts/startup/*.py
Scripts which are automatically imported on startup.
./scripts/presets/{preset}/*.py
Presets used for storing user defined settings for cloth, render formats etc.
./scripts/templates/*.py
Example scripts which can be accessed from: Text Space’s Header –> Text –> Script Templates.
./python/ ...
Bundled Python distribution, only necessary when the system Python installation is absent or
incompatible.
Search order: LOCAL, SYSTEM.
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Help System
Tooltips
When hovering your cursor over a button or setting, it will show
you the Tooltip, and related details depending on the button type,
such as the key-shortcut for a tool.
The Python: text, included last may be of interest to you if you’re
an animator or automating tasks, see Scripting & Extending
Bforartists.

Help Menu

The Mouse pointer was Stopped for a
while over the Render Engines List in the
Info Window.

Bforartists has a range of built-in and web-based Help options.

General Web-based Help
Tip
Browser and Internet Connection
Some forms of Help start up your web browser and access the Bforartists Foundation’s web servers. In order
to do this, you must have configured a default web browser for your Operating System, and have a connection
to the Internet.

•

Manual - which you are now reading.

• Release Notes - The release notes on the Web for the current Bforartists
version.
• Bforartists Website - The Bforartists.org home page.
• Report a Bug The Bforartists Bug Tracker.
Note: in order to Report a Bug, you must register at the website.

Scripting Reference
• Python API Reference - Python application programming interface (API).
• Operator Cheat Sheet - Creates the OperatorList.txt text-block,
which you can access in the Text Editor. You can also use Bforartists Search to generate the file. The
lists the available Python operators.

Save System Info
Access Help ‣ Save System Info
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This extracts system information which can be useful to include in bug reports, inspecting the configuration or
diagnosing problems.
You will be prompted to save a text file system-info.txt.
The text file contains sections:
Bforartists
This section shows you the Bforartists version, details about the build configuration, and the path in
which Bforartists is running.
Python
The Python version you are using, showing the paths of the Python programming language paths.
Directories
Paths used for scripts, data-files, presets and temporary files.
Those directories are configured using the User Preferences Editor Window.
OpenGL
This section shows the OpenGL version, the name of the manufacturer, and lists the capabilities of your
hardware & driver.

Info Window Log
This is not exactly a Help menu, but it is related. If you mouse-over the line between the Info window and the
3D then click and drag the Info window down a bit, you can see the stream of Python calls that the UI is
making when you work. This can be useful in creating scripts.

The Info Window Log after adding a Cube
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Splash Screen
Usually the splash screen shows at startup until you change this behaviour in the User preference. You can also
bring up the Splash screen by clicking on the Splash Screen button in the Help menu. This displays the image
where you can identify the current version.

Bforartists Splash Screen

The splash screen contains also a few links to useful resources, like the
official Quickstart Learning videos. Or the Python API.
Here you can change the keymap too. The Interaction menu item.
When you install a new version, and start it the first time, then it also
provides the Copy Previous settings button. Which will transfer over the
settings from the previous Bforartists version.
It displays a way to recover the last session.
And in the last line you can see at which Blender version Bforartists is
based.

Interface

When starting Bforartists, the splash screen appears. On the left side are links to official web pages, and on the
right are your most recently opened projects.
5
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To close the splash screen perform an action , like start a new project, press Esc or click anywhere inside the
Bforartists Window (except on the splash screen)..

User Interface Principles
Non Overlapping
unlike the original Blender UI where this was just propaganda, the new UI for Bforartists will truely be
designed to allow you to view all relevant options and tools at a glance without pushing or dragging
editors around. Since all relevant elements will be accessible at top level.
Non Blocking
Tools and interface options will not block the user from any other parts of Bforartists. Bforartists typically
doesn’t use pop-up boxes (requiring users to fill in data before running an operation).
Non Modal Tools
Tools can be accessed efficiently without taking time to learn dozens of hotkeys first and without the bend
to a wicked UI. You can easily select between different tools by buttons.
Intuitive graphical UI centered useage
Bforartists is based at a intuitive uesage around the graphical UI. This means buttons and widgets. This
doesn't exclude hotkeys. But the official Bforartists keymap is reduced to the very basics. And not the
primary way to use Bforartists. You will have to add your own hotkeys when you need it.
Note
There is nevertheless still A TON of hotkeys to find in the Input manager. The reason is that the
input manager handles all input. Not just the hotkeys from the tools. And some of the navigation
can simply not be done without hotkeys.
See also the Bforartists keymap page in the Bforartists in the Manual section of the WIKI
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The Bforartists window is organized into one or more Areas with each area containing an Editor. Editors are
divided into a Header and one or more Regions. Regions can have smaller structuring elements like panels with
buttons, controls and widgets placed within them.

The composition of various Areas with predefined Editors in them is called a Screen Layout. By default
Bforartists starts up with a layout of 5 Editors as shown in the image below.

Components of an Editor
In general an editor provides a way to view and modify your work through a specific part of Bforartists.
The image below shows the 3D View as an example of an editor.

7

Bforartists Reference Manual - © Copyright - This page is under OCL license

The 3D View

Editors are consistently organized into following parts:

Regions
At least one region of an editor is always visible. It’s called the main region and is the most prominent part of
the editor. In the 3D View above this is marked with a green frame.
Aside from that there can be more regions available. In the 3D View above these are the Toolshelf on the left
side and the Properties on the right side. Additional regions mostly show context-sensitive content.
Each editor has a specific purpose, so the main region and the availability of additional regions are different
between editors. See specific documentation about each editor in the Editors chapter.

Header
A header is a small horizontal part of an editor and sits either at the top or bottom of
the area. It acts as a container for menus and commonly used tools. Much like
additional regions the header can be hidden.
The 3D View above the header is marked with a purple frame.
See: Headers for details.

Panels
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The smallest organizational unit in the user interface is a panel, which can be collapsed to hide its contents by
clicking on its header. This is where the buttons, menus, checkboxes, etc. are located.
Panels are usually found in the side regions of an editor, but also make up most of the Properties Editor‘s main
region.
In the image on the right there are 3 panels: Transfor*, Edit and History. The edit panel is expanded and the
other 2 panels are collapsed. Note that you can change the order of panels by clicking on the handle in the upper
right corner of a panel’s title.
See: panels for details.

Tabs
The Toolshelf has been further structured into a set of context sensitive vertical
tabs.
In the image to the right you can see the tabs: Tools, Create, etc. The Tools tab is
currently selected, showing a set of panels containing various tools.

Pinning
Often it is desirable to view panels from different tabs at the same time. This has
been solved by making panels pinnable.
A pinned panel remains visible regardless of which tab has been selected. You can
pin a panel by Shift clicking its header, or by right clicking on the header and
choosing Pin.
Shown in the image above is an example of the Mesh Options pinned in the tools
tab.

Input Devices
Bforartists supports various types of input devices:
•
•
•
•

Keyboard (recommended: keyboard with numeric keypad, english layout works best)
Mouse (recommended: 3 button mouse with scroll wheel)
NDOF Devices (also known as 3D Mouse)
Graphic Tablets

Usage of Mouse Buttons
In Bforartists the LMB (Left Mouse Button) is used for Selection and the LMB also (Left Mouse Button) initiates
or confirms actions. Bforartists is not longer bound to the old Blender dogma of Action and Select mouse.
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Non English Keyboard
If you use a keyboard with a non-english keyboard layout, you may stumble across bugs and quirks and odd
behaviours. Blender was developed for and with the UK or US layout. Some quirks for other keyboard layouts
slipped through. And quite a few of those old bugs are still unfixed in Bforartists too.
Bforartists corrects Gamma by default
Note
You can change the default keymap and default hotkeys from the User Preferences, however this manual
assumes you are using the default keymap.

The Window System
The default scene
The default scene is separated into five windows and is loaded each time you start Bforartists or a new file. The
five areas are:
•
•
•
•
•

The Info Space (shaded red) at the top. (The Info window used mainly for its header).
A large 3D View (shaded green).
A Timeline at the bottom (shaded purple).
An Outliner at the top right (shaded yellow).
A Properties editor at the bottom right (shaded blue).

As an introduction we will cover a few of the basic elements.
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Default Bforartists scene and Window arrangement

Arranging Areas
Bforartists uses a novel screen-splitting approach to arrange areas. The application window is always a
rectangle on your desktop. It divides it up into a number of re-sizable areas. An area contains the workspace for
a particular type of window, like a 3D View window, or an Outliner. The idea is that you split up that big
application window into any number of smaller (but still rectangular) non-overlapping area. That way, each
window is always fully visible, and it is very easy to work in one window and hop over to work in another.

Maximizing an Area
You can maximize an area to fill the whole application window with the View –> Toggle Full Screen menu
entry. To return to normal size, use again View –> Toggle Full Screen. A quicker way to achieve this is to use
the corresponding hotkeys that gets displayed besides . NOTE: The window your mouse is currently hovering
over is the one that will be maximized using the keyboard shortcuts.
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Splitting an Area

In the upper right and lower left corners of a window are the window splitter widgets, and they look like a little
ridged thumb grip. It both splits and combines window panes. When you hover over it, your cursor will change
to a cross. LMB and drag it to the left to split the window pane vertically, or downward to split it horizontally.

Joining Two Areas
In order to merge two areas, they must be the same dimension in the direction you wish to merge. For example,
if you want to combine two areas that are side-by-side, they must be the same height. If the one on the left is
not the same as the one on the right, you will not be able to combine them horizontally. This is so that the
combined window space results in a rectangle. The same rule holds for joining two areas that are stacked on top
of one another; they must both have the same width. If the one above is split vertically, you must first merge
those two, and then join the bottom one up to the upper one.

To merge the current window with the one above it (in the picture the properties window is being merged
“over” the Outliner), hover the mouse pointer over the window splitter. When the pointer changes to a cross,
LMB click and drag up to begin the process of combining. The upper window will get a little darker, overlaid
with an arrow pointing up. This indicates that the lower (current) area will “take over” that darkened area space.
Let go of the LMB to merge. If you want the reverse to occur, move your mouse cursor back into the original
(lower) area, and it will instead get the arrow overlay.
In the same way, windows may be merged left to right or vice versa.
If you press Esc before releasing the mouse, the operation will be aborted.
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Changing Area Size
You can resize areas by dragging their borders with LMB. Simply move your mouse cursor over the border
between two areas until it changes to a double-headed arrow, and then click and drag.

Swapping Contents
You can swap the contents between two areas with Ctrl-LMB on one of the splitters of the initial area,
dragging towards the target area, and releasing the mouse there. The two areas don’t need to be side by side,
though they must be inside the same window.

Opening New Windows
You may wish to have a new window. This can be useful, for instance, if you have multiple monitors and want
them to show different information on the same instance of Bforartists.
A new window can be created from Window ‣ Duplicate Window.
You can also create a new window from an existing area by Shift-LMB on a area splitter, and dragging
slightly. A new window pops up, with its maximize, minimize, close and other buttons (depending on your
platform), containing a single area with a duplicate of the initial window on which you performed the operation.
Once you have that new window, you can move it to the other monitor (or leave it in the current one); you can
resize it (or keep it unchanged); you can also arrange its contents in the same way discussed so far (split and
resize areas, and tune them as needed), and so on.

Window Headers
All windows have a header (the strip with a lighter gray background containing icon buttons). We will also refer
to the header as the window ToolBar. The header may be at the top (as with the Properties Window) or the
bottom (as with the 3D Window) of a window’s area. The picture below shows the header of the 3D window:

If you move the mouse over a window, its header changes to a slightly lighter shade of gray. This means that it
is “focused”. All hotkeys you press will now affect the contents of this window.

Hiding a header

To hide a header, move your mouse over the thin line between a window and its header, until the pointer takes
the form of an up/down arrow. Then click, hold and drag with LMB from the window over the header to hide the
13
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latter.

Showing a header

A hidden header leaves a little plus sign (see picture). By LMB this, the header will reappear.
Note 1: In the 3D window, there are up to two more of these little plus signs (to the top left and right of the
window). Those will open panels with several tools, not a second header.

Note 2: In some windows, the mentioned plus sign can be hard to find, because it might look like a part of other
icons. One example is the Outliner, in which there are other such plus signs, thus giving the one to get the
header back good camouflage.

Header position
To move a header from top to bottom or the other way round, simply RMB on it and select the appropriate item
from the pop-up menu. If the header is at the top, the item text will read “Flip to Bottom”, and if the header is at
the bottom the item text will read “Flip to Top”.
Tip
Theme colors
Bforartists allows for most of its interface color settings to be changed to suit the needs of the user. If you find
that the colors you see on screen do not match those mentioned in the Manual then it could be that your default
theme has been altered. Creating a new theme or selecting/altering a pre-existing one can be done by selecting
the User Preferences window and clicking on the Themes tab of the window.

Window type button
LMB clicking on the first icon at the left side of a header allows changing the window type. Every window
frame in Bforartists may contain any type of window, allowing you to customize your window layout to your
own work flows.

Menus and buttons
Most Window Headers, located immediately next to this first “Window Type” Menu button, exhibit a set of
menus which can be hidden - again with a little minus sign. So if you cannot find a menu that was mentioned
14
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somewhere, try looking for a little plus sign (once again) next to the “Window Type” button. By clicking LMB
on it, the menu will come back.
Menus allow you to directly access many features and commands, so just look through them to see what’s there.
All Menu entries show the relevant shortcut keys, if any.
Menus and buttons will change with Window Type and the selected object and mode. They only show the
actions that can be performed.

Collapsing Menus
Sometimes its helpful to gain some extra horizontal space in the header by collapsing menus, this can be
accessed from the header context menu, simply right click on the header and enable set it to collapsed.

Right-click on any of the header menus Header ‣ Collapse Menus.

Access the menu from the collapsed icon.

Hiding the editor type menu

In Bforartists it is possible to hide the editor type menu. And it is in fact hidden for most editors in the standard
15
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layout.
Right click at the menu bar. And you will see a menu with the menu entry Hide Editortype Menu. This shows or
hides the editor type menu.

The Console Window
The Console Window is an operating system text window that displays messages about Bforartists operations,
status, and internal errors.
Use Cases:
•
•
•
•

If Bforartists exits unexpectedly, the messages may indicate the cause or error.
To see the output of Python scripts print() command.
To launch with Command Line Arguments options.
When troubleshooting, to see the output of --debug messages.

Platform Dependant Instructions
Linux

Starting Bforartists from a Linux console window.

The Bforartists Console Window in Linux will typically only be visible on the desktop if Bforartists is manually
started from a terminal, as Bforartists outputs to the Console Window it is started from.
Depending on your desktop environment setup, a Bforartists icon may appear on your desktop or an entry for
Bforartists added to your menu after you install Bforartists. When you start Bforartists using a desktop icon or
menu entry rather than a Terminal window, the Bforartists Console Window text will most likely be hidden on
the Terminal that your XWindows server was started from.
This screenshot shows Bforartists started from a Linux Terminal and the resulting console text being printed to
it.

16
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Mac OSX

Starting Bforartists from a Mac OSX console window.

Mac-OSX uses “files” with the .app extension called applications. These files are actually folders that appear
as files in Finder. In order to run Bforartists you will have to specify that path to the Bforartists executable
inside this folder, to get all output printed to the terminal. You can start a terminal from Applications –>
Utilities. The path to the executable in the .app folder is
./Bforartists.app/Contents/MacOS/Bforartists.
If you have Bforartists installed in the Applications folder, the following command can be used:
/Applications/Bforartists-2.76/Bforartists.app/Contents/MacOS/Bforartists
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MS-Windows

Bforartists’s Console Window on MS-Windows.

When Bforartists is started on a MS-Windows operating system, the Console Window is first created as a
separate window on the desktop. The main Bforartists window will also appear and the Console Window will
then be toggled off. To display the console again, go to Window ‣ Toggle System Console.
The screenshot shows the Bforartists Console Window on MS-Windows directly after starting Bforartists and
then a short while later after opening a file along with the relevant messages.
Tip
Closing the Bforartists Console Window
Closing the Console Window will also close Bforartists, losing any unsaved work.
To turn off the console without closing Bforartists, just run Toggle System Console again from the menu (as
mentioned above).

Console Window Status and Error Messages
The Bforartists Console Window can display many different types of Status and Error Messages. Some
messages simply inform the user what Bforartists is doing, but have no real impact on Bforartists’s ability to
function. Other messages can indicate serious errors that will most likely prevent Bforartists carrying out a
particular task and may even make Bforartists non-responsive or shut down completely. The Bforartists
Console Window messages can also originate internally from within the Bforartists code or from external
sources such as Python scripts.

Common messages
• found bundled python: (FOLDER)
This message indicates that Bforartists was able to find the Python library for the Python
interpreter embedded within Bforartists. If this folder is missing or unable to be found, it is
likely that an error will occur, and this message will not appear.
• malloc returns nil()
18
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When Bforartists carries out operations that require extra memory (RAM), it calls a function
called malloc (short for memory allocate) which tries to allocate a requested amount of
memory for Bforartists. If this cannot be satisfied, malloc will return nil/null/0 to indicate
that it failed to carry out the request. If this happens Bforartists will not be able to carry out
the operation requested by the user. This will most likely result in Bforartists operating very
slowly or shutting down. If you want to avoid running out of memory you can install more
memory in your system, reduce the amount of detail in your Bforartists models, or shut
down other programs and services which may be taking up memory that Bforartists could
use.

Screens

Layout Dropdown

Bforartists’s flexibility with windows lets you create customized working environments for different tasks such
as modeling, animating, and scripting. It is often useful to quickly switch between different environments
within the same file.
To do each of these major creative steps, Bforartists has a set of pre-defined screens, that show you the types of
windows you need to get the job done quickly and efficiently. Screens are essentially pre-defined window
layouts. If you are having trouble finding a particular screen, you can use the search function at the bottom of
the list (pictured right).
Default Screens available
3D View Full:
Animation:
Compositing:
Default:
Motion Tracking:
Scripting:
UV Editing:

A full screen 3D view, used to preview your scene.
Making actors and other objects move about, change shape or color, etc.
Combining different parts of a scene (e.g. background, actors, special
effects) and filter them (e.g. color correction).
The default layout used by Bforartists for new files. Useful for modeling
new objects.
Used for motion tracking with the movie clip editor.
Documenting your work and/or writing custom scripts to automate
Bforartists.
Flattening a projection of an object mesh in 2D to control how a texture
maps to the surface.
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Hint
Just important when you work with more than one scene at once:
By default, each screen layout ‘remembers’ the last scene it was used on. Selecting a different layout will
switch to the layout and jump to that scene.
All changes to windows, as described in Editor Types, are saved within one screen. Changes to one screen,
wont affect others.

Configuring your Screens
Adding a new Screen Type
Click on the “Add” button(

) and a new frame layout will be created based on your current layout.

Deleting a Screen
You can delete a screen by using the Delete Data-Block button (

). See Screen and Scene selectors above.

Rearranging a Screen
Use the window controls to move frame borders, split and consolidate windows. When you have a layout that
you like, press Ctrl-U to update your User defaults. Be aware that all of the current scenes become part of
those defaults, so consider customizing your layouts with only a single, simple scene.
The properties window has a special option: pressing RMB on its background will allow you to arrange its
panels horizontally or vertically. Of the two, vertically-arranged panels have greater support.

Overriding Defaults
When you save a .blend file, the screen layouts are also saved in it. When you open a file, enabling the Load UI
checkbox in the file browser indicates that Bforartists should use the file’s screen layouts (overriding your
defaults in the process). Leaving the Load UI checkbox disabled tells Bforartists to use the current layout.

Additional Layouts
As you become more experienced with Bforartists, consider adding some other screen layouts to suit your
workflow as this will help increase your productivity. Some examples could include:
Modeling
Four 3D windows (top, front, side and perspective), Properties window for Editing
Lighting
3D windows for moving lights, UV/Image Window for displaying Render Result, Properties window for
rendering and lamp properties and controls
Materials
Properties window for Material settings, 3D window for selecting objects, Outliner, Library script (if
used), Node Editor (if using Node based materials)
Painting
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UV/Image Editor for texture painting image, 3D window for painting directly on object in UV Face
Select mode, three mini-3D windows down the side that have background reference pictures set to full
strength, Properties window
Hint
Reuse your Layouts
If you create a new window layout and would like to use it for future .blend files, you can save it for later
reuse, see Startup File.
Blender 2.76 Reference Manual - © Copyright : This page is in public domain as CC0.

Panels
Panels are collapsible sections within regions to help organize the interface. They are heavily used in the
Properties Editor but also appear elsewhere (For example: in the Tool Shelf or the Properties Shelf, available in
some editors).
The image below shows panels in different regions in their expanded and collapsed state.

Expanded (1) and collapsed (2) Panels in the Properties Editor (right area) and in the additional Regions of the 3D View
Editor (left area)

• A click with the LMB on the title area of a panel expands or collapses it.
• A LMB drag motion over the title area will expand or collapse many at once.
• A Ctrl-LMB click on the title area of a specific panel will collapse all other panels and make this the
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only expanded one.
Some panels only show in certain contexts. So for instance the Tool Shelf will show different panels depending
on the objects mode.
There are some options available to customize panels to your preference:
• You can change the position of a panel within its region by clicking and dragging it with the LMB on the
little widget in the upper right corner.
• The zoom factor of a whole region with panels can be changed by Ctrl-MMB clicking and moving the
mouse anywhere within that region or use the NumpadPlus and NumpadMinus to zoom in and out
the contents. Pressing Home (Show All) will reset the zooming at the screen/panel focused by the mouse
pointer.
• The alignment of the panels in the Properties Editor can be changed between vertical and horizontal. To
do this click with RMB somewhere within the main region of the Properties Editor and choose either
Horizontal or Vertical from the appearing menu. Keep in mind though that the panels are optimized for
vertical alignment.

Buttons and Controls
Buttons and other controls can be found in almost every Window of the Blender interface. The different types of
controls are described below.

Operation Buttons

Operation button

These are buttons that perform an operation when clicked with LMB. They can be identified by their gray color
in the default color scheme.

Toggle Buttons

Toggle buttons

Toggle buttons are typically displayed as check boxes. Clicking this type of button will toggle a state but will
not perform any operation.
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Toggle Drag
To change many toggle buttons at once, you can LMB drag over multiple buttons, This works for check-boxes,
toggles in the outliner and layer buttons.
Note
For layer buttons (a type of toggle button) it is often useful to hold Shift at the same time, to set
or clear many layers at once.

Radio Buttons

Radio buttons

Radio buttons are used to choose from a small selection of “mutually exclusive” options.

Number Buttons

Number buttons

Number buttons can be identified by their labels, which in most cases contains the name and a colon followed
by a number. Number buttons can be edited in several ways:
Incremental Steps
To change the value in steps, click LMB on the small triangles on the sides of the button.
Dragging
To change the value in a wider range, hold down LMB and drag the mouse to the left or right.
Text Input
Press LMB or Return to edit the value as a text field.
When entering values by hand, this button works like any other text button.
• Press Return to apply the change.
• Press Esc will cancel the value.

Multi-Value Editing

Multi-value-editing
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It’s often useful to edit multiple values at once (object scale or render resolution for example).
This can be done by clicking on the button and dragging vertically to include buttons above/below.
After the vertical motion you can drag from side to side, or release the LMB to type in a value.

Expressions
You can also enter expressions such as 3*2 instead of 6. or 5/10+3. Even constants like pi (3.142) or
functions like sqrt(2) (square root of 2) may be used.
These expressions are evaluated by Python; for all available math expressions see: math module reference

Expressions as Drivers
You may want your expression to be re-evaluated after its entered. Blender supports this using Drivers (a
feature of the animation system).
Expression beginning with #, have a special use. Instead of evaluating the value and discarding the expression,
a driver is added to the property with the expression entered.
The expression #frame is a quick way to access map a value to the current frame, but more complex
expressions are also supported #fmod(frame, 24) / 24 for example.
This is simply a convenient shortcut to add drivers which can also be added via the RMB menu.

Units
As well as expressions, you can mix units with numbers; for this to work, units need to be set in the scene
settings (Metric or Imperial).
Examples of valid units include:
• 1cm
• 2ft
• 1m 3mm
• 3ft/0.5km
• 1m, 3mm
• 2.2mm + 5' / 3" - 2yards
Note that the commas are optional. Notice how you can mix between metric and imperial even though the
display can only show one at a time.

Unit Names
Unit names have can be used with both long and short forms, here are listed recognized unit names you can use.
Plurals of the names are recognized too, so meter and meters can both be used.
Imperial Units

Full Name
thou
inch
foot, feet
yard
chain

Short Name(s)
mil
", in
', ft
yd
ch

Scale of a Meter
0.0000254
0.0254
0.3048
0.9144
20.1168
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Full Name
furlong
mile

Short Name(s) Scale of a Meter
fur
201.168
mi, m
1609.344

Full Name
micrometer
millimeter
centimeter
decimeter
meter
dekameter
hectometer
kilometer

Short Name(s)
um
mm
cm
dm
m
dam
hm
km

Metric Units

Scale of a Meter
0.000001
0.001
0.01
0.1
1.0
10.0
100.0
1000.0

Menu Buttons
Blender uses a variety of different menus for accessing options, tools and selecting data-blocks.

Menu Shortcuts
• Arrow keys can be used to navigate.
• Each menu item has an underlined character which can be pressed to activate it.
• Number keys or num-pad can be used to access menu items. (Where 1 is the first menu item, 2 the
second... etc. For larger menus Alt-1 the 11th... up to Alt-0 the 20th)
• Press Return to activate the selected menu item.
• Press Esc to cancel the menu.

Header Menus
Header menus are used to configure the editor and access tools.
See Headers for header options.

Pop-Up Menus
Pop-up menus are displayed as regular buttons, showing a range of options. For example, the Add Modifier
button will produce a menu with all of the available modifiers.
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Modifier options

Data-Block Menus
Menu buttons are used link data-blocks to each other. data-blocks are items
like Meshes, Objects, Materials, Textures, and so on.
These menu’s may show a preview and allow you to search by name since its
common all items wont fit in the list.

Data-block link menu with search

• The first button (with an icon of the data-block type) opens up a
menu to select an item by clicking LMB.
• The second button displays the name of the linked data-block which
can be edited as a regular text field.
• The “+” button duplicates the current data-block and applies it.
• The “X” button clears the link.
Sometimes there is a list of applied data-blocks (such as a list of materials used on the object). See data-block
link buttons above.

Data-block link buttons

• To select a data-block, click LMB on it.
• To add a new section (e.g. material, or particle system), click LMB on the “+” button to the right of the
list.
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• To remove a section, click LMB on the “-” to the right of the list.
For details on the behavior of linking data see data-block.

Extended Controls
This page documents some of the more involved interface controls.
Operator Search Menu

The operator search popup.

A menu with access to all Blender commands is available in the Window menu at the top, or by pressing
Spacebar. Simply start typing the name of the command you want to refine the list. When the list is
sufficiently narrowed, LMB on the desired command or navigate with Down and Up, activate it by pressing
Return.

Color Picker
All of the Color picker types have the common RGB, HSV and Hex options to show values.
Blender uses 0 - 1.0 values to express colors for RGB and HSV values.
Some colors also define an alpha value (A), below the color sliders.
Note
Blender corrects Gamma by default
for more information about how to disable Gamma correction in Blender, see: Color Management and
Exposure page.

• Use Wheel to change overall brightness.
• Press Backspace to reset to the original color.
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Color Picker Types
The default color picker type can be selected in the user preferences, see: System.
For operations that are capable of using Alpha, another slider is added at the bottom of the color picker.

•
Square (SV + H), Saturation,

•

Value plus Hue. Colors are

Square (HS + V), Hue,

adjusted using the a range of

Saturation plus Value.

brightness of the base color

Brightness is subtracted from

chosen at the color bar in the

the base color chosen on the

middle of the picker.

square of the color picker
moving the slider to the left.

•
Square (HV + S), Hue, Value
and Saturation. Brightness is
added to the base color chosen
on the square of the color picker
moving the slider to the left.

•

•
Circle HSV (Default). A full

•

gamut of colors ranging from

Circle HSL. A variation of the

center to the borders is always

regular circle select that uses

shown; center is a mix of the

HSL for mixing.

colors.

•

•

Hexidecimal Colors
You can optionally use hexidecimal (Hex) values, expressed as (RRGGBB), a common way to represent colors
for HTML and useful quicky copy/paste colors between applications.
Shorthand hex colors are also supported (RGB), so dark-yellow (ffcc00), can be written as fc0.
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Eye Dropper
The eye dropper allows you to sample from anywhere in the Blender window.
The eyedropper can be use to select different kinds of data.
Color
This is the most common usage.
Objects / Object-Data
This is used with object buttons such as parent, constraints or modifiers to select an object from the 3D
view.
Camera Depth
Number buttons effecting distance can also use the eye-dropper, this is most useful for camera depth of
field.
• E will activate the eye-dropper while hovering over a button.
• LMB dragging will mix the colors you drag over which can help when sampling noisy imagery.
• Spacebar resets and starts mixing the colors again.

Color Ramp Widget

Colorband before

Colorband after

Color Ramps enables the user to specify a range of colors based on color stops. Color stops are similar to a
mark indicating where the exact chosen color should be. The interval from each of the color stops added to the
ramp is a result of the color interpolation and chosen interpolation method. The available options for Color
Ramps are:
Add (Button)
Clicking on this button will add a stop to your custom weight paint map. The stops are added from the last
selected stop to the next one, from left to right and they will be placed in the middle of both stops.
Delete (Button)
Deletes the selected color stop from the list.
‘F’ (Button)
Flips the color band, inverting the values of the custom weight paint range.
Numeric Field
Whenever the user adds a color stop to the custom weight paint range, the color stop will receive an
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index. This field shows the indexes added (clicking in the arrows until the counter stops), and allows the
user to select the color stop from the list. The selected color stop will be shown with a dashed line.
Interpolation Options
Enables the user to choose from 4 types of calculations for the color interpolation for each color stop.
Available options are:
B-Spline
Uses a B-Spline Interpolation for the color stops.
Cardinal
Uses a Cardinal Interpolation for the color stops.
Linear
Uses a Linear Interpolation for the color stops.
Ease
Uses a Ease Interpolation for the color stops.
Constant
Uses a Constant Interpolation for the color stops.
Position
This slider controls the positioning of the selected color stop in the range.
Color Bar
Opens a color Picker for the user to specify color and Alpha for the selected color stop. When a color is
using Alpha, the Color Bar is then divided in two, with the left side showing the base color and the right
side showing the color with the alpha value.

Curve Widget
The Curve Widget is found in several places throughout
Blender, such as:
•
•
•
•

RGB Curves node
Vector Curves node
Paint/Sculpt brush falloff
Color Management curves

The purpose of the Curve Widget is to allow the user to
modify an input (such as an image) in an intuitive manner by
smoothly adjusting the values up and down using the curve.
The input values are mapped to the X-axis of the graph, and
the Y-axis is mapped to the output values.

Control Points
Like all curves in Blender, the curve of the Curve Widget is
controlled using control points.
By default there are two control points: one at 0.0, 0.0 and one at 1.0, 1.0, meaning the input is
mapped directly to the output (unchanged).
To move a control point
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Simply click and drag it around.
To add a new control point
Click anywhere on the curve where there is not already a control point.
To remove a control point
select it and click the

button at the top right.

Controls
Above the curve graph is a row of controls. These are:

Node curve controls

Channel selector
Allows to select appropriate curve channel.

Curve channel selector

Zoom In
Zoom into the center of the graph to show more details and provide more accurate control. To navigate
around the curve while zoomed in, click and drag in an empty part of the graph.
Zoom Out
Zoom out of the graph to show less details and view the graph as a whole. You cannot zoom out further
than the clipping borders (see Clipping below).
Tools

Advanced tools for curve

Reset View
Resets view of the curve.
Vector Handle
Vector type of curve point’s handle.
Auto Handle
Automatic type of curve point’s handle.
Extend Horizontal
Extends the curve horizontal.
Extend Extrapolated
Extends the curve extrapolated.
Reset Curve
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Resets the curve in default (removes all added curve’s points).
Clipping
Enable/disable clipping and set the values to clip to.
Delete
Remove the selected control point.

List View

At the bottom of a list view (like the ones found in the object data properties) there are controls for filtering and
sorting and resizing.
Rename
By pressing (Ctrl, LMB) over an item’s name, you can edit the text-field. This can also be achieved by
double clicking.
Resize
The list view can be resized to show more or less items. Hover the mouse over the handle then click and
drag the handle to expand or shrink the list.
Filter
Click the Show filtering options button to toggle filter option buttons.
Type part of a list item’s name in the filter text box to filter items by part of their name.
Filter Include
When the magnifying glass icon has a + sign then only items that match the text will be displayed.
Filter Exclude
When the magnifying glass icon has a - sign then only items that do not match text will be
displayed.
Sort
Sort list items.
Alphabetical
This button switches between alphabetical and non-alphabetical ordering.
Inverse
Sort objects in ascending or descending order. This also applies to alphabetical sorting, if selected.

Copy / Paste
Reference
Mode: All modes
Hotkeys: ctrl + c to copy, ctrl + v to paste
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Copy and paste works like in many other applications too. And works in most editors. The menu entry is usual
located in the menu bar as a menu item in the menus. And it's one of those things in Bforartists that has a
standard hotkey.
Copy and paste in Edit mode has a special behaviour. It copies the current selection. But it does not paste the
selection in Edit mode. But it pastes the selection as a new object.
To create a copy of the current selection in Edit mode, which is part of the current object, is a job for the
duplicate tool.

Undo and Redo
The commands listed below will let you roll back an accidental action, redo your last action, or let you choose
to recover to a specific point, by picking from a list of recent actions recorded by Blender.

Undo
If you want to undo your last action, just press Ctrl-Z. Or click at the Undo button in the History section in
the Tool Shelf. See Editing Preferences section on undo to change defaults.

Redo
To roll back your Undo action, press Ctrl-Shift-ZOr click at the Undo button in the History section in the
Tool Shelf.

Redo Last
Redo Last is short for Redo(ing your) Last (Action). The operator area in the Tool Shelf will present you a Panel
based on your last action taken and the Mode and Window in which Blender is being used.
For example, if your last action was a rotation in Object Mode, the Panel will show you the last value changed
for the angle (see Fig:Redo Last - Rotation), where you can change your action back completely by typing 0
(zero) in the numeric field. There are other useful options, based on your action context, and you can not only
Undo actions, but change them completely using the available options.
If you are in Edit Mode, the Window will also change its contents based on your last action taken. In our second
example (at the right), the last action taken was a Vertex Move; we did a Scale on a Face, and, as you can see,
the contents of the Pop-Up Window are different, because of your context (Edit Mode).
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Tip
Operations using Redo Last
Some operations produce particularly useful results if you tweak their parameters with the F6 Menu. Take, for
example, adding a Circle. If you reduce the Vertex count to 3, you get a perfect equilateral triangle.

Undo History

The Undo History Menu

There is also a Undo History of your actions, recorded by Blender. You can access the history with CtrlAlt-Z. Or by clicking at the Undo History button in the History section of the Tool Shelf
Rolling back actions using the Undo History feature will take you back to the action you choose. Much like
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how you can alternate between going backward in time with Ctrl-Z and then forward with Ctrl-Shift-Z,
you can hop around on the Undo timeline as much as you want as long as you do not make a new change. Once
you do make a new change, the Undo History is truncated at that point.

Repeat Last
The Repeat Last feature will Repeat your last action when you press Shift-R. Or by clicking at the Repeat
History button in the History section of the Tool Shelf
In the example Images below, we duplicated a Monkey Mesh, and then we moved the Object a bit. Using repeat
Shift-R, the Monkey was also duplicated and moved.

Suzanne.

After a Shift-D and move.

After a Shift-R.

Repeat History

The Repeat Menu

The Repeat History feature will present you a list of the last repeated actions, and you can choose the actions
you want to repeat. It works in the same way as the Undo History, explained above, but the list contains only
repeated actions. To access Repeat History, use F3. Or by clicking at the Repeat History button in the History
section of the Tool Shelf

Note
Blender uses two separate Histories, one dedicated for the Edit Mode, and one dedicated for the Object Mode.

Important
When you quit Blender, the complete list of user actions will be lost, even if you save your file before quitting.

See also
Troubleshooting section on Recovering your lost work

Screen Capture
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Screenshots
Reference
Mode: All modes
Menu: Window ‣ Save Screenshot

Save Screenshot Option

A click at the Save Screenshot Button in the Windows menu will take a screenshot of your Blender window and
then open the Blender File Browser window, allowing you to specify the name and location of the screenshot.
In the example image at the right, the PNG format will be the output of the screenshot taken (settings are the
same as the ones available to save render results). When the Blender File Browser window opens for you, at the
left, there is a tab called Save Screenshot where you can find format settings and a checkbox with the option
Full Screen.
• Check the Option to save the entire Blender window (full width and height of the Blender window you
are using when you call the command).
• Uncheck the box to save only your active window (where your mouse is located when you call the
command).

Screencasts
Reference
Mode: All modes
Menu: Window ‣ Make Screencast
This is a quick way to make screen-casts from within Blender.
Note
This is limited to a single window and does not support audio.
For recording tutorials you may want to use more comprehensive, 3rd party solutions.

Screencasts will record your actions over time either as a video or sequence of image files. The type and
location of the output is determined by the settings in the Output panel of the Render context window. The
default settings will generate a screencast consisting of a series of PNG images captured every 50 ms and stored
in the /tmp folder. If you want to record a video, set the Output to one of the Movie File Formats supported by
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your system listed in the Output panel format menu. If you are unsure what video codecs your system supports,
select AVI JPEG.

Options in the User Preferences Editor

The FPS for video Screencasts and time between each Screenshot for an image series Screencast can be set
from the System panel of the User Preferences window.
When you start Blender Screencasts, the header of the Info Window will change, and it will show you a button
for stopping your capture.
Below, we show the normal header of the Info Window, when in normal Blender operation (See Fig: Info
Window - Header - Normal Operation), and with the Stop button for the Screencast, when in Screencast Mode.
(See Fig: Info Window - Header - Capture Stop Button).

Info Window - Header - Normal Operation

Info Window - Header - Capture Stop Button

Note
The only way to stop the Screencast
Pressing the Stop button in the header of the Info Window is the only way to stop the Screencast capture. If
you press Esc, the shortcut will only work for operations performed in the Blender User Interface, (it will
stop animations, playbacks and so on...), but will not work to stop Screencasts.

Dimensions Panel - Frame Range
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The frames are stored using a suffix added to their file name, where the suffix is composed of the numbers
present in the fields for start and end frames, defined in the Frame Range of the Dimensions panel, Render
context. (See Fig: Dimensions Panel - Frame Range - highlighted in yellow)
Note
The configuration of the End frame, present in the Frame Range of the Dimensions Panel, will not stop your
capture automatically. You will always have to stop the Screencast manually, using the Stop button.

The Videos are generated internally in the same manner as the Screenshots, using the width and height of the
Window you are working in. If you choose to capture to a Video file, Blender will have to pass those frames to
a Video codec.
Warning
Some codecs limit the output width/height or the video quality.
• When you save your Screencast in an Image format, the Images will be saved using the entire Blender
Window, with full width and height, and the quality of the Image will be defined by its type (i.e. JPG,
PNG, and so on) and configuration (i.e. Slider quality of the .JPG format).
• When you save your Screencast in a Video format, it will be sent to a codec. Depending on the codec
limitations, the resulting output Video could be scaled down. Furthermore, some combinations of
Window width and height cannot be processed by certain codecs. In these cases, the Screencast will try
to start, but will immediately stop. In order to solve this, choose another Window format and/or another
codec.

Blender Window Dimension
There is a way to match the Blender Window dimensions with the Output Video File, achieving standard
dimensions for the output of the Blender Screencast. (I.e. NTSC, HD, Full HD, etc). You can control the width
and height of your Blender Window, starting Blender from a Command Line. To learn more about starting
Blender from a command line, see the page about Blender Console Window.

Ruler and Protractor
The ruler can be accessed from the toolshelf, once activated you can use the ruler to measure lengths and angles
in the scene.
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Example of the ruler and protractor.

Example using the ruler to measure thickness.
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Usage

Here are common steps for using the ruler.
• Activate the Ruler from the toolshelf.
• Click and drag in the view-port to define the initial start/end point for the ruler.
• Orbit the view and click on either end of the ruler to re-position it. Holding Ctrl enables snap to
elements.
• Click on the middle to measure angles.
• Press Return to store the ruler for later use or Esc to cancel.
Note
Editing operations can be used while the ruler is running, however tools like the knife can’t be used at the
same time.

Note
Unit settings and scale from the scene are used for displaying dimensions.
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Introduction
The interaction concept for Bforartists is the graphical UI. And so the Bforartists keymap is as reduced as possible. It still contains most of the
standard navigation hotkeys, and also standard hotkeys like for copy and paste, but nearly all hotkeys for tools are removed. So that users can
implement their own hotkeys how they need it and when they need it.
The keymap that you can find in the Input Manager in the User Preferences is nevertheless still pretty heavy as you can see here. That's because the
Input Manager in the user preferences contains all available user interaction. And not just the usual hotkeys to call tools like in other software. There
is no distinction between tools and things like editor manipulation. Every user interaction is defined here. So be careful what you change at the here
listed input nodes. You may remove a vital part to deal with windows for example.
The hotkeys are also editor specific. So there are lots of repetitions when you need the same hotkeys across several editors too. Navigation hotkeys
for example.
Legend
LMB= Left Mouse Button
RMB = Right Mouse Button
Action mouse is the opposite of the select mouse. Bforartists uses LMB select. So the Action Mouse is RMB. And the Select Mouse is LMB.
The concept to use Action mouse and Select mouse is a Blender relict. It's one of the reasons why there was RMB select at all. And will most
probably vanish in the further Bforartists development.
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Window
Window - Some menu stuff, some general hotkeys like enter to confirm.
Function

Surface menu location

User Preferences location

Hotkey

Special note

Reload Startup file creates a
new scene

Info Editor / File / New

Window / Reload Startup File

Ctrl N

Open file

Info Editor / File / Open

Window / Open Blender File

Ctrl O

Save File

Info Editor / File / Save

Window / Save Blender File

Ctrl S

Save File as

Info Editor / File / Save as

Window / Save As Blender
File

Shift Ctrl S

Save File as Copy

Info Editor / File / Save
Copy

Window / Save As Blender
File

Ctrl Alt S

Search Menu

Info Editor / Window /
Search Menu

Info Editor / File / Save Copy

Spacebar

Unknown. Ndof device for
3dConnexion

No Location

Windows / Call Menu

Ndof

Unknown. Ndof device for
3dConnexion

No Location

Windows / Context Scale Float Ndof Plus

Cannot test

Unknown. Ndof device for
3dConnexion

No Location

Windows / Context Scale Float Ndof Minus

Cannot test

Unknown. Ndof device for
3dConnexion

No Location

Windows / Context Scale Float Shift Ndof Plus

Cannot test

Unknown. Ndof device for
3dConnexion

No Location

Windows / Context Scale Float Shift Ndof Minus

Cannot test

Unknown

No Location

Windows / Update Reports
Display

Timer

No hotkey at all.

Cannot test

Screen / Screen (Global)
Screen / Screen (Global)
Function

Surface menu location

User Preferences location

Hotkey

Special note

Unknown

No Location

Screen / Screen (Global) /
Animation Step

Timer 0

No hotkey at all

Unknown

No Location

Screen / Screen (Global) /
Region Alpha

Timer Region

No hotkey at all

Change to the next screen
layout.

Info Editor / Layout
Screen / Screen (Global) / Set
Dropdown box in the menu Screen
bar

Ctrl Right Arrow

Change to the previous
screen layout

Info Editor / Layout
Screen / Screen (Global) / Set
Dropdown box in the menu Screen
bar

Ctrl Left Arrow

Toggles the current selected
editor between Fullscreen
and Windowed. WITHOUT
menus

RMB menu of the menu
bars

Screen / Screen (Global) /
Toggle Maximize Area

Ctrl Up Arrow

Toggles the current selected
editor between Fullscreen
and Windowed. WITHOUT
menus

RMB menu of the menu
bars

Screen / Screen (Global) /
Toggle Maximize Area

Ctrl Down Arrow

Toggles the 3D view
between a single screen and
a quad layout

3D View / View / Toggle
Quad View

Screen / Screen (Global) /
Toggle Quad View

Ctrl Alt Q
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Screen / Screen (Global)
Flips the UI region (Tool
None
Shelf) where you have the
mouse over to the other side
of the current editor. Like
the header. Or the sidebars to
the left or to the right

Screen / Screen (Global) / Flip
Region

F5

No menu entry. Hotkey only
functionality.

Calls the Last operator panel None - The original
Screen / Screen (Global) /
as a floating menu
location is at the bottom of Redo Last
the tool shelf

F6

Reloads all Python scripts,
including the Bforartists UI
scripts made with Python

Info Editor / Window /
Reload Scripts

Screen / Screen (Global) /

F8

Execute. Like entering a
value, then press enter ....

None

Screen / Screen (Global) /
Execute File Window

Return

No menu entry. Hotkey only
functionality.

Execute. Like entering a
value, then press enter ....

None

Screen / Screen (Global) /
Execute File Window

Numpad Enter

No menu entry. Hotkey only
functionality.

Cancel file load

None

Screen / Screen (Global) /
Cancel File load

Esc

No menu entry. Hotkey only
functionality.

Undo

Sometimes in Object
menu, sometimes in Edit
menu. Also in 3D View
Toolshelf / History

Screen / Screen (Global) /
Undo

Ctrl Z

Redo Sometimes in Object
menu, sometimes in Edit
menu. Also in 3D View
Toolshelf / History

Sometimes in Object
menu, sometimes in Edit
menu. Also in 3D View
Toolshelf / History

Screen / Screen (Global) /
Redo

Shift Ctrl Z

Undo History

Sometimes in Object
menu, sometimes in Edit
menu. Also in 3D View
Toolshelf / History

Screen / Screen (Global) /
Redo

Ctrl Alt Z

Render a single image

Info Editor / Render /
Render Image

Screen / Screen (Global) /
Render

F12

Render animation sequence

Info Editor / Render /
Render Animation

Screen / Screen (Global) /
Render

Ctrl F12

Escapes the Render View

No Menu entry

Screen / Screen (Global) /
Cancel Render View

Esc

Show / Hide Render View

Info Editor / Render /
Show / Hide Render View

Screen / Screen (Global) /
Show / Hide Render View

F11

Screen /Screen Editing
Screen /Screen Editing - All around dealing with the editor windows. Split, join, etc. DO NOT CHANGE!
Function

Surface menu location

User Preferences location

Hotkey

Special note

Split / Join window code.
Needed for Move Area
edges and Area Options

None

Screen / Screen Editing /
Handle Area Action Zones

LMB

No menu entry. Mouse
functionality.

Make new floating window.
First part. You need both
parts.

None

Screen / Screen Editing /
Handle Area Action Zones

Shift LMB

No menu entry. Mouse
functionality.

Drag into other editor
window to swap position
with it. First part. You need
both parts.

None

Screen / Screen Editing /
Handle Area Action Zones

Ctrl LMB

No menu entry. Mouse
functionality.

Split Area code

None

Screen / Screen Editing / Split
area

4

No menu entry. Mouse
functionality.

Bforartists Reference Manual - © Copyright - This page is Public Domain
Screen /Screen Editing - All around dealing with the editor windows. Split, join, etc. DO NOT CHANGE!
Join Area code

None

Screen / Screen Editing / Join
Area

No menu entry. Mouse
functionality.

Make new floating window.
Second part. You need both
parts.

None

Screen / Screen Editing /
Duplicate Area into new
Window

Drag into other editor
window to swap position
with it. Second part. You
need both parts.

None

Screen / Screen Editing / Swap Ctrl
Areas

No menu entry. Mouse
functionality.

Scale Region Size

None

Screen / Screen Editing / Scale
Region Size

No menu entry. Mouse
functionality.

Toggle Fullscreen Area

No idea where it could be

Screen / Screen Editing /
Toggle Fullscreen Area

No menu entry. Mouse
functionality.

Split Windows

None

Screen / Screen Editing / Move LMB
Area Edges

No menu entry. Mouse
functionality.

Join Windows

None

Screen / Screen Editing / Area
Options

RMB

No menu entry. Mouse
functionality.

Shift

No menu entry. Mouse
functionality.

Screen / Header
Header - DO NOT CHANGE!
Function

Surface menu location

User Preferences location

Hotkey

Special note

Calls the RMB menu at
headers

Every header menu bar

Header / Header Toolbox

RMB

No menu entry. Mouse
functionality.

View 2D
View 2D - Global navigation stuff for 2D panels and editors. DO NOT CHANGE!
Function

Surface menu location

User Preferences location

Hotkey

Special note

???

None

View 2D / Scroller Activate

LMB

No menu entry. Mouse
functionality.

???

None

View 2D / Scroller Activate

MMB

No menu entry. Mouse
functionality.

???

None

View 2D / Pan View

MMB

No menu entry. Mouse
functionality.

???

None

View 2D / Pan View

Shift MMB

No menu entry. Mouse
functionality.

???

None

View 2D / Pan View

Mouse/ Trackpad
pan

No menu entry. Mouse
functionality.

???

None

View 2D / Scroll right

Ctrl Wheel down

No menu entry. Mouse
functionality.

???

None

View 2D / Scroll left

Ctrl Wheel up

No menu entry. Mouse
functionality.

???

None

View 2D / Scroll down

Shift Wheel down

No menu entry. Mouse
functionality.

???

None

View 2D / Scroll up

Shift Wheel up

No menu entry. Mouse
functionality.

Ndof device for
3dConnexion

None

View 2D / NDOF Pan/Zoom

Ndof Motion

Cannot test

???

UV Editor / View / View
Zoom Out

View 2D / Zoom out

Wheel out

No menu entry. Mouse
functionality.
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View 2D - Global navigation stuff for 2D panels and editors. DO NOT CHANGE!
???

UV Editor / View / View
Zoom In

View 2D / Zoom in

Wheel in

No menu entry. Mouse
functionality.

???

None

View 2D / Zoom out

Numpad -

No menu entry. Entry
already exists for scroll
wheel functionality above.

???

None

View 2D / Zoom in

Numpad +

No menu entry. Entry
already exists for scroll
wheel functionality above.

???

None

View 2D / Zoom 2D View

Ctrl Mouse/
Trackpad pan

No menu entry. Mouse
functionality.

???

None

View 2D / Smooth view 2D

Timer 1

No hotkey at all

???

None

View 2D / Scroll down

Wheel down

No menu entry. Mouse
functionality.

???

None

View 2D / Scroll up

Wheel up

No menu entry. Mouse
functionality.

???

None

View 2D / Scroll right

Wheel down

No menu entry. Mouse
functionality.

???

None

View 2D / Scroll left

Wheel up

No menu entry. Mouse
functionality.

???

None

View 2D / Zoom 2D View

Ctrl MMB

No menu entry. Mouse
functionality.

???

None

View 2D / Zoom 2D View

Mouse/Trackpad
Zoom

No menu entry. Mouse
functionality.

View 2D Buttons List
View 2D Buttons List - Global navigation stuff for 2D panels and editors. DO NOT CHANGE!
Function

Surface menu location

User Preferences location

Hotkey

Special note

UV Editor Toolshelf
navigation

None

View 2D Buttons List /
Scroller Activate

LMB

No menu entry. Mouse
functionality.

UV Editor Toolshelf
navigation

None

View 2D Buttons List /
Scroller Activate

MMB

No menu entry. Mouse
functionality.

UV Editor Toolshelf
navigation

None

View 2D Buttons List / Pan
View

MMB

No menu entry. Mouse
functionality.

UV Editor Toolshelf
navigation

None

View 2D Buttons List /
Scroller Activate

Mouse /Trackpad
Pan

No menu entry. Mouse
functionality.

UV Editor Toolshelf
navigation

None

View 2D Buttons List / Scroll
down

Wheel down

No menu entry. Mouse
functionality.

UV Editor Toolshelf
navigation

None

View 2D Buttons List / Scroll
up

Wheel up

No menu entry. Mouse
functionality.

UV Editor Toolshelf
navigation

None

View 2D Buttons List / Scroll
down

Page down

No menu entry possible.

UV Editor Toolshelf
navigation

None

View 2D Buttons List / Scroll
up

Page Up

No menu entry possible.

UV Editor Toolshelf
navigation

None

View 2D Buttons List / Zoom
2D View

Ctrl Middle Mouse No menu entry. Mouse
functionality.

UV Editor Toolshelf
navigation

None

View 2D Buttons List / Zoom
2D View

Mouse/ Trackpad
Zoom

No menu entry. Mouse
functionality.

UV Editor Toolshelf
navigation

None

View 2D Buttons List / Zoom
2D View

Ctrl
Mouse/Trackpad
Pan

No menu entry. Mouse
functionality.

UV Editor Toolshelf
navigation

None

View 2D Buttons List / Zoom
out

Numpad -

No menu entry possible.
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View 2D Buttons List - Global navigation stuff for 2D panels and editors. DO NOT CHANGE!
UV Editor Toolshelf
navigation

None

View 2D Buttons List / Zoom
in

Numpad +

No menu entry possible.

UV Editor Toolshelf
navigation

None

View 2D Buttons List / Reset
View

Home

No menu entry possible.

User Interface
User Interface - Needs Investigation as a whole! - DOES NOT EXIST IN BLENDER 2.78c - Most probably an experimental change in the
master.
Function

Surface menu location

User Preferences location

Hotkey

???

???

User Interface / Eyedropper

E

???

???

User Interface / Eyedropper
Data-Block

E

???

???

User Interface / Eyedropper
Depth

E

???

???

User Interface / Copy Data
Path

Shift Ctrl C

???

???

User Interface / Copy Data
Path

Shift Ctrl Alt C

???

???

User Interface / Insert
Keyframe ( Buttons )

I

???

???

User Interface / Clear
Keyframe ( Buttons )

Shift Alt I

???

???

User Interface / Add Driver

Ctrl D

???

???

User Interface / Remove
Driver

Ctrl Alt D

???

???

User Interface / Add to Keying K
Set

???

???

User Interface / Remove from
Keying Set

Special note

Alt K

3D View / 3D View (Global)
3D View / 3D View (Global) - Mainly all the navigation stuff
Function

Surface menu location

User Preferences location

Hotkey

Special note

Needed for the 3D
manipulator to work

None

3D View / 3D View (Global) /
3D Manipulator

Shift Left Mouse

No menu entry. Mouse
functionality.

Needed for the 3D
manipulator to work

None

3D View / 3D View (Global) /
3D Manipulator

Any Left mouse

No menu entry. Mouse
functionality. Covered by
the Important Hotkeys
addon

Sets the 3D cursor position
to Mouse position.

None

3D View / 3D View (Global) /
Set 3D Cursor

Alt Action Mouse

No menu entry. Mouse
functionality. Covered by
the Important Hotkeys
addon

Rotate view

3D view / tool shelf /tools
tab / transform panel /
Rotate Button

3D View / 3D View (Global) /
Rotate View

RMB

Rotate view

None

3D View / 3D View (Global) /
Rotate View

Alt MMB

7
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3D View / 3D View (Global) - Mainly all the navigation stuff
Move view

3D view / tool shelf /tools
tab / transform panel /
Translate Button

3D View / 3D View (Global) /
Move View

MMB

Zoom view. See also the
other zoom methods.

3D view / tool shelf /tools
tab / transform panel /
Scale Button

3D View / 3D View (Global) /
Zoom View

Ctrl MMB

Dolly View moves the World 3D Viewport / View /
camera forward or
Navigation / Dolly Zoom
backward. Be careful with
that one! You can trap
yourself that regular zoom
seems to have no more
effect.

3D View / 3D View (Global) /
Dolly View

Shift Ctrl MMB

Brings the selected object
into focus. With all regions.

3D Viewport / View / View 3D View / 3D View (Global) /
Selected all Regions
View Selected

Ctrl Numpad 0

Brings the selected object
into focus

3D Viewport / View / View 3D View / 3D View (Global) /
Selected
View Selected

Numpad 0

Locks the view to active
object

3D Viewport / View / View 3D View / 3D View (Global) /
Selected
View Lock to active

Shift Numpad ,

Unlocks the view of the
formerly locked object

3D Viewport / View / Align 3D View / 3D View (Global) /
View /
View Lock to active

Alt Numpad ,

???

None

3D View / 3D View (Global) /
Smooth View

Rotates the view with
trackpad

None

3D View / 3D View (Global) /
Rotate View

Mouse/Trackpad
pan

No menu entry. Mouse
functionality. Covered by
the Important Hotkeys
addon

Rotates the view with
trackpad

None

3D View / 3D View (Global) /
Rotate View

Mouse/Trackpad
Rotate

No menu entry. Mouse
functionality. Covered by
the Important Hotkeys
addon

Moves the view with
trackpad

None

3D View / 3D View (Global) /
Move View

Shift
Mouse/Trackpad
pan

No menu entry. Mouse
functionality. Covered by
the Important Hotkeys
addon

Zooms the view with
trackpad

None

3D View / 3D View (Global) /
Zoom View

Mouse/Trackpad
Zoom

No menu entry. Mouse
functionality. Covered by
the Important Hotkeys
addon

Zooms the view with
trackpad

None

3D View / 3D View (Global) /
Zoom View

Ctrl
Mouse/Trackpad
pan

No menu entry. Mouse
functionality. Covered by
the Important Hotkeys
addon

Zooms in

3D Viewport / View / View 3D View / 3D View (Global) /
Selected
Zoom View

Numpad +

Covered by the Important
Hotkeys addon

Zooms out

3D Viewport / View / View 3D View / 3D View (Global) /
Selected
Zoom View

Numpad -

Covered by the Important
Hotkeys addon

Zooms in

None

3D View / 3D View (Global) /
Zoom View

Ctrl = ( german
keyboard Ctrl *)

No menu entry. Double
Entry! But may be useful for
laptop users that has no
numpad. Covered by the
Important Hotkeys addon

Zooms out

None

3D View / 3D View (Global) /
Zoom View

Ctrl -

No menu entry. Double
Entry! But may be useful for
laptop users that has no
numpad.Covered by the
Important Hotkeys addon
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3D View / 3D View (Global) - Mainly all the navigation stuff
Zooms in

None

3D View / 3D View (Global) /
Zoom View

Wheel in

No menu entry. Mouse
functionality. Covered by
the Important Hotkeys
addon

Zooms out

None

3D View / 3D View (Global) /
Zoom View

Wheel out

No menu entry. Mouse
functionality. Covered by
the Important Hotkeys
addon

Moves in. Dolly View
None
moves the World camera
forward or backward. Be
careful with that one! You
can trap yourself that regular
zoom seems to have no more
effect.

3D View / 3D View (Global) /
Dolly View

Shift Numpad +

No menu entry. Double
Entry! The regular way to
dolly zoom is with middle
mouse button. But may be
useful for laptop users that
has no mouse with mmb.

Moves out. Dolly View
None
moves the World camera
forward or backward. Be
careful with that one! You
can trap yourself that regular
zoom seems to have no more
effect.

3D View / 3D View (Global) /
Dolly View

Shift Numpad -

No menu entry. Double
Entry! The regular way to
dolly zoom is with middle
mouse button. But may be
useful for laptop users that
has no mouse with mmb.

Moves in. Dolly View
None
moves the World camera
forward or backward. Be
careful with that one! You
can trap yourself that regular
zoom seems to have no more
effect.

3D View / 3D View (Global) /
Dolly View

Shift Ctrl =
No menu entry. Double
( german keyboard Entry! The regular way to
Shift Ctrl *)
dolly zoom is with middle
mouse button.But may be
useful for laptop users that
has no numpad.

Moves out. Dolly View
None
moves the World camera
forward or backward. Be
careful with that one! You
can trap yourself that regular
zoom seems to have no more
effect.

3D View / 3D View (Global) /
Dolly View

Shift Ctrl -

Zooms Camera 1:1 when
you are in camera view.
Means it fits the
passepartout left and right
into the screen.

3D Viewport / View /
3D View / 3D View (Global) /
Navigation / Zoom Camera Zoom Camera 1:1
1:1

Shift Numpad
Enter

Centers the view to the
current active Lock Center,
in camera view

3D Viewport / View / Align 3D View / 3D View (Global) /
View / View Camera
View Lock Center
Center

Home (Pos1 at
german keyboard)

Centers view at the 3D
cursor

3D Viewport / View / Align 3D View / 3D View (Global) /
View / Center View to
Center View to cursor
cursor

Alt Home (Alt
Pos1 at german
keyboard)

Centers view at the current
mouse position

3D Viewport / View /
Navigation / Center View
to mouse

Alt F

Views all

3D Viewport / View / View 3D View / 3D View (Global) /
all
View All

Home (Pos1 at
german keyboard)

Switches between active
camera and World view

3D Viewport / View /
Cameras / Active Camera

3D View / 3D View (Global) /
View Numpad

Numpad ,

Switches to Front Ortho
sight

3D Viewport / View / Front 3D View / 3D View (Global) /
View Numpad

Numpad 1

Orbit down

3D Viewport / View /
Navigation / Orbit down

3D View / 3D View (Global) /
View Orbit

Numpad 2

Switches to Left Ortho sight 3D Viewport / View / Front 3D View / 3D View (Global) /
View Numpad

Numpad 3

3D View / 3D View (Global) /
Center View to mouse
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No menu entry. Double
Entry! The regular way to
dolly zoom is with middle
mouse button.But may be
useful for laptop users that
has no numpad.
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3D View / 3D View (Global) - Mainly all the navigation stuff
Orbit Left

3D Viewport / View /
Navigation / Orbit Left

3D View / 3D View (Global) /
View Orbit

Numpad 4

Changes between
orthographic and
perspectivic presentation of
the 3D viewport.

3D Viewport / View / View 3D View / 3D View (Global) /
Persp/Ortho
View Persp/ Ortho

Numpad 5

Orbit Right

3D Viewport / View /
Navigation / Orbit Right

3D View / 3D View (Global) /
View Orbit

Numpad 6

Switches to Top Ortho sight

3D Viewport / View / Top

3D View / 3D View (Global) /
View Numpad

Numpad 7

Orbit Up

3D Viewport / View /
Navigation / Orbit Up

3D View / 3D View (Global) /
View Orbit

Numpad 8

Switches to Back Ortho
sight

3D Viewport / View / Back 3D View / 3D View (Global) /
View Numpad

Ctrl Numpad 1

Switches to Left Ortho sight 3D Viewport / View / Left

3D View / 3D View (Global) /
View Numpad

Ctrl Numpad 3

Switches to Bottom Ortho
sight

3D Viewport / View /
Bottom

3D View / 3D View (Global) /
View Numpad

Ctrl Numpad 7

Moves the view down

3D Viewport / View / Pan
down

3D View / 3D View (Global) /
View Pan

Ctrl Numpad 2

Moves the view left

3D Viewport / View / Pan
Left

3D View / 3D View (Global) /
View Pan

Ctrl Numpad 4

Moves the view right

3D Viewport / View / Pan
Right

3D View / 3D View (Global) /
View Pan

Ctrl Numpad 6

Moves the view up

3D Viewport / View / Pan
Up

3D View / 3D View (Global) /
View Pan

Ctrl Numpad 8

Mirrors the axis orientation

3D Viewport / View /
3D View / 3D View (Global) /
Navigation / Orbit opposite View Orbit

Numpad 9

Moves the view right

None

3D View / 3D View (Global) /
View Pan

Ctrl Wheel Up

No menu entry. Mouse
functionality. Double Entry!
But may be useful for laptop
users that has no numpad.

Moves the view left

None

3D View / 3D View (Global) /
View Pan

Ctrl Wheel Down

No menu entry. Mouse
functionality. Double Entry!
But may be useful for laptop
users that has no numpad.

Moves the view up

None

3D View / 3D View (Global) /
View Pan

Shift Wheel Up

No menu entry. Mouse
functionality. Double Entry!
But may be useful for laptop
users that has no numpad.

Moves the view up

None

3D View / 3D View (Global) /
View Pan

Shift Wheel down

No menu entry. Mouse
functionality. Double Entry!
But may be useful for laptop
users that has no numpad.

Orbit Left

None

3D View / 3D View (Global) /
View Orbit

Ctrl Alt Wheel Up

No menu entry. Mouse
functionality. Double Entry!
But may be useful for laptop
users that has no numpad.

Orbit right

None

3D View / 3D View (Global) /
View Orbit

Ctrl Alt Wheel
Down

No menu entry. Mouse
functionality. Double Entry!
But may be useful for laptop
users that has no numpad.

Orbit up

None

3D View / 3D View (Global) /
View Orbit

Shift Alt Wheel Up No menu entry. Mouse
functionality. Double Entry!
But may be useful for laptop
users that has no numpad.
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3D View / 3D View (Global) - Mainly all the navigation stuff
Orbit down

None

3D View / 3D View (Global) /
View Orbit

Shift Alt Wheel
Down

Rolls the view counter
clockwise

None

3D View / 3D View (Global) /
View Roll

Shift Ctrl Wheel up No menu entry. Mouse
functionality. Double Entry!
But may be useful for laptop
users that has no numpad.

Rolls the view clockwise

None

3D View / 3D View (Global) /
View Roll

Shift Ctrl Wheel
down

Switches to Front Ortho, but 3D Viewport / View / Align 3D View / 3D View (Global) /
with the selected Object in
View / Front
View Numpad
center.

Shift Numpad 1

Switches to Right Ortho,
but with the selected Object
in center.

3D Viewport / View / Align 3D View / 3D View (Global) /
View / Right
View Numpad

Shift Numpad 3

Switches to Top Ortho, but
with the selected Object in
center.

3D Viewport / View / Align 3D View / 3D View (Global) /
View / Top
View Numpad

Shift Numpad 7

Switches to Back Ortho, but 3D Viewport / View / Align 3D View / 3D View (Global) /
with the selected Object in
View / Back
View Numpad
center.

Shift Ctrl Numpad
1

Switches to Left Ortho, but
with the selected Object in
center.

3D Viewport / View / Align 3D View / 3D View (Global) /
View / Left
View Numpad

Shift Ctrl Numpad
3

Switches to Bottom Ortho,
but with the selected Object
in center.

3D Viewport / View / Align 3D View / 3D View (Global) /
View / Bottom
View Numpad

Shift Ctrl Numpad
7

No menu entry. Mouse
functionality. Double Entry!
But may be useful for laptop
users that has no numpad.

No menu entry. Mouse
functionality. Double Entry!
But may be useful for laptop
users that has no numpad.

Switches between local view 3D Viewport / View /
and global view
Global/Local

3D View / 3D View (Global) /
Local View

Numpad /

Ndof device for
3dConnexion

None

3D View / 3D View (Global) /
Ndof Orbit View with Zoom

Ndof Motion

Cannot test

Ndof device for
3dConnexion

None

3D View / 3D View (Global) /
Ndof Orbit View

Ctrl Ndof Motion

Cannot test

Ndof device for
3dConnexion

None

3D View / 3D View (Global) /
Ndof Pan View

Shift Ndof Motion

Cannot test

Ndof device for
3dConnexion

None

3D View / 3D View (Global) /
Ndof Move View

Shift Ctrl Ndof
Motion

Cannot test

Ndof device for
3dConnexion

None

3D View / 3D View (Global) /
View Selected

Ndof fit

Cannot test

Ndof device for
3dConnexion

None

3D View / 3D View (Global) / Ndof roll ccw
Ndof Orbit View with Zoom3D
View / 3D View (Global) /
Ndof Orbit View with Zoom

Cannot test

Ndof device for
3dConnexion

None

3D View / 3D View (Global) /
View Roll

Ndof roll cw

Cannot test

Ndof device for
3dConnexion

None

3D View / 3D View (Global) /
View Roll

Ndof Front

Cannot test

Ndof device for
3dConnexion

None

3D View / 3D View (Global) /
View Numpad

Ndof Back

Cannot test

Ndof device for
3dConnexion

None

3D View / 3D View (Global) /
View Numpad

Ndof Left

Cannot test

Ndof device for
3dConnexion

None

3D View / 3D View (Global) /
View Numpad

Ndof Right

Cannot test
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3D View / 3D View (Global) - Mainly all the navigation stuff
Ndof device for
3dConnexion

None

3D View / 3D View (Global) /
View Numpad

Ndof Top

Cannot test

Ndof device for
3dConnexion

None

3D View / 3D View (Global) /
View Numpad

Ndof Bottom

Cannot test

Ndof device for
3dConnexion

None

3D View / 3D View (Global) /
View Numpad

Shift Ndof Front

Cannot test

Ndof device for
3dConnexion

None

3D View / 3D View (Global) /
View Numpad

Shift Ndof Right

Cannot test

Ndof device for
3dConnexion

None

3D View / 3D View (Global) /
View Numpad

Shift Ndof Top

Cannot test

Activate/Select

None

3D View / 3D View (Global) /
Activate/Select

Select Mouse

No menu entry. Mouse
functionality. Fundamental
interaction. Covered by the
Important Hotkeys addon

Activate/Select

None

3D View / 3D View (Global) /
Activate/Select

Shift Select Mouse No menu entry. Mouse
functionality. Fundamental
interaction. Covered by the
Important Hotkeys addon

Activate/Select

None

3D View / 3D View (Global) /
Activate/Select

Ctrl Select Mouse

No menu entry. Mouse
functionality. Fundamental
interaction

Activate/Select

None

3D View / 3D View (Global) /
Activate/Select

Alt Select Mouse

No menu entry. Mouse
functionality. Fundamental
interaction

Activate/Select

None

3D View / 3D View (Global) /
Activate/Select

Shift Ctrl Select
Mouse

No menu entry. Mouse
functionality. Fundamental
interaction

Activate/Select

None

3D View / 3D View (Global) /
Activate/Select

Ctrl Alt Select
Mouse

No menu entry. Mouse
functionality. No menu entry.
Mouse functionality.
Fundamental interaction

Activate/Select

None

3D View / 3D View (Global) /
Activate/Select

Shift Alt Select
Mouse

No menu entry. Mouse
functionality. Fundamental
interaction

Activate/Select

None

3D View / 3D View (Global) /
Activate/Select

Shift Ctrl Alt
Select Mouse

No menu entry. Mouse
functionality. Fundamental
interaction

Border Select

3D Viewport / Select /
Border Select

3D View / 3D View (Global) /
Border Select

B

Lasso Select, select

3D Viewport / Select /
Lasso Select

3D View / 3D View (Global) /
Lasso Select

Ctrl Action Mouse
(with lmb select
action mouse is
rmb)

Lasso Select, deselect

None

3D View / 3D View (Global) /
Lasso Select

Shift Ctrl Action
No menu entry. Event
Mouse (with lmb
Mapping Tweak
select action mouse
is rmb)

Circle Select

3D Viewport / Select /
Circle Select

3D View / 3D View (Global) /
Circle Select

G

Copy

3D Viewport / Object /
Copy

3D View / 3D View (Global) /
Copy Selection to Buffer

Ctrl C

Paste

3D Viewport / Object /
Paste

3D View / 3D View (Global) /
Paste Selection from Buffer

Ctrl V

Move

3D Viewport / Tool Shelf /
Tools / Transform tab /
Translate

3D View / 3D View (Global) /
Translate

W
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3D View / 3D View (Global) - Mainly all the navigation stuff
Move

None

3D View / 3D View (Global) /
Translate

No menu entry. Event
mapping Tweak. Covered by
the Important Hotkeys
addon

Rotate

3D Viewport / Tool Shelf /
Tools / Transform tab /
Rotate

3D View / 3D View (Global) /
Rotate

E

Scale

3D Viewport / Tool Shelf /
Tools / Transform tab /
Scale

3D View / 3D View (Global) /
Resize

R

Part of the Reset 3D View
3D Viewport / View / Reset 3D View / 3D View (Global) /
Addon. Resets the 3D View. 3D View
Reset 3D View

Numpad *

Stroke Select addon.
Activates stroke select with
hold down key.

3D Viewport / Select /
Stroke Select

3D View / 3D View (Global) /
Stroke Select

I Select Mouse

Toggles the 3D Widget in
the viewport

3D Viewport / Header / 3d
Widget button

3D View / 3D View (Global) /
Context Toggle

Q

Rolls the view counter
clockwise

3D View / Navigation /
Roll Left

3D View / 3D View (Global) /
View Roll

Shift Ctrl Numpad
4

Rolls the view clockwise

3D View / Navigation /
Roll Right

3D View / 3D View (Global) /
View Roll

Shift Ctrl Numpad
6

3D View - Object Mode
3D View - Object Mode
Function

Surface menu location

User Preferences location

Hotkey

Select all / Deselect all

3D Viewport / Select /
(De)select all

3D View / Object Mode /
(De)select All

A

Inverse selection

3D Viewport / Select /
Inverse

3D View / Object Mode /
(De)select All

Ctrl I

Make Parent

3D Viewport / Object /
Parent

3D View / Object Mode / Make Ctrl P
Parent

Show hidden Objects

3D Viewport / Object /
3D View / Object Mode / Clear Alt H
Show Hide / Show Hidden Restrict View

Hide selected Object

3D Viewport / Object /
Show Hide / Hide selected

3D View / Object Mode / Set
Restrict View

H

Hide unselected Object(s)

3D Viewport / Object /
Show Hide / Hide
unselected

3D View / Object Mode / Set
Restrict View

Shift H

Delete

3D Viewport / Object /
Delete

3D View / Object Mode /
Delete

Delete

Duplicate Objects

3D Viewport / Object /
Duplicate Objects

3D View / Object Mode /
Duplicate Objects

Shift D

Join Object

3D Viewport / Object /
Join

3D View / Object Mode / Join

Ctrl J

Adds a SDS modifier to
3D Viewport / Object /
selected object and sets SDS Subdivide / Subdivision
Level to value
Set

3D View / Object Mode /
Subdivision Set

Ctrl 0

Adds a SDS modifier to
3D Viewport / Object /
selected object and sets SDS Subdivide / Subdivision
Level to value
Set

3D View / Object Mode /
Subdivision Set

Ctrl 1

Adds a SDS modifier to
3D Viewport / Object /
selected object and sets SDS Subdivide / Subdivision
Level to value
Set

3D View / Object Mode /
Subdivision Set

Ctrl 2

13

Special note

One of the Popup Panels that
we have to keep for now!
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3D View - Object Mode
Adds a SDS modifier to
3D Viewport / Object /
selected object and sets SDS Subdivide / Subdivision
Level to value
Set

3D View / Object Mode /
Subdivision Set

Ctrl 3

Adds a SDS modifier to
3D Viewport / Object /
selected object and sets SDS Subdivide / Subdivision
Level to value
Set

3D View / Object Mode /
Subdivision Set

Ctrl 4

Adds a SDS modifier to
3D Viewport / Object /
selected object and sets SDS Subdivide / Subdivision
Level to value
Set

3D View / Object Mode /
Subdivision Set

Ctrl 5

Inverses the current
Selection

3D View / Object Mode / Clear Ctrl I
Parent

3D Viewport / Select /
Inverse

3D View - Mesh
Mesh - Edit Mode
Function

Surface menu location

User Preferences location

Selects a edgeloop

None

3D View / Mesh / Loop Select Alt Select Mouse

No menu entry. Mouse
functionality. Covered by
the Important Hotkeys
addon

Selects a edgeloop, adds to
selection.

None

3D View / Mesh / Loop Select Shift Alt Select
Mouse

No menu entry. Mouse
functionality. Covered by
the Important Hotkeys
addon

Selects a ring loop

None

3D View / Mesh / Edge Ring
Select

Ctrl Alt Select
Mouse

No menu entry. Mouse
functionality. Covered by
the Important Hotkeys
addon

Selects a ring loop, adds to
selection.

None

3D View / Mesh / Edge Ring
Select

Shift Ctrl Alt
Select Mouse

No menu entry. Mouse
functionality. Covered by
the Important Hotkeys
addon

Select shortest path between None
srating and end edge

3D View / Mesh / Pick
shortest path

Ctrl Select Mouse

No menu entry. Mouse
functionality. Covered by
the Important Hotkeys
addon

Selects / deselects all

3D View / Select /
(De)select all

3D View / Mesh / (De)select
all

A

Inverts the selection

3D View / Select / Inverse

3D View / Mesh / (De)select
all

Ctrl I

Select more

3D View / Select / Select
More

3D View / Mesh / Select More

Ctrl Numpad +

Select less

3D View / Select / Select
Less

3D View / Mesh / Select Less

Ctrl Numpad -

Select Linked

3D View / Select / Linked
Pick Select

3D View / Mesh / Select
Linked

L

Deselect Linked

3D View / Select / Linked
Pick Deselect

3D View / Mesh / Select
Linked

Shift L

Hide selected Object

3D Viewport / Mesh /
Show Hide / Hide selected

3D View / Mesh / Hide
selection

H

Hide unselected Object(s)

3D Viewport / Mesh /
Show Hide / Hide
unselected

3D View / Mesh / Hide
selection

Shift H

Show hidden Objects

3D Viewport / Mesh /
3D View / Mesh / Reveal
Show Hide / Show Hidden Hidden
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Hotkey

Alt H

Special note
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Mesh - Edit Mode
Extrude and Move on
Normals

3D Viewport / Mesh /
Extrude / Region

3D View / Mesh / Extrude and
Move on Normals

S

Adds a duplicate

3D Viewport / Mesh / Add
Duplicate

3D View / Mesh / Add
Duplicate

Shift D

Adds a duplicate of selection 3D Viewport / Tool Shelf /
at mouse position, slightly
Tools / Mesh Tools/
rotates source object and
DupliEx
target object

3D View / Mesh / Duplicate or Ctrl Action Mouse
Extrude to Cursor

Adds a duplicate of selection 3D Viewport / Tool Shelf /
at mouse position, slightly
Tools / Mesh Tools/
rotates target object only
DupliExRot

3D View / Mesh / Duplicate or Shift Ctrl Action
Extrude to Cursor
Mouse

Calls the Delete menu quiz

3D Viewport / Mesh /
Delete

3D View / Mesh / Delete

Ctrl + Delete

Calls the Knife tool

3D Viewport / Tool Shelf /
Tools / Mesh Tools/ Knife

3D View / Mesh / Knife
Topology Tool

K

Calls the Knife tool for new
topology. Needs a selection

3D Viewport / Tool Shelf /
Tools / Mesh Tools/ Select

3D View / Mesh / Knife
Topology Tool

Shift K

Calls the Unwrap submenu

3D Viewport / Tool Shelf /
Shading / UV's / UV's /
Unwrap

3D View / Mesh / Call Menu

U

Adds a SDS modifier to
3D Viewport / Mesh /
selected object and sets SDS Subdivide / Subdivision
Level to value
Set

3D View / Mesh / Subdivision
Set

Ctrl 0

Adds a SDS modifier to
3D Viewport / Mesh /
selected object and sets SDS Subdivide / Subdivision
Level to value
Set

3D View / Mesh / Subdivision
Set

Ctrl 1

Adds a SDS modifier to
3D Viewport / Mesh /
selected object and sets SDS Subdivide / Subdivision
Level to value
Set

3D View / Mesh / Subdivision
Set

Ctrl 2

Adds a SDS modifier to
3D Viewport / Mesh /
selected object and sets SDS Subdivide / Subdivision
Level to value
Set

3D View / Mesh / Subdivision
Set

Ctrl 3

Adds a SDS modifier to
3D Viewport / Mesh /
selected object and sets SDS Subdivide / Subdivision
Level to value
Set

3D View / Mesh / Subdivision
Set

Ctrl 4

Adds a SDS modifier to
3D Viewport / Mesh /
selected object and sets SDS Subdivide / Subdivision
Level to value
Set

3D View / Mesh / Subdivision
Set

Ctrl 5

Deletes mode dependant
what is selected in Edit
mode.

3D Viewport / Mesh /
Delete

3D View / Mesh / Smart Delete Delete

Sets selection mode to
Vertices

3D Viewport / toolbar

3D View / Mesh / Select Mode X

Sets selection mode to Edge

3D Viewport / toolbar

3D View / Mesh / Select Mode C

Sets selection mode to Face

3D Viewport / toolbar

3D View / Mesh / Select Mode V

Make vertex parent parents
an object to a vertice

3D Viewport / Tool Shelf /
Relations / Make Vertex
Parent

3D View / Mesh / Make Vertex Ctrl P
Parent

Calls the Delete menu quiz

3D Viewport / Mesh /
Delete

3D View / Mesh / Delete

Ctrl + Delete

Clear Seam for Unwrapping 3D Viewport / Tool Shelf /
Shading/UV's / UV's

3D View / Mesh / Mark Seam

N

Deletes mode dependant
what is selected in Edit
mode.

3D View / Mesh / Smart Delete Delete

3D Viewport / Mesh /
Delete
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Original Hotkey was E. But
E is occupied by navigation
now. So changed it to S

Keep this one until the new
UI is done. Very useful time
saver!
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Mesh - Edit Mode
Separate

3D Viewport / Mesh /
Separate

3D View / Mesh / Separate

P

Mark Seam for Unwrapping 3D Viewport / Tool Shelf /
Shading/UV's / UV's

3D View / Mesh / Mark Seam

M

Adds a edgeloop across
selected faces, which can
then be moved. Right click
centers the loop.

3D View / Mesh / Loop Cut
and Slide

Ctrl R

3D Viewport / Tool Shelf /
Tools / Mesh Tools /

3D View - Curve
3D View - Curve - everything connected with curve editing
Function

Surface menu location

User Preferences location

Hotkey

Add Vertex

None

3D View / Curve / Add Vertex

Ctrl Action Mouse

Selects or deselects all

3D Viewport / Select /
(De)select all

3D View / Curve / (De)select
all

A

Inverts the selection

3D Viewport / Select /
Inverse

3D View / Curve / (De)select
all

Ctrl I

Select more

3D Viewport / Select /
Select More

3D View / Curve / Select More Ctrl Numpad +

Select less

3D Viewport / Select /
Select Less

3D View / Curve / Select Less

Ctrl Numpad -

Select Linked

3D View / Select / Linked
Pick Select

3D View / Curve / Set Linked

L

Deelect Linked

3D View / Select / Linked
Pick Deselect

3D View / Curve / Set Linked

Shift L

Picks shortest path

None

3D View / Curve / Picks
shortest path

Ctrl Select Mouse

Extrudes a new path
segment

3D Viewport / Tool Shelf /
Tools / Curve Tools /
Extrude

3D View / Curve / Extrude

S

Add Duplicate

3D Viewport / Curve / Add 3D View / Curve / Add
Duplicate
Duplicate

Shift D

Delete

3D Viewport / Curve /
Delete

Delete

Show hidden Objects

3D Viewport / Curve /
3D View / Curve / Reveal
Show Hide / Show Hidden Hidden

Alt H

Hide selected Object

3D Viewport / Curve /
Show Hide / Hide selected

3D View / Curve / Hide
selection

H

Hide unselected Object(s)

3D Viewport / Curve /
Show Hide / Hide
unselected

3D View / Curve / Hide
selection

Shift H

Separate

3D Viewport / Curve /
Separate

3D View / Curve / Separate

P

Make Vertex Parent parents
an object to a vertex

3D Viewport / Tool Shelf /
Relations / Make Vertex
Parent

3D View / Curve / Make
Vertex Parent

Ctrl P

3D View / Curve / Delete

3D View - Armature
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Special note

No menu entry. Mouse only
action. Covered by the
Important Hotkeys addon
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3D View - Armature
Function

Surface menu location

Sketch delete. Works for
skeleton sketching

3D Viewport / Properties
3D View / Armature / Delete
toolbar Skeleton Sketching
/ Delete Strokes

Delete

Ends the stroke from the
skeleton sketching

None

3D View / Armature / End
Stroke

Right Mouse

No menu entry. Mouse only
action. Covered by the
Important Hotkeys addon

Ends the stroke from the
skeleton sketching

None

3D View / Armature / Cancel
Stroke

Esc

No menu entry. Cancel with
esc should be obvious. And
rmb ends the stroke too.
Not covered by the
Important Hotkeys addon.
But should be obvious
enough. And is not really
workflow important.

Draws skeleton sketching

None

3D View / Armature / Gesture

Shift Left Mouse

No menu entry. Mouse only
action. Covered by the
Important Hotkeys addon

Draws skeleton sketching

None

3D View / Armature / Draw
Stroke

LMB

No menu entry. Mouse only
action. Covered by the
Important Hotkeys addon

Draws skeleton sketching

None

3D View / Armature / Draw
Stroke

Ctrl LMB

No menu entry. Mouse only
action. Covered by the
Important Hotkeys addon

Draws skeleton sketching

None

3D View / Armature / Draw

Mouse Move

No menu entry. Mouse only
action. Covered by the
Important Hotkeys addon

Draws skeleton sketching

None

3D View / Armature / Draw

Ctrl Mouse Move

No menu entry. Mouse only
action. Covered by the
Important Hotkeys addon

Hide selected bone/s

3D View / Armature /
Show/Hide

3D View / Armature / Hide
selected Bones

H

Hide unselected bone/s

3D View / Armature /
Show/Hide

3D View / Armature / Hide
selected Bones

Shift H

Show hidden bones

3D View / Armature /
Show/Hide

3D View / Armature / Reveal
Hidden

Alt H

Select more

3D View / Select / More

3D View / Armature / Select
More

Ctrl Numpad +

Select less

3D View / Select / Less

3D View / Armature / Select
Less

Ctrl Numpad -

Select connected bones

3D View / Select /
Connected

3D View / Armature / Select
Connected

L

Hotkey Only Tool!

Picks shortest path between
start and end point and
selects everything in
between

None

3D View / Armature / Pick
shortest Path

Ctrl Select Mouse

No menu entry. Mouse only
action.

Duplicate

3D View / Armature /
Duplicate

3D View / Armature /
Duplicate

Shift D

Extrude

3D View / Armature /
Extrude

3D View / Armature / Extrude

S

Extrudes with option Forked 3D View / Armature /
enabled. Bones extrudes
Extrude forked
from the center of the
selected joints.

3D View / Armature / Extrude
forked

Shift S

Extrudes the bone to mouse
position.

3D View / Armature / Click
Extrude

Ctrl Select Mouse

None

User Preferences location
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Hotkey

Special note

No menu entry. Mouse only
action. Remapped from
Action to select mouse.
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3D View - Armature
Inverts the selection

3D View / Select / Inverse

3D View / Armature /
(De)select all

Ctrl I

Deletes the selected bones.

3D View / Armature /
Delete Selected Bones

3D View / Armature / Delete
Selected Bones

Delete

Make Parent

3D Viewport / Armature /
Parent

3D View / Armature / Make
Parent

Ctrl P

Clear Parent

3D Viewport / Armature /
Parent

3D View / Armature / Clear
Parent

Alt P

Separate

3D Viewport / Armature /
Separate

3D View / Armature / Separate P

Inverts the selection

3D View - Metaball
3D View - Metaball
Function

Surface menu location

User Preferences location

Hotkey

Show hidden

3D View / Metaball /
Show/Hide /

3D View / Armature / Reveal
Hidden

Alt H

Hide selected

3D View / Metaball /
Show/Hide /

3D View / Armature / Hide
selected

H

Hide unselected

3D View / Metaball /
Show/Hide /

3D View / Armature / Hide
selected

Shift H

Delete

3D View / Metaball /
Delete

3D View / Metaball / Delete

Delete

Selects or deselects all.

3D View / Select /
(De)select all

3D View / Metaball /
(De)select all

A

Inverts the selection

3D View / Select / Inverse

3D View / Metaball /
(De)select all

Ctrl I

Special note

3D View - Lattice
3D View - Lattice
Function

Surface menu location

User Preferences location

Hotkey

Selects or deselects all.

3D View / Select /
(De)select all

3D View / Lattice / (De)select
all

A

Inverts the selection

3D View / Select / Inverse

3D View / Lattice / (De)select
all

Ctrl I

Select more

3D View / Select / Select
more

3D View / Lattice / Select
More

Ctrl Numpad +

Select less

3D View / Select / Select
less

3D View / Lattice / Select Less Ctrl Numpad -

Make Vertex Parent

3D View / Lattice / Make
Vertex Parent

3D View / Lattice / Make
Vertex Parent

Ctrl P

User Preferences location

Hotkey

Special note

3D View - Font
3D View - Font
Function

Surface menu location
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3D View - Font
Deletes selected text

3D View / Text / Delete

3D View / Font / Delete

Delete

No menu entry. Standard
text editor hotkey that
exists in other text editors
without menu entry too.

Deletes last letter

None

3D View / Font / Delete

Backspace

No menu entry. Standard
text editor hotkey that
exists in other text editors
without menu entry too.

Deletes whole text

None

3D View / Font / Delete

Ctrl Backspace

No menu entry. Standard
text editor hotkey that
exists in other text editors
without menu entry too.

Text navigation

None

3D View / Font / Move Cursor

Home

No menu entry. Standard
text editor hotkey that
exists in other text editors
without menu entry too.

Text navigation

None

3D View / Font / Move Cursor

End

No menu entry. Standard
text editor hotkey that
exists in other text editors
without menu entry too.

Text navigation

None

3D View / Font / Move Cursor

Left Arrow

No menu entry. Standard
text editor hotkey that
exists in other text editors
without menu entry too.

Text navigation

None

3D View / Font / Move Cursor

Right Arrow

No menu entry. Standard
text editor hotkey that
exists in other text editors
without menu entry too.

Text navigation

None

3D View / Font / Move Cursor

Ctrl Left Arrow

No menu entry. Standard
text editor hotkey that
exists in other text editors
without menu entry too.

Text navigation

None

3D View / Font / Move Cursor

Ctrl Right Arrow

No menu entry. Standard
text editor hotkey that
exists in other text editors
without menu entry too.

Text navigation

None

3D View / Font / Move Cursor

Up Arrow

No menu entry. Standard
text editor hotkey that
exists in other text editors
without menu entry too.

Text navigation

None

3D View / Font / Move Cursor

Down Arrow

No menu entry. Standard
text editor hotkey that
exists in other text editors
without menu entry too.

Text navigation

None

3D View / Font / Move Cursor

Page Up

No menu entry. Standard
text editor hotkey that
exists in other text editors
without menu entry too.

Text navigation

None

3D View / Font / Move Cursor

Page Down

No menu entry. Standard
text editor hotkey that
exists in other text editors
without menu entry too.

Text navigation

None

3D View / Font / Move Select

Shift Home

No menu entry. Standard
text editor hotkey that
exists in other text editors
without menu entry too.

Text navigation

None

3D View / Font / Move Select

Shift End

No menu entry. Standard
text editor hotkey that
exists in other text editors
without menu entry too.
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3D View - Font
Text navigation

None

3D View / Font / Move Select

Shift Left Arrow

No menu entry. Standard
text editor hotkey that
exists in other text editors
without menu entry too.

Text navigation

None

3D View / Font / Move Select

Shift Right Arrow

No menu entry. Standard
text editor hotkey that
exists in other text editors
without menu entry too.

Text navigation

None

3D View / Font / Move Select

Shift Ctrl Left
Arrow

No menu entry. Standard
text editor hotkey that
exists in other text editors
without menu entry too.

Text navigation

None

3D View / Font / Move Select

Shift Ctrl Right
Arrow

No menu entry. Standard
text editor hotkey that
exists in other text editors
without menu entry too.

Text navigation

None

3D View / Font / Move Select

Shift Up Arrow

No menu entry. Standard
text editor hotkey that
exists in other text editors
without menu entry too.

Text navigation

None

3D View / Font / Move Select

Shift Down Arrow

No menu entry. Standard
text editor hotkey that
exists in other text editors
without menu entry too.

Text navigation

None

3D View / Font / Move Select

Shift Page Up

No menu entry. Standard
text editor hotkey that
exists in other text editors
without menu entry too.

Text navigation

None

3D View / Font / Move Select

Shift Page Down.

No menu entry. Standard
text editor hotkey that
exists in other text editors
without menu entry too.

Text navigation

None

3D View / Font / Change
Spacing

Alt Left Arrow

No menu entry. Standard
text editor hotkey that
exists in other text editors
without menu entry too.

Text navigation

None

3D View / Font / Change
Spacing

Alt Right Arrow

No menu entry. Standard
text editor hotkey that
exists in other text editors
without menu entry too.

Text navigation

None

3D View / Font / Change
Character

Alt Up Arrow

No menu entry. Standard
text editor hotkey that
exists in other text editors
without menu entry too.

Text navigation

None

3D View / Font / Change
Character

Alt Down Arrow

No menu entry. Standard
text editor hotkey that
exists in other text editors
without menu entry too.

Select All

3D View / Edit / Select All 3D View / Font / Select All

Ctrl A

Copy Text

3D View / Edit / Copy Text 3D View / Font / Copy Text

Ctrl C

Cut Text

3D View / Edit / Copy Text 3D View / Font / Copy Text

Ctrl X

Paste Text

3D View / Edit / Paste Text 3D View / Font / Paste Text

Ctrl V

Line Break

None

Return

Insert Text

3D View / Font / Line Break

3D View / Font / Insert Text
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No menu entry. Standard
text editor hotkey that
exists in other text editors
without menu entry too.
No menu entry. Event
Mapping Keyboard

Bforartists Reference Manual - © Copyright - This page is Public Domain
3D View - Font
Insert Text

None

3D View / Font / Insert Text

Alt Backspace

No menu entry. Standard
text editor hotkey that
exists in other text editors
without menu entry too.

3D View - Pose
3D View - Pose
Function

Surface menu location

User Preferences location

Hotkey

Special note

Calls the Make Parent panel

3D View / Pose / Parent

3D View / Pose / Parent

Ctrl P

One of the panels to keep for
now

Hide selected

3D View / Pose /
Show/Hide

3D View / Pose / Hide selected H

Hide unselected

3D View / Pose /
Show/Hide

3D View / Pose / Hide selected Shift H

Show hidden

3D View / Pose /
Show/Hide

3D View / Pose / Reveal
Selected

Alt H

Copy pose

3D View / Pose / Copy
pose

3D View / Pose / Copy pose

Ctrl C

Paste Pose

3D View / Pose / Paste
pose

3D View / Pose / Paste pose

Ctrl V

Selects or deselects all.

3D View / Pose /
(De)select all

3D View / Pose / (De)select all A

Inverts the selection

3D View / Pose / Inverse

3D View / Pose / (De)select all Ctrl I

Select connected bones

3D View / Select /
Connected

3D View / Armature / Select
Connected

L

Hotkey Only Tool!

Hotkey

Special note

3D View - Vertex Paint
3D View - Vertex Paint
Function

Surface menu location

User Preferences location

Vertex Paint

None

3D View / Vertex Paint / Vertex LMB
Paint

Turns Mouse into a colour
picker.

3D View / Tool Shelf /
Tools / Brush /

3D View / Vertex Paint /
Sample Color

Sets the brush radius

3D View / Tool Shelf /
Tools / Brush / Radius
Slider

3D View / Vertex Paint / Radial F
Control

Covered by the Important
Hotkeys addon

Sets the brush radius with a
value in the middle

3D View / Tool Shelf /
Tools / Brush / Radius
Slider

3D View / Vertex Paint / Radial Shift F
Control

Covered by the Important
Hotkeys addon

Sets the brush direction.
Useful for painting with
maps. Like for scales.

3D View / Tool Shelf /
Tools / Brush / Radius
Slider

3D View / Vertex Paint / Radial Ctrl F
Control

Covered by the Important
Hotkeys addon

Brush Mode Stencil
navigation

None

3D View / Vertex Paint /
Stencil Brush Control

Shift Ctrl RMB

No menu entry. Mouse only
action. Original hotkey RMB
conflicts with new
navigation. Set to Shift Ctrl
RMB. Covered by the
Important Hotkeys addon

Brush Mode Stencil
navigation

None

3D View / Vertex Paint /
Stencil Brush Control

Shift RMB

No menu entry. Mouse only
action. Covered by the
Important Hotkeys addon
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3D View - Vertex Paint
Brush Mode Stencil.
Changes the angle value in
the Texture tab

3D View / Tool Shelf /
Tools / Texture

3D View / Vertex Paint /
Stencil Brush Control

Ctrl RMB

Covered by the Important
Hotkeys addon

Brush Mode Stencil
navigation

None

3D View / Vertex Paint /
Stencil Brush Control

Alt RMB

No menu entry. Mouse only
action. Covered by the
Important Hotkeys addon

Brush Mode Stencil
navigation

None

3D View / Vertex Paint /
Stencil Brush Control

Shift Alt RMB

No menu entry. Mouse only
action. Covered by the
Important Hotkeys addon

Brush Mode Stencil
navigation

None

3D View / Vertex Paint /
Stencil Brush Control

Ctrl Alt RMB

No menu entry. Mouse only
action. Covered by the
Important Hotkeys addon

User Preferences location

Hotkey

Special note

LMB

No menu entry. Mouse only
action.
No menu entry. Mouse only
action. Covered by the
Important Hotkeys addon

3D View - Weight Paint
3D View - Weight Paint
Function

Surface menu location

Weight Paint

None

Click at a bone to select it
for weightpaiting.

None

3D View / Weight Paint /
Weight Paint

CTRL Action
Mouse

Calls Weight Paint Sample
Group panel, which shows
the available group for the
current position

None

3D View / Weight Paint /
Weight Paint Sample Weight

Shift Action Mouse No menu entry. Mouse only
action.

Draws a gradient at the
weightmap

None

3D View / Weight Paint /
Weight Gradient

Alt LMB

No menu entry. Mouse only
action. Covered by the
Important Hotkeys addon

Draws a gradient at the
weightmap

None

3D View / Weight Paint /
Weight Gradient

Ctrl Alt LMB

No menu entry. Mouse only
action. Covered by the
Important Hotkeys addon

Should set the brush radius.
Doesn't work. Not in
Blender neither.

3D View / Tool Shelf /
Tools / Brush / Radius
Slider

3D View / Weight Paint /
Radial Control

F

Sets the brush radius with a
value in the middle

3D View / Tool Shelf /
Tools / Brush / Radius
Slider

3D View / Weight Paint /
Radial Control

Shift F

Sets the brush direction.
Useful for painting with
maps. Like for scales.

3D View / Tool Shelf /
Tools / Brush / Radius
Slider

3D View / Weight Paint /
Radial Control

Ctrl F

Brush Mode Stencil.

None

3D View / Weight Paint /
Stencil Brush Control

Shift Ctrl RMB

No menu entry. Mouse only
action. Original hotkey RMB
conflicts with new
navigation. Set to Shift Ctrl
RMB. Covered by the
Important Hotkeys addon

Brush Mode Stencil.

None

3D View / Weight Paint /
Stencil Brush Control

Shift RMB

No menu entry. Mouse only
action. Covered by the
Important Hotkeys addon

Brush Mode Stencil.
Changes the angle value in
the Texture tab

3D View / Tool Shelf /
Tools / Texture

3D View / Weight Paint /
Stencil Brush Control

Ctrl RMB

Covered by the Important
Hotkeys addon

Brush Mode Stencil.

None

3D View / Weight Paint /
Stencil Brush Control

Alt RMB

No menu entry. Mouse only
action. Covered by the
Important Hotkeys addon
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3D View - Weight Paint
Brush Mode Stencil.

None

3D View / Weight Paint /
Stencil Brush Control

Shift Alt RMB

No menu entry. Mouse only
action. Covered by the
Important Hotkeys addon

Brush Mode Stencil.

None

3D View / Weight Paint /
Stencil Brush Control

Ctrl Alt RMB

No menu entry. Mouse only
action. Covered by the
Important Hotkeys addon

3D View - Weight Paint Vertex Selection
3D View - Weight Paint Vertex Selection
Function

Surface menu location

User Preferences location

Hotkey

Special note

Selects or deselects all.

3D View / Select /
(De)select all

3D View / Weight Paint Vertex A
Selection / (De)select all

Inverts the selection

3D View / Select / Inverse

3D View / Weight Paint Vertex Ctrl I
Selection / (De)select all

Border Select

3D View / Select / Border
Select

3D View / Weight Paint Vertex B
Selection / Border Selec

Lasso Select

None

3D View / Weight Paint Vertex
Selection / Lasso Select

No menu entry. Event
Mapping Tweak

Lasso Select

None

3D View / Weight Paint Vertex
Selection / Lasso Select

No menu entry. Event
Mapping Tweak

Cirlcle Select

3D View / Select / Border
Select

3D View / Weight Paint Vertex C
Selection / Cirlcle Select

3D View - Face Mask - Face selection masking on.
3D View - Face Mask - Face selection masking on.
Function

Surface menu location

User Preferences location

Hotkey

Selects or deselects all.

3D View / Select /
(De)select all

3D View / Face Mask /
(De)select all

A

Inverts the selection

3D View / Select / Inverse

3D View / Face Mask /
(De)select all

Ctrl I

Hide selected

3D View / Brush /
Show/Hide /

3D View / Face Mask / Hide
selected

H

Hide unselected

3D View / Brush /
Show/Hide /

3D View / Face Mask / Hide
selected

Shift H

Show hidden

3D View / Brush /
Show/Hide /

3D View / Face Mask / Reveal Alt H
Hidden

Select Linked

3D View / Select / Linked
Pick Select

3D View / Face Mask / Select
Linked Pick

L

Select Linked

3D View / Select / Linked
Pick Deselect

3D View / Face Mask / Select
Linked Pick

Shift L

Special note

3D View - Image Paint
3D View - Image Paint - already a reason to investigate. The Mode is called Texture Paint.
Function

Surface menu location

User Preferences location

Image Paint

None

3D View / Image Paint / Image LMB
Paint
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Hotkey

Special note
No menu entry. Mouse only
action.
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3D View - Image Paint - already a reason to investigate. The Mode is called Texture Paint.
Image Paint

None

3D View / Image Paint / Image Ctrl LMB
Paint

Inverts the current selected
colour to paint with

3D View / Tool Shelf /
Tools / Brush / toggle
button

3D View / Image Paint / Brush X
Colors Flip

Turns Mouse into a colour
picker.

3D View / Tool Shelf /
Tools / Brush / eyedropper
button

3D View / Image Paint /
Sample Color

Sets the brush radius

3D View / Tool Shelf /
Tools / Brush / Radius
Slider

3D View / Image Paint / Radial F
Control

Sets the brush radius with a
value in the middle

3D View / Tool Shelf /
Tools / Brush / Radius
Slider

3D View / Image Paint /
Radial Control

Shift F

Sets the brush direction.
Useful for painting with
maps. Like for scales.

3D View / Tool Shelf /
Tools / Brush / Radius
Slider

3D View / Image Paint /
Radial Control

Ctrl F

Sets the brush direction.
Useful for painting with
maps. Like for scales.

3D View / Tool Shelf /
Tools / Brush / Radius
Slider

3D View / Image Paint / Radial Ctrl Alt F
Control

Brush Mode Stencil.

3D View / Tool Shelf /
Tools / Texture mask when mask mapping is
stencil

3D View / Image Paint /
Stencil Brush Control

Shift Ctrl RMB

Brush Mode Stencil.

3D View / Tool Shelf /
Tools / Texture mask when mask mapping is
stencil

3D View / Image Paint /
Stencil Brush Control

Shift RMB

Brush Mode Stencil.
Changes the angle value in
the Texture tab

3D View / Tool Shelf /
Tools / Texture mask when mask mapping is
stencil

3D View / Image Paint /
Stencil Brush Control

Ctrl RMB

Brush Mode Stencil.

3D View / Tool Shelf /
Tools / Texture mask when mask mapping is
stencil

3D View / Image Paint /
Stencil Brush Control

Alt RMB

Brush Mode Stencil.

3D View / Tool Shelf /
Tools / Texture mask when mask mapping is
stencil

3D View / Image Paint /
Stencil Brush Control

Shift Alt RMB

Brush Mode Stencil.

3D View / Tool Shelf /
Tools / Texture mask when mask mapping is
stencil

3D View / Image Paint /
Stencil Brush Control

Ctrl Alt RMB

No menu entry. Mouse only
action.

S

3D View Sculpt
3D View Sculpt
Function

Surface menu location

User Preferences location

Hotkey

Special note

Sculpt

None

3D View / Sculpt / Sculpt

LMB

No menu entry. Mouse only
action.

Sculpt

None

3D View / Sculpt / Sculpt

Ctrl LMB

No menu entry. Mouse only
action.

Sculpt

None

3D View / Sculpt / Sculpt

Shift LMB

No menu entry. Mouse only
action.
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3D View Sculpt
Show Bounding Box

3D View / Hide/Mask /
Show Bounding Box

3D View / Sculpt / Hide/Show

Shift H

Hide Bounding Box

3D View / Hide/Mask /
Hide Bounding Box

3D View / Sculpt / Hide/Show

H

Show All

3D View / Hide/Mask /
Show All

3D View / Sculpt / Hide/Show

Alt H

Adds a Multires modifier to 3D View / Sculpt /
selected object and sets SDS Subdivide /
Level to value

3D View / Sculpt / Subdivision Ctrl 0
Set

Adds a Multires modifier to 3D View / Sculpt /
selected object and sets SDS Subdivide /
Level to value

3D View / Sculpt / Subdivision Ctrl 1
Set

Adds a Multires modifier to 3D View / Sculpt /
selected object and sets SDS Subdivide /
Level to value

3D View / Sculpt / Subdivision Ctrl 2
Set

Adds a Multires modifier to 3D View / Sculpt /
selected object and sets SDS Subdivide /
Level to value

3D View / Sculpt / Subdivision Ctrl 3
Set

Adds a Multires modifier to 3D View / Sculpt /
selected object and sets SDS Subdivide /
Level to value

3D View / Sculpt / Subdivision Ctrl 4
Set

Adds a Multires modifier to 3D View / Sculpt /
selected object and sets SDS Subdivide /
Level to value

3D View / Sculpt / Subdivision Ctrl 5
Set

Sets Detail size of brush in
Dyntopo mode!

3D View / Tool Shelf /
Tools / Dyntopo / Set
Detail Size

3D View / Sculpt / Set Detail
Size

Shift D

Sets the brush radius

3D View / Tool Shelf /
Tools / Brush / Radial
Control

3D View / Sculpt / Radial
Control

F

Sets the brush radius with a
value in the middle

3D View / Tool Shelf /
Tools / Brush / Radial
Control

3D View / Sculpt / Radial
Control

Shift F

Sets the brush direction.
Useful for painting with
maps. Like for scales.

3D View / Tool Shelf /
Tools / Brush / Radial
Control

3D View / Sculpt / Radial
Control

Ctrl F

Brush Mode Stencil.

3D View / Tool Shelf /
Tools / Texture - shows
with Brush mapping
Stencil

3D View / Sculpt / Stencil
Brush Control

Shift Ctrl Alt RMB

Brush Mode Stencil.

3D View / Tool Shelf /
Tools / Texture - shows
with Brush mapping
Stencil

3D View / Sculpt / Stencil
Brush Control

Shift RMB

Brush Mode Stencil.

3D View / Tool Shelf /
Tools / Texture - shows
with Brush mapping
Stencil

3D View / Sculpt / Stencil
Brush Control

Ctrl RMB

Brush Mode Stencil.

3D View / Tool Shelf /
Tools / Texture - shows
with Brush mapping
Stencil

3D View / Sculpt / Stencil
Brush Control

Alt RMB

Brush Mode Stencil.

3D View / Tool Shelf /
Tools / Texture - shows
with Brush mapping
Stencil

3D View / Sculpt / Stencil
Brush Control

Shift Alt RMB
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3D View Sculpt
Brush Mode Stencil.

3D View / Tool Shelf /
3D View / Sculpt / Stencil
Texture - shows with Brush Brush Control
mapping Stencil

Ctrl Alt RMB

3D View - Particle
3D View - Particle. Note that most hotkeys are just available for hair.
Function

Surface menu location

User Preferences location

Hotkey

Special note

Selects or deselects all.

3D View / Select /
(De)select all

3D View / / (De)select all

A

Inverts the selection

3D View / Select / Inverse

3D View / Particle / (De)select Ctrl I
all

Select more

3D View / Select / Select
More

3D View / Particle / Select
More

Ctrl Numpad +

Select less

3D View / Select / Select
Less

3D View / Particle / Select
Less

Ctrl Numpad -

Select Linked, in particle
mode with Hair

3D View / Select / Select
linked

3D View / Particle / Select
Linked

L

Select Linked, in particle
mode with Hair

3D View / Select / Deselect 3D View / Particle / Select
linked
Linked

Shift L

Delete

3D View / Particle / Delete 3D View / Particle / Delete

Delete

Show All

3D View / Particle / Show/ 3D View / Particle /
Hide / Show All
Hide/Show

Alt H

Hide Selected

3D View / Particle / Show/ 3D View / Particle /
Hide / Hide Selected
Hide/Show

H

Hide Unselected

3D View / Particle / Show/ 3D View / Particle /
Hide / Show Hidden
Hide/Show

Shift H

Painting with the brush

None

3D View / Particle / 3D
Manipulator

Any LMB

Painting with the brush

None

3D View / Particle / Brush Edit LMB

No menu entry. Mouse only
action.

Painting with the brush

None

3D View / Particle / Brush Edit Shift LMB

No menu entry. Mouse only
action.

Sets the brush radius

3D View / Sidebar / Tools / 3D View / Particle / Radial
Brush / Radial Control Size Control

F

Sets the brush strength

3D View / Sidebar / Tools / 3D View / Particle / Radial
Brush / Radial Control
Control
Strength

Shift F

No menu entry. Mouse only
action.

3D View - Knife Tool Modal Map
3D View - Knife Tool Modal Map
Function

Surface menu location

User Preferences location

Hotkey

Special note

Cancel

None

3D View / Knife Tool Modal
Map / Cancel

Any Esc

No menu entry. Covered
by the tooltip in the menu
bar that appears when you
are in knife mode

Panning

None

3D View / Knife Tool Modal
Map / Panning

Any MMB

No menu entry. Mouse only
action. Covered by the
tooltip in the menu bar that
appears when you are in
knife mode
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3D View - Knife Tool Modal Map
None

3D View / Knife Tool Modal
Map /

Any Dbl-LMB

No menu entry. Mouse only
action. Unlabeled

Add Cut

None

3D View / Knife Tool Modal
Map / Add Cut

Any LMB

No menu entry. Mouse only
action. Covered by the
tooltip in the menu bar that
appears when you are in
knife mode

Cancel

None

3D View / Knife Tool Modal
Map / Cancel

Any RMB

No menu entry. Mouse only
action. Covered by the
tooltip in the menu bar that
appears when you are in
knife mode

Confirm

None

3D View / Knife Tool Modal
Map / Confirm

Any Return

No menu entry. Covered by
the tooltip in the menu bar
that appears when you are
in knife mode

Confirm

None

3D View / Knife Tool Modal
Map / Confirm

Any Numpad Enter No menu entry. Covered by
the tooltip in the menu bar
that appears when you are
in knife mode

Confirm

None

3D View / Knife Tool Modal
Map / Confirm

Any Spacebar

No menu entry. Covered by
the tooltip in the menu bar
that appears when you are
in knife mode

End current cut

None

3D View / Knife Tool Modal
Map / End current cut

E

No menu entry. Covered by
the tooltip in the menu bar
that appears when you are
in knife mode

Snap to Midpoints On

None

3D View / Knife Tool Modal
Map / Snap to Midpoints On

Any Left Ctrl

No menu entry. Covered by
the tooltip in the menu bar
that appears when you are
in knife mode

Snap to Midpoints Off

None

3D View / Knife Tool Modal
Map / Snap to Midpoints Off

Any Left Ctrl

No menu entry. Covered by
the tooltip in the menu bar
that appears when you are
in knife mode

Snap to Midpoints On

None

3D View / Knife Tool Modal
Map / Snap to Midpoints On

Any Right Ctrl

No menu entry. Covered by
the tooltip in the menu bar
that appears when you are
in knife mode

Snap to Midpoints Off

None

3D View / Knife Tool Modal
Map / Snap to Midpoints Off

Any Right Ctrl

No menu entry. Covered by
the tooltip in the menu bar
that appears when you are
in knife mode

Ingore Snapping On

None

3D View / Knife Tool Modal
Map / Ingore Snapping On

Any Left Shift

No menu entry. Covered by
the tooltip in the menu bar
that appears when you are
in knife mode

Ingore Snapping Off

None

3D View / Knife Tool Modal
Map / Ingore Snapping Off

Any Left Shift

No menu entry. Covered by
the tooltip in the menu bar
that appears when you are
in knife mode

Ingore Snapping On

None

3D View / Knife Tool Modal
Map / Ingore Snapping On

Any Right Shift

No menu entry. Covered by
the tooltip in the menu bar
that appears when you are
in knife mode

Ingore Snapping Off

None

3D View / Knife Tool Modal
Map / Ingore Snapping Off

Any Right Shift

No menu entry. Covered by
the tooltip in the menu bar
that appears when you are
in knife mode
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3D View - Knife Tool Modal Map
Toggle Angle Snapping

None

3D View / Knife Tool Modal
Map / Toggle Angle Snapping

C

No menu entry. Covered by
the tooltip in the menu bar
that appears when you are
in knife mode

Toggle Cut Through

None

3D View / Knife Tool Modal
Map / Toggle Cut Through

Z

No menu entry. Covered by
the tooltip in the menu bar
that appears when you are
in knife mode

Hotkey

Special note

3D View - Paint Stroke Modal
3D View - Paint Stroke Modal
Function

Surface menu location

User Preferences location

End paint stroke

None

3D View / Paint Stroke Modal / Any Esc
Paint Stroke Modal

No menu entry.

3D View - Paint Curve
3D View - Paint Curve - Texture painting with stroke mode curve.
Function

Surface menu location

User Preferences location

Hotkey

Special note

Add Curve Point and Slide

None

3D View / Paint Curve / Add
Curve Point and Slide

Ctrl Action Mouse

No menu entry. Mouse only
action.

Select Paint Curve Point

None

3D View / Paint Curve / Select Select Mouse
Paint Curve Point

Select Paint Curve Point

None

3D View / Paint Curve / Select Shift Select Mouse No menu entry. Mouse only
Paint Curve Point
action.

Slide Paint Curve Point

None

3D View / Paint Curve / Slide
Paint Curve Point

Action Mouse

Slide Paint Curve Point

None

3D View / Paint Curve / Slide
Paint Curve Point

Shift Action Mouse No menu entry. Mouse only
action.

Select Paint Curve Point

???

3D View / Paint Curve / Select A
Paint Curve Point

No Menu Entry since there is
no menu for Texture Paint
Stroke Method Curve at all.

Place Cursor

None

3D View / Paint Curve / Place
Cursor

Action Mouse

No menu entry. Mouse only
action.

Remove Paint Curve Point

3D View / Paint Curve /
Remove Paint Curve Point

Delete

No Menu Entry since there is
no menu for Texture Paint
Stroke Method Curve at
all.Original Key was X.
Deleting is Delete, so
mapped to Delete.

Draw Curve

3D View / Paint Curve / Draw
Curve

Return

No Menu Entry since there is
no menu for Texture Paint
Stroke Method Curve at all.

Draw Curve

3D View / Paint Curve / Draw
Curve

Numpad Enter

No Menu Entry since there is
no menu for Texture Paint
Stroke Method Curve at all.

Translate

3D View / Navi / Translate 3D View / Paint Curve /
Translate

Translate

3D View / Paint Curve /
Translate

No menu entry. Mouse only
action.

W

Rotate

3D View / Navi / Rotate

3D View / Paint Curve / Rotate E

Resize

3D View / Navi / Resize

3D View / Paint Curve / Resize R
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No menu entry. Event
mapping Tweak
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3D View - Object Non Modal
3D View - Object Non Modal - Formerly the tab nonsense to jump back and forth between different modes. Now the switch between all
available modes by using the numbers above the letters
Function

Surface menu location

User Preferences location

Hotkey

Object Mode

3D View / Dropdown Box
in menu bar

3D View / Object Non-modal / 1

Edit Mode

3D View / Dropdown Box
in menu bar

3D View / Object Non-modal / 2

Sculpt Mode

3D View / Dropdown Box
in menu bar

3D View / Object Non-modal / 3

Vertex Paint

3D View / Dropdown Box
in menu bar

3D View / Object Non-modal / 4

Weight Paint

3D View / Dropdown Box
in menu bar

3D View / Object Non-modal / 5

Texture Paint

3D View / Dropdown Box
in menu bar

3D View / Object Non-modal / 6

Pose Mode

3D View / Dropdown Box
in menu bar

3D View / Object Non-modal / 7

Special note

3D View - View 3D Walk Modal
3D View - View 3D Walk Modal - Just active in Walk mode navigation. Can be activated in 3D View / View / Navigation / Walk Navigation
Function

Surface menu location

User Preferences location

Hotkey

Special note

Cancel

None

3D View / View 3D Walk
Modal / Cancel

Any Esc

No menu entry. Covered by
the tooltip in the menu bar
that appears when you are
in walk mode

Cancel

None

3D View / View 3D Walk
Modal / Cancel

Any RMB

No menu entry. Covered by
the tooltip in the menu bar
that appears when you are
in walk mode

Confirm

None

3D View / View 3D Walk
Modal / Confirm

Any LMB

No menu entry. Covered by
the tooltip in the menu bar
that appears when you are
in walk mode

Confirm

None

3D View / View 3D Walk
Modal / Confirm

Any Return

No menu entry. Covered by
the tooltip in the menu bar
that appears when you are
in walk mode

Confirm

None

3D View / View 3D Walk
Modal / Confirm

Any Numpad Enter No menu entry. Covered by
the tooltip in the menu bar
that appears when you are
in walk mode

Fast Enable

None

3D View / View 3D Walk
Modal / Fast Enable

Any Left Shift

No menu entry. Covered by
the tooltip in the menu bar
that appears when you are
in walk mode

Fast Disable

None

3D View / View 3D Walk
Modal / Fast Disable

Any Left Shift

No menu entry. Covered by
the tooltip in the menu bar
that appears when you are
in walk mode
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3D View - View 3D Walk Modal - Just active in Walk mode navigation. Can be activated in 3D View / View / Navigation / Walk Navigation
Slow Enable

None

3D View / View 3D Walk
Modal / Slow Enable

Any Left Alt

No menu entry. Covered by
the tooltip in the menu bar
that appears when you are
in walk mode

Slow Disable

None

3D View / View 3D Walk
Modal / Slow Disable

Any Left Alt

No menu entry. Covered by
the tooltip in the menu bar
that appears when you are
in walk mode

Move Forward

None

3D View / View 3D Walk
Modal / Move Forward

Any W

No menu entry. Covered by
the tooltip in the menu bar
that appears when you are
in walk mode

Move Backward

None

3D View / View 3D Walk
Modal / Move Backward

Any S

No menu entry. Covered by
the tooltip in the menu bar
that appears when you are
in walk mode

Move Left ( Strafe)

None

3D View / View 3D Walk
Modal / Move Left ( Strafe)

Any A

No menu entry. Covered by
the tooltip in the menu bar
that appears when you are
in walk mode

Move Right ( Strafe)

None

3D View / View 3D Walk
Modal / Move Right ( Strafe)

Any D

No menu entry. Covered by
the tooltip in the menu bar
that appears when you are
in walk mode

Move Up

None

3D View / View 3D Walk
Modal / Move Up

Any E

No menu entry. Covered by
the tooltip in the menu bar
that appears when you are
in walk mode

Move Down

None

3D View / View 3D Walk
Modal / Move Down

Any Q

No menu entry. Covered by
the tooltip in the menu bar
that appears when you are
in walk mode

Stop Move Forward

None

3D View / View 3D Walk
Modal / Stop Move Forward

Any W

No menu entry. Covered by
the tooltip in the menu bar
that appears when you are
in walk mode

Stop Move Backward

None

3D View / View 3D Walk
Modal / Stop Move Backward

Any S

No menu entry. Covered by
the tooltip in the menu bar
that appears when you are
in walk mode

Stop Move Left ( Strafe)

None

3D View / View 3D Walk
Modal / Stop Move Left
( Strafe)

Any A

No menu entry. Covered by
the tooltip in the menu bar
that appears when you are
in walk mode

Stop Move Right ( Strafe)

None

3D View / View 3D Walk
Modal / Stop Move Right
( Strafe)

Any D

No menu entry. Covered by
the tooltip in the menu bar
that appears when you are
in walk mode

Stop Move Up

None

3D View / View 3D Walk
Modal / Stop Move Up

Any E

No menu entry. Covered by
the tooltip in the menu bar
that appears when you are
in walk mode

Stop Move Down

None

3D View / Walk Modal / Stop
Move Down

Any Q

No menu entry. Covered by
the tooltip in the menu bar
that appears when you are
in walk mode

Move Forward

None

3D View / View 3D Walk
Modal / Move Forward

Up Arrow

No menu entry. Covered by
the tooltip in the menu bar
that appears when you are
in walk mode
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3D View - View 3D Walk Modal - Just active in Walk mode navigation. Can be activated in 3D View / View / Navigation / Walk Navigation
Move Backward

None

3D View / View 3D Walk
Modal / Move Backward

Down Arrow

No menu entry. Covered by
the tooltip in the menu bar
that appears when you are
in walk mode

Move Left ( Strafe)

None

3D View / View 3D Walk
Modal / Move Left ( Strafe)

Left Arrow

No menu entry. Covered by
the tooltip in the menu bar
that appears when you are
in walk mode

Move Right ( Strafe)

None

3D View / View 3D Walk
Modal / Move Right ( Strafe)

Right Arrow

No menu entry. Covered by
the tooltip in the menu bar
that appears when you are
in walk mode

Stop Move Forward

None

3D View / View 3D Walk
Modal / Stop Move Forward

Any Up Arrow

No menu entry. Covered by
the tooltip in the menu bar
that appears when you are
in walk mode

Stop Move Backward

None

3D View / View 3D Walk
Modal / Stop Move Backward

Any Down Arrow

No menu entry. Covered by
the tooltip in the menu bar
that appears when you are
in walk mode

Stop Move Left ( Strafe)

None

3D View / View 3D Walk
Modal / Stop Move Left
( Strafe)

Any Left Arrow

No menu entry. Covered by
the tooltip in the menu bar
that appears when you are
in walk mode

Stop Move Right ( Strafe)

None

3D View / View 3D Walk
Modal / Stop Move Right
( Strafe)

Any Right Arrow

No menu entry. Covered by
the tooltip in the menu bar
that appears when you are
in walk mode

Toggle Gravity

None

3D View / View 3D Walk
Modal / Toggle Gravity

Tab

No menu entry. Covered by
the tooltip in the menu bar
that appears when you are
in walk mode

Toggle Gravity

None

3D View / View 3D Walk
Modal / Toggle Gravity

G

No menu entry. Covered by
the tooltip in the menu bar
that appears when you are
in walk mode

Jump

None

3D View / View 3D Walk
Modal / Jump

Any V

No menu entry. Covered by
the tooltip in the menu bar
that appears when you are
in walk mode

Jump Stop

None

3D View / View 3D Walk
Modal / Jump Stop

Any V

No menu entry. Covered by
the tooltip in the menu bar
that appears when you are
in walk mode

Teleport

None

3D View / View 3D Walk
Modal / Teleport

Any Spacebar

No menu entry. Covered by
the tooltip in the menu bar
that appears when you are
in walk mode

Teleport

None

3D View / View 3D Walk
Modal / Teleport

Any MMB

No menu entry. Covered by
the tooltip in the menu bar
that appears when you are
in walk mode

Accellerate

None

3D View / View 3D Walk
Modal / Accelerate

Any Numpad +

No menu entry. Covered by
the tooltip in the menu bar
that appears when you are
in walk mode

Decelerate

None

3D View / View 3D Walk
Modal / Decelerate

Any Numpad -

No menu entry. Covered by
the tooltip in the menu bar
that appears when you are
in walk mode
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3D View - View 3D Walk Modal - Just active in Walk mode navigation. Can be activated in 3D View / View / Navigation / Walk Navigation
Accelerate

None

3D View / View 3D Walk
Modal / Accelerate

Any Wheel Up

No menu entry. Covered by
the tooltip in the menu bar
that appears when you are
in walk mode

Decelerate

None

3D View / View 3D Walk
Modal / Decelerate

Any Wheel Down

No menu entry. Covered by
the tooltip in the menu bar
that appears when you are
in walk mode

3D View - View 3D Fly Modal
3D View - View 3D Fly Modal - Just active in Fly mode navigation. Can be activated in 3D View / View / Navigation / Fly Navigation
Function

Surface menu location

User Preferences location

Hotkey

Special note

Cancel

None

3D View / View 3D Fly
Modal / Cancel

Any Esc

No menu entry. Covered by
the tooltip in the menu bar
that appears when you are
in fly mode

Cancel

None

3D View / View 3D Fly
Modal / Cancel

Any RMB

No menu entry. Covered by
the tooltip in the menu bar
that appears when you are
in fly mode

Confirm

None

3D View / View 3D Fly
Modal / Confirm

Any LMB

No menu entry. Covered by
the tooltip in the menu bar
that appears when you are
in fly mode

Confirm

None

3D View / View 3D Fly
Modal / Confirm

Any Return

No menu entry. Covered by
No menu entry. the tooltip
in the menu bar that
appears when you are in fly
mode

Confirm

None

3D View / View 3D Fly
Modal / Confirm

Any Spacebar

No menu entry. Covered by
the tooltip in the menu bar
that appears when you are
in fly mode

Confirm

None

3D View / View 3D Fly
Modal / Confirm

Any Numpad Enter No menu entry. Covered by
the tooltip in the menu bar
that appears when you are
in fly mode

Accellerate

None

3D View / View 3D Fly
Modal / Accellerate

Any Numpad +

No menu entry. Covered by
the tooltip in the menu bar
that appears when you are
in fly mode

Decelerate

None

3D View / View 3D Fly
Modal / Decelerate

Any Numpad -

No menu entry. Covered by
the tooltip in the menu bar
that appears when you are
in fly mode

Accelerate

None

3D View / View 3D Fly
Modal / Accellerate

Any Wheel Up

No menu entry. Covered by
the tooltip in the menu bar
that appears when you are
in fly mode

Decelerate

None

3D View / View 3D Fly
Modal / Decelerate

Any Wheel Down

No menu entry. Covered by
the tooltip in the menu bar
that appears when you are
in fly mode

None

3D View / View 3D Fly
Modal /
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3D View - View 3D Fly Modal - Just active in Fly mode navigation. Can be activated in 3D View / View / Navigation / Fly Navigation
Pan Enable

None

3D View / View 3D Fly
Modal / Pan Enable

Any MMB

No menu entry. Covered by
the tooltip in the menu bar
that appears when you are
in fly mode

Pan Disable

None

3D View / View 3D Fly
Modal / Pan Disable

Any MMB

No menu entry. Covered by
the tooltip in the menu bar
that appears when you are
in fly mode

Fly Forward

None

3D View / View 3D Fly
Modal / Fly Forward

W

No menu entry. Covered by
the tooltip in the menu bar
that appears when you are
in fly mode

Fly Backward

None

3D View / View 3D Fly
Modal / Fly Backward

S

No menu entry. Covered by
the tooltip in the menu bar
that appears when you are
in fly mode

Fly Left

None

3D View / View 3D Fly
Modal / Fly Left

A

No menu entry. Covered by
the tooltip in the menu bar
that appears when you are
in fly mode

Fly Right

None

3D View / View 3D Fly
Modal / Fly Right

D

No menu entry. Covered by
the tooltip in the menu bar
that appears when you are
in fly mode

Fly Up

None

3D View / View 3D Fly
Modal / Fly Up

E

No menu entry. Covered by
the tooltip in the menu bar
that appears when you are
in fly mode

Fly Down

None

3D View / View 3D Fly
Modal / Fly Down

Q

No menu entry. Covered by
the tooltip in the menu bar
that appears when you are
in fly mode

Fly Up

None

3D View / View 3D Fly
Modal / Fly Up

R

No menu entry. Covered by
the tooltip in the menu bar
that appears when you are
in fly mode

Fly Down

None

3D View / View 3D Fly
Modal / Fly Down

F

No menu entry. Covered by
the tooltip in the menu bar
that appears when you are
in fly mode

Fly Forward

None

3D View / View 3D Fly
Modal / Fly Forward

Up Arrow

No menu entry. Covered by
the tooltip in the menu bar
that appears when you are
in fly mode

Fly Backward

None

3D View / View 3D Fly
Modal / Fly Backward

Down Arrow

No menu entry. Covered by
the tooltip in the menu bar
that appears when you are
in fly mode

Fly Left

None

3D View / View 3D Fly
Modal / Fly Left

Left Arrow

No menu entry. Covered by
the tooltip in the menu bar
that appears when you are
in fly mode

Fly Right

None

3D View / View 3D Fly
Modal / Fly Right

Right Arrow

No menu entry. Covered by
the tooltip in the menu bar
that appears when you are
in fly mode

X Axis Correction

None

3D View / View 3D Fly
Modal / X Axis Correction

X

No menu entry. Covered by
the tooltip in the menu bar
that appears when you are
in fly mode
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3D View - View 3D Fly Modal - Just active in Fly mode navigation. Can be activated in 3D View / View / Navigation / Fly Navigation
X Axis Correction

None

3D View / View 3D Fly
Modal / X Axis Correction

Z

No menu entry. Covered by
the tooltip in the menu bar
that appears when you are
in fly mode

Precision Enable

None

3D View / View 3D Fly
Modal / Precision Enable

Any Left Alt

No menu entry. Covered by
the tooltip in the menu bar
that appears when you are
in fly mode

Precision Disable

None

3D View / View 3D Fly
Modal / Precision Disable

Any Left Alt

No menu entry. Covered by
the tooltip in the menu bar
that appears when you are
in fly mode

Precision Enable

None

3D View / View 3D Fly
Modal / Precision Enable

Any Left Shift

No menu entry. Covered by
the tooltip in the menu bar
that appears when you are
in fly mode

Precision Disable

None

3D View / View 3D Fly
Modal / Precision Disable

Any Left Shift

No menu entry. Covered by
the tooltip in the menu bar
that appears when you are
in fly mode

Rotation Enable

None

3D View / View 3D Fly
Modal / Rotation Enable

Any Left Ctrl

No menu entry. Covered by
the tooltip in the menu bar
that appears when you are
in fly mode

Rotation Disable

None

3D View / View 3D Fly
Modal / Rotation Disable

Any Left Ctrl

No menu entry. Covered by
the tooltip in the menu bar
that appears when you are
in fly mode

3D View - View 3D Rotate Modal
3D View - View 3D Rotate Modal - Needs Investigation! How do we enter this mode?
Function

Surface menu location

User Preferences location

Hotkey

Special note

Confirm

None

3D View / View 3D Rotate
Modal / Confirm

Any MMB

No menu entry.

Confirm

None

3D View / View 3D Rotate
Modal / Confirm

Any Esc

No menu entry.

Enable Axis Snap

None

3D View / View 3D Rotate
Modal / Enable Axis Snap

Any Left Alt

No menu entry.

Disable Axis Snap

None

3D View / View 3D Rotate
Modal / Disable Axis Snap

Any Left Alt

No menu entry.

3D View - View 3D Move Modal
3D View - View 3D Move Modal - Needs Investigation! How do we enter this mode?
Function

Surface menu location

User Preferences location

Hotkey

Special note

Confirm

None

3D View / View 3D Move
Modal / Confirm

Any MMB

No menu entry.

Confirm

None

3D View / View 3D Move
Modal / Confirm

Any Esc

No menu entry.

3D View - View 3D Zoom Modal
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3D View - View 3D Zoom Modal - Needs Investigation! How do we enter this mode?
Function

Surface menu location

User Preferences location

Hotkey

Special note

Confirm

None

3D View / View 3D Zoom
Modal / Confirm

Any MMB

No menu entry.

Confirm

None

3D View / View 3D Zoom
Modal / Confirm

Any Esc

No menu entry.

3D View - View 3D Dolly Modal
3D View - View 3D Dolly Modal - Needs Investigation! How do we enter this mode?
Function

Surface menu location

User Preferences location

Hotkey

Special note

Confirm

None

3D View / View 3D Dolly
Modal / Confirm

Any MMB

No menu entry.

Confirm

None

3D View / View 3D Dolly
Modal / Confirm

Any Esc

No menu entry.

Special note

3D View - 3D View Generic
3D View - 3D View Generic
Function

Surface menu location

User Preferences location

Hotkey

Calls or hides the Properties
sidebar

3D View / View /
Properties

3D View / 3D View Generic /
Properties

Ctrl T

3D View / 3D View Generic /
Tool Shelf

T

Calls or hides the Tool Shelf 3D View / View / Tool
sidebar
Shelf

Graph Editor / Graph Editor (Global)
Graph Editor / Graph Editor (Global)
Function

Surface menu location

User Preferences location

Hotkey

Special note

Set Cursor

None

Graph Editor / Graph Editor
(Global) / Set Cursor

Action Mouse

No menu entry. Mouse only
action

Mouse Select Keys

None

Graph Editor / Graph Editor
(Global) / Mouse Select Keys

Select Mouse

No menu entry. Mouse only
action

Mouse Select Keys

None

Graph Editor / Graph Editor
(Global) / Mouse Select Keys

Alt Select Mouse

No menu entry. Mouse only
action

Mouse Select Keys

None

Graph Editor / Graph Editor
(Global) / Mouse Select Keys

Shift Select Mouse No menu entry. Mouse only
action

Mouse Select Keys

None

Graph Editor / Graph Editor
(Global) / Mouse Select Keys

Shift Alt Select
Mouse

No menu entry. Mouse only
action

Mouse Select Keys

None

Graph Editor / Graph Editor
(Global) / Mouse Select Keys

Ctrl Alt Select
Mouse

No menu entry. Mouse only
action

Mouse Select Keys

None

Graph Editor / Graph Editor
(Global) / Mouse Select Keys

Shift Ctrl Alt
Select Mouse

No menu entry. Mouse only
action

Select Left/Right

None

Graph Editor / Graph Editor
(Global) /

Ctrl Select Mouse

No menu entry. Mouse only
action

Select Left/Right

None

Graph Editor / Graph Editor
(Global) /

Shift Ctrl Select
Mouse

No menu entry. Mouse only
action

Select All

Graph Editor / Select /

Graph Editor / Graph Editor
(Global) / Select All

A
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Graph Editor / Graph Editor (Global)
Invert Selection

Graph Editor / Select /
Invert Selection

Graph Editor / Graph Editor
(Global) / Select All

Ctrl I

Border Select

Graph Editor / Select /
Border Select

Graph Editor / Graph Editor
(Global) / Border Select

B

Lasso Select

None

Graph Editor / Graph Editor
(Global) / Lasso Select

No menu entry. Event
Mapping Tweak

Lasso Select

None

Graph Editor / Graph Editor
(Global) / Lasso Select

No menu entry. Event
Mapping Tweak

Circle Select

Graph Editor / Select /
Circle Select

Graph Editor / Graph Editor
(Global) / Circle Select

G

Select More

Graph Editor / Select /
Select More

Graph Editor / Graph Editor
(Global) / Select More

Ctrl Numpad +

Select Less

Graph Editor / Select /
Select Less

Graph Editor / Graph Editor
(Global) / Select Less

Ctrl Numpad -

Duplicate

Graph Editor / Key /
Duplicate

Graph Editor / Graph Editor
(Global) / Duplicate

Shift D

Insert Keyframes

None

Graph Editor / Graph Editor
(Global) / Click-Insert
Keyframes

Ctrl Action Mouse

Copy Keyframes

Graph Editor / Key / Copy
Keyframes

Graph Editor / Graph Editor
(Global) / Copy Keyframes

Ctrl C

Paste Keyframes

Graph Editor / Key / Paste
Keyframes

Graph Editor / Graph Editor
(Global) / Paste Keyframes

Ctrl V

Paste Keyframes flipped

Graph Editor / Key / Paste
Flipped

Graph Editor / Graph Editor
(Global) / Paste Keyframes

Shift Ctrl V

View All

Graph Editor / View / View Graph Editor / Graph Editor
All
(Global) / View All

View All. Ndof device for
3dConnexion

Home

Graph Editor / Graph Editor
(Global) / View All

NDOF Fit

View Selected

Graph Editor / View / View Graph Editor / Graph Editor
Selected
(Global) / View Selected

Numpad .

View Frame

Graph Editor / View / View Graph Editor / Graph Editor
Frame
(Global) / View Frame

Numpad 0

Translate

Graph Editor / Key /
Translate

W

Translate

None

Rotate

Graph Editor / Key /
Rotate

Graph Editor / Graph Editor
(Global) / Rotate

E

Resize

Graph Editor / Key /
Resize

Graph Editor / Graph Editor
(Global) / Resize

R

Delete Keyframes

Graph Editor / Key /
Delete Keyframes

Graph Editor / Graph Editor
(Global) / Delete Keyframes

Delete

Graph Editor / Graph Editor
(Global) / Translate

No menu entry. Mouse only
action

Cannot test

Event Type Tweak

Graph Editor / Graph Editor Generic
Graph Editor / Graph Editor Generic
Function

Surface menu location

User Preferences location

Hotkey

Opens /closes the Properties Graph Editor / View /
sidebar
Properties

Graph Editor / Graph Editor
Generic / Properties

Ctrl T

Hide selected curve

Graph Editor / Graph Editor
Generic / Hide Curves

H

Graph Editor / Channel /
Hide selected curve
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Graph Editor / Graph Editor Generic
Hide unselected curves

Graph Editor / Channel /
Hide unselected curves

Graph Editor / Graph Editor
Generic / Hide Curves

Shift H

Show all curves

Graph Editor / Channel /
Show all curves

Graph Editor / Graph Editor
Generic / Reveal Curves

Alt H

Dopesheet (Global)
Dopesheet (Global)
Function

Surface menu location

User Preferences location

Hotkey

Special note

Mouse Select Keys

None

Dopesheet (Global) / Mouse
Select Keys

Select Mouse

No menu entry. Mouse only
action

Mouse Select Keys

None

Dopesheet (Global) / Mouse
Select Keys

Alt Select Mouse

No menu entry. Mouse only
action

Mouse Select Keys

None

Dopesheet (Global)/ Mouse
Select Keys

Shift Select Mouse No menu entry. Mouse only
action

Mouse Select Keys

None

Dopesheet (Global)/ Mouse
Select Keys

Shift Alt Select
Mouse

No menu entry. Mouse only
action

Mouse Select Keys

None

Dopesheet (Global)/ Mouse
Select Keys

Ctrl Alt Select
Mouse

No menu entry. Mouse only
action

Mouse Select Keys

None

Dopesheet (Global)/ Mouse
Select Keys

Shift Ctrl Alt
Select Mouse

No menu entry. Mouse only
action

Select Left/Right

None

Dopesheet (Global)/ Mouse
Select Keys

Ctrl Select Mouse

No menu entry. Mouse only
action

Select Left/Right

None

Dopesheet (Global)/ Mouse
Select Keys

Shift Ctrl Select
Mouse

No menu entry. Mouse only
action

Select All

Dope Sheet / Select /
Select All

Dopesheet (Global)/ Select All A

Inverts Selection

Dope Sheet / Select / Invert Dopesheet (Global)/ Select All Ctrl I
Selection

Border Select

Dope Sheet / Select /
Border Select

Dopesheet (Global)/ Border
Select

Lasso Select

???

Dopesheet (Global)/ Lasso
Select

Event Type Tweak

Lasso Select

???

Dopesheet (Global)/ Lasso
Select

Event Type Tweak

Circle Select

Dope Sheet / Select /
Circle Select

Dope Sheet (Global)/ Circle
Select

G

Select more

Dope Sheet / Select /
Select More

Dopesheet (Global)/ Select
More

Ctrl Numpad +

Select less

Dope Sheet / Select /
Select Less

Dopesheet (Global)/ Select
Less

Ctrl Numpad -

Copy Keyframes

Dope Sheet / Key / Copy
Keyframes

Dopesheet (Global)/ Copy
Keyframes

Ctrl C

Paste Keyframes

Dope Sheet / Key / Paste
Keyframes

Dopesheet (Global)/ Paste
Keyframes

Ctrl V

Paste Keyframes flipped?

None

Dopesheet (Global)/ Paste
Keyframes

Shift Ctrl V

View All

Dope Sheet / View / View
All

Dopesheet (Global)/ View All

Home

Dopesheet (Global)/ View All

NDOF Fit

View All. Ndof device for
3dConnexion
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Dopesheet (Global)
View Selected

Dope Sheet / View / View
Selected

Dopesheet (Global)/ View
Selected

Numpad ,

View Frame

Dope Sheet / View / View
Frame

Dopesheet (Global)/ View
Frame

Numpad 0

Calls a Find Channels panel

Dope Sheet / Channel /
Find Channel

Dopesheet (Global)/ Find
Channel

Ctrl F

Grab / Move

Dope Sheet / Key /
Transform

Dopesheet (Global) /
Transform

W

Time Translate

Dopesheet (Global) /
Transform

Event Type Tweak

Extend

Dope Sheet / Key /
Transform

Dopesheet (Global) /
Transform

E

Scale

Dope Sheet / Key /
Transform

Dopesheet (Global) /
Transform

R

Slide

Dope Sheet / Key /
Transform

Dopesheet (Global) /
Transform

Shift T

Delete Keyframes

Dope Sheet / Key / Delete
Keyframes

Dopesheet (Global) / Delete
Keyframes

Delete

User Preferences location

Hotkey

Dopeshet Generic / Properties

Ctrl T

Dopesheet Generic
Dopesheet Generic
Function

Surface menu location

Opens / closes the Properties Dope Sheet / View /
Panel

Special note

NLA Channels / NLA Editor (Global)
NLA Channels / NLA Editor (Global)
Function

Surface menu location

User Preferences location

Hotkey

Special note

Mouse Select Keys

None

NLA Editor / NLA Editor
(Global) / Mouse Select

Select Mouse

No menu entry. Mouse only
action

Mouse Select Keys

None

NLA Editor / NLA Editor
(Global) / Mouse Select

Shift Select Mouse No menu entry. Mouse only
action

Select Left/Right

None

NLA Editor / NLA Editor
(Global) / Select Left/Right

Ctrl Select Mouse

No menu entry. Mouse only
action

Select Left/Right

None

NLA Editor / NLA Editor
(Global) / Select Left/Right

Shift Ctrl Select
Mouse

No menu entry. Mouse only
action

Select All

NLA / Select / Select All

NLA Editor / NLA Editor
(Global) / (De)Select All

A

Inverts Selection

NLA / Select / Invert
Selection

NLA Editor / NLA Editor
(Global) / (De)Select All

Ctrl I

Border Select

NLA / Select / Border
Select

NLA Editor / NLA Editor
(Global) / Border Select

B

View All

NLA / View / View All

NLA Editor / NLA Editor
(Global) / View All

Home

NLA Editor / NLA Editor
(Global) / View All

NDOF Fit

View All. Ndof device for
3dConnexion
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NLA Channels / NLA Editor (Global)
View Selected

View / View Selected

NLA Editor / NLA Editor
(Global) / View Selected

Numpad ,

Delete Strips

NLA / Edit / Delete Strips

NLA Editor / NLA Editor
(Global) / Delete Strips

Delete

Move Strips up

NLA / Edit / Move Strips
up

NLA Editor / NLA Editor
(Global) / Move Strips up

Page Up

Move Strips down

NLA / Edit / Move Strips
down

NLA Editor / NLA Editor
(Global) / Move Strips down

Page Down

Transform

None

NLA Editor / NLA Editor
(Global) / /Transform

Extend

NLA / Edit / Transform /

NLA Editor / NLA Editor
(Global) / /Transform

E

Scale

NLA / Edit / Transform /
Scale

NLA Editor / NLA Editor
(Global) / Transform

R

Transform / Move

NLA / Edit / Transform /
Grab/Move

NLA Editor / NLA Editor
(Global) / Transform

W

Event Mapping Tweak

NLA Channels / NLA Channels
NLA Channels / NLA Channels
Function

Surface menu location

User Preferences location

Hotkey

Special note

Mouse Click on NLA
Channels

None

NLA Editor / NLA Channels / LMB
Mouse Click on NLA Channels

No menu entry. Mouse only
action

Mouse Click on NLA
Channels

None

NLA Editor / NLA Channels / Shift LMB
Mouse Click on NLA Channels

No menu entry. Mouse only
action

Delete

NLA Editor / Edit / Delete
Strips

NLA Editor / NLA Channels /
Delete

Delete

NLA Channels / NLA Generic
NLA Channels / NLA Generic
Function

Surface menu location

User Preferences location

Hotkey

Opens/ Closes the Properties NLA Editor / View /
Sidebar
Properties

NLA Editor / NLA Generic /
Properties

Ctrl T

Exit Tweak Mode.

NLA Editor / Edit / Stop
tweaking Strip Actions

NLA Editor / NLA Generic /
Exit Tweak Mode

Tab

Enter Tweak Mode.

NLA Editor / Edit / Start
tweaking Strip Actions

NLA Editor / NLA Generic /
Enter Tweak Mode

Tab

Exit Tweak Mode. Isolate
Action

NLA Editor / Edit / Stop
tweaking Stashed Action

NLA Editor / NLA Generic /
Exit Tweak Mode

Shift Tab

Enter Tweak Mode. Isolate
Action

NLA Editor / Edit / Start
tweaking Stashed Action

NLA Editor / NLA Generic /
Enter Tweak Mode

Shift Tab

Surface menu location

User Preferences location

Hotkey

Special note

Timeline
Timeline
Function
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Timeline
View All

Timeline / View / View All Timeline / View All

Home

View All. Ndof device for
3dConnexion

None

Timeline / View All

NDOF Fit

Cannot test

Hotkey

Special note

Image / Image (Global)
Image / Image (Global)
Function

Surface menu location

User Preferences location

View All

UV Image Editor / View /
View All

Image / Image (Global) / View Home
All

View Center

UV Image Editor / View /
View Center

Image / Image (Global) / View Numpad ,
Center

Shows when you have a UV
mesh in the editor.

View Pan

None

Image / Image (Global) / View MMB
Pan

No menu entry. Mouse only
action

View Pan

None

Image / Image (Global) / View Shift MMB
Pan

No menu entry. Mouse only
action

View Pan

None

Image / Image (Global) / View Mouse/Trackpad
Pan
Pan

Trackpad for laptops.

View All. Ndof device for
3dConnexion

None

Image / Image (Global) /

NDOF Fit

Cannot test!

NDOF Pan/Zoom. Ndof
device for 3dConnexion

None

Image / Image (Global) /
NDOF Pan/Zoom

NDOF Motion

Cannot test!

View Zoom In

UV/Image Editor / View /
View Zoom In

Image / Image (Global) / View Wheel In
Zoom in

View Zoom Out

UV/Image Editor / View /
View Zoom Out

Image / Image (Global) / View Wheel Out
Zoom Out

View Zoom in

None

Image / Image (Global) / View Numpad +
Zoom in

No menu entry. Double
functionality, see above.

View Zoom Out

None

Image / Image (Global) / View Numpad Zoom Out

No menu entry. Double
functionality, see above.

View Zoom

None

Image / Image (Global) /

Ctrl MMB

View Zoom

None

Image / Image (Global) /

Mouse/Trackpad
Zoom

Trackpad for laptops.

View Zoom

None

Image / Image (Global) /

Ctrl
Mouse/Trackpad
Pan

Trackpad for laptops.

Change Frame.

None

Image / Image (Global) /
Change Frame

Left Mouse

No menu entry. Mouse only
action

Sample Color.

None

Image / Image (Global) /
Sample Color

Action Mouse

No menu entry. Mouse only
action

Set Curves Point.

None

Image / Image (Global) / Set
Curves Point

Ctrl Action Mouse

No menu entry. Mouse only
action

Set Curves Point.

None

Image / Image (Global) / Set
Curves Point

Shift Action Mouse No menu entry. Mouse only
action

Open Image

UV/Image Editor / Image / Image / Image (Global) / Open Ctrl O
Open Image
Image

New Image

UV/Image Editor / Image / Image / Image (Global) / New
New Image
Image

View All

UV/Image Editor / View /
View All

Ctrl N

Image / Image (Global) / View Numpad 0
All

40

Bforartists Reference Manual - © Copyright - This page is Public Domain

Image / UV Editor
Image / UV Editor
Function

Surface menu location

User Preferences location

Hotkey

Special note

Select

None

Image / UV Editor / Select

Select Mouse

No menu entry. Mouse only
action

Select

None

Image / UV Editor / Select

Shift Select Mouse No menu entry. Mouse only
action

Loop Select. No menu item
possible, works with mouse
position

None

Image / UV Editor / Loop
Select

Shift Select Mouse No menu entry. Mouse only
action

Loop Select. No menu item
possible, works with mouse
position

None

Image / UV Editor / Loop
Select

Alt Select Mouse

Border Select

UV/Image Editor / Select / Image / UV Editor /
Border Select

B

Circle Select

UV/Image Editor / Select / Image / UV Editor /
Circle Select

G

Lasso Select

None

Image / UV Editor / Lasso
Select

Event Mapping Tweak

Lasso Select

None

Graph Editor / Graph Editor
(Global) / Lasso Select

Event Mapping Tweak

Select Linked Pick

UV/Image Editor / Select / Image / UV Editor / Select
Linked Pick
Linked Pick

L

Select More

UV/Image Editor / Select / Image / UV Editor / Select
More
More

Ctrl Numpad +

Select Less

UV/Image Editor / Select / Image / UV Editor /
Less

Ctrl Numpad -

Select All

UV/Image Editor / Select / Image / UV Editor / Select All
Select All

A

Hide selected Object

UV/Image Editor / UVs /
Show/Hide Faces / Hide
Selected

Image / UV Editor / Hide
selection

H

Hide unselected Object(s)

UV/Image Editor / UVs /
Show/Hide Faces / Hide
Unselected

Image / UV Editor / Hide
selection

Shift H

Show hidden Objects

UV/Image Editor / UVs /
Show/Hide Faces / Reveal
Hidden

Image / UV Editor / Reveal
Hidden

Alt H

Set 2D Cursor

None

Image / UV Editor /

Action Mouse

Set Tile

None

Image / UV Editor /

Shift Action Mouse No menu entry. Mouse only
action

Translate

UV/Image Editor /
Toolshelf / Transform

Image / UV Editor / Translate

W

Translate

None

Image / UV Editor / Translate

Rotate

UV/Image Editor /
Toolshelf / Transform

Image / UV Editor /

E

Resize

UV/Image Editor /
Toolshelf / Transform

Image / UV Editor /

R

Mirror

None

Image / UV Editor /

Ctrl M

Inverts Selection

UV/Image Editor / Select / Image / UV Editor / Select All
Invert Selection

41

No menu entry. Mouse only
action

No menu entry. Mouse only
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Event mapping Tweak
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Image / UV Editor
Select Linked Pick

UV/Image Editor / Select / Image / UV Editor / Select
Linked Pick Extend
Linked Pick

Shift L

Image / Image Paint
Image / Image Paint
Function

Surface menu location

User Preferences location

Hotkey

Special note

Image Paint

None

Image / Image Paint / Image
Paint

LMB

No menu entry. Mouse only
action

Image Paint

None

Image / Image Paint / Image
Paint

Ctrl LMB

No menu entry. Mouse only
action

Brush Colors Flip. Toggles
the current colour

Tool Shelf / Paint / Toggle Image / Image Paint / Brush
Fouregrou8nd and
Colors Flip
Background Brush colours.

X

Grab Clone

None

RMB

Sample Color

UV/IMage Editor / Sidebar Image / Image Paint / Sample
/ Paint
Color

S

Radial Control

UV/IMage Editor / Sidebar Image / Image Paint / Radial
/ Paint
Control

F

Radial Control

UV/IMage Editor / Sidebar Image / Image Paint / Radial
/ Paint
Control

Shift F

Radial Control

UV/IMage Editor / Sidebar Image / Image Paint / Radial
/ Paint
Control

Ctrl F

Radial Control

UV/IMage Editor / Sidebar Image / Image Paint / Radial
/ Paint
Control

Ctrl Alt F

Stencil Brush control

UV/IMage Editor / Sidebar Image / Image Paint / Stencil
/ Texture Mask with Mask Brush control
Mapping Stencil

Shift Ctrl RMB

Stencil Brush control

UV/IMage Editor / Sidebar Image / Image Paint / Stencil
/ Texture Mask with Mask Brush control
Mapping Stencil

Shift RMB

Stencil Brush control

UV/IMage Editor / Sidebar Image / Image Paint / Stencil
/ Texture Mask with Mask Brush control
Mapping Stencil

Ctrl RMB

Stencil Brush control

UV/IMage Editor / Sidebar Image / Image Paint / Stencil
/ Texture Mask with Mask Brush control
Mapping Stencil

Alt RMB

Stencil Brush control

UV/IMage Editor / Sidebar Image / Image Paint / Stencil
/ Texture Mask with Mask Brush control
Mapping Stencil

Shift Alt RMB

Stencil Brush control

UV/IMage Editor / Sidebar Image / Image Paint / Stencil
/ Texture Mask with Mask Brush control
Mapping Stencil

Ctrl Alt RMB

Image / Image Paint / Grab
Clone

No menu entry. Mouse only
action

Image / UV Sculpt
Image / UV Sculpt
Function

Surface menu location

User Preferences location

Hotkey

Special note

Sculpt UVs

None

Image / UV Sculpt / Sculpt
UVs

LMB

No menu entry. Mouse only
action
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Image / UV Sculpt
Sculpt UVs

None

Image / UV Sculpt / Sculpt
UVs

Ctrl LMB

No menu entry. Mouse only
action

Sculpt UVs

None

Image / UV Sculpt / Sculpt
UVs

Shift LMB

No menu entry. Mouse only
action

Radial Control for
UV/Image Editor in UV
Sculpt Mode

None

Image / UV Sculpt / Radial
Control

F

No menu entry. Deserves a
hint somewhere, but
important hotkey tool is 3D
view only.

Radial Control for
UV/Image Editor in UV
Sculpt Mode

None

Image / UV Sculpt / Radial
Control

Shift F

No menu entry. Deserves a
hint somewhere, but
important hotkey tool is 3D
view only.

Special note

Image / Image generic
Image / Image generic
Function

Surface menu location

User Preferences location

Hotkey

New Image

UV/Image Editor/ Image /
New Image

Image / Image generic / New
Image

Ctrl N

Open Image

UV/Image Editor/ View /
Open Image

Image / Image generic / Open
Image

Ctrl O

Save Image

UV/Image Editor/ Image /
Save Image

Image / Image generic / Save
Image

Ctrl S

Properties

UV/Image Editor/ View /
Properties

Image / Image generic /
Properties

N

Tool Shelf

UV/Image Editor/ View /
Tool Shelf

Image / Image generic / Tool
Shelf

T

Function

Surface menu location

User Preferences location

Hotkey

Special note

Rename Item

None

Outliner / Rename Item

double-LMB

No menu entry. Mouse
Only action

Activate Item

Outliner / Activate Item

LMB

No menu entry. Mouse
Only action

Activate Item

Outliner / Activate Item

Shift LMB

No menu entry. Mouse
Only action

Activate Item

Outliner / Activate Item

Ctrl LMB

No menu entry. Mouse
Only action

Activate Item

Outliner / Activate Item

Shift Ctrl LMB

No menu entry. Mouse
Only action

Outliner / Border Select

B

Open/Close Item

Outliner / Open/Close Item

Return

No menu entry.

Open/Close Item

Outliner / Open/Close Item

Shift Return

No menu entry.

Rename Item

Outliner / Rename Item

Ctrl LMB

No menu entry. Mouse
Only action

Calls a RMB menu

Outliner / Execute Operation

RMB

No menu entry. Mouse
Only action

Outliner
Outliner

Border Select

Outliner / View / Border
Select
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Outliner
Scroll Page

Outliner / Scroll Page

Page Down

No menu entry.

Scroll Page

Outliner / Scroll Page

Page Up

No menu entry.

A

Toggle Selected

Outliner / View / Toggle
Selected

Outliner / Toggle Selected

Expand/Collapse All

Outliner / View / Expand/
Collapse All

Outliner / Expand/Collapse All Shift A

Node Editor / Node Editor Global
Node Editor / Node Editor Global
Function

Surface menu location

User Preferences location

Hotkey

Special note

Select

None

Node Editor / Node Editor
Global / Select

Action Mouse

No menu entry. Mouse
Only action

Select

None

Node Editor / Node Editor
Global / Select

Select Mouse

No menu entry. Mouse
Only action

Select

None

Node Editor / Node Editor
Global / Select

Ctrl Action Mouse

No menu entry. Mouse
Only action

Select

None

Node Editor / Node Editor
Global / Select

Ctrl Select Mouse

No menu entry. Mouse
Only action

Select

None

Node Editor / Node Editor
Global / Select

Alt Action Mouse

No menu entry. Mouse
Only action

Select

None

Node Editor / Node Editor
Global / Select

Alt Select Mouse

No menu entry. Mouse
Only action

Select

None

Node Editor / Node Editor
Global / Select

Ctrl Alt Action
Mouse

No menu entry. Mouse
Only action

Select

None

Node Editor / Node Editor
Global / Select

Ctrl Alt Select
Mouse

No menu entry. Mouse
Only action

Select

None

Node Editor / Node Editor
Global / Select

Shift Action Mouse No menu entry. Mouse
Only action

Select

None

Node Editor / Node Editor
Global / Select

Shift Select Mouse No menu entry. Mouse
Only action

Select

None

Node Editor / Node Editor
Global / Select

Shift Ctrl Action
Mouse

No menu entry. Mouse
Only action

Select

None

Node Editor / Node Editor
Global / Select

Shift Ctrl Select
Mouse

No menu entry. Mouse
Only action

Select

None

Node Editor / Node Editor
Global / Select

Shift Alt Action
Mouse

No menu entry. Mouse
Only action

Select

None

Node Editor / Node Editor
Global / Select

Shift Alt Select
Mouse

No menu entry. Mouse
Only action

Select

None

Node Editor / Node Editor
Global / Select

Shift Ctrl Alt
Action Mouse

No menu entry. Mouse
Only actionCrazy Hotkey.
But probably not to solve in
another way.

Select

None

Node Editor / Node Editor
Global / Select

Shift Ctrl Alt
Select Mouse

No menu entry. Mouse
Only actionCrazy Hotkey.
But probably not to solve in
another way.

Border Select

None

Node Editor / Node Editor
Global / Border Select

Event Mapping Tweak

Lasso Select

None

Node Editor / Node Editor
Global / Lasso Select

Event Mapping Tweak

Lasso Select

None

Node Editor / Node Editor
Global / Lasso Select

Event Mapping Tweak
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Node Editor / Node Editor Global
Circle Select

Node Editor / Select /
Circle Select

Node Editor / Node Editor
Global / Circle Select

G

Link Nodes

None

Node Editor / Node Editor
Global / Link Nodes

LMB

No menu entry. Mouse
Only action

Link Nodes

None

Node Editor / Node Editor
Global / Link Nodes

Ctrl LMB

No menu entry. Mouse
Only action

Resize Node

None

Node Editor / Node Editor
Global / Resize Node

LMB

No menu entry. Mouse
Only action

Cut Links

None

Node Editor / Node Editor
Global / Cut Links

Ctrl LMB

No menu entry. Mouse
Only action

Link Viewer

None

Node Editor / Node Editor
Global / Link Viewer

Shift Ctrl LMB

No menu entry. Mouse
Only action

Background Image Move

None

Node Editor / Node Editor
Global /

Alt MMB

No menu entry. Mouse
Only action

Background Image Zoom

Node Editor / View /
Backdrop / Zoom Out

Node Editor / Node Editor
Global / Background Image
Zoom

V

Background Image Zoom

Node Editor / View /
Backdrop / Zoom In

Node Editor / Node Editor
Global / Background Image
Zoom

Alt V

Background Image Fit

Node Editor / View /
Backdrop / Fit Backdrop

Node Editor / Node Editor
Alt Home
Global / Background Image Fit

Displays the colour
None
information of the
Background Image under the
current mouse position.
Position, RGB Values, HSV,
etc.

Node Editor / Node Editor
Global / Backimage Sample

Alt Action Mouse

Duplicate

Node Editor / Node /
Duplicate

Node Editor / Node Editor
Global / Duplicate

Shift D

Duplicate with keep inputs

Node Editor / Node /
Duplicate Keep Input

Node Editor / Node Editor
Global / Duplicate

Shift Ctrl D

Hide

Node Editor / Node / Hide

Node Editor / Node Editor
Global / Hide

H

Toggle Node Preview

Node Editor / Node /
Toggle Node Preview

Node Editor / Node Editor
Global / Toggle Node Preview

Shift H

Toggle Hidden Node
Sockets

Node Editor / Node /
Toggle Hidden Node
Sockets

Node Editor / Node Editor
Global / Toggle Hidden Node
Sockets

Ctrl H

View All

Node Editor / View / View
All

Node Editor / Node Editor
Global / View All

Home

View All. Ndof device for
3dConnexion

Node Editor / View / View
All

Node Editor / Node Editor
Global / View All

Ndof Fit

View Selected

Node Editor / View / View
Selected

Node Editor / Node Editor
Global / View Selected

Numpad ,

Border Select

Node Editor / Select /
Border Select

Node Editor / Node Editor
Global / Border Select

B

Delete

Node Editor / Node /
Delete

Node Editor / Node Editor
Global / Delete

Delete

(De)select all

Node Editor / Select /
(De)select all

Node Editor / Node Editor
Global / (De)select all

A

Invert Selection

Node Editor / Select /
Inverse

Node Editor / Node Editor
Global / (De)select all

Ctrl I

Copy to Clipboard

Node Editor / Node / Copy Node Editor / Node Editor
Global / Copy to Clipboard
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Node Editor / Node Editor Global
Paste from Clipboard

Node Editor / Node / Paste Node Editor / Node Editor
Global / Paste from Clipboard

Ctrl V

Move and Attach

Node Editor / Node /
Translate

Node Editor / Node Editor
Global / Move and Attach

W

Move and Attach

None

Node Editor / Node Editor
Global / Move and Attach

Event mapping tweak

Move and Attach

None

Node Editor / Node Editor
Global / Move and Attach

Event mapping tweak

Translate

None

Node Editor / Node Editor
Global / Translate

Event mapping tweak

Translate

None

Node Editor / Node Editor
Global / Translate

Event mapping tweak

Rotate

Node Editor / Node /
Rotate

Node Editor / Node Editor
Global / Rotate

E

Resize

Node Editor / Node /
Resize

Node Editor / Node Editor
Global / Resize

R

Detach

Node Editor / Node /
Detach Linked Move

Node Editor / Node Editor
Global / Detach

Alt D

Detach

None

Node Editor / Node Editor
Global / Detach

Event mapping tweak

Detach

None

Node Editor / Node Editor
Global / Detach

Event mapping tweak

Translate

Node Editor / Node /
Translate

Node Editor / Node Editor
Global / Translate

W

User Preferences location

Hotkey

Calls or closes the Properties Node Editor / View /
panel
Properties

Node Editor / Node Editor
Generic / Properties

Ctrl T

Calls or closes the Tool
Shelf panel

Node Editor / Node Editor
Generic / Tool Shelf

T

Node Editor / Generic
Node Editor / Generic
Function

Surface menu location

Node Editor / View / Tool
Shelf

Special note

Sequencer / Sequencer (Global)
Sequencer / Sequencer (Global) - NOTE THAT I WILL NOT FIX THE VIDEO EDITING STUFF! Video editing module is deprecated. It is
still available. But Bforartists does not offer any support for it.
The red marked hotkeys in this seciton are just marked for the very unlikely case that we really spend the time to change anyhting here
Function

Surface menu location

User Preferences location

Hotkey

(De)select all

Sequencer / Select/
(De)select all

Sequencer / Sequencer
(Global) / De)select all

A

Inverse

Sequencer / Select /
Inverse

Sequencer / Sequencer
(Global) / De)select all

Ctrl I

Un-Mute Strips

None

Sequencer / Sequencer
(Global) / Un-Mute Strips

Shift Alt H

Duplicate Strips

Sequencer / Strip /
Duplicate Strips

Sequencer / Sequencer
(Global) / Duplicate Strips

Shift D

Erase Strips

Sequencer / Strip / Erase
Strips

Sequencer / Sequencer
(Global) / Erase Strips

Delete
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Copy

None

Sequencer / Sequencer
(Global) /

Ctrl C

Remove Icons in Menu bar.
Needs Menu entry!

Paste

None

Sequencer / Sequencer
(Global) /

Ctrl V

Remove Icons in Menu bar.
Needs Menu entry!

Toggle Meta Strips. What
metastrips? What does this
do?

None

Sequencer / Sequencer
(Global) /

Tab

Needs Investigation!

View All

Sequencer / View / View
All

Sequencer / Sequencer
(Global) /

Home

View All . Ndof device for
3dConnexion

None

Sequencer / Sequencer
(Global) /

NDOF Fit

View Selected

Sequencer / View / View
Selected

Sequencer / Sequencer
(Global) /

Numpad ,

Jump to Strip

None

Sequencer / Sequencer
(Global) /

Page Up

Needs Menu entry!

Jump to Strip

None

Sequencer / Sequencer
(Global) /

Page Down

Needs Menu entry!

Jump to Strip

None

Sequencer / Sequencer
(Global) /

Alt Page Up

Needs Menu entry!

Jump to Strip

None

Sequencer / Sequencer
(Global) /

Alt Page Down

Needs Menu entry!

Remove Gaps. What gaps?

None

Sequencer / Sequencer
(Global) /

Shift Back Space

Needs Investigation! Needs
Menu entry!

Cut Multicam. What does
this do?

None

Sequencer / Sequencer
(Global) / Cut Multicam

1

Needs Investigation! Needs
Menu entry!

Cut Multicam. What does
this do?

None

Sequencer / Sequencer
(Global) / Cut Multicam

2

Needs Investigation! Needs
Menu entry!

Cut Multicam. What does
this do?

None

Sequencer / Sequencer
(Global) / Cut Multicam

3

Needs Investigation! Needs
Menu entry!

Cut Multicam. What does
this do?

None

Sequencer / Sequencer
(Global) / Cut Multicam

4

Needs Investigation! Needs
Menu entry!

Cut Multicam. What does
this do?

None

Sequencer / Sequencer
(Global) / Cut Multicam

5

Needs Investigation! Needs
Menu entry!

Cut Multicam. What does
this do?

None

Sequencer / Sequencer
(Global) / Cut Multicam

6

Needs Investigation! Needs
Menu entry!

Cut Multicam. What does
this do?

None

Sequencer / Sequencer
(Global) / Cut Multicam

7

Needs Investigation! Needs
Menu entry!

Cut Multicam. What does
this do?

None

Sequencer / Sequencer
(Global) / Cut Multicam

8

Needs Investigation! Needs
Menu entry!

Cut Multicam. What does
this do?

None

Sequencer / Sequencer
(Global) / Cut Multicam

9

Needs Investigation! Needs
Menu entry!

Cut Multicam. What does
this do?

None

Sequencer / Sequencer
(Global) / Cut Multicam

0

Needs Investigation! Needs
Menu entry!

Activate/Select

None

Sequencer / Sequencer
(Global) / Activate/Select

Select Mouse

Activate/Select

None

Sequencer / Sequencer
(Global) / Activate/Select

Shift Select Mouse

Activate/Select

None

Sequencer / Sequencer
(Global) / Activate/Select

Alt Select Mouse

Activate/Select

None

Sequencer / Sequencer
(Global) / Activate/Select

Shift Alt Select
Mouse
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Activate/Select

None

Sequencer / Sequencer
(Global) / Activate/Select

Ctrl Select Mouse

Activate/Select

None

Sequencer / Sequencer
(Global) / Activate/Select

Shift Ctrl Select
Mouse

Select more

Sequencer/ Select / Select
More

Sequencer / Sequencer
(Global) / Select More

Ctrl Numpad +

Select less

Sequencer / Select / Select
Less

Sequencer / Sequencer
(Global) / Select Less

Ctrl Numpad -

Select Pick Linked

???

Sequencer / Sequencer
(Global) / Select Pick Linked

L

Hotkey is NOT from the
menu item Select Linked.
Needs Investigation

Select Pick Linked

???

Sequencer / Sequencer
(Global) / Select Pick Linked

Shift L

Hotkey is NOT from the
menu item Select Linked.
Needs Investigation. Needs
Menu entry.

Border Select

None

Sequencer / Sequencer
(Global) / Border Select

B

Needs Menu entry.

Context Set. What?

None

Sequencer / Sequencer
(Global) / Context Set

O

Needs Menu entry. Needs
Investigation

Sequence Slide. Grabs the
current active clip and
moves it with the mouse.
Why? You can click at the
clip and do the same. Odd
double functionality.

None

Sequencer / Sequencer
(Global) / Sequence Slide.

G

Needs Investigationg

Sequence Slide

None

Sequencer / Sequencer
(Global) / Sequence Slide

Event Mapping Tweak

Sequencer / SequencerCommon
Sequencer / SequencerCommon
Function

Surface menu location

User Preferences location

Hotkey

Opens or closes the
Properties sidebar

Sequencer / View /
Properties

Sequencer / SequencerGlobal / Ctrl T
Properties

Special note

Sequencer / SequencerPreview
Sequencer / SequencerPreview
Function

Surface menu location

User Preferences location

Hotkey

View All

None

Sequencer /
SequencerPreview / View All

Home

View All . Ndof device for
3dConnexion

None

Sequencer /
SequencerPreview / View All

NDOF Fit

Cannot test

Border Offset View Does
nothing? In what mode?

None

Sequencer /
SequencerPreview / Border
Offset View

O

Needs Investigation

Sets sequencer View Zoom
Ratio to 1:1

None

Sequencer /
Numpad 1
SequencerPreview / Sequencer
View Zoom Ratio
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Special note

Different ratios Needs Menu
entry. They have for other
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Sequencer / SequencerPreview
Displays the colour values
under the mouse when
holding action mouse and
hovering over the movie

None

Sequencer /
SequencerPreview / Sample
Color

Action Mouse

Logic Editor
Logic Editor - Note that the Logic Editor as part of the Game Engine is not officially supported by Bforartists.
Function

Surface menu location

User Preferences location

Hotkey

Properties

???

Logic Editor / Properties

Ctrl T

Cut Links

???

Logic Editor / Cut Links

Ctrl LMB

Calls a Menu

???

Logic Editor / Call Menu

Shift A

View All

???

Logic Editor / View All

Home (pos1)

View All

???

Logic Editor / View All

NDOF Fit

Special note

File Browser / File Browser (Global)
File Browser / File Browser (Global)
Function

Surface menu location

User Preferences location

Hotkey

Special note

Delete selected Files

None

File Browser / File Browser
(Global) /

Delete

No menu entry. Hotkey only
functionality

Smooth Scroll
Toggles the sidebar

File Browser / File Browser
(Global) /
File Browser / Select /
Toggle Bookmarks

File Browser / File Browser
(Global) /

No menu entry. Event
Mapping Timer
T

File Browser / File Browser Main
File Browser / File Browser Main
Function

Surface menu location

User Preferences location

Hotkey

Special note

Execute File Window

None

File Browser / File Browser
Main / Execute File Window

double-LMB

No menu entry. Mouse
Only action

Activate/Select File

None

File Browser / File Browser
Main / Activate/Select File

LMB

No menu entry. Mouse
Only action

Activate/Select File

None

File Browser / File Browser
Main / Activate/Select File

Shift LMB

No menu entry. Mouse
Only action

Activate/Select File

None

File Browser / File Browser
Main /

Shift Ctrl LMB

No menu entry. Mouse
Only action

Activate/Select File

None

File Browser / File Browser
Main /

RMB

No menu entry. Mouse
Only action

Activate/Select File

None

File Browser / File Browser
Main /

Shift RMB

No menu entry. Mouse
Only action

Activate/Select File

None

File Browser / File Browser
Main /

Alt RMB

No menu entry. Mouse
Only action

Walk Select/Deselect File

None

File Browser / File Browser
Main / Walk Select/Deselect
File

Up Arrow

Needs Menu entry!
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File Browser / File Browser Main
Walk Select/Deselect File

None

File Browser / File Browser
Main / Walk Select/Deselect
File

Shift Up Arrow

Needs Menu entry!

Walk Select/Deselect File

None

File Browser / File Browser
Main / Walk Select/Deselect
File

Shift Ctrl Up
Arrow

Needs Menu entry!

Walk Select/Deselect File

None

File Browser / File Browser
Main / Walk Select/Deselect
File

Down Arrow

Needs Menu entry!

Walk Select/Deselect File

None

File Browser / File Browser
Main / Walk Select/Deselect
File

Shift Down Arrow

Needs Menu entry!

Walk Select/Deselect File

None

File Browser / File Browser
Main / Walk Select/Deselect
File

Shift Ctrl Down
Arrow

Needs Menu entry!

Walk Select/Deselect File

None

File Browser / File Browser
Main / Walk Select/Deselect
File

Left Arrow

Needs Menu entry!

Walk Select/Deselect File

None

File Browser / File Browser
Main / Walk Select/Deselect
File

Shift Left Arrow

Needs Menu entry!

Walk Select/Deselect File

None

File Browser / File Browser
Main / Walk Select/Deselect
File

Shift Ctrl Left
Arrow

Needs Menu entry!

Walk Select/Deselect File

None

File Browser / File Browser
Main / Walk Select/Deselect
File

Right Arrow

Needs Menu entry!

Walk Select/Deselect File

None

File Browser / File Browser
Main / Walk Select/Deselect
File

Shift Right Arrow

Needs Menu entry!

Walk Select/Deselect File

None

File Browser / File Browser
Main / Walk Select/Deselect
File

Shift Ctrl Right
Arrow

Needs Menu entry!

(De)select all files

File Browser / Select /
(De)select all files

File Browser / File Browser
Main /

A

Activate/Select File

File Browser / Select /
Border Select

File Browser / File Browser
Main / Activate/Select File

B

Activate/Select File

None

File Browser / File Browser
Main / Activate/Select File

Rename File or Directory

None

File Browser / File Browser
Main / Rename File or
Directory

Ctrl LMB

Highlight File

None

File Browser / File Browser
Main / Highlight File

Any Mouse Move

Increment Number in
Filename by 1

The little + button left from File Browser / File Browser
the cancel button
Main /

Numpad +

Increment Number in
Filename by 10

None

File Browser / File Browser
Main / Increment Number in
Filename

Shift Numpad +

No menu entry. So rarely
used, doesn't really deserve
a menu entry.

Increment Number in
Filename by 100

None

File Browser / File Browser
Main / Increment Number in
Filename

Ctrl Numpad +

No menu entry. So rarely
used, doesn't really deserve
a menu entry.

Decrease Number in
Filename by 1

The little - button left from File Browser / File Browser
the cancel button
Main / Increment Number in
Filename
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File Browser / File Browser Main
Decrease Number in
Filename by 10

None

File Browser / File Browser
Main / Increment Number in
Filename

Shift Numpad -

No menu entry. So rarely
used, doesn't really deserve
a menu entry.

Decrease Number in
Filename by 100

None

File Browser / File Browser
Main / Increment Number in
Filename

Ctrl Numpad -

No menu entry. So rarely
used, doesn't really deserve
a menu entry.

Hotkey

Special note

File Browser / File Browser Buttons
File Browser / File Browser Buttons
Function

Surface menu location

User Preferences location

Increment Number in
Filename by 1

Filebrowser ,the tiny plus File Browser / File Browser
button besides the edit box Buttons /

Increment Number in
Filename by 10

None

File Browser / File Browser
Shift Numpad +
Buttons / Increment Number in
Filename

No menu entry. So rarely
used, doesn't really deserve
a menu entry.

Increment Number in
Filename by 100

None

File Browser / File Browser
Ctrl Numpad +
Buttons / Increment Number in
Filename

No menu entry. So rarely
used, doesn't really deserve
a menu entry.

Decrease Number in
Filename by 1

Filebrowser ,the tiny minus File Browser / File Browser
Numpad button besides the edit box Buttons / Increment Number in
Filename

Decrease Number in
Filename by 10

None

File Browser / File Browser
Shift Numpad Buttons / Increment Number in
Filename

No menu entry. So rarely
used, doesn't really deserve
a menu entry.

Decrease Number in
Filename by 100

None

File Browser / File Browser
Ctrl Numpad Buttons / Increment Number in
Filename

No menu entry. So rarely
used, doesn't really deserve
a menu entry.

Numpad +

Info
Info - Those items would deserve a menu entry. But the menu bar is used as the general file bar. And so the menu items for the Info area would
be confusing since the Info area is hidden by default.
Function

Surface menu location

User Preferences location

Hotkey

Special note

Select Report

None

File / Select Report

Select Mouse

No menu entry. Mouse
Only action

Selects or deselects all text

None

File / (De)select all

A

No menu entry. See above.

Brings up a rectangle select

None

File / Border Select

B

No menu entry. See above.

Replay Operator.

None

File / Replay Operator.

R

No menu entry. See above.

Delete Reports

None

File / Delete Reports

Delete

No menu entry. See above.

Copy Reports to Clipboard

None

File / Copy Reports to
Clipboard

Ctrl C

No menu entry. See above.

Property Editor
Property Editor
Function

Surface menu location

User Preferences location

Hotkey

Special note

Opens a rmb menu where
you can select to arrage the
properties horizontally or
vertically

None

Property Editor / Toolbox

RMB

No menu entry. Mouse
Only action
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Text / Text (Global)
Text / Text (Global)
Function

Surface menu location

User Preferences location

Hotkey

Special note

Context Int Cycle

None

Text / Text (Global) / Context
Int Cycle

Ctrl Wheel Up

No menu entry. Common
Text editor Hotkeys

Context Int Cycle

None

Text / Text (Global) / Context
Int Cycle

Ctrl Wheel Down

No menu entry. Common
Text editor Hotkeys

Context Int Cycle

None

Text / Text (Global) / Context
Int Cycle

Ctrl Numpad +

No menu entry. Common
Text editor Hotkeys

Context Int Cycle

None

Text / Text (Global) / Context
Int Cycle

Ctrl Numpad -

No menu entry. Common
Text editor Hotkeys

Create Text Block

Text / Text / Create Text
Block

Text / Text (Global) / Create
Text Block

Ctrl N

Open Text Block

Text / Text / Open Text
Block

Text / Text (Global) / Open
Text Block

Alt O

Reload

Text / Text / Reload

Text / Text (Global) / Reload

Alt R

Save

Text / Text / Save

Text / Text (Global) / Save

Alt S

Save As

Text / Text / Save As

Text / Text (Global) / Save As

Shift Crtl S

Run Script

Text / Text / Run Script

Text / Text (Global) / Run
Script

Alt P

Cut

Text / Edit / Cut

Text / Text (Global) / Cut

Ctrl X

Copy

Text / Edit / Copy

Text / Text (Global) / Copy

Ctrl C

Paste

Text / Edit / Paste

Text / Text (Global) / Paste

Ctrl V

Duplicate Line

Text / Edit / Duplicate Line Text / Text (Global) / Duplicate Ctrl D
Line

Select All

Text / Edit / Select All

Text / Text (Global) / Select All Ctrl A

Selects the whole Line.

Text / Edit / Select Line

Text / Text (Global) / Select
Line

Shift Ctrl A

Select Word

None

Text / Text (Global) / Select
Word

double-LMB

Move selected Lines up

Text / Edit / Move Line(s)
up

Text / Text (Global) / Move
Lines

Shift Ctrl Up
Arrow

Move selected Lines down

Text / Edit / Text / Edit /
Move Line(s) up

Text / Text (Global) / Move
Lines

Shift Ctrl Down
Arrow

Indent

Text / Format / Indent

Text / Text (Global) / Indent

Tab

Unindent

Text / Format / Unindent

Text / Text (Global) / Unindent Shift Tab

Move Cursor to start of line

None

Text / Text (Global) / Move
Cursor

Home

No menu entry. Common
Text editor Hotkeys

Move Cursor to end of line

None

Text / Text (Global) / Move
Cursor

End

No menu entry. Common
Text editor Hotkeys

Move Cursor to the right

None

Text / Text (Global) / Move
Cursor

Left Arrow

No menu entry. Common
Text editor Hotkeys

Move Cursor to the left

None

Text / Text (Global) / Move
Cursor

Right Arrow

No menu entry. Common
Text editor Hotkeys

Move Cursor to the right by
word space

None

Text / Text (Global) / Move
Cursor

Ctrl Left Arrow

No menu entry. Common
Text editor Hotkeys

Move Cursor to the left by
word space

None

Text / Text (Global) / Move
Cursor

Ctrl Right Arrow

No menu entry. Common
Text editor Hotkeys
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Text / Text (Global)
Move Cursor to line above

None

Text / Text (Global) / Move
Cursor

Up Arrow

No menu entry. Common
Text editor Hotkeys

Move Cursor to line below

None

Text / Text (Global) / Move
Cursor

Down Arrow

No menu entry. Common
Text editor Hotkeys

Move Cursor up by text
height

None

Text / Text (Global) / Move
Cursor

Page Up

No menu entry. Common
Text editor Hotkeys

Move Cursor down by text
height

None

Text / Text (Global) / Move
Cursor

Page Down

No menu entry. Common
Text editor Hotkeys

Move Cursor to start of text

None

Text / Text (Global) / Move
Cursor

Ctrl Home

No menu entry. Common
Text editor Hotkeys

Move Cursor to end of text

None

Text / Text (Global) / Move
Cursor

Ctrl End

No menu entry. Common
Text editor Hotkeys

Select Text of line before the None
caret

Text / Text (Global) / Move
Select

Shift Home

No menu entry. Common
Text editor Hotkeys

Select Text of line after the
caret

None

Text / Text (Global) / Move
Select

Shift End

No menu entry. Common
Text editor Hotkeys

Expands the text selection to None
the left

Text / Text (Global) / Move
Select

Shift Left Arrow

No menu entry. Common
Text editor Hotkeys

Expands the text selection to None
the right

Text / Text (Global) / Move
Select

Shift Right Arrow

No menu entry. Common
Text editor Hotkeys

Expands the text selection to None
the left by word space

Text / Text (Global) / Move
Select

Shift Ctrl Left
Arrow

No menu entry. Common
Text editor Hotkeys

Expands the text selection to None
the right by words space

Text / Text (Global) / Move
Select

Shift Ctrl Right
Arrow

No menu entry. Common
Text editor Hotkeys

Expands the text selection
upwards by one line

None

Text / Text (Global) / Move
Select

Shift Up Arrow

No menu entry. Common
Text editor Hotkeys

Expands the text selection
downwards by one line

None

Text / Text (Global) / Move
Select

Shift Down Arrow

No menu entry. Common
Text editor Hotkeys

Expands the text selection
upwards by the width of the
text window

None

Text / Text (Global) / Move
Select

Shift Page Up

No menu entry. Common
Text editor Hotkeys

Expands the text selection
downwards by the width of
the text window

None

Text / Text (Global) / Move
Select

Shift Page Down

No menu entry. Common
Text editor Hotkeys

Expands the text selection
upwards to the start of the
text

None

Text / Text (Global) / Move
Select

Shift Ctrl Home

No menu entry. Common
Text editor Hotkeys

Expands the text selection
None
downwards to the end of the
text

Text / Text (Global) / Move
Select

Shift Ctrl End

No menu entry. Common
Text editor Hotkeys

Deletes selection / next
character

Text Editor / Edit / Delete / Text / Text (Global) / Delete
Next Character

Delete

Deletes selection / deletes
previous character

Text Editor / Edit / Delete / Text / Text (Global) / Delete
Previous Character

Back Space

Deletes next word

Text Editor / Edit / Delete / Text / Text (Global) / Delete
Next Word

Ctrl Delete

Deletes previous word

Text Editor / Edit / Delete / Text / Text (Global) / Delete
Previous Word

Ctrl Back Space

Toggle Overwrite

None

Text / Text (Global) /

Insert

Scrollbar

None

Text / Text (Global) / Scrollbar LMB

No menu entry. Mouse
Only action

Scrollbar

None

Text / Text (Global) / Scrollbar MMB

No menu entry. Mouse
Only action
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Text / Text (Global)
Scroll

None

Text / Text (Global) / Scroll

MMB

No menu entry. Mouse
Only action

Scroll

None

Text / Text (Global) / Scroll

Mouse Trackpad
Pan

Set Selection

None

Text / Text (Global) / Set
Selection

Set Cursor

None

Text / Text (Global) / Set
Cursor

LMB

No menu entry. Mouse
Only action

Set Selection

None

Text / Text (Global) / Set
Selection

Shift LMB

No menu entry. Mouse
Only action

Scroll

None

Text / Text (Global) / Scroll

Wheel Up

No menu entry. Common
Text editor Hotkeys

Scroll

None

Text / Text (Global) / Scroll

Wheel Down

No menu entry. Common
Text editor Hotkeys

Line Break

None

Text / Text (Global) / Line
Break

Return

No menu entry. Common
Text editor Hotkeys

Line Break

None

Text / Text (Global) / Line
Break

Numpad Enter

No menu entry. Common
Text editor Hotkeys

Text Auto Complete

None

Text / Text (Global) / Text Auto Ctrl Spacebar
Complete

No menu entry. Common
Text editor Hotkeys

Line Number

None

Text / Text (Global) / Line
Number

Event Mapping Text Input

insert

None

Text / Text (Global) / insert

Event Mapping Text Input

Event Mapping Tweak

Text / Text Generic
Text / Text Generic
Function

Surface menu location

User Preferences location

Hotkey

Find

Text / Edit / Find

Text / Text Generic / Find

Ctrl F

Properties

Text / View / Properties

Text / Text Generic / Properties Ctrl T

Surface menu location

User Preferences location

Hotkey

Move Cursor Previous Word Console / Edit / Cursor to
Previous Word

Console / Move Cursor

Ctrl Left Arrow

Move Cursor Next Word

Console / Edit / Cursor to
Next Word

Console / Move Cursor

Ctrl Right Arrow

Move Cursor Line Begin

Console / Edit / Cursor to
Line Begin

Console / Move Cursor

Home

Move Cursor Line End

Console / Edit / Cursor to
Line End

Console / Move Cursor

End

Scale text up

Console / Edit / Zoom Text Console / Context Int Cycle
out

Ctrl Wheel Up

Scale text down

Console / Edit / Zoom Text Console / Context Int Cycle
in

Ctrl Wheel Down

Scale text up

None

Ctrl Numpad +

Special note

Console
Console
Function

Console / Context Int Cycle
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Console
Scale text down

None

Console / Context Int Cycle

Ctrl Numpad -

Move caret left

Console / Edit / Cursor to
next Character

Console / Move Cursor

Left Arrow

Move caret right

Console / Edit / Cursor to
previous Character

Console / Move Cursor

Right Arrow

Move caret up

Console / Edit / History
Cycle

Console / History Cycle

Up Arrow

Move caret down

Console / Edit / History
Cycle

Console / History Cycle

Down Arrow

Delete next character

Console / Edit / Delete /

Console / Delete

Delete

Delete previous character

Console / Edit / Delete /
Previous Characater

Console / Delete

Backspace

Delete previous character

None

Console / Delete

Shift Backspace

Delete next word

Console / Edit / Delete /
Next Word

Console / Delete

Ctrl Delete

Delete previous word

Previous Word

Console / Delete

Ctrl Back Space

Clears the whole line

Console / Console / Clear
Line

Console / Clear Line

Shift Return

Clears the whole line

None

Console / Clear Line

Shift Numpad
Enter

Execute

Console / Console /
Console Execute

Console / Console Execute

Return

Execute

None

Console / Console Execute

Numpad Enter

Autocomplete

Console / Autocomplete
button in header

Console / Console
Autocomplete

Ctrl Spacebar

Copy as script

Console / Console / Copy
as script

Console / Copy to Clipboard as Shift Ctrl C
script

Copy

Console / Console / Copy

Console / Copy to Clipboard

Paste

Console / Console / Paste

Console / Paste from Clipboard Ctrl V

Set caret

None

Console / Set Selection

Left Mouse

No menu item. Mouse bound
action.

Select whole word

None

Console / Select word

dbl-Left Mouse

No menu item. Mouse bound
action.

Insert

None

Console / Insert

Ctrl Tab

No menu item. There was no
way to add it to the menu.

Indents the line

Console / Console / Indent

Console / Indent

Tab

Unindents the line

Console / Console /
Unindent

Console / Unindent

Shift Tab

Insert

Console /

No menu entry. Same
functionality is already given
with menu item Zoom Text
In

No menu entry. Same
functionality is already given
with menu item Previous
Characater

No menu item. Same
functionality is already given
with menu item Clear Line.

No menu item. Same
functionality is already given
with menu item Console
Execute

Ctrl C

No menu item. Event
Mapping Text Input

Clip / Clip (Global)
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Clip / Clip (Global)
Function

Surface menu location

User Preferences location

Hotkey

Special note

Open Clip

Clip / Clip / Open Clip

Clip / Clip (Global) / Open
Clip

Alt O

Tools

Clip / View / Tools

Clip / Clip (Global) / Tools

T

Properties

Clip / View / Properties

Clip / Clip (Global) /
Properties

Ctrl T

Set Solver Keyframe.

None

Clip / Clip (Global) / Set
Solver Keyframe

Q

Needs menu entry!

Set Solver Keyframe.

None

Clip / Clip (Global) / Set
Solver Keyframe

Shift E

Needs menu entry

Clip / Clip Editor
Clip / Clip Editor
Function

Surface menu location

User Preferences location

Hotkey

Special note

View Pan

None

Clip / Clip Editor /

MMB

No menu entry. Mouse
Only action

View Pan

None

Clip / Clip Editor /

Shift MMB

No menu entry. Mouse
Only action

View Pan

None

Clip / Clip Editor /

Mouse/Trackpad
Pan

laptop trackpad field

View Zoom

None

Clip / Clip Editor / View Zoom Ctrl MMB

No menu entry. Mouse
Only action

Clip / Clip Editor / View Zoom Mouse/Trackpad
Zoom

laptop trackpad field
laptop trackpad field

View Zoom
View Zoom

None

Clip / Clip Editor / View Zoom Ctrl
Mouse/Trackpad
Pan

View Zoom In

Clip Editor / View / View
zoom in

Clip / Clip Editor / View Zoom Wheel In
In

View Zoom Out

Clip Editor / View / View
zoom in

Clip / Clip Editor / View Zoom Wheel Out
Out

View Zoom In

None

Clip / Clip Editor / View Zoom Numpad +
In

No menu entry. Double
functionality from above

View Zoom Out

None

Clip / Clip Editor / View Zoom Numpad Out

No menu entry. Double
functionality from above

View Zoom Ratio 1:1

Clip / View /View Zoom
Ratio 1:1

Clip / Clip Editor / View Zoom Numpad 1
Ratio

View All

Clip / View /View All

Clip / Clip Editor / View All

Home

View Fit

Clip / View /View Fit

Clip / Clip Editor / View Fit

F

View Selected

Clip / View /View Selected Clip / Clip Editor / View
Selected

Numpad .

View All. Ndof device for
3dConnexion

None

Clip / Clip Editor /

NDOF Fit

Cannot test

NDOF Pan/Zoom. Ndof
device for 3dConnexion

None

Clip / Clip Editor /

NDOF Motion

Cannot test

Jump to Frame.

None

Clip / Clip Editor / Jump to
Frame

Shift Ctrl Left
Arrow

???

Jump to Frame.

None

Clip / Clip Editor / Jump to
Frame

Shift Ctrl Right
Arrow

???

Jump to Frame.

None

Clip / Clip Editor / Jump to
Frame

Shift Alt Left
Arrow

???
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Clip / Clip Editor
Jump to Frame.

None

Clip / Clip Editor / Jump to
Frame

Shift Alt Left
Arrow

???

Change Frame

None

Clip / Clip Editor / Change
Frame

LMB

No menu entry. Mouse
Only action

Select

None

Clip / Clip Editor / Select

Select Mouse

No menu entry. Mouse
Only action

Select

None

Clip / Clip Editor / Select

Shift Select Mouse No menu entry. Mouse
Only action

(De)select all

Clip / Select / (De)select
all

Clip / Clip Editor / (De)select
all

A

Inverts the selection

Clip / Select / Inverse

Clip / Clip Editor / (De)select
all

Ctrl I

Border Select

Clip / Select / Border
Select

Clip / Clip Editor / Border
Select

B

Circle Select

Clip / Select / Circle Select Clip / Clip Editor / Circle
Select

Lasso Select

None

Clip / Clip Editor / Lasso
Select

Event Mapping Tweak

Lasso Select

None

Clip / Clip Editor / Lasso
Select

Event Mapping Tweak

Add Marker and Slide

None

Clip / Clip Editor / Add Marker Ctrl LMB
and Slide

No menu entry. Mouse
Only action

Delete Marker

Clip / Track / Delete
Marker

Clip / Clip Editor / Delete
Marker

Shift Delete

Slide Marker

None

Clip / Clip Editor / Slide
Marker

LMB

No menu entry. Mouse
Only action

Disable Markers

None

Clip / Clip Editor / Disable
Markers

Shift D

Needs menu entry!

Delete Track

Clip / Track / Delete Track Clip / Clip Editor / Delete
Track

Hide Selected

Clip / Track / Show/Hide /
Hide Selected

Clip / Clip Editor / Hide Tracks H

Hide Unselected

Clip / Track / Show/Hide /
Hide Unselected

Clip / Clip Editor / Hide Tracks Shift H

Show Hidden

Clip / Track / Show/Hide /
Show Hidden

Clip / Clip Editor / Hide Tracks Alt H
Clear

Side Plane Marker

None

Clip / Clip Editor / Side Plane
Marker

Action Mouse

No menu entry. Mouse
Only action

Insert Keyframe

None

Clip / Clip Editor / Insert
Keyframe

I

Needs menu entry!

Delete Keyframe

None

Clip / Clip Editor / Delete
Keyframe

Alt I

Needs menu entry!

Translate

Clip / Track / Transform /
Translate

Clip / Clip Editor / Translate

W

Translate
Resize

G

Delete

Clip / Clip Editor / Translate
Clip / Track / Transform /
Resize

Event Mapping Tweak

Clip / Clip Editor / Resize

R

Rotate

Clip / Clip Editor / Rotate

E

Needs menu entry!

Set 2 D Cursor

Clip / Clip Editor /

Action Mouse

No menu entry. Mouse
Only action

Copy Tracks

Clip / Track / Copy Tracks

Clip / Clip Editor / Copy
Tracks

Ctrl C

Paste Tracks

Clip / Track / Paste Tracks

Clip / Clip Editor / Paste
Tracks

Ctrl V
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Clip / Clip Graph Editor
Clip / Clip Graph Editor - Needs investigation as a whole.
Function

User Preferences location

Hotkey

Special note

Change Frame

Clip / Clip Graph Editor /
Change Frame

Action Mouse

No menu entry. Mouse
Only action

Select

Clip / Clip Graph Editor /
Select

Select Mouse

No menu entry. Mouse
Only action

Adds to selection

Clip / Clip Graph Editor /
Select

Shift Select Mouse No menu entry. Mouse
Only action

(De)select all Markers

Clip / Clip Graph Editor /
(De)select all Markers

A

Inverts Marker Selection

Clip / Clip Graph Editor /
(De)select all Markers

Ctrl I

Border Select

Clip / Clip Graph Editor /
Border Select

B

Delete Curve

Clip / Clip Graph Editor /
Delete Curve

Delete

Delete Knot

Clip / Clip Graph Editor /
Delete Knot

Shift Delete

View All

Surface menu location

Clip / View / Home

View All. Ndof device for
3dConnexion
Center Current Frame

Clip / Clip Graph Editor / View Home
All
Clip / Clip Graph Editor / View NDOF Fit
All
Clip / Clip Graph Editor /
Center Current Frame

Numpad ,

Context Toggle

Clip / Clip Graph Editor /
Context Toggle

L

Clear Track Path

Clip / Clip Graph Editor /
Clear Track Path

Alt T

Clear Track Path

Clip / Clip Graph Editor /
Clear Track Path

Shift T

Clear Track Path

Clip / Clip Graph Editor /
Clear Track Path

Shift Alt T

Disable Markers

Clip / Clip Graph Editor /
Disable Markers

Shift D

Clip / Clip Graph Editor /
Translate

W

Translate

Clip / View / Center
Current Frame

None

Translate

Cannot test

Clip / Clip Graph Editor /
Translate

Resize

None

Clip / Clip Graph Editor /
Resize

R

Rotate

None

Clip / Clip Graph Editor /
Rotate

E

Clip / Clip Dopesheet Editor
Clip / Clip Dopesheet Edior
Function

Surface menu location

User Preferences location

Hotkey

Special note

Select Channel

None

Clip / Clip Dopesheet Edior /

Action Mouse

No menu entry. Mouse
Only action
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Clip / Clip Dopesheet Edior
View All

???

Clip / Clip Dopesheet Edior /

Home

Needs menu entry!

View All. Ndof device for
3dConnexion

Clip / View / Home

Clip / Clip Dopesheet Edior /

NDOF View

Cannot Test

Grease Pencil / Grease Pencil(Global)
Grease Pencil / Grease Pencil(Global) - Grease Pencil hotkeys general
Function

Surface menu location

User Preferences location

Hotkey

Special note

Grease Pencil draw

None

Grease Pencil / Grease
Pencil(Global) / Grease Pencil
draw

D LMB

No menu entry. Mouse
Only action

Grease Pencil draw

None

Grease Pencil / Grease
Pencil(Global) / Grease Pencil
draw

Ctrl D LMB

No menu entry. Mouse
Only action

Grease Pencil draw

None

Grease Pencil / Grease
Pencil(Global) / Grease Pencil
draw

Ctrl D RMB

No menu entry. Mouse
Only action

Grease Pencil draw

None

Grease Pencil / Grease
Pencil(Global) / Grease Pencil
draw

D RMB

No menu entry. Mouse
Only action

Grease Pencil draw

None

Grease Pencil / Grease
Pencil(Global) / Grease Pencil
draw

Eraser

Event mapping Eraser

Context Toggle

Header / Mode Menu

Grease Pencil / Grease
Pencil(Global) / Context
Toggle

D Tab

This one is a mode!

Calls a Pie Menu

None

Grease Pencil / Grease
DQ
Pencil(Global) / Call Pie Menu

No menu entry. Calls a Pie
menu

Calls a Pie Menu

None

Grease Pencil / Grease
DW
Pencil(Global) / Call Pie Menu

No menu entry. Calls a Pie
menu

Add Blank Frame

G-Pencil tab / Grease
Pencil panel / Insert

Grease Pencil /Grease Pencil
Stroke edit mode / Add Blank
Frame

DB

Grease Pencil / Grease Pencil in Stroke edit mode
Grease Pencil - Grease Pencil in Stroke edit mode. This hotkeys and menus are just available when you are in Edit Strokes mode.
Function

Surface menu location

User Preferences location

Strokes Edit Mode Toggle

None

Grease Pencil /Grease Pencil
Tab
Stroke edit mode / Strokes Edit
Mode Toggle

This one is a mode!

Call Pie Menu.

None

Grease Pencil /Grease Pencil
Stroke edit mode / Call Pie
Menu

DE

No menu entry. Calls a Pie
menu

Radial Control for pencil
strength

None

Grease Pencil /Grease Pencil
Stroke edit mode / Radial
Control

Ctrl F

No menu entry.

Grease Pencil Interpolation

None

Grease Pencil /Grease Pencil
Stroke edit mode / Grease
Pencil Interpolation

Ctrl Alt E

No menu entry.
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Hotkey

Special note
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Grease Pencil - Grease Pencil in Stroke edit mode. This hotkeys and menus are just available when you are in Edit Strokes mode.
Interpolate Sequence

None

Grease Pencil /Grease Pencil
Stroke edit mode / Interpolate
Sequence

Shift Ctrl E

No menu entry.

Stroke Sculpt

None

Grease Pencil /Grease Pencil
Stroke edit mode / Stroke
Sculpt

S Left Mouse

No menu entry. Mouse
Only action

Stroke Sculpt

Tool Shelf / G-Pencil tab /
Sculpt Strokes Panel /
Sculpt Strokes

Grease Pencil /Grease Pencil
Stroke edit mode / Stroke
Sculpt

S Left Mouse

Radial Control

Grease Pencil /Grease Pencil
Stroke edit mode / Radial
Control

Shift F

No menu entry. Mouse
Only action

Calls a radial control menu None
when Edit strokes Enable
editing is active and pressing
F.

Grease Pencil /Grease Pencil
Stroke edit mode / Radial
Control

F

It's for proportional editing.
Select one vertice of the
greasepencil, and that will
define the influence of the
proportional editing.

Select / Deselect all

3D View / Tool Shelf /
Select / (De) Select all

Grease Pencil /Grease Pencil
Stroke edit mode / (De)select
all strokes

A

Inverts the current selection

3D View / Tool Shelf /
Grease Pencil Tab / Edit
Strokes panel / Inverse

Grease Pencil /Grease Pencil
Stroke edit mode / (De)select
all strokes

Ctrl I

Circle Select

3D View / Tool Shelf /
Grease Pencil Tab / Edit
Strokes panel / Circle
Select button

Grease Pencil /Grease Pencil
Stroke edit mode / Circle
Select

G

Border Select

3D View / Tool Shelf /
Grease Pencil Tab / Edit
Strokes panel / Border
Select button

Grease Pencil /Grease Pencil
Stroke edit mode / Border
Select

B

Lasso select strokes Event
mapping

None

Grease Pencil /Grease Pencil
Stroke edit mode / Lasso select
strokes

Event mapping Tweak

Lasso select strokes Event
mapping

None

Grease Pencil /Grease Pencil
Stroke edit mode / Lasso select
strokes

Event mapping Tweak

Lasso select strokes Event
mapping

None

Grease Pencil /Grease Pencil
Stroke edit mode / Lasso select
strokes

Event mapping Tweak

Lasso select strokes Event
mapping

None

Grease Pencil /Grease Pencil
Stroke edit mode / Lasso select
strokes

Event mapping Tweak

Select knot, This deselects
the other selected knots

None

Grease Pencil /Grease Pencil
Stroke edit mode / Select

Select Mouse

Adds the selection to the
current selection

None

Grease Pencil /Grease Pencil
Stroke edit mode / Select

Shift Select Mouse No menu entry. Mouse
Only action

Selects whole stroke

None

Grease Pencil /Grease Pencil
Stroke edit mode / Select

Alt Select Mouse

Selects linked stroke

3D View / Tool Shelf /
Grease Pencil Tab / Edit
Strokes panel / Select
Linked

Grease Pencil /Grease Pencil
Stroke edit mode / Select
linked

L

Selects linked stroke

None

Grease Pencil /Grease Pencil
Stroke edit mode / Select
linked

Ctrl L
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No menu entry. Mouse
Only action

No menu entry. Mouse
Only action

Possible Double entry. Same
as above? Exact same values
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Grease Pencil - Grease Pencil in Stroke edit mode. This hotkeys and menus are just available when you are in Edit Strokes mode.
Selects Grouped stroke

3D View / Tool Shelf /
Grouped

Grease Pencil /Grease Pencil
Stroke edit mode / Select
Grouped

Expands the selection

3D View / Tool Shelf /
Grease Pencil /Grease Pencil
Ctrl Numpad +
Grease Pencil Tab / Edit
Stroke edit mode / Select more
Strokes panel / Select More

Reduces the selection

3D View / Tool Shelf /
Grease Pencil /Grease Pencil
Grease Pencil Tab / Edit
Stroke edit mode / Select less
Strokes panel / Select Less

Ctrl Numpad -

Duplicates the currently
selected stroke

3D View / Tool Shelf /
Grease Pencil Tab / Edit
Strokes panel / Duplicate

Shift D

Calls a delete menu quiz

3D View / Tool Shelf / Edit Grease Pencil /Grease Pencil
Strokes Panel
Stroke edit mode / Call Menu

Delete

Dissolve

3D View / Gpencil / Delete Grease Pencil /Grease Pencil
Stroke edit mode / Dissolve

Ctrl X

Delete selected points
without splitting stroke

3D View / Tool Shelf /
Grease Pencil Tab / Edit
Strokes panel / Dissolve

Ctrl Delete

Delete all active Frames

3D View / Gpencil / Delete Grease Pencil /Grease Pencil
Stroke edit mode / Delete all
active Frames

Join Strokes

3D View / Gpencil / Join

Grease Pencil /Grease Pencil
Ctrl J
Stroke edit mode / Join Strokes

Join Strokes

3D View / Gpencil / Join

Grease Pencil /Grease Pencil
Shift Ctrl J
Stroke edit mode / Join Strokes

Copy strokes

3D View / Tool Shelf /
Grease Pencil Tab / Edit
Strokes panel / Delete

Grease Pencil /Grease Pencil
Stroke edit mode / Copy

Ctrl C

Paste strokes

3D View / Tool Shelf /
Grease Pencil Tab / Edit
Strokes panel / Delete

Grease Pencil /Grease Pencil
Stroke edit mode / Paste

Ctrl V

Convert Grease Pencil

3D View / Gpencil /
Convert to Geometry

Grease Pencil /Grease Pencil
Stroke edit mode / Convert
Grease Pencil

Alt C

Show all layers

3D View / Gpencil / Show
all Layers

Grease Pencil /Grease Pencil
Stroke edit mode / Show all
layers

Alt H

Hide selected Grease pencil
layer

3D View / Gpencil / Hide
active Layer

Grease Pencil /Grease Pencil
Stroke edit mode / Hide
Layer(s)

H

Hide all Grease pencil layers 3D View / Gpencil / Show
active layer only

Grease Pencil /Grease Pencil
Stroke edit mode / Hide
Layer(s)

Shift H

Isolate Layer

None

Grease Pencil /Grease Pencil
Stroke edit mode /

Numpad *

Move Strokes to Layer

3D View / Gpencil / Move
Strokes to Layer

Grease Pencil /Grease Pencil
Stroke edit mode / Move
Strokes to Layer

M

Select Brush

3D View / Tool Shelf /
Grease Pencil Tab / Edit
Strokes panel / Drawing
Brushes edit field

Grease Pencil /Grease Pencil
Stroke edit mode / Select
Brush

1

Select Brush

3D View / Tool Shelf /
Grease Pencil Tab / Edit
Strokes panel / Drawing
Brushes edit field

Grease Pencil /Grease Pencil
Stroke edit mode / Select
Brush

2

Grease Pencil /Grease Pencil
Stroke edit mode / Duplicate
Strokes

Grease Pencil /Grease Pencil
Stroke edit mode / Dissolve
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Shift G

Shift X

Needs menu entry!

Bforartists Reference Manual - © Copyright - This page is Public Domain
Grease Pencil - Grease Pencil in Stroke edit mode. This hotkeys and menus are just available when you are in Edit Strokes mode.
Select Brush

3D View / Tool Shelf /
Grease Pencil Tab / Edit
Strokes panel / Drawing
Brushes edit field

Grease Pencil /Grease Pencil
Stroke edit mode / Select
Brush

3

Select Brush

3D View / Tool Shelf /
Grease Pencil Tab / Edit
Strokes panel / Drawing
Brushes edit field

Grease Pencil /Grease Pencil
Stroke edit mode / Select
Brush

4

Select Brush

3D View / Tool Shelf /
Grease Pencil Tab / Edit
Strokes panel / Drawing
Brushes edit field

Grease Pencil /Grease Pencil
Stroke edit mode / Select
Brush

5

Select Brush

3D View / Tool Shelf /
Grease Pencil Tab / Edit
Strokes panel / Drawing
Brushes edit field

Grease Pencil /Grease Pencil
Stroke edit mode / Select
Brush

6

Select Brush

3D View / Tool Shelf /
Grease Pencil Tab / Edit
Strokes panel / Drawing
Brushes edit field

Grease Pencil /Grease Pencil
Stroke edit mode / Select
Brush

7

Select Brush

3D View / Tool Shelf /
Grease Pencil Tab / Edit
Strokes panel / Drawing
Brushes edit field

Grease Pencil /Grease Pencil
Stroke edit mode / Select
Brush

8

Select Brush

3D View / Tool Shelf /
Grease Pencil Tab / Edit
Strokes panel / Drawing
Brushes edit field

Grease Pencil /Grease Pencil
Stroke edit mode / Select
Brush

9

Select Brush

3D View / Tool Shelf /
Grease Pencil Tab / Edit
Strokes panel / Drawing
Brushes edit field

Grease Pencil /Grease Pencil
Stroke edit mode / Select
Brush

0

Move

3D View / Tool Shelf /
Grease Pencil Tab / Edit
Strokes panel / Delete

Grease Pencil /Grease Pencil
Stroke edit mode / Show all
layers

W

Move

None

Grease Pencil /Grease Pencil
Stroke edit mode / Translate

Rotate

3D View / Tool Shelf /
Grease Pencil Tab / Edit
Strokes panel / Delete

Grease Pencil /Grease Pencil
Stroke edit mode / Rotate

E

Scale

3D View / Tool Shelf /
Grease Pencil Tab / Edit
Strokes panel / Scale

Grease Pencil /Grease Pencil
Stroke edit mode / Resize

R

Mirror

3D View / Tool Shelf /
Grease Pencil Tab / Edit
Strokes panel / Mirror

Grease Pencil /Grease Pencil
Stroke edit mode / Mirror

Ctrl M

Bend

3D View / Tool Shelf /
Grease Pencil Tab / Edit
Strokes panel / Bend

Grease Pencil /Grease Pencil
Stroke edit mode / Bend

Shift W

To Sphere

3D View / Tool Shelf /
Grease Pencil Tab / Edit
Strokes panel / To Sphere

Grease Pencil /Grease Pencil
Stroke edit mode / To Sphere

Shift Alt S

Scales the currtent selected
stroke section bigger or
smaller

3D View / Tool Shelf /
Grease Pencil Tab / Edit
Strokes panel /
Shrinkfatten

Grease Pencil /Grease Pencil
Stroke edit mode / Transform

Alt S

Grease Pencil /Grease Pencil
Stroke edit mode / Context
Toggle Values

O

Context Toggle Values
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Remove this
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Grease Pencil - Grease Pencil in Stroke edit mode. This hotkeys and menus are just available when you are in Edit Strokes mode.
Context Toggle Values

Grease Pencil /Grease Pencil
Stroke edit mode / Context
Toggle Values

Alt O

Remove this

Hotkey

Special note

Mask Editing
Mask Editing - UV Image Editor in Mask mode. But also other locations.
Function

Surface menu location

User Preferences location

New Mask

UV Image Editor / Header, Mask Editing / New Mask
Mask Dropdown box

Alt N

Call Menu

None

Mask Editing / Call Menu

Shift A

What Context does Toggle
here? Not to catch.

???

Mask Editing / Context Toggle O

Context is usually something
to remove ...

Add Vertex and Slide

None

Mask Editing /

Ctrl Action Mouse

No menu entry. Mouse
Only action

Add FeatherVertex and Slide None

Mask Editing / Add
FeatherVertex and Slide

Shift Action Mouse No menu entry. Mouse
Only action

Delete

UV Image Editor / Mask /
Delete

Mask Editing / Delete

Delete

Select

None

Mask Editing / Select

Select Mouse

Select

None

Mask Editing / Select

Shift Select Mouse No menu entry. Mouse
Only action

(De)select all

UV Image Editor / Select /
(De)Select all

Mask Editing / (De)select all

A

Invert Selection

UV Image Editor / Select /
Inverse

Mask Editing / (De)select all

Ctrl I

Select Linked all

UV Image Editor / Select /
Select Linked

Mask Editing / Select Linked
all

Ctrl L

Select Linked

None

Mask Editing / Select Linked

L

No menu entry. Mouse
action. The mouse needs to
be over the spline

Select Linked

None

Mask Editing / Select Linked

Shift L

No menu entry. Mouse
action. The mouse needs to
be over the spline

Border Select

UV Image Editor / Select /
Border Select

Mask Editing / Border Select

B

Circle Select

UV Image Editor / Select /
Circle Select

Mask Editing / Circle Select

G

Lasso Select

None

Mask Editing / Lasso Select

Event Mapping Tweak

Lasso Select

None

Mask Editing / Lasso Select

Event Mapping Tweak

Select More

UV Image Editor / Select /
Select More

Mask Editing / Select More

Ctrl Numpad +

Select Less

UV Image Editor / Select /
Select Less

Mask Editing / Select Less

Ctrl Numpad -

Clear Restrict View

UV Image Editor / Mask /
Show / Hide

Mask Editing / Clear Restrict
View

Alt H

Set Restrict View

UV Image Editor / Mask /
Show / Hide

Mask Editing / Set Restrict
View

H

Set Restrict View

UV Image Editor / Mask /
Show / Hide

Mask Editing / Set Restrict
View

Shift H
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Needs Menu entry

No menu entry. Mouse
Only action
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Mask Editing - UV Image Editor in Mask mode. But also other locations.
Select

None

Mask Editing / Select

Ctrl Select Mouse

No menu entry. Mouse
Only action

Toggle Cyclic

UV Image Editor / Mask /
Toggle Cyclic

Mask Editing /

Alt C

Toggle is usually something
to remove ...

Slide Point

None

Mask Editing / Slide Point

Action Mouse

No menu entry. Mouse
Only action

Slide Spline Curvature

None

Mask Editing / Slide Spline
Curvature

Action Mouse

No menu entry. Mouse
Only action

Set Handle Type

None

Mask Editing / Set Handle
Type

V

Needs Menu entry

Recalc Normals

UV Image Editor / Mask /
Recalc Normals

Mask Editing / Recalc Normals Ctrl N

Make Parent

UV Image Editor / Mask /
Make Parent

Mask Editing / Make Parent

Ctrl P

Clear Parent

UV Image Editor / Mask /
Clear Parent

Mask Editing / Clear Parent

Alt P

Insert Shapekey

UV Image Editor / Mask /
Animation

Mask Editing / Insert Shapekey I

Clear Shape Key

UV Image Editor / Mask /
Animation

Mask Editing / Clear Shape
Key

Alt I

Add Duplicate

None

Mask Editing / Add Duplicate

Shift D

Copy Splines

UV Image Editor / Mask /
Copy Splines

Mask Editing / Copy Splines

Ctrl C

Paste Splines

UV Image Editor / Mask /
Paste Splines

Mask Editing / Paste Splines

Ctrl V

Set 2D Cursor

None

Mask Editing / Set 2D Cursor

Action Mouse

Translate

UV Image Editor / Mask /
Transform

Mask Editing / Translate

W

Translate

None

Mask Editing / Translate

Resize

UV Image Editor / Mask /
Transform

Mask Editing / Resize

R

Rotate

UV Image Editor / Mask /
Transform

Mask Editing / Rotate

E

Scale Feather

UV Image Editor / Mask /
Transform

Mask Editing / Transform

Alt S

Surface menu location

User Preferences location

Hotkey

Special note

Frame Offset by a step of ten None

Frames / Frame Offset

Shift Up Arrow

No menu entry. Would just
confuse.

Frame Offset by a step of ten None

Frames / Frame Offset

Shift Down Arrow

No menu entry. Would just
confuse.

Frame Offset

None

Frames / Frame Offset

Left Arrow

No menu entry. Would just
confuse.

Frame Offset

None

Frames / Frame Offset

Right Arrow

No menu entry. Would just
confuse.

Frame Offset

None

Frames / Frame Offset

Alt Wheel Down

No menu entry. Would just
confuse.

Neeeds menu entry!

No menu entry. Mouse
Only action

Event Mapping Tweak

Frames
Frames - Timeline stuff
Function
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Frames - Timeline stuff
Frame Offset

None

Frames / Frame Offset

Alt Wheel Up

No menu entry. Would just
confuse.

Jump to Keyframe

None

Frames / Jump to Keyframe

Media Last

No menu entry. Would just
confuse.

Jump to Keyframe

None

Frames / Jump to Keyframe

Media First

No menu entry. Would just
confuse.

Cancel Animation

None

Frames / Cancel Animation

Esc

No menu entry. Would just
confuse.

Cancel Animation

None

Frames / Cancel Animation

Media Stop

No menu entry. Would just
confuse.

Markers
Markers - Marker menu for various animation editors like timeline and graph editor. Add marker adds a mark at the bottom of the timeline,
dopesheet and graph editor.
Function

Surface menu location

User Preferences location

Hotkey

Special note

Move Time Marker

None

Markers / Move Time Marker

Duplicate Time Marker

Graph, Dopesheet, NLA
Markers / Duplicate Time
Editor / Marker / Duplicate Marker
Marker

Shift D

Select Time Marker

None

Markers / Select Time Marker

Select Mouse

Select Time Marker

None

Markers /Select Time Marker

Shift Select Mouse No menu entry. Mouse
Only action

Select Time Marker

None

Markers / Select Time Marker

Ctrl Select Mouse

No menu entry. Mouse
Only action

Select Time Marker

None

Markers / Select Time Marker

Shift Ctrl Select
Mouse

No menu entry. Mouse
Only action

Marker Border Select

Graph, Dopesheet, NLA
Editor / Select / Border
Select

Markers / Marker Border
Select

B

(De)select all markers

Graph, Dopesheet, NLA
Editor / Select / (De)select
all

Markers / (De)select all
markers

A

Delete Markers

Graph, Dopesheet, NLA
Editor / Marker / Delete

Markers / Delete Markers

Delete

Move Time Marker

None

Markers / Move Time Marker

W

Bind Camera to Marker

Graph, Dopesheet, NLA
Editor / View / Bind
Camera to Marker

Markers / Bind Camera to
Marker

Ctrl B

Function

Surface menu location

User Preferences location

Hotkey

Special note

Change Frame

None

Animation / Change Frame

Action Mouse

No menu entry. Mouse
Only action

Event Mapping Tweak

No menu entry. Mouse
Only action

No menu entry. Mouse
Only action

Animation
Animation

Animation Channels - Dope Sheet and Graph Editor
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Animation Channels - Dope Sheet and Graph Editor
Function

Surface menu location

User Preferences location

Hotkey

Special note

Mouse Click on Channels

None

Animation Channels / Mouse
Click on Channels

LMB

No menu entry. Mouse
Only action

Mouse Click on Channels

None

Animation Channels / Mouse
Click on Channels

Shift LMB

No menu entry. Mouse
Only action

Mouse Click on Channels

None

Animation Channels / Mouse
Click on Channels

Shift Ctrl LMB

No menu entry. Mouse
Only action

Rename Channels

None

Animation Channels / Rename Ctrl LMB
Channels

No menu entry. Mouse
Only action

Rename Channels

None

Animation Channels / Rename double-LMB
Channels

No menu entry. Mouse
Only action

Set Channel Keyframes

None

Animation Channels / Set
Channel Keyframes

double-LMB

No menu entry. Mouse
Only action

Set Channel Keyframes

None

Animation Channels / Set
Channel Keyframes

Shift double-LMB

No menu entry. Mouse
Only action

Select All

/ Select / Select All

Animation Channels / Select
All

A

Inverts Selection

/ Select / Invert Selection

Animation Channels / Select
All

Ctrl I

Border Select

/ Select / Border Select

Animation Channels / Border
Select

B

Border Select

None

Animation Channels / Border
Select

Delete Channels

/ Channel / Delete
Channels

Animation Channels / Delete
Channels

Expands Channels

/ Channel / Expands
Channels

Animation Channels / Expands Numpad +
Channels

Collapse Channels

/ Channel / Collapse
Channels

Animation Channels / Collapse Numpad Channels

Expands Channels

/ Channel / Expands
Channels

Animation Channels / Expands Ctrl Numpad +
Channels

Collapse Channels

/ Channel / Collapse
Channels

Animation Channels / Collapse Ctrl Numpad Channels

Move Channels

/ Channel / Move / To Top

Animation Channels / Move
Channels

Page Up

Move Channels

/ Channel / Move / Up

Animation Channels / Move
Channels

Page Down

Move Channels

/ Channel / Move / Down

Animation Channels / Move
Channels

Shift Page Up

Move Channels

/ Channel / Move / To
Bottom

Animation Channels / Move
Channels

Shift Page Down

Event mapping Tweak
Delete

View 3D Gesture Circle
View 3D Gesture Circle
Function

Surface menu location

User Preferences location

Hotkey

Cancel

None

View 3D Gesture Circle /
Cancel

Any Esc

Cancel

None

View 3D Gesture Circle /
Cancel

Any RMB
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View 3D Gesture Circle
Confirm

None

View 3D Gesture Circle /
Confirm

Any Return

Confirm

None

View 3D Gesture Circle /
Confirm

Numpad Enter

Select

None

View 3D Gesture Circle /
Select

LMB

Deselect

None

View 3D Gesture Circle /
Deselect

Shift LMB

No Operation

None

View 3D Gesture Circle / No
Operation

Shift LMB

Deselect

None

View 3D Gesture Circle /
Deselect

MMB

No Operation

None

View 3D Gesture Circle / No
Operation

MMB

No Operation

None

View 3D Gesture Circle / No
Operation

LMB

Subtract

None

View 3D Gesture Circle /
Subtract

Wheel Up

Subtract

None

View 3D Gesture Circle /
Subtract

Numpad -

Add

None

View 3D Gesture Circle / Add

Wheel Down

Add

None

View 3D Gesture Circle / Add

Numpad +

Size

None

View 3D Gesture Circle / Size

Mouse
Trackpad/Pan

Gesture Straight Line
Gesture Straight Line
Function

Surface menu location

User Preferences location

Hotkey

Cancel

None

Gesture Straight Line / Cancel

Any Esc

Cancel

None

Gesture Straight Line / Cancel

Any RMB

Begin

None

Gesture Straight Line / Begin

LMB

Select

None

Gesture Straight Line / Select

LMB

Hotkey

Special note

Gesture Zoom Border
Gesture Zoom Border
Function

Surface menu location

User Preferences location

Cancel

None

Gesture Zoom Border / Cancel Any Esc

Cancel

None

Gesture Zoom Border / Cancel Any RMB

Begin

None

Gesture Zoom Border / Begin

LMB

In

None

Gesture Zoom Border / In

LMB

Begin

None

Gesture Zoom Border / Begin

MMB

Out

None

Gesture Zoom Border / Out

MMB

Gesture Border
67

Special note

Bforartists Reference Manual - © Copyright - This page is Public Domain
Gesture Border
Function

Surface menu location

User Preferences location

Hotkey

Cancel

None

Gesture Border / Cancel

Any Esc

Cancel

None

Gesture Border / Cancel

Any RMB

Select

None

Gesture Border / Select

Any RMB

Begin

None

Begin Gesture Border /

Shift LMB

Deselect

None

Gesture Border / Deselect

Shift LMB

Begin

None

Gesture Border / Begin

LMB

Select

None

Gesture Border / Select

Any LMB

Begin

None

Gesture Border / Begin

MMB

Deselect

None

Gesture Border / Deselect

MMB

Special note

Standard Modal Map
Standard Modal Map - Needs investigation as a whole. What does this do?
Function

Surface menu location

User Preferences location

Hotkey

Cancel

None

Standard Modal Map /

Any Esc

Apply

None

Standard Modal Map / Apply

Any LMB

Apply

None

Standard Modal Map / Apply

Any Return

Apply

None

Standard Modal Map / Apply

Any Numpad Enter

Steps on

None

Standard Modal Map / Steps
on

Any Left Ctrl

Steps off

None

Standard Modal Map / Steps
off

Any Left Ctrl

Special note

Transform Modal Map
Transform Modal Map - Needs investigation as a whole. What does this do?
Function

Surface menu location

User Preferences location

Hotkey

Cancel

None

Transform Modal Map /
Cancel

Any Esc

Confirm

None

Transform Modal Map /
Confirm

Any LMB

Confirm

None

Transform Modal Map /
Confirm

Any Return

Confirm

None

Transform Modal Map /
Confirm

Any Numpad Enter

Translate

None

Transform Modal Map /
Translate

W

Rotate

None

Transform Modal Map / Rotate E

Resize

None

Transform Modal Map / Resize R

Snap Toggle

None

Transform Modal Map / Snap
Toggle

Invert Snap On

None

Transform Modal Map / Invert Any Left Ctrl
Snap On

Invert Snap Off

None

Transform Modal Map / Invert Any Left Ctrl
Snap Off

Invert Snap On

None

Transform Modal Map / Invert Any Right Ctrl
Snap On
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Transform Modal Map - Needs investigation as a whole. What does this do?
Invert Snap Off

None

Transform Modal Map / Invert Any Right Ctrl
Snap Off

Add Snap Point

None

Transform Modal Map / Add
Snap Point

A

Remove last Snap Point

None

Transform Modal Map /

Alt A

Increase Proportional
Influence

None

Transform Modal Map /
Page Up
Increase Proportional Influence

Decrease Proportional
Influence

None

Transform Modal Map /
Decrease Proportional
Influence

Increase Proportional
Influence

None

Transform Modal Map /
Shift Page Up
Increase Proportional Influence

Decrease Proportional
Influence

None

Transform Modal Map /
Decrease Proportional
Influence

Increase Proportional
Influence

None

Transform Modal Map /
Wheel Down
Increase Proportional Influence

Decrease Proportional
Influence

None

Transform Modal Map /
Decrease Proportional
Influence

Increase Proportional
Influence

None

Transform Modal Map /
Shift Wheel Down
Increase Proportional Influence

Decrease Proportional
Influence

None

Transform Modal Map /
Decrease Proportional
Influence

Shift Wheel Up

Adjust Proportional
Influence

None

Transform Modal Map /

Mouse/Trackpad
Pan

Page Down

Shift Page Down

Wheel Up

Select next Edge Slide Edge None

Transform Modal Map / Select Alt Wheel Down
next Edge Slide Edge

Select previous Edge Slide
Edge

Transform Modal Map / Select Alt Wheel Up
previous Edge Slide Edge

None

Increase Max AutoIK Chain None
Length

Transform Modal Map /
Increase Max AutoIK Chain
Length

Shift Page Up

Decrease Max AutoIK Chain None
Length

Transform Modal Map /
Decrease Max AutoIK Chain
Length

Shift Page Down

Increase Max AutoIK Chain None
Length

Transform Modal Map /
Increase Max AutoIK Chain
Length

Shift Wheel Down

Decrease Max AutoIK Chain None
Length

Transform Modal Map /
Decrease Max AutoIK Chain
Length

Shift Wheel Up

Toggle Direction for Node
Auto-offset

Transform Modal Map /
Toggle Direction for Node
Auto-offset

T

None

Eyedropper Modal Map
Eyedropper Modal Map - Needs investigation as a whole. What does this do?
Function

Surface menu location

User Preferences location
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Eyedropper Modal Map - Needs investigation as a whole. What does this do?
Cancel

???

Eyedropper Modal Map /
Cancel

Any Esc

Cancel

???

Eyedropper Modal Map /
Cancel

Any Right Mouse

Confirm Sampling

???

Eyedropper Modal Map /
Confirm Sampling

Any Return

Confirm Sampling

???

Eyedropper Modal Map /
Confirm Sampling

Any Numpad Enter

Confirm Sampling

???

Eyedropper Modal Map /
Confirm Sampling

Any Left Mouse

Start Sampling

???

Eyedropper Modal Map / Start
Sampling

Any Left Mouse

Reset Sampling

???

Eyedropper Modal Map / Reset Any Spacebar
Sampling
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Introduction
The Bforartists Interface is made of several layouts.
We have one for general 3D work, one for scripting,
one for UV editing and so on.
And every layout is made of several editors. See
image. Which brings the functionality to the layout.
Every editor type has another purpose.
The upper menu bar is a editor called Info editor.
Below is the Toolbar editor. The green area is the
3D View editor, the blue little area up right is the
Outliner Editor, the bluegreen editor below is the
Properties editor. And the collapsed small bar at the
bottom is the Timeline.
We will explain the single editors and their functionality and menus in detail at a one by one base. Here we will
talk about the layouts in general. The editors are just covered for the layout needs here.

Switching Layouts
The first important interaction is the ability to
switch between the existing different layouts. This
can be done in two ways. By the six tabs for quick
navigation. And in the layout dropdown box.
The six tabs are connected to the six most important
layouts. In the order: Default, Animation, UV
Editing, Compositing, Scripting and Motion
Tracking.
To switch between layouts by the dropdown box
you have to click at this symbol left of the
dropdown box. A list will open with the available
Layouts. And here you can choose which layout you want to load in the dropdown list by clicking at it.

WARNING!
Do NOT delete the tab button layouts from the dropdown box. This will make the tab buttons disfunctional.

Hint
Just important when you work with more than one scene at once:
By default, each screen layout ‘remembers’ the last scene it was used on. Selecting a different layout will
switch to the layout and jump to that scene.
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Standard Layouts
The Standard layouts are 3D View full, Animation, Compositing, Default, Motion Tracking, Scripting and UV
Editing. Plus a layout for Video editing. And one for the game logic. Both features that are not officially
supported by Bforartists. Please use the Blender documentation here.

3D View full
This layout gives you a maximized 3D view that
hides every other toolbar and editor. This layout is
useful when you want to have a look at the whole
scene in a fullscreen manner. It just shows the 3D
View Editor.

Animation
This layout provides you with a layout that is
optimized for Animation tasks. It contains two 3D
View editors, a Info Editor, a Outliner Editor, a
Properties Editor, a Timeline Editor, a Dope Sheet
Editor and a Graph editor.

Compositing
This layout gives you a compositing layout. This
layout is also meant for working at textures and
materials. It contains a Node Editor, a Info editor, a
UV Image Editor, a 3D View Editor, a Properties
Editor and a Timeline editor.
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Default
This layout is for general 3D work. Here you work
at your 3D scene. Here happens modeling,
texturing, etc. It is also the layout with which
Bforartists opens up. It contains a 3D View editor, a
Info editor, a Timeline editor, a Outliner editor and a
Properties editor.

Motion Tracking
This layout gives you a layout for Motion Tracking.

Scripting
The scripting layout gives you a layout where you
can write Python code. It contains a Info editor, a
3D View editor, a Console editor, a Text editor, a
Outliner Editor and a Properties Editor.
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UV Editing
The UV Editing ist made for texturing and UV
mapping. It contains a Info Editor, a UV Image
Editor and a 3D View editor.

Video Editing
The Video Editing is made for editing videos. It
contains a Graph Editor, a Timeline, and two Video
Sequence Editors.

Game Logic
The Game Logic layout is made for developing a
game. It contains a Outliner, a Logic Editor, a Text
Editor, and a Properties Editor.

5

Bforartists Reference Manual - © Copyright - This page is Public Domain

Modifying Layouts
The standard layouts can be modified. You can resize the editor windows, drag-open more editors, drag-close
editors away, etc.

Maximizing an Editor Window
You can maximize an editor in the layout to fill the whole screen in the View menu. The menu item Toggle Full
Screen. The same menu item will return the editor back to its initial state. This feature is dependant of the
mouse position when you use the hotkey. The editor under the mouse will be maximized.

Resizing Editor Windows
Move the mouse over a border between the editors. The mouse cursor will
turn into a double arrow. Drag the arrow around and the editor will resize with
your moving mouse.
In the Default layout there are two editors that are collapsed to just show the
menu. The menu bar at the top is a own editor. The Info editor. You can drag it
down to reveal a text field. Here Bforartists displays all the former actions as
strings. When you create a primitive for example, then it displays a string with
the python command for it.
The other collapsed editor is at the bottom. The timeline.
6
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Splitting Editor Windows
There is a little triangle area in the upleft and downright corner of the editors. When you move the mouse over
it then the mouse pointer turns into a white cross.
When you click and drag the mouse inwards of the current editor, then the editor splits up. You open a second
3D view for example.

Unioning Editor Windows
There is a little triangle area in the upleft and downright corner of the editors. When you move the mouse over
it then the mouse pointer turns into a white cross.
When you click and drag the mouse outwards of the current editor, then the editor unions with the neighbour
editor. Note that this just works when they are in one row, horizontally or vertically.
7
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Swapping Contents
You can swap the contents between two editors with clicking at the triangle area, press Ctrl-LMB and drag
into the target editor.

Make Editor Window floating
There is a little triangle area in the upleft and downright corner of the editors. When you move the mouse over
it then the mouse pointer turns into a white cross.
Hold down Shift, and drag the mouse. The editor will detach from the Blender surface. This is useful for a multi
monitor setup for example. Now you can place this editor at Monitor 2.

Note that there is no way to reintegrate this floating editor window back into the Blender UI once it is detached.
8
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You have to close it.

Change Editor Type
When you split an editor then you get a second editor window. This is of the
same type than the original editor window. Means when you have split the 3D
View then you have two 3D views now. But with a little difference. It has the so
called Editor Type menu visible.
Have a closer look at the menu bar of the new created editor, at the left. Here
you can find the Editor type menu in the new created editor. This is the place
where you can change the editor type for the new created editor.
You can also change the editors in the standard layouts to something else. You
just need to show the Editor Type Menu there, and then you can change the
editor type also there. See next point.
A closer explanation of the single editors follows in the chapter Editors.

Show / Hide the editor type menu
You might have noticed that the editor type menu is not
available in the editors of the standard layouts. This is to reduce
visual noise and to free some UI space.
You can show and hide this editor type menu. To do so right
click at an empty space somewhere at the menu bar of an editor.
You will see a menu now. And here you can check or uncheck
the menu item Hide Editortype Menu to show or hide the Editor Type menu.

Collapse Menus
The text menus can be collapsed to free some UI space. Right click at
an empty space somewhere at the menu bar of an editor. You will see a
menu now. Here you can choose if you want to display the text menu
collapsed or expanded.
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Resize Tool Shelf and Properties content
You can resize the Tool Shelf content and the
Properties Sidebar content. This means that you can
zoom in or out. This trick also works in the Properties
Editor.
Move the mouse over the upper region of the Tool
Shelf.
Hold down Ctrl key
Click with Middle Mouse button. The mouse pointer
will turn into two white triangles.
Now drag up or down to resize the area content
OR
Move the mouse over the upper region of the Tool Shelf.
Simply press Numpad + or Numpad To reset the area content to default scale move the mouse over the area and press Home key ( german keyboard
layout Pos 1)

Create new Layout
You can either modify an existing layout. Or you can create a new
layout. And do your modifications there.
This can be done in the upper menu bar. Have a look at the plus
sign at the right of the dropdown box.
Click it, and you will get a new layout in the text field. The new layout will be
based at the layout that you had loaded when you clicked the plus button.
Now rename the layout. Click in the text field and change the layout name to
whatever name you want.
It will be part of the layout list now. But just as long as you haven't closed
Bforartists. When you want to keep the new layout and the changes at it, then
you need to save the modifications. See next point.
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Save changes at the Layout
You cannot save new layouts or modifications at an existing layout directly. To save
modifications at an existing layout you have to save the Startup File. This menu item can
be found in the File menu.
Note that this also affects other changes. Bforartists will for example now start with the
currently active layout. And it will also preserve the changes that you did at other layouts
before saving.
So when you work at a layout be sure that you don't accidentally do changes at other
areas. And before you save the startup file you should switch back to the layout with
which you want to start Bforartists.

Delete Layout
Layouts can also be deleted. To do so simply click at the X button
besides the dropdown box.
That's just half of the job though. When you reopen Bforartists
then the layout is back. When you want to remove the layout
permanently then you have to save the Startup file. See above.

WARNING!
Do NOT delete the tab layouts from the dropdown box. This will make the tab buttons disfunctional. And you
will get a warning when you click these buttons.
The tab layouts are: Default, Animation,
UV Editing, Compositing, Scripting and
Motion Tracking.
In case you have deleted them
accidentally, simply readd them.
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Load Layout from Blend Files
Every blend file saves
also the layout in
which the scene is at
the point of saving.
Means you can load a
layout from the blend
file.
This feature is off by
default since it is
usually unwanted
behaviour to load
layouts from other
people.
You can turn it on in
the User Preferences in
the File tab. Tick the
menu item Load UI.
Then save User
Settings.
Note that now all Blend files that you open will load the layout that the Blend files are saved with.

Tool Shelf and Properties Sidebar
Some editors have a Tool Shelf or a Properties Sidebar. Or both. They can be resized by dragging. They can be
closed and opened. They can even be rearranged to be left or right. The screenshot shows the 3D view. Left is
the Tool Shelf. Right is the Properties sidebar.

Opening and closing by menu and hotkey
The view menu provides you with menus to close and to open the Tool shelf and the Properties sidebar.
12
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It also shows the hotkeys for those two items.

Resize
You can grab the border and drag the Tool Shelf and the Properties Sidebar to the left or to the right to expand
or to close them. Text buttons will stretch across the whole width. But the icon buttons will not follow. They
have a fixed width of four icon buttons per row.

Open Sidebar by Plus Button
When a sidebar is closed then you will see a little plus button. When you click at this button then the sidebar
will reappear.

Rearrange Sidebars
The sidebars can be rearranged to be shown at the left side or the left side. To do so move your mouse over one
sidebar, and press F5. The sidebar will jump to the other side now.
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Header
´
Every editor has a header area. It usually contains the menu. And some tools or settings.

Show / Hide header
You can hide the header by simply dragging at the
border to close it. A little plus button will now show.
When you want to reveal the header then click this plus
button.

Flip Header to top or bottom
The header can either be displayed at the top or at the
bottom.
Right click at an empty space somewhere at the menu
bar of an editor. You will see a menu now. Here you can
choose if you want to display the menu bar at the top of the editor, or at the bottom.
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Panels
A Panel is a container that contains tools and settings. At the right you see the History panel.
Panels can be rearranged in order. Simply drag them over each other to achieve the order that
you need.
Panels can be expanded and collapsed by clicking at the title bar.
When you hold down ctrl and click at the title bar then this panel will open, and all other
panels will close.
Panels in the 3D View editor are mode dependant. When you are in Edit mode then you might
see other panels in the Tool Shelf than in Object Mode.

Tabs
The 3D View editor and the Node editor have Tabs in
the Tool Shelf. Tabs. This tabs help to organize the
available tools into categories. In the 3D view it's also
a common place where addons adds themselves.

Pinning panels
Normally the tabs just displays the panels of the
current tab. But you can pin panels so that they display
always.
Right click at the tab that you want to pin. A menu
pops up. Check the Pin checkbox. The tab will now
show a pin, and will display permanently.
To unpin the panel simply click at the Pin icon.
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Grease Pencil Introduction
Years ago people needed a way to quickly draw on their monitors, they did this with a tool called a grease
pencil. This is especially helpful for animators who need to add notes directly on their screen. However, not
everyone wants to draw on their monitors. So a digital version was made, also called a grease pencil.
You can use the Grease Pencil tool to draw freehand sketches and annotations in most of the Editors. The
sketches that are made are saved with the blend-file so they can be seen at any time, a disadvantage of the old
grease pencil. However, you can also do much more with the digital grease pencil such as:
• Planning animation poses and motion curves.
1
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•
•
•
•

Sketching out model topology.
Hand-drawn storyboarding in 3D.
As director’s tool to review shots.
2D animations

An advanced use of Grease Pencil is for different tools (e.g. add-ons). Allowing you to draw where the tool is
to take effect.
https://player.vimeo.com/video/155635261

Drawing Strokes
Enable the Grease Pencil by clicking Draw, Line, Poly or Erase from the Tool Shelf T. A new layer will be
automatically added for you to draw on.
A new layer can be added from the Grease Pencil panel in the Properties region. This panel can also be used to
customize the color, opacity and thickness of the pencil lines. Changes to these settings will affect all strokes on
the current layer.

An example of the Grease Pencil.
Grease Pencil sketches can be converted to editable geometry and used to aid the animation process.

Drawing
Reference
Mode: All Modes
Panel: Tool Shelf ‣ Grease Pencil ‣ Grease Pencil

The Tool Shelf provides a number of options for drawing with the Grease Pencil which are detailed below.
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Draw D-LMB
Draw a new stroke (multiple short, connected lines). The stroke will finish when you release the mouse
button.
Line Ctrl-D-LMB
Draw a new line in rubber band mode. The line will finish when you release the mouse button.
Poly Ctrl-D-RMB
Draw connected lines by clicking on position you want to add the next point. Lines will be automatically
added to connect the two points. Holding LMB down and sliding mouse lets you place the new
point/segment preview. The transformation of the point is locked to X/Y axis set by initial direction of the
mouse movement.
Erase D-RMB, Eraser
Erases segments of strokes that fall within the radius of the eraser “brush” (with a linear falloff from the
center of the eraser circle). The erasing will continue until the mouse button is released, while trying to
reduce the thickness of strokes before removing them. The eraser operates on all visible and editable
layers. If begun with Erase, either RMB or LMB will erase strokes. Its cursor is a red circle with a dashed
outline.
The size of the eraser “brush” can be controlled with Wheel, or with NumpadPlus and
NumpadMinus, while still holding RMB.

Additive Drawing
With the “Additive Drawing” option enabled the active frame’s strokes will be carried over/copied if you start
drawing on an empty frame (i.e. one without any keyframe already). This saves the effort of keeping a Dopes
sheet open, and to remember to duplicate the current frame before starting to draw the next pose (or risk
managing to draw the perfect pose, but without everything else).
This option makes it easier to animate shots where you’re building on a result from a previous frame. Examples
of cases where this comes in handy includes animating facial expressions (when all outlines are on the same
layer), or animating “growing” things (e.g. vines, or concentric circles growing from a central point).
Note
Even without this option enabled, this is the default behavior when using the eraser on an “empty” frame. This
makes it easier to do shots where you’re just changing parts of the facial expression, or if you’re animating an
“eraser” effect.

Continuous Drawing
Continuous Drawing allows for rapid sketching with the Grease Pencil when multiple strokes are desired. So
that you only have to hold D once for the first stroke. Besides the checkbox Continuous Drawing is also enabled
if the D key is released while pressing LMB. The eraser for one-off strokes (RMB) is still available. Note that
with the Eraser both LMB or RMB can be used when drawing has started.
Use Esc or Return or clicking outside the current viewport (e.g. another region or editor) to exit the mode.
Continuous drawing can be disabled using E key in order to get fast access to sculpt mode.

3
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Draw on Back
New strokes are moved behind the drawing when confirming the drawing tool (lowered to the bottom of the
stack).

Stroke Placement

Grease Pencil panel.
Defines how the strokes are converted to 3D (or 2D) space.
View
New strokes are placed in screen space (2D) and are locked to the view.
Cursor
New strokes are drawn in 3D-space, with position determined by the 3D cursor and the view rotation at
the time of drawing. Cursor is available as an option in the UV/Image Editor but it functions identically to
the View option. (3D View only)
Surface
New strokes are drawn in 3D-space, with their position projected onto the first visible surface. (3D View
only)
Stroke
New strokes are drawn in 3D-space, with their position projected onto existing visible strokes. Note that
strokes created with View are not in 3D-space and are not considered for this projection. (3D View only)
Only Endpoints
Applies the drawing setting only to the endpoints of the stroke. The part of the stroke between the
endpoints is adjusted to lie on a plane passing through the endpoints.

4
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The effect of different Drawing Settings on Grease Pencil strokes.
Tip
Notes For Tablet Users:
• The thickness of a stroke at a particular point is affected by the pressure used when drawing that part of
the stroke.
• The “eraser” end of the stylus can be used to erase strokes.

Enable Editing
See Stroke Edit Mode. A overlay is displayed in the top-right corner of editors when enabled.

Tools
• Convert to Geometry
• Ruler and Protractor

Layers
Reference
Mode: All Modes
Panel: Properties region‣ Grease Pencil Layers

Grease Pencil sketches are organized in layers, much like the image layers in the GIMP or Photoshop®. These
layers are not related to any of the other layer systems in Bforartists.
5
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The layers’ main purpose is to gather sketches that are related in some meaningful way (e.g. “blocking notes”,
“director’s comments on blocking”, or “guidelines”). For this reason, all the strokes on a layer (not just those
made after a particular change) are affected by that layer’s color, opacity, and stroke thickness settings.
Layers are managed in the Grease Pencil Panel of the Properties region N shown here.

Grease Pencil Panel.

Grease Pencil Data
Use the following controls to Add, Remove or adjust the position of a layer in the list.
Source
Scene
Grease Pencil data is attached to the current scene is used, unless the active object already has
Grease Pencil data (i.e old files).
Object
Grease Pencil data is attached to the active object are used. This is required when using pre 2.73
add-ons.
Grease Pencil
Used to select the Grease Pencil data-block to use for layers. For controls see Data-Block Menu.
Active Layer
A List Views & Presets of layers attached to each scene or object.
Parent (bone icon)
Indicates that a parent has been set for the layer.
Lock (padlock icon)
Locks the ability to edit the current layers layer.
Hide (eye icon) H
Hides the current layer in the drawing region.
Unlock Color (palette with arrow icon)
Unprotects selected colors from further editing and/or frame changes.
Isolate (padlock icon) NumpadAsterix
To restrict editing to the active layer only.
Isolate (visible) (eye icon)
An option of Isolate to also affect the visibility.
Specials
Duplicate Layer
Creates a copy of the current layer.
6
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Show All Alt-H
Makes all hidden layers visible.
Hide Others Shift-H
Makes all non selected layers hidden.
Lock/Unlock All
Locks/Unlocks all of the layers. This can be useful to prevent unwanted editing.
Merge Down
Merges the current layer with the layer below it.
Note
By default, most operations occur only on the active layer highlighted in the list.

Appearance Settings
These settings can be used to change how the active layer appears.
Opacity
The transparency of the layer.
X-Ray
Makes the lines visible when they pass behind other objects in the scene.
Show Points
Draws the start/end points that make up the stroke.
Tint
Color
The color to tint the layer.
Factor
The amount that the Tint Color has on the layer.
Thickness Change
A relative change in pixels to apply to the thickness of all stroke in the active layer (works like a
modifier).
Apply (hand and bulged in blue line icon)
If the apply button is pressed, the thickness change is applied and the value is reset to zero.

Animation
Parent
An Data ID to select the parent object. The strokes of the layer will follow parent transformations.
Type
Type of parent relation.
Object, Armature, Bone
Lock Frame
Locks the current frame displayed by layer.
Delete Frame
7
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Deletes the active frame for the active Grease Pencil Layer.

Onion Skinning
Onion-skinning, also known as ghosting, helps an animator by displaying the neighboring frames as a faded
trail.

Grease Pencil Onion Skinning.
A: Use Custom Colors
Onion Skinning
Checkbox to enable onion skinning.
Always Use (camera icon)
If enabled ghosts are displayed when scrubbing the view and/or playing back animation.
Use Custom Colors (palette icon)
Toggles to use the Before and After controls to change the color of the ghosted frames.
Before/After
Color
The color of the strokes before/after the current frame.
Before/After Range
The maximum number of ghosts to show before/after the current frame. 0 will only show the
previous/next sketch, and -1 will not show any frames before/after current.

Colors
Reference
Mode: Stroke Edit Mode
Panel: Properties region‣ Grease Pencil Colors

Palette

8
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A Data-Block Menu to select a palette, which is a set of colors. Switching palettes will change all strokes
color in all layers if the same color are linked.
New +
If there are more than one palette, all colors of the old palette will be transferred to the new selected
palette.
• If the color exist in the new palette (same name), the stroke is linked to new color.
• If the color does not exist in the new palette, a new color is added to the palette in order to
keep the stroke.
Colors
A List Views & Presets of colors grouped in the palette linked as stroke or fill colors. If a
color with strokes is removed, all strokes of this color are removed. Any change to line color
or fill color, will change any stroke of any layer using this color. A palette must contain at
least one color, so the last one cannot be deleted.
Lock (padlock icon)
ToDo.
Hide (eye icon)
ToDo.
Ghost (ghost icon)
ToDo.
Specials
ToDo.
Stroke
Sets the line color and the maximum opacity (which is also affected by the brush strength).
Fill
Sets the color of the interior space enclosed by the strokes. Increase the opacity from zero to make the fill
visible. Fill works best on convex shapes, unless you are using High Quality Fill (see below).
Volumetric Strokes
An alternative drawing technique by drawing strokes as a series of filled screen-aligned discs. Get best
results with partial opacity and large stroke widths.
High Quality Fill
Uses a better fill algorithm that works better for concave drawings.

Brushes
Drawing Brushes
Reference
Mode: Stroke Edit Mode
Panel: Tool Shelf ‣ Grease Pencil ‣ Drawing Brushes
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Brushes
A List Views & Presets of preset brushes. You can switch between the brushes using keyboard numbers
from 1 to 0. The selected drawing brush is the brush in the list located at that position.
Thickness
Width of full pressure strokes in pixels constant to the viewport i.e. not affected by the zoom. The
thickness can be lower depending of the pressure.
Sensibility
Adjust the sensibility of the thickness to the pressure of the pencil on the tablet. This pressure can be
disabled using the right small button.
Strength
Similar to sensibility, but affect the alpha value of the color. This parameter allows to get effects as color
fading or watercolor.
Randomness
The properties for Sensibility and Strength additionally have a randomness factor which can be enabled
using the jagged line icon to the right of the number sliders.
Jitter
Define a jitter randomness in the stroke.
Angle
Defines the angle when the thickness of the stroke will be 100%. Any change in the direction will change
the thickness.
Factor
Defines the effect for drawing angle changes in the thickness.
Tip
The Angle and Angle Factor parameters allow to create drawing brushes such as markers that
change the thickness depending of the angle of drawing. This gets a more artistic drawing and less
“computer” lines.

10
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Preset Brushes.

Stoke Quality
These settings are per-brush settings that are applied after each stroke is drawn (when converting from
2D/screen space coordinates to 3D/data space coordinates). These are per-brush settings so that you can apply
varying proprieties to different types of brushes. E.g higher smoothing and/or subdivision for final “beauty”,
and less smoothing/subdivision for initial “blocking” strokes.
Smooth
Defines how much smoothing is applied (using the same method as the “Smooth” Brush). It is used to get
rid of jagged edges and jitter/hand shake.
Smoothing Iterations
Defines how many times smoothing is applied. On each additional round of smoothing performed,
the strength of the smoothing applied is halved, i.e. on the first round, it will be 100% of smoothing
factor, then 50%, then 25%, etc. This setting is most useful for improving the quality of heavily
subdivided strokes, where the multiple rounds of smoothing can help reduce “faceting” artifacts.
Subdivision Steps
Defines how many times the stroke will be subdivided. Each time the stroke is subdivided, extra stroke
points are added between each pair of existing stroke points. The main use of this setting is to make
strokes look less “faceted” (especially large strokes drawn quickly). Strokes are subdivided before
smoothing is applied.
Randomness
Amount of randomness to add new new strokes after subdivision.

Brush Curves
Reference
Mode: Stroke Edit Mode
Panel: Tool Shelf ‣ Grease Pencil ‣ Brush Curves
This panel allows you to adjust the parameters used with tablets to get personal preferences. The available
curves that can be edited are:
• Sensitivity
• Strength
• Jitter
Read more about using the Curve Widget.

Stroke Edit Mode
Enter Stroke Edit Mode with the Mode select menu in the 3D Views header or toggle the Enable Editing in the
11
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Grease Pencil panel, or use D-Tab. In this mode, many common editing tools will operate on Grease Pencil
stroke points instead.
These tools let you move and reshape grease pencil strokes after they have been drawn.
Open the Grease Pencil tab on the Tool Shelf. Look for the tools in the Edit Strokes panel shown here:

Edit panel with grease pencil strokes.

Selecting
Grease pencil strokes are formed from a series of connected vertex points. To make changes, first select points
on the strokes that you want to edit. You can only select points on the active layer. The selected points are
highlighted as in the image above.
Hint
Set the layer’s Stroke Thickness to 1 to make the points more visible.

Use the mouse to select the points, or one of the selection buttons in the panel as detailed in Basic Selection.
Various selection functions similar to those available when editing meshes can be used:

12
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Select A
All
Border B
Select
Circle C
Select
Lasso Ctrl-LMB
Select
Select L, Ctrl-L
Linked
Select Ctrl-NumpadPlus
More
Select Ctrl-NumpadMinus
Less
Select Alt-LMB
Stroke

Editing
Header
Some tools can be access through the 3D View header. e.g. Copy/Paste.
Onion Skinning
Toggles Onion Skinning.
Selection Mask, Alpha
See Further Options.

Menu
Shrink/Flatten Alt-S
Adjust the pressure values of selected stroke points. This provides a way to modify the thickness of
strokes by moving the mouse or the Wheel.
Delete All Active Frame D-X
Deletes all strokes in the active frame. It can be accessed using D-X (anywhere), as well as Shift-X
(Edit Strokes Mode only) or the GPencil ‣ Delete menu. This makes it easier to quickly get rid of
throwaway scribbles.
Move to Layer M
Can be used to move strokes between layers (including to a new layer).

Edit Strokes Panel
Reference
Mode: Edit Stroke Mode
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Panel: Tool Shelf ‣ Grease Pencil ‣ Edit Strokes
Menu: GPencil

Copy Ctrl-C
Copies the selected Grease Pencil strokes (or actually, points and segments).
Paste Ctrl-V
Pastes the previously copied strokes.
Paste & Merge
Pastes the previously copied strokes and merge in active layer.
Delete X
Points
Delete the selected points, leaving a gap in the stroke.
Dissolve
Reconnect the ends so there is no gap in the stroke.
Strokes
Delete the entire stroke containing any selected points.
Frame
Delete a frame when doing Animating Sketches.
Duplicate Shift-D
Make a copy of the selected points at the same location. Use the mouse to Translate them into position.
LMB places them at their new position. RMB cancels and removes the duplicates.
Toggle Cyclic
Close or open the selected stroke by adding an edge from the last to first point.
Bend Shift-W
Bends selected item between the 3D cursor and the mouse.
Mirror Ctrl-M
Mirrors selected strokes along one or more axises.
Shear Shift-Ctrl-Alt-S
Shears selected items along the horizontal screen axis.
To Sphere Shift-Alt-S
Move selected vertices outward in a spherical shape around the midpoint.
Arrange Strokes
Arranges the selection of strokes up/down in the drawing order of the active layer.
Bring Froward, Send Backward, Bring to Front, Send to Back
Move to Color
Sets the active color as the new color to all selected strokes.
Interpolate
Interpolate Ctrl-Alt-E
Interpolates grease pencil strokes between frames.
Sequence Shift-Ctrl-E
Interpolates full grease pencil strokes sequence between frames.
Interpolate All Layers
Checkbox to interpolates all layers, not only active.
Interpolate Selected Strokes
Checkbox to interpolates only the selected strokes in the original frame.
Join Strokes
Type
14
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Join Ctrl-J
Joins selected strokes.
Join & Copy Shift-Ctrl-J
Joins selected strokes as a new stroke.
Leave Gaps
Leaves gaps between joined strokes instead of linking them.
Flip Direction
Flips the start and end of a stroke.
Show Directions
Displays stroke drawing direction with a bigger green dot of the start point and a smaller red dot for the
end point.
Reproject Strokes
Reprojects the selected strokes from the current viewpoint to get all points on the same plane again. This
can be useful to fix problem from accidental 3D cursor movement, or viewport changes.

Sculpt Strokes Panel
Reference
Mode: Edit Stroke Mode
Panel: Tool Shelf ‣ Grease Pencil ‣ Sculpt Strokes
Menu: GPencil ‣ Sculpt Strokes/Brushes
Hotkey: E-LMB
Several tools for editing Grease Pencil strokes are provided in the form of brushes which you can use to “paint”
or “sculpt” the appearance of the strokes without having to keep doing a tedious select-tweak-select-tweak
pattern of edits.
Hold E-LMB and drag to sculpt.

Brushes
The brushes currently implemented are:
Smooth
Allows you to selectively relax jitter/shake and bumpiness, to tidy up messy parts of your sketches.
Affect Pressure
Use this option to perform smoothing on stroke thickness values.
Thickness
The Thickness Brush can be used to increase (Add) or decrease (Subtract) the thickness of the parts of the
stroke under the cursor.
Strength
Increase/decrease (Ctrl) the alpha value of the stroke, E.g. for creating fading effects.
Grab
Takes the stroke points which fall within the brush circle when the sculpting action begins, and allows
you to translate this set of points.
Push
The Push Brush is very similar to the Grab brush, in that it also allows the user to translate stroke points.
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However, unlike the Grab Brush, the Push Brush is not restricted to operating only on the first set of
points which were under the brush when the sculpt action was initiated. Instead, on each brush movement,
the points currently under the brush get moved based on the amount the brush has moved since the last
time it was evaluated.
Twist
Used to twist/rotate points around the cursor, creating a “swirling” effect. It is useful for applying low
levels of distortion to stroke points. The Direction controls whether the points are rotated in a clockwise
(CW) or anti-clockwise (CCW) direction.
Pinch/Inflate
Used to draw points away from the cursor, or towards it.
Pinch
Draw points towards the cursor.
Inflate
Push points away from the cursor.
Randomize
Randomizes the stoke attributes. e.g. with Position enabled it displaces the points randomly in screen
space to create jittered/jagged lines.
Clone Brush
Used to paste the previously copied points (in the Copy/Paste buffer on the active layer), located at the
point where you clicked.
Hold LMB and drag to position and adjust the pasted strokes. The strokes center follows the movements of
the brush/cursor (“Stamp Mode”).
Use Falloff
When the Use Falloff option is enabled, instead of moving all the newly pasted strokes by the same
amount, only the points that are currently under the cursor get affected. Thus, this in this mode of
operation, the brush is closer to a Paste and Push operation instead (“Stamp and Smudge”).

Common Options
Radius Shift-F/Wheel
The size of the brush. Increase/decrease brush size with Shift-F when not sculpting or with Wheel
while sculpting (i.e. with the pen tip down, or mouse button held).
Strength Ctrl-F/Shift-Wheel
The Strength off the brush, can be changed by the pressure of the stylus. (In/decrease see Radius).
Use Falloff
Enables a linear falloff to calculate the influence of the brush on a point. That is, a point closer to the
midpoint of the brush (i.e. the point under the cursor) will get affected more than the ones at the edges.
Direction E-Ctrl-LMB
Radio button to invert the brush effect.
Affect
Enable sculpt for position, strength (alpha value) and thickness in Smooth and Randomize brush.

Further Options
Selection Mask
Used to restrict the brush to only operating on the selected points.
Alpha Ctrl-H
16
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Alpha value of the visualization for selected vertices. The visibility can be toggled (hide/unhide) using
Ctrl-H.

Animating Sketches
You can use Grease Pencil to create 2D animations (e.g. in flipbook style) and mixing it with 3D objects and
composition.
Sketches are stored on the frame that they were drawn on, as a separate drawing (only on the layer that they
exist on). A keyframe is automatically add per layer. Each drawing is visible until the next drawing for that
layer is encountered. The only exception to this is the first drawing for a layer, which will also be visible before
the frame it was drawn on.
Therefore, it is simple to make a pencil-test/series of animated sketches:
1. Go to first relevant frame. Draw.
2. Jump to next relevant frame. Draw some more.
3. Keep repeating process, and drawing until satisfied. Voila! Animated sketches.
See also
Grease Pencil mode in the Dope Sheet editor.

Compositing
The grease pencil layers create a pass inside OpenGL render result. This result can be exported to EXR
multilayer and used in composition.
ToDo.
https://youtu.be/vSD5mN7LT_g

Convert to Geometry
Reference
Mode: All Modes

Panel: Tool Shelf ‣ Grease Pencil ‣ Grease Pencil ‣ Tools: Convert to Geometry...
Menu: GPencil ‣ Convert to Geometry...
Hotkey: Alt-C
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The Convert to Curve options.
In the 3D View, sketches on the active layer can be converted to geometry, based on the current view settings,
by transforming the points recorded when drawing (which make up the strokes) into 3D-space. Currently, all
points will be used, so it may be necessary to simplify or subdivide parts of the created geometry for standard
use.
Sketches can currently be converted into curves, as proposed by the Convert Grease Pencil menu popped-up by
the Convert button in the grease pencil properties.

Options
Type
The type of object to convert to.
Path
Create NURBS 3D curves of order 2 (i.e. behaving like polylines).
Bézier Curve
Create Bézier curves, with free “aligned” handles (i.e. also behaving like polylines).
Polygon Curve
Bézier Curve with strait line segments (auto handles).
Note
Converting to Mesh
If you want to convert your sketch to a mesh, simply choose first NURBS, and then convert the created
curve to a mesh.

Normalize Weight
Will scale weights value so that they tightly fit into the (0.0 to 1.0) range. (enabled by default)
All this means that with a pressure tablet, you can directly control the radius and weight of the created
curve, which can affect e.g. the width of an extrusion, or the size of an object through a Follow Path
18
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Constraint or Curve Modifier!
Link Strokes
Will create a single spline, i.e. curve element. (enabled by default) from all strokes in active grease pencil
layer. This especially useful if you want to use the curve as a path. All the strokes are linked in the curve
by “zero weights/radii” sections.

Timing
Grease pencil stores “dynamic” data, i.e. how fast strokes are drawn. When converting to curve, this data can be
used to create an Evaluate Time F-Curve (in other words, a path animation), that can be used e.g. to control
another object’s position along that curve (Follow Path constraint, or, trough a driver, Curve modifier). So this
allows you to reproduce your drawing movements.
Warning
All those “timing” options need Link Stroke to be enabled, else they would not make much sense!

Timing Mode
This control let you choose how timing data are used.
No Timing
Just create the curve, without any animation data (hence all following options will be hidden).
Linear
The path animation will be a linear one.
Original
The path animation will reflect to original timing, including for the “gaps” (i.e. time between
strokes drawing).
Custom Gaps
The path animation will reflect to original timing, but the “gaps” will get custom values. This is
especially useful if you have very large pauses between some of your strokes, and would rather like
to have “reasonable” ones!
Frame Range
The “length” of the created path animation, in frames. In other words, the highest value of Evaluation
Time.
Start Frame
The starting frame of the path animation.
Realtime
When enabled, the path animation will last exactly the same duration it took you do draw the strokes.
End Frame
When Realtime is disabled, this defines the end frame of the path animation. This means that the drawing
timing will be scaled up or down to fit into the specified range.
Gap Duration
Custom Gaps only. The average duration (in frames) of each gap between actual strokes. Please note that
the value entered here will only be exact if Realtime is enabled, else it will be scaled, exactly as the actual
strokes’ timing is!

Example
Here is a simple “hand writing” video created with curves converted from sketch data:
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https://youtu.be/VwWEXrnQAFI
The blend-file from the above example can be found here.
https://wiki.blender.org/index.php/file:ManGreasePencilConvertToCurveDynamicExample.blend
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Introduction
The Bforartists Interface is made of several layouts.
And every layout is made of several editors. See
image. The editors brings the functionality to the
layout. Every editor type has another purpose.
In this chapter we will talk about the general aspects
of the editors. And give an overview over the
available editor types and their purpose.
The detailled description happens for every editor
one by one then.

Hidden menus
The editors contains a few hidden menus. Nearly every UI element contains a context menu that can be called
by right click. The content varys from element to element, dependant of what options are available.

The Header menu
The header menu can be accessed by right clicking at
an empty space of a menu bar. It is also accessible in
the context menu of an UI element in the menu bar.
Like a button.

Flip to Top
The Flip to Top menu item enables you to flip the whole menu bar to the top or to the bottom

Collapse Menus
The Collapse menus menu item makes the text menu items
either be displayed expanded. Or as a single little button that
you have to click first so that the menu can be accessed.
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Hide Editortype menu
The Hide Editortype menu shows or hides the Editortype menu in the menu bar.

Maximize Area - Tile Area
Maximize Area maximizes this editor.
When the editor is maximized then this menu item turns into Tile area. Which returns the editor to the previous
state then.

The editor type menu
The Editor Type menu gives you an overview of all available editor types. And here you can
switch to another editortype.
This menu is in the standard layouts hidden. See Header Menu, Hide Editortype menu.

Area Options
When you hover over a border between two editors and right click, then you will see the Area Options menu.

Split area
Split area splits the current editor at mouse position into
two new editors.

Join Area
Join Area joins the current editor with the neighbour
editor if possible.
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Pin Panels menu in Tool Shelf
This one is a Tool Shelf only behaviour. When you right click at the
title bar of a panel then you will see the Pin menu. Here you can pin
the panel to stay visible in all tabs.
When ticked then the title bar of the panel shows a pin.

Align
This feature lets you align the panels horizontally or vertically. You can find this menu for
example in the Properties editor by right clicking.
Horizontal aligns the panels horizontal. Vertical aligns the panels vertical.

RMB menu entries
Every tool or UI element has a RMB menu where you can find various things.
The content is varying, dependant of the tool where you right click at. Value edit boxes
have for example a Reset to Default Value menu item. For other tools you might be able
to add or change the shortcut here. They all have the last three menu items, Online
Python Reference, Edit source and Edit translation.
A few examples:

Add Shortcut / Change Shortcut
The Add Shortcut / Change Shortcut button allows you to assign a new shortcut to the tool or to change an
existing shortcut for the tool. Note that this may or may not work proper. For some tools you might need to
change the shortcut in the User preferences.
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Online Python Reference
The Online Python Reference button opens the Bforartists Online Python reference page in your browser.

Edit Source
The Edit Source button opens the corresponding Python file for this element. Note that you need to be in the
Scripting layout. The file loads in the Text editor there.

Edit Translation
This is a developer entry. It allows you to edit the *.mo translation files directly. But you need to have a special
setup here. Which is currently not documented.

Reset to Default Value
Reset to Default Value is usually a RMB menu entry when you right click at a edit box. It resets the value to the
default value.

Reset All to Default Value
Reset All to Default Value is usually a RMB menu entry when you right click at a edit box combo made of two,
three or more edit boxes together. It resets the value for all the edit boxes in the combo to the default value.

Reset Single to Default Value
Reset Single to Default Value is usually a RMB menu entry when you right click at a edit box combo made of
two, three or more edit boxes together. It resets the value for the single edit box under the mouse to the default
value.

Unset
Unset is usually a RMB menu entry when you right click at a edit box. It is somehow similar to Reset to
Default Value. But it clears the property instead of resetting it to the default value. Which can end in another
value.

Add Driver
In Bforartists lots of things can be animated. Also buttons. Add Driver does exactly what it tells. It adds a driver
for animation needs to the element.

Add Drivers
In Bforartists lots of things can be animated. Also buttons. Add Drivers does exactly what it tells. It adds a
driver for animation needs to the elements.

Add Single Driver
In Bforartists lots of things can be animated. Also buttons. Add Driver does exactly what it tells. It adds a driver
for animation needs to the single element under the mouse.

5

Bforartists Reference Manual - © Copyright - This page is under Public Domain

Add to Keying Set
Add to Keying Set adds the information of the element to the current keyframe.

Add All to Keying Set
Add All to Keying Set adds the information of the element to the current keyframe.

Add single to Keying Set
Add to Keying Set adds the information of the element to the current keyframe.

Remove from Keying Set
Remove from Keying Set removes the information of the element from the current keyframe.

Copy Data Path
Copy Data Path copies the RNA data path for this property

Copy to Selected
Copy to Selected copies the property of this element to selected objects or bones

Resize Tool Shelf and Properties content
You can resize the Tool Shelf content and the Properties Sidebar content. This means that you can zoom in or
out. This trick also works in the Properties Editor.
Move the mouse over the upper region of the Tool Shelf.
Hold down Ctrl key
Click with Middle Mouse button. The mouse pointer will turn into two white triangles.
Now drag up or down to resize the area content
OR
Move the mouse over the upper region of the Tool Shelf.
Simply press Numpad + or Numpad To reset the area content to default scale move the mouse over the area and press Home key ( german keyboard
layout Pos 1)
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Miscellaneous
Hotkey recognition
The hotkeys are dependant of the mouse position. Means when your mouse is over the 3d View, then the
hotkeys from the 3D View gets recognized. This means when your mouse is not over the 3D View but the
Outliner, and you press the hotkey for let's say move, then this hotkey will not be recognized.
A special behaviour shows the sidebars here. They are part of the editors. But to have the mouse over the
toolbars at the side can already prevent a hotkey from being triggered. Your mouse needs to stay in the active
part of the editor.

The editor types
3D View
The 3D View is the editor where you do your 3D
work. Here you can model meshes, etc. . It's the core
editor for everything where you work at your 3D data.
You will find it in every layout where you need to
display your 3d data.

Timeline
The timeline editor provides you with a toolbar for all
animation needs. Start, stop, record, set keying set,
etc.
The Timeline is one of four special editors for
animation needs. You will find it in the animation
layout. But also in the standard 3D layout.
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Dope Sheet
The Dope Sheet Editor is the place where you deal
with keyframes.
The Dope Sheet Editor is one of four special editors
for animation needs. You will find it in the animation
layout.
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NLA Editor
The NLA Editor is the place where you work with
Clips and Actions.
The NLA Editor is one of four special editors for
animation needs. You will find it in the animation
layout.

Graph Editor
The Graph Editor is the place where you work with
function curves.
The Graph Editor is one of four special editors for
animation needs. You will find it in the animation
layout.

UV / Image Editor
The UV / Image Editor is the place where you work
with textures and UV mapping.
You will find it in the UV editing Layout and the
Compositing layout.
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Movie Clip Editor
The movie clip editor is for tracking purposes.
You will find it in the Motion Tracking layout.

Text Editor
The Text Editor is the place where you write code. The
scripts for addons for example.
You will find it in the Scripting layout.

Node Editor
The Node editor is the place where you create the
material for the renderer Cycles. It is also the place
where you create and apply compositing effects.
You will find it in the Compositing layout.
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Properties Editor
The Properties editor is the place where you can see
and tweak all properties for the 3D scene. The range
goes from render settings across object settings up to
particle settings.
You will find it in the Default layout, the Animation
layout and the Scripting layout.

Outliner
The Outliner is the place that gives you an overview
of what is in the scene.
You will find it in the Default layout, the Compositing
layout, the Animation layout and the Scripting layout.

User Preferences
The User preferences is the place where you manage
all the settings of the software. Theme, Keymap, etc.
This editor is not present in the standard layouts. This
editor can be called by the file menu -> User
Preferences.
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Info Editor
The Info editor is normally collapsed. And serves as
the file menu for the 3D view. Here you can load a
new scene etc.
It is a bit more though than just the main menu bar. It's
a own editor. With a list of the last performed
operations. Including error messages.
This editor is in all layouts.

File Browser
The File Browser is the editor in which you can load
and save data. Your last blend file for example.
This editor is not part of the standard layouts. It
usually gets called when you load or save a data.

Python Console
The Python console gives you access to the Python
API.
You will find it in the Scripting layout.
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VSE
The VSE Editor, or longer, the Video Sequence Editor,
is the part where you could deal with video clips.
Cutting videos is deprecated in Bforartists. And is not
documented. When you want to cut videos then please
use Blender.
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Editors
Bforartists provides a number of different Editor types for displaying and modifying
different aspects of data.
It is also possible to open the same Editor type multiple times to have different views
on the same data.
Read more about arranging areas

3D
• 3D View

Animation
•
•
•
•

Timeline
Graph Editor
Dope Sheet
NLA Editor

Image/Video
• UV/Image Editor
• Video Sequence Editor
• Movie Clip Editor

Nodes/Logic
• Text Editor
• Node Editor
• Logic Editor

Settings
•
•
•
•

Properties Editor
Outliner
Preferences
Info

Other
• File Browser
• Python Console
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3D View
The 3D View is used to interact with the 3D scene for a variety of purposes, such as modeling, animation,
texture painting, etc.
Navigating in the 3D space is done with the use of both mouse movement and keyboard shortcuts. They can
vary, dependand of the used keymap.
Turn on the Important Hotkeys addon to see the basic navigation hotkeys

Modes
Bforartists has a number of Modes used for editing different kinds of data:
•
•
•
•
•
•
•
•

Object Mode
Edit Mode
Pose Mode
Sculpt Mode
Vertex Paint
Weight Paint
Texture Paint
Particle Edit

The mode can be changed using the menu in
the 3D View header, or using the hotkey
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associated with that mode.

Regions of the 3D View
Toolshelf
The Toolshelf is a context-sensitive region containing tools depending on the current
mode (for example, modeling tools in Edit Mode, brush tools in Sculpt Mode...).
For more information on specific tools available, see:
•
•
•
•
•
•
•
•
•
•
•
•
•

Transformations
History
Creating Objects
Parents
Groups
Animation
Rigid Body
Grease Pencil
Modeling
Sculpting
Vertex Paint
Weight Paint
Texture Paint

Properties Region
The Properties Region contains properties of the active object and selected objects
(such as their locations), as well as properties of the editor itself (such as Display
settings and background images).
Note that the Properties region might vanish in the further Bforartists development.

Header

Contains various menus, buttons and options based on the current mode, such as:
•
•
•
•
•

Shading mode
Pivot options
Transform manipulator
Proportional Edit
Snapping

Navigating
8
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To Do
Note that the Bforartists UI is still under heavy development. The following information may not be longer
complete or valid.
More than one tool has been removed, added, and/or will find its place at another location. The whole
graphical UI may still change in further versions. Means the menu items may have another location then.

The 3D View is where you perform most of the object modeling and scene creation. Bforartists has a wide array
of tools and options to support you in efficiently working with your mouse, keyboard and numpad.

3D Window Header
The 3D View window is comprised of a workspace and a header. The header is shown at the bottom or top of
the workspace, and can be hidden if desired. The header shows you a menu and the current mode, as explained
below.

View Menu
Properties Panel
Toggles the Properties side panel
Tool Shelf
Toggles the Tool Shelf
Set Active Object as Camera
Sets the current active Object as a camera
Active Camera
Toggles between the view of the current active camera and the 3D
view camera
View Camera Center
Centers the pasepartout of the camera to fit into the 3D view
Set Restrict Render
Turns off the rendering of the elected geometry of the same type.
Example: make three cubes, select two, click Set Restrict Render,
and the selected cubes will turn off its rendering in the Outliner.
Note that this item is just available when you have an object selected
in the scene.
Restrict Render unselected
Turns off the rendering of the unselected geometry of the same type.
Example: make three cubes, select one, click Restrict Render
unselected, and the other two cubes will turn off its rendering in the
Outliner.
Note that this item is just available when you have an object selected in the scene.
9
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Clear Restrict Render
Turns back on the rendering of the objects
Note that this item is just available when you have an object selected in the scene.
Clipping Border...
Allows you to define a clipping border to limit the 3D view display to a portion of 3D space.
Clear Render Border
Removes the restriction to render just a portion of the screen
Render Border
Render a defined area of the screen. It's a rectangle tool.
Show all Layers
Makes all of the display layers visible.
Create orientation
Allows you to create and to use a user defined orientation
View Global/Local
Global view shows all of the 3D objects in the scene. Local view only displays the selected objects. This
helps if there are many objects in the scene, that may be in the way. Accidentally pressing
NumpadSlash can happen rather often if you’re new to Bforartists, so if a bunch of the objects in your
scene seem to have mysteriously vanished, try turning off local view.
View Selected all Regions
Zooms the 3D view to encompass all the selected objects in all available 3D views
View Selected
Zooms the 3D view to encompass all the selected objects in current view.
View All all Regions
Zooms the 3D view to encompass all the objects in the current scene in all Views
Center Cursor and view All
Zooms the 3D view to encompass all the objects in the current scene in the current view, and resets the
3D cursor back to the center of the groundgrid.
View All
Zooms the 3D view to encompass all the objects in the current scene in the current view
Duplicate area in new window
Clones the current 3D view in a new window
Toggle Quad View
Toggles a four pane 3D view, each showing a different angle of the scene.
Toggle Maximize Area
Toggle Display selected Area as Fullscreen / maximized
Toggle Full Screen Area
10
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Maximizes the 3D View window to fill the full screen area.

Navi Menu
The Navigation menu,in short Navi Menu, contains the tools to navigate in the 3D space
Orbit Left, Right, Up, Down, Opposite
Orbits the view in the defined direction
Roll Right, Roll Left
Rolls the view to right or left
Pan Down, Pan Up, Pan Right, Pan Left
Pans the view up, down, right, left
Zoom Border
Allows you to define the area you want to zoom in and out by a

rectangle

Zoom In, Zoom Out
Zooms the 3D view in and out
Zoom Camera 1:1
Resets the Camera zoom back to 1:1. Just available when you are in Camera
mode.
Dolly View
Dolly in/out in the View. Note that you can trap yourself with zoom when
you use this tool. Handle with care!
Center view to mouse
Centers the view to the current Mouse position.
Fly Navigation
Enter the Fly Navigation Mode
Walk Navigation
Enter the Walk Navigation
View Navigation
Enter the View Navigation. You can look around from the camera point.
Playback Animation
Starts and stops to play the animation
Scale, Rotate, Translate
Transforms the current selected object. You can scale it, rotate it, and move it.

Select Menu
This menu contains tools for selecting objects and geometry. Its content changes dependant of what type of
object is selected and in what mode you are.
Read more about Selecting in the Selection chapter
11
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Object Menu
This menu appears when in Object Mode. And the content changes dependant of what type of object is selected.
In edit mode, it will change to the appropriate menu with editing tools.
Read more about Objects in the Objects chapter

Modes
Bforartists has a number of Modes used for editing different kinds of data:
•
•
•
•
•
•
•
•

Object Mode
Edit Mode
Pose Mode
Sculpt Mode
Vertex Paint
Weight Paint
Texture Paint
Particle Edit

The mode can be changed using the menu in the 3D View header, or using the
hotkey associated with that mode.
Object Mode
mode allows you to work with objects as a whole.
Edit Mode
Allows you to modify the shape of the object.
Sculpt Mode
In this mode your cursor becomes a tool to shape the object
The cursor becomes a brush in:
• Vertex Paint mode
• Weight Paint mode
• Texture Paint mode.

ViewPort Shading List
Allows you to change the way 3D objects are displayed in the viewport.
•
•
•
•
•
•

Bounding Box
Wireframe
Solid
Texture
Material
Rendered
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Pivot Point Selector
When rotating or scaling an object or group of vertices/edges/faces, you may want to shift the pivot point (the
transformation center) in 3D space. Using this selector, you can change the pivot point to the location of the:
•
•
•
•
•

Active Element
Median Point the average center spot of the selected items
Individual Origins
3D Cursor
Bounding Box Center

Use the Object Center to switch between transforming the entire objects, or
just the position of the objects

Transform (Manipulator) Selectors
Transform Manipulators is a widget. They allow you to scale, rotate or
move objects by grabbing (clicking with your mouse) their controls and
moving your mouse in the corresponding axis.
The widget can be oriented in various ways.

Proportional Editing
Enables proportional editing.

Snap to Mesh
This “magnet” button controls the snapping tools that help with transforming and modeling
objects.

Reset 3D View
Resets the 3D view to the default zoom, rotation and scale. Reset 3D View is an addon, and can be
disabled in the User Preferences.

Align View buttons
Align View Buttons provides you with buttons to switch the view.
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From left to right: Front, Back, Left Right, Top, Bottom. The seventh button is to switch between orthographic
and perspectivic view. Button 8 is to view from the active camera. Button 9 sets the active camera. Note that
you need to have a camera object selected to make this button activated.
Align View is an addon, and can be disabled in the User Preferences.

3D View
To be able to work in the three dimensional space that Bforartists uses, you must be able to change your
viewpoint as well as the viewing direction of the scene. While we will describe the 3D View window, most of
the other windows have similar functions. For example, it is possible to translate and zoom a Buttons window
and its panels.
Tip
Mouse Buttons and Numpad
If you have a mouse with less than three buttons or a keyboard without numpad, see the Keyboard and Mouse
page of the manual to learn how to use them with Bforartists.

Perspective and Orthographic Views
Reference
Mode: All modes
Menu: View ‣ Perspective / View ‣ Orthographic
Hotkey: Numpad5

Each 3D viewport supports two different types of projection. These are demonstrated in the Orthographic (left)
and perspective (right) projections image below.
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Orthographic (left) and perspective (right) projections.

Our eye is used to perspective viewing because distant objects appear smaller. Orthographic projection often
seems a bit odd at first, because objects stay the same size regardless of their distance. It is like viewing the
scene from an infinitely distant point. Nevertheless, orthographic viewing is very useful (it is the default in
Bforartists and most other 3D applications), because it provides a more “technical” insight into the scene,
making it easier to draw and judge proportions.

Options

Demonstration of camera view.

To change the projection for a 3D view, choose the View ‣ Orthographic or the View ‣ Perspective menu entry.
The Numpad5 shortcut toggles between the two modes. Changing the projection for a 3D view does not affect
15
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the way the scene will be rendered. Rendering is in perspective by default. If you need to create an orthographic
rendering, select the camera, go to the Object Data context and press the Orthographic button in the Lens
panel.
The View ‣ Camera menu entry sets the 3D view to camera mode (Numpad0). The scene is then displayed as it
will be rendered later (see Demonstration of camera view). The rendered image will contain everything within
the orange dotted line. Zooming in and out is possible in this view, but to change the viewpoint, you have to
move or rotate the camera.
See also
•
•
•
•

Render perspectives
Camera View
Camera Clipping
Camera Projections

Rotating the View
Reference
Mode: All modes
Menu: View ‣ Navigation
Hotkey: Numpad2 / Numpad4 / Numpad6 / Numpad8 / Ctrl-Alt-Wheel
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A 3D viewport’s View menu.

Bforartists provides four default viewing directions: Side, Front, Top and Camera view. Bforartists uses a rightangled “Cartesian” coordinate system with the Z axis pointing upwards. “Side” corresponds to looking along
the X axis, in the negative direction, “Front” along the Y axis, and “top” along the Z axis. The Camera view
shows the current scene as seen from the camera view point.

Options
You can select the viewing direction for a 3D viewport with the View menu entries, or by pressing the hotkeys
Numpad3 for “side”, Numpad1 for “front”, Numpad7 for “top”. You can select the opposite directions if you
hold Ctrl while using the same numpad shortcuts. Finally Numpad0 gives access to the “camera” viewpoint.
Apart from these four default directions, the view can be rotated to any angle you wish. Click and drag MMB on
the viewport’s area. If you start in the middle of the window and move up and down or left and right, the view
is rotated around the middle of the window. Alternatively, if the Emulate 3 button mouse option is select in the
User Preferences you can press and hold Alt while dragging LMB in the viewport’s area.
To change the viewing angle in discrete steps, use Numpad8 and Numpad2 (which correspond to vertical MMB
dragging, from any viewpoint), or use Numpad4 and Numpad6 (or Ctrl-Alt-Wheel) to rotate the scene
around the Z global axis from your current point of view.
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Note
Hotkeys
Remember that most hotkeys affect the active window (the one that has focus), so check that the mouse
cursor is in the area you want to work in before your use the hotkeys.
See also
• Orbit Style Preference
• Auto-Perspective Preference

Panning the View
Reference
Mode: All modes
Menu: View –> Navigation

To pan the view, hold down Shift and drag MMB in the 3D Viewport. For discrete steps, use the hotkeys
Ctrl-Numpad8, Ctrl-Numpad2, Ctrl-Numpad4 and Ctrl-Numpad6 as with rotating (note: you can
replace Ctrl by Shift). For those without a middle mouse button, you can hold Shift Alt while dragging
with LMB.

Zooming the View
Reference
Mode: All modes
Menu: View –> Navigation
You can zoom in and out by holding down Ctrl and dragging MMB. The hotkeys are NumpadPlus and
NumpadMinus. The View ‣ Navigation sub-menu holds these functions too as well. Refer to the 3D
viewport’s View menu image above for more information.
If you have a wheel mouse, you can perform all of the actions in the 3D viewport that you would do with
NumpadPlus and NumpadMinus by rotating the Wheel. To zoom a Buttons window, hold Ctrl-MMB and
move your mouse up and down.
Hint
If You Get Lost
If you get lost in 3D space, which is not uncommon, two hotkeys will help you: Home changes the view so
that you can see all objects (View ‣ View All menu entry), while NumpadPeriod zooms the view to the
currently selected objects when in perspective mode (View ‣ View Selected menu entry).
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Zoom Border
The Zoom Border tool allows you to specify a rectangular region and zoom in so that the region fills the 3d
view.
You can access this through the View menu, or the shortcut Shift-B, then LMB click and drag a rectangle to
zoom into.
Alternatively you can zoom out using the MMB.

Dolly the View
Reference
Mode: All modes

In most cases its sufficient to zoom the view to get a closer look at something, however you may notice that at a
certain point you cannot zoom any closer.
This is because Bforartists stores a view-point thats used for orbiting and zooming, This works well in many
cases but sometimes you want to move the view-point to a different place - This is what Dolly supports,
allowing you to transport the view from one place to another.
You can dolly back and fourth by holding down Ctrl-Shift and dragging MMB.

Aligning the View
Align View
These options allow you to align and orient the view in different ways. They are found in the View Menu
Align View to Selected menu
These options align your view with specified local axes of the selected object, bone or in Edit
mode, with the normal of the selected face.
Hold down Shift while using the numpad to set the view axis.
Center Cursor and View All
moves the cursor back to the origin and zooms in/out so that you can see everything in your
scene.
Align Active Camera to View, Ctrl-Alt-Numpad0
Gives your active camera the current viewpoint
View selected, NumpadPeriod
Focuses view on currently selected object/s by centering them in the viewport, and zooming
in until they fill the screen.
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Center view to cursor, Alt-Home
Centers view to 3D-cursor
View Selected
See above
View All Home
Frames all the objects in the scene, so they are visible in the viewport.

Local and Global View

Global and Local view

You can toggle between Local and Global view by selecting the option from the View Menu or using the
shortcut NumpadSlash. Local view isolates the selected object or objects, so that they are the only ones
visible in the viewport. This is useful for working on objects that are obscured by other ones, or have heavy
geometry. Press NumpadSlash to return to Global View.
This can be used to speed up viewport performance in heavy scenes, or allow you to focus on a specific object
without others getting in your way.

Quad View
Reference
Mode: All modes
Menu: View ‣ Toggle Quad View
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Quad View

Toggling Quad View will split the 3D window into 4 views: 3 Ortho views and a Camera / User View. This
view will allow you to instantly see your model from a number of view points. In this arrangement, you can
zoom and pan each view independently but you cannot rotate the view. Note that this is different from splitting
the windows and aligning the view manually. In Quad View, the four views are still part of a single 3D window.
So they share the same draw options and layers.
If you want to be able to rotate each view, you can un-check the Locked option.
However in sometimes its preferable to split the view, so each can have its own configuration.
Read more about splitting areas

View Clipping Border
Reference
Mode: All modes
Menu: View ‣ Set Clipping Border
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Region/Volume clipping.

To assist in the process of working with complex models and scenes, you can set the view clipping to visually
isolate what you’re working on.
Once clipping is used, you will only see whats inside a volume you’ve defined. Tools such as paint, sculpt,
selection, transform-snapping etc. will also ignore geometry outside the clipping bounds.
Once activated, you have to draw a rectangle with the mouse, in the wanted 3D view. The created clipping
volume will then be:
• A right-angled parallelepiped (of infinite length) if your view is orthographic.
• A rectangular-based pyramid (of infinite height) if your view is in perspective.
To delete this clipping click at the button again

Example
The Region/Volume clipping image shows an example of using the clipping tool with a cube. This will generate
a dashed cross-hair cursor. Click with the LMB and drag out a rectangular region shown in the upper right. Now
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a region is defined and clipping is applied against that region in 3D space. Notice that part of the cube is now
invisible or clipped. Rotate the view and you will see that only what is inside the pyramidal volume is visible.
All the editing tools still function as normal but only within the pyramidal clipping volume.
The dark gray area is the clipping volume itself. Once clipping is deactivated, all of 3D space will become
visible again.

Walk/Fly Mode
When you have to place the view, normally you do as described above.
However, there are cases in which you really prefer to just navigate your model, especially if it’s very large, like
environments or some architectural model. In these cases viewing the model in perspective mode has
limitations, for example after zooming a lot of panning is extremely uncomfortable and difficult, or you
apparently cannot move the camera any nearer. As an example, try to navigate to a very distant object in the
view with traditional methods (explained above) and see what you can get.
With walk/fly modes you move, pan, tilt, and dolly the camera around without any of those limitations.

View Navigation.

In the User Preferences window select the navigation mode you want to use as default when invoking the View
Navigation operator. Alternatively you can call the individual modes from the View Navigation menu.
Note
This mode actually moves the camera used by the view. This means that when you are in camera view, it
moves the active camera’‘, which is another way to place and aim it.

Walk Mode
Reference
Mode: All modes
Menu: View ‣ View Navigation ‣ Walk Navigation

Usage
On activation the mouse pointer will move at the center of the view, and a cross marker will appear...
This navigation mode behaves similar to the first person navigation system available in most 3d world games
nowadays. It works with a combination of keyboard keys (WASD) and mouse movement. By default the
navigation is in the ‘free’ mode, with no gravity influence. You can toggle between gravity and free mode
during the navigation (Tab).
To move to places more quickly you can teleport (Spacebar) around your scene. If there is an object in front
of the walk cross/aim you will move in that direction until you reach the point (offset by the ‘camera height’
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value set in the [Doc:2.6/Manual/Preferences|User Preferences window]]).
If the defaults values (speed, mouse sensitivity, ...) need adjustments for your project, in the Preferences you
can select a few options for the navigation system:

Fly Mode
Reference
Mode: All modes
Menu: View ‣ View Navigation ‣ Fly Navigation
Hotkey: Shift-F

Usage
On activation the mouse pointer will move at the center of the view, and a squared marker will appear – a sort
of HUD...
Some of the options of Fly mode are influenced by the position of the mouse pointer relative to the center of the
view itself, and the squared marker around this center provides a sort of “safe region” where you can place the
mouse for it to have no effect on the view. The more you take the mouse pointer away from the marker, the
more you pan, or track, etc.

Shortcuts
• Move the mouse left/right to pan the view left/right or move it up/down to tilt the view up/down.
• Move the view forward/backward: - WheelUp or NumpadPlus} to accelerate the movement forward.
- WheelDown or to NumpadMinus} to accelerate the movement backward.
So if the view is already moving forward, WheelDown/NumpadMinus} will eventually
stop it and then move it backward, etc.
• Drag the MMB to dolly. In this case the view can move laterally on its local axis at the moment you drag
the mouse – quite obviously, dragging left/right/up/down makes the view dolly on the left/right/up/down
respectively.
When you are happy with the new view, click LMB to confirm. In case you want to go back from where you
started, press Esc or RMB, as usual.

Camera View
Reference
Mode: All modes
Menu: View ‣ Camera ‣ Active Camera

Cameras View can be used to virtually compose shots and preview how the scene will look when rendered.
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Pressing Numpad0 will show the scene as viewed from the currently active camera. In this view you can also
set the Render Border which defines the portion of the camera view to be rendered.

Camera view provides a preview for the final rendered image.

There are several different ways to navigate and position the camera in your scene, some of them are explained
below.

Camera Navigation
There are several different ways to navigate and position the camera in your scene, some of them are explained
below.
Note
Remember that the active “camera” might be any kind of object. So these actions can be used, for example, to
position and aim a lamp.

Align Active Camera to View
Reference
Mode: Object mode

This feature allows you to position and orient the active camera to match your current view-port.
Select a camera and then move around in the 3D view to a desired position and direction for your camera (so
that you’re seeing what you want the camera to see). Now click at Align Active Camera to View to align the
camera to the current view. This also switches to the camera view.

Camera View Positioning
By enabling Lock Camera to View in the View menu of the View Properties panel, while in camera view, you
can navigate the 3d view-port as usual, while remaining in camera view. Controls are exactly the same as when
normally moving in 3d.

Roll, Pan, Dolly, and Track
To perform these camera moves, the camera must first be selected, so that it becomes the active object (while
viewing through it, you can RMB -click on the solid rectangular edges to select it). The following actions also
assume that you are in camera view. Having done so, you can now manipulate the camera using the given
commands that are used to manipulate any object.
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See also
Fly/Walk Mode
When you are in walk/fly mode, navigation actually moves your camera:
Lock Camera to View
When enabled, performing typical view manipulation operations will move the camera object.

Objects
The geometry of a scene is constructed from one or more Objects. These objects can range from lamps to light
your scene, basic 2D and 3D shapes to fill it with models, armatures to animate those models, to cameras to
take pictures or video of it all.

Types of Objects
Meshes
Meshes are objects composed of Polygonal Faces, Edges and/or Vertices, and can be edited extensively
with Bforartists’s mesh editing tools. The default scene features a cube, which is one of the many
included basic building-block shapes called Mesh Primitives
Curves
Curves are mathematically defined objects which can be manipulated with control handles or control
points (instead of vertices), to manage their length and curvature.
Surfaces
Surfaces are patches that are also manipulated with control points. These are useful for simple rounded
forms and organic landscapes.
Meta Objects
Meta Objects (or Metaballs) are objects formed by a mathematical function (with no control points or
vertices) defining the 3D volume in which the object exists. Meta Objects have a liquid-like quality,
where when two or more Metaballs are brought together, they merge by smoothly rounding out the
connection, appearing as one unified object.
Text
Text objects create a two dimensional representation of a string of characters.
Armatures
Armatures are used for rigging 3D models in order to make them poseable and animateable.
Lattice
Lattices are non-renderable wireframes, commonly used for taking additional control over other objects
with help of the Lattice Modifier.
Empty
Empties are null objects that are simple visual transform nodes that do not render. They are useful for
controlling the position or movement of other objects.
Speaker
Brings to scene source of sound.
Cameras
This is the virtual camera that is used to determine what appears in the render.
Lamps
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These are used to place light sources in the scene.
Force Fields
Force fields are used in physical simulations. They give simulations external forces, creating movement,
and are represented in 3d editor by small control objects.

Speaker

Speaker Object.

The speaker object is used to give sound in the 3D Viewport. After adding the object the various settings can be
changed in the properties editor.

Options
Sound
Mute
Toggles whether or not the sound can be heard.
Volume
Adjust the loudness of the sound
Pitch
Can be used to bend the pitch of the sound to be either deeper or higher.
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Distance

Volume:
Minimum
Minimum volume, no matter how far the object is.
Maximum
Maximum volume, no matter how far the object is.
Attenuation
How strong the distance affects the volume.
Distance:
Maximum
Maximum distance for volume calculation.
Reference
Reference distance at which volume is 100%.

Cone
Angle:
Outer
Angle of the outer cone in degrees. Outside this cone the volume is the outer cone volume (see below).
Between the inner and outer cone the volume is interpolated.
Inner
Angle of the inner cone in degrees. Inside the cone the volume is 100%.
Volume:
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Outer
Volume outside the outer cone.

Selecting
Introduction
Selection determines which elements will be the target of our actions. Bforartists has advanced selection
methods. Both in Object mode and in Edit mode.

Selections and the Active Object
Bforartists distinguishes between two different states of selection:

Unselected object in black, selected object in orange, and active object in yellow

• In Object mode the last (de)selected item is called the “Active Object” and is outlined in yellow (the
others are orange). There is exactly one active object at any time (even when nothing is selected).
Many actions in Bforartists use the active object as a reference (for example linking operations). If you
already have a selection and need to make a different object the active one, simply re-select it with
Shift and Left mouseclick
• All other selected objects are just selected. You can select any number of objects.

Point Selection
The simplest form of object selection is to click at it.
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To add to the selection, use Shift-LMB on more objects.
If the objects are overlapping in the view, you can use Alt-LMB to cycle through possible choices.
If you want to add to a selection this way then the shortcut becomes Shift-Alt-LMB.
To activate an object that is already selected, click Shift-LMB on it.
To deselect an active object, click Shift-RMB one time - and hence two clicks if the object isn’t active. Note
that this only works if there are no other objects under the mouse. Otherwise it just adds those to the selection.
There appears to be no workaround for this bug.

Rectangular or Border Select
Reference
Mode: Object mode and Edit mode
Menu: Select –> Border Select

Description
With Border Select you draw a rectangle while holding down LMB. Any object that lies even partially within
this rectangle becomes selected.
For deselecting objects, use MMB or Border Select again with holding Shift.
To cancel the selection use RMB.

Example

Border selecting in three steps

Border Select has been activated in the first image and is indicated by showing a dotted cross-hair cursor. In the
second image, the selection region is being chosen by drawing a rectangle with the LMB. The rectangle is only
covering two cubes. Finally, in the third image, the selection is completed by releasing LMB.
Notice in the third image, the bright color of left-most selected cube. This means it is the “active object”, the
last selected object prior to using the Border Select tool.

Hints
Border Select adds to the previous selection, so in order to select only the contents of the rectangle, deselect all
with A first.
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Lasso Select
Reference
Mode: Object mode and Edit mode
Menu: no entry in the menu
Hotkey: Ctrl-LMB

Description
Lasso select is used by drawing a dotted line around the pivot point of the objects, in Object mode.

Usage
While holding Ctrl down, you simply have to draw around the pivot point of each object you want to select
with LMB.
Lasso select adds to the previous selection. For deselection, use Ctrl-Shift-LMB.

Lasso selection example

Circle Select
Reference
Mode: Object mode and Edit mode
Menu: Select –> Circle Select

Description

Main selection menu

Circle Select is used by moving with dotted circle through objects with LMB. You can select any object by
touching of circle area. It is possible to dynamically change the diameter of circle by scrolling MMB as seen in
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pictures below. Deselection is under the same principle - MMB. To cancel the selection use RMB or key Esc,

Circle selection

...with huge circle

Menu Selection
The selection methods described above are the most common. There are also many more options accessible
through the Select menu of the 3D view.
Each is more adapted to certain operations.

Select Grouped
Reference
Mode: Object mode
Menu: Select –> Grouped
There are two ways to organize the objects in relation to one another. The first one is parenting, and the second
is simple grouping. We can use these relationships to our advantage by
selecting members of respective families or groups.

Options
Select –> Grouped in Object mode uses the active object as a basis to select all
others.
Available options are:
Children
Selects all children of the active object recursively.
Immediate Children
Selects all direct children of the active object.
Parent
Selects the parent of this object if it has one.
Siblings
Select objects that have the same parent as the active object. This can
also be used to select all root level objects (objects with no parents).
Type
Select objects that are the same type as the active one.
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Layer
Objects that have at least one shared layer.
Group
Objects that are part of a group (rendered green with the default theme) will be selected if they are in one
of the groups that the active object is in.
Object Hooks
Every hook that belongs to the active object.
Pass
Select objects assigned to the same render pass. Render passes are set in Properties –> Object –>
Relations and can be used in the Node Compositor (Add –> Convertor –> ID Mask.)
Color
Select objects with same Object Color. Object colors are set in Properties –> Object –> Display –>
Object Color.)
Properties
Select objects with same Game Engine Properties.
Keying Set
Select objects included in active Keying Set.
Lamp Type
Select matching lamp types.
Pass Index
Select matching object pass index.

Select linked
Reference
Mode: Object mode
Menu: Select –> Linked

Selects all objects which share a common data-block with the active object.

Options
Select –> Linked in Object mode uses the active object as a basis to select all others.
Available options are:
Object Data
Selects every object that is linked to the same Object Data, i.e. the data-block that specifies the type
(mesh, curve, etc.) and the build (constitutive elements like vertices, control vertices, and where they are
in space) of the object.
Material
Selects every object that is linked to the same material data-block.
Texture
Selects every object that is linked to the same texture data-block.
Dupligroup
Selects all objects that use the same Group for duplication.
Particle System
Selects all objects that use the same Particle System
Library
Selects all objects that are in the same Library Library (Object Data)
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Select All by Type
Reference
Mode: Object mode
Menu: Select –> Select All by Type

The types are Mesh, Curve, Surface, Meta, Font, Armature, Lattice, Empty, Camera, Lamp, Speaker.
With this tool it becomes possible to select every visible object of a certain type in one go.

Options
Select All by Type in Object mode offers an option for every type of object that can be described by the ObData
data-block.
Just take your pick.

Select All by Layer
Reference
Mode: Object mode
Menu: Select –> Select All by Layer

All by Layer selection menu

Layers are another means to regroup your objects to suit your purpose.
This option allows the selection of every single object that belongs to a given layer, visible or not, in one single
command.
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Options
In the Tool Shelf –> Select by Layer the following options are available:
Match
The match type for selection.
Extend
Enable to add objects to current selection rather than replacing the current selection.
Layer
The layer on which the objects are.
Tip
Selection of Objects
Rather than using the Select All by Layer option, it might be more efficient to make the needed layers visible
and use A on them. This method also allows objects to be deselected.

Other Menu Options
Available options on the first level of the menu are:
Select Pattern...
Selects all objects whose name matches a given pattern. Supported wildcards: * matches everything, ?
matches any single character, [abc] matches characters in “abc”, and [!abc] match any character not in
“abc”. The matching can be chosen to be case sensitive or not. As an example house matches any name
that contains “house”, while floor* matches any name starting with “floor”.
Select Camera
Select the active camera.
Mirror
Select the Mirror objects of the selected object eg. L.sword –> R.sword.
Random
Randomly selects unselected objects based on percentage probability on currently active layers. On
selecting the command a numerical selection box becomes available in the Tool Shelf. It’s important to
note that the percentage represents the likelihood of an unselected object being selected and not the
percentage amount of objects that will be selected.
Inverse
Selects all objects that were not selected while deselecting all those which were.
(De)select All
If anything was selected it is first deselected. Otherwise it toggles between selecting and deselecting
every visible object.
Less
Decreases the selection
More
Increases the selection
Child
Select the child objects in the hierarchy
Parent
Select the Parent object of the hierarchy
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Child Extended
Select the child objects in the hierarchy
Parent Extended
Select the Parent object of the hierarchy

Transforms
Transformations refer to a number of operations that can be performed on a selected Object or Mesh that alters
its position or characteristics.
Each object can be moved, rotated and scaled in Object Mode. However, not all of these transformations have
an effect on all objects. For example, scaling a camera has no effect on the render dimensions.
Basic transformations include:
• Grabbing (moving)
• Rotating
• Scaling
These three transforms are the three big ones however more, advanced transformations can be found in the
Advanced Transformations section.
For making other changes to the geometry of editable objects, you should use Edit Mode.
Once you’ve added a basic object, you remain in Object Mode.
The object’s wireframe should now appear orange. This means that the object is now selected and active.

Grab/Move
Reference
Mode: Object Mode, Edit Mode, and Pose Mode for the 3D View; UV/Image Editor Tools, Sequence Editor,
Dopesheet, and Graph Editor for other specific types of Grab/Move operation.
Menu: Context Sensitive, Object Based –> Transform –> Grab/Move
In Object Mode, the grab/move option lets you translate (move) objects. It also lets you translate any elements
that make up the object within the 3D space of the active 3D viewport. Grab/Move works similarly here as it
does in the Node Editor, Graph Editor, UV Editor, Sequencer, etc.
Options and other details will be discussed in their respective sections.
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Translation Display

While Grab/Move is active, the amount of change in the X, Y and Z co-ordinates is displayed at the bottom left
corner of the 3D View window.

3D View
There are 2 ways to Grab/Move in 3D View:
• Using shortcuts and combinations of shortcuts.
• Using the Transform Widget helper. This can be toggled from the Translation Widget in the header of the
3DView.

Transform Widget

Translation Widget

In the default installation of Bforartists, this is the Transform Widget. It is active by default. You can use the
widget by holding LMB over it and dragging in the 3D view.
Note
This behavior can be changed using Release Confirms in the User Preferences, so that a single RMB drag can
be used to move and confirm.

Controling Grab/Move Precision
In addition to the Axis constraint options listed above, Bforartists offers options to limit the amount of the
transformation in small or predefined steps.
Shift
Slow translation mode. While still in the grab mode i.e. after G is pressed, holding down Shift reduces
how quickly the object moves and allows extra precision.
Ctrl
This activates snapping based on the snapping constraint which has been already set. You may not be able
to enable every snapping option in all cases.
Ctrl-Shift
Precise snap. This option will move the object with high precision along with the snapping constraint.
X/Y/Z + decimal number
This option limits the transformation to the specified axis and the decimal number specified will be the
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magnitude of the translation along that axis. This decimal number is displayed at the bottom left corner of
the 3D view window as it is entered.
• Hitting Backspace during number entry and deleting the number removes the numerical
specification option but the object will remain constrained to the same axis.
• Hitting / during number entry switches the number being entered to its reciprocal, e.g. 2 / results
in 0.5 (1/2), 2 / 0 results in 0.05 (1/20).
• The axis of movement can be changed at any time during translation by typing X/Y/Z.

Orientations
There are 5 standard orientation references for all transformations. You can find out more about transform
orientations here.

Orientation choice menu

Each mode is a co-ordinate system in which transformations can be carried out. These orientations can be
chosen from the pop-up menu to the side of the controls which toggle and select the transformation manipulator
widgets.
If you have changed the orientation to something other than Global, you can hotkey your chosen axis of
orientation by hitting the relevant axis modifying hotkey twice instead of just once. Hitting the axis modifying
hotkey three times reverts back to Global orientation.

Numerical Entry Display

Other Editor Windows
In other editors such as the UV/Image Editor, Sequence Editor, Dopesheet and Graph Editor, the Grab/Move
Operations are used to move objects or elements - the difference from 3D View is that only two axes are used usually X and Y. You can use many of the same Grab/Move hotkeys in other editor windows and they will
work much the same way as they do in 3D View. Rotating and scaling also work in certain editors as well.
Tip
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Moving an object in Object mode changes the object’s origin. Moving the object’s vertices/edges/faces in Edit
Mode doesn’t change the object’s origin.

Rotate
Reference
Mode: Object and Edit modes
Menu: Object/Mesh/Curve/Surface ‣ Transform ‣ Rotate

Description
Rotation is also known as a spin, twist, orbit, pivot, revolve, or roll and involves changing the orientation of
elements (vertices, edge, face, Object etc) around one or more axes or the element’s Pivot Point. There are
multiple ways to rotate an element which include:
• The keyboard shortcut
• The 3D manipulator widget
• The Properties menu
Basic rotation usage and common options are described below. For additional information, you may wish to
read the Transform Control and Orientation pages which provide more information about options such as
Precision, Axis Locking, Numeric Input, Snapping and the different types of Pivot Point.
Read more about Transform Control Read more about Transform Orientations

Usage
Rotation using the keyboard shortcut
The hotkeys vary, dependant of the chosen keymap, For the current standard hotkeys see the Important Hotkeys
addon.
The amount of rotation will be displayed in the bottom left hand corner of the 3D window.

Rotation values

Constraining the rotation axis (axis locking)
Rotation can be constrained to a particular axis or axes through the use of Axis Locking. To constrain rotation,
the following shortcuts can be used:
• Rotate Hotkey, then X: Rotate only along the X Axis
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• Rotate Hotkey, Y: Rotate only along the Y Axis
• Rotate Hotkey, Z: Rotate only along the Z Axis
Axis locking can also be enabled by pressing the MMB after enabling rotation and moving the mouse in the
desired direction e.g.
• Rotate Hotkey, move the mouse along the X axis, MMB: Rotate only along the X Axis

Fine Tuning The Rotation
Precise control can be had over rotation through the use of the Shift and Ctrl keys to limit rotation to
discrete amounts. You can also enter a numerical value in degrees to specify the amount of rotation after after
initiating a rotation transformation.
• Hold Ctrl down while performing a rotation to rotate the selected element in 5 degree increments.
• Hold Shift down while performing a rotation to rotate the selected element in 0.01 degree increments.
• Hold Shift-Ctrl down while performing a rotation to rotate the selected element in 1 degree
increments.
• Press Rotate Hotkey, type in a number and press Return to confirm.
• Press Rotate Hotkey twice to enable Trackball rotation.
Tip
Orientation dependant rotations
By default, all rotations happen around a Global Orientation. You can change the rotation orientation by
pressing the axis key twice. For example, pressing R, X, X will by default set rotation to occur around the local
orientation.

Read more about Precision Control Read more about Numerical Transformations Read more about Transform
Orientations

Rotation with the 3D Transform Manipulator

Rotation Transform Manipulator

In the 3D View header, ensure that the Transform Manipulator is enabled (the red, green, and blue triad is
selected). Set the manipulator type to rotation (the highlighted arc icon shown below).

• Select your element with RMB.
• Use LMB and drag any of the three colored axes on the rotation manipulator to rotate your object along
40

Bforartists Reference Manual - © Copyright - This page is under OCL license

that axis. You can also use Shift, Ctrl or numeric input with the 3D manipulator widget for further
control.
• Your changes will be applied when you release LMB or press Spacebar or Return. Your changes will
be cancelled if you press RMB or Esc.
Read more about the 3D Transform Manipulator

Rotation with the Properties Panel

Rotation transform properties panel.

Rotation values can also be specified in the Properties panel (N) by altering the degree value in the rotation
slider of the Transform panel. Rotation along particular axes can be enabled or disabled by toggling the padlock
icon. The rotation mode (Euler, Axis Angle, Quaternion) can also be set in this panel from the drop down box.

Scale
Reference
Mode: Object and Edit modes
Menu: Object/Mesh/Curve/Surface ‣ Transform ‣ Scale

Description
Pressing the Scale hotkey will enter the Scale transformation mode where the selected element is scaled
inward or outward according to the mouse pointer’s location. The element’s scale will increase as the mouse
pointer is moved away from the Pivot Point and decrease as the pointer is moved towards it. If the mouse
pointer crosses from the original side of the Pivot Point to the opposite side, the scale will continue in the
negative direction and flip the element.
Read more about Pivot Points

41

Bforartists Reference Manual - © Copyright - This page is under OCL license

Basic scale usage. From left to right, the panels show: the original Object, a scaled down Object, a scaled up Object and a
scale-flipped Object.

There are multiple ways to scale an element which include:
• The keyboard shortcut
• The 3D manipulator widget
• The Properties menu
Basic scale usage and common options are described below. For additional information, you may wish to read
the Transform Control and Orientation pages which provide more information about options such as Precision,
Axis Locking, Numeric Input, Snapping and the different types of Pivot Point.

Usage
Scaling using the keyboard shortcut
The hotkeys vary, dependant of the chosen keymap, For the current standard hotkeys see the Important Hotkeys
addon.
The amount of scaling will be displayed in the bottom left hand corner of the 3D window.

Scale values

Constraining the scaling axis (axis locking)
Scaling can be constrained to a particular axis or axes through the use of Axis Locking. To constrain scaling, the
following shortcuts can be used:
• Scale Hotkey, X: Scale only along the X Axis
• Scale Hotkey, Y: Scale only along the Y Axis
• Scale Hotkey, Z: Scale only along the Z Axis
Axis locking can also be enabled by pressing the MMB after enabling scaling and moving the mouse in the
desired direction e.g.
• Scale Hotkey, move the mouse along the X axis, MMB: Scale only along the X Axis
Read more about Axis Locking
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Fine Tuning The Scaling
Precise control can be had over scaling through the use of the Shift and Ctrl keys to limit scaling to
discrete amounts. You can also enter a numerical value in Bforartists Units (BU) to specify the amount of
scaling after after initiating a scale transformation.
•
•
•
•

Hold Ctrl down while scaling to scale the selected element in degree 0.1 BU increments.
Hold Shift down while scaling to scale the selected element in very fine increments.
Hold Shift-Ctrl down while scaling to scale the selected element in 0.01 BU increments.
Press S, type in a number and press Return to confirm.

Tip
Orientation dependent scaling
By default, all scaling happens around a Global Orientation. You can change the scaling orientation by
pressing the axis key twice. For example, pressing S, X, X will by default set scaling to occur around the local
orientation.

Read more about Precision Control
Read more about Numerical Transformations
Read more about Transform Orientations

Scaling with the 3D Transform Manipulator

Scaling Transform Manipulator

In the 3D View header, ensure that the Transform Manipulator is enabled (the red, green, and blue triad is
selected). Set the manipulator type to scale (the highlighted square icon shown below).

• Select your element with RMB.
• Use LMB and drag any of the three colored axes on the scaling manipulator to scale your object along
that axis. You can also use Shift, Ctrl or numeric input with the 3D manipulator widget for further
control.
• Your changes will be applied when you release LMB or press Spacebar or
Return. Your changes will be cancelled if you press RMB or Esc.

Scaling with the Properties Panel
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Scale values can also be specified in the Properties panel (N) by altering the amount value in the scaling slider
of the Transform panel. Scaling along particular axes can be enabled or disabled by toggling the padlock icon.

Duplication
There are two types of object duplication, being Duplicate and Linked Duplicates which instance their objectdata.

Instancing
Each Bforartists object type (mesh, lamp, curve, camera etc.) is composed from two parts: an Object and
Object Data (sometimes abbreviated to ObData):
Object
Holds information about the position, rotation and size of a particular element.
Object Data
Holds everything else. For example:
Meshes:
Store geometry, material list, vertex groups... etc.
Cameras:
Store focal length, depth of field, sensor size... etc.
Each object has a link to its associated object-data, and a single object-data may be shared by many
objects.

Duplicate
Reference
Mode: Edit and Object modes
Menu: Object –> Duplicate
This will create a visually-identical copy of the selected object(s). The copy is created at the same position as
the original object and you are automatically placed in Grab mode. See the example below.
This copy is a new object, which shares some data-blocks with the original object (by default, all the Materials,
Textures, and Ipos), but which has copied others, like the mesh, for example. This is why this form of
duplication is sometimes called “shallow link”, because not all data-blocks are shared; some of them are “hard
copied”!
Note that you can choose which types of data-block will be linked or copied when duplicating: in the User
Preferences, Editing Page.
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Examples

The mesh Cone.006 of object Cone.002 is being edited. The mesh’s Unique data-block ID name is highlighted in the
Outliner.

The cone in the middle has been (1) link duplicated to the left and (2) duplicated to the right.
• The duplicated right cone is being edited, the original cone in the middle remains unchanged. The mesh
data has been copied, not linked.
• Likewise, if the right cone is edited in object mode, the original cone remains unchanged. The new
object’s transform properties or data-block is a copy, not linked.
• When the right cone was duplicated, it inherited the material of the middle cone. The material properties
were linked, not copied.
See above if you want separate copies of the data-blocks normally linked.

Linked Duplicates
Reference
Mode: Object mode
Menu: Object –> Duplicate Linked
You also have the choice of creating a Linked Duplicate rather than a Duplicate; this is called a deep link. This
will create a new object with all of its data linked to the original object. If you modify one of the linked objects
in Edit mode, all linked copies are modified. Transform properties (object data-blocks) still remain copies, not
links, so you still can rotate, scale, and move freely without affecting the other copy. Reference (Duplicate
Example) for the discussions below.
Hint
If you want to make changes to an object in the new linked duplicate independently of the original object, you
will have to manually make the object a “single-user” copy by LMB the number in the Object Data panel of

45

Bforartists Reference Manual - © Copyright - This page is under OCL license

the Properties Window.

Examples

The object Cone.001 was linked duplicated. Though both these cones are separate objects with unique names, the single
mesh named Cone, highlighted in the Outliner, is shared by both.

The left cone is a Linked Duplicate of the middle cone.
• As a vertex is moved in Edit mode in one object, the same vertex is moved in the original cone as well.
The mesh data are links, not copies.
• In contrast, if one of these two cones is rotated or rescaled in object mode, the other remains unchanged.
The transform properties are copied, not linked.
• As in the previous example, the newly created cone has inherited the material of the original cone. The
material properties are linked, not copied.
A common table has a top and four legs. Model one leg, and then make linked duplicates three times for each of
the remaining legs. If you later make a change to the mesh, all the legs will still match. Linked duplicates also
apply to a set of drinking glasses, wheels on a car... anywhere there is repetition or symmetry.

Procedural Duplication
Reference
Mode: Object mode and Edit mode
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Panel: Object settings

There are currently four ways in Bforartists to procedurally duplicate objects. These options are located in the
Object menu.
Verts
This creates an instance of all children of this object on each vertex (for mesh objects only).
Faces
This creates an instance of all children of this object on each face (for mesh objects only).
Group
This creates an instance of the group with the transformation of the object. Group duplicators can be
animated using actions, or can get a Proxy.
Frames
For animated objects, this creates an instance on every frame. As you’ll see on this topic’s subpage, this is
also a very powerful technique for arranging objects and for modeling them.

Copying & Linking Objects Between Scenes
Sometimes you may want to link or copy objects between scenes. This is possible by first selecting objects you
want to link and then using: Object ‣ Make Links ‣ Object to Scene.
This makes the same object exist in 2 different scenes at once, including its position and animation data. You
can tell this is a multi-user object by the blue color of its center-circle
If you don’t want the objects to be shared between the scenes, you can make them Single-User by using: Object
‣ Make Single User ‣ Object.
Further information on working with scenes can be found here.

Linked Library Duplication
Reference
Menu: File –> Link Append
Linked Libraries :Linked Libraries are also a form of duplication. Any object or data-block in other .blend
files can be reused in the current file.
Hint
• If you want transform properties (i.e. object data-blocks) to be “linked”, see the page on parenting.
• Material Transparency will not display when instancing dupli-groups; this is a known limitation of
Bforartists’s view-port.
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DupliVerts
Reference
Mode: Object mode
Panel: Object –> Duplication

Duplication Vertices or DupliVerts is the duplication of a base object at the location of the vertices of a mesh. In
other words, when using DupliVerts on a mesh, an instance of the base object is placed on every vertex of the
mesh.
There are actually two approaches to modeling using DupliVerts. They can be used as an arranging tool,
allowing us to model geometrical arrangements of objects (e.g. the columns of a Greek temple, the trees in a
garden, an army of robot soldiers, the desks in a classroom). The object can be of any object type which
Bforartists supports. The second approach is to use them to model an object starting from a single part of it (e.g.
the spikes in a club, the thorns of a sea-urchin, the tiles in a wall, the petals in a flower).
Note
Download example .blend file
You can download a file with the examples described on this page. In this .blend, the first example, a monkey
parented to a circle is on layer 1; while a tentacle parented to an icosphere is on layer 2.

DupliVerts as an Arranging Tool
Setup

A monkey head and a circle

All you need is a base object (e.g. the tree or the column) and a pattern mesh with its vertices following the
pattern you have in mind. In this section, we will use a simple scene for the following part. We’ll be using a
monkey head located at the origin of the coordinate system as our base object and a circle at the same location
as our parent mesh.
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Dupliverted monkeys

First, in Object mode, select the base object and add the circle to the selection (order is very important here),
and parent the base object to the circle. Now, the circle is the parent of the monkey; if you move the circle, the
monkey will follow it.
With only the circle selected, enable Duplication vertices in the Object panel–> Duplication –> Verts. A
monkey head should be placed at every vertex of the circle.
The original monkey head at the center and the parent mesh are still shown in the 3D view but neither will be
rendered. If the placement and rotation of your monkey head is odd, you might need to clear its rotation.

Rearranging
If you now select the base object and modify it in either object or edit mode, all changes will also affect the
shape of all duplicate objects. You can also select the parent mesh to modify the arrangement of the duplicates;
adding vertices will also add more base objects. Note that the base objects will inherit changes made to the
parent mesh in object mode, but not in edit mode - so scaling the circle up in object mode will enlarge the
monkey head, while scaling the circle up in edit mode will only increase the distance between the base objects.

Orientation

Orientation enabled, orientation +Y

The orientation of the base objects can be controlled by enabling Rotation in the Duplication panel. This will
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rotate all base objects according to the vertex normals of the parent mesh.
To change the orientation of the duplicated objects, select the base object and in the Object –> Relations extras
panel change the Tracking Axes.
Output of various orientations:

Negative Y

Positive X

Positive Z, up X
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Note
The axes of an object can be made visible in the Object –> Display panel. To display the vertex normals of the
parent mesh, tab into edit mode and enable this function in Properties –> Display panel where you can also
resize the displayed normals as necessary.

DupliVerts as a Modeling Tool
Very interesting models can be made using DupliVerts and a standard primitive. In this example, a simple
tentacle was made by extruding a cube a couple of times. The tentacle object was then parented to an icosphere.
With dupli Rotation enabled for the parent mesh (the icosphere), the orientation of the base object (the tentacle)
was adapted to the vertex normals of the parent mesh
(in this case the tentacle was rotated -90- about the X axis in edit mode).

A simple tentacle set to smooth
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Tentacle dupliverted onto the parent mesh

Rotation enabled to align duplicates

As in the previous example, the shape and proportions of the arrangement can now be tweaked.
To turn all duplicates into real objects, simply select the icosphere and Object –> Apply –> Make Duplicates
Real. To make the icosphere and the tentacle a single object, make sure they are all selected and go to Object –>
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Join

DupliFaces
Reference
Mode: Object mode
Panel: Object –> Duplication
Duplication Faces or DupliFaces is the capability to replicate an object on each face of a parent object. One of
the best ways to explain this is through an example illustration.
Note
Example .blend file
Download the .blend file used for the examples on this page here
http://wiki.Bforartists.org/index.php/:File:Manual-2.5-Duplifaces-Example01.blend

Basic usage

A cube and a sphere

In this example we will use a UV sphere with an extruded “north pole” as our base object and cube as our
parent mesh. To parent the sphere to the cube, in Object mode, first select the sphere, then select the cube (order
is very important here), and finally parent it.
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Duplication Faces applied to the cube

Next, in the Object context’s Duplication panel, enable Faces. The sphere is duplicated one for each face of the
cube.
Note
Inherited properties
The location, orientation, and scale of the duplicated child(ren) matches that of the faces of the parent. So, if
several objects are parented to the cube, they will all be duplicated once for each face on the cube. If the cube
is subdivided (in Edit Mode W), every child will be duplicated for each face on the cube.

Both the parent object and original are displayed as editable “templates” in 3D view, but neither is rendered.
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Scale

Scale enabled

Top face of cube scaled down
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By enabling Scale for the parent object, the scale of the child objects will be adapted to the size of each face in
the parent object.
Thus, by rescaling the face of the parent object, the size of the duplicated object will change accordingly.

Limitations / Considerations
The positioning of the duplicated geometry relative to the face is dependent upon the position of the child
objects relative to the duplicator’s origin. This can lead to some visual artifacts in the editor as the geometry of
the original objects overlaps or intersects with the duplicates. One workaround is to move the origin of the
duplicator mesh off of the plane of the faces.
If the geometry of the children is not symmetrical then the orientation of the face (as determined by the order of
its vertices) could matter. As of 2.70 Bforartists does not have tools which allow you to adjust the ordering of
the vertices on a face.
However, there is a workflow that lets you control for this. Make a single square and enable the Duplication /
Faces so you can see the duplicated geometry in your editor window. If the orientation is not what you want,
rotate the face until it is how you want. Typically you want to do the rotation in Edit mode, not Object mode,
but this is not a hard rule.
Once you have the orientation correct, Duplicate the face and move the duplicate where you want it. Repeat this
process until you have enough faces. Since it is common for these faces to butt up against one another, your
geometry will have lots of duplicate vertices. Use the Remove Doubles button in the Tools panel.

DupliFrames
DupliFrames is a tool to duplicate objects at frames distributed along a path. This is a useful tool to quickly
arrange objects.

Examples

Settings for the curve
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Add a Bezier Circle and scale it up. In the Curve menu under Path Animation enable Follow and set Frames to
something more reasonable than 100 (say 16).

Settings for the object

Add a Monkey. In the Object menu under Duplication enable Frames and disable Speed.
Note
Speed
The Speed option is used when the parent-child relationship is set to Follow Path (see below). In this example,
the monkey will then travel along the circle over 16 frames.

Parenting

To parent the monkey to the Bezier circle, first select the monkey then the curve (so that the curve is the active
object) and Ctrl-P. Select the monkey and reset its origin.
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Orientation tweaks

You can now change the orientation of the monkey by either rotating it (either in Edit mode or Object mode) or
by changing the Tracking Axes under Animation Hacks (with the monkey selected). The arrangement of
monkeys can, of course, be further enhanced by editing the curve.
To transform all monkeys into real objects, first Make Duplicates Real. All monkeys are now real objects, but
still linked copies. To change this, Object ‣ Make Single User ‣ ObjectData` then choose All.
Note
There are many alternatives to Dupliframes. Which tool to use depends on context.
• To use a small curve as a profile and a larger curve as a path, simply use the former as a Bevel Object
to the latter.
• To arrange objects along a curve, combining an Array Modifier and a Curve Modifier is often useful.
• Dupliverts can be used to arrange objects, for example, along a circle or across a subdivided plane.

External links
• Bforartists Artists: Dupliframes in 2.5

DupliGroup
Reference
Mode: Object mode
Panel: Object –> Duplication –> Group

Duplication Group or DupliGroup allows you to create an instance of a group for each instance of another
object.
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Basic Usage
• Create a number of objects and group them by
• selecting them all,
• Group them by menu item Object / Group
• eventually rename your group in Object –> Groups
• Create a DupliGroup by
• adding another object, say an Empty,
• in Object –> Duplication enable Group, and
• select the name of your newly created group in the selection box that appears.

DupliGroup and Dynamic Linking
See Appending and Linking to understand how to dynamically link data from another .blend file into the
current file. You can dynamically link groups from one blend file to another. When you do so, the linked group
does not appear anywhere in your scene until you create an object controlling where the group instance appears.

Example
• Link a group from another file into your scene, as described in Appending and Linking.
From here, you can use the easy way or the hard way:
• The easy way:
• Select Add –> Group Instance –> [name of group you just linked].
• The hard way:
• Select Add –> Empty, and select the empty that you added.
• Switch to the Object context, and in the Duplication panel, click Group.
• In the dropdown box that appears next to Group:, pick the group that you linked.
At this point, an instance of the group will appear. You can duplicate the empty, and the DupliGroup settings
will be preserved for each empty. This way, you can get multiple copies of linked data very easily.

Making a DupliGroup Object Real
Say you want to make further edits on an DupliGroup instance:
Simply select your DupliGroup and convert the DupliGroup into regular objects that can be transformed and
animated normally.
Note
Note that if the DupliGroup was linked from an external file the Object Data (mesh, materials, textures,
transforms) will also still be linked from the original group. However, the various object’s parent-child
relationships do not carry over.

Advanced Transformations
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Randomize Transform
Reference
Mode: Object mode
Menu: Object ‣ Transform ‣ Randomize Transform

Randomize transform options

The randomize transform tool allows you to apply random translate, rotate, and scale values to an object or
multiple objects. When applied on multiple objects, each object gets its own seed value, and will get different
transform results from the rest.

Options
Random Seed
The random seed is an offset to the random transformation. A different seed will produce a new result.
Transform Delta
Randomize Delta Transform values instead of regular transform.
Randomize Location
Randomize Location vales
Location
The maximum distances the objects can move along each axis.
Randomize Rotation
60

Bforartists Reference Manual - © Copyright - This page is under OCL license

Randomize rotation values.
Rotation
The maximum angle the objects can rotate on each axis
Randomize Scale
Randomize scale values.
Scale Even
Use the same scale for each axis.
Scale
The maximum scale randomization over each axis.

Separate
Reference
Mode: Edit mode
Menu: Tool Shelf, Tools Tab, Mesh Tools
At some point, you’ll come to a time when you need to cut parts away from a mesh to be separate. Well, the
operation is easy.
To separate an object, the vertices (or faces) must be selected and then separated, though there are several
different ways to do this.

Suzanne dissected neatly

Selected
This option separates the selection to a new object.
All Loose Parts
Separates the mesh in its unconnected parts.
By Material
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Creates separate mesh objects for each material.

Join
Reference
Mode: Object mode
Menu: Tool Shelf –> Tools, Edit Panel, Join button
Joining makes one single object from all selected objects. Objects must be of the same type. Origin point is
obtained from the previously active object. Performing a join is equivalent to adding new objects while in Edit
mode. The non-active objects are deleted and their meshes added to the active object, so that only the active
object remains. This only works with editable objects containing meshes and curves.

Object Origins
Each object has an origin point. The location of this point determines where the object is located in 3D space.
When an object is selected, a small circle appears, denoting the origin point. The location of the origin point is
important when translating, rotating or scaling an object. See Pivot Points for more.

Moving Object Centers
Object Centers can be moved to different positions through 3D View window –> Transform –> Origin:
Geometry to Origin
Move model to origin and this way origin of the object will also be at the center of the object.
Origin to Geometry
Move origin to the center of the object and this way origin of the object will also be at the center of the
object.
Origin to 3D Cursor
Move origin of the model to the place of the 3D cursor.
Origin to Center of Mass
Move origin to calculated center of mass of model.

Transform Control
Transform controls can be used to modify and control the effects of the available transformations.

Precision
Reference
Mode: Object and Edit modes
Hotkey: Ctrl and/or Shift
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Description
Holding Ctrl during a transform operation (such as grab, rotate or scale) will toggle Transform Snapping.
When the Snap Element is set to Increment, this allows the transformation to be performed in fixed amounts.
Holding Shift during a transform operation will transform the object at 1/10th the speed, allowing much finer
control.
The magnitude of the transformation can be viewed in the 3D window header in the bottom left hand corner.
Releasing Ctrl or Shift during the transformation will cause the movement to revert back to its normal
mode of operation.
Note
The snapping behaviors described on this page only apply when Increment Snap is selected.
Read more about Window Headers

Usage
With hotkeys
Press the navigation hotkeys, and then hold either Ctrl, Shift or Ctrl-Shift.

With the Transform Manipulator
Hold Ctrl, Shift or Ctrl-Shift and click on the appropriate manipulator handle. Then move the mouse
in the desired direction. The reverse action will also work i.e. clicking the manipulator handle and then holding
the shortcut key for precision control.
Read more about the Transform Manipulator
Tip
Combining with other controls
All of the precision controls detailed on the page can be combined with the Axis Locking controls and used
with the different Pivot Points.
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Holding CTRL
Grab/move transformations

1 Bforartists Unit - shown at the default zoom level.

For grab/move operations at the default zoom level, holding Ctrl will cause your selection to move by
increments of 1 Bforartists Unit (1 BU) (i.e. between the two light grey lines). Zooming in enough to see the
next set of grey lines will now cause Ctrl movements to occur by 1/10 of a BU. Zooming in further until the
next set of grey lines becomes visible will cause movement to happen by 1/100 of a BU and so on until the
zoom limit is reached. Zooming out will have the opposite effect and cause movement to happen by increments
of 10, 100 etc BU.
Read more about Zooming

Rotation transformations
Holding Ctrl will cause rotations of 5 degrees.

Scale transformations
Holding Ctrl will cause size changes in increments of 0.1 BU.
Note
Snapping modes
Note that if you have a Snap Element option enabled, holding Ctrl will cause the selection to snap to the
nearest element.
Read more about Snapping

Holding SHIFT
Holding Shift during transformations allows for very fine control that does not rely on fixed increments.
Rather, large movements of the mouse across the screen only result in small transformations of the selection.

Holding CTRL and SHIFT
Grab/move transformations
For grab/move operations at the default zoom level, holding Ctrl-Shift will cause your selection to move
by increments of 1/10 Bforartists Units. Holding Ctrl-Shift at any zoom level will cause the transformation
increments to always be 1/10 of the increment if you were only holding Ctrl.
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Rotation transformations
Holding Ctrl-Shift will cause rotations of 1 degree.

Scale transformations
Holding Ctrl-Shift will cause size changes in 0.01 BU increments.

Numeric input

Numeric input in the 3D window header

Using the mouse for transformations is convenient, but if you require more precise control, you can also enter
numeric values. After pressing one of the navigation hotkeys, type a number to indicate the magnitude of the
transformation.
You can see the numbers you enter in the bottom left hand corner of the 3D window header. Negative numbers
and decimals can be entered by pressing the minus (Minus) and period (.) keys respectively.

Translation
To move Objects, vertices, faces or edges select the element, press G and then type a number. By default and
with no other key presses, movement will occur along the X-axis. To confirm the movement, press Return or
LMB. To cancel the movement, press Esc or RMB. If you mistype the value, press Backspace to cancel the
current entry and retype a new value.
To enter numeric values for multiple axes, use the Tab key after entering a value for the axis. e.g. To move an
Object, one (1) Bforartists unit on all three axes press: A navigation hotkey, let's say W for move, 1, Tab, 1,
Tab, 1. This will move the element one unit along the X-axis, followed by the Y-axis and then the Z-axis.
You can also combine numeric input with axis locking to limit movement to a particular axis. To do so, press a
navigation hotkey, let's say W for move, followed by X, Y or Z to indicate the axis. Then type in the transform
amount using (0 - 9) followed by Return to confirm. Pressing X, Y or Z will initially constrain movement to
the Global axis. Pressing X, Y or Z again will constrain movement to the orientation set in the Transform
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Orientation setting of the 3D window header.
Read more about Transform Orientations
Read more about Axis Locking

Rotation
To specify a value for clockwise rotation, press navigation hotkey for rotate, (0 - 9), then Return to confirm.
To specify counter-clockwise rotation press navigation hotkey for rotate, Minus, (kbd:0 - 9), then Return to
confirm. Note that 270 degrees of clockwise rotation is equivalent to -90 degrees of counter-clockwise rotation.

Scaling
Objects, faces and edges can be scaled by pressing the navigation hotkey for scale , (0 - 9), then Return to
confirm., Scaling transformations can also be constrained to an axis by pressing X, Y or Z after pressing the
navigation hotkey for scale. Essentially, scaling with numeric values works in almost identical
fashion to translation. The primary difference is that by default, scaling applies equally to all three axes. e.g.
pressing the navigation hotkey for scale , 0.5, Return will scale an Object by 0.5 on all three
axes.

Numeric input via the Properties shelf

Transformations can also be entered through the Transform panel on the Properties shelf.

It is also possible to enter numeric values for each transformation using the Transform panel found on the
Properties shelf. The Transform panel can also be used to prevent transformations along particular axes by
clicking the lock icon.

Transform Properties
Each object stores its position, orientation, and scale values. These may need to be manipulated numerically,
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reset, or applied.

Transform Properties Panel
Reference
Mode: Edit and Object modes
Menu: Object ‣ Transform Properties

The Transform Properties section in the View Properties panel allows you to view and manually/numerically
control the position, rotation, and other properties of an object, in Object mode. In Edit mode, it mainly allows
you to enter precise coordinates for a vertex, or median position for a group of vertices (including an
edge/face). As each type of object has a different set of options in its Transform Properties panel in Edit mode,
see their respective descriptions in the Modeling chapter.

Options in Object mode

Transform Properties panel in Object mode.

Location
The object’s center location in global coordinates.
Rotation
The object’s orientation, relative to the global axes and its own center.
Scale
The object’s scale, relative to its center, in local coordinates (i.e. the Scale X value represents the scale
along the local X-axis). Each object (cube, sphere, etc.), when created, has a scale of one Bforartists unit
in each local direction. To make the object bigger or smaller, you scale it in the desired dimension.
Dimensions
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The object’s basic dimensions (in Bforartists units) from one outside edge to another, as if measured with
a ruler. For multi-faceted surfaces, these fields give the dimensions of the bounding box (aligned with the
local axes - think of a cardboard box just big enough to hold the object).
Use this panel to either edit or display the object’s transform properties such as position, rotation and/or scaling.
These fields change the object’s center and then affects the aspect of all of its vertices and faces.

Transform Properties Locking
The locking feature of the Location, Rotation and Scale fields allows you to control a transform property solely
from the properties panel. Once a lock has been activated any other methods used for transformation are
blocked. For example, if you locked the Location X field then you can’t use the mouse to translate the object
along the global X axis. However, you can still translate it using the Location X edit field. Consider the locking
feature as a rigid constraint only changeable from the panel.
To lock a field, click the padlock icon next to the field. The field is unlocked if the icon appears as (

), and it is locked if the icon appears as (

).

Clear Object transformations
Reference
Mode: Object mode
Menu: Object ‣ Clear ‣ Clear Location/Clear Scale/Clear Rotation/Clear Origin

Description
Clearing transforms simply resets the transform values. The objects location and rotation values return to 0, and
the scale returns to 1.

Clear Options
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Clear Transformation menu

Clear Location
Clear (reset) the location of the selection. This will move the selection back to the coordinates 0,0,0.
Clear Scale
Clear (reset) the scale of the selection. This will resize the selection back to the size it was when created.
Clear Rotation
Clear (reset) the rotation of the selection. This will set the rotation of the selection to 0 degrees in each
plane.
Clear Origin
Clear (reset) the origin of the Child objects. This will cause Child objects to move to the coordinates of
the parent.

Apply Object transformations
Reference
Mode: Object mode
Menu: Object ‣ Apply ‣

Applying transform values essentially resets the values of object’s position, rotation, or scale, but does not
actually do anything to the object. The center point is moved to the origin and the transform values are set to
zero. In terms of scale, the scale values return to 1.
To apply a transform select the Apply sub-menu from the Object menu and select the appropriate transform to
apply
Make Duplicates Real unlinks linked duplicates so each duplicate now has its own data-block.

Apply Options

Apply Transformation menu

Apply Location
Apply (set) the location of the selection. This will make Bforartists consider the current location to be
equivalent to 0 in each plane i.e. the selection will not move, the current location will be considered to be
the “default location”. The Object Center will be set to actual 0,0,0 (where the colored axis lines intersect
in each view).
Apply Rotation
Apply (set) the rotation of the selection. This will make Bforartists consider the current rotation to be
equivalent to 0 degrees in each plane i.e. the selection will not rotated, the current rotation will be
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considered to be the “default rotation”.
Apply Scale
Apply (set) the scale of the selection. This will make Bforartists consider the current scale to be
equivalent to 0 in each plane i.e. the selection will not scaled, the current scale will be considered to be
the “default scale”.
Apply Rotation and Scale
Apply (set) the rotation and scale of the selection. Do the above two applications simultaneously.
Apply Visual Transform
Apply (set) the result of a constraint and apply this back to the Object’s location, rotation and scale. See
the following post for more detailed discussion: Apply visual transform.
Make Duplicate Real
Make any duplicates attached to this Object real so that they can be edited.

Proportional Edit
Proportional Edit is a way of transforming selected elements (such as vertices) while having that transformation
affect other nearby elements. For example, having the movement of a single vertex cause the movement of
unselected vertices within a given range. Unselected vertices that are closer to the selected vertex will move
more than those farther from it (i.e. they will move proportionally relative to the location of the selected
element). Since proportional editing affects the nearby geometry, it is very useful when you need to smoothly
deform the surface of a dense mesh.
Note
Sculpting
Bforartists also has Sculpting that contains brushes and tools for proportionally editing a mesh without seeing
the individual vertices.

Object mode
Reference
Mode: Object mode
Menu: Via the icon in the header indicated by the yellow square in the below image.

Proportional editing is typically used in Edit mode, however, it can also be used in Object mode. In Object
mode the tool works on entire objects rather than individual mesh components. In the image below, the green
cube is the active Object, while the red and blue cubes are located within the proportional edit tool’s radius of
influence. When the green cube is moved to the right, the other two cubes follow the movement.
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Proportional editing in Object mode.

Edit mode
Reference
Mode: Edit mode
Menu: Mesh ‣ Proportional Editing and via the highlighted icon in the below image

When working with dense geometry, it can become difficult to make subtle adjustments to the vertices without
causing visible lumps and creases in the model’s surface. When you face situations like this the proportional
editing tool can be used to smoothly deform the surface of the model. This is done by the tool’s automatic
modification of unselected vertices within a given range.

Proportional editing in Edit mode.
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Influence
You can increase or decrease the radius of the proportional editing influence with the mouse wheel WheelUp /
WheelDown or PageUp / PageDown respectively. As you change the radius, the points surrounding your
selection will adjust their positions accordingly.

Influence circle.

Options

Proportional Editing tool.

Falloff menu.

The Proportional Editing mode menu is on the 3D View header.
Disable
Proportional Editing is Off, only selected vertices will be affected.
Enable
Vertices other than the selected vertex are affected, within a defined radius.
Projected (2D)
Depth along the view is ignored when applying the radius.
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The difference between regular and Projected (2D) proportional option (right).

Connected
Rather than using a radius only, the proportional falloff spreads via connected geometry. This means that
you can proportionally edit the vertices in a finger of a hand without affecting the other fingers. While the
other vertices are physically close (in 3D space), they are far away following the topological edge
connections of the mesh. The icon will have a grey center when Connected is active. This mode is only
available in Edit mode.
Falloff
While you are editing, you can change the curve profile used by either using the Mesh ‣ Proportional
Falloff submenu, using the toolbar icon (Falloff menu), or by pressing Shift-O to toggle between the
various options.

Constant, No Falloff.

Random Falloff.

Linear Falloff.

Sharp Falloff.

Root Falloff.

Sphere Falloff.
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Smooth Falloff.

Examples
Switch to a front view (Numpad1) and activate the grab tool with G. As you drag the point upwards, notice
how nearby vertices are dragged along with it. When you are satisfied with the placement, click LMB to fix the
position. If you are not satisfied, cancel the operation and revert your mesh to the way it looked before with
RMB (or Esc).
You can use the proportional editing tool to produce great effects with the scaling (S) and rotation (R) tools, as
A landscape obtained via proportional editing shows.

A landscape obtained via proportional editing.

Combine these techniques with vertex painting to create fantastic landscapes. The final rendered landscape
image below shows the results of proportional editing after the application of textures and lighting.

Final rendered landscape.
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Manipulators
Reference
Mode: Object and Edit modes

In combination with axis locking, the normal Transform commands, can be used to manipulate objects along
any axis. However, there may be times when these options are not adequate. For example, when you want to
translate a single face on a randomly rotated object in a direction perpendicular to the face’s normal. In
instances like this, Transform Manipulators may be useful.

Manipulator options in the Window Header.

Transform manipulators provide a visual representation of the transform options and allow movement, rotation
and scaling along any axis, mode and orientation of the 3D view. The manipulator can be enabled by clicking
on the axis icon from the manipulator options portion of the window header or via the shortcut key CtrlSpacebar.
There is a separate manipulator for each Transform Command. Each manipulator can be used separately or in
combination with the others. Clicking with Shift-LMB on multiple manipulator icons (arrow, arc, box) will
combine manipulator options.
Manipulators can be accessed in the header of the 3D View window:
•
•
•
•
•

Axis: Enable/disable the manipulators.
Arrow: Translation.
Arc: Rotation.
Box: Scale.
Transform Orientation menu: choice of the transformation orientation.

Manipulator Options

Manipulator controls
• Holding down Ctrl constrains the action to set increments. Holding down Shift after you LMB the
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manipulator handle will constrain the action to smaller increments.
• Holding down Shift before you LMB click on one of the handles will cause the manipulator action to
be performed relative to the other two axes (you can let go of Shift once you have clicked). For
example, if you Shift then LMB the Z axis handle of the translate manipulator, movement will occur in
the X and Y planes.
• When in rotate mode, LMB on the white circle (largest circle around the rotation manipulator) will be
equivalent to pressing R.
• When in rotate mode, LMB on the grey circle (small inner circle at the center of the rotation manipulator)
will be equivalent to pressing R twice. This will start trackball rotation.
Read more about constraining transformations Read more about axis locking Read more about trackball
rotation

Manipulator Preferences

Manipulator preferences.

The settings of the manipulator (e.g. its size) can be found in the Interface section of the User Preferences
window.
Size
Diameter of the manipulator.
Handle Size
Size of manipulator handles, as a percentage of the manipulator radius (size / 2).
Hotspot
Hotspot size (in pixels) for clicking the manipulator handles.

Choosing the Transform Orientation
Reference
Mode: Object and Edit modes
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Transform Orientation options.

You can also change the orientation of the Transform Manipulator to global, local, gimbal, normal or view
from the Transform options menu. The image below shows a cube with the rotation manipulator active in
multiple transform orientations. Notice how the manipulator changes depending on the orientation selected
(compare A with F).
Similarly, notice how when normal orientation (F and G) is selected the manipulator changes between Object
mode and Edit mode. The normal orientation manipulator will also change depending on what is selected in
Edit mode i.e. the orientation is based on the normal of the selection which will change depending on how
many and which faces, edges or vertices are selected.

Transform manipulator orientation options.

1.
2.
3.
4.
5.
6.
7.
8.

Standard cube in default top view with global orientation selected
Standard cube with view rotated and global orientation selected
Randomly rotated cube with view rotated and global orientation selected
Randomly rotated cube with local orientation selected
Randomly rotated cube with gimbal orientation selected
Randomly rotated cube with normal orientation selected
Randomly rotated cube, vertices selected with normal orientation selected
Randomly rotated cube with view orientation selected

Transform Orientations
Reference
Mode: Object and Edit modes
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Transform orientations selection menu.

Orientations affect the behavior of Transformations: Location, Rotation, and Scale. You will see an effect on the
3D Manipulator (the widget in the center of the selection), as well as on transformation constraints (like axis
locking). This means that, when you press the navigation hotkey for move and X, it will constrain to the global
x-axis, but if you press the navigation hotkey for move-X-X it will constrain to your Transform Orientation s
x-axis.

Alt+Space Menu.

The Orientations options can be set on the 3D View’s header (or “footer”, since it is at the bottom of the view
by default), or with Alt-Spacebar or through the Orientation menu in a 3D view header.
In addition to the four built-in options, you can define your own custom orientation (see Custom Orientations
below).

Our Demo Cube
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To demonstrate the various behaviors, we add some colors to the default cube, rotate it -15º along its local z- and x-axes,
and we scale its “y” face down.

Please note two things:
• The “Mini-axis” in the lower-left corner, which represents the Global x/y/z orientation.
• The “Object Manipulator” widget emanating from the selection, which represents the current
Transform Orientation.
• If you click on one of the axes of the Manipulator with LMB, it will allow you to constrain
movement to only this direction. An example of a keyboard equivalent is the navigation hotkey
for move, Z, Z.
• If you Shift-LMB click, it will lock the axis you clicked on and allow you to move in the plane
of the two remaining axes. The keyboard analogue is the navigation hotkey for move, ShiftZ, Shift-Z.

Orientations
Global

Global.

The manipulator matches the global axis.
When using the Global orientation, the orientation’s XYZ matches world’s XYZ axis. When this mode is
selected, the local coordinates of the object are subjected to the Global coordinates. This is good to place
objects in the scene. To constrain an axis, press G and the desired axis. To constrain to a local axis, press
the desired axis two times. The difference between Global and Local, is more noticeable when you have
an object in which the origin is not located at the exact center of the object, and doesn’t match the Global
coordinates.
Local
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Local.

The manipulator matches the object axis.
Notice that, here, the Manipulator is at a slight tilt (it is most visible on the object’s y-axis, the green
arrow). This is due to our 15º rotation of the object. This demonstrates the difference between local
coordinates and global coordinates. If we had rotated the object 90º along its x-axis, we would see that the
object’s “Up” is the world’s “Forward” – or the object’s z-axis would now be the world’s y-axis. This
orientation has an effect on many parts of the interface, so it is important to understand the distinction.
Normal

Normal.

The z-axis of the manipulator will match the normal vector of the selection.
In Object Mode, this is equivalent to Local Orientation, in Edit Mode, it becomes more interesting.
As you see, the light blue lines indicate the faces’ normals, and the darker blue lines indicate the vertex
normals (these were turned on in the N Properties Panel under Mesh Display ‣ Normals ‣ Face and
Vertex). Selecting any given face will cause our Manipulator’s z-axis to align with that normal. The same
goes for Vertex Select Mode. Edge Select is different–A selected Edge has the z-axis aligned with it (so
you will have to look at the Manipulator widget to determine the direction of x and y). If you select
several elements, it will orient towards the average of those normals.
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A great example of how this is useful is in Vertex Select Mode: Pick a vertex and then do the navigation
hotkey for move, Z, Z to tug it away from the mesh and shove it into the mesh. To make this even
more useful, select a nearby vertex and press Shift- the navigation hotkey for rotate
to repeat the same movement—except along that second vertex’s normal instead.
Gimbal

Gimbal.

Gimbal’s behavior highly depends on the current Rotation Mode (accessible in the N Properties Panel in
the 3D View, in top section, Transform).
XYZ Euler
The manipulator handles are aligned to the euler axis, allowing you to see the discreet XYZ axis
underlying the euler rotation, as well as possible gimbal lock.
Axis Angle
The x, y, and z coordinates define a point relative to the object origin through which an imaginary
“skewer” passes. The w value is the rotation of this skewer. Here, the Manipulator’s z-axis stays
aligned with this skewer.
Quaternion
Though Quaternion rotation is very different from the Euler and Axis Angle rotation modes, the
Manipulator behaves the same as in Local mode.
View

View.

The manipulator will match the 3D view:
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Y:
Up/Down
X:
Left/Right,
Z:
Towards/Away from you.
This way you can constrain movement to one View axis with the navigation hotkey for move-X-X.

Custom Orientations
Reference
Mode: Object and Edit modes

custom orientation

You can define custom transform orientations, using object or mesh elements. Custom transform orientations
defined from objects use the local orientation of the object whereas those defined from selected mesh elements
(vertices, edges, faces) use the normal orientation of the selection.
The Transform Orientations panel, found in the Properties Panel, can be used to manage transform orientations:
selecting the active orientation, adding and deleting custom orientations.

Renaming a Custom Orientation

The default name for these orientations comes from whatever you have selected. If an edge, it will be titled,
“Edge,” if an object, it will take that object’s name, etc. The Toolshelf (T in the 3D View) allows you to rename
the custom orientation after you press Ctrl-Alt-Spacebar.
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Figure 1.

The technique of creating custom orientations can become important in creating precise meshes. In Figure 1, to
achieve this effect:
•
•
•
•
•
•
•

Select the object’s sloping top edge
Create a Custom Orientation with Ctrl-Alt-Spacebar and rename it “Top Edge”.
Select the objects’s bottom, right edge.
Extrude
Cancel the extrusion’s default movement by pressing RMB or Esc.
Hit G to reinitiate movement.
Hit the navigation hotkey for scale-Z to constrain to the “Top Edge” orientation.

Axis Locking
Description
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Axis locking

Transformations (translation/scale/rotation) in Object and Edit mode, as well as extrusion in Edit mode) can be
locked to particular axis relative to the current transform orientation. By locking a transformation to a
particular axis you are restricting transformations to a single dimension.

Usage
A locked axis will display in a brighter color than an unlocked axis. For example in the image to the right, the Z
axis is drawn in light blue as movement is constrained to this axis. This example can be achieved in two ways:
• Press the navigation hotkey for move to enable translation, press Z to constrain movement to the Z-axis.
• Press the navigation hotkey for move to enable translation, move the mouse in the Z
direction, then press MMB.

Axis locking types
Axis locking
Reference
Mode: Object and Edit modes (translate, rotate, scale, extrude)

Axis locking limits the transformation to a single axis (or forbids transformations along two axes). An object,
face, vertex or other selectable item will only be able to move, scale or rotate in a single dimension.

Plane locking
Reference
Mode: Object and Edit modes (translate, scale)
Hotkey: Shift-X, Shift-Y, Shift-Z or Shift-MMB

after moving the mouse in the desired direction.
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Plane locking

Plane locking locks the transformation to two axes (or forbids transformations along one axis), thus creating a
plane in which the element can be moved or scaled freely. Plane locking only affects translation and scaling.
Note that for rotation, both axis and plane locking have the same effect because a rotation is always constrained
around one axis. Trackball type rotations cannot be locked at all.
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Axis locking modes

Axis locking modes

A single key press constrains movement to the corresponding Global axis. A second key press of the same key
constrains movement to the current transform orientation selection (except if it is set to Global, in which case
the Local orientation is used). Finally, a third key press of the same key removes constraints.
For example, if the current transform orientation is set to Normal, pressing the navigation hotkey for move to
start translation, followed by Z will lock translation in the Z direction relative to the Global orientation,
pressing Z again will lock translation to the Z axis relative to the Normal orientation. Pressing Z again will
remove all constraints. The current mode will be displayed in the left hand side of the 3D window header.

As can be seen in the Axis locking modes image, the direction of the transform also takes into account the
selection. Sections A and B show Z axis locking in Global and Normal orientations respectively. C and D show
the same situation with face selection, E and F with edge selection and G and H with vertex selection.

86

Bforartists Reference Manual - © Copyright - This page is under OCL license

Note that using a locked axis does not prevent you from using the keyboard to enter numeric transformation
values.

Snapping
There are two types of snap operations that you can use in Bforartists. The first type snaps your selection or
cursor to a given point while the second type is used during transformations (translate, rotate, scale) and snaps
your selection to elements within the scene.

Snap
Reference
Mode: Object and Edit modes

The Snap menu (also available from the 3D header in both Object and Edit mode (Object ‣ Snap and Mesh ‣
Snap). This menu provides a number of options to move the cursor or your selection to a defined point (the
cursor, selection or the grid).
Selection to Grid
Snaps the currently selected object(s) to the nearest grid point.
Selection to Cursor
Snaps the currently selected object(s) to the cursor location.
Cursor to Selected
Moves the cursor to the center of the selected object(s).
Cursor to Center
Moves the cursor to the center of the grid.
Cursor to Grid
Moves the cursor to the nearest grid point.
Cursor to Active
Moves the cursor to the center of the active object.

Transform Snapping
The ability to snap Objects and Mesh element to various types of scene elements during a transformation is
available by toggling the magnet icon (which will turn red) in the 3D view’s header buttons.

Magnet icon in the 3D view header (red when enabled).
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Snap Element

Snap Element menu

Volume
Snaps to regions within the volume of the first Object found below the mouse cursor. Unlike the other
options, this one controls the depth (i.e. Z-coordinates in current view space) of the transformed element.
By toggling the button that appears to the right of the snap target menu (see below), target objects will be
considered as a whole when determining the volume center.
Face
Snap to the surfaces of faces in mesh objects. Useful for retopologizing.
Edge
Snap to edges of mesh objects.
Vertex
Snap to vertices of mesh objects.
Increment
Snap to grid points. When in Orthographic view, the snapping increment changes depending on zoom
level.
Note
In this context the grid does not mean the visual grid cue displayed. Snapping will use the resolution of
the displayed grid, but all transformations are relative to the initial position (before the snap operation).

Snap Target
Snap target options become active when either Vertex, Edge, Face, or Volume is selected as the snap element.
These determine what part of the selection snaps to the target objects.
Active
Moves the active element (vertex in Edit mode, object in Object mode) to the target.
Median
Moves the median of the selection to the target.
Center
Moves the current transformation center to the target. Can be used with 3D cursor to snap with an offset.
Closest
Moves the closest point of the selection to the target.
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Closest

Median

Active

Additional snap options

Object mode

Edit mode

As seen by the red highlighted areas in the image above, additional controls are available to alter snap
behaviour. These options vary between mode (Object and Edit) as well as Snap Element. The four options
available are:
•
Align rotation with the snapping target.

•
Project individual elements on the surface of other objects.

•
Snaps elements to its own mesh.

•
Consider Objects as whole when finding volume center.
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Multiple Snap Targets

Multiple snapping targets.

Once transforming a selection with Snapping on (not just with the Ctrl key held), you can press A to mark the
current snapping point, then proceed to mark as many other snapping points as you wish and the selection will
be snapped to the average location of all the marked points.
Marking a point more than once will give it more weight in the averaged location.

Pivot Point
Reference
Mode: Object mode and Edit mode
Menu: Droplist in the header of the 3D view
The pivot point is the point in space around which all rotations, scalings and mirror
transformations are centered. You can choose one of five Pivot Points from a dropdown list in the header of any 3D area, as seen here in (Pivot Point modes). The pages
below describe each Pivot Point mode in more detail.
Note that even if the above examples use meshes, the same rules apply for other types
(curves, surfaces...) as well.

Active Element as Pivot
Reference
Mode: Object mode and Edit mode
Menu: Select from the following icon in the 3D window header

The active element can be an Object, vertex, edge or a face. The active element is the last one to be selected and
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will be shown in a lighter orange color when in Object mode and white when in Edit mode. With Active element
as Pivot set to active, all transformations will occur relative to the active element.
Read more about selecting different Pivot Points

Display of active elements in Object mode is shown on the left of the image where the active element (cube) is a lighter
orange. Active elements for vertices, edges and faces in Edit mode are displayed in white and are shown on the right.

In Object mode
When in Object mode, rotation and scaling happen around the active Object’s center. This is shown by the
figure to the below where the active Object (the cube) remains in the same location (note its position relative to
the 3D cursor) while the other Objects rotate and scale in relation to the active element.

Rotation and scaling with the cube as the active element.

In Edit mode
Using the active element as a pivot point in Edit mode may seem complex but all the possible transformations
follow a few rules:
• The pivot point is always at the median of the active element(s).
• The transformations occur by transformation of the vertices of the selected element(s). If an unselected
element shares one or more vertices with a selected element then the unselected one will get some
degree of transformation also.
Let’s examine the following examples: in each case we will see that the two rules apply.
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Single selection
When one single element is selected it becomes automatically active. In the image below, you can see that when
it is transformed its vertices move, with the consequence that any adjacent element which shares one or more
vertices with the active element is also transformed.

Edit mode and only one element selected.

Let’s review each case:
• Faces have their pivot point where their selection dot appears, which is where the median of their
vertices is.
• Edges have their pivot point on their middle since this is always where the median of an edge is.
• A single Vertex has no dimensions at all so it can’t show any transformation (except translation, which is
not affected by the pivot point).

Multiple selection
When multiple elements are selected they all transform. The pivot points stay in the same place as what we’ve
seen above, with only one exception for Fgons. In the image below, the selected elements have been rotated.

Edit mode and multiple selections.

•
•
•
•

For Faces the transformation occurs around the selection dot of the active face.
Edges also keep the same behavior with their pivot point at their median.
Fgons behave exactly like faces.
There is a case for Vertices this time: the active Vertex is where the pivot point resides. All other vertices
are transformed relative to it.
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Median Point as Pivot
Reference
Mode: Object mode and Edit mode
Menu: Select from the following icon in the 3D window header

The Median Point can be considered to be broadly similar to the concept of Center of Gravity (COG). If we
assume that every element (Object, face, vertex etc) of the selection has the same mass, the median point would
sit at the point of equilibrium for the selection (the COG).

In Object Mode
In Object Mode, Bforartists only considers the Object centers when determining the median point. This can lead
to some counterintuitive results. In the Object Mode median points image below, you can see that the median
point is between the Object centers and can be nowhere near the Objects’ mesh.

Median points in Object Mode. The Median point is indicated by the yellow dot.

In Edit Mode
In Edit Mode, the median point is determined via the part of the selection that has the most elements. For
example, in the Median points in Edit Mode image, when there are two cubes with an equal number of vertices,
the median point lies directly between the two cubes. However, if we subdivide one cube multiple times so that
it has many more vertices, you can see that the median point has shifted to the region with the most vertices.
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Median points in Edit Mode. The Median point is indicated by the yellow dot.

Individual Origins as Pivot
Reference
Mode: Object mode and Edit mode
Menu: Select from the following icon in the 3D window header

In Object mode

Rotation around individual origins.

The Origin of an Object is shown in the 3D view by a small orange circle. This is highlighted in the image to
the right by the red arrow. The origin tells Bforartists where that Object is in 3D space. What you see in the 3D
view (vertices, edges etc) is what makes up the Object.
While the Origin is equivalent to the center of the Object, it does not have to be located in the center of the
Mesh. This means that an Object can have its center located on one end of the mesh or even completely outside
the mesh. For example, the orange rectangle in the image has its Origin located on the far left of the mesh.
Now let’s examine Rotation around the individual origins.
• The blue rectangle has its Origin located in the center of the mesh, while the orange rectangle has its
Origin located on the left hand side.
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• When the Pivot Point is set to Individual Origins, the center of each Object (indicated by the red arrow)
remains in place while the Object rotates around it in the path shown by the black arrow.

In Edit mode
In Edit mode, setting the Pivot Point to Individual Origins produces different results when the selection mode is
set to Vertex, Edge or Face. For example, Vertex mode produces results similar to setting the pivot point to
median and Edge mode often produces distorted results. Using Individual Origins in Face mode produces the
most predictable results.

Rotation of individual faces with the pivot point indicated Rotation of grouped faces with the pivot point indicated
by the image text.

by the image text.

As can be seen in the images above, faces that touch each other will deform when rotated when the pivot point
is set to Individual Origins. Faces that do not touch will rotate around their Individual Origins (their center).

Scaling with non-touching faces.

Scaling with touching faces.

Groups of faces and Fgons can be scaled without their outside perimeter being deformed. However, the
individual faces inside will not be scaled uniformly.
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Modeling with faces and individual origins as the pivot point.

Once you are aware of its limitations and pitfalls, this tool can save a lot of time and lead to unique shapes. This
“anemone” was modeled from a 12 sided cylinder in about 10 minutes by repeatedly using this workflow:
extrusions of individual faces, scaling with median as a pivot point, and scaling and rotations of those faces
with Individual Origins as pivot points.

3D Cursor as Pivot
Reference
Mode: Object mode and Edit mode
The 3D cursor is the most intuitive of the pivot points. With the 3D cursor selected as the active pivot point
(from either the Window Header or via the . hotkey), simply position the 3D cursor and then do the required
transformation. All rotation and scaling transformations will now be done relative to the location of the 3D
cursor. The image below shows the difference when rotating an Object from its starting position (first panel) 90
degrees around the median point (second panel) and 90 degrees around the 3D cursor (third panel).
Read more about selecting different Pivot Points
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Rotation around the 3D cursor compared to the median point.

Bounding Box Center as Pivot
Reference
Mode: Object mode and Edit mode
Menu: Select from the following icon in the 3D window header

The bounding box is a rectangular box that is wrapped as tightly as possible around the selection. It is oriented
parallel to the world axes. In this mode the pivot point lies at the center of the bounding box. You can set the
pivot point to bounding box with the , hotkey or via the menu in the Window Header. The image below shows
how the Object’s Bounding Box size is determined by the size of the Object.
Read more about selecting different Pivot Points

Relationship between an Object and its Bounding Box.

In Object mode
In Object mode, the bounding box is wrapped around the Object and transformation takes place relative to the
location of the Object center (indicated by the yellow circle). The image below shows the results of using the
Bounding Box as the pivot point in a number of situations.
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For example, images A (before rotation) and B show rotation when the Object center is in its default position,
while images C (before rotation) and D shows the result when the Object center has been moved. Image E
shows that when multiple Objects are selected, the pivot point is calculated based on the Bounding Box of all
the selected Objects.

The grid of four images on the left (ABCD) shows the results of Object rotation when the pivot point is set to Bounding Box.
The image to the right (E) shows the location of the Bounding Box pivot point when multiple Objects are selected. The pivot
point is shown by a yellow circle.

In Edit mode
This time it is the ObData that is enclosed in the bounding box. The bounding box in Edit mode takes no
account of the Object(s) centers, only the center of the selected vertices.

The effects of rotation in different mesh selection modes when the bounding box is set as the pivot point. The pivot point is
shown by a yellow circle.
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Relationships
Relationships describes everything around interaction of objects. Grouping etc.

Grouping objects

Grouped objects

There can be many objects in a scene: A typical stage scene consists of furniture, props, lights, and backdrops.
Bforartists helps you keep everything organized by allowing you to group like objects together.
Group objects together without any kind of transformation relationship. Use groups to just logically organize
your scene, or to facilitate one-step appending or linking between files or across scenes. Objects that are part of
a group always shows as light green when selected; see image (Grouped objects).

Options
Creating a Group
Look in the Object menu / Group submenu

99

Bforartists Reference Manual - © Copyright - This page is under OCL license

Naming a Group

Naming a Group
All groups that an object has been assigned to are listed in the Object Properties Panel ‘s Relations panel.
To rename a group, simply click in the groups name field. To name groups in the Outliner window, select
Groups as the outliner display from the header combo box, and Ctrl-LMB click on the group name. The
name will change to an editable field; make your changes and press Return.
Restricting Group Contents via Layers
The cluster of layer buttons attached to each group determines from which layers the group objects will
be included when duplicated. If your group contains objects on layers 10, 11 and 12, but you disable the
layer 12 button in the group controls, duplicates of that group (using the Dupligroup feature) will only
show the portions of the group that reside in layers 10 and 11.
Appending or Linking Groups
To append a group from another .blend file, consult this page. In summary, File ‣ Link / Append Link
Select a .blend file and, and then the group.
Removing Groups
To remove a object from a group, under the object context button, open the “Groups” pane. Find the name
of the group from which you wish to remove the object, and click the x to the right of the group name.
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Select Grouped
Reference
Mode: Object mode
Menu: Select –> Grouped
Select objects by parenting and grouping characteristics. See Select Grouped for more information.

Parenting Objects
When modeling a complex object, such as a watch, you may choose to model the different parts as separate
objects. However, all of the parts may be attached to each other. In these cases, you want to designate one
object as the parent of all the children. Movement, rotation or scaling of the parent also affects the children.
To parent objects, select at least two objects (select the Child Objects first, and select the Parent Object last),
and press Ctrl-P. The Set Parent To dialog will pop up allowing you to select from one of several possible
different parenting types. Selecting one of the entries in Set Parent To confirms, and the child/children to parent
relationship is created.
The last object selected will be the Active Object (outlined in light orange), and will also be the Parent Object.
If you selected multiple objects before selecting the parent, they will all be children of the parent and will be at
the same level of the hierarchy (they are “siblings”).
The Set Parent To pop-up dialog is context sensitive, which means the number of entries it displays can change
depending on what objects are selected when the Ctrl-P shortcut is used.
For non-inverse-mode, press Shift-Ctrl-P instead. This creates an alternative parent-child-relationship
where child-objects exist entirely in the parent’s coordinate system. This is the better choice for CAD purposes,
for example.
Moving, rotating or scaling the parent will also usually move/rotate/scale the child/children. However
moving/rotating/scaling the child/children of the parent will not result in the parent moving/rotating/scaling. In
other words, the direction of influence is from parent to child and not child to parent.
In general when using the Ctrl-P or [3D View Editor Header > Object Menu > Parent Menu] entires to parent
objects, the Child Objects can only have one Parent Object. If a Child Object already has a Parent Object and
you give it another parent then Bforartists will automatically remove the previous parent relationship.
Bforartists supports many different types of parenting, listed below:
•
•
•
•
•
•
•

Object
Armature Deform
Bone
Curve Deform
Path Constraint
Lattice Deform
Vertex
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• Vertex (Triangle)

Object Parent
Object Parent is the most general form of parenting that Bforartists supports. If will take selected objects and
make the last selected object the Parent Object, while all other selected objects will be Child Objects.

Object (Keep Transform) Parent
Object (Keep Transform) Parent works in a very similar way to Object Parent the major difference is in
whether the Child Objects will remember any previous transformations applied to them from the previous
Parent Object.
Since explaining this in an easy to understand technical way is hard, lets instead use an example to demonstrate.
Assume that we have a scene consisting of 3 objects, those being 2 Empty Objects named “EmptyA” and
“EmptyB”, and a Monkey object. See figure 1.

Figure 1 - Scene with 2 Empties and a Monkey, no parenting currently active.

Figure 1 shows the 3 objects with no parenting relationships active on them.
If you select the Monkey object by RMB click and then Shift-RMB click “EmptyA” object and press Ctrl-P
and then select Object from the Set Parent To pop-up dialog box. This will result in “EmptyA” object being the
Parent Object of the Monkey object. With only “EmptyA” selected rotating/scaling/moving it will result in the
Monkey object being altered respectively.
Scale the “EmptyA” object, so that the Monkey becomes smaller and moves to the left a little. See figure 2.
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Figure 2 - Scene with Monkey object being the Child Object of “EmptyA”. “EmptyA” has been scaled resulting in the Monkey
also being scaled and moved to the left.

If you select only the Monkey object by RMB click and then Shift-RMB click “EmptyB” object and press
Ctrl-P and select Object from the Set Parent To pop-up dialog box. This will result in “EmptyB” object being
the Parent Object of the Monkey object. Notice that when you change the parent of the Monkey the scale of the
Monkey changed. See figure 3.

Figure 3 - Scene with Monkey object having its a parent changed from “EmptyA” to “EmptyB” and the resulting change in
scale.

This happens because the Monkey object never had its scale altered directly, the change came about because it
was the child of “EmptyA” which had its scale altered. Changing the Monkey’s parent to “EmptyB” resulted in
those indirect changes in scale being removed, because “EmptyB” has not had its scale altered.
This is often the required behaviour, but it is also sometimes useful that if you change your Parent Object that
the Child Object keep any previous transformations it got from the old Parent Object; If instead when changing
the Parent Object of the Monkey from “EmptyA” to “EmptyB” we had chosen parenting type Object (Keep
Transform), the Monkey would keep its scale information it obtained from the old parent “EmptyA” when it is
assigned to the new parent “EmptyB”; See Figure 4.
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Figure 4 - Scene with Monkey object having its a parent changed from “EmptyA” to “EmptyB” using ‘Object (Keep
Transform)’ parent method.

If you want to follow along with the above description here is the blend file used to describe Object (Keep
Transform) parenting method:
File:Parent_-_Object_(Keep_Transform)_(Demo_File).blend

Armature Deform Parent
An Armature in Bforartists can be thought of as similar to the armature of a real skeleton, and just like a real
skeleton an Armature can consist of many bones. These bones can be moved around and anything that they are
attached to or associated with will move and deform in a similar way.
In Bforartists Armature Object Types are usually used to associate certain bones of an Armature to certain parts
of a Mesh Object Types Mesh Geometry. You are then able to move the Armature Bones and the Mesh Object
will deform. See figure 5.
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Figure 5 - Armature Object Bone associated with another Mesh Object, as the bone move the Mesh deforms similarly.

Armature Deform Parenting is one of the most flexible ways of associating Bones in an Armature to another
Object, it gives a lot of freedom but that comes at the price of a little complexity, as there are multiple steps
involved in setting up Armature Deform Parenting such that deformations are actually carried out.
Bforartists has several different ways of Parenting an Armature to an object, most of them can automate several
of the steps involved, but all of them ultimately do all the steps we describe for Armature Deform Parenting.
Using the Armature Deform Parenting operator is the first step in setting up the relationship between an
Armature Object and it’s Child Objects.
To use Armature Deform Parenting you must first select all the Child Objects that will be influenced by the
Armature and then lastly select the Armature Object itself. Once all the Child Objects and the Armature Object
are selected press Ctrl-P and select Armature Deform in the Set Parent To pop-up dialog. See figure 6.

Figure 6 - Set Parent To dialog with Armature Deform Parenting option highlighted.

Once this is done the Armature Object will be the Parent Object of all the other Child Objects, also we have
informed Bforartists that the Bones of the Armature Object can be associated with specific parts of the Child
Objects so that they can be directly manipulated by the Bones.
At this point however all Bforartists knows is that the Bones of the Armature could be used to alter the Child
Objects, we haven’t yet told Bforartists which Bones can alter which Child Objects or by how much.
To do that we must individually select each Child Object individually and toggle into Edit Mode on that Child
Object. Once in Edit Mode we can then select the vertices we want to be influenced by the Bones in the
Armature. Then with the vertices still selected navigate to [Properties Editor > Object Data Context > Vertex
Groups Panel] and create a new Vertex Group with the same name as the Bone that you want the selected
105

Bforartists Reference Manual - © Copyright - This page is under OCL license

vertices to be influenced by.
Once the Vertex Group has been created we then assign the selected vertices to the Vertex Group by clicking the
Assign Button. By default when selected vertices are assigned to a Vertex Group they will have an Influence
Weight of 1.0 This means that they are fully influenced when a Bone they are associated with is moved, if the
Influence Weight had been 0.5 then when the bone moves the vertices would only move half as much. See
figure 7.

Figure 7 - Properties Editor > Object Data Context > Vertex Groups Panel with Assign Button and influence Weight Slider
highlighted.

Once all these steps have been carried out, the Bones of the Armature Object should be associated with the
Vertex Groups with the same names as the Bones. You can then select the Armature Object and switch to Pose
Mode in the [3D View Editor Header > Mode Select Button]. See figure 8.
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Figure 8 - 3D View Editor Header > Mode Select Button] set to Pose Mode, with Armature Bone highlighted in Cyan and
effecting the Mesh Object

Once in Pose Mode transforming one of the Bones of the Armature that has been associated with vertices of an
object will result in those vertices also being transformed.

Armature Deform Parent With Empty Groups
The Armature Deform With Empty Groups parenting method works in almost the same way as Armature
Deform parenting with one difference. That difference is that when you parent a Child Object to an Armature
Object the names of the bones in the armature are copied to the Child Objects in the form of newly created
Vertex Groups, one for each different deforming armature bone name. The newly created Vertex Groups will be
empty this means they will not have any vertices assigned to those Vertex Groups. You still must manually
select the vertices and assign them to a particular Vertex Group of your choosing to have bones in the armature
influence them.
For example if you have an Armature Object which consists of 3 bones named BoneA, BoneB and BoneC and
Cube Mesh Object type called Cube. If you parent the Cube Child Object to the Armature Parent Object the
Cube will get 3 new Vertex Groups created on it called BoneA, BoneB and BoneC. Notice that each Vertex
Group is empty. See figure 21.
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Figure 21 - Cube in Edit Mode showing the 3 created Vertex Groups after it was parented using Armature Deform With
Empty Groups to an Armature with 3 Bones named BoneA, BoneB and BoneC with the Vertex Group Panel shown. All the
Vertex Groups are empty.

Bones in an Armature can be generally classified into 2 different types:
• Deforming Bones
• Control Bones
Deforming Bones - Are bones which when transformed will result in vertices associated with them also
transforming in a similar way. Deforming Bones are directly involved in altering the positions of vertices
associated with their bones.
Control Bones - Are Bones which act in a similar way to switches, in that they control how other bones or
objects react when they are transformed. A Control Bone could for example act as a sliding switch control,
when the bone is in one position to the left it could indicate to other bones that they react in a particular way
when transformed, when the Control Bone is positioned to the right, transforming other bones or objects could
do something completely different. Control Bones are not directly used to alter the positions of vertices, in fact
Control Bones often have no vertices directly associated with themselves.
When using the Armature Deform With Empty Groups parenting method Vertex Groups on the Child Object
will only be created for Armature Bones which are setup as Deforming Bone types. If a Bone is a Control Bone
no Vertex Group will be created on the Child Object for that bone.
To check weather a particular bone in an armature is a Deforming Bone simply switch to Pose Mode or Edit
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Mode on the armature and select the bone you are interested in by RMB it. Once the bone of interest is selected
navigate to [Properties Editor > Bone Context > Deform Panel] and check if the Deform tickable option is
ticked or not. If it is the selected bone is a Deforming Bone, otherwise it is a Control Bone. See figure 22.

Figure 22 - 3 Bone Armature in Edit Mode with 2nd bone selected with [Properties Editor > Bone Context > Deform Panel]
displayed an ticked, indicating the bone is a Deforming Bone.

Armature Deform With Automatic Weights
Armature Deform With Automatic Weights parenting feature does everything Armature Deform With Empty
Groups does with one extra thing. That extra thing is that unlike Armature Deform With Empty Groups which
leaves the automatically created Vertex Groups empty with no vertices assigned to them; Armature Deform
With Automatic Weight will try to calculate how much Influence Weight a particular Armature Bone would
have on a certain collection of vertices based on the distance from those vertices to a particular Armature Bone.
Once Bforartists has calculated the Influence Weight vertices should have it will assign that Influence Weight to
the Vertex Groups that were previously created automatically by Bforartists on the Child Object when Armature
Deform With Automatic Weights parenting command was carried out.
If all went well it should be possible to select the Armature Object switch it into Pose Mode and transform the
bones of the Armature and the Child Object should deform in response. Unlike Armature Deform parenting you
won’t have to create Vertex Groups on the Child Object, neither will you have to assign Influences Weights to
those Vertex Groups, Bforartists will try to do it for you.
To activate Armature Deform With Automatic Weights you must be in Object Mode or Pose Mode, then select
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all the Child Objects (usually Mesh Object Types) and lastly select the Armature Object; Once done press
Ctrl-P and select the Armature Deform With Automatic Weights from the Set Parent To pop-up dialog.
This method of parenting is certainly easier setup but it can often lead to Armatures which do not deform Child
Objects in ways you would want, as Bforartists can get a little confused when it comes to determining which
Bones should influence certain vertices when calculating Influence Weights for more complex armatures and
Child Objects. Symptoms of this confusion are that when transforming the Armature Object in Pose Mode parts
of the Child Objects don’t deform as you expect; If Bforartists does not give you the results you require you
will have to manually alter the Influence Weights of vertices in relation to the Vertex Groups they belong to and
have influence in.

Armature Deform With Envelope Weights
Works in a similar way to Armature Deform With Automatic Weights in that it will create Vertex Groups on the
Child Objects that have names matching those of the Parent Object Armature Bones. The created Vertex Groups
will then be assigned Influence Weights. The major difference is in the way those Influence Weights are
calculated.
Influence Weights that are calculated when using Armature Deform With Envelope Weights parenting are
calculated entirely visually using Bone Envelopes. See figure 28.

Figure 28 - Single Armature Bone in Edit Mode with Envelope Weight display enabled. The gray volume around the bone is
the Bone Envelope.

Figure 28 shows a single Armature Bone in Edit Mode with Envelope Weight activated. The gray semi110
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transparent volume around the bone is the Bone Envelope.
Any Child Object that has vertices inside the volume of the Bone Envelope will be influenced by the Parent
Object Armature when the Armature Deform With Envelope Weights operator is used. Any vertices outside the
Bone Evelope volume will not be influenced. See figure 29.

Figure 29 - 2 sets of Armatures each with 3 bones, the first set has all vertices inside the Bone Envelope, the second did not.
When the bones are transformed in Pose Mode the results are very different.

The default size of the Bone Envelope volume does not extend very far from the surface of a bone; You can
alter the size of the Bone Envelope volume by clicking on the body of the bone you want to alter, switch to Edit
Mode or Pose Mode and then pressing Ctrl-Alt-S then drag your mouse left or right and the Bone
Envelope volume will alter accordingly. See figure 30.

Modes
Modes are a Bforartists-level object-oriented feature, which means that the whole Bforartists application is
always in one and only one mode, and that the available modes vary depending on the selected active object’s
type - most of them only enable the default Object mode (like cameras, lamps, etc.). Each mode is designed to
edit an aspect of the selected object. See the Bforartists’s Modes table below for details.
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Mode selection example (mesh object).

You set the current mode in the Mode drop-down list of 3D View header (see Mode selection example (mesh
object)).
Warning
You can only select objects in Object mode. In all others, the current object selection is “locked” (except,
to some extent, with an armature’s Pose mode).

Modes might affect many things in Bforartists:
• They can modify the panels and/or controls available in some Buttons windows’ contexts.
• They can modify the behavior of whole windows, like e.g. the UV/Image Editor window (and obviously,
3D View s!).
• They can modify the available header tools (menus and/or menu entries, as well as other controls...). For
example, in the 3D View window, the Object menu in Object mode changes to a Mesh menu in Edit
mode (with an active mesh object!), and a Paint menu in Vertex Paint mode...
We won’t detail further more modes’ usages here. Most of them are tackled in the modeling chapter, as they are
mainly related to this topic. The Particle mode is discussed in the particle section, and the Pose and Edit modes
for armatures, in the rigging one.
Note
If you are reading this manual and some button or menu option is referenced that does not appear on your
screen, it may be that you are not in the proper mode for that option to be valid.
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Figure 30 - Single Armature Bone with various different Bone Evelope sizes.

You can also alter the Bone Envelope volume by selecting the Bone you wish to alter and switching to Edit
Mode or Pose Mode, then navigate to [Properties Editor > Bone Context > Deform Panel > Envelope Section >
Distance field] then enter a new value into it. See figure 31.

Figure 31 - [Properties Editor > Bone Context > Deform Panel > Envelope Section > Distance field] highlighted.

Altering the Bone Envelope volume does not alter the size of the Armature Bone just the range within which it
can influence vertices of Child Objects.
You can alter the radius that a bone has by selecting the head, body or tail parts of a bone while in Edit Mode,
and then press Alt-S and move the mouse left or right. This will make the selected bone fatter or thinner
without altering the thickness of the Bone Envelope volume. See figure 32.
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Figure 32 - 4 Armature Bones all using Envelope Weight. The 1st with a default radius value, the 3 others with differing Tail,
Head and Body radius values.

You can also alter the bone radius by selecting the tail or head of the bone you wish to alter and switching to
Edit Mode, then navigate to [Properties Editor > Bone Context > Deform Panel > Radius Section] and entering
new values for the Tail and Head fields. See figure 33.

Figure 33 - [Properties Editor > Bone Context > Deform Panel > Radius Section] head and tail fields highlighted.

Note
If you alter the Bone Envelope volume of a bone so that you can have it include/exclude certain vertices after
you have already used Armature Deform With Envelope Weights, by default the newly included/excluded
vertices won’t be effected by the change. When using Armature Deform With Envelope Weights it only
calculates which vertices will be affected by the Bone Envelope volume at the time of parenting, at which point
it creates the required named Vertex Groups and assigns vertices to them as required. If you want any vertices
to take account of the new Bone Envelope volume size you will have carry out the Armature Deform With
Envelope Weights parenting again; In fact all parenting used in the Set Parent To pop-up dialog which tries to
automatically assign vertices to Vertex Groups works like this.

Bone Parent
Bone parenting allows you to make a certain bone in an armature the Parent Object of another object. This
means that when transforming an armature the Child Object will only move if the specific bone it is the Child
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Object of moves. See figure 34.

Figure 34 - 3 pictures of Armatures with 4 Bones, with the 2nd bone being the Bone Parent of the Child Object Cube. The
Cube is only transformed if the 1st or 2nd bones are. Notice altering the 3rd and 4th bones has no effect on the Cone.

To use Bone Parenting, you must first select all the Child Objects you wish to parent to a specific Armature
Bone, then Shift-RMB select the Armature Object and switch it into Pose Mode and then select the specific
bone you wish to be the Parent Bone by RMB selecting it. Once done press Ctrl-P and select Bone from the
Set Parent To pop-up dialog.
Now transforming that bone in Pose Mode will result in the Child Objects also transforming.

Relative Parenting
Bone Relative parenting is an option you can toggle for each bone. This works in the same way as Bone
parenting with one difference.
With Bone parenting if you have parented a bone to some Child Objects and you select that bone and switch it
into Edit Mode and then translate that bone; When you switch back into Pose Mode on that bone, the Child
Object which is parented to that bone will snap back to the location of the bone in Pose Mode. See figure 37.
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Figure 37 - [Single Armature Bone which has a Child Object cube parented to it using Bone parenting. 1st picture shows the
position of the cube and armature before the bone is moved in Edit Mode. 2nd picture shows the position of the cube and
armature after the bone was selected in Edit Mode, moved and switched back into Pose Mode. Notice that the Child Object
moves to the new location of the Pose Bone.

Bone Relative parenting works differently; If you move a Parent Bone in Edit Mode, when you switch back to
Pose Mode, the Child Objects will not move to the new location of the Pose Bone. See figure 38.

Figure 38 - [Single Armature Bone which has a Child Object cube parented to it using Bone Relative parenting. 1st picture
shows the position of the cube and armature before the bone is moved in Edit Mode. 2nd picture shows the position of the
cube and armature after the bone was selected in Edit Mode, moved and switched back into Pose Mode. Notice that the
Child Object does not move to the new location of the Pose Bone.

Vertex Parent
You can parent an object to a single vertex or a group of three vertices as well; that way the child/children will
move when the parent mesh is deformed, like a mosquito on a pulsing artery.

Vertex Parent from Edit Mode
In Object mode, select the child/children and then the parent object. Tab into Edit mode and on the parent
object select either one vertex that defines a single point, or select three vertices that define an area (the three
vertices do not have to form a complete face; they can be any three vertices of the parent object), and then press
Ctrl-P and confirm.
At this point, if a single vertex was selected, a relationship/parenting line will be drawn from the vertex to the
child/children. If three vertices were selected then a relationship/parenting line is drawn from the averaged
center of the three points (of the parent object) to the child/children. Now, as the parent mesh deforms and the
chosen parent vertex/vertices move, the child/children will move as well.
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Vertex Parent from Object Mode
Vertex parenting can be performed from object mode, This is done like regular object parenting, Press Ctrl-P
in object mode and select Vertex or Vertex (Triangle).
The nearest vertices will be used from each object which is typically what you would want.

See:

1. The small cubes can each be automatically parented to a triad of nearby vertices on the icosphere using
the “Vertex (Triangle)” in the set parent context menu.
2. Reshaping the object in edit mode then means each of the cubes follows their vertex triad parent
separately.
3. Re-scaling the parent icosphere in object mode means the child cubes are also rescaled as expected.
The parent context menu item means users can rapidly set up a large number of vertex parent relationships, and
avoid the tedious effort of establishing each parent-child vertex relationship separately.
Note
It is in fact a sort of “reversed” hook

Options
Move child
You can move a child object to its parent by clearing its origin. The relationship between the parent and child
isn’t affected. Select the child object and press Alt-O. By confirming the dialog the child object will snap to
the parent’s location. Use the Outliner view to verify that the child object is still parented.

Remove relationship/Clear Parent
You can remove a parent-child relationship via Alt-P
The menu contains:
Clear Parent
If the parent in the group is selected nothing is done. If a child or children are selected they are
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disassociated from the parent, or freed, and they return to their original location, rotation, and size.
Clear and Keep Transformation
Frees the children from the parent, and keeps the location, rotation, and size given to them by the parent.
Clear Parent Inverse
Places the children with respect to the parent as if they were placed in the Global reference. This
effectively clears the parent’s transformation from the children. For example, if the parent is moved 10
units along the X axis and Clear Parent Inverse is invoked, any selected children are freed and moved -10
units back along the X axis. The “Inverse” only uses the last transformation; if the parent moved twice, 10
units each time for a total of 20 units, then the “Inverse” will only move the child back 10 units, not 20.

Hints

Outliner view

There is another way to see the parent-child relationship in groups and that is to use the Outliner view of the
Outliner window. Image (Outliner view) is an example of what the Outliner view looks like for the (Parenting
Example). Cube A‘s object name is Cube_Parent and cube B is Cube_Child.

Shading
Shading Modes
Shading refers to the way objects are drawn and lit in
the 3D View.
Rendered
An accurate representation using the selected
Render Engine and lit with the visible scene
lights.
Material
A fast approximation of the applied material.
Some effects, such as procedural textures may
not be shown.
Textured
Shows meshes with an image applied using the
mesh’s active UV Map. For Cycles materials, the
image is the last one selected in the Node Editor.
For other render engine’s, the UV Map’s applied face texture will be shown.
Solid
The default drawing mode using solid colored surfaces and simple lighting.
Wireframe
Objects appear as a mesh of lines representing the edges of faces and surfaces.
Bounding Box
Shows only the rectangular boxes that outlines an object’s size and shape.
Except for Rendered, these shading modes are not dependent on light sources in the scene. Instead they use a
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simple default lighting adjusted by the Solid OpenGL Lights controls on the System tab of the User Preferences
window.
The viewport shading controls the appearance of all objects in a scene, but this can be overridden for individual
objects using the Display panel in their Object Properties.

Shading Panel
3D Viewport Shading Panel.

The shading panel in the Properties Region provides additional control over
the way objects in the 3D view appear.
Textured Solid
Display assigned face textures in the Solid shading mode. (Not
available in the Cycles Render Engine)
Matcap
A selection of preset shader effects, (overriding regular materials)
which can help visualize your models while editing or sculpting,
without having to set up complex materials first.
Backface Culling
Only show the front side of faces. Use this to find faces flipped the
wrong way, especially when exporting to programs that use single
sided drawing.
Depth of Field
Simulates a camera’s focal blur effect in the 3D viewport. Only visible
in a camera view. Control the effect using these options in the
Properties Tab of the active camera: Focal Length, Sensor Size, Focus Object or Focus Distance, and
Viewport F-stop.
Ambient Occlusion
Improves the realism of the viewport image by simulating the darkening effect that occurs in crevices and
corners. Typically such effects are rendered at higher quality, but this is a quick real-time preview which
can help when modelling or sculpting.
These settings control the AO effect.
Strength
A higher number makes the corners darker.
Distance
How far out of the corners does the effect extend.
Attenuation
How strongly the effect attenuates with distance. Increasing this makes far away surfaces contribute
less to the effect. Use this to get rid of some banding artifacts.
Samples
The number of samples used for the effect. Low numbers produce a grainy effect, but the actual
number used is squared so use high numbers with caution.
Color
Color of the effect, can be modified to give a different feel, from ambient lighting to dirt/rust.
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Display
Display Panel
Only Render
Displays only items that will be rendered.
This can be is useful to preview how animations look without being distracted by rigs, empties, lights &
cameras.
Useful to enable with OpenGL Render.
Outline Selected
If disabled, the pink outline around your selected objects in Solid / Shaded / Textured draw types will no
longer be displayed.
All Object Origins
If enabled, the center dot of objects will always be visible, even for non-selected ones (by default,
unselected centers might be hidden by geometry in solid/shaded/textured shadings).
Relationship Lines
Controls whether the dashed parenting, constraining, hooking, etc., lines are drawn.
3D Cursor
Shows or hides the 3D cursor.
Groundgrid
Shows or hides the whole grid. This also affects the orthogonal views like Top View
Grid Floor
If disabled, you have no grid in other views than the orthographic top/front/side ones.
X Axis, Y Axis, Z Axis
Control which axes are shown in other views than the orthographic top/front/side ones.
Lines
Controls the number of lines that make the grid in non-top/front/side orthographic views, in both
directions.
Scale
Control the scale of the grid floor
Subdivisions
Controls the number of sub-lines that appear in each cell of the grid when you zoom in, so it is a
setting specific to top/front/side orthographic views.
Toggle Quad View
Toggles the four pane 3D view. Read more about arranging areas

View Panel
The View Properties panel lets you set other settings regarding the 3D view. You can show it with the View ‣
View Properties... menu entry.
Lens
Control the focal length of the 3d view camera in millimeters, unlike a rendering camera
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Lock to Object
By entering the name of an object in the Object field, you lock your view to this object, i.e. it will always
be at the center of the view (the only exception is the active camera view, Numpad0). If the locked object
is an armature, you can further center the view on one of its bones by entering its name in the Bone field.
Lock to Cursor
Lock the center of the view to the position of the 3D cursor
Lock Camera to View
When in camera view, use this option to move the camera in 3D space, while continuing to remain in
camera view.
Clip Start and Clip End
Adjust the minimum and maximum distances to be visible for the view-port.
Note
A large clipping range will allow you to see both near and far objects, but reduces the depth precision.
To avoid this:
• increase the near clipping when working on large scenes.
• decrease the far clipping when objects are not viewed at a distance.
When perspective is disabled only the far Clip-End is used, very high values can still give artifacts.
This is not specific to Bforartists, all OpenGL/DirectX graphics applications have these same
limitations.
Examples:

Model with no clipping artifacts.
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Model with clipping artifacts.

Mesh with artifacts in edit-mode.

Local Camera
Active camera used in this view
Render Border
Use a Render Border when not looking through a camera. Draw a border region will automatically enable
this option.

Custom Wireframe Colors
Reference
Mode: Object mode + Wireframe mode or Solid mode
Menu: Properties Editor > Object tab > Display panel

122

Bforartists Reference Manual - © Copyright - This page is under OCL license

Sometimes it is useful to give
objects in the scene different
colors to have a better way to
divide them visually. When you
have a complex building with
different parts for example
Bforartists comes with the ability
to set up custom wireframe colors
per mesh object. You can activate
them in the Properties Editor in
the Object tab in the Display
panel.

The custom wireframe colors is
meant for theWireframe mode.
But you can also use it in Solid
mode. There just the outline
shows in the custom color then.
But you can show the wire at an
solid object by ticking the Wire
checkbox. Best in conjunction
with Draw all Edges. Or not all
edges might be drawn.
The custom wireframe colors just
shows up in Wire mode and in
Solid mode. In all other modes it
does not show. Even when Wire
is ticked.
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The wireframe color dropdown box allows you to choose between different
pre defined wireframe colour sets.

The custom color set allows you to customize the
colors. Switch to Custom Color set. Then click at one
of the three colors below to open the color picker.

Layers
Reference
Mode: Object mode
Panel: Relations (Object context)
Menu: Object ‣ Move to Layer...

3D scenes often become exponentially more confusing as they grow more complex.
Sometimes the artist also needs precise control over how individual objects are lit, and does
not want lights for one object to affect nearby objects. For this and other reasons below,
objects can be placed into one or more “layers”. Using object layers, you can:
• Selectively display objects from certain layers in your 3D view, by selecting those
layers in the 3D View header bar. This allows you to speed up interface redrawing,
reduce virtual-world clutter, and help improve your workflow.
• Control which lights illuminate an object, by making a light illuminate only the
objects on its own layer(s).
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• Control which forces affect which particle systems, since particles are only affected by forces and
effects on the same layer.
• Control which layers are rendered (and hence, which objects), and which properties/channels are made
available for compositing by using render layers.
Armatures can also become very complex, with different types of bones, controllers, solvers, custom shapes,
and so on. Since armatures are usually located close together, this can quickly become cluttered. Therefore,
Bforartists also provides layers just for armatures. Armature layers are very similar to object layers, in that you
can divide up an armature (rig) across layers and only display those layers you wish to work on.

Working with Layers
3D layers differ from the layers you may know from 2D graphics applications as they have no influence on the
drawing order and are there (except for the special functions listed above) mainly to allow you to organize your
scene.
When rendering, Bforartists only renders the selected layers. If all your lights are on a layer that is not selected,
you won’t see anything in your render except for objects lit by ambient lighting.
Groups and Parents are other ways to logically group related sets of objects.

Viewing layers
Bforartists provides twenty layers whose visibility can be toggled with the small unlabeled buttons in the Layer
Management panel in the Tool Shelf. To select a single layer, click the appropriate button with LMB; to select
more than one, use Shift-LMB - doing this on an already active layer will deselect it.

Locking to the scene
By default, the lock button directly to the right of the layer buttons is enabled. This means that changes to the
viewed layers affect all other 3D Views locked to the scene - see the navigating the 3D view options page for
more information.

Multiple Layers
An object can exist on multiple layers. For example, a lamp that only lights objects on a shared layer could “be”
on layers 1, 2, and 3. An object on layers 3 and 4 would be lit, whereas an object on layers 4 and 5 would not.
There are many places where layer-specific effects come into play, especially lights and particles.

Moving objects between layers

Object context selection.

The way to change a selected object layer is via the Relations panel, in the Object context.
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Layers in Object context, Relations panel.

You will then see the layer buttons in the Relations panel - as before the object can be displayed on more than
one layer by clicking Shift-LMB.

3D Cursor
The 3D Cursor is simply a point in 3D space which can be used for a number of purposes

Placement
There are a few methods to position the 3D cursor.

Direct Placement with the Mouse

Positioning the 3D cursor with two orthogonal views.

Using LMB in the 3D area will place the 3D cursor directly under your mouse pointer.
For accuracy you should use two perpendicular orthogonal 3D views, i.e. any combination of top (Numpad7),
front (Numpad1) and side (Numpad3). That way you can control the positioning along two axes in one view
and determine depth in the second view.
To place the 3D Cursor on the surface of geometry, enable Cursor Depth in the User Preferences

Using the Snap Menu
The Snap menu (Shift-S or Object/Mesh ‣ Snap) will allow you to snap the cursor in the following ways:
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Cursor to Selected
Snaps the cursor to the center of the current selection.
Cursor to Center
Snaps the cursor to the origin of the scene (location 0,0,0).
Cursor to Grid
Snaps the cursor to the nearest visible grid lines.
Cursor to Active
Snaps the cursor to the active (last selected) object, edge, face or vertex.
The Cursor to Selected option is also affected by the current Pivot Point. For example:
• With the Bounding Box Center pivot point active, the Cursor to Selected option will snap the
3D cursor to the center of the bounding box surrounding the objects’ centers.
• When the Median Point pivot point is selected, Cursor to Selected will snap the 3D cursor to
the median of the object centers.

Numeric Input

The 3D Cursor panel of the Properties shelf.

Hiding the 3D cursor
The 3D cursor is very handy. Several operations are performed by using the
3D cursor. New objects gets created at the 3D Cursor location. You can
place it around and snap elements to it, and so on.
But the visual part is sometimes very disturbing. You can hide it in the
Properties sidebar in the Display section.

Background Images
Reference
Editor: 3D View
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Panel: Background Image
A background picture in your 3D view is very helpful in many situations: modeling is obviously one, but it is
also useful when painting (e.g. you can have reference pictures of faces when painting textures directly on your
model...), or animation (when using a video as background), etc.
Note
Background images are only available for orthographic views.

Settings

The panel has two subtabs. Settings and Align. They are closed by default.
Axis
Choose which views the image is visible from. This is helpful when you have several reference images
from different views (e.g. top, front and side).
Data Source
The source of the background image.
Image
Use an external image, image sequence, video file or generated texture.
Movie Clip
Use one of the Movie Clip data-blocks.
Opacity
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Controls the transparency of the background image.
Front/Back
Choose whether the image is shown behind all objects, or in front of everything.
Stretch/Fit/Crop
Controls how the image is placed in the camera view.
Stretch
Forces the image dimensions to match the camera bounds (may alter the aspect ratio).
Fit
Scales the image down to fit inside the camera view without altering the aspect ratio.
Crop
Scales the image up so that it fills the entire camera view, but without altering the aspect ratio (some
of the image will be cropped)
X/Y
Position the background image using these offsets.
In orthographic views, this is measured in the normal scene units. In the camera view, this is measured
relative to the camera bounds (0.1 will offset it by 10% of the view width/height)
Flip Horizontally
Swap the image around, such that the left side is now on the right, and the right now on the left.
Flip Vertically
Swap the image around, such that the top side is now on the bottom, and the bottom now on the top.
Rotation
Rotate the image around its center.
Size
Scale the image up or down from its center.
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Introduction
The 3D View is made of several areas.
Yellow is the Tool Shelf.
Blue is the Header or Menu bar. It can be at the top or
the bottom.
Green is the Viewport. Here you will see and work
with your 3D data.
Red is the Properties Sidebar.
The content of the Tool Shelf , the Header and the
Properties Sidebar can vary. It depends of the type of
the objects and the modes that you are in.
This chapter here is about the Tool Shelf.

Tool Shelf
The Tool Shelf is split into two areas. The upper area with the tabs is the
actual tool shelf where you find your tools. It is also a usual place where
add-ons gets installed, and adds their tab too.
The lower area is the so called Last Operator panel. The Last operator
Here you will find settings of various types. For example adjustable
settings for a new created primitive. In other software you will get this
settings before you perform the tool. In Blender you get the settings after
you perform the tool.
The tool shelf shelf part is made of several tabs. Tabs and content is
varying dependant of what object type you use, and in what object mode you are. We will go through the tools
by modes and object types.
The tool shelf itself contains icon buttons by default. The tool tips tells
you the name of the tool. But you can also turn the buttons into Text and
Icon Buttons. Which makes it easier to recognize what is what at the
beginning. Or when you search for a specific tool and cannot remember
the icon for it.
To display the buttons as pure icons or as icon and text buttons can be
turned on or of in the Display tab in the Properties Sidebar at the right
side of the 3D View.
The reference manual will in the following shots provide both, the icon
button toolbars and the text and icon toolbars where necessary and available.
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Tool Shelf in Object Mode
The Tool Shelf in Object Mode provides you the tools to work with the objects at object level. Things like
position, rotation, scale, mirror, or join or group etc. .
The Object mode is available for all object types.

Tool Shelf in Object Mode - Tools Tab
Edit Panel
The Edit panel contains tools around editing the selected object(s) at object
level. Mirroring, set Origin, etc.

Object Type Mesh, Curve, Surface
Mirror
Mirror mirrors the selected geometry along the defined axis. Click the Mirror button, type
in X, Y or Z, then confirm with enter.
Last Operator Mirror
The Last Operator Mirror panel gives you tools to adjust the mirror action.
Constraint Axis
Constraint Axis gives you again the possibility to define the mirror axis. You can choose
more than one axis here.
Orientation
Orientation is a drop-down box where you can choose the type of orientation for the
mirroring action.
Proportional Editing
Proportional Editing is a drop-down box where you can choose to use proportional editing.
When you choose one of the active methods then the neighbour geometry gets influenced
by Shrink/Fatten too in a proportional way.
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Proportional Editing Falloff
Proportional Editing Falloff is a drop-down box where you can choose a method for the falloff for the
proportional editing.
Proportional size
Proportional size is a edit box where you can adjust the strength of the Proportional
falloff.
Edit Grease Pencil
Edit Grease Pencil edits the selected Grease Pencil strokes.
Confirm on Release
With Confirm on Release checked the action gets performed when you release the mouse button.

Join
The join tool unions the selected mesh parts to one object.
Join has no settings in the Last Operator panel.

Set Origin
- Geometry to Origin sets the geometry to the origin.
- Origin to Geometry sets the origin to the centre of the object.
- Origin to 3D Cursor sets the origin to the 3D cursor.
- Origin to centre of mass sets the origin to the centre of the mass of the object.
Last Operator Set Origin
Type
Type is a drop-down box where you can again choose how you want to set the origin.
Centre
Centre is a drop-down box where you can choose to use the Bounding Box centre of the object, or the Median
Centre. The two are not necessarily at the same location.

Shading
Smooth makes the shading of the object smooth. Last Operator Set Smooth has
no settings.
Flat makes the shading of the object faceted. Last Operator Set Flat has no
settings.
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Auto Smooth
Auto Smooth just appears in the Shading section when you have a Mesh object selected. With
Auto smooth you can define the angle after which the shading is set to smooth instead of
faceted. It gives you fine control between the two extremes smooth and faceted.

You need to have the Shading set to Smooth. Then tick Auto Smooth.
And then you can adjust behind what angle the shading is set to smooth
instead of faceted with the angle slider.
Note that the Auto Smooth feature also exists in the Data Properties of
the object.

Data Transfer
Contains the data transfer tools Data, Data Layout and UV Map

Data
Opens a Transfer Mesh data menu where you can
choose different methods to transfer data layers from
active to selected objects.
Last Operator Transfer Mesh Data
Last Operator Transfer Mesh Data displays different content, dependant of what data you
want to transfer. To document all possible combinations would be a manual at its own. So
we will just show the content for Edge Data Sharp here.
Freeze Operator

Prevent changes to the settings when rerun the operator.
Data Transfer

Opens a Transfer Mesh data menu where you can choose different methods to transfer data
layers from active to selected objects.
Create Data

Add Data Layers on Destination Meshes if needed.
Edge Mapping

Edge Mapping is a drop-down box where you can choose the method for Edge
Mapping
Auto Transform

Automatically compute transformation to get the best possible match between Source
and Destination Object.
Object Transform

Evaluate Source and Destination object in Global Space.
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Only Neighbour Geometry

Source Elements must be closer than given distance. This one reveals a Max Distance slider.
Ray Radius

Width of Rays.
Mix Mode

Mix Mode is a drop-down box where you can choose the Mix Mode.
Mix Factor

A slider to adjust the Mix mode.

Data Layout
opens a menu where you can choose different
methods to transfer the layout of data from active
to selected objects.

Last Operator Transfer Mesh Data Layout
Last Operator Transfer Mesh Data displays different content, dependant of what data you
want to transfer. To document all possible combinations would be a manual at

its own. So we will just show the content for Vertex Group here.
Data Type

opens a menu where you can choose different methods to transfer the layout of data from
active to selected objects.
Exact Match

Also delete some data layers from destination if necessary. So that it matches exactly the source.
Source Layers Selection

A drop-down box where you can choose which Layers to transfer.
Destination Layers Matching

A drop-down box where you can choose how to match source and destination layers.

Join UV's / UV Map
Transfers the UV map from selected to active object. Requires to have matching geometry and the same vertex
order.

Select the target mesh. Hold Shift and click to add the source object to the selection. Then perform the tool. The
target mesh will now have the UV map from the source object.
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Object Type Meta ball, Lamp, Camera, Speaker, Empties, Force Fields
Mirror
The Mirror tool mirrors the selected geometry.
When activated type in x y or z to define the mirror axis. Then hit enter.
Last Operator Mirror
The Last Operator Mirror panel gives you tools to adjust the mirror action.
Constraint Axis
Constraint Axis gives you again the possibility to define the mirror axis. You can choose
more than one axis here.
Orientation
Orientation is a drop-down box where you can choose the type of orientation for the
mirroring action.
Proportional Editing
Proportional Editing is a drop-down box where you can choose to use proportional editing.
When you choose one of the active methods then the neighbour geometry gets influenced by
Shrink/Fatten too in a proportional way.
Proportional Editing Falloff
Proportional Editing Falloff is a drop-down box where you can choose a method for the
falloff for the proportional editing.
Proportional size
Proportional size is a edit box where you can adjust the strength of the Proportional
falloff.
Edit Grease Pencil
Edit Grease Pencil edits the selected Grease Pencil strokes.
Confirm on Release
With Confirm on Release checked the action gets performed when you release the mouse
button.
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Tool Shelf in Object Mode - Create Tab
The Create tab provides you with some pre made objects. Mesh Objects, Lamps, Empties, etc. .
When you create a primitive then the Last Operator Panel shows some settings for this
primitive.
Note that those settings are not longer available when you perform any operation at the object.
And be it to move the primitive. Some of those settings might still be available in the
Properties editor. But things like create UV not. So when you want to adjust those settings,
then do it immediately after creation.
Several object types can be edited. A Mesh Primitive for example. They have different modes
available then. Some not. Like an Empty. There is just the Object mode available for an Empty.

Mesh Panel
Mesh
The Mesh section contains the primitives that are made of meshes.
Mesh primitives are a good starting point for polygon modelling.

Plane
Plane creates a simple quad mesh
Last Operator Add Plane Panel
Radius is in real the size of the plane.
Generate UV's creates UV's for this primitive.
Align to view aligns the Plane to the current view.
Location Here you can adjust the location of the Plane.
Rotation defines the rotation of the Plane.
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Cube
Cube creates a Cube mesh.
Last Operator Add Cube Panel
Radius is in real the size of the Cube.
Generate UV's creates UV's for this primitive.
Align to view aligns the Cube to the current view.
Location defines the location of the Cube.
Rotation defines the rotation of the Cube.

Circle
Circle creates a Circle mesh.
Last Operator Add Circle Panel
Vertices defines of how much vertices the circle is made.
Radius defines the radius of the circle.
Fill Type defines how the Circle mesh is filled.
- Nothing means you have pure edge geometry.
- N-Gon means that the circle face is a N-Gon face.
- Triangle Fan means that the circle face is triangulated.
Generate UV's creates UV's for this primitive.
Align to view aligns the Circle to the current view.
Location defines the location of the Circle.
Rotation defines the rotation of the Circle.

UV Sphere
UV Sphere creates a sphere mesh.
Last Operator Add UV Sphere Panel
Segments defines of how much segments the sphere has vertically.
Rings defines how much rings the sphere has horizontally.
Size defines the radius of the UV Sphere.
Generate UV's creates UV's for this primitive.
Align to view aligns the Sphere to the current view.
Location defines the location of the Sphere.
Rotation defines the rotation of the Sphere.

Ico Sphere
Ico Sphere creates a sphere mesh.
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Last Operator Add Ico Sphere Panel
Subdivisions defines the subdivision level of the Ico Sphere.
Size defines the radius of the Ico Sphere.
Generate UV's creates UV's for this primitive.
Align to view aligns the Sphere to the current view.
Location defines the location of the Sphere.
Rotation defines the rotation of the Sphere.

Cylinder
Cylinder creates a Cylinder mesh.
Last Operator Add Circle Panel
Vertices defines of how much vertices the circle is made.
Radius defines the radius of the Cylinder.
Depth defines the length of the Cylinder.
Cap Fill Type defines how the cap face is filled.
- Nothing means you have no face at the top and the bottom of
the Cylinder.
- N-Gon means that the cap face is a N-Gon face.
- Triangle Fan means that the cap face is triangulated.
Generate UV's creates UV's for this primitive.
Align to view aligns the Cylinder to the current view.
Location defines the location of the Cylinder.
Rotation defines the rotation of the Cylinder.

Cone
Cone creates a Cone mesh
Last Operator Add Cone Panel
Vertices defines of how much vertices the circle is made.
Radius 1 defines the base radius of the Cone.
Radius 2 defines the top radius of the Cone.
Depth defines the length of the Cone.
Base Fill Type defines how the Base face is filled.
- Nothing means you have no base face.
- N-Gon means that the base face is a N-Gon face.
- Triangle Fan means that the base face is triangulated.
Generate UV's creates UV's for this primitive.
Align to view aligns the Cone to the current view.
Location defines the location of the Cone.
Rotation defines the rotation of the Cone.
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Torus
Torus creates a Torus mesh
Last Operator Add Torus Panel
Operator Presets allows you to store presets for the Torus. So that you don't have to start
from scratch when you need different tori with different setup. This presets are temporary.
And cannot be stored between sessions.
Align to view aligns the Cone to the current view.
Location defines the location of the Torus.
Rotation defines the rotation of the Torus.
Major segments defines the segment division of the Torus.
Minor segments defines the circle division of the Torus.
Torus Dimensions defines the method to use when changing Major and Minor Radius.
Major Radius changes the radius of the Torus.
Minor Radius changes the thickness of the Torus.

Grid
Grid creates a subidividable plane mesh
Last Operator Add Grid Panel
X Subdivisions defines the number of subdivisions in x direction.
X Subdivisions defines the number of subdivisions in Y direction.
Radius is in real the size of the plane.
Generate UV's creates UV's for this primitive.
Align to view aligns the Plane to the current view.
Location Here you can adjust the location of the Plane.
Rotation defines the rotation of the Plane.

Monkey
Monkey creates a monkey head mesh.
Last Operator Add Monkey Panel
Radius is in real the size of the Monkey head mesh.
Align to view aligns the Monkey head mesh to the current view.
Location Here you can adjust the location of the Monkey head mesh.
Rotation defines the rotation of the Monkey head mesh.
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Misc Panel
The Misc Panel provides you with the buttons to create several types of objects.
Here you will find mainly the objects that are not for modelling. But everything
else. Lights, Bones, Camera, Empties etc.
And it containst the Group Instance menu and the legacy Add menu, which gets
used for older addons. Quite a few, like the Sapling addon, places their entries
here.

Text
Text creates a text object. Text is not mesh geometry. It is a special curve geometry.
Note
You can enter the Edit mode with the standard hotkey. But you cannot switch back to
Object mode with the standard hotkey. Since this hotkey gets count as input for the text
object in Edit mode. You have to use the mode drop-down box to leave the Edit mode.

Last Operator Add Text
Radius is in real the size of the Text object.
Align to view aligns the Text object to the current view.
Location Here you can adjust the location of the Text object.
Rotation defines the rotation of the Text object.

Armature
Armature creates a Armature. It adds the first bone of a skeleton.
Last Operator Add Armature
Radius is in real the size of the Armature object.
Align to view aligns the Armature object to the current view.
Location Here you can adjust the location of the Armature object.
Rotation defines the rotation of the Armature object.

Lattice
Lattice creates a Lattice. Which is a control cage to control deforming at another object.
Usage
Create a Lattice object.
Make sure it is bigger than the object that you want to deform, and is around this object.
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Add a Lattice Modifier to the object that you want to deform.
In the Object box of the Lattice Modifier add our created Lattice object.
Select Lattice Object. Enter Edit mode. And here you can deform the Lattice Object now, and the object to
deform will follow.
Last Operator Add Lattice object
Radius is in real the size of the Lattice object.
Type is a drop-down box where you can define the type of Lattice object.
Align to view aligns the Lattice object to the current view.
Location Here you can adjust the location of the Lattice object.
Rotation defines the rotation of the Lattice object.

Camera
Camera creates a Camera object.
Last Operator Add Camera
Location Here you can adjust the location of the Camera object.
Rotation defines the rotation of the Camera object.

Speaker
Speaker creates a Speaker object.
Last Operator Add Speaker
Location Here you can adjust the location of the Speaker object.
Rotation defines the rotation of the Speaker object.

Group Instance
Group Instance is a drop-down box that contains the current groups. And you can add another
instance of an existing group by clicking at the group in this drop-down list.
First create a group. It will display in the list.
Then click at one of the list items to add an instance of the group to
the scene.
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Addons Add
The Addons Add menu exists for historical reasons. Quite a few Blender addons adds their
entries into this add menu. And so we have to keep it in Bforartists too. But it is now in the
Tool Shelf, and not in the Header menu anymore like in Blender.
There are a handful of double menu entries left that cannot be removed for exact this reason.
We would make some addons disfunctional.

Curve Panel
The Curve section contains the Curve primitives. Curves are handy to create
curved shapes. Or a camera path.
The curve types are very similar. But do have some small differences. The
difference between Bezier and Nurbs is that with Bezier you have handlers at
the curve. And with a Nurbs you have a control geometry to influence the
curve.
Note that Curves is no mesh data. You have to convert the Curves data to Mesh data when you want to work
with it like with a mesh. Note also that you cannot convert it back to curve then.

Bezier
Bezier creates a Bezier type curve.

Circle
Circle creates a Bezier circle type curve.

Nurbs Curve
Nurbs Curve creates a Nurbs type curve.

Nurbs Circle
Nurbs Circle creates a Nurbs type circle curve.

Path
Path creates a Nurbs type curve.
Last Operator Add Curve
The Last Operator add panel is for all curves equal.

Radius is in real the size of the curve.
Align to view aligns the curve to the current view.
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Location Here you can adjust the location of the curve.
Rotation defines the rotation of the curve.

Draw Curve
Draw Curve is just active in Edit mode.

Surface Panel
The Surface section contains the Surface primitives. Surfaces are some kind of
curves. But curves with which you can construct surfaces. Surfaces are all of
type Nurbs curves.
Surfaces are handy to construct curved surfaces.
Note that Surfaces similar to Curves is no mesh data. You have to convert the Surfaces data to Mesh data when
you want to work with it like with a mesh. Note also that you cannot convert it back to Surface then.

Nurbs Curve
Nurbs Curve creates a Nurbs type curve.

Nurbs Circle
Nurbs Circle creates a Nurbs type circle.

Nurbs Surface
Nurbs Surface creates a Nurbs type Surface.

Nurbs Cylinder
Nurbs Cylinder creates a Nurbs type cylinder.

Nurbs Sphere
Nurbs Sphere creates a Nurbs type sphere.

Nurbs Torus
Nurbs Torus creates a Nurbs type Torus.
Last Operator Add Surface
The Last Operator add panel is for all curves equal.

Radius is in real the size of the surface.
Align to view aligns the surface to the current view.
Location Here you can adjust the location of the surface.
Rotation defines the rotation of the surface.
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Metaballs Panel
Meta-balls are procedural primitives. They are not defined by vertices or
curves. The interesting behaviour of meta-balls is that you can stick them into
each other. And they have one surface then. Like merging two water drops.
And this works in Object mode already.

Ball
Ball creates a meta-ball in Sphere shape.

Capsule
Capsule creates a meta-ball in Capsule shape.

Plane
Plane creates a meta-ball in Plane shape.

Ellipsoid
Ellipsoid creates a meta-ball in Ellipsoid shape.

Cube
Cube creates a meta-ball in Cube shape.
Last Operator Add Meta ball
The Last Operator add panel is for all Meta-balls equal.

Primitive is a drop-down box where you can change the Meta ball type.
Radius is in real the size of the surface.
Align to view aligns the surface to the current view.
Location Here you can adjust the location of the surface.
Rotation defines the rotation of the surface.

Group Instance
Group Instance is a drop-down box that contains the current groups. And you can add another
instance of an existing group by clicking at the group in this drop-down list.
First create a group. It will display in the list.
Then click at one of the list items to add an instance of the group to
the scene.
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Lamp Panel
The lamps brings light into your scene. There are five different Lamp types.

Point
Point creates a Point Light. A point light shines into all directions.

Sun
Sun creates a light that behaves like a sun. It's a directional light.

Spot
Spot creates a Spot light. It's a directional light.

Hemi
Hemi creates a hemi light. It illuminates the whole scene.

Area
Area creates a Area light. It's a directional light.
Last Operator Add Lamp
The Last Operator add panel is for all Lamps equal

Type is a drop-down box where you can change the light type.
Radius is in real the size of the surface.
Align to view aligns the surface to the current view.
Location Here you can adjust the location of the surface.
Rotation defines the rotation of the surface.

Empties Panel
An Empty is an object without any data attached. It is basically just a
container. Empties can be used as anchor objects. Or as visible handlers at a
skeleton for example.
The empty types differs just by how they gets displayed in the viewport.
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Last Operator Add Empty

Type is a drop-down box where you can define the type of Empty object.
Radius is in real the size of the Empty object.
Align to view aligns the Empty object to the current view.
Location Here you can adjust the location of the Empty object.
Rotation defines the rotation of the Empty object.

Force Field Panel
A Force Field is for physical simulations. It
provides you with tools to add different forces
to objects. Wind, Smoke, Gravity, Magnetic,
etc. .
The added Force Fields can be further adjusted
in the Properties panel then.
There is also the legacy dropdown menu
available. it's a double menu, it contains the
same buttons again. But some addons adds
their entries here.

A Force Field is internally also called Effector. So our Last Operator panel
has the title Add Effector.
Last Operator Add Effector
Type is a drop-down box where you can define the type of Effector.
Radius is in real the size of the Effector.
Align to view aligns the Text object to the Effector.
Location Here you can adjust the location of the Effector.
Rotation defines the rotation of the Effector.
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Add Modals Panel
Add Modals allows you to create primitives with adjustable divisions in 3DS Max style.
First you drag a rectangle in the 3D view. Then you drag the height. Then you adjust the
divisions in the Last Operator.

Add Modals is an addon. You can turn it off in the User Preferences when you don't need it.
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Mini Lightlib Panel
Mini Lightlib is a little add-on that gives you some standard lighting settings for the Cycles
renderer. It contains for example the classical three-point setup. But also some basic
volumetrics examples.
It can be turned off in the User Preferences.

Select Asset
The Select Asset drop-down box contains the assets that comes
with Mini Lightlib. Here you can select what you want to load.
The assets are grouped by numbers.
0 is everything setup. We have three backgrounds here. And the
studio camera that fits to the setup.
1 are the light set-ups for a studio setup. From classical threepoint to white.
2 is everything not studio setup.
3 are some volumetrics set-ups. Be very careful with this ones. Especially the Musgrave example renders eons.
4 is the included test asset. Some colored spheres.

Append Asset
The Append Asset Button appends what is currently selected in the drop-down box to the scene.

Path Edit box
The Path Edit box shows the path to the
library. You will usually not touch this edit
box. This edit box gives you a hint where the
Mini Lightlib library is located. So that you
can add your own assets to that folder. At Windows it's in the Appdata Directory. Which is usually hidden and
protected. You might need to adjust your rights to access this folder directly.
But it is also a Path selector. You can select other library folders here if you want, and append the assets from
that folder. The Drop-down box will show the content of all blend files in this folder then.
Every blend file is also a library file. The add-on appends the content of this
blend file then. To make your own library file is as easy as saving your blend
file with your asset. That's already a library. But note that Mini Lightlib will
append the whole content from this blend file. There is no filter as in the Blender append
feature. So when you plan to create your own libraries, then take care to remove everything
except the asset that you want to load.
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Note that changes in the Path Edit box are not permanent. The path to the Mini Lightlib is hard-coded. So when
you restart Blender then every change is gone. That's also a quick method to get the original path to the light
library back. Restart Blender.

Simple Usage
Preparation
Make sure that you have the Cycles renderer selected!
Mini Lightlib is made for the Cycles renderer. It will not work with the Blender Internal renderer. At least not
without adjustments.
Throw out all lights and cameras from the scene.
We don't want to have the standard lights ruin the result. Also the standard
camera does not fit to our studio setup.
This can be done in the Outliner. Or you select the lights and camera in the
viewport and hit delete.

Load Assets
Select in the drop-down box what you want to append. And
append it one by one to the scene.
Let's start with a studio setup. I suggest to use the bg white,
which is a white background. The camera. One of the studio
light set-ups. And finally our test asset to have something to
render.
So we select bg white, and click at the Append Asset Button.
Then we select Studiocamera, and click at the Append Asset
Button.
Then we select let's say the Studio White, and click at the
Append Asset Button.
And then we select the Test asset Spheres, and click at the Append Asset Button. What's left is to click at the
render button.

The available light set-ups
Here you can get an overview how the result looks like for the different lighting set-ups.
Be careful with the volumetrics examples. Especially the Musgrave example can render eons.
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Tool Shelf in Object Mode - Relations Tab
The Relations tab contains all tools that has to do with relations between
objects. Grouping, Parenting, etc. .
Note that the Relations tab is empty when there is no object in the scene.
Relation settings also exists for every individual object in the Properties
editor.

Group
The Group section contains the group tools. Here you can to add and remove
from a group.
Grouped objects are coloured different in the Viewport. They show green
instead of orange. They have no difference in the Outliner though.

New Group
New Group creates a new group. When you have one or more objects selected, then this object(s) becomes part
of the new group. You can name this Group in the Last Operator panel.
Last Operator Create New Group
Name is a edit box where you can change the name of the Group.

Add to Active
Add to Active adds the selected object to the group of the
selected object.
First select the object to add. Then shift select one object of
the group where you want to add it. So that both are
selected. Then press the Add To Active button, and choose
the group name. And the object will be added to this Group.
Last Operator Add Selected to Active Group
Name is a edit box where you can change the name of the Group.
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Remove from Group
Remove from Group removes the selected object from the
Group.
Select the object, then click the button and choose the Group
where you want to remove it from.
Last Operator Remove from Group
Name is a edit box where you can choose the group to remove from.

Remove from Active
A object can be in more than one group. Remove from Active removes the selected object from the currently
active Group.
Select the object, then click the button and choose the group where you want to
remove it from.
Last Operator Remove from Group
Name is a edit box where you can choose the group to remove from.

Remove from All
Remove from All removes the selected object from all Groups.
Last Operator Remove from All has no settings.

Parent
The Parent section contains a tool to deal with parent child relationships. This
includes things like sending an object along a curve. Or skinning an armature.
Child objects becomes part of the hierarchy of the parent object. You
will see them in the outliner in the hierarchy of the parent object then.
See image.
The usual way to parent an object is to select the child object, then shift
click add the parent object to the selection, then click the Parent button,
and finally choose the parenting method in the upcoming menu.
This menu has different content, dependant of what type the parent object is.

64

Bforartists Reference Manual - © Copyright - This page is Public Domain

Set Parent to Mesh Object
When your parent object is of type mesh, then you will have the following parent options:

Object
Object simply parents the current object to the target object.

Object (Keep Transform)
Object (Keep Transform) parents the current object to the target object, but keeps the transform intact.

Vertex
Vertex parents the current object to a vertex of the target object. The vertex will be chosen automatically, it's the
closest vertice of the parent object. When you want to assign the object to a specific vertice, then you have to do
the vertex parenting in Edit mode.

Vertex (Triangle)
Vertex (Triangle) parents the current object to a face of the target object. The face will be chosen automatically.
It's the closest face of the parent object. When you want to assign the object to a specific face, then you have to
do the vertex parenting in Edit mode.

Last Operator Make Parent to mesh object
Type is a drop-down box where you can change the type of parenting. Note that this list
also contains items that does not work for this object type parent relation.
Keep Transform applies transformation before parenting.

Set Parent to Armature
This is also known as skinning. When your parent object is of type mesh, then you
will have the following parent options:

Object
Object simply parents the current object to the target object.

Object (Keep Transform)
Object (Keep Transform) parents the current object to the target object, but keeps the transform intact.

Armature Deform
Armature Deform parents the current object to the armature. But the mesh has no weighting of the vertices. And
no groups.

With Empty Groups
With Empty Groups parents parents the current object to the armature. But the mesh has no weighting of the
vertices.
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With Envelope Weights
With Envelope Weights parents the current object to the armature. The mesh has weighting from the envelopes.
When the mesh has vertices that are outside of the envelope, then this vertices has no weighting.

With Empty Groups
With Empty Groups parents parents the current object to the armature. The mesh gets weighted automatically.
All vertices are weighted. Even when vertices are outside of envelopes.

Bone
Bone parents parents the current object to the currently selected bone. The whole object is influenced by this
single bone. When you edit the bones position in edit mode and switch to pose mode, then the child object will
follow to the new position.

Bone Relative
Bone parents parents the current object to the currently selected bone. The whole object is influenced by this
single bone. When you edit the bones position in edit mode and switch to pose mode, then the child object will
not follow to the new position.

Last Operator Make Parent to Armature
Type is a drop-down box where you can change the type of parenting. Note that this list
also contains items that does not work for this object type parent relation.
X Mirror applies weight symmetrically along X axis for Envelope/ Automatic vertex group
creation.
Keep Transform applies transformation before parenting

Set Parent to Curve
Curves can be used to define motion paths of objects. Curves can also be used to deform objects.
When your parent object is of type Curve, then you will have the following parent options:

Object
Object simply parents the current object to the target object.

Object (Keep Transform)
Object (Keep Transform) parents the current object to the target object, but keeps the
transform intact.

Curve Deform
Curve Deform parents the current object to the target object. It allows you to deform the object by moving it
along the curve axis.
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Follow path
Follow path parents the current object to the target object. The object becomes animated. The number of key
frames can be adjusted in the Properties editor. Select the curve, click the Data tab, and in the Path Animation
tab adjust the number of frames to your needs.

Path Constraint
No idea. Seriously, no idea what this should do and how it should work.

Vertex
Vertex parents the current object to a vertex of the target object. The vertex will be chosen automatically, it's the
closest vertice of the parent object. When you want to assign the object to a specific vertice, then you have to do
the vertex parenting in Edit mode.

Vertex (Triangle)
Vertex (Triangle) parents the current object to a face of the target object. Problem is, a path has no faces. And so
the operation will fail. Just ignore. It's a bug.

Last Operator Make Parent to Curve
Type is a drop-down box where you can change the type of parenting. Note that this list
also contains items that does not work for this object type parent relation.
Keep Transform applies transformation before parenting.

Set Parent to other object types
You can parent an object also to objects like lamps or an empty.

Object
Object simply parents the current object to the target object.

Object (Keep Transform)
Object (Keep Transform) parents the current object to the target object, but keeps the transform intact.

Last Operator Make Parent to other object types
Type is a drop-down box where you can change the type of parenting. Note that this list
also contains items that does not work for this object type parent relation.
Keep Transform applies transformation before parenting.
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Clear Parent
Clear Parent
Clear Parent clears the parent relation completely, including involved modifiers.

Clear and Keep Transformation
Clear Parent clears the parent relation completely, including involved modifiers.
But keeps the current visual transformation.

Clear Parent Inverse
Clear Parent Inverse resets the transform corrections applied to the parenting relationship. It does not remove
the parenting itself.

Last Operator Clear Parent
Type is a drop-down box where you can change the type of clearing. Same as the clear
parent menu.

Object Data
The Object data section gives you tools to handle object data.

Link Data
Link Data links the data from the selected to the active object.

Last Operator Link Data
Type is a drop-down box where you can choose what data type you want to link

Make Single User
Selected Objects makes the linked data local to each selected objects.
All makes the linked data local to all objects.

Last Operator Make Single User
Type is a drop-down box where you can choose if you want to handle selected objects or all
objects.
The checkboxes defines what data type you want to make local.

68

Bforartists Reference Manual - © Copyright - This page is Public Domain

Link to SCN
Link to SCN is a dropdown box where you can link to a specific scene. Obviouisly you need to have more than
one scene to be able to do so. But Blender just supports to load one scene at a time. You can however create
more than one scene data block in such a single scene. And that's the scene that you can link to.

To create a new scene data block see Properties
Editor, Scene Tab, Scene Panel.

Last Operator Link Objects to Scene

Scene
Scene is the same dropdown box like in the Relations
panel. Here you can again adjust to which scene you
want to link.

Linked Objects
Linked objects means the objects that you might have linked from other blend
files. When you don't have linked data in your scene then this buttons are of no
use.

Make Local
Make Local copies the object data from the original blend file to the new file. And
removes the link to the blend file. It calls a menu where you can choose a method.
Selected Objects makes the selected objects local.
Selected Objects and Data makes the selected objects and its data local.
Selected Objects, Data and Materials makes the selected objects, its data and its
material local.

Make Proxy
Make Proxy adds a new object and sets it as the parent of the linked data. This allows you to transform the
empty while still retaining the link to the original blend file. The mesh is not editable though. The Object data
block is cloned, but the Mesh data block is not.

Tool Shelf in Object Mode - Animation Tab
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The animation tab gives you tools to work with animation. Here you can handle
key frames, set keying set, etc.

Keyframes
The Keyframes section allows you to insert and remove key frames, bake
actions and clear all animation.

Insert
Insert inserts a keyframe.
When your object does have a active keying set, then a click at the button inserts the
keyframe directly.

Insert Keyframe Menu
The keying set defines what kind of key frames gets recorded. When you start with an
animation, and your object does not have a keying set yet, then you will be prompted with a
menu where you can choose the proper keying set. The Insert Keyframe menu.
For the meaning of the single items see Set Keying Set below. It's the same items.
Insert has no settings in the Last Operator panel.

Remove
Removes the current active keyframe for the selected object. You will get a confirmation
dialogue here.
Remove has no settings in the Last Operator panel.
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Bake Action
Bake Action bakes the object animation to a new action.
Bake action calls a panel where you can adjust the settings for the new
action.
Last Operator Bake Action
Start Frame

Defines the start frame for baking.
End Frame

Defines the end frame for baking.
Frame Step

Defines the frame step for baking.
Only Selected

Pose Baking only.
Visual Keying

Keyframe from the final transform.
Clear Constraints

Remove all constraints from keyed objects / bones, and do visual keying.
Clear Parents

Bake animation onto the object, then clear parents (objects only)
Overwrite current Action

Bake Action into current action instead of creating a new one.
Bake Data

Which data transformations to bake to. You have the choice between Pose and Object here.

Clear
Clears all animation, and removes all key frames for the selected object.
Clear has no settings in the Last Operator panel.

Set Keying Set
The keying set defines what kind of key frames gets recorded. Some keying sets have a
specific purpose, and works just in specific context and with specific kind of objects.
A click at the set keying set button brings up a menu where you can choose the keying set. It is nearly the same
menu as in the keying set drop-down box, and has the same functionality. With small differences. For example,
the two items Whole Character and Available.
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Available is context sensitive. So when you cannot see it in the list, then you can't use it yet. And Whole
Character is just available in Pose Mode.

Keying Set in detail:

Location
Location records key frames for the location of the object, absolute in the world.

Rotation
Rotation records key frames for the rotation of the object, absolute in the world.

Scale
Scale records key frames for the scale of the object, absolute in the world.

LocRot
LocRot records key frames for the location and rotation of the object, absolute in the world.

LocScale
LocScale records key frames for the location and scale of the object, absolute in the world.

LocRotScale
LocRotScale records key frames for the location rotation and scale of the object, absolute in the world.

RotScale
RotScale records key frames for the rotation and scale of the object, absolute in the world.
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Visual Location
Location records key frames for the location of the object, at 0/0/0 of the world.

Visual Rotation
Visual Rotation records key frames for the rotation of the object, at 0/0/0 of the world.

4Visual Scale
Visual Scale records key frames for the scale of the object, at 0/0/0 of the world.

Visual LocRot
Visual LocRot records key frames for the location and rotation of the object, at 0/0/0 of the world.

Visual LocScale
Visual LocScale records key frames for the location and scale of the object, at 0/0/0 of the world.

Visual LocRotScale
Visual LocRotScale records key frames for the location rotation and scale of the object, at 0/0/0 of the world.

Visual RotScale
Visual RotScale records key frames for the rotation and scale of the object, at 0/0/0 of the world.

Delta Location
Delta Location records key frames for the location of the object. It records the difference to the current location.
Means local.

Delta Rotation
Delta Rotation records key frames for the rotation of the object. It records the difference to the current rotation.
Means local.

Delta Scale
Delta Scale records key frames for the scale of the object. It records the difference to the current scale. Means
local.

Available
Available records the keyframe in the current active keying set. This means that you need to
have an active keying set already. The menu item is not available when you don't have an
active keying set.
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Motion Paths
Objects can be animated. Let's say you
send them from a to b to c. The object will
move to b, then to c. Some kind of a path.
This path is not visible by default.
With motion paths you can calculate this path, and make it visible.

Calculate
Calculate calculates the motion path of the selected object. It opens a panel where you
can define the start and end frame of the calculation.

Last Operator Calculate Object Path
Start defines the start frame of the calculation.
End defines the end frame of the calculation.

Clear
Clear remove the motion path from the object.

Tool Shelf in Object Mode - Physics Tab
The Physics panel contains physics tools. It contains just one panel. Rigid Body Tools. You can do basic
operations here. The setup has to happen in the Properties editor then.
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Add / Remove
Here you can add and remove rigid bodys. Rigid bodies are needed for physics
in Bforartists. Think of it as invisible colliders for your object where the forces
can work at.

Add Active
Add Active adds a rigid body to the selected object. The type of this rigid body is active. This is useful for any
actively moving object. Characters, bullets, etc.

Add Passive
Add Active adds a rigid body to the selected object. The type of this rigid body is passive. This is useful for any
static object, like ground for example.

Last Operator Add Rigid bodies
The rigid body type is a drop-down box where you can choose if the type of the rigid body
is active or passive.

Remove
Remove simply removes the rigid body from the current object. It has no Last Operator settings

Object Tools
The Object tools gives you some tools for your rigid body.

Change shape
Change Shape opens a pop-up menu where you can change the shape of your rigid body.

Last Operator Change Collision shape

Rigid Body Shape is a pop-up menu where you can change the shape of your rigid body again.
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Calculate Mass
Calculate Mass does NOT calculate the mass. But
gives you a pop-up menu where you can choose
between different predefined mass set-ups. The
corresponding value will then be set in the physics
settings in the Rigid Body settings.

Last Operator Calculate Mass

Material Preset is a pop-up menu where you can choose the type of preset again.
Density is the mass value from the Rigid Body panel.

Copy from Active
Copy from Active allows you to copy all the physics settings from the active object and apply it at the selected.
First select the object that contains the physics settings. Then add the target object to the selection. Then press
the button.

Apply visual transform
Apply visual transform applies the visual transform to the object.

Bake to Keyframe
Bake to Keyframe bakes the whole physics animation to key frames. A click
at the button brings up a menu where you can set the range and the number
of frame steps.

Constraints
Constraints allows objects and rigid bodys to interact with each other. It can act as a joint. Or
limit the movement along one axis, etc. .

Connect
Connect connects rigid bodies. It creates a new Empty object named “Constraint”, which has a physics
constraint already attached. And is pointing at the two selected objects. The setup has to happen in the
Properties editor then.
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Last Operator Connect Rigid Bodies
Type is a drop-down box where you can choose the type of the constraint.
Location is a drop-down box where you can choose the location of the constraint empty.
Connection is a drop-down box where you can choose the type of connection pattern.

Tool Shelf in Edit Mode
The Tool Shelf in Edit Mode provides you the tools to edit the objects. Things like modifying geometry, modify
an armature, modify Curves or 3D text, etc. .
Not all object types are editable. Editable object types are all object types in the Add Primitive panel. Mesh,
Curve, Surface, Meta ball. In the Add Misc panel it's Text, Armature and Lattice from the Other category.
The tools differs from object type to object type. Even the available tabs differs. So in Edit mode we have to
come from the Object type to explain the tabs and panels.

Tool Shelf in Edit Mode - Mesh Object, Relations Tab
Relations Panel
The Relation panel contains tools around relations. In Edit Mode it's just
Make Vertex Parent.
In Object mode select the object that you want to parent to a vertex. Shift
select the parent object so that both are selected. Enter Edit mode. Then select one vertex for a single point. Or
three for an area. Then click the Make Vertex Parent button to make the relation.

Tool Shelf in Edit Mode - Mesh Object, Tools Tab
The Tools tab contains the tools to edit the mesh object. It contains the panels Mesh Tools,
Vertices Tools, Edge Tools, Faces Tools, Clean Up, Weight Tools, History and Bake.
Which Bake panel is active is dependant of what render engine is selected. When it's cycles
then you have the Cycles bake tools. When it's the Blender Render, then you have the
Blender Render bake tools.
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Mesh Tools Panel
The Mesh Tools Panel contains the tools to edit and
manipulate the geometry of a mesh object.
There are four main tool groups in the Mesh Tools panel.
Transform tools, Deform tools, Add tools, and Dissolve
tools. The Transform tools at the top doesn't have a label.

Shrink/Fatten
Shrink/Fatten scales the selected geometry along its
normals. Transform orientation and Pivot point gets
ignored.
A positive value pushes the vertices outwards. A
negative value pushes the vertices inwards.

Last Operator Shrink/Fatten
The Last Operator Shrink/Fatten panel gives you tools to adjust the Shrink/Fatten operation. Here you have
numeric input for the strength and a few more options.

Offset
Offset is the strength of the offset for Shrink/Fatten.
Offset Even
Offset Even scales the selection to give more thickness in even areas.
Proportional Editing
Proportional Editing is a drop-down box where you can choose to use
proportional editing. When you choose one of the active methods then
the neighbour geometry gets influenced by Shrink/Fatten too in a
proportional way.
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Proportional Editing Falloff
Proportional Editing Falloff is a drop-down box where you can choose a method for the
falloff for the proportional editing.
Proportional size
Proportional size is a edit box where you can adjust the strength of the Proportional
falloff
Confirm on Release
With Confirm on Release checked the action gets performed when you release the mouse button.

Mirror
Mirror mirrors the selected geometry along the defined axis. Click the Mirror button, type in X, Y or Z, then
confirm with enter.
Last Operator Mirror
The Last Operator Mirror panel gives you tools to adjust the mirror action.

The Last Operator Mirror panel gives you tools to adjust the mirror action.
Constraint Axis
Constraint Axis gives you again the possibility to define the mirror axis. You can choose
more than one axis here.
Orientation
Orientation is a drop-down box where you can choose the type of
orientation for the mirroring action.
Proportional Editing
Proportional Editing is a drop-down box where you can choose to use
proportional editing. When you choose one of the active methods then
the neighbour geometry gets influenced by Shrink/Fatten too in a proportional way.
Proportional Editing Falloff
Proportional Editing Falloff is a drop-down box where you can choose a method for the
falloff for the proportional editing.
Proportional size
Proportional size is a edit box where you can adjust the strength of the Proportional
falloff.
Edit Grease Pencil
Edit Grease Pencil edits the selected Grease Pencil strokes.
Confirm on Release
With Confirm on Release checked the action gets performed when you release the mouse button.
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Mirror Vertex Group
This tool requires to have a vertex group assigned. It tries to mirror for example existing Weight Painting from
one side to the other.
This tool works only with a perfectly symmetrical mesh along the local X axis. Vertices that have no
corresponding vertex on the other side will not be affected.
Use case:
Let's say you have a rigged character, and do Weight Paint at one side of the mesh. Now you would have to
repeat the Weight Painting at the other side. Instead, go to the vertex group panel in the Properties editor, and
choose Copy Vertex Group (from the drop down menu) for each group you want to mirror. Then select the copy
and choose Mirror Vertex Group.
Last Operator Mirror Vertex Group
Mirror Weights
Mirrors the Weight Painting informations from the symmetrical counterpart. When both are
selected it will become a group and weight information exchange. If only one is selected,
then the information from the unselected vertice will go to the selected vertice.
Flip Group Names
Flip selected group names. This works with vertex groups with symmetrical name conventions. Like .L , .R,
right, left.
All Groups
Pass information to all groups instead of the active one.
Topology Mirror
Use topology based mirroring.

Symmetrize
The Symmetrize tool mirrors the selected geometry
symmetrical along a world axis.
Last Operator Symmetrize

Direction
Direction is a drop down box where you can define the mirroring direction.
Threshold
Here you can adjust a distance after which the mirroring should happen, relative to the mirror
axis. 0 means it mirrors the geometry directly at the axis.
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Modify section
This section contains tools for general mesh modifications.

Extrude Region
The Extrude Region tool extrudes along the vertex normals. This leads at our
standard cube with two selected faces and with a value of 1 to a extrude that
goes inside of the mesh.
The method works the same in all Mesh select modes.

Last Operator Extrude Region and Shrink/Fatten
The Last Operator Extrude Region and Shrink/Fatten contains the tools to adjust the
Extrude settings for the extrude method Region (Vertex Normals)
Extrude Individual Faces

Just ignore, it's a bug. It's the title of the panel when you call this menu by a hotkey. Shrink/
Fatten Offset
You have to read the two parts Shrink Fatten and Offset as one. Shrink Fatten Offset is a
edit box where you can adjust the strength of the extrude offset numerically.
Offset Even

Scale the offset to give more even thickness.
Proportional Editing

Proportional Editing is a drop-down box where you can choose to use proportional editing.
When you choose one of the active methods then the neighbour geometry gets influenced
by Shrink/Fatten too in a proportional way.
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Proportional Editing Falloff

Proportional Editing Falloff is a drop-down box where you can choose a method for the
falloff for the proportional editing.
Proportional size

Proportional size is a edit box where you can adjust the strength of the Proportional
falloff.
Confirm on Release

With Confirm on Release checked the action gets performed when you release the mouse button.

Individual Faces
The extrude method Individual Faces is the exact same method than the
method Individual - In Face mode

Individual Faces extrudes the faces individually. When you for example
select two faces at a cube, then the extrusion happens at both faces in their
own direction, which is defined by the normals of the faces. And not as a
whole in one shared direction.
Individual Faces works in all mesh select methods the same. It needs
selected faces. Stand-alone vertices or edges gets ignored.

Last Operator Extrude Individual Faces and Move
The Last operator Extrude Individual Faces and Move contains the tools to adjust the Extrude Individual Faces
settings. It shows when you use the Individual tool in Face mode.
Extrude Individual Faces

Just ignore, it's a bug. It's the title of the panel when you call this menu by a hotkey.
Shrink/Fatten Offset

You have to read the two parts Shrink Fatten and Offset as one. Shrink Fatten Offset is a
edit box where you can adjust the strength of the extrude offset numerically.
Offset Even

Scale the offset to give more even thickness.
Proportional Editing
Proportional Editing is a drop-down box where you can choose to use proportional editing.
When you choose one of the active methods then the neighbour geometry gets influenced
by Shrink/Fatten too in a proportional way.
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Proportional Editing Falloff

Proportional Editing Falloff is a drop-down box where you can choose a method for the
falloff for the proportional editing.
Proportional size

Proportional size is a edit box where you can adjust the strength of the Proportional
falloff.
Confirm on Release

With Confirm on Release checked the action gets performed when you release the mouse
button.

Extrude Drop-down box
The Extrude drop-down box contains the special Extrude methods. The methods that you don't use this often.
The available Extrude tools depends of the Mesh select mode. Edge, Vertice and Face select.
And the tool works then of course for the current mode. Means when you are vertice select
mode, then the extrude will extrude the vertices. But it also depends of what you have
selected. And so you see different content in the drop-down box.
From left to right, with a whole cube selected: Vertices select mode, Edge select mode, Face select mode.

Dupli Extrude
Dupli Extrude is a two trick tool. With faces selected it creates a rotated copy of the geometry. With edges or
vertices selected it extrudes to the mouse position. That's why it is a good idea to use this tool with the hotkey.
Dupli Extrude - with selected Faces

Dupli Extrude with selected faces creates a copy of the selection and rotates it slightly.
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Dupli Extrude - with selected Vertices

Dupli Extrude with selected vertices extrudes the vertice to the mouse position.

Extrude Region

Extrude region is the most common and most used extrude method. That's
why it has a default hotkey. Shortcut S. It extrudes the whole selection into
the direction of the middled normals of the selection.
Last Operator Region and Move
The Last operator Extrude Individual Faces and Move contains the tools to
adjust the Extrude Individual Faces settings. It shows when you use the
Individual tool in Face mode.
Extrude Region label

Just ignore, it's a bug. It's the title of the panel when you call this menu by a hotkey.
Translate Vector

You have to read the two parts Translate and Vector as one. Here you can adjust the
extrude amount by a vector.
Constraint Axis

Tick or untick X, Y Z to limit the extrusion to one or more axis.
Orientation

Here you can adjust the orientation of the extrusion. It usually starts with Normal.
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Proportional Editing
Proportional Editing is a drop-down box where you can choose to use proportional editing. When you choose
one of the active methods then the neighbour geometry gets influenced by Shrink/Fatten too in a proportional
way.
Proportional Editing Falloff

Proportional Editing Falloff is a drop-down box where you can choose a method for the
falloff for the proportional editing.
Proportional size

Proportional size is a edit box where you can adjust the strength of the Proportional falloff.
Edit Grease Pencil

Edit Grease pencil ticked allows you to edit the grease pencil stroke.
Edit Texture Space

By default extrusion will not modify the UV mapping. With Edit texture Space ticked
the UV mapping updates with the extrusion.
Confirm on Release

With Confirm on Release checked the action gets performed when you release the mouse
button.

Extrude Individual - In Face mode
Individual in Face mode extrudes the elements individually. When you for
example select two faces at a cube, then the extrusion happens at both faces
in their own direction, which is defined by the normals of the faces. And not
as a whole in one shared direction.
Last Operator Extrude Individual Faces and Move
The Last operator Extrude Individual Faces and Move contains the tools to
adjust the Extrude Individual Faces settings. It shows when you use the
Individual tool in Face mode.
Extrude Individual Faces

Just ignore, it's a bug. It's the title of the panel when you call this menu by a hotkey.
Shrink/Fatten Offset

You have to read the two parts Shrink Fatten and Offset as one. Shrink Fatten Offset is a
edit box where you can adjust the strength of the extrude offset numerically.
Offset Even

Scale the offset to give more even thickness.
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Proportional Editing
Proportional Editing is a drop-down box where you can choose to use proportional editing.
When you choose one of the active methods then the neighbour geometry gets influenced
by Shrink/Fatten too in a proportional way.
Proportional Editing Falloff

Proportional Editing Falloff is a drop-down box where you can choose a method for the
falloff for the proportional editing.
Proportional size

Proportional size is a edit box where you can adjust the strength of the Proportional
falloff.
Confirm on Release

With Confirm on Release checked the action gets performed when you release the mouse button.

Extrude Individual in Edge and Vertice Mode
For Individual in Edge and Vertice Mode see the extrude methods Edges only and Vertices only. It's the same
functionality.

Spin
The Spin tool extrudes the selection and spins it by a defined amount and
segments. This amount and number of segments can be adjusted in the Last
operator. It is best performed in a orthographic view from side. It depends of the
view orientation when extruding out.
Last Operator Spin
Steps

Steps is the number of segments.
Dupli

With dupli checked the geometry gets duplicated instead of
extruded. Angle
Angle defines the angle of the spin.
Centre

The Centre edit boxes defines the centre of the radius for the spin
operation. In our example the X value is set to 2, and the Z value is set to 1.
Axis

Axis defines the extrude direction. With X and Z values you can twist the result.
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Screw
With the Screw tool you can extrude edges to a screw shape. Examples:

Last Operator Screw
Steps

Steps is the number of segments.
Turns

Turns defines the repeating of the screw.
Centre

The Centre edit boxes defines the centre of the radius for the screw operation.
Axis

Axis defines the extrude direction.

Inset
Inset insets edges into the selected faces. Think of it as a extrude inwards the face.
Last Operator Inset
Boundary

With Boundary ticked you will get the connect edges in the corners.
Offset Even

Scales the offset to give more even thickness.
Offset Relative

Scales the offset by surrounding geometry.
Edge Rail

Inset the region along existing edges.
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Thickness

Thickness adjusts the thickness of the inset geometry.
Depth

With depth you can bevel the inset geometry. It is then not longer coplanar to the initial face.
Outset

With outset ticked the Inset will not extrude inwards but outwards.
Select Outer

With Select Outer the outer ring will be selected after the Inset.
Individual

Inset every face individually.
Interpolate

Blend Face Data across the inset.

Make Edge/Face
The Make Edge/Face tool adds a face when you have edges selected. And Edges when you have Vertices
selected. It's a Bridge tool.

First select the edges or Vertices that you want to bridge. Then click the Make Edge/Face Button.

The Last Operator Make Edge/Face has no further options.

Bevel
The Bevel Tool adds a bevel to the selected geometry.

Usage: first select the geometry that you want to bevel. Then activate the tool.
Don't wonder that the mouse movement does nothing. That's by design. Adjust
the amount in the Last Operator Bevel panel.
Last Operator Bevel
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Amount type

Amount Type is a drop-down box where you can choose the Amount type for the bevel
action.
Amount

The Bevel amount
Segments

How many segments gets created
Profile

Controls the Profile shape. 0.5 means round.
Vertex only

Bevel Vertices only.
Clamp Overlap

Do not allow bevelled geometry to overlap each other.
Loop Slide

Prefer slide along edge to even widths.
Material

Material for bevelled faces. -1 is the surrounding material.

Vertex Bevel
Vertex Bevel is nothing else than Bevel. But with some pre adjustments to
perform a vertex bevel directly. This saves some clicks.

This means that the Last Operator is of course the same than the one from Bevel
since it is Bevel.

Subdivide
Subdivide divides the selected edges. It subdivides the involved
faces too, and can create new vertices.

A more unknown functionality is that it can also randomize the
result with the Fractal slider in the Last operator panel.
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Last Operator Subdivide
Number of Cuts

The number of cuts defines the amount of subdivisions.
Smoothness.

This value defines how smooth the subdivision result is. From flat to bent.
Quad/Tri Mode

With this tool ticked it tries to prevent N-Gons while subdivision.
Quad Corner Type

Here you can adjust the corner type.
Fractal

Randomize the selected vertices.
Along Normal

When randomized, this value defines how strong the subdivision follows the normals of the
initial vertices.
Random Seed

Randomizing value for fractal randomizing.

Bridge Edgeloops
The Bridge edgeloops tool bridges selected edges, and adds a polygon
between them. You need to have at least two edges selected.

Last Operator Bridge Edgeloops
Connect Loops

Here you can choose the method how to deal with bridging multiple loops
Merge

With merge ticked it will not create a bridge face, but merge the selected edges.
Merge Factor

The merge factor determines at which distance between the selected edges the merge
happens. 0.5 is the middle of the selected edges.
Twist

The twist offset for closed loops.
Number of Cuts

Adds cuts to the bridge face.
Interpolation

Here you can choose the interpolation mode for the cuts.
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Smoothness

Here you can adjust the smoothness for the cuts.
Profile Factor

Here you can adjust the profile factor for the cuts.
Profile shape

Here you can adjust the profile shape for the cuts.

Cut Slide panel
This section contains tools around cut functionality.

Knife tool
The Knife tool cuts the geometry, and adds edges. When it crosses
existing geometry then it adds a vertice at the crossing point.

The Knife tool cuts across every geometry, selected or not.
Usage: activate the tool, left click to define the starting point. This can
also be a point in the middle of a face. But ideally you choose an
existing vertice or an edge as the start and endpoints. When done press
Space bar to confirm.
Last Operator Knife Topology Tool
There is no adjustable setting in the Last Operator Knife Topology
Tool.

Just a hint that Redo is not supported for this operator. And the states of the checkboxes are
displayed.

Knife Select Tool
Knife Select tool works similar to the Knife tool. But it cuts just selected faces.
Last Operator Knife Topology Tool
There is no adjustable setting in the Last Operator Knife Topology
Tool.

Just a hint that Redo is not supported for this operator. And the states
of the checkboxes are displayed. For Knife Select this checkboxes are checked different than for the normal
knife tool.
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Loop Cut and Slide
Loop Cut and Slide is a tool that works in two steps. In the first
step you divide the selected geometry by a loop. When you left
click, then the added loop becomes moveable along the edges.
Last Operator Loop Cut and Slide
Number of Cuts

The number of cuts that gets added. It can be more than one loop at once.
Smoothness

This value defines how smooth the loop cut gets added. From flat to bent.
Falloff

Here you can adjust the Falloff type for smoothness.
Edge Slide Factor

Where the loop is centred.
Even

Make the edge loop match the shape of the adjacent edge loop
Flipped

When Even mode is active, flips between the two adjacent edge loops.
Clamp

Clamp within the edge extend.
Correct UV's

Corrects the UV's when modifying the geometry.
Confirm on Release

With Confirm on Release checked the action gets performed when you release the mouse button.

Offset Edge Slide
Edge slide slides the selected edge(s)

Usage: select the edges that you want to slide. Click to confirm. Then adjust the sliding
amount in the Last Operator Offset Edge Slide.

Last Operator Offset Edge Slide
Cap Endpoint
Cap Endpoint caps the loose edges.
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Edge Slide Factor

Here you can adjust the slide amount.
Even

Make the edge loop match the shape of the adjacent edge loop
Flipped

When Even mode is active, flips between the two adjacent edge loops.
Clamp

Clamp within the edge extend.
Correct UV's

Corrects the UV's when modifying the geometry.
Confirm on Release

With Confirm on Release checked the action gets performed when you release the mouse button.

Knife Project
Knife Project uses an object as a knife to cut edges into a mesh.

Usage: Create a cube. Create a circle. Rotate the circle by 90 degrees, and move it in front of the cube so that it
does not overlap the cube. Now go into front view. Select circle, hold down shift, select Cube. Enter Edit Mode.
Click the Knife Project tool.

Last Operator Knife Project
Cut through

The cut goes through the whole object when the Cut through checkbox is ticked.

Bisect
Bisect cuts geometry along a plane. This description is a bit misleading though. You simply
cut through the whole geometry by defining a line. And the cut goes through the geometry
from the current view.
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Last Operator Bisect
Plane Point
Defines the start point of the Bisect cut.
Plane Normal

The direction in which the bisect points.
Fill

Fills the cut
Clear Inner

Removes the inner part of the face to cut.
Clear Outer

Removes the outer part of the face to cut.
Axis threshold

Axis threshold.

Merge / Separate
This section contains the merge and separate tools.

Merge
Merge merges the vertices of the selected geometry. There are three methods available. At
centre, At Cursor and Collapse.

At Centre merges the geometry at the centre of the selected vertices.
At Cursor merges the geometry at the 3D Cursor.
Collapse merges the geometry at the centre of the selected vertices.
Last Operator Merge
Type

Type is the drop-down box again where you can choose what method to use for merge.
UV's

With UV's ticked the UV mapping will update with changes at the geometry.

Separate
Separate separates the selected geometry, and creates a new object. The geometry becomes
uneditable, since it is now a new object. You will have to leave the Edit mode, select the new
object, and re-enter Edit mode when you want to edit it.
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Selection separates the current selection.
By Material separates all geometry that has the same material than the current selection.
By Loose parts separates all geometry that is connected by edges to the current selection.
Separate has no Last Operator.

Deform section
The Deform section contains tools to deform the existing geometry.

Edge Slide
Edge Slide slides the selected edge along the
face that it is part of. This is for the edge at a
cube into two possible directions.
Last Operator Edge Slide
Factor
Factor is a sliding box Here you can adjust
the slide strength numerically. The width of
the face is the 0-1 range.
Even
Make the Edge loop match the shape of the adjacent edge loop.
Flipped
When Even Mode is active, flips between the two adjacent edge loops.
Clamp
Clamp within the edge extend.
Correct UV's
Correct UV's corrects the UV's while editing the geometry.
Confirm on Release
With Confirm on Release checked the action gets performed when you release the mouse button.
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Vertex Slide
Vertex Slide slides the selected vertice along the edge that it is part of. This is for the corner vertice at a cube
into three possible directions.

Last Operator Vertex Slide
Factor
Factor is a sliding box Here you can adjust the slide strength numerically. The width of the
face is the 0-1 range.
Even
Make the Edge loop match the shape of the adjacent edge loop.
Flipped
When Even Mode is active, flips between the two adjacent edge loops.
Clamp
Clamp within the edge extend.
Correct UV's
Correct UV's corrects the UV's while editing the geometry.
Confirm on Release
With Confirm on Release checked the action gets performed when you release the mouse button.

Smooth Vertex
Smooth Vertex smooths the selected vertices. It is a tool to reduce noise at the mesh.
Last Operator Smooth Vertex
Smoothing
Smoothing is the strength of the smoothing
Repeat
Repeat is the number of iterations that the smoothing action gets repeated. With 1 the
smoothing is just performed once. With 10 it is performed ten times.
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Axis
The Axis checkboxes lets you limit the smoothing to specific world axis.

Laplacian Smooth Vertex
Laplacian Smooth Vertex smooths the selected vertices. It is a tool to reduce noise at the mesh. It works a bit
different than the normal Smooth Vertex tool. And gives a different result. The Laplacian method allows you to
preserve the volume, and to adjust border smoothing.
Last Operator Laplacian Smooth Vertex
Number of Iterations
Number of Iterations is the number of iterations that the smoothing action gets repeated. With 1 the smoothing
is just performed once. With 10 it is performed ten times.
Lambda Factor
Lambda Factor is the strength of the smoothing.
Lambda Factor in border
Lambda Factor is the strength of the smoothing in border areas.
Smooth Axis
The Smooth Axis checkboxes allows you to limit the smoothing to specific world axis.
Preserve Volume
Preserve Volume preserves the volume of the object.

Dissolve Section
Dissolve operations removes for examples selected vertices, edges and faces.
But they are not delete operations. It's not simply removing the selected
element. Dissolve can behave different than delete. And offers some options.

When you for example choose Delete vertices from the mesh menu,
then the involved faces can get deleted too. When you choose
Dissolve vertices, then the vertices gets removed, and the faces stays
intact.
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Dissolve Vertices
Dissolve Vertices dissolves the selected Vertices.

Note that pressing DEL in Vertice select mode calls Dissolve Vertices already. It's the same operator. But you
don't get the Last operator that way.
Last Operator Dissolve Vertices
Face Split

Split off Face corners to maintain surrounding geometry
Tear Boundary

Split off Face corners instead of merging faces

Dissolve Edges
Dissolve Edges dissolves the selected Edges.

Note that pressing DEL in Edge select mode calls Dissolve Edges already. It's the same operator. But you don't
get the Last operator that way.
Last Operator Dissolve Edges
Dissolve Verts

When the dissolve operation leaves vertices behind, then this vertices will be dissolved too.
Face Split

Split off Face corners to maintain surrounding geometry

Dissolve Faces
Dissolve Faces removes the inlaying edges of the selected faces. This faces becomes one big N-Gon.
Last Operator Dissolve Faces
Dissolve Verts

When the dissolve operation leaves vertices behind, then this vertices will be dissolved too.

Remove Doubles
Remove doubles merges vertices that are close to each other or overlapping each other. This is sometimes
necessary to remove vertices that overlaps each other, and cannot even be seen therefore.
Last Operator Remove Doubles
Merge Distance

The distance in which the vertices gets catched and merged.
Unselected

With Unselected ticked all surrounding vertices will be calculated.
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Limited Dissolve
Limited Dissolve dissolves the selected Edges and Vertices, limited by the surrounding geometry.
Last Operator Limited Dissolve
Max Angle

The limiting angle.
All Boundaries

All Boundaries dissolves in-between face boundaries.
Delimit

You can also delimit by other methods than normals.

Dissolve Selection
Dissolve Selection dissolves the geometry based at the selection mode.
Last Operator Dissolve Selection
Dissolve Verts

When the dissolve operation leaves vertices behind, then this vertices will be dissolved too.
Face Split

Split off Face corners to maintain surrounding geometry.
Tear Boundary

Split off Face corners instead of merging faces.

Edge Collapse
Edge Collapse collapses the selected edges to a vertice at the centre of the selection.

Edge Collapse has no adjustable settings in the Last Operator panel.

F2 Tool
The F2 Tool is an addon that speeds up modeling
process. It allows you to quickly fill gaps in a mesh.
This addon can be disabled in the addon section of the
user preferences.
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Vertices Tools Panel
Vertices Tools is a panel that contains vertices related tools.

Rip
Rip splits the edges between the selected vertices. It creates two edges out of
one.
This tool works similar to the Edge Split tool. But with selected edges instead
of selected vertices. It also selects the outer edges so that you immediately
move them. And it provides some options in the Last operator.

Last Operator Rip
There are some greyed out parts. We will ignore them since it is most
probably a bug, and we cannot edit them anyway.

Vector
Here you can adjust the position values for the three values
Constraint Axis
Here you can limit the position relative to the source object.
Orientation
Orientation is a drop-down box where you can choose the type of orientation for the
mirroring action.
Proportional Editing
Proportional Editing is a drop-down box where you can choose to use proportional editing.
When you choose one of the active methods then the neighbour geometry gets influenced
by Shrink/Fatten too in a proportional way.
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Proportional Editing Falloff
Proportional Editing Falloff is a drop-down box where you can choose a method for the
falloff for the proportional editing.
Proportional Size
Proportional size is a edit box where you can adjust the strength of the Proportional
falloff.
Edit Grease Pencil
Edit Grease Pencil edits the selected Grease Pencil strokes.
Edit Texture Space
With Confirm on Release checked the action gets performed when you release the mouse button.

Rip Fill
Rip Fill works similar to the Rip tool. It splits the edges between the selected
vertices. It creates two edges out of one. But it fills the gap between the new
edges when you move the geometry.
This tool works similar to the Edge Split tool. But with selected edges instead
of selected vertices. It also selects the outer edges so that you immediately
move them. And it provides some options in the Last operator.

Last Operator Rip Fill
There are some greyed out parts. We will ignore them since it is most
probably a bug, and we cannot edit them anyway.

Vector
Here you can adjust the position values for the three values
Constraint Axis
Here you can limit the position relative to the source object.
Orientation
Orientation is a drop-down box where you can choose the type of orientation for the
mirroring action.
Proportional Editing
Proportional Editing is a drop-down box where you can choose to use proportional editing.
When you choose one of the active methods then the neighbour geometry gets influenced
by Shrink/Fatten too in a proportional way.

101

Bforartists Reference Manual - © Copyright - This page is Public Domain

Proportional Editing Falloff
Proportional Editing Falloff is a drop-down box where you can choose a method for the
falloff for the proportional editing.
Proportional Size
Proportional size is a edit box where you can adjust the strength of the Proportional
falloff.
Edit Grease Pencil
Edit Grease Pencil edits the selected Grease Pencil strokes.
Edit Texture Space
With Confirm on Release checked the action gets performed when you release the mouse button.

Extend Vertices
Extend vertices extrudes out the selected vertices. When you do this operation at
an edge then you will create N-Gons that way.

Last Operator Extend Vertices
There are some greyed out parts. We will ignore them since it is most
probably a bug, and we cannot edit them anyway.

Vector
Here you can adjust the position values for the three values
Constraint Axis
Here you can limit the position relative to the source object.
Orientation
Orientation is a drop-down box where you can choose the type of orientation for the
mirroring action.
Proportional Editing
Proportional Editing is a drop-down box where you can choose to use proportional editing.
When you choose one of the active methods then the neighbour geometry gets influenced
by Shrink/Fatten too in a proportional way.
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Proportional Editing Falloff
Proportional Editing Falloff is a drop-down box where you can choose a method for the
falloff for the proportional editing.
Proportional Size
Proportional size is a edit box where you can adjust the strength of the Proportional
falloff.
Edit Grease Pencil
Edit Grease Pencil edits the selected Grease Pencil strokes.
Edit Texture Space
With Confirm on Release checked the action gets performed when you release the mouse button.

Split
Split works similar to the Rip tool. It splits the edges between the selected
vertices. It creates two edges out of one.
This tool works similar to the Edge Split tool. But with selected edges
instead of selected vertices.

Connect Vertex Path
Connect Vertex path connects selected vertices, but takes the vertex order into
account. It just creates edges between vertices that are not connected in this
order.

Connect Vertices
Connect Vertices connects the selected vertices. It does not fill the selection with
edges though, but creates just the edges for the outside of a polygon.
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Convex Hull
Creates a convex hull around the selected vertices.

Last Operator Convex Hull
Delete Unused
Removes vertices that are not part of the convex geometry.
Use existing Faces
Use existing input faces that lies on the hull where possible. This option allows to have NGons in the convex hull.
Make Holes
Deletes edges and faces in the hull that were part of the input. This allows to delete faces
between the existing mesh and the convex hull.
Join Triangles
Joins adjacent triangles into quads
Max Face Angle
Max Face Angle belongs to the Join Triangles setting. Here you can set the maximum face angle.
Max Shape Angle
Max Face Angle belongs to the Join Triangles setting. Here you can set the maximum shape angle.
Compare UV's
Takes existing UV patches for the calculation into account.
Compare Vcols
Takes existing Vertex colors for the calculation into account.
Compare Seam
Takes existing seams for the calculation into account.
Compare Sharp
Takes existing sharp edges for the calculation into account.
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Compare Materials
Takes existing materials for the calculation into account.

Edges Tools Panel
Edges Tools is a panel where you can find some Edges related tools.

Subdivide Edge ring
Subdivides the selected edge ring(s).

Last Operator Subdivide Edge ring
Number of Cuts
Here you can adjust the number of cuts for the subdivision.
Interpolation
Here you can chose a interpolation method for the new geometry.

Linear ends in a equal division and a flat result. Blend Surface interpolates the surrounding
geometry. And can end in a curvy result.
Smoothness
The Smoothness factor for the interpolation.
Profile Factor
The profile strength
Profile Shape
A drop-down box where you can define a profile for the generated geometry.
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Un-Subdivide
Decimates the geometry by trying to make one quad out of four quads. But can also end
in Tris where this is not possible.

Last Operator Un-Subdivide
Iterations
Number of iterations. This means how deep the calculation should go. One level of SDS,
two levels, three levels, etc. . Down to the point where you cannot decimate any geometry
anymore.

Edge Crease
When you use a Subdivision Surface Modifier, then you can define the sharpness of
selected edges with this tool. Crease edges will be marked colored in edit mode.
You will see a value in the header that indicates the current strength when you activate
the tool. Move with the mouse to increase or decrease the value. Or type in a value
while you are in this mode. You can also scale into negative range.
A negative crease value will subtract from the current active crease value in case it
exists already from a former crease operation. A Crease value of -1 removes the crease from
this edge.

Last Operator Edge Crease
Factor
Here you can adjust the crease factor.

Edge Bevel Weight
This tool adjusts the edge bevel weight for selected edges when you use the Bevel
modifier at the mesh.
You will see a value in the header that indicates the current strength when you
activate the tool. Move with the mouse to increase or decrease the value. Or type in a
value while you are in this mode. You can also scale into negative range.
A negative Edge Bevel Weight value will subtract from the current active crease
value in case it exists already from a former crease operation. A Edge Bevel Weight value of
-1 removes the weight from this edge.
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Last Operator Edge Bevel Weight
Factor
Here you can adjust the Edge Bevel Weight
factor.

Mark Sharp
Mark Sharp is a tool that you need for the Edge Split modifier.
Marked edges are displayed and rendered as sharp edges.

Last Operator Mark Sharp
Clear
Clears selected edges instead of marking it
Vertices
Calculate by the selected vertices instead of edges to mark the edges.

Clear Sharp
Clears formerly as sharp marked selected edges

Last Operator Mark Sharp
Clear
Clears selected edges instead of marking it.
Vertices
Calculate by the selected vertices instead of edges to mark the edges.

Rotate Edge CW
Rotate Edge rotates the selected edge clockwise.
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This feature is useful when you have a triangulated quad mesh, and need to have some edges point into another
direction as they currently do.
Rotate Edge CW rotates clockwise by default. But you can also rotate counter clockwise.

Last Operator Rotate Selected Edge
Counter Clockwise
Rotate selected edges counter clockwise

Edge Split
Edge split splits the selected edges. It creates two edges out of one.
This tool works similar to the Rip tool. But with selected edges instead
of selected vertices. And this tool has no further settings.

Mark Freestyle Edge
Freestyle is a comic renderer that is included in Bforartists. Mark Freestyle Edges marks
the selected edges as Freestyle feature edges.

Last Operator Mark Freestyle Edge
Clear
Unmarks the selected edges as Freestyle feature edges.

Clear Freestyle Edge
Freestyle is a comic renderer that is included in Bforartists. Clear Freestyle Edges unmarks the selected edges
as Freestyle feature edges.

Last Operator Mark Freestyle Edge
Clear
Unmarks the selected edges as Freestyle feature edges.

Faces Tools Panel
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Faces
Faces is a menu where you can find some Faces related tools.

Fill
Fills holes and triangulates the geometry.

Last Operator Fill
Beauty
Use best triangulation division.

Grid Fill
Grid Fill allows you to fill two edge loops with quad geometry that follows the
surrounding geometry.
Usage: select two opposite edge loops. Then perform the tool.

Last Operator Grid Fill
Span
Number of sides.
Offset
Here you can define a offset.
Simple Blending
Uses a simple interpolation. Faster but less accurate.

Beautify Faces
Beautify faces tries to optimize triangulations.

Last Operator Beautify Faces
Max Angle
Here you can set an angle limit.
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Solidify
Gives the selected faces a thickness, and makes it solid.
There is also a Solidify modifier available.

Last Operator Solidify
Thickness
Here you can adjust the thickness. You can scale also into the negative range.

Intersect
Intersect creates edges where geometry intersects.
This operation happens in Edit mode, and so all parts must be in the same mesh.

Last Operator Intersect
Source
Source is a drop-down box where you can choose at which mesh part you want to
operate.

Selected/Unselected works between the selected and unselected geometry.
Self Intersect works on the overlapping geometry of the mesh.
Separate Mode
Separate mode is a drop-down box where you can choose the separation mode.

All splits the geometry at the new edge.
Cut keeps each side of the intersection separate without splitting the faces in half.
Merge merges all the geometry from the intersection.
Merge Threshold
Here you can adjust the merge threshold. Increase it when some geometry is not calculated.
But keep it small for fast calculation.
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Intersect ( Boolean )
Intersect (Boolean) performs a boolean operation between the selected and unselected
mesh parts.
This operation happens in Edit mode, and so all parts must be in the same mesh.

Last Operator Intersect (Boolean)
Boolean
Here you can choose the boolean method.

Difference subtracts the source geometry from the target geometry.

Union unions the source geometry with the target geometry. Geometry inside the source
and target geometry gets removed.

Intersect removes all geometry but the overlapping geometry.

Swap
Inverts source and target geometry.
Merge Threshold
Here you can adjust the tolerance for the boolean operation. Increase it when some geometry is not calculated.
But keep it small for fast calculation.

Wire Frame
Wireframe grabs the edges of the faces and turns them into tubes.
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Last Operator Wire Frame
Boundary
Inset Face Boundaries.
Offset Even
Scales the offset to give more even thickness.
Offset Relative
Scales the offset by surrounding geometry.
Replace
Removes the source geometry.
Thickness
Here you can adjust he thickness of the tubes.
Offset
Here you can adjust the offset of the tubes.
Crease
Crease adds close edges so that you have sharp corners when you use Subdivision Surface.
Crease Weight
Here you can adjust the crease weight.

Poke Faces
Splits the selected faces to create a triangulated geometry.

Last Operator Poke Faces
Poke Offset
Normally the center vertice of the poke operation is planar with the rest. Here you can
adjust an offset.
Offset Relative
Scale the offset by surrounding geometry.

Poke Center
Poke Center is a drop-down box where you can choose what the center of the poke operation
should be. You can choose between weighted mean, mean and bounds.
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Triangulate Faces
Triangulate Faces triangulates the faces of the selected geometry.

Last Operator Triangulate Faces
Quad Method
Here you can choose how quads should be triangulated.
Shortest diagonal
Splits the quads based on their distance between vertices.
Fixed Alternate
Splits the quads on the second and fourth vertice.
Fixed
Splits the quads on the first and third vertice.
Beauty
Tries to optimize the triangulation.
Polygon Method
Here you can choose how N-Gons should be triangulated.
Clip
Splits the polygons with an ear clipping algorithm.
Beauty
Tries to optimize the triangulation.

Tris to Quads
Tris to quads tries to convert triangulated geometry back to a quad geometry by
removing the edges inside of the quads.

Last Operator Tris to Quads
Max Face Angle
Here you can adjust the threshold to adjacent triangles.
Max Shape Angle
Here you can adjust the shape angle limit.
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Compare UV's
Takes the UV patches for the calculation into account. Border geometry will not be calculated.
Compare VCols
Takes the Vertex colors for the calculation into account. Border geometry will not be calculated.
Compare Seam
Takes the Vertex colors for the calculation into account. Border geometry will not be calculated.
Compare Sharp
Takes the as sharp marked edges for the calculation into account. Border geometry will not be calculated.
Compare Materials
Takes the Materials colors for the calculation into account. Border geometry will not be calculated.

Split by Edges
This tool incorporates loose wire edges into selected faces.
You need a loose edge geometry to get it to work. By converting a curve to a
Mesh geometry for example. You need to join the edge into the mesh where you
want to use it. The operation happens in Edit mode.
In edit mode select the edge and the face where you want it to join. And then
perform the tool.

Rotate UV's
Rotates the UV space for the selected geometry by 90 degrees. This tool
requires to have a working UV mapping.

Last Operator Rotate UV's
The tool rotates clockwise by default. With this option ticked the rotation happens counter
clockwise.

Reverse UV's
Reverses the UV Space for the selected geometry. This tool requires to have a working UV mapping.
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Rotate Colors
Rotates the vertex colors for the selected geometry. This tool requires to have
vertex colors painted at the mesh.
Note that there is no way to display vertex colors in Edit mode. So you need to
switch to Vertex paint mode to see the result.

Last Operator Rotate Colors
Counter Clockwise
The tool rotates clockwise by default. With this option ticked the rotation happens counter clockwise.

Reverse Colors
Reverses the vertex colors.
Note that there is no way to display vertex colors in Edit mode. So you need to
switch to Vertex paint mode to see the result.

Mark Freestyle Face
Mark selected Faces for exclusion from Freestyle Feature edge detection. Freestyle is a cartoon renderer that is
also included in Bforartists.

Clear Freestyle Face
Unmark selected Faces for exclusion from Freestyle Feature edge detection. Freestyle is a cartoon renderer that
is also included in Bforartists.

Clean Up Panel
Clean Up is a menu that contains various functionality to clean up your
geometry.
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Delete Loose
Delete loose deletes not connected geometry. Vertices, Edges, and
Faces. The tool starts with deleting Vertices and Edges. But you can tick
Faces in the Last Operator too, and then it also removes not connected
Faces.

Last Operator Delete Loose
Vertices
Delete Vertices
Edges
Delete Edges
Faces
Delete Faces

Decimate Geometry
Decimate Geometry decimates the currently selected geometry. It starts with
a Ratio of 1. Which means no decimation. The lower the ratio the more
decimation you will get. The Decimate Modifier works with Tris!

Last Operator Decimate Geometry
Ratio
Here you can adjust the strength of decimation
Vertex Group
Use active Vertex Group as an influence. You need to have a Vertex Group.
Weight
Here you can adjust the Vertex Group Strength.
Invert
Invert Vertex Group Influence
Symmetry
Here you can make the decimation geometry symmetric along a chosen world axis.
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Degenerate Dissolve
Removes zero size Faces and Edges.

Make Planar Faces
Make Planar Faces tries to make the selected faces planar. Quads or NGons for example can have vertices that are not planar.

Last Operator Make Planar Faces
Factor
Here you adjust how strong the influence should be.
Iterations
Here you adjust how often it should repeat in the try to find a solution.

Split Non-Planar Faces
Split Non Planar Faces splits up non planar Quads and N-Gons to end in
planar faces.

Last Operator Split Non-Planar Faces
Max Angle
Here you can limit the action to a maximum angle.

Split Concave Faces
Splits concave faces to make the geometry more stable. This tool is thought for N-Gons.
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Fill Holes
Fill holes closes holes in the mesh geometry.
Fill holes can just calculate one face size at one time. So when you have several holes
in the mesh, let's say one is a tri, and one is a quad, then you need to calculate twice.

Last Operator Fill Holes
Sides
Here you can define what face size will be filled.

Weight Tools panel
The Weight Tools panel contains Weight tools. Those tools are meant to modify
the weight mapping. At characters for example. The Weight Tools requires
Vertex Groups to work with. Such Vertex groups gets created when you do
weight painting at a character for example. Here is defined what bone is
connected to what vertice.

This Panel also exists in Weight Paint mode. Minus the Weight Gradient and Transfer Weight tools.

Normalize All
Normalize all normalizes the weight of all Vertex groups so that the values for the single vertices in the sum is
1.
Last Operator Normalize all
Subset

Subset is a drop-down menu where you can choose the Subset method.
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Lock Active

Keep the values of the active group while normalizing others.

Normalize
Normalize normalizes the weight of the current selected Vertex group so that the values for the single vertices
in the sum is 1. Means when there is influence from other groups, then those values are kept, but the one for the
current group gets lowered so that the sum is 1.

The Last Operator Normalize panel has no adjustable settings.

Mirror
Mirror Vertex Group mirrors Vertex Groups and flips weights and/or names. It only edits selected Vertices. It
flips when both sides are selected. Otherwise it copies from Unselected.
Last Operator Mirror Vertex Group
Mirror Weights

With Mirror Weights ticked it mirrors the weights.
Flip Group Names

With Flip Group Names ticked it flips the Group names
All Groups

Mirrors all Vertex Groups
Topology Mirror

Uses topology based mirroring. This requires matching mirrored topology.

Invert
Invert inverts the weight painting for the selected vertex group.
Last Operator Invert Vertex Group
Subset

Subset is a drop-down menu where you can choose the Subset method.
Add Weights

Add Vertices from Groups that have zero Weighting before inverting.
Remove Weights

Remove Vertices from Groups that have zero weight after inverting.

Clean
Removes Vertex group assignments that are not required from the active vertex group.
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Last Operator Clean Vertex Group
Subset

Subset is a drop-down menu where you can choose the Subset method.
Limit

Remove weights that are below or equal to the limit value.
Keep Single

Keep Vertices assigned to at least one vertex group when cleaning.

Quantize
Quantize quantizes the weight paint values. It starts with 4 steps. With a step of 1 you have
a single vertex color, no matter how you have painted it before.
Last Operator Quantize
Subset

Subset is a drop-down menu where you can choose the Subset method.
Steps

Here you adjust in how many steps the weight paint colors should be divided.

Levels
Adds some offset to the Weight paint, and multiplys it with some gain.
Last Operator Levels
Subset

Subset is a drop-down menu where you can choose the Subset method.
Offset

Here you adjust the offset.
Gain

Here you adjust the gain.

Smooth
Smooths the weight for selected vertices.
Last Operator Smooth Vertex Weights
Subset

Subset is a drop-down menu where you can choose the Subset method.

120

Bforartists Reference Manual - © Copyright - This page is Public Domain

Factor

Here you adjust the factor.
Iterations

Here you adjust how many iterations you use.
Expand/Contract

Expand or contract the weights.
Source

A drop-down box where you can choose what should be affected by Smooth.

Limit Total
Limit number of Weights per vertex. The lowest weights gets removed.

This is of interest when you have for example five bones associated with a vertice. But your
game engine just allows four ...
Last Operator Limit Total
Subset

Subset is a drop-down menu where you can choose the Subset method.
Limit

Here you adjust how many weights are allowed.

Fix Deforms
Modify the position of selected vertices by changing only their respective group weights.

This tool may operate slow at too many vertices.
Last Operator Fix Deforms
Distance

Adjust the distance.
Strength

Adjust the strength.
Change Sensitivity

Adjust the sensitivity.

Tool Shelf in Edit Mode - Mesh Object, Create Tab
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Add Meshes Panel
The create tab in edit mode contains an Add Meshes panel with the object types
that can be added in Edit mode. That way you can add mesh primitives
geometry in edit mode to the current object.
For detailed information and the Last Operator panels for the single buttons see
chapter Tool Shelf in Object Mode - Create Tab .

Tool Shelf in Edit Mode - Mesh Object, Shade/UV's Tab
The Shade / UV's tab contains two panels. Shading and UV's.

Shading Panel
The Shading panel contains shading relevant settings like smooth and flat
shading and recalculate normals.

Faces, Edges and Vertices
Faces, Edges and Vertices can have either smooth or flat shading.
Faces, Edges and Vertices does not have content in the Last operator panel.

Faces
Smooth
Sets the shading for the selected faces to Smooth.
Flat
Sets the shading for the selected faces to Flat.
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Edges
Smooth
Sets the shading for the selected edges to Smooth.
Sharp
Sets the shading for the selected edges to sharp.

Vertices
Smooth
Sets the shading for the selected vertices to Smooth.
Sharp
Sets the shading for the selected vertices to sharp.

Normals
Normals influences the shading and the direction of a face. They can point
inwards or outwards.

Recalc Outside
Recalculates the normals of the selected geometry so that everything points outwards.
Last Operator Recalc Outside
Inside
Inside recalculates the normals of the selected geometry so that everything points inwards.

Recalc Inside
Recalculates the normals of the selected geometry so that everything points inwards.

Flip
Flips the direction of the normals of the selected geometry.

Set from Faces
Sets the vertex normals from the selected faces. This tool requires to have Autosmooth activated!

UVs Panel
The UVs Panel contains the Tools for UV Mapping. A drop-down box for the
different methods. And a button to mark and to clear seam for the two Unwrap
algorithms Angle Based (ABF) and Conformal ( LSCM).
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UV Mapping
Unwrap is a drop-down box that contains all the UV Mapping methods that are
available in Blender. UV Mapping is best done in the UV Editing Layout. So that you
can see what you produce.

Unwrap ABF
Unwrap ABF unwraps the selected geometry with the method Angle based. ABF stands for Angle Based
Flattening. ABF can give a bit better result than LSCM when unwrapping organic shapes.
Unwrap LSCM
Unwrap ABF unwraps the selected geometry with the method Angle based. ABF stands for Angle Based
Flattening. LSCM can give a bit better results than ABF with geometric shapes.
Last Operator Unwrap
Unwrap ABF and Unwrap LSCM shares the same Last Operator.
Method

Method is a drop down box where you can choose between Unwrap method Angle Based
and Conformal.
Fill Holes

Fill holes in the mesh before unwrapping.
Correct Aspect

Take the Image Aspect Ratio into account.
Use Subsurf Modifier

Unwraps an existing Subsurf Modifier. You need to add a Subsurf Modifier first.
Margin

The distance between the single UV patches.

Smart UV Project
Smart UV Project projects the UV mapping from different angles.
Smart UV Project Settings dialogue
Angle Limit

The Angle Limit defines after which angle the mapping happens from the
next side. With an angle of 66 you have around six sides to map from. The calculation is 360/66.
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Island Margin

Island Margin defines the distance between the UV patches.
Area Weight

Weight Projection Vector by faces with larger areas.
Correct Aspect

Take the Image Aspect Ratio into account.
Last Operator Smart UV Project
The Last Operator for Smart UV Project contains the same settings than the Smart UV
Project Settings dialogue.
Angle Limit

The Angle Limit defines after which angle the mapping happens from the next side. With
an angle of 66 you have around six sides to map from. The calculation is 360/66.
Island Margin

Island Margin defines the distance between the UV patches.
Area Weight

Weight Projection Vector by faces with larger areas.
Correct Aspect

Take the Image Aspect Ratio into account.

Lightmap Pack
Lightmap Pack maps each face individually, and puts the result into the UV
space. Without margin.

Lightmap Pack has no Last Operator.
Settings
Selection

Selection is a drop-down box where you can choose what will be packed.
Share Tex Space

Map all objects into one lightmap.
New UV Map

Create a new UV map for every new mesh.
New Image

Assign new Image to every new mesh.
Image Size

The size for new images.
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Pack Quality

The pack quality.
Margin

The distance between the single UV patches.

Follow Active Quads
Follow Active quads maps UV coordinates starting from an active face, and maps all adjacent faces in quad
shape then. This way you can for example unwrap a pipe or a road. You first need to have a face selected. Then
select everything. And then click at Follow Active Quads.
Settings
Edge Length Mode

Edge Length Mode is a drop-down box where you can choose the Length
method.
Last Operator Follow Active Quads
The Last Operator contains the same settings than the Settings dialogue.
Edge Length Mode

Edge Length Mode is a drop-down box where you can choose the Length method.

Cube Projection
Cube Projection maps the mesh from six sides, means cubic.
Last Operator Cube Projection
Cube Size

Cube Size defines the size of the UV mesh in the UV space.
Correct Aspect

Take Image Aspect ratio into account.
Clip to Bounds

Clip UV Coordinates to bounds after unwrapping.
Scale to Bounds

Scale UV Coordinates to bounds after unwrapping.

Cylinder Projection
Cylinder Projection tries to map cylindric.
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Last Operator Cylinder Projection
Direction

Direction is a drop-down box where you can choose in which direction the cylindric
projection will be mapped.
Align

Align is a drop-down box where you can choose the Align method.
Radius

Radius defines the Polar size of the UV mesh in the UV space.
Correct Aspect

Take Image Aspect ratio into account.
Clip to Bounds

Clip UV Coordinates to bounds after unwrapping.
Scale to Bounds

Scale UV Coordinates to bounds after unwrapping.

Sphere Projection
Sphere Projection tries to map spherical.
Last Operator Sphere Projection
Direction

Direction is a drop-down box where you can choose in which direction the spherical
projection will be mapped.
Align

Align is a drop-down box where you can choose the Align method.
Correct Aspect

Take Image Aspect ratio into account.
Clip to Bounds

Clip UV Coordinates to bounds after unwrapping.
Scale to Bounds

Scale UV Coordinates to bounds after unwrapping.

Project from View
Project from View projects the UV from the current 3D view.
Last Operator Project from View
Orthographic

User orthographic projection
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Camera Bounds

Map UV's to the camera region taking resolution and aspect into account.
Correct Aspect

Take Image Aspect ratio into account.
Clip to Bounds

Clip UV Coordinates to bounds after unwrapping.
Scale to Bounds

Scale UV Coordinates to bounds after unwrapping.

Project from View (Bounds)
Project from View projects the UV from the current 3D view.

Same as Project from View, but with Scale to Bounds ticked in the Last operator.

Reset
Resets the UV Projection

Reset has no Last Operator.

Mark Seam
The unwrap algorithms Angle based and Conformal requires to have edges
marked as seams. Think of it as a cutting pattern for a trouser for example.
Such a trouser is also made of fabric patterns.
Same goes for the UV patches when you use Angle based or conformal
unwrapping. You need to cut your mesh into parts and mark edges as
seams, so that the algorithm knows where the seams are.
Mark seam marks the currently selected edge(s) as a seam. Seam edges
will be displayed as red in the 3D viewport.
You need to unwrap the mesh again when you want to apply changes.

Last Operator Mark Seam
Clear
Clears the seam instead of marking it.
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Clear Seam
Clear seam removes the seam from the currently selected edge(s)

Tool Shelf in Edit Mode - Mesh Object, Options Tab
The Options tab provides you with some Mesh Object options.

Mesh Options Panel
X Mirror
X Axis Mirror Editing.

Topology Mirror
Use Topology based mirroring.

Edge Select Mode
Edge Select Mode is a drop-down box where you can choose the select method for edges.

Live Unwrap
Changing edges seam recalculates UV Unwrap.

Double Threshold
Limit for removing duplicates and 'Auto Merge'.

Tool Shelf in Edit Mode - Curve Object, Relations Tab
Relations Panel
The Relation panel contains tools around relations. In Edit Mode it's just
Make Vertex Parent.
In Object mode select the object that you want to parent to a vertex. Shift
select the parent object so that both are selected. Enter Edit mode. Then select one vertex for a single point. Or
three for an area. Then click the Make Vertex Parent button to make the relation.

Tool Shelf in Edit Mode - Curve Object, Tools Tab
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Curve Tools Panel
The Curve Tools panel contains the tools to modify the curve
object in Edit Mode .

Tilt
Modifies the Mean Tilt.
Activate the tool, and drag the mouse.
You will see a value in the header now.
The selected curve path will rotate by
dragging the mouse.
The Tilt angle always starts at zero. It is
relative. To modify the Mean Tilt use the edit box in the Transform panel.
Last Operator Tilt
Angle
The Tilt angle.
Proportional Editing
Proportional Editing is a drop-down box where you can choose to use proportional editing.
When you choose one of the active methods then the neighbour geometry gets influenced
by Shrink/Fatten too in a proportional way.
Proportional Editing Falloff
Proportional Editing Falloff is a drop-down box where you can choose a method for the
falloff for the proportional editing.
Proportional Size
The proportional size in case you have Proportional editing activated.
Confirm on Release
Always confirm operation when releasing button.
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Shrink/ Fatten
Modifies the Mean Radius.
Activate the tool, and drag the mouse. You will see a
value in the header now. The selected curve radius will
increase / decrease.
The Radius angle always starts at zero. It is relative.
To modify the Mean Radius use the edit box in the
Transform panel.
Last Operator Transform
Values
Transform values for Shrink Fatten.
Constraint Axis
Here you can constraint the operation to specific axis.
Proportional Editing
Proportional Editing is a drop-down box where you can choose to use proportional editing.
When you choose one of the active methods then the neighbour geometry gets influenced
by Shrink/Fatten too in a proportional way.

Proportional Editing Falloff
Proportional Editing Falloff is a drop-down box where you can choose a method for the
falloff for the proportional editing.
Proportional Size
The proportional size in case you have Proportional editing activated.
Edit Grease Pencil
Edit selected Grease Pencil strokes.
Confirm on Release
Always confirm operation when releasing button.

Mirror
Mirror mirrors the selected geometry along the defined axis. Click
the Mirror button, type in X, Y or Z, then confirm with enter.
Last Operator Mirror
The Last Operator Mirror panel gives you tools to adjust the mirror action.
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Constraint Axis
Constraint Axis gives you again the possibility to define the mirror axis. You can choose more than one axis
here.
Orientation
Orientation is a drop-down box where you can choose the type of orientation for the mirroring action.
Proportional Editing
Proportional Editing is a drop-down box where you can choose to use proportional editing.
When you choose one of the active methods then the neighbour geometry gets influenced by
Shrink/Fatten too in a proportional way.
Proportional Editing Falloff
Proportional Editing Falloff is a drop-down box where you can choose a method for the
falloff for the proportional editing.
Proportional size
Proportional size is a edit box where you can adjust the strength of the Proportional
falloff.
Edit Grease Pencil
Edit Grease Pencil edits the selected Grease Pencil strokes.
Confirm on Release
With Confirm on Release checked the action gets performed when you release the mouse
button.

Curve
The Curve Tools contains the tools to modify the curves.

Toggle Cyclic
Toggle Cyclic closes or opens the curve.
Last Operator Toggle Cyclic
Direction
Direction is a drop-down box where you can choose the direction in which the curve gets closed.

Switch Direction
Switch Direction inverts the direction of the selected curve.
Switch Direction has no settings in the Last Operator panel.
132

Bforartists Reference Manual - © Copyright - This page is Public Domain

Set Spline Type
With set Spline Type you can set the type of the curve.
Last Operator Set Spline Type
Type
Type is a drop-down box where you can choose the spline type
Handles
Use Handles when converting Bezier curves into polygons.

Set Curve Radius
Set the Point radius which is used for bevel tapering
Last Operator Set Radius
Radius
Set the Point radius which is used for bevel tapering

Handles
Handles defines the type of handle for the knots of the curve. You have the
choice between Auto, Vector, Align and Free. And the Last Operator gives you
a fifth possibility to toggle between Free and Align.

Auto
Auto aligns the handles automatically.

Vector
Set Handle type to Vector.

Align
Set Handle type to Align.

Free
Set Handle type to Free.
Last Operator Set Handle Type
Type
Type is a drop-down box where you can set the handle type. You have the choice between
Auto, Vector, Align, Free. And the fifth possibility toggles between Free and Align.
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Recalc Normals
Recalculates the normals of the selected curve.
Last Operator Recalc Normals
Length
Recalculates the handle length too.

Modelling
The Modelling Section contains some modelling tools to modify the curve
object.

Extrude
Extrudes the selected curve point(s).
Last operator Extrude Curve and Move
Extrude
Confusing label. Just ignore
Mode
A drop-down box where you can choose between different extrude modes.
Translate
Confusing label. Just ignore
Vector
The position of the extruded point(s)
Constraint Axis
Here you can limit the extrusion to specific axes.
Orientation
Here you can adjust the orientation of the extrusion. It usually starts with Normal.
Proportional Editing
Proportional Editing is a drop-down box where you can choose to use proportional editing. When you choose
one of the active methods then the neighbour geometry gets influenced by Shrink/Fatten too in a proportional
way. Proportional Editing Falloff
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Proportional Editing Falloff
Proportional Editing Falloff is a drop-down box where you can choose a method for the falloff for the
proportional editing.
Proportional size

Proportional size is a edit box where you can adjust the strength of the Proportional falloff.
Edit Grease Pencil

Edit Grease pencil ticked allows you to edit the grease pencil stroke.
Edit Texture Space

By default extrusion will not modify the UV mapping. With Edit texture Space ticked
the UV mapping updates with the extrusion.
Confirm on Release

With Confirm on Release checked the action gets performed when you release the mouse
button.

Subdivide
Subdivide subdivides the selected curve part. You need to have at least two curve points selected.
Subdivide has no Last Operator panel.

Smooth
Smooth smooths the selected curve part. You need to have at least two curve points selected.
Smooth has no Last Operator panel.

Split
Splits the curve at the selected control point(s). You need to select two control points to select the segment
between it.

Separate
Separates the selected control points, and creates a new curve object out of it. You need to select two control
points to select the segment between it.
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Make Segment
Joins two curves by adding a segment between the end of the one and the beginning of the other. You can also
create a closed curve that way.

Add Vertex
Add Vertex adds a control point under the mouse, extruding from the
selected endpoint(s). In case that you don't have an endpoint of your
curve selected you will create a not connected control point.
The tool provides similar functionality to the extrude tool. But here
you define the end point with the mouse position already.

Note!
Add Vertex is a hotkey only tool. Since it requires to have the mouse at the right position in the viewport.

Last Operator Add Vertex
Location
Here you can change the position of the new created control point.

Smooth Curve Tilt
Smooths the curve tilt of the selected control point(s).

Smooth Curve Radius
Smooths the curve radius of the selected control point(s).

Smooth Curve Weight
Interpolates the weight of the selected control point(s).

Set Goal Weight
This tool requires to have a Soft Body physics applied to the curve. With this
tool you can adjust the goal weight of the selected control points. A setting of
zero allows to pin this control point vertice(s).
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When you activate the tool then you will see a dialogue where you can adjust the weight.
Last Operator Set Goal Weight
Weight
Here you can again adjust the weight strength.

Tool Shelf in Edit Mode - Curve Object, Create Tab
Add Curves Panel
The create tab in edit mode contains an Add Curves panel with the object
types that can be added in Edit mode. That way you can add other curves edit
mode to the current curve.
For detailed information and the Last Operator panels for the single buttons
see chapter Tool Shelf in Object Mode - Create Tab

Tool Shelf in Edit Mode - Curve Object, Options Tab
Curve Stroke Panel
The Curve Stroke Panel provides you with some options to draw and modify the curves. It is divided into two
parts. The curve type Bezier. And the curve type Poly.

Curve Stroke Panel type Bezier
Type
Here you switch between the curve type Bezier and Poly.

Bezier Options
Tolerance
Allow deviation for a smoother but less precise line

Method
The curve fitting method. Here you can choose between Refit and Split.

Detect Corners
Detect corners and use non aligned angles.

Corner Angle
Corners above this angle are considered as corners.
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Pressure Radius
Pressure radius is interesting when you use a tablet. Here you can adjust the Minimum and Maximum pressure
radius. When you don't use a tablet then the maximum pressure value will be used.

Taper Radius
Taper factor for the radius of each point along the curve.

Projection depth
Here you can set the method of projection depth.

Cursor
Sets the projection depth to 3D Cursor.

Surface
Sets the projection depth to Surface. Then the curve paints at a surface that is placed under
the stroke. It also reveals some more settings for Projection Depth method Surface
Offset
Offset the stroke from the surface
Absolute Offset
Apply a fixed offset
Only First
Use the start of the stroke for depth.

Curve Stroke Panel type Poly
Type
Here you switch between the curve type Bezier and Poly.

Pressure Radius
Pressure radius is interesting when you use a tablet. Here you can adjust the Minimum and
Maximum pressure radius. When you don't use a tablet then the maximum pressure value
will be used.

Taper Radius
Taper factor for the radius of each point along the curve.

Projection depth
Here you can set the method of projection depth.
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Cursor
Sets the projection depth to 3D Cursor.

Surface
Sets the projection depth to Surface. Then the curve paints at a surface that is placed under
the stroke. It also reveals some more settings for Projection Depth method Surface
Offset
Offset the stroke from the surface
Absolute Offset
Apply a fixed offset
Only First
Use the start of the stroke for depth.

Tool Shelf in Edit Mode - Surface Object, Tools Tab
Surface Tools Panel
The Surface Tools panel contains the tools to modify the Surface
object in Edit Mode.

Mirror
Mirror mirrors the selected geometry along the defined axis. Click the
Mirror button, type in X, Y or Z, then confirm with enter.
Last Operator Mirror
The Last Operator Mirror panel gives you tools to adjust the mirror action.
Constraint Axis
Constraint Axis gives you again the possibility to define the mirror axis. You can choose
more than one axis here.
Orientation
Orientation is a drop-down box where you can choose the type of orientation for the
mirroring action.

139

Bforartists Reference Manual - © Copyright - This page is Public Domain

Proportional Editing
Proportional Editing is a drop-down box where you can choose to use proportional editing.
When you choose one of the active methods then the neighbour geometry gets influenced by
Shrink/Fatten too in a proportional way.
Proportional Editing Falloff
Proportional Editing Falloff is a drop-down box where you can choose a method for the
falloff for the proportional editing.
Proportional size
Proportional size is a edit box where you can adjust the strength of the Proportional falloff.
Edit Grease Pencil
Edit Grease Pencil edits the selected Grease Pencil strokes.
Confirm on Release
With Confirm on Release checked the action gets performed when you release the mouse
button.

Curve
The Curve Tools contains the tools to modify the curves.

Toggle Cyclic
Toggle Cyclic closes or opens the curve.
Last Operator Toggle Cyclic
Direction
Direction is a drop-down box where you can choose the direction in which the curve gets closed.

Switch Direction
Switch Direction inverts the direction of the selected curve.
Switch Direction has no settings in the Last Operator panel.

Modelling
The Modelling Section contains some modelling tools to
influence the curve object.
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Extrude
Extrudes the selected curve point(s).
Last operator Extrude Curve and Move
Extrude
Confusing label. Just ignore
Mode
A drop-down box where you can choose between different extrude modes.
Translate
Confusing label. Just ignore
Vector
The position of the extruded point(s)
Constraint Axis
Here you can limit the extrusion to specific axes.
Orientation
Here you can adjust the orientation of the extrusion. It usually starts with Normal.
Proportional Editing
Proportional Editing is a drop-down box where you can choose to use proportional
editing. When you choose one of the active methods then the neighbour geometry gets
influenced by Shrink/Fatten too in a proportional way.
Proportional Editing Falloff

Proportional Editing Falloff is a drop-down box where you can choose a method for the
falloff for the proportional editing.
Proportional size

Proportional size is a edit box where you can adjust the strength of the Proportional falloff.
Edit Grease Pencil

Edit Grease pencil ticked allows you to edit the grease pencil stroke.
Edit Texture Space

By default extrusion will not modify the UV mapping. With Edit texture Space ticked
the UV mapping updates with the extrusion.
Confirm on Release

With Confirm on Release checked the action gets performed when you release the mouse button.
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Spin
Extrudes the selected curve part around the pivot point. You need to have at least two curve
points selected.
Last Operator Spin
Centre
Edit boxes to set the position of the Centre point
Axis
The rotation of the extrusion

Subdivide
Subdivide subdivides the selected curve part. You need to have at least two curve points selected.
Subdivide has no Last Operator panel.

Split
Splits the curve at the selected control point(s). You need to select two control points to select the segment
between it.

Separate
Separates the selected control points, and creates a new curve object out of it. You need to select two control
points to select the segment between it.

Make Segment
Joins two curves by adding a segment between the end of the one and the beginning of the other. You can also
create a closed curve that way.

Add Vertex
Add Vertex adds a control point under the mouse, extruding from the
selected endpoint(s). In case that you don't have an endpoint of your
curve selected you will create a not connected control point.
The tool provides similar functionality to the extrude tool. But here
you define the end point with the mouse position already.
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Note!
Add Vertex is a hotkey only tool. Since it requires to have the mouse at the right position in the viewport.

Last Operator Add Vertex
Location
Here you can change the position of the new created control point.

Smooth Curve Tilt
Smooths the curve tilt of the selected control point(s).

Smooth Curve Radius
Smooths the curve radius of the selected control point(s).

Smooth Curve Weight
Interpolates the weight of the selected control point(s).

Set Goal Weight
This tool requires to have a Soft Body physics applied to the curve. With this
tool you can adjust the goal weight of the selected control points. A setting of
zero allows to pin this control point vertice(s).
When you activate the tool then you will see a dialogue where you can adjust the weight.
Last Operator Set Goal Weight
Weight
Here you can again adjust the weight strength.

Tool Shelf in Edit Mode - Surface Object, Create Tab
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Add Surfaces Panel
The create tab in edit mode contains an Add Surfaces panel with the object
types that can be added in Edit mode. That way you can add other Surfaces
edit mode to the current Surface object.
For detailed information and the Last Operator panels for the single buttons
see chapter Tool Shelf in Object Mode - Create Tab

Tool Shelf in Edit Mode - Surface Object, Relations Tab
Relations Panel
The Relation panel contains tools around relations. In Edit Mode it's just
Make Vertex Parent.
In Object mode select the object that you want to parent to a vertex. Shift
select the parent object so that both are selected. Enter Edit mode. Then select one vertex for a single point. Or
three for an area. Then click the Make Vertex Parent button to make the relation.

Tool Shelf in Edit Mode - Metaball Object, Tools Tab
Meta Tools Panel
The Meta Tools panel contains the tools to modify the Metaball object in Edit Mode.

Mirror
Mirror mirrors the selected geometry along the defined axis. Click the
Mirror button, type in X, Y or Z, then confirm with enter.
Last Operator Mirror
The Last Operator Mirror panel gives you tools to adjust the mirror action.
Constraint Axis
Constraint Axis gives you again the possibility to define the mirror axis. You can choose
more than one axis here.
Orientation
Orientation is a drop-down box where you can choose the type of orientation for the
mirroring action.

144

Bforartists Reference Manual - © Copyright - This page is Public Domain

Proportional Editing
Proportional Editing is a drop-down box where you can choose to use proportional editing.
When you choose one of the active methods then the neighbour geometry gets influenced by
Shrink/Fatten too in a proportional way.
Proportional Editing Falloff
Proportional Editing Falloff is a drop-down box where you can choose a method for the
falloff for the proportional editing.
Proportional size
Proportional size is a edit box where you can adjust the strength of the Proportional
falloff.
Edit Grease Pencil
Edit Grease Pencil edits the selected Grease Pencil strokes.
Confirm on Release
With Confirm on Release checked the action gets performed when you release the mouse
button.

Tool Shelf in Edit Mode - Metaball Object, Create Tab
Add Metaball Panel
The create tab in edit mode contains an Add Metaball panel with the object
types that can be added in Edit mode. That way you can add other Metaballs in
edit mode to the current Metaball object.
For detailed information and the Last Operator panels for the single buttons see chapter Tool Shelf in Object
Mode - Create Tab

Tool Shelf in Edit Mode - Metaball Object, Relations Tab
Relations Panel
The Relation panel contains tools around relations. In Edit Mode it's just
Make Vertex Parent.
In Object mode select the object that you want to parent to a vertex. Shift
select the parent object so that both are selected. Enter Edit mode. Then select one vertex for a single point. Or
three for an area. Then click the Make Vertex Parent button to make the relation.
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Tool Shelf in Edit Mode - Text Object, Tools Tab
Text Tools Panel
The Text tools panel contains the tools to adjust the created text object.
Select the text part that you want to modify, then click at the tools.

Set Case
Set case sets selected the letters to be uppercase or lower case.
Last Operator Set Case
Set Case has one Last Operator for all items.
Case
Case is a drop-down box where you can choose to set the selected letters to be uppercase or lower case.

To Upper
To Upper sets the selected text to be uppercase letters.

To Lower
To Lower sets the selected text to be lowercase letters.

Style
Style sets the selected letters to some styles.
Last Operator Toggle Style
Style has one Last Operator for all items.

Style is a drop-down box where you can choose to set the selected letters to be displayed in
some styles.

Bold
Bold sets the selected letters to be displayed as bold letters.

Italic
Italic sets the selected letters to be displayed as italic letters.

Underline
Underline sets the selected letters to be displayed as underlined letters.

Toggle Small Caps
Toggle small caps sets the selected letters to be displayed as if they were upper case letters, but with lower case
size.
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Tool Shelf in Edit Mode - Text Object, Relations Tab
Relations Panel
The Relation panel contains tools around relations. In Edit Mode it's just
Make Vertex Parent.
In Object mode select the object that you want to parent to a vertex. Shift
select the parent object so that both are selected. Enter Edit mode. Then select one vertex for a single point. Or
three for an area. Then click the Make Vertex Parent button to make the relation.

Tool Shelf in Edit Mode - Armature Object, Tools Tab
Armature Tools Panel
The Armature Tools panel contains the tools to modify the selected armature in
Edit mode.

Mirror
Mirror mirrors the selected geometry along the defined axis. Click the
Mirror button, type in X, Y or Z, then confirm with enter.
Last Operator Mirror
The Last Operator Mirror panel gives you tools to adjust the mirror action.
Constraint Axis
Constraint Axis gives you again the possibility to define the mirror axis. You can choose
more than one axis here.
Orientation
Orientation is a drop-down box where you can choose the type of orientation for the
mirroring action.
Proportional Editing
Proportional Editing is a drop-down box where you can choose to use proportional editing.
When you choose one of the active methods then the neighbour geometry gets influenced by
Shrink/Fatten too in a proportional way.
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Proportional Editing Falloff
Proportional Editing Falloff is a drop-down box where you can choose a method for the falloff for the
proportional editing.
Proportional size
Proportional size is a edit box where you can adjust the strength of the Proportional falloff.
Edit Grease Pencil
Edit Grease Pencil edits the selected Grease Pencil strokes.
Confirm on Release
With Confirm on Release checked the action gets performed when you release the mouse
button.

Symmetrize
Creates a symmetrical mirrored copy of the currently selected
bones along the X axis. The mirror center is the pivot of the
armature.
Symmetrize follows the name conventions for bones. If there is
a lower or upper case “L”, “R”, “left” or “right” with a
separating dot in the bone name, then this tool renames the bones names to its counter part. Bone.L becomes
Bone.R.

Last Operator Symmetrize
Direction
Here you can define the calculation direction. From -X to + X or from +X to -X

Bones section
The Bones section contains tools around the bones of the armature.

Add
Adds a new bone to the armature. This new created bone is not connected to other bones of the armature.
Last Operator Add Bone
Name
Name is an edit field where you can rename the created bone
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Merge Bones
Merges two connected bones in a chain into one bone.
When you click the Merge Bones button then you will get a pop-up where you can choose
between exactly nothing since there is one choice. Within chains.

Last Operator Merge Bones
Type
Type is a drop-down box where you can choose between exactly nothing since there is one
choice. Within chains.

Fill between Joints
Fill between joints fills a bone between two selected joints.
When there is just one joint selected, then the bone is created between this
selected joint and the 3D cursor.
The Last operator for Fill Between Joints has no content.

Split
Split splits the selected bone(s) from connected bones. They are still part of the armature. But the bone is now
floating. And you can pull this bone(s) around without pulling the rest of the armature around.
The Last operator for Split has no content.
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Separate
Separate separates the selected bone(s) from the armature. And creates a new, independent, armature.
The Last operator for Separate has no content.

Switch Direction
Switches the direction in which the bone points at. The head becomes the tail, and the tail
becomes the head.
The Last operator for Switch Direction has no content.

Tool Shelf in Edit Mode - Armature Object, Relations Tab
Relations Panel
The Relation panel contains tools around relations inside the currently edited
armature.

Make Vertex Parent
In Object mode select the object that you want to parent to a vertex. Shift select the parent object so that both
are selected. Enter Edit mode. Then select one vertex for a single point. Or three for an area. Then click the
Make Vertex Parent button to make the relation.

Make
Make calls a sub menu. When you have one bone selected then you get just the Connected menu
part. But this doesn't make much sense since then there is nothing to parent.
Make requires to have at least two bones
selected that are not parented to each other
already. Select first bone, hold down shift,
select second bone. The first selected bone
will be the child, the second selected bone
the parent.
Connected
Connected connects the Head joint of the one bone with the Tail joint of
the other. The child bone will be placed at the position of the head joint of
the parent bone. And the joints will be merged.
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Keep Offset
Keep Offset connects the Head joint of the one bone with the Tail joint of the other.
The target bone will remain in its position. The joints are not merged. The
relationship is indicated by the black dotted line. The child bone will move with the
parent bone.
Last Operator Make Parent
Parent Type
Parent Type is a drop-down box where you can again choose to use the method
Connected or the method Keep Offset.

Tool Shelf in Edit Mode - Armature Object, Options Tab
Armature Options Panel
The Armature Options panel contains some options.

X Axis Mirror
X Axis Mirror is made to sync the right side of a symmetrical armature with the left side of a symmetrical
armature. Means you can create just one half of a skeleton. And then simply mirror it over
to the other half. And any further changes that you do at the one side will also apply to the
other side of the armature. This includes the whole FK IK setup. And can save you lots of
work therefore.
To get X Axis mirror to work requires a bit preparation work.
Create a armature, with some bones at the one side. Like
this. The 3D cursor needs to be at 0/0/0. The left bone is in
the middle. Think of it as the backbone. The right bone has
an offset, and shall represent our right side of the armature.
Change the Pivot Point in the Header to 3D Cursor.
Important step. We want to mirror around the 3D Cursor.
Now select the right side of the armature. Border select is one fast way. But NOT
the bone in the middle, which is our backbone. We don't want to mirror this one
too.
Duplicate what we have selected. And click immediately to leave the duplicate
mode. Or you will pull the duplicated part around. Which is not what we want.
Next we will scale our new created armature part by -1 to mirror it over to the other side. Activate Scale, don't
move the mouse, but type immediately in X for the axis and -1 for the scale factor.
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This will create our mirrored armature part.

Next important step is to Flip Names. This renames the mirrored bones.
Bone.001.R becomes without this step Bone.001.R.001. With rename we get
Bone.001.L

And now we are finally arrived at X Axis Mirror. Tick it.
Now you should be able to modify the one side of the armature, and the other side will be
modified too. This includes as told above also FK IK set-ups that you do in Pose mode.
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Tool Shelf in Edit Mode - Lattice Object, Tools Tab
Lattice Tools Panel
Lattice is a deform cage. You can use it to deform other objects.

Mirror
Mirror mirrors the selected geometry along the defined axis. Click the
Mirror button, type in X, Y or Z, then confirm with enter.
Last Operator Mirror
The Last Operator Mirror panel gives you tools to adjust the mirror action.
Constraint Axis
Constraint Axis gives you again the possibility to define the mirror axis. You can choose
more than one axis here.
Orientation
Orientation is a drop-down box where you can choose the type of orientation for the
mirroring action.
Proportional Editing
Proportional Editing is a drop-down box where you can choose to use proportional editing.
When you choose one of the active methods then the neighbour geometry gets influenced
by Shrink/Fatten too in a proportional way.
Proportional Editing Falloff
Proportional Editing Falloff is a drop-down box where you can choose a method for the
falloff for the proportional editing.
Proportional size
Proportional size is a edit box where you can adjust the strength of the Proportional falloff.
Edit Grease Pencil
Edit Grease Pencil edits the selected Grease Pencil strokes.
Confirm on Release
With Confirm on Release checked the action gets performed when you release the mouse
button.
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Mirror Vertex Group
This tool requires to have a vertex group assigned. It mirrors the selected vertex group.
This tool works only with a perfectly symmetrical mesh along the local X axis. Vertices that have no
corresponding vertex on the other side will not be affected.

Last Operator Mirror Vertex Group
Mirror Weights
Mirrors the Weight Painting informations from the symmetrical counterpart. When both are
selected it will become a group and weight information exchange. If only one is selected,
then the information from the unselected vertice will go to the selected vertice.
Flip Group Names
Flip selected group names. This works with vertex groups with symmetrical name conventions. Like .L , .R,
right, left.
All Groups
Pass information to all groups instead of the active one.
Topology Mirror
Use topology based mirroring.

Make Regular
Make regular sets the shape of the Lattice cage back to a regular cube.
The Last operator Make Regular has no settings.

Tool Shelf in Edit Mode - Force Field, Curve Guide Force
Normally the Force Fields does not have any edit mode. With
one exception. The force Curve Guide. It is not only a force
object, but also a curve object. And so you need a way to
modify the curve.
When you enter the edit mode with the force object "Curve
Guide", then you will find yourself in the same panels in the
tool shelf like if you would edit a normal curve object. And in
fact that's what you do here.
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Please have a look at the Curve Object chapters to find out more about the functionality.

Tool Shelf in Pose Mode
The Pose Mode is a mode especially for armatures. Other object types have no Pose mode. In Pose mode you
can pose and animate your armature. This is best done in the Animation layout.

Tool Shelf in Pose Mode - Armature Object, Tools Tab
Pose Tools Panel
The Pose Tools Panel contains the tools that are needed to pose the armature.

In Between
In Between are tools to influence the look of the
pose between the keyframes.
For example, record a keyframe at frame 1, then
record a keyframe at frame 20. Then go to frame
10, and activate one of the tools. Now you can play around with the settings.
And when you are satisfied with the result then you can record a keyframe at
this position.

Push
Push exxagerrates the current pose. When you activate it then you will see a percentage
value in the header.
Last Operator Push Pose
Previous Keyframe
The keyframe position before the current frame.
Next Keyframe
The keyframe position after the current frame.
Percentage
The percentage of exxageration. Interestingly the value in the Last operator differs from the value in the header.

Relax
Relax relaxes the current pose. When you activate it then you will see
a percentage value in the header. And some hotkeys. The hotkeys W
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E and R allows you just to move, rotate or scale. Hotkey B stands for Bendy Bones. And C is for a custom
property. This hotkeys are hard coded, and cannot be changed in the input manager.
Last Operator Relax Pose
Previous Keyframe
The keyframe position before the current frame.
Next Keyframe
The keyframe position after the current frame.
Percentage
The percentage of exxageration. Interestingly the value in the Last operator differs from the
value in the header.
Channels
Here you can again choose if you just want to limit a specific channel.
Axis Lock
Allows you to lock a specific axis.

Breakdowner
Creates a suitable breakdowner pose on the current frame. When you activate it then you
will see a percentage value in the header.
Last Operator Pose Breakdowner
Previous Keyframe
The keyframe position before the current frame.
Next Keyframe
The keyframe position after the current frame.
Percentage
The percentage of exxageration. Interestingly the value in the Last operator differs from the value in the header.

Pose
The Pose section contains the Propagate tool. The Propagate tool
automates the process of copying and pasting between keyframes. It
copies the pose of the selected bones on the current frame over to the keyframes by the chosen Termination
mode in the Last Operator Propagate Pose.
The different Propagate methods can be adjustetd in the Last operator.

Usage example with Termination mode "On Selected Keyframes".
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Create a little armature.
Set a keyframe at frame 0.
Set a keyframe at frame 20.
Pose frame 20.
Set a keyframe at frame 40. It will most probably be identical with Frame 20.
Now select those Keyframes at position 40 in the Dope Sheet Editor.
Set position to Frame 0.
Press Propagate, and in the Last operator Propagate Pose choose On Selected Keyframes.
The selected keyframes at frame 40 will now turn into the corresponding keyframes from position 0.

Last Operator Propagate Pose
Terminate Mode
A dropdown box where you can choose between different termination modes for Propagate.
While Held

While held it tries to guess when to stop propagating by examining the pauses in the
animation curves per control (This means all F-Curves for a bone instead of per F-Curve).
To Next Keyframe

Copies the pose to the first keyframe after the current frame.
To Last Keyframe

Replaces the last keyframe.
Before Frame

Copies to all keyframes between current frame and the End frame option.
Before Last Keyframe

To all keyframes from current frame until no more are found.
On Selected Keyframes

Applies the pose of the selected bones to all selected keyframes.
On Selected Markers

Copies to all keyframes on frames with Scene Markers after the current frame.
End Frame
Defines the end frame for the Propagate.

Keyframes
Contains some keyframing tools.
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Insert
Inserts keyframes for the specified keying set. Insert has no settings in the Last Operator.

Remove
Removes the keyframes at the current frame. Remove has no settings in the
Last Operator.

Bake Action
Calls a popup where you can adjust the bake settings to bake the action.
Bake Action bakes the current action into a clip for the NLA editor.
Last Operator Bake Action
The Last Operator Bake Action contains the same settings from the Popup.
Start Frame
Defines the start frame.
End Frame
Defines the end frame.
Frame Step
Defines the number of keyframes per step.
Only Selected
Only key selected bones.
Visual Keying
Keyframe from the final transformations.
Clear Constraints
Remove all constraints and do visual keying.
Clear Parents
Bake animation onto teh object, then clear parents. This is for objects only.
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Overwrite current Action
Bake animation into current action.

Bake Data
You can either bake to pose, or bake to object.

Set keying set
Set keying set is a dropdown box where you can choose between the different available
keying sets.

Motion Paths
Calculate Bone Paths
Calculate Bone Paths calculates the paths of the bones. And displays
them visually in the 3D space.

Last Operator Calculate Bone Paths
Start
Defines the start frame
End
Defines the end frame
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Bake Locaton
Here you can adjust if the motion path gets displayed at the tail of the bone(s) or the head of the bone(s).

Clear Bone Path
Clears the calculated Bone paths.
Last Operator Clear Bone Paths
Only Selected
Only clear paths from selected bones.

Tool Shelf in Pose Mode - Armature Object, Relations Tab
Relations Panel
The Relation panel contains tools around relations.

Parent
Set
Set calls a menu where you can choose between different parenting methods.
Object
Sets the parent to selected object.
Object ( Keep Transform)
Sets the parent to selected object, but keeps the transform position / rotation
Armature Deform
Sets the parent to selected Armature.
With empty Groups
Sets the parent to selected Armature, using empty groups.
With Envelope Weights
Sets the parent to selected Armature, using envelope weights
With automatic Weights
Sets the parent to selected Armature, with automatic weights.
Bone
Sets the parent absolute to selected Bone.
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Bone Relative
Sets the parent relative to selected Bone.
Last Operator Make Parent
Type

is a dropdown box where you can choose between different parenting methods.
The working methods are the same than from the Parent popup. The other methods
doesn't belong to Armature.
Keep Transform

Apply transformation before parenting.

Clear
Clears the parenting.

Tool Shelf in Pose Mode - Armature Object, Options Tab
Pose Options Panel
Auto IK
Add temporary IK constraints while grabbing bones in Pose mode.

Tool Shelf in Sculpt Mode
The Tool Shelf in Sculpt Mode provides you the tools to sculpt a mesh. The high poly version of a game
character for example, where you bake the normal map from.
The Sculpt mode is just available for mesh objects. And requires a tesselated mesh to have useful results.

Tool Shelf in Sculpt Mode - Mesh Object, Tools Tab
Brush Panel
The Brush Panel contains the different Sculpt Brushes and some Brush
settings.

Browse Brush
The big image at the top is a dropdown box where you can choose a
brush. Click at it, and you will see the different brushes. A click at one of
the images will choose this brush then.
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Persistent and Set Persistent Base is just available with the brush type Layer.

When you have added a few more brushes then the dropdown box may be more than full. You will see some
little white arrows then. Either in the top left or in the bottom right corner. They indicate that some brushes are
hidden before or after the current display.
To scroll to this hidden content use the mouse wheel, or the arrow up and down buttons at the keyboard.

The edit box below the Image shows you the name of the current active brush.
The number right of it, in this case 2, indicates how much number of users ( internally ) this brush uses. This
means that this data block (the brush) shares currently settings with at least one other object. Most probably the
parent brush where we have created it from. Click at the value to make this brush a single user. The button will
vanish then.
F set the brush to have a fake user. Zero user data-blocks are normally not saved. But sometimes you want to
force the data to be kept even when the data block has no user.
The + button allows you to add a new pencil with the current settings. Note that the brushes are NOT saved
when you close Bforartists. You can save them into the current blend file. Or you can save the startup file. But
be careful here. This saves everything else of the current state of Bforartists too.
The X button deletes the brush as the active one. It does NOT delete it from the brushes list.

Radius
The Radius edit box allows you to adjust the radius of the brush. When the Lock
symbol at the front is ticked, then the pencil keeps its size relative to the object
when zooming in and out. The button behind the edit box enables tablet pressure
sensitivity for radius.
And the button at the end allows you to set the radius of the pencil by hotkey. A click at this button works of
course too. But this is a hotkey tool. The button is just a visible reminder.
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Strength
The Strength edit box allows you to adjust the strength of the brush. When the
Lock symbol at the front is ticked, then the pencil keeps its strength relative to the
object when zooming in and out. The button behind the edit box enables tablet pressure sensitivity for strength.
And the button at the end allows you to set the strength by hotkey. A click at this button works of course too.
But this is a hotkey tool. The button is just a visible reminder.

Autosmooth
The autosmooth edit box allows you to adjust the amout of smoothing that gets automatically
applied to each stroke. The button behind the edit box enables tablet pressure sensitivity for
autosmooth.

Sculpt Plane
The sculpt plane defines how the sculpting is aligned. It is a dropdown box where you can
choose different methods. By default the Area Plane gets used.
When the Lock symbol at the front is ticked, then it keeps using the normal of the surface
where the stroke was initiated.

Front Faces Only
Front Faces only means that the stroke just affects the vertices that are pointing forwards to
the camera.

Add / Subtract
Add means the stroke adds to the geometry. Subtract means the stroke subtracts from the
geometry.

Accumulate, Persistent, etc.
In this area you will find the brush related settings. They differ from brush
to brush.
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Texture Panel
The Texture panel allows you to sculpt with textures. This allows you for example to grab a
foto from some fish scales, and simply sculpt them into the surface of your object by using
this image as a pencil. Or as a blueprint where you calk through ( Stencil method ).
Note that the following shots are made with Symmetry off and without Brush falloff. Since
they disturbed.
Symmetry can be turned off here:

And the brush falloff can be adjusted here. Choose the last method here to have no falloff towards the borders
of the brush.

Browse Texture to be linked
The image at the top of the panel is a image browser. Here you can choose a texture that you
can choose for sculpting then. You can also have more than one image loaded at once.

In this shot there is already a texture added. The way to add the texture here is a bit more complicated. And not
done with clicking at the New button.
First click at the New button below the image. This will create a new texture slot. This
slot is still empty, it displays black.
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We need to load the texture in this slot. This must be done in the Properties editor in the Textures tab. And then
the texture finally shows in the Texture panel in the Tool Shelf.

Texture Edit box
The Texture edit box is the edit box below the Image browser. When
there's no image loaded then it displays the New button. When there's
a image (or more) loaded, then you will see the name of the current
texture.
The F button turns this texture into a data block with a fake user. Means it will exists
even when there is no data connected to it anymore.
When you activate Fake User, then you may get a value in front of it, which displays
how much users this data block (our texture slot) currently has.
The + Button adds another texture slot. Note that you will have to load a texture too, as explained above.
The X button deletes the texture slot.

Brush Mapping
Our texture can be mapped in different methods. The Brush mapping is a dropdown box where you can choose
this different brush mapping methods.
The settings vary. So we will go through them by the different brush mapping methods.
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Brush Mapping with mapping method View Plane and Area Plane
The brush mapping method View
Plane maps the brush onto the surface
of the object, calculating the mapping
from the current view. The result may
be distorted when the view does not
align with the surface of the object.
The brush mapping method Area
Plane maps the brush onto the surface
of the object, calculating the mapping
from the current view. The result is not distorted.

Angle edit box
Here you can adjust the angle of the brush.

Rake
The angle follows the direction of the brush stroke.

Random
The brush angle gets set random.

Random edit box
Becomes visible when you tick Random. Here you can adjust the maximum value of the random angle.

Offset
Fine tune the offset of the texture in the brush.
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Size
Fine tune the size of the texture in the brush.

Sample Bias
Here you can add to or subtract from the amount that gets added by the brush texture.

Brush Mapping with mapping method Tiled
The brush mapping method View Plane maps the brush onto the surface of the object, and
tiles the pencil onto the surface. The mapping happens from the View plane. Means you get
distortions when you sculpt from an angle.

Angle edit box
Here you can adjust the angle of the brush.

Offset
Fine tune the offset of the texture in the brush.

Size
Fine tune the size of the texture in the brush.

Sample Bias
Here you can add to or subtract from the amount that gets added by the brush texture.
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Brush Mapping with mapping method 3D
The brush mapping method View Plane and Area Plane sculpts where the pencil is. The
method 3D sculpts at the initial position of the pencil, as long as you don't release the mouse.
The mapping happens from the View plane. Means you get distortions when you sculpt from
an angle.

Offset
Fine tune the offset of the texture in the brush.

Size
Fine tune the size of the texture in the brush.

Sample Bias
Here you can add to or subtract from the amount that gets added by the brush texture.

Brush Mapping with mapping method Random
The brush mapping method Random randomizes the texture position of the pencil texture.
And so it sculpts random fragments of the pencil.
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Angle edit box
Here you can adjust the angle of the brush.

Rake
The angle follows the direction of the brush stroke.

Random
The brush angle gets set random.

Random edit box
Becomes visible when you tick Random. Here you can adjust the maximum value of the random angle.

Offset
Fine tune the offset of the texture in the brush.

Size
Fine tune the size of the texture in the brush.

Sample Bias
Here you can add to or subtract from the amount that gets added by the brush texture.

Brush Mapping with mapping method Stencil
The former methods uses the textures for the brush. The method Stencil works different. You have your texture
displayed in the workspace above the object, and you paint this texture onto your object with your pencil
strokes.
Note that the texture in the 3d space is just visible when you are with the mouse over the viewport.
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Image Aspect
Adjust the stencil size to fit to the image aspect ratio

Stencil Brush controls
Here you can move, rotate and scale the stencil image in the 3D viewport. And reset the
transform. You better use the hotkeys here that gets displayed in the tool tips, since the
image is not displayed when the mouse is not over the 3D viewport.

Angle edit box
Here you can adjust the angle of the brush. The button at the end allows you to set the
radius by dragging the mouse. This should be done in the viewport and with the hotkey.
This button is just a visible reminder.

Offset
Fine tune the offset of the texture in the brush.

Size
Fine tune the size of the texture in the brush.

Stroke Panel
The Stroke panel contains settings to influence the behaviour of the brush stroke. There are various stroke
methods available. We will go through them one by one.

Stroke Panel with Stroke method Space
This is the default Stroke method. The sculpt stroke gets added continuously with given
settings.
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Spacing Edit Box
The sculpt drawing happens by mapping the pencil onto the mouse
position. And when you move the mouse then the next mapping
happens. Here you can adjust the spacing after what mouse movement
the next mapping should happen. The lower the value, the lower the
distance between the single dots.
The icon behind the edit box enables tablet pressure sensitivity for
tablets.

Jitter Edit Box
Here you can add Jitter to the brush while painting.
The icon in front of the edit box toggles between jittering in screen space and relative to brush size.
The icon behind the edit box enables tablet pressure sensitivity for tablets.

Smooth Stroke
The brush lags behind the mouse position, and produces a much smoother stroke by that.

Smooth Stroke Radius Edit Box
Is just active when Smooth Stroke is activated. Here you can adjust the radius of the smoothing.

Smooth Stroke Factor Edit Box
Is just active when Smooth Stroke is activated. Here you can adjust the factor of the smoothing.

Input Samples Edit Box
Average multiple input samples together to smooth the brush stroke.

Stroke Panel with Stroke method Curve
The Stroke method curve doesn't simply influence the way how the stroke is painted.
It is a special method. First you draw a curve object by holding down ctrl and
clicking with left mouse button. Then you tweak the curve. You can click at the curve
point, and drag out handlers to make the curve points smoooth
Then you hit the Draw Curve button. And the curve gets sculpted.
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Spacing Edit Box
The sculpt drawing happens by mapping the pencil
onto the mouse position. And when you move the mouse then the next
mapping happens. Here you can adjust the spacing after what mouse
movement the next mapping should happen. The lower the value, the
lower the distance between the single dots.
The icon behind the edit box enables tablet pressure sensitivity for
tablets.

Paint Curve edit box
Here you set the active curve.
The first element is a dropdown box where you will find your curves objects. You
can have more than one.
The second element is the edit box that displays the active curve.
The number right of it, in this case 2, indicates how much number of users ( internally ) this brush uses. This
means that this data block (the brush) shares currently settings with at least one other object. Most probably the
parent brush where we have created it from. Click at the value to make this brush a single user. The button will
vanish then.
F set the brush to have a fake user. Zero user data-blocks are normally not saved. But sometimes you want to
force the data to be kept even when the data block has no user.
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The + button allows you to add a new pencil with the current settings. Note that the brushes are NOT saved
when you close Bforartists. You can save them into the current blend file. Or you can save the startup file. But
be careful here. This saves everything else of the current state of Bforartists too.
The X button deletes the brush as the active one. It does NOT delete it from the brushes list.

Draw Curve Button
A click at it to turns the curve into a sculpt stroke.

Jitter Edit Box
Here you can add Jitter to the brush while painting.
The icon in front of the edit box toggles between jittering in screen space and relative to brush size.
The icon behind the edit box enables tablet pressure sensitivity for tablets.

Input Samples Edit Box
Average multiple input samples together to smooth the brush stroke.

Stroke Panel with Stroke method Line
With Stroke method line you draw a line between a starting point and a endpoint. And when
you release the mouse then the line gets sculpted.

Spacing Edit Box
The sculpt drawing happens by mapping the pencil onto the mouse
position. And when you move the mouse then the next mapping
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happens. Here you can adjust the spacing after what mouse movement the next mapping should happen. The
lower the value, the lower the distance between the single dots.
The icon behind the edit box enables tablet pressure sensitivity for tablets.

Jitter Edit Box
Here you can add Jitter to the brush while painting.
The icon in front of the edit box toggles between jittering in screen space and relative to brush size.
The icon behind the edit box enables tablet pressure sensitivity for tablets.

Input Samples Edit Box
Average multiple input samples together to smooth the brush stroke.

Stroke Panel with Stroke method Airbrush
The sculpt stroke acts like an airbrush pencil. The dots gets placed randomly.

Rate Edit Box
Here you can define the rate of the drawing.

Jitter Edit Box
Here you can add Jitter to the brush while painting.
The icon in front of the edit box toggles between jittering in screen space and relative to brush size.
The icon behind the edit box enables tablet pressure sensitivity for tablets.
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Smooth Stroke
The brush lags behind the mouse position, and produces a much smoother stroke by that.

Smooth Stroke Radius Edit Box
Is just active when Smooth Stroke is activated. Here you can adjust the radius of the smoothing.

Smooth Stroke Factor Edit Box
Is just active when Smooth Stroke is activated. Here you can adjust the factor of the smoothing.

Input Samples Edit Box
Average multiple input samples together to smooth the brush stroke.

Stroke Panel with Stroke method Anchored
Click and drag to place a dot and to scale it.

Edge to Edge
Without Edge to Edge the scaling happens from the center of the brush. With edge to edge the scaling happesn
from the edge of the brush.

Input Samples Edit Box
Average multiple input samples together to smooth the brush stroke.

Stroke Panel with Stroke method Drag dot
Click and drag to place a dot.
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Input Samples Edit Box
Average multiple input samples together to smooth the brush stroke.

Curve Panel
The curve panel allows you to define different fallofs methods for the border of the brush.

Navigation elements
The navigation elements at the top are described from left to right

Zoom in and out
The two buttons with the magnifying glass at it zooms in and out in the curve window.

Tools
Tools is a menu where you can find some cuve related tools.
Reset View
Resets the curve windows zoom
Vector Handle
Set handle type to Vector
Auto Handle
Set handle type to Auto
Auto Clamped Handle
Set handle type to Auto Clamped
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Reset Curve
Resets the curve to the initial shape.

Curve Presets
Here you can find some predefined curve presets.

Dyntopo Panel
Dyntopo stands for Dynamic Topology Sculpting.
Without dyntopo you just deform the existing geometry. With Dyntopo geometry gets
subdivided when needed. This makes it possible to sculpt complex shapes out of a block.
Left without Dyntopo, right with Dyntopo.

Note that some brushes does not work with Dyntopo. They are Grab brush, Rotate brush, Thumb brush, Layer
brush, Smooth brush (including alt-key smoothing with a different brush) and Mask brush.
The topology will also not be updated if the stroke mode is Anchored or Drag Dot.

Detail Size
The Detail size defines how fine the subdivision will be. When you click at the upper button
then a widget appears where you can set the detail size by dragging. This button contains also
the hotkey to change the detail size in the viewport so that you don't have to grab the slider all
the time when working.
The edit box below does the same. But with a slider, and without visible feedback in form of a widget.

Detail Refine method
Here you can define the Detail refine method.
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Subdivide Collapse
Both methods in one. Subdivide long edges to add mesh detail where needed. And collapse short edges to
remove mesh detail where possible.

Collapse Edges
Collapse short edges to remove mesh detail where possible.

Subdivide Edges
Subdivide long edges to add mesh detail where needed.

Detail Type Method
Here you can define the Detail Type method.

Brush Detail
Mesh Detail is relative to brush radius.

Constant Detail
Mesh detail is constant in object space according to detail size.

Relative Detail
Mesh Detail is relative to brush size and detail size

Smooth shading
Show faces in smooth shading instead of flat shading.

Optimize
Recalculate the sculpt BVH to improve performance.

Detail Floodfill
Flood fill the mesh with the selected detail settings.

Direction
Source and Destination for Symmetrize operator. This has to do with the symmetrize button below.
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Symmetrize
Symmetrize the topology modifications.

Symmetry / Lock
The Symmetry Lock panel contains tools around symmetry and lock features. Here you can
turn on or off mirroring along axis, etc.

Mirror
Mirror sculpt along activated axis.
By default the mirroring is
activated around X axis.

Radial
Adjust the repeatings across some
axis. For example, when you
change Z to 32, then you can draw
32 segments simultaneously around
the Z axis instead of just one,
distributed around the Z axis.

Feather
Reduce the strength of the brush where it overlaps symmetrical daubs

Lock
Disallow vertices movement in locked axis direction.

Tiling
Produces a mesh that is tilable in the activated directions.

Tile Offset
Here you can adjust the offset of the tiling.

Tool Shelf in Sculpt Mode - Mesh Object, Options tab
The Options tab for sculpting provides you with some settings and options for sculpting.
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Overlay Panel
Curve
This setting is interesting for the Stroke method Curve. Here you can
adjust how transparent the curve is.
The eye icon button in front of the slider is to show the curve object in viewport. The brush icon button behind
the slider is to hide the overlay during a stroke.

Texture
This setting is interesting for Texture painting. Here you can adjust how transparent the texture is.
The eye icon button in front of the slider is to show the texture in the viewport. The brush icon button behind
the slider is to hide the overlay during a stroke.
The Stencil map texture has no eye icon button since it gets shown in the viewport anyways.

Options Panel
Dab Gravity
Here you can add gravity after each stroke.

Factor
The factor silder defines the amount.

Orientation
Here you define an object that gets used to determine the gravity from. The Z axis of this
object gets used.

Threaded Sculpt
Use multiple CPU cores for sculpting.

Fast Navigate
For Multires, show Low Res mesh when navigating.

Use Deform only
Use only deformation modifiers ( The other constructive modifiers except multi-resolution gets temporary
disabled)

Show Diffuse Color
Show the diffuse color of the object while sculpting.
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Unified Settings
Size
Instead of per Brush radius, the radius is shared across brushes.

Strength
Instead of per Brush strength, the strength is shared across brushes.

Color
Instead of per Brush color, the color is shared across brushes.

Enabled Brush Modes
Enabled Modes
Enabled modes is a dropdown menu where you can adjust in which modes the brushes
shows.

Appearance Panel
The Appearance panel provides you with some settings to adjust the appearance of the brush.

Show Brush
Show the brush in 3D view.

Add
The color that the brush cursor has when adding to geometry.

Subtract
The color of the brush cursor when subtracting from the geometry.

Custom Brush Icon
Here you can define a custom icon for the brush.

Tool Shelf in Vertex Paint Mode
The Tool Shelf in Vertex Paint Mode provides you the tools to paint vertices.
Vertex painting assigns colors to single vertices. And this color gets interpolated between the different vertices
then. This is what makes the faces colored. And this means that you can NOT paint in the middle of a face with
this method. You just paint the vertices from the mesh.
The Vertex Paint mode is just available for mesh objects.
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Tool Shelf in Vertex Paint Mode - Mesh Object, Tools Tab
Brush Panel
The Brush Panel contains the different Brushes and some Brush settings. Here you can
choose and adjust your current active brush.
At down left you can find the display options. The button with the gear symbol at it.
Here you will find two toggles to hide away the color picker and the palette edit box.

Browse Brush
The big image at the top is a dropdown box where you can choose a brush. Click at it, and you will see the
different brushes. A click at one of the images will choose this brush then.

When you have added a few more brushes then the dropdown box may be more than full. You will see some
little white arrows then. Either in the top left or in the bottom right corner. They indicate that some brushes are
hidden before or after the current display.
To scroll to this hidden content use the mouse wheel, or the arrow up and down buttons at the keyboard.
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The edit box below the Image shows you the name of the current active brush.
The number right of it, in this case 2, indicates how much number of users ( internally ) this brush uses. This
means that this data block (the brush) shares currently settings with at least one other object. Most probably the
parent brush where we have created it from. Click at the value to make this brush a single user. The button will
vanish then.
F set the brush to have a fake user. Zero user data-blocks are normally not saved. But sometimes you want to
force the data to be kept even when the data block has no user.
The + button allows you to add a new pencil with the current settings. Note that the brushes are NOT saved
when you close Bforartists. You can save them into the current blend file. Or you can save the startup file. But
be careful here. This saves everything else of the current state of Bforartists too.
The X button deletes the brush as the active one. It does NOT delete it from the brushes list.

Color dialog
The color dialog is hidden by default. See display options at the
bottom of the panel. You can define the color in the color element
below the brush browser. It will also open a color dialog then.

When you set it to visible, then you can set the color for painting by a click with the
mouse in the color wheel. The slider at the right defines the brightness.
The button below shows you the active color.
A click at the color button will open a more detailed color dialog, where you can set up rgb, hsv and hex colors
and with sliders.

Color Element
Here you can set a primary and a secondary color. The button with the arrows
at it switches the active and the secondary color. And with the pipette you can pick a color from the screen. This
will reveal some more elements, and create a palette. Here you can choose now the color to use it for painting.
You can add and remove colors here too.
This color picker can just pick a color in the 3D view. It does not work elsewhere.
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Radius
The Radius edit box allows you to adjust the radius of the brush. The button
behind the edit box enables tablet pressure sensitivity for radius.
And the button at the end allows you to set the radius of the pencil by hotkey. A
click at this button works of course too. But this is a hotkey tool. The button is just a visible reminder.

Strength
The Strength edit box allows you to adjust the strength of the brush. The button
behind the edit box enables tablet pressure sensitivity for strength.
And the button at the end allows you to set the strength by hotkey. A click at this button works of course too.
But this is a hotkey tool. The button is just a visible reminder.

Blending Modes
Here you can define how the stroke will blend.

Accumulate, Alpha, etc.
This are brush specific settings. They change with the brush.

Palette Editbox
Palette Edit box is hidden by default.
Here you can give your palette a name, create another palette, remove palette, and give it a fake user.

Display options
Here you can show or hide the Colorpicker and the Palette Editbox.
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Texture Panel
The Texture panel allows you to paint with textures. This allows you for example to grab a
foto from some fish scales, and simply paint them onto the vertices by using this image as a
pencil. Or as a blueprint where you calk through ( Stencil method ).

Browse Texture to be linked
The image at the top of the panel is a image browser. Here you can choose a texture that you
can choose for sculpting then. You can also have more than one image loaded at once.

In this shot there is already a texture added. The way to add the texture here is a bit more complicated. And not
done with clicking at the New button.
First click at the New button below the image. This will create a new texture slot. This
slot is still empty, it displays black.
We need to load the texture in this slot. This must be done in the Properties editor in the
Textures tab. And then the texture finally shows in the Texture panel in the Tool Shelf.
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Texture Edit box
The Texture edit box is the edit box below the Image browser. When
there's no image loaded then it displays the New button. When there's
a image (or more) loaded, then you will see the name of the current
texture.
The F button turns this texture into a data block with a fake user. Means it will exists even when there is no
data connected to it anymore.
When you activate Fake User, then you may get a value in front of it, which displays
how much users this data block (our texture slot) currently has.
The + Button adds another texture slot. Note that you will have to load a texture too, as explained above.
The X button deletes the texture slot.

Brush Mapping
Our texture can be mapped in different methods. The Brush mapping is a
dropdown box where you can choose this different brush mapping methods.
The settings vary. So we will go through them by the different brush mapping methods.
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Brush Mapping with mapping method Tiled
The brush mapping method Tiled tiles the brush
stroke at the surface. The mapping happens
from the current view. The result may be
distorted when the view does not align with the
surface of the object.

Angle
The angle of the brush.

Offset
The offset of the texture in the brush.

Size
The size of the texture in the brush.

Brush Mapping with mapping method View Plane
The brush mapping method View Plane simply
paints onto the surface. The mapping happens
from the current view. The result may be
distorted when the view does not align with the
surface of the object.

Angle
The angle of the brush.

Rake
The angle follows the direction of the brush stroke.

Random
The brush angle gets set random.
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Offset
The offset of the texture in the brush.

Size
The size of the texture in the brush.

Brush Mapping with mapping method 3D
The brush mapping method 3D paints the
texture at the surface, by tiling it 1/1 at the
object surface.

Offset
The offset of the texture in the brush.

Size
The size of the texture in the brush.

Brush Mapping with mapping method Random
The brush mapping method Random paints onto
the surface, and randomizes the texture position
in the brush while that. The mapping happens
from the current view. The result may be
distorted when the view does not align with the
surface of the object.
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Angle
The angle of the brush.

Rake
The angle follows the direction of the brush stroke.

Random
The brush angle gets set random.

Offset
The offset of the texture in the brush.

Size
The size of the texture in the brush.

Brush Mapping with mapping method Stencil
The former methods uses the textures for the brush. The method Stencil works different. You have your texture
displayed in the workspace above the object, and you paint this texture onto your object with your pencil
strokes.
Note that the texture in the 3d space is just visible when you are with the mouse over the viewport.

Image Aspect
Adjust the stencil size to fit to the image aspect ratio

Stencil Brush controls
Here you can move, rotate and scale the stencil image in the 3D viewport. And reset the
transform. You better use the hotkeys here that gets displayed in the tool tips, since the
image is not displayed when the mouse is not over the 3D viewport.
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Angle edit box
Here you can adjust the angle of the brush. The button at the end allows you to set the
radius by dragging the mouse. This should be done in the viewport and with the hotkey.
This button is just a visible reminder.

Offset
Fine tune the offset of the texture in the brush.

Size
Fine tune the size of the texture in the brush.

Stroke Panel
The Stroke panel contains settings to influence the behaviour of the brush stroke. There are various stroke
methods available. We will go through them one by one.

Stroke Panel with Stroke method Space
This is the default Stroke method. The sculpt stroke gets added continuously with given
settings.

Spacing Edit Box
The sculpt drawing happens by mapping the pencil onto the mouse
position. And when you move the mouse then the next mapping
happens. Here you can adjust the spacing after what mouse
movement the next mapping should happen. The lower the value,
the lower the distance between the single dots.
The icon behind the edit box enables tablet pressure sensitivity for
tablets.
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Jitter Edit Box
Here you can add Jitter to the brush while painting.
The icon in front of the edit box toggles between jittering in screen space and relative to
brush size.
The icon behind the edit box enables tablet pressure sensitivity for tablets.

Smooth Stroke
The brush lags behind the mouse position, and produces a much smoother stroke by that. The
Smooth Stroke relatet settings are hidden as long as Smooth Stroke is not activated.

Smooth Stroke Radius Edit Box
Is just active when Smooth Stroke is activated. Here you can adjust the radius of the smoothing.

Smooth Stroke Factor Edit Box
Is just active when Smooth Stroke is activated. Here you can adjust the factor of the smoothing.

Input Samples Edit Box
Is just active when Smooth Stroke is activated. Average multiple input samples together to smooth the brush
stroke.

Stroke Panel with Stroke method Curve
The Stroke method curve doesn't simply influence the way how the stroke is painted. It is a
special method. First you draw a curve object by holding down ctrl and clicking with left
mouse button. Then you tweak the curve. You can click at the curve point, and drag out
handlers to make the curve points smoooth.
Then you hit the Draw Curve button. And the curve gets drawn onto the surface.
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Spacing Edit Box
The drawing happens by mapping the pencil onto the mouse
position. And when you move the mouse then the next mapping
happens. Here you can adjust the spacing after what mouse
movement the next mapping should happen. The lower the value,
the lower the distance between the single dots.
The icon behind the edit box enables tablet pressure sensitivity for
tablets.

Paint Curve edit box
Here you set the active curve.
The first element is a dropdown box where you will find your curves objects. You
can have more than one.
The second element is the edit box that displays the active curve.
The number right of it, in this case 2, indicates how much number of users ( internally ) this brush uses. This
means that this data block (the brush) shares currently settings with at least one other object. Most probably the
parent brush where we have created it from. Click at the value to make this brush a single user. The button will
vanish then.
F set the brush to have a fake user. Zero user data-blocks are normally not saved. But sometimes you want to
force the data to be kept even when the data block has no user.
The + button allows you to add a new pencil with the current settings. Note that the brushes are NOT saved
when you close Bforartists. You can save them into the current blend file. Or you can save the startup file. But
be careful here. This saves everything else of the current state of Bforartists too.
192

Bforartists Reference Manual - © Copyright - This page is Public Domain

The X button deletes the brush as the active one. It does NOT delete it from the brushes list.

Draw Curve Button
A click at it to turns the curve into a sculpt stroke.

Jitter Edit Box
Here you can add Jitter to the brush while painting.
The icon in front of the edit box toggles between jittering in screen space and relative to brush size.
The icon behind the edit box enables tablet pressure sensitivity for tablets.

Input Samples Edit Box
Average multiple input samples together to smooth the brush stroke.

Stroke Panel with Stroke method Line
With Stroke method line you draw a line between a starting point and a endpoint. And when
you release the mouse then the line gets sculpted.

Spacing Edit Box
The sculpt drawing happens by mapping the pencil onto the mouse
position. And when you move the mouse then the next mapping
happens. Here you can adjust the spacing after what mouse
movement the next mapping should happen. The lower the value,
the lower the distance between the single dots.
The icon behind the edit box enables tablet pressure sensitivity for
tablets.
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Jitter Edit Box
Here you can add Jitter to the brush while painting.
The icon in front of the edit box toggles between jittering in screen space and relative to
brush size.
The icon behind the edit box enables tablet pressure sensitivity for tablets.

Input Samples Edit Box
Average multiple input samples together to smooth the brush stroke.

Stroke Panel with Stroke method Airbrush
The stroke acts like an airbrush pencil. The dots gets placed randomly.

Rate Edit Box
Here you can define the rate of the drawing.

Jitter Edit Box
Here you can add Jitter to the brush while painting.
The icon in front of the edit box toggles between jittering in screen space and relative to brush size.
The icon behind the edit box enables tablet pressure sensitivity for tablets.

Smooth Stroke
The brush lags behind the mouse position, and produces a much smoother stroke by that.

Smooth Stroke Radius Edit Box
Is just active when Smooth Stroke is activated. Here you can adjust the radius of the smoothing.

Smooth Stroke Factor Edit Box
Is just active when Smooth Stroke is activated. Here you can adjust the factor of the smoothing.
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Input Samples Edit Box
Average multiple input samples together to smooth the brush stroke.

Stroke Panel with Stroke method Dots
The stroke method Dots draws dots of the pencil onto the surface. The mapping happens from
the current view. Means you will get distortions when your view is not aligned with the
surface of the object.

Jitter Edit Box
Here you can add Jitter to the brush while painting.
The icon in front of the edit box toggles between jittering in screen space and relative to
brush size.
The icon behind the edit box enables tablet pressure sensitivity for tablets.

Smooth Stroke
The brush lags behind the mouse position, and produces a much smoother stroke by that.

Smooth Stroke Radius Edit Box
Is just active when Smooth Stroke is activated. Here you can adjust the radius of the smoothing.

Smooth Stroke Factor Edit Box
Is just active when Smooth Stroke is activated. Here you can adjust the factor of the smoothing.

Input Samples Edit Box
Average multiple input samples together to smooth the brush stroke.

Curve Panel
The curve panel allows you to define different fallofs methods for the border of the brush.
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Navigation elements
The navigation elements at the top are described from left to right

Zoom in and out
The two buttons with the magnifying glass at it zooms in and out in the curve window.

Tools
Tools is a menu where you can find some cuve related tools.
Reset View
Resets the curve windows zoom
Vector Handle
Set handle type to Vector
Auto Handle
Set handle type to Auto
Auto Clamped Handle
Set handle type to Auto Clamped
Reset Curve
Resets the curve to the initial shape.

Curve Presets
Here you can find some predefined curve presets.

Tool Shelf in Vertex paint Mode - Mesh Object, Options tab
The Options tab for sculpting provides you with some settings and options for vertex
painting.

Overlay Panel
Curve
This setting is interesting for the Stroke method Curve. Here you can
adjust how transparent the curve is.
The eye icon button in front of the slider is to show the curve object in viewport. The brush
icon button behind the slider is to hide the overlay during a stroke.

Texture
This setting is interesting for Texture painting. Here you can adjust how transparent the texture is.
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The eye icon button in front of the slider is to show the texture in the viewport. The brush icon button behind
the slider is to hide the overlay during a stroke.
The Stencil map texture has no eye icon button since it gets shown in the viewport anyways.

Appearance Panel
The Appearance panel provides you with some settings to adjust the appearance of the brush.

Show Brush
Show the brush in 3D view.

Color of cursor when adding
The color that the brush cursor has when painting

Custom Icon
Here you can define a custom icon for the brush.

Options Panel
Unified Settings
Size
Instead of per Brush radius, the radius is shared across brushes.

Strength
Instead of per Brush strength, the strength is shared across brushes.

Color
Instead of per Brush color, the color is shared across brushes.

Enabled Brush Modes
Enabled Modes
Enabled modes is a dropdown menu where you can adjust in which modes the brushes
shows.

Tool Shelf in Weight Paint Mode
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Weight painting general
The Tool Shelf in Weight Paint Mode provides you the tools to
do weight painting at a mesh. Skinned characters for example.
The vertices becomes a "weighting" assigned in this process.
Means a per centage influence of the bone to a vertice. And under
the hood you create vertex groups with the vertices that are
assigned to the bones.
The amount of influence is defined by the weight paint color.
Pure red has an influence value of 1. Pure blue has an influence
value of 0. And the gradients between red and blue defines the
inbetween steps in the 0-1 range. This is needed since there can
be more than one bone influence and deform a vertice. Usually at the transition areas between two bones. The
green areas in this shot.
The Weight Paint mode is just available for mesh objects.

Weight painting at characters
The main purpose for Weightpainting is to weight the skin for characters.
So that they deform proper when you pose your armature.

Skinning
To do weightpainting at a character you first have to
assign the skin to the armature. So we need a mesh
and a armature here.
Let's do a quick run through skinning. This method
works in Object mode, but also in Pose mode.
First we activate X Ray at the armature. So that we can still see the
armature inside of the mesh.
Position the mesh at its final location.
Now select the Mesh, hold down Shift key, and select the Armature. Both should be selected now.
In the Tool Shelf switch to the Relations tab and click at the Parent button. You can also press the hotkey Ctrl P.
This calls the parenting menu under the mouse position.
Here we choose "With Automatic Weights". Automatic
weighting means that the bones grabs the nearest vertices
within a given radius, and assignes them to this bone.
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When everything went well then the mesh, in our case the Cylinder, is
now part of the hierarchy of the armature. Which can be seen in the
outliner.
And when you select the armature, and switch to Pose mode now, then
you can already deform the mesh by posing the armature.

Enter and leave Weight painting
You can enter Weight Painting for the mesh in any state of the armature. But
weight painting should happen in Pose mode so that you can pose your
mesh to see the resulting deformings.
So with the armature in Pose mode, select the mesh by clicking at it. Then
enter Weight Paint mode. You can now do weight painting at the mesh.
To leave Weight painting, simply switch back to Object mode.
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Switch bones
The weighting that gets displayed when you enter Weight Paint mode is from the
last active bone. You might want to do weight painting for another bone. So we
need to switch the bone.
Hold down Ctrl, and click at the bone that you want to set active. Then the
weighting for this bone gets displayed.

Weight painting without any further combination
You can also do weightpainting without an armature. Just at the pure mesh. In this case you just create the
vertex groups for the mesh. And those vertex groups can be accessed in edit mode then for further useage. As
shown in the shots below.

Weight painting in combination with particles
You can also combine weight painting with particles. To influence the length of hair for example. The
weightmap can be assigned in the Vertex Groups panel in the Particles tab.
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Tool Shelf in Weight Paint Mode - Mesh Object, Tools Tab
Brush Panel
The Brush Panel contains the different Brushes and some Brush settings. Here you can
choose and adjust your current active brush.

Browse Brush
The big image at the top is a dropdown box where you can choose a brush. Click at it, and
you will see the different brushes. A click at one of the images will choose this brush then.

When you have added a few more brushes then the dropdown box may be more than full. You will see some
little white arrows then. Either in the top left or in the bottom right corner. They indicate that some brushes are
hidden before or after the current display.
To scroll to this hidden content use the mouse wheel, or the arrow up and down buttons at the keyboard.
The edit box below the Image shows you the name of the current active brush.
The number right of it, in this case 2, indicates how much number of users ( internally ) this brush uses. This
means that this data block (the brush) shares currently settings with at least one other object. Most probably the
parent brush where we have created it from. Click at the value to make this brush a single user. The button will
vanish then.
F set the brush to have a fake user. Zero user data-blocks are normally not saved. But sometimes you want to
force the data to be kept even when the data block has no user.
The + button allows you to add a new pencil with the current settings. Note that the brushes are NOT saved
when you close Bforartists. You can save them into the current blend file. Or you can save the startup file. But
be careful here. This saves everything else of the current state of Bforartists too.
The X button deletes the brush as the active one. It does NOT delete it from the brushes list.
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Weight edit box
Here you can adjust the strength of the weight painting.

Radius
The Radius edit box allows you to adjust the radius of the brush. The button
behind the edit box enables tablet pressure sensitivity for radius.
And the button at the end allows you to set the radius of the pencil by hotkey. A click at this button works of
course too. But this is a hotkey tool. The button is just a visible reminder.

Strength
The Strength edit box allows you to adjust the strength of the brush. The button
behind the edit box enables tablet pressure sensitivity for strength.
And the button at the end allows you to set the strength by hotkey. A click at this button works of course too.
But this is a hotkey tool. The button is just a visible reminder.

Blend
Blend is a dropdown box where you can choose between different blend modes for the color
that you paint.

Darken
Darkens the color under the brush.

Lighten
Brightens the color under the brush.

Blur
Blurs the color under the brush.

Multiply
Multiplys with the color under the brush.

Subtract
Subtract from the color under the brush.

Add
Adds to the color under the brush.

Mix
Mixes with the color under the brush.
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Auto Normalize
Auto normalizes the weighting so that in the sum all vertex groups does not go over 1.0

Multipaint
Paint across the weights of all selected bones, maintaining their relative influence.

Stroke Panel
The Stroke panel contains settings to influence the behaviour of the brush stroke. There are various stroke
methods available. We will go through them one by one.

Stroke Panel with Stroke method Space
This is the default Stroke method. The sculpt stroke gets added continuously with given
settings.

Spacing Edit Box
The drawing happens by mapping the pencil onto the mouse
position. And when you move the mouse then the next mapping
happens. Here you can adjust the spacing after what mouse
movement the next mapping should happen. The lower the value,
the lower the distance between the single dots.
The icon behind the edit box enables tablet pressure sensitivity for
tablets.

Jitter Edit Box
Here you can add Jitter to the brush while painting.
The icon in front of the edit box toggles between jittering in screen space and relative to brush size.
The icon behind the edit box enables tablet pressure sensitivity for tablets.

Smooth Stroke
The brush lags behind the mouse position, and produces a much smoother stroke by that.
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Smooth Stroke Radius Edit Box
Is just active when Smooth Stroke is activated. Here you can adjust the radius of the smoothing.

Smooth Stroke Factor Edit Box
Is just active when Smooth Stroke is activated. Here you can adjust the factor of the smoothing.

Input Samples Edit Box
Average multiple input samples together to smooth the brush stroke.

Stroke Panel with Stroke method Curve
The Stroke method curve doesn't simply influence the way how the stroke is painted. It is a
special method. First you draw a curve object by holding down ctrl and clicking with left
mouse button. Then you tweak the curve. You can click at the curve point, and drag out
handlers to make the curve points smoooth.
Then you hit the Draw Curve button. And the curve gets drawn onto the surface.

Spacing Edit Box
The drawing happens by mapping the pencil onto the mouse
position. And when you move the mouse then the next mapping
happens. Here you can adjust the spacing after what mouse
movement the next mapping should happen. The lower the value,
the lower the distance between the single dots.
The icon behind the edit box enables tablet pressure sensitivity for
tablets.
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Paint Curve edit box
Here you set the active curve.
The first element is a dropdown box where you will find your curves objects.
You can have more than one.
The second element is the edit box that displays the active curve.
The number right of it, in this case 2, indicates how much number of users ( internally ) this brush uses. This
means that this data block (the brush) shares currently settings with at least one other object. Most probably the
parent brush where we have created it from. Click at the value to make this brush a single user. The button will
vanish then.
F set the brush to have a fake user. Zero user data-blocks are normally not saved. But sometimes you want to
force the data to be kept even when the data block has no user.
The + button allows you to add a new pencil with the current settings. Note that the brushes are NOT saved
when you close Bforartists. You can save them into the current blend file. Or you can save the startup file. But
be careful here. This saves everything else of the current state of Bforartists too.
The X button deletes the brush as the active one. It does NOT delete it from the brushes list.

Draw Curve Button
A click at it to turns the curve into a sculpt stroke.

Jitter Edit Box
Here you can add Jitter to the brush while painting.
The icon in front of the edit box toggles between jittering in screen space and relative to brush size.
The icon behind the edit box enables tablet pressure sensitivity for tablets.

Input Samples Edit Box
Average multiple input samples together to smooth the brush stroke.

Stroke Panel with Stroke method Line
With Stroke method line you draw a line between a starting point and a endpoint. And when
you release the mouse then the line gets sculpted.
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Spacing Edit Box
The sculpt drawing happens by mapping the pencil onto the mouse
position. And when you move the mouse then the next mapping
happens. Here you can adjust the spacing after what mouse
movement the next mapping should happen. The lower the value,
the lower the distance between the single dots.
The icon behind the edit box enables tablet pressure sensitivity for
tablets.

Jitter Edit Box
Here you can add Jitter to the brush while painting.
The icon in front of the edit box toggles between jittering in screen space and relative to brush size.
The icon behind the edit box enables tablet pressure sensitivity for tablets.

Input Samples Edit Box
Average multiple input samples together to smooth the brush stroke.

Stroke Panel with Stroke method Airbrush
The stroke acts like an airbrush pencil. The dots gets sprayed randomly.

Rate Edit Box
Here you can define the rate of the drawing.

Jitter Edit Box
Here you can add Jitter to the brush while painting.
The icon in front of the edit box toggles between jittering in screen space and relative to brush size.
The icon behind the edit box enables tablet pressure sensitivity for tablets.

Smooth Stroke
The brush lags behind the mouse position, and produces a much smoother stroke by that.
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Smooth Stroke Radius Edit Box
Is just active when Smooth Stroke is activated. Here you can adjust the radius of the smoothing.

Smooth Stroke Factor Edit Box
Is just active when Smooth Stroke is activated. Here you can adjust the factor of the smoothing.

Input Samples Edit Box
Average multiple input samples together to smooth the brush stroke.

Stroke Panel with Stroke method Dots
The stroke method Dots draws dots of the pencil onto the surface. The mapping happens from
the current view. Means you will get distortions when your view is not aligned with the
surface of the object.

Jitter Edit Box
Here you can add Jitter to the brush while painting.
The icon in front of the edit box toggles between jittering in screen space and relative to
brush size.
The icon behind the edit box enables tablet pressure sensitivity for tablets.

Smooth Stroke
The brush lags behind the mouse position, and produces a much smoother stroke by that.

Smooth Stroke Radius Edit Box
Is just active when Smooth Stroke is activated. Here you can adjust the radius of the smoothing.

Smooth Stroke Factor Edit Box
Is just active when Smooth Stroke is activated. Here you can adjust the factor of the smoothing.

Input Samples Edit Box
Average multiple input samples together to smooth the brush stroke.
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Curve Panel
The curve panel allows you to define different fallofs methods for the border of the brush.

Navigation elements
The navigation elements at the top are described from left to right

Zoom in and out
The two buttons with the magnifying glass at it zooms in and out in the curve window.

Tools
Tools is a menu where you can find some cuve related tools.
Reset View
Resets the curve windows zoom
Vector Handle
Set handle type to Vector
Auto Handle
Set handle type to Auto
Auto Clamped Handle
Set handle type to Auto Clamped
Reset Curve
Resets the curve to the initial shape.

Curve Presets
Here you can find some predefined curve presets.

Weight Tools
The Weight Tools provides you with tools to manipulate the existing weight
painting and its vertex groups in various ways.
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Normalize All
Normalize all vertex groups. So that for each vertex the sum of all weights is 1.0

Last Operator Normalize All Vertex Groups
Subset
Defines which group of subset shall be used. There is just one in the dropdown list. So
nothing really to choose here.
Lock Active
Keep the values of the active groupd while normalizing the others.

Normalize
Normalize the current active vertex group.
Normalize has no settings in the Last operator.

Mirror
Mirrors the weighting of the current active vertex group.

Last Operator Mirror Vertex Group
Mirror Weights
Mirror the weights
Flip Group Names
Flip the vertex group names
All Groups
Mirror all groups, not just the current active one.
Topology Mirror
Use topology based mirroring (for when both sides of th emesh have matching, unique topology)

Invert
Inverts the colors of the weight painting.

Last Operator Invert Vertex Groups
Subset
A dropdown box where you can choose to work with the Active Group or All Groups.
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Add Weights
Add Vertices to groups that has zero weighting before inverting.
Remove Weights
Remove Vertices from groups that have zero weighting after inverting.

Clean
Remove Vertex Group assignments that are below a defined limit. This limit can be set in the Last Operator
panel.

Last Operator Clean Vertex Groups
Subset
A dropdown box where you can choose to work with the Active Group or All Groups.
Limit
Here you can define the limit. Every vertice with a weighting below this value will be
removed from the current vertex group.
Keep Single
Keep vertices assigned to at least one vertex group when cleaning.

Quantize
Reduces the number of colours that are used for weight painting. A smooth gradient reduces to a few colors.

Last Operator Quantize Vertex Weights
Subset
A dropdown box where you can choose to work with the Active Group or All Groups.
Steps
The number of colors after quantize.
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Levels
Here you can manipulate the colors of the weight painting similar to contrast and brightness. The tool adds an
offset and a scale to all weights of the selected Weight Groups.

Last Operator Vertex Group Levels
Subset
A dropdown box where you can choose to work with the Active Group or All Groups.
Offset
Adjust the brightness of the color.
Gain
Adjust the contrast of the color.

Smooth
Smooth smoothens the weight painting by
blending the weights of selected vertices with
adjacent unselected vertices.
You need to have Vertex Selection masking set
to active to set this tool active. Then every
vertice of the mesh gets displayed as a dot. And
then you can select the vertices that you want to
smooth.

Last Operator Smooth Vertex Weights
Subset
A dropdown box where you can choose to work with the Active Group or All Groups.
Factor
The smoothing factor.
Iterations
The number of iterations to smooth.
Expand/Contract

211

Bforartists Reference Manual - © Copyright - This page is Public Domain

With positive values it expands the smoothing. With negative values it contracts the
smoothing.
Source
A dropdown box where you can choose with what vertices you want to work.

Limit Total
Limit the number of deform weights for a vertex by removing the lowest weights. For example when five
vertex groups are assigned to one vertice, and you set the limit to 4, then the vertice will just be assigned to the
four vertex groups with the highest weight. This is useful for game content where the game engine has a limit
for how much bones can be connected to one vertice.

Last Operator Limit Number of Weights
Subset
A dropdown box where you can choose to work with the Active Group or All Groups.
Limit
Here you can set the limit.

Fix Deforms
When complex models are deformed to their most extreme poses, they often show visibly incorrect
deformations. Shoulder or elbow for example. Fix Deforms tries to fix this incorrect deformations by modifying
the positions of the selected vertices to fit better into the positions of the surrounding vertices.
The problem with this tool is that it is meant for complex models, but doesn't play well with complex models at
all. More than a handful selected vertices slows even strong PC's down to a crawl. So you might be better suited
to fix the incorrect deformations by simply doing manual weight painting at the trouble makers. Or by adding a
shape key in the extreme pose to clean up the incorrect deformations.

Usage
Make sure that there is no mirroring applied. The tool does not work with
mirroring.
In Pose mode pose your mesh into the extreme pose.
Select the mesh, switch to Weigth Paint.
In Weight Paint mode turn on Vertex Selection Masking.
Then select the trouble vertices. By Border select for example. Or by Shift LMB
click.
Then click at Fix Deforms. You might or might not get a visible result.
212

Bforartists Reference Manual - © Copyright - This page is Public Domain

Play around with the Distance in the Last Operator to get other results.

Last Operator Fix Vertex Group Deform
Distance
The distance to move to.
Strength
A modifier for the Distance.
Change Sensitivity
Change the amount that the weights are altered with each iteration. The lower the value the slower the
calculation.

Weight Gradient
Weight gradient allows you to draw a gradient by defining the
start point and the end point.

Last Operator Weight Gradient
Type
A dropdown box where you can choose between a linear gradient and a radial gradient.

Transfer Weights
Transfer weights allows you to transfer weights from one object to
another object in the same space. For example to copy the weight of a
body shape to a covering cloth.

Usage
Make sure the target part is at its location.
In Object mode Select the source object(s). Then shift click to select the
target object too. This makes the target object the active object
Switch to Weight Paint mode.
Click the Transfer Weight Button, and the weighting should be
transfered to the target object.
You can adjust the result in the Last Operator Transfer Mesh Data panel.
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Last Operator Transfer Mesh Data
Freeze Operator
Prevent the operator to rerun when you tweak the settings. So that you can tweak many
settings at once, then untick to run the operator again.
Data Type
A dropdown box where you can choose the data type to work with.

Create Data
Add Data layers on target object if needed.
Vertex Mapping
A dropdown box where you can choose the vertex mapping method.
Auto Transform
Automatically compute transformation to get the best possible match
between source and target object.
Object Transform
Calculate the objects in Global space. Unticked means the transfer happens from and to the origin of the
objects.
Only Neighbour Geometry
Source Objects must be closer than given distance to the target objects.
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Ray Radius
The ray distance for Only Neighbour Geometry.
Source Layers Selection
A dropdown box where you can choose the Source Layer selection method.
Destination Layers Matching
A dropdown box where you can choose the Destination Layers matching.

Mix Mode
A dropdown box where you can choose the mix mode. That's how the mapping gets
transfered into the target object.
Mix Factor
The strength of the chosen mix mode.

Tool Shelf in Weight Paint Mode - Options Tab
The Options tab provides you with some options for the weight painting tools.

Overlay Panel
Curve
This item is for the Stroke method Curve. Here you can adjust how transparent the curve
itself gets drawn.
The eye icon in front of the edit box shows or hides the cursor while drawing a curve.
The pencil icon behind the edit box is for don't show overlay during a stroke.

Appearance Panel
Show Brush
Show or hide the brush in the viewport.

Brush color
The color of the brush icon.

Custom Icon
Here you can define a custom brush icon.
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Options Panel
Normals
Apply the vertex normals before painting.

Spray
Keep applying paint effect while holding down mouse button.

Restrict
Restrict painting to vertices in the group.

X Mirror
X Axis Mirror Editing.

Topology Mirror
Needs X Mirror ticked. Use topology based mirroring. For when both sides of the mesh have matching, unique
topology.

Show Zero Weights
None
Doesn't show zero weights. Not weighted vertices gets displayed as blue. Which is also the color for very low
weighted vertices.
Active
Displays the not weighted vertices for the active vertex group as black.
All
Displays the not weighted vertices for all vertex groups as black.

Unified Settings
Size
The radius of the brush is shared across brushes.
Strength
The strength is shared across brushes.
Weight
The weight is shared across brushes.

Enabled Brush Modes
Enabled Modes
Enabled modes is a dropdown menu where you can adjust in which modes the brushes
shows.
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Tool Shelf in Texture Paint Mode
The Tool Shelf in Texture Paint Mode provides you the tools to paint directly at the texture of your mesh in the
viewport. To fix visible seams for example.
The Texture Paint mode is just available for mesh objects.

Requirements
Texture Painting requires to have a working UV mapping and a texture applied. When there
is no UV mapping and no assigned texture, then you will get a warning about missing data.
In this warning dialog you can fix the problem to some degree. The simple UV's is no
substitute for real UV mapping though. It is simple cubic mapping. And also the material
might need some tweaking to get it rendered.

Available Renderers
Currently you can choose between two render engines for texture painting. Blender Internal
and Cycles. This means that you end in two possible materials.

Save Texture
The result of texture painting can be found in the UV Image Editor. You can also paint in the UV editor.
The modified texture does NOT save with the scene. You have to save out the image when you want to save the
changes at the texture. There is no warning. So DON'T FORGET TO SAVE THE TEXTURE.

Tool Shelf in Texture Paint Mode - Mesh Object, Tools Tab
Missing Data Panel
Texture Painting requires to have a working UV mapping and a texture applied. When your
mesh already has UV mapping and a texture applied then you won't see this warning. When
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there is no UV mapping and no assigned texture, then you will see the warning about missing data. You have to
add those two missing elements to get texture painting to work.

Add Simple UV's
Add Simple UV's adds a simple cubic UV Mapping.
The shot from the simple UV mapping is taken in Edit
mode to make the UV patches more visible. Left 3D View,
right UV Image Editor.

In case you need better UV mapping, then the recommended method is to unwrap it with Angle Based or
Conformal method. Or any other method that doesn't produce overlapping geometry in the UV's. LikeSmart UV
project. This is done in Edit mode. When done switch back to Texture Paint mode.

Add Paint Slot
Here you can add a paint slot, and choose what texture type you want to paint. This
creates a material with a blank texture. When unsure start with a Diffuse Color. You can
at a later point use any texture for any purpose. It's the useage that defines if a texture is
the normal map or the diffuse, not the name.
We have two integrated render engines in Bforartists, and so we have two possible
materials that can be created. Bforartists has Cycles as the default renderer. When you
use the Cycles renderer then it will create a Cycles material. When you switch to
Blender Internal then it will create a BI Material.
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Add Paint Slot with Cycles
When you add a Paint slot with Cycles then a Cycles material will be
created.
The texture of this material will not render yet. We have to fix one thing
here.

Switch to Compositing layout. Have a look at the
nodes. You will notice that the Texture node is
not connected. Connect Color output with Color
input as shown in the image.
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And the texture will now render too.

Add Paint Slot with Blender Internal
When you add a Paint slot with Cycles then a BI material will be
created.
The texture of this material will immediately render.
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Brush Panel
The Brush Panel contains the different paint brushes, a color dialog, and some brush
settings.

At down left you can find the display options. The button with the gear symbol at it. Here you will find two
toggles to hide away the color picker and the palette edit box.

Browse Brush
The big image at the top is a dropdown box where you can choose a brush. Click at it, and you will see the
different brushes. A click at one of the images will choose this brush then.

When you have added a few more brushes then the dropdown box may be more than full. You will see some
little white arrows then. Either in the top left or in the bottom right corner. They indicate that some brushes are
hidden before or after the current display.
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To scroll to this hidden content use the mouse wheel, or the arrow up and down buttons at the keyboard.

The edit box below the Image shows you the name of the current active brush.
The number right of it, in this case 2, indicates how much number of users ( internally ) this brush uses. This
means that this data block (the brush) shares currently settings with at least one other object. Most probably the
parent brush where we have created it from. Click at the value to make this brush a single user. The button will
vanish then.
F set the brush to have a fake user. Zero user data-blocks are normally not saved. But sometimes you want to
force the data to be kept even when the data block has no user.
The + button allows you to add a new pencil with the current settings. Note that the brushes are NOT saved
when you close Bforartists. You can save them into the current blend file. Or you can save the startup file. But
be careful here. This saves everything else of the current state of Bforartists too.
The X button deletes the brush as the active one. It does NOT delete it from the brushes list.

Color dialog
The color dialog is hidden by default. See display options at the
bottom of the panel. You can define the color in the color element
below the brush browser. It will also open a color dialog then.

When you set it to visible, then you can set the color for painting by a click with the
mouse in the color wheel. The slider at the right defines the brightness.
The button below shows you the active color.
A click at the color button will open a more detailed color dialog, where you can set up rgb, hsv and hex colors
and with sliders.
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Color Element
Here you can set a primary and a secondary color. The button with the arrows
at it switches the active and the secondary color. And with the pipette you can
pick a color from the screen. This will reveal some more elements, and create a palette. Here you can choose
now the color to use it for painting. You can add and remove colors here too.
This color picker can just pick a color in the 3D view. It does not work elsewhere.

Radius
The Radius edit box allows you to adjust the radius of the brush. The button
behind the edit box enables tablet pressure sensitivity for radius.
And the button at the end allows you to set the radius of the pencil by hotkey. A click at this button works of
course too. But this is a hotkey tool. The button is just a visible reminder.

Strength
The Strength edit box allows you to adjust the strength of the brush. When the
Lock symbol at the front is ticked, then the pencil keeps its strength relative to the
object when zooming in and out. The button behind the edit box enables tablet pressure sensitivity for strength.
And the button at the end allows you to set the strength by hotkey. A click at this button works of course too.
But this is a hotkey tool. The button is just a visible reminder.

Blend
A dropdown box where you can adjust the blend mode of the paint stroke. Default
method is Mix.
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Accumulate
Accumulates stroke daubs on top of each other.

Alpha
When unchecked, lock Alpha while painting.

Use Gradient
When you tick Use Gradient then you reveal a Gradient dialog. Here you can set up a
gradient.
Important!
Painting a gradient requires to have the Fill pencil chosen. It will not work with the other
pencil types.

Gradient Colors dialog
The + Button adds a color ramp point. That way you can have more than one
color in the gradient.

The - Button removes the currently selected color ramp point.
The <> Element flips the color ramp
Color Mode is a dropdown box where you can choose the color mode for the gradient.

Interpolation is a dropdown box where you can choose the interpolation mode for the
gradient.
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In the Color Ramp element you will see the color ramp with the
single color points.
Choose Active Color Stop is the stop point of the gradient.
Position is a edit box where you can fine tune the position of the currently selected color point

Set Color of selected color stop is the color of the currently selected color point. When
you click at it then you will get a color dialog that allows you to setup the color.

Usage
Set up the gradient in the Gradient dialog.
Choose the Fill pencil. Gradient will not work with other
pencils.
Click at the start point of the gradient.
Drag the mouse to the end point of the gradient. This will
draw a line that defines the gradient direction.
Release the mouse.

Palette
When you pick up a color with the color picker then a palette of colors gets created. This color
palette is stored here. You can have more than one palette.
Palettes saves with the scene.
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The icon with the color wheel is a dropdown box where you can choose the
active palette.
The Palette edit box shows you the current active palette. Here you can also rename it.
The number right of it, in this case 2, indicates how much number of users ( internally ) this palette uses. This
means that this data block (the palette) shares currently settings with at least one other object. Most probably
the parent palette where we have created it from. Click at the value to make this palette a single user. The button
will vanish then.
F set the item to have a fake user. Zero user data-blocks are normally not saved. But sometimes you want to
force the data to be kept even when the data block has no user.
The + button allows you to add a new palette with the current settings.
The X button deletes the palette as the active one. You will see the "New" button then. It does NOT delete it
from the palette list.

Texture Panel
The Texture panel allows you to paint with textures. This allows you for example to grab a
foto from some fish scales, and simply paint them onto the mesh by using this image as a
pencil. Or as a blueprint where you calk through ( Stencil method ).
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Browse Texture to be linked
The image at the top of the panel is a image browser. Here you can choose a texture that you
can choose for painting then. You can also have more than one image loaded at once.

In this shot there is already a texture added. The way to add the texture here is a bit more complicated. And not
done with clicking at the New button.
First click at the New button below the image. This will create a new texture slot. This
slot is still empty, it displays black.
We need to load a texture in this slot. This must be done in the Properties editor in the
Textures tab.
The problem is, we have an object with a material and a texture already selected. And
when we change this texture , then we don't get the pencil texture loaded. But we change the texture at our
mesh.

What we need to do is to create a material first.
And in this material we load our pencil texture
then. And then this texture becomes available in
the image browser of the Texture panel.
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Texture Edit box
The Texture edit box is the edit box below the Image browser. When
there's no image loaded then it displays the New button. When there's
a image (or more) loaded, then you will see the name of the current
texture.
The F button turns this texture into a data block with a fake user. Means it will exists
even when there is no data connected to it anymore.
When you activate Fake User, then you may get a value in front of it, which displays
how much users this data block (our texture slot) currently has.
The + Button adds another texture slot. Note that you will have to load a texture too, as explained above.
The X button deletes the texture slot.

Brush Mapping
Our texture can be mapped in different methods. The Brush mapping is a
dropdown box where you can choose this different brush mapping methods.
The settings vary. So we will go through them by the different brush mapping methods.
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Brush Mapping with mapping method Tiled
The brush mapping method Tiled tiles
the brush stroke at the surface. The
mapping happens from the current
view. The result may be distorted
when the view does not align with the
surface of the object.

Angle
The angle of the brush.

Offset
The offset of the texture in the brush.

Size
The size of the texture in the brush.

Brush Mapping with mapping method View Plane
The brush mapping method View
Plane simply paints onto the surface.
The mapping happens from the
current view. The result may be
distorted when the view does not
align with the surface of the object.

Angle
The angle of the brush.

Rake
The angle follows the direction of the brush stroke.

Random
The brush angle gets set random.
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Offset
The offset of the texture in the brush.

Size
The size of the texture in the brush.

Brush Mapping with mapping method 3D
The brush mapping method 3D paints
the texture at the surface, by tiling it
1/1 at the object surface.

Offset
The offset of the texture in the brush.

Size
The size of the texture in the brush.

Brush Mapping with mapping method Random
The brush mapping method Random
paints onto the surface, and
randomizes the texture position in the
brush while that. The mapping
happens from the current view. The
result may be distorted when the view
does not align with the surface of the
object.

Angle
The angle of the brush.

Rake
The angle follows the direction of the brush stroke.

Random
The brush angle gets set random.
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Offset
The offset of the texture in the brush.

Size
The size of the texture in the brush.

Brush Mapping with mapping method Stencil
The former methods uses the textures for the brush. The method Stencil works different. You have your texture
displayed in the workspace above the object, and you paint this texture onto your object with your pencil
strokes.
Note that the texture in the 3d space is just visible when you are with the mouse over the viewport.

Image Aspect
Adjust the stencil size to fit to the image aspect ratio

Stencil Brush controls
Here you can move, rotate and scale the stencil image in the 3D viewport. And reset the
transform. You better use the hotkeys here that gets displayed in the tool tips, since the
image is not displayed when the mouse is not over the 3D viewport.

Angle edit box
Here you can adjust the angle of the brush. The button at the end allows you to set the
radius by dragging the mouse. This should be done in the viewport and with the hotkey.
This button is just a visible reminder.

Offset
Fine tune the offset of the texture in the brush.
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Size
Fine tune the size of the texture in the brush.

Texture Mask Panel
The texture mask panel allows you to use a texture as a mask
to define the strength of painting. In the shot example we use
a tiled Texture as a pencil, and a stencil map as our texture
mask. And it paints just where the mask texture is bright. You
can of course use gradients here to define the paint strength.

Browse Texture to be linked
The image at the top of the panel is a image browser. Here you can choose a texture that you

can choose for painting then. You can also have more than one image loaded at once.
In this shot there is already a texture added. The way to add the texture here is a bit more complicated. And not
done with clicking at the New button.
First click at the New button below the image. This will create a new texture slot. This
slot is still empty, it displays black.
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We need to load a texture in this slot. This must be done in the Properties editor in the Textures tab.
The problem is, we have an object with a material and a texture already selected. And when we change this
texture , then we don't get the pencil texture loaded. But we change the texture at our mesh.
What we need to do is to create a material first. And in this material we load our pencil texture then. And then
we can choose this texture in the image browser of the texture.

Brush Mapping with mapping method Tiled
The brush mapping method Tiled
tiles the brush stroke at the surface.
The mapping happens from the
current view. The result may be
distorted when the view does not
align with the surface of the object.

Mask Pressure Mode
A dropdown box where you can choose the mask pressure mode for tablets.
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Angle
The angle of the brush.

Offset
The offset of the texture in the brush.

Size
The size of the texture in the brush.

Brush Mapping with mapping method View Plane
The brush mapping method View
Plane simply paints onto the
surface. The mapping happens from
the current view. The result may be
distorted when the view does not
align with the surface of the object.

Mask Pressure Mode
A dropdown box where you can choose the mask pressure mode for tablets.

Angle
The angle of the brush.

Rake
The angle follows the direction of the brush stroke.

Random
The brush angle gets set random.

Offset
The offset of the texture in the brush.

Size
The size of the texture in the brush.
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Brush Mapping with mapping method Random
The brush mapping method
Random paints onto the surface,
and randomizes the texture position
in the brush while that. The
mapping happens from the current
view. The result may be distorted
when the view does not align with
the surface of the object.

Mask Pressure Mode
A dropdown box where you can choose the mask pressure mode for tablets.

Angle
The angle of the brush.

Rake
The angle follows the direction of the brush stroke.

Random
The brush angle gets set random.

Offset
The offset of the texture in the brush.

Size
The size of the texture in the brush.

Brush Mapping with mapping method Stencil
The former methods uses the textures for the brush. The method Stencil works different. You
have your texture displayed in the workspace above the object, and you paint this texture onto
your object with your pencil strokes.
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Note that the texture in the 3d space is just visible when you are with the mouse over the viewport.

Mask Pressure Mode
A dropdown box where you can choose the mask pressure mode for tablets.

Stencil Brush controls Secondary
Here you can move, rotate and scale the stencil image from the TEXTURE MASK panel,
And reset the transform. You better use the hotkeys here that gets displayed in the tool tips,
since the image is not displayed when the mouse is not over the 3D viewport.

Angle edit box
Here you can adjust the angle of the brush. The button at the end allows you to set the
radius by dragging the mouse. This should be done in the viewport and with the hotkey.
This button is just a visible reminder.

Offset
Fine tune the offset of the texture in the brush.

Size
Fine tune the size of the texture in the brush.

Stroke Panel
The Stroke panel contains settings to influence the behaviour of the brush stroke. There are various stroke
methods available. We will go through them one by one.
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Stroke Panel with Stroke method Space
This is the default Stroke method. The sculpt stroke gets added continuously with given
settings.

Spacing Edit Box
The sculpt drawing happens by mapping the pencil onto the mouse
position. And when you move the mouse then the next mapping
happens. Here you can adjust the spacing after what mouse
movement the next mapping should happen. The lower the value,
the lower the distance between the single dots.
The icon behind the edit box enables tablet pressure sensitivity for
tablets.

Jitter Edit Box
Here you can add Jitter to the brush while painting.
The icon in front of the edit box toggles between jittering in screen space and relative to brush size.
The icon behind the edit box enables tablet pressure sensitivity for tablets.

Smooth Stroke
The brush lags behind the mouse position, and produces a much smoother stroke by that.

Smooth Stroke Radius Edit Box
Is just active when Smooth Stroke is activated. Here you can adjust the radius of the smoothing.

Smooth Stroke Factor Edit Box
Is just active when Smooth Stroke is activated. Here you can adjust the factor of the smoothing.

Input Samples Edit Box
Average multiple input samples together to smooth the brush stroke.
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Stroke Panel with Stroke method Curve
The Stroke method curve doesn't simply influence the way how the stroke is painted. It is a
special method. First you draw a curve object by holding down ctrl and clicking with left
mouse button. Then you tweak the curve. You can click at the curve point, and drag out
handlers to make the curve points smoooth.
Then you hit the Draw Curve button. And the curve gets drawn onto the surface.

Spacing Edit Box
The drawing happens by mapping the
pencil
onto the mouse position. And when you move the mouse then
the next mapping happens. Here you can adjust the spacing
after what mouse movement the next mapping should happen.
The lower the value, the lower the distance between the single
dots.
The icon behind the edit box enables tablet pressure sensitivity
for tablets.

Paint Curve edit box
Here you set the active curve.
The first element is a dropdown box where you will find your curves objects.
You can have more than one.
The second element is the edit box that displays the active curve.
The number right of it, in this case 2, indicates how much number of users ( internally ) this brush uses. This
means that this data block (the brush) shares currently settings with at least one other object. Most probably the
parent brush where we have created it from. Click at the value to make this brush a single user. The button will
vanish then.
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F set the brush to have a fake user. Zero user data-blocks are normally not saved. But sometimes you want to
force the data to be kept even when the data block has no user.
The + button allows you to add a new pencil with the current settings. Note that the brushes are NOT saved
when you close Bforartists. You can save them into the current blend file. Or you can save the startup file. But
be careful here. This saves everything else of the current state of Bforartists too.
The X button deletes the brush as the active one. It does NOT delete it from the brushes list.

Draw Curve Button
A click at it to turns the curve into a sculpt stroke.

Jitter Edit Box
Here you can add Jitter to the brush while painting.
The icon in front of the edit box toggles between jittering in screen space and relative to brush size.
The icon behind the edit box enables tablet pressure sensitivity for tablets.

Input Samples Edit Box
Average multiple input samples together to smooth the brush stroke.

Stroke Panel with Stroke method Line
With Stroke method line you draw a line between a starting point and a endpoint. And when
you release the mouse then the line gets sculpted.

Spacing Edit Box
The drawing happens by mapping the pencil onto the mouse
position. And when you move the mouse then the next mapping
happens. Here you can adjust the spacing after what mouse
movement the next mapping should happen. The lower the
value, the lower the distance between the single dots.
The icon behind the edit box enables tablet pressure sensitivity
for tablets.

239

Bforartists Reference Manual - © Copyright - This page is Public Domain

Jitter Edit Box
Here you can add Jitter to the brush while painting.
The icon in front of the edit box toggles between jittering in screen space and relative to
brush size.
The icon behind the edit box enables tablet pressure sensitivity for tablets.

Input Samples Edit Box
Average multiple input samples together to smooth the brush stroke.

Stroke Panel with Stroke method Airbrush
The stroke acts like an airbrush pencil. The dots gets placed randomly.

Rate Edit Box
Here you can define the rate of the drawing.

Jitter Edit Box
Here you can add Jitter to the brush while painting.
The icon in front of the edit box toggles between jittering in screen space and relative to brush size.
The icon behind the edit box enables tablet pressure sensitivity for tablets.

Smooth Stroke
The brush lags behind the mouse position, and produces a much smoother stroke by that.

Smooth Stroke Radius Edit Box
Is just active when Smooth Stroke is activated. Here you can adjust the radius of the smoothing.

Smooth Stroke Factor Edit Box
Is just active when Smooth Stroke is activated. Here you can adjust the factor of the smoothing.

Input Samples Edit Box
Average multiple input samples together to smooth the brush stroke.
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Stroke Panel with Stroke method Dots
The stroke method Dots draws dots of the pencil onto the surface. The mapping happens from
the current view. Means you will get distortions when your view is not aligned with the
surface of the object.

Jitter Edit Box
Here you can add Jitter to the brush while painting.
The icon in front of the edit box toggles between jittering in screen space and relative to
brush size.
The icon behind the edit box enables tablet pressure sensitivity for tablets.

Smooth Stroke
The brush lags behind the mouse position, and produces a much smoother stroke by that.

Smooth Stroke Radius Edit Box
Is just active when Smooth Stroke is activated. Here you can adjust the radius of the smoothing.

Smooth Stroke Factor Edit Box
Is just active when Smooth Stroke is activated. Here you can adjust the factor of the smoothing.

Input Samples Edit Box
Average multiple input samples together to smooth the brush stroke.

Curve Panel
The curve panel allows you to define different fallofs methods for the border of the brush.

Navigation elements
The navigation elements at the top are described from left to right

Zoom in and out
The two buttons with the magnifying glass at it zooms in and out in the curve window.
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Tools
Tools is a menu where you can find some cuve related tools.
Reset View
Resets the curve windows zoom
Vector Handle
Set handle type to Vector
Auto Handle
Set handle type to Auto
Auto Clamped Handle
Set handle type to Auto Clamped
Reset Curve
Resets the curve to the initial shape.

Curve Presets
Here you can find some predefined curve presets.

External Panel
The external panel allows you to do projection painting by using an external 2d image editor.
The projection happens from the current view. So this can lead to distortions.

Quick Edit
Opens a shot of the current view in your 2D Image Editor.

Apply
Applies the changes that you made and saved in your 2D Image Editor.

Resolution
Here you can set the resolution of the shot.

Apply Camera Image
Project an edited render from the active camera back onto the object.
This feature requires to have a background image loaded. Then this background image can be projected onto
the object from the camera view.
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Preparations
You first have to link your software that you want to use here. When there is no image editor linked then you
will get a warning.

Open the User Preferences, go to the
File tab. Here choose the Image Editor
section, and browse for your image
editor. I have chosen Gimp here at
Windows 7.

Save User Settings.
For further options have a look in the Project Paint panel in the Options tab in Weight paint mode. There can be
quite a few things adjusted.
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Usage
Click at the Quick Edit Button. And your image editor will open up with a shot from the current view. Modify
your image.

Then overwrite the image. Sorry for the german shot ...
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Back in Bforartists click at the Apply button. And the result gets mapped onto your object.

Symmetry Panel
Here you can turn on/off symmetry painting along X, Y and Z axis. The mirroring happens
along the world axis.
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Tool Shelf in Texture Paint Mode - Slots Tab
The slots tab contains some settings around the paint slots.

Slots Panel
Here you can choose to paint by using the textures in a material. Those textures gets auto detected. Material is
the standard settings.
Or directly onto an image that you choose or create. This image is not part of the material then. But uses the UV
mapping from the mesh.

With painting mode Material
Painting Mode
The dropdown box where you can choose between Material and Image.

Available Paint Slots
The list of available materials. A mesh can have more than one material applied.
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Save all Images
Saves all images at once. This feature requires valid texture paths, means that the images are already saved
somewhere at your pc. It throws a "Invalid Path" warning when one or more images does not have
a valid texture path. This is for example the case when you create a
texture in Blender. And you haven't saved it yet.
So when you get this warning, switch to the UV Image Editor and check
which image in the list isn't saved yet. The ones that aren't saved yet
shows an asterisk in the Header when you choose them.

With painting mode Image
Painting Mode
The dropdown box where you can choose between Material and Image.

Canvas Image
Here you can choose or create a Image that gets used for the texture painting. You can choose
any image that is loaded.

UV Map
A dropdown box with the UV map to use for image painting. A mesh can have more than one material and more
than one UV Map applied.

Save all Images
Saves all images at once. This feature requires valid texture paths,
means that the images are already saved somewhere at your pc. It
throws a "Invalid Path" warning when one or more images does not
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have a valid texture path. This is for example the case when you create a image in Blender's UV Image Editor.
And you haven't saved it to file yet.
So when you get this warning, switch to the UV Image Editor and check which image in the list isn't saved yet.
The ones that aren't saved yet shows an asterisk in the Header when you choose them. Unfortunately not in the
list itself. So you have to go through one by one.

Mask Panel
Here you can load a stencil map to mask out parts of the texture. You have to activate it in the
panel header.

UV Map
A dropdown box with the UV map to use for image painting. A mesh can have more than one
material and more than one UV Map applied.

Stencil Image
Here you can choose or create a Image that gets used for the masking. You can
choose any image that is loaded.

Visualization
You usually want a black n white image for masking. But here you can set up the color
for the stencil map. A click at the button opens a color dialog. The button at the right
flips the colors.
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Tool Shelf in Texture Paint Mode - Options Tab
Here you can find some more options and settings for texture painting tools.

Overlay Panel
Curve
This setting is interesting for the Stroke method Curve. Here you can adjust how transparent
the curve is.
The eye icon button in front of the slider is to show the curve object in viewport. The brush
icon button behind the slider is to hide the overlay during a stroke.

Texture
This setting is interesting for Texture painting. Here you can adjust how transparent the texture is.
The eye icon button in front of the slider is to show the texture in the viewport. The brush icon button behind
the slider is to hide the overlay during a stroke.

Mask Texture
This setting is interesting for Texture painting. Here you can adjust how transparent the Mask texture is.
The eye icon button in front of the slider is to show the texture in the viewport. The brush icon button behind
the slider is to hide the overlay during a stroke.

Appearance panel
The Appearance panel provides you with some settings to adjust the appearance of the brush.

Show Brush
Show the brush in 3D view.

Color Button
The color that the brush cursor has when adding to geometry.
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Custom Icon
Here you can define a custom icon for the brush.

Project Paint panel
The Project Paint panel contains the settings for the External painting panel
from the Tools tab.

Occlude
Only paint the faces directly under the mouse

Cull
Ingore faces that points away from the current view.

Normal
This defines the angle after which the painting is not applied anymore. That way you can avoid heavy
distortions at higher angles since it projects from the current view.

Cavity Mask
Mask painting according to mesh geometry cavity

Bleed
An edit box to adjust the amount of bleeding into the areas outside of the faces uv.

Dither
An Edit box to adjust the amount of dither when painting on byte images

Unified Settings
Size
Instead of per Brush radius, the radius is shared across brushes.

Strength
Instead of per Brush strength, the strength is shared across brushes.

Color
Instead of per Brush color, the color is shared across brushes.
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Enabled Brush Modes
Enabled Modes
Enabled modes is a dropdown menu where you can adjust in which modes the brushes
shows.

Tool shelf in Particle edit mode - Tools Tab
The particle edit mode requires to have a particle system at the object.

Tools Panel
This panel contains tools to modify the particles.

Mirror
Mirrors the selected particles.
If you want a symmetrical haircut, first select all particles, then mirror the particles, then
tick X Mirror in the Particle panel.

Remove Doubles
Remove double vertices that are very close to each other. This can for example happen when you mirror the
particles.
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Unify Length
Unifies the length of the selected hair particles. The length is calculated by the average length of the selection.

Rekey
You need to have some hair particles selected.
Rekey changes the number of keys for the selected particles, including root
and tip keys. This tool brings up a popup where you can adjust the number
of keys. Two means you have only a root and a tip key. Everything more
subdivides the selected hair particle with more keys.

Last Operator Rekey
Number of keys
Here you can again adjust the number of keys.

Weight Set
Here you can manually set a weight for the selected keys to interpolate
between the current key weight and the brushes weight.
Using this tool activates and reveals Free Edit in the particle system
settings.

Last Operator Weight Set
Factor
The strength of the keys weighting.

Brush Panel
The Brush panel contains brushes to modify the particles in various ways. Dependant of
what brush is selected you will also see some settings below the brush buttons.
The brushes are meant for the particle system type Hair.

None
No Brush is selected
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Comb
Allows you to comb the strands of the particle system.

Radius
The brush radius. The button behind the edit box allows you to set the radius by mouse move. This is a hotkey
tool, and should be performed in the viewport.

Strength
The brush strength. The button behind the edit box allows you to set the radius by mouse move. This is a hotkey
tool, and should be performed in the viewport.

Smooth
Allows you to smooth the strands of the particle system.

Radius
The brush radius. The button behind the edit box allows you to set the radius by mouse move. This is a hotkey
tool, and should be performed in the viewport.

Strength
The brush strength. The button behind the edit box allows you to set the radius by mouse move. This is a hotkey
tool, and should be performed in the viewport.

Add
Allows you to add strands to the particle system.

Radius
The brush radius. The button behind the edit box allows you to set the radius by mouse move.
This is a hotkey tool, and should be performed in the viewport.

Count
The amount of strands.

Interpolate
Interpolate new particles from the existing ones.

Steps
Brush steps. Steps is connected with Interpolate.

Keys
How many keys to make new particles with
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Length
Manipulate the length of the strands

Radius
The brush radius. The button behind the edit box allows you to set the radius by mouse move. This is a hotkey
tool, and should be performed in the viewport.

Strength
The brush strength. The button behind the edit box allows you to set the radius by mouse move. This is a hotkey
tool, and should be performed in the viewport.

Grow/ Shrink
Grow or shrink the particles.

Puff
Manipulate the volume of the strands.

Radius
The brush radius. The button behind the edit box allows you to set the radius by mouse move. This is a hotkey
tool, and should be performed in the viewport.

Strength
The brush strength. The button behind the edit box allows you to set the radius by mouse move. This is a hotkey
tool, and should be performed in the viewport.

Add / Sub
Add or subtract to the current volume.

Puff Volume
Apply Puff to unselected end points.

Cut
Cut away particles.
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Radius
The brush radius. The button behind the edit box allows you to set the radius by mouse move. This is a hotkey
tool, and should be performed in the viewport.

Strength
The brush strength. The button behind the edit box allows you to set the radius by mouse move. This is a hotkey
tool, and should be performed in the viewport.

Weight
Manipulate the weight of the strands

Radius
The brush radius. The button behind the edit box allows you to set the radius by mouse move. This is a hotkey
tool, and should be performed in the viewport.

Strength
The brush strength. The button behind the edit box allows you to set the radius by mouse move. This is a hotkey
tool, and should be performed in the viewport.

Options Panel
The Options panel provides you some options and settings for particle editing.

Particle Edit Type
Particle Edit Type Dropdown box.
Honestly, i don't have the slightest idea what this is good for. Thanks Blender Devs for
your "fabulous" documentation.
Most obviously you can switch to other editing modes here. But it is not to find out under
what circumstances.

Deflect Emitter
Keep Paths from intersecting the emitter

Distance
Is connected with the Deflect Emitter. The distance to the emitter.

Keep Lengths
Keep Path Lengths constant.
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Keep Root
Keep Root keys unmodified.

X Mirror
X Axis Mirror Editing

Shape
Define a outer shape object to use for tools.

Shape Cut
Is connected with Shape, Cut hair to conform to the defined shape object.

Draw Path Steps
How many steps a path should draw.

Children
Draw actual particles.

Tool Shelf in all Modes but Edit Mode
There are a few panels that are visible in all modes and with all object types. Snapping for example. Or layers.
To list them again and again in all modes with all available combinations would just blow up the manual. So we
list them in the following chapters instead.

Tool Shelf in all Modes but Edit Mode - Layers Tab
Layers are a way to organize the scene. With Object layers you can display objects from a
layer, and hide others. Physics and particles is also layer dependant. Means you can exclude
objects from physics by simply putting them onto another layer. You can also in- or exclude
complete layers from rendering. For compositing you can use render layers. And for
armatures you can use Armature layers.
A object does not necessarily have to be at one layer only. You can place it at multiple
layers.
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Bforartists offers currently 20 layers. Which can be named in the Layers tab.
The layers tab is available in all modes but the Edit mode. And shows for all object types the same content.

Layer Manager Panel
The layer manager panel gives you the tools to manage the layers in a quick way.

Move to Layer
The move to Layer button opens a pop-up where you can move
the currently selected object to a new layer.
Shift click to add the selected object(s) to more than one layer.

Last Operator Move to Layer
The last operator Move to Layer gives you again the possibility to move your selected
object(s) to a new layer.

Visible Layers
Visible layers is a quick access element to manage the layers and to have an
overview if the layer has any content. A orange or grey dot in the button means
there is content in this layer.
Visible is what is activated. Active layers gets indicated as blue. To select more than one layer hold down shift,
and select the other elements that you want to select.

Lock Camera and Layers
With Lock camera and layers activated the active camera and layers in this view gets used instead
local layers. Means the camera renders all layers then.

Show Hide all Layers
Show Hide all Layers shows or hides all layers at once.
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Named Layers Panel
The named layers panel gives you an extended overview of the layers, with the
possibility to give the layers a name.

Options
The options are hidden at first. Click at the Options title to reveal them.

Classic
The classic option shows the eye icon for the layer visibility grey instead blue.

Options
The Options option shows the option buttons at the layers. Select, Lock, Move
to Layer, Show as Wire.

Indices
The Indices option shows numbers before the layers.

Hide Empty
The Hide Empty option hides all not active layers.

Layer Bar
The layer bar in the Named Layers tab is made of some sub elements.

Eye icon at the left
You can show or hide the layer with this button.

Edit box
The edit box is where you can name a layer. Click with the left mouse into the edit box to
make it editable. Type in your text. Then press enter to confirm the change.
The green check icon tells you that this is the currently active layer.

The option buttons
When you have Options ticked then you will see the options buttons at the right of the edit
box. They are from left to right: Select, Lock, Move to Layer, Render as Wire
Select
Clicking at the Select icon button will select all objects in this layer.
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Lock
Clicking at the Lock icon button will lock all objects in this layer. They become unelectable.
Move to Layer
With this button you can move objects to other layers. Select the object, click at the Move to Layer button. Shift
click to attach the object to several layers.
Render as Wire
Render as wire will toggle the display for all objects between chosen state and wireframe.

Layer Groups Panel
The Layer groups panel enables you to create groups of layers. It is pretty self explaining.
Create a group with the + button. Name it. And activate which layers are affected by this
group by clicking at the corresponding fields in the layers widget.
To remove a layer group select the group and click at the - Button

Tool Shelf in all Modes - Grease Pencil Tab
The Grease Pencil tool is a tool with which you can paint strokes in
editors like the 3D view. They can be converted into polygons. The
Grease Pencil tool is available in all modes.
It is unfortunately cluttered across two shelves. The Tool Shelf and
the Properties Editor. Means you have to adjust settings at two
places.
The first thing that you have to do is to create a new Grease pencil.
This can either be done in the Properties Editor by clicking at New.
Or in the Grease Pencil Tab in the Tool Shelf by simply clicking at
the Draw button. Then all Grease Pencil tools becomes visible. And
a Grease Pencil layer gets created.

Grease Pencil Panel
The Grease Pencil panel contains the general Grease Pencil tools. The Draw tool, eraser,
some settings and tools.
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Draw
The Draw section contains the draw tools.

Draw
Draw activates the freehand draw mode.

Erase
Erase is the eraser tool with which you can delete strokes.

Line
Line paints a straight line between start and end point.

Poly
Poly allows you to paint polygon shapes.

Eraser Radius
Here you can adjust the radius of the eraser tool. Have a look at the hotkey, it's a hotkey only tool for proper
functionality.

Insert Blank Frame
Insert a blank frame on the current frame.

Delete all active frames
Delete the active frame(s) of all editable grease pencil layers.

Draw Settings
The draw settings are placed besides each other, to save space.

Additive Drawing
When you create new frames then the strokes from the previous active frame are included as the base for the
current frame.
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Continuous Draw
The Continuous Draw checkbox enables and disables the continuous draw mode. Normally the draw mode ends
when you stop drawing the current line. And you have to activate the draw tool again when you want to
continue with painting. With continuous draw you can immediately paint the second stroke without to enable
the draw tool again.
Eraser in Continuous Draw
The draw tools are disabled as long as you are in continuous draw. To erase a stroke use the
right mouse button. The pencil turns into a red circle. With which you can erase strokes
now.
End Continuous Draw
The draw tools are disabled as long as you are in continuous draw. To end the continuous
draw mode click outside of the viewport. In the tool shelf for example.

Draw on Back
New strokes will be drawn behind all other strokes in the layer

Data Source
Data source defines if the paint stroke is placed in the data block of the scene or the data
block of the currently selected object.

Stroke Placement
Stroke Placement defines where the Grease Pencil stroke is placed.

View
View will place the stroke at the top of the viewport. It is not drawn in the 3D view.

Cursor
Cursor will place the stroke aligned with the 3d cursor, and aligned with the current camera view. It is drawn in
the 3D view.

Surface
Surface will place the stroke aligned to the surface of the underlying object. It is drawn in the 3D View.

Stroke
New strokes will align to existing visible strokes. Does not work with View strokes. It is drawn in the 3D View.
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Only Endpoints
The only Endpoints checkbox is connected to the Stroke setting. And just shows when Stroke is selected. With
Only Endpoints enabled the alignment of the stroke is just applied to the endpoints.

Tools
The Tools section contains one tool. Ruler/Protractor. It activates a ruler protractor tool with
which you can measure distances.

Edit Strokes
Sometimes you want to edit the strokes that you
have placed. Edit Strokes is a mode of the 3D
view. And can be entered in the header of the 3d
view in the modes drop-down box.
When you are in Edit Strokes mode, then you
will see the Edit Strokes Panel. Where you will
find the tools to edit the Grease Pencil strokes.

Edit Strokes Panel
The Edit Strokes Panel contains the tools to edit the Grease Pencil strokes.
Most of the tools are pretty self explaining.
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Note!
The Edit Strokes Panel is just visible in Edit Strokes
Mode!

Toggle Cyclic
Toggle Cyclic closes a stroke to become a loop.
Last operator Set Cyclical State
The Last operator for Toggle cyclic contains a drop-down box where you can adjust the
cyclic state.

Mirror
Mirror mirrors the selection.
Last Operator Mirror
The Last Operator Mirror panel gives you tools to adjust the mirror action.
Constraint Axis
Constraint Axis gives you again the possibility to define the mirror axis. You can choose
more than one axis here.
Orientation
Orientation is a drop-down box where you can choose the type of orientation for the
mirroring action.
Proportional Editing
Proportional Editing is a drop-down box where you can choose to use proportional editing.
When you choose one of the active methods then the neighbour geometry gets influenced by
Shrink/Fatten too in a proportional way.
Proportional Editing Falloff
Proportional Editing Falloff is a drop-down box where you can choose a method for the
falloff for the proportional editing.
Proportional size
Proportional size is a edit box where you can adjust the strength of the Proportional
falloff.
Edit Grease Pencil
Edit Grease Pencil edits the selected Grease Pencil strokes.
Confirm on Release
With Confirm on Release checked the action gets performed when you release the mouse
button.
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Shrink / Fatten
Shrink / Fatten shrink fattens the selection.

Bend
Bend bends the selection.
Last Operator Bend
The last operator Bend is disabled for Grease Pencil.

Shear
Shear shears the selection.
Last Operator Shear
Offset
Adjust the offset
Proportional Editing
Proportional Editing is a drop-down box where you can choose to use proportional editing.
When you choose one of the active methods then the neighbour geometry gets influenced
by Shrink/Fatten too in a proportional way.
Proportional Editing Falloff
Proportional Editing Falloff is a drop-down box where you can choose a method for the
falloff for the proportional editing.
Edit Grease Pencil
Edit Grease Pencil edits the selected Grease Pencil strokes.
Confirm on Release
With Confirm on Release checked the action gets performed when you release the mouse
button.

To Sphere
To Sphere transforms the selection into a spherical form.
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Last Operator To Sphere
Factor
Adjust the rounding factor
Proportional Editing
Proportional Editing is a drop-down box where you can choose to use proportional editing.
When you choose one of the active methods then the neighbour geometry gets influenced
by Shrink/Fatten too in a proportional way.
Proportional Editing Falloff
Proportional Editing Falloff is a drop-down box where you can choose a method for the
falloff for the proportional editing.
Proportional Size
Adjust the proportional size
Edit Grease Pencil
Edit Grease Pencil edits the selected Grease Pencil strokes.
Confirm on Release
With Confirm on Release checked the action gets performed when you release the mouse
button.

Move to Color
Recolors the currently selected grease pencil stroke with the
active color in the Grease Pencil Colors color.
The grease pencil colors can be found in the properties sidebar
at the right.

Arrange Strokes drop-down box
Arrange the layering of the current stroke.

Subdivide
Subdivide subdivides the current selection.
Last Operator Subdivide Stroke
Number of Cuts
Adjust the number of subdivisions
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Join
Joins strokes.
Last Operator Join Strokes
Type
Here you can choose if it should only join, or join and also copy the strokes.
Leave Gaps
Leave Gaps between joined strokes instead of linking them.

Join & Copy
Joins strokes and copies it.
For last operator see above.

Flip Direction
Change the direction of the stroke.

Show Directions
Shows the direction of the stroke by displaying a green dot at the beginning, and a red dot at the end of the
stroke.

Re project Strokes Drop-down Box
Here you can re project the stroke(s) planar or across the surface of the target object as if you
would have drawn it new to the current viewport.

Interpolate Panel
The Interpolate Panel provides some tools for interpolation between different animation frames.
Note!
The Interpolate Panel is just visible in Edit Strokes
Mode!

Interpolate
Interpolate Grease Pencil Strokes between frames.
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Sequence
Generate In-Betweens for smooth interpolation between Grease Pencil Frames.

Remove Breakdowns
Remove Breakdown Frames generated by interpolation between two Grease Pencil frames.

Interpolate all Layers
Interpolate all layers, not only active

Interpolate selected Strokes
Interpolate only selected strokes in the original frame

Sequence Options, Type
Sequence Options, Type is a drop-down box where you can
choose between three different effect types. Interpolation,
Easing and Dynamic Effects. You can get even more options, depending of the type you choose here.

Sculpt Strokes Panel
The Sculpt Strokes Panel provides tools to sculpt the Grease pencil strokes.

Note!
The Sculpt Strokes Panel is just visible in Edit Strokes
Mode!

Sculpt Strokes Button
The Sculpt Strokes Button activates the Sculpt brush. Now you can sculpt the Grease Pencil stroke with left
mouse button. Clicking with right mouse button ends the sculpt mode.

Radius
The radius of the sculpt brush.
The button behind the edit box allows you to set the radius by moving the mouse. This should be done in the
viewport and with the hotkey. This button is just a visible reminder.

Strength
The strength of the sculpt brush.
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The button behind the edit box allows you to set the strength by moving the mouse. This should be done in the
viewport and with the hotkey. This button is just a visible reminder.

Use Falloff
Defines if the brush has a falloff from the centre to the border of the pencil.

Position
The Brush affects the position of the point.

Strength
The Brush affects the strength of the point.

Thickness
The Brush affects the thickness of the point.

Selection Mask
Only sculpt the selected points.

Alpha
Alpha value for selected vertices.

Affect Pressure
Affect pressure values as well when smoothing strokes.

Drawing Brushes panel
The Drawing Brushes panel contains everything around the Brushes and their settings. It is visible in all modes.
But the content just shows when you have activated the draw tool already.

Brushes selection box
Here you can choose different brush types. At the right you can add and remove
brushes. And you can sort the brushes order.

Thickness
Defines the thickness of the stroke.

Sensitivity
Pressure sensitivity for new strokes.
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Strength
Color strength for new strokes. The alpha factor of the color is affected.

Randomness
Randomness factor for pressure and strength of new strokes.

Jitter
Jitter factor for new strokes.

Angle
Direction of the stroke at which the brush gives the maximum thickness.

Factor
Reduce Brush thickness by this factor when stroke is perpendicular to angle direction

Smooth
Amount of smoothing to apply to newly created strokes to reduce jitter / noise.

Iterations
Number of times to smooth newly created strokes.

Subdivision
Number of times to subdivide newly created strokes, for less jagged strokes.

Randomness
Randomness factor for new strokes after subdivision.

Brush Curves Panel
The Brush curves panel is meant for usage with tablets. Here you can manipulate the curves
for Sensitivity, Strength and Jitter.

Tool Shelf in all Modes - Tools Tab - Snap panel
Snap Panel
The Snap panel contains the snapping tools.
The one half snaps a selected element to ...
The other half snaps the 3D cursor to ...
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In Edit Mode with Mesh object you will
also have the Snap to Symmetry tool
here.

Selection to Grid
Selection to Grid snaps the selected element(s) to the closest Grid point.

Selection to Cursor
Selection to Grid snaps the selected element(s) to the 3D cursor. ALL selected elements will end at cursor
position. For example all selected vertices.

Selection to Cursor ( Offset )
Selection to Grid snaps the selected element(s) to the 3D cursor. The centre of the selected elements will snap to
the 3D cursor. A group of vertices for example will remain its shape.

Selection to Active
Selection to Active snaps the selected element(s) to the current active element.

Cursor to Selected
Cursor to Selected snaps the 3D cursor to the selected element.

Cursor to Centre
Cursor to Centre snaps the 3D cursor to the centre of the world.

Cursor to Grid
Cursor to Grid snaps the 3D cursor to the closest Grid point.

Cursor to Active
Cursor to Grid snaps the 3D cursor to the current active element.

Snap to Symmetry
Tries to snap the selected vertices symmetrical along the chosen world orientation.
Last Operator Snap to Symmetry
Direction
The calculation direction.
Threshold
The threshold defines the radius in which matching vertices gets located. When you get a
warning that snapping failed try increasing the threshold value.
Factor
The snapping factor. Blend mirrored locations from one side to the other. 0.5 is blending both sides equal.
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Center
Snap vertices in the center axis to zero.

Tool Shelf in all Modes - Tools Tab - Transform panel
Transform is a menu that contains some special
transform functionality. It exists in all modes.
But is not functional in all modes.
In Edit Mode with a mesh object we have a few
more options. For armatures we have some
tools fewer, and one more. Align Bones.
Set dimensions is an addon meant for Mesh
Objects in Edit Mode. Using it will lead you to
Edit mode.
In Object mode some tools requires to have more than one object selected. To Sphere for example.

To Sphere
To Sphere tries to transform the selection to a sphere shape, using the center of the selected objects as a center
point for the operation.

While the operation you will see in the header the strength value for the spherical shape.

Last Operator To Sphere

Factor
A edit box where you can adjust the strength of influence of the tool.
Proportional Editing
Proportional Editing is a drop-down box where you can choose to use proportional editing.
When you choose one of the active methods then the neighbour geometry gets influenced
by Shrink/Fatten too in a proportional way.
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Proportional Editing Falloff
Proportional Editing Falloff is a drop-down box where you can choose a method for the
falloff for the proportional editing.
Proportional Size
Proportional size is a edit box where you can adjust the strength of the Proportional
falloff.
Edit Grease Pencil
Edit Grease Pencil edits the selected Grease Pencil strokes.

Shear
Shear shears the object positions relative to the center of the selection.
While the operation you can press x or y to change the direction of shearing.
While the operation you will see the strength value in the header.

Last Operator Shear

Factor
A edit box where you can adjust the strength of influence of the tool.
Proportional Editing
Proportional Editing is a drop-down box where you can choose to use proportional editing.
When you choose one of the active methods then the neighbour geometry gets influenced
by Shrink/Fatten too in a proportional way.
Proportional Editing Falloff
Proportional Editing Falloff is a drop-down box where you can choose a method for the
falloff for the proportional editing.
Proportional Size
Proportional size is a edit box where you can adjust the strength of the Proportional
falloff.
Edit Grease Pencil
Edit Grease Pencil edits the selected Grease Pencil strokes.
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Bend
Bends the selected objects between 3D cursor and mouse.
HOTKEY ONLY TOOL!
You might want to add/use a hotkey here, since the operation calculates from the mouse position starting point.
And the menu item might not be at the wanted position.
While the operation you will see in the header the strength value for the bend.
Holding down Alt turns off Clamp.
The Last operator for Bend is greyed out. Undo is not supported.

Push/Pull
In Object mode this tool requires to have more than one object selected. It pushes or pulls the object positions
relative to the center of the selection.

Last Operator Shear

Factor
A edit box where you can adjust the strength of influence of the tool.
Proportional Editing
Proportional Editing is a drop-down box where you can choose to use proportional editing.
When you choose one of the active methods then the neighbour geometry gets influenced
by Shrink/Fatten too in a proportional way.

Proportional Editing Falloff
Proportional Editing Falloff is a drop-down box where you can choose a method for the
falloff for the proportional editing.
Proportional Size
Proportional size is a edit box where you can adjust the strength of the Proportional
falloff.
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Move Texture Space
This tool relies at the move tool. With the difference that it moves the texture space
instead of the object. It has also a very special use case, and just works with a
material with a Texture Coordinate / Generated node. And requires to have the
shading at Material or Rendered to see a result in the viewport.

Last Operator Translate
Vector
Here you can adjust the position values for the three axis.
Constraint Axis
Here you can limit the position relative to the source object.
Orientation
Orientation is a drop-down box where you can choose the type of orientation for the
mirroring action.
Proportional Editing
Proportional Editing is a drop-down box where you can choose to use proportional editing.
When you choose one of the active methods then the neighbour geometry gets influenced
by Shrink/Fatten too in a proportional way.

Proportional Editing Falloff
Proportional Editing Falloff is a drop-down box where you can choose a method for the
falloff for the proportional editing.
Proportional Size
Proportional size is a edit box where you can adjust the strength of the Proportional
falloff.
Edit Grease Pencil
Edit Grease Pencil edits the selected Grease Pencil strokes.
Edit Texture Space
With Confirm on Release checked the action gets performed when you release the mouse button.
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Scale Texture Space
This tool relies at the scale tool. With the difference that it scales the texture space
instead of the object. It has also a very special use case, and just works with a
material with a Texture Coordinate / Generated node. And requires to have the
shading at Material or Rendered to see a result in the viewport.

Last Operator Resize Texture
Vector
Here you can adjust the position values for the three values
Constraint Axis
Here you can limit the position relative to the source object.
Orientation
Orientation is a drop-down box where you can choose the type of orientation for the
mirroring action.

Proportional Editing
Proportional Editing is a drop-down box where you can choose to use proportional editing. When you choose
one of the active methods then the neighbour geometry gets influenced by Shrink/Fatten
too in a proportional way.
Proportional Editing Falloff
Proportional Editing Falloff is a drop-down box where you can choose a method for the
falloff for the proportional editing.
Proportional Size
Proportional size is a edit box where you can adjust the strength of the Proportional
falloff.
Edit Grease Pencil
Edit Grease Pencil edits the selected Grease Pencil strokes.
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Edit Texture Space
With Confirm on Release checked the action gets performed when you release the mouse button.

Align to Transform Orientation
Rotates the selected objects so that their local orientation
matches the active transform orientation in the Transform
orientation panel or the Orientation selection in the
Transform Operator panels.
For example when you have a few cubes that are rotated
differently, then perform align to transform orientation with
Global coordinates, then the cubes rotations gets set back to 0/0/0

Last Operator Transform
Align Transform Orientation is a subset of the Transform tool. And so it
comes with the full set.
Values
The transform values for the single axis.
Constraint Axis
Here you can limit the transform of single axis.
Orientation
Orientation is a drop-down box where you can choose the type of orientation for the
mirroring action.
Proportional Editing
Proportional Editing is a drop-down box where you can choose to use proportional editing.
When you choose one of the active methods then the neighbour geometry gets influenced
by Shrink/Fatten too in a proportional way.

Proportional Editing Falloff
Proportional Editing Falloff is a drop-down box where you can choose a method for the
falloff for the proportional editing.
Proportional Size
Proportional size is a edit box where you can adjust the strength of the Proportional
falloff.
Edit Grease Pencil
Edit Grease Pencil edits the selected Grease Pencil strokes.
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Randomize Transform
This tool allows to randomize position rotation
and scale of selected objects. Each object gets
threaten individually by a random value.
It starts with zeroed values. You need to adjust the
values in the last operator.

Last Operator Randomize Transform
Random Seed
Here you can adjust the random seed value.
Transform Delta
Randomize Delta transform values instead of the regular transform values.
Randomize Location checkbox
With this checkbox ticked the location of the selected objects gets randomized.
Location edit boxes
Here you can adjust the strength of the transform for the single axis.
Randomize Rotation checkbox
With this checkbox ticked the rotation of the selected objects gets randomized.
Rotation edit boxes
Here you can adjust the strength of the transform for the single axis.
Randomize Scale checkbox
With this checkbox ticked the scale of the selected objects gets randomized.
Scale Even
Use the same scale values for all axis.
Scale edit boxes
Here you can adjust the strength of the transform for the single axis.

Align Objects
Align Objects allows you to align the selected objects in various ways. You need to adjust
the settings in the Last operator panel. The align operation happens in world coordinates.
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Last Operator Align Objects
High Quality
When ticked the calculation gets performed in a higher precision.
Align Mode
Align Mode is a drop-down box where you can choose between different align modes.
Relative To
Relative to is a drop-down box. Here you adjust in what method the alignment happens.
Relative to the active object, to the center of selection, to the 3D cursor or to the scene origin.
Align
Here you can turn on or off the single axis for the align operation.

Warp
Edit Mode only! Warps the selected vertices around the 3D cursor.

Last Operator Warp
Warp Angle
The amount to wrap around the 3D cursor.
Offset Angle
Angle to use as the basis for warping
Min
The minimum amount
Max
The maximum amount

Randomize
Edit Mode Only! Randomizes the positions of the selected vertices.

Last Operator Randomize
Amount
The distance to offset.
Uniform
Increase for uniform offset distance.
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Normal
Align Offset direction to normals.
Random Seed
The seed for the random number generator.

Skin Resize
This tool requires to have a skin modifier at the mesh. It scales the
thickness of the skin.
While the operation you will see in the header the strength value for the
skin.

Last Operator Skin Resize

Vector
Here you can adjust the position values for the three values.
Constraint Axis
Here you can limit the position relative to the source object.
Orientation
Orientation is a drop-down box where you can choose the type of orientation for the
mirroring action.
Proportional Editing
Proportional Editing is a drop-down box where you can choose to use proportional editing.
When you choose one of the active methods then the neighbour geometry gets influenced
by Shrink/Fatten too in a proportional way.
Proportional Editing Falloff
Proportional Editing Falloff is a drop-down box where you can choose a method for the
falloff for the proportional editing.
Proportional Size
Proportional size is a edit box where you can adjust the strength of the Proportional
falloff.
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Align Bones
Armature only.
Align bones aligns the selected bones.

Set Dimensions
Edit Mode Only!
Normally all scale operations in Bforartists are relative to the
current selection and dimensions. Set dimensions allows to scale
mesh selections in absolute world values. No matter how the
initial values are. The new values gets set in the Last Operator.
Set dimensions is an add-on. You can turn it off in the add-ons
section of the user preferences when you want.

Last Operator Set Dimensions
New Dimensions
When you activate the tool then you will see the world coordinates of the selection. Here you can change the
values to other world coordinates.

Tool Shelf in all Modes - Tools Tab - History Panel
History Panel
The History Panel contains the tools around undo , redo and repeat. It is in the
Tools tab.

Undo
Undo undoes the previous action.

Redo
Redo redoes the previous action.

Undo History
Undo History opens a menu where you can redo a last action in history.

Repeat last
Repeat last repeats the last operation. For example, when you have moved a object by 5 in x,
then it moves the object by 5 in x with every new repeat last step.
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Repeat History
Repeat History calls a menu with the last actions where yon can choose an action to be
repeated.

Tool Shelf in all Modes - Tools Tab - Bake Panel general
Bake Panel
Texture baking is the process to bake specific informations from one object
into the texture or the vertex colors of another object. Ambient Occlusion. Or a
Normal Map for example.
NOTE
Baking requires to have a working UV mapping and a texture at the
target object!

How to use: Select the source object where you want to bake from, hold down Shift, select the target object
where you want to bake to, so that both objects are selected. Adjust the settings to your needs. Then hit the
Bake button.
Texture baking can be done with two available render engines. Blender
Internal. And Cycles. The list of available bake types differs a bit, even
when some of the texture types are similar.
Which renderer gets used for baking can be adjusted in the Properties
Editor.
When you have the Blender Render selected then the Bake Panel is
called Bake Blender Render. When you have the Cycles Render selected then the Bake Panel is called Bake
Cycles.

NOTE
The Bake panel is visible in all Modes. But you have to bake in Object Mode.

Tool Shelf in all Modes - Tools Tab - Bake Blender Render
When you have Blender Renderer selected then the Bake panel will show the settings to bake with Blender
Render.
Texture baking uses the settings of the chosen renderer. This includes Antialias, Global Illumination, Ambient
Occlusion, etc.
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Settings for all Texture types
Most settings in the Bake panel are available for all texture types.
Bake
The Bake Button will start the baking process.

Bake Mode
Bake Mode is a drop-down box where you can choose what type of information you want to bake from the
source object into the texture or the vertex colors of the target object.

You can bake Specular Colors, Specular Intensity, Mirror Colors, Mirror Intensity, Alpha,
Emission, Vertex Colors, Derivate, Displacement, Textures, Normals, Shadow, Ambient
Occlusion and Full Render.
Specular Colors
Bakes the specular colors of a material into the texture of the target object.
Specular Intensity
Bakes the specular intensity of a material into the texture of the target object.
Mirror Colors
Bakes the Mirror colors into the texture of the target object.
Mirror Intensity
Bakes the Mirror Intensity of a material into the texture of the target object.
Alpha
Bakes the Alpha channel colors of a material into the texture of the target object.
Emission
Bakes the Emission colors of a material into the texture of the target object.
Vertex Colors
Bakes the Vertex colors of the source object into the texture of the target object.
Derivate
Bakes the Derivate colors of a material into the texture of the target object.
Displacement
Creates a displacement map by using the vertex positions of the source object, and baking them as greyscale
colors into the texture of the target object.
Textures
Bakes the texture colors of the source object into the texture of the target object.
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Normals
Creates a Normal map by using the normals of the source object, and baking them as colors into the texture of
the target object.
Shadow
Bakes the Shadow into the texture of the target object.
Ambient Occlusion
Bakes the Vertex colors of the source object into the texture of the target object.
Full Render
Bakes the full rendering, means materials, textures, lightning, into the texture of the target object.

Selected to Active
The usual way to bake is first select the Source Object, where you want to bake from, hold down Shift, select
the target object where you want to bake to, so that both objects are selected. Then hit the Bake button. That's
Selected to Active.
Bake to Vertex Color
Usually bake bakes into the texture of the target object. Bake to Vertex Color bakes the information into the
Vertex colors of the mesh instead into the texture.

Clear
Clear clears the target image before baking.
Split
Here you can adjust the Quad Split method for baking.
Margin
Adjust the margin width.
Distance
Maximum Distance in Blender Units from source object to target object(s).
Bias
Bias in Blender Units towards faces further away from the object(s).

Settings for specific Texture types
Derivative
Bake from Multires
Bake directly from Multires mesh.
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User
Here you can apply a user scale to the derivate map instead of automatically normalizing to 0-1.

Displacement
Bake from Multires
Bake directly from Multires mesh.
Normalized
Normalizes to the Distance.

Normals
Bake from Multires
Bake directly from Multires mesh.
Normal Space
Normal Space is a drop-down box where you can choose what normals to calculate.

Ambient Occlusion
Bake from Multires
Bake directly from Multires mesh.
Normalized
Normalizes without using material settings.

Tool Shelf in all Modes - Tools Tab - Bake Cycles
When you have Cycles as the Renderer selected then the Bake panel will show the settings to bake with Cycles
Render.
Texture baking uses the settings of the chosen renderer. This includes Antialias, Global Illumination, Ambient
Occlusion, etc.
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Settings for all Texture types
Most settings in the Bake panel are available for all texture types.
Bake
The Bake Button will start the baking process.

Bake Type
Bake Mode is a drop-down box where you can choose what type of information you want to
bake from the source object into the texture or the vertex colors of the target object.

You can bake Subsurface, Transmission, Glossy, Diffuse, Environment, Emit, UV, Normal,
Shadow, Ambient Occlusion and Combined.
Subsurface
Bakes the Subsurface Passes of a material into the texture of the target object.
Transmission
Bakes the transmission Passes of a material into the texture of the target object.
Glossy
Bakes the Glossy Passes of a material into the texture of the target object.
Environment
Bakes the Environment texture into the texture of the target object. As seen from the center of the object.
Emit
Bakes the Emission or the glow color of a material into the texture of the target object.
UV
Bakes colors of materials and textures only, without shading.
Normals
Creates a Normal map by using the normals of the source object, and baking them as colors into the texture of
the target object.
Shadow
Bakes the Shadow into the texture of the target object.
Ambient Occlusion
Bakes ambient occlusion as specified in the World panels. Ignores all lights in the scene.
Combined
Bakes the full rendering, means materials, textures, lightning, into the texture of the target object. Except
Specularity.
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Margin
Adjust the margin width.
Clear
Clear clears the target image before baking.
Selected to Active
The usual way to bake is first select the Source Object, where you want to bake from, hold down Shift, select
the target object where you want to bake to, so that both objects are selected. Then hit the Bake button. That's
Selected to Active.
Cage
This setting is hidden as long as Selected to active is not ticked.

Cast Rays to active object from a cage.
Ray Distance
Distance to use for the inward ray cast when using Selected to Active.

Settings for specific Texture types
Subsurface, Transmission, Glossy, Diffuse
Direct
Add direct Light.
Indirect
Add indirect Light.
Color
Add Color.

Normal
Space
A drop-down box where you can chooses the Normal Space to use.
Swizzle
Axis to bake in red, green and blue channels.
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Normals
Bake from Multires
Bake directly from Multires mesh.
Normal Space
Normal Space is a drop-down box where you can choose what normals to calculate.

Ambient Occlusion
Bake from Multires
Bake directly from Multires mesh.
Normalized
Normalizes without using material settings.

Combined
Direct
Bake directly from Multires mesh.
Indirect
Normalizes without using material settings.
Diffuse
Bake with Diffuse.
Glossy
Bake with Glossy.
Transmission
Bake with Transmission.
Subsurface
Bake with Subsurface.
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AO
Bake with Ambient Occlusion.
Emit
Bake with Emit.
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Introduction
The 3D View is made of several areas.
Yellow is the Tool Shelf.
Blue is the Header or Menu bar. It can be at the top or
the bottom.
Green is the Viewport. Here you will see and work
with your 3D data.
Red is the Properties Sidebar.
The content of the Tool Shelf , the Header and the
Properties Sidebar can vary. It depends of the type of
the objects and the modes that you are in.
This chapter here is about the Header.

Header
The Header contains various menus, navigation elements and tools for the 3d view. This content vary,
dependant of mode and object type. The navigation widget for example is not available in Sculpt Mode. The
Object menu just in Object mode and so on.

The header not only provides tools and menus. It is also the place where
you will see specific informations when you perform an operation.
When you move an object for example, then the menus hides, and you
will see the actual transformation values in the header in real time.
The header has also some right click functionality. Or that you can show or hide a editor
type menu where you can switch to other editor types. For this general header
functionality, like to show the editor type menu, collapse menus, etc. please have a look
at the chapter 2.2 Layouts.
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All Modes - View Menu
The View menu contains all View related tools. The range goes from tools to
maximize the current window across align view tools up to rendering related
tools for the viewport like Render Border.

Toggle Full screen Area
Displays the editor maximized without menus.
To return from the full screen view press hotkey Alt F10, or use
the little button that appears up right when you move the mouse in
this corner.

Toggle Maximize Area
Displays the editor maximized with menus.
To return to split view press hotkey Ctrl Up Arrow, or reuse the
menu item in the View menu.
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Toggle Quad view
Displays the 3D View divided into four screen parts.
To return to single view reuse the menu item in the View menu.

Duplicate Area into New Window
Duplicate Area into New Window makes the selected editor
window floating. You can then drag it around at the monitor.
A separated window cannot be merged into the main window
again. You have to close it when not longer needed.

View All
View all zooms in or out until all objects in the scene are displayed
fitting in the viewport.

Center Cursor and View All
Center Cursor and View all centres the 3D Cursor at 0/0/0, and
zooms in or out until all objects in the scene are displayed fitting in
the viewport.

View All all Regions
View All all Regions works just in Quad View. It zooms in or out
until all objects in the scene are displayed fitting in the four
divided parts of the viewport.
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View Selected
View Selected zooms in or out until the Selection is displayed
fitting in the viewport.

View Selected All Regions
View Selected all Regions works just in Quad View. It zooms in or
out until the Selection in the scene are displayed fitting in the four
divided parts of the viewport.

View Global / Local
View Global / Local zooms in or out until the Selection is
displayed fitting in the viewport. And hides all other objects but
the Selection.

Render Border
With the Render Border you can drag a rectangle at the viewport to define a portion of the screen to render. The
benefit here is to have much faster preview renderings. You just render what you want to judge, and not the
whole image.
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It has two use cases. The one is with the rendering through the camera. Just what is marked gets rendered. The
other is directly in the viewport, with the Viewport shading method Rendered.

Clear Render Border
Removes the Render Border from the viewport.

Clipping
With clipping you can draw a rectangle that excludes the display of everything outside of this rectangle. That
way you can look inside the geometry when you rotate the viewport. To clear the clipping use the tool again.

Clear All Restrict Render
Sets all Objects in the scene to be rendered. Have a look in the outliner, the
camera row at the right.
This menu option just appears when there is a render able object in the
viewport.
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Restrict Render Unselected
Sets all unselected Objects in the scene to be rendered. The selected object(s) will be excluded from rendering
now. Have a look in the outliner, the camera row at the right.
This menu option just appears when there is a render able object in the viewport

Set Restrict Render
Sets the selected Objects in the scene to be rendered. The unselected objects will be excluded from rendering
now. Have a look in the outliner, the camera row at the right.
This menu option just appears when there is a render able object in the viewport

Align View to Active
Align View to Active is a menu where you can choose
between different view align methods. The view gets
aligned relative to the rotation of the currently active object.
Not in World coordinates. The menu items should be self
explaining. So we won't list them one by one.

Align View
Align View is a menu where you can choose between different view align methods.
The view gets aligned at the world coordinates. Here we also find a few more align
methods.

Align Active Camera to View
Aligns the active camera to the current view. This means you can navigate with the
viewport camera, select the render camera, and align it with this tool, so that the
render camera has the same position and angle than the viewport camera.

Align Active Camera to Selected
Aligns the active camera to the current selected object. This means you can navigate with the viewport camera,
select the render camera, and align it with this tool, so that the render camera has the same position and angle
than the selected object.
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Center View to Cursor
Centres the view at the 3D cursor position.

View Lock to Active
Locks the view to the currently active object.

View Lock Center
Centres the view to the currently active and locked object. This tool is just active when you have performed a
View Lock to Active before.

View Lock Clear
Removes the View Lock to Active from the object.

View Persp/Ortho
Toggles between perspectivic and orthographic view. Perspectivic view acts like a real camera with the
perspectivic distortions. Orthographic view acts like a mathematical display of an object, without distortions.

Top, Bottom, etc.
Switches to Top view, Bottom View, etc.

View Camera Center
This tool is of use when you are in camera view. It can be that the passepartout around the actual camera view
field does not fit into the viewport. It can be too big or too small. It's already enough to resize the Tool shelf at
the left or the Properties Sidebar at the right. And then it doesn't fit anymore.
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View Camera center fits the camera view into the viewport.

Active Camera
Switches to Camera view and back to Viewport Camera.

Set Active Object as Camera
With this tool you can set any object to be the active camera where you render from.

OpenGL Render Animation
Renders an animation, using the Viewport OpenGL renderer. This can be useful for preview renderings.
Note
Note that this menu item is a double menu entry. The same menu item exists in the Render menu in the Info
Header. But this is required when you work with more than one 3D view. When you use the entry in the
Render menu, then it picks an arbitrary 3D view. When you use the menu entry in the 3D view, then it renders
from this 3D view.

OpenGL Render Image
Renders an Image, using the Viewport OpenGL renderer. This can be useful for preview renderings.
Note
Note that this menu item is a double menu entry. The same menu item exists in the Render menu in the Info
Header. But this is required when you work with more than one 3D view. When you use the entry in the
Render menu, then it picks an arbitrary 3D view. When you use the menu entry in the 3D view, then it renders
from this 3D view.
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Tool Shelf
Opens or closes the Tool Shelf at the left side of the 3D Viewport.

Properties
Opens or closes the Properties sidebar at the right side of the 3D
Viewport.

All Modes - Navigation Menu
The Navigation menu provides you with all tools around viewport navigation.
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Scale
Scales the selected object in the viewport by moving the mouse.

Last Operator Resize
Vector
Here you can adjust the position values for the three values
Constraint Axis
Here you can limit the position relative to the source object.
Orientation
Orientation is a drop-down box where you can choose the type of orientation for the
mirroring action.
Proportional Editing
Proportional Editing is a drop-down box where you can choose to use proportional editing.
When you choose one of the active methods then the neighbour geometry gets influenced
by Shrink/Fatten too in a proportional way.
Proportional Editing Falloff
Proportional Editing Falloff is a drop-down box where you can choose a method for the
falloff for the proportional editing.
Proportional Size
Proportional size is a edit box where you can adjust the strength of the Proportional
falloff.
Edit Grease Pencil
Edit Grease Pencil edits the selected Grease Pencil strokes.
Edit Texture Space
With Confirm on Release checked the action gets performed when you release the mouse button.

Rotate
Rotates the selected object in the viewport by moving the mouse.

Last Operator Translate
Angle
Here you can adjust the rotation angle.
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Constraint Axis
Here you can limit the position relative to the source object.
Orientation
Orientation is a drop-down box where you can choose the type of orientation for the
mirroring action.
Proportional Editing
Proportional Editing is a drop-down box where you can choose to use proportional editing.
When you choose one of the active methods then the neighbour geometry gets influenced
by Shrink/Fatten too in a proportional way.
Proportional Editing Falloff
Proportional Editing Falloff is a drop-down box where you can choose a method for the
falloff for the proportional editing.
Proportional Size
Proportional size is a edit box where you can adjust the strength of the Proportional
falloff.
Edit Grease Pencil
Edit Grease Pencil edits the selected Grease Pencil strokes.

Translate
Moves the selected object in the viewport by moving the mouse.

Last Operator Translate
Vector
Here you can adjust the position values for the three values
Constraint Axis
Here you can limit the position relative to the source object.
Orientation
Orientation is a drop-down box where you can choose the type of orientation for the
mirroring action.
Proportional Editing
Proportional Editing is a drop-down box where you can choose to use proportional editing.
When you choose one of the active methods then the neighbour geometry gets influenced
by Shrink/Fatten too in a proportional way.
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Proportional Editing Falloff
Proportional Editing Falloff is a drop-down box where you can choose a method for the
falloff for the proportional editing.
Proportional Size
Proportional size is a edit box where you can adjust the strength of the Proportional
falloff.
Edit Grease Pencil
Edit Grease Pencil edits the selected Grease Pencil strokes.
Edit Texture Space
With Confirm on Release checked the action gets performed when you release the mouse button.

Playback Animation
Plays back an existing animation.

View Navigation
Switches to View Navigation Mode. In this view mode the view gets rotated moved and scaled from the
Camera view point.

Walk Navigation
Switches to Walk Navigation. In this view mode the camera acts like a player in a first person shooter. Gravity
will pull you down, The ground grid is the ground. And you can move around with wasd keys.

Fly Navigation
Switches to Fly navigation. In this view mode the camera acts like an air plane.

Center View to Mouse
Centres the view to the current mouse position.

Dolly View
Dolly View is a special zoom mode.
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Be careful with this navigation method, you can easily trap yourself to not zoom able anymore!

Zoom Camera 1:1
Zooms the camera fitting to match the render output size by factor 1:1

Zoom In
Zooms into the viewport. Works also in camera view.

Zoom Out
Zooms out of the viewport. Works also in camera view.

Zoom Border
Draws a rectangle and zooms then to fit the size of this rectangle.
Zooming in is done with drawing the rectangle with left mouse button. Zooming out is done with drawing the
rectangle with middle mouse button.

Pan Left
Pans the viewpoint to the left. The scene moves to the right.

Pan Right
Pans the viewpoint to the right. The scene moves to the left.

Pan Up
Pans the viewpoint upwards. The scene moves down.

Pan Down
Pans the viewpoint downwards. The scene moves up.
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Roll Right
Rolls the viewport clockwise.

Roll Left
Rolls the viewport counter clockwise.

Orbit Opposite
Rotates the view by 180 degree.

Orbit Left
Orbits to the left.

Orbit Right
Orbits to the right.

Orbit Up
Orbits upwards.

Orbit Down
Orbits downwards.

All Modes, all Object types - Show / Hide
The Show/Hide menu is available for all object types and in all modes. It
is usually in the object related menu to find. In Object mode it's the
Object menu, for a curve object in edit mode it is the Curve menu. It
always contains three menu items. Show Hidden, Hide Selected and
Hide Unselected.

Show Hidden
Makes all objects in the scene visible again.
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Hide Selected
Hides the selected objects.

Hide Unselected
Hides the not selected objects. The selected object stays visible.

Last Operator Show Hidden
Here you can define if the selected or the unselected objects gets hidden.

Object Mode - Select menu
The select menu in Object mode is for all object types equal. It provides you with
several selection methods.

Less
Less requires to have a parent or child relationship. It reduces the selection.

More
More requires to have a parent or child relationship. It expands the selection.
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Child Extended
Child Extended requires to have a parent or child relationship. It selects the child object(s) of the currently
selected object(s). But keeps the active object in the selection, even when it's not currently selected.

Parent extended
Parent extended requires to have a parent or child relationship. It selects the parent object of the currently
selected object(s). But keeps the active object in the selection, even when it's not currently selected.

Child
Child requires to have a parent or child relationship. It selects the child object(s) of the currently selected
object(s).

Parent
Parent requires to have a parent or child relationship. It selects the parent object of the currently selected
object(s).

Last Operator Select Hierarchy
Child Extended, Parent Extended, Child and Parent share the same Last Operator.
Called Select Hierarchy.

Direction
Direction is a drop-down box where you can adjust if child or parent objects gets selected.

Extended
This checkbox defines if the selection is extended or not. Extended means that it keeps the active object in the
selection, even when it's not currently selected.

All by Type
All by Type is a menu where you can choose between the
different object types to select.
The menu items are pretty self explaining. So we won't
cover every single menu item here.
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Last Operator Select By Type
Extend
With this option activated the selection does not clear before performing the selection
operation, but extends. This means when you have a mesh object selected, and want to select all objects by type
curve, then the mesh object is still selected. Without Extend just the curve objects are selected. The mesh object
gets deselected.

Type
Type is a drop-down box where you can choose the object type to select again.

All by Layer
Selects all object in the defined layer.
You need to define the layer in the last operator panel. It's not enough to switch to let's say layer three, then
perform the tool. The default value is Layer 1.

Last Operator Select by Layer
Match
Match is a drop-down box where you can choose if you want to select the objects that just
exists at the current layer only. This is the option Exact Match. Or if you want to select
objects too that exists at more than one layer. This is the option Shared Layers.

Extend
Extends existing selection instead of deselecting everything first.

Layer
The edit box where you can define the layer where you want to select the objects at.

By Pattern
Selects all objects whose name matches the entered string. For missing parts you need to add an asterix.
For example, you have four cubes in the scene. Cube, Cube.001, Cube.002 and mycube3. Then the term " Cube
" will just select the first cube. While the term " Cube* " will select the first three. And " *cube* " will select all
four.
Supported wild-cards:
* matches everything
? matches any single character
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[abc] matches characters in “abc”
[!abc] match any character not in “abc”
The tool operates immediately at entering the string.

Pattern
Here you can type in your string.

Case Sensitive
When ticked then the string comparison happens by taking upper and lower letters into account.

Extend
Extends existing selection instead of deselecting everything first.
Last Operator Select Pattern
The Last Operator Select Pattern contains the same menu items than the pop-up.
Pattern
Here you can type in your string.
Case Sensitive
When ticked then the string comparison happens by taking upper and lower letters into account.
Extend
Extends existing selection instead of deselecting everything first.

Linked
Linked is a menu where you can select different types.
Here you can select all objects that shares a common datablock with the active object. Select Linked uses the active
object as a basis to select all others.

Object Data
Selects every object that is linked to the same Object Data.

Material
Selects every object that is linked to the same material data-block.

Texture
Selects every object that is linked to the same texture data-block.
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Dupligroup
Selects all objects that use the same Group for duplication.

Particle System
Selects all objects that use the same Particle System.

Library
Selects all objects that are in the same Library

Library (Object Data)
Selects all objects that are in the same Library and limited to object data.

Last Operator Select Linked
Extend
Extends existing selection instead of deselecting everything first.
Type
Type is a drop-down list where you can choose the Linked type again.

Grouped
Grouped is a menu where you can select different types of
objects within the group. It requires to have a group
selected.
The menu items are pretty self explaining. So we won't go
into detail here.

Last Operator Select Grouped
Extend
Extends existing selection instead of deselecting everything first.
Type
Type is a drop-down list where you can choose the Linked type again.
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Camera
Selects the active camera.

Last Operator Select Camera
Extend
Extends existing selection instead of deselecting everything first.

Mirror
Select the mirrored parts of an object. For example for L.Sword it selects R.Sword.

Last Operator Select Mirror
Extend
Extends existing selection instead of deselecting everything first.

Random
Selects random objects.

Last Operator Select Random
Percent
The Percentage of objects that should be selected randomly.
Random Seed
The Seed for the random number generator.
Action
Action is a drop-down box where you can choose if you want to select or to deselect random.

Inverse
Inverts the current selection.

(De)Select All
Toggles between select all and deselect all.

Last Operator (De)Select All
Action
Action is a drop-down box where you can choose between different methods.
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Invert
Inverts the selection.
Deselect
Deselects all.
Select
Selects all.
Toggle
Toggles between select all and deselect all.

Circle Select
Circle select enters the Circle Select mode. This is a special
select mode where you can select elements by moving with
the mouse over it. It adds to selection by default.
To subtract from selection hold down Shift key. To exit the
Circle select click with the right mouse button.
The pencil radius of the circle select tool can be adjusted
with the scroll wheel.

Note
You cannot navigate while you are in Circle Select mode. You have to leave the Circle Select mode, do the
navigation, then re-enter the Circle Select mode.

Border Select
Border select enters the Border Select mode. This is a special select mode where
you can select elements by dragging a rectangle. And what's inside of the
rectangle gets selected then. It adds to selection by default.
To subtract from selection hold down Shift key.
The selection gets applied when you release the mouse. You leave the mode
automatically when you release the mouse.

F36

Bforartists Reference Manual - © Copyright - This page is Public Domain

Lasso Select
Lasso select enters the Lasso Select mode. This is a special select mode where you can select elements by
dragging a form around what you want to select. And what's inside of the rectangle gets selected then. It adds to
selection by default.
To subtract from selection hold down Shift key.
The selection gets applied when you release the mouse. You leave the mode automatically when you release the
mouse.

Note
You can of course also start with clicking at the menu item. But this tool is by design a hotkey only tool. Hold
down Ctrl , and select with left mouse button.

Stroke Select
Stroke select enters the Stroke Select mode. This is a special select mode where you can select elements by
moving with the mouse over it. It is somehow similar to the Circle select tool. But has no pencil size. At the
contrary, here you can navigate while you are in stroke select mode.
It adds to selection by default. To subtract from selection right click to change to deselect mode. This can also
be done in the Properties sidebar in the Stroke Select panel. To return to add to selection right click again. Or
untick the menu item in the Stroke Select Panel.
Note
This tool is by design a hotkey only tool. Hold down the key combo Shift Q, and paint with left mouse button.
Stroke Select is an add-on, and can be uninstalled if wanted. But note that the functionality is not longer
available then.
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Object Mode - Object menu
The object menu in Object mode provides you with tools to work at Object level.
It contains things like undo redo, copy and paste, delete and other general tools. But also
some object specific tools, like the Convert to menu.

Convert to
Convert to is a menu to convert curves object types to mesh
objects, and mesh object types to curves.

Curve from Mesh/Text
Converts a selected Mesh or Text Object to a Curve Object.

Mesh from Curve/Meta/Surf/Text
Converts a selected Curve, Metaball, Surface or Text Object to a Mesh Object.

Last Operator Convert to
Target is a drop-down box where you can again choose between the two convert methods.
Keep Original
With this option ticked the original object gets kept. And a new object gets created.

Show/Hide
Show/Hide is a menu. Here you can show or hide objects in the
viewport. See chapter All Modes, all Object types - Show / Hide
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Game
Game is a menu that is related to the Blender Game Engine. Bforartists does not give any support for the Game
Engine. Please head over to the Blender Manual when you want to learn more about this menu.

Subdivide
Subdivide is a menu where you can quickly add and change a subdivision
surface modifier with a predefined resolution in a quick way. Especially
when you use the hotkey for it. The subdivision surface modifier panel can
then as usual be found in the Properties editor in the Modifier tab.

Last Operator Subdivision Set
Level
Here you can set the level of subdivisions

Relative
Applies the sub surf level as an offset to the already existing sub surf level.

Quick Effects
Quick effects is a menu with some predefined basic Particle effects.
You need to have a mesh object selected.

Quick Fur
Adds a particle system with Fur settings.

Quick Explode
Adds a particle system that lets the selected object explode into pieces.
Hit play to play the animation.
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Quick Smoke
Adds a particle system with a simple smoke.
Hit play to play the animation.

Quick Fluid
Adds a particle system with Fluid settings.
This feature does not completely work out of the box. You need to
bake the animation first. This can be done in the Properties Editor,
Particles Tab, Fluid Panel.

Constraints
Constraints is a menu around Constraints functionality.
Constraints provides you with various limitation methods
connected to a target object. For example, you can limit the
X position of an object to the X position of the target object. And when you move the target object, then the
object will change its X position too.

Add Constraints ( With Targets)
Add Constraints ( With Targets) calls a menu where you can choose the constraints type. It's the same content
than in the Constraints tab in the Properties editor.

We will not explain every single constraint type here. Please have a look at the constraint types in the manual
part for the Properties editor.
Usage:
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Select the target object. Hold down Shift key. Now select the object where you want to add the constraints to.
Both should be selected. Then choose the constraints type in the menu that you want to add.
As a result a constraints panel gets created in the Constraints tab in the Properties editor. Here you can tweak
the settings then further if required. In our example we wanted to limit the X axis. So we added a Copy
Location constraint, and unticked Y and Z axis.
In the 3D view a black dotted line indicates the relationship.

Last Operator Add Constraints (with Target)
Type
Type is a drop-down box where you can choose the constraints type again.

Copy Constraints to Selected Objects
Copy Constraints to Selected Objects copies a constraint from one object to another.
Usage:
Select the object where you want to copy the constraint to. Hold down Shift and select the object with the
constraint. Both should be selected. Then click at Copy Constraints to Selected Objects. This copies the
constraint to the object.

Clear Object Constraints
Removes all constraints from the object.

Clear Track
This menu item is just relevant when you have a Track constraint applied. It removes the track constraint.
F41

Bforartists Reference Manual - © Copyright - This page is Public Domain

Last Operator Clear track
Type
Type is a drop-down box where you can choose between Clear Track and Clear Track Keep
Transformation.

Clear Track - Keep Transformation
This menu item is just relevant when you have a Track constraint applied. Removes the track constraint. But
keeps the current position.

Last Operator Clear track
Type
Type is a drop-down box where you can choose between Clear Track and Clear Track Keep
Transformation.

Make Dupli Face
Make Dupli Face is a relict from the past, when there was
no instancing or parenting feature available in Blender.
When you turn an object into a Dupli Face object, then this
object becomes an instancing container for this object. All
objects in this container just exists once in ram when you
duplicate it. No matter how often you duplicate it. This
allows to plant whole forests without to run into a memory
problem. Since the tree object just loads once into ram.
And gets just drawn at different screen positions then.

Delete
Delete deletes the selected object(s)

Last Operator Delete
Delete Globally
When ticked then the delete operation deletes global, in all scenes.

Delete Global
It can be that you have more than one scene open. Delete deletes the selected object(s) in all scenes.
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Last Operator Delete
Delete Globally
When ticked then the delete operation deletes global, in all scenes.

Duplicate Linked
Duplicates selected objects. The instance has its own transforms.
But the duplicate shares some data with the first instance. This
means when you for example edit the mesh of one of the
instances, then the other instance gets modified too. As you can
see this in the screen shot. Here you can also see that the mesh
name is the same.
If you want to make changes to an object in the new linked
duplicate independently of the original object, then you will have
to manually make the object a “single-user” . This can be done for
example in the Outliner, in the right click menu of the object.
You are automatically in grab mode, and so you can easily move
the object out of position. which is sometimes wanted, since you
can position the duplicate then. But sometimes this is unwanted. A
right click after releasing the mouse lets the object snap back into
its creation position.

Last Operator Duplicate Linked
Duplicate Objects
Linked
With this option ticked the duplication happens with linked data.

Translate
The Position of the duplicated object

Constraint Axis
Here you can limit the position relative to the source object.

Orientation
Orientation is a drop-down box where you can choose the type of orientation for the
mirroring action.

Proportional Editing
Proportional Editing is a drop-down box where you can choose to use proportional editing.
When you choose one of the active methods then the neighbour geometry gets influenced
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by Shrink/Fatten too in a proportional way.

Proportional Editing Falloff
Proportional Editing Falloff is a drop-down box where you can choose a method for the
falloff for the proportional editing.

Proportional Size
Proportional size is a edit box where you can adjust the strength of the Proportional
falloff.

Edit Grease Pencil
Edit Grease Pencil edits the selected Grease Pencil strokes.

Edit Texture Space
With Confirm on Release checked the action gets performed when you release the mouse button.

Duplicate Objects
Duplicates selected objects. The copy is completely independent.
All containing data gets duplicated too. And you can edit the
object instances completely independent. then.
You are automatically in grab mode, and so you can easily move
the object out of position. Which is sometimes wanted, since you can position the duplicate then. But
sometimes this is unwanted. A right click after releasing the mouse lets the object snap back into its creation
position.
When you drag the duplicate around you will see the position values in the
header.

Last Operator Duplicate
Duplicate Objects
Linked
With this option ticked the duplication happens with linked data.

Translate
The Position of the duplicated object.

Constraint Axis
Here you can limit the position relative to the source object.

Orientation
Orientation is a drop-down box where you can choose the type of orientation for the
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mirroring action.

Proportional Editing
Proportional Editing is a drop-down box where you can choose to use proportional editing.
When you choose one of the active methods then the neighbour geometry gets influenced
by Shrink/Fatten too in a proportional way.

Proportional Editing Falloff
Proportional Editing Falloff is a drop-down box where you can choose a method for the
falloff for the proportional editing.

Proportional Size
Proportional size is a edit box where you can adjust the strength of the Proportional
falloff.

Edit Grease Pencil
Edit Grease Pencil edits the selected Grease Pencil strokes.

Edit Texture Space
With Confirm on Release checked the action gets performed when you release the mouse button.

Copy
Copies the selected object(s)

Paste
Pastes copied object(s).

Last Operator Paste Selection from Buffer
Select
Select pasted object(s).

Active Layer
Paste the object into the active layer.
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Apply
Apply is a menu where you can apply transforms in various
combinations. For example, when you create a cube, then move it
to let's say 3, then apply the location, then the origin gets set to 0.
The position is "applied". Of special Interest is apply scale, since
it resets the scale factor to 1.
Apply just works with single user objects. And it does not apply
to pose position, animation curves or constraints. These tools
should be used before rigging and animation.

Location, Rotation, Scale and Rotation&Scale
This applies the location, rotation and scale of the object.

Last Operator Apply Object Transform.
Location
Applies the position, and resets origin to 0
Rotation
Applies the rotation.
Scale
Applies the Scale.
Apply Properties
Properties such as Curve Vertex Radius. Font Size and bone envelope gets applied.

Location, Rotation, Scale and All Transforms to Deltas
Transforms are absolute to the world coordinates. Delta Transforms are relative to the current transformation.
The delta transform values can be found in the Object properties, in the Delta Transform Panel.
Example use case:
Keyframe a object rotation from 0 to 90 degrees. Rotate the object by 45 degrees. When you play the animation
it will still rotate from 0 to 90 degrees.
Now keyframe a delta rotation from 0 to 90 degrees and rotate the object by 45 degrees. When you playback the
animation it will rotate from 45 to 135 degrees now. (a 90 degree difference from the current state)

Last Operator Transforms to Deltas
Mode
Mode is a drop-down box where you can choose the transform mode again.
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Reset Values
Clears the transform values after transferring to Deltas.

Animated Transform to Deltas
Converts the “normal” transformation animations to Delta transforms. This tool requires to have key frames at
the object.

Clear
Clear Transform is a menu where you can clear the transform for
location, rotation, scale and Origin. Clear means in this conjunction
that the values gets reset. When you have for example a cube at X 5,
and clear the location, then the cube gets positioned at position X 0.

Location
Resets the location of the selected object(s).

Last Operator Clear Location
Clear Delta
With Clear Delta ticked it clears the delta transform instead of the transform.

Rotation
Resets the rotation of the selected object(s).

Last Operator Clear Rotation
Clear Delta
With Clear Delta ticked it clears the delta transform instead of the transform.

Scale
Resets the scaling of the selected object(s).

Last Operator Clear Scale
Clear Delta
With Clear Delta ticked it clears the delta transform instead of the transform.

Origin
Clear Origin requires to have a parent child relationship selected. It sets the child object to the position of the
parent object.
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Edit Mode - Mesh Object - Mesh Menu
The Mesh Menu in Edit Mode contains the tools to manipulate the mesh geometry in Edit
mode. It just exists for Mesh Objects.
Lots of functionality that could also belong here can also be found in the Tool Shelf. The
difference is that the tools in the tool shelf are easier to access. And so it contains the most
used tools for the daily work. While the Mesh menu contains the not so often used tools.
Or tools where you use the hotkey anyway. Delete for example.

Smart Delete
Smart delete deletes what is selected in an intelligent way.
When you for example delete an edge then the edge gets
deleted. But it also deletes the vertices connected to this edge. It
performs a Dissolve operation under the hood.
There is a bit below a Delete menu where you can choose
different methods for deleting if required. And the Dissolve
tools can be found in the Tool Shelf in the Tools tab.

Show / Hide
Show / hide is a menu that contains the Show Hide tools. Here you can
show or hide your current selection in the viewport. See chapter All
Modes, all Object types - Show / Hide

Sort Elements
Sort Elements is a menu with different sorting methods. It allows you to
reorder the mesh indices of the selected mesh elements by various
methods.

Hint
You can enable the viewing of mesh indices by typing in bpy.app.debug = True in the Python console
in the scripting layout. This reveals a checkbox in the Mesh Display panel in the Info Options subsection. And
when you tick this checkbox, then the vertices or edges or faces gets displayed with their indices value.
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View Z Axis
Sorts along the active view’s Z axis, from farthest to nearest. You can use Reverse if you want it the other way.

View Y Axis
Sorts along the active view’s Y axis, from farthest to nearest. You can use Reverse if you want it the other way.

Cursor Distance
Sorts from nearest to farthest away from the 3D cursor position.

Material
Faces only! Sorts faces by their lowest material index up to highest material index. Order of faces inside each of
those material groups remains unchanged.
Note that the Reverse option only reverses the order of the materials. And the order of the faces inside them.

Selected
Moves all selected elements to the beginning without affecting their relative orders. Attention, this option will
also affect unselected element indices!
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Randomize
Randomizes the indices of selected elements. This option does not affect the unselected elements.

Reverse
Reverses the order of the selected elements.

Last Operator Sort Mesh Elements
Sort Elements always brings up the same last operator.
But with a small difference for Randomize and Reverse.
Reverse has no checkbox. And Randomize has a Seed
checkbox.

Type
This is a drop-down box where you can choose the sort method again.

Vertices, Edges or Faces
Here you can adjust if the sort will affect the vertices, edges or faces.

Reverse Checkbox
Reverses the sorting.

Seed Edit box (Randomize only)
The seed option allows you to get another randomization – the same seed over the same mesh/set of selected
elements will always give the same result!

Noise
Noise is a displacement tool where you can use a texture
to displace the geometry. It just works with the Blender
Internal renderer, and you need to have a texture and a
material assigned.
The strength can be adjusted in the Last Operator.
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Last Operator Noise
Factor
Here you can adjust the strength of the displacement.

Subdivide
Subdivide is a menu where you can
quickly set the subdivision level of the
selection.
What it does is to add a SDS modifier
in the Properties Editor if required. And set the SDS level to the needed value.
Crtrl 0 sets SDS to level 0. Ctrl 1 sets SDS level to 1 , and so on.
SDS happens at Object mode level. Even when you apply it in the Edit Mode!
And it happens at the whole object.

Last Operator Subdivision Set
Level
Here you can adjust the SDS level.

Relative
Applies the Subsurf Level as an offset relative to the current level.

Blend from Shape
This tool requires to have a shape key at the mesh. It blends the selected
shape key into the mesh.

Last Operator Blend from Shape
Drop-down box
Here you can define which shape key should be
used.
Blend edit box
Here you can adjust the blend factor
Add
Add to blend shape instead of blending in.
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Shape Propagate
This tool requires to have a shape key at the mesh. It applies the current vertex locations to all other shape keys
at the mesh.

Hooks
Hooks is a menu with tools around the hook
modifier. You could also adjust the hook
modifier from the Properties editor. But the
menu items are more accessible.
When there is no hook modifier at the mesh
then you just see three menu items. When there is minimum one
hook modifier applied, then you will see an extended menu.

Hook to New Object
Creates a new Hook Modifier for the active object and assigns it to the selected vertices. It also creates an
empty at the center of those vertices, which are hooked to it.

Hook to Selected Object
Does the same as Hook to New Object, but instead of hooking the vertices to a new empty, it hooks them to the
selected object (if it exists). There should be only one selected object (besides the mesh being edited).

Last Operator Hook to Selected Object
Active Bone
Hook to the object(s) of the active bone.

Hook to Selected Object Bone
Does the same as Hook to New Object. But it sets the last selected bone in the also selected armature as a
target.

Assign to Hook
Here you can assign the selected vertices to the chosen hook modifier. Existing hooks gets overwritten. One
vertex can be assigned to more than one hook.

Remove Hook
Removes the chosen Hook Modifier from the object.
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Select Hook
Selects all vertices assigned to the chosen Hook Modifier.

Reset Hook
Resets the chosen Hook Modifier.

Recenter Hook
Recenter the Hook Modifier.

Vertex Groups
Vertex groups is a menu around vertex group functionality. The vertex
groups can be found in the Object data tab in the Properties editor.

When there is no vertex group assigned yet then you can only see one
menu item. The assign to new group button.
Once you have a vertex group assigned you will see the full
functionality.

Assign to New Group
Assigns the mesh selection to a new vertex group.

Assign to active Group
Assigns the mesh selection to the currently active vertex group.
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Remove from Active Group
Removes the mesh selection from the currently active vertex group.

Remove from All
Removes the mesh selection from all vertex groups.

Set Active Group
Here you can select a vertex group to be the active one.

Remove Active Group
Removes the currently active vertex group.

Remove All Groups
Removes all vertex groups from the mesh.

Mesh Select Mode
Mesh Select mode is a sub menu where you can set the
current mesh select mode. Its functionality is equal to
the mesh select mode buttons in the header. Just that you
can't select more than one mode directly here. This menu
exists to show and to edit the hotkeys. Not to work with
it.
Interestingly the menu items have a last operator. Again, it is not meant to work this way. So this is just listed
for documentation reasons.

Last Operator Select Mode
Extend
Adds to the current selection mode
Expand
Not documented, not to find out, sorry.
Type
Here you can again adjust what select mode you want to activate
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Action
How to work with the operator. Toggle means when you click at the button and it is disabled, then it enables.
And vice versa. Enable and disable should be self explaining.

Delete
The smart delete works dependant of the selection and the mode. Which
is fine for most cases. This delete menu gives you some more control over
what exactly you want to delete. And how you want to delete it.

Vertices
Deletes the selected vertices, and all with it connected edges and faces.

Edges
Deletes the selected edges and the connected faces.

Faces
This one works similar to the smart delete. It deletes the selected faces.

Only Edges and Faces
This mode is of interest when you have more than one selection mode activated.
It deletes then just the selected edges and faces. And not single vertices.

Only Faces
This mode is of interest when you have more than one selection mode activated. Just selected faces gets
deleted. Not single edges or vertices.

Last Operator Delete
The Last Operator Delete is the same for the above menu items.

Type
Here you can choose the delete method again.
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Edge Loops
This method works similar to the smart delete tool. It deletes the edge loop.
But it selects the faces of the edge ring. And the Last operator offers you
the option to split off face corners.

Last Operator Delete Edge Loop
Face Split
Split off face corners to maintain surrounding geometry.

Duplicate
Duplicates the current selection. The copy sticks to the mouse until you release it. A Right click while moving
will reset the position of the duplicate. The duplicated part will be part of the same object.
When you drag the duplicate around you will see the position values in the
header.

Last Operator Duplicate
Duplicate Objects
Linked
With this option ticked the duplication happens with linked data.

Translate
The Position of the duplicated object

Constraint Axis
Here you can limit the position relative to the source object.

Orientation
Orientation is a drop-down box where you can choose the type of orientation for the
mirroring action.

Proportional Editing
Proportional Editing is a drop-down box where you can choose to use proportional editing.
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When you choose one of the active methods then the neighbour geometry gets influenced by Shrink/Fatten too
in a proportional way.

Proportional Editing Falloff
Proportional Editing Falloff is a drop-down box where you can choose a method for the
falloff for the proportional editing.

Proportional Size
Proportional size is a edit box where you can adjust the strength of the Proportional
falloff.

Edit Grease Pencil
Edit Grease Pencil edits the selected Grease Pencil strokes.

Edit Texture Space
With Confirm on Release checked the action gets performed when you release the mouse button.

Transform
Transform is a menu that contains some special transform functionality.
See chapter Edit Mode - Transform Menu

Edit Mode - Curve + Surface Object - Curve + Surface Menu
The Curve Menu in Edit Mode contains the tools to manipulate the curve
geometry in Edit mode. It just exists for Curve Objects.
Same counts for the Surface Menu in Edit mode. The menus are identical
since both object types are a curve type. So we handle both menus here.

Show/Hide
Show/Hide is a menu. Here you can show or hide objects in the
viewport. See chapter All Modes, all Object types - Show / Hide
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Hooks
Hooks is a menu with tools around the hook
modifier. You could also adjust the hook
modifier from the Properties editor. But the
menu items are more accessible.
When there is no hook modifier at the mesh
then you just see three menu items. When
there is minimum one hook modifier applied, then you will see an
extended menu.

Hook to New Object
Creates a new Hook Modifier for the active object and assigns it to the selected vertices. It also creates an
empty at the center of those vertices, which are hooked to it.

Hook to Selected Object
Does the same as Hook to New Object, but instead of hooking the vertices to a new empty, it hooks them to the
selected object (if it exists). There should be only one selected object (besides the mesh being edited).

Last Operator Hook to Selected Object
Active Bone
Hook to the object(s) of the active bone.

Hook to Selected Object Bone
Does the same as Hook to New Object. But it sets the last selected bone in the also selected armature as a
target.

Assign to Hook
Here you can assign the selected vertices to the chosen hook modifier. Existing hooks gets overwritten. One
vertex can be assigned to more than one hook.

Remove Hook
Removes the chosen Hook Modifier from the object.

Select Hook
Selects all vertices assigned to the chosen Hook Modifier.
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Reset Hook
Resets the chosen Hook Modifier.

Recenter Hook
Recenter the Hook Modifier.

Delete
Delete calls a pop-up where you can choose if you want to delete vertices or segments.

Last Operator Delete
Type
Here you can again choose if you want to delete vertices or segments.

Duplicate
Duplicates the current selection. The copy sticks to the mouse until you release it. A Right click while moving
will reset the position of the duplicate. The duplicated part will be part of the same object.
When you drag the duplicate around you will see the position values in the
header.

Last Operator Duplicate
Duplicate Objects
Linked
With this option ticked the duplication happens with linked data.

Translate
The Position of the duplicated object

Constraint Axis
Here you can limit the position relative to the source object.

Orientation
Orientation is a drop-down box where you can choose the type of orientation for the
mirroring action.
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Proportional Editing
Proportional Editing is a drop-down box where you can choose to use proportional editing.
When you choose one of the active methods then the neighbour geometry gets influenced
by Shrink/Fatten too in a proportional way.

Proportional Editing Falloff
Proportional Editing Falloff is a drop-down box where you can choose a method for the
falloff for the proportional editing.

Proportional Size
Proportional size is a edit box where you can adjust the strength of the Proportional
falloff.

Edit Grease Pencil
Edit Grease Pencil edits the selected Grease Pencil strokes.

Edit Texture Space
With Confirm on Release checked the action gets performed when you release the mouse button.

Edit Mode - Metaball Object - Metaball Menu
The Metaball menu in Edit mode contains the tools to work with Meta elements in Edit
Mode.

Show/Hide
Show/Hide is a menu. Here you can show or hide objects in the viewport.
See chapter All Modes, all Object types - Show / Hide

Duplicate
Duplicates the current selection. The copy sticks to the mouse until you release it. A Right click while moving
will reset the position of the duplicate. The duplicated part will be part of the same object.
When you drag the duplicate around you will see the position values in the
header.
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Last Operator Duplicate
Duplicate Meta elements
Just ignore this label.

Translate
The Position of the duplicated object.

Constraint Axis
Here you can limit the position relative to the source object.

Orientation
Orientation is a drop-down box where you can choose the type of orientation for the
mirroring action.

Proportional Editing
Proportional Editing is a drop-down box where you can choose to use proportional editing.
When you choose one of the active methods then the neighbour geometry gets influenced
by Shrink/Fatten too in a proportional way.

Proportional Editing Falloff
Proportional Editing Falloff is a drop-down box where you can choose a method for the
falloff for the proportional editing.

Proportional Size
Proportional size is a edit box where you can adjust the strength of the Proportional
falloff.

Edit Grease Pencil
Edit Grease Pencil edits the selected Grease Pencil strokes.

Edit Texture Space
With Confirm on Release checked the action gets performed when you release the mouse button.

Delete
Deletes the selected element(s).
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Edit Mode - Text Object - Text Menu
The Text menu contains the tools to work with text in edit mode.
Note that you have to use the Object mode box to escape the Edit mode
with a text object. The hotkey to change the mode will be counted as text
input for the text object.

Delete
Delete deletes the selected text.
To select parts of the text, move the cursor with the arrow buttons to the needed location, then hold down Shift,
and select the letters by pressing the arrow buttons left or right. And then you can delete this selected text part.
Selecting text parts with the arrows brings up the Last Operator for Move Select.

Last Operator Move Select
Type
Type is a drop-down box where you can change the selection method.

Last Operator Delete
Type
Type is a drop-down box where you can change the delete method.

Special Characters
Special characters is a menu that contains some special text characters,
like copyright, which you can insert into the text.
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Edit Mode - Armature Object - Armature Menu
The armature menu provides you the tools to work with armatures and its bones in edit
mode.

Bone Settings
Bone Settings is a menu with menu items to toggle special
checkboxes in the Properties editor. But here you can do it
for a selection too, and not just one object.

Last Operator Collection Boolean Set
Each of the menu items uses the same Last Operator. With different strings for the
booleans.

Draw Wire
Turns on or off the Wireframe checkbox, and so its functionality, in the
Bones tab in the Display Panel Properties editor.
This checkbox requires to have a custom bone shape. It will not work at
a normal bone shape. When you have a custom bone shape defined, then
this custom bone object gets always displayed as Wireframe, regardless
of viewport draw mode.
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Deform
Turns on or off the Deform panel, and so its functionality, in the Bones tab in
the Properties editor.
With Deform enabled the chosen bone deforms the connected mesh. The
Deform panel also contains some Envelope settings.

Multiply Vertex Group with Envelope
Turns on or off the Multiply checkbox in the Deform panel, and so its
functionality, in the Bones tab in the Properties editor.
Multiply the effects of vertex group weights with envelope influence.
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Inherit Rotation
Turns on or off the Inherit Rotation checkbox in the Relations panel, and
so its functionality, in the Bones tab in the Properties editor.
The bone inherits rotation from the parent bone.

Inherit Scale
Turns on or off the Inherit Scale checkbox in the Relations panel, and so
its functionality, in the Bones tab in the Properties editor.
The bone inherits scale from the parent bone.

Lock
Turns on or off the Lock checkbox in the Transform panel, and so its
functionality, in the Bones tab in the Properties editor.
Locked bones cannot be edited in edit mode anymore. They are locked.

Show/Hide
Show/Hide is a menu. Here you can show or hide objects in
the viewport. See chapter All Modes, all Object types - Show /
Hide

Change Bone Layers
This menu item opens a popup where you can put single selected bone(s)
onto another layer.
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Last Operator Change Bone Layers
Layer
Here you can again put the selected bones onto another layer.

Change Armature Layers
This menu item opens a popup where you can put the whole armature onto
another layer.

Last Operator Change Armature Layers
Layer
Here you can again put the armature onto another layer.

Flip Names
This tool requires to follow some name conventions. If there is a
lower or upper case “L”, “R”, “left” or “right” with a separating dot in
the bone name, then this tool renames the bones names to its counter
part. Bone.L becomes Bone.R.
This tool is useful when you mirror parts of the armature, and don't want to rename all the bones one by one.

AutoName Top/Bottom
This tool automatically adds a suffix to all selected bones, based on their local position relative to the armature
center.
Bones with a positive Z Coordinate will receive a .Top suffix. Bones with a negative Z coordinate will receive a
.Bot suffix.

AutoName Front/Back
This tool automatically adds a suffix to all selected bones, based on their local position relative to the armature
center.
Bones with a positive Y Coordinate will receive a .Fr suffix. Bones with a negative Y coordinate will receive
a .Bk suffix.
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AutoName Left/Right
This tool automatically adds a suffix to all selected bones, based on their local position relative to the armature
center.
Bones with a positive X Coordinate will receive a .L suffix. Bones with a negative X coordinate will receive
a .R suffix.

Delete Selected Bone(s)
Deletes the currently selected bones.

Duplicate
Duplicates selected bones. The duplicate is still part of the armature. The name number at
the bones increases.
You are automatically in grab mode, and so you can easily move the object out of position.
Which is sometimes wanted, since you can position the duplicate then. But sometimes this is
unwanted. A right click after releasing the mouse lets the object snap back into its creation
position.
When you drag the duplicate around you will see the position values in the
header.

Last Operator Duplicate
Duplicate Selected Bone(s)
Just ignore this label.

Translate
Just ignore this label.

Constraint Axis
Here you can limit the position relative to the source object.

Orientation
Orientation is a drop-down box where you can choose the type of orientation for the
mirroring action.

Proportional Editing
Proportional Editing is a drop-down box where you can choose to use proportional editing.
When you choose one of the active methods then the neighbour geometry gets influenced
by Shrink/Fatten too in a proportional way.
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Proportional Editing Falloff
Proportional Editing Falloff is a drop-down box where you can choose a method for the
falloff for the proportional editing.

Proportional Size
Proportional size is a edit box where you can adjust the strength of the Proportional
falloff.

Edit Grease Pencil
Edit Grease Pencil edits the selected Grease Pencil strokes.

Edit Texture Space
With Confirm on Release checked the action gets performed when you release the mouse button.

Recalculate Roll
Recalculate Roll is a menu where you can recalculate the bone roll in
various ways.
The menu items are pretty self explaining. So we will not repeat the
descriptions here.

Last Operator Recalculate Roll
Type
Type is a drop-down box where you can choose the recalculation method again.

Flip Axis
Negates the alignment axis.

Shortest Rotation
Ignore the axis direction, and use the shortest rotation to align the
bone(s)
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Bone Roll
Bone Roll is a menu where you can directly set the bone roll,
or reset the bone roll to zero.

Set Roll
This operation is relative to the starting value, and starts always with zero. It does not display the Bone Roll
value from the Transform panel. It adds or subtracts the amount of the operation to/from the
Roll value then.
While operating you will see the current relative Roll value in the header.

Last Operator Transform
The only interesting value is the X value right at the top. The other settings
here are simply dysfunctional. You cannot turn on proportional editing,
there is nothing to constraint, etc. . And so we will not go into detail here.
Unfortunately even the X value to display the amount of the roll is broken.
It displays the amount in Radians, while the Bone roll is in degrees.

Clear Roll
Here you can set the bone roll value directly.

Last Operator Clear Roll
Roll
Here you can set the bone roll.

Edit Mode - Lattice Object - Lattice Menu
The Lattice menu provides you with tools to edit the Lattice object in edit mode.

Flip
Flip is a menu where you can flip the lattice object along the world axis X, Y or Z
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Pose Mode - Armature Object - Pose Menu
The Pose menu contains the tools to work with Armature objects in Pose mode. This means
here you find all the tools that you need to pose and animate your armature.

Bone Settings
Bone Settings is a menu with menu items to toggle special
checkboxes in the Properties editor. But here you can do it
for a selection too, and not just one object.

Last Operator Collection Boolean Set
Each of the menu items uses the same Last Operator. With different strings for
the booleans.

Draw Wire
Turns on or off the Wireframe checkbox, and so its functionality, in the
Bones tab in the Display Panel Properties editor.
This checkbox requires to have a custom bone shape. It will not work at
a normal bone shape. When you have a custom bone shape defined, then
this custom bone object gets always displayed as Wireframe, regardless
of viewport draw mode.
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Deform
Turns on or off the Deform panel, and so its functionality, in the Bones tab in
the Properties editor.
With Deform enabled the chosen bone deforms the connected mesh. The
Deform panel also contains some Envelope settings.

Multiply Vertex Group with Envelope
Turns on or off the Multiply checkbox in the Deform panel, and so its
functionality, in the Bones tab in the Properties editor.
Multiply the effects of vertex group weights with envelope influence.
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Inherit Rotation
Turns on or off the Inherit Rotation checkbox in the Relations panel, and
so its functionality, in the Bones tab in the Properties editor.
The bone inherits rotation from the parent bone.

Inherit Scale
Turns on or off the Inherit Scale checkbox in the Relations panel, and so
its functionality, in the Bones tab in the Properties editor.
The bone inherits scale from the parent bone.

Show/Hide
Show/Hide is a menu. Here you can show or hide objects in
the viewport. See chapter All Modes, all Object types - Show /
Hide

Change Bone Layers
This menu item opens a popup where you can put single selected bone(s)
onto another layer.

Last Operator Change Bone Layers
Layer
Here you can again put the selected bones onto another layer.

Change Armature Layers
This menu item opens a popup where you can put the whole armature onto
another layer.
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Last Operator Change Armature Layers
Layer
Here you can again put the armature onto another layer.

Flip Quats
This feature flips the quaternion rotation values of the currently selected bone(s). Positive
values becomes negative, and negative values becomes positive.

Flip Names
This tool requires to follow some name conventions. If there is a
lower or upper case “L”, “R”, “left” or “right” with a separating dot in
the bone name, then this tool renames the bones names to its counter
part. Bone.L becomes Bone.R.
This tool is useful when you mirror parts of the armature, and don't want to rename all the bones one by one.

AutoName Top/Bottom
This tool automatically adds a suffix to all selected bones, based on their local position relative to the armature
center.
Bones with a positive Z Coordinate will receive a .Top suffix. Bones with a negative Z coordinate will receive a
.Bot suffix.

AutoName Front/Back
This tool automatically adds a suffix to all selected bones, based on their local position relative to the armature
center.
Bones with a positive Y Coordinate will receive a .Fr suffix. Bones with a negative Y coordinate will receive
a .Bk suffix.
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AutoName Left/Right
This tool automatically adds a suffix to all selected bones, based on their local position relative to the armature
center.
Bones with a positive X Coordinate will receive a .L suffix. Bones with a negative X coordinate will receive
a .R suffix.

Constraints
Constraints is a menu that contains some tools around
constraints.

Add (With Targets)
Add (With Targets) calls the Constraints menu where you can choose
the constraint that you want to add. When you add an IK constraints
with just the bone selected, then it adds an empty as a handler too, and
fills it in as a target.

You can define a own target object too. The armature needs to be in pose mode.
Let's create a cube or another primitive. Select it. Now hold down Shift, and
click at the bone where you want to add the constraint too. Then choose Add
(with Targets), and choose your constraint method. The cube will now be chosen as the target object.

Copy Constraints to selected Bones
Copies the constraints with all its settings to the selected bone.
Usage:
Select the bone where you want to copy the constraints to. Hold down shift, then select the bone that contains
the constraints. Then perform the tool. The constraints will be copied.
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Clear Pose Constraints
Removes all bone constraints modifiers from the bone.

Inverse Kinematics
Inverse Kinematics is a menu with two isolated items from the whole
bone constraints menu. The Inverse Kinematics. You could also add an Inverse Kinematics bone constraint by
the Constraints / Add (With Targets) menu item from above. It is in the list. But this menu allows quick access
without big search.

Add IK to Bone
Add IK to bone adds an IK bone constraint to
the selected bone. When you add an IK
constraints with just the bone selected, then it
adds an empty as a handler too, and fills it in as
a target.

You can define a own target object too. The armature needs to be in pose mode. Let's create a cube or another
primitive. Select it. Now hold down Shift, and click at the bone where you want to add the constraint too. Then
choose Add (with Targets), and choose your constraint method. The cube will now be chosen as the target
object.

Last Operator Add IK to Bone
With Targets
Here you can define if you want to add the IK constraints with or without a target.

Remove IK
Removes all IK bone constraint(s) at the selected bone(s).
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Bone Groups
Bone Groups is a menu to handle bone group functionality from within a
menu in the 3D view. The bone groups themselves can be found in the
Properties editor.

Assign to New Group
Assigns the selected bone(s) to a new group.

Assign to Group
Assigns the selected bone(s) to a existing group.

Last operator Add Selected to Bone Group
This last operator belongs to both tools. Assign to New Group, and Assign to Group.
Bone Group Index
Here you can adjust the Bone Group Index. An Index of 0 creates a new bone group. Higher values tries to
assign the bone to existing bone groups instead.

Remove selected from Bone Groups
Removes the selected bone(s) from the assigned bone groups.

Remove Bone Group
Removes the currently active bone group.

Pose Library
The content of this menu belongs to the Pose library. Which can be found
in the Properties editor.
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Browse Poses
With this feature you can browse through the available poses in the 3D view. While operation you will see
informations in the header. It shows you what the current pose is, and how to navigate to the next or previous
pose.
Note that you need to have the bones selected for which you want to display the poses. When in doubt, select all
bones.

Last Operator Pose lib Browse Poses
Pose
Here you can scroll through the poses

Add Pose
Here you can add a new pose for your armature to the pose library.
Note that you need to have the bones selected for which you want to
add the pose. It just records the pose for the selected bones.
Calling the tool opens a popup where you can choose how you want to add the current pose.

Add New
Adds a new pose.

Add New (Current Frame)
Adds a new pose at the current frame. It does NOT record a keyframe.

Replace Existing
Here you can replace an existing pose.
Last Operator Pose Lib Add Pose
Frame
The frame at which this pose should be created
Pose Name
Here you can rename the pose while creation.

Rename Pose
Here you can rename a pose. It opens a popup menu where you can choose
the pose to rename, and where you can rename it. One pose at a time.
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Last Operator Pose Lib Rename Pose
New Pose Name
Here you can enter the new pose name.
Pose
Here you can choose the pose that you want to rename.

Remove Pose
Removes the currently active pose. The tool opens a popup where you can choose the pose
to remove.

Last Operator Pose Lib Remove Pose
Pose
Here you can again choose which pose to remove.

Paste X-Flipped Pose
Pastes a formerly copied pose, and flips it around the X axis of the object. Local.

Paste Pose
Pastes a formerly copied pose.

Last Operator Paste Pose
This Last Operator belongs to both paste actions. Paste Pose and Paste X-Flipped Pose
Flipped on X-Axis
Flips the pasted pose around the X axis of the object.
On Selected Only
Pastes just to the currently selected bones. Not to the whole armature.

Copy Pose
Copies the current pose.

Apply
Apply is a menu with some Apply functionality.
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Apply Pose as Rest Pose
You need a rest pose where you can reset the pose back to. With this tool you can set the current pose to be the
new Rest pose.

Apply Visual Transform to Pose
Apply final constrained position of posed bones to their transform.

Clear Transform
Clear transform is a menu with some Clear functionality. You need to
have the bones selected where you want to perform the operation.
Unselected bones will not be calculated.

All
Resets location, rotation and scale back to the Rest pose.

Location
Resets location back to the Rest pose.

Rotation
Resets rotation back to the Rest pose.

Scale
Resets scale back to the Rest pose.

Reset Unkeyed
Resets the pose for the selected bones back to the state of the latest keyframe.

Last Operator Clear User Transforms
Only Selected
Clear User transform for selected armature part, or for the whole armature.
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Sculpt Mode - Sculpt Menu
The Sculpt menu contains just one menu item at the moment. Subdivide.

Subdivide
Subdivide is a menu where you can
quickly set the subdivision level of the
selection.
What it does is to add a SDS modifier
in the Properties Editor if required. And set the SDS level to the needed value.
Crtrl 0 sets SDS to level 0. Ctrl 1 sets SDS level to 1 , and so on.
SDS happens at Object mode level. Even when you apply it in the Sculpt
Mode! And it happens at the whole object.

Last Operator Subdivision Set
The last operator Subdivision Set is greyed out in Sculpt mode.

Sculpt Mode - Brush Menu
This menu contains brush related tools.

Reset Brush
Resets the current brush size to default size.

Sculpt Mode - Hide/Mask Menu
This menu contains some masking functionality.
Masking is a way to control which areas of the mesh are influenced by sculpting. To
edit a mask manually, select the Mask Brush from the Brush panel.
Masked parts turns black.
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Lasso Mask
Select part of the mesh with a lasso tool.
Hotkey only tool, since the menu item is a bad starting point.

Box Mask
Select part of the mesh with a Rectangle tool.

Clear Mask
Clears the mask.

Fill Mask
Fills the mask with a given value, or inverts its values.

Invert Mask
Inverts the mask.

Hide Masked
Hides the masked mesh part.

Show Bounding Box
Lets you rectangle select a screen area to make hidden masked parts visible again.

Hide Bounding Box
Lets you rectangle select a screen area to hide mesh parts.

F81

Bforartists Reference Manual - © Copyright - This page is Public Domain

Show All
Makes all invisible mesh parts visible again.

Vertex paint Mode - Paint Menu
The Paint menu contains tools for vertex painting in Vertex paint mode.

Bright / Contrast
This tool allows you to adjust the brightness and the contrast of the vertex painting. You
adjust the settings in the last operator.

Last Operator Vertex Paint Bright/Contrast
Brightness
Adjust the brightness of the vertex colors.

Contrast
Adjust the contrast of the vertex colors.

Hue Saturation Value
This tool allows you to adjust the hue, saturation and value values of the vertex painting. You adjust the settings
in the last operator.

Last Operator Vertex Paint Hue Saturation Value
Hue
Adjust the Hue of the vertex colors.

Saturation
Adjust the Saturation of the vertex colors.

Value
Adjust the Value of the vertex colors.

Levels
This tool allows you to level the values of the vertex painting. You adjust the settings in the last operator.
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Last Operator Vertex Paint Levels

Offset
Adjust the Offset of the vertex colors.

Gain
Adjust the Gain of the vertex colors.

Invert
Inverts the vertex colors.

Vertex Color from Weight
This tool requires to have Weight Painting at the mesh. It converts the weight paint
colors into greyscale vertex colors.

Dirty Vertex Colors
Dirty vertex colors is a special tool for ageing meshes. Let's for example imagine we have a
relief. Edges that are outstanding are often touched, and tends to become brighter. While areas
in the inner side of a relief are not so often touched. And here the relief collects dirt too. So
this areas becomes darker.
And that's what the tool simulates. It makes the outer edges brighter, and the inner edges darker. This
calculation is somehow similar to Ambient Occlusion. Ambient Occlusion makes corners darker. The dirty tool
makes edges brighter too. And it calculates with the vertices. Not Texel positions like AO.
You need to convert this result to a texture to use it in your texturing, as a mask for example. This conversion
can be done by baking.
The tessellation of the mesh should not be too high for this operation. Since it calculates the angles of the mesh
edges.

Last Operator Dirty Vertex Colors
Blur strength
How strong the result should be blurred
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Blur Iterations
The number of iterations for the blur.

Highlight Angle
The angle for the bright areas. Angles higher as this value will not be recognized as a edge to highlight.

Dirt Angle
The angle for the dark areas. Angles lower as this value will not be recognized as a corner to darken.

Dirt only
Ignore the highlight areas, just calculate the dirt angles.

Smooth Vertex Colors
Smooths out the vertex colors.

Set Vertex Colors
Flood fills the vertex colors with the current vertex color value.

Weight Paint Mode - Select Menu
The Select menu in Weight Paint mode provides you with
some selection tools for masking. This menu is just visible
when you have either Face selection masking or vertex
selection masking activated. The content differs between
those two modes. Ungrouped Verts is just visible with Vertex
Selection masking. The three "Linked" menu items just with
Face Selection masking.

Linked
Just active with Face selection masking. Select linked faces.

Linked Pick Select
Just active with Face selection masking. Hotkey Only Functionality! This entry exists so that you know the tool
is there and that you can edit the hotkey.
Linked Pick Select selects the linked faces under the cursor.
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Linked Pick Deselect
Just active with Face selection masking. Hotkey Only Functionality! This entry exists so that you know the tool
is there and that you can edit the hotkey.
Linked Pick Select deselects the linked faces under the cursor.

Ungrouped Verts
Just active with Vertex selection masking. Selects ungrouped Vertices.

Last Operator Select Ungrouped
Extend
Extends the selection.

Inverse
Inverts the current selection.

(De)Select All
Toggles between select all and deselect all.

Last Operator (De)Select All
Action
Action is a drop-down box where you can choose between different methods.
Invert
Inverts the selection.
Deselect
Deselects all.
Select
Selects all.
Toggle
Toggles between select all and deselect all.
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Circle Select
Circle select enters the Circle Select mode. This is a special
select mode where you can select elements by moving with
the mouse over it. It adds to selection by default.
To subtract from selection hold down Shift key. To exit the
Circle select click with the right mouse button.
The pencil radius of the circle select tool can be adjusted
with the scroll wheel.

Note
You cannot navigate while you are in Circle Select mode. You have to leave the Circle Select mode, do the
navigation, then re enter the Circle Select mode.

Border Select
Border select enters the Border Select mode. This is a special select mode where
you can select elements by dragging a rectangle. And what's inside of the
rectangle gets selected then. It adds to selection by default.
To subtract from selection hold down Shift key.
The selection gets applied when you release the mouse. You leave the mode
automatically when you release the mouse.

Lasso Select
Lasso select enters the Lasso Select mode. This is a special select mode where you can select elements by
dragging a form around what you want to select. And what's inside of the rectangle gets selected then. It adds to
selection by default.
To subtract from selection hold down Shift key.
The selection gets applied when you release the mouse. You leave the mode automatically when you release the
mouse.

Note
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You can of course also start with clicking at the menu item. But this tool is by design a hotkey only tool. Hold
down Ctrl , and select with left mouse button.

Weight Paint Mode - Weights Menu
The weights menu contains some tools around Weight Painting.

Set Weight
This tool is just active when you have either Face selection masking or vertex selection masking activated.

The tool fills the selection with the current active Weight color that you have adjusted in the Brush panel in the
Tools tab in the Tool shelf.

Assign from Bone Envelopes
Weights the vertices from the connected bone envelopes. And takes the distance to the bone envelope into
account.

Assign Automatic from Bones
Weights the vertices connected with the bone. And takes the distance to the bone into account.

Last Operator Weight from Bones
This last operator is the same for both tools. Assign Automatic from Bones, and Assign
from Bone Envelopes.

Type
Here you can choose if you want to Assign from Bone Envelopes, or from Bones.

Texture Paint Mode - Select Menu
The Select menu in Weight Paint mode provides you with some selection tools for
masking. This menu is just visible when you have either Face selection masking or
vertex selection masking activated.
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Linked
Select linked faces.

Linked Pick Select
Hotkey Only Functionality! This entry exists so that you know the tool is there and that you can edit the hotkey.
Linked Pick Select selects the linked faces under the cursor.

Linked Pick Deselect
Hotkey Only Functionality! This entry exists so that you know the tool is there and that you can edit the hotkey.
Linked Pick Select deselects the linked faces under the cursor.

Inverse
Inverts the current selection.

(De)Select All
Toggles between select all and deselect all.

Last Operator (De)Select All
Action
Action is a drop-down box where you can choose between different methods.
Invert
Inverts the selection.
Deselect
Deselects all.
Select
Selects all.
Toggle
Toggles between select all and deselect all.
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Circle Select
Circle select enters the Circle Select mode. This is a special
select mode where you can select elements by moving with
the mouse over it. It adds to selection by default.
To subtract from selection hold down Shift key. To exit the
Circle select click with the right mouse button.
The pencil radius of the circle select tool can be adjusted
with the scroll wheel.

Note
You cannot navigate while you are in Circle Select mode. You have to leave the Circle Select mode, do the
navigation, then re enter the Circle Select mode.

Border Select
Border select enters the Border Select mode. This is a special select mode where
you can select elements by dragging a rectangle. And what's inside of the
rectangle gets selected then. It adds to selection by default.
To subtract from selection hold down Shift key.
The selection gets applied when you release the mouse. You leave the mode
automatically when you release the mouse.

Lasso Select
Lasso select enters the Lasso Select mode. This is a special select mode where you can select elements by
dragging a form around what you want to select. And what's inside of the rectangle gets selected then. It adds to
selection by default.
To subtract from selection hold down Shift key.
The selection gets applied when you release the mouse. You leave the mode automatically when you release the
mouse.
Note
You can of course also start with clicking at the menu item. But this tool is by design a hotkey only tool. Hold
down Ctrl , and select with left mouse button.
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Particle Mode - Select Menu
The Select menu in Particle mode provides you with some selection tools to edit the
particles.
When you are in Emitter mode then most of the menu items are greyed out. This menu
items are for Hair particles.

Less
Select less.

More
Select more.

Linked
Select linked geometry.

Deselect Linked
Deselect linked geometry.

Select Tips
Selects the end vertices of hair particles.

Last Operator Select Tips
Action
A dropdown box where you can choose what you want to do.

Select Roots
Selects the start vertices of hair particles.

Last Operator Select Roots
Action
A dropdown box where you can choose what you want to do.
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Random
Selects random objects.

Last Operator Select Random
Percent
The Percentage of objects that should be selected randomly.
Random Seed
The Seed for the random number generator.
Action
Action is a drop-down box where you can choose if you want to select or to deselect random.

Inverse
Inverts the current selection.

(De)Select All
Toggles between select all and deselect all.

Last Operator (De)Select All
Action
Action is a drop-down box where you can choose between different methods.
Invert
Inverts the selection.
Deselect
Deselects all.
Select
Selects all.
Toggle
Toggles between select all and deselect all.

Border Select
Border select enters the Border Select mode. This is a special select mode where
you can select elements by dragging a rectangle. And what's inside of the
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rectangle gets selected then. It adds to selection by default.
To subtract from selection hold down Shift key.
The selection gets applied when you release the mouse. You leave the mode automatically when you release the
mouse.

Lasso Select
Lasso select enters the Lasso Select mode. This is a special select mode where you can select elements by
dragging a form around what you want to select. And what's inside of the rectangle gets selected then. It adds to
selection by default.
To subtract from selection hold down Shift key.
The selection gets applied when you release the mouse. You leave the mode automatically when you release the
mouse.

Note
You can of course also start with clicking at the menu item. But this tool is by design a hotkey only tool. Hold
down Ctrl , and select with left mouse button.

Particle Mode - Particle Menu
The Particle menu contains some tools to modify the particles.

Show/Hide
Show/Hide is a menu. Here you can show or hide objects in the
viewport. See chapter All Modes, all Object types - Show / Hide

Delete
Brings up a popup where you can choose to delete either the selected particle(s)
or the selected key(s).
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Last Operator Delete
Type
Here you can again choose what type to delete. Particle or Key.

Grease Pencil - Edit Strokes Mode
The Edit strokes mode allows you to edit your grease pencil strokes. The Select menu contains the usual select
methods. The GPencil menu contains some further functionality.

Gpencil Menu
Convert to Geometry
Convert to Geometry is a sub menu with thee menu items.

Path
Convert selected Grease pencil stroke into a Path.
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Bezier Curve
Convert selected Grease pencil stroke into a Bezier Curve.

Polygon Curve
Convert selected Grease pencil stroke into a Polygon Curve.
Last Operator Convert Grease Pencil
Type
Here you can again choose the conversion method again.
Normalize Weight
Normalize weight, set from stroke width
Radius Multiplier
Multiplier for the points radii, set from stroke width
Link Strokes
Link strokes with zero radius sections of curves.
Timing
For animation - the timing method
Frame Range
For animation - the frame range
Start Frame
For animation - the start frame
Realtime
For animation - Realtime update or not
End Frame
For animation - the end frame

Move to Layer
Grease pencil strokes gets created at layers. Here you can
move the strokes to a new layer

New Layer
Creates a new layer, and moves the selection to this layer.

GP Layer
Choose an existing layer and move the selection to this layer.
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Last Operator Move Strokes to Layer
Here you can again decide if you want to create a new layer,
or if you want to move the selection to an existing layer.

Hide active layer
Hides the active layer.

Last operator Hide Layer(s)
Unselected
Hides the unselected layers. See next point.

Show Active Layer only
Should be called Hide unselected! Show active layers, and hide all others.

Last operator Hide Layer(s)
Unselected
Hides the unselected layers.

Show all Layers
Makes all hidden layers visible.

Last Operator Show All Layers
Select
Selects all geometry in the layer.

Isolate Layer
Locks the active layer. This corresponds with the lock symbol in
the Grease Pencil Layers panel.

Last Operator Isolate Layer
Affect Visibility
Make the layer invisible too.
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Animation
Animation is a sub menu around animation functionality. You
need to have an object in the scene.

Insert Keyframe
Opens a menu where you can insert a keyframe with a defined keying set.

Delete Keyframes
Deletes keyframes at the current frame.

Clear Keyframes
Deletes all keyframes.

Change Keying Set
Opens a menu where you can change the keying set.

Bake Action
Bake the keyframes into an action.
This tool calls a dialog with the bake settings. They are
identical with the last operator.
Start Frame
Defines the start frame.
End Frame
Defines the end frame.
Frame Step
Defines the number of keyframes per step
Only Selected
Only key selected bones.
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Visual Keying
Keyframe from the final transformations.
Clear Constraints
Remove all constraints and do visual keying.
Clear Parents
Bake animation onto teh object, then clear parents. This is for objects only.
Overwrite current Action
Bake animation into current action.
Bake Data
You can either bake to pose, or bake to object.

Snap
Snap is a sub menu with snapping functionality.

Selection to Grid
Selection to Grid snaps the selected element(s) to the closest Grid point.

Selection to Cursor
Selection to Grid snaps the selected element(s) to the 3D cursor. ALL selected elements will end at cursor
position. For example all selected vertices.

Selection to Cursor ( Offset )
Selection to Grid snaps the selected element(s) to the 3D cursor. The centre of the selected elements will snap to
the 3D cursor. A group of vertices for example will remain its shape.

Cursor to Selected
Cursor to Selected snaps the 3D cursor to the selected element.

Cursor to Centre
Cursor to Centre snaps the 3D cursor to the centre of the world.

Cursor to Grid
Cursor to Grid snaps the 3D cursor to the closest Grid point.

Duplicate
Duplicates the current selection. The copy sticks to the mouse until you release it. A Right click while moving
will reset the position of the duplicate. The duplicated part will be part of the same object.
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When you drag the duplicate around you will see the position values in the

Delete
Delete is a sub menu where you can define what exactly you
want to delete.

Points
Delete the vertices of the selection. The strokes gets split at
this point.

Strokes
Delete the whole stroke(s).

Frames
Delete the grease pencil frames.

Last Operator Delete
Type
Type is a dropdown box where you can choose the delete method again.´

Dissolve
Delete selected points without splitting strokes.

Delete all active frames
Delete all active frames of all editable grease pencil layers.

Copy
Copies the selected selection(s).

Paste
Pastes copied selection(s).

Last Operator Paste Strokes
Select
Select pasted object(s).
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Pie menus
Pie menus is a sub menu that contains operators to call pie
menus. This pie menus contains the tools from the tool
shelf, and provides an easier access, since the menu
appears directly under the mouse.
This pie menus are hotkey tools! They are meant to be used with hotkeys in the 3D viewport. The menu entries
are fully functional. They call the pie menus. But are meant as a visual hint.

Tools Pie menu

Settings Pie menu

Sculpt Pie menu

Header Tool - Mode Drop-down Box
The Mode drop-down box allows you to switch between
the different modes.
Modes are object states that allows you to edit and
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manipulate objects at different levels with different tool sets and goals. The sculpt mode for example allows you
to sculpt a mesh object. Edit Mode allows to manipulate the mesh of the object, and so on.
The available modes can differ from object to object. A armature for example has an additional pose mode. And
when you work with the grease pencil, then the Edit Strokes mode becomes available.

Object Mode
This mode allows to manipulate objects at Object level. Like move it around, rotate it, etc. This mode is
available for all object types.

Edit Mode
The edit mode allows to edit the object. With a mesh object this means that you are able to modify and to
change the geometry. With an armature you build your skeleton. And with a text object you can type in text, and
choose the font etc.
Not all objects has an edit mode.

Sculpt Mode
Sculpt mode is a mesh object only mode. In this mode you can sculpt the mesh.

Vertex Paint
Vertex Paint is a mesh object only mode. In this mode you can paint vertices with colors.

Weight Paint
Weight Paint is a mesh object only mode. In this mode you can adjust weight painting for an armature for
example. But Weight Painted mesh objects can also be used in conjunction with particles.

Texture Paint
Weight Paint is a mesh object only mode. In this mode you can paint at the texture of a mesh directly. This
mode requires to have a working UV mapping and a texture at the mesh object.

Edit Strokes
Edit Strokes is a Grease Pencil only mode. It allows to manipulate the curves at a mesh level.

Particle Edit
Particle edit is a Particle System mode only. When you apply a particle system to a mesh object then this mode
becomes available. It allows you to manipulate the particle system at a mesh level. You can comb hair particles
for example.
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Header Tool - 3D Manipulator Widget
The 3D Manipulator widget tool allows you to enable and to disable a
3D Manipulator widget in the viewport. It is made of several sub
elements.
This element exists in most modes. But in Sculpting mode for example the 3D Manipulator
is not available.

3D Manipulator
This button activates or deactivates the widget. Have a look at the shortcut here.

Transformation manipulator Translate, Rotate and Scale
Here you can activate or deactivate three different types of widgets. One for
Translate, one for Rotate, one for Scale.
You can also activate more than one widget at a time. Hold down shift while
clicking at one of the buttons adds to the selection.
When you use the translate and scale widget, then you can transform in two
directions by holding down shift. For example when you use translate widget and pull at
the blue handler for upwards in Z direction, then you don't pull upwards, but sidewards in
X and Y direction. The green and red line indicates the movement freedom.

When you use the Translate widget and hold down Ctrl, then you move the object with a snapping of one unit.

Last Operator Translate, Rotate and Resize
For the last Operator Translate, Rotate and Resize please have a look in the chapter Navigation Menu. They are
identical.

Transform Orientation
Transform Orientation is a drop-down box where you can choose between different
orientation methods for the transform operation. The widget points into this direction
then.

View
The transform orientation aligns to the current view.

Gimbal
Aligns each axis to the Euler rotation axis as used for input.
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Normal
This is of interest for bones for example. Aligns the transformation axis to average normal of the selected
elements. Bone Y axis for Pose mode.

Local
Uses the local orientation of the selected elements.

Global
Uses the global orientation for the selected elements.

Header Tool - Proportional Editing
Proportional editing is a way to transform selected elements with some kind of a falloff. So when you for
example pull a vertice upwards in Edit mode, the neighbour vertices will also pull upwards, but not so strong.
The neighbours gets influenced proportional.
Proportional Editing is not available in all modes.

Proportional editing in Object mode is made of two elements. The on off switch. And a
drop-down box where you can choose the falloff method.

In Edit Mode with a mesh object you just have the on off switch. But here you can choose
between three different falloff modes.
Both settings can be found in the Last Operator panel, when you for
example move or scale an object or selection.

Changing the Proportional influence radius
You can change the influence radius for proportional editing with the mouse wheel or the Page up Page down
arrows while keeping the mouse button pressed down for translate, rotate or scale. Or at the widget.

Usage:
Create for example two cubes. Now move one of it around. Enable proportional
editing. Choose your favourite falloff method if you want.
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When you click at the widget you will see a white circle around the Pivot point. That's the influence radius for
the proportional editing.
Now increase the radius for falloff. So that the second cube is in the influence radius. You will see it moving at
one point.
In the last operator Translate there is also a Proportional Size edit
box that shows you the size of the radius. Here you can adjust the
value too. But note that it will not update the visible influence
radius in the 3D view. And when you change the radius in the
viewport with the scroll wheel, then it will use the old value, and
not the value that you have typed in here. So you better adjust the
radius in the viewport. And use this edit box as a visual feedback.

Header Tool - Transform Snapping
Transform Snapping
This element is for snapping while transformation. Not to mix with the snapping tools in the
Tools tab in the Tool Shelf. The Transform Snapping tool includes for example grid
snapping.
Transform Snapping is not available in all modes.
The Transform Snapping tool is made of three elements.

Transform Snapping
Here you enable or disable snapping.

Snap Element
Snap Element is a drop-down box where you can choose between different snapping
methods.

Volume
Snapping happens to the volume of another object.

Snapping
Snapping happens to the face of another object.

Edge
Snapping happens to the Edge of another object.
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Vertex
Snapping happens to the Edge of another object.

Increment
Snapping happens relative to the ground grid.

Absolute Grid alignment while translating
With this feature on the selection snaps to the grid points. Without this feature it snaps increasing by unit size.
When you have a grid snapping of 1, and an element at 0.56, then without absolute grid alignment it will snap
at 1.56, 2.56 etc. With absolute grid snapping it will snap at 0, 1, 2 etc.

Header Tool - Viewport Shading
The Viewport shading drop-down box contains the different shading modes for the viewport.
It exists in all modes.

Rendered
Displays the content in the viewport like you would have rendered it. This mode is
dependant of what render engine you have currently active. And is available for Blender
Render and Cycles.

Material
Displays the content in the viewport with all material settings and with OpenGL rendering.

Texture
Displays the content in the viewport textured. You need of course a working UV mapping and a texture at the
mesh to see it.

Solid
Displays the content in the viewport with a solid white color.

Wireframe
Displays the content in the viewport as Wireframe.

Bounding Box
Displays the content in the viewport as Bounding box. The mesh content is not displayed.

F104

Bforartists Reference Manual - © Copyright - This page is Public Domain

Header Tool - Pivot Point
The Pivot Point is the point around which the object manipulation happens. Rotation,
mirroring, and so on. Normally this happens around the pivot of the active object. In this
menu you can set the pivot point to other locations. Like the position of the 3D cursor.
It exists in all modes.

Active Element
With this setting the manipulation happens relative to the center of the selected active elements. With more than
one element is involved, then in Object mode this center gets calculated from the elements pivots. In edit mode
the pivot is also the median point.

Median Point
With this setting the manipulation happens relative to the median point of the selected elements. This can be
another point than calculating the center of the pivots. The median gets calculated from the geometry, not from
the pivot point of the geometry.

Individual Origins
With this setting the manipulation happens relative to the origins of the selected elements. The origin is the little
orange dot in every element.

3D Cursor
With this setting the manipulation happens relative to the 3D cursor.

Bounding Box Center
With this setting the manipulation happens relative to the Bounding Box Center.

Header Tool - Manipulate Center Points
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This option is of interest when you have more than one object selected. With this option enabled a
transformation will change the positions of the object’s origins, but will not affect the object itself.
For example, when you want to scale a group of selected cubes. Without the option enabled the cubes will scale
also down when you scale the selection. With this option enabled, the cubes will keep their size. But they will
scale closer together. The Pivot points gets scaled.

Header Tool - Mesh Object - Edit Mode - Mesh Select Mode
The mesh select mode in Edit Mode with a Mesh object allows you to switch between the three available
selection modes Vertice select, Edge Select and Face Select.

You can have more than one mode active by shift clicking at the other mesh select modes.

Header Tool - Mesh Object - Edit Mode - Limit Selection to
Visible
Limit selection to visible limits the view to what you can see from the front. By default the back geometry
shines a bit through.
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Header Tool - Mesh Object - Face selection masking for
Painting

Painting at a Mesh object has two header tools that just belongs to the painting operations. One of it is Face
selection masking for Painting. It is visible in Vertex Paint Weight Paint and Texture Paint.

Face selection masking for Painting
When you activate this tool then you reveal a Select menu in the header. And you
can select the mesh parts that you want to manipulate.
Note that you may first want to deselect all. By default everything is selected ...

The select menu is explained in the chapter Vertex Painting - Select Menu.

Header Tool - Mesh Object - Vertex selection masking for
Painting

Painting at a Mesh object has two header tools that just belongs to the painting operations. One of it is Face
selection masking for Painting. It is visible in Vertex Paint and Weight Paint.

Vertex selection masking for Painting
When you activate this tool then you reveal a Select menu in the header. And you can select the mesh parts that
you want to manipulate.
This tool is meant for Weight Painting. And so the mesh displays the vertices too.
Note that you may first want to deselect all. By default everything is selected ...
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The select menu is explained in the chapter Vertex Painting - Select Menu.

Header Tool - Particle Edit - Select modes
The Select modes allows you to change the display and the editability of the particle vertices.

Path
No keypoints are visible. You can only select or deselect all keypoints at once.

Point
You see all keypoints. And all keypoints are editable

Tip
You can only see and edit the tip keypoints.

Header Tool - Reset 3D View
Reset 3D View is a navigation element. It resets the 3D view to a predefined setting.
It exists in all modes.
Reset 3D View is an add-on, and can be uninstalled when wanted. But note that the functionality is missing
then.
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Header Tool - Align View Buttons
The Align View buttons contains some quick navigation elements
to navigate in the viewport. You can switch between the different
views, switch between orthographic and perspectivic view, switch
to camera view and back to viewport view, and set the active camera.
It exists in all modes.
Align View Buttons is an add-on, and can be uninstalled when wanted. But note that the functionality is missing
then.

Top, Bottom, etc.
Switches to Top view, Bottom View, etc.

View Persp/Ortho
Toggles between perspectivic and orthographic view. Perspectivic view acts like a real camera with the
perspectivic distortions. Orthographic view acts like a mathematical display of an object, without distortions.

Align View to active Camera
Switches to Camera view and back to Viewport Camera.
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Set Active Camera
Sets the currently selected camera as the active camera. The active camera is the camera that gets used for
rendering.
You need to have a camera object selected to activate the tool. Unlike the tool in the View menu, this tool here
just works for camera objects.
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Introduction
The 3D View is made of several areas.
Yellow is the Tool Shelf.
Blue is the Header or Menu bar. It can be at the top or
the bottom.
Green is the Viewport. Here you will see and work
with your 3D data.
Red is the Properties Sidebar.
The content of the Tool Shelf , the Header and the
Properties Sidebar can vary. It depends of the type of
the objects and the modes that you are in.
This chapter here is about the Properties Sidebar.

Properties Sidebar
The Properties Sidebar contains various settings for the 3d view.
The Properties Sidebar is made of several panels. The range goes from object related
settings, Grease Pencil settings, across things like Motion Tracking settings, Background
Image settings, up to to Viewport related settings.
Most panels shows in all modes and with all content. Some Panels and its content is
varying dependant of what object type you use, and in what object mode you are.

Grease Pencil Layers Panel
The Grease Pencil Layers are connected with the Grease Pencil
panel in the Tool Shelf. And provides you with the layer
settings for the Grease Pencil.
When no layer exists then there are just a few buttons available.
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Scene / Object
Here you can adjust if the Grease Pencil stroke is relative to the selected object, or relative to the Screen.

Grease Pencil Prop
Here you can add a new grease pencil to work with. Or choose an existing
grease pencil.
The edit box allows you to rename the current grease pencil.
The F Button adds a fake user to the grease pencil. So that it does not get
deleted when you delete the connected object and close the scene.
When you add a fake user, then a number field will appear that shows how
much users are connected with the current pencil.

New Layer
Here you can create a new layer for your grease pencil. Doing so will reveal several layer
settings. And another panel with some color settings.

Layer list
Here you can see a list of the current layers. And here you can select the current
active layers.
Grease Pencil Layers can be locked (lock icon) and hidden (eye icon). The third
symbol is to unprotect selected colors from further modifications.
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Add / Delete
Right besides the layer list box there is a add button and a delete button. The plus button adds a new
layer, The minus button removes the current layer.

Layer Specials menu
Below the add and delete buttons there is a text menu with some further options.

Duplicate Layer
Duplicates the currently selected layer.

Show All
Unhides all hidden layers.

Hide Others
Hides all layers but the selected.

Lock All
Locks all layers.

Unlock All
Unlocks all layers.

Merge Down
Merges all layers into one.

Move Up / Move down
Moves the currently selected Grease pencil layer one up or down the list.

Lock Unlock unselected / Show Hide unselected
Lock Unlock unselected toggles the lock for the unselected layers.
Show Hide unselected toggles the visibility for the unselected layers.

Opacity
Opacity sets the opacity of the current grease pencil stroke.
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X Ray
X Ray makes the grease pencil stroke appear in front of objects. Without X Ray the stroke will be
invisible behind objects.

Show Points
Shows the points in the current grease pencil stroke.

Tint
Tint tints the color of the current grease pencil stroke with the tint color.
The upper field is a color picker where you can select a color. The fac slider defines the blending
factor between the grease pencil stroke color and the tint color.

Parent
Here you can set the parent object for the current grease pencil layer

Thickness Change
Increase or decrease the thickness of the grease pencil stroke.

Lock Frame
You can draw grease pencil strokes in different frames. Here you can lock those frames
from further editing.
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Onion Skinning
You can draw grease pencil strokes in different frames.
With onion skinning you can display the strokes from the
previous and following frames as ghost drawings.

Onion Skinning checkbox
Activates / deactivates the onion skinning.

Use always ghosts
When activated the ghost images will also show in rendering.

Use custom colors
Here you can choose to display the ghost drawing in predefined colors, or in their original colors. Default is to
display the predefined colors.

Before
Here you can choose in which color the previous frame gets displayed. And how many frames gets displayed
before the current frame.

After
Here you can choose in which color the following frame gets displayed. And how many frames gets displayed
after the current frame.

Grease Pencil Colors Panel
The grease pencil colors panel contains all the settings to set up and define the colors
that you use for your grease pencil drawings.
It activates when you start to draw a grease pencil stroke. And shows its content then.

GP Palette
Here you can select, create and delete a color palette for the grease pencil colors.
Define some colors in the Color list, then create a new palette with it.
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Color List
Here you can add custom colors.
The color field at the beginning of the edit box reveals a color picker when you click
at it. Which allows you to define a color.
The string “Color”, “Color 002” and “Color 003” is an edit box which allows you to
rename the color. Click into the field to activate it.
The Lock symbol allows you to lock the current color.
The eye symbol allows you to show or hide the current layer.
The ghost symbol allows you to display this color with onion skinning.

Add / Delete
Right besides the layer list box there is a add button and a delete button. The plus button adds a new
layer, The minus button removes the current layer.

Palette color Specials menu
Below the add and delete buttons there is a text menu with some further options.

Show All
Unhides all hidden colors.

Hide Others
Hides all colors but the selected.

Lock All
Locks all colors.

Unlock All
Unlocks all colors.

Copy color
Copys the color.

Select strokes
Selects all grease pencil strokes that uses the curent color.

Move to color
Move selected strokes to active color.
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Strokecolor
Here you can define the stroke color and set its opacity.

Volumetric Strokes
With Volumetric strokes the grease pencil stroke does not draw as a stroke, but a line of
dotted points.

Fill
Fill fills the space between the grease pencil strokes.
The opacity is by default at zero. The fill color shows when you
increase the opacity.

High Quality Fill
Fill Strokes uses high quality to avoid glitches. But this gives slower fps while animation. Here you can turn it
off.

View panel
The View panel contains some camera settings for the world camera and the render
camera.
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Lens
Here you can setup the lens viewport angle for the world camera. You need to
be in perspectivic view. In Orthographic view the lens values doesn't have an
effect.

Clip
Here you can set up the clipping values for the world camera. Geometry behind
the end value and before the start value will not be drawn.

Render border
When you have defined a renderborder then you can toggle it with this switch. See View menu in the 3d view
header.

Submenu Lock
The submenu lock contains some camera settings regarding locking.

Lock Camera and Layers
This menu item also exists in the layers tab in the Tool shelf at the left.
Use the scene's active camera and layers in this view. And not local ones. When you
untick this menu item thenyou can define a local camera below.

Lock Camera to view
This menu item allows you to navigate in camera view like you would
be in world view. When it is unticked then you can navigate the
passepartout, you can zoom and move it. And when you rotate the view,
then you will leave the camera mode.

Lock to Object
Locks the view of the world camera to an object. Here you can choose an object for it.
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Lock to cursor
Locks the view of the world camera to the 3D cursor. You can either lock to an object or to the 3d cursor. When
you choose an object then the checkbox for the 3d cursor vanishes.

3D Cursor Panel
The 3d cursor panel contains the location edit boxes to display and set the 3D
cursor in X, Y and Z Position. And it contains a checkbox to lock the 3D cursor.
Of interest is also the RMB menu where you can reset the 3D cursor to 0/0/0.
Simply right click in one of the edit boxes and choose Reset All to default value.

Display Panel
The Display panel contains various settings around the display in the current 3D view
editor.

Icons or Text Buttons
The icons or text buttons checkbox defines if some of
the buttons in the Tool Shelf are displayed as pure icon
buttons, or as text buttons with icons.

3D Cursor
This checkbox can hide the 3D cursor.

Only Render
When ticked then just the objects that gets rendered are displayed. This option hides the groundgrid and things
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like relationship lines and pivot points.

Ground Grid
This checkbox can show or hide the whole Grid Floor at once. Other things like relationship lines or pivots are
still displayed.

Grid Floor
The Grid Floor prop contains the settings for the Grid Floor. Number of lines, scale etc.

Grid Floor Checkbox
Displays or hides the grey grid of the Grid floor

X, Y Z buttons
Displays the colored orientation lines.

Lines
The Lines edit box defines how much lines the grey grid has.

Scale
Scales the whole Grid Floor.

Subdivisions
This setting affects the orthographic views. Here you have sublines in the grey grid.
And with Subdivisions you can define how much sublines a gridcell has.

Miscellaneous subtab
The Miscellaneous subtab contains settings that you rarely use.

World Background
Show or hide the world background.

Outline Selected
Display the selected object with an outline.

All Object Origins
Display the origin of all objects in the scene. Normally just the origin of the selected object is displayed

Relationship Lines
When you have a parenting relationship, then you will see a dotted line between the parent and the child object.
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Shading Panel
The Shading Panel contains some shading related settings. You have different settings
available in different Viewport shading modes. And in different Object modes with
different object types too. So best thing is to list all available options instead of going
through all possible combinations in shading and object modes.

Shading Options
Backface Culling
Excludes the backfaces of the geometry from rendering.

Depth of Field
Use Depth of Field in the viewport from the active camera. Does not work with the world camera. You have to
be in camera view.

Ambient Occlusion
Use Ambient Occlusion in the viewport. When ticked some edit boxes with the Ambient
Occlusion settings are revealed.

Shadeless
Displays the texture shadeless. Shows in Viewport shading Textured.

Textured solid
Normally the Solid shading mode doesn't display textures. With this checkbox ticked it
does.

Matcap
Use Matcap Materials for solid display. Matcap stands for "material capture". It is a
complete material that includes lighting and reflections. This is useful for sculpting needs
for example. When you tick the Matcap checkbox then you will reveal a image field where
you can choose different matcap materials.
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Wire Tools Subtab
Wire Tools is an addon developed by Lapineige. You can turn it off in the addon manage
if you want.
It offers a few more display mode posibilities. For example, normally you have to setup
the mesh in the Properties editor to display the wireframe in Object mode. This can be
done with this addon.

Wire Selection (Auto)
Display the Wire of the selection. Auto Update when selecting another object.

Only Selection
No idea. Somebody should ask the addon developer.

Invert
No idea. Somebody should ask the addon developer.

Wire + Edges
Display the Wire and Edges.

Wire
Display the Wire.

Hide All
Removes the wire display.

Only Bounds
Displays the selected object just as a bounding box.

Textured
Displays the selected object as textured.
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Motion Tracking Panel
In case you do motion tracking with Bforartists, here are some options for it. Motion
Tracking is another word for Motion Capture. Motion capture (in short Mo-cap) is the
process of recording the movement of objects or people.
This panel can be activated an deactivated at once with the checkbox in the title.

Camera Path
Show or hide reconstructed camera path.

3D Marker Names
Show names for reconstructed track objects.

Track Type and Size
Here you can define the look and size of the track display type.

Background Images Panel
In this panel you can set up background reference images for
modeling or painting needs.
The panel can be activated an deactivated at once with the checkbox in the title.

Note
Background images only shows in orthographic views. Front, back, etc.

Add Image
The Add Image button adds a new image panel to the list of background images.

Image Panel
The Image panel contains the settings and data for the background image.

Image Panel Header
The header of the image panel contains the name of the file. The eye icon hides the image from the 3D view.
The X button removes the whole image panel from the list of background images.
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Data Source
Here you can define if you want to load a single image, or a movie clip.

Image Edit Box
The Image icon is a dropdown box where you can choose another image or
movie that is already loaded into Bforartists.
The edit box allows you to rename your image.
With the F button you can make this data block a fake user.
The Folder icon allows you to load another image here.
And the X button removes the image. The image panel is still there then.

Settings Subtab
Opacity
Controls the transparency of the background image.

Axis
Choose which views the image is visible from. This is helpful when you have several reference images from
different views (e.g. top, front and side).

Source
Here you can choose different source types.
Single Image
Single Image doesn't have further options.

Image Sequence and Movie
Frames
Number of frames to use.
Start
The start frame.
Offset
Offset the number of the frame to use in animation.
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Match Movie Length
Set the image user length to the one of the movie.
Auto Refresh
Always refresh image on frame change
Cyclic
Cycle the images in the movie.

Generated
Generated doesn't use an external image, but a generated one.
Color Space
In this dropdown box you can define the color space.
View as Render
Turns on or off the color management settings in the Properties window - Possible fail
entry. Shouldn't belong here.
Size edit boxes
Here you can set the size of the image
Float Buffer
Generate Floating Point Buffer. Gives a higher quality image.
Type
You can choose between three different types. Blank, UV Grid and Color.

Blank is a plain color that you can define in a color picker
below.

UV Grid is a black and white checker texture.

Color Grid is a colored checker texture.
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Align Subtab
This tools helps you to align the image in the view.

Back / Front
Display the image in the front of the scene objects, or behind the scene objects.

Stretch / Fit / Crop
This option is for camera view. It does not work with the world camera.
Stretch stretches the background image into the current camera view. It fills the whole view.
Fit fits the background image into the height of the current camera view. Offset parts are cut off.
Crop fits the background image into the width of the current camera view. Offset parts are cut off.

Offset Editboxes
Here you can position the image in x and y position.

Flip Horizontal
Flip the image horizontal.

Flip Vertical
Flip the image vertical.

Rotation
Rotate the image.

Size
Set the size of the image.

Important Hotkeys Panel
Important Hotkeys is an addon. It displays the most important
hotkeys as strings in the viewport.
This addon can be deactivated and uninstalled from the User
Preferences in case you don't need it anymore.

Show Text / Hide Text
Shows or hides the text.
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Color
Here you can set the color of the font.

Fontsize
Here you can set the size of the font.

Item Panel
When you have an object in the scene then you will see the Item panel.
This edit box shows the name of the current selected item. And here you can also rename
the item.

Stroke Select Panel
Stroke select is an addon. You can switch between
select and deselect with the right mouse button. This
panel is the visual end to show you in which mode
you currently are.

Transform Panel
The transform panel shows you the transform values. The content depends of what object
you have chosen, and in what mode you are. In Edit mode you may have other transform
values than in object mode. Non Primitive objects doesn't have a edit dimensions box,
and so on.

In Object Mode
Location
The location edit boxes. Here you can see and set the position of the selected object. The
lock symbol behind the edit boxes allows you to lock the axis position

Rotation
The Rotation edit boxes. Here you can see and set the rotation of the selected object. The
lock symbol behind the edit boxes allows you to lock the axis rotation.

Rotation mode
Rotation mode is a dropdown box where you can choose between different rotation
modes.
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Euler angles gets calculated with three values. Quaternions with four angles. And so
you get a fourth angle value when you choose Quaternions as the rotation mode.
The 4L button allows you to lock out the fourth component from editing.

Scale
The Scale edit boxes. Here you can see and set the scale factor of the selected object. The lock symbol behind
the edit boxes allows you to lock the axis scale.

Dimensions
The Dimensions edit boxes. Here you can see and set the dimensions of the selected object in world
coordinates. The lock symbol behind the edit boxes allows you to lock the axis rotation.
The Dimensions edit boxes are just available for primitives objects. Objects like Empties or a Camera doesn't
have a dimension, but a scale factor.

In Edit Mode
Just primitive objects does have an edit mode. Non primitive objects like a camera or an empty doesn't have an
edit mode. With two exceptions. Text and Force Field type Curve Guide. Both are curve types.

Mesh Objects
Median
Median is the position of the selected mesh part

Global / Local
Here you can define if the orientation of the selection is local to the selected object, or
global to the world coordinates.

Mean Bevel Weight - Vertices Data
Here you can adjust the bevel weight for the selected vertices when you have a bevel modifier at the mesh.

Mean Bevel Weight - Edges Data
Here you can adjust the bevel weight for the selected edges when you have a bevel modifier at the mesh.

Mean Crease
Here you can adjust the weight of the selected vertices when you have a subdivision surface modifier at the
mesh.

23

Bforartists Reference Manual - © Copyright - This page is Public Domain

Curve Objects / Surface Objects
Median
Median is the position of the selected mesh part

Global / Local
Here you can define if the orientation of the selection is local to the selected object, or
global to the world coordinates.

Mean Weight
Here you can adjust the weight used by softbody. Needs softbody.

Mean Radius
Here you can adjust the radius of the curve control points

Mean Tilt
Here you can adjust the tilt of the curve control points.

Metaball Objects
Median
Median is the position of the selected mesh part

Global / Local
Here you can define if the orientation of the selection is local to the selected object, or
global to the world coordinates.

Radius
Here you can adjust the radius of the selected meta element.

Stiffness
Here you can adjust the stiffness of the selected meta element.

Type
Type is a dropdown box. Here you can adjust the meta element type.

Text Objects
Text objects do have an edit mode, but they don't show content in the Transform panel.
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Armature objects Edit Mode
Bones do have a head and a tail. You cannot position the whole bone by numeric values,
but the head and tail joints.

Head
Here you can adjust the world position of the head joint.

Radius
This is just useful when you use Envelopes type bones. Here you can adjust the Envelope
radius of the head joint.

Tail
Here you can adjust the world position of the tail joint.

Radius
This is just useful when you use Envelopes type bones. Here you can adjust the Envelope radius of the tail joint.

Roll
Here you can adjust the bone roll.

Envelope
This is just useful when you use Envelopes type bones. Here you can adjust the overall Envelope size.

Armature Objects in Pose Mode
The content in Pose mode is the same than in Object mode. We have Location, Rotation
and Scale Edit Boxes. And the corresponding lock buttons.
Wiht one small difference. The rotation mode starts with Quaternions by default. And not
with Euler Angles.

Lattice Objects
You need to have some vertices of the Lattice object selected to see the content.

Vertex
Here you can see and set the vertex positions of the lattice objects.
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Global / Local
Here you can define if the orientation of the selection is local to the selected object, or global to the world
coordinates.

Mean Weight
Lattice object is a deform cage. Here you can adjust the mean weight of the selected vertice(s).

Mesh Display Panel
This panel just shows in Edit mode with a mesh object selected. It contains some mesh
related display settings like normals, or that you can display the length of an edge.

Normals
Here you can display the vertex, edge and faces normals at the selected mesh. The
size box allows you to adjust the length of the stroke that displays the normal.

Overlay Options subtab
This subtab contains various display settings.

Faces
Displays selected faces with the orange select color.

Edges
Displays selected edges with the orange select color.

Creases
Displays Creases.

Seams
Displays marked seams.

Show Weights
Shows the weights of the vertices.
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Sharp
Shows as sharp marked edges.

Bevel
Shows Beveled edges.

Edge Marks
Shows Edge Marks.

Face Marks
Shows Face marks.

Info Options subtab
The info Options subtab contains some settings with which you can display additional
informations at the mesh geometry. The values are in world coordinates.

Edge Info
Length
Displays the length of the selected edges.

Angle
Displays what angle the adjacent faces of the selected edges has.

Face Info
Area
Displays how big the area of the selected faces is.

Angle
Displays what angle the adjacent faces of the selected edges has.

Mesh Analysis Panel
The Mesh Analysis is to analyze mesh attributes for 3D printing. For example, Some
3D printers have a physical limit to the overhang that can be printed. Or it needs a
specific thickness.
The Mesh Analysis panel just shows in Edit mode with a mesh object selected. And in
Solid Mode. Furthermore you need to have a Deform modifier at the mesh. You can activate and deactivate the
whole panel at once in the header.
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Type dropdown box
Here you can choose between the different methods of analysis

Overhang
Calculates and displays the overhang areas.

Thickness
Calculates and displays the thickness.

Intersections
Displays intersecting faces in red. This mode has no settings.

Distortion
Displays non planar quads and n-gons dependant of a given angle.

Sharp Edges
Similar to wall-thickness, sharp edges can form shapes that are too thin to be able to print.

Angle
Here you can adjust the angle for the calculation

Axis
Here you can choose the axis that should be calculated.
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Curve Display Panel
Here you can find some display settings for Curve objects.
This panel is just visible with a Curve Object in Edit Mode.

Handles
Display the handles at the curve object.

Normals
Display the normals at the curve object.

Normal Size
Adjust the size of the normals at the curve object.

Skeleton Sketching Panel
This is a tool, and should belong into the tool shelf. For now it's in the
Properties.
Skeleton sketching allows you to paint your skeleton with strokes instead of
extruding out bones. Every point becomes a joint then. And when you click the
convert button, then the armature gets created.
The Skeleton sketching panel is just visible in Edit mode with an Armature
object.
To activate and deactivate this tool simply tick the checkbox in the header of the panel.
Then you will be able to paint strokes in the viewport. Right click to end a stroke.

Quick Sketching
Automatically convert the strokes to bones when you end the stroke.

Overdraw Sketching
With this option ticked you can adjust strokes by painting near them.

Stroke Conversion method
Here you can choose between different conversion methods.
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Retarget
This method is unfortunately not documented in the Blender manual, it is listed as
Todo. And it is not to find out how this is meant to work.

Adaptive
Draws bones in the average length of the stroke, but tries to follow the shape of the
stroke.

Length
Draws bones in the average length of the stroke.

Fixed
Draws bones between the points in the stroke.

Convert to bones
Converts the current strokes into an armature.

Delete Strokes
Deletes all strokes from the viewport.
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Introduction
The 3D View is made of several areas.
Yellow is the Tool Shelf.
Blue is the Header or Menu bar. It can be at the top or
the bottom.
Green is the Viewport. Here you will see and work
with your 3D data.
Red is the Properties Sidebar.
The content of the Tool Shelf , the Header and the
Properties Sidebar can vary. It depends of the type of
the objects and the modes that you are in.
This chapter here is about the Properties Sidebar.

Properties Sidebar
The Properties Sidebar contains various settings for the 3d view.
The Properties Sidebar is made of several panels. The range goes from object related
settings, Grease Pencil settings, across things like Motion Tracking settings, Background
Image settings, up to to Viewport related settings.
Most panels shows in all modes and with all content. Some Panels and its content is
varying dependant of what object type you use, and in what object mode you are.

Grease Pencil Layers Panel
The Grease Pencil Layers are connected with the Grease Pencil
panel in the Tool Shelf. And provides you with the layer
settings for the Grease Pencil.
When no layer exists then there are just a few buttons available.
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Scene / Object
Here you can adjust if the Grease Pencil stroke is relative to the selected object, or relative to the Screen.

Grease Pencil Prop
Here you can add a new grease pencil to work with. Or choose an existing
grease pencil.
The edit box allows you to rename the current grease pencil.
The F Button adds a fake user to the grease pencil. So that it does not get
deleted when you delete the connected object and close the scene.
When you add a fake user, then a number field will appear that shows how
much users are connected with the current pencil.

New Layer
Here you can create a new layer for your grease pencil. Doing so will reveal several layer
settings. And another panel with some color settings.

Layer list
Here you can see a list of the current layers. And here you can select the current
active layers.
Grease Pencil Layers can be locked (lock icon) and hidden (eye icon). The third
symbol is to unprotect selected colors from further modifications.
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Add / Delete
Right besides the layer list box there is a add button and a delete button. The plus button adds a new
layer, The minus button removes the current layer.

Layer Specials menu
Below the add and delete buttons there is a text menu with some further options.

Duplicate Layer
Duplicates the currently selected layer.

Show All
Unhides all hidden layers.

Hide Others
Hides all layers but the selected.

Lock All
Locks all layers.

Unlock All
Unlocks all layers.

Merge Down
Merges all layers into one.

Move Up / Move down
Moves the currently selected Grease pencil layer one up or down the list.

Lock Unlock unselected / Show Hide unselected
Lock Unlock unselected toggles the lock for the unselected layers.
Show Hide unselected toggles the visibility for the unselected layers.

Opacity
Opacity sets the opacity of the current grease pencil stroke.

8

Bforartists Reference Manual - © Copyright - This page is Public Domain

X Ray
X Ray makes the grease pencil stroke appear in front of objects. Without X Ray the stroke will be
invisible behind objects.

Show Points
Shows the points in the current grease pencil stroke.

Tint
Tint tints the color of the current grease pencil stroke with the tint color.
The upper field is a color picker where you can select a color. The fac slider defines the blending
factor between the grease pencil stroke color and the tint color.

Parent
Here you can set the parent object for the current grease pencil layer

Thickness Change
Increase or decrease the thickness of the grease pencil stroke.

Lock Frame
You can draw grease pencil strokes in different frames. Here you can lock those frames
from further editing.
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Onion Skinning
You can draw grease pencil strokes in different frames.
With onion skinning you can display the strokes from the
previous and following frames as ghost drawings.

Onion Skinning checkbox
Activates / deactivates the onion skinning.

Use always ghosts
When activated the ghost images will also show in rendering.

Use custom colors
Here you can choose to display the ghost drawing in predefined colors, or in their original colors. Default is to
display the predefined colors.

Before
Here you can choose in which color the previous frame gets displayed. And how many frames gets displayed
before the current frame.

After
Here you can choose in which color the following frame gets displayed. And how many frames gets displayed
after the current frame.

Grease Pencil Colors Panel
The grease pencil colors panel contains all the settings to set up and define the colors
that you use for your grease pencil drawings.
It activates when you start to draw a grease pencil stroke. And shows its content then.

GP Palette
Here you can select, create and delete a color palette for the grease pencil colors.
Define some colors in the Color list, then create a new palette with it.
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Color List
Here you can add custom colors.
The color field at the beginning of the edit box reveals a color picker when you click
at it. Which allows you to define a color.
The string “Color”, “Color 002” and “Color 003” is an edit box which allows you to
rename the color. Click into the field to activate it.
The Lock symbol allows you to lock the current color.
The eye symbol allows you to show or hide the current layer.
The ghost symbol allows you to display this color with onion skinning.

Add / Delete
Right besides the layer list box there is a add button and a delete button. The plus button adds a new
layer, The minus button removes the current layer.

Palette color Specials menu
Below the add and delete buttons there is a text menu with some further options.

Show All
Unhides all hidden colors.

Hide Others
Hides all colors but the selected.

Lock All
Locks all colors.

Unlock All
Unlocks all colors.

Copy color
Copys the color.

Select strokes
Selects all grease pencil strokes that uses the curent color.

Move to color
Move selected strokes to active color.
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Strokecolor
Here you can define the stroke color and set its opacity.

Volumetric Strokes
With Volumetric strokes the grease pencil stroke does not draw as a stroke, but a line of
dotted points.

Fill
Fill fills the space between the grease pencil strokes.
The opacity is by default at zero. The fill color shows when you
increase the opacity.

High Quality Fill
Fill Strokes uses high quality to avoid glitches. But this gives slower fps while animation. Here you can turn it
off.

View panel
The View panel contains some camera settings for the world camera and the render
camera.
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Lens
Here you can setup the lens viewport angle for the world camera. You need to
be in perspectivic view. In Orthographic view the lens values doesn't have an
effect.

Clip
Here you can set up the clipping values for the world camera. Geometry behind
the end value and before the start value will not be drawn.

Render border
When you have defined a renderborder then you can toggle it with this switch. See View menu in the 3d view
header.

Lock section
The lock section contains some camera settings regarding locking.

Lock Camera to view
This menu item allows you to navigate in camera view like you would
be in world view. When it is unticked then you can navigate the
passepartout, you can zoom and move it. And when you rotate the view,
then you will leave the camera mode.

Lock Camera and Layers
This menu item also exists in the layers tab in the Tool shelf at the left.
Use the scene's active camera and layers in this view. And not local ones. When you untick this menu item then
you can define a local camera below.
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Lock to Object
Locks the view of the world camera to an object. Here you can choose an object for it.

Lock to cursor
Locks the view of the world camera to the 3D cursor. You can either lock to an object or to the 3d cursor. When
you choose an object then the checkbox for the 3d cursor vanishes.

3D Cursor Panel
The 3d cursor panel contains the location edit boxes to display and set the 3D cursor in X,
Y and Z Position. And it contains a checkbox to lock the 3D cursor.
Of interest is also the RMB menu where you can reset the 3D cursor to 0/0/0. Simply right
click in one of the edit boxes and choose Reset All to default value.

Lock 3D cursor
Locks the 3D cursor at its place.

Show 3D Cursor
This checkbox can hide the 3D cursor.

Viewport Display Panel
The Display panel contains various settings around the display in the current 3D view
editor.

14

Bforartists Reference Manual - © Copyright - This page is Public Domain

Icons or Text Buttons
The icons or text buttons checkbox defines if some of the buttons in the Tool
Shelf are displayed as pure icon buttons, or as text buttons with icons.

Only Render
When ticked then just the objects that gets rendered are displayed. This option
hides the groundgrid and things like relationship lines and pivot points.

Ground Grid
This checkbox can show or hide the whole Grid Floor at once. Other things like relationship lines or pivots are
still displayed.

Grid Floor
The Grid Floor prop contains the settings for the Grid Floor. Number of lines, scale etc.

Grid Floor Checkbox
Displays or hides the grey grid of the Grid floor

X, Y Z buttons
Displays the colored orientation lines.

Lines
The Lines edit box defines how much lines the grey grid has.

Scale
Scales the whole Grid Floor.

Subdivisions
This setting affects the orthographic views. Here you have sublines in the grey grid.
And with Subdivisions you can define how much sublines a gridcell has.

Miscellaneous subtab
The Miscellaneous subtab contains settings that you rarely use.

World Background
Show or hide the world background.
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Outline Selected
Display the selected object with an outline.

All Object Origins
Display the origin of all objects in the scene. Normally just the origin of the selected object is displayed

Relationship Lines
When you have a parenting relationship, then you will see a dotted line between the parent and the child object.

Object Shading Panel
The Shading Panel contains some shading related settings. You have different settings
available in different Viewport shading modes. And in different Object modes with
different object types too. So best thing is to list all available options instead of going
through all possible combinations in shading and object modes.

Shading Options
Backface Culling
Excludes the backfaces of the geometry from rendering.

Depth of Field
Use Depth of Field in the viewport from the active camera. Does not work with the world camera. You have to
be in camera view.

Ambient Occlusion
Use Ambient Occlusion in the viewport. When ticked some edit boxes with the Ambient
Occlusion settings are revealed.

Shadeless
Displays the texture shadeless. Shows in Viewport shading Textured.
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Textured solid
Normally the Solid shading mode doesn't display textures. With this checkbox ticked it
does.

Matcap
Use Matcap Materials for solid display. Matcap stands for "material capture". It is a
complete material that includes lighting and reflections. This is useful for sculpting needs
for example. When you tick the Matcap checkbox then you will reveal a image field where
you can choose different matcap materials.

Wireframe Colors Subtab
The Wireframe Colors subtab contains a toolset where you can give any objects in the
viewport different wire colors. As the name says, it makes most sense when you have a
mode with wireframe display selected. And you need to have a object selected. When
there is nothing selected then you will get a warning.
Wireframe colors works in all modes where you can have a wireframe
display. Object mode, Edit Mode, Sculpt mode.
Here an example in Object mode with wireframe display.

Wire Color Set
Wire Color Set is a dropdown box where you can choose between 20
predefined color sets. The colors of this color sets are not editable.

Wire colors
You can see three colors below the Wire Color Set. From left to right. The
first color is the color for the object when it is not selected. The second is
the color for the object when it is selected, but not the active object. The
third color is the color for the object when it is selected and the active
object.
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Custom color set
There is also a Custom Color Set menu item in the Wire Color Set. This one is editable.
When you click at one of the color fields below the Wire Color Set, then you open up a
color picker dialog where you can choose a custom color for every object.
This custom colors are saved with the scene.

Wire Tools Subtab
Wire Tools is an addon developed by Lapineige. You can turn it off in the addon manage
if you want.
It offers a few more display mode posibilities. For example, normally you have to setup
the mesh in the Properties editor to display the wireframe in Object mode. This can be
done with this addon.

Wire Selection (Auto)
Display the Wire of the selection. Auto Update when selecting another object.

Only Selection
No idea. Somebody should ask the addon developer.

Invert
No idea. Somebody should ask the addon developer.

Wire + Edges
Display the Wire and Edges.

Wire
Display the Wire.

Hide All
Removes the wire display.

Only Bounds
Displays the selected object just as a bounding box.
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Textured
Displays the selected object as textured.

Motion Tracking Panel
In case you do motion tracking with Bforartists, here are some options for it. Motion
Tracking is another word for Motion Capture. Motion capture (in short Mo-cap) is the
process of recording the movement of objects or people.
This panel can be activated an deactivated at once with the checkbox in the title.

Camera Path
Show or hide reconstructed camera path.

3D Marker Names
Show names for reconstructed track objects.

Track Type and Size
Here you can define the look and size of the track display type.

Background Images Panel
In this panel you can set up background reference images for
modeling or painting needs.
The panel can be activated an deactivated at once with the checkbox in the title.

Note
Background images only shows in orthographic views. Front, back, etc.

Add Image
The Add Image button adds a new image panel to the list of background images.

Image Panel
The Image panel contains the settings and data for the background image.
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Image Panel Header
The header of the image panel contains the name of the file. The eye icon hides the image from the 3D view.
The X button removes the whole image panel from the list of background images.

Data Source
Here you can define if you want to load a single image, or a movie clip.

Image Edit Box
The Image icon is a dropdown box where you can choose another image or movie that is
already loaded into Bforartists.
The edit box allows you to rename your image.
With the F button you can make this data block a fake user.
The Folder icon allows you to load another image here.
And the X button removes the image. The image panel is still there then.

Settings Subtab
Opacity
Controls the transparency of the background image.

Axis
Choose which views the image is visible from. This is helpful when you have several reference images from
different views (e.g. top, front and side).

Source
Here you can choose different source types.
Single Image
Single Image doesn't have further options.

Image Sequence and Movie
Frames
Number of frames to use.
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Start
The start frame.
Offset
Offset the number of the frame to use in animation.
Match Movie Length
Set the image user length to the one of the movie.
Auto Refresh
Always refresh image on frame change
Cyclic
Cycle the images in the movie.

Generated
Generated doesn't use an external image, but a generated one.
Color Space
In this dropdown box you can define the color space.
View as Render
Turns on or off the color management settings in the Properties window - Possible fail
entry. Shouldn't belong here.
Size edit boxes
Here you can set the size of the image
Float Buffer
Generate Floating Point Buffer. Gives a higher quality image.
Type
You can choose between three different types. Blank, UV Grid and Color.

Blank is a plain color that you can define in a color picker
below.

UV Grid is a black and white checker texture.

Color Grid is a colored checker texture.
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Align Subtab
This tools helps you to align the image in the view.

Back / Front
Display the image in the front of the scene objects, or behind the scene objects.

Stretch / Fit / Crop
This option is for camera view. It does not work with the world camera.
Stretch stretches the background image into the current camera view. It fills the whole view.
Fit fits the background image into the height of the current camera view. Offset parts are cut off.
Crop fits the background image into the width of the current camera view. Offset parts are cut off.

Offset Editboxes
Here you can position the image in x and y position.

Flip Horizontal
Flip the image horizontal.

Flip Vertical
Flip the image vertical.

Rotation
Rotate the image.

Size
Set the size of the image.

Transform Orientations Panel
Transform Orientations allows you to
create and remove a custom transform
orientation, using object or mesh
elements.
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When such a custom transform orientations is defined from objects, then it uses the local orientation of the
object. When it is defined from mesh elements (vertices, edges, faces), then it uses the normal orientation of the
selection.

Dropdown Box with the current views.
The dropdown box with the currently available views.

Create Orientation
The create orientation button adds a new orientation from the current mode and view.

Transform Orientation Name
Here you can rename and delete the new created custom view.

Last Operator Create Orientation
Name
Here you can rename and delete the new created custom view.

Use View
The new orientation will be aligned to the view space.

Use after creation
It leaves the newly created orientation active.

Overwrite previous
Overwrites previous created orientation.

Important Hotkeys Panel
Important Hotkeys is an addon. It displays the most important
hotkeys as strings in the viewport.
This addon can be deactivated and uninstalled from the User
Preferences in case you don't need it anymore.

Show Text / Hide Text
Shows or hides the text.

Color
Here you can set the color of the font.
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Fontsize
Here you can set the size of the font.

Item Panel
When you have an object in the scene then you will see the Item panel.
This edit box shows the name of the current selected item. And here you can also rename
the item.

Stroke Select Panel
Stroke select is an addon. You can switch between
select and deselect with the right mouse button. This
panel is the visual end to show you in which mode
you currently are.

Transform Panel
The transform panel shows you the transform values. The content depends of what object
you have chosen, and in what mode you are. In Edit mode you may have other transform
values than in object mode. Non Primitive objects doesn't have a edit dimensions box,
and so on.

In Object Mode
Location
The location edit boxes. Here you can see and set the position of the selected object. The
lock symbol behind the edit boxes allows you to lock the axis position

Rotation
The Rotation edit boxes. Here you can see and set the rotation of the selected object. The
lock symbol behind the edit boxes allows you to lock the axis rotation.

Rotation mode
Rotation mode is a dropdown box where you can choose between different rotation
modes.

Euler angles gets calculated with three values. Quaternions with four angles. And so
you get a fourth angle value when you choose Quaternions as the rotation mode.
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The 4L button allows you to lock out the fourth component from editing.

Scale
The Scale edit boxes. Here you can see and set the scale factor of the selected object. The lock symbol behind
the edit boxes allows you to lock the axis scale.

Dimensions
The Dimensions edit boxes. Here you can see and set the dimensions of the selected object in world
coordinates. The lock symbol behind the edit boxes allows you to lock the axis rotation.
The Dimensions edit boxes are just available for primitives objects. Objects like Empties or a Camera doesn't
have a dimension, but a scale factor.

In Edit Mode
Just primitive objects does have an edit mode. Non primitive objects like a camera or an empty doesn't have an
edit mode. With two exceptions. Text and Force Field type Curve Guide. Both are curve types.

Mesh Objects
Median
Median is the position of the selected mesh part

Global / Local
Here you can define if the orientation of the selection is local to the selected object, or
global to the world coordinates.

Mean Bevel Weight - Vertices Data
Here you can adjust the bevel weight for the selected vertices when you have a bevel modifier at the mesh.

Mean Bevel Weight - Edges Data
Here you can adjust the bevel weight for the selected edges when you have a bevel modifier at the mesh.

Mean Crease
Here you can adjust the weight of the selected vertices when you have a subdivision surface modifier at the
mesh.

Curve Objects / Surface Objects
Median
Median is the position of the selected mesh part
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Global / Local
Here you can define if the orientation of the selection is local to the selected object, or global to the world
coordinates.

Mean Weight
Here you can adjust the weight used by softbody. Needs softbody.

Mean Radius
Here you can adjust the radius of the curve control points

Mean Tilt
Here you can adjust the tilt of the curve control points.

Metaball Objects
Median
Median is the position of the selected mesh part

Global / Local
Here you can define if the orientation of the selection is local to the selected object, or
global to the world coordinates.

Radius
Here you can adjust the radius of the selected meta element.

Stiffness
Here you can adjust the stiffness of the selected meta element.

Type
Type is a dropdown box. Here you can adjust the meta element type.

Text Objects
Text objects do have an edit mode, but they don't show content in the Transform panel.

Armature objects Edit Mode
Bones do have a head and a tail. You cannot position the whole bone by numeric values,
but the head and tail joints.
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Head
Here you can adjust the world position of the head joint.

Radius
This is just useful when you use Envelopes type bones. Here you can adjust the Envelope radius of the head
joint.

Tail
Here you can adjust the world position of the tail joint.

Radius
This is just useful when you use Envelopes type bones. Here you can adjust the Envelope radius of the tail joint.

Roll
Here you can adjust the bone roll.

Envelope
This is just useful when you use Envelopes type bones. Here you can adjust the overall Envelope size.

Armature Objects in Pose Mode
The content in Pose mode is the same than in Object mode. We have Location, Rotation
and Scale Edit Boxes. And the corresponding lock buttons.
Wiht one small difference. The rotation mode starts with Quaternions by default. And not
with Euler Angles.

Lattice Objects
You need to have some vertices of the Lattice object selected to see the content.

Vertex
Here you can see and set the vertex positions of the lattice objects.

Global / Local
Here you can define if the orientation of the selection is local to the selected object, or global to the world
coordinates.
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Mean Weight
Lattice object is a deform cage. Here you can adjust the mean weight of the selected vertice(s).

Mesh Display Panel
This panel just shows in Edit mode with a mesh object selected. It contains some mesh
related display settings like normals, or that you can display the length of an edge.

Normals
Here you can display the vertex, edge and faces normals at the selected mesh. The
size box allows you to adjust the length of the stroke that displays the normal.

Overlay Options subtab
This subtab contains various display settings.

Faces
Displays selected faces with the orange select color.

Edges
Displays selected edges with the orange select color.

Creases
Displays Creases.

Seams
Displays marked seams.

Show Weights
Shows the weights of the vertices.

Sharp
Shows as sharp marked edges.

Bevel
Shows Beveled edges.
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Edge Marks
Shows Edge Marks.

Face Marks
Shows Face marks.

Info Options subtab
The info Options subtab contains some settings with which you can display additional
informations at the mesh geometry. The values are in world coordinates.

Edge Info
Length
Displays the length of the selected edges.

Angle
Displays what angle the adjacent faces of the selected edges has.

Face Info
Area
Displays how big the area of the selected faces is.

Angle
Displays what angle the adjacent faces of the selected edges has.

Indices
Indices is a special debug feature for
programmers and developers. Sometimes the
order of the mesh elements counts. With this
option ticked you can display the indices of
the mesh elements in the viewport.
This feature is deactivated by default. You
first need to activate it in the Python console
by activating the Debug mode. Type in
'bpy.app.debug = True', and hit enter . Then
tick the Indices checkbox. And then you can
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see the values for the selected elements at the mesh.
When you are in Vertices mode then the indices numbers for the vertices gets displayed. When you are in Edge
mode, then the indices for the Edges gets displayed. And when you are in Face mode, then the Face indices gets
displayed.

Mesh Analysis Panel
The Mesh Analysis is to analyze mesh attributes for 3D printing. For example, Some
3D printers have a physical limit to the overhang that can be printed. Or it needs a
specific thickness.
The Mesh Analysis panel just shows in Edit mode with a mesh object selected. And in
Solid Mode. Furthermore you need to have a Deform modifier at the mesh. You can activate and deactivate the
whole panel at once in the header.

Type dropdown box
Here you can choose between the different methods of analysis

Overhang
Calculates and displays the overhang areas.

Thickness
Calculates and displays the thickness.

Intersections
Displays intersecting faces in red. This mode has no settings.

Distortion
Displays non planar quads and n-gons dependant of a given angle.

Sharp Edges
Similar to wall-thickness, sharp edges can form shapes that are too thin to be able to print.
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Angle
Here you can adjust the angle for the calculation

Axis
Here you can choose the axis that should be calculated.

Curve Display Panel
Here you can find some display settings for Curve objects.
This panel is just visible with a Curve Object in Edit Mode.

Handles
Display the handles at the curve object.

Normals
Display the normals at the curve object.

Normal Size
Adjust the size of the normals at the curve object.

Skeleton Sketching Panel
This is a tool, and should belong into the tool shelf. For now it's in the
Properties.
Skeleton sketching allows you to paint your skeleton with strokes instead of
extruding out bones. Every point becomes a joint then. And when you click the
convert button, then the armature gets created.
The Skeleton sketching panel is just visible in Edit mode with an Armature
object.
To activate and deactivate this tool simply tick the checkbox in the header of the panel.
Then you will be able to paint strokes in the viewport. Right click to end a stroke.
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Quick Sketching
Automatically convert the strokes to bones when you end the stroke.

Overdraw Sketching
With this option ticked you can adjust strokes by painting near them.

Stroke Conversion method
Here you can choose between different conversion methods.

Retarget
This method is unfortunately not documented in the Blender manual, it is listed as
Todo. And it is not to find out how this is meant to work.

Adaptive
Draws bones in the average length of the stroke, but tries to follow the shape of the
stroke.

Length
Draws bones in the average length of the stroke.

Fixed
Draws bones between the points in the stroke.

Convert to bones
Converts the current strokes into an armature.

Delete Strokes
Deletes all strokes from the viewport.
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Timeline Editor
The Timeline window, identified by a clock icon, is shown by default at the bottom of the screen.

Timeline

The Timeline is not much of an editor, but more of a information and control window.
Here you can have an overview of the animation part of your scene
What is the current time frame, either in frames or in seconds, where are the keyframes of the active
object, the start and end frames of your animation, markers, etc...
The Timeline has Player Controls, to play, pause the animation, and to skip though parts of the scene.
It also has some tools for Keyframes, Keying Sets, and Markers.
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Timeline Elements
Time Cursor

Time Cursor

The Time Cursor is the green line, its used to set and display the current time frame.
The Time Cursor can be set or moved to a new position by pressing or holding LMB in the Timeline window.
The current frame or second can be displayed on the Time Cursor, check the View menu for settings.
The Time Cursor can be moved in steps by pressing Left or Right, or in steps of 10 frames by pressing
Shift-Up or Shift-Down.

Keyframes
For the active and selected objects, keyframes are displayed as a yellow line.
For Armatures, the object keyframes and the pose bones keyframes are drawn.
Only Selected Channels can be enabled. Timeline > View > Only Selected Channels. For Armatures, this will
draw the object keyframes, and the keyframes for the active and selected pose bones.

Markers
Markers are the small triangles, with their name near them.
Markers are usually used to identify key parts of the animation.

Markers

Markers can be selected by pressing RMB or Shift-RMB to select more.
See Marker Menu below or Markers for more info.
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Adjusting the View
Timeline Area
The main Timeline area displays the animation frames over time.

Timeline Main Area

The Timeline can be panned by holding MMB, then dragging the area left or right.
You can zoom the Timeline by using Ctrl-MMB, the mouse Wheel, or pressing the Minus and Plus keys on
the numpad.
By default, the Playback/Rendering Range (Frame Start 1 to Frame End 200) is a lighter shade of gray. The
start and end frame can be set to the Time Cursor by pressing S or E. The Playback Range can also be set by
pressing P then drawing a box.

Timeline Header
View Menu
The View Menu controls what you see, and what it looks like.
Toggle Full Screen
Maximize or minimize the Timeline window. Ctrl-Up or Ctrl-Down
Duplicate Area into New Window
This creates a new OS window, and sets the editor window to the Timeline.
Bind Camera to Markers
This is used switch cameras during animation. It binds the active camera to the selected markers. First
select a camera. Then select the marker(s). Then use the function. Ctrl-B
Cache
This will display the baked Cache Steps for the active object.

Timline Cache

Show Cache
Show all enabled types.
Softbody, Particles, Cloth, Smoke, Dynamic Paint, Rigid Body.
Only Selected Channels
For Armatures, this will draw the object keyframes, and the keyframes for the active and selected pose
bones.
Show Frame Number Indicator
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This will draw the current frame or seconds on the Time Cursor.
View All
Maximize the Timeline area based on the Animation Range. Home
Show Seconds
Show time in seconds for the Timeline and the Time Cursor based on the FPS.

Marker Menu
Jump to Previous Marker
Jump to Next Marker
Grab/Move Marker
Grab/Move the selected markers. G
Rename Marker
Rename the active marker.
Delete Marker
Delete selected markers.
Duplicate Marker to Scene...
Duplicate the selected markers to another scene.
Duplicate Marker
Duplicate the selected markers.
Add Marker
Add marker to the current frame.

Frame Menu
Auto-Keyframing Mode
This controls how the Auto Keyframe mode works. Only one mode can be used at a time.
Add & Replace
Add or Replace existing keyframes.
Replace
Only Replace existing keyframes.

Playback Menu
• Audio Scrubbing If your animation has sound, this option plays bits of the sound wave while you move
the time cursor with LMB or keyboard arrows.
• Audio Muted Mute the sound from Sequence Editors.
• AV-sync Play back and sync with audio clock, dropping frames if frame display is too slow. See 4.
Synchronize Playback for more info.
• Frame Dropping Play back dropping frames if frames are too slow. See 4. Synchronize Playback for
more info.
• Clip Editors While playing, updates the Movie Clip Editor.
• Node Editors While playing, updates the Node properties for the Node Editor.
• Sequencer Editors While playing, updates the Video Sequence Editor.
Note
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Image Editors
TODO Not sure what is updated, maybe gif images or, image sequence.

• Image Editors Todo
• Property Editors When the animation is playing, this will update the property values in the UI.
• Animation Editors While playing, updates the Timeline, Dope Sheet, Graph Editor, Video Sequence
Editor.
• All 3D View Editors While playing, updates the 3D View and the Timeline.
• Top-Left 3D Editor While playing, updates the Timeline if Animation Editors and All 3D View Editors
disabled.

Header Controls
The Timeline header controls.

Timeline header controls.

1. Range Control
Use Preview Range
This is an alternative range used to preview animations. This works for the UI playback, this
will not work for rendering an animation.
Lock Time Cursor to Playback Range
This limits the Time Cursor to the Playback Range.

2. Frame Control
Start Frame
The start frame of the animation / playback range.
End Frame
The end frame of the animation / playback range.
Current Frame
The current frame of the animation / playback range. Also the position of the Time Cursor.

3. Player Control
These button are used to set, play, rewind, the Time Cursor.
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Player Controls.

Jump to start
This sets the cursor to the start of frame range.
Jump to previous keyframe
This sets the cursor to the previous keyframe.
Rewind
This plays the animation sequence in reverse. SWhen playing the play buttons switch to a pause button.
Play
This plays the animation sequence. When playing the play buttons switch to a pause button.
Jump to next keyframe
This sets the cursor to the next keyframe.
Jump to end
This sets the cursor to the end of frame range.
Pause
This stops the animation.

4. Synchronize Playback

3D View Red FPS. 60:54.75

When you play an animation, the FPS is displayed at the top left of the 3D View. If the scene is detailed and
playback is slower than the set Frame Rate (see Dimensions Presets, these options are used to synchronize the
playback.
No Sync
Do not sync, play every frame.
Frame Dropping
Drop frames if playback is too slow. This enables Frame Dropping from the Playback Menu.
AV-sync
Sync to audio clock, dropping frames if playback is slow. This enables AV-sync and Frame Dropping
from the Playback Menu.

5. Keyframe Control

Timeline Auto Keyframe.

Auto Keyframe
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The “Record” red-dot button enables something called Auto Keyframe : It will add and/or replace existing
keyframes for the active object when you transform it in the 3D view.
For example, when enabled, first set the Time Cursor to the desired frame, then move an object in the 3d
view, or set a new value for a property in the UI.
When you set a new value for the properties, Bforartists will add keyframes on the current frame for the
transform properties.
Auto Keying Set - Optional if Auto Keyframe enabled. Auto Keyframe will insert new keyframes for the
properties in the active Keying Set.
Note that Auto Keyframe only works for transform properties (objects and bones), in the 3D views (i.e.
you cant use it e.g. to animate the colors of a material in the Properties window...).
Note
Layered
Todo.

Timeline Layered.

Layered - Optional while playback. TODO.

Timeline Keying Sets.

Active Keying Set
Keying Sets are a set of keyframe channels in one.
They are made so the user can record multiple properties at the same time.
With a keying set selected, when you insert a keyframe, Bforartists will add keyframes for the properties
in the active Keying Set.
There are some built in keying sets, ‘LocRotScale’, and also custom keying sets.
Custom keying sets can be defined in the in the panels Properties > Scene > Keying Sets + Active Keying
Set.
Insert Keyframes
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Insert keyframes on the current frame for the properties in the active Keying Set.
Delete Keyframes
Delete keyframes on the current frame for the properties in the active Keying Set.

User Preferences
Some related user preferences from the Editing tab.
Playback
Allow Negative Frames
Time Cursor can be set to negative frames with mouse or keyboard. When using Use Preview
Range, this also allows playback.
Keyframing
Visual Keying
When an object is using constraints, the objects property value doesnt actually change. Visual
Keying will add keyframes to the object property, with a value based on the visual transformation
from the constraint.
Only Insert Needed
This will only insert keyframes if the value of the propery is different.
Auto Keyframing
Enable Auto Keyframe by default for new scenes.
Show Auto Keying Warning
Displays a warning at the top right of the 3D View, when moving objects, if Auto Keyframe is on.
Only Insert Available
With Auto Keyframe enabled, this will only add keyframes to channel F-Curves that already exist.

Graph Editor
The graph editor is the main animation editor. It allows you to modify the animation for any properties using FCurves.
The graph editor has two modes, F-Curve for Actions, and Drivers for Drivers. Both are very similar in
function.

The Graph Editor.
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Curve Editor Area
Here you can see and edit the curves and keyframes.

A curve with different types of interpolation.

See F-Curves for more info.

2D Cursor

Graph Editor 2D Cursor.

The current frame is represented by a green vertical line called the Time Cursor.
As in the Timeline, you can change the current frame by pressing or holding LMB.
The green horizontal line is called the Cursor. This can be disabled via the View Menu or the View Properties
panel.
The Time Cursor and the Cursor make the 2D Cursor. The 2D Cursor mostly used for editing tools.

View Axes
For Actions the X-axis represents time, the Y-axis represents the value to set the property.
For Drivers the X-axis represents the Driver Value, the Y-axis represents the value to set the property.
Depending on the selected curves, the values have different meaning: For example rotation properties are
shown in degrees, location properties are shown in Bforartists Units. Note that Drivers use radians for rotation
properties.

Markers
Like with most animation editors, markers are shown at the bottom of the editor.

Graph Editor Markers.

Markers can be modified in the Graph Editor though its usually best to use the Timeline.
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See Markers for more info.

Header
Here you’ll find.
•
•
•
•

The menus.
Graph Editor mode.
View controls.
Curve controls.

Header Controls

Graph Mode.

Mode
F-Curve for Actions, and Drivers for Drivers.

View Controls.

View controls
Show Only Selected
Only include curves related to the selected objects and data.
Show Hidden
Include curves from objects/bones that are not visible.
Show Only Errors
Only include curves that are disabled or have errors.
Search Filter
Only include curves with keywords contained in the search text.
Type Filter
Filter curves by property type.
Normalize
Normalize curves so the maximum or minimum point equals 1.0 or -1.0.
Auto
Automatically recalculate curve normalization on every curve edit.

Curve Controls.

Curve controls
Auto Snap
Auto snap the keyframes for transformations.
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No Auto-Snap Time Step Nearest Frame Nearest Marker
Pivot Point
Pivot point for rotation.
Bounding Box Center
Center of the select keyframes.
2D Cursor
Center of the 2D Cursor. Time Cursor + Cursor.
Individual Centers
Rotate the selected keyframe Bezier handles.
Copy Keyframes
Copy the selected keyframes to memory.
Paste Keyframes
Paste keyframes from memory to the current frame for selected curves.
Create Snapshot
Creates a picture with the current shape of the curves.

Channels Region

Channels Region.

The channels region is used to select and manage the curves for the graph editor.
Hide curve
Represented by the eye icon.
Deactivate/Mute curve
Represented by the speaker icon.
Lock curve from editing
Represented by the padlock icon.
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Channel Editing
Select channel
Multi Select/Deselect
Toggle Select All
Border Select
Border Deselect
Delete selected
Lock selected
Make only selected visible
Enable Mute Lock selected
Disable Mute Lock selected
Toggle Mute Lock selected

Properties Region
The panels in the Properties Region.

View Properties Panel

View Properties Panel.

Show Cursor
Show the vertical Cursor.
Cursor from Selection
Set the 2D cursor to the center of the selected keyframes.
Cursor X
Time Cursor X position.
To Keys
Snap selected keyframes to the Time Cursor.
Cursor Y
Vertical Cursor Y position.
To Keys
Snap selected keyframes to the Cursor.
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Active F-Curve Panel

Active F-Curve Panel.

This panel displays properties for the active F-Curve.
Channel Name (X Location)
ID Type + Channel name.
RNA Path
RNA Path to property + Array index.
Color Mode
Color Mode for the active F-Curve.
Auto Rainbow
Increment the HUE of the F-Curve color based on the channel index.
Auto XYZ to RGB
For property sets like location xyz, automatically set the set of colors to red, green, blue.
User Defined
Define a custom color for the active F-Curve.

Active Keyframe Panel

Active Keyframe Panel.

Interpolation
Set the forward interpolation for the active keyframe.
Constant
Keep the same value till the next keyframe.
Linear
The difference between the next keyframe.
Bezier
Bezier interpolation to the next keyframe.
Key
Frame
Set the frame for the active keyframe.
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Value
Set the value for the active keyframe.
Left Handle
Set the position of the left interpolation handle for the active keyframe.
Right Handle
Set the position of the right interpolation handle for the active keyframe.

Drivers Panel

Drivers Panel.

See Drivers Panel for more info.

Modifiers Panel

Modifiers Panel.

See F-Modifiers for more info.
See also
•
•
•
•

Graph Editor - F-Curves
Graph Editor - F-Modifiers
Actions
Drivers

F-Curves
After animating some property in Bforartists using keyframes you can edit their corresponding curves. When
something is “animated,” it changes over time. This curve in shown as something called an F-Curve. Basically
what an F-Curve does is it a interpolates between two animated properties. In Bforartists, animating an object
means changing one of its properties, such as an objects location, or its scale.
As mentioned, Bforartists’s fundamental unit of time is the “frame”, which usually lasts just a fraction of a
15
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second, depending on the frame rate of the scene. As animation is composed of incremental changes spanning
multiple frames, usually these properties ARE NOT manually modified frame by frame, because:
• it would take ages!
• it would be very difficult to get smooth variations of the property (unless you compute mathematical
functions and type a precise value for each frame, which would be crazy).
This is why nearly all direct animation is done using interpolation.
The idea is simple: you define a few Key Frames, which are multiple frames apart. Between these keyframes,
the properties’ values are computed (interpolated) by Bforartists and filled in. Thus, the animators’ workload is
significantly reduced.

Example of interpolation

For example, if you have:
• a control point of value 0 at frame 0,
• another one of value 10 at frame 25,
• and you use linear interpolation,
then, at frame 5 we get a value of 2.
The same goes for all intermediate frames: with just two points, you get a smooth growth from 0 to 10 along
the 25 frames. Obviously, if you’d like the frame 15 to have a value of 9, you’d have to add another control
point (or keyframe)...

Settings
F-curves have three additional properties, which control the interpolation between points, extension behavior,
and the type of handles.

Interpolation Mode
You have three choices (T, or Curve ‣ Interpolation Mode):
Constant
There is no interpolation at all. The curve holds the value of its last keyframe, giving a discrete (stairway)
“curve”. Usually only used during the initial “blocking” stage in pose-to-pose animation workflows.
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Constant.

Linear
This simple interpolation creates a straight segment between each neighbor keyframes, giving a broken
line. It can be useful when using only two keyframes and the Extrapolation extend mode, to easily get an
infinite straight line (i.e. a linear curve).

Linear.

Bezier
The more powerful and useful interpolation, and the default one. It gives nicely smoothed curves, i.e.
smooth animations!

Bézier.

Remember that some FCurves can only take discrete values, in which case they are always shown as if constant
interpolated, whatever option you chose.

Extrapolation
(Shift-E, or Channel ‣ Extrapolation Mode)
Extrapolation defines the behavior of a curve before the first and after the last keyframes.
There are two basic extrapolation modes:
Constant
The default one, curves before their first keyframe and after their last one have a constant value (the one
of these first and last keyframes).
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Constant extrapolation

Linear
Curves ends are straight lines (linear), as defined by their first two keyframes (respectively their last two
keyframes).

Linear extrapolation

Additional extrapolation tools (e.g. the “Cycles” F-Modifier) are located in the F-Curve Modifiers

Handle Types
There is another curve option quite useful for Bézier-interpolated curves. You can set the type of handle to use
for the curve points V
Automatic
Keyframes are automatically interpolated

Auto handles

Vector
Creates linear interpolation between keyframes. The linear segments remain if keyframe centers are
moved. If handles are moved, the handle becomes Free.
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Vector handles

Aligned
Handle maintain rotation when moved, and curve tangent is maintained

Aligned handles

Free
Breaks handles tangents

Free handles

Auto Clamped
Auto handles clamped to not overshoot

Auto clamped handles

Direction of time
Although F-curves are very similar to Bezier Curves, there are some important differences.
For obvious reasons, a property represented by a Curve cannot have more than one value at a given time,
hence:
• when you move a control point ahead of a control point that was previously ahead of the point that you
are moving, the two control points switch their order in the edited curve, to avoid that the curve goes
back in time
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• for the above reason, it’s impossible to have a closed Ipo curve
Two control points switching: the curve can’t go back in time!

Before moving the second keyframe

After moving the second keyframe

Editing Tools
By default, when new channels are added, the Graph Editor sets them to Edit Mode. Selected channels can be
locked by pressing Tab.
Many of the hotkeys are the same as the viewport ones, for example Navigation hotkeys and select keys. Which
one depends of the chosen keymap.
And of course you can lock the transformation along the X (time frame) or Y (value) axises by pressing X or Y
during transformation.
For precise control of the keyframe position and value, you can set values in the Active Keyframe of the
Properties Region.

Transform Snapping
When transforming keyframes with the navigation hotkeys the transformation can be snapped to increments.
Snap Transformation to 1.0 Ctrl
Divide Transformation by 10.0 Shift
Keyframes can be snapped to different properties by using the Snap Keys tool.
Snap Keys Shift-S
Current Frame
Snap the selected keyframes to the Time Cursor.
Cursor Value
Snap the selected keyframes to the Cursor.
Nearest Frame
Snap the selected keyframes to their nearest frame individually.
Nearest Second
Snap the selected keyframes to their nearest second individually, based on the FPS of the scene.
Nearest Marker
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Snap the selected keyframes to their nearest marker individually.
Flatten Handles
Flatten the Bezier handles for the selected keyframes.
Flatten Handles snapping example.

Before Flatten Handles.

After Flatten Handles.

Mirror
Selected keyframes can be mirrored over different properties using the Mirror Keys tool.
Mirror Keys
By Times Over Current Frame
Mirror horizontally over the Time Cursor.
By Values over Cursor Value
Mirror vertically over the Cursor.
By Times over Time 0
Mirror horizontally over frame 0.
By Values over Value 0
Mirror vertically over value 0.
By Times over First Selected Marker
Mirror horizontally the over the first selected Marker.

Clean Keyframes
Clean Keyframes resets the keyframe tangents to their auto-clamped shape, if they have been modified. Clean
Keyframes O

FCurve before cleaning

FCurve after cleaning

Smoothing
There is also an option to smooth the selected curves , but beware: its algorithm seems to be to divide by two
the distance between each keyframe and the average linear value of the curve, without any setting, which gives
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quite a strong smoothing! Note that the first and last keys seem to be never modified by this tool.

FCurve before smoothing

FCurve after smoothing

Sampling and Baking Keyframes
Sample Keyframes
Sampling a set a keyframes replaces interpolated values with a new keyframe for each frame.

FCurve before sampling

FCurve after sampling

Bake Curves
Baking a curve replaces it with a set of sampled points, and removes the ability to edit the curve.

F-Curve Modifiers
F-Curve modifiers are similar to object modifiers, in that they add non-destructive effects, that can be adjusted
at any time, and layered to create more complex effects.

Adding a Modifier
The F-curve modifier panel is located in the Properties panel. Select a curve by selecting one of its curve points,
or by selecting the channel list. Click on the Add Modifier button and select a modifier.
To add spin to an object or group, select the object/group and add a keyframe to the axis of rotation (x,y, or z)
Go to the Graph Editor.....make sure the f-curves properties panel is visible (View > Properties)
>Add Modifier > (e.g.) Generator

Types of Modifiers
Generator
Generator creates a Factorized or Expanded Polynomial function. These are basic mathematical formulas that
represent lines, parabolas, and other more complex curves, depending on the values used.
Additive
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This option causes the modifier to be added to the curve, instead of replacing it by default.
Poly Order
Specify the order of the polynomial, or the highest power of ‘x’ for this polynomial. (number of
coefficients - 1).
Change the Coefficient values to change the shape of the curve.
See also
The Wikipedia Page for more information on polynomials.

Built-in Function
These are additional formulas, each with the same options to control their shape. Consult mathematics reference
for more detailed information on each function.
•
•
•
•
•
•

Sine
Cosine
Tangent
Square Root
Natural Logarithm
Normalized Sine (sin(x)/x)

Amplitude
Adjusts the Y scaling
Phase Multiplier
Adjusts the X scaling
Phase Offset
Adjusts the X offset
Value Offset
Adjusts the Y offset

Envelope
Allows you to adjust the overall shape of a curve with control points.
Reference Value
Set the Y value the envelope is centered around.
Min
Lower distance from Reference Value for 1:1 default influence.
Max
Upper distance from Reference Value for 1:1 default influence.
Add Point
Add a set of control points. They will be created at the current frame.
Fra:
Set the frame number for the control point.
Min
Specifies the lower control point’s position.
Max
specifies the upper control point’s position.
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Cycles
Cycles allows you add cyclic motion to a curve that has 2 or more control points. The options can be set for
before and after the curve.
Cycle Mode
Repeat Motion
Repeats the curve data, while maintaining their values each cycle.
Repeat with Offset
Repeats the curve data, but offsets the value of the first point to the value of the last point each
cycle.
Repeat Mirrored
Each cycle the curve data is flipped across the X-axis.
Before/After Cycles
Set the number of times to cycle the data. A value of 0 cycles the data infinitely.

Noise
Modifies the curve with a noise formula. This is useful for creating subtle or extreme randomness to animated
movements, like camera shake.
Blend Type
Replace
Adds a -.5 to .5 range noise function to the curve.
Add
Adds a 0 to 1 range noise function to the curve.
Subtract
Subtracts a 0 to 1 range noise function to the curve.
Multiply
Multiplies a 0 to 1 range noise function to the curve.
Scale
Adjust the overall size of the noise. Values further from 0 give less frequent noise.
Strength
Adjusts the Y scaling of the noise function.
Phase
Adjusts the random seed of the noise.
Depth
Adjusts how detailed the noise function is.

Python
Limits
Limit curve values to specified X and Y ranges.
Minimum/Maximum X
Cuts a curve off at these frames ranges, and sets their minimum value at those points.
Minimum/Maximum Y
Truncates the curve values to a range.

Stepped
Gives the curve a stepped appearance by rounding values down within a certain range of frames.
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Step Size
Specify the number of frames to hold each frame
Offset
Reference number of frames before frames get held. Use to get hold for ‘1-3’ vs ‘5-7’ holding patterns.
Use Start Frame
Restrict modifier to only act before its ‘end’ frame
Use End Frame
Restrict modifier to only act after its ‘start’ frame

Dope Sheet
• Action Editor
• Action Data-Blocks
• Channel Menu
• The Dopesheet
• Dope Sheet Modes
• Interface
• Shape Key

Action Editor
In Bforartists Actions are a generic containers for F-Curves. Actions can contain any number of F-Curves, and
can be attached to any data block. As long as the RNA data paths stored in the Action’s F-Curves can be found
on that data block, the animation will work. For example, an action modifying ‘X location’ and ‘Y location’
properties can be shared across multiple objects, since both objects have ‘X location’ and ‘Y location’ properties
beneath them.
The Action Editor window enables you to see and edit the FCurve data-blocks you defined as actions in the
FCurve Editor window. So it takes place somewhere in-between the low-level FCurves, and the high-level NLA
editor. Hence, you do not have to use them for simple Ipo curves animations - and they have not much interest
in themselves, so you will mostly use this window when you do NLA animation (they do have a few specific
usages on their own, though, like e.g. with the Action constraint, or the pose libraries).
This is not a mandatory window, as you do can edit the actions used by the NLA directly in the FCurve Editor
window (or even the NLA Editor one). However, it gives you a slightly simplified view of your FCurve datablocks (somewhat similar to the “key” mode of the FCurve window, even though more powerful in some ways)
- and, more interesting, it can show you all “action” FCurve data-blocks of a same object at once.
Additionally, it also allows you to affect timing of the different keys of the layers created with the grease pencil
tool.
Each “action” FCurve data-block forms a top-level channel (see below). Note that an object can have several
Constraint (one per animated constraint) and Pose (for armatures, one per animated bone) FCurve data-blocks,
and hence an action can have several of these channels.
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Action Data-Blocks
As everything else in Bforartists, actions are data-blocks. Unlike FCurve ones, there is only one type of action,
which can regroup all FCurve of a given object. You’ll find its usual data-block controls in the Action Editor
header.
However, there is one specificity with action data-blocks: they have by default a “fake user”, i.e. once created,
they are always kept in Bforartists file, even if no object uses them. This is due to the fact that actions are
designed to be used in the NLA, where you can affect several different actions to a same object! Yes, this is the
only way to use different actions (and hence, different FCurve data-blocks of the same kind) to animate a same
object. But as you have to assign an action to an object to be able to edit it (and an object can only have one
action data-block at a time), to have “fake users” guaranties you that you won’t lost your precious previouslyedited actions when you start working on a new one!
This window shows, by default, the action data-block linked to the current active object. However, as with
FCurvs, you can pin an Action Editor to a given action with the small “pin” button to the left of the data-block
controls, in the header. This will force the window to always display this data-block, whatever the current
selected object is.

Channel Menu
Delete (X)
Deletes the whole channel from the current action (i.e. unlink the underlying FCurve datablock from this action data-block).
Warning
The X shortcut is area-dependent: if you use it in the left list part, it’ll delete the selected channels,
whereas if you use it in the main area, it’ll delete the selected keyframes...

Settings ‣ Toogle/Enable/Disable a Setting
Enable/disable a channel’s setting (selected in the menu that pops-up) - currently, “lock” and/or “mute”
only.
Toggle Channel Editability Tab
Locks or unlocks a channel for editing
Extrapolation Mode
Change the extrapolation between selected keyframes. More options are available in the Graph Editor.
Expand Channels, Collapse Channels
Expands or collapses selected channels.
Move...
This allows you to move top-level channels up/down , or directly to the top/bottom.
Revive Disabled F-Curves
Clears ‘disabled’ tag from all F-Curves to get broken F-Curves working again

The Dopesheet
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The DopeSheet

Classical hand-drawn animators often made a chart, showing exactly when each drawing, sound and camera
move would occur, and for how long. They nicknamed this the ‘dopesheet’. While CG foundations dramatically
differ from classical hand-drawn animation, Bforartists’s Dopesheet inherits a similar directive. It gives the
animator a ‘birds-eye-view’ of every thing occurring within a scene.

Dope Sheet Modes

DopeSheet modes

There are four basic views for the Dopesheet.These all view different contexts of animation:
DopeSheet
The dopeSheet allow you to edit multiple actions at once.
Action Editor
Action Editor is the default, and most useful one. It’s here you can define and control your actions.
Shape Key Editor
ShapeKey Editor is dedicated to the Shape Ipo data-blocks. It uses/edits the same action data-block as the
previous mode. It seems to be an old and useless thing, as the Action Editor mode handles Shape channels
very well, and this mode adds nothing...
Grease Pencil
Grease Pencil is dedicated to the grease pencil tool’s keyframes - for each grease pencil layer, you have a
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strip along which you can grab its keys, and hence easily re-time your animated sketches. As it is just
another way to see and edit the grease pencil data, this mode uses no data-block (and hence has nothing to
do with actions...). Note that you’ll have as much top-level grease pencil channels as you have sketched
windows (3D views, UV/Image Editor, etc.)

Interface
The Action Editor interface is somewhat similar to the FCurve Editor one, it is divided in three areas:

The Action Editor window, Action Editor mode, with an Object and Shape channels.

The header bar
Here you find the menus, a first block of controls related to the editor “mode”, a second one concerning
the action data-blocks, and a few other tools (like the copy/paste buttons, and snapping type).
The main area
It contains the keyframes for all visible action channels. As with the other “time” windows, the X-axis
materializes the time. The Y-axis has no mean in itself, unlike with the FCurve editor, it’s just a sort of
“stack” of action channels - each one being shown as an horizontal colored strip (of a darker shade
“during” the animated/keyed period). On these channel strips lay the keyframes, materialized as lightgray (unselected) or yellow (selected) diamonds. One of the key feature of this window is that it allow
you to visualize immediately which channel (i.e. Ipo curve) is really affected. When the value of a given
channel does not change at all between two neighboring keyframes, a gray (unselected) or yellow
(selected) line is drawn between them.
The left “list-tree”
This part shows the action’s channel “headers” and their hierarchy. Basically, there are:
• “Top-level” channels, which represent whole FCurve data-blocks (so there’s one for Object one,
one for Shape one, etc.). They gather all keyframes defined in their underlying FCurve data-block.
• “Mid-level” channels, which seem currently to have no use (there’s one per top-level channel, they
are all named FCurves, and have no option at all...).
• “Low-level” channels, which represent individual FCurve , with their own keyframes (fortunately,
only keyed Ipos are shown!).
Each level can be expended/collapsed by the small arrow to the left of its “parent” channel. To the right of
the channel’s headers, there are some channel’s setting controls:
• Clicking on the small “eye” will allow you to mute that channel (and all its “children” channels, if
any!).
• Clicking on the small “lock” will allow you to prevent this channel and its children to be edited
(note that this is also working inside the NLA, but that it doesn’t prevent edition of the underlying
FCurve ...).
A channel can be selected (text in white, strip in gray-blue color) or not (text in black, strip in pink-brown
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color.), use LMB clicks to toggle this state. You can access some channel’s properties by clicking CtrlLMB on its header. Finally, you can have another column with value-sliders, allowing you to change the
value of current keyframes, or to add new ones. These are obviously only available for low-level channels
(i.e. individual FCurve ). See View Menu below for how to show these sliders.

View Menu

the action editor showing sliders

Realtime Updates
When transforming keyframes, changes to the animation data are flushed to other views
Show Frame Number Indicator
Show frame number beside the current frame indicator line
Show Sliders
A toggle option that shows the value sliders for the channels. See the The Action Editor window, Action
Editor mode, with a group and sliders picture above).
Use Group Colors
Draw groups and channels with colors matching their corresponding groups.
AutoMerge Keyframes
Automatically merge nearby keyframes
Sync Markers
Sync Markers with keyframe edits
Show Seconds
Whether to show the time in the X-axis as frames or as seconds
Set Preview Range
Interactively define frame range used for playback. Allow you to define a temporary preview range to use
for the Alt-A realtime playback (this is the same thing as the Playback Range option of the timeline
window header).
Clear Preview Range
Clears the preview range
Auto-Set Preview Range
Automatically sets the preview range to playback the whole action.

Marker Menu
See the Markers page.
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Shape Key
To do

Non-Linear Animation Editor
The NLA editor can manipulate and repurpose actions, without the tedium of keyframe handling. Its often used
to make broad, significant changes to a scene’s animation, with relative ease. It can also repurpose, and ‘layer’
actions, which make it easier to organize, and version-control your animation.

Tracks
Tracks are the layering system of the NLA. At its most basic level, it can help organize strips. But it also layers
motion much like an image editor layers pixels - the bottom layer first, to the top, last.

Strips
There’s three kinds of strips - Action, Transition, and Meta. Actions contain the actual keyframe data,
Transitions will perform calculations between Actions, and Meta will group strips together as a whole.

Creating Action Strips
Any action used by the NLA first must be turned into an Action strip. This is done so by clicking the

next to the action listed in the NLA. Alternatively, you can go to

Reference
Menu: Add –> Action

Action Strip.

Creating Transition Strips
Select two or more strips on the same track, and go to
Reference
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Menu: Add –> Transition

Transition Strip.

Grouping Strips into Meta Strips
If you find yourself moving a lot of strips together, you can group them into a Meta strip. A meta strip can be
moved and duplicated like a normal strip.
Reference
Menu: Add –> Add Meta-Strips

Shift-select two or more strips..

Combine them into a meta strip.

A meta strip still contains the underlying strips. You can ungroup a Meta strip.
Reference
Menu: Add –> Remove Meta-Strips

Editing Strips
The contents of Action strips can be edited, but you must be in ‘Tweak Mode’ to do so.
Reference
Menu: View –> Enter Tweak Mode

Strip in NLA mode..

Strip in Tweak mode.

If you try moving the strip, while in edit mode, you’ll notice that the keys will go along with it. On occasion,
you’ll prefer the keys to remain on their original frames, regardless of where the strip is. To do so, hit the
‘unpin’ icon, next to the strip.
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Nla strip with pinned keys.

Strip moved, notice the keys move with it.

The unpinned keys return to their original frames.

When your finished editing the strip, simply go to View > Exit Tweak Mode. Note the default key for this is
Tab.

Re-Instancing Strips
The contents’ of one Action strip can be instanced multiple times. To instance another strip, select a strip, go to

Reference
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Menu: Edit–> Duplicate Strips

Now, when any strip is tweaked, the others will change too. If a strip other than the original is tweaked, the
original will turn to red.

Duplicated strip being edited.

Duplicated strip.
Original strip.

Strip Properties
Strip properties can be accessed via the NLA header.
Reference
Menu: View–> Properties

Renaming Strips
All strips can be renamed, in the “Active Track” section in the Strip Properties.

Active Track
This is which track the strip currently belongs to.

Active Strip
Elements of the strip itself. An Action Strip can be either an Action Clip, or a Transition Clip. Note that the
‘Strip Extents’ fields determine strictly the strip, and not the action. Also, the “Hold” value in the Extrapolation
section means hold both beginning, and after. This can cause previous clips to not work, if checked.
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Active Action
This represents the ‘object data’ of the strip. Much like the transform values of an object.

Evaluation
This determines the degree of influence the strip has, and over what time.

If influence isn’t animated, the strips will fade linearly, during the overlap.
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Strip Modifiers
Like its close cousins in mesh and graph editing, Modifiers can stack different combinations of effects for
strips. Obviously there will be more to come on this.
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UV/Image Editor
Navigating
Panning can be done by clicking the MMB and dragging.
Zooming can be done by scrolling MMB up or down. Also, as in the 3D view, you can use NumpadPlus or
NumpadMinus to zoom.
The following shortcuts are available, and through the View Menu:
• View All Home
• View Center NumpadPeriod

Masking
To Do

Texturing
The UV/Image Editor is where you will be editing the UVs. This is an overview of the tools found there. Using
2
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the UV editor is explained more in depth in the next sections.

UV/Image Editor window for texturing.

Header Bar
UV/Image Editor Header

The header bar contains several menus and options for working with UVs
View Menu
Tools for, working with the editor and controlling how things are displayed. The properties panel has
display options and manipulation tools.
Select Menu
Tools for Selecting UV’s
Image Menu
This contains options for when Working with Images
UVs Menu
Contains tools for Unwrapping Meshes and Editing UV’s.
Image Selector Menu
Select the image to apply when Working with Images.
Pin Image
Displays current image regardless of selected object.
Pivot Point Selector
Similar to working with Pivot Points in the 3D view.
Sync Selection
Keeps UV and Mesh component selections in sync.
Selection Modes:
• Vertex
• Edge
3
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• Face
• Island
Sticky Selection Mode
When Sync Selection is disabled, these options control how UVs are selected.
Proportional Editing
See Proportional Editing.
UV Snapping
Similar to Snapping in the 3D View
Active UV Texture Map Selector
Select which UV texture to use
Image Channels to Draw
Set the image to be displayed with Color, Color and Alpha, or just Alpha.
Auto Update Other Affected Windows
Update other affected windows space automatically to reflect changes during interactive operations e.g.
transfom.

Properties Panel
UV Vertex
Transform Properties Selecting UV’s.
Grease Pencil
See the Grease Pencil Docs.
Image
Contains the properties of the current Image.
Display
Controls display options for UVs and additional settings for when
Working with Images.

Display Options
You can set how UVs are displayed in the Display Panel:
Aspect Ratio
Display Aspect for this image. Does not affect rendering.
Coordinates
Display UV coordinates
Repeat
Draw the image repeated outside of the main view.
Normalized
Display UV coordinates from 0.0 to 1.0 rather than in pixels
Cursor Location
2D cursor location for this view
Outline/Dash/Black/White
Sets how UV edges are displayed
Draw Faces
Draw faces over the image
Smooth
Makes edges appeared Antialiased
Modified
4
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Show results of modifiers in the UV display
Stretch
Shows how much of a difference there is between UV coordinates and 3D coordinates. Blue means low
distortion, while Red means high distortion. Choose to display the distortion of Angles or the Area.

Procedural Textures
Procedural textures are textures that are defined mathematically. They are
generally relatively simple to use, because they don’t need to be mapped
in a special way - which doesn’t mean that procedural textures can’t
become very complex.
These types of textures are ‘real’ 3D. By that we mean that they fit
together perfectly at the edges and continue to look like what they are
meant to look like even when they are cut; as if a block of wood had really
been cut in two. Procedural textures are not filtered or anti-aliased. This is
hardly ever a problem: the user can easily keep the specified frequencies
within acceptable limits.
These are the available types:
•
•
•
•
•
•
•
•
•
•

Blend
Clouds
Distorted Noise
Magic
Marble
Musgrave
Noise
Stucci
Voronoi
Wood

Common options
Noise Basis
Each noise-based Bforartists texture (with the exception of Voronoi and simple noise) has a Noise Basis setting
that allows the user to select which algorithm is used to generate the texture. This list includes the original
Bforartists noise algorithm. The Noise Basis settings makes the procedural textures extremely flexible
(especially Musgrave).
The Noise Basis governs the structural appearance of the texture :

5

Bforartists Reference Manual - © Copyright - This page is under OCL license

Bforartists Original

Voronoi F1

Voronoi F2-F1

Original Perlin

Voronoi F2

Voronoi Crackle

Improved Perlin

Voronoi F3

Cell Noise

Voronoi F4

There are two more possible settings for Noise Basis, which are relatively similar to Bforartists Original:
Improved Perlin and Original Perlin

Nabla
Almost all procedural textures in Bforartists use derivatives for calculating normals for texture mapping (with
as exception Blend and Magic). This is important for Normal and Displacment Maps. The strength of the effect
is controlled with the Nabla Number Button.

6
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Hints
Use the size buttons in the Mapping panel to set the size that the procedural textures are mapped to.
Procedural textures can either produce colored textures, intensity only textures, textures with alpha values and
normal textures. If intensity only ones are used the result is a black and white texture, which can be greatly
enhanced by the use of ramps. If on the other hand you use ramps and need an intensity value, you have to
switch on No RGB in the Mapping panel.

Procedural Shaders
Procedural shaders are shaders that relies at computer generated algorithms. Like a wood texture. Or a ocean
surface.

Ocean
TODO

Blend

Blend Texture Panels

Often used for
This is one of the most frequently used procedural textures. You can use blend textures to blend other
textures together (with Stencil), or to create nice effects (especially with the Mapping: Normal trick). Just
remember: if you use a ramp to create a custom blending, you may have to use No RGB, if the Mapping
value needs an intensity input.
Result(s)
Intensity. The Blend texture generates a smoothly interpolated progression.
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Options
Progression
Profile of blend
Linear
A linear progression
Quadratic
A quadratic progression
Easing
A flowing, non-linear progression
Diagonal
A diagonal progression
Spherical
A progression with the shape of a three-dimensional ball
Quadratic Sphere
A quadratic progression with the shape of a three-dimensional ball
Radial
A radial progression Horizontal / Vertical The direction of the progression is flipped a quarter turn.

Clouds
Clouds represent Perlin noise. In addition, each noise-based
Bforartists texture (with the exception of Voronoi and simple
noise) has a “Noise Basis” setting that allows the user to select
which algorithm is used to generate the texture.
Often used for
Clouds, Fire, Smoke. Well-suited to be used as a Bump
map, giving an overall irregularity to the material.
Result(s)
Greyscale (default) or RGB Color

Options
Greyscale
The standard noise, gives an intensity
Color
The noise gives an RGB value
Noise
Soft or Hard, changes contrast and sharpness
Size
The dimension of the Noise table
Depth
The depth of the Clouds calculation. A higher number results in a long calculation time, but also in finer
details.
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Distorted Noise
Distortion Noise takes the option that you pick from Noise Basis and filters it, to create hybrid pattern.
Often used for
Grunge, very complex and versatile
Result(s)
Intensity

Options
Noise Distortion
The texture to use to distort another
Basis
The texture to be distorted
Noise
The size of the noise generated
Distortion
The amount that Distortion Noise affects Basis

Magic
Often used for
Not frequently used. It can be used for “Thin Film
Interference”, if you set Mapping to Reflection and use a
relatively high Turbulence.
Result(s)
RGB color. The RGB components are generated
independently with a sine formula.

Options
Depth
The depth of the calculation. A higher number results in a
long calculation time, but also in finer details.
Turbulence
The strength of the pattern.
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Marble
Often used for
Marble, Fire, Noise with a structure
Result(s)
Intensity value only
Bands are generated based on the sine, saw, or triangular formulae and noise turbulence.

Options
Soft / Sharp / Sharper
Three presets for soft to more clearly defined Marble
Sin / Saw / Tri
Shape of wave to produce bands
Soft / Hard
The noise function works with two methods.
Size
The dimensions of the noise table
Depth
The depth of the Marble calculation. A higher value results in greater calculation time, but also in finer
details.
Turbulence
The turbulence of the sine bands.

Musgrave
Often used for
Organic materials, but it’s very flexible. You can do
nearly everything with it.
Result(s)
Intensity

Options
Type
This procedural texture has five noise types on which
the resulting pattern can be based and they are
selectable from a dropdown menu at the top of the tab.
The five types are:
•
•
•
•
•

Hetero Terrain
fBm
Hybrid Multifractal
Ridged Multifractal
Multifractal

These noise types determine the manner in which
10
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Bforartists layers successive copies of the same pattern on top of each other at varying contrasts and
scales.
Examples with Basis : Voronoi F1 - Dimension : 0.5 - Lacunarity : 0.15 - Octave: 2.0

Hetero Terrain

fBM

Hybrid Multifrct

Ridged Multifrct

Multifractal

The main noise types have four characteristics:
Dimension
Fractal dimension controls the contrast of a layer relative to the previous layer in the texture. The higher
the fractal dimension, the higher the contrast between each layer, and thus the more detail shows in the
texture. Range: 0 to 2.
Lacunarity
Lacunarity controls the scaling of each layer of the Musgrave texture, meaning that each additional layer
will have a scale that is the inverse of the value which shows on the button. i.e. Lacunarity = 2 –> Scale =
1/2 original. Range: 0 to 6.
Octaves
Octave controls the number of times the original noise pattern is overlayed on itself and scaled/contrasted
with the fractal dimension and lacunarity settings. Range: 0 to 8.
Intensity
Light intensity. Called Offset for Hetero Terrain. Range: 0 to 10.
The Hybrid Multifractal and Ridged Multifractal types have these additional settings:
Offset
Both have a “Fractal Offset” button that serves as a “sea level” adjustment and indicates the base height
of the resulting bump map. Bump values below this threshold will be returned as zero. Range: 0 to 6.
Gain
Setting which determines the range of values created by the function. The higher the number, the greater
the range. This is a fast way to bring out additional details in a texture where extremes are normally
clipped off. Range: 0 to 6.

Noise
Although this looks great, it is not Perlin Noise! This is a true, randomly generated Noise. This gives a different
result every time, for every frame, for every pixel.
There are no options for this noise
Often used for
White noise in an animation. This is not well suited if you
don’t want an animation. For material displacement or
bump, use clouds instead.
Result(s)
11
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Intensity

Stucci
The Stucci texture is based on noise functions.
Often used for
Stone, Asphalt, Oranges. Normally for Bump-Mapping to
create grainy surfaces.
Result(s)
Normals and Intensity

Options
Plastic / Wall In / Wall out
Plastic is the standard Stucci, whilst the “walls” is where
Stucci gets it name. This is a typical wall structure with
holes or bumps.
Soft / Hard
There are two methods available for working with Noise
Size
Dimension of the Noise table
Turbulence
Depth of the Stucci calculations

Voronoi
Often used for
Very convincing Metal, especially the “Hammered”
effect. Organic shaders (e.g. scales, veins in skin).
Result(s)
Intensity (default) and Color

Options
Distance Metric
This procedural texture has seven Distance Metric
options. These determine the algorithm to find the
distance between cells of the texture. These options are:
•
•
•
•
•
•

Minkovsky
Minkovsky 4
Minkovsky 1/2
Chebychev
Manhattan
Distance Squared
12
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• Actual Distance
The Minkovsky setting has a user definable value (the Exponent button) which determines the Minkovsky
exponent (e) of the distance function (xe + ye + ze )1/e. A value of one produces the Manhattan
distance metric, a value less than one produces stars (at 0.5, it gives a Minkovsky 1/2), and higher values
produce square cells (at 4.0, it gives a Minkovsky 4, at 10.0, a Chebychev). So nearly all Distance Settings
are basically the same - variations of Minkowsky.
You can get irregularly-shaped rounded cells with the Actual Distance / Distance Squared options.

Minkovsky Exponent: 0.5

Minkovsky Exponent: 1

Minkovsky Exponent: 2 (Actual

(Minkovsky 1/2)

(Manhattan)

Distance)

Minkovsky Exponent: 4 (Minkovsky Minkovsky Exponent: 10

Distance Squared (More contrast

4)

than ActualDistance)

(Chebychev)

Feature Weights
These four sliders at the bottom of the Voronoi panel represent the values of the four Worley constants,
which are used to calculate the distances between each cell in the texture based on the distance metric.
Adjusting these values can have some interesting effects on the end result...
Coloring
Four settings (Intensity, Position, Position and Outline, and Position, Outline, and Intensity) that can use
four different noise basis as methods to calculate color and intensity of the texture output. This gives the
Voronoi texture you create with the “Worley Sliders” a completely different appearance and is the
equivalent of the noise basis setting found on the other textures.

Wood
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Often used for
Woods and ring-shaped patterns.
Result(s)
Intensity only

Options
Sin / Saw / Tri
Shape of wave to produce bands
Bands / Rings / Band Noise / Ring Noise
Set the bands to either straight or ring-shaped, with
or without turbulence
Soft / Hard
There are two methods available for the Noise
function
Size
Dimension of the Noise table
Turbulence
Turbulence of the Band Noise and Ring Noise types

UV Mapping
The most flexible way of mapping a 2D texture over a 3D object is a process called “UV mapping”. In this
process, you take your three-dimensional (X,Y & Z) mesh and unwrap it to a flat two-dimensional (X & Y ... or
rather, as we shall soon see, “U & V”) image. Colors in the image are thus mapped to your mesh, and show up
as the color of the faces of the mesh. Use UV texturing to provide realism to your objects that procedural
materials and textures cannot do, and better details than Vertex Painting can provide.

UVs Explained

Box being inspected

Box mapped flat
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The best analogy to understanding UV mapping is cutting up a cardboard box. The box is a three-dimensional
(3D) object, just like the mesh cube you add to your scene.
If you were to take a pair of scissors and cut a seam or fold of the box, you would be able to lay it flat on a
tabletop. As you are looking down at the box on the table, we could say that U is the left-right direction, is V is
the up-down direction. This image is thus in two dimensions (2D). We use U and V to refer to these “texturespace coordinates” instead of the normal X and Y, which are always used (along with Z) to refer to “3D space.”
When the box is reassembled, a certain UV location on the paper is transferred to an (X,Y,Z) location on the
box. This is what the computer does with a 2D image in wrapping it around a 3D object.
During the UV unwrapping process, you tell Bforartists exactly how to map the faces of your object (in this
case, a box) to a flat image in the UV/Image Editor window. You have complete freedom in how to do this.
(Continuing our previous example, imagine that, having initially laid the box flat on the tabletop, you now cut it
into smaller pieces, somehow stretch and/or shrink those pieces, and then arrange them in some way upon a
photograph that’s also lying on that tabletop ...)

Cartography Example
Cartographers (map makers) have been dealing with this problem for millennia. A cartography (map-making)
example is creating a projection map of the whole world. In cartography, we take the surface of the earth (a
sphere) and make a flat map that can be folded up into the glove compartment aboard the space shuttle. We ‘fill
in’ spaces toward the poles, or change the outline of the map in any of several ways:

Mercator Projection

Mollweide Projection

Albers-equal Projection

Each of these is an example of a way to UV map a sphere. Each of the hundred or so commonly accepted
projections has its advantages and disadvantages. Bforartists allows us to do the same thing any way we want
to, on the computer.
On more complex models (like seen in the earth map above) there pops up an issue where the faces can’t be
‘cut’, but instead they are stretched in order to make them flat. This helps making easier UV maps, but
sometimes adds distortion to the final mapped texture. (Countries and states that are closer to the North or the
South Pole look smaller on a flat map than do ones which are close to the Equator.)
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Half-Sphere Example

3D Space (XYZ) versus UV Space (click to enlarge)

In this image you can easily see that the shape and size of the marked face in 3D space is different in UV space.
This difference is caused by the ‘stretching’ (technically called mapping) of the 3D part (XYZ) onto a 2D plane
(i.e the UV map).
If a 3D object has a UV map, then, in addition to the 3D-coordinates X, Y, and Z, each point on the object will
have corresponding U and V coordinates. (P in the image above is an example of how a point on a 3D object
might be mapped onto a 2D image.)

The UV Editor
About functionalities for mapping UV see UV/Image Editor section for details.

Advantages of UVs
While procedural textures (described in the previous chapters) are useful-they never repeat themselves and
always “fit” 3D objects-they are not sufficient for more complex or natural objects. For instance, the skin on a
human head will never look quite right when procedurally generated. Wrinkles on a human head, or scratches
on a car do not occur in random places, but depend on the shape of the model and its usage. Manually-painted
images, or images captured from the real world gives more control and realism. For details such as book covers,
tapestry, rugs, stains, and detailed props, artists are able to control every pixel on the surface using a UV
Texture.
A UV map describes what part of the texture should be attached to each polygon in the model. Each polygon’s
vertex gets assigned to 2D coordinates that define which part of the image gets mapped. These 2D coordinates
are called UVs (compare this to the XYZ coordinates in 3D). The operation of generating these UV maps is
also called “unwrap”, since it is as if the mesh were unfolded onto a 2D plane.
For most simple 3D models, Bforartists has an automatic set of unwrapping algorithms that you can easily
apply. For more complex 3D models, regular Cubic, Cylindrical or Spherical mapping, is usually not sufficient.
For even and accurate projection, use seams to guide the UV mapping. This can be used to apply textures to
16
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arbitrary and complex shapes, like human heads or animals. Often these textures are painted images, created in
applications like the Gimp, Photoshop, or your favorite painting application.
Note
Games
UV mapping is also essential in games. It is the de facto standard for applying textures to models. Almost any
model you find in a game is UV mapped.

UV Mapping a mesh
The first step is to unwrap your mesh. You want to unwrap when you feel your mesh is complete with respect to
the number of faces it needs to have. If you do add faces or subdivide existing faces when a model is already
unwrapped, Blender will add those new faces for you, but you may need to do additional mapping or editing. In
this fashion, you can use the UV Texture image to guide additional geometry changes.
This section covers techniques for Mapping Uvs. The next sections cover Editing UVs, followed by methods of
Managing UV Layouts, and Applying Images to UVs.

About UVs
Every point in the UV map corresponds to a vertex in the mesh. The lines joining the UVs correspond to edges
in the mesh. Each face in the UV map corresponds to a mesh face.
Each face of a mesh can have many UV Textures. Each UV Texture can have an individual image assigned to it.
When you unwrap a face to a UV Texture in the UV/Image Editor, each face of the mesh is automatically
assigned four UV coordinates: These coordinates define the way an image or a texture is mapped onto the face.
These are 2D coordinates, which is why they are called UV, to distinguish them from XYZ coordinates. These
coordinates can be used for rendering or for real-time OpenGL display as well.
Every face in Blender can have a link to a different image. The UV coordinates define how this image is
mapped onto the face. This image then can be rendered or displayed in real time. A 3D View has to be in “Face
Select” mode to be able to assign Images or change UV coordinates of the active Mesh Object. This allows a
face to participate in many UV Textures. A face at the hairline of a character might participate in the facial UV
Texture, and in the scalp/hair UV Texture.
These are described more fully in the next sections.
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Getting Started

UV Editing screen layout.
By default, meshes are not created with UVs. First you must map the faces, then you can edit them. The process
of unwrapping your model is done within Edit Mode in the 3D View editor. This process creates one or more
UV Islands in the UV/Image Editor.
To begin, choose the UV Editing screen layout from the selection list at the top of your screen in the User
Preferences header. This sets one of the area to show you the UV/Image Editor Shift-F10, and the other area
to the 3D View Shift-F5.
Enter Edit Mode, as all unwrapping is done in Edit Mode. You can be in vertex, face, or edge selection mode.

Workflow
The process for unwrapping is straightforward, but there are tons of options available, each of which
dramatically affect the outcome of the unwrap. By understanding the meaning behind the options, you will
become more efficient at unwrapping. The process is:
•
•
•
•
•
•

Mark Seams if necessary
Select all of the mesh components
Select a UV mapping method from the UV Unwrap menu
Adjust the unwrap settings
Add a test image to see if there will be any distortion. See Applying Images to UVs
Adjust UVs in the UV/Image editor. See Editing UVs
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Mapping Types
Blender offers several ways of mapping UVs. The simpler projection methods use formulas that map 3D space
onto 2D space, by interpolating the position of points toward a point/axis/plane through a surface. The more
advanced methods can be used with more complex models, and have more specific uses.
Basic:
Cube
Maps the mesh onto the faces of a cube, which is then unfolded.
Sphere
Projects the UVs onto a spherical shape. Useful only for spheres or spherical shapes, like
eyes, planets, etc.
Cylinder
Projects UVs onto a cylindrical surface.
Project from View
Takes the current view in the 3D View and flattens it as it appears.
Advanced:
Unwrap ABF
Useful for organic shapes. Smooths the mesh into a flat surface by cutting along seams.
Unwrap LSCM
Useful for non organic shapes. Smooths the mesh into a flat surface by cutting along seams.
Smart UV Project
Breaks the mesh into islands based on an angle threshold.
Lightmap Pack
Separates each face and packs them onto the UV grid.
Follow Active Quads
Follow UV from active quads along continuous face loops.
You can also reset UVs, which maps each face to fill the UV grid, giving each face the same mapping.
If we were to use an image that was tileable, the surface would be covered in a smooth repetition of that image,
with the image skewed to fit the shape of each individual face. Use this unwrapping option to reset the map and
undo any unwrapping (go back to the start).
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Basic Mapping
Based on the fundamental geometry of the object, and how it is being viewed, the Mesh ‣ UV Unwrap ‣ Cube,
Cylinder and Sphere UV Calculations attempt to unfold the faces for you as an initial best fit. Here, the view
from the 3D View is especially important. Also, the settings for cube size or cylinder radius (Editing buttons,
UV Calculation panel) should be set (in Blender units) to encompass the object.
The following settings are common for the Cube, Cylinder, and Sphere mappings:
Correct Aspect
Map UVs taking image aspect ratios into consideration. If an image has already been mapped to the
texture space that is non-square, the projection will take this into account and distort the mapping to
appear correct.
Clip to Bounds
Any UVs that lie outside the (0 to 1) range will be clipped to that range by being moved to the UV space
border it is closest to.
Scale to Bounds
If the UV map is larger than the (0 to 1) range, the entire map will be scaled to fit inside.

Cube
Cube mapping projects s mesh onto six separate planes, creating six UV islands. In the UV/Image editor, these
will appear overlapped, but can be moved. See Editing UVs.
Cube Size
Set the size of the cube to be projected onto.

Cylinder and Sphere
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Using a Mercator image with a Sphere Projection.
Cylindrical and Spherical mappings have the same settings. The difference is that a cylindrical mapping
projects the UVs on a plan toward the cylinder shape, while a spherical map takes into account the sphere’s
curvature, and each latitude line becomes evenly spaced.
Normally, to unwrap a cylinder (tube) as if you slit it lengthwise and folded it flat, Blender wants the view to be
vertical, with the tube standing “up”. Different views will project the tube onto the UV map differently, skewing
the image if used. However, you can set the axis on which the calculation is done manually. This same idea
works for the sphere mapping:
Recall the opening cartographer’s approaching to mapping the world? Well, you can achieve the same here
when unwrapping a sphere from different perspectives. Normally, to unwrap a sphere, view the sphere with the
poles at the top and bottom. After unwrapping, Blender will give you a Mercator projection; the point at the
equator facing you will be in the middle of the image. A polar view will give a very different but common
projection map. Using a Mercator projection map of the earth as the UV image will give a very nice planet
mapping onto the sphere.
Direction
View on Poles
Use when viewing from the top (at a pole) by using an axis that is straight down from the view
View on Equator
Use if view is looking at the equator, by using a vertical axis
Align to Object
Uses the object’s transform to calculate the axis
Align
Select which axis is up
Polar ZX
Polar 0 is on the x axis
Polar ZY
Polar 0 is on the y axis
Radius
The radius of the cylinder to use

Project From View
In the 3D View, the Face ‣ Unwrap UVs ‣ Project from View option maps the face as seen through the view of
the 3D View it was selected from. It is almost like you had x-ray vision or squashed the mesh flat as a pancake
onto the UV map. Use this option if you are using a picture of a real object as a UV Texture for an object that
you have modeled. You will get some stretching in areas where the model recedes away from you.
Using Project from View (Bounds) will do the same as above, but scales the UVs to the bounds of the UV space.

Resetting UVs
In the 3D View, Face ‣ Unwrap ‣ Reset maps each selected face to the same area of the image, as previously
discussed. To map all the faces of an object (a cube, for example) to the same image, select all the faces of the
cube, and unwrap them using the Reset menu option.
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Advanced Mapping
Unwrapping Using Seams

Simple Seam on a Cylinder.
For many cases, using the Unwrap calculations of Cube, Cylinder, Sphere, or best fit will produce a good UV
layout. However, for more complex meshes, especially those with lots of indentations, you may want to define
a seam to limit and guide any of the unwrapping processes discussed above.
Just like in sewing, a seam is where the ends of the image/cloth are sewn together. In unwrapping, the mesh is
unwrapped at the seams. Think of this method as peeling an orange or skinning an animal. You make a series of
cuts in the skin, then peel it off. You could then flatten it out, applying some amount of stretching. These cuts
are the same as seams.
When using this method, you need to be aware of how much stretching there is. The more seams there are, the
less stretching there is, but this is often an issue for the texturing process. It is a good idea to have as few seams
as possible while having the least amount of stretching. Try to hide seams where they will not be seen. In
productions where 3D paint is used, this becomes less of an issue, as projection painting can easily deal with
seams, as opposed to 2D texturing, where it is difficult to match the edges of different UV islands.
The workflow is the following:
• Create seams. A seam is marked in Edit Mode by selecting edges to make the seam and then issuing the
command to Mark Seam.
• Unwrap
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• Adjust seams and repeat
• Manually adjust UVs. See the next section on Editing UVs.

Marking Seams
Seamed Suzanne.
To add an edge to a seam, simply
select the edge and Ctrl-E Mark
Seam. To take an edge out of a
seam, select it, Ctrl-E and Clear
Seam.
In the example to the right, the
back-most edge of the cylinder was
selected as the seam (to hide the
seam), and the default unwrap
calculation was used. In the
UV/Image Editor, you can see that
all the faces are nicely unwrapped,
just as if you cut the seam with a
scissors and spread out the fabric.
When marking seams, you can use
the Select ‣ Linked Faces or
Ctrl-L in Face Select Mode to
check your work. This menu option selects all faces connected to the selected one, up to a seam. If faces outside
your intended seam are selected, you know that your seam is not continuous. You do not need continuous
seams, however, as long as they resolve regions that may stretch.
Just as there are many ways to skin a cat, there are many ways to go about deciding where seams should go. In
general though, you should think as if you were holding the object in one hand, and a pair of sharp scissors in
the other, and you want to cut it apart and spread it on the table with as little tearing as possible. Note that we
seamed the outside edges of her ears, to separate the front from the back. Her eyes are disconnected submeshes, so they are automatically unwrapped by themselves. A seam runs along the back of her head vertically,
so that each side of her head is flattened out.
Another use for seams is to limit the faces unwrapped. For example, when texturing a head, you do not really
need to texture the scalp on the top and back of the head since it will be covered in hair. So define a seam at the
hairline. Then, when you select a frontal face, and then select linked faces before unwrapping, the select will
only go up to the hairline seam, and the scalp will not be unwrapped.
When unwrapping anything that is bilateral, like a head or a body, seam it along the mirror axis. For example,
cleave a head or a whole body right down the middle in front view. When you unwrap, you will be able to
overlay both halves onto the same texture space, so that the image pixels for the right hand will be shared with
the left; the right side of the face will match the left, etc.
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Note
You do not have to come up with “one unwrapping that works perfectly for everything everywhere.” As we
will discuss later, you can easily have multiple UV unwrappings, using different approaches in different areas
of your mesh.

Unwrap ABF or LSCM
Result of unwrapping Suzanne.
Begin by selecting all faces to be unwrapped
in the 3D View. With our faces selected, it is
now time to unwrap them. In the 3D View,
select Mesh ‣ UV Unwrap ‣ Unwrap or U
and select Unwrap.
You can also do this from the UV/Image
Editor with UVs ‣ Unwrap or E. This
method will unwrap all of the faces and reset
previous work. The UVs menu will appear in
the UV/Image Editor after unwrapping has
been performed once.
This tool unwraps the faces of the object to
provide the “best fit” scenario based on how
the faces are connected and will fit within
the image, and takes into account any seams
within the selected faces. If possible, each
selected face gets its own different area of
the image and is not overlapping any other
faces UV’s. If all faces of an object are selected, then each face is mapped to some portion of the image.
Blender has two ways of calculating the unwrapping. They can be selected in the tool setting in the tool panel in
the 3D View.
Angle Based - ABF
This method gives a good 2D representation of a mesh. Good for organic shape.
Conformal - LSCM
Uses LSCM (Least Squared Conformal Mapping). This usually gives a less accurate UV mapping than
Angle Based, but works better for geometric shape.
Fill Holes
Activating Fill Holes will prevent overlapping from occurring and better represent any holes in the UV
regions.
Correct Aspect
Map UVs taking image aspect into account
Use Subsurf Modifier
Map UVs taking vertex position after subsurf modifier into account
Margin
Space between UV islands
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Tip
A face’s UV image texture only has to use part of the image, not the whole image. Also, portions of the same
image can be shared by multiple faces. A face can be mapped to less and less of the total image.

Smart UV Project

Smart UV project on a cube.
Smart UV Project, (previously called the Archimapper) gives you fine control over how automatic seams
should be created, based on angular changes in your mesh. This method is good for simple and complex
geometric forms, such as mechanical objects or architecture.
This function examines the shape of your object, the faces selected and their relation to one another, and creates
a UV map based on this information and settings that you supply.
In the example to the right, the Smart Mapper mapped all of the faces of a cube to a neat arrangement of three
sides on top, 3 sides on the bottom, for all six sides of the cube to fit squarely, just like the faces of the cube.
For more complex mechanical objects, this tool can very quickly and easily create a very logical and
straightforward UV layout for you.
The Tool Settings panel in the Tool Shelf allows the fine control over how the mesh is unwrapped:
Angle Limit
This controls how faces are grouped: a higher limit will lead to many small groups but less distortion,
while a lower limit will create fewer groups at the expense of more distortion.
Island Margin
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This controls how closely the UV islands are packed together. A higher number will add more space in
between islands.
Area Weight
Weight projection’s vector by faces with larger areas

Lightmap Pack
Lightmap Pack takes each of a mesh’s faces, or selected faces, and packs them into the UV bounds. Lightmaps
are used primarily in gaming contexts, where lighting information is baked onto texture maps, when it is
essential to utilize as much UV space as possible. It can also work on several meshes at once. It has several
options that appear in the Tool Shelf:
You can set the tool to map just Selected Faces or All Faces if working with a single mesh.
The Selected Mesh Object option works on multiple meshes. To use this, in Object Mode select several mesh
objects, then go into Edit Mode and activate the tool.
Share Tex Space
This is useful if mapping more than one mesh. It attempts to fit all of the objects’ faces in the UV bounds
without overlapping.
New UV Layer
If mapping multiple meshes, this option creates a new UV layer for each mesh. See Managing the Layout.
New Image
Assigns new images for every mesh, but only one if Shared Tex Space is enabled.
Image Size
Set the size of the new image.
Pack Quality
Pre-packing before the more complex Box packing.
Margin
This controls how closely the UV islands are packed together. A higher number will add more space in
between islands.

Follow Active Quads
The Face ‣ Unwrap ‣ Follow Active Quads takes the selected faces and lays them out by following continuous
face loops, even if the mesh face is irregularly shaped. Note that it does not respect the image size, so you may
have to scale them all down a bit to fit the image area.
Edge Length Mode:
Even
Space all UVs evenly.
Length
Average space UV’s edge length of each loop.
Please note that it is the shape of the active quad in UV space that is being followed, not its shape in 3D space.
To get a clean 90-degree unwrap make sure the active quad is a rectangle in UV space before using “Follow
active quad”.
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Managing UV Maps
After you finish editing a UV map, you may need to create additional maps on the same object, or transfer a UV
map to another mesh.

Transferring UV Maps
You can copy a UV Map from one mesh to another Mesh provided both meshes have the same geometry/vertex
order. This is useful for example when you want to recreate a UV map from an earlier version of your model
with intact UVs.

Workflow
• RMB Select the target mesh (to which you want to copy the UV Map)
• Shift select the source mesh (that contains the intact UV map)
• Object menu ‣ Make Links... ‣ Transfer UV Layouts (Shortcut: Ctrl-L ...)
The target Mesh will now have a UV map that matches the original mesh.

Multiple UV Maps

Mesh with Multiple UV Textures

You are not limited to one UV Map per mesh. You can have multiple UV maps for parts of the mesh by creating
new UV Textures. The first UV Texture is created for you when you select a face in UV Face Select mode. You
can manually create more UV Textures by clicking the New button next to “UV Texture” on the Mesh panel in
the Buttons Window, Editing Context) and unwrapping a different part of the mesh. Those faces will then go
with that UV Texture, while the previously unwrapped faces will still go with the previous UV Texture. Note
that if you unwrap the same face twice or more times (each time to a different UV Texture), the coloring for that
face will be the alpha combination of the layers of those UV Textures.
In the example to the right, we have a mesh for a blouse. The mesh has been seamed as a normal blouse would,
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shown in the middle in UV Face Select mode. Wishing to make a cut pattern, the front of the blouse was
unwrapped and basic rotation and scaling was done to center it in the UV/Image Editor window. It was then
moved off to the side, while the left and right sleeves were unwrapped, each rotated and scaled. Then, select a
sample face from each cloth piece, in the 3D View Select–>Linked Faces, and the UV/Image Editor will show
all those pieces (as shown to the right). You can then work with all pieces for that UV Map. The example shows
all three pieces moved onto the image area for painting. As you can see, the pattern nicely fits a square yard of
cloth.
Another UV Map was created by clicking the New button in the Mesh panel, and the process was repeated for
the backs of the sleeves and the back of the blouse. Two images, one for the front and one for the back, are used
to color the fabric. In this case, some faces map to the first texture, while other faces map to the second texture.

UV Textures List
The Mesh panel lists the UV Texture maps created for this mesh, and allows you to create New ones as
placeholders for future unwrapping operations.
Click the + button to add a new UV texture, and the - to delete an existing one}}.
Deleting a UV Map for the mesh destroys all work done in all unwrapping
associated the mesh. Click with care. You’ve been warned.
Each map has a selector button. Click the camera icon to enable that UV texture
for rendering. You can change the name by selecting one and changing the text in
the Name box. The selected map is displayed in the UV/Image Editor window. The example shows a few UV
maps created for a character, and the map for Clothes is selected.
Note that each texture can be mapped to a specific UV texture. See the Mapping section of the texture panel.

Applying Textures
Sooner or later, you may want to use an image texture on your model. If you are using an external application,
you need to know where on the mesh you are painting. You may also need to test your UV mapping with a test
image. This section covers how to export an outline of your UV map, and how to load images into the UV
editor.

Exporting UV Layout Image
As a way of communicating to an artist who is painting your UV Texture for you, Bforartists has a tool called
Save UV Face Layout (located in the UV/Image Editor Window, UVs–>Save UV Face Layout) that saves an
image as a Targa (.tga), EPS, or an SVG format for the object you have selected.
The image is an outline of the UV face mapping. Activating the tool brings up the File Browser Window with
options for saving the layout:
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Export Options

All UVs
if disabled, then only the UV faces selected will be outlined
Modified
Export UVs from the modified mesh.
Format
Select the type of image file to save (.png, .eps, .svg)
Size
select the size of the image in pixels. The image be square.
Fill Opacity
Set the opacity of the fill regions. Completely Opaque is 1, completely transparent is 0. It is opaque by
default.
The image will be lines defining the UV edges that are within the image area of the UV mapping area. Edges
outside the boundary, even if selected, will not be shown in the saved graphic.
The artist will use this as a transparent layer in their paint program as a guide when painting your texture. The
example below shows Bforartists in the background, and the Gimp working on the texture, using the saved
layout as a guide. Note that targa format supports the Alpha channel, so you can paint transparent areas of the
mesh.
For using images as textures, see the page on Image Textures

A UV Layout in the UV Editor

A UV Layout in the Image Editor

Applying Textures to UVs
The UV/Image Editor allows you to map textures directly to the mesh faces. The 3D View window shows you
the object being textured. If you set this window into Textured viewport shading, you will immediately see any
changes made in the UV/Image Editor window in this window, and vice versa.
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You can edit and load images, and even play a game in the Bforartists Game Engine with UV textures for
characters and object, without a material, and still see them in the 3D window. This is because no ‘real’
rendering is taking place; it is all just viewport shading. If you were to apply an image to UVs then render, the
texture would not show up by default
To render an image however, you must
• create a Material for the object, and
• tell Bforartists to use the UV Textures on faces when rendering.
To create a Material, you have to click Add New Material in the Shading context.
There are two ways to tell Bforartists to use the UV Texture when rendering: the Proper way and the Quick
Way:

Use UV Coordinates

A texture setup to map using its UV coordinates

In the Texture channel panel, Add a New Texture and define the texture as an image and load the image you
want to use. In the Mapping section, choose UV from the Coordinates menu, and select the UV layer to use.
Make sure it is mapped to Color in the Influence section as well (it will be mapped to Color by default, and the
UV Texture is named “UVTex” by default). If the image has an alpha channel and you want to use it, click
“UseAlpha” in the Map Image panel.
Full details of using Image textures are on the Image Textures page.
Note
Material is Required for Rendering
You can perform UV Texturing on a mesh within Bforartists without assigning a material, and you will even
see it in your 3D View in textured viewport mode. However, when you render, you will just get a default gray
if the object does not have a Material assigned. You will get a black if you do not load an image. If you do not
create a texture that uses the image, or enable Face Texture, your object will render according to the
procedural material settings.
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Face Textures

The Material panel with activated Face Textures button.

An alternate way is to set up a Face Textures Material as shown. To do so, with the buttons window displayed,
press F5 to display the Shader Buttons. In the Buttons window, Material settings, click ADD NEW material.
On the Options panel, enable Face Textures. This way is quick, but bypasses the normal rendering system for
fast results, but results which do not respect transparency and proper shading.

Loading and Saving Images
In the UV editor, you can assign certain faces certain textures. To do so, first you need an image to work with.
In the Image Menu you can open an image file with the File Browser. If you have images in the file already,
that you want to use, click the Browse button in the Header, or make a new texture by clicking the New button.
In a team environment, or if you are using an external paint program to edit the image while the .blend file is
active, and the file is updated and re-saved, use the UV/Image Editor to Image–>Reload it and see the latest
and greatest in Bforartists. Also, use Reload if you have mapped more faces to an image, and the 3D View will
be updated with the latest image mapping back to faces.
If you move the image file, Bforartists may not be able to find it, and you will have to Image–>Replace it. Use
this option to map a UV layout to a different image altogether.

Replacing the active Image
Recall that each face gets coordinates and a link to an image. To map a face to a different image, simply select
that face (or faces) and use the UV/Image Editor window Image}} menu to Replace the current image with an
existing file (such as a JPG or PNG file).

New Images
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The new Image dialogue

When you select New Image you are presented with several options. This Generated image can also be
modified afterward in the Properties Panel:
Image Name
Set the name if the generated image
Width and Height
Set the size if the image in pixels
Color
Sets the default fill color if creating a blank image.
Alpha
Adds an alpha channel to the image
Generated Type
The type of image to generate:
UV Grid
Creates a checkerboard pattern with a colored + in each square.
Color Grid
Creates a UV Test Grid, which is useful for testing how UVs have been mapped, and to reduce
stretching. There are two types available, which can be set after the image has been created.
Blank
Generates a blank image of the specified color.
32 bit
Creates a 32 bit image. This is a larger file size, but holds much more color information than the standard
8 bit image. For close ups and large gradients, it may be better to use a 32 bit image.

Using the Test Grid
Use the UV Test Grid option to check for undue stretching or distortion of faces. If your image is a base
uniform pattern and you want the application of that image to your model to look like cloth, you do NOT want
any stretching (unless you want the cloth to look like spandex).

A preview of the texture on the geometry
The test grid applied to the UVs

When you render, the mesh will have the test grid as its colors, and the UV Texture will be the size image you
specified. You can save the UV image using the Image–>Save menu.
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Image Settings
When an image has been loaded or created in the UV editor, an additional section appears in the Properties
Panel. The first row of buttons allow you to:
•
•
•
•
•
•

Browse for an image
Change the image name
Set as Fake User
Create a New Image
Open an image
Unlink Data-Block

Select the image type in the Source menu. Each has different options:
Generated
Generates a new image:
Width and Height of image in pixels
Blank
Creates a Blank image
UV grid
Creates a checkerboard pattern with colored plus symbols in each square.
Color Grid
Creates a more complex colored grid with letters and numbers denoting locations in the grid.
File
Use for loading image files:
Fields
Use if image is made of fields. You can set it to use Upper First or Lower First
Premultiply
Converts RGB from key alpha to premultiplied alpha.
Movie and Sequence
Frames
Set the number of frames to use
Start
Set the starting frame of the movie/sequence
Offset
Offset the number of frame used in the animation
Fields
Set the number fields per rendered frame to use(2 fields is 1 frame)
Auto Refresh
Always refresh images on frame changes.
Cyclic
Cycle the images in a movie/sequence.

Saving Images
Images can be saved to external files if they were created or edited in Bforartists with tools in the Image menu.
If images are already files, use the Save command (Alt-S). You can also Save As (F3) if the image was
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generated or you want to save as a different name. Using Save as Copy, (F3) will save the file to a specified
name, but will keep the old one open in the Image editor.

Modifying your Image Texture
To modify your new Texture, you can:
• Render Bake an image based on how the mesh looks
• The Render Bake feature provides several tools to replace the current image based on a render of
Vertex Paint colors, Normals (bumps), Procedural materials, textures and lighting, and ambient
occlusion.
• Paint using Texture Paint.
• Use the UV/Image Editor menu Image –> New. Then start painting your mesh with
• Use external software to create an image
• Using your favorite image painting program, you could use an exported UV layout to create a
texture. Then save your changes, and back in Bforartists, use the Image–>Open menu command
to load it as your UV image for the mesh in Face Select Mode for the desired (and active) UV
Texture layer. Using the Edit Externally tool in the Image menu, Bforartists will open an image
editor, as specified in the User Preferences and load in the image to be edited.
• Use the “projection painting” feature of recent versions of Bforartists
• Use the Bake uV-Textures to Vertex Colors add-on to create an image from vertex colors
• Some combination of the above.
The first three options, (UV Painter, Render Bake, and Texture Baker) replace the image with an image that
they create. Texture paint and external software can be used to add or enhance the image. Regardless of which
method you use, ultimately you must either
• save your texture in a separate image file (for example JPG for colors, PNG with RGBA for alpha),
• pack the image inside the blend file (UV/Image Editor Image–>Pack as PNG),
• or do both.
The advantage to saving as a separate file is that you can easily switch textures just by copying other image
files over it, and you can use external editing programs to work on it. The advantage of packing is that your
whole project is kept in the .blend file, and that you only have to manage one file.
You can invert the colors of an image by selecting the Invert menu. in the Image menu

Packing Images inside the Blend file
If you pack your .blend file, the current version of all UV Texture images are packed into the file. If those files
later change, the updates will not be automatically re-packed; the old version of the image is what will be used.
To update, you will have to re-pack or reload.
To pack an image, select Pack Image from the Image menu. To Unpack, select this option again and select
Remove Pack. The File–>Append function automatically goes into .blend files and shows you the image
textures packed in it.
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UV/Image Editor
The UV Image Editor is the place where you deal with all the textures and images that you use in Bforartists.
It is also the place where you can display and edit the UV mapping, which doesn't necessarily require to have a
image to be loaded. The UV / Image Editor has different modes, dependant of what you want to do and what
element is active. We will go through them one by one.

Navigating in the UV IMage Editor viewport
Pan the view - MMB
Zoom - Mouse Wheel, LMB+CTRL, Numpad + / View All - Home
View Fit - Numpad Period

Header - View Menu
When nothing is loaded then you have just a few elements
available in the header. And most of them are disfunctional until
something is loaded.
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View Menu
The View menu contains view related tools. The content is varying, dependant in
what mode you are, and what you currently do.

Properties
Opens or closes the Properties sidebar at the right side of the UV Image Editor.

Tool Shelf
Opens or closes the Tool Shelf at the left side of the UV Image Editor.

View Zoom In
Zooms into the view

View Zoom Out
Zooms out of the view

Zoom 1:8 ... Zoom 8:1
A set of predefined zoom factors.

View All
View all zooms in or out until all selections are displayed fitting in the viewport.

View Fit
Zooms in or out to fit the selection into the current view.

Duplicate Area into new Window
Duplicate Area into New Window makes the selected editor
window floating. You can then drag it around at the monitor.
A separated window cannot be merged into the main window
again. You have to close it when not longer needed.
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Toggle Maximize Area
Displays the editor maximized with menus.
To return to split view press hotkey Ctrl Up Arrow, or reuse the
menu item in the View menu.

Toggle Full screen Area
Displays the editor maximized without menus.
To return from the full screen view press hotkey Alt F10, or use
the little button that appears up right when you move the mouse in

Render Border
Just visible when you have a render result selected!
This feature allows you for preview purposes to render just a part of the image
instead of the full image.
Note that the render border in the Image editor is not visible like in the 3D view.

Clear Render Border
Just visible when you have a render result selected!
Removes an existing render border.

Render Slot Cycle Next
Just visible when you have a render result selected!
You can have up to 8 different render slots. Here you can cylce through them by menu entry and
hotkey.

Render Slot Cycle Previous
Just visible when you have a render result selected!
You can have up to 8 different render slots. Here you can cylce through them by menu entry and hotkey.
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View Selected
Just visible with 3D View in Edit mode, for UV mapping.
View Selected zooms in or out until the Selection is displayed fitting in the viewport.

Header - Image menu
Here you will find all image related menu items.
When the currently selected image is unsaved then the menu name
contains an asterisk.

New Image
Creates a new image. You will get a dialog where you can define settings for
the new image.

Name
The name of the new image

Width
The width of the new image.

Height
The height of the new image.

Color
Here you can adjust the color of the new image. A click will call a color picker.

Alpha
Check this checkbox if the new image should have an alpha channel.

Generated Type
Here you can define what kind of texture you want to create.
Blank is one plain color.
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UV Grid is a checker texture in black and white.
Color Grid is a colored checker texture.

32 Bit Float
Check this checkbox if the image should be in 32 Bit floating point bit depth per channel. Else it is in 8 bit per
channel.

Open Image
Opens the file browser to load an image.

Read Render Layers
Just visible when you have a render result selected!
Read all the current scene's render layers from cache, as needed. For this featute to
work save Buffers needs to be activated in the Performance tab in the render settings.
This feature can be be used to save RAM while rendering because the render layers do
not have to be saved in RAM. It can also be used to recover some information from a
fail render.

Save all Images
Saves all images.
Note that the images must already exist somewhere at your hard disk so that they can be saved.

Replace Image
Replaces the currently active image by an image that you load.

Reload Image
Reloads the currently selected image.
Note that the images must already exist somewhere at your hard disk. When you create a new image in
Bforartists, then this image isn't saved yet, and so you cannot reload it.

Save Image
Saves the currently selected image without any further questions. Note that the images must already exist
somewhere at your hard disk.

Save As Image
Saves the currently selected image.
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Save a Copy
Saves a copy of the currently selected image. This will save the file to a specified name, but will keep the old
one open in the Image editor.

Edit Externally
Here you can open the image in a defined external image editor like The Gimp or Photoshop.
The image must be saved. And the image editor must be defined in the User Preferences.

Invert
Invert is a sub menu where you can invert the colors of the whole image,
or just specific colors.

Pack Image / Pack as PNG
Packs the currently active image into the blend file. When you save the blend file the next time, then this image
will be embedded.
Packed images are marked with a pack icon. A click at this icon will unpack the
texture, and try to save it to file. Usually to the last existing location before it was
packed.
Warnning
You cannot modify packed images. Changes at the image will not be saved. You need to unpack the image
when you want to modify it. And repack it after you have done the changes.

Header - Select menu
This menu just appears when you are in Edit mode in the 3D viewport, and you edit the
UV's of a mesh. It allows you to select the UV geometry in the UV / Image Editor.

Border Select
Border select enters the Border Select mode. This is a special select mode where you can
select elements by dragging a rectangle. And what's inside of the rectangle gets selected
then. It adds to selection by default.
To subtract from selection hold down Shift key.
The selection gets applied when you release the mouse. You leave the mode
automatically when you release the mouse.

Border Select Pinned
Same as with Border Select. But just vertices that are pinned gets selected.
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Circle Select
Circle select enters the Circle Select mode. This is a special select mode where you can select elements by
moving with the mouse over it. It adds to selection by default.
To subtract from selection hold down Shift key. To exit the Circle select click with the right mouse button.
The pencil radius of the circle select tool can be adjusted with the scroll wheel.

(De)select All
Toggles between select all and deselect all.

Inverse
Inverts the current selection.

Linked
Select all UV vertices linked to the active UV map. The previous selection gets cleared.

Last Operator Select Linked
Extend
The previous selection gets kept, the selection gets extended.

Linked Extend
Select all UV vertices linked to the active UV map. The previous selection gets kept.

Linked Pick
Hotkey Only Tool!
Select all UV vertices linked to the active UV map. The previous selection gets cleared.

Last Operator Select Linked
Extend
The previous selection gets kept, the selection gets extended.

Linked Pick Extend
Hotkey Only Tool!
Select all UV vertices linked to the active UV map. The previous selection gets kept.

Pinned
Selects all pinned vertices.
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Split
Select only entirely selected faces. When you just have three vertices of the face selected, then this face is not
selected.

More
Select more

Less
Select less.

Header - UV's menu
This menu just appears when you are in Edit mode in the 3D viewport, and you edit the
UV's of a mesh. It contains some UV editing related functionality.

Show/Hide Faces
This is a sub menu where you can show or hide UV faces. And this not
only in the UV Image Editor, but also in the 3D view.

Show Hidden
Makes all faces visible again.

Hide Selected
Hides the selected faces.

Hide Unselected
Hides the not selected faces. The selected faces stays visible.

Export UV Layout
Here you can export the UV layout to an image, so that you can use it as a mask to build your texture in your
favourite image editing software like Phothoshop. It will open a file dialog, where you can define further export
settings down left.
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All UV's
Export all UV's, not just the visible ones.

Modified
Export UV's from the modified mesh.

Format
Here you can choose the export format.

Size
Here you can define the size of the image.

Fill Opacity
How opaque the wireframe lines are.

Header - Mask menu
This menu appears when you are in Mask mode. In Mask mode you can mask areas with
splines. This can be useful for motion tracking.

Delete
Deletes the selected spline(s) or spline points.

Duplicate
Deletes the selected spline(s) or spline points.

Clear Parent
Clears the parent relationship.

Make Parent
Parents the selected spline points. Mask splines can be parented to motion tracker markers.

Copy Splines
Copys the selected spline(s) or spline points.

Paste Splines
Pastes the copied spline(s) or spline points.
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Show/Hide
Show/Hide Faces
This is a sub menu where you can show or hide the selection.

Show Hidden
Makes hidden splines visible again.

Hide Selected
Hides the selected spline(s)

Hide Unselected
Hides the not selected spline(s). The selected spline(s) stays visible.

Transform
This is a sub menu with some transform menu items. This menu items are
hotkey tools!

Translate
Move the selection.

Rotate
Rotate the selection.

Scale
Scale the selection.

Scale Feather
Shrinkfattens the selection.

Header tools
The header contains several tools, dependand of what you do and what toolset is selected.
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Image Prop
This property contains the list of loaded images. When no
image is loaded then it displays the New and Open Buttons.
When an image exists then it displays the name of the currently selected image.
From left to right ...

List of images in the scene
This is a list of the images in the scene. Here you can switch to other images.

Image Edit Box
Here you can read the name of the currently selected image. And you can rename the image here too.

Fake User
Wit this button you assign a fake user to this selected image.
Data, like images, that is not longer linked to anything else gets removed when you save and reload a scene.
Bforartists has the concept of fake users to go around this behaviour. An image with a fake user is in fact linked
to something. And so it is not lost when you save and reload the scene.

Search form
Here you can search for specific images.

New Image
Create a new image.
Creates a new image. You will get a dialog where you can define settings for
the new image.

Name
The name of the new image

Width
The width of the new image.

Height
The height of the new image.
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Color
Here you can adjust the color of the new image. A click will call a color picker.

Alpha
Check this checkbox if the new image should have an alpha channel.

Generated Type
Here you can define what kind of texture you want to create.
Blank is one plain color.
UV Grid is a checker texture in black and white.
Color Grid is a colored checker texture.

32 Bit Float
Check this checkbox if the image should be in 32 Bit floating point bit depth per channel. Else it is in 8 bit per
channel.

Open Image
Opens the file browser to load an image.

Unlink Datablock
This deletes the selected image. Unfortunately not immediately. You need to save the scene and to reload it.
And you need to make sure that it is not linked to anything else. A mesh or a
fake user for example. Have a look if there is a number besides the F button.
When this is the case then the image has still a user, and so still loads with loading the scene.

Use Image Pin
When you select another object. for UV
mapping for example, then usually the
connected images for this object gets
displayed. Use image pin nails the currently selected image so that it stays displayed.

Mode
The UV Image Editor has three image modes. View, Paint and Mask mode.

View
In this mode you can view the images.
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Paint
In this mode you can paint at images. The paint tools can be found in the tool shelf.

Mask
In this mode you can create a mask, and mask parts of the
images with spline shapes. The mask tools can be found in
the tool shelf.

Pivot Point
This tool is for UV Editing.
The pivot point is the center point in the current selection of UV elements. Rotation
happens around this center point for example. Here you can define where this center point is defined.
The pivot point is not visible.

Bounding Box Center
Uses the center of the bouding box around the current selection.

Median Point
Uses the center of the selected geometry.
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2D Cursor
Uses the 2D cursor as the pivot point.

Individual Origins
Uses an individual pivot point for every UV element.

Draw Channels
This toolbar appears when you have an image loaded. Here you can define specific display modes of the image

Color and Alpha
Displays the whole image, including alpha channel.

Color
Displays the whole image, but without alpha channel.

Alpha
Displays the alpha channel of the image.

Red
Displays the red channel of the image.

Green
Displays the green channel of the image.

Blue
Displays the blue channel of the image.
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Use Realtime Update
This setting appears when you are in Paint mode or in UV Editing mode.
Updates other editor windows like the 3D view while you paint or while you edit UV data.

Mask Prop
When you are in mask mode then you can create a new mask, and work with this mask then.

List of Masks
This is a list of the masks in the scene. Here you can switch to other masks.

Mask Edit Box
Here you can read the name of the currently selected mask. And you can rename
the image mask too.

Fake User
Wit this button you assign a fake user to this selected mask. Masks gets created with a fake user already. Means
when you save the scene and reopen it, then this mask will still be there.
Data, like images, that is not longer linked to anything else gets removed when you save and reload a scene.
Bforartists has the concept of fake users to go around this behaviour. An image with a fake user is in fact linked
to something. And so it is not lost when you save and reload the scene.

Search form
Here you can search for specific images.

Create Mask
Adds a new mask.

Unlink Datablock
This deletes the selected mask. Unfortunately not immediately. You need to save the scene and to reload it.
And you need to make sure that it is not linked to anything else. A mesh or a
fake user for example. Have a look if there is a number besides the F button.
When this is the case then the image has still a user, and so still loads with loading the scene.

27

Bforartists Reference Manual - © Copyright - This page is Public Domain

Header - UV Editing
The UV Image Editor is not only used for images. But also to manipulate the UV data of mesh objects. UV
mapping is the process to project a 2D texture at your 3D mesh.
In the 3D view select your mesh object, enter edit mode, choose a uv mapping method like Smart UV project,
and you will see the UV mapping result in the UV Image Editor. For our example cube all six sides are now laid
out flat.

The image editor is the place where
you can further edit this UV mesh
now. The header provides some tools
for this purpose.

Use UV select Sync
Here you can toggle between two modes for editing the UV geometry. Both methods have their purpose.
With UV Select Sync off you will be able to modify single UV elements, like whole
UV patches. And the 3D view will not change its selection.
When you have some geometry in the 3D view not selected, then it will not show up
in the UV image editor neither.

Vertex selection mode
Select vertices in the UV geometry.

Edge selection mode
Select edges in the UV geometry

Face selection mode
Select single faces in the UV geometry

Island selection mode
Select whole UV patches in the UV geometry.
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With UV Select Sync on you will keep selections of UV space and 3D view in sync. But
you cannot modify single UV elements anymore. In this mode you work with Vertices,
Edges and Faces.
All UV geometry of the object will show up, no matter what's selected in the 3D view.

Vertex selection mode
Select vertices in the UV geometry and at the 3D mesh
object.

Edge selection mode
Select edges in the UV geometry and at the 3D mesh
object.

Face selection mode
Select single faces in the UV geometry and at the 3D mesh object.

Sticky Selection mode
This options controls how UV's are selected when
Sync Selection is off. This mainly affects vertices. But edge and face selection relies at
vertices too.

Disabled
No sticky selection. You can just move one UV vertice at time. In case you have two
vertices above each other, like with a UV patch with two faces, then just one vertice
gets selected. Even when it's the same UV patch.

Shared Location
Selects all UV vertices under the mouse in case it's part of the same UV patch.
Vertices of other UV patches gets ignored.
In this shot the two down left faces are one UV patch.
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Shared Vertex
Selects all UV vertices that shares the same vertice at the 3D mesh. Regardless if it's
the same UV patch or not.

Proportional editing
Proportional Editing is a drop-down box where you can choose to use proportional editing.
When you choose one of the active methods, then the neighbour geometry gets influenced
by any transformation too in a proportional way.
Proportional Editing Falloff
Proportional Editing Falloff is a drop-down box where you can choose a method for the
falloff for the proportional editing.

Snapping
Here you can turn on or off Snapping.

Increment
Snaps by two units at the grid that is displayed in the UV image editor.

Vertex
Snaps the selection to other vertices.

Snap target
Here you can adjust how the selection snaps to other vertices.
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UV Map
A mesh object can have more than one UV map.
Usually you manage the UV maps in the properties
editor. This dropdown list is to have a quick way to
switch between the existing UV maps. So that you
don't have to dive into the Properties editor for that.
A UV map is simply a group of selected UV elements. The UV layout can differ
too. Secondary UV's are used where a mesh simply needs more than one
texture. And you don't want to create more materials for it. A terrain mesh for example, to mix two textures
together.

Use Realtime Update
This setting appears when you are in Paint mode or in UV Editing mode. Updates other editor
windows like the 3D view while you paint or while you edit UV data.

Tool Shelf - Grease Pencil
The Grease Pencil tool is a tool with which you can paint strokes in
editors like the 3D view. They can be converted into polygons. The
Grease Pencil tool is available in all modes.
It is unfortunately cluttered across two shelves. The Tool Shelf and the
Properties Editor. Means you have to adjust settings at two places.
The first thing that you have to do is to create a new Grease pencil. This can either be done in the Properties
Editor by clicking at New. Or in the Grease Pencil Tab in the Tool Shelf by simply clicking at the Draw button.
Then all Grease Pencil tools becomes visible. And a Grease Pencil layer gets created.

Grease Pencil Panel
The Grease Pencil panel contains the general Grease Pencil tools. The Draw tool,
eraser, some settings and tools.
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Draw
The Draw section contains the draw tools.

Draw
Draw activates the freehand draw mode.

Erase
Erase is the eraser tool with which you can delete strokes.

Line
Line paints a straight line between start and end point.

Poly
Poly allows you to paint polygon shapes.

Eraser Radius
Here you can adjust the radius of the eraser tool. Have a look at the hotkey, it's a
hotkey only tool for proper functionality.

Insert Blank Frame
Insert a blank frame on the current frame.

Delete frames
Delete the active frame(s) of all editable grease pencil layers.

Draw Settings
The draw settings are placed besides each other, to save space.

Additive Drawing
When you create new frames then the strokes from the previous active frame are included as the base for the
current frame.

Continuous Draw
The Continuous Draw checkbox enables and disables the continuous draw mode. Normally the draw mode ends
when you stop drawing the current line. And you have to activate the draw tool again when you want to
continue with painting. With continuous draw you can immediately paint the second stroke without to enable
the draw tool again.
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Eraser in Continuous Draw
The draw tools are disabled as long as you are in continuous draw. To erase a stroke use the
right mouse button. The pencil turns into a red circle. With which you can erase strokes
now.
End Continuous Draw
The draw tools are disabled as long as you are in continuous draw. To end the continuous
draw mode click outside of the viewport. In the tool shelf for example.

Draw on Back
New strokes will be drawn behind all other strokes in the layer

Stroke Placement
Stroke Placement defines where the Grease Pencil stroke is placed.

View
View will place the stroke at the top of the viewport. It is not drawn in the 3D view.

Cursor
Cursor will place the stroke aligned with the 3d cursor, and aligned with the current camera view. It is drawn in
the 3D view.

Enable Editing
Sometimes you want to edit the strokes that you have placed. Here you can enter the editing mode, and reveal
some editing tools.

Edit Strokes Panel
The Edit Strokes Panel contains the tools to edit the Grease Pencil strokes. Most
of the tools are pretty self explaining.
It is divided into two sections. Select and Edit.

Select
The select section.

33

Bforartists Reference Manual - © Copyright - This page is Public Domain

Select All
Toggles between select all and deselect all.

Border Select
Border select enters the Border Select mode. This is a special select mode where you can select elements by
dragging a rectangle. And what's inside of the rectangle gets selected then. It adds to selection by default.
To subtract from selection hold down Shift key.
The selection gets applied when you release the mouse. You leave the mode automatically when you release the
mouse.

Circle Select
Circle select enters the Circle Select mode. This is a special select mode where you can select elements by
moving with the mouse over it. It adds to selection by default.
To subtract from selection hold down Shift key. To exit the Circle select click with the right mouse button.
The pencil radius of the circle select tool can be adjusted with the scroll wheel.

Select Linked
Select the linked vertices of the same stroke.

Select More
More expands the selection.

Select Less
Less reduces the selection.

Select Color
Select all grease pencil strokes with the same color than the currently selected one.
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Edit
The Edit section.

Translate
Moves the selected grease pencil geometry in the viewport by moving the
mouse.
Last Operator Translate
The last operator appears in the 3D view!
Vector
Here you can adjust the position values for the three values
Constraint Axis
Here you can limit the position relative to the source object.
Orientation
Orientation is a drop-down box where you can choose the type of orientation for the
mirroring action.

Proportional Editing
Proportional Editing is a drop-down box where you can choose to use proportional editing.
When you choose one of the active methods then the neighbour geometry gets influenced
by Shrink/Fatten too in a proportional way.
Proportional Editing Falloff
Proportional Editing Falloff is a drop-down box where you can choose a method for the
falloff for the proportional editing.
Proportional Size
Proportional size is a edit box where you can adjust the strength of the Proportional
falloff.
Edit Grease Pencil
Edit Grease Pencil edits the selected Grease Pencil strokes.
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Edit Texture Space
With Confirm on Release checked the action gets performed when you release the mouse button.

Rotate
The last operator appears in the 3D view!
Rotates the selected grease pencil geometryi in the viewport by moving the mouse.
Last Operator Translate
Angle
Here you can adjust the rotation angle.
Constraint Axis
Here you can limit the position relative to the source object.
Orientation
Orientation is a drop-down box where you can choose the type of orientation for the
mirroring action.
Proportional Editing
Proportional Editing is a drop-down box where you can choose to use proportional editing.
When you choose one of the active methods then the neighbour geometry gets influenced
by Shrink/Fatten too in a proportional way.
Proportional Editing Falloff
Proportional Editing Falloff is a drop-down box where you can choose a method for the
falloff for the proportional editing.
Proportional Size
Proportional size is a edit box where you can adjust the strength of the Proportional
falloff.
Edit Grease Pencil
Edit Grease Pencil edits the selected Grease Pencil strokes.

Scale
The last operator appears in the 3D view!
Scales the selected grease pencil geometry in the viewport by moving the
mouse.
Last Operator Resize
Vector
Here you can adjust the position values for the three values
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Constraint Axis
Here you can limit the position relative to the source object.
Orientation
Orientation is a drop-down box where you can choose the type of orientation for the
mirroring action.
Proportional Editing
Proportional Editing is a drop-down box where you can choose to use proportional editing.
When you choose one of the active methods then the neighbour geometry gets influenced
by Shrink/Fatten too in a proportional way.
Proportional Editing Falloff
Proportional Editing Falloff is a drop-down box where you can choose a method for the
falloff for the proportional editing.
Proportional Size
Proportional size is a edit box where you can adjust the strength of the Proportional
falloff.
Edit Grease Pencil
Edit Grease Pencil edits the selected Grease Pencil strokes.
Edit Texture Space
With Confirm on Release checked the action gets performed when you release the mouse button.

Mirror
Mirror mirrors the selected geometry along the defined axis. Click the Mirror button, type
in X, Y or Z, then confirm with enter.
Last Operator Mirror
The Last Operator Mirror panel gives you tools to adjust the mirror action.
Constraint Axis
Constraint Axis gives you again the possibility to define the mirror axis. You can choose
more than one axis here.
Orientation
Orientation is a drop-down box where you can choose the type of orientation for the
mirroring action.
Proportional Editing
Proportional Editing is a drop-down box where you can choose to use proportional editing.
When you choose one of the active methods then the neighbour geometry gets influenced
by Shrink/Fatten too in a proportional way.

37

Bforartists Reference Manual - © Copyright - This page is Public Domain

Proportional Editing Falloff
Proportional Editing Falloff is a drop-down box where you can choose a method for the falloff for the
proportional editing.
Proportional size
Proportional size is a edit box where you can adjust the strength of the Proportional
falloff.
Edit Grease Pencil
Edit Grease Pencil edits the selected Grease Pencil strokes.
Confirm on Release
With Confirm on Release checked the action gets performed when you release the mouse button.

Shear
Shear shears the selection.
Last Operator Shear
Offset
Adjust the offset
Proportional Editing
Proportional Editing is a drop-down box where you can choose to use proportional editing.
When you choose one of the active methods then the neighbour geometry gets influenced
by Shrink/Fatten too in a proportional way.
Proportional Editing Falloff
Proportional Editing Falloff is a drop-down box where you can choose a method for the
falloff for the proportional editing.
Edit Grease Pencil
Edit Grease Pencil edits the selected Grease Pencil strokes.
Confirm on Release
With Confirm on Release checked the action gets performed when you release the mouse
button.

To Sphere
To Sphere transforms the selection into a spherical form.
Last Operator To Sphere
Factor
Adjust the rounding factor
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Proportional Editing
Proportional Editing is a drop-down box where you can choose to use proportional editing. When you choose
one of the active methods then the neighbour geometry gets influenced by Shrink/Fatten too in a proportional
way.
Proportional Editing Falloff
Proportional Editing Falloff is a drop-down box where you can choose a method for the
falloff for the proportional editing.

Proportional Size
Adjust the proportional size
Edit Grease Pencil
Edit Grease Pencil edits the selected Grease Pencil strokes.
Confirm on Release
With Confirm on Release checked the action gets performed when you release the mouse
button.

Arrange Strokes
This is a dropdown box where you can arrange the currently selected stroke relative to
the other ones.

Move to Color
Recolors the currently selected grease pencil stroke with the
active color in the Grease Pencil Colors color.
The grease pencil colors can be found in the properties sidebar
at the right.

Subdivide
Subdivide subdivides the current selection.
Last Operator Subdivide Stroke
Number of Cuts
Adjust the number of subdivisions
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Join
Joins strokes.
Last Operator Join Strokes
Type
Here you can choose if it should only join, or join and also copy the strokes.
Leave Gaps
Leave Gaps between joined strokes instead of linking them.

Join & Copy
Joins strokes and copies it.
For last operator see above.

Flip Direction
Change the direction of the stroke.

Sculpt Strokes Panel
The Sculpt Strokes Panel provides tools to sculpt the Grease pencil strokes.

Note!
The Sculpt Strokes Panel is just visible in Edit Strokes
Mode!

Sculpt Strokes Button
The Sculpt Strokes Button activates the Sculpt brush. Now you can sculpt the Grease Pencil stroke with left
mouse button. Clicking with right mouse button ends the sculpt mode.

Radius
The radius of the sculpt brush.
The button behind the edit box allows you to set the radius by moving the mouse. This should be done in the
viewport and with the hotkey. This button is just a visible reminder.

Strength
The strength of the sculpt brush.
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The button behind the edit box allows you to set the strength by moving the mouse. This should be done in the
viewport and with the hotkey. This button is just a visible reminder.

Use Falloff
Defines if the brush has a falloff from the centre to the border of the pencil.

Position
The Brush affects the position of the point.

Strength
The Brush affects the strength of the point.

Thickness
The Brush affects the thickness of the point.

Selection Mask
Only sculpt the selected points.

Alpha
Alpha value for selected vertices.

Affect Pressure
Affect pressure values as well when smoothing strokes.

Drawing Brushes panel
The Drawing Brushes panel contains everything around the Brushes and their settings. It is visible in all modes.
But the content just shows when you have activated the draw tool already.

Brushes selection box
Here you can choose different brush types. At the right you can add and remove
brushes. And you can sort the brushes order.

Thickness
Defines the thickness of the stroke.

Sensitivity
Pressure sensitivity for new strokes.
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Strength
Color strength for new strokes. The alpha factor of the color is affected.

Randomness
Randomness factor for pressure and strength of new strokes.

Jitter
Jitter factor for new strokes.

Angle
Direction of the stroke at which the brush gives the maximum thickness.

Factor
Reduce Brush thickness by this factor when stroke is perpendicular to angle direction

Smooth
Amount of smoothing to apply to newly created strokes to reduce jitter / noise.

Iterations
Number of times to smooth newly created strokes.

Subdivision
Number of times to subdivide newly created strokes, for less jagged strokes.

Randomness
Randomness factor for new strokes after subdivision.

Brush Curves Panel
The Brush curves panel is meant for usage with tablets. Here you can manipulate the curves
for Sensitivity, Strength and Jitter.
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Grease Pencil - Properties Sidebar - Layers Panel
The Grease Pencil Layers are connected with
the Grease Pencil panel in the Tool Shelf.
And provides you with the layer settings for
the Grease Pencil.
When no layer exists then there are just a few
buttons available.

Grease Pencil Prop
Here you can add a new grease pencil to work with. Or choose an existing
grease pencil.
The edit box allows you to rename the current grease pencil.
The F Button adds a fake user to the grease pencil. So that it does not get
deleted when you delete the connected object and close the scene.
When you add a fake user, then a number field will appear that shows how
much users are connected with the current pencil.

New Layer
Here you can create a new layer for your grease pencil. Doing so will reveal several layer
settings. And another panel with some color settings.
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Layer list
Here you can see a list of the current layers. And here you can select the current
active layers.
Grease Pencil Layers can be locked (lock icon) and hidden (eye icon). The third
symbol is to unprotect selected colors from further modifications.

Add / Delete
Right besides the layer list box there is a add button and a delete button. The plus button adds a new
layer, The minus button removes the current layer.

Layer Specials menu
Below the add and delete buttons there is a text menu with some further options.

Duplicate Layer
Duplicates the currently selected layer.

Show All
Unhides all hidden layers.

Hide Others
Hides all layers but the selected.

Lock All
Locks all layers.

Unlock All
Unlocks all layers.

Merge Down
Merges all layers into one.

Move Up / Move down
Moves the currently selected Grease pencil layer one up or down the list.
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Lock Unlock unselected / Show Hide unselected
Lock Unlock unselected toggles the lock for the unselected layers.
Show Hide unselected toggles the visibility for the unselected layers.

Opacity
Opacity sets the opacity of the current grease pencil stroke.

X Ray
X Ray makes the grease pencil stroke appear in front of objects. Without X Ray the stroke will be
invisible behind objects.

Show Points
Shows the points in the current grease pencil stroke.

Tint
Tint tints the color of the current grease pencil stroke with the tint color.
The upper field is a color picker where you can select a color. The fac slider defines the blending
factor between the grease pencil stroke color and the tint color.

Thickness Change
Increase or decrease the thickness of the grease pencil stroke.
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Lock Frame
You can draw grease pencil strokes in different frames. Here you can lock those frames
from further editing.

Onion Skinning
You can draw grease pencil strokes in different frames.
With onion skinning you can display the strokes from the
previous and following frames as ghost drawings.

Onion Skinning checkbox
Activates / deactivates the onion skinning.

Use always ghosts
When activated the ghost images will also show in rendering.

Use custom colors
Here you can choose to display the ghost drawing in predefined colors, or in their original colors. Default is to
display the predefined colors.

Before
Here you can choose in which color the previous frame gets displayed. And how many frames gets displayed
before the current frame.

After
Here you can choose in which color the following frame gets displayed. And how many frames gets displayed
after the current frame.

Properties Sidebar - Grease Pencil - Colors Panel
The grease pencil colors panel contains all the settings to set up and define the colors
that you use for your grease pencil drawings.
It activates when you start to draw a grease pencil stroke. And shows its content then.

GP Palette
Here you can select, create and delete a color palette for the grease pencil colors.
Define some colors in the Color list, then create a new palette with it.
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Color List
Here you can add custom colors.
The color field at the beginning of the edit box reveals a color picker when you click
at it. Which allows you to define a color.
The string “Color”, “Color 002” and “Color 003” is an edit box which allows you to
rename the color. Click into the field to activate it.
The Lock symbol allows you to lock the current color.
The eye symbol allows you to show or hide the current layer.
The ghost symbol allows you to display this color with onion skinning.

Add / Delete
Right besides the layer list box there is a add button and a delete button. The plus button adds a new
layer, The minus button removes the current layer.

Palette color Specials menu
Below the add and delete buttons there is a text menu with some further options.

Show All
Unhides all hidden colors.

Hide Others
Hides all colors but the selected.

Lock All
Locks all colors.

Unlock All
Unlocks all colors.

Copy color
Copys the color.

Select strokes
Selects all grease pencil strokes that uses the curent color.
47

Bforartists Reference Manual - © Copyright - This page is Public Domain

Move to color
Move selected strokes to active color.

Strokecolor
Here you can define the stroke color and set its opacity.

Volumetric Strokes
With Volumetric strokes the grease pencil stroke does not draw as a stroke, but a line of dotted points.

Fill
Fill fills the space between the grease pencil strokes.
The opacity is by default at zero. The fill color shows when you
increase the opacity.

High Quality Fill
Fill Strokes uses high quality to avoid glitches. But this gives slower fps while animation. Here you can turn it
off.

Tool Shelf - Scopes Tab
The Scopes tab contains several panels with analytic tools.
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Histogram
Histogram is a graph that displays the color distribution of the pixels in the image. The
range from left to right goes from 0, which represents black, to 255, which represents
white. And the height represents how much pixels in the image have this specific color.
The different display modes are:

Luma
Shows the luminosity of an image.

RGB
Shows the RGB channels.

R/G/B/A
Shows the R, G, B, A channels.

Show line
Displays lines instead of filled shapes.

Waveform
The waveform graph is another way to display the color information of the image.

Waveform Opacity
Here you can adjust the opacity of the pixels in the waveform histogram.

Waveform Mode
This is a dropdown box menu where you can choose further options.

Luma
Shows the luminosity of an image.

Parade
The RGB channels are shown side-by-side.

YCbCr (jpeg)
Displays the channels in the YCbCr standard, fitting to Jpg.

YCbCr (ITU 709)
Displays the channels in the YCbCr standard, fitting to ITU 709 standard.
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YCbCr (ITU 601)
Displays the channels in the YCbCr standard, fitting to ITU 601 standard.

Red Green Blue
Shows the RGB channels overlaid as a “Full color” waveform.

Vectorscope
This is a graph to display the pixel color distribution in the image in a radial way. The
radial arrangement allows to display data that is behind the maximum 255 of the
normal histogram. This can happen with 32 bit float images for example.

Vectorscope Opacity
Here you can adjust the opacity of the pixels in the waveform histogram.

Sample Line
The Sample Line scope is a graph that allows you to get the sample data from a line.
Click at the Sample Line button above the histogram to draw a line. The pixels under
this line will then be used to read the sample data from.
The different display modes are:

Luma
Shows the luminosity of an image.

RGB
Shows the RGB channels.

R/G/B/A
Shows the R, G, B, A channels.

Show line
Displays lines instead of filled shapes.

Scope Samples
Scope samples contains general option settings for the above histograms.
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Full Sample
Sample every pixel.

Accuracy
Proportion of original image source pixel lines to sample.

Properties Sidebar - Image panel
Here you will find some image related settings.
This settings are different, dependant of what Source type you have loaded.

Image Prop
This property contains the list of loaded images. It displays the name of the
currently selected image.
From left to right ...

List of images in the scene
This is a list of the images in the scene. Here you can switch to other images or
movies.

Image Edit Box
Here you can read the name of the currently selected image. And you can rename the image here too.

Fake User
Wit this button you assign a fake user to this selected image.
Data, like images, that is not longer linked to anything else gets removed when you save and reload a scene.
Bforartists has the concept of fake users to go around this behaviour. An image with a fake user is in fact linked
to something. And so it is not lost when you save and reload the scene.
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Search form
Here you can search for specific images.

Source
Here you can define what kind of image is loaded. The settings of the Image are different, dependant of what
type you choose here.
Note that when you switch an Image to Generated for example, then the image information gets lost.

Generated
When you create a new image, then this image is generated.
Generated images does not have a path.

Color Space
Here you can choose the color space type for the image.

View as Render
Toggles the color management settings in the color management panel in
the properties window on and off.

X/Y
The image width and height.

Float Buffer
Use a floating point buffer. 8 Bit images uses integers. 32 Bit works with floats.
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Generated Type Blank
This type displays an image with one blank color
Color
The color of the blank image.

Generated Type UV Grid
This type displays an with a black and white checker texture but colored dots.

Generated Type Color Grid
This type displays an with a colored checker texture with numbers.

Movie + Image Sequence
Path edit box
Pack
With this button you can pack the movie or the image sequence into the blend file. It
gets packed when you save the blend file the next time.
Path edit box
Here you can see and edit the path to your movieor image sequence files.
Open
Here you can open a new movie or image sequence files. A file dialog will appear.
Refresh
Here you can reread the movie or image sequence files.

Info string
Some information about the currently loaded movie. Frames, resolution and colorspace.

Color Space
Here you can choose the color space type for the movie or image sequence files.
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View as Render
Toggles the color management settings in the color management panel in
the properties window on and off.

Use Alpha
Use an alpha channel if available.

Alpha
Here you can choose the alpha channel mode. Straight or Premultiplied.

Deinterlace
Deinterlace the movie file on load.

Fields
Use fields of the image.
In video, a field is one of the many still images which is displayed sequentially to create the impression of
motion on the screen. Two fields makes one video frame.
Number of fields
The number of fields to use. Usually two.
Upper or Lower First
Order of video fields. Upper or Lower first.

Frames
Number of frames of the movie or image sequence files to use.

Start
The start frame.

End
The end frame.

Match Movie Length
Sets the value in the Frames edit box to the movie length.
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Auto Refresh
Always refresh image on frame changes

Cyclic
Cycle the images in the movie.

Single Image

Path edit box
Pack
With this button you can pack the movie or the image sequence into the blend file. It
gets packed when you save the blend file the next time.
Path edit box
Here you can see and edit the path to your movieor image sequence files.
Open
Here you can open a new movie or image sequence files. A file dialog will appear.
Refresh
Here you can reread the movie or image sequence files.

Info string
Some information about the currently loaded image. Resolution and colorspace.

Color Space
Here you can choose the color space type for the movie or image sequence files.

View as Render
Toggles the color management settings in the color management panel in
the properties window on and off.
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Use Alpha
Use an alpha channel if available.

Alpha
Here you can choose the alpha channel mode. Straight or Premultiplied.

Fields
Use fields of the image.
In video, a field is one of the many still images which is displayed sequentially to create the impression of
motion on the screen. Two fields makes one video frame.
Upper or Lower First
Order of video fields. Upper or Lower first.

Properties Sidebar - Game Properties panel
The BGE is fully accessible and functional. But Bforartists does officially not
maintain, support or document any game related settings. Please refer to the Blender
manual.

Properties Sidebar - Display panel with Image
The Display panel shows different content, dependant of what you do. Here we will
cover the image related content.

Aspect Ratio
Here you can set the aspect ratio of the image.

Update Automatically
Update other editor windows simultaneously with the changes or transforms in the UV Image Editor.

Draw Other Objects
Draw other selected objects that shares the same image.
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Show Metadata
Draw Metadata properties of the image.

Coordinates
Repeat
With this ticked the image is repeated in the UV Image canvas.

Tool Shelf - Tools Tab - UV Editing - Snap panel
The Tools tab and its content just appears when you do UV editing at a mesh object.
Here you can find some snapping tools for the UV geometry.

Selected to Pixels
Selected to Pixels saps the selected element(s) to the nearest pixel.

Selection to Cursor
Selection to Grid snaps the selected element(s) to the 2D cursor. ALL selected elements will end at cursor
position. For example all selected vertices.

Selection to Cursor ( Offset )
Selection to Grid snaps the selected element(s) to the 2D cursor. The centre of the selected elements will snap to
the 2D cursor. A group of vertices for example will remain its shape.

Selection to Adjacent unselected
Selection to Adjacent unselected snaps the selected element(s) to the center of
the closest adjacent unselected element(s) in the 3D space.

Cursor to Pixels
Cursor to Pixel snaps the 2D cursor to the nearest pixel

Cursor to Selected
Cursor to Selected snaps the 2D cursor to the selected element(s)
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Tool Shelf - Tools Tab - UV Editing - UV Align panel
The Tools tab and its content just appears when you do UV editing at a mesh object.
Here you can find various align tools. The last operator for this tools can be found in
the 3D view.

Mirror X
Mirrors the selection along the X axis. The mirror point is the pivot of the selection.

Mirror Y
Mirrors the selection along the Y axis. The mirror point is the pivot of the selection.

Last Operator Mirror
The Last Operator Mirror panel gives you tools to adjust the mirror action.

Constraint Axis
Constraint Axis gives you the possibility to define the mirror axis. You can choose more than one axis here.

Orientation
Orientation is a drop-down box where you can choose the type of orientation for the
mirroring action.

Proportional Editing
Proportional Editing is a drop-down box where you can choose to use proportional editing.
When you choose one of the active methods then the neighbour geometry gets influenced
by Shrink/Fatten too in a proportional way.

Proportional Editing Falloff
Proportional Editing Falloff is a drop-down box where you can choose a method for the
falloff for the proportional editing.

Proportional size
Proportional size is a edit box where you can adjust the strength of the Proportional
falloff.
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Edit Grease Pencil
Edit Grease Pencil edits the selected Grease Pencil strokes.

Rotate +90
Rotates the selection by 90 degrees clockwise.

Rotate -90
Rotates the selection by 90 degrees counter clockwise.

Last Operator Rotate

Angle
The amount that you want to rotate.

Constraint Axis
Constraint Axis gives you the possibility to define the constraint axis. You can choose more
than one axis here.

Orientation
Orientation is a drop-down box where you can choose the type of orientation for the
mirroring action.

Proportional Editing
Proportional Editing is a drop-down box where you can choose to use proportional editing.
When you choose one of the active methods then the neighbour geometry gets influenced
by Shrink/Fatten too in a proportional way.

Proportional Editing Falloff
Proportional Editing Falloff is a drop-down box where you can choose a method for the
falloff for the proportional editing.

Proportional size
Proportional size is a edit box where you can adjust the strength of the Proportional
falloff.

Edit Grease Pencil
Edit Grease Pencil edits the selected Grease Pencil strokes.
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Straighten
Straightens the selected geometry in both directions, X and Y axis.

Straighten X
Straightens the selected geometry along the X axis.

Straighten Y
Straightens the selected geometry along the Y axis.

Align Auto
Aligns the selection. The align axis gets chosen from the selection itself. When it's higher than tall, then it
aligns along the Y axis. When it's taller than high, then it aligns along the X axis.
The align point is the pivot of the selection.

Align X
Aligns the selection along the X axis. The align point is the pivot of the selection.

Align Y
Aligns the selection along the Y axis. The align point is the pivot of the selection.

Last operator Align
The Last operator Align unions all the single straighten and align actions in one operator.

Axis
Lists the straighten and align methods again.

Tool Shelf - Tools Tab - UV Editing - UV Tools
The Tools tab and its content just appears when you do UV editing at a mesh object.
The UV tools are divided into two sections. UV Unwrap and Modify UV

UV Unwrap
The Unwrap section.

60

Bforartists Reference Manual - © Copyright - This page is Public Domain

Mark Seam
The unwrap algorithms Angle based and Conformal requires to have edges
marked as seams. Think of it as a cutting pattern for a trouser for example.
Such a trouser is also made of fabric patterns.
Same goes for the UV patches when you use Angle based or conformal
unwrapping. You need to cut your mesh into parts and mark edges as
seams, so that the algorithm knows where the seams are.
Mark seam marks the currently selected edge(s) as a seam. Seam edges
will be displayed as red in the 3D viewport. But not in the UV Image Editor. The UV patches represents the
seams.
You need to unwrap the mesh again when you want to apply changes.

Last Operator Mark Seam
Clear
Clears the seam instead of marking it.

Clear Seam
Clear seam removes the seam from the currently selected edge(s) in the 3D
view.

Mark Seams from Islands
Unwrapping creates the UV geometry from the 3D object. You mark the seams, then you click at unwrap, and
the UV mesh gets created.
Mark Seams from islands goes the other way around for marking seams. It creates the seams at the mesh object
in the 3D view from the UV geometry in the UV Image Editor.
A use case is wheen you import meshes. Then you usually just have the UV patches in the UV Image editor.
And when you want to modify the UV's further, then you need the seams at the mesh.

Unwrap ABF
Unwrap ABF unwraps the selected geometry with the method Angle based. ABF stands for Angle Based
Flattening. ABF can give a bit better result than LSCM when unwrapping organic shapes.
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Note that you need to have the geometry selected in the 3D view.
Unwrap LSCM
Unwrap ABF unwraps the selected geometry with the method Angle based. ABF stands for Angle Based
Flattening. LSCM can give a bit better results than ABF with geometric shapes.

Note that you need to have the geometry selected in the 3D view.
Last Operator Unwrap
The last operator appears in the 3D view. Unwrap ABF and Unwrap LSCM shares the same
Last Operator.
Method

Method is a drop down box where you can choose between Unwrap method Angle Based
and Conformal.
Fill Holes

Fill holes in the mesh before unwrapping.
Correct Aspect

Take the Image Aspect Ratio into account.
Use Subsurf Modifier

Unwraps an existing Subsurf Modifier. You need to add a Subsurf Modifier first.
Margin

The distance between the single UV patches.

Modify UV
The tools to modify the UV geometry.

Pin
Pins the selected vertices . This vertices are now nailed for the unwrap algorithms
Angle based and Conformal. Their positions will not change when you repeat the
unrwapping. And the algorithms will try to fit the rest of the geometry to this
pinned vertices.
Pinned vertices are marked red.
A use case is for example when you have a distorted result for symmetric geometry
like a face with the Conformal method. Then you can try to align two center vertices, pin them, and repeat the
conformal method. It may be more symmetrical afterwards.

Unpin
Unpins pinned geometry.
62

Bforartists Reference Manual - © Copyright - This page is Public Domain

Last operator Pin
This last opeartor appears in the 3D view. Pin and unpin shares the same last operator.
Clear
Unpins pinned geometry.

Weld
Welds selected vertices together. The weld happens at the center point.

Stitch
Stitch tries to union UV patches along the selected edges or vertices. You need to click the tool twice. The first
click previews the stitching. The second click confirms the action then.

Last Operator Stitch
This last opeartor appears in the 3D view.
Use Limit
Just snap when the elements are below a given distance.
Snap Island
Snap the whole UV patch, or just the selected edge(s)/vertices
Limit
The limit distance for Use Limit.
Static Island
Here you can adjust which island stays in place when stitching.
Snap at Midpoint
Snap at the center point of the two elements instead the first to the last.
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Clear Seams
Unmarks seams when stitching.
Operation Mode
The operation mode. Edges or Vertices.

Remove Doubles UV
Welds overlapping UV vertices together.

Last operator Remove Doubles UV
This last opeartor appears in the 3D view.
Merge Distance
The distance below the vertices gets merged.
Unselected
Merge selected to other unselected vertices.

Average Island Scale
Scales the selected UV geometry to have the same relative size than the rest of the mesh. So that the texels at
the mesh have roughly the same size everywhere.

Pack Islands
Pack Islands tries to pack the selected UV geometry as close together as possible. Without to
waste too much empty space.
Note that the algorithm fails at round geometry. It calculates with rectangle shapes.

Last Operator Pack Islands
This last opeartor appears in the 3D view.
Rotate
Allow the UV patches to be rotated while the pack operation.
Margin
UV patches needs a margin between the single patches. So that the pixels of the texture doesn't bleed into other
areas. Here you can adjust this margin.
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Copy Mirrored UV coords
Copies and pastes the selected UV geometry on the X axis based on a mirrored mesh.
Use UV Select Sync must be off. The tool does not work with Use UV Select Sync on. And it is
not fully reliable as our example shows.

Minimize Stretch
You might end in a UV mapping result that still shows unwanted distortions here and there. For example when
you uv map a human face. Minimize Stretch tries to minimize this stretching effects in
the UV patches.
To view stretched areas at your UV patches, tick Stretch in the Properties Sidebar in
the Display panel, and switch from Angle to Area. Then a stretch mask gets displayed.
The color range goes from blue to green to red, where blue is minimal stretch and red
is maximal stretch.
Let's explain it with an example. A sphere where the cut is nearly at the pole. And uv
mapped with Angle Based. The result will of course show heavy stretched areas.

Note that the UV geometry must be selected in the UV Image editor. Now let's use the
Minimize stretch tool. The algorithm now first tries its best to find the best fitting
result that shows fewest stretching across the overall UV geometry.
The header shows a help text while the algorithm works. The Blend
factor is the value between the original unwrapped UV mesh, and the
maximum minimized stretch. You can also set this value manually by
using the scroll wheel at your mouse, or with the + and - keys.
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Last Operator Minimize Stretch
Fill Holes
Fill holes virtually fills holes before unwrapping to avoid overlappings and to preserve the geometry.
Blend
The Blend factor is the value between the original and the maximum minimized stretch.
Iterations
Number of iterations for the Minimize stretch algorithm.

Tool Shelf - Tools Tab - UV Editing - Transform panel
The Tools tab and its content just appears when you do UV editing at a mesh object.
Here you will find some navigation tools.

Translate
Moves the selected UV geometry in the viewport by moving the mouse.

Last Operator Translate
Vector
Here you can adjust the position values for the three values
Constraint Axis
Here you can limit the position relative to the source object.
Orientation
Orientation is a drop-down box where you can choose the type of orientation for the
mirroring action.
Proportional Editing
Proportional Editing is a drop-down box where you can choose to use proportional editing.
When you choose one of the active methods then the neighbour geometry gets influenced
by Shrink/Fatten too in a proportional way.
Proportional Editing Falloff
Proportional Editing Falloff is a drop-down box where you can choose a method for the
falloff for the proportional editing.
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Proportional Size
Proportional size is a edit box where you can adjust the strength of the Proportional falloff.
Edit Grease Pencil
Edit Grease Pencil edits the selected Grease Pencil strokes.
Edit Texture Space
With Confirm on Release checked the action gets performed when you release the mouse button.

Rotate
Rotates the selected UV geometry in the viewport by moving the mouse.

Last Operator Translate
Angle
Here you can adjust the rotation angle.
Constraint Axis
Here you can limit the position relative to the source object.
Orientation
Orientation is a drop-down box where you can choose the type of orientation for the
mirroring action.
Proportional Editing
Proportional Editing is a drop-down box where you can choose to use proportional editing.
When you choose one of the active methods then the neighbour geometry gets influenced
by Shrink/Fatten too in a proportional way.
Proportional Editing Falloff
Proportional Editing Falloff is a drop-down box where you can choose a method for the
falloff for the proportional editing.
Proportional Size
Proportional size is a edit box where you can adjust the strength of the Proportional
falloff.
Edit Grease Pencil
Edit Grease Pencil edits the selected Grease Pencil strokes.
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Scale
Scales the selected UV geometry in the viewport by moving the mouse.

Last Operator Resize
Vector
Here you can adjust the position values for the three values
Constraint Axis
Here you can limit the position relative to the source object.
Orientation
Orientation is a drop-down box where you can choose the type of orientation for the
mirroring action.

Proportional Editing
Proportional Editing is a drop-down box where you can choose to use proportional editing. When you choose
one of the active methods then the neighbour geometry gets influenced by Shrink/Fatten
too in a proportional way.
Proportional Editing Falloff
Proportional Editing Falloff is a drop-down box where you can choose a method for the
falloff for the proportional editing.
Proportional Size
Proportional size is a edit box where you can adjust the strength of the Proportional
falloff.
Edit Grease Pencil
Edit Grease Pencil edits the selected Grease Pencil strokes.
Edit Texture Space
With Confirm on Release checked the action gets performed when you release the mouse button.

Shear
Shear shears the selection.
Last Operator Shear
Offset
Adjust the offset
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Proportional Editing
Proportional Editing is a drop-down box where you can choose to use proportional editing.
When you choose one of the active methods then the neighbour geometry gets influenced
by Shrink/Fatten too in a proportional way.
Proportional Editing Falloff
Proportional Editing Falloff is a drop-down box where you can choose a method for the
falloff for the proportional editing.
Edit Grease Pencil
Edit Grease Pencil edits the selected Grease Pencil strokes.

Tool Shelf - UV Editing - Options Tab - Options Panel
In this panel you will find some options for UV editing. It has just one panel. The
Options panel.

UV Sculpt
Here you can enable the UV sculpting mode. With UV Sculpt enabled you can sculpt the UV
geometry.
When you turn on UV Sculpt, then the UV editing tools in the Tools tab disappears, and you
will find the sculpting tools instead.

Brush Size
Here yo can adjust the brush size for the UV sculpt. Hotkey tool! See also the Tools tab. There
are the sliders for this.

Brush Strength
Here yo can adjust the brush size for the UV sculpt. Hotkey tool! See also the Tools tab. See also the Tools tab.
There are the sliders for this.

Live Unwrap
Continously unwrap the selected UV Island while transforming pinned vertices.
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Snap to Pixels
Snap UV's to the closest pixel while editing.

Constraint to Image bounds
Constraints the UV geometry to stay within the image bounds while editing.

Tool Shelf - UV Sculpt - Tools Panel
When you turn on UV Sculpt in the UV Options, then the UV editing tools in the Tools tab disappears, and you
will find the sculpting tools instead.
There are two panels now for sculpting the UV geometry. UV Sculpt Panel and UV Sculpt Curve Panel.

UV Sculpt Panel
Radius
Here yo can adjust the brush size for the UV sculpt. See also the Options tab.

Strength
Here yo can adjust the brush strength for the UV sculpt. See also the Tools tab.

Lock Borders
With this option checked, the borders of the UV patches will not deform with sculpting.

Sculpt all Islands
With this option checked all UV patches that are covered by the brush will be deformed. Without this option
checked just the UV patch under the mouse will be sculpted.

UV Sculpt Tools
Here you can choose between three different brush types.

Show Brush
Shows the brush radius while sculpting.

UV Sculpt Curve Panel
Here you can adjust the brush falloff method. Use a curve shape, then adjust the handles.
Curve points can be moved by simply clicking at them and move them with the mouse.
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A new handle point can be added by left clicking at the curve.
Selected curve points are slightly brighter. And when you select a curve point, then you
will see two edit boxes with coordinates of this curve point.

Upper toolbar
Zoom in
Zooms in into the curve viewport.

Zoom out
Zooms out of the curve viewport

Tools
Reset View
Resets the curve viewport to initial zoom.
Vector Handle
Sets the handle type of the curve point to Vector Handle. This one breaks the tangent at
the curve handle, and makes it an angle.
Auto Handle
Sets the handle type of the curve point to Auto Handle.
Auto Clamped Handle
Sets the handle type of the curve point to Auto Clamped Handle.
Extend Horizontal
The line before and last handle point will go horizontal.

Extend Extrapolated
The line before and last handle point will go extrapolated from the curve.
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Reset Curve
Resets the curve, and removes all handle points. Unfortunately this resetted curve points
into the wrong direction.

Clipping
Use Clipping
Forces the curve points to stay between specified values.
Min X/Y and Max X/Y
Set the minimum and maximum bounds of the curve points.

Delete Point
Deletes the selected curve point. The first and last curve point cannot be deleted.

XY
When you have a curve point selected, then you will see two edit boxes below the curve
viewport. Here you can adjust the position of the curve point in a numerical way.

Curve presets
Below the curve viewport you will find some curve presets.

Properties Sidebar - UV Editing
When you are in UV editing then the Properties sidebar will show UV editing related properties.

UV Vertex panel
X/Y
Here you can adjust the position of your current selection.
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Without an image loaded the range goes from 0 to 255. With an image loaded you will work with the
dimensions of the image.

Display Panel
The Display panel has different content, dependant of what you work at. It shares its
settings between image and UV editing related settings.

Coordinates
Normalized
Draws the coordinates in a range of 0 to 1 instead of pixels. This affects for example the UV Vertex values.
First image is coordinates of a vertex in pixels. Second image shows it with the range.

Cursor Location
X/Y
The location of the 2D cursor in the image.

UV's
Outline
Displays the UV mesh wire as white with a black outline.
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Dash
Displays the UV mesh wire as dashed lines.

Black
Displays the UV mesh wire as pure black.

White
Displays the UV mesh wire as pure white.

Draw Faces
Draws the faces between the wireframe lines.

Stretch
Displays stretched areas in the mesh by color. The range goes from blue across green
up to red. Where blue is the fewest stretch, and red is the strongest stretch.
This setting is required when you want to work with the minimize stretch tool, and
want to see the stretched areas.

Angle
Shows the angular distortion between UV and 3D angles.

Area
Shows the area distortion between UV and 3D faces.

Smooth
Draw the UV wire with antialias.

Modified
Draw edges after modifiers are applied.
A use case for this setting is the SDS modifier. Without this setting just the original mesh gets displayed. With
this setting, also the edges of the SDS modifier gets displayed.

Draw Other Objects
Draw other selected objects that shares the same image.
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Other UV Filter
Draw just for same image, or all images.

Update Automatically
Update other editor windows simultaneously with the changes or transforms in the UV Image Editor.

UV Local View
Draw only faces with the currently displayed image assigned.

Draw Other Objects
Same as Draw other objects above. This one is a double menu entry.

Show Metadata
Draw Metadata properties of the image.

Applying Textures
Apply material to mesh
The most obvious way to apply a texture is first to create a valid UV
mapping, then to create a material with a texture. And assign this
material to the mesh.
We use the Cycles material system here. But the method works the
same with Blender Render.

Apply material to Mesh parts
In Edit Mode you can apply different materials to specific faces too.
First, create a second material like the one above, with our second
texture.
Enter Edit Mode, select the faces that you want to map with this other
texture. In the Properties Editor, click at Assign button. Then this second
material gets assigned to the selected geometry.
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Replace Texture
When you want to replace a texture, then you can either do this from the material. Or you
choose the Replace Image menu item in the Image menu.
This will replace the currently selected texture by the one that you load.

Checker texture without material
There are cases where you want to test the UV mapping beforehand, with a checker texture for example. To
check if there are strong distortions in the UV mapping. This checker texture can of course be assigned with a
material, like shown above. But there is also an internal way, without to create and assign a material first.

Note!
This method just works with the Blender Render and Blender Game. It will not work with Cycles Renderer.
Also note, this is no way to assing a texture to a mesh! This image will not render. It is just a preview. For
rendering a material is required!

Switch to Blender Render.

Unrwap your mesh.
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Create a new texture, and set it to UV Grid or Color Grid.

Last needed step to see the checker texture in the
viewport is to set the Viewport shading to Texture.
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Video Sequence Editor
This manual part is grabbed 1: 1 from Blender.
Note that the Video Sequence Editor is not officially supported in Bforartists. It is still there. It is fully
functional. You can work with it, the layout exists. It's the same VSE than in Blender. But Bforartists
does not support it officially. We recommend to use something more useful. Everything is better than the
Video Sequence Editor in Bforartists. Kdenlive is opensource and multiplatform. Hitfilm has a free
version. Or do yourself a favour and spend the few bucks for one of the commercial solutions. It is well
spent money.
NOTE ALSO THAT THE BFORARTISTS KEYMAP DOES NOT HAVE THE HOTKEYS THAT ARE
MENTIONED IN THIS MANUAL PART. THEY ARE REMOVED. YOU WOULD HAVE TO USE THE
BLENDER KEYMAP TO USE THE VSE.
This manual part is just up because it doesn't hurt to have it online since the functionality is there.

Introduction
In addition to modeling and animation, Bforartists has a fully functional Video Sequence Editor (VSE) as well
as an advanced node-based editor that also manipulates a video stream. Compositing Nodes operate equally
well on images or video streams, and can apply detailed image manipulation on the stream.
The VSE within Bforartists is a complete video editing system that allows you to combine multiple video
channels and add effects to them. You can use these effects to create powerful video edits (especially when you
combine it with the animation power of Bforartists!) Furthermore, it is extensible via a plugin system to
perform an unlimited number of image manipulations.
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Using the VSE, you load multiple video clips and lay them end-to-end (or in some cases, overlay them),
inserting fades and transitions to link the end of one clip to the beginning of another. Finally, add an audio track
so you can synchronize the timing of the video sequence to match it. The result of using the VSE is your
finished movie.

Default Video Editing screen layout.

The Video Sequence Editor has a header (where the menu and view modes are shown) and a workspace, and
works in one of several view modes. The Marker menu allows you to add markers in the VSE. Markers are
shared across animation editors. See Markers
The sequencer workspace is horizontally striped into channels and each video strip will go in a horizontal
channel. Each channel is numbered on the left-hand side, starting from 0 and going up.
Reference
The first channel 0 is unusable as a place to put strips. This is because it is used by the Sequencer Display to
show a composite of all strips above channel 0.

Stripes toward the bottom are more dominant, which we’ll get to in a minute. In the x direction, seconds of
animation or frames of animation (Ctrl-T to choose) are used as the measure of time (seconds 1 through 7 are
shown). You can scale the time using the zoom keys or mouse actions (see the Reference for more info).
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Video Sequence Editor in Sequence display mode

Reference
By default the Sequencer is enabled however, it can be disabled in the Post Processing Panel.

Editing and Manipulating
Adjusting the View
Use these shortcuts to adjust the sequence area of the VSE: Pan MMB Zoom Wheel Vertical Scroll use ShiftWheel, or drag on the left scroll bar. Horizontal Scroll use Ctrl-Wheel, or drag on the lower scroll bar.
Scale View Vertically, drag on the circles on the vertical scroll bar. Scale View Horizontally, drag on the circles
on the horizontal scroll bar.
As usual, the View Menu controls what and how you view in the workspace.
Properties Panel
The Properties Panel contains options for the way the preview is displayed.
View all Sequences Home
Zooms (out) the display to show all strips.
Fit preview in Window Home
Resizes preview so that it fits in the window.
Show Preview 1:1 Numpad1
Resizes preview to a 1:1 scale (actual size).
View Selected NumpadPeriod
Zooms in the display to fit only the selected strips
Use this when working arranging a lot of strips and you want to use all of your screen to work.
Reference
Mode: Sequence
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Menu: View –> Show Frames, View –> Show Seconds
Hotkey: Ctrl-T

Draw Frames
Displays the frame number instead of the time, in the Frame Number Indicator.
Show Frame Number Indicator
Toggles the units of measure across the bottom of the workspace between seconds or frames.
Safe Margin
Displays an overlay on the preview, marking where title safe region is.
Separate Colors
When using Luma Waveform view, this separates R,G, and B into separate graphs.
Transform Markers
Transform Markers as well as Strips.

Scrubbing
To move back and forth through your movie, use the Timeline window. LMB click and drag left/right in the
timeline window, moving the vertical bar which indicates the current frame. As you do, the image for that frame
is displayed in the VSE window.
When you LMB directly on a sequence strip, this will show the strip solo, (temporarily disregarding effects and
other strips, showing only this strips output).
Real-time scrubbing and image display is possible on reasonable computers when viewing an image sequence
or movie (avi/mov) file.
Scene strips can use OpenGL previews or proxies for realtime playback, otherwise displaying rendered frame is
supported, but typically too slow for real-time playback.

View Modes
The icons in the header allow to change the view of the VSE. By default, only the sequencer is displayed. The
second button displays only the Preview window, and the third button displays both the Sequencer and the
Preview.
When the preview is enabled, you have several options to change what type pf preview to display. They are
explained in the Display Modes Page.

Scene Preview
When using a Scene Strip in the sequencer, these settings in the Properties Panel determine how they are shown
in the preview window.
Open GL Preview
If you have Open GL, enable this setting to use Open GL for the scene preview renders. The drop down
menu allows you to change how the Scene is displayed (Bounding Box, Wireframe, Solid, Textured).

5
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View Settings
The View Settings section in the properties panel contains addition display options.
Show Overexposed
Increasing this number to 1 or greater displays a striped overlay to the preview image, showing where it is
overexposed. A higher number gives a higher threshold for marking overexposure.
Safe Margin
Displays an overlay on the preview, marking where title safe region is.
Proxy Render Size
Draws preview using full resolution or different proxy resolutions. Render resolution is determined in the
render settings panel. Using a smaller preview size will increase speed.

Refresh View
Certain operations, like moving an object in 3D View, may not force the Sequencer to call for a refresh of the
rendered image (since the movement may not affect the rendered image). If an image or video, used as a strip,
is changed by some application outside of Bforartists, Bforartists has no real way of being notified from your
operating system. To force Bforartists to re-read in files, and to force a re-render of the 3D View, click the
Refresh button to force Bforartists to update and synchronize all cached images and compute the current frame.

Selecting Strips
The Select Menu helps you select strips in different ways.
Strips to the Left
Select all strips to the left of the currently selected strip.
Strips to the Right
Select all strips to the right of the currently selected strip.
Select Surrounding Handles Alt-Ctrl-RMB
Select both handles of the strip, plus the neighboring handles on the immediately adjoining strips. Select
with this method to move a strip that is between to others without affecting the selected strip’s length.
Left Handle Alt-RMB
Select the left handle of the currently selected strip.
Right Handle Ctrl-RMB
Select the right handle of the currently selected strip.
Linked
Select all strips linked to the currently selected strip
Select All A
Selects all the strips loaded.
Select Inverse
Inverts the current selection.
Border Select B
Begins the Box mode select process. Click and drag a rectangular lasso around a region of strips in your
Sequence workspace. When you release the mouse button, the additional strips will be selected.

Moving and Modifying Strips
G Moves the selected strip(s) in time or in channels. Move your mouse horizontally (left/right) to change the
strip’s position in time. Move vertically (up/down) to change channels.

6

Bforartists Reference Manual - © Copyright - This page is under OCL license

• To snap while dragging hold Ctrl
• To ‘ripple edit’ (Make room for strips you drag) hold Alt when placing a strip.
If you have added a strip by mistake or no longer want it, delete it by pressing X or using this menu option.
Duplicate a strip to make an unlinked copy; drag it to a time and channel, and drop it by LMB click.
The Strip Menu contains additional tools for working with strips:
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•

Grab/Move
Grab/Extend from Frame
Cut (hard) at frame
Cut (soft) at frame
Separate Images
Deinterlace Movies
Duplicate Strips
Erase Strips
Set Render Size
Make Meta Strip
UnMeta Strip
Reload Strips
Reassign Inputs
Swap Inputs
Lock Strips
UnLock Strips
Mute Strips
Un-Mute Strips
Mute Deselected Strips
Snap Strips
Swap Strips

Snap to Frame
Shift-S Position your cursor (vertical green line) to the time you want. Snap to current frame to start a strip
exactly at the beginning of the frame. If your Time display is in seconds, you can get to fractional parts of a
second by zooming the display; you can get all the way down to an individual frame.

Separate Images to Strips
Y Converts the strip into multiple strips, one strip for each frame. Very useful for slide shows and other cases
where you want to bring in a set on non-continuous images.

Editing Strips
• RMB in the middle of the strip selects the entire strip; holding it down (or pressing G rab) and then
moving the mouse drags a strip around.
• RMB on the left arrow of the strip selects the start frame offset for that strip; holding it down (or
pressing G rab and then moving the mouse left/right changes the start frame within the strip by the
7
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number of frames you move it:
• If you have a 20-image sequence strip, and drag the left arrow to the right by 10 frames, the strip
will start at image 11 (images 1 to 10 will be skipped). Use this to clip off a rollup or useless
lead-in.
• Dragging the left arrow left will create a lead-in (copies) of the first frame for as many frames as
you drag it. Use this when you want some frames for transitions to the this clip.
• RMB on the right arrow of the strip selects the end frame of the strip; holding it down (or pressing G rab)
and then moving the mouse changes the ending frame within the strip:
• Dragging the right arrow to the left shortens the clip; any original images at the tail are ignored.
Use this to quickly clip off a rolldown.
• Dragging the right arrow right extends the clip. For movies and images sequences, more of the
animation is used until exhausted. Extending a clip beyond its end results in Bforartists making a
copy of the last image. Use this for transitions out of this clip.
Note
Multiple selection
You can select several (handles of) strips by Shift-RMB clicking: when you press G, everything that’s
selected will move with your mouse- this means that, for example, you can at the same time move a strip,
shorten two others, and extend a forth one.

• STRIP EXTEND. With a number of Image strips selected, pressing E enters EXTEND mode. All
selected strip handles to the “mouse side” of the current frame indicator will transform together,
allowing you to essentially extend the strips that fall exactly on the current frame marker and having all
others adjust to compensate.
While splicing two strips happens just by placing them finish-to-start, cut a strip by pressing K to cut. At the
selected frame for the selected strips, K cuts them in two. Use Cut to trim off roll-ups or lead-ins, or roll-downs
or extra film shot.
Reference
Note on the ‘cut’
When you ‘cut’ a strip, you don’t really make a cut like it was with the ‘old editing’ on real film. In fact, you
make a copy of the strip: the end of the original one is ‘winded’ to the cut point, as with the beginning of the
new copy.
For example, imagine that you have a strip of 50 frames, and that you want to delete the first ten ones. You
have to go to the 11 th frame, and press K; the cut ‘divides’ your strip in two parts. You now can select the first
small part (frames 1 to 10), and delete it press X.
You might think that you have really erased the frames 1 to 10, but there are still there, ‘winded’, as in a film
reel, under your frame 11 : you just have deleted one of the two copies of your strip created by the ‘cut’. And
you can at any time get your ‘lost’ frames back (just RMB -click on the left arrow of the strip, then G grab it to
the left to display the desired number of frames again (or to the right to ‘hide’ more frames - this is another
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way to remove frames at the beginning/end of a strip!).
This is at the heart of nearly every editor solution, and that’s quite handy!

Note
Action Stops
When extending the start beyond the beginning or end after the ending, keep in mind that only the last image
copies, so when viewed, action will stop on that frame. Start your transition (fade, cross) a little early while
action is still happening so that the stop action is not that noticeable (unless, of course, you want it to be, like
the 80’s drama sitcoms).

Change the length of an effect strip by changing the start/end frame of the origin strips.

Copy and Paste
You can copy a clip and paste it using the two header buttons.

Strip Properties
The properties for the strip are examined and set in the properties panel, shortcut kbd`N`.
•
•
•
•
•
•
•

Edit Strip - change properties of the strip
Strip Input - where to pull images from
Effect - Settings for effects strips
Filter - Image pre-processing
Proxy - Use representatives of the real image, for low-powered PCs
Scene - Settings for when a scene strip is selected
Sound - Settings for a sound clip

The panels for each of these sets of options and controls are shown to the right
Edit Strip Panel
Strip Input Panel
Filter Panel
Proxy / Timecode Panel
• Proxy
• Timecode
• Modifiers Panel
•
•
•
•

Edit Strip Panel
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Name
You can name or rename your strips here.
Type
Displays the type of strip selected.
Blend Mode
By default, a strip Replaces the output image of any lower-level strips. However, many other blending
modes are available based on the strip type. For example, Alpha-Over automatically overlays the image
on top of a lower level strip. Autoblending modes remove the need for separate effect strips. Blend
percent controls how much of an effect the strip exerts, even over time.
Opacity
Set the opacity of the strip.
Mute
Hides the strip so that it does not participate in the final image computation
Lock
Prevents the strip from being moved.
Channel
Changes the channel number, or row, of the strip.
Start Frame
Changes the starting frame number of the strip, which is the same as grabbing and moving the strip. Tip
when you add a strip, I like to just drop it and then use this field to place it at the frame I want, rather that
trying to drag and drop in exactly the right place.
Length
Specify the number of frames to use for the strip.
Use the Convert to Premul button if a strip has an Alpha (transparency) channel. Use FilterY if the strip is from
broadcast video and has even or odd interlacing fields. Enhance the color saturation through the Mul tiply field.
Play a strip backwards by enabling Reverse Frames. Tell Bforartists to display every nth frame by entering a
Strobe value. Finally, when using MPEG video (VCD, DVD, XVid, DivX, ...), an image is built up over the
course of a few frames; use the Preseek field to tell Bforartists to look backward and compose the image based
on the n previous frames (e.g. 15 for Mpeg2 DVD).

Strip Input Panel
Controls the source of the strip. Fields include file path, file name, image offset, crop settings.
This is here you can editupdate the path of the file used by a strip. Very useful when you moved it one way or
the other - this avoid you deleting and re-creating the strip!
You have two text fields for path, the first being the path of the parent directory (Path), and the second the file
name itself.

Filter Panel
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Enables you to quickly set common image pre-processing options.
Strobe
To display only a defined number of images. For example, if you set this to 10, the strip will only display
frames 1,11,21,31,41... of the source.
Flip
X flips (reverses) the image left-to-right, Y reverses top-to-bottom.
Backwards
Reverses strip image sequence
De-Interlace
Removes fields in a video file.
Saturation
Increase or decrease the saturation of an image.
Multiply
Multiplies the colors by this value.
Convert Float
Converts input to float data.

Proxy / Timecode Panel
Once you’ve chosen the Proxy/Timecode parameters, you need to use Strip ‣ Rebuild Proxy and Timecode
indices to generate the proxy clip and it will be available after Bforartists makes it.
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Proxy

A proxy is a smaller image (faster to load) that stands in for the main image. When you Rebuild proxy
Bforartists computes small images (like thumbnails) for the big images and may take some time. After
computing them, though, editing functions like scrubbing and scrolling and compositing functions like cross
using these proxies is much faster but gives a low-res result. Disable proxies before final rendering.
In order to actually use the proxies, the proper Proxy Render Size dropdown value must be selected in the
Properties panel of the Sequencer View (where the edit plays back).
Proxy Storage
Defines whether the proxies are for individual strips or the entire sequence.
Per Strip
Proxies are stored in the directory of the input.
Proxy Custom Directory
By default, all generated proxy images are storing to the <path of original footage>
/BL_proxy/<clip name> folder, but this location can be set by hand using this option.
Proxy Custom File
Allows you to use pre-existing proxies
Project
All proxies are stored in one directory
Proxy Directory
The location to to store the proxies for the project.
Proxy Size
Buttons to control how big the proxies are. The available options are 25,``50``, 75, 100 percent of
original strip size.
Overwrite
Saves over any existing proxies in the proxy storage directory.
Quality
Defines the quality of the JPEG’s used for proxies.
12
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Timecode
See Timecode.
Set Selected Strip Proxies
Same as choosing the Proxy Size and Overwrite
Rebuild Proxy and Timecode Indices
Generates Proxies and Timecodes, same as doing Strip ‣ Rebuild Proxy and Timecode indices

Timecode
When you’re working with footage directly copied from a camera without pre-processing it, there might be
bunch of artifacts, mostly due to seeking a given frame in sequence. This happens because such footage usually
doesn’t have correct frame rate values in their headers. So, for Bforartists to calculate the position of a needed
frame in the stream works inaccurately and can give errant result. There are two possible ways to avoid this:
• Preprocess your video with, say, mencoder to repair file header and insert correct keyframes.
• Use Proxy/Timecode option in Bforartists.

Options
Timecode
Timecode to use on the selected movie strip.
The following timecodes are supported:
•
•
•
•
•

No TC in use- do not use any timecode
Record Run
Free Run
Free Run (rec date)
Record Run No Gaps

Note
Record Run is the timecode which usually is best to use, but if the clip’s file is totally damaged, ‘Record Run
No Gaps’ will be the only chance of getting acceptable result.

Modifiers Panel
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Modifiers are used to make adjustments on the image, like contrast, brightness, saturation, color balance and
applying masks.
You can add these modifiers directly to the selected strip, or you can use it within an “Adjustment Layer” effect
strip, which allows you to apply these modifiers onto several strips the same time.
Use Linear Modifiers
Calculate modifiers in linear space instead of sequencer space.
Each modifiers have several buttons at their top:
The “eye” is to disable the modifier. Very useful to compare the image, with / without modifications.
The next two buttons (up and down arrows) are used to change the modifier’s position in the stack.
The cross is to delete the modifier from the stack.
Strip Use this to apply the modification on the whole image, or to use another strip’s image (with alpha
channel) for masking the modifier (and only this modifier), by choosing it in the “Mask” drop-down list.
• Mask This one allows you to choose a Mask created in the Mask editor which will limit the modification
to the masked image’s zones.
•
•
•
•

Currently, the following modifiers are supported:
Color Balance
Color balance adjustments, through Lift, Gamma, and Gain.
Note
This modifier works the same as the Color Balance Node
Curves
C/RGB curves.
Note
This modifier works the same as the Curves Node

Hue Correct
HSV multi points curves.
Note
This modifier works the same as the Curves Node

Bright/Contrast
Adjusts the brightness and contrast of the modifier input.
Mask
Use it for masking the other modifiers in the stack which are below.
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For example, to correct the brightness only on a certain zone of the image, you can filter the
Bright/Contrast modifier by placing a Mask modifier, just before it in the stack. You can choose to use a
Mask created in the Mask editor, or to use another strip as a mask (the image of this strip must have an
alpha channel). This mask will be applied on all the others modifiers below it in the stack.
White Balance
Use it to adjust the white balance by choosing the color that should be white.
Tone Map
Used to map one set of colors to another in order to approximate the appearance of high dynamic range
images in a medium that has a more limited dynamic range.
Note
This modifier works the same as the Tone Map Node

Strip Types
Introduction
Scene Strip
Image and Movie Strips
Effect Strips
• Introduction
• Add Effect
• Adjustment Layer
• Alpha Over, Under, and Over Drop
• Gaussian Blur
• Color
• Cross
• Gamma Cross
• Glow
• Multicam Selector
• Multiply
• Speed Control
• Subtract Effect
• Text Effect
• Transform
• Wipe
• Sound Strips
• Options
• Working with Audio Tracks
• Animating Audio Track Properties
• Output
•
•
•
•
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• Known Limitations
• Meta Strips

Introduction

The Add Menu

The Add menu is the main menu you will be using to add content to the VSE. In general, you load up your
strips, create strips of special transition effects, and then animate out your sequence by selecting “Do Sequence”
and clicking the Anim button. You can use the Add menu in the header, or hover your mouse cursor over the
Sequence workspace and press Shift-A.
Note
Clips can be Huge
A three minute quicktime .mov file can be 140Megs. Loading it, even over a high-speed LAN can take some
time. Don’t assume your computer or Bforartists has locked up if nothing happens for awhile.
First, let’s add a clip:
A movie clip in the Audio-Video Interleaved format (*.avi file)
A movie clip in the Apple QuickTime format (*.mov)
A single still image to be repeated for a number of frames (*.jpg, *.png, etc.)
A numbered sequence of images (*-0001.jpg, *-0002.jpg, *-0003.jpg, etc, of any image
format)
• One or more images from a directory
• A Scene in your .blend file.
•
•
•
•

Bforartists does not care which of these you use; you can freely mix and match any of them. They all become a
color-coded strip in the VSE:
•
•
•
•

Blue is used for Avi/mov codec strips
Grey is a single image that is repeated/copied
Purple is an image sequences or group of images played one after the other
Green is an Audio track

When you choose to add one of these, the VSE window will switch to a file browser for you to select what you
want to add. Supported files have a little rectangle next to their name (blue for images, green for clips) as a
16
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visual cue that you can pick them successfully:

Scene Strip
You can add the virtual image output of a Scene in your current .blend file as well. Select the scene from the
pop-up list, and a strip will be added and rubberbanded to your mouse just like a movie or image. The strip
length will be determined based on the animation settings in that scene (not the current scene, unless the VSE is
operating in the same scene).
When adding a Scene strip, please note that, in order to show you the strip in the VSE Image preview mode,
Bforartists must render the scene. This may take awhile if the scene is complex, so there may be a delay
between the time you select the scene and the time the strip appears. To reduce the delay, simplify the scene
rendering by selecting fewer layers to render.
If the extra overhead of rendering the scene becomes burdensome (for either preview or for multiple test
renders) and you have enough disk space consider rendering the scene to a sequence of PNGs and using an
Image Sequence strip instead of a scene. This is very popular for static graphic overlays like title cards which
are often little more than a static image with animated opacity.
Sequencer
Process the render (and composited) result through the video sequence editor pipeline, if sequencer strips
exist. This is the same function as in the render settings.
Camera Override
Change the camera that will be used.

Image and Movie Strips
When adding a Movie or Movie+Audio LMB to put the name of the file into the text box at the top; this selects a
single file (like a movie)
In the case of (numbered) image sequences, you have a choice:
Directory
RMB right-click on a directory name, and all files in that directory will be brought in as part of the image,
in sort order, one image per frame
Range
Navigate into the directory and right-click and drag over a range of names to highlight multiple files. You
can page down and continue right-click-dragging to add more to the selection
Batch
Shift-right-click selected non-related stills for batch processing; each image will be one frame, in sort
order, and can be a mix of file types (jpg, png, exr, etc.)
All
Press A to select/deselect All files in the directory.
When you click the Select <whatever> button, the window pane will switch back to VSE, and the strip will be
rubber-banded to your mouse. You cannot load multiple movies at the same time by right-clicking them; no
17
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movies load if you right click them. Right-clicking only works for images.
In order to add items to the VSE, left-click for movies, left-click for single images, or right-click and drag for
image sequences. Move your mouse to the frame/time and stripe you want, and click to break the rubberband
and drop the strip in place (in a channel and starting at a frame).
When you add an image, Bforartists makes it into a 50-frame strip, which means that image will be in your
video for two seconds (at 25 fps - PAL). Aside from re-positioning it, you will want to scale it by RMB -clicking
on either the start or end arrow, and dragging left or right. As you move, the frame number updates to say where
the arrow is. Click LMB to validate, or RMB to cancel the modification.
Tip
Dealing with Different Sizes
Dealing with different sized images and different sized outputs is tricky. Think like a pixel. If you have a mismatch between the size of the input image and the render output size, the VSE does try to auto-scale the image
to fit it entirely in the output. This may result in clipping. If you do not want that, use Crop and/or Offset in the
Input panel to move and select a region of the image within the output. When you use Crop or Offset, the autoscaling will be disabled and you can manually re-scale by adding the Transform effect.

If you scroll up the workspace, you will see an information channel (at vertical location channel 0) that gives
you some helpful hints about the active strip. The example above shows a color strip from frames 1 to 25, then
a mov file, and then an image strip. The info channel shows handy information about the image strip, whose
name has been scrunched in the strip display, but is clearly spelled out in the information strip.

Effect Strips
•
•
•
•
•
•
•
•
•

Introduction
Add Effect
Adjustment Layer
Alpha Over, Under, and Over Drop
Gaussian Blur
• Options
Color
Cross
Gamma Cross
Glow
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• Multicam Selector
• Multiply
• Speed Control
• Creating a Slow-Motion Effect
• Keyframing the Speed Control
• Changing Video Frame Rates
• Subtract Effect
• Text Effect
• Options
• Export Subtitles
• Transform
• Options
• Wipe
• Options

Introduction

Available Effects.

Bforartists offers a set of effects that can be added to your sequence. Theses effects are listed to the right. Each
effect is explained in the next pages individually, but they all are added and controlled in the same way. To add
an effect strip, select one base strip (image, movie, or scene) by RMB clicking on it. For some effects, like the
Cross transition effect, you will need to Shift-RMB a second overlapping strip (it depends on the effect you
want). Then select Add ‣ Effect and pick the effect you want from the pop-up menu. When you do, the Effect
strip will be shown above the source strips. If it is an independent effect, like the Color Generator, it will be
rubberbanded to your mouse; click to drop the strip.
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Note
Since most Effects strips depend on one or two source strips, their frame location and duration depends on
their source strips. Thus, you may not be able to move it; you have to move the source strips in order to affect
the effect strip.

To use an effect that combines or makes a transition between (or composites) two strips, you must Box select
(B) or shift-right-click two of them. When you add the effect strip, it will be placed in a channel above the two
in Grab mode (click to drop it on a channel). Its duration will be the overlap between the two strips as a
maximum.
With some effects, like the Alpha Over, the order in which you select the strips is important. You can also use
one effect strip as the input or source strip with another strip, thus layering effects on top of one another.
Note
The only exception is the Color Generator effect. It does not depend on a base strip; you can add and position
it independent of any other strip. Change the length as you would any strip.

If you picked the wrong effect from the menu, you can always change it by selecting the strip (RMB) and using
the Strip ‣ Change Effect selection. Or, you can press C to switch effects on a selected Effects strip.

Add Effect

Can you hear the thunder?

The Add effect adds two colors together. Red and Cyan (Green and Blue) make White. Red and Blue make
“Magenta” (i.e. Purple!). Red and Green make Yellow.
The Add Effect adds the colors of two strips together, Use this effect with a base image strip, and a modifier
strip. The modifier strip is either a solid color or a black-and-whte mask, or another image entirely. The
example to the right shows what happens when you add gray to an image, and animate the effect over time. The
image gets bright because we are adding gray (R:.5, G:.5, B:.5) to say, a blue color (R.1, G:.1, B:.5) resulting in
(R:.6, G:.6, B:1.0) which retains the original hue (relationship between the colors) but is much brighter (has a
higher value). When applied to the whole image like this, the whole image seems to flash.
You can use this effect to increase the brightness of an image, or if you use a BW mask, selectively increase the
brightness of certain areas of the image. The Mix node, in Add mode, does exactly the same thing as the Add
sfx strip here, and is controlled the same way by feeding the Factor input.
20

Bforartists Reference Manual - © Copyright - This page is under OCL license

Adjustment Layer
The Adjustment Layer strip works like a regular input file strip except for the fact, that it considers all strips
below it as it’s input.
Real world use cases: you want to add some last finishing color correction on top of parts of your final
sequencer timeline without messing with metastrips around. Just add an adjustment layer on top and activate
the color balance.
Or: you can stack a primary color correction and several secondary color correction on top of each other
(probably using the new mask input for area selection).

Alpha Over, Under, and Over Drop

AlphaOver Effect

Using the alpha (transparency channel), this effect composites a result based on transparent areas of the
dominant image. If you use a Scene strip, the areas of the image where there isn’t anything solid are
transparent; they have an alpha value of 0. If you use a movie strip, that movie has an alpha value of 1
(completely opaque).
So, you can use the Alpha Over / Alpha Under effect to composite the CGI Scene on top of your movie. The
result is your model doing whatever as if it was part of the movie. The Factor curve controls how much the
foreground is mixed over the background, fading in the foreground on top of the background. The colors of

21

Bforartists Reference Manual - © Copyright - This page is under OCL license

transparent foreground image areas is ignored and does not change the color of the background.
Select two strips (Shift-RMB):
• With Alpha Over, the strips are layered up in the order selected; the first strip selected is the background,
and the second one goes over the first one selected. The Fac tor controls the transparency of the
foreground, i.e. a Fac of 0.0 will only show the background, and a Fac of 1.0 will completely override
the background with the foreground (except in the transparent areas of this one, of course!)
• With Alpha Under, this is the contrary: the first strip selected is the foreground, and the second one, the
background. Moreover, the Fac tor controls the transparency of the background, i.e. a Fac of 0.0 will
only show the foreground (the background is completely transparent), and a Fac of 1.0 will give the
same results as with Alpha Over.
• Alpha Over Drop is between the two others: as with Alpha Under, the first strip selected will be the
foreground, but as with Alpha Over, the Fac tor controls the transparency of this foreground.
The example shows layering of AlphaOver effects. The very bottom channel is red, and an arrow is on top of
that. Those two are AlphaOver to Channel 3. My favorite toucan is Channel 4, and Channel 5 alphaovers the
toucan on top of the composited red arrow. The last effect added is tied to Channel 0 which will be rendered.
By clicking the PreMult Alpha button in the properties panel of the foreground strip, the Alpha values of the
two strips are not multiplied or added together. Use this effect when adding a foreground strip that has a
variable alpha channel (some opaque areas, some transparent, some in between) over a strip that has a flat
opaque (Alpha=1.0 or greater) channel. If you notice a glow around your foreground objects, or strange
transparent areas of your foreground object when using AlphaOver, enable PreMultiply. The AlphaOver Drop
effect is much like the Cross, but puts preference to the top or second image, giving more of a gradual overlay
effect than a blend like the Cross does. Of course, all of the Alpha effects respect the alpha (transparency)
channel, whereas Cross does not.
The degree of Alpha applied, and thus color mixing, can be controlled by an F-curve. Creating a Sine wave
could have the effect of the foreground fading in and out.

Gaussian Blur
The Guassian Blur strip is used to blur the input strip in the defined direction. This can be used to blur a
background or to blur though a transition (see image).

Example of Bluring a Transition.
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Options
Size X
Distance of the blur effect on the X axis.
Size Y
Distance of the blur effect on the X axis.

Color
This effect works by itself to create a color strip. By default, when it is created, it is 50 frames long, but you can
extend it by grabbing and moving one of the ends. Click on the color swatch in the Effect panel under
Sequencer buttons, which is under the Scene tab, to pick a different color (by default, it is gray). Use this strip
crossed with your main movie to provide a fade-in or fade-out.

Cross

This effect fades from one strip to another, based on how many frames the two strips overlap. This is a very
useful strip that blends the whole image from one to the other.

Gamma Cross
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This effect fades from one strip to another, based on how many frames the two strips overlap. This is a very
useful strip that blends the whole image from one to the other.
Gamma Cross uses color correction in doing the fade, resulting in a smooth transition that is easier on the eye.

Glow
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Example of a Glow effect applied to a picture. Top left: base picture (Lofoten Islands, Norway - source: wikipedia.fr); Top
right: result of the effect; Bottom left: effect settings; Bottom right: result with the Only boost button activated.

This effect makes parts of an image glow brighter by working on the luminance channel of an image. The Glow
is the superposition of the base image and a modified version, where some areas (brighter than the Threshold:)
are blurred. With the Glow strip properties, you control this Threshold:, the maximum luminosity that can be
added (Clamp:), a Boost factor: for it, the size of the blur (Blur distance:), and its Quality:. The Only boost
button allows you to only show/use the ‘modified’ version of the image, without the base one. To “animate” the
glow effect, mix it with the base image using the Gamma Cross effect, crossing from the base image to the
glowing one.

Multicam Selector
The Multicam Selector stip is used for multi camera editing. Multicam editing is for when you have multiple
cameras recording the same scene from different angles. To edit these in the VSE can be easy if you do it right.
• First your going to want to add in each of your video strips.
• Next make sure to sync them to each other using there audio waveform see the Audio Docs or by the
movement of objects.
• If you are using any effects on you strips it may helpful to use Meta Strips
• Add a viewer window for every input channel and put it into 25% proxy display mode
• Add a multicam selector effect strip above all the channel tracks
After Completing these steps you should get something similar to the image below:

• Now select the multicam strip, if you take a look at the strip options (N-key), you will notice, that
multicam is a rather simple effect strip: it just takes a selected channel as it’s input. That’s all. The magic
comes with the convenient keyboard layout.
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• When you select the multicam strip, the keys 1-9 are mapped to a python handler, that does a cut on the
multicam and changes it’s input.
• So: you select the multicam strip, you start playback and press the keys for the correct input while
watching your show.
• You’ll end up with a small multicam selector strip for every cut.
In reality, it boils down to: watch a few seconds to see, what’s coming, watch it again and do a rough cut using
the number keys, do some fine tuning by selecting the outer handles of two neighboring multicam for A/B
rolling.

Multiply

Multiply Effect.

The Multiply effect multiplies two colors. Bforartists uses values between 0.0 and 1.0 for the colors, he doesn’t
have to normalise this operation, the multiplication of two terms between 0.0 and 1.0 always gives a result
between 0.0 and 1.0 (with the ‘traditional’ representation with three bytes - like RGB(124, 255, 56) -, the
multiplications give far too high results - like RGB(7316, 46410, 1848) -, that have to be ‘brought back’,
normalised - just by dividing them by 256 ! - to ‘go back’ to range of 0 to 255 ...). 256 ! - to ‘go back’ to range
of 0 to 255 ...).
This effect has two main usages:
With a mask
A mask is a B&W picture witch, after multiplication with a ‘normal’ image, only show this one in the
white areas of the mask (everything else is black). The opening title sequence to James Bond movies,
where the camera is looking down the barrel of a gun at James, is a good example of this effect.
With uniform colors
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Multiplying a color with a ‘normal’ image allows you to soften some hues of this one (and so symmetrically - to enhance the others). For example, if you have a brown pixel RGB(0.50, 0.29, 0.05),
and you multiply it with a cyan filter (uniform color RGB(0.0, 1.0, 1.0), you’ll get a color RGB(0.0, 0.29,
0.5). Visually, the result is to kill the reds and bring up (by ‘symmetry’ - the real values remain
unchanged!) the blues an greens. Physically, it is the same effect as shining a cyan light onto a chocolate
bar. Emotionally, vegetation becomes more lush, water becomes more Caribbean and inviting, skies
become friendlier.

Note
This effect reduces the global luminosity of the picture (the result will always be smaller than the smallest
operand). If one of the image is all white, the result is the other picture; if one of the image is all black, the
result is all black!

Speed Control
Speed Control time-warps the strip, making it play faster or slower than it normally would. A Global Speed less
than 1.0 makes the strip play slower; greater than 1. 0 makes it play faster. Playing faster means that some
frames are skipped, and the strip will run out of frames before the end frame. When the strip runs out of frames
to display, it will just keep repeating the last one; action will appear to freeze. To avoid this, position the next
strip under the original at a point where you want motion to continue.

Creating a Slow-Motion Effect

50% Slow motion using Speed Control

Suppose you want to slow your strip down. You need to affect the speed of the video clip without affecting the
overall frame rate. Select the clip and Add–>Effect–>Speed Control effect strip. Click to drop it and press N to
get the Properties. Uncheck the Stretch to input strip length option in the Effect Strip section. Set the Speed
factor to be the factor by which you want to adjust the speed. To cut the displayed speed by 50%, enter 0.5.
Now, a 275-frame clip will play at half speed, and thus display only the first 137 frames.
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If you want the remaining frames to show in slo-mo after the first set is displayed, double the Length of the
source strip (since effects strip bounds are controlled by their source strips). If you’re using a speed factor other
than 0.5 then use the formula
new_length = real_length / speed_factor
That’s it! Set your render to animate (in this example) all 550 frames.

Keyframing the Speed Control

keyframing the Frame number

To get even finer control over your clip timing, you can use curves! While it is possible to keyframe the Speed
factor, usually you want to keyframe the Frame number directly.
Uncheck Stretch to input strip length and uncheck Use as speed. You now have a Frame number field which
you can keyframe. If you want the strip to animate at all you will have to insert some keyframes, otherwise it
will look like a still. In most cases you will want to use the Graph editor view to set the curve interpolation to
Linear since the default Bezier will rarely be what you want.
If you do choose to keyframe the Speed factor instead, remember to click the Refresh Sequencer button in the
header of the Video Sequence Editor’s strip view or your changes will not take effect.

Changing Video Frame Rates
You can use the speed control to change the frames per second (fps), or framerate, of a video. If you are
rendering your video to a sequence set, you can effectively increase or decrease the number of individual image
files created, by using a Global Speed value less than or greater than one, respectively. For example, if you
captured a five-minute video at 30 fps and wanted to transfer that to film, which runs at 24 fps, you would enter
a Global Speed of 30/24, or 1.25 (and Enable Frame Blending to give that film blur feel). Instead of
producing 5*60*30=9000 frames, Bforartists would produce 9000/1.25=7200=5*60*24 frames. In this
case, you set a start=1 and end=7200, set your Format output to Jpeg, 30fps, and image files 0001.jpg
through 7200.jpg would be rendered out, but those images ‘cover’ the entire 9000 frames. The image file
7200.jpg is the same a frame 9000. When you read those images back into your film .blend at 24 fps, the
strip will last exactly 5 minutes.
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Subtract Effect

Subtract Effect

This effect takes away one strip’s color from the second. Make a negative of an image using this effect, or
switch the order of the strips and just darken the strip. Subtracting a hue of blue from a white image will make
it yellow, since red and green make yellow.

Text Effect
The text effect strip allows you to directly displaying text in the sequence editor. The strip will display the text
inserted in its text field on the final sequence.

29

Bforartists Reference Manual - © Copyright - This page is under OCL license

Text Effect

Options
Text
The actual text displayed.
Size
Size of the text.
Shadow
Creates a shadow under the text.
Auto Center
Centers the text on the x axis.
X Position
Positions the text on the x axis. Only appears if auto center is off.
Y Position
Positions the text on the y axis.

Export Subtitles
Exporting subtitles in .srt format is also supported. The exported subtitles contain all text strips in the sequence
editing.

Transform
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Transform is a swiss-army knife of image manipulation. It scales, shifts, and rotates the images within a strip.

Options
Interpolation
Todo.
Translation Unit
Control whether the input values are in Percent or Pixels
Uniform Scale
Scale the input evenly along the X and Y axis.
Scale
Scale the image on the X and Y axis
Rotation
Rotates the input 2 dimensionally along the Z axis.

Wipe

Wipe Effect Settings

31

Bforartists Reference Manual - © Copyright - This page is under OCL license

The wipe effect is a type of transition strip. It can be used to transition from one strip to the next. The wipe will
have no effect if created from a single strip instead of two strips. The duration of the wipe is the intersection of
the two source strips and can not be adjusted. To adjust the start and end of the wipe you must adjust the
temporal bounds of the source strips in a way that alters their intersection.

Options
Transition
The type of transition used.
Clock
Like the hands of an analog clock, it sweeps clockwise or (if Wipe In is enabled) counterclockwise
from the 9:00 position. As it sweeps, it reveals the next strip.
Iris
Like the iris of a camera or eye, it reveals the next strip through an expanding (or contracting)
circle. You can blur the transition, so it looks like ink bleeding through a paper.
Double
Similar to Single but uses two lines either starting from the middle of the image or the outside.
Unlike the other transitions you can control the angle of the line using the angle controls.
Single
Reveals the next strip by uncovering it in a strait line moving across the image. This transition also
allows you to control the angle of the transition.
Direction
Control whether to fade In or Out.
Blur Width
The width of the blur used to blur the transition.

Sound Strips
As well as images and movies the VSE can also edit audio tracks. You can add WAV, Mp3 and other audio
formates files from your hard disk as a file, or as encoded within a movie, and mix them using an F-Curve as a
volume control.
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Example of Sound Editing

Options
Pack
This allows you to save the audio file into the .blend file.
Caching
Caching loads a file into ram and plays it from there, apposed to reading it for the hard drive.
Draw Waveform
Draws a waveform over top of the sequence strip. This can be useful for syncing two or more audio strips.
Volume
Changes the loudness of the audio.
Pitch
Changes the frequency of the audio.
Pan
Used to pan the audio from left an right channels -2 being hard left, 2 being hard right.

Working with Audio Tracks
An audio track (strip) is just like any other strip in the VSE. You can grab and move it, adjust its starting offset
using RMB over the arrow end handles, and K cut it into pieces. A useful example is cutting out the “um’s” and
dead voice time.
You can have as many Audio strips as you wish and the result will be the mixing of all of them. You can give
each strip its own name and volume via the N menu.
Overlapping strips are automatically mixed down during ANIM processing. For example, you can have the
announcer on channel 5, background music on channel 6, and Foley sound effects on channel 7.
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Animating Audio Track Properties
To animate audio strips simply hit I over any of its values. Examples of animating an audio strip are to fade
in/out background music or to adjust volume levels. Layered/crossed audio strips are added together; the lower
channel does not override and cut out higher channels (unlike image and video strips). This makes Bforartists
an audio mixer. By adding audio tracks and using the curves to adjust each tracks’ sound level, you have an
automated dynamic multi-track audio mixer!

Output
There are two ways to render out your audio. You can either have it encoded with a video file or in its own
audio file. To render your audio in an video file make sure to use a video format as the output with an audio
codec and hit the render ANIMATION button in the properties editor. Read more on how to do this here. To
render as a audio file simple use the AUDIO button. Read more on how to do this here.

Known Limitations
Hiss, Crackle and Pop
In some cases when Caching is disabled, playback noise/hiss is introduced.
If you hear pops and crackles, usually that is a sign that your hardware cannot keep up in real-time playback.
They will not be present in your final rendered animation output.
Also, static hiss can occur whenever two or more audio strips are overlapping in the timeline.

Meta Strips
Meta-Strips are a kind of organization tool. For example, if you are using a lot of strips and they are
complicated the the interface you can group them together using Meta-Strips. A Meta-Strip spans from the
beginning of the first strip to the end of the last one, and condenses all channels into a single strip. Separating
(ungrouping) them restores them to their relative positions and channels. To create a Meta-Strip select all the
strips you want to group, and Ctrl-G to group them. If you choose to delete a Meta-Strip and want to keep the
strips inside, use Alt-G.

Example of Meta-Strip.

After creating a Meta-Strip it is also possible to edit the contents inside a Meta-Strip. To do this select the
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desired Meta-strip and press Tab. Once you are done editing the contents inside a Meta-Strip press Tab again
to exit the Meta-Strip. Meta-Strips can also be nested, which make editing them a little confusing. To exit out
one level of Meta-Strip make sure you do not have a Meta-Strip selected when you press Tab.
Note
The default blend mode for a Meta strip is Replace. There are many cases where this alters the results of the
animation so be sure to check the results and adjust the blend mode if necessary.
One convenient use for Meta-Strips is when you want to apply the same effect to multiple strips. For example:
if you have a video that was recorded in different files and want to add an effect strip. It is much more
convenient to apply a single set of effects to one Meta-Strip then applying it to each individual strip.
See also
It is also possible to do the similar task described above with a Adustment Layer effect strip.

Sequence Display Modes
By default, the VSE only displays the sequencer. Several options in the header bar allow you change the editor
to display the sequence in real time, and in various ways.

Sequencer Display Header

The second button will change the editor to display only the preview, and the third button displays both the
sequencer and the preview.
The VSE workspace can show you different aspects of the composite result, for the current frame:
•
•
•
•

Image/Sequence: Colors (what you see)
Chroma: Color hue and saturation
Luma: Brightness/contrast
Histogram: Levels of red, green, and blue

In the Chroma, Luma, and Image modes, a channel selector appears; channel 0 is the result of compositing the
strips with their special effects strips. Channel 1 is what the current frame’s image from the strip in channel 1
looks like (channel 1 is at the bottom of the heap). The display of these modes is either the composite (channel
0) or the frame from the strip (channels 1 through n).

Previews
Image Preview
In the upper window pane of the Sequence screen layout is another VSE window, this one set to Image Preview
mode. It shows you what the resulting video will look like when saved. This is the main working mode for
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adding strips and moving them around, cutting, grouping (making meta) and splicing them through special
effects.

Luma Waveform
For the selected channel, brightness, or luminosity, is mapped with this display.
A luma waveform allows you to judge the quality of the luminance distribution across your video signal, you
can view a luma-waveform instead of the usual output display on every control monitor.
The display plots for every scanline the luminance value. The lines are all drawn on top of each other. The
points get brighter if the lines cross (which is very likely with several hundred scanlines). You will understand
the picture most easily if you plug an oscilloscope to the Luma-video-output of your television set. It will
basically look the same.
In this mode, the vertical axis represents the luminosity: 0 at the bottom, 1 at the top; the horizontal axis is a
mapping from the horizontal axis of the frame. There are as many curves as scanlines in the frame: each one of
this curves represents the luminosity of the pixels of one line. Moreover, the color of a pixel in this mode
represents the number of pixels from the matching column of the frame sharing the same luminosity - i.e. the
number of curves that cross at this point (black/transparent, for no pixel, white/opaque for at least 3 pixels).
This mode is good for:
• If the waveform does not fill the whole picture you might want to play with the “setup” and “gain”
master-sliders in the “gamma”-plugin until it fills the whole picture (contrast autostretch).
• With the more advanced gamma-plugin you can decide where you have to desaturated (especially in
dark regions).
• You can judge if you want to dump the whole thing since it is completely distorted and clips at the top or
the bottom.
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‘Simple’ picture. The various horizontal lines in the
Luma waveform match the uniform-color lines of the
picture. Note that the ‘grey 20%’ one-pixel width line

A ‘real’ picture. The curves are quite visible. We

(inside the yellow strip) is represented in the Luma

found a luma of 80-100% for the sky, a luma around

waveform by a grey line. The two lines drawing an ‘X’

40% for the sea, and a luma of 10-20% for the

are from the two linear tone shades (white–>black

mountains, growing around 40% for the sunny part.

and black–>white). Finally, the broken line matches
the complex tone shade at the bottom of the picture.

Note
Note that the pictures (first green frame, at the top) are only 50px high, to limit the number of curves displayed
in the Luma waveform

Use this display to check for appropriate contrast and luminosity across all frames in the channel. When spots in
the film that should have even illumination don’t, it looks like a flashbulb went off or an extra light was
suddenly turned on. This can happen if two strips were rendered or shot under different lighting conditions but
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are supposed to be contiguous.

Chroma Vectorscope

Example of Chroma Vectorscope Preview.

Use this mode judge the quality of the color-distribution and saturation, you can also view a U/V scatter-plot.
The picture is converted to YUV-format. The U- and V-values represent the angle of the color. For pixel of the
picture, one point is plotted in the display at the U and V-value-position. If several pixels happen to have the
same U/V-value the pixel in the plot gets brighter.
To help you understand what color is meant, a hexagram marking the extreme positions (red, magenta, blue,
cyan, green, yellow) is drawn and a red cross to mark the origin.
In other words, for the selected channel, this display shows the color space of the image inside a hexagon. Each
point of the hexagon is a primary color: red, magenta, blue, cyan, green, and yellow. Black is at the center, and
overall saturation is scaled as dots closer to the outside. The example to the right shows that the image has a lot
of red (50% saturation) and small amount of blue, with no green.
Always: remember to activate an additional control monitor of the end result. Color calibration is a matter of
taste and depends on what you want.
Use this display to check for too much color saturation. While over-saturated images look great for op-art and
computer displays, they stink when shown on the big screen TV. Use Alt-A to scrub the video; this display
will update with a new/revised map for each frame. Just like watching the Image preview to see what it looks
like, watch the Chroma Vectorscope to watch for color use.
This mode is good for:
• If you picture looks very moody or desaturated you might want to take a look at the U/V-plot. You will
most likely see all pixels building a crowd at the origin. If you add saturation using the “gamma”-plugin
you can see in the U/V-plot if you distort the color.
• If you do color-matching on a by hand basis you can match the angle you see of different channels
monitors.
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Histogram

Example of Histogram Preview.

This mode displays a graph showing the distribution of color information in the pixels of the currently
displayed image. The X-axis represents values of pixel, from 0 to 1 (or 0 to 255), while the Y-axis represents
the number of pixels in that tonal range. A predominantly dark image would have most of its information
toward the left side of the graph.
Use this mode to balance out the tonal range in an image. A well balanced image should a nice smooth
distribution of color values.
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Tracking Introduction
Match moving is a cinematic technique that allows the insertion of computer graphics into live-action footage
( a movie ) with correct position, scale, orientation, and motion relative to the objects in the shot. And this is
what motion tracking does.
Bforartists motion tracker supports tools for 2D tracking and 3D motion tracking. This includes camera tracking
and object tracking, as well as some special features like the plane track for compositing. Tracks can also be
used to move and deform masks for rotoscoping in the Mask Editor. This is available as a special mode in the
Movie Clip Editor.

Manual Lens Calibration
All cameras record distorted video. That's how optical lenses work. For accurate camera motion you need the
exact value of the focal length and the “strength” of distortion.
Focal length can only be automatically obtained from the camera’s settings or from the EXIF information. Both
is not necessarily available. There are some tools which can help to find approximate values to compensate for
distortion. There are also fully manual tools where you can use a grid which is getting affected by distortion
model and deformed cells defines straight lines in the footage.
You can also use the grease pencil for this – just draw a line which should be straight on the footage using poly
line brush and adjust the distortion values to make the grease pencil match lines on the footage.
To calibrate your camera more accurately, use the grid calibration tool from OpenCV. OpenCV is using the
same distortion model, so it should not be a problem.

Camera and Object Motion Solving
Bforartists supports the solving of camera motion, including tripod shots,. It includes also the solving of object
motion in relation to the motion of the camera. In addition to that there is the Plane Track, which solves the
motion of all markers on one plane.

Tools for Scene Orientation and Stabilization
After solve, you need to orient the real scene in the 3D scene for more convenient compositing. There are tools
to define the floor, the scene origin, and the X/Y axes to perform scene orientation.
Sometimes, the video footage includes spurious jumps and tilting movements, like e.g. when using a hand held
camera. Based on some tracked image elements, the 2D Stabilization is able to detect and compensate such
movements to improve the quality of the final result.

15

Bforartists Reference Manual - © Copyright - This page is Public Domain

Movie Clip Editor Introduction
The Movie Clip Editor is the editor where you deal with the footage for motion tracking. Here you load your
footage movies, mask them out, set the markers, and calculate the tracks.
The Movie clip editor is three editors in one. The actual Clip editor, a Graph editor, and a Dopesheet editor. You
can switch to the different editor types with this menu here in the header:

And the Clip editor has two modes. Tracking and Mask.

Marker
A marker is a tracking point in the movie. A point where the position of the pixel underneath the marker gets
tracked. That's where the camera tries to follow the motion.
Each marker is represented by a rectangle. You can insert a marker by hand or automatically with the
Detect feature.
When you select a marker then it will be displayed with handlers. One in each corner, and a
straight line from the center of the marker. This Handlers can be manipulated with the mouse.

The handlers in the corners allows to distort the marker, to fit it to distortions in the movie.

The straight handler from the center allows you to rotate and scale the marker.

Every marker has also a search area, where the searching for the
tracking happens.
The search area can be enabled in the Marker Display panel in the
Properties Sidebar.
This area usually scales with the marker. To scale this search area
16

Bforartists Reference Manual - © Copyright - This page is Public Domain

separately you can use the handlers of this search area.
Or you can scale the marker only by pressing the scale hotkey twice.

Track
A track is the recorded movement of a marker. The
movement is recorded in keyframes and curves.
Once recorded you can see the track for the markers
in the Dopesheet editor in the Movie Clip Editor.

And you can see the curves for this track(s) in the
Graph editor.

Short tutorial
There are too many steps involved to get Motion tracking working. You can't figure it out by your own, nothing
is self explaining. So here comes a short workflow tutorial.
Note that we will just cover some of the basics here, some first steps. And we describe the setup for a ground
tracking case here. I would suggest to search for a Blender tracking tutorial for more details.

Preparing the video
Load a video.
Set the frame to the one where you want to start the tracking. The range of the movie to work with can be set in
the Timeline at the bottom of the layout. I have chosen frame 90 to 120 here. Since especially the first frames of
my example movie were very blurry.

Click the Detect Features button in the tool shelf in the Track tab in the Marker panel. This sets some markers
automatically, and adds tracks in the movie clip editor in dopesheet mode. Every track represents one marker.
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You can add a few more markers manually with the Add Marker button, and place them at
marcant locations in the current image of the movie. Borders or Corners for example. To do so,
click the Add Marker button, then click in the image. We need minimum eight markers to have
enough stability. The Add Marker button is below the Detect Features button.
Selected markers can be moved with the left mouse. You can fine tune the position of the marker
in the Track panel in the Properties sidebar. Simply move the image there to the required position.

Now choose a camera preset in the properties sidebar in the Camera Data panel. If unsure,
and your camera isn't listed, select Blender.
Or type in the values manually. Sensor and Optical Center ...

Select all markers.
Click the Track Forward button in the Track panel. This records everything. And you get
data in the Graph Editor view. Blue and red lines for every marker.

Some markers may go crazy at this point. Motion means blurry graphics. And then a
marker can loose its tracking position. Or the tracking point moves out of the visible area.
You can either remove such markers after tracking when you have enough working tracks
left. Remember we need eight valid tracks. You can also try to add new markers, and
repeat the procedure with this new markers.
Or you can manually adjust the markers, and add a keyframe where they loose their
position. Scroll to the frames where the marker is loosing its position, move it back into
location, and add a keyframe for it. Adding keyframes is done in the Track menu.
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Tracking the object
This was the preparation of the movie material. Now for the tracking part. We need a camera. And something to
track. A cube will do it for now.
In the 3D view, create or select the object that you want to track.
Now go into camera view, and adjust it so that it shows the content somehow in the center.
Our cube for example.
Go to the solve tab into the solve panel. First adjust the range. I had tracked frame 90 to
frame 120. So the default of 1 and 30 will not work since there are no keyframes for the
markers at this position. And so you will get an error.
When done click at the solve camera motion button. This calculates the camera motion.
In the solve tab in the Scene Setup panel click at Set as Background. This will show our
movie as background now in the 3D view in the camera view.

In the solve tab in the Geometry panel, click at 3D Markers to Mesh. You can also click
Link Empty to Track. This will create an empty where you can parent things at.
Then click at Setup Tracking Scene below the Set as Background button. This will create a
ground plane, which is used for shadow catching in the rendering. And now our object
should already follow the motion of the movie when you play back.
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Orientation and dimensions
In the solve tab you can find the Orientation panel. This allows you to adjust the
orientation of the object along marker points. Select three of your markers, and click at
Floor, and the object will orient along this three points.
This may or may not lead to useful results. In our case it didn't.
Even after selecting other markers. So we need to rotate our
object manually.

Note that the view in the Motion Tracking
layout the camera is NOT locked to view. So
when you zoom then the passepartout zooms,
not the view. And you can't rotate the camera
view that way. So go to the View panel, and
tick Lock Camera to view. Then you can
navigate from the camera view, and rotate and
zoom everything so that it fits.
You can also scale the object to the needed
size. Or fit the perspectivic distortions by
changing the Camera focal length, or by
zooming.

Reloading a project
When you save your project and reload it then you might notice that
the Movie Clip editor loads empty. This is because Bforartists has
"Load UI" unticked. And so it looks like the movie is missing and the
project is empty.
There is nothing missing. You just need to select the movie again in
the dropdown box at the top.
When you work more often with motion tracking, then you might want to activate Load UI in the user
preferences permanently.

Clip Editor, Gaph Editor and Dopesheet Editor
The Tracking mode has three different sub editor types. Clip Editor, Graph Editor and
Dopesheet Editor.
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Clip Editor
The clip editor contains the footage related tools and settings. Here you deal with the footage movie. It's the
main window that you see in the Motiontracking layout. The Clip Editor view has two main purposes. It can be
used for for tracking or masking movies.

The Clip Editor has four areas. Actually five, since the tool shelf is divided into two areas.
The Header. The place for menus and some often used tools and settings.
The viewport, where you display your movies.
The Tool shelf. Here you will find the tools. When you are in Mask mode then the toolset will be different.
The Last Operator panel. Here you will find the settings for the currently active tool.
The Properties Sidebar. Here you will find properties.

Graph Editor
The Graph editor is the place where you can see and deal with the function curves of the recorded tracks.

The Graph editor has two areas.
The Header. The place for menus and some often used tools and settings.
The viewport, where you display the curves.
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Dopesheet Editor
The Dopesheet Editor is the place where you deal with the keyframes for the tracks.

The Dopesheet editor has three areas.
The Header. The place for menus and some often used tools and settings.
The left column where you can see the name of the tracks.
The right column where you can see the keyframes.

Clip Editor Introduction
The clip editor contains the footage related tools and settings. Here you deal with the footage movie. It's the
main window that you see in the Motiontracking layout. The Clip Editor view has two main purposes. It can be
used for for tracking or masking movies.
The Clip View is used is the main part of the of the Movie Clip editor. Almost all motion tracking tools are
concentrated in the Movie Clip Editor.
Camera solver consists of three separate steps.
2D tracking of footage.
Camera intrinsics (focal length, distortion coefficients) specification/estimation/calibration.
Solving camera, scene orientation, and scene reconstruction.

Clip Editor general navigation
You can move the frame slider with the left mouse here.
To scroll in and out in the viewport you can use the scroll wheel. Or the + and - Buttons at the Numpad.
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Panning the viewport happens with middle mouse button.

Clip Editor - Tracking and Mask Mode
The Clip editor has two modes. Tracking Mode and Mask Mode.
The Tracking mode contains all functionality regarding motion tracking and footage. The Mask
Mode contains tools to mask out parts of the footage. The masking part is spline based.

The mask tools in the Tool Shelf and the Properties Editor
appears when you create a new mask.

Tool Shelf - Grease Pencil
The Grease Pencil tool is a tool with which you can paint strokes in editors like
the 3D view.
It is unfortunately cluttered across two shelves. The Tool Shelf and the Properties
Sidebar. Means you have to adjust settings at two places.
The first thing that you have to do is to load a movie. Without a movie loaded
you can't use the Grease Pencil here. Then you can create a new Grease pencil.
This can either be done in the Properties Editor by clicking at New. Or in the Grease Pencil Tab in the Tool
Shelf by simply clicking at the Draw button. Then all Grease Pencil tools becomes visible. And a Grease Pencil
layer gets created.
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Grease Pencil Panel
The Grease Pencil panel contains the general Grease Pencil tools. The Draw tool,
eraser, some settings and tools.

Draw
The Draw section contains the draw tools.

Draw
Draw activates the freehand draw mode.

Erase
Erase is the eraser tool with which you can delete strokes.

Line
Line paints a straight line between start and end point.

Poly
Poly allows you to paint polygon shapes.

Eraser Radius
Here you can adjust the radius of the eraser tool. Have a look at the hotkey, it's a
hotkey only tool for proper functionality.

Insert Blank Frame
Insert a blank frame on the current frame.

Delete frames
Delete the active frame(s) of all editable grease pencil layers.

Draw Settings
The draw settings are placed besides each other, to save space.

Additive Drawing
When you create new frames then the strokes from the previous active frame are included as the base for the
current frame.
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Continuous Draw
The Continuous Draw checkbox enables and disables the continuous draw mode. Normally the draw mode ends
when you stop drawing the current line. And you have to activate the draw tool again when you want to
continue with painting. With continuous draw you can immediately paint the second stroke without to enable
the draw tool again.
Eraser in Continuous Draw
The draw tools are disabled as long as you are in continuous draw. To erase a stroke use the
right mouse button. The pencil turns into a red circle. With which you can erase strokes
now.
End Continuous Draw
The draw tools are disabled as long as you are in continuous draw. To end the continuous
draw mode click outside of the viewport. In the tool shelf for example.

Draw on Back
New strokes will be drawn behind all other strokes in the layer

Stroke Placement
Stroke Placement defines where the Grease Pencil stroke is placed.

View
View will place the stroke at the top of the viewport. It is not drawn in the 3D view.

Cursor
Cursor will place the stroke aligned with the 3d cursor, and aligned with the current camera view. It is drawn in
the 3D view.

Enable Editing
Sometimes you want to edit the strokes that you have placed. Here you can enter the editing mode, and reveal
some editing tools.

Edit Strokes Panel
The Edit Strokes Panel contains the tools to edit the Grease Pencil strokes. Most
of the tools are pretty self explaining.
It is divided into two sections. Select and Edit.
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Select
The select section.

Select All
Toggles between select all and deselect all.

Border Select
Border select enters the Border Select mode. This is a special select mode where you can select elements by
dragging a rectangle. And what's inside of the rectangle gets selected then. It adds to selection by default.
To subtract from selection hold down Shift key.
The selection gets applied when you release the mouse. You leave the mode automatically when you release the
mouse.

Circle Select
Circle select enters the Circle Select mode. This is a special select mode where you can select elements by
moving with the mouse over it. It adds to selection by default.
To subtract from selection hold down Shift key. To exit the Circle select click with the right mouse button.
The pencil radius of the circle select tool can be adjusted with the scroll wheel.

Select Linked
Select the linked vertices of the same stroke.

Select More
More expands the selection.

Select Less
Less reduces the selection.

Select Color
Select all grease pencil strokes with the same color than the currently selected one.
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Edit
The Edit section.

Translate
Moves the selected grease pencil geometry in the viewport by moving the
mouse.
Last Operator Translate
The last operator appears in the 3D view!
Vector
Here you can adjust the position values for the three values
Constraint Axis
Here you can limit the position relative to the source object.
Orientation
Orientation is a drop-down box where you can choose the type of orientation for the
mirroring action.

Proportional Editing
Proportional Editing is a drop-down box where you can choose to use proportional editing.
When you choose one of the active methods then the neighbour geometry gets influenced in
a proportional way.
Proportional Editing Falloff
Proportional Editing Falloff is a drop-down box where you can choose a method for the
falloff for the proportional editing.
Proportional Size
Proportional size is a edit box where you can adjust the strength of the Proportional
falloff.

27

Bforartists Reference Manual - © Copyright - This page is Public Domain

Edit Grease Pencil
Edit Grease Pencil edits the selected Grease Pencil strokes.
Edit Texture Space
With Confirm on Release checked the action gets performed when you release the mouse button.

Rotate
The last operator appears in the 3D view!
Rotates the selected grease pencil geometryi in the viewport by moving the mouse.
Last Operator Translate
Angle
Here you can adjust the rotation angle.
Constraint Axis
Here you can limit the position relative to the source object.
Orientation
Orientation is a drop-down box where you can choose the type of orientation for the
mirroring action.
Proportional Editing
Proportional Editing is a drop-down box where you can choose to use proportional editing.
When you choose one of the active methods then the neighbour geometry gets influenced
by Shrink/Fatten too in a proportional way.
Proportional Editing Falloff
Proportional Editing Falloff is a drop-down box where you can choose a method for the
falloff for the proportional editing.
Proportional Size
Proportional size is a edit box where you can adjust the strength of the Proportional
falloff.
Edit Grease Pencil
Edit Grease Pencil edits the selected Grease Pencil strokes.

Scale
The last operator appears in the 3D view!
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Scales the selected grease pencil geometry in the viewport by moving the
mouse.
Last Operator Resize
Vector
Here you can adjust the position values for the three values
Constraint Axis
Here you can limit the position relative to the source object.
Orientation
Orientation is a drop-down box where you can choose the type of orientation for the
mirroring action.
Proportional Editing
Proportional Editing is a drop-down box where you can choose to use proportional editing.
When you choose one of the active methods then the neighbour geometry gets influenced
by Shrink/Fatten too in a proportional way.
Proportional Editing Falloff
Proportional Editing Falloff is a drop-down box where you can choose a method for the
falloff for the proportional editing.
Proportional Size
Proportional size is a edit box where you can adjust the strength of the Proportional
falloff.
Edit Grease Pencil
Edit Grease Pencil edits the selected Grease Pencil strokes.
Edit Texture Space
With Confirm on Release checked the action gets performed when you release the mouse button.

Mirror
Mirror mirrors the selected geometry along the defined axis. Click the Mirror button, type
in X, Y or Z, then confirm with enter.
Last Operator Mirror
The Last Operator Mirror panel gives you tools to adjust the mirror action.
Constraint Axis
Constraint Axis gives you again the possibility to define the mirror axis. You can choose
more than one axis here.
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Orientation
Orientation is a drop-down box where you can choose the type of orientation for the
mirroring action.
Proportional Editing
Proportional Editing is a drop-down box where you can choose to use proportional editing.
When you choose one of the active methods then the neighbour geometry gets influenced
by Shrink/Fatten too in a proportional way.

Proportional Editing Falloff
Proportional Editing Falloff is a drop-down box where you can choose a method for the falloff for the
proportional editing.
Proportional size
Proportional size is a edit box where you can adjust the strength of the Proportional
falloff.
Edit Grease Pencil
Edit Grease Pencil edits the selected Grease Pencil strokes.
Confirm on Release
With Confirm on Release checked the action gets performed when you release the mouse button.

Shear
Shear shears the selection.
Last Operator Shear
Offset
Adjust the offset
Proportional Editing
Proportional Editing is a drop-down box where you can choose to use proportional editing.
When you choose one of the active methods then the neighbour geometry gets influenced
by Shrink/Fatten too in a proportional way.
Proportional Editing Falloff
Proportional Editing Falloff is a drop-down box where you can choose a method for the
falloff for the proportional editing.
Edit Grease Pencil
Edit Grease Pencil edits the selected Grease Pencil strokes.
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Confirm on Release
With Confirm on Release checked the action gets performed when you release the mouse button.

To Sphere
To Sphere transforms the selection into a spherical form.
Last Operator To Sphere
Factor
Adjust the rounding factor
Proportional Editing
Proportional Editing is a drop-down box where you can choose to use proportional editing.
When you choose one of the active methods then the neighbour geometry gets influenced by Shrink/Fatten too
in a proportional way.
Proportional Editing Falloff
Proportional Editing Falloff is a drop-down box where you can choose a method for the
falloff for the proportional editing.

Proportional Size
Adjust the proportional size
Edit Grease Pencil
Edit Grease Pencil edits the selected Grease Pencil strokes.
Confirm on Release
With Confirm on Release checked the action gets performed when you release the mouse
button.

Arrange Strokes
This is a dropdown box where you can arrange the currently selected stroke relative to
the other ones.
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Move to Color
Recolors the currently selected grease pencil stroke with the
active color in the Grease Pencil Colors color.
The grease pencil colors can be found in the properties sidebar
at the right.

Subdivide
Subdivide subdivides the current selection.
Last Operator Subdivide Stroke
Number of Cuts
Adjust the number of subdivisions

Join
Joins strokes.
Last Operator Join Strokes
Type
Here you can choose if it should only join, or join and also copy the strokes.
Leave Gaps
Leave Gaps between joined strokes instead of linking them.

Join & Copy
Joins strokes and copies it.
For last operator see above.

Flip Direction
Change the direction of the stroke.
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Sculpt Strokes Panel
The Sculpt Strokes Panel provides tools to sculpt the Grease pencil strokes.

Note!
The Sculpt Strokes Panel is just visible in Edit Strokes
Mode!

Sculpt Strokes Button
The Sculpt Strokes Button activates the Sculpt brush. Now you can sculpt the Grease Pencil stroke with left
mouse button. Clicking with right mouse button ends the sculpt mode.

Radius
The radius of the sculpt brush.
The button behind the edit box allows you to set the radius by moving the mouse. This should be done in the
viewport and with the hotkey. This button is just a visible reminder.

Strength
The strength of the sculpt brush.
The button behind the edit box allows you to set the strength by moving the mouse. This should be done in the
viewport and with the hotkey. This button is just a visible reminder.

Use Falloff
Defines if the brush has a falloff from the centre to the border of the pencil.

Position
The Brush affects the position of the point.

Strength
The Brush affects the strength of the point.

Thickness
The Brush affects the thickness of the point.

Selection Mask
Only sculpt the selected points.

Alpha
Alpha value for selected vertices.
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Affect Pressure
Affect pressure values as well when smoothing strokes.

Drawing Brushes panel
The Drawing Brushes panel contains everything around the Brushes and their settings. It is visible in all modes.
But the content just shows when you have activated the draw tool already.

Brushes selection box
Here you can choose different brush types. At the right you can add and remove
brushes. And you can sort the brushes order.

Thickness
Defines the thickness of the stroke.

Sensitivity
Pressure sensitivity for new strokes.

Strength
Color strength for new strokes. The alpha factor of the color is affected.

Randomness
Randomness factor for pressure and strength of new strokes.

Jitter
Jitter factor for new strokes.

Angle
Direction of the stroke at which the brush gives the maximum thickness.

Factor
Reduce Brush thickness by this factor when stroke is perpendicular to angle direction

Smooth
Amount of smoothing to apply to newly created strokes to reduce jitter / noise.

Iterations
Number of times to smooth newly created strokes.

Subdivision
Number of times to subdivide newly created strokes, for less jagged strokes.
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Randomness
Randomness factor for new strokes after subdivision.

Brush Curves Panel
The Brush curves panel is meant for usage with tablets. Here you can manipulate the curves
for Sensitivity, Strength and Jitter.

Properties Sidebar - Grease Pencil - Layers Panel
The Grease Pencil Layers are connected with
the Grease Pencil panel in the Tool Shelf.
And provides you with the layer settings for
the Grease Pencil.
When no layer exists then there are just a few
buttons available.

Grease Pencil Prop
Here you can add a new grease pencil to work with. Or choose an existing
grease pencil.
The edit box allows you to rename the current grease pencil.
The F Button adds a fake user to the grease pencil. So that it does not get
deleted when you delete the connected object and close the scene.
When you add a fake user, then a number field will appear that shows how
much users are connected with the current pencil.
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New Layer
Here you can create a new layer for your grease pencil. Doing so will reveal several layer
settings. And another panel with some color settings.

Layer list
Here you can see a list of the current layers. And here you can select the current
active layers.
Grease Pencil Layers can be locked (lock icon) and hidden (eye icon). The third
symbol is to unprotect selected colors from further modifications.

Add / Delete
Right besides the layer list box there is a add button and a delete button. The plus button adds a new
layer, The minus button removes the current layer.

Layer Specials menu
Below the add and delete buttons there is a text menu with some further options.

Duplicate Layer
Duplicates the currently selected layer.

Show All
Unhides all hidden layers.

Hide Others
Hides all layers but the selected.
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Lock All
Locks all layers.

Unlock All
Unlocks all layers.

Merge Down
Merges all layers into one.

Move Up / Move down
Moves the currently selected Grease pencil layer one up or down the list.

Lock Unlock unselected / Show Hide unselected
Lock Unlock unselected toggles the lock for the unselected layers.
Show Hide unselected toggles the visibility for the unselected layers.

Opacity
Opacity sets the opacity of the current grease pencil stroke.

X Ray
X Ray makes the grease pencil stroke appear in front of objects. Without X Ray the stroke will be
invisible behind objects.

Show Points
Shows the points in the current grease pencil stroke.

Tint
Tint tints the color of the current grease pencil stroke with the tint color.
The upper field is a color picker where you can select a color. The fac slider defines the blending
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factor between the grease pencil stroke color and the tint color.

Thickness Change
Increase or decrease the thickness of the grease pencil stroke.

Lock Frame
You can draw grease pencil strokes in different frames. Here you can lock those frames
from further editing.

Onion Skinning
You can draw grease pencil strokes in different frames.
With onion skinning you can display the strokes from the
previous and following frames as ghost drawings.

Onion Skinning checkbox
Activates / deactivates the onion skinning.

Use always ghosts
When activated the ghost images will also show in rendering.

Use custom colors
Here you can choose to display the ghost drawing in predefined colors, or in their original colors. Default is to
display the predefined colors.

Before
Here you can choose in which color the previous frame gets displayed. And how many frames gets displayed
before the current frame.

After
Here you can choose in which color the following frame gets displayed. And how many frames gets displayed
after the current frame.
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Properties Sidebar - Grease Pencil - Colors Panel
The grease pencil colors panel contains all the settings to set up and define the colors
that you use for your grease pencil drawings.
It activates when you start to draw a grease pencil stroke. And shows its content then.

GP Palette
Here you can select, create and delete a color palette for the grease pencil colors.
Define some colors in the Color list, then create a new palette with it.

Color List
Here you can add custom colors.
The color field at the beginning of the edit box reveals a color picker when you click
at it. Which allows you to define a color.
The string “Color”, “Color 002” and “Color 003” is an edit box which allows you to
rename the color. Click into the field to activate it.
The Lock symbol allows you to lock the current color.
The eye symbol allows you to show or hide the current layer.
The ghost symbol allows you to display this color with onion skinning.

Add / Delete
Right besides the layer list box there is a add button and a delete button. The plus button adds a new
layer, The minus button removes the current layer.

Palette color Specials menu
Below the add and delete buttons there is a text menu with some further options.

Show All
Unhides all hidden colors.

Hide Others
Hides all colors but the selected.
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Lock All
Locks all colors.

Unlock All
Unlocks all colors.

Copy color
Copys the color.

Select strokes
Selects all grease pencil strokes that uses the curent color.

Move to color
Move selected strokes to active color.

Strokecolor
Here you can define the stroke color and set its opacity.

Volumetric Strokes
With Volumetric strokes the grease pencil stroke does not draw as a stroke, but a line of dotted points.

Fill
Fill fills the space between the grease pencil strokes.
The opacity is by default at zero. The fill color shows when you
increase the opacity.
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High Quality Fill
Fill Strokes uses high quality to avoid glitches. But this gives slower fps while animation.
Here you can turn it off.

All Modes - Header - View Menu
The View menu provides you with some view related tools.

Properties
Opens or closes the Properties sidebar at the right side of
the UV Image Editor.

Tools
Opens or closes the Tool Shelf at the left side of the UV
Image Editor.

View Selected
Just visible with 3D View in Edit mode, for UV mapping.
View Selected zooms in or out until the Selection is displayed fitting in the viewport.

View All
View all zooms in or out until all selections are displayed fitting in the viewport.
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View Fit
Zooms in or out to fit the selection into the current view.View Zoom In
Zooms into the view

View Zoom Out
Zooms out of the view

Zoom 1:8 ... Zoom 8:1
A set of predefined zoom factors.

Duplicate Area into new Window
Duplicate Area into New Window makes the selected editor
window floating. You can then drag it around at the monitor.
A separated window cannot be merged into the main window

Toggle Full screen Area
Displays the editor maximized without menus.
To return from the full screen view press hotkey Alt F10, or use
the little button that appears up right when you move the mouse in
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Toggle Maximize Area
Displays the editor maximized with menus.
To return to split view press hotkey Ctrl Up Arrow, or reuse the
menu item in the View menu.

All Modes - Header - Clip menu
The clip menu contains clip related tools. It shows in both modes, Tracking and Mask.

Open Clip
Open a new movie file

Prefetch Frames
Preloads the frames of the movie file for faster playback.

Reload Clip
Reloads the movie file.

Proxy
Proxy is a sub menu with proxy related settings. A proxy is a smaller
image (faster to load) that stands in for the main image. And this
allows faster editing once this proxy images are generated. The
Proxy and Timecode settings are in the Properties sidebar at the right.

Rebuild Proxy and Timecode Indices
Rebuild all selected proxies and time code indicies in the background.

Delete Proxy
Delete the Proxy.
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Set Solver Keyframe A
Set keyframe used by solver A at current keyframe position. It's
the same solver keyframe than in the Solve panel.

Set Solver Keyframe B
Set keyframe used by solver B at current keyframe position. It's
the same solver keyframe than in the Solve panel.

All Modes - Header - Tools
Clip Browser
The clip browser is the place where you can load a new movie and choose an existing movie.
When no movie is loaded, or when no movie is selected, then you will see the Open button.
When a movie is loaded and selected, then you will see the
currently selected movie.
From left to right.

Clip browser
A dropdown box with the currently loaded movies.

Edit Box
Here you can read and edit the currently selected movie.

Number of users
How much other sources uses this movie at the moment.

Fake User
Pressing this button sets the selected movie to have a fake user. Zero user data-blocks are normally not saved.
But sometimes you want to force the data to be kept even when the data block has no user.

Open Clip
Open a new movie

Delete Clip
Deletes the movie. Note that the numbers of users has to be zero when you really want to remove the movie
completely from the Blend file. Else it always comes back.
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Mode dropdown box
Here you can choose if you want to be in Tracking or in Mask mode.
In Tracking mode you do motion tracking.
In Mask Mode you can mask out specific parts of the footage. For green screening for example.

Clip Editor Type
The clip editor is made of three sub editors. Clip Editor, Graph Editor and Dopesheet Editor.
Here you can switch between them. This element is available in all three sub editor types.

Pivot Point
Here you can adjust where the pivot point of the currently selected element is. This is
important for transforms like move or rotate.

Bounding Box Center
The pivot point is in the center of a bounding box around the selected element(s).

2D Cursor
The pivot point is at the 2D cursor.

Individual Origins
Each selected element has its own pivot point.

Median Point
The pivot point is in the center of the selected element(s).

Tracking Mode - Select Menu
Border Select
Border select enters the Border Select mode. This is
a special select mode where you can select elements
by dragging a rectangle. And what's inside of the
rectangle gets selected then. It adds to selection by
default.
To subtract from selection hold down Shift key.
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The selection gets applied when you release the mouse. You leave the mode automatically when you release the
mouse.

Circle Select
Circle select enters the Circle Select mode. This is a special select mode where you can select
elements by moving with the mouse over it. It adds to selection by default.
To subtract from selection hold down Shift key. To exit the Circle select click with the right mouse button.
The pencil radius of the circle select tool can be adjusted with the scroll wheel.

(De)Select All
Toggles between select all and deselect all.

Last Operator (De)Select All
Action
Action is a drop-down box where you can choose between different methods.
Invert
Inverts the selection.
Deselect
Deselects all.
Select
Selects all.
Toggle

Inverse
Inverts the current selection.

Grouped tracks
Grouped tracks is a sub menu where you can select grouped tracks by specific
types. The menu items are pretty self explaining. So we won't go into detail
here.
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Last Operator Select Grouped
Action is again the same menu content from above. But the names
differs here a bit. Here every item contains the term track.

Tracking Mode - Header Tools
Info String
In this area you might get additional information. For example in this case the
solve error after motion tracking calculation for the markers.

Tracking Mode - Track menu
The track menu contains some tracking related tools. They belong to the Dopesheet Editor
in the Movie Clip Editor.

Clear Solution
Clears all calculated data.

Clear Track Path
Clear tracks after/before current position or clears the whole track. It basically deletes the involved
keyframes.
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Last Operator Clear Track Path
Action
Action is a dropdown box where you can
choose the clear method.

Clear Active
Clear just the active track instead of all
selected tracks.

Lock
Locks the current track. This setting is related to the lock symbol in the
Dopesheet editor.

Unlock
Unlocks the current track. This setting is related to the lock symbol in the Dopesheet editor.

Last Operator Lock Tracks
Action
A dropdown box where you can choose again if you want to lock or to unlock the current
track. Plus a possibility to toggle the current lock.

Copy
Copies a track

Paste
Pastes the copied track

Insert Keyframe
Inserts a keyframe to the selected track(s) at current movie position

Delete Keyframe
Deletes a keyframe in the selected track(s) at current movie position
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Show / Hide
Show Hide is a sub menu where you will find show hide functionality for the markers in the viewport.

Show Hidden
Shows all hidden markers.

Hide Selected
Hides the selected markers.

Hide Unselected
Hides the unselected markers.

Last Operator Hide Tracks
Unselected
Here you can again choose if you want to hide the selected or the unselected marker

Transform
Markers can be changed in size position and
rotation. Transform is a sub menu where you will
find the menu items for the transform operations to
manipulate the markers in the clip viewport.

Translate
Move the selected marker(s).

Last Operator Translate
Move
Here you can adjust the position.
Proportional Editing
Proportional Editing is a drop-down box where you can choose to use proportional editing. When you choose
one of the active methods then the neighbour geometry gets influenced too in a proportional
way.
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Proportional Editing Falloff
Proportional Editing Falloff is a drop-down box where you can choose a method for the falloff for the
proportional editing.
Proportional size
Proportional size is a edit box where you can adjust the strength of the Proportional
falloff.

Edit grease Pencil
Edit Grease Pencil edits the selected Grease Pencil strokes.
Edit Texture Space
Edit Object Data Texture space. - Note that this most probably doesn't belong here.

Rotate
Rotate the selected marker(s).

Last Operator Rotate
Values
Here you can adjust the position.
Proportional Editing
Proportional Editing is a drop-down box where you can choose to use proportional editing.
When you choose one of the active methods then the neighbour geometry gets influenced
too in a proportional way.
Proportional Editing Falloff
Proportional Editing Falloff is a drop-down box where you can choose a method for the
falloff for the proportional editing.
Proportional size
Proportional size is a edit box where you can adjust the strength of the Proportional
falloff.

Edit grease Pencil
Edit Grease Pencil edits the selected Grease Pencil strokes.

Resize
Scale the selected marker(s).
Note: Every marker has also a search area connected to it. It
normally scales with the marker. You can scale just the marker
without scaling the search area by pressing the Resize hotkey
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twice.
This functionality has no menu entry.

Last Operator Resize
Scale
Here you can adjust the scale.
Proportional Editing
Proportional Editing is a drop-down box where you can choose to use proportional editing.
When you choose one of the active methods then the neighbour geometry gets influenced
too in a proportional way.
Proportional Editing Falloff
Proportional Editing Falloff is a drop-down box where you can choose a method for the
falloff for the proportional editing.
Proportional size
Proportional size is a edit box where you can adjust the strength of the Proportional
falloff.

Edit grease Pencil
Edit Grease Pencil edits the selected Grease Pencil strokes.
Edit Texture Space
Edit Object Data Texture space. - Note that this most probably doesn't belong here.

Reconstruction
This menu was formerly a menu full of double entries that can also be found in the tool shelf. It remains in
place for addon compatibility.
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Tracking Mode - Tool Shelf
The Tool Shelf is split into two areas. The upper area with the tabs is the actual tool shelf
where you find your tools. It is also a usual place where add-ons gets installed, and adds
their tab too.
The lower area is the so called Last Operator panel. Here you will find the settings for the
currently performend tool.
The content is varying, dependant of the mode you are in. Tracking mode has other tools
than the Masking mode.

Track Tab and Solve Tab
The track tab contains the tools around the movie side of things. Markers, tracking etc.
The solve tab contains the tools around the scene side of things. Scene setup, camera
motion, etc.

Grease Pencil tab
The grease pencil tab contains grease pencil tools.

Tracking Mode - Tool Shelf - Track tab - Clip Panel
The Clip panel contains movie related tools.

Set Scene Frames
Sets the length, means start and end frame of the tracking to match the start and end frame
of the active movie.
You can see the length of the active movie in the Properties sidebar in the Footage
Information panel. And the tracking length and position can be seen and set in the time line.
The default range for tracking is from 1 to 250. But our movie is 295 frames long. Pressing
the Set Scene Frames button makes the range going from 1 to 295
here.
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Tracking Mode - Tool Shelf - Track tab - Marker Panel
The marker panel contains marker related tools.

Detect Features
Adds automatically markers at the current
movie position, and tries to detect marcant
areas in the current frame that are useful for
tracking. It also sets keyframes at this
position.
When enough marcant areas are available
then it adds up to eight markers that way.

Last Operator Detect Features
Placement
Placement is a dropdown box where you can limit the placement of the markers.
Whole frame
The markers can be at every position of the current frame image.
Inside Grease Pencil
The markers have to be inside the Grease Pencil.
Outside Grease Pencil
The markers have to be outside Grease Pencil.

Margin
Gives a margin to the border of the frame image. Markers have to stay away from the border by the given
amount.

Threshold
The threshold level to consider the current position of the marker as good enough for tracking.

Distance
The minimum distance between two markers.
53

Bforartists Reference Manual - © Copyright - This page is Public Domain

Add Marker
Adds a marker by hand. First click the tool, then click at the location where you want it to be.
You can reposition this marker afterwards by simply clicking at it and move it to a new position.

Last Operator Add Marker at Click
This last operator has no functionality. Just a warning that redo is not supported.

Enable Markers
Enables the currently selected marker(s)

Disable Markers
Disables the currently selected marker(s)

Last operator Disable Markers
Action
Edit box where you can again choose if you want to enable or disable the selected
marker(s).

Delete Marker
Deletes the currently selected marker(s) data. The track stays available. And the marker is still there too. But
cleared.

Delete Track
Deletes marker, marker data and track data.

Tracking Mode - Tool Shelf - Track tab - Tracking Settings
Panel
In the Tracking Settings Panel you will find some settings for Tracking.

Tracking Presets
A dropdown box where you can choose between some predefined tracking presets.
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+ Button adds a new preset with the current settings.
- Button removes the current tracking preset.

RGB
By default all three colors gets used for calculation. But you can enable or disable specific color range.

Pattern Size
Size of pattern area for newly created tracks.

Search Size
Size of search area for newly created tracks.

Motion
Here you can choose between different motion models for tracking.
Loc stands for location. Rot for Rotation, etc.

Match
The pattern match method.
Keyframe matches the tracking from the keyframe.
Previous frame matches the tracking from the previous frame. Regardless if there is a keyframe recorded or not.

Prepass
Use a Brute Force translation - only intialisation when tracking.

Normalize
Normalize light intensities when tracking.

Copy from Active Track
Copy tracking settings from active track to default settings

Extra Settings
Extra settings is a sub menu that contains some not so often used settings.
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Use Mask
Use a Grease Pencil data block as a mask.

Correlation
Default minimum value of correlation between matched pattern and reference that is still treated as successful
tracking.

Frames Limit
In every tracking cylce the numbers of given frames are tracked.

Margin
Default distance from image boundary at which markers stops tracking.

Weight
Influence of newly created track on a final solution.

Tracking Mode - Tool Shelf - Track tab - Track Panel
The tracking tools.

Track
Track selected markers in chosen direction. Usually you want to play them forward. But
you can also track backwards. And by one step.
The two play buttons in the center tracks the whole range. The two outer buttons tracks just frame wise.
Tip
To select good points for tracking, use points in the middle of the footage timeline and track backwards and
forwards from there. This will provide a greater chance of the marker and point staying in the camera shot.

Clear
The left button clears the track before the chosen position. The right button
clears the track after the chosen position.

Last Operator Clear Track Path
Action
Here you can again choose the direction.
Clear up to clears the track before the chosen position.
Clear remained clears the track after the chosen position.
Clear all clears the whole track.

56

Bforartists Reference Manual - © Copyright - This page is Public Domain

Clear active
When ticked, just the active track gets cleared.

Refine
Refine selected marker position in given direction from the current position.
Last operator Refine Markers

Backwards
Refine in backwards directory.

Merge
Joins selected tracks.

Tracking Mode - Tool Shelf - Solve tab - Plane Track Panel
Here you can create a plane track. A plane track can be used to map an image or a movie at an area in your clip.
The Plane track.
A plane track can be used to replace things like billboards and screens on the footage with another image or
video. It can also be used for masking.
It is also possible to have some tracks appear and disappear during the time. This required to have two neighbor
frames have at least 4 common tracks.
You need to select at least four markers. And the four markers should preferrably be at
the corners of the area in which you want to map the image or movie.
With the left mouse button and clicking at one of the corners of the cage you can move the plane track plane
around in the view.
With the right mouse button and clicking at one of the corners of the cage you can move the single corners, and
fit the plane into the area of the movie.
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The image or movie that you want to display here has to be added in the node editor then, in the compositing
mode.
Here add a image or movie node, and load an image or movie. Then back in motion tracking layout have a look
at the plane track panel in the Properties sidebar. Here choose the Image that we have added here.

Tracking Mode - Tool Shelf - Solve tab - Solve Panel
The Solve Panel contains functionality around solving the camera motion.

Tripod
Tripod tracking is a special method to track a stable camera position, and uses special
solver. Tripod Motion can be used for footage where the camera does not move and only
rotates. Here you can enable Tripod camera tracking. Keyframe A and B are greyed out
then.
Note that Tripod behaves different from regular solver. More tracks doesn't imply to have more accuration. 5-10
solver is recommended.

Keyframe
Automatically select Keyframes when solving camera / object motion

Keyframe A
The first keyframe for camera tracking.

Keyframe B
The last keyframe for camera tracking.

Refine
Here you can choose between different refine methods.
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Solve Camera Motion
Starts the calculation for the camera motion to match the track motion.
There should be at least eight common tracks on the both of the selected keyframes.
There should be noticeable parallax effects between these two keyframes.
The average reprojection error is reported to the information space and to the clip editor header. Reprojeciton
error means the average distance between reconstructed 3D position of tracks projected back to footage and
original position of tracks. Reprojection error below 0.3 means accurate reprojection, (0.3 - 3.0) means quite
nice solving which still can be used. Values above 3 means some tracks should be tracked more accurately, or
that values for focal length or distortion coefficients were set incorrectly.

Tracking Mode - Tool Shelf - Solve tab - Cleanup Panel
This panel contains tools to clean up tracks.

Clean Tracks
Cleans tracks with high error values or few frames. The tracks or segments in question
can either be selected, or directly removed. Dependant of the settings.

Last Operator Clean Tracks
Frames
Here you can adjust the number of "few" frames for clean track. 0 means the feature
gets ignored.

Error
Here you can adjust the error value for Clean Tracks.
See also Last Operator Clean Tracks.

Select
The action that should happen when you click at Clean Tracks. Default is select.

Frames
Here you can adjust the number of "few" frames for clean track. 0 means the feature gets ignored.
See also Last Operator Clean Tracks
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Error
Here you can adjust the error value for Clean Tracks.
See also Last Operator Clean Tracks.

Select
The action that should happen when you click at Clean Tracks. Default is select.
See also Last Operator Clean Tracks.

Filter Tracks
Removes tracks with too high spikes in their motion curve.

Tracking Mode - Tool Shelf - Solve tab - Geometry Panel
3D Markers to Mesh
Creates a vertex cloud using the coordinates of the reconstructed tracks.

Link Empty to Track
Creates an Empty which will be copying movement of active track.

Tracking Mode - Tool Shelf - Solve tab - Orientation Panel
Here you will find some orientation functionality to match the geometry in the 3D view
to the movie.

Floor
Set plane in the 3D space as a Floor plane, based at three selected markers.

Wall
Set plane in the 3D space as a Wall plane, based at three selected markers.

Last Operator Set Plane
Plane
A dropdown box where you can choose if you want to set the selected markers as plane
or as floor.

60

Bforartists Reference Manual - © Copyright - This page is Public Domain

Set Origin
Set active marker as origin in 3D space.

Last Operator Set Origin
Use Median
Set Origin to Median Point of selected bundles.

Set X Axis
Set X axis rotation in 3D space, based at the selected marker.

Set Y Axis
Set X axis rotation in 3D space, based at the selected marker.

Last Operator Set Axis
Axis
A dropdown box where you can again choose if you want to use the axis to X or to Y

Set Scale
Set scale of scene by scaling camera, based at two selected markers.

Last Operator Set Scale
Distance
The distance between two bundles used for scene scaling.

Apply Scale
Apply scale to solution.

Last operator Apply Solution Scale
Distance
The distance between two bundles used for scene scaling.
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Distance
The distance between two bundles used for scene scaling. This setting is a pre value, and gets used for Set Scale
as well as for Apply Scale when you perform those tools.

Tracking Mode - Tool Shelf - Solve tab - Scene Setup Panel
Set as Background
Sets the current movie as background in the 3D view. You need to be in camera view to
see the movie in the background.

Setup Tracking Scene
Prepare Scene for composing 3D objects into this footage.
This feature will create a ground plane, which is used for shadow catching in the rendering.

Tracking Mode - Properties Sidebar - Track Panel
Here you can find some marker settings for the currently selected marker.

Edit Box
Here you can read and edit the name of the currently selected marker.

Enable
Enable the currently selected marker.

Lock
Lock the currently selected marker.

Track Scope
This is a preview image and fine tune window for the currently selected
marker. The fade cross stays always in the center, but you can move the image
with the left mouse. This automatically records the changed position, and
inserts a keyframe at the current position if necessary.
You can pull it vertically bigger by pulling at the handler below the image.
And horizontally bigger by pulling out the properties sidebar.
If an anchor is used (the position in the image which is tracking is different from the position which is used for
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parenting), a preview widget will display the area around the anchor position.

Color Settings
R, G, B
Use red, green and blue color in the preview image.

B/W
Use a greyscale preview image.

Alpha
Use existing alpha channel for preview image.

Weight
The influence of this track to the final solution. Altering the weights of problem tracking markers can correct or
greatly reduce undesirable jumps. This parameter can be animated.

Stabilization Weight
The influence of this track on 2D stabilization.

Average Error
The average error of this marker.

Marker Color
Here you can give the markers different colors.

Color Preset
A dropdown box where you can choose between some predefined colors.
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Copy
Here you can copy the color of the currently chosen preset.

Add Preset, Remove Preset
Here you can add a new or remove a existing preset.

Custom Color
Use a custom color instead of a preset or the default color. A color field will appear. And
you can change the color by clicking at it. A color picker will appear.

All Modes - Properties Sidebar - Objects Panel
This content shows in Tracking Mode and Masking mode.
A list of the tracked objects. Usually the camera. But you can track every other
object too.

Add, Remove Tracking Object
The plus and minus buttons at the right allows you to add new objects to the list, or to remove existing objects
from the list.

Search Field
The list field contains a hidden search field. Click at the little + button down left to
reveal it.

Tracking Mode - Properties Sidebar - Plane Track Panel
This content is just active and visible when you have a Plane track in your footage.

Name
The name of the Plane track.

Auto Keyframe
Use Auto Keyframe when moving plane track corners.
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Image
Here you can see and load images or movies that you want to display inside of the Plane
track. Note that this image needs to exist already so that it gets displayed in the list. As a
image node for example.

Opacity
The opacity of the image or movie.

Tracking Mode - Properties Sidebar - Tracking Settings Panel
This content is visible when you have at least one of the markers selected.

Motion Model
Here you can choose the motion model for the marker.

Match
Here you can choose the pattern match method.

Prepass
Use a brute-force translation only pre-track before refinement.

Normalize
Normalize light intensities while tracking.
Extra settings is a sub menu that contains some not so often used settings.

Use Mask
Use a Grease Pencil data block as a mask.

Correlation
Default minimum value of correlation between matched pattern and reference that is still treated as successful
tracking.
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Frames Limit
In every tracking cylce the numbers of given frames are tracked.

Margin
Default distance from image boundary at which markers stops tracking.

Speed
A dropdown box where you can choose the tracking speed. This is just a preview feature. The
tracking quality is not affected.

Tracking Mode - Properties Sidebar - Camera Panel
Here you can choose the settings for the camera with which you have recorded the footage
movie. Every camera has some specific settings. And this needs to be calculated too to
match the footage to the 3D content.

Presets
A dropdown box where you can choose between different camera presets. When your
camera is not listed then you need to do the settings manually.

Add / Remove Camera Preset
Here you can add a new preset or remove an existing preset

Sensor
The sensor width and pixel aspect ratio of your camera.

Width
The width of the CCD Sensor in your used camera. This value can be found in the camera specifications.

Pixel Aspect Ratio
The Pixel Aspect of the CCD Sensor in your used camera. This value can be found in the camera specifications.
This value ccan also be guessed. For example, when the footage should be 1920×1080, but the images
themselves are 1280×1080, then the pixel aspect is: 1920 / 1280 = 1.5.

Optical center
The optical center. Usually in the middle of the movie. But some cameras also have an offset here.

Center
Center the optical center.
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In most cases it is equal to the image center, but it can be different in some special cases. Check camera/lens
specifications in such cases. To set the optical center to the center of image, there is a Return button below the
sliders.

Tracking Mode - Properties Sidebar - Lens Panel
This panel belongs to the Camera panel above. Here you can type in your lens
values from the camera with which you have recorded your footage movie.

Focal length
The focal length units with which the movie was shot. You can choose between
milimeter and pixel.

Lens Distortion
The lens distortion of your camera. You can choose between two distortion models.
Polynomial and Divisions.
Basically, just tweak K1 until solving is most accurate for the known focal length (but
also take grid and grease pencil into account to prevent “impossible” distortion).

All Modes - Properties Sidebar - Display Panel
This content shows in Tracking Mode and Masking mode.
Here you can adjust how the movie in the movie clip editor viewport gets displayed.

Color settings
RGB
Here you can activate single colors.

B/W
Display the footage movie in greyscale.

Mute Footage
Hide the footage movie.
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Render Undistorted
Display the footage movie undistorted, without the camera and lens settings.

Lock to Selection
Locks the display to selected markers through playback. Means the marker stays in position, and the movie
moves.

Display Stabilization
Show stable footage movie in the viewport. 2D Stabilization must be enabled
for this.

Grid
Displays a grid above the footage movie.

Calibration
Use manual calibration helpers.

Display Aspect Ratio
The aspect ratio of the footage movie.

Show Metadata
Displays the metadata of the movie if available.

Tracking Mode - Properties Sidebar - Marker Panel
The Marker panel contains the settings for the selected marker(s).

Enabled
Enable the selected marker(s).

Position
The position of the selected marker(s) in pixel. Zero is down left.
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Offset
You can give the marker handler an offset. So that it gets displayed
besides the marker.

Pattern Area
The handler size.

Search Area
The size and position of the search area for this marker for tracking.

Tracking Mode - Properties Sidebar - Marker Display Panel
Pattern
Display the marker handler.

Path
Display the marker paths.

Disabled
Show disabled tracks from the footage.

3D Markers
Shows the 3D markers from the 3D view as colored dots. The color of the point depends on the distance
between the projected coordinate and the original coordinate: if they are close enough, the point is green,
otherwise it will be red.

Search
Shows a handler cage for the search area for the marker(s).

Length
This belongs to the path. Here you can adjust how many frames the path should display.

Info
Displays a info string below the markers
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Thin
Displays the handlers as thin dotted lines instead of thick lines.

Tracking Mode - Properties Sidebar - 2D Stabilization Panel
The purpose of 2D Stabilization is to smooth out jerky
camera handling on existing real world footage. To
activate the 2D stabilizer, you need to set the toggle in
the panel, and additionally you need to enable Display
Stabilization in the Display panel. Then you’ll need to
set up some tracking points to detect the image
movements.

Anchor Frame
The first frame of the stabilization.

Rotation/Scale
Normally you just stabilize the position. Here you can stabilize rotation and scale too. Note that you can't
activate scale independently here.

Tracks for Location
The list of markers that gets used for location stabilization.
With the plus and minus button at the right you can add selected markers, or remove the markers from the list.

Tracks for Rotation/Scale
The list of markers that gets used for rotation/scale stabilization.
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With the plus and minus button at the right you can add selected markers, or remove the markers from the list.
This list is just visible when you have at least Rotation activated.

Autoscale
The stabilization will lead to areas where the movie doesn't
show at the canvas anymore. Autoscale scales the content so
that the whole canvas is covered again.

Max
The maximum value for autoscale.

X/Y
The position of the movie at the canvas.

Expected Rotation
Here you can rotate the movie at the canvas manually.

Expected Scale
Here you can scale the movie at the canvas manually. Note that this slider is greyed out when you have
Autoscale activated

Influence
The influence of stabilization algorithm. You can independently adjust location, rotation and scale. When oyu
have rotation off, then the sliders for rotation influence and scale influence are greyed out.

Interpolate
For rotation and scale the images needs to be recalculated. Here you can adjust the interpolation mode for it.

All Modes - Properties Sidebar - Proxy/Timecode Panel
This content shows in Tracking Mode and Masking mode.
A proxy is a smaller replacement image for the main image. Think of it as a thumbnail. The
creation may take some time. But once done, all other calculations happens much faster. So
it can make sense to use proxies for bigger footages.
Make sure to disable the Proxy images before doing the final render!
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Build Original
Here you can define the resolution of the proxy images.

Build Undistorted
Builds the proxy images from the undistorted original images for the sizes set above.

Quality
Defines the quality of the JPEG images used for proxies.

Proxy Custom Directory
By default, all generated proxy images are storing to the <path of original
footage>/BL_proxy/<clip name> folder. Here you can define a custom
directory.

Build Proxy / Timecode
(Re)creates the proxy images and the timecode.

Use Timecode Index
When you are working with footage directly copied from a camera without pre-processing
it, then there might be a bunch of artifacts. In this case the calculation can give errant
result. One way to avoid this is to use the Proxy / Timecode option. Another method would
be to use a external tool like mencoder to repair the file header and insert correct
keyframes.

Note
Record Run is recommended for most needs. Buf when the clip’s file is totally damaged, Record Run No Gaps
will be the only chance of getting acceptable result.

Proxy Render Size
This setting defines which proxy image resolution is used for display in the viewport.
If there is no generated proxies, render size is set to “No proxy, full render”.
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All Modes - Properties Sidebar - Footage Settings Panel
This content shows in Tracking Mode and Masking mode.
Here you can find some footage related settings.

File Path
The file path for the currently loaded and active video. Here you can also load another video, or refresh the
video.

Color Space
The color space for the currently loaded and active video.

Start Frame
The start frame for the currently loaded and active video.

Frame Offset
Here you can define a frame offset.

All Modes - Properties Sidebar - Footage Information Panel
This content shows in Tracking Mode and Masking mode.
Here you can see some information about the footage movie.

Masking Introduction
Masks have many purposes. They can be
used in a motion tracking workflow to
mask out, or influence a particular object
in the footage. They can be used for
manual rotoscoping to pull a particular
object out of the footage. Or as a rough
matte for green screen keying. This is
done in the Node editor in compositing
mode by a mask node.
Masks are independent from a particular
image of movie clip, and so they can just
as well be used for creating motion
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graphics or other effects in the compositor.
Masks are defined by splines. Means you work with splines, and you have a bunch of spline tools available.

S-Curves
The curve type used for creating mask splines is almost a Bézier curve,. But there are some differences. Smooth
edges of the mask are defined by feathering. These are called S-Curves.
Besides the handles, every control point also has points that define the feather between the current point and the
next point on the spline. Each feather point is stored in UV space, where U means position across spline
segment, and V means distance between main spline and feather points.

This allows for deforming the main spline in almost any way, and the feather will be updated automatically to
reflect that change.
For example if there is just rotation of the spline, feather would stay completely unchanged. If one point’s
feather is moved, the other feathers will be automatically stretched uniformly along that segment and the
overall shape will be almost the same as artists would want it to be.

Mask Mode - Header - Select Menu
The select tools for masking.

Border Select
Border select enters the Border Select mode. This is a special select mode where you can select elements by
dragging a rectangle. And what's inside of the rectangle gets selected then. It adds to selection by default.
To subtract from selection hold down Shift key.
The selection gets applied when you release the mouse. You leave the mode automatically when you release the
mouse.
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Circle Select
Circle select enters the Circle Select mode. This is a special select mode where you can select elements by
moving with the mouse over it. It adds to selection by default.
To subtract from selection hold down Shift key. To exit the Circle select click with the right mouse button.
The pencil radius of the circle select tool can be adjusted with the scroll wheel.

Select All
Toggles between select all and deselect all.

Select Linked
Select the linked vertices of the same stroke.

Select More
More expands the selection.

Select Less
Less reduces the selection.

Mask Mode - Header - Mask Menu
The mask menu contains some mask related functionality.

Delete
Deletes the selected mask spline.

Duplicate
Duplicates the selected mask spline.

Clear Parent
You can parent spline points to motion tracks. This tool clears the parent relationship.
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Make Parent
You can parent spline points to motion tracks. This tool creates the parent relationship.
Select spline point(s), hold down shift, select the marker where you want to parent it to.
Then choose make parent.
In the Properties editor you will see now content in the Active Point panel. The parent
relationship for the active spline point(s).

Copy Splines
Copies the selected mask spline(s)

Paste Splines
Pastes the copied mask spline(s)

Show Hide
Here you can find the tools to show or hide mask layers. Every spline is
one layer. See also the Mask layer list in the Mask layer panel in the
Properties sidebar.

Show Hidden
Show the hidden mask layer.

Last operator Show Hidden Layer
Select
Select the layer when revealing.

Hide Selected
Hide the selected mask layer.

Hide Unselected
Hide unselected mask layer.

Last Operator Hide Layer
Unselected
Hide Selected or Hide Unselected.
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Transform
The transform tools. Usually you will use the hotkeys here, not the menu
items.

Translate
Move the selected spline point(s).

Last Operator Translate
Move
Here you can adjust the position.
Proportional Editing
Proportional Editing is a drop-down box where you can choose to use proportional editing.
When you choose one of the active methods then the neighbour geometry gets influenced
too in a proportional way.
Proportional Editing Falloff
Proportional Editing Falloff is a drop-down box where you can choose a method for the
falloff for the proportional editing.
Proportional size
Proportional size is a edit box where you can adjust the strength of the Proportional
falloff.

Edit grease Pencil
Edit Grease Pencil edits the selected Grease Pencil strokes.
Edit Texture Space
Edit Object Data Texture space. - Note that this most probably doesn't belong here.

Rotate
Rotate the selected spline point(s).

Last Operator Rotate
Values
Here you can adjust the position.
Proportional Editing
Proportional Editing is a drop-down box where you can choose to use proportional editing.
When you choose one of the active methods then the neighbour geometry gets influenced
too in a proportional way.
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Proportional Editing Falloff
Proportional Editing Falloff is a drop-down box where you can choose a method for the falloff for the
proportional editing.
Proportional size
Proportional size is a edit box where you can adjust the strength of the Proportional
falloff.

Edit grease Pencil
Edit Grease Pencil edits the selected Grease Pencil strokes.

Scale
Scale the selected spline point(s).

Last Operator Resize
Scale
Here you can adjust the scale.
Proportional Editing
Proportional Editing is a drop-down box where you can choose to use proportional editing. When you choose
one of the active methods then the neighbour geometry gets influenced too in a proportional
way.
Proportional Editing Falloff
Proportional Editing Falloff is a drop-down box where you can choose a method for the
falloff for the proportional editing.
Proportional size
Proportional size is a edit box where you can adjust the strength of the Proportional
falloff.

Edit grease Pencil
Edit Grease Pencil edits the selected Grease Pencil strokes.
Edit Texture Space
Edit Object Data Texture space. - Note that this most probably doesn't belong here.

Scale Feather
Scales the feather point(s). See chapter S Curves.

Last Operator Transform
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Values
Here you can adjust the scale amount.
X, Y and Z defines the position. W defines the rotation.
Proportional Editing
Proportional Editing is a drop-down box where you can choose to use proportional editing.
When you choose one of the active methods then the neighbour geometry gets influenced
too in a proportional way.
Proportional Editing Falloff
Proportional Editing Falloff is a drop-down box where you can choose a method for the
falloff for the proportional editing.
Proportional size
Proportional size is a edit box where you can adjust the strength of the Proportional
falloff.

Edit grease Pencil
Edit Grease Pencil edits the selected Grease Pencil strokes.

Mask Mode - Header - Mask tools
Mask Browser
Here you can create new masks, and set the active mask.
From left to right:

Mask browser
A dropdown box with the available masks.

Edit Box
Here you can read and edit the currently selected mask.

Number of users
How much other sources uses this mask at the moment.

Fake User
Pressing this button sets the selected movie to have a fake user. Zero user data-blocks are normally not saved.
But sometimes you want to force the data to be kept even when the data block has no user.

New Mask
Creates a new mask.
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Delete Mask
Deletes the Mask. Note that the numbers of users has to be zero when you really want to remove the mask
completely from the Blend file. Else it always comes back.

Proportional Editing
here you can activate Proportional editing. With proportional editing neighbour
geometry gets influenced too.
Proportional Editing Falloff
Proportional Editing Falloff is a drop-down box where you can choose a method for
the falloff for the proportional editing.

Mask Mode - Tool Shelf - Mask tools panel
The Mask tools provides you with tools to modify the mask splines. It is divided into three
sections. Add Spline, Spline and Animation.
The splines that you can add have handlers to change their position and size. And in the
Spline section you can modify the splines even more. In the animation section you can
animate the spline points.

Add Spline section
Here you can add two types of mask splines.

Add Circle
Add a circle shaped spline.

Last Operator Add Circle
Size
The size of the mask spline.
Location
The location of the mask spline.
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Add Square
Add a square shaped spline.

Last Operator Add Square
Size
The size of the mask spline.
Location
The location of the mask spline.

Spline Section
Delete
Deletes the selected spline point.

Toggle Cyclic
A spline can be closed or have two ends. Here you can toggle between a
closed spline and a open spline.

Switch Direction
Switch direction switches the direction of the spline.

Set Handle Type
Here you can set the type of the spline handles. The different handle types gives you more
control about the shape of the spline.

Last Operator Set Handle Type
Type
A dropdown box where you can again set the handle type.

Clear Feather Weight
With Scale feather in the Mask Transform menu you can scale the feather points. With Clear feather weight you
can reset this scaling to default.

Animation section
Insert Key
Inserts a shape key to the selected spline points().
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Clear Key
Removes a shape key from the selected spline points().

Reset Feather Animation
Resets feather weights at all selected points animation values.

Re Key Shape Points
Recalculate the animation data on selected points for the selected frames in the dope sheet.

Mask Mode - Properties Sidebar - Mask Settings Panel
Here you can adjust the start and endframe for the mask.

Mask Mode - Properties Sidebar - Mask Layers Panel
Here you handle the mask layers and their settings. You can have more than one mask layer in a mask. And they
can be blended in different ways.
Layers can be used to create complex shapes and to define how the splines
interact with each other. Splines belonging to the same layer can be animated
together,

List Box
The list of currently existing Mask layers.
Double clicking at a name allows you to rename the mask layer.

The eye icon allows you to hide this specific layer.
The arrow icon allows you to make this layer unselectable.
The camera icon allows you to make this layer not to render.

Add / Remove Layer
Here you can add a new layer, and remove an existing layer.

Move Layer upwards / downwards
Here you can move the selected layer upwards or downwards the hierarchy.
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Opacity
The opacity of this layer.
The button at the right end inverts the mask in black and white.

Blend
Layers can have different blend modes. The names of the blend modes should be self
explaining.

Falloff
The falloff mode for the feather spline.

Overlap
Calculate self intersections and overlap before filling.

Holes
Calculate holes when filling overlapping curves.

Mask Mode - Properties Sidebar - Mask Display Panel
Here you can find some display options for the masks.

Smooth
Display the spline lines smoothed.

Edge Draw Type
How to draw the spline lines.

Overlay
Displays the mask in the footage. Masked areas are white.
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Overlay Mode
Combined
Displays the footage in the mask area. Areas outside the mask are displayed black.

Alpha Channel
Displays the masked area white, the rest black.

Mask Mode - Properties Sidebar - Active Spline Panel
Here you can find some settings for the active mask spline.

Feather Offset
The offset method for the feather spline.

Weight Interpolation
The type of weight interpolation for this spline.

Cyclic
Is it a closed spline or one with two ends.

Fill
Make this spline filled.

Self Intersection Check
Prevent the feather spline from self intersecting.

Mask Mode - Properties Sidebar - Active Spline Panel
This panel content appears when you parent a spline to a marker. Here you can see
and adjust the parent relationship for the currently active spline point.

Parent
The parent footage.

Point Track / Plane Track
The parent type. If you use point tracking here, or plane tracking.
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Object
The tracking object. Usually the camera.

Track
The track / marker where this spline point is parented at.

Graph Editor Introduction
The Graph editor is the place where you can see and deal with the function curves of the recorded tracks.
There are not this much tools to find. And there is no Tool Shelf and no Properties Sidebar. The functionality is
focused at the function curves.
The function curves shows you the speed of the trackers at the given frames. A function curve is made of a
green curve and a red curve. The red curve represents the horizontal movement of a marker. The green curve
the vertical moveoment. The first frame will always be at zero.
When you have performed a camera resolve then you will see a blue line. The blue line is the average per frame
error. It is not editable. This line should be as flat as possible. The high points will show you the inaccurate
tracking areas.
Frames outside of scene frame range are darkened.

Graph Editor general navigation
You need to use the right mouse button to move the frame slider here. The left mouse button is used to select
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marker points.
To scroll in and out in the viewport you can use the scroll wheel. Or the + and - Buttons at the Numpad.
Panning the viewport happens with middle mouse button.

Graph Editor - View Menu
Show Seconds
This affects the scrolling bar below the view. You can display the values
at it in frame units, or in second units.

Lock Time to Other Windows
Synchronizes the frame position of the Motion tracking editors. That way these editors shows the
identical part of the time you work on. When you scrub to frame 90 here, then in the other editors the
marker scrubs to frame 90 too.

Center Current Frame
Centers the view at the current frame.

View All
Fits the view of the function curves into the window.

Duplicate Area into new Window
Duplicate Area into New Window makes the selected editor
window floating. You can then drag it around at the monitor.
A separated window cannot be merged into the main window
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Toggle Full screen Area
Displays the editor maximized without menus.
To return from the full screen view press hotkey Alt F10, or use
the little button that appears up right when you move the mouse in

Toggle Maximize Area
Displays the editor maximized with menus.
To return to split view press hotkey Ctrl Up Arrow, or reuse the
menu item in the View menu.

Graph Editor - Select Menu
Border Select
Border select enters the Border Select mode. This is a special select mode where you can
select elements by dragging a rectangle. And what's inside of the rectangle gets selected
then. It adds to selection by default.
To subtract from selection hold down Shift key.
The selection gets applied when you release the mouse. You leave the mode automatically when you release the
mouse.

(De)select All Markers
Here you can select or deselect all markers of the currently selected tracks.

Inverse
Inverts the selection.
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Graph Editor - Graph Menu
Note, selecting a track and its curve is done in the Dopesheet Editor.

Delete Curve
Deletes the selected curve(s). The track gets deleted.

Delete Knot
Deletes the selected knot(s) of the curve(s).

Clear Track Path Remained
Deletes the knots and track part after the current frame position.

Clear Track Path Up To
Deletes the knots and track part before the current frame position.

Clear Track Path All
Deletes the track.

Disable Markers
Disables the markers.

Translate
Move the selected knot points.

Resize
Scale the selected knot points along the Y axis

Rotate
Rotates the selected knot points along the center of the selection. The knot points will go up or downwards.

Graph Editor - Header Tools
Show Selected
Just display the function curve from the selected track(s).
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Display Hidden
Include channels from objects or bones that aren't visible.

Filters
The filter section allows you to show or hide different kind of function curves.

Show Frames
Show curve for per frame average error for the selected track(s). This one requires to have a camera resolve
first. The color is blue.

Show Track Motion
Displays the speed curves for the markers of the selected track(s). Red is X Direction. Green is Y direction.

Show Track Error
Display the reprojection error curve for the selected track(s). The color is blue like for the frame average error
curve.

Dopesheet Editor - Intro
Dopesheet Editor
The Dopesheet Editor is the place where you deal with the keyframes for the tracks. The possibilties are
limited. Adding or deleting keyframes is done in the Clip editor, by tracking.
In the left row you will see the tracks. In the right row the keyframes.
You can select or deselect tracks by clicking at them.

Tracks can be locked. The lock symbol in the left row besides the track name. Locked tracks can't be edited
anymore.
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Dopesheet Editor general navigation
You can move the frame slider with the left mouse here.
To scroll in and out in the viewport you can use the scroll wheel. Or the + and - Buttons at the Numpad.
Panning the viewport happens with middle mouse button.

Dopesheet Editor - View menu
Show Seconds
This affects the scrolling bar below the view. You can display the values
at it in frame units, or in second units.

Lock Time to Other Windows
Synchronizes the frame position of the Motion tracking editors. That way these editors shows the
identical part of the time you work on. When you scrub to frame 90 here, then in the other editors the
frame slider also goes to this position.

Duplicate Area into new Window
Duplicate Area into New Window makes the selected editor
window floating. You can then drag it around at the monitor.
A separated window cannot be merged into the main window

Toggle Full screen Area
Displays the editor maximized without menus.
To return from the full screen view press hotkey Alt F10, or use
the little button that appears up right when you move the mouse in
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Toggle Maximize Area
Displays the editor maximized with menus.
To return to split view press hotkey Ctrl Up Arrow, or reuse the
menu item in the View menu.

Dopesheet Editor - Header Tools
Dopesheet Sort Field
Here you can sort the list of tracks by different methods.

Invert
This functionality is connected to the sort field. It inverts the list of tracks.
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Editors - Text Editor
Text Editor...............................................................................................................................................................1

Text Editor
Bforartists has a Text Editor among its windows types, accessible via the Window type menu. It is mainly used
to write Python scripts, and so the functionality orients towards this useage.
The newly opened Text window has a very simple toolbar (Text Toolbar).

Text Toolbar.

From left to right there are the standard Window type selection button and the window menus. Then there is the
Text ID Block browse button followed by the New button for creating new Text files. Once you click it, you
will find that the Toolbar has changed.. for good!

Text Toolbar with a file open

Now you find a textbox to change name of your text file, followed by + button to create new files. To remove
the text block, click the X button.
The following three buttons toggle display of line numbers, word-wrap text and syntax highlighting
respectively.
Typing on the keyboard produces text in the text buffer. As usual, pressing dragging and releasing LMB selects
text.
To delete a text buffer just press the X button next to the buffer’s name, just as you do for materials, etc.
It is worth noticing that Bforartists comes with a fully functional Python interpreter built in, and with a lots of
Bforartists-specific modules, as described in the API references.
The Text Editor has now also some dedicated Python scripts, which add some useful writing tools, like a
class/function/variable browser, completion... You can access them through the File / Template menu entry.
Some functionality can also be found in the tool shelf at the left.
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Tip
Usages for the Text window
The text window is handy also when you want to share your .blend files with others. A Text window can be
used to write in a README text explaining the contents of your blend file. Be sure to keep it visible when
saving!
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Text Editor
The Text Editor is mainly used to write scripts. And so the functionality orients towards this useage. But you
can also use it to store some notes for the scene. See Tip below.
When you don't have a file loaded then the header content is rather small.

Once you create a new file, or load a file, you will see the toolbar change, and reveal further functionality.

Some text related functionality can also be found in the tool shelf at the left.
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Tip
A Text window can be used to write in a README text explaining the contents of your blend file. Be sure to
keep it visible when saving! And be sure to tell the receiver to activate Load UI to display the text file then.
Bforartists has Load UI deactivated by default.

Header - File Menu
The File menu contains the load and save functionality. But also some
Python and OSL templates.

New Text
Creates a new text file.

Open Text
Open a text file.

Reload
It can happen that you work with an external script editor, like Visual Studio, and change your script there. The
reload button reloads the text file from hard disk.

Save
Saves the text file. Overwrites the existing version immediately.

Save As
Save as opens a save as file dialog.

Run Script
This button is for python or OSL scripts. It executes the script.

Templates
The Templates category contains some example
scripts. There are two kind of templates. Python
scripts and Open Shading Language scripts. The
name of the files should tell you what the script
is good for.
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Header - View Menu
The View menu contains some view related functionality.

Properties
Opens or closes the Properties sidebar.

Top of File
Jumps to the top of the text file.

Bottom of File
Jumps to the bottom of the text file.

Duplicate Area into New Window
Duplicate Area into New Window makes the selected editor
window floating. You can then drag it around at the monitor.
A separated window cannot be merged into the main window
again. You have to close it when not longer needed.

Toggle Full screen Area
Displays the editor maximized without menus.
To return from the full screen view press hotkey Alt F10, or use
the little button that appears up right when you move the mouse in
this corner.

Toggle Maximize Area
Displays the editor maximized with menus.
To return to split view press hotkey Ctrl Up Arrow, or reuse the
menu item in the View menu.
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Header - Edit Menu
The Edit menu contains tools to modify the text.

Undo
Undoes the last operation

Redo
Redoes the undone operation.

Cut
Cuts the selected text.

Copy
Copies the selected text.

Paste
Pastes copied text at Textcursor position.

Duplicate Line
Duplicates the line where the Textcursor currently is.

Move Line up
Moves the line where the Textcursor is one line up.

Move Line down
Moves the line where the Textcursor is one line down.

Select all
Selects all text.

Select Line
Selects the line where the Textcursor currently is

Select Text
Select text is a sub menu that contains selection
functionality, starting from the current position of the
Textcursor. The buttons should be self explaining.
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And usually you use the hotkeys for this functionality.

Delete
Delete is a sub menu with some special Delete
methods, starting from the current position of the
Textcursor. And usually you use the hotkeys for this functionality.

Jump
Go to Line number ... . This tool opens a sub menu where you can type in the line
number.

Find
Find opens the Tool Shelf, where you can find a search panel. The search panel is explained
in the tool shelf chapter.

Text: Auto Complete
Auto Complete tries to complete your text input.
This feature is currently broken, and will most probably lead to crashes. Don't use it!

Text to 3D Object
Text to 3D Object converts the text of the file to a
editable 3D object in the 3D Viewport.

One Object
Converts the whole text into one object.

One Object Per Line
Converts every line of the text into a separate object.

Header - Tools
The Headertools provides you with quick access functionality.

Header Tools without a text file loaded
Text File Browser Dropdown box
This list is empty when no file is loaded.
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New
Creates a new text file

Open
Opens a file browser where you can choose a file to load.

Show Line Numbers, Wrap and Syntax Highlight
See below.

Header Tools with a text file loaded

Text File Browser Dropdown box
This list shows you the currently loaded text files.

Text File Browser Edit Box
The edit box allows you to rename the currently active text file.
The + Button behind allows you to create a new text file.
The Button with the folder at it calls a file browser where you can load files.
The X button at the end unlinks the text file, means it deletes it from the Text file browser list.

Show Line Numbers, Wrap and Syntax Highlight
Show Line numbers dislpays a row of numbers at the left side of the text file.
Wrap words wraps the text to fit into the current editor size.
Syntax highlighting colors text parts fitting to the language.

Run Script
This button is for python or OSL scripts. It executes the script.

Register
This checkbox is for Python or OSL Scripts. When checked the classes of the script gets registered in
Bforartists.
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Info String
Shows infos about the current text file. When it's an internal created file then it displays the String File :
Internal. When it's an external loaded file, then the string displays the path to the location of the file.

Tool Shelf
The Tool Shelf is the place for some options and the text search panel.

Properties Panel
Highlight
Highlights the line where the textcursor is.

Live Edit
Updates the script while editing.

Font Size
The font size for the text editor

Tab width
Number of spaces to display tabs with. Default is four.

Tabs as spaces
When you press tab and Tabs as spaces is active, then it gets indented as a tab indent. When Tabs as spaces is
unticked, then a tab just acts like pressing a spacebar.

Show Margin
Shows a dotted line at the right. Note that we have curerntly a
theming problem here with the default Bforartists theme. We have
white text, means a white dotted line. And we have a white
background. This means that the dotted line just shows with other
themes where the header text color is black.

Margin Column
The width from the left at which the dotted margin line should show.
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Find Panel
In the find panel you will find tools with text search and replace functionality.

Find Edit Box
Here you can type in the string that you want to search.

Find set selected
Copies the currently selected text into the Find edit box, searches for a matching string in the text, and selects
this match then.

Find Next
Searches for the next matching string in the text.

Replace Edit Box
Here you can type in the string that you want to replace in the text.

Replace set selected
Copies the currently selected text into the Find edit box, searches for a matching string in the text, and replaces
this match with the string in the Replace edit box.

Replace Next
Searches for the next matching string in the text. And replaces it the string in the Replace edit box.
Note
By default when the search does not find a matching string anymore in the text below the
current selection, then you will get a warning that the search string is not present in the
text file. It will not automatically start the search from the top again. You have to place the
text cursor manually at the top of the text.
Or turn on the Wrap checkbox below.

Match case
When ticked then the search is Upper case sensitive.

Wrap
Starts the search from the top of the document when the search has reached the end of the document.
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All
Search in all opened Textfiles, not just the currently active one.
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Node Editor

1

Bforartists Reference Manual - © Copyright - This page is under OCL license

The node editor

The node editor is used to work with node-based dataflows.
Navigating the node editor is done with the use of both mouse movement and keyboard shortcuts.
Pan (MMB)
Move the view up, down, left and right
Zoom (Ctrl-MMB/Wheel)
Move the camera forwards and backwards

Node Tree Types
Bforartists has a number of different node tree types:
• Compositing Nodes
• Texture Nodes
• Material Nodes (Bforartists Internal, Cycles)
The node tree type can be changed using the buttons in the node editor header.

Regions of the Node Editor
Toolshelf
The toolshelf is a context-sensitive region, natively containing tools for the grease pencil and buttons for adding
nodes. The toolshelf is organized using tabs.
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Properties Region
The properties region contains properties for the current selected node as well as node editor specific settings.

Header
The header contains various menus, buttons and options, partially based on the current node tree type.

Editor
By default, the header, when first displayed, is uninitialized as shown:

Default Node Editor Header

Activating Nodes
What nodes to use?
• If you want to work with a material node map, click the ball in the Material/Compositing node set
selector.

Node Editor for Materials

• If you want to work with a compositing node map, click the overlaped pictures on the
Material/Compositing node set selector.

Node Editor for Compositing

• If you want to work with a texture node map, click the checker on the Material/Compositing node set
selector.

Node Editor for Texturing

To actually activate nodes, click the Use Nodes button.

Node Editor Window Actions
When the cursor is in the window, several standard Bforartists hotkeys and mouse actions are available,
including actions like delete or box select.

Node Editor Header
On the window header, you will see header options:
3
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View
This menu changes your view of the window.
Select
This menu allows you to select a node or groups of nodes, and does the same as typing the hotkey to
select all A or start the border select B process.
Add
This menu allows you to add nodes.
Node
To do things with selected nodes, akin to vertices.
Material, Compositing or Texture buttons
Nodes are grouped into two categories, based on what they operate on:
• To work with Material Nodes, click on the ball,
• To work with Compositing nodes, click on the overlaped pictures,
• To work with Texture nodes, click on the checker.
Use Nodes
Tells the render engine to use the node map in computing the material color or rendering the final image,
or not. If not, the map is ignored and the basic render of the material tabs or scene is accomplished.
Use Pinned
This button tells the render engine to use pinned node tree.
Go to Parent button
This button allows you go to parent node tree.
Snap
Toggle snap mode for node in the Node Editor window.
Snap Node Element Selector
This selector provide the follow node elements for snap:
•
•
•
•

Grid (default) Snap to grid of the Node Editor window.
Node X Snap to left/right node border.
Node Y Snap to top/bottom node border.
Node X/Y Snap to any node border.

Snap Target
Which part to snap onto the target.
•
•
•
•

Closest: Snap closest point onto target.
Center: Snap center onto target.
Median: Snap median onto target.
Active: Snap active onto target.

Copy Nodes
This button allows you copy selected nodes to the clipboard.
Paste Nodes
This button allows you paste nodes from the clipboard to the active node tree.

Node Parts
All nodes in Bforartists are based off of a similar construction. This applies to any type of node. These parts
4
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include the Title, Sockets, Preview and more.

Title
The Title shows the name/type of the node. It can be overridden by changing the value of Label in the Node
section of the Properties Region N. On the left side of the title is the collapse toggle which can be used to
collapse the node this can also be done with H.

How a node appears when collapsed.

Sockets
The Sockets input and output values from the node. They appear as little colored circles on either side of the
node. Unused sockets can be hidden. There are two functions of sockets; inputs and outputs.
Each socket is color-coded depending on what type of data it handles.
Color (Yellow)
5
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Indicates that color information needs to be input or will be output from the node. This may or may not
include an alpha channel.
Numeric (Grey)
Indicates values (numeric) information. It can either be a single numerical value or a so-called “value
map”. (You can think of a value map as a grayscale-map where the different amount of bright/dark
reflects the value for each point). If a single value is used as an input for a “value map” socket, all points
of the map are set to this same value. Common use: Alpha maps and value options for a node.
Vector (Blue)
Indicates vector/coordinate/normal information.
Shader (Green)
Used for shaders in Cycles

Inputs
The Inputs are located on bottom left side of the node, and provide the data the node needs to perform its
function. Each input socket, except for the green shader input, when disconnected, has a default value which
can be edited via a color, numeric, or vector interface input. In the screen shot of the node above, the second
color option is set by a color interface input.

Outputs
The Outputs are located on the top right side of the node, and can be connected to the input of nodes further
down the node tree.

Preview
On some nodes this shows a preview image of how the output data for a certain channel will appear. Usually it
shows color data.
The preview can be toggled using the icon on the very top right hand corner of the node, next to the title.

How a node appears without the preview.

Settings
Many nodes have settings which can affect the way they interact with inputs and outputs. Node settings are
6
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located below the outputs and above any inputs.

An example of the controls on the chroma key node.

Using Nodes
Adding Nodes
Nodes are added in two ways to the node editor:
• By using the toolshelf which has buttons for adding nodes, organized with tabs, or
• By using the Add menu

Arranging Nodes
In general, try to arrange your nodes within the window such that the image flows from left to right, top to
bottom. Move a node by clicking on a benign area and drag it around. A node can be clicked almost anywhere
to start dragging.

Auto-offset
Auto-offset is a feature that helps organizing node layouts interactively without interrupting the user workflow.
When you drop a node with at least one input and one output socket onto an existing connection between two
nodes, auto-offset will, depending on the direction setting, automatically move the left or right node away to
make room for the new node.
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Auto-offset is enabled by default, but it can be disabled from the node editor header.
You can toggle the offset direction while you are moving the node by pressing T.
The offset margin can be changed using the Auto-offset Margin setting in the editing section of the User
Preferences.

Connecting nodes
LMB-click on a socket and drag. You will see a line coming out of it: This is called a link or noodle.
Keep dragging and connect the link to an input socket of another node, then release the LMB.
While multiple links can route out of an output socket, only a single link can be attached to an input socket.
To reposition the outgoing links of a node, rather than adding a new one, hold Ctrl while dragging from an
output socket. This works for single as well as for multiple outgoing links.

Disconnecting nodes
To break a link between sockets Ctrl-LMB-click in an empty area, near the link you want to disconnect, and
drag: You will see a little cutter icon appearing at your mouse pointer. Move it over the link itself, and release
the LMB.

Duplicating a node
Click LMB or RMB on the desidered node, press Duplicate and move the mouse away to see the duplicate of
the selected node appeaing under the mouse pointer.
Note
When you duplicate a node, the new node will be positioned exactly on top of the node that was duplicated. If
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you leave it there (and it’s quite easy to do so), you can not easily tell that there are two nodes there! When in
doubt, grab a node and move it slightly to see if something’s lurking underneath.

Node Groups
Both material and composite nodes can be grouped. Grouping nodes can simplify the node network layout in
the node editor, making your material or composite ‘noodle’ (node network) easier to work with. Grouping
nodes also creates what are called NodeGroups (inside a .blend file) or NodeTrees (when appending).
Conceptually, “grouping” allows you to specify a set of nodes that you can treat as though it were “just one
node”. You can then re-use it one or more times in this or some other .blend file(s).
As an example: If you have created a material using nodes that you would like to use in another .blend file, you
could simply append the material from one .blend file to another. However, what if you would like to create a
new material, and use a branch from an existing material node network? You could re-create the branch. Or you
could append the material to the new .blend file, then cut and paste the branch that you want into the new
material. Both of these options work, but are not very efficient when working across different .blend files. A
better method of re-use, for either material node branches or composite node networks, would be to create
groups of nodes.
Once a group has been defined, it becomes an opaque object; a reusable software component. You can (if you
choose) ignore exactly how it is defined, and simply use it as many times as you like.

Grouping Nodes
To create a node group, in the node editor, select the nodes you want to include, then choose Make Group. A
node group will have a green title bar. All of the selected nodes will now be contained within the group node.
Default naming for the node group is NodeGroup, NodeGroup.001 etc. There is a name field in the node group
you can click into to change the name of the group. Change the name of the node group to something
meaningful. When appending node groups from one .blend file to another, Bforartists does not make a
distinction between material node groups or composite node groups, so it’s recommended some naming
convention that will allow you to easily distinguish between the two types.
Note
What not to include in your groups (all types of Node editors)
Remember that the essential idea is that a group should be an easily-reusable, self-contained software
component. Material node groups should not include:
Input nodes
if you include a source node in your group, you’ll end up having the source node appearing twice: once
inside the group, and once outside the group in the new material node-network.
Output node
if you include an output node in the group, there won’t be an output socket available from the group!
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Editing Node Groups
With a group node selected, Tab expands the node to a window frame, and the individual nodes within it are
shown. You can move them around, play with their individual controls, re-thread them internally, etc. just like
you can if they were a normal part of your editor window. You will not be able, though, to thread them to a
node outside the group; you have to use the external sockets on the side of the group node. To add or remove
nodes from the group, you need to ungroup them.

Ungrouping Nodes
The Ungroup command removes the group and places the individual nodes into your editor workspace. No
internal connections are lost, and now you can thread internal nodes to other nodes in your workspace.

Appending Node Groups
Once you have appended a NodeTree to your .blend file, you can make use of it in the node editor by pressing
Add ‣ Group, then select the appended group. The “control panel” of the Group is the individual controls for
the grouped nodes. You can change them by working with the Group node like any other node.
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Editors - Properties Editor
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Documentation....................................................................................................................................................3

Properties Editor
The Properties Editor is used to edit data and properties for the Active Scene and the Active Object. It also
contains lots of other functionality that you would expect to find in separate settings. Rendersettings. Materials,
particle settings and and and.

The Properties Editor with the Mesh tab selected.

Contexts
The Properties (or Buttons) Window shows several Contexts, which can be chosen via the icon row in the
header.

Scene / Render
These tabs are used to add features, and to change properties for the Active Scene.

1
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Scene / Render tabs.

Render
Everything related to render output (dimensions, anti-aliasing, performance etc).
Render Layers
Render Layers and Passes.
Scene
Gravity, Units to use, Keying Sets, Color Management, Audio settings, Physics, and scene simplification
options.
World
Environmental lighting, sky, mist and Ambient Occlusion.

Object Data
These tabs are used to add features, and to change properties for the Active Object (and other active elements,
material, curve... etc).

Object Data tabs.

The Object Data tabs shown depend on what type of object was selected last (The Active Object).
Features unique to the object type are usually added to the Data and Bone tabs, highlighted in yellow.
Object
Transformations, display options, visibility settings (via layers) duplication settings and animation
information (regarding Object position).
Constraints
Used to control an Object’s transform (position, rotation, scale), tracking and relationship properties.
Modifiers
Array, Mirror, Subdivision Surface, Armature, Cast.
Object Data
Settings for the objects data, depending on the Object Type.
Bone
Armature Bone settings.
Bone Constraints
2
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Armature Bone constraints.
Materials
Properties of the surface (color, specularity, transparency, etc).
Textures
Used by materials, world and brushes to provide additional details.
Particles
Hair and Emitter particles.
Physics
Properties relating to Cloth, Force Fields, Collision, Fluid and Smoke Simulation.

Documentation
Rendering is mainly documented in its own section, there is also information on materials and textures.
• Render
Scene features are mainly documented in the data-system, though some tools are added to different sections.
• Scenes
• Keying Sets
The Object features are usually documented in the ‘Objects’ part of the 3D Viewport Section.
• Modeling
The other features each have their own section in the manual.
•
•
•
•

Constraints
Modifiers
Particles
Physics
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Editors - Outliner
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Searching............................................................................................................................................................4
Filtering the display............................................................................................................................................4

Outliner

The Outliner window.

The Outliner is a list that organizes data in your scene. In the outliner, you can:
•
•
•
•
•
•
•
•
•

View the data in the scene.
Select and deselect objects in the scene.
Hide or show an object in the scene.
Enable or disable selection (to make an object “unselectable” in the 3D View).
Enable or disable the rendering of an object.
Delete objects from the scene.
Unlink data (equivalent to pressing the X button next to the name of a data-block).
Easily select which render layer to render.
Easily select which render pass to render (for example, you can choose to render just the Specular pass).

Using the Outliner
Each row in the Outliner shows a data-block. You can click the plus-sign to the left of a name to expand the
current data-block and see what other data-blocks it contains.
1
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You can select data-blocks in the Outliner, but this won’t necessarily select the data-block in the scene. To
select the data-block in the scene, you have to activate it.

Selecting and Activating
Single selection doesn’t require any pre-selection: just work directly with LMB (and/or RMB - contextual menu,
see below) inside the name/icon area.
When you select an object in the list this way, it is selected and becomes the active object in all other 3D Views.
Use this feature to find objects in your 3D View, select them in the Outliner, then zoom to them with View ‣
Show Active or NumpadPeriod.
Activating a data-block
Activate the data-block with LMB on the icon of the data-block. Activating the data-block will
automatically switch to the relevant mode. For example, activating the mesh data of the cube will select
the cube and enter Edit mode while activating the object data of the cube will select the cube and enter
Object mode (see right).

Toggling pre-selection of a data-block.

Toggle pre-selection of a group of data-blocks
Useful when you want to select/deselect a whole bunch of data-blocks. For this you must prepare the
selection using, to your liking:
• RMB or LMB,
• Shift-RMB or Shift-LMB,
• RMB and drag or LMB and drag,
all outside the name/icon area. Those pre-selected have their line in a lighter color. You then can
(de)select them with a RMB on the name/icon area, which brings on a context menu (see bellow).
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Context menu
Right click at an item and you will see the context menu. Depending on the type of the pre-selected datablock(s), you will have a different set of options.

Note
Some data-block types will not have a context menu at all!

Toggling object-level restrictions
The three following options, in the right side of the Outliner window, are only available for
objects:
Visibility (eye icon)
Toggles the visibility of the object in the 3D View. V will toggle this property for any
objects that are selected in the Outliner.
Selectability (mouse cursor icon)
This is useful for if you have placed something in the scene and don’t want to accidentally
select it when working on something else. S will toggle this property for any objects that
are selected in the Outliner.
Rendering (camera icon)
This will still keep the object visible in the scene, but it will be ignored by the renderer.
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Searching
You can search the file for data-blocks by using
the Search menu in the header of the Outliner
Matching data-blocks will be automatically
selected.

Filtering the display
The window header has a field to let you select what the outliner should show to help you narrow the list of
objects so that you can find things quickly and easily.
All Scenes
Shows everything the outliner can display (in all scenes, all layers, etc.)
Current Scene
Shows everything in the current scene.
Visible Layers
Shows everything on the visible (currently selected) layers in the current scene. Use
the layer buttons to make objects on a layer visible in the 3D window.
Selected
Lists only the object(s) currently selected in the 3D window. You can select multiple
objects by Shift-RMB -clicking.
Active
Lists only the active (often last selected) object.
Same Types
Lists only those objects in the current scene that are of the same types as those selected
in the 3d window.
Groups
Lists only Groups and their members.
Libraries
TODO *
Sequence
TODO *
Data Blocks
TODO *
User Preferences
TODO *
Key Maps
TODO *

*Thank you Blender devs for not having a complete manual after 20 years ...
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Editors - Info Editor
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Info Editor

Info Window

The Info Editor is found at the top of the Default Scene. It contains the default file menu. And has the following
components:
Menu options
The menus provides access to the main menu options.
Current Screen (default is Default)
The dropdown box allows you to select different Screens. By default, Bforartists comes with several preconfigured Screen s for you to choose from. If you need custom screen layouts, you can create and name
them.
Resource Information
The information string ives you information about the current scene. This region will tell you how much
memory is being consumed based on the number of vertices, faces and objects in the selected scene, as
well as totals of what resources are currently selected. This can help identify when you are reaching the
limits of your hardware.
Message area

The toolbar also contains an message area. When there is a warning or an error, then it will pop up
besides the Current Screen dropdown box. But also a progressbar can be found here.

Info Area
The info editor is not just a file menu
bar for the standard layout. It also has a
Info are, which brings a list of the last
used commands as Python commads.
This is useful for programming needs.
When you write a plugin for example.
Or when you want to automatize a
task.
To access this Info area simply drag down the menu bar a bit. Or switch to the Scripting layout. There you can
see this area open by default.
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Editors - File browser
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File Browser

Usage
The file browser has multiple uses, while its often used for save/load, it can be kept open for other uses too.
Use cases include:
•
•
•
•

Opening and Saving Blend files.
Import/Export other file formats.
Picking new locations for existing file-paths (images, video’s, fonts... etc).
Browsing inside other .blend files, when using Append and Link.

You can also keep the file selector open, as with any other window type. In this case the buttons to load a files
is removed.
The main purpose of this is to be able to drag media files.
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• Images into the Video Sequence Editor (to set background or apply as material textures).
• Media files into the Video Sequence Editor.

Interface
Toolbar
The left sidebar displays different ways to find files and several options.
System
The system menu contains a list of drives that are available to navigate through to find files. Click on one
to jump to that drive.
Bookmarks
These are folders that you want to be able to access often without having to navigate to them in the file
browser. To add a directory to the bookmark menu, navigate to that folder, then click the Add button. To
remove a folder from the list, simply click the X icon next to it.
Recent
This is a list of recently accessed folders. You can control how many folders appear in this list by going to
the File tab of the User Preferences, in the box labeled Recent Files.

Header
The Header contains several tools for navigation of files. The four arrow icons allow you to:
•
•
•
•

Move to previous folder
Move to next folder
Move up to parent directory
Refresh current folder

Create a new folder inside the current one by clicking the Create New Directory button.
The other icons allow you to control what files are visible and how they are displayed. You can:
• Display files as a short list
• Display files as a detailed list
• Display files as thumbnails
Hint
Along with all supported image & video formats, thumbnails for fonts and .blend are displayed too.

You can sort files:
•
•
•
•

Alphabetically
By file type
By Date of last edit
By file size

Click the funnel icon to toggle which file types are shown:
• Folders
2
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•
•
•
•
•
•
•

Blend files
Images
Movie files
Scripts
Font files
Music files
Text files
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File Dialog navigation........................................................................................................................................9

File Browser

The file browser is a explorer dialog that allows you to browse for locations and files, and allows you to load
and save them.
The file browser has multiple uses. While its often used for save/load, it can be kept open for other uses too.
Use cases include:
•
•
•
•

Opening and Saving Blend files.
Import/Export other file formats.
Picking new locations for existing file-paths (images, video’s, fonts... etc).
Browsing inside other .blend files, when using Append and Link.

You can also keep the file selector open, as with any other window type. In this case the buttons to load files is
removed. The main purpose of this is to be able to drag media files.
• Images into the Video Sequence Editor (to set background or apply as material textures).
2

Bforartists Reference Manual - © Copyright - This page is under OCL license

• Media files into the Video Sequence Editor.

Back to Previous
Once you open the file browser you will see a "Back to
Previous" Button in the header of the Info Editor. This allows
you to leave the File Browser when you decide not to load or
save. The same can of course be done with the Cancel button.

Header tools
There are several tools in the header to find. The range goes from navigation elements across filters up to
display options. Some defaults differs, dependant of what file format you try to load or to save.

Editor Type menu
Allows you to change the editor type from File Browser to another editor type.
Note
This menu is required when you build layouts. You can for example incorporate the file browser into a layout
as a drag n drop location for your movies.
In a callable file browser it's a bit disturbing, and should be hidden. But there is unfortunately no way to hide it
by default since when you call the file browser then you create the editor type from scratch, with this menu
showing.This means we have to live with this menu here.

Folder Navigation
Previous Folder
Navigates to the previous folder location

Next Folder
Navigates to the next folder location. This just works when you had Previous folder clicked before.
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Parent File
Moves one upwards in the explorer hierarchy

Refresh List
Refreshes the file list. This is useful when you did some modifications at the folder content outside of the file
browser.

Create new Directory
Creates a new folder inside of the currently selected directory.

Recursion
Recursion is a dropdown menu where you can adjust how deep the explorer should dig.
Normally it just lists the content of the currently selected directory. But it is also possible to list
the content of the folders three levels lower.
The recursion direction is always downwards. Default is None.

None
Just the matching content of the current directory is showing.

One Level, Two Levels, Three Levels
The matching content of the current directory is showing, plus the content of possible subfolders, defined by
how deep the search should go.

Display mode for File List
There are three methods to display the content of the folders.

Short List
Displays the content of the file browser as a short list. Just File
name and size gets displayed.

Long List
Displays the content of the file browser as a list.
Besides Filename and Size also the create date gets
displayed.
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Thumbnails
Displays the content of the file browser as
thumbnails. This is especially for images of
use.

Display Size
Here you can adjust how big the directory content gets displayed.

Sort Method
Here you can adjust how the directory list gets sorted.

Alphabetically
Sorts the content by its name.

By Extension Type
Sorts the content by the extension type.

By Modification Time
Sorts the content by date.

By Size
Sorts the content by size.

Show hidden Dot Files
This is a Unix feature. Unix systems like Linux or Mac hides files from file browsers and explorers by
having a dot before the file. A good example is the .htaccess file at servers. Show hidden Dot Files
makes such files visible to the file browser.

Filtering
You can filter the content of the file
browser in various ways. The defaults differs, dependant of what you want to load or to save.
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Enable Filtering of Files
This is the button that enables or disables filtering at all.

Show Folders
Display folders.

Show Blend files
Display Blend files.

Show Blend1, Blend2, Blend3, etc. files
Display blender backup scenes. Blender creates sometimes backups with the file ending with an increasing
number at the end. blend1 for example.

Show Image files
Display image files.

Show Movie Files
Display movie files.

Show Script files
Display script files

Show Font files
Display font files.

Show Sound files
Display sound files.

Show Text files
Display text files.

Filter by string
Here you can filter the results in the file browser by a string.
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Tool Shelf
The Tool Shelf provides you with some panels for quick access to files and bookmarks.

System Panel
Lists your drives.

System Bookmarks
Lists some system libraries.

Bookmarks
Here you can add your own bookmarks.

Recent
A list of the recent accessed folders.
Greyed out folders are not longer existing directories. There is unfortunately no
way to remove them from within Bforartists. You would need to do this manually
in the History text files in the settings folder.
Under Windows this is the bookmarks.txt file in the Appdata folder.
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Import Export Settings
At the lower half of the Tool Shelf you will find the special Import or Export
settings for the current file format. For a Blend file you will just see two entries.
For file formats like FBX you wil find plenty of settings.
As an example, and to explain the two settings for loading a blend file:

Load UI
Bforartists comes with the feature *Load UI* unticked. This means the Bforartists UI will not change when you
load a scene. Here you can temporary enable to load the scene with the layout and UI arrangement in which the
scene was saved.

Trusted Source
With Load UI you can also load script files, which can execute. This is a potential security risk when the file
comes from an unknown source.

File dialog
The file dialog is the actual place where
your files and directories gets listed.

Path edit box
Here you can see and edit the full path to the file. And here you can set or modify it manually too. But usually
you will use the navigation elements in the tool shelf. Or navigate by clicking at the folders and items in the list.

Open / Save Button
Execute loading or saving. For file loading, you can also double click at the file in the list to open it.

File edit box
Here you can read the file name. When you save a file, then this is the place to insert your needed file name.

+ and - Buttons behind File Edit box
This feature is of interest when you want to save a file with increasing number. The + button adds a increasing
number at the end of the file name. The - button decreases this value. This means when you have a file with no
number at the end, like cube, then the name changes to cube1. When the name is cube1, and you press the +
button, then the name changes to cube2. When the file name is cube2, and you press the + button, then the file
8
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name changes to cube3. And so on.

The red color indicates that a file with this name already exists.

Cancel Button
Cancel the load or save action completely. The file dialog will close.

File Dialog navigation
Usually you move one hierarchy downwards by simply clicking at the folder in the
list that you want to explore.

So when i click at "mysubfolder" here, then we will enter this folder. And its
content gets displayed. As you can see, the path has changed. We are now in the
subfolder directory.
A double click at the mycube.blend file will open the file then.
There is also a way to navigate upwards. It's the arrow button in the list. A click at
it, and we are back at the parent directory.

9

Bforartists Reference Manual - © Copyright - This page is under OCL license

Editors - Python Console
Python Console........................................................................................................................................................1
Menus......................................................................................................................................................................1
Console Menu.....................................................................................................................................................1
Edit Menu...........................................................................................................................................................1
Usage.......................................................................................................................................................................2
Accessing Built-in Python Console...............................................................................................................2
First look at the Console Environment..........................................................................................................2
Auto Completion at work...............................................................................................................................2
Before tinkering with the modules.................................................................................................................3
Examples.................................................................................................................................................................4
bpy.context.....................................................................................................................................................4
Try it out!...................................................................................................................................................4
bpy.data..........................................................................................................................................................5
Try it out!...................................................................................................................................................5
Exercise.....................................................................................................................................................5
bpy.ops...........................................................................................................................................................6
Try it out!...................................................................................................................................................6

Python Console
The Python console is a quick way to execute commands, with access to the entire Python API, command
history and auto-complete.
Its a good way to explore possibilities, which can then be pasted into larger scripts.

Menus
Console Menu

Edit Menu

The Console menu provides you with the text operation The Edit menu provides you with the usual navigation
and window tools.
tools.
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Usage
Accessing Built-in Python Console

From the screen shot above, you will notice that by clicking at the Autocomplete button you can enable Autocomplete feature.
The command prompt is typical for Python 3.x, the interpreter is loaded and is ready to accept commands at the
prompt >>>

First look at the Console Environment
To check what is loaded into the interpreter environment, type dir() at the prompt and execute it.

Following is a quick overview of the output
C
Quick access to bpy.context
D
Quick access to bpy.data
bpy
Top level Bforartists Python API module.
The rest of the commands are of various content. Most of them are mathematical expressions.

Auto Completion at work
Now, type bpy. and then press the Autocomplete button, and you will see the Console auto-complete feature in
action.
2
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You will notice that a list of sub-modules inside of bpy appear. These modules encapsulate all that we can do
with Bforartists Python API and are very powerful tools.
Lets list all the contents of bpy.app module.

Notice the green output above the prompt where you enabled auto-completion. What you see is the result of
auto completion listing. In the above listing all are module attribute names, but if you see any name end with
‘(‘, then that is a function.
We will make use of this a lot to help our learning the API faster. Now that you got a hang of this, lets proceed
to investigate some of modules in bpy.

Before tinkering with the modules..
If you look at the 3D Viewport in the default Bforartists scene, you will notice some objects. We have added a
cube here too.
•
•
•
•

All objects exist in a context and there can be various modes under which they are operated upon.
At any instance, only one object is active and there can be more than one selected objects.
All objects are data in the Bforartists file.
There are operators/functions that create and modify these objects.

For all the scenarios listed above (not all were listed, mind you..) the bpy module provides functionality to
access and modify data.

3
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Examples
Note
For the commands below to show the proper output, make sure you have selected object(s) in the 3D view.

bpy.context

Try it out!
bpy.context.mode
Will print the current 3D View mode (Object, Edit, Sculpt etc.,)
bpy.context.object or bpy.context.active_object
Will give access to the active object in the 3D View
>>> bpy.context.object.location.x = 1

Change x location to a value of 1
4

Bforartists Reference Manual - © Copyright - This page is under OCL license
>>> bpy.context.object.location.x += 0.5

Move object from previous x location by 0.5 unit
>>> bpy.context.object.location = (1, 2, 3)

Changes x, y, z location
>>> bpy.context.object.location.xyz = (1, 2, 3)

Same as above
>>> type(bpy.context.object.location)

Data type of objects location
>>> dir(bpy.context.object.location)

Now that is a lot of data that you have access to
bpy.context.selected_objects
Will give access to a list of all selected objects.
>>> bpy.context.selected_objects

... then press Ctrl-Spacebar
>>> bpy.context.selected_objects[0]

Prints out name of first object in the list
>>> [object for object in bpy.context.selected_objects if object != bpy.context.object]

Complex one... But this prints a list of objects not including the active object

bpy.data
bpy.data has functions and attributes that give you access to all the data in the Bforartists file.
You can access following data in the current Bforartists file: objects, meshes, materials, textures, scenes,
screens, sounds, scripts, ... etc.
That’s a lot of data.

Try it out!

Exercise
>>> for object in bpy.data.scenes['Scene'].objects: print(object.name)
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Return twice Prints the names of all objects belonging to the Bforartists scene with name “Scene”
>>> bpy.data.scenes['Scene'].objects.unlink(bpy.context.active_object)

Unlink the active object from the Bforartists scene named ‘Scene’
>>> bpy.data.materials['Material'].shadows
>>> bpy.data.materials['Material'].shadows = False

bpy.ops
The tool/action system in Bforartists 2.5 is built around the concept of operators. These operators can be called
directly from console or can be executed by click of a button or packaged in a python script. Very powerful they
are..
For a list of various operator categories, click here
Lets create a set of five Cubes in the 3D Viewport. First, delete the existing Cube object by selecting it and
pressing X

Try it out!
The following commands are used to specify that the objects are created in layer 1. So first we define an array
variable for later reference:
>>> mylayers = [False] * 20
>>> mylayers[0] = True

We create a reference to the operator that is used for creating a cube mesh primitive
>>> add_cube = bpy.ops.mesh.primitive_cube_add

Now in a for loop, we create the five objects like this (In the screenshot above, I used another method) Press
ENTER-KEY twice after entering the command at the shell prompt.
>>> for index in range(0, 5): add_cube(location=(index * 3, 0, 0), layers=mylayers)
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Python Console
The Python console is a quick way to execute commands, with access to the entire Python API, command
history and auto-complete. It's a research tool for addon- and script developers. But also a place to quickly
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execute single operators or to try out some simple code.

Console Menu
The Console menu provides some console editor window specific functionality.

Toggle Full screen Area
Displays the editor maximized without menus.
To return from the full screen view press hotkey Alt F10, or use
the little button that appears up right when you move the mouse in
this corner.

Toggle Maximize Area
Displays the editor maximized with menus.
To return to previous view press hotkey Ctrl Up Arrow, or reuse
the menu item in the View menu.

Duplicate Area into new Window
Duplicate Area into New Window makes the selected editor window floating. You can
then drag it around at the monitor.
A separated window cannot be merged into the main window again. You have to close
it when not longer needed.
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Zoom Text Out
Zooms out the text in the console window.

Zoom Text In
Zooms in the text in the console window.

Languages
Languages is a sub menu where you can choose the
language.
This menu looks pretty uselesss, since there is just one
language available. But it has its useage. With a click at the
Python button you can restart the console when you have lost
yourself in the deeps of the api.

Paste
Pastes copied content

Copy
Copies selected content.

Copy as Script
Copies the whole content of the console as a script that can be pasted into the Text editor.

Clear Line
Clears the selected line(s)

Clear
Clears all lines. The blue help text remains.

Console Execute
The expressions in the python console are not read only. You can execute them like you would do from a script.
3
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This button executes a selected command.

Edit Menu
The Edit menu provides you with text specific
functionality. Its content should be used by hotkeys.
The menu is more to show that this functionality
exists.

History Cycle
Cycles through the history. Up arrow cycles forwards through the history.
Down arrow cycles backwards through the history.
What does this mean? When you write some text, then add something more, delete something, then all this
steps are entries in the history. And with History cycle you can access this steps.

Delete
Delete is a sub menu with several delete methods.

Next character
Deletes the character beyond the caret.

Previous Character
Deletes the character before the caret.

Next Word
Deletes the word beyond the caret.

Previous Word
Deletes the word before the caret.

Cursor to Next character
Sets the caret in front of the next character.
4
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Cursor to Previous Character
Sets the caret in front of the previous character.

Cursor to Line End
Sets the caret to line end.

Cursor to Line Begin
Sets the caret to line begin.

Cursor to Next word
Sets the caret in front of the next word.

Cursor to Previous word
Sets the caret in front of the previous word.

Unindent
Removes indention of the selected text.

Indent
Indents the selected text.

Autocomplete
Autocomplete is a functionality to autocomplete what you have written in the console. It lists for example all
available bpy operators when you type in bpy.context.area. , and then hit the Autocomplete button. That way
you can go through the whole bpy hierarchy down to what you need for your code, starting with bpy. , and
having a look at what is available.
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Usage
Accessing Built-in Python Console

From the screen shot above, you will notice that by clicking at the Autocomplete button you can enable Autocomplete feature.
The command prompt is typical for Python 3.x, the interpreter is loaded and is ready to accept commands at the
prompt >>>

First look at the Console Environment
To check what is loaded into the interpreter environment, type dir() at the prompt and execute it.

Following is a quick overview of the output
C
Quick access to bpy.context
D
Quick access to bpy.data
bpy
Top level Bforartists Python API module.
The rest of the commands are of various content. Most of them are mathematical expressions.

Auto Completion at work
Now, type bpy. and then press the Autocomplete button, and you will see the Console auto-complete feature in
action.
6
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You will notice that a list of sub-modules inside of bpy appear. These modules encapsulate all that we can do
with Bforartists Python API and are very powerful tools.
Lets list all the contents of bpy.app module.

Notice the green output above the prompt where you enabled auto-completion. What you see is the result of
auto completion listing. In the above listing all are module attribute names, but if you see any name end with
‘(‘, then that is a function.
We will make use of this a lot to help our learning the API faster. Now that you got a hang of this, lets proceed
to investigate some of modules in bpy.

Before tinkering with the modules..
If you look at the 3D Viewport in the default Bforartists scene, you will notice some objects. We have added a
cube here too.
•
•
•
•

All objects exist in a context and there can be various modes under which they are operated upon.
At any instance, only one object is active and there can be more than one selected objects.
All objects are data in the Bforartists file.
There are operators/functions that create and modify these objects.

For all the scenarios listed above (not all were listed, mind you..) the bpy module provides functionality to
access and modify data.

7

Bforartists Reference Manual - © Copyright - This page is under OCL license

Examples
Note
For the commands below to show the proper output, make sure you have selected object(s) in the 3D view.

bpy.context

Try it out!
bpy.context.mode
Will print the current 3D View mode (Object, Edit, Sculpt etc.,)
bpy.context.object or bpy.context.active_object
Will give access to the active object in the 3D View
>>> bpy.context.object.location.x = 1

Change x location to a value of 1
8
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>>> bpy.context.object.location.x += 0.5

Move object from previous x location by 0.5 unit
>>> bpy.context.object.location = (1, 2, 3)

Changes x, y, z location
>>> bpy.context.object.location.xyz = (1, 2, 3)

Same as above
>>> type(bpy.context.object.location)

Data type of objects location
>>> dir(bpy.context.object.location)

Now that is a lot of data that you have access to
bpy.context.selected_objects
Will give access to a list of all selected objects.
>>> bpy.context.selected_objects

... then press Ctrl-Spacebar
>>> bpy.context.selected_objects[0]

Prints out name of first object in the list
>>> [object for object in bpy.context.selected_objects if object != bpy.context.object]

Complex one... But this prints a list of objects not including the active object

bpy.data
bpy.data has functions and attributes that give you access to all the data in the Bforartists file.
You can access following data in the current Bforartists file: objects, meshes, materials, textures, scenes,
screens, sounds, scripts, ... etc.
That’s a lot of data.

Try it out!
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Exercise
>>> for object in bpy.data.scenes['Scene'].objects: print(object.name)

Return twice Prints the names of all objects belonging to the Bforartists scene with name “Scene”
>>> bpy.data.scenes['Scene'].objects.unlink(bpy.context.active_object)

Unlink the active object from the Bforartists scene named ‘Scene’
>>> bpy.data.materials['Material'].shadows
>>> bpy.data.materials['Material'].shadows = False

bpy.ops
The tool/action system in Bforartists is built around the concept of operators. These operators can be called
directly from console or can be executed by click of a button or packaged in a python script. Very powerful they
are..
For a list of various operator categories, click here
Lets create a set of five Cubes in the 3D Viewport. First, delete the existing Cube object by selecting it and
pressing X

Try it out!
The following commands are used to specify that the objects are created
in layer 1. So first we define an array variable for later reference:
>>> mylayers = [False] * 20
>>> mylayers[0] = True

We create a reference to the operator that is used for creating a cube mesh
primitive
>>> add_cube = bpy.ops.mesh.primitive_cube_add

Now in a for loop, we create the five objects like this (In the screenshot
above, I used another method) Press ENTER-KEY twice after entering
the command at the shell prompt.
>>> for index in range(0, 5): add_cube(location=(index * 3, 0, 0), layers=mylayers)
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User Preferences
This chapter explains how to change Blender’s default configuration with the User Preferences editor.
The Blender User Preferences editor contains settings to control how Blender behaves.

Open User Preferences
To open the User Preferences editor go to File ‣ User Preferences.

Configure
Now that you have opened the User Preferences editor, you can configure Blender to your liking. At the top of
the editor, the available options are grouped into seven tabs:
Interface
Change how UI elements are displayed and how they react.
Editing
2
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Control how several tools will interact with your input.
Input
Customize how Blender reacts to the mouse and keyboard as well as define your own keymap.
Add-ons
Manage Blender’s Add-ons, allowing you to access features not built-in as well as install new features.
Themes
Customize interface appearance and colors.
File
Configure auto-save preferences and set default file paths for blend-files, rendered images, and more.
System
Set resolution, scripting console preferences, sound, graphics cards, and internationalization.

Save the new preferences
Once you have set your preferences, you will need to manually save them, otherwise the new configuration will
be lost after a restart. Blender saves its preferences to userpref.blend in your user folder (see next section,
“Load Factory Settings”, for details).
In the User Preferences editor, click on the Save User Settings button in the bottom left. This will save all of the
new preferences.

Load Factory Settings
Go to File ‣ Load Factory Settings then save the preferences via the User Preferences editor.
Hint
It can be valuable to make a backup of your preferences in the event that you lose your configuration.
See the directory layout section to see where your preferences are stored.

Startup File
Reference
Mode: All modes
Menu: File ‣ Save Startup File
When you start Blender or start a new project with the menu entry File ‣ New, a new scene is created from the
default scene included with Blender.
This default scene can instead be your own customized setup.
To change the default scene, make all of the desired changes to the current scene or current file and File ‣
Save Startup File.

Interface
Interface configuration lets you change how UI elements are displayed and how they react.
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Display
Tooltips
When enabled, a tooltip will appear when your mouse pointer is over a control. This tip explains the
function of what is under the pointer, gives the associated hotkey (if any) and the Python function that
refers to it.
Python Tooltips
Displays a property’s Python information below the tooltip.
Object Info
Display the active Object name and frame number at the bottom left of the 3D View.
Large Cursors
Use large mouse cursors when available.
View Name
Display the name and type of the current view in the top left corner of the 3D View. For example: User
Persp or Top Ortho.
Playback FPS
Show the frames per second screen refresh rate while an animation is played back. It appears in the
viewport corner, displaying red if the frame rate set cannot be reached.
Global Scene
Forces the current scene to be displayed in all screens (a project can consist of more than one scene).
Object Origin Size
Diameter of 3D Object centers in the view port (value in pixels from 4 to 10).
Display Mini Axis
Show the mini axis at the bottom left of the viewport.
Size
Size of the mini axis.
Brightness
Adjust brightness of the mini axis.

4

Bforartists Reference Manual - © Copyright - This page is under OCL license

Warnings
Prompt Quit
When exiting Blender, a pop-up will ask you weather or not you really want to quit (currently only
available on MS-Windows).

View Manipulation
Cursor Depth
Use the depth under the mouse when placing the cursor.
Auto Depth
Use the depth under the mouse to improve view pan, rotate, zoom functionality. Useful in combination
with Zoom To Mouse Position.
Zoom to Mouse Position
When enabled, the mouse pointer position becomes the focus point of zooming instead of the 2D window
center. Helpful to avoid panning if you are frequently zooming in and out.
Rotate Around Selection
The selected object becomes the rotation center of the viewport. When there is no selection the last
selection will be used.
Hint
This may seem ideal behavior, however, it can become problematic with larger objects such as a
terrain-mesh, where the center is not necessarily your point of interest.

Global Pivot
Lock the same rotation/scaling pivot in all 3D Views.
Camera Parent Lock
When the camera is locked to the view and in fly mode, transform the parent rather than the camera.
Auto Perspective
Automatically to perspective Top/Side/Front view after using User Orthographic. When disabled,
Top/Side/Front views will retain Orthographic or Perspective view (whichever was active at the time of
switching to that view).
Smooth View
Length of time the animation takes when changing the view with the numpad (Top/Side/Front/Camera...).
Reduce to zero to remove the animation.
Rotation Angle
Rotation step size in degrees, when Numpad4, Numpad6, Numpad8, or Numpad2 are used to rotate the
3D View.

2D Viewports
Minimum Grid Spacing
The minimum number of pixels between grid lines in a 2D (i.e. top orthographic) viewport.
TimeCode Style
Format of Time Codes displayed when not displaying timing in terms of frames. The format uses ‘+’ as
5
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separator for sub-second frame numbers, with left and right truncation of the timecode as necessary.
Zoom To Frame Type
How zooming to frame focuses around current frame.
Keep Range:
Seconds:
Keyframes:

Todo.
Todo.
Todo.

Manipulator
Turns manipulators on and off.
Size
Diameter of the manipulator.
Handle Size
Size of manipulator handles, as a percentage of the manipulator radius (size/ 2).
Hotspot
Hotspot size (in pixels) for clicking the manipulator handles.

Menus
Open on Mouse Over
Select this to have the menu open by placing the mouse pointer over the entry instead of clicking on it.
Menu Open Delay
Time for the menu to open.
Top Level
Time delay in 1/10 second before a menu opens (Open on Mouse Over needs to be enabled).
Sub Level
Same as above for sub menus (for example: File ‣ Open Recent).

Pie Menus
Animation Timeout
Length of animation when opening Pie Menus.
Recenter Timeout
The window system tries to keep the pie menu within the window borders. Pie menus will use the initial
mouse position as center for this amount of time, measured in 1/100ths of a second. This allows for fast
dragged selections.
Radius
Size of the Pie Menu.
Threshold
Distance from center before a selection can be made.
Confirm Threshold
Distance threshold after which selection is made (zero disables).

Splash
Show Splash
Display the Splash Screen when starting Blender.
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Editing
These preferences control how several tools will interact with your input.

Link Materials To

Example for a Mesh.
To understand this option properly, you need to understand how Blender works with Objects. Almost
everything in Blender is organized in a hierarchy of data-blocks. A data-block can be thought of as containers
for certain pieces of information. For example, the Object data-block contains information about the Object’s
location while the Object Data ObData data-block contains information about the mesh.
A material may be linked in two different ways:

A material linked to ObData (left) and Object (right).
ObData
Any created material will be created as part of the ObData data-block.
Object
Any created material will be created as part of the Object data-block.
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New objects
Enter Edit Mode
If selected, Edit Mode is automatically activated when you create a new object.
Align To
World
New objects align with world coordinates.
View
New object align with view coordinates.

Undo
Global Undo
This enables Blender to save actions done when you are not in Edit Mode. For example, duplicating
Objects, changing panel settings or switching between modes.
Warning
While disabling this option does save memory, it stops the redo panel from functioning, also preventing
tool options from being changed in some cases.
For typical usage, its best to keep this enabled.

Step
Number of Undo steps available.
Memory Limit
Maximum memory usage in Mb (0 is unlimited).

Grease Pencil
Grease Pencil permits you to draw in the 3D View with a pencil-like tool.
Manhattan Distance
The minimum number of pixels the mouse has to move horizontally or vertically before the movement is
recorded.
Euclidian Distance
The minimum distance that mouse has to travel before movement is recorded.
Eraser Radius
The size of the eraser used with the grease pencil.
Smooth Stroke
Smooths the pencil stroke after it is finished.

Playback
Allow Negative Frame
Time Cursor can be set to negative frames with mouse or keyboard. When using Use Preview Range, this
also allows playback.
8
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Keyframing
In many situations, animation is controlled by keyframes. The state of a value (e.g. location) is recorded in a
keyframe and the animation between two keyframes is interpolated by Blender.
Visual Keying
When an object is using constraints, the objects property value doesnt actually change. Visual Keying will
add keyframes to the object property, with a value based on the visual transformation from the constraint.
Only Insert Needed
This will only insert keyframes if the value of the propery is different.
Auto Keyframing
Enables Auto Keyframe by default for new scenes.
Show Auto Keying Warning
Displays a warning at the top right of the 3D View, when moving objects, if Auto Keyframe is on.
Only Insert Available
This will only add keyframes to channel F-Curves that already exist.

New F-Curve Defaults
Interpolation
This controls how the state between two keyframes is computed. Default interpolation for
new keyframes is Bézier which provides smooth acceleration and de-acceleration whereas
Linear or Constant is more abrupt.
XYZ to RGB
Color for X, Y or Z animation curves (location, scale or rotation) are the same as the color for
the X, Y and Z axis.

Transform
Release confirm
Dragging LMB on an object will move it. To confirm this (and other) transforms, a LMB is necessary by
default. When this option is activated, the release of LMB acts as confirmation of the transform.

Sculpt Overlay Color
This color button allows the user to define a color to be used in the inner part of the brushes circle when in
sculpt mode, and it is placed as an overlay to the brush, representing the focal point of the brush influence. The
overlay color is visible only when the overlay visibility is selected (clicking at the eye to set its visibility), and
the transparency of the overlay is controlled by the alpha slider located at the brush pop-up, located at the top of
the tool shelf, when in sculpt mode.

Duplicate Data
The ‘Duplicate Data’ check-boxes define what data is copied with a duplicated Object and what data remains
linked. Any boxes that are checked will have their data copied along with the duplication of the Object. Any
boxes that are not checked will instead have their data linked from the source Object that was duplicated.

9
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For example, if you have Mesh checked, then a full copy of the mesh data is created with the new Object, and
each mesh will behave independently of the duplicate. If you leave the mesh box unchecked then when you
change the mesh of one object, the change will be mirrored in the duplicate Object.
The same rules apply to each of the check-boxes in the ‘Duplicate Data’ list.

Input
In the Input preferences, you can customize how Blender reacts to the mouse and keyboard as well as define
your own keymap.

Presets
Blender lets you define multiple Preset input configurations. Instead of deleting the default keymap to create
yours, you can just add new Presets for both the mouse and keyboard. Mouse options can be found on the lefthand side of the editor and keyboard options to the right in the above picture.

Adding and deleting presets

Before changing anything in the default configuration, click on the “plus” symbol shown in the picture to add a
new Preset. Blender will ask you to name your new preset after which you can select the Preset from the list to
edit it. If you want to delete your Preset, select it from the list and then click the “minus” symbol.

Selecting presets
You can change the preset you are using by doing one of the following:
10
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• Selecting the configuration from the Interaction menu of the splash screen at startup or by selecting
Help ‣ Splash Screen.
• Selecting the configuration from the User Preferences Input tab.

Hint
Note that either of the above options will only change the preset for the current file. If you select File ‣ New
or File ‣ Open, the default preset will be re-loaded.

Setting presets to default

Once you have configured your mouse and keyboard Presets, you can make this the default configuration by:
• Opening the User Preferences Input editor and select your presets from the preset list or,
• Selecting your preset configuration from the splash screen.
• Saving your configuration using the Save As Default option from a User Preferences editor

Export/Import key configuration
In some cases, you may need to save your configuration in an external file (e.g. if you need to install a new
system or share your keymap configuration with the community). Simply LMB Export Key Configuration on the
Input tab header and a file browser will open so that you can choose where to store the configuration. The
Import Key Configuration button installs a keymap configuration that is on your computer but not in Blender.
The exported keymap will only contain keymaps and categories that have been modified by the user. In
addition, add-ons may register keymaps to their respective functions, however, these keymaps are not exported
unless changed by the user. This exported file may be thought of as a “keymap delta” instead of a full keymap
export.

Mouse
Emulate 3 Button Mouse
Blender can be configured to work with pointing devices which do not have a middle-mouse button (such
as a two-button mouse, Apple single-button mouse, or laptop touch-pad). The functionality of the three
mouse buttons will then be emulated with key/mouse button combinations as shown in the table below.
Shortcuts for supported mouse hardware¶
3-button Mouse
LMB
MMB

2-button Mouse
LMB
Alt-LMB
11
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3-button Mouse

2-button Mouse

Apple Mouse
mouse button)
RMB
RMB
Cmd-LMB (Command/Apple key
+ mouse button)
Mouse/Keyboard combinations referenced in this manual can be expressed with the combinations shown
in the table. For example:
• MMB drag becomes Alt-LMB drag.
• Shift-Alt-RMB becomes Shift-Alt-Cmd-LMB on a single-button mouse.
Continuous Grab
This feature is used to prevent the problem where an action such as grabbing or panning a view, is limited
by your screen bounds.
This is done by warping the mouse within the view.
Bemerkung
Cursor warping is only supported by relative input devices (mouse, trackball, trackpad).
Graphics tablets, however, typically use absolute positioning, this feature is disabled when a tablet is
being used
This is detected for each action, so the presence of a tablet will not disable Continuous Grab for mouse
cursor input.
Drag Threshold
The number of pixels that a User Interface element has to be moved before it is recognized by Blender.
Select with
You can choose which button is used for selection (the other one is used to place the 3D cursor).
Double Click
The time for a double click (in ms).
Hint
The Mouse emulate option is only available if Select With is set to Right.

Numpad Emulation
The Numpad keys are used quite often in Blender and are not the same keys as the regular number keys. If you
have a keyboard without a Numpad (e.g. on a laptop), you can tell Blender to treat the standard number keys as
Numpad keys. Just check Emulate Numpad.

View Manipulation
Orbit Style
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Select how Blender works when you rotate the 3D View by default when holding MMB.
Turntable
Rotates the view keeping the horizon horizontal.
This behaves like a potter’s wheel or record player where you have two axes of rotation available,
and the world seems to have a better definition of what is “Up” and “Down” in it.
The drawback to using the Turntable style is that you lose some flexibility when working with your
objects. However, you gain the sense of “Up” and “Down” which can help if you are feeling
disoriented.
Orbit
Is less restrictive, allowing any orientation.
Zoom Style
Choose your preferred style of zooming in and out with Ctrl-MMB
Scale
Scale zooming depends on where you first click in the view. To zoom out, hold Ctrl-MMB while
dragging from the edge of the screen towards the center. To zoom in, hold Ctrl-MMB while
dragging from the center of the screen towards the edge.
Continue
The Continue zooming option allows you to control the speed (and not the value) of zooming by
moving away from the initial click point with Ctrl-MMB. Moving up from the initial click-point or
to the right will zoom out, moving down or to the left will zoom in. The further away you move, the
faster the zoom movement will be. The directions can be altered by the Vertical and Horizontal
radio buttons and the Invert Zoom Direction option.
Dolly
Dolly zooming works similarly to Continue zooming except that zoom speed is constant.
Vertical
Moving up zooms out and moving down zooms in.
Horizontal
Moving left zooms in and moving right zooms out.
Invert Zoom Direction
Inverts the Zoom direction for Dolly and Continue zooming.
Invert Wheel Zoom Direction
Inverts the direction of the mouse wheel zoom.
NDOF device
Set the sensitivity of a 3D mouse.
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Keymap Editor

The Keymap editor lets you change the default Hotkeys. You can change keymaps for each of Blender’s editors.
• Select the keymap you want to change and click on the white arrows to open up the keymap tree.
• Select which Input will control the function
• Keyboard: Only hotkey or combo hotkey E, Shift-E.
• Mouse: Left/middle/right click. Can be combined with Alt, Shift, Ctrl, Cmd.
• Tweak: Click and drag. Can also be combined with the four previous keys.
• Text input: Use this function by entering a text
• Timer: Used to control actions based on a time period. e.g. By default, Animation Step uses
Timer 0, Smooth view uses Timer 1.
• Change hotkeys as you want. Just click on the shortcut input and enter the new shortcut.
If you want to restore the default settings for a keymap, just click on the Restore button at the top right of this
keymap.

Add-ons
The Add-ons tab lets you manage secondary options which are not enabled in Blender by default. New features
may be added with Install Add-ons. There will be a growing number of such Add-ons, generated by the
Blender-community so look out for that one feature you were missing (or maybe simply create it yourself).
See the Add-ons Page for more on using Add-ons.
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Themes
The Themes tab allows you to customize interface appearance and colors.

The colors for each editor can be set separately by simply select the editor you wish to change in the multi15
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choice list at the left, and adjust colors as required. Notice that changes appear in real-time on your screen. In
addition, details such as the dot size in the 3D View or the Graph Editor can also be changed.
Themes use Blender’s preset system. To save a theme, click the + button next to the preset selection drop-down
and enter a name. This will save the theme to an XML file in the
./scripts/presets/interface_theme/ subdirectory of one of the configuration directories.

Blender comes bundled with a small selection of themes.
This is an example of the theme Elsyiun.

File Preferences
The File Preferences tab allows you to configure auto-save preferences and set default file paths for blend-files,
rendered images, and more.

16
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File Paths
Locations for various external files can be set for the following options:
Fonts
Default location when searching for font files.
Textures
Default location when searching for image textures.
Render Output
Where rendered images/videos are saved.
Scripts
An additional location to search for Python scripts. See Scripts Path below.
Sounds
Default location when searching for sound files.
Temp
The location where temporary files are stored.
Render Cache
The location where cached render images are stored.
I18n Branches
The path to the /branches directory of your local svn-translation copy, to allow translating from the
UI.
Image Editor
The path to an external program to use for image editing.
Animation Player
The path to an external program to use for playback of rendered animations.
Hint
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If these folders do not exist, they will not be created automatically.

Scripts Path
By default Blender looks in several directories (OS dependant) for scripts. By setting a user script path in the
preferences an additional directory is looked in. This can be used to store certain scripts/templates/presets
independently of the currently used Blender Version.
Inside the specified folder specific folders have to be created to tell Blender what to look for where. This folder
structure has to mirror the structure of the scripts folder found in the installation directory of Blender:
•
•
•
•
•
•
•
•
•
•
•
•

scripts
add-ons
modules
presets
camera
cloth
interface_theme
operator
render
...
startup
templates Not all of the folders have to be present.

Auto Execution
Python scripts (including driver expressions) are not executed by default for security reasons.
Auto Run Python Scripts
You may choose to ignore these security issues and allow scripts to be executed automatically.
Excluded Paths
Blend files in these folders will not automatically run Python scripts. This can be used to define where
blend-files from untrusted sources are kept.

Save & Load
Relative Paths
By default, external files use a relative path.
Compress File
Compress blend-file when saving.
The option to Compress files will compact your files whenever Blender is saving them. Dense meshes,
large packed textures or lots of elements in your scene will result in a large blend being created.
This option may slow down Blender when you quit, or under normal operation when Blender is saving
your backup files. Using this option traces processor time for file-size.
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Load UI
Default setting is to load the Window layout (the Screens) of the saved file. This can be changed
individually when loading a file from the Open blend-file panel of the File Browser.

File extension filter.
Filter File Extensions
By activating this, the file dialog in the File Browser will only show appropriate files (i.e. blend-files
when loading a complete Blender setting). The selection of file types may be changed in the file dialog.
Hide Dot File/Data-blocks
Hide file which start with . on file browsers (in Linux and Apple systems, . files are hidden).
Hide Recent Locations
Hides the Recent panel of the File Browser which displays recently accessed folders.
Show Thumbnails
Displays a thumbnail of images and movies when using the File Browser.

Auto Save
Save Versions
Number of versions created for the same file (for backup).
This option tells Blender to keep the indicated number of saved versions of your file in your current
working directory when you manually save a file. These files will have the extension: .blend1,
.blend2, etc., with the number increasing to the number of versions you specify. Older files will be
named with a higher number. e.g. With the default setting of 2, you will have three versions of your file:
*.blend (your last save), *.blend1 (your second last save) and *.blend2 (your third last save).
Recent Files
Number of files displayed in File ‣ Open Recent.
Save Preview Images
Previews of images and materials in the File Browser are created on demand. To save these previews into
your blend-file, enable this option (at the cost of increasing the size of your blend-file).
Auto Save Temporary File
Enable Auto Save (create a temporary file).
Checking this box tells Blender to automatically save a backup copy of your work-in-progress to the
Temp directory (refer to the File tab in the User Preferences for its location).
The Auto Saved files are named using a random number and have a blend extension.
Timer
Time to wait between automatic saves.
This specifies the number of minutes between each Auto Save. The default value of the Blender
installation is 5 (5 minutes). The minimum is 1, and the Maximum is 60 (Save at every one hour).
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System Preferences
The System tab allows you to set resolution, scripting console preferences, sound, graphics cards, and
internationalization.

General
DPI
Value of the screen resolution which controls the size of Blender’s interface fonts and internal icons
shown. Useful for taking screen shots for book printing and use of high resolution monitors. During
typical usage, you may prefer to use zoom which is an available in many parts of Blender interface.
Virtual Pixel Mode
Allows you to select global scaling. While the DPI only scales the interface, this will scale line width,
vertex-size. This is intended for hi-dpi monitors.
Native
The normal pixel size.
Double
Double of the native pixel size.
Hint
This is auto-detected on OSX.
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Frame Server Port
TCP/IP port used in conjunction with the IP Address of the machine for frameserver rendering. Used
when working with distributed rendering. Avoid changing this port value unless it is conflicting with
already existing service ports used by your Operating System and/or softwares. Always consult your
operating system documentation and services or consult your system administrator before changing this
value.
Console Scrollback
The number of lines, buffered in memory of the console window. Useful for debugging purposes and
command line rendering.

Sound
Audio Device
Set the audio output device or no audio support:
None
No Audio support (no audio output, audio strips can be loaded normally)
SDL
Uses Simple Direct Media Layer API from libsdl.org to render sounds directly to the sound device
output. Very useful for sequencer strips editing.
OpenAL
Provides buffered sound rendering with 3D/spatial support. Used for 3D source support by Speaker
Objects and the Game Engine.
Sound options
Specific to SDL or OpenAL enabled
Channels
Set the audio channel count. Available options are: Stereo, 4 Channels , 5.1 Surround , 7.1 Surround
Mixing Buffer
Set the number of samples used by the audio mixing buffer. Available options are: 512 , 1024 , 2048,
4096 , 8192, 16384, and 32768
Sample Rate
Set the audio sample rate. Available options are: 44.1 Khz, 48 Khs, 96 Khz and 192Khz
Sample Format
Set the audio sample format. Available options are: 32 bit float, 8 bit Unsigned, 16 Bits Signed, 24 Bits
Signed, 32 Bits Signed, 32 Bits Float, and 64 Bits Float.

Screencast
These settings are used to control the frame-rate for recording a Screencast.
FPS
Frame-rate for screencast playback.
Wait Timer
Time in milliseconds between each frame recorded for screencast.

Compute Device
The Options here will set the compute device used by the Cycles render engine.
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None
When set to None or the only option is None: your CPU will be used as a computing device for Cycles
Render Engine
CUDA
If the system has a compatible Nvidia CUDA enabled graphics card you will be able to use it to render
with the Cycles render engine.
OpenCL
If the system has a compatible OpenCL device, it will show up has an option for rendering cycles.
Note
that this currently has limited support, see: Cycles Features page for more information.

OpenSubdiv Compute
The Options here will set the compute device used by OpenSubdiv for the Subdivision Surface Modifier.
None
Disables any OpenSubdiv compute devices, makes sure legacy subsurf method is used. Use this option
when OpenSubdiv causes any bugs or regressions.
CPU
Single threaded CPU implementation. It is mainly useful in cases when GPU compute is possible and
threaded CPU option causes artifacts (it is unlikely to happen, but still possible).
OpenMP
Multi-threaded CPU implementation. Use it for maximum performance in cases when GPU compute is
not available.
GLSL Transform Feedback
Uses GPU to perform calculations, has minimal requirements to video card and driver.
GLSL Compute
Uses GPU to perform calculations, supposed to be more efficient than Transform Feedback but also has
higher requirements to video card and driver.

OpenGL
Clip Alpha
Clip alpha below this threshold in the 3D View. Note that the default is set to a low value to prevent issues
on some GPU’s.
Mipmaps
Scale textures for 3D View using Mipmap filtering. This increases display quality, but uses more memory.
GPU MipMap Generation
Generate MipMaps on the GPU. Offloads the CPU Mimpap generation to the GPU.
16 Bit Float Textures
Enables the use of 16 Bit per component Texture Images (Floating point Images).
Selection
Selection method to use for selecting.
Automatic
Automatically choses the best setting depending on your OS, GPU, and drivers.
OpenGL Select
22
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Legacy OpenGL selection method for legacy hardware.
OpenGL Occlusion Queries
More optimized OpenGL selection method. Use this method if you are using an OpenSubdiv
Compute compute device.
Anisotropic Filtering
Sets the level of anisotropic filtering. This improves the quality of how textures are drawn at the cost of
performance. Available Options are: Off (No Filtering), 2x, 4x, 8x, and 16x.

Window Draw Method
Window Draw Method
Specifies the Window Draw Method used to display Blender Window(s).
Automatic
Automatically set based on graphics card and driver.
Triple Buffer
Use a third buffer for minimal redraws at the cost of more memory. If you have a capable GPU, this
is the best and faster method of redraw.
Overlap
Redraw all overlapping regions. Minimal memory usage, but more redraws. Recommended for
some graphics cards and drivers combinations.
Overlap Flip
Redraw all overlapping regions. Minimal memory usage, but more redraws (for graphics drivers
that do flipping). Recommended for some graphic cards and drivers combinations.
Full
Do a full redraw each time. Only use for reference, or when all else fails. Useful for certain cards
with bad to no OpenGL acceleration at all.
Multi-Sampling
This enables FSAA for smoother drawing, at the expense of some performance.
Note
This is known to cause selection issues on some configurations

Region Overlap
This checkbox will enable Blender to draw regions overlapping the 3D View. It means that the Object
Tools and Transform Properties regions, which are opened by using the shortcuts T and N will be drawn
overlapping the 3D View editor.
If you have a capable graphics card and drivers with Triple Buffer support, clicking the checkbox will
enable the overlapping regions to be drawn using the Triple Buffer method, which will also enable them
to be drawn using Alpha, showing the 3D View contents trough the Object Tools and Transform
Properties regions.
Text Draw Options
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Enable interface text anti-aliasing. When disabled, texts are drawn using text straight render (Filling only
absolute Pixels).

Textures
Limit Size
Limit the maximum resolution for pictures used in textured display to save memory. The limit options are
specified in a square of pixels, (e.g.: the option 256 means a texture of 256×256 pixels) This is useful for
game engineers, whereas the texture limit matches paging blocks of the textures in the target graphic card
memory. Available Options are: Off (No limit), 128, 256, 512, 1024, 2048, 4096, and 8192.
Time Out
Time since last access of a GL texture in seconds, after which it is freed. Set to 0 to keep textures
allocated. Minimum: 0, Maximum: 3600.
Collection Rate
Number of seconds between each run of the GL texture garbage collector. Minimum: 0, Maximum: 3600.
Image Draw Method
Method to draw images as the following options are supported:
2D Texture
Uses CPU for display transform and draws images as a 2D texture.
GLSL
Fastest method using GLSL for display transform and draws images as a 2D texture.
Draw Pixels
Uses CPU for display transform and draws images as a 2D texture.

Sequencer/Clip Editor
Memory Cache Limit
Upper limit of the sequencer’s memory cache (megabytes). For optimum clip editor and sequencer
performance, high values are recommended.

Solid OpenGL lights
Solid OpenGL Lights are used to light the 3D View, mostly during Solid view. Lighting is constant and position
“world” based. There are three virtual light sources, also called OpenGL auxiliary lamps, used to illuminate 3D
View scenes, which will not display in renders.
The Lamp Icons allows the user to enable or disable OpenGL Lamps. At least one of the three auxiliary
OpenGL Lamps must remain enabled for the 3D View. The lamps are equal, their difference is their positioning
and colors. You can control the direction of the lamps, as well as their diffuse and specular colors. Available
Options are:
Direction
Clicking with LMB in the sphere and dragging the mouse cursor let us the user change the direction of the
lamp by rotating the sphere. The direction of the lamp will be the same as shown at the sphere surface.
Diffuse
This is the constant color of the lamp. Clicking on the color widget, opens the color picker pop-up and
allows the user to change colors using the color picker.
Specular
This is the highlight color of the lamp Clicking on the color widget, opens the color picker pop-up and
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allows the user to change colors using the color picker.

Color Picker Type
Choose which type of color space you prefer. It will show when clicking LMB on any color field.
See the different color picker types at the Extended Controls page.

Custom Weight Paint Range
Mesh skin weighting is used to control how much a bone deforms the mesh of a character. To visualize and
paint these weights, Blender uses a color ramp (from blue to green, and from yellow to red). Enabling the
checkbox will enable an alternate map using a ramp starting with an empty range. Now you can create your
custom map using the common color ramp options. For detailed information about how to use color ramps, see:
to the Extended Controls page.

Internationalization
Blender supports a wide range of languages, enabling this check box will enable Blender to support
International Fonts. International fonts can be loaded for the User Interface and used instead of Blender default
bundled font.
This will also enable options for translating the User Interface through a list of languages and Tips for Blender
tools which appear whenever the user hovers a mouse over Blender tools.
Blender supports I18N for internationalization. For more Information on how to load International fonts, see:
Editing Texts page.

25

Bforartists Reference Manual - © Copyright - This page is under Public Domain license

User Preferences
User Preferences......................................................................................................................................................8
Interface Tab............................................................................................................................................................8
Header.................................................................................................................................................................8
First Row............................................................................................................................................................9
Second Row......................................................................................................................................................10
Third Row.........................................................................................................................................................12
Editing...................................................................................................................................................................14
Header...............................................................................................................................................................14
First row............................................................................................................................................................15
Row Three.........................................................................................................................................................17
Fourth Row.......................................................................................................................................................18
Duplicate Data..................................................................................................................................................19
Input.......................................................................................................................................................................19
Header...............................................................................................................................................................19
Left row............................................................................................................................................................20
Right row..........................................................................................................................................................24
Add-ons.................................................................................................................................................................26
Header...............................................................................................................................................................26
Left Row...........................................................................................................................................................27
Right row..........................................................................................................................................................27
Themes..................................................................................................................................................................27
Header...............................................................................................................................................................28
File Preferences.....................................................................................................................................................29
Header...............................................................................................................................................................29
File Paths..........................................................................................................................................................30
Auto Execution.................................................................................................................................................31
Save & Load.....................................................................................................................................................31
Compress File...................................................................................................................................................31
Auto Save..........................................................................................................................................................33
System Preferences................................................................................................................................................33
Header...............................................................................................................................................................33
General..............................................................................................................................................................34
Sound................................................................................................................................................................34
Screencast.........................................................................................................................................................35
Compute Device...............................................................................................................................................35
OpenSubdiv Compute.......................................................................................................................................36
OpenGL............................................................................................................................................................36
Window Draw Method.....................................................................................................................................37
Text Draw Options............................................................................................................................................39
Textures.............................................................................................................................................................39
Image Draw Method.........................................................................................................................................39
Sequencer/Clip Editor.......................................................................................................................................39
Solid OpenGL lights.........................................................................................................................................40
Color Picker Type.............................................................................................................................................40
Custom Weight Paint Range.............................................................................................................................40
Interface Font....................................................................................................................................................41
Monospace Font................................................................................................................................................41
Internationalization...........................................................................................................................................41
International Fonts............................................................................................................................................42

1

Bforartists Reference Manual - © Copyright - This page is under Public Domain license

Detailed table of content
User Preferences......................................................................................................................................................8
Interface Tab............................................................................................................................................................8
Header.................................................................................................................................................................8
Editor Type Menu..........................................................................................................................................8
Save User Settings.........................................................................................................................................8
First Row............................................................................................................................................................9
Display...........................................................................................................................................................9
Scale Edit Box...........................................................................................................................................9
Tooltips......................................................................................................................................................9
Python Tooltips..........................................................................................................................................9
Object Info.....................................................................................................................................................9
Large Cursors............................................................................................................................................9
View Name................................................................................................................................................9
Playback FPS...........................................................................................................................................10
Global Scene...........................................................................................................................................10
Object Origin Size...................................................................................................................................10
Display Mini Axis...................................................................................................................................10
Size..........................................................................................................................................................10
Brightness................................................................................................................................................10
Warnings......................................................................................................................................................10
Prompt Quit.............................................................................................................................................10
Second Row......................................................................................................................................................10
View Manipulation.......................................................................................................................................10
Cursor Depth...........................................................................................................................................11
Auto Depth..............................................................................................................................................11
Zoom to Mouse Position.........................................................................................................................11
Rotate Around Selection..........................................................................................................................11
Global Pivot.............................................................................................................................................11
Camera Parent Lock................................................................................................................................11
Auto Perspective......................................................................................................................................11
Smooth View...........................................................................................................................................11
Rotation Angle.........................................................................................................................................11
2D Viewports...............................................................................................................................................12
Minimum Grid Spacing...........................................................................................................................12
TimeCode Style.......................................................................................................................................12
Zoom To Frame Type..............................................................................................................................12
Third Row.........................................................................................................................................................12
Manipulator.............................................................................................................................................12
Size..........................................................................................................................................................12
Handle Size.............................................................................................................................................13
Hotspot....................................................................................................................................................13
Menus...........................................................................................................................................................13
Open on Mouse Over..............................................................................................................................13
Top Level............................................................................................................................................13
Sub Level............................................................................................................................................13
Pie Menus.....................................................................................................................................................13
Animation Timeout.................................................................................................................................13
Recenter Timeout....................................................................................................................................13
Radius......................................................................................................................................................13
Threshold.................................................................................................................................................13
Confirm Threshold..................................................................................................................................13
2

Bforartists Reference Manual - © Copyright - This page is under Public Domain license

Show Splash............................................................................................................................................14
App Template...............................................................................................................................................14
Show Layout Widgets.............................................................................................................................14
Show 3D cursor.......................................................................................................................................14
Editing...................................................................................................................................................................14
Header...............................................................................................................................................................14
Editor Type Menu........................................................................................................................................14
Save User Settings.......................................................................................................................................14
First row............................................................................................................................................................15
Link Materials To.........................................................................................................................................15
ObData....................................................................................................................................................15
Object......................................................................................................................................................15
New objects..................................................................................................................................................15
Enter Edit Mode......................................................................................................................................15
Align To...................................................................................................................................................15
World..................................................................................................................................................15
View....................................................................................................................................................15
Undo.............................................................................................................................................................15
Global Undo............................................................................................................................................15
Steps........................................................................................................................................................16
Memory Limit.........................................................................................................................................16
Grease Pencil................................................................................................................................................16
Eraser Radius...........................................................................................................................................16
Manhattan Distance......................................................................................................................................16
Euclidian Distance...................................................................................................................................16
Default Color...........................................................................................................................................16
Simplify Stroke.......................................................................................................................................16
Playback.......................................................................................................................................................16
Allow Negative Frame............................................................................................................................16
Node Editor..................................................................................................................................................17
Auto Offset Margin.................................................................................................................................17
Animation Editors........................................................................................................................................17
F-Curve Visibility....................................................................................................................................17
Row Three.........................................................................................................................................................17
Keyframing..................................................................................................................................................17
Visual Keying..........................................................................................................................................17
Only Insert Needed..................................................................................................................................17
Auto Keyframing.....................................................................................................................................17
Show Auto Keying Warning....................................................................................................................17
Only Insert Available...............................................................................................................................17
New F-Curve Defaults.................................................................................................................................18
Interpolation............................................................................................................................................18
Handles....................................................................................................................................................18
XYZ to RGB...........................................................................................................................................18
Transform.....................................................................................................................................................18
Release confirm.......................................................................................................................................18
Fourth Row.......................................................................................................................................................18
Sculpt Overlay Color...................................................................................................................................18
Duplicate Data..................................................................................................................................................19
Input.......................................................................................................................................................................19
Header...............................................................................................................................................................19
Editor Type Menu........................................................................................................................................19
Save User Settings.......................................................................................................................................19
3

Bforartists Reference Manual - © Copyright - This page is under Public Domain license

Import Key Configuration............................................................................................................................19
Export Key Configuration............................................................................................................................19
Left row............................................................................................................................................................20
Presets..........................................................................................................................................................20
Mouse...........................................................................................................................................................20
Emulate 3 Button Mouse.........................................................................................................................20
Continuous Grab.....................................................................................................................................21
Drag Threshold........................................................................................................................................21
Tweak Threshold.....................................................................................................................................21
Select with....................................................................................................................................................21
Double Click................................................................................................................................................21
Emulate Numpad..........................................................................................................................................22
Orbit Style....................................................................................................................................................22
Zoom Style...................................................................................................................................................22
Zoom Style Dropdown Box....................................................................................................................22
Scale....................................................................................................................................................22
Dolly...................................................................................................................................................22
Continue..............................................................................................................................................22
Vertical / Horizontal................................................................................................................................22
Invert Mouse Zoom Direction.................................................................................................................22
Invert Wheel Zoom Direction.................................................................................................................22
View Navigation..........................................................................................................................................23
Walk Navigation..........................................................................................................................................23
Reverse Mouse........................................................................................................................................23
Mouse Sensitivity....................................................................................................................................23
Teleport Duration....................................................................................................................................23
Walk Speed..............................................................................................................................................23
Speed Factor............................................................................................................................................23
Gravity.....................................................................................................................................................23
View Height.............................................................................................................................................23
Jump Height............................................................................................................................................23
NDOF device...............................................................................................................................................24
Pan Sensitivity.........................................................................................................................................24
Orbit Sensitivity......................................................................................................................................24
Deadzone.................................................................................................................................................24
Navigation Style......................................................................................................................................24
Rotation Style..........................................................................................................................................24
Right row..........................................................................................................................................................24
Keyconfig dropdown box.............................................................................................................................24
Search field..................................................................................................................................................24
Keymap Editor.............................................................................................................................................25
Map Type.................................................................................................................................................25
Type of Event..........................................................................................................................................25
Operator...................................................................................................................................................25
Type of Event..........................................................................................................................................25
Value........................................................................................................................................................25
Secondary hotkeys...................................................................................................................................25
Specific settings.......................................................................................................................................26
Restore.........................................................................................................................................................26
Add-ons.................................................................................................................................................................26
Header...............................................................................................................................................................26
Editor Type Menu........................................................................................................................................26
Save User Settings.......................................................................................................................................27
4

Bforartists Reference Manual - © Copyright - This page is under Public Domain license

Install Add-on...............................................................................................................................................27
Refresh.........................................................................................................................................................27
Left Row...........................................................................................................................................................27
Search field..................................................................................................................................................27
Supported Level...........................................................................................................................................27
Categories.....................................................................................................................................................27
Right row..........................................................................................................................................................27
Themes..................................................................................................................................................................27
Header...............................................................................................................................................................28
Editor Type Menu........................................................................................................................................28
Save User Settings.......................................................................................................................................28
Install Theme................................................................................................................................................28
Presets..........................................................................................................................................................28
Editors..........................................................................................................................................................29
Theming settings..........................................................................................................................................29
File Preferences.....................................................................................................................................................29
Header...............................................................................................................................................................29
Editor Type Menu........................................................................................................................................29
Save User Settings.......................................................................................................................................30
File Paths..........................................................................................................................................................30
Fonts.............................................................................................................................................................30
Textures........................................................................................................................................................30
Render Output..............................................................................................................................................30
Scripts..........................................................................................................................................................30
Sounds..........................................................................................................................................................30
Temp.............................................................................................................................................................31
Render Cache...............................................................................................................................................31
I18n Branches..............................................................................................................................................31
Image Editor.................................................................................................................................................31
Animation Player.........................................................................................................................................31
Auto Execution.................................................................................................................................................31
Auto Run Python Scripts.............................................................................................................................31
Save & Load.....................................................................................................................................................31
Relative Paths...............................................................................................................................................31
Compress File...................................................................................................................................................31
Load UI........................................................................................................................................................32
Filter File Extensions...................................................................................................................................32
Hide Dot File/Data-blocks...........................................................................................................................32
Hide Recent Locations.................................................................................................................................32
Hide System Bookmarks..............................................................................................................................32
Show Thumbnails........................................................................................................................................32
Save Versions...............................................................................................................................................32
Recent Files..................................................................................................................................................32
Save Preview Images...................................................................................................................................32
Auto Save..........................................................................................................................................................33
Keep Session................................................................................................................................................33
Auto Save Temporary File...........................................................................................................................33
Timer............................................................................................................................................................33
System Preferences................................................................................................................................................33
Header...............................................................................................................................................................33
Editor Type Menu........................................................................................................................................33
General..............................................................................................................................................................34
Frame Server Port........................................................................................................................................34
5

Bforartists Reference Manual - © Copyright - This page is under Public Domain license

Console Scrollback......................................................................................................................................34
Sound................................................................................................................................................................34
Audio Device...............................................................................................................................................34
None........................................................................................................................................................34
SDL.........................................................................................................................................................34
OpenAL...................................................................................................................................................34
Jack..........................................................................................................................................................34
Channels.......................................................................................................................................................34
Mixing Buffer..............................................................................................................................................35
Sample Rate.................................................................................................................................................35
Sample Format.............................................................................................................................................35
Screencast.........................................................................................................................................................35
FPS...............................................................................................................................................................35
Wait Timer....................................................................................................................................................35
Compute Device...............................................................................................................................................35
None........................................................................................................................................................35
CUDA......................................................................................................................................................36
OpenCL...................................................................................................................................................36
OpenSubdiv Compute.......................................................................................................................................36
None........................................................................................................................................................36
CPU.........................................................................................................................................................36
OpenMP..................................................................................................................................................36
GLSL Transform Feedback.....................................................................................................................36
GLSL Compute.......................................................................................................................................36
OpenGL............................................................................................................................................................36
Clip Alpha....................................................................................................................................................36
Mipmaps......................................................................................................................................................37
GPU MipMap Generation............................................................................................................................37
16 Bit Float Textures....................................................................................................................................37
Selection.......................................................................................................................................................37
Automatic................................................................................................................................................37
OpenGL Select........................................................................................................................................37
OpenGL Occlusion Queries....................................................................................................................37
OpenGL Depth Picking................................................................................................................................37
Anisotropic Filtering....................................................................................................................................37
Window Draw Method.....................................................................................................................................37
Window Draw Method.................................................................................................................................38
Automatic................................................................................................................................................38
Triple Buffer............................................................................................................................................38
Overlap....................................................................................................................................................38
Overlap Flip.............................................................................................................................................38
Full..........................................................................................................................................................38
Multi-Sampling............................................................................................................................................38
Region Overlap............................................................................................................................................38
Text Draw Options............................................................................................................................................39
Text Anti-aliasing.........................................................................................................................................39
Textures.............................................................................................................................................................39
Limit Size.....................................................................................................................................................39
Time Out......................................................................................................................................................39
Collection Rate.............................................................................................................................................39
Image Draw Method.........................................................................................................................................39
2D Texture....................................................................................................................................................39
GLSL............................................................................................................................................................39
6

Bforartists Reference Manual - © Copyright - This page is under Public Domain license

Draw Pixels..................................................................................................................................................39
Sequencer/Clip Editor.......................................................................................................................................39
Memory Cache Limit...................................................................................................................................39
Solid OpenGL lights.........................................................................................................................................40
Color Picker Type.............................................................................................................................................40
Custom Weight Paint Range.............................................................................................................................40
Custom Weight Paint Range........................................................................................................................40
Gradient Colors dialog............................................................................................................................40
Interface Font....................................................................................................................................................41
Monospace Font................................................................................................................................................41
Internationalization...........................................................................................................................................41
International Fonts............................................................................................................................................42
Language......................................................................................................................................................42
Translate.......................................................................................................................................................42
Interface...................................................................................................................................................42
Tooltips....................................................................................................................................................42
New Data.................................................................................................................................................42

7

Bforartists Reference Manual - © Copyright - This page is under Public Domain license

User Preferences
The user preferences is the place where you can tweak several settings to your needs. It
can be opened in the File menu.
The User Preferences contains several tabs. And every tab contains several rows or
panels with content. We will go through them one by one.
When you have changed something, and want that changes to be permanent, then you
are required to save the user settings. See the Save User Settings button in the header.

Interface Tab
The Interface category contains settings to change how
UI elements are displayed and how they react.

Header
Editor Type Menu
Here you can switch to another editor type.

Save User Settings
Save the user settings.
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First Row
Ther first row contains some Display related settings.

Display
The Display section contains settings around the UI display.

Scale Edit Box
At 4K displays the whole UI elements are usually ways too small. Here you can scale the whole UI size display
by moving the slider to the needed value.

Tooltips
Display tooltips in the UI. With this feature unticked you won't see any tooltips anymore. It is not
recommended to turn this feature off. The icon buttons needs the tooltips to display the tool name.

Python Tooltips
Every tooltip can also display the Python code tag for the
tool. It may look like noise in the first moment. But can give
you some further hints here and there. Some tooltips, like
the Node editor buttons, doesn't have a proper tool
description by design. Here the Python tooltip can tell you
the function when you turn it into pure icon buttons.
It is not recommended to turn the Python tooltips off.

Object Info
Display Object name and Frame number in the lower left edge of the 3D view

Large Cursors
Use large mouse cursors if available.

View Name
Display the name of the current view up left in the 3D view.
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Playback FPS
Show the frames per second screen refresh rate while an animation is played back. It appears
in the viewport corner, displaying red if the frame rate set cannot be reached. Amd replaces
the View name while the animation is playing.

Global Scene
Forces the current scene to be displayed in all screens (a project can consist of more than one scene).

Object Origin Size
Here you can adjust the size of the Object origin, which is displayed as an orange dot at the
place where the Object origin is.
The size can be set between 4 and 10 pixels.

Display Mini Axis
Display the mini axis widget down left

Size
Here you can define the size of the Mini Axis. The size can be set between 10 and 64
pixels

Brightness
Here you can set the transparency of the Mini axis. The range goes from 0 to 10. 10 is full opaque. 0 is around
50% semi transparent.

Warnings
This section has just one entry.

Prompt Quit
When you close Bforartists then you can display a do you really want to
quit warning.

Second Row
View Manipulation
This section contains settings around things like mouse cursor and pivot.
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Cursor Depth
Use the depth under the mouse when placing the 3D cursor. That way you can place the 3D cursor at the surface
of an object.

Auto Depth
Use the depth under the mouse to improve view pan, rotate, zoom functionality.

Zoom to Mouse Position
When enabled, the mouse pointer position becomes the focus point of zooming instead of the 2D window
center.

Rotate Around Selection
The selected object becomes the rotation center of the viewport. When there is no selection the point of the last
selection will be used.
Hint
This may seem ideal behavior, however, it can become problematic with larger objects such as a terrainmesh, where the center is not necessarily your point of interest.

Global Pivot
Lock the same rotation/scaling pivot in all 3D Views.

Camera Parent Lock
When the camera is locked to the view and in fly mode, transform the parent rather than the camera.

Auto Perspective
With Auto perspective off when you switch to one of the side views the chosen orthographic or perspectivic
view is kept. Means when you have the distorted perspectivic view, and switch to top view, then your mesh will
be perspectivic distorted here too.
With Auto Perspective the view in the side views will be orthographic, and not perspectivic, no matter what
View Persp/Ortho is chosen.

Smooth View
The switch to change to another view is animated. Here you can adjust the length of time the animation takes
when changing the view with the numpad (Top/Side/Front/Camera...). A value of zero will remove the
animation, and immediately switch to the chosen view.

Rotation Angle
Rotation step size in degrees, when Numpad4, Numpad6, Numpad8, or Numpad2 are used to rotate the 3D
11
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View.

2D Viewports
Settings for 2D viewports like Timeline, Dopesheet, Graph or NLE Editor.

Minimum Grid Spacing
Here you can adjust the
minimum number of pixels
between grid lines in a 2D
viewport. This affects for
example Timeline, Dopesheet,
Graph or NLE Editor.

TimeCode Style
In Timeline, Dopesheet, Graph
and NLE editor you can either
display the keyframe number
or the time in the timeline.
Here you can define how the
time gets displayed when you
have chosen to display time.

Zoom To Frame Type
Timeline, Dopesheet, Graph and NLE. Here you can define how zooming to frame focuses
around current frame.

Third Row
Manipulator
Turns the 3D widget on and off. Note that you can still turn the 3D widget on and
off in the 3D view. So this checkbox is a bit useless.

Size
Here you can change the size of the 3D widget.
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Handle Size
Here you can change the handle size of the 3D widget. The area that you can grab.

Hotspot
Here you can change the hotspot size of the 3D widget. The center of the widget.

Menus
Menus section contains some menu relatet settings.

Open on Mouse Over
With this ticked you don't need to click at a menu item to open it.
Top Level
Time delay in 1/10 second before a menu opens (Open on Mouse Over needs to be enabled).
Sub Level
Same as above for sub menus (for example: File ‣ Open Recent).

Pie Menus
Bforartists has some pie menus onboard. Here you can adjust some settings for it.

Animation Timeout
Length of animation when opening Pie Menus.

Recenter Timeout
The window system tries to keep the pie menu within the window borders. Pie
menus will use the initial mouse position as center for this amount of time, measured in 1/100ths of a second.
This allows for fast dragged selections.

Radius
The size of the Pie Menu.

Threshold
The distance from center before a selection can be made.

Confirm Threshold
Distance threshold after which selection is made (zero disables).
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Show Splash
Display the Splash Screen when starting Bforartists.

App Template
App Templates section contains some settings
for the Application template system. You need
to create and use such a template to see the
needed effect.

Show Layout Widgets
Show Screen Layout Editing UI.

Show 3D cursor
Show the 3D View Cursor.

Editing
These preferences control how several tools will interact
with your input.

Header
Editor Type Menu
Here you can switch to another editor type.

Save User Settings
Save the user settings.
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First row

Link Materials To
Here you can define how materials will be linked to its objects. Almost everything in
Bforartists is organized in a hierarchy of data-blocks. A data-block can be thought of as
containers for certain pieces of information. For example, the Object data-block contains
information about the Object’s location while the Object Data ObData data-block
contains information about the mesh.

ObData
Any created material will be created as part of the ObData data-block.

Object
Any created material will be created as part of the Object data-block.

New objects
Enter Edit Mode
If selected, Edit Mode is automatically activated when you create a new object.

Align To
World
New objects align with world coordinates.
View
New object align with view coordinates.

Undo
Global Undo
Bforartists Undo system is split in several subparts. Global undo stores the undo
step outside of Edit mode.For example for duplicating Objects, changing panel
15
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settings or switching between modes.
Warning
It is not recomended to turn it off! Disabling this option does save memory. But it stops the redo panel from
functioning, also preventing tool options from being changed in some cases.

Steps
Number of Undo steps available.

Memory Limit
Maximum memory usage in Mb (0 is unlimited).

Grease Pencil
Here you can find some options for Grease Pencil

Eraser Radius
The size of the eraser used with the grease pencil. This setting can also be found in the
tool shelf

Manhattan Distance
The minimum number of pixels the mouse has to move horizontally or vertically before the movement is
recorded.

Euclidian Distance
The minimum distance that mouse has to travel before movement is recorded.

Default Color
The default color with which you draw a stroke.

Simplify Stroke
Simplifys the pencil stroke after it is finished.

Playback
Allow Negative Frame
The time Cursor can be set to negative frames with mouse or keyboard. But usually it
doesn't play it then. When using Use Preview Range, this also allows playback of frames in negative range.
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Node Editor
Auto Offset Margin
When you insert a new node between two existing connected nodes,
then the two nodes gets pushed to left and right, with an offset. Here
you can adjust this offset.

Animation Editors
F-Curve Visibility
The amount with which unselected FCurves in the Graph Editor are semitransparent.

Row Three
Keyframing
In many situations, animation is controlled by keyframes. The state of a value (e.g.
location) is recorded in a keyframe and the animation between two keyframes is
interpolated by Blender.

Visual Keying
When an object is using constraints, the objects property value doesnt actually change. Visual Keying will add
keyframes to the object property, with a value based on the visual transformation from the constraint.

Only Insert Needed
This will only insert keyframes if the value of the propery is different.

Auto Keyframing
Enables Auto Keyframe by default for new scenes.

Show Auto Keying Warning
Displays a warning at the top right of the 3D View, when moving objects, if Auto Keyframe is on.

Only Insert Available
This will only add keyframes to channel F-Curves that already exist.
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New F-Curve Defaults
Interpolation
This controls how the state between two keyframes is computed. Default interpolation
for new keyframes is Bézier which provides smooth
acceleration and de-acceleration whereas Linear or
Constant is more abrupt.

Handles
The default handle types for F-Curves.

XYZ to RGB
Color for X, Y or Z animation curves (location, scale or rotation) are the same as the color for the X, Y and Z
axis.

Transform
Release confirm
Dragging LMB on an object will move it. When you release the mouse, then the object "drops" from the mouse.
Wiht this option unticked, a mouse click is necessary to drop the currently attached object.

Fourth Row
Sculpt Overlay Color
This color button allows the user to define a color to be used in the inner part of the brushes circle when in
sculpt mode, and it is placed as an overlay to the brush, representing the focal point of the brush influence.
The overlay color is visible only when the overlay visibility is selected
(clicking at the eye to set its visibility), and the transparency of the overlay
is controlled by the alpha slider located at the brush pop-up, located at the
top of the tool shelf, when in sculpt mode.
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Duplicate Data
When you duplicate an object, then some of the containing data of it gets also duplicated.
But not everything. Some data, like a material, remains linked with the original object .
Here you can define what data gets duplicated for the new object too.

Input
Here you can customize how Blender reacts to mouse
and keyboard, and change keymap entries.
In the left row you will find some general mouse related
settings. Like with what mouse button to select, or the
orbit style. The right row is the actual keymap. Here is all
input defined. Not just tools. This also includes the
mouse action to split windows for example.

Header
Editor Type Menu
Here you can switch to another editor type.

Save User Settings
Save the user settings.

Import Key Configuration
Import a key configuration python file into Bforartists.

Export Key Configuration
Export a key configuration python file from Bforartists.
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Left row
In the left row you can find some general mouse related settings.

Presets
A dropdown box where you can choose some presets for the left row, the general mouse
related settings. You can also ceate your own presets here by clicking at the + button, or
delete a preset with the - button.
The created preset will be stored immediately by clicking at OK. You don't
need to save the user preferences to store the new preset. But you need to
save the user preferences to use this new preset.

Mouse
Emulate 3 Button Mouse
In the Windows world 3 button mouses are common. But Apple for example has a
single mouse button. Bforartists can emulate a 3 button mouse. The third mouse button
will then be emulated by a key combination.
3-button Mouse

2-button Mouse

Apple Mouse

LMB

LMB

LMB (mouse button)

MMB

Alt-LMB

Alt-LMB (Option/Alt key +
mouse button)

RMB

RMB

Cmd-LMB (Command/Apple key
+ mouse button)

Mouse/Keyboard combinations referenced in this manual can be expressed with the combinations shown in the
table. For example, MMB drag becomes Alt-LMB drag. Shift-Alt-RMB becomes Shift-Alt-Cmd-LMB
20
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on a single-button mouse.

Hint
The Mouse emulate option is only available if Select With is set to Right. It does not work with Left Click
select.

Continuous Grab
When you work for example with a manipulator, then it can happen that you move your mouse out of the
current editor. Normally the action that you want to perform then stops, since the mouse is not longer in the
editor window where it belongs. Continuous grab fixes this problem by warping the mouse pointer within the
current view.
Note
Cursor warping is only supported by relative input devices (mouse, trackball, trackpad).
Graphics tablets, however, typically use absolute positioning, this feature is disabled when a tablet is being
used.
This is detected for each action, so the presence of a tablet will not disable Continuous Grab for mouse cursor
input.

Drag Threshold
The number of pixels that a User Interface element has to be moved before it is recognized by Blender.

Tweak Threshold
Number of pixels that you have to drag before a tweak event gets triggered.

Select with
You can choose which button is used for selection (the other one is used to place the 3D
cursor).

Double Click
Here you can adjust the time after which two mouse clicks behind are recognized as a
double click.
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Emulate Numpad
Laptops usually doesn't have Numpad keys. Here you can choose to use the number keys
above the letters as numpad keys.

Orbit Style
Here you can ajdust in what style you rotate the 3D View. Turntable and Trackball
navigation reacts a bit different. Turntable navigation tries to hold the horizon line while
rotation. Turntable rotation rotates also the horizon line.

Zoom Style
Zoom Style Dropdown Box
In the dropdown box you can adjust the zoom style.
Scale
Scale zooming depends on where you first click in the view.
Dolly
Dolly zooming works similarly to Continue zooming except that zoom speed is constant.
Continue
The Continue zooming option allows you to control the speed (and not the value) of zooming by moving away
from the initial click point. Moving up from the initial click-point or to the right will zoom out, moving down or
to the left will zoom in. The further away you move, the faster the zoom movement will be.

Vertical / Horizontal
With Vertical moving up zooms out and moving down zooms in. With Horizontal moving left zooms in and
moving right zooms out.

Invert Mouse Zoom Direction
Inverts the Zoom direction for Dolly and Continue zooming.

Invert Wheel Zoom Direction
Inverts the direction of the mouse wheel zoom.
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View Navigation
Here you can adjust how the View navigation in the 3D
view behaves. You can choose between walk and fly.

Walk Navigation
Here you can adjust how the Walk navigation in the 3D view behaves. Note that these
settings also influences the View navigation in Walk navigation style.

Reverse Mouse
Reverse the mouse movement when you move upwards or downwards

Mouse Sensitivity
Here you can adjust how strong the viewport movement reacts to the mouse movement

Teleport Duration
Here you can adjust the teleport duration when teleporting in navigation mode.

Walk Speed
Here you can adjust the walk speed

Speed Factor
Here you can adjust the run speed.

Gravity
Here you can choose if the virtual character, your point of view, uses gravity.

View Height
Here you can adjust the height of the point of view for your virtual character. This setting requires to have
Gravity on.

Jump Height
Here you can adjust the maximal jump height for your virtual character. This setting requires to have Gravity
on.
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NDOF device
Here you can adjust some settings for a 3D mouse.

Pan Sensitivity
Here you can adjust the pan sensitivity.

Orbit Sensitivity
Here you can adjust the orbit sensitivity

Deadzone
The initial movement that is needed before the movement gets recognized.

Navigation Style
Here you can choose the navigation style between Free and Orbit

Rotation Style
Here you can ajdust in what style you rotate the 3D View. Turntable and Trackball navigation reacts a bit
different. Turntable navigation tries to hold the horizon line while rotation. Turntable rotation rotates also the
horizon line.

Right row
Keyconfig dropdown box
Bforartists comes with several predefined key configurations. Here you can choose
between them. You need to save the User Settings to make the change permanent.
To add your own keymap, first change the keymap to your needs. Then
click the + button. This will call a form where you can give your keymap a
name. Click OK to store it. The process to create a new keymap does not
require to save the user settings. To have this keymap active after the next
restart does.

Search field
You can search the keymaps for keys and terms. In the left edit box
you can adjust if you want to search for names and terms, or for
keystrokes.
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Keymap Editor
The Keymap editor is the list where the single
inputs are defined. Every input can have several
specific operator settings in the lower area. The
upper area defines the general things like the key
combos. The lower area those operator specific
settings.
Normally you don't edit those key entries manually. Most of the usual tools have an
entry in the right click menu to create or to change the hotkey. But sometimes you have
to do this task manually.

Map Type
Here you define what input will control the function.

Type of Event
Here you define your main hotkey. In our case the right mouse.

Operator
Here you can find the Python operator name for the tool.

Type of Event
The main hotkey again. For special events like mouse events you have a
dropdown box here.

Value
What key action is required. On click, on double click, etc. ...

Secondary hotkeys
Many hotkeys uses a key combination, for example Shift D for select.
Here you can define those secondary hotkeys.
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Specific settings
Every operator can have several settings. And
some tools even just defines itself by those
different settings. Align view for example has
the same operator called view3d.viewnumpad.
But switches to the needed view by the right
entry in the specific settings then.
What is equal in the key map in all cases is the
RNA entry. That's the name of the operator
again. But this time not the Python operator name. But the C operator name.

Restore
When you modify a keymap item, then you will see a Restore button appear
at the right side. This indicates that this keymap item gots modified. A click
at the Restore button will restore the original hotkey.

Add-ons
An add-on is external software written by other
developers. Add-ons are a way to extend the core
functionality of Bforartists. Bforartists already comes
with lots of add-ons. Some already activated. Here you
can manage them, and add even more add-ons if
required.
Note that Bforartists works with Blender addons.
Note also that this list contains some add-ons that are
required by Bforartists to work proper. You
will see a warning in those addons. Don't
turn them off. Or vital parts of Bforartists
will not longer work. Like the toolbar.

Header
Editor Type Menu
Here you can switch to another editor type.
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Save User Settings
When you have enabled or disabled an addon, then you should save the user settings to make the change
permanent.

Install Add-on
Here you can install external add-ons. Note that addons that comes as a zip file should be loaded zipped. And
not unzipped.

Refresh
Scan the add-on directories for new modules. This is useful when you decide to install an add-on manually.

Left Row
Search field
Here you can search for a specific addon

Supported Level
Here you can filter the addons by supported level.
The addons comes in three flavours. The official addons are the addons from the Blender developers.
Community are the addons from Community developers that doesn't officially belong to the Blender developer
team. And Testing add-ons are add-ons that aren't really finished yet. They can do the job, but are experimental.

Categories
Here you can filter the addons by categories.
The addons comes in different categories, dependant of their useage.

Right row
This is the list of add-ons. To enable an add-on, tick the checkbox at
the left. When you expand an add-on then you will find some further
informations. Sometimes you will also find some more settings.

Themes
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The Themes tab allows you to customize interface
appearance and colors.
The colors for each editor can be set separately. Simply
select the editor you wish to change in the multi-choice
list at the left, and adjust colors as required. Notice that
changes appear in real-time on your screen. In addition,
details such as the dot size in the 3D View or the Graph
Editor can also be changed.

Header
Editor Type Menu
Here you can switch to another editor type.

Save User Settings
Save the user settings.

Install Theme
Here you can install a new theme.

Presets
Bforartists comes with several theme presets. You can choose between them in the
dropdown box. Don't forget to save the user settings to make the change permanent.
To create a new theme, click the + button next to the preset selection drop-down and enter
a name. This will save the theme to an XML file in the
./scripts/presets/interface_theme/ subdirectory of one of the configuration
directories.
To share the new created theme you have to copy it from that folder. This
xml file can then be loaded as a theme at another computer with Bforartists
installed.
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Editors
The list of the editors that you can theme. Every editor can have its own theming.

Theming settings
Here you can adjust the colors for the single UI elements.

File Preferences
The File Preferences tab allows you to configure autosave preferences and set default file paths for blend-files,
rendered images, and more.

Header
Editor Type Menu
Here you can switch to another editor type.
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Save User Settings
Save the user settings.

File Paths
Locations for various external files can be set for the following options:

Fonts
Default location when searching for font files.

Textures
Default location when searching for image textures.

Render Output
Where rendered images/videos are saved.

Scripts
An additional location to search for Python scripts.
By default Bforartists looks in several directories (OS dependant) for scripts. By setting a user script path in the
preferences an additional directory is looked in. This can be used to store certain scripts/templates/presets
independently of the currently used Blender Version.
Inside the specified folder specific folders have to be created to tell Bforartists what to look for where. This
folder structure has to mirror the structure of the scripts folder found in the installation directory of :
•
•
•
•
•
•
•
•
•
•
•
•

scripts
add-ons
modules
presets
camera
cloth
interface_theme
operator
render
...
startup
templates

Not all of the folders have to be present.
Python scripts (including driver expressions) are not executed by default for security reasons.

Sounds
Default location when searching for sound files.
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Temp
The location where temporary files are stored.

Render Cache
The location where cached render images are stored.

I18n Branches
The path to the /branches directory of your local svn-translation copy, to allow translating from the UI.

Image Editor
The path to an external program to use for image editing.

Animation Player
By default Bforartists uses the internal player to play back animations. Here you can choose an external
program to use for playback of rendered animations. There are also some presets available.

Hint
If these defined folders do not exist, they will not be created automatically.

Auto Execution
Auto Run Python Scripts
You may choose to ignore the security issues, and allow scripts to be executed automatically.

Save & Load
Relative Paths
By default, external files use a relative path.

Compress File
Compress blend-file when saving.
The option to Compress files will compact your files whenever Blender is saving
them. Dense meshes, large packed textures or lots of elements in your scene will
result in a large blend being created.
This option may slow down Blender when you quit, or under normal operation when Blender is saving your
backup files. Using this option traces processor time for file-size.
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Load UI
In Bforartists you can load the scene in the screen layout in which you have saved it. Default is off.
This can also be changed individually when loading a file from the Open blend-file
panel of the File Browser.

Filter File Extensions
By activating this, the file dialog in the File Browser will only show appropriate files in the Load dialog. Blend
files for example.
The selection of file types can also be changed in the header of the file dialog.

Hide Dot File/Data-blocks
On non Windows systems like Linux and Mac OS X files are hidden by a dot in front of the file name. Here you
can make them visible in the file browser if you want. Note that this feature does not work with Windows

Hide Recent Locations
Hides the Recent panel of the File Browser which displays recently accessed
folders.

Hide System Bookmarks
Hides the System Bookmarks panel of the File Browser which displays the
system bookmarks.

Show Thumbnails
Displays a thumbnail of images and movies when using the File Browser.

Save Versions
Number of versions created for the same file (for backup).
This option tells Bforartists to keep the indicated number of saved versions of your file in your current working
directory when you manually save a file. These files will have the extension: .blend1, .blend2, etc., with
the number increasing to the number of versions you specify. Older files will be named with a higher number.
e.g. With the default setting of 2, you will have three versions of your file: *.blend (your last save),
*.blend1 (your second last save) and *.blend2 (your third last save).

Recent Files
The number of recent files to display in the Recent panel.

Save Preview Images
When this option is off, previews of images and materials in the File Browser are created on demand. With this
option on it will save these preview images into your blend-file. This will increase the size of your blend file by
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the size of the thumbnails.

Auto Save
Keep Session
Always load session recovery files and save it after quitting Bforartists. This
means you can work at a blend file, quit Bforartists, and when you reopen it, then it will load with this blend
file in the latest state.

Auto Save Temporary File
Enable Auto Save. Auto save creates a temporary file.
Checking this box tells Blender to automatically save a backup copy of your work-in-progress to the Temp
directory (refer to the File tab in the User Preferences for its location).
The Auto Saved files are named using a random number and have a blend extension.

Timer
Here you can asjust the number of minutes between each Auto Save. The minimum is 1, and the Maximum is
60 (Save at every one hour).

System Preferences
The System tab contains system related settings. Such
as Audio settings, Cuda device, OpenGL Color settings
and so on.

Header
Editor Type Menu
Here you can switch to another editor type.
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General
Frame Server Port
TCP/IP port used in conjunction with the IP Address of the machine for frameserver
rendering. Used when working with distributed rendering. Avoid changing this port
value unless it is conflicting with already existing service ports used by your Operating System and/or
softwares. Always consult your operating system documentation and services or consult your system
administrator before changing this value.

Console Scrollback
The number of lines, buffered in memory of the console window. Useful for debugging purposes and command
line rendering.

Sound

Audio Device
Here you can set the audio device.

None
No Audio support. No audio output, but audio strips can be loaded normally.

SDL
Uses Simple Direct Media Layer API from libsdl.org to render sounds directly to the sound device output.

OpenAL
Provides buffered sound rendering with 3D/spatial support. Used for 3D source support by Speaker Objects and
the Game Engine.

Jack
The Jack Audio Connection Kit

Channels
Set the audio channel count. Available options are: Stereo, 4 Channels , 5.1 Surround , 7.1
Surround
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Mixing Buffer
Set the number of samples used by the audio mixing buffer. Available options are: 512 ,
1024 , 2048, 4096 , 8192, 16384, and 32768

Sample Rate
Set the audio sample rate. Available options are: 44.1 Khz, 48 Khs, 96 Khz and 192Khz

Sample Format
Set the audio sample format. Available options are: 32 bit float, 8 bit Unsigned, 16 Bits
Signed, 24 Bits Signed, 32 Bits Signed, 32 Bits Float, and 64 Bits Float.

Screencast
These settings are used to control the frame-rate
for recording a Screencast.

FPS
Frame-rate for screencast playback.

Wait Timer
Time in milliseconds between each frame recorded for screencast.

Compute Device
The Options here will set the compute device used by the Cycles render engine.

None
When set to None or the only option is None: your CPU will be used as a computing device for Cycles Render
Engine.
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CUDA
If the system has a compatible Nvidia CUDA enabled graphics card you will be able to use it to render with the
Cycles render engine.

OpenCL
If the system has a compatible OpenCL device, it will show up has an option for rendering cycles. Note that
OpenCL currently has limited support, see: Cycles Features page for more information.

OpenSubdiv Compute
The Options here will set the compute device used by OpenSubdiv for the
Subdivision Surface Modifier.

None
Disables any OpenSubdiv compute devices, makes sure legacy subsurf method is
used. Use this option when OpenSubdiv causes any bugs or regressions.

CPU
Single threaded CPU implementation. It is mainly useful in cases when GPU compute is possible and threaded
CPU option causes artifacts (it is unlikely to happen, but still possible).

OpenMP
Multi-threaded CPU implementation. Use it for maximum performance in cases when GPU compute is not
available.

GLSL Transform Feedback
Uses GPU to perform calculations, has minimal requirements to video card and driver.

GLSL Compute
Uses GPU to perform calculations, supposed to be more efficient than Transform Feedback but also has higher
requirements to video card and driver.

OpenGL
Here you can find some OpenGL settings.

Clip Alpha
Clip alpha below this threshold in the 3D View. Note that the default is set to a
low value to prevent issues on some GPU’s.
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Mipmaps
Scale textures for 3D View using Mipmap filtering. This increases display quality, but uses more memory.

GPU MipMap Generation
Generate MipMaps on the GPU. Offloads the CPU Mimpap generation to the GPU.

16 Bit Float Textures
Enables the use of 16 Bit per component Texture Images (Floating point Images).

Selection
Selection method to use for selecting.

Automatic
Automatically choses the best setting depending on your OS, GPU, and drivers.

OpenGL Select
Legacy OpenGL selection method for legacy hardware.

OpenGL Occlusion Queries
More optimized OpenGL selection method. Use this method if you are using an OpenSubdiv Compute compute
device.

OpenGL Depth Picking
Use the depth buffer for picking 3D View selection.

Anisotropic Filtering
Sets the level of anisotropic filtering. This improves the quality of how textures are drawn at the cost of
performance. Available Options are: Off (No Filtering), 2x, 4x, 8x, and 16x.

Window Draw Method
Some Window draw method related settings.
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Window Draw Method
Specifies the Window Draw Method used to display Blender Window(s).

Automatic
Automatically set based on graphics card and driver.

Triple Buffer
Use a third buffer for minimal redraws at the cost of more memory. If you have a capable GPU, this is the best
and faster method of redraw.

Overlap
Redraw all overlapping regions. Minimal memory usage, but more redraws. Recommended for some graphics
cards and drivers combinations.

Overlap Flip
Redraw all overlapping regions. Minimal memory usage, but more redraws (for graphics drivers that do
flipping). Recommended for some graphic cards and drivers combinations.

Full
Do a full redraw each time. Only use for reference, or when all else fails. Useful for certain cards with bad to no
OpenGL acceleration at all.

Multi-Sampling
This enables FSAA for smoother drawing, at the expense of some performance.

Note
Multisampling is known to cause selection issues on some configurations.

Region Overlap
This checkbox will enable Blender to draw regions overlapping the 3D View. It means that the Object Tools and
Transform Properties regions, which are opened by using the shortcuts T and N will be drawn overlapping the
3D View editor.
If you have a capable graphics card and drivers with Triple Buffer support, clicking the checkbox will enable
the overlapping regions to be drawn using the Triple Buffer method, which will also enable them to be drawn
using Alpha, showing the 3D View contents trough the Object Tools and Transform Properties regions.
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Text Draw Options
Text Anti-aliasing
Enable interface text anti-aliasing. When disabled, texts are drawn using text straight render (Filling only
absolute Pixels).

Textures
Limit Size
Limit the maximum resolution for pictures used in textured display to save memory.
The limit options are specified in a square of pixels, (e.g.: the option 256 means a texture of
256×256 pixels) This is useful for game engineers, whereas the texture limit matches paging
blocks of the textures in the target graphic card memory. Available Options are: Off (No
limit), 128, 256, 512, 1024, 2048, 4096, and 8192.

Time Out
Time since last access of a GL texture in seconds, after which it is freed. Set to 0 to keep
textures allocated. Minimum: 0, Maximum: 3600.

Collection Rate
Number of seconds between each run of the GL texture garbage collector. Minimum: 0, Maximum: 3600.

Image Draw Method
Method to draw images as the following options are supported:

2D Texture
Uses CPU for display transform and draws images as a 2D texture.

GLSL
Fastest method using GLSL for display transform and draws images as a 2D texture.

Draw Pixels
Uses CPU for display transform and draws images as a 2D texture.

Sequencer/Clip Editor
Memory Cache Limit
Upper limit of the sequencer’s memory cache (megabytes). For optimum clip editor and sequencer
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performance, high values are recommended.

Solid OpenGL lights
The 3D view uses Solid OpenGL lamps to light the 3D view. You can enable
three different light sources here. These lamps does not affect the rendering.
Their only purpose is to light the 3D view.
You can turn on or off the lamps with the lamp icons in front . There should be
at least one light enabled.
Diffuse color is the constant color of the lamp.
Specular is the hilight color of the lamp.
The icon at the end allows you to control the direction of the light source.

Color Picker Type
Here you can choose the type of Color picker that
will show when you click on a color field. You can
choose between three square types and two circle
types.

Custom Weight Paint Range
How much a bone deforms is defined by Mesh Skin weighting. For visualization
and weightpainting a color ramp is used. Which goes from blue to green to red.
Blue is the lowest weighting, red the hightest.
Here you can define a custom color ramp with your own colors for weightpainting.

Custom Weight Paint Range
The checkbox to enable or disable the custom weight paint range.

Gradient Colors dialog
The + Button adds a color ramp point. That way you can have more
than one color in the gradient.
The - Button removes the currently selected color ramp point.
The <> Element flips the color ramp
The Color picker button? I have no idea! It is not documented, and not to figure out.
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Color Mode is a dropdown box where you can choose the color mode for the gradient.

Interpolation is a dropdown box where you can choose the interpolation mode for the
gradient.

In the Color Ramp element you will see the color ramp with the
single color points.
Choose Active Color Stop is the stop point of the gradient.
Position is a edit box where you can fine tune the position of the currently selected color point

Set Color of selected color stop is the color of the currently selected color point. When
you click at it then you will get a color dialog that allows you to setup the color.

Interface Font
Here you can define a custom interface font. The font in the whole UI.

Monospace Font
Here you can define a custom Monospace font. That's the one used in the python console for example.

Internationalization
Bforartists supports a wide range of languages. Here you can enable the
international fonts for it, and choose a localization for the interface.
This feature will also enable options for translating the user interface.
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Bforartists supports I18N for internationalization.

International Fonts
The checkbox to enable the international fonts.

Language
Here you can choose the language.

Translate
Here you can define what parts of the Ui you want to be localized.

Interface
Interface translates all the interface texts

Tooltips
Tooltips translates the tooltips too.

New Data
New data is meant to edit the localization texts.
This can be done in the right click menus of the tools when
everything is set up in the correct way.

Note
This feature is currently not functional in Bforartists. It ends in an error message.

Let's nevertheless document the way how it should work. Note that you need a Bforartists repository for that.
The binary version does not come with the editable *.po files, but with already compiled *.mo files for the
translation.
Note that you first need to set the path to the translation
files for that. Or you will get an error. This is done in
the File tab. The |18n string.
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The path should lead to the *.po files that you want
to translate. Which can be found in the Bforartistrs
repository.
And you need to enable the Manage UI translations addon. And to fix the paths in this addon. The default paths
are currently set for Blender.

And then you might end in this error here ...

In case somebody has an idea what's going on here, every hint is welcome ...
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Introduction

The Toolbar editor is what you normally have to avoid in UI design. It's a bunch of double menu entries. It is
made by lots of tools that already exists elsewhere.
But the value of this this double menu here is that it is configurable. This customizable toolbar makes it
possible to have the most needed tools at top UI level. This can save a ton of clicks, tabbing, scrolling, and
digging in sub menus. And you can display what you need for your personal workflow. And hide away the rest.
The toolbar editor uses pure Icon buttons.
Parts of the toolbars are just visible when you are in the right mode. The full Primitives toolbar for example in
just visible in Object mode. Parts of it are visible in Edit mode, dependant of what type of object you modify.
And in the other modes the toolbars are hidden.
Parts of the toolbars are just visible when the right object type in the scene exists / is selected.
As told, the toolbars are double menu entries. This means te description of the tools in this chapter will be as
short as possible. Closer descriptions, like how to use the tools, can be found in the other chapters where the
tools comes from. The Tool Shelf in the 3D
View for example.

Limits
- The toolbar does not contain all possible
tools. More the opposite, the selection is very
limited. Lots of tools depends to be performed
in the editor type where you want to do the
change. They just work there. And not in other
editors. And the toolbar is another editor. This
limits the available tools in the toolbar
dramatically.
The global View buttons to switch to the
orthographic views ( Align View) is already a
compromise. They change the view in all open
3D view editors. When you want to change the
view just in one 3D view, then you have to use
the entries in the View menu, or the Numpad
hotkeys for them.

- The toolbars have a fixed order. The content is not sortable. The sorting is defined by the order of the toolbar
8
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type. And inside the toolbar type by the order in the toolbars menu. You would need to have to edit the python
file to change this order.
- Just the toolbar types are independent. The checkboxes to display the toolbars themselves are global. Means
when you set one toolbar type to Primitives, and activate all the primitives types there, then other toolbars will
have the same primitives types displayed.

Menus
When you first look at the Toolbar then you will see no visible menus. They exists, but they are hidden away to
save UI space. The text menus would eat lots of space that we can better spend in displaying more tools.
The Toolbar Type menu and the Toolbars menus are collapsed. You can expand those menus. This makes it
easier to setup. But you can also work with the collapsed menus.

(Un-) Collapse the menus
Right click a the Toolbar. Untick Collapse Menus in the
upcoming menu. Then the collapsed menus becomes
visible again.

To collapse the menus go the opposite route. Right click a the
Toolbar. And tick Collapse Menus in the upcoming menu.

Toolbar Type menu
The first entry of a toolbar is the Toolbar Type menu.
Here you can choose what kind of Toolbar Type you want to
show. You can show multiple types of toolbars at once.
The toolbar types are independant from each other. You can
set up every toolbar to display different content.
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Toolbars Menus
Every toolbar type has several toolbars to display.
In the toolbar menu you can choose what toolbars you want to display.
The toolbars are not independant. This setup is global. When you for example tick the
Toolbar File in this toolbar, then it will be displayed in all other toolbars too. Including in
other layouts.
These checkboxes are also available in the Toolbar Settings Bforartists addon.

Toolbar Settings Bforartists addon
The settings for the toolbar needs to be stored
somewhere. This is done in an addon called Toolbar
Settings Bforartists.
This addon contains the same checkboxes than the
single toolbars menus in the toolbar. But all of them
at once. And here is where they get stored when
you save the user settings.

Warning!
Do not deactivate this addon. The toolbar will not work then. It depends of the settings in the addon!

Create new toolbar
You might want to create your own toolbar for a new layout. Let's explain the needed steps.
First create a new editor type. This can be done by dragging the triangle area of an
existing editor. And will create a new editor.
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Look at the right of this new created editor type. You will now see a small button. This is
the Editor type menu. Open it by clicking at it. And choose Toolbar.

Now set up your new created Toolbar editor. Choose the toolbar types you want to display here. Then choose
the toolbars to display.
The last step is to hide the Editor Type menu and to collapse the menus.
Right click at the toolbar, and tick Collapse Menus and Hide Editortype
menu.

Save Toolbar state
You may want to save the changes at the toolbar. Because without saving the changes you will loose them when
you reopen Bforartists.
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The state of the checkboxes are stored in the
Toolbar Settings Bforartists Addon. So to save
this part you have to save the User Settings in the
User Preferences. It doesn't matter if you have
changed the checkboxes in the toolbar or the
addon. They are the same.

But the state of the collapsed Toolbar menus is not
stored in the User Preferences. They are part of the
layout. You have to save the startup file to make
this changes permanent.
Be careful here. Saving the startup file saves every
change at the layout. Including things like having a
mesh in the scene.

Toolbar Types
Currently the Toolbar editor contains eight toolbar types.
File - Contains some file menu related tools. Like load save. But also the render menu.
Mesh Edit - Contains tools for Meshes in Edit Mode.
Primitives - Contains the primitives from the Create tab in the Tool Shelf.
Image - Contains some tools for editing UV
Tools - Contains the content of the Relations panel in Object mode.
Animation - Contains Animation tools
Edit - Contains some tools from Object and Edit Mode
Misc - Contains Undo, and an empty menu as a place holder.
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Toolbars File
The Toolbars File contains some file menu related tools. Like load save. But also the render
menu.
These toolbars are available in all modes.

Available Toolbars
The description of the single buttons goes from left to right.

Load / Save
The original menu items are in the File menu of the Info editor.

Reload Startup file

Recent

Save As Blend File

Creates a new scene.

The recent files
menu.

Save a Blend file as.

Save Blend File

Saves a copy of the Blend file.

Open Blend File
Load a Blend file.

Save Copy

Save a Blend file.

Link Append
The original menu items are in the File menu of the Info editor.
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Link from Library
Link contend from a Blend file

Append from Library
Append content

Import Menu
The Import menu is the same menu that you can find in the File menu of the Info
editor. It contains all available file import types.

Export Menu
The Export menu is the same menu that you can find in the File menu of the Info editor.
It contains all available file export types.

Import Common
The original menu items are in the File menu of the Info editor.

Import FBX

Import Obj

Import ABC

Import FBX files.

Import Object files.

Import Alembic files.

Import Common 2
The original menu items are in the File menu of the Info editor.

Import DAE

Import BVH

Import 3DS

Import Collada files.

Import Biovision Motion Capture
files.

Import 3DS files.

Import Uncommon
The original menu items are in the File menu of the Info editor.
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Import STL

Import WRL

Import STL files

Import X3D or VRML2 files.

Import PLY

Import SVG

Import PLY files.

Import SVG Files.

Export Common
The original menu items are in the File menu of the Info editor.

Export FBX

Export Obj

Export ABC

Export as FBX file.

Export as Obj file.

Export as Alembic file.

Export Common 2
The original menu items are in the File menu of the Info editor.

Export DAE

Export BVH

Export 3DS

Export as Collada file.

Export as BVH Motion Capture
file.

Export as 3DS file.

Export Uncommon
The original menu items are in the File menu of the Info editor.

Export 3DS

Export PLY

Export WRL

Export as 3DS.

Export as PLY file.

Export as X3D or VRML2 files.

Render
The original menu items are in the Render menu of the Info editor.

Render Image

Render Animation

Renders the current scene as an image by using the
current offline renderer. Either Blender Internal or
Cycles.

Renders the current scene as an animation. Either
Blender Internal or Cycles.

Render Open GL
The Render Open GL toolbar is made of three tools.
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Open GL Render Image
Renders the current scene as an
image by using the Viewport and
Open GL.

Open GL Render
Animation
Renders the current scene as an
animation by using the Viewport

and Open GL.

Open GL Render Settings
The triangle button contains the
Open GL Render settings.

Render Misc
The original menu items are in the Render menu of the Info editor.

Mixdown Audio

Show/ Hide Renderview

Play rendered animation

Mixdown and export the scene's
audio to an audio file.

Toggles display of Render view.

Play rendered Animation sequence.

Window Search
The original menu item is in the Windows menu in the Info editor.
This button calls the search menu.

Toolbars Mesh Edit

The Toolbars Mesh Edit contains tools for Mesh Objects in Edit Mode. The original menu items are mainly in
the Mesh menu in Edit Mode. In the Vertices, Edges and Faces submenus.
This toolbars shows its content Edit mode.
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Available Toolbars
The description of the single buttons goes from left to right.

Vertices Splitconnect

Split

Vertex Connect Path

Vertex Connect

Splits two connected Vertices.

Connect Vertices by their seleciton Connect selected vertices of faces,
order, creating edges, splitting faces splitting the face.

Vertices Misc

Convex Hull

Blend from Shape

Shape Propagate

Enclose selected vertices in a
convex polyhedron.

Blend in shape from a shapekey.

Apply selected vertex locations to
all other shapekeys.

Edges Subdiv
Subdivide Edge Ring

Un-Subdivide

Subdivides an Edge Ring

Unsubdivides selected edges and faces.

Edges Sharp
Mark Sharp

Unmark Sharp

Mark selected edges as sharp.

Unmark selected edges as sharp.

Edges Freestyle
Mark Freestyle Edge

Unmark Freestyle Edge

Mark selected edges as Freestyle feature edges.

Unmark selected edges as Freestyle feature edges.
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Edges Rotate
Rotate
Rotate selected edges or adjoining faces.

Edges Misc

Edge Split

Bridge Edgeloops

Split selected edges so tthat each neighbour face gets
its own copy.

Create faces between selected edge loops.

Faces general
Fill

Boolean Intersect

Fill a selected edge loop with faces.

Solidify

Grid Fill

Create a solid skin by extruding.
Compensating for sharp angles.

Fill grid from two loops.

Beautify Faces
Rearrange some faces to minimize
degenerations.

Intersect
Cut an intersection into faces.

Cut solid geometry from selected to
unselected.

Wire Frame
Create a solid wire frame from
faces.

Faces Freestyle
Mark Freestyle Face

Unmark Freestyle Face

Mark selected faces for exclusion from freestyle
feature edge detection.

Unmark selected faces for exclusion from freestyle
feature edge detection.

Faces Tris
Poke Faces

Tris to Quads

Split a face into a fan.

Join triangle faces into quads.

Triangulate Faces

Split by Edges

Triangulates selected faces.

Split faces by loose edges.
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Faces Rotate Misc
Rotate UV's

Rotate Colors

Rotate UV coordinates inside faces.

Rotate Vertex Colors inside faces.

Reverse UV's

Reverse Colors

Flip direction of UV coordinates inside faces.

Flip direction of Vertex Colors inside faces.

Cleanup

Delete Loose

Degenerate Dissolve

Delete loose vertices, edges or
faces.

Dissolve zero area faces and zero
Split Concave Faces
length edges.
Make all faces convex.

Decimate Geometry

Make Planar Faces

Simplify geometry by collapsing
edges.

Flatten selected faces.

the angle threshold.

Fill Holes
Fill in holes (boundary edge loops)

Split Non Planar Faces
Split non planar faces that exceeds

Toolbars Primitives
The toolbars Primitives contains the Add items from the Create tab.

The full toolbar with all its content is just available in Object mode. In other modes it hides
away. Single types are also visible in Edit mode. When you work at an mesh type, then the Mesh
primitives toolbar is visible for example.

Available Toolbars
The description of the single buttons goes from left to right.

Mesh
The Mesh toolbar contains the Mesh primitives.
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The original menu items are in the Tool Shelf in the 3D View, in the Create tab in the Add Primitives Panel.

Add Plane

Add UV Sphere

Add Torus

Add a Plane primitive.

Add a UV Sphere primitive.

Add a Torus primitive.

Add Cube

Add Cylinder

Add Grid

Add a Cube primitive.

Add a Cylinder primitive.

Add a Grid primitive.

Add Circle

Add Cone

Add a Circle primitive.

Add a Cone primitive.

Curve
The Curve toolbar contains the Curve primitives.
The original menu items are in the Tool Shelf in the 3D View, in the Create tab in the Add Primitives Panel.

Add Bezier

Add Nurbs Curve

Add Nurbs Path

Add a Bezier curve primitive.

Add a Nurbs Curve primitive.

Add a Nurbs Path curve primitive.

Add Circle

Add Nurbs Circle

Add a Circle curve primitive.

Add a Nurbs Circle curve primitive.

Surface
The Surface toolbar contains the Surface primitives.
The original menu items are in the Tool Shelf in the 3D View, in the Create tab in
the Add Primitives Panel.

Add Surface Curve

Add Surface Patch

Add Surface Sphere

Add a Nurbs Surface curve
primitive.

Add a Nurbs Surface Patch
primitive.

Add a Nurbs Surface Sphere
primitive.

Add Surface Circle

Add Surface Cylinder

Add Surface Torus

Add a Nurbs Surface Circle
primitive.

Add a Nurbs Surface Cylinder
primitive.

Add a Nurbs Surface Torus
primitive.

Metaball
The metaball toolbar contains the Metaball primitives.
The original menu items are in the Tool Shelf in the 3D View, in the Create tab in the Add Primitives Panel.

20

Bforartists Reference Manual - © Copyright - This page is Public Domain

Add Metaball of type Ball

Add Metaball of type Plane

Add Metaball of type Cube

Add Metaball of type Ball
primitive.

Add Metaball of type Plane
primitive.

Add Metaball of type Cube
primitive.

Add Metaball of type
Capsule

Add Metaball of type
Elipsoid

Add Metaball of type Capsule
primitive.

Add Metaball of type Elipsoid
primitive.

Lamp
The Lamp toolbar contains the different lamp types.
The original menu items are in the Tool Shelf in the 3D View, in the Create tab in the
Add Misc Panel.

Add Lamp of type Point

Add Lamp of type Spot

Add Lamp of type Area

Add Lamp of type Point.

Add Lamp of type Spot.

Add Lamp of type Area.

Add Lamp of type Sun

Add Lamp of type Hemi

Add Lamp of type Sun.

Add Lamp of type Hemi.

Other
The Other toolbar contains some other ground types like bones and text.
The original menu items are in the Tool Shelf in the 3D View, in the Create tab in the
Add Misc Panel.

Add Text

Add Lattice

Add Speaker

Add a Text object.

Add a Lattice object.

Add a Speaker object.

Add Armature

Add Camera

Add a Armature object.

Add a Camera object.

Empties
The Empties toolbar contains the available empty types.
The original menu items are in the Tool Shelf in the 3D View, in the
Create tab in the Add Misc Panel.
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Add Empty of type Plain
Axes

Add Empty of type Cone

Add Empty of type Arrows

Add Empty of type Cone.

Add Empty of type Arrows.

Add Empty of type Cube

Add Empty of type Image

Add Empty of type Cube.

Add Empty of type Image.

Add Empty of type Plain Axes.

Add Empty of type Sphere
Add Empty of type Sphere.

Add Empty of type Circle

Add Empty of type Single
Arrow

Add Empty of type Circle.

Add Empty of type Single Arrow.

Force Field
The Force Field toolbar contains the available Force
field types.
The original menu items are in the Tool Shelf in the 3D View, in the Create tab in the Add Misc Panel.

Add Physics Effector of
Type Boid

Force.

Add Physics Effector of Type Boid. Add Physics Effector of

Type Harmonic

Add Physics Effector of
Type Charge
Add Physics Effector of Type
Charge.

Add Physics Effector of
Type Curve Guide
Add Physics Effector of Type
Curve Guide.

Add Physics Effector of
Type Drag
Add Physics Effector of Type Drag.

Add Physics Effector of
Type Force
Add Physics Effector of Type

Add Physics Effector of Type
Harmonic.

Add Physics Effector of
Type Lennard-Jones
Add Physics Effector of Type
Lennard-Jones.

Add Physics Effector of
Type Magnetic
Add Physics Effector of Type
Magnetic.

Add Physics Effector of
Type Smoke Flow
Add Physics Effector of Type
Smoke Flow.

Toolbars Image
The toolbars Image contains some image related tools. At
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Add Physics Effector of
Type Texture
Add Physics Effector of Type
Texture.

Add Physics Effector of
Type Turbulence
Add Physics Effector of Type
Turbulence.

Add Physics Effector of
Type Vortex
Add Physics Effector of Type
Vortex.

Add Physics Effector of
Type Wind
Add Physics Effector of Type
Wind.
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the moment this toolbar contains just tools to edit UV meshes. This means that you have to be in Edit mode
with an UV mapped mesh to make the tools active.
The original menu items are in the Image menu of the UV Image Editor.

Available Toolbars
The description of the single buttons goes from left to right.

UV Align
The UV Align toolbar contains tools to clean up and align the selected UV
geometry.

Align Straighten
Align UV's along the line defined by the end points of the selection.

Align Straighten X
Align UV's along the line defined by the end points along the X axis.

Align Straighten Y
Align UV's along the line defined by the end points along the Y axis.

Align Auto
Automatically choose the axis on which there is most alignmend already.

Align X
Align UV's at X axis

Align Y
Align UV's at Y axis

UV Unwrap
The UV Common toolbar contains tools for unwrapping.

Mark Seam
Mark selected UV Edges as Seam.

Clear Seam
Remove Seam from selected UV Edges.
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Seams from Islands
Marks the border edges of the UV patches as Seam.

Unwrap Angle Based
Unwraps the selected geometry with the Angle based ( ABF ) method.

Unwrap Conformal
Unwraps the selected geometry with the Conformal ( LSCM ) method.

UV Modify UV
The UV Modify toolbar contains tools to clean up the uv mapping.

Pin
Pins the selected vertices.

Unpin
Unpins the selected verstices.

Weld
Weld the selected UV vertices together.

Remove Doubles UV
Removes double vertices

Average Island Scale
Average the size of separated UV patches, based at their size in 3D space.

Pack Island
Packs the UV patches so that they fit best into the UV space, and as few texturespace as possible is wasted.

Copy mirrored UV Coordinates
Copy mirrored UV Coordinates at X axis based on a mirrored mesh.

Toolbars Tools
The Toolbars Tools contains some tools in object mode. The content from the relations panel
and the edit panel in the tool shelf. And one tool in Edit mode. Make Vertex Parent. Since this
is also part of the relations panel.
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Available Toolbars
The description of the single buttons goes from left to right.

Group
The Group block.

Create new group
Creates a new group.

Add Selected to active group
Adds the selected object to the active group.

Remove from Group
Removes the selected object from the group.

Remove from all Groups
Removes the selected object from all groups.

Remove selected from active Group
Removes the selected object from the active group.

Parent
Make Parent
Parents the selected object to the active object.

Clear Parent
Removes the parenting.

Object to Data
Make Single User
Make linked data local to each object.
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Link Data
Apply active object links to other selected objects.
This button is a menu where you can choose the link method.

Link to SCN
Link to SCN
Link selection to another scene. This other scene has of course to exist.

Linked Objects
Make Local
Make library linked datablocks local to this file.

Make Proxy
Add empty object to become local replacement data of a library linked object.

Join
Join
Join selected objects into active objects.

Origin
Set Geometry to Origin
Sets the geometry to origín.

Set Origin to Geometry
Sets the origin to geometry.

Set Origin to 3D cursor
Sets the origin to the 3D cursor.

Set Origin to Center of Mass
Sets the origin to the center of mass.
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Shading
Shade Smooth
Shades the geometry smooth.

Shade Flat
Shades the geometry flat.

Data Transfer
Transfer Mesh Data
Transfers mesh data.

Transfer Mesh Data Layout
Transfers the mesh data layout.

Join UV's
Transfer UV Maps.

Relations
The Relations toolbar contains one tool in Edit mode. Make Vertex Parent.

Make Vertex Parent
Parents an object to the selected vertice(s).

Toolbars Animation
The Toolbars Animation contains tools around animation. The Toolbars Range, Play, Sync and
Keyingset are the toolbars from the Timeline. But separated into four independant parts.

Available Toolbars
The description of the single buttons goes from left to right.
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Keyframes
The Keyframes toolbar contains some keyframe tools. The original menu items
can be found in the Tool Shelf in the Animation tab in the Animation panel.
The original menu items are in the Tool Shelf in the 3D View, in the Animation tab in the Animation panel.

Insert Keyframe Menu
When there is no keying set assigned to the currently selected object ,then this button is a menu where you can
choose a keying set. When there is already a keying set assigned, then you can record a keyframe with this
button

Delete Keyframe
Deletes the current Keyframe

Bake Action
Bakes the animation to a new
action

Remove Animation
Remove all keyframe animation for
selected objects

Calculate Object Paths
Calculate motion paths for the
selected objects.

Clear Object Paths
Clears motion paths for the selected
objects.
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Range

Use Preview Range
Use an alternative start/end frame grange for animation playback and OpenGL renders instead of the Render
Properties start/end frame range.

Lock Frame Selection to
Range
Don't allow frame to be selected

with mouse outside of frame range

Frame End
The frame end point

Frame Start
The frame start point

Play
Current Frame
The current frame number

Jump to Endpoint
Jumps to beginning of animation

Jump to Keyframe

Jump to Keyframe

Play Animation

Play Animation
Plays animation reversed

Play Animation

Jumps to next keyframe

Jump to Endpoint
Jumps to end of animation

Plays animation forward

Jumps to the previous keyframe

Sync
Sync is a dropdown box where you can adjust the syncing method.

Keyframe Type
Keyframe Type is a dropdown box where you can choose in what color the keyframe gets
displayed in the Dope Sheet Editor.
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Keyingset

Use Keyframe Insert Auto

Insert Keyframe

Auto insert keyframes at manipulation.

Insert a keyframe.

Keying set Dropdown box

Delete Keyingset Keyframe

This is a dropdown box where you can choose the
keyingset method.

Delete Keyframe.

Toolbars Edit
The Toolbars Edit contains various toolbars around editing. Some content just
shows when an object exists in the scene. Some content is visible in Object
mode. Some content is visible in Edit mode.

Available Toolbars
The description of the single buttons goes from left to right.

Edit
The Edit toolbar is just visible in Edit
Mode. The original menu items are in
the Tool Shelf in the 3D View in the
Tools tab in the Mesh Tools panel.

Dissolve Vertices

Dissolve Edges

Dissolve Faces

Dissolve Vertices.

Dissolve Edges.

Dissolve Faces.
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Remove Doubles
Removes double vertices.

Limited Dissolve
Dissolve Edges and Vertices limited
by the surrounding angle.

Dissolve Selection
Dissolve Geometry dependant of
selection mode.

Edge Collapse
Collapse selected edges.

Merge
Merges selected
geometry. This is a
dropdown box
where you can choose where to
merge.

Separate
Separate the
selection, and
create a new
object from it.
This is a
dropdown box where you can
choose the separate method.
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Weigth in Edit
The Weight in Edit toolbar is just visible in Edit Mode for normal
meshes, and Pose mode when you have a rigged character
selected. The original menu items are in the Tool Shelf in the 3D
View in the Tools tab in the Weight Tools panel. You need to have a Vertex Group applied.

Normalize all

Clean

vertex group.

Normalizes the whole mesh.

Remove Vertex Assignments that
are not required.

Smooth

Normalize
Normalizes the selection

Quantize

Mirror

Set Weights to a fixed number of
steps.

Mirrors the selection.

Invert
Inverts the weighting.

Levels
Add some offset and multiply with
some gain the weights of the active

Smooth weights for selected
vertices.

Limit Total
Limit deform weights.

Fix Deforms
Fix Deforms by modifying the
position of selected vertices.

Object Apply
The Object Apply toolbar is just visible in Object Mode. The original menu
items are in the Object menu in the 3D View. The Apply menu.

Location

Scale

Visual Transform

Apply location.

Apply Scale.

Apply Visual Transform.

Rotation

Rotation & Scale

Make Duplicates real

Apply Rotation.

Apply Rotation, Scale.

Make Duplicates attached to this
object real.

Object Apply Deltas
Object Apply deltas converts normal object transforms to delta transforms. Any
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existing delta transform will also be included.

Location

All

Apply location.

Apply Location, Rotation, Scale.

Rotation

Transforms to Delta Anims

Apply Rotation.

Convert object animation for
normal transforms to delta
transforms

Scale
Apply Scale.

Object Clear
The Object Clear toolbar is just visible in Object Mode. The original menu items are in
the Object menu in the 3D View. The Clear menu.

Location

Scale

Resets the position of the object to zero

Resets the object's scale to 1

Rotation

Origin

Resets the object's rotation to zero

Resets the Origin Position

Toolbars Misc
The Toolbars Misc contains some miscellaneous tools.
Undo / Redo, Undo History and Repeat are originally
located in the Tool Shelf in the 3D View. In the Tools
tab in the History panel.

Available Toolbars
The description of the single buttons goes from left to right.
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Undo / Redo
Undo
Undo the last step

Redo
Redo the last undone step

Undo History
Undo History
A click at at the button reveals a list of the last operations where you can undo more
than one step.

Repeat
Repeat
Repeats the last action

Repeat History
A click at at the button reveals a list of the last operations where you can choose from wich
undo step to repeat.

Scene
The Scene dropdown box to choose and create a new scene data block. The original
dropdown box is in the Properties editor in the Scene tab in the Scene panel.

Misc
The Misc toolbar is currently empty besides a placeholder string.
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Data System
Each .blend file contains a database. This database contains all scenes, objects, meshes, textures, etc. that are
in the file.
A file can contain multiple scenes and each scene can contain multiple objects. Objects can contain multiple
materials which can contain many textures. It is also possible to create links between different objects.

Outliner
You can easily inspect the contents of your file by using the Outliner editor, which displays all of the data in
your .blend file.
The Outliner allows you to do simple operations on objects, such as selecting, renaming, deleting, linking and
parenting.
Read more about the Outliner

Pack and Unpack Data
Bforartists has the ability to encapsulate (incorporate) various kinds of data within the .blend file that is
normally saved outside of the .blend file. For example, an image texture that is an external .jpg file can be
put “inside” the .blend file via File ‣ External Data ‣ Pack into .blend file. When the .blend file is saved, a
copy of that .jpg file is put inside the .blend file. The .blend file can then be copied or emailed
anywhere, and the image texture moves with it.
You know that an image texture is packed because you will see a little “Christmas present gift box” displayed in
the header.

Unpack Data
When you have received a packed file, you can File ‣ External Data ‣ Unpack into Files.... You will be
presented with the option to create the original directory structure or put the file in the // (directory where
the .blend file is). Use “original locations” if you will be modifying the textures and re-packing and
exchanging .blend files, so that when you send it back and the originator unpacks, his copies of the textures will
be updated.

Data-Blocks
The base unit for any Bforartists project is the data-block. Examples of data-blocks include: meshes, objects,
materials, textures, node-trees, scenes, texts, brushes and even screens.
For clarity, bones, sequence strips and vertex groups are not data-blocks, they belong to armature, scene and
2
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mesh types respectively.
Some common characteristics:
• They’re the primary contents of the .blend file.
• They can link to each other, for reuse and instancing. (child/parent, object/object-data, with modifiers
and constraints too).
• Their names are unique.
• They can be added/removed/edited/duplicated.
• They can be linked between files (only enabled for a limited set of data-blocks)
• They can have their own animation data.
• They can have custom properties.
When doing more complex projects managing data-blocks becomes more important, especially when interlinking .blend files.

Data-blocks view

Users (Garbage Collection)
It’s good to be aware of how Bforartists, handles data-blocks life-time, when they are freed and why.
Bforartists follows the general rule where unused data is eventually removed.

3
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Since its common to add and remove a lot of data while working, this has the advantage of not having to
manually manage every single data-block.
This works by skipping zero user data-blocks when writing .blend files.
In some cases you want to save a data-block even when its unused (typically for re-usable asset libraries). see
Fake User.

Fake User
Since zero user data-blocks aren’t saved. There are times when you want to force the data to be kept
irrespective of its users.
If you’re building a .blend file to serve as a library of things that you intend to link-to from other files, you’ll
need to make sure that they don’t accidentally get deleted from the library file.
Do this by giving the data-blocks a Fake User, by pressing the F button next to the name of the data-block. This
prevents the user count from ever becoming zero: therefore, the data-block won’t be deleted. (since Bforartists
doesn’t keep track of how many other files link to this one.)

Users (Sharing)
Many data-blocks can be shared among other data-blocks,
Examples where sharing data is common.
• Sharing textures among materials.
• Sharing meshes between objects (instances).
• Sharing animated actions between objects, for example to make all the lights dim together.
You can also share data-blocks between files, see.
• linked libraries.

Removing Data-Blocks
As covered in Users (Garbage Collection), data-blocks are typically removed when they’re no longer used.
There are some exceptions to this however.
The following data-blocks can be removed directly: Scene, Text, Group and Screen.
Other data-blocks such as groups and actions can be Unlinked from the Outliner context menu.
Tip
Some data (images especially) is hard to keep track of, especially since image views are counted as users.
For data-blocks that can be unlinked - hold Shift while pressing on the X button, This force-clears the usercount, so the data-block will be removed on reload.
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Data-Block Types
For reference, here is a table of data-blocks types stored in .blend files.
Link:
Pack:
Type

Link

Pack

Action

✓

✗

Armature

✓

✗

Brush
Camera
Curve
Font

✓
✓
✓
✓

✗
✗
✗
✓

GreasePencil

✓

✗

Group

✓

✗

Image

✓

✓

Lamp
Lattice

✓
✗

✗
✗

Library

✗

✓

LineStyle
Mask

✓
✓

✗
✗

Material

✓

✗

Mesh

✓

✗

MetaBall

✓

✗

MovieClip

✓

✗

NodeGroup

✓

✗

Object

✓

✗

Particle

✓

✗

Library Linking, supports bing linked into other blend
files.
File Packing, supports file contents being packed into
the blend file.
Description
Stores animation FCurves.
Used as data-block animation data,
and the Non-Linear-Editor.
Skeleton used to deform meshes.
Used as object-data & by the Armature Modifier.
Used by paint tools.
Used as object-data.
Used by camera, font & surface objects.
References font files.
Used by Font object-data.
2D/3D sketch data.
Used as overlay helper info, by the
3D-View, Image, Sequencer & MovieClip editors.
Reference object’s.
Used by dupli-grous & often library-linking.
Image files.
Used by textures & shader nodes.
Used as object-data.
Grid based lattice deformation.
Used as object-data and by the Lattice Modifier.
References to external .blend files.
Access from the outliner’s Blendfile view.
Used by the FreeStyle render-engine.
2D animated mask curves.
Used by compositing nodes & sequencer strip.
Set shading and texturing render properties.
Used by objects, meshes & curves.
Geometry verts/edges/faces.
Used as object-data.
An isosurface in 3D space.
Used as object-data.
Reference to an image sequence or video file.
Used in the motion-tracking editor.
Collections of re-usable nodes.
Used in the node-editor.
An entity in the scene with location,
scale, rotation.
Used by scenes & groups.
Particle settings.
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Type

Link

Pack

Palette

✓

✗

Scene

✓

✗

Screen

✗

✗

ShapeKeys

✗

✗

Sounds

✓

✓

Speaker

✓

✗

Text

✓

✗

Texture

✓

✗

World

✓

✗

Description
Used by particle systems.
Store color presets.
Access from the paint tools.
Primary store of all data displayed and animated.
Used as top-level storage for objects & animation.
Screen layout.
Used by each window, which has its own screen.
Geometry shape storage, which can be animated.
Used by mesh, curve and lattice objects.
References to sound files.
Used by speaker objects and the game-engine.
Sound sources for a 3D scene.
Used as object-data.
Text data.
Used by Python scripts and OSL shaders.
2D/3D textures.
Used by materials, world and brushes.
Used by scenes for render environment settings.

Scenes
Scenes are a way to organize your work. Usually you work with just one scene. But each .blend file can
contain multiple scenes which share other data such as objects and materials
Scene management and library appending/linking is based on Bforartists’s Library and Data System, so it is a
good idea to read that manual page first if you’re not familiar with the basics of that system.
You can select and create scenes with the Scene selector

6
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Screen and Scene selectors

Adding a Scene
To add a scene, click on the scene list button, and select Add New. While you are adding a new scene, you have
these options:

Add scene pop-up menu.

New
Creates an empty scene with default values.
Copy Settings
Creates an empty scene but also copies the settings from the active scene into the new one.
Link Objects
This option creates a new scene with the same settings and contents as the active scene. However, instead
of copying the objects, the new scene contains links to the objects in the old scene. Therefore, changes to
objects in the new scene will result in the same changes to the original scene, because the objects used are
literally the same. The reverse is also true.
Link Object Data
Creates new, duplicate copies of all of the objects in the currently selected scene, but each one of those
duplicate objects will have links to the object-data (meshes, materials and so on) of the corresponding
objects in the original scene.
This means that you can change the position, orientation and size of the objects in the new scene without
affecting other scenes, but any modifications to the object-data (meshes, materials etc) will also affect
other scenes. This is because a single instance of the “object-data” is now being shared by all of the
objects in all of the scenes that link to it.
More information at the Window Type page. This has the effect of making a new independent copy of the
object-data.
Full Copy
Using this option, nothing is shared. This option creates a fully independent scene with copies of the
active scenes contents. Every object in the original scene is duplicated, and a duplicate, private copy of its
object-data is made as well.
Note
To choose between these options, it’s useful to understand the difference between Objects and Object Data.
See Duplication.
The choices for adding a scene, therefore determine just how much of this information will be copied from the
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active scene to the new one, and how much will be shared (linked).

Removing a Scene
You can delete the current scene by clicking the X next to the name in the Info Editor.

Background Set Scene
You can use a scene as a background, this is typically useful when you want to focus on animating the
foreground for example, without background elements getting in the way.
You can assign a Background to your current scene from the Properties Editor Scene panel.
This scene can have its own animation, physics-simulations etc, but you will have to select it from the Scene
browser if you want to edit any of its contents.
This can also be used in combination with Linking to a Scene, where one .blend file has the environment,
which can be re-used in many places.

Linking to a Scene
You can link any object from one scene to another. Just open the scene where these objects are, from the 3dview header access Obejct -> Make Links... and choose the scene where you want your objects to appear. The
selected objects will be added to that scene but remain linked to the original objects.
To make them single user (independent and unlinked) in a given scene go to that scene, select them, then from
the 3d-view header access Obejct -> Make Single User. You will be presented with a few options that allow you
to free up the data-blocks (Object, Material, Texture...) that you want.

Files
The options to manage files are:
New
Clears the current scene and loads startup.blend
Open
Open a blend file
Open Recent
Displays a list of recently saved .blend files to open
Recover last session
This will load the quit.blend file Bforartists automatically saves just before exiting. So this option enables
you to recover your last work session, e.g. if you closed Bforartists by accident
Recover Auto Save
This will open an automatically saved file to recover it.
Save
Save the current blend file.
Save As
8
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Opens file browser to specify file name and location of save.
Save Copy
Saves a copy of the current file.
User Preferences
Opens the user preferences dialog.
Save User Settings
Saves the current scene and preferences to startup.blend.
Load Factory Settings
Restore the default scene to the factory settings.
Link or Append
You don’t have to load a complete file, you can load in only selected parts from another file if you wish.
Import
Bforartists can use information stored in a variety of other format files which are created by other
graphics programs.
Export
Normally you save your work in a .blend file, but you can export some or all of your work to a format
that can be processed by other graphics programs.
External Data
Pack into .blend
Pack all used external files into the .blend
Unpack into Files
Unpack all files packed into this .blend to external ones
Make all paths Relative
Make all paths to external files relative to current .blend
Make all paths Absolute
Make all paths to external files absolute
Report Missing Files
Report all missing external files
Find Missing Files
Try to find missing external files

Opening Files

Usage
Reference
Menu: File ‣ Open
9
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The upper text box displays the current directory path, and the lower text box contains the selected filename.
Warning
For Linux and Mac-OSX users:
When existing you are not asked to save unsaved changes to the scene you were previously working on. So
take care to save your work.
On MS-Windows there is a Save & Load option to warn on exit.

Options
Load UI
Inside each .blend file, Bforartists saves the user interface arrangement. By default, this saved UI is
loaded, overriding any user defaults or current screen layouts that you have. If you want to work on the
blend file using your own defaults, start a fresh Bforartists, then open the file browser and turn off the
Load UI button, and then open the file.
Trusted Source
When enabled, Python scripts and drivers that may be included in the file will be run automatically.
Enable this only if you created the file yourself, or you trust that the person who gave it to you did not
include any malicious code with it. See Scripting & Security to configure default trust options.

Other File Open Options
From the File menu, you can also open files with the following tools:
Open Recent
Lists recently used files. Click on one to load it in.
Recover Last Session
This will load the quit.blend file Bforartists automatically saved just before exiting. This option
enables you to recover your last work session if, for example, you closed Bforartists by accident.
Recover Auto Save
This will allow you to open an automatically saved file to recover it.
See also
Auto Saves

Saving Files
Reference
Editor: Info
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Menu: File
There are a number of slightly different methods you can use to save your blend file to your hard drive:
Save
Save an existing blend file over itself.
Save As
Choose a file to save the blend to.
Save Copy
Choose a file to save the blend to, but return to editing the original file upon completion. This can be used
to save backups of the current working state without modifying the original file.
If the file name doesn’t end with .blend, the extension is automatically appended. If a file with the same
given name already exists, the text field will turn red as a warning.

Tip
Use the plus/minus buttons to the right of the file name, or NumpadPlus/NumpadMinus to
increase/decrease a number at the end of the file name (e.g. changing file_01.blend to
file_02.blend).

Options
The save options appear at the bottom of the sidebar.
Compress File
When enabled, the saved file will be smaller, but take longer to save and load.
Remap Relative
This option remaps relative paths (such as linked libraries and images) when saving a file in a new
location.
Save Copy
This option saves a copy of the actual working state, but does not make the saved file active.
Legacy Mesh Format
Save the blend file, but ignore faces with more than 4 vertices (“ngons”) so that older versions of
Bforartists (before 2.63) can open it.
See also
Auto Save
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Importing and Exporting Files
Bforartists supports import and export to and from other file formats (e.g. OBJ, FBX, 3DS, PLY... etc).
These formats can be accessed from the menus: File ‣ Import and File ‣ Export.
Popular formats are enabled by default, other formats are also supported and distributed with Bforartists, these
can be enabled in the user-preferences through the use of Add-ons.
A list of these add-ons can be found on the Bforartists Add-ons Catalog
In case you wonder why the mouse pointer at import
and export turns into this square symbol, this is not a
bug. This little thing is a progress bar. Handy for large
files where you could have the impression that the
import or export is frozen.

Relative Paths
Many Bforartists files reference external images or other linked .blend files. A path tells Bforartists where to
look for these files. If the external files are moved, the blend file that references them won’t look right.
When you specify one of these external files, the default option is to make the path relative. Bforartists stores a
partial path evaluated relative to the directory location of the referencing blend file. This choice helps when you
need to reorganize folders or move your files.
With a relative path you can move the .blend file to a new location provided the externally linked files are
moved along with it. For example you could send someone a folder that contains a .blend file and a sub-folder
of external images that it references.
Most file selection windows provide a Relative Path check box, or when you type in a path into a text field, use
a double slash prefix (//) to make it so.
Relative paths is the default but this can be changed in the File Preferences Tab of the User Preferences Editor.
Note
You can’t enter relative paths into a new untitled blend file. Save it before linking to external files.

Hint
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If it’s necessary to relocate a blend file relative to its linked resources, use Bforartists’s File Save As function
which has an option to Remap Relative file links.

Supported Graphics Formats
Image Formats
This is the list of image file formats supported internally by Bforartists:
Format
BMP
Iris
PNG
JPEG
JPEG 2000
Targa
Cineon & DPX
OpenEXR
Radiance HDR
TIFF

Channel Depth
8bit
8bit
8, 16bit
8bit
8, 12, 16bit
8bit
8, 10, 12,16bit
float 16, 32bit
float
8, 16bit

Alpha
✗
✓
✓
✗
✓
✓
✓
✓
✓
✓

Metadata
✗
✗
✓
✓
✗
✗
✗
✓
✗
✗

DPI
✓
✗
✓
✓
✗
✗
✗
✓
✗
✓

Extensions
.bmp
.sgi .rgb .bw
.png
.jpg .jpeg
.jp2 .jp2 .j2c
.tga
.cin .dpx
.exr
.hdr
.tif .tiff

Hint
If you aren’t interested in technical details, a good rule of thumb for selecting an output formats for your
project is:
Use OpenEXR
if you intend to do compositing or color-grading on these images.
Use PNG
if you intend on-screen output or encoding into multiple video formats.
Use JPEG
for on-screen output where file size is a concern and quality loss is acceptable.
All these formats support compression which can be important when rendering out animations.

Note
Quicktime
On OSX, Quicktime can be used to access file formats not natively supported (such as GIF).

Channel Depth
Image file formats support a varying number of bits per pixel. This effects the color quality and file-size.
13
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Commonly used depths:
8 bit (256 levels)
Most common for on-screen graphics and video
10,12,16 bit (1024,4096,65536 levels)
Used for some formats focusing on photography and digital film formats (such as DPX and JPEG 2000).
16 bit half float
Since full 32bit float is often more than enough precision, half float can save on disk-space while
providing high dynamic range.
32 bit float
Highest quality color depth.
Internally Bforartists’s image system supports either:
• 8 bit per channel (4 x 8 bits).
• 32 bit float per channel (4 x 32 bits) - using 4x as much memory.
Images higher than 8 bits per channel will be converted into float on loading into Bforartists.
Note
Floating point is often used for HDRI,
When an image has float colors, all imaging functions in Bforartists default to use that. This
includes the Video Sequence Editor, texture mapping, background images, and the
Compositor.

Metadata
Bforartists can save details such as render-time, marker, camera... etc, into the file. See: Render Metadata.
Only some files support this however.

Format Details
Cineon & DPX
Cineon is Kodak’s standard for film scanning, 10 bits/channel and logarithmic. DPX has been derived from
Cineon as the ANSI/SMPTE industry standard. DPX supports 16 bits color/channel, linear as well as
logarithmic. DPX is currently a widely adopted standard used in the film hardware/software industry.
DPX as well as Cineon only stores and converts the “visible” color range of values between 0.0 and 1.0 (as
result of rendering or composite).

OpenEXR
ILM’s OpenEXR has become a software industry standard for HDR image files, especially because of its
flexible and expandable structure.
An OpenEXR file can store multiple layers and passes. This means OpenEXR images can be loaded into a
compositor keeping render layers, passes intact.
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Output Options
Available options for OpenEXR render output are:
Half
Saves images in a custom 16 bits per channel floating point format. This reduces the actual “bit depth” to
10 bits, with a 5 bits power value and 1 bit sign.
Zbuf
Save the depth information. In Bforartists this now is written in floats too, denoting the exact distance
from the camera in “Bforartists unit” values.
Preview
On rendering animations (or single frames via command line), Bforartists saves the same image also as a
JPEG, for quick preview or download.
Compression
This button is below the Image menu button, default set to “None”
PIZ
lossless wavelet compression. Compresses images with grain well.
ZIP
standard lossless compression using zlib.
RLE
runlength encoded, lossless, works well when scanlines have same values.
PXR24
lossy algorithm from Pixar, converting 32 bits floats to 24 bits floats.

Radiance HDR
Radiance is a suite of tools for lighting simulation. Since Radiance had the first (and for a long time the only)
HDR image format, this format is supported by many other software packages.
Radiance (.hdr) files store colors still in 8 bits per component, but with an additional (shared) 8 bits exponent
value, making it 32 bits per pixel.

Supported Video Formats
Video Formats
These formats are primarily used for compressing rendered sequences into a playable movie (they can also be
used to make plain audio files).
A codec is a little routine that compresses the video so that it will fit on a DVD, or be able to be streamed out
over the Internet, over a cable, or just be a reasonable file size. Codecs compress the channels of a video down
to save space and enable continuous playback. Lossy codecs make smaller files at the expense of image quality.
Some codecs, like H.264, are great for larger images. Codecs are used to encode and decode the movie, and so
must be present on both the encoding machine (Bforartists) and the target machine. The results of the encoding
are stored in a container file.
There are dozens, if not hundreds, of codecs, including XviD, H.264, DivX, Microsoft, and so on. Each has
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advantages and disadvantages and compatibility with different players on different operating systems.
Most codecs can only compress the RGB or YUV color space, but some support the Alpha channel as well.
Codecs that support RGBA include:
• animation (quicktime)
• PNG TIFF Pixlet - not loss-less, and may be only available on Mac-OSX.
• Lagarith Loss-less Video Codec
AVI Codec
AVI codec compression. Available codecs are operating-system dependent. When an AVI codec is initially
chosen, the codec dialog is automatically launched. The codec can be changed directly using the Set
Codec button which appears (AVI Codec settings.).
AVI Jpeg
AVI but with Jpeg compression. Lossy, smaller files but not as small as you can get with a Codec
compression algorithm. Jpeg compression is also the one used in the DV format used in digital
camcorders.
AVI Raw
Audio-Video Interlaced (AVI) uncompressed frames.
Frameserver
Bforartists puts out frames upon request as part of a render farm. The port number is specified in the
OpenGL User Preferences panel.
H.264
Encodes movies with the H.264 codec. See Advanced Encoding.
MPEG
Encodes movies with the MPEG codec. See Advanced Encoding.
Ogg Theora
Encodes movies with the Theora codec as Ogg files. See Advanced Encoding.
QuickTime
Apple’s Quicktime .mov file. The Quicktime codec dialog is available when this codec is installed on
OSX. See Quicktime in Video Formats.
Xvid
Encodes movies with the Xvid codec. See Advanced Encoding.

Advanced Encoding

If the H.264, MPEG, Ogg Theora, or Xvid codecs are chosen, an Encoding panel becomes available. This has
settings for encoding these file types, and other formats using FFmpeg.
FFmpeg, short for Fast Forward Moving Pictures Expert Group, is a collection of free and open source software
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libraries that can record, convert and stream digital audio and video in numerous formats. It includes
libavcodec, an audio/video codec library used by several other projects, and libavformat, an audio/video
container mux and demux library.

Video Settings
Here you choose which video codec you want to use, and compression settings. With all of these compression
choices, there is a tradeoff between file size, compatibility across platforms, and playback quality.
When you view the System Console, you can see some of the output of the encoding process. You will see even
more output if you execute Bforartists as Bforartists -d.
You can use the presets, DV, SVCD, DVD, etc. which choose optimum settings for you for that type of output,
or you can manually select the format (MPEG-1, MPEG-2, MPEG-4, AVI, Quicktime (if installed), DV, H.264,
or Xvid (if installed). You must have the proper codec installed on your computer for Bforartists to be able to
call it and use it to compress the video stream.

Video Containers
MPEG-1: .mpg, .mpeg
A standard for lossy compression of video and audio. It is designed to compress VHS-quality raw digital
video and CD audio down to 1.5 Mbit/s.
MPEG-2: .dvd, .vob, .mpg, .mpeg
A standard for “the generic coding of moving pictures and associated audio information”. It describes a
combination of lossy video compression and lossy audio data compression methods which permit storage
and transmission of movies using currently available storage media and transmission bandwidth.
MPEG-4(DivX): .mp4, .mpg, .mpeg
Absorbs many of the features of MPEG-1 and MPEG-2 and other related standards, and adds new
features.
AVI: .avi
A derivative of the Resource Interchange File Format (RIFF), which divides a file’s data into blocks, or
“chunks.”
Quicktime: .mov
A multi-tracked format. QuickTime and MP4 container formats can use the same MPEG-4 formats; they
are mostly interchangeable in a QuickTime-only environment. MP4, being an international standard, has
more support.
DV: .dv
An intraframe video compression scheme, which uses the discrete cosine transform (DCT) to compress
video on a frame-by-frame basis. Audio is stored uncompressed.
H.264: .avi for now.
A standard for video compression, and is currently one of the most commonly used formats for the
recording, compression, and distribution of high definition video.
Xvid: .avi for now
A video codec library following the MPEG-4 standard. It uses ASP features such as b-frames, global and
quarter pixel motion compensation, lumi masking, trellis quantization, and H.263, MPEG and custom
quantization matrices. Xvid is a primary competitor of the DivX Pro Codec.
Ogg: .ogg, .ogv
A free lossy video compression format. It is developed by the Xiph.Org Foundation and distributed
without licensing fees.
Matroska: .mkv
An open standard free container format, a file format that can hold an unlimited number of video, audio,
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picture or subtitle tracks in one file.
Flash: .flv
A container file format used to deliver video over the Internet using Adobe Flash Player.
Wav: .wav
An uncompressed (or lightly compressed) Microsoft and IBM audio file format.
Mp3: .mp3
A highly-compressed, patented digital audio encoding format using a form of lossy data compression. It is
a common audio format for consumer audio storage, as well as a de facto standard of digital audio
compression for the transfer and playback of music on digital audio players.

Video Codecs
None
For audio-only encoding.
MPEG-1
See Video Formats.
MPEG-2
See Video Formats.
MPEG-4(DivX)
See Video Formats.
HuffYUV
Loss-less video codec created by Ben Rudiak-Gould which is meant to replace uncompressed YCbCr as a
video capture format.
DV
See Video Formats.
H.264
See Video Formats.
Xvid
See Video Formats.
Theora
See Ogg in Video Formats.
Flash Video
See Video Formats.
FFmpeg video codec #1
A.K.A. FFV1, a loss-less intra-frame video codec. It can use either variable length coding or arithmetic
coding for entropy coding. The encoder and decoder are part of the free, open-source library libavcodec in
FFmpeg.

Options
Bitrate
Set the average bitrate (quality), which is the count of binary digits per frame. See also: ffmpeg -b:v
Rate
The bitrate control also includes a Minimum and a Maximum.
Buffer
The decoder bitstream buffer size.
GOP Size
The number of pictures per Group of Pictures. Set to 0 for “intra_only”, which disables inter-frame video.
From ffmpeg docs: “For streaming at very low bitrate application, use a low frame rate and a small GOP
size. This is especially true for RealVideo where the Linux player does not seem to be very fast, so it can
miss frames”
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Autosplit Output
If your video is HUGE and exceeds 2Gig, enable Autosplit Output. The main control over output filesize
is the GOP, or keyframe interlace. A higher number generally leads to a smaller file, but needs a higherpowered device to replay it.
Mux
Multiplexing settings.
Rate
Maximum bit rate of the multiplexed stream.
Packet Size
(Undocumented in ffmpeg)
Note
Standards
Codecs cannot encode off-the-wall video sizes, so stick to the XY sizes used in the presets for standard TV
sizes.

Audio Settings
Audio is encoded using the codec you choose.
Audio Codecs
MP2
A lossy audio compression format defined by ISO/IEC 11172-3.
MP3
See MP3 in Video Formats above.)
AC3
Audio Codec 3, an audio compression technology developed by Dolby Laboratories.
AAC
Advanced Audio Codec,” a standardized, lossy compression and encoding scheme for digital audio.
AAC generally achieves better sound quality than MP3 at similar bit rates.
Vorbis
An open-standard, highly-compressed format comparable to MP3 or AAC.
Vorbis generally achieves better sound quality than MP3 at similar bit rates.
FLAC
Free Loss-less Audio Codec. Digital audio compressed by FLAC’s algorithm can typically be reduced to
50-60% of its original size, and decompressed into an identical copy of the original audio data.
PCM
Pulse Code Modulation, a method used to digitally represent sampled analog signals. It is the standard
form for digital audio in computers and various Blu-ray, Compact Disc and DVD formats, as well as other
uses such as digital telephone systems
Bitrate
For each codec, you can to control the bitrate (quality) of the sound in the movie. This example shows
MP3 encoding at 128kbps. Higher bitrates are bigger files that stream worse but sound better. Stick to
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powers of 2 for compatibility.
Samplerate
Samplerate controls the number of samples per second of the audio. The default, 44100, is standard for
many file types, including CD audio, and produces a high quality sound.
Volume
Set the output volume of the audio.

Tips
Choosing which format to use depends on what you are going to do with the image.
If you are animating a movie and are not going to do any post-processing or special effects on it, use either
AVI-JPEG or AVI Codec and choose the XviD open codec. If you want to output your movie with sound that
you have loaded into the VSE, use FFMPEG.
If you are going to do post-processing on your movie, it is best to use a frame set rendered as OpenEXR
images; if you only want one file, then choose AVI Raw. While AVI Raw is huge, it preserves the exact quality
of output for post-processing. After post-processing (compositing and/or sequencing), you can compress it
down. You don’t want to post-process a compressed file, because the compression artifacts might throw off
what you are trying to accomplish with the post-processing.
Note that you might not want to render directly to a video format. If a problem occurs while rendering, you
have to re-render all frames from the beginning. If you first render out a set of static images (such as the default
PNG, or the higher-quality OpenEXR), you can stitch them together with an Image Strip in the Video Sequence
Editor (VSE). This way, you can easily:
• Restart the rendering from the place (the frame) where the problem occurred.
• Try out different video options in seconds, rather than minutes or hours.
• Enjoy the rest of the features of the VSE, such as adding Image Strips from previous renders, audio,
video clips, etc.

Append and Link
These functions help you reuse materials, objects and other data-blocks loaded from an external source
.blend file. You can build libraries of common content and share them across multiple referencing files.
Link creates a reference to the data in the source file such that changes made there will be reflected in the
referencing file the next time it is reloaded.
Where as Append makes a full copy of the data into your .blend. You can make further edits to your local
copy of the data, but changes in the external source file will not be reflected in the referencing file.
Reference
Mode: All Modes
Menu: File –> Append or Link
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In the File Browser window navigate to the external source .blend file and select the data-block you want to
reuse.
Options:
Relative Path
Available only when linking, see relative paths.
Select
Makes the object Active after it is loaded.
Active Layer
Enabled by default, the object is assigned to the visible layers in your scene. Otherwise, it is assigned to
the same layers it resides on in the source file.
Instance Groups
This option links the Group to an object, adding it to the active scene.
When you select an Object type, it will be placed in your scene at the cursor. Many other data types - cameras,
curves, and materials for example - must be linked to an object before they become visible.
Newly added Group types are available in Add ‣ Group Instances in 3D View, or for NodeTree groups, the
same menu in the Node Editor.
Look in the Outliner, with display mode set to Bforartists File, to see all your linked and appended data-blocks.
Ctrl-LMB on a file name allows you to redirect a link to another file.
Hint
You cannot move a linked object. Its position is defined in its source file.
If you want to modify the object locally you can either:
Use Dupli-Groups
Instead of linking in Objects directly, its often more useful to link in Groups, which can be assigned to
empties and moved, while maintaining the link to the original file.
Its also useful to be able to add/remove objects from the group without having to manage linking in
multiple objects.
Make Objects Local
Use Object ‣ Make Local ‣ Selected Objects to make the position editable.
This means that object data (animation, constraints, modifiers...) will be local to your .blend file. But
the object-data will still be linked and remain immutable.

Note
Appending data you already have linked, will add objects / groups to the scene, but will keep them linked (and
un-editable).
This is done so existing relationships with linked data remain intact.
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Proxy Objects
Used with rigged models, proxy objects, allow specified bone layers to be linked back to the source file while
the remainder of the object and its skeleton are edited locally.
Ctrl-Alt-P* makes the active linked object into a local proxy, appending _proxy to its name.
* I hate it. Dear Blender developers. Ever thought that users wants to know WHAT TOOL is meant, not WHAT
HOTKEY ? - To Do
Set the Protected Layers in the source file using using the Skeleton panel of the Armatures tab. See Armature
Layers. The bones in protected layers will have their position restored from the source file when the referencing
file is reloaded.

Known Limitations
For the most part linking data will work as expected, however there are some corner-cases which aren’t
supported.

Circular Dependencies
In general dependencies shouldn’t go in both directions.
Attempting to link or append data which links back to the current file will likely result in missing links.

Object Rigid-Body Constraints
When linking objects directly into a .blend file, the Rigid Body settings won’t be linked in since they’re
associated with their scenes world.
As an alternative you could link in the entire scene and set it as a Background Set Scene.

22

Bforartists Reference Manual - © Copyright - This page is under OCL license

5.1 Modeling - Meshes
Modeling.................................................................................................................................................................6
Meshes.....................................................................................................................................................................7
Edit Mode................................................................................................................................................................7
Entering Edit Mode............................................................................................................................................7
Visualization.......................................................................................................................................................9
Tool Shelf..........................................................................................................................................................10
Properties Shelf.................................................................................................................................................11
Mesh Display...............................................................................................................................................12
Vertices, Edges and Faces......................................................................................................................................12
Vertices.............................................................................................................................................................13
Edges.................................................................................................................................................................13
Faces.................................................................................................................................................................13
Loops................................................................................................................................................................14
Edge Loops.......................................................................................................................................................14
Face Loops........................................................................................................................................................14
Mesh Primitives.....................................................................................................................................................15
Plane.................................................................................................................................................................16
Cube..................................................................................................................................................................16
Circle.................................................................................................................................................................16
UV Sphere.........................................................................................................................................................16
Icosphere...........................................................................................................................................................17
Cylinder............................................................................................................................................................17
Cone..................................................................................................................................................................17
Torus.................................................................................................................................................................18
Grid...................................................................................................................................................................18
Monkey.............................................................................................................................................................19
Add-ons.............................................................................................................................................................19
Mesh Analysis.......................................................................................................................................................19
Overhang...........................................................................................................................................................20
Thickness..........................................................................................................................................................20
Intersections......................................................................................................................................................21
Distortion..........................................................................................................................................................21
Sharp Edges......................................................................................................................................................22
Selecting................................................................................................................................................................22
Selecting Mesh Components.................................................................................................................................22
Selection Mode.................................................................................................................................................23
Select Mode Header Widgets.......................................................................................................................23
Select Mode Pop-up.....................................................................................................................................23
Switching Select Mode................................................................................................................................24
Multiple Selection Modes.......................................................................................................................24
Expanding Selection Modes....................................................................................................................24
Selection Tools..................................................................................................................................................25
Basic Selection......................................................................................................................................................26
Adding to a Selection........................................................................................................................................27
Selecting Elements in a Region........................................................................................................................27
Rectangular region (Border select)..............................................................................................................27
Circular region.............................................................................................................................................28
Lasso region.................................................................................................................................................29
Additional Selection Tools................................................................................................................................29
Advanced Selection...............................................................................................................................................30
1

Bforartists Reference Manual - © Copyright - This page is under OCL license

Select Linked....................................................................................................................................................30
Select Similar....................................................................................................................................................31
Selecting Loops................................................................................................................................................32
Edge Loops and Vertex Loops.....................................................................................................................32
Face Loops...................................................................................................................................................33
Edge Ring.....................................................................................................................................................34
Path Selection...............................................................................................................................................35
Loop Inner-Region.......................................................................................................................................35
Boundary Loop............................................................................................................................................36
Selecting Edges.....................................................................................................................................................37
Edge Loops.......................................................................................................................................................37
Edge Rings........................................................................................................................................................38
Selecting Faces......................................................................................................................................................39
Face Loops........................................................................................................................................................40
Ngons in Face Select Mode..............................................................................................................................41
Editing...................................................................................................................................................................41
Mesh Editing.........................................................................................................................................................41
Types of Tools...................................................................................................................................................42
Accessing Mesh Tools......................................................................................................................................42
Mesh Tools Palette.......................................................................................................................................42
Menus...........................................................................................................................................................42
Basics.....................................................................................................................................................................42
Basic Mesh Editing...............................................................................................................................................43
Translation, Rotation, Scale...................................................................................................................................43
Adding...................................................................................................................................................................43
Deleting and Merging............................................................................................................................................43
Delete................................................................................................................................................................44
Dissolve............................................................................................................................................................44
Convert Triangles to Quads..............................................................................................................................45
Unsubdivide......................................................................................................................................................45
Merging.............................................................................................................................................................45
Merging Vertices..........................................................................................................................................45
AutoMerge Editing......................................................................................................................................46
Remove Doubles..........................................................................................................................................46
Make Edge/Face....................................................................................................................................................46
Further Reading................................................................................................................................................49
Mirror Editing........................................................................................................................................................49
X-Mirror...........................................................................................................................................................49
Topology Mirror...............................................................................................................................................49
Mirror Modifier................................................................................................................................................50
Snap to Symmetry.............................................................................................................................................50
Symmetrize Mesh.............................................................................................................................................51
Mirroring Geometry..........................................................................................................................................52
Normals.................................................................................................................................................................52
Introduction.......................................................................................................................................................52
Displaying Normals..........................................................................................................................................52
Editing...............................................................................................................................................................53
Flip Direction...............................................................................................................................................53
Recalculate Normals....................................................................................................................................53
Vertex Tools...........................................................................................................................................................53
Merging.............................................................................................................................................................54
Merging Vertices..........................................................................................................................................54
AutoMerge Editing......................................................................................................................................54
2

Bforartists Reference Manual - © Copyright - This page is under OCL license

Remove Doubles..........................................................................................................................................54
Separating.........................................................................................................................................................55
Rip................................................................................................................................................................55
Examples.................................................................................................................................................55
Limitations..............................................................................................................................................57
Rip Fill.........................................................................................................................................................57
Split..............................................................................................................................................................58
Separate........................................................................................................................................................59
Connect Vertex Path..........................................................................................................................................59
Connect Vertices...............................................................................................................................................59
Vertex Slide.......................................................................................................................................................60
Smooth..............................................................................................................................................................61
Make Vertex Parent...........................................................................................................................................61
Add Hook..........................................................................................................................................................62
Blend From Shape, Propagate Shapes..............................................................................................................62
Edges.....................................................................................................................................................................62
Make Edge/Face...............................................................................................................................................62
Set Edge Attributes...........................................................................................................................................62
Mark Seam and Clear Seam.........................................................................................................................62
Mark Sharp and Clear Sharp........................................................................................................................63
Adjust Bevel Weight....................................................................................................................................63
Crease SubSurf.............................................................................................................................................63
Edge Slide.........................................................................................................................................................63
Usage............................................................................................................................................................64
Even mode...............................................................................................................................................64
Limitations & Workarounds....................................................................................................................65
Rotate Edge.......................................................................................................................................................65
Using Face Selection....................................................................................................................................66
Delete Edge Loop.............................................................................................................................................66
Example.......................................................................................................................................................66
Collapse............................................................................................................................................................67
Edge Split..........................................................................................................................................................68
Bridge Edge Loops...........................................................................................................................................68
Face Tools..............................................................................................................................................................71
Creating Faces..................................................................................................................................................71
Make Edge/Face...........................................................................................................................................71
Fill................................................................................................................................................................72
Beauty Fill....................................................................................................................................................73
Grid Fill........................................................................................................................................................74
Convert Quads to Triangles.........................................................................................................................74
Convert Triangles to Quads.........................................................................................................................74
Solidify.............................................................................................................................................................75
Rotate Edges.....................................................................................................................................................76
Normals........................................................................................................................................................77
Deforming.............................................................................................................................................................77
Mirror....................................................................................................................................................................77
Axis of symmetry.............................................................................................................................................78
Pivot point.........................................................................................................................................................78
Transformation orientation...............................................................................................................................79
Shrink/Fatten Along Normals................................................................................................................................79
Smooth...................................................................................................................................................................80
Laplacian Smooth.............................................................................................................................................81
Noise......................................................................................................................................................................82
3

Bforartists Reference Manual - © Copyright - This page is under OCL license

Push/Pull................................................................................................................................................................83
Description........................................................................................................................................................83
Usage............................................................................................................................................................84
Shear......................................................................................................................................................................85
Description........................................................................................................................................................85
Usage............................................................................................................................................................86
To Sphere...............................................................................................................................................................87
Description........................................................................................................................................................87
Usage............................................................................................................................................................88
Warp......................................................................................................................................................................89
Usage................................................................................................................................................................90
Cursor position and view.............................................................................................................................90
Example............................................................................................................................................................91
Bend.......................................................................................................................................................................91
Usage................................................................................................................................................................92
Duplicating............................................................................................................................................................93
Mesh Duplicating Tools.........................................................................................................................................93
Duplicate...............................................................................................................................................................93
Extrude..................................................................................................................................................................94
Extrude Region.................................................................................................................................................94
Extrude Individual............................................................................................................................................95
Extrude Edges and Vertices Only.....................................................................................................................95
Inset.......................................................................................................................................................................97
Options..............................................................................................................................................................98
Mirror....................................................................................................................................................................99
Description........................................................................................................................................................99
Usage..........................................................................................................................................................100
Spin......................................................................................................................................................................100
Example..........................................................................................................................................................101
Angle..........................................................................................................................................................102
Dupli..........................................................................................................................................................103
Merge Duplicates.......................................................................................................................................104
Recalculate Normals..................................................................................................................................104
Screw Tool...........................................................................................................................................................104
Introduction.....................................................................................................................................................104
Description......................................................................................................................................................105
Usage..............................................................................................................................................................106
Limitations......................................................................................................................................................106
Options............................................................................................................................................................107
Examples.........................................................................................................................................................109
The Spring example...................................................................................................................................109
Clockwise and Counterclockwise using the Spring Example....................................................................110
Bending the Profiles using the Spring Example.........................................................................................111
Creating perfect Screw Spindles................................................................................................................112
A Screw Tip................................................................................................................................................114
Subdividing..........................................................................................................................................................116
Mesh Subdividing Tools......................................................................................................................................116
Subdivide.............................................................................................................................................................116
Options............................................................................................................................................................117
Examples.........................................................................................................................................................119
One Edge....................................................................................................................................................119
Two Tri Edges............................................................................................................................................120
Two Opposite Quad Edges.........................................................................................................................120
4

Bforartists Reference Manual - © Copyright - This page is under OCL license

Two Adjacent Quad Edges.........................................................................................................................120
Three Edges................................................................................................................................................121
Tri...............................................................................................................................................................122
Quad/Four Edges.......................................................................................................................................122
Multicut......................................................................................................................................................122
Loop Subdivide...................................................................................................................................................123
Usage..............................................................................................................................................................123
Options............................................................................................................................................................124
Knife Tool............................................................................................................................................................125
Usage..............................................................................................................................................................126
Options............................................................................................................................................................127
Confirming and selection................................................................................................................................128
Limitations......................................................................................................................................................128
Knife Project..............................................................................................................................................129
Examples.........................................................................................................................................................129
Known Issues..................................................................................................................................................131
Mesh Bisect.........................................................................................................................................................131
Vertex Connect....................................................................................................................................................132
Bevel....................................................................................................................................................................133
Bevel Modifier................................................................................................................................................134
Usage..............................................................................................................................................................134
Options............................................................................................................................................................135
Examples.........................................................................................................................................................137
Miscellaneous Editing Tools...............................................................................................................................137
Sort Elements..................................................................................................................................................138
Vertex Groups......................................................................................................................................................138
Typical usage scenarios for Vertex groups.....................................................................................................139
Creating Vertex Groups..................................................................................................................................139
Vertex Groups Panel Controls....................................................................................................................140
Deleting vertex Groups...................................................................................................................................140
Locking Vertex Groups...................................................................................................................................141
Working with Content of Vertex Groups........................................................................................................141
Assigning verts to a Group.........................................................................................................................142
Checking Assignments...............................................................................................................................142
Removing assignments from a Group........................................................................................................142
Using groups for Selecting/Deselecting.....................................................................................................143
Finding ungrouped verts............................................................................................................................143
Vertex Group Management.............................................................................................................................144
Hints................................................................................................................................................................145
Weight Editing.....................................................................................................................................................145
Vertex Group Categories.................................................................................................................................145
The Deform Groups...................................................................................................................................145
The Other Groups.......................................................................................................................................146
The Weight Table.......................................................................................................................................146
Set the Active Group.......................................................................................................................................146
Display Weights in Edit Mode........................................................................................................................147
Edit Weights in Edit Mode..............................................................................................................................147
Change a weight.............................................................................................................................................147
Paste a weight to other verts...........................................................................................................................147
Delete a weight from a Group........................................................................................................................148
The Function bar........................................................................................................................................148
About locked Vertex Groups......................................................................................................................148
Smoothing...........................................................................................................................................................149
5

Bforartists Reference Manual - © Copyright - This page is under OCL license

Mesh Shading.................................................................................................................................................149
Smooth shading..........................................................................................................................................149
Smoothing parts of a mesh....................................................................................................................150
Auto Smooth..............................................................................................................................................150
Edge Split Modifier....................................................................................................................................151
Smoothing the mesh geometry...................................................................................................................151
Mesh editing tools.................................................................................................................................151
Modifiers...............................................................................................................................................152
Mesh Clean-up....................................................................................................................................................153
Fill Holes........................................................................................................................................................153
Split Non-Planar Faces...................................................................................................................................153
Delete Loose Geometry..................................................................................................................................153
Degenerate Dissolve.......................................................................................................................................153

Modeling
The creation of a 3D scene needs at least three key components: Models, Materials and Lights. In this part, we
will delve deeper into the creation of the first of these: modeling. Modeling is the art and science of creating a
surface that either mimics the shape of a real-world object or expresses your imagination of abstract objects.
There are three primary types of modeling - mesh modeling, curve/surface modeling, and meta modeling.
Mesh Modeling
is done within the 3D View and typically begins with a primitive shape (e.g. circle, cube, cylinder...).
This Mesh Primitive is defined by an array of points in 3D space called vertices (singular form is Vertex).
From there you might begin extruding faces and moving vertices to create a larger, more complex shape.
Mesh Modeling Modes
The 3D View has three principal modes that allow for the creation of, editing and manipulation of
the mesh models. Each of the three modes have a variety of tools. Some tools may be found in one
or more of the modes.
Modes that used for modeling:
• Object Mode
• Edit Mode
• Sculpt Mode
Creation of a mesh primitive typically starts by adding a mesh object in Object Mode. Limited types
of editing such as size, location, and orientation can be accomplished in Object Mode. Object mode
also provides the means to Join and Group multiple mesh primitives.
More detailed editing of the mesh model shape is done in Edit Mode, and Sculpt Mode. The nature
of these three modes determines the tools that are available within the various panels of the 3D
View. Switching between modes while modeling is common. Some tools may be available in more
than one mode while others may be unique to a particular mode.
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Curve modeling
Uses control points to define the shape of the curve.
Surface modeling
Similar to curve modeling, but instead of being limited to simple linear paths, they allow the creation of
three dimensional surfaces, potentially with volume.
Meta Object (Metaball) Modeling
begins similarly to mesh modeling, with a base shape like a cube or sphere, but instead of extruding these
base shapes, these objects are clumped together to form a larger object. In order to accomplish this, the
metaballs have a liquid-like quality, when two or more are brought together they merge by smoothly
rounding out the point of connection, appearing as one unified object.
This can also be a quick way to get started with a rough shape which can be converted to a mesh later.
Text Modeling inserting text is quite common for the creation of logos, and can be seen as a special case of neither curve
nor mesh modeling.
You may define the text, font, bevel, extruded width and several other parameters that control generated
object.
Scripted Modeling
Since Bforartists functionality is extensible via Python scripting, there are a number of very useful scripts
that assist you in modeling. They may give you new mesh primitives to work with, or apply some fancy
manipulation of the meshes that you are already working with.
Modeling scripts are an advanced topic, while not essential automating some tasks can be a huge time
saver in certain cases.

Meshes
Meshes are the polygonal objects.

Edit Mode
Entering Edit Mode
You can work with geometric objects in two modes.
Object Mode
Operations in Object Mode affect the whole object. Object Mode has the following header in the 3D
view:

Object Mode Header.
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Edit mode
Operations in Edit mode affect only the geometry of an object, but not global properties such as location
or rotation. Edit Mode has the following header in the 3D view:

Edit Mode Header.

Tools and modes in the 3D view header are (left to right):
•
•
•
•
•
•
•
•
•
•

View, Select, and Mesh menus
Bforartists Mode
Display method for 3D view
Pivot center
3D manipulator widget
Selection mode
Depth buffer clipping (hide
Proportional editing
Snap
OpenGL render

You can switch between the Object and Edit modes with the Tab key. You can change to any mode by selecting
the desired Mode in the menu in the 3d view header.
After creating an object youd may be immediately placed in Edit mode - depending on whether the Switch to
Edit Mode button is toggled in the User Preferences Editing tab. Edit mode only applies to one object at a time,
the active, or most recently selected, object.
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Visualization

One cube selected

Two cubes selected before entering Edit mode
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By default, Bforartists highlights selected geometry in orange in both Object mode and Edit mode.
In Object mode with Wireframe shading enabled , objects are displayed in black when unselected and in orange
when selected. If more than one object is selected, all selected object except the active object, typically the
object last selected, is displayed in a darker orange color. Similarly, in Edit mode, unselected geometry is drawn
in black while selected faces, edges, or vertices are drawn in orange. The active face is highlighted in white.
In Edit mode, only one mesh can be edited at the time. However, several objects can be joined into a single
mesh and then separated again. If multiple objects are selected before entering Edit mode, all the selected
objects remain highlighted in orange indicating that they are part of the active selection set.
If two vertices joined by an edge are selected in Vertex selection mode, the edge between them is highlighted
too. Similarly, if enough vertices or edges are selected to define a face, that face is also highlighted.

Tool Shelf
When entering Edit mode, several mesh tools become available.
Even more mesh editing tools can be enabled in the User Preferences ‘ Add-ons section.
For further information on panels see Panels.
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Properties Shelf

The Properties Shelf panel in edit mode (panel split in two parts for layout reasons)

In the Properties Shelf, panels directly related to mesh editing are the Transform panel, where numeric values
can be entered, and the Mesh Display panel, where for example normals and numeric values for distances,
angles, and areas can be turned on.
Other useful tools are found in the Properties Editor under the Object ‘s and Object Data ‘s Context buttons,
including display options and Vertex groups.
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Mesh Display

Mesh Display Panel

This panel is available only in edit mode, when the object being edited is a mesh.
The Overlays section provides controls for highlighting parts of the mesh.
Edges
Toggles the option to see the selected edges highlighted. If enabled the edges that have both vertices
selected will be highlighted This only affects in vertex selection mode and when UV Unwrapping.
Faces
Defines if the selected faces will be highlighted in the 3D Viewport. This affects all selection modes.
Creases and Bevel Weight
Highlights edges marked with a crease weight for the Subdivision Surface Modifier and/or a bevel weight
for the Bevel Modifier, respectively. In both cases, the higher the weight, the brighter the highlight.
Seams and Sharp
Highlights edges marked as an UV seam for unwrapping and/or sharp edges for the Edge Split Modifier
Normals Section:
We can choose to show or not the normals of faces and/or vertices using the Face and Vertex tick boxes, under
the Normals section. In addition, we can define the size of these with Normal Size.
The Numerics section lets us see some numerical measures of the selected elements on screen:
Edge Length
shows the lenghts, in Bforartists units, of the selected edges.
Face Angles and Face Area
show the angles (in degrees) and area (in square Bforartists units) of the selected faces.

Vertices, Edges and Faces
With meshes, everything is built from three basic structures: Vertices, Edges and Faces.
12
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Vertices

Vertex example

A vertex is primarily a single point or position in 3D space. It is usually invisible in rendering and in Object
mode. Don’t mistake the center point of an object for a vertex. It looks similar, but it’s bigger and you can’t
select it. (Vertex example) shows the center point labeled as A. B and C are vertices.
A simple way to create a new vertex is to click Ctrl-LMB in Edit mode. Of course, as a computer screen is
two-dimensional, Bforartists can’t determine all three vertex coordinates from a single mouse click, so the new
vertex is placed at the depth of the 3D cursor. Using the method described above, any vertices selected
previously are automatically connected to the new ones by an edge. In the image above, the vertex labeled C is
a new vertex added to the cube with a new edge added between in B and C.

Edges
An edge always connects two vertices by a straight line. The edges are the “wires” you see when you look at a
mesh in wireframe view. They are usually invisible on the rendered image. They are used to construct faces.

Faces
Faces are used to build the actual surface of the object. They are what you see when you render the mesh. If this
area does not contain a face, it will simply be transparent or non-existent in the rendered image.
A face is defined as the area between either three (triangles), four (quadrangles) or more (ngons) vertices, with
an edge on every side. These are often abbreviated to tris, quads & ngons.
Triangles are always flat and therefore easy to calculate. On the other hand, quadrangles “deform well” and are
therefore preferred for subdivision modeling.
While you could build a cube with triangular faces, it would just look more confusing in Edit mode.
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Loops

Edge and Face Loops

Edge and Face Loops are sets of faces or edges that form continuous “loops” as shown in (Edge and Face
Loops). The top row (1 - 4) shows a solid view, the bottom row (5 - 8) a wireframe view of the same loops.
Note that loops 2 and 4 do not go around the whole model. Loops stop at so called poles because there is no
unique way to continue a loop from a pole. Poles are vertices that are connected to either three, five, or more
edges. Accordingly, vertices connected to exactly one, two or four edges are not poles.
In the image above, loops that do not end in poles are cyclic (1 and 3). They start and end at the same vertex
and divide the model into two partitions. Loops can be a quick and powerful tool to work with specific,
continuous regions of a mesh and are a prerequisite for organic character animation. For a detailed description
of how to work with loops in Bforartists, see: Advanced Selection.

Edge Loops
Loops 1 and 2 in (Edge and Face Loops) are edge Loops. They connect vertices so that each one on the loop
has exactly two neighbors that are not on the loop and placed on both sides of the loop (except the start and end
vertex in case of poles).
Edge Loops are an important concept especially in organic (subsurface) modeling and character animation.
When used correctly, they allow you to build models with relatively few vertices that look very natural when
used as subdivision surfaces and deform very well in animation.
Take (Edge Loops in organic modeling) as an example: the edge loops follow the natural contours and
deformation lines of the skin and the underlying muscles and are more dense in areas that deform more when
the character moves, for example at the shoulders or knees.
Further details on working with Edge Loops can be found in Edge Loop Selection.

Face Loops
These are a logical extension of Edge Loops in that they consist of the faces between two Edge Loops, as
shown in loops 3 and 4 in (Edge and Face Loops). Note that for non-circular loops (4) the faces containing the
poles are not included in a Face Loop.
14
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Further details on working with Face Loops can be found in Face Loop Selection.

Mesh Primitives
Reference
Mode: Object mode
Menu: Toolshelf > Add Primitive
A common object type used in a 3D scene is a mesh. Bforartists comes with a number of “primitive” mesh
shapes that you can start modeling from.

Bforartists’s ten standard primitives

Options included in more than one primitive are:
Radius
Sets the starting size for Circle, Cylinder, Cone, UVSphere and IcoSphere.
Depth
Sets the starting length for Cylinder and Cone.
Note
Note about planar primitives
You can make a planar mesh three-dimensional by moving one or more of the vertices out of its plane (applies
to Plane, Circle and Grid). A simple circle is actually often used as a starting point to create even the most
complex of meshes.
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Plane
A standard plane contains four vertices, four edges, and one face. It is like a piece of paper lying on a table; it is
not a real three-dimensional object because it is flat and has no thickness. Objects that can be created with
planes include floors, tabletops, or mirrors.

Cube
A standard cube contains eight vertices, twelve edges, and six faces, and is a real three-dimensional object.
Objects that can be created out of cubes include dice, boxes, or crates.

Circle
A standard circle is comprised of n vertices. The number of vertices and radius can be specified in the context
panel in the Tool Shelf which appears when the circle is created.
Vertices
The number of vertices that define the circle. The more vertices the circle contains, the smoother its
contour will be; see (“Circles” obtained with various settings). In contrast, a circle with only 3 vertices is
actually a triangle - the circle is actually the standard way of adding polygons such as triangles,
pentagons, et cetera.
Radius
Sets the radius of the circle.
Fill Type
Set how the circle will be filled
Triangle Fan
Fill with triangular faces which share a vertex in the middle.
Ngon
fill with a single ngon
Nothing
Do not fill. Creates only the outer ring of vertices

UV Sphere
A standard UV sphere is made out of n segments and m rings. The level of detail and radius can be specified in
the context panel in the Tool Shelf which appears when the UV sphere is created. Increasing the number of
segments and rings makes the surface of the UV sphere smoother.
Segments
Number of vertical segments. Like Earth’s meridians, going pole to pole and
Rings
Number of horizontal segments. These are like Earth’s parallels.
Note
If you specify a six segment, six ring UVsphere you’ll get something which, in top view, is a hexagon (six
segments), with five rings plus two points at the poles. Thus, one ring fewer than expected, or one more, if you
count the poles as rings of radius 0.
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Icosphere
An icosphere is a polyhedra sphere made up of triangles. The number of subdivisions and radius can be
specified in the context panel in the Tool Shelf after the Icosphere is created. Icospheres are normally used to
achieve a more isotropical and economical layout of vertices than a UV sphere.
Subdivisions
How many recursions are used to define the sphere. Increasing the number of subdivisions makes the
surface of the Icosphere smoother. At level 1 the Icosphere is an icosahedron, a solid with 20 equilateral
triangular faces. Any increasing level of subdivision splits each triangular face into four triangles,
resulting in a more spherical appearance.
Size
The radius of the sphere.
Note
It is possible to add an icosphere subdivided 500 times. Adding such a dense mesh is a sure way to cause a
program crash. An icosphere subdivided 10 times would have 5,242,880 triangles, so be very careful about
this!

Cylinder
A standard cylinder is made out of n vertices. The number of vertices in the circular cross-section can be
specified in the context panel in the Tool Shelf that appears when the object is created; the higher the number of
vertices, the smoother the circular cross-section becomes. Objects that can be created out of cylinders include
handles or rods.
Vertices
Then number of vertical edge loops used to define the cylinder. Similarly to the circle, specifying a small
number of vertices produces an object with a polygonal cross section (a prism).
Radius
Sets the radius of the cylinder.
Depth
Sets the height of the cylinder.
Cap Fill Type
Similar to circle (see above). When set to none, the created object will be a tube. Objects that can be
created out of tubes include pipes or drinking glasses (the basic difference between a cylinder and a tube
is that the former has closed ends).

Cone
A standard cone is made out of n vertices. The number of vertices in the circular base, dimensions and option to
close the base of the cone can be specified in the context panel in the Tool Shelf that appears when the object is
created; the higher the number of vertices, the smoother the circular base becomes. Objects that can be created
out of cones include spikes or pointed hats.
Vertices
The number of vertical edge loops used to define the cone. Similarly to the circle and cylinder, specifying
a small number of vertices produces an object with a polygonal base section (a pyramid).
Radius 1
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Bforartists Reference Manual - © Copyright - This page is under OCL license

Sets the radius of the base of the cone.
Radius 2
Sets the radius of the tip of the cone. A value of 0 will produce a standard cone shape.
Depth
Sets the height of the cylinder.
Base Fill Type
Similar to circle (see above).

Torus
A doughnut-shaped primitive created by rotating a circle around an axis. The overall dimensions are defined by
the Major and Minor Radius. The number of vertices (in segments) can be different for the circles and is
specified in the context panel in the Tool Shelf with both radii (Major Segments and Minor Segments).
Major Radius
Radius from the origin to the center of the cross sections
Minor Radius
Radius of the torus’s cross section
Major Segments
Number of segments for the main ring of the torus. If you think of a torus as a “spin” operation around an
axis, this is how many steps in the spin.
Minor segments
Number of segments for the minor ring of the torus. This is the number of vertices of each circular
segment.
Use Int+Ext Controls
Change the way the torus is defined:
Exterior Radius
When Use Int+Ext Controls is active, if viewed along the major axis, this is the radius from the center to
the outer edge.
Interior Radius
When Use Int+Ext Controls is active, if viewed along the major axis, this is the radius of the hole in the
center.

Grid
A standard grid is made out of n by m vertices. The resolution of the x-axis and y-axis can be specified in the
context panel in the Tool Shelf which appears when the object is created; the higher the resolution, the more
vertices are created. Example objects that can be created out of grids include landscapes (with the proportional
editing tool or Displace modifier) and other organic surfaces. You can also obtain a grid when you create a
plane and then use a subdivide modifier in Edit mode. However, there is a Landscape add-on available in the
User Preferences.
X Subdivisions
The number of spans in the x direction. Minimum of 3, creating two face loops.
Y Subdivisions
The number of spans in the y direction.
Size
The length of the sides of the grid.
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Monkey
This is a gift from old NaN to the community and is seen as a programmer’s joke or “Easter Egg”. It creates a
monkey’s head once you press the Monkey button. The Monkey’s name is “Suzanne” and is Bforartists’s
mascot. Suzanne is very useful as a standard test mesh, much like the Utah Tea Pot or the Stanford Bunny.

Add-ons

A few of the mesh primitives available as add-ons.

In addition to the basic geometric primitives, Bforartists has a constantly increasing number of script generated
meshes to offer as pre-installed add-ons. These become available when enabled in the User Preferences ‘ Addons section (filter by Add Mesh). Only a few are mentioned here:
Landscape
Adds a landscape primitive. Many parameters and filters appear in the Tool Shelf.
Pipe Joints
Adds one of five different pipe joint primitives. Radius, angle, and other parameters can be changed in the
Tool Shelf.
Gears
Adds a gear or a worm with many parameters to control the shape in the Tool Shelf.

Mesh Analysis
Mesh analysis is useful for displaying attributes of the mesh that may impact certain use cases.
The mesh analysis works in editmode and shows areas with a high value in red, and areas with a low value in
blue. Geometry outside the range is displayed grey.
Currently the different modes target 3d-printing as their primary use.
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Overhang

Overhang

Extrusion 3D printers have a physical limit to the overhang that can be printed, this display mode shows the
overhang with angle range and axis selection.

Thickness

Thickness

Printers have a limited wall-thickness where very thin areas can’t be printed, this test uses ray casting and a
distance range to the thickness of the geometry.
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Intersections

Intersecting faces

Another common cause of problems for printing are intersections between surfaces, where the inside/outside of
a model can’t be reliably detected.
Unlike other display modes, intersections have no variance and are either on or off.

Distortion

Distorted Faces

Distorted geometry can cause problems since the triangulation of a distorted ngon is undefined.
Distortion is measured by faces which are not flat, with parts of the face pointing in different directions.
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Sharp Edges

Sharp edges

Similar to wall-thickness, sharp edges can form shapes that are too thin to be able to print.
Warning
There are some known limitations with mesh analysis
• Currently only displayed with deform modifiers.
• For high-poly meshes is slow to use while editing the mesh.

Selecting

Selecting Mesh Components
There are many ways to select elements, and it depends on what Mesh Select Mode you are in as to what
selection tools are available. First we will go through these modes and after that a look is taken at basic
selection tools.
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Selection Mode
Select Mode Header Widgets

Edit mode selection buttons

In Edit mode there are three different selection modes. You can enter the different modes by selecting one of the
three buttons in the toolbar.
Vertices
In this mode vertices are drawn as points.
Selected vertices are drawn in orange, unselected vertices in black, and the active or last selected vertex in
white.
Edges
In this mode the vertices are not drawn.
Instead the selected edges are drawn in orange, unselected edges black, and the active or last selected
edge in white.
Faces
In this mode the faces are drawn with a selection point in the middle which is used for selecting a face.
Selected faces and their selection point are drawn in orange, unselected faces are drawn in black, and the
active or last selected face is highlighted in white.
When using these button, you can make use of modifier keys, see: Switching Select Mode.
Almost all tools are available in all three mesh selection modes. So you can Rotate, Scale, Extrude, etc. in all
modes. Of course rotating and scaling a single vertex will not do anything useful (without setting the pivot
point to another location), so some tools are more or less applicable in some modes.

Select Mode Pop-up
Reference
Mode: Edit mode
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Mesh Select Mode menu

You can choose a selection mode with the pop-up menu:
Select Mode ‣ Vertices
Select Mode ‣ Edges
Select Mode ‣ Faces
You can assign a hotkey to access the modes faster. The standard Bforartists keymap has assigned the keys 1 to
8 above the letter area to do so.
When using this menu, you can make use of modifier keys, see: Switching Select Mode.

Switching Select Mode
When switching modes in an “ascendant” way (i.e. from simpler to more complex), from Vertices to Edges and
from Edges to Faces, the selected parts will still be selected if they form a complete element in the new mode.
For example, if all four edges in a face are selected, switching from Edges mode to Faces mode will keep the
face selected. All selected parts that do not form a complete set in the new mode will be unselected.
Hence, switching in a “descendant” way (i.e. from more complex to simpler), all elements defining the “highlevel” element (like a face) will be selected (the four vertices or edges of a quadrangle, for example).

Multiple Selection Modes
By holding Shift-LMB when selecting a selection mode, you can enable multiple Selection Modes at once.
This allows you to quickly select Vertices/Edges/Faces, without first having to switch modes.

Expanding Selection Modes
By holding Ctrl when selecting a higher selection mode, all elements touching the current selection will be
added, even if the selection does not form a complete higher element.
See (Vertices mode example), (Edges mode example), (Faces mode example) and (Mixed mode example) for
examples of the different modes.
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Vertices mode example.

Edges mode example.

Faces mode example.

Mixed mode example.

Selection Tools
The select menu in edit mode contains tools for selecting components. These are described in more detail in the
following pages.
Border Select
Enables a rectangular region for selection
Circle Select
Enables a circular shaped region for selection
(De)select All
Select all or none of the mesh components.
Invert Selection
Selects all geometry that are not selected, and deselect currently selected components.
Select Random
Selects a random group of vertices, edges, or faces, based on a percentage value.
Checker Deselect
Deselect alternating faces, to create a checker like pattern.
Select Sharp Edges
This option will select all edges that are between two faces forming an angle less than a given value,
which is asked you via a small pop-up dialog. The lower is this angle limit, the sharper will be the
selected edges. At 180, all manifold edges will be selected.
Linked Flat Faces
Select connected faces based on a threshold of the angle between them. This is useful for selecting faces
that are planar.
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Interior Faces
Select faces where all edges have more than 2 faces.
Side of Active
Selects all data on the mesh in a single axis
Select Faces by Sides
Selects all faces that have a specified number of edges.
Non Manifold
Selects non-manifold geometry. See Mesh Advanced Selection.
Loose
Select all vertices or edges that do not form part of a face.
Similar
Select geometry based on how similar certain properties are to it.
Note
The items shown in the menu depend on the Selection Mode.

More
Propagates selection by adding geometry that are adjacent to selected elements.
Less
Deselects geometry that form the bounds of the current selection
Mirror
Select mesh items at the mirrored location.
Pick Linked
Selects all geometry connected to the geometry under the cursor.
Linked
Selects all geometry that are connected to the current selection.
Vertex Path
Selects a vertex path between two selected vertices
Edge Loop
Selects a loop of edges from a selected edge
Edge Ring
Selects edges parallel to a selected edge in the same ring of faces
Loop Inner-Region
Converts a closed selection of edges to the region of faces it encloses
Boundary Loop
Converts a selection of faces to the ring of edges enclosing it

Basic Selection
Reference
Mode: Edit mode

The most common way to select an element is to RMB on that item; this will replace the existing selection with
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the new item.

Adding to a Selection
To add to the existing selection, hold down Shift while right clicking. Clicking again on a selected item will
deselect it.
As in Object mode, there is a unique active element, displayed in a lighter shade (in general, the last element
selected). Depending on the tools used, this element might be very important!
Note that there is no option to choose what element to select between overlapping ones (like the Alt-RMB
click in Object mode). However, if you are in solid, shaded, or textured viewport shading mode (not bounding
box or wireframe), you will have a fourth button in the header that looks like a cube, just right of the select
mode ones.
When enabled, this limits your ability to select based on visible elements (as if the object was solid), and
prevents you from accidentally selecting, moving, deleting or otherwise working on backside or hidden items.

Selecting Elements in a Region
Reference
Mode: Edit mode

Region selection allows you to select groups of elements within a 2D region in your 3D view. The region can be
either a circle or rectangle. The circular region is only available in Edit mode. The rectangular region, or Border
Select, is available in both *Edit mode and Object mode.

Note
What is selected using both these tools is affected by the Limit Selection to visible feature (available under the
3D viewport) in Solid Viewport Shading Mode.
For example,
• in solid shading mode and face selection mode, all faces within the selection area will be selected;
• whilst in the wireframe shading mode and face selection mode, only faces whose handle are within the
selection area will be selected.

Rectangular region (Border select)
Border Select is available in either Edit mode or Object mode. To activate the tool use the B. Use Border Select
to select a group of objects by drawing a rectangle while holding down LMB. In doing this you will select all
objects that lie within or touch this rectangle. If any object that was last active appears in the group it will
become selected and active.
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Start

Selecting

Complete

In (Start), Border Select has been activated and is indicated by showing a dotted cross-hair cursor. In
(Selecting), the selection region is being chosen by drawing a rectangle with the LMB. The selection area is only
covering the selection handles of three faces. Finally, by releasing LMB the selection is complete; see
(Complete).
Reference
Border select adds to the previous selection, so in order to select only the contents of the rectangle, deselect all
with A first. In addition, you can use MMB while you draw the border to deselect all objects within the
rectangle.

Circular region
This selection tool is only available in Edit mode and can be activated with C. Once in this mode the cursor
changes to a dashed cross-hair with a 2D circle surrounding it. The tool will operate on whatever the current
select mode is. Clicking or dragging with the LMB, causing elements to be inside the circle will cause those
elements to be selected.
You can enlarge or shrink the circle region using NumpadPlus and NumpadMinus, or the Wheel.
Circle Region Select
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Before

After

(Circle Region Select) is an example of selecting edges while in Edge Select Mode. As soon as an edge
intersects the circle the edge becomes selected. The tool is interactive such that edges are selected while the
circle region is being dragged with the LMB.
If you want to deselect elements, hold MMB and begin clicking or dragging again.
For Faces select mode, the circle must intersect the face indicators usually represented by small pixel squares;
one at the center of each face.
To exit from this tool, click RMB, or press the Esc key.

Lasso region
Lasso select is similar to Border select in that you select objects based on a region, except Lasso is a handdrawn region that generally forms a circular/round-shaped form; kind of like a lasso.
Lasso is available in either Edit Mode or Object Mode. To activate the tool use the Ctrl-LMB while dragging.
The one difference between Lasso and Border select is that in Object mode, Lasso only selects objects where
the lasso region intersects the objects’ center.
To deselect, use Ctrl-Shift-LMB while dragging.
Lasso selection

Start

Selecting

Complete

(Lasso selection) is an example of using the Lasso select tool in Vertex Select Mode.

Additional Selection Tools
The select menu in edit mode contains additional tool for selecting components:
(De)select All
Select all or none of the mesh components.
Invert Selection
Selects all components that are not selected, and deselect currently selected components.
More
Propagates selection by adding components that are adjacent to selected elements.
Less
Deselects components that form the bounds of the current selection
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Advanced Selection
The select menu in edit mode contains additional tool for selecting components:
Mirror
Select mesh items at the mirrored location.
Linked
Selects all components that are connected to the current selection. (see Select Linked)
Random
Selects a random group of vertices, edges, or faces, based on a percentage value.
Checker Deselect
Deselect alternating faces, to create a checker like pattern.
Select Every N Number of Vertices
Selects vertices that are multiples of N.
Sharp Edges
This tool selects all edges between two faces forming an angle greater than the angle option, Where an
increasing angle selects sharper edges.
Linked Flat Faces
Select connected faces based on a threshold of the angle between them. This is useful for selecting faces
that are planar.
Non Manifold
Selects the non-manifold geometry of a mesh. This entry is available when editing a mesh, in Vertex and
Edge selection modes only. The redo panel provides several selection options:
Extend
Lets you extend the current selection.
Wire
Selects all the edges that don’t belong to any face.
Boundaries
Selects edges in boundaries and holes.
Multiple Faces
Selects edges that belong to 3 or more faces.
Non Contiguous
Selects edges that belong to exactly 2 faces with opposite normals.
Vertices
Selects vertices that belong to wire and multiple face edges, isolated vertices, and vertices that
belong to non adjoining faces.
Interior Faces
Select faces where all edges have more than 2 faces.
Side of Active
Selects all data on the mesh in a single axis
Select Faces by Sides
Selects all faces that have a specified number of edges.
Loose Geometry
Select all vertices or edges that do not form part of a face.

Select Linked
Reference
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Mode: Edit mode
Menu: Select ‣ Linked

Select parts of a mesh connected to already selected elements. This is often useful when a mesh has
disconnected, overlapping parts, where isolating it any other way would be tedious.
To give more control, you can also enable delimiters so the selection is constrained by seans, sharp-edges,
materials or UV islands.
Hint
You can also select linked data directly under the cursor, using the L shortcut to select or Shift-L to deselect
linked.
This works differently in that it uses the geometry under the cursor instead of the existing selection.

Select Similar
Reference
Mode: Edit mode
Menu: Select ‣ Similar...

Select components that have similar attributes to the ones selected, based on a threshold that can be set in tool
properties after activating the tool. Tool options change depending on the selection mode:
Vertex Selection Mode:
Normal
Selects all vertices that have normals pointing in similar directions to those currently selected.
Amount of Adjacent Faces
Selects all vertices that have the same number of faces connected to them.
Vertex Groups
Selects all vertices in the same vertex group.
Amount of connecting edges
Selects all vertices that have the same number of edges connected to them.
Edge Selection Mode:
Length
Selects all edges that have a similar length as those already selected.
Direction
Selects all edges that have a similar direction (angle) as those already selected.
Amount of Faces Around an Edge
Selects all edges that belong to the same number of faces.
Face Angles
Selects all edges that are between two faces forming a similar angle, as with those already selected.
Crease
Selects all edges that have a similar Crease value as those already selected. The Crease value is a
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setting used by the Subsurf Modifier.
Bevel
Selects all edges that have the same Bevel Weight as those already selected.
Seam
Selects all edges that have the same Seam state as those already selected. Seam is a true/false setting
used in UV-texturing.
Sharpness
Selects all edges that have the same Sharp state as those already selected. Sharp is a true/false
setting (a flag) used by the EdgeSplit Modifier.
Face Selection Mode:
Material
Selects all faces that use the same material as those already selected.
Image
Selects all faces that use the same UV-texture as those already selected (see UV-texturing pages).
Area
Selects all faces that have a similar area as those already selected.
Polygon Sides
Selects all faces that have the same number of edges.
Perimeter
Selects all faces that have a similar perimeter as those already selected.
Normal
Selects all faces that have a similar normal as those selected. This is a way to select faces that have
the same orientation (angle).
Co-planar
Selects all faces that are (nearly) in the same plane as those selected.

Selecting Loops
You can easily select loops of components:

Edge Loops and Vertex Loops
Reference
Mode: Edit mode –> Vertex or Edge select mode
Menu: Select ‣ Edge Loop or Mesh ‣ Edges ‣ Edge Loop

Holding Alt while selecting an edge selects a loop of edges that are connected in a line end to end, passing
through the edge under the mouse pointer. Holding Alt-Shift while clicking adds to the current selection.
Edge loops can also be selected based on an existing edge selection, using either Select ‣ Edge Loop
Note
Vertex mode
In Vertex select mode, you can also select edge loops, by using the same hotkeys, and clicking on the edges
(not on the vertices).
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Longitudinal and latitudinal edge loops.

The left sphere shows an edge that was selected longitudinally. Notice how the loop is open. This is because the
algorithm hit the vertices at the poles and terminated because the vertices at the pole connect to more than four
edges. However, the right sphere shows an edge that was selected latitudinally and has formed a closed loop.
This is because the algorithm hit the first edge that it started with.

Face Loops
Reference
Mode: Edit mode –> Face or Vertex select modes

In face select mode, holding Alt while selecting an edge selects a loop of faces that are connected in a line end
to end, along their opposite edges.
In vertex select mode, the same can be accomplished by using Ctrl-Alt to select an edge, which selects the
face loop implicitly.

Face loop selection.

This face loop was selected by clicking with Alt-RMB on an edge, in face select mode. The loop extends
perpendicular from the edge that was selected.
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Alt versus Ctrl-Alt in vertex select mode.

A face loop can also be selected in Vertex select mode. Technically Ctrl-Alt-RMB will select an Edge Ring,
however in Vertex select mode, selecting an Edge Ring implicitly selects a Face Loop since selecting opposite
edges of a face implicitly selects the entire face.

Edge Ring
Reference
Mode: Edit mode –> Edge select mode
Menu: Select ‣ Edge Ring or Mesh ‣ Edges ‣ Edge Ring

In Edge select mode, holding Ctrl-Alt while selecting an edge selects a sequence of edges that are not
connected, but on opposite sides to each other continuing along a face loop.
As with edge loops, you can also select edge rings based on current selection, using Select ‣ Edge Ring
Note
Vertex mode
In Vertex select mode, you can use the same hotkeys when clicking on the edges (not on the vertices), but this
will directly select the corresponding face loop...

A selected edge loop, and a selected edge ring.

In (A selected edge loop, and a selected edge ring), the same edge was clicked on but two different “groups of
edges” were selected, based on the different commands. One is based on edges during computation and the
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other is based on faces.

Path Selection
Reference
Mode: Edit mode

Select a face or vertex path with Ctrl-RMB

Selects all geometry along the shortest path from the active vertex/edge/face to the one which was selected.

Loop Inner-Region
Reference
Mode: Edit mode –> Edge select mode
Menu: Select ‣ Select Loop Inner-Region or Mesh ‣ Edges ‣ Select Loop Inner-Region

Select Loop Inner-Region selects all edges that are inside a closed loop of edges. While it is possible to use this
operator in Vertex and Face selection modes, results may be unexpected. Note that if the selected loop of edges
is not closed, then all connected edges on the mesh will be considered inside the loop.

Loop to Region.
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This tool handles multiple loops fine, as you can see.

This tool handles “holes” just fine as well.

Boundary Loop
Reference
Mode: Edit mode –> Edge select mode
Menu: Select ‣ Select Boundary Loop or Mesh ‣ Edges ‣ Select Boundary Loop

Select Boundary Loop does the opposite of Select Loop Inner-Region, based on all regions currently selected, it
selects only the edges at the border of these regions. It can operate in any select mode, but will always switch to
Edge select mode when run.
All this is much more simple to illustrates with examples:
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Select Boundary Loop does the opposite and forces into Edge Select Mode

Selecting Edges

Buttons for the selection modes

Edges can be selected in much the same way as vertices and faces - by right-clicking them while Edge Select
Mode is activated. Pressing Shift while clicking will add/subtract to the existing selection.

Edge Loops
Reference
Mode: Edit Mode (Mesh)
Menu: Select ‣ Edge Loop

Edge loops can be selected by first selecting an edge (vertex or edge selection mode), and then going to Select ‣
Edge Loop. The shortcut Alt-RMB on an edge (either vertex or edge select mode) is a quicker and more
powerful way of doing so. More powerful, because you can add/remove loops from an existing selection if you
press Shift too.
Note, that if you want to select a loop while being in vertex select mode, you still have to perform the shortcut
on an edge - while you, for just selecting vertices, would rightclick on a vertex.
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An edge loop

Note
Alt on Linux
Alt is on some Linux distros caught by the windows manager. If you see the above shortcut not working,
make sure that Bforartists can properly recognize the usage of Alt.

Edge Rings
Reference
Mode: Edit Mode (Mesh)
Menu: Select ‣ Edge Ring

Edge Rings are selected similarly. Based on the selection of an edge go to Select ‣ Edge Ring. Or use AltCtrl-RMB on an edge.
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An Edge Ring

Note
Convert selection to whole faces
If the edge ring selection happened in Edge Select Mode, switching to Face Select Mode will erase the
selection.
This is because none of those faces had all its (four) edges selected, just two of them.
Instead of selecting the missing edges manually or by using Shift-Alt-RMB twice, it is easier to first
switch to Vertex Select Mode, which will kind of “flood” the selection. A subsequent switch to Face Select
Mode will then properly select the faces.

Selecting Faces

Activated the Face Select Mode
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To select parts of a mesh face-wise, you have to switch to Face Select Mode. Do this by clicking the button
shown above, or press Ctrl-Tab to spawn a menu. The selection works as usual with RMB ; to add/remove to
an existing selection, additionally press Shift

Face Loops
Reference
Mode: Edit Mode (Mesh)

Face Loops are pretty much the same as Edge Rings. If you want to select a Face Loop, there is no menu entry
that works based on a selected face. Using Select ‣ Edge Ring would select a “cross” with the prior selected
face as the middle. If you want to avoid switching to Edge Select Mode to select a Face Loop, use the AltRMB shortcut.

Different Loopselect Operations on a grid in Face Select Mode

• Just the selected face.
• Select the face, then Select ‣ Edge Ring. See, how Bforartists selects edges, even if being in Face Select
Mode. If these edges are desired and you want to work on them, switch in Edge Select Mode. Switching
to Vertex Select Mode would flood the selection and leave you with the 4th image as result, after going
back to Face Select Mode.
• Select the face, the Select ‣ Edge Loop. As in the example above, Bforartists pretends to be in Edge
Select Mode and takes the four edges of the selected face as base for the selection operation.
• This selection was created by Alt-RMB on the left edge of the center face, followed by twice ShiftAlt-RMB on the top edge of the center face. Two times, because the first click will remove the selected
face loop (in this case, just the original selected face), while the second click will add the whole vertical
running loop to the selection, creating the cross.
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Ngons in Face Select Mode

Ngon-Face having its center dot inside another face

As already known, faces are marked with a little square dot in the middle of the face. With ngons that can lead
in certain cases to a confusing display. The example shows the center dot of the U-shaped ngon being inside of
the oblong face inside the “U”. It is not easy to say which dot belongs to which face (the orange dot in the
image is the object center). Luckily, you don’t need to care much - because to select a face, you don’t have to
click the center dot, but the face itself.
Tip
Face selection
To select a face: Click the face, not the dot!

Editing
Mesh Editing
Bforartists provides a variety of tools for editing meshes. These are available through the Mesh Tools palette,
the Mesh menu in the 3d view header, and context menus in the 3d view, as well as individual shortcut keys.
Note that all the “transform precision/snap” keys (Ctrl and/or Shift) work also for all these advanced
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operations... However, most of them do not have axis locking possibilities, and some of them do not take into
account pivot point and/or transform orientation either.
These transform tools are available in the Transform section of the Mesh menu in the menu bar. Note that some
of these can also be used on other editable objects, like curves, surfaces, and lattices.

Types of Tools
The mesh tools are found in various places, and available through shortcuts as well.
Transform and Deform tools:
• Translate
• Rotate
• Scale
• Mirror
• Shrink/Flatten/Along Normal
• Push/Pull
• To Sphere
• Shear
• Warp
• Edge Slide
• Vertex Slide
• Noise
• Smooth Vertex
• Rotate Edge
Merge and Remove tools:
• Delete
• Dissolve
• Merge
• Auto-Merge
• Remove Doubles
• Tris to Quads
• Unsubdivide

Add and Divide tools:
• Make Edge/Face
• Fill
• Beauty Fill
• Solidify
• Quads to Tris
• Extrude Region
• Extrude Individual
• Subdivide
• Loop Cut/Slide
• Knife tool
• Vertex connect
• Duplicate
• Spin
• Screw
• Symmetrize
• Inset
• Bevel
• Wireframe
Separate tools:
• Rip
• Rip fill
• Split
• Separate
• Edge Split

Accessing Mesh Tools
Mesh Tools Palette
When you select a mesh and Tab into edit mode, the Tool Shelf changes from Object Tools to Mesh Tools.
These are only some of the mesh editing tools.

Menus
The Mesh is located in the Header bar.

Basics

42

Bforartists Reference Manual - © Copyright - This page is under OCL license

Basic Mesh Editing
In this section we explain how to do basic editing on a mesh.
•
•
•
•
•

Translation, Rotation, Scale
Adding Elements
Deleting Elements
Creating Faces and Edges
Mirror editing

Translation, Rotation, Scale
Reference
Mode: Edit mode
Panel: Mesh Tools (Editing context)
Menu: Mesh ‣ Transform ‣ Grab/Move, Rotate, Scale, ...

Once you have a selection of one or more elements, you can grab/move (G), rotate (R) or scale (S) them, like
many other things in Bforartists, as described in the Manipulation in 3D Space section.
To move, rotate and scale selected components, either use the Translate, Rotate, and Scale buttons, the
transform manipulators, or the shortcuts. This shortcuts depends of your keymap. See important hotkeys addon.
After moving a selection, the options in the Tool Shelf allow you to fine-tune your changes, limit the effect to
certain axes, turn proportional editing on and off, etc.
Of course, when you move an element of a given type (e.g. an edge), you also modify the implicitly related
elements of other kinds (e.g. vertices and faces).
You also have in Edit mode an extra option when using these basic manipulations: the proportional editing.

Adding Geometry
Adding Geometry
In Bforartists, for modeling, you have several ways of adding mesh elements. Some of them are basic objects
that adds a starting block of data (called data-block in Bforartists) when adding their basic geometry to the
scene. We have 10 available mesh Objects, and those starting meshes are also called mesh primitives. In
Bforartists, we have a set of basic primitives so you can add a starting mesh to modify and model to suit your
specific needs. Also, you have specific tools to add, duplicate, move and delete elements, which will be
explained in other pages of the modeling section present in this manual.
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This page explains how to add basic geometry creating objects from primitives and how to add more elements
to your primitives, including the addition of other primitives and basic elements when you’re modeling.
To enter Edit you can select Edit from the modes menu as explained in the Interface overview, or use Tab with
a mesh object selected.
Bforartists’s mesh primitives.
To select and add one of the primitives to work with press Shift-A in Edit mode. Bforartists automatically
detects the appropriate context for the object type you are editing, and will
show a list of compatible, combining elements. If you are editing Mesh
types, Bforartists will show a list of primitive meshes to add to your object.
Other contexts are also automatically detected for the correct element
additions. (See Fig. Bforartists’s mesh primitives., you can add primitives to
already existing objects, in Edit Mode)
A dropdown menu opens from which you can select the primitive you wish
to add to the object.
There are many cases when it is useful to directly add a mesh to an object.
Maybe you want to model a teapot. It would be useful to model the cup and
the handle as separate meshes and only combine them when you are done.

Adding elementary parts to meshes
As explained before in Mesh Structures, meshes are objects formed from basic elements such as vertices, edges
and faces.
The most elementary part of a mesh is the vertex, a point in 3D space; the line between two or more
interconnected vertices is called an edge, and three or more edges can be connected to form a face. The
geometry of the faces performing the model is called topology.

Creating vertices
The most basic element, a vertex, can be added with a left button mouse click while pressing Ctrl when no
other vertices are selected, or Ctrl-LMB.
To create interconnected vertices, you can add a vertex and continuously make subsequent Ctrl-LMB
operations with the last one vertex selected. This will link the last selected vertex with the vertex created at the
mouse position with an edge (See Fig. Adding vertices one by one., and will continuously connect them
creating vertices if you continue repeating this operation. (see Fig. 3 - Creating simple connected vertices with
Ctrl-LMB.

44

Bforartists Reference Manual - © Copyright - This page is under OCL license

Adding vertices one by one.

Creating Edges
In addition to automatically creating edges from vertices, if you have two vertices selected, you can connect
them with and edge using the shortcut F (Fill). If you have more than two vertices selected, this will
automatically create face(s).

Creating Faces
Creating Faces with the Mouse
Quad from an Edge with source automatically rotated.
If you have two vertices selected and already connected with an
edge, left-click while pressing Ctrl-LMB will create a planar
face, also known as a quad. Bforartists will follow your mouse
cursor and will use the planar view from your viewport to
create those quads.
For Ctrl-LMB, Bforartists will automatically rotate the last
selected Edge (the source) for the subsequent operations if you
have at least one face created, dividing the angles created
between the newly-created edge and the last two edges,
performing a smooth angle between them. Bforartists will
calculate this angle using the last positive and negative position
of the last X and Y coordinates and the last connected
unselected edge. If this angle exceeds a negative limit
(following a quadrant rule) between the recently created edge
and the last two, Bforartists will wrap the faces. But if you do
not want Bforartists rotating and smoothing edges
automatically when extruding from Ctrl-LMB, you can also
inhibit Bforartists from rotating sources using the shortcut
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Ctrl-Shift-LMB. In this case, Bforartists won’t rotate the source dividing the angle between those edges
when creating a face.
For both cases, Bforartists will inform the user about the source rotation during the creation process. If you look
at the Bottom of the Mesh Tools Panel, if you press Ctrl-LMB, you will see that the Rotate Source is
automatically checked and if Ctrl-Shift-LMB is used, it will be automatically unchecked. Examples:
• Creating Faces with shortcut Ctrl-LMB, (see Fig. - Faces created with source automatically rotated)
• Creating Faces with shortcut Ctrl-Shift-LMB, (see Fig. Faces created with no source rotation)
If you have three or more vertices selected, and left click with mouse while pressing Ctrl-LMB, you will also
create planar faces, but along the vertices selected, following the direction of the cursor. This operation is
similar to an extrude operation, which is explained in the Extrude page.
Tip
When adding Objects with Ctrl-LMB, The extrusions of the selected elements, being vertices, edges and
faces with the Ctrl-LMB, is viewport dependent. This means, once you change your viewport, for example,
from top to left, bottom or right, the extrusion direction will also follow your viewport and align your
extrusions with your planar view.

Filling Faces
Filling a triangle.
You can also create faces with at least three vertices selected,
using F to fill them with edges and faces, or only fill edges with
faces if they are already connected (Fill) (See Fig. Filling a
triangle.). For four or more vertices, it’s mandatory that you
have coplanar vertices. four coplanar vertices will create a quad
when filled, and more than four coplanar vertices will create a
Ngon face.

Note
Note that you can only modify the mesh of the object
you’re editing. To modify other objects you need to
leave, select them and re-enter Edit Mode.

Tip
When you’re modeling, that, in order to facilitate the modeling, the best solution is to imagine what primitive
type suits better for your model. If you will model a cuboid, the best solution is to start with a primitive cube,
and so on.
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Deleting and Merging
These tools can be used to remove components.

Delete
Delete
Deletes selected vertices, edges, or faces. This operation can also be limited to:
Vertices
Delete all vertices in current selection, removing any faces or edges they are connected to.
Edges
Deletes any edges in the current selection. Removes any faces that the edge shares with it.
Faces
Removes any faces in current selection.
Only Edges & Faces
Limits the operation to only selected edges and adjacent faces.
Only faces
Removes faces, but edges within face selection are retained.
Edge Collapse
Collapses edges into single vertices. This can be used to remove a loop of faces.
Edge Loop
Deletes an edge loop. If the current selection is not an edge loop, this operation does nothing.

Dissolve
Dissolve operations are also accessed from the delete menu. Instead of removing the geometry, which may
leave holes that you have to fill in again, dissolve will remove the geometry and fill in the surrounding
geometry.
Dissolve
Removes selected geometry, but keeps surface closed, effectively turning the selection into a single ngon. Dissolve works slightly different based on if you have edges, faces or vertices selected. You can add
detail where you need it, or quickly remove it where you don’t.
Limited Dissolve
Limited Dissolve reduces detail on planar faces and linear edges with an adjustable angle threshold.
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Example showing the how Limited Dissolve can be used.

Face Split - dissolve option.
When dissolving vertices into surrounding faces, you can often end up with very large, uneven ngons.
The face split option limits dissolve to only use the corners of the faces connected to the vertex.

Dissolve Face Split option. Left - the input, middle - regular dissolve, right - Face Split enabled

Convert Triangles to Quads
Tris to Quads Alt-J This takes adjacent tris and removes the shared edge to create a quad. This tool can be
performed on a selection of multiple triangles.
This same action can be done on a selection of just 2 tris, by selecting them and using the shortcut F, to create a
face.

Unsubdivide
Reference
Mode: Edit mode
Menu: Mesh ‣ Edges ‣ Unsubdivide
Unsubdivide functions as the reverse of subdivide by attempting to remove edges that were the result of a
subdivide operation. If additional editing has been done after the subdivide operation, unexpected results may
occur.
Iterations
How many subdivisions to remove.
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Merging
Merging Vertices
Reference
Mode: Edit mode
Menu: Mesh ‣ Vertices ‣ Merge..., Specials ‣ Merge or Vertex Specials ‣ Merge

This tool allows you to merge all selected vertices into an unique one, deleting all others. You can choose the
location of the surviving vertex in the menu this tool pops up before executing:
At First
Only available in Vertex select mode, it will place the remaining vertex at the location of the first one
selected.
At Last
Only available in Vertex select mode, it will place the remaining vertex at the location of the last one
selected (the active one).
At Center
Available in all select modes, it will place the remaining vertex at the center of the selection.
At Cursor
Available in all select modes, it will place the remaining vertex at the 3D Cursor.
Collapse
This is a special option, as it might let “live” more than one vertex. In fact, you will have as many
remaining vertices as you had “islands” of selection (i.e. groups of linked selected vertices). The
remaining vertices will be positioned at the center of their respective “islands”. It is also available via the
Mesh ‣ Edges ‣ Collapse menu option...
Merging vertices of course also deletes some edges and faces. But Bforartists will do everything it can to
preserve edges and faces only partly involved in the reunion.

AutoMerge Editing
Reference
Mode: Edit mode
Menu: Mesh ‣ AutoMerge Editing
The Mesh menu as a related toggle option: AutoMerge Editing. When enabled, as soon as a vertex moves closer
to another one than the Limit setting (Mesh Tools panel, see below), they are automatically merged.

Remove Doubles
Reference
Mode: Edit mode
Panel: Editing context –> Mesh Tools
Menu: Mesh ‣ Vertices ‣ Remove Doubles, Specials ‣ Remove Doubles or Vertex Specials ‣ Remove Doubles
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Remove Doubles is a useful tool to simplify a mesh by merging vertices that are closer than a specified distance
to each other. An alternate way to simplify a mesh is to use the Decimate modifier.
Merge Distance
Sets the distance threshold for merging vertices, in Bforartists units.
Unselected
Allows vertices in a selection to be merged with unselected vertices. When disabled, selected vertices will
only be merged with other selected ones.

Make Edge/Face
Reference
Mode: Edit mode
Menu: Mesh –> Faces –> Make Face/Edge

This is a context sensitive tool which creates geometry by filling in the selection. When only 2 vertices are
selected it will create an edge, otherwise it will create faces.
The following methods are used automatically depending on the context.

Isolated vertices.

Before

After

Isolated edges
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Before

After

N-gon from edges: When there are many edges Bforartists will make an ngon, note that this doesn’t support
holes, to support holes you need to use the Fill Faces tool.

Before

After

Mixed vertices/edges: existing edges are used to make the face as well as an extra vertex.

Before

After

Edge-Net: sometimes you may have many connected edges without interior faces.
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Before

After

Point Cloud: when there are many isolated vertices, Bforartists will calculate the edges for an n-gon.

Before

After

Single Vertex Selection: with a single vertex selected on a boundary, the face will be created along the
boundary, this saves manually selecting the other 2 vertices. Notice this tool can run multiple times to continue
creating faces.’‘

Further Reading
For other ways to create faces see:
• Fill
• Grid Fill
• Bridge Edge Loops

Mirror Editing
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X-Mirror
Reference
Mode: Edit mode
Panel: Mesh Options ‣ X-mirror
The X-mirror option of the Mesh Options panel allows you edit both “sides” of your mesh in a single action.
When you transform an element (vertex, edge or face), if there is its exact X-mirrored counterpart (in local
space), it will be transformed accordingly, through a symmetry along the local X axis.

Topology Mirror
The Topology Mirror option is available in the 3D View Editor ‣ Toolshelf Region ‣ Mesh Options Panel whilst
in Edit Mode
For Topology Mirror to work the X Mirror option must be enabled.
When using the X Mirror option to work on mirrored Mesh Geometry the vertices that are mirrored must be
perfectly placed. If they are not exactly positioned in their mirror locations then X Mirror will not treat those
vertices as mirrored. This can be annoying because often the out of position vertices are only very slightly out
of position.
Topology Mirror tries to solve this problem by determining which vertices are mirrored vertices not only by
using their positions but also by looking at how those vertices are related to others in the Mesh Geometry. It
looks at the overall Mesh Geometry topology to determine if particular vertices will be treated as mirrored. The
effect of this is that mirrored vertices can be non-symetrical and yet still be treated as mirrored when X Mirror
and Topology Mirror are both active.
Note that Topology Mirror functionality will work more reliably on Mesh Geometry which is more detailed. If
you use very simple Mesh Geometry such as a Cube or UV Sphere for example the Topology Mirror option will
often not work.
For an example of how to use Topology Mirror open up a new Bforartists scene, then delete Bforartists’s default
cube and add a Monkey Object to the 3D Viewport.
Press the TAB Key to put the Monkey Object into Edit Mode.
With the X Mirror option disabled move one of the Monkey Object’s vertices slightly.
Then Turn X Mirror option on again but leave Topology Mirror disabled
If you now move that vertice again X Mirror will not work and the mirrored vertices will not be altered.
If you then enable Topology Mirror and move the same vertices again, then X Mirror should still mirror the
other vertice, even though they are not perfectly positioned.

Mirror Modifier
The conditions for X-mirror to work are quite strict, which can make it difficult to use. To have an exact
mirrored version of a (half) mesh, its easier and simpler to use the Mirror modifier
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Snap to Symmetry
Reference
Mode: Edit mode
Menu: Mesh ‣ Snap to Symmetry
The Snap to Symmetry tool works on meshes which are mostly symmetrical but have vertices which have been
moved enough that Bforartists does not detect then as mirrored (when x-mirror option is enable for example).
This can be caused by accident when editing without x-mirror enabled. Sometimes models imported from other
applications are asymmetrical enough that mirror fails too.
Direction
Specify the axis and direction to snap. Can be any of the 3 axes, and either positive to negative, or
negative to positive.
Threshold
Specify the search radius to use when finding matching vertices.
Factor
Support for blending mirrored locations from one side to the other (0.5 is an equal mix of both).
Center
Snap vertices in the center axis to zero.

Before Snap to Symmetry
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After Snap to Symmetry

Symmetrize Mesh
Reference
Mode: Edit mode
Menu: Mesh ‣ Symmetrize
The Symmetrize tool is a quick way to make a mesh symmetrical. Symmetrize works by cutting the mesh at the
pivot point of the object, and mirroring over the geometry in the specified axis, and merges the two halves
together (if they are connected)
Direction
Specify the axis and direction of the effect. Can be any of the 3 axes, and either positive to negative, or
negative to positive.

Mesh before Symmetrize
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Mesh after Symmetrize

Mirroring Geometry
See Mirror for information on mirroring, which allows you to flip geometry across an axis

Normals
Introduction
Displaying Normals
Showing the normals is located in the Transform Panel, in the Mesh display tab. Here you can display the
normals for edges, faces and vertices. You can also change the height of the axis that points the direction of the
normal. The default is 0.1.

Normal Display Options

Editing
Flip Direction
Reference
Mode: Edit mode
3D View > Tool Shelf > Shade UV's tab ‣ Shading panel > Normals ‣ Flip Direction
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Flip direction will reverse the normals direction of all selected faces. It will not change the orientation.

Recalculate Normals
Reference
Mode: Edit mode
3D View > Tool Shelf > Shade UV's tab ‣ Shading panel > Normals ‣ Recalc Outside
and
3D View > Tool Shelf > Shade UV's tab ‣ Shading panel > Normals ‣ Recalc Inside

The Recalc outside and Recalc inside commands will recalculate the normals of selected faces so that they
point outside or inside the volume that the face belongs to. This volume does not need to be closed. In fact, this
means that the face of interest must be adjacent with at least one non-coplanar other face. For example, with a
Grid primitive, neither Recalculate Outside nor Recalculate Inside will never modify its normals.

Vertex Tools
This page covers many of the tools in the Mesh ‣ Vertices menu. These are tools that work primarily on vertex
selections, however, some also work with edge or face selections.

Merging
Merging Vertices
Reference
Mode: Edit mode
Menu: Mesh ‣ Vertices ‣ Merge..., Specials ‣ Merge or Vertex Specials ‣ Merge

This tool allows you to merge all selected vertices to an unique one, deleting all others. You can choose the
location of the surviving vertex in the menu this tool pops up before executing:
At First
Only available in Vertex select mode, it will place the remaining vertex at the location of the first one
selected.
At Last
Only available in Vertex select mode, it will place the remaining vertex at the location of the last one
selected (the active one).
At Center
Available in all select modes, it will place the remaining vertex at the center of the selection.
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At Cursor
Available in all select modes, it will place the remaining vertex at the 3D Cursor.
Collapse
This is a special option, as it might let “live” more than one vertex. In fact, you will have as much
remaining vertices as you had “islands” of selection (i.e. groups of linked selected vertices). The
remaining vertices will be positioned at the center of their respective “islands”. It is also available via the
Mesh ‣ Edges ‣ Collapse menu option...
Merging vertices of course also deletes some edges and faces. But Bforartists will do everything it can to
preserve edges and faces only partly involved in the reunion.

AutoMerge Editing
Reference
Mode: Edit mode
Menu: Mesh ‣ AutoMerge Editing
The Mesh menu as a related toggle option: AutoMerge Editing. When enabled, as soon as a vertex moves closer
to another one than the Limit setting (Mesh Tools panel, see below), they are automatically merged.

Remove Doubles
Reference
Mode: Edit mode
Panel: Editing context –> Mesh Tools
Menu: Mesh ‣ Vertices ‣ Remove Doubles, Specials ‣ Remove Doubles or Vertex Specials ‣ Remove Doubles
Remove Doubles is a useful tool to simplify a mesh by merging vertices that are closer than a specified distance
to each other. An alternate way to simplify a mesh is to use the Decimate modifier.
Merge Distance
Sets the distance threshold for merging vertices, in Bforartists units.
Unselected
Allows vertices in selection to be merged with unselected vertices. When disabled, selected vertices will
only be merged with other selected ones.

Separating
Rip
Reference
Mode: Edit mode
Menu: Mesh ‣ Vertices ‣ Rip
Rip creates a “hole” into a mesh by making a copy of selected vertices and edges, still linked to the neighbor
non-selected vertices, so that the new edges are borders of the faces on one side, and the old ones, borders of
the faces of the other side of the rip.
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Examples

selected vertex

Hole created after using rip on vertex
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Edges selected

Result of rip with edge selection
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A complex selection of vertices

Result of rip operation

Limitations
Rip will only work when edges and/or vertices are selected. Using the tool when a face is selected (explicitly or
implicitly), will return an error message “Can’t perform ripping with faces selected this way” If your selection
includes some edges or vertices that are not “between” two faces (manifold), it will also fail with message “No
proper selection or faces include”.

Rip Fill
Reference
Mode: Edit mode
Menu: Mesh ‣ Vertices ‣ Rip Fill

Rip fill works the same as the Rip tool above, but instead of leaving a hole, it fills in the gap with geometry.
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Edges selected

Result of rip fill

Split
Reference
Mode: Edit mode
Menu: Mesh ‣ Vertices ‣ Split

A quite specific tool, it makes a sort of copy of the selection, removing the original data if it is not used by any
non-selected element. This means that if you split an edge from a mesh, the original edge will still remain
unless it is not linked to anything else. If you split a face, the original face itself will be deleted, but its edges
and vertices remain unchanged. And so on.
Note that the “copy” is left exactly at the same position as the original, so you must move it (G) to see it
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clearly...

Separate
Reference
Mode: Edit mode
Menu: Mesh ‣ Vertices ‣ Separate

This will separate the selection in another mesh object, as described here.

Connect Vertex Path
Reference
Mode: Edit mode
Menu: Mesh ‣ Vertices ‣ Connect Vertex Path

This tool connects vertices in the order they’re selected, splitting the faces between them.
Runnign a second time will connect the first/last endpoints.
Vertices not connected to any faces will create edges, so this can be used as a way to quickly connect isolated
vertices too.

Connect Vertices
Reference
Mode: Edit mode
Menu: Mesh ‣ Vertices ‣ Connect Vertices
This tool connects selected vertices by creating edges between them and splitting the face.
This tool can be used on many faces at once.

Selected vertices before connecting
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After connecting vertices

Two faces created from vertex connect operation

Vertex Slide
Reference
Mode: Edit mode
Panel: Editing context –> Mesh Tools
Menu: Mesh ‣ Vertices ‣ Vertex Slide

Vertex Slide will transform a vertex along one of its adjacent edges. Use Shift-V to enter tool. Highlight the
desired edge by moving the mouse, then confirm with LMB. Drag the cursor to specify the position along the
line formed by the edge, then LMB again to move the vertex.
Shift
Higher precision control.
Ctrl
Snap to value (useful to combine with auto merge)
LMB
confirms the tool
RMB or Esc
Cancels.
Alt or C
Toggle clamping the slide within the edge extents.
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Selected vertex

Positioning vertex interactively

Repositioned vertex

Smooth
Reference
Mode: Edit mode
Panel: Editing context –> Mesh Tools
Menu: Mesh ‣ Vertices ‣ Smooth, Specials ‣ Smooth or Vertex Specials ‣ Smooth

This will apply once the Smooth Tool.

Make Vertex Parent
Reference
Mode: Edit mode
Menu: Mesh ‣ Vertices ‣ Make Vertex Parent

This will parent the other selected object(s) to the vertices/edges/faces selected, as described here.
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Add Hook
Reference
Mode: Edit mode
Menu: Mesh ‣ Vertices ‣ Add Hook

Adds a Hook Modifier (using either a new empty, or the current selected object) linked to the selection. Note
that even if it appears in the history menu, this action cannot be undone in Edit mode - probably because it
involves other objects...

Blend From Shape, Propagate Shapes
Reference
Mode: Edit mode
Menu: (Vertex) Specials ‣ Blend From Shape and Mesh ‣ Vertices ‣ Shape Propagate
These are options regarding shape keys.

Edges
Make Edge/Face
Reference
Mode: Edit mode
Menu: Mesh ‣ Edges ‣ Make Edge/Face

It will create an edge or some faces, depending on your selection.
See also Make Edge/Face.

Set Edge Attributes
Edges can have several different attributes that affect how certain other tools affect the mesh.

Mark Seam and Clear Seam
Reference
Mode: Edit mode (Vertex or Edge select modes)
Menu: Mesh ‣ Edges ‣ Mark Seam/Clear Seam (or the same options in Edge Specials menu)
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Seams are a way to create separations, “islands”, in UV maps. See the UVTexturing section for more details.
These commands set or unset this flag for selected edges.

Mark Sharp and Clear Sharp
Reference
Mode: Edit mode (Vertex or Edge select modes)
Menu: Mesh ‣ Edges ‣ Mark Seam/Clear Seam (or the same options in Edge Specials menu)

The Sharp flag is used by the EdgeSplit modifier, which is part of the smoothing technics. As seams, it is a
property of edges, and these commands set or unset it for selected ones.

Adjust Bevel Weight
Reference
Mode: Edit mode (Vertex or Edge select modes)
Menu: Mesh ‣ Edges ‣ Adjust Bevel Weight

This edge property (a value between 0.0 and 1.0) is used by the Bevel modifier to control the bevel intensity of
the edges. This command enters an interactive mode (a bit like transform tools), where by moving the mouse
(or typing a value with the keyboard) you can set the (average) bevel weight of selected edges.

Crease SubSurf
Reference
Mode: Edit mode (Vertex or Edge select modes)
Menu: Mesh ‣ Edges ‣ Crease SubSurf

This edge property (a value between 0.0 and 1.0) is used by the Subsurf modifier to control the sharpness of the
edges in the subdivided mesh. This command enters an interactive mode (a bit like transform tools), where by
moving the mouse (or typing a value with the keyboard) you can set the (average) crease value of selected
edges. To clear the crease edge property, enter a value of -1.

Edge Slide
Reference
Mode: Edit mode (Vertex or Edge select modes)
Menu: Mesh ‣ Edges ‣ Slide Edge (or the same option in Edge Specials menu)

Slides one or more edges across adjacent faces with a few restrictions involving the selection of edges (i.e. the
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selection must define a valid loop, see below.)
Shift
Higher precision control.
Ctrl
Snap to value (useful to combine with auto merge)
LMB
confirms the tool
RMB or Esc
Cancels.
Even E
Forces the edge loop to match the shape of the adjacent edge loop. You can flip to the opposite vertex
using F. Use Alt-Wheel to change the control edge.
Flip F
When Even mode is active, this flips between the two adjacent edge loops the active edge loop will match
Alt or C
Toggle clamping the slide within the edge extents.
This tool has a factor, which is displayed in the 3D View footer and in the Tool Shelf (after confirmation). A
numerical value between -1 and 1 can be entered for precision.
In Proportional mode, Wheel, or Left and Right changes the selected edge for calculating a proportion.
Unlike Percentage mode, Proportional
Holding Ctrl or Shift control the precision of the sliding. Ctrl snaps movement to 10% steps per move
and Shift snaps movement to 1% steps. The default is 5% steps per move.

Usage
By default, the position of vertices on the edge loop move as a percentage of the distance between their original
position and the adjacent edge loop, regardless of the edges’ lengths.

Selected Edge Loop

Repositioned Edge Loop

Even mode
Even mode keeps the shape of the selected edge loop the same as one of the edge loops adjacent to it, rather
than sliding a percentage along each perpendicular edge.
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In Even mode, the tool shows the position along the length of the currently selected edge which is marked in
yellow, from the vertex that as an enlarged red marker. Movement of the sliding edge loop is restricted to this
length. As you move the mouse the length indicator in the header changes showing where along the length of
the edge you are.
To change the control edge that determines the position of the edge loop, use the Alt-Wheel to scroll to a
different edge.

Even Mode Enabled

Even Mode with Flip Enabled

Moving the mouse moves the selected edge loop towards or away from the start vertex, but the loop line will
only move as far as the length of the currently selected edge, conforming to the shape of one of the bounding
edge loops.

Limitations & Workarounds
There are restrictions on the type of edge selections that can be operated upon. Invalid selections are:
Loop crosses itself
This means that the tool could not find any suitable faces that were adjacent to the selected edge(s). (Loop
crosses) is an example that shows this by selecting two edges that share the same face. A face cannot be
adjacent to itself.
Multiple edge loops
The selected edges are not in the same edge loop, which means they don’t have a common edge. You can
minimize this error by always selecting edges end to end or in a “Chain”. If you select multiple edges just
make sure they are connected. This will decrease the possibility of getting looping errors.
Border Edge
When a single edge was selected in a single sided object. An edge loop can not be found because there is
only one face. Remember, edge loops are loops that span two or more faces.
A general rule of thumb is that if multiple edges are selected they should be connected end to end such that they
form a continuous chain. This is literally a general rule because you can still select edges in a chain that are
invalid because some of the edges in the chain are in different edge loops.

Rotate Edge
Reference
Mode: Edit mode (Vertex or Edge select modes)
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Menu: Mesh ‣ Edges ‣ Rotate Edge CW / Rotate Edge CCW

Rotating an edge clockwise or counter-clockwise spins an edge between two faces around their vertices. This is
very useful for restructuring a mesh’s topology. The tool can operate on one explicitly selected edge, or on two
selected vertices or two selected faces that implicitly share an edge between them.

Selected Edge

Edge, rotated CW

Using Face Selection
To rotate an edge based on faces you must select two faces, (Adjacent selected faces), otherwise Bforartists
notifies you with an error message, “ERROR: Could not find any select edges that can be rotated”. Using
either Rotate Edge CW or Rotate Edge CCW will produce exactly the same results as if you had selected the
common edge shown in (Selected edge rotated CW and CCW.).

Delete Edge Loop
Reference
Mode: Edit mode (Vertex or Edge select modes)
Menu: Mesh ‣ Delete ‣ Edge Loop

Delete Edge Loop allows you to delete a selected edge loop if it is between two other edge loops. This will
create one face-loop where two previously existed.
Note
The Edge Loop option is very different to the Edges option, even if you use it on edges that look like an edge
loop. Deleting an edge loop merges the surrounding faces together to preserve the surface of the mesh. By
deleting a chain of edges, the edges are removed, deleting the surrounding faces as well. This will leave holes
in the mesh where the faces once were.

Example
The selected edge loop on the UV Sphere has been deleted and the faces have been merged with the
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surrounding edges. If the edges had been deleted by choosing Edges from the (Erase Menu) there would be an
empty band of deleted faces all the way around the sphere instead.

Selected Edge Loop

Edge Loop Deleted

Collapse
Reference
Mode: Edit mode
Menu: Mesh ‣ Delete ‣ Edge Collapse

This takes a selection of edges and for each edge, merges its two vertices together. This is useful for taking a
ring of edges and collapsing it, removing the face loop it ran through.

Selected Edge Ring

Edge Ring Collapsed
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Edge Split
Reference
Mode: Edit mode
Menu: Mesh ‣ Edges ‣ Edge Split

Edge split is similar to the rip tool. When two or more touching interior edges, or a border edge is selected
when using Edge split, a hole will be created, and the selected edges are duplicated to form the border of the
hole

Selected Edges

Adjacent face moved to reveal hole left by split

Bridge Edge Loops
Reference
Mode: Edit mode
Menu: Mesh ‣ Edges ‣ Bridge Edge Loops
Bridge Edge Loops connects multiple edge loops with faces.
Simple example showing 2 closed edge loops.
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Input

Bridge Result

Example of bridge tool between edge loops with different numbers of vertices.

Input

Bridge Result

Example using the bridge tool to punch holes in face selections and connect them.
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Input

Bridge Result

Example showing how bridge tool can detect multiple loops and loft them in one step.

Input

Bridge Result

Example of the subdivision option and surface blending with UV’s.
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Input

Bridge Result

Face Tools
These are tools that manipulate faces.

Creating Faces
Make Edge/Face
Reference
Mode: Edit mode
Menu: Mesh ‣ Faces ‣ Make Edge/Face

This will create an edge or some faces, depending on your selection. Also see Make Edge/Face.
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A closed perimeter of edges

Filled using fill

Fill
Reference
Mode: Edit mode
Menu: Mesh ‣ Faces ‣ Fill/Beautify Fill

The Fill option will create triangular faces from any group of selected edges or vertices, as long as they form
one or more complete perimeters.

Filled using fill

note, unlike creating n-gons, fill supports holes.
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A closed perimeter of edges with holes

Filled using fill

Beauty Fill
Reference
Mode: Edit mode
Menu: Mesh ‣ Faces ‣ Fill/Beautify Fill

Beautify Fill works only on selected existing faces. It rearrange selected triangles to obtain more “balanced”
ones (i.e. less long thin triangles).

Text converted to a mesh

Result of Beauty Fill, Alt-Shift-F
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Grid Fill
Reference
Mode: Edit mode
Menu: Mesh ‣ Faces ‣ Fill/Grid Fill
Grid Fill uses a pair of connected edge-loops to fill in a grid that follows the surrounding geometry.

Input

Grid Fill Result

Convert Quads to Triangles
Reference
Mode: Edit mode
Menu: Mesh ‣ Faces ‣ Convert Quads to Triangles or Face Specials ‣ Triangulate
As its name intimates, this tool converts each selected quadrangle into two triangles. Remember that quads are
just a set of two triangles.

Convert Triangles to Quads
Reference
Mode: Edit mode
Panel: Mesh Tools (Editing context)
Menu: Mesh ‣ Faces ‣ Convert Triangles to Quads
This tool converts the selected triangles into quads by taking adjacent tris and removes the shared edge to create
a quad, based on a threshold. This tool can be performed on a selection of multiple triangles.
This same action can be done on a selection of 2 tris, by selecting them and using the shortcut F, to create a
face, or by selecting the shared edge and dissolving it with the shortcut [X] ‣ Dissolve.
To create a quad, this tool needs at least two adjacent triangles. If you have an even number of selected
triangles, it is also possible not to obtain only quads. In fact, this tool tries to create “squarishest” quads as
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possible from the given triangles, which means some triangles could remain.

Before converting tris to quads

After converting tris to quads

All the menu entries and hotkey use the settings defined in the Mesh Tools panel:
Max Angle
This values (between 0 and 180) controls the threshold for this tool to work on adjacent triangles. With a
threshold of 0.0, it will only join adjacent triangles that form a perfect rectangle (i.e. right-angled triangles
sharing their hypotenuses). Larger values are required for triangles with a shared edge that is small,
relative to the size of the other edges of the triangles.
Compare UVs
When enabled, it will prevent union of triangles that are not also adjacent in the active UV map. Note that
this seems to be the only option working...
Compare Vcol
When enabled, it will prevent union of triangles that have no matching vertex color. I’m not sure how this
option works - or even if it really works...
Compare Sharp
When enabled, it will prevent union of triangles that share a “sharp” edge. I’m not sure either if this
option works, and what is the “sharp” criteria - neither the Sharp flag nor the angle between triangles
seem to have an influence here...
Compare Materials
When enabled, it will prevent union of triangles that do not use the same material index. This option does
not seem to work neither...

Solidify
Reference
Mode: Edit mode
Menu: Mesh ‣ Faces ‣ Solidify
This takes a selection of faces and solidifies them by extruding them uniformly to give volume to a nonmanifold surface. This is also available as a Modifier. After using the tool, you can set the offset distance in the
Tool Palette.
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Thickness
Amount to offset the newly created surface. Positive values offset the surface inward relative to the
normals. Negative values offset outward.

Mesh before solidify operation

Solidify with a positive thickness

Solidify with a negative thickness

Rotate Edges
Reference
Mode: Edit mode
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Menu: Mesh ‣ Faces ‣ Rotate Edge CW
This command functions the same edge rotation in edge mode.
It works on the shared edge between two faces and rotates that edge if the edge was selected.

Two Faces Selected

Full Render

See Rotate Edge for more information.

Normals
See Editing Normals for more information.

Deforming

Mirror
Reference
Mode: Edit mode
Menu: Mesh ‣ Mirror ‣ Desired Axis
The mirror tool mirrors a selection across a selected axis.
The mirror tool in Edit mode is similar to Mirroring in Object mode. It is exactly equivalent to scaling by -1
vertices, edges or faces around one chosen pivot point and in the direction of one chosen axis, only it is
faster/handier.
After this tool becomes active, select an axis to mirror the selection on entering x,y, or z.
You can also interactively mirror the geometry by holding the MMB and dragging in the direction of the desired
mirror direction.
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Axis of symmetry
For each transformation orientation, you can choose one of its axes along which the mirroring will occur.
As you can see, the possibilities are infinite and the freedom complete: you can position the pivot point at any
location around which we want the mirroring to occur, choose one transformation orientation and then one axis
on it.

Pivot point
Pivot points must be set first. Pivot points will become the center of symmetry. If the widget is turned on it will
always show where the pivot point is.
On (Mirror around the Individual Centers ...) the pivot point default to median point of the selection of
vertices in Edit mode. This is a special case of the Edit mode as explained on the pivot point page.

Mesh before mirror.

Mesh after mirrored along X axis

On (Mirror around the 3D Cursor ...) the pivot point is the 3D Cursor, the transformation orientation is Local,
a.k.a. the Object space, and the axis of transformation is X.
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Mesh before mirror.

Mesh after mirrored along X axis using the 3d cursor as a pivot point

Transformation orientation
Transformation Orientations are found on the 3D area header, next to the Widget buttons. They decide which
coordinate system will rule the mirroring.

Shrink/Fatten Along Normals
Reference
Mode: Edit mode
Panel: Mesh Tools (Editing context)
Menu: Mesh ‣ Transform ‣ Shrink/Fatten Along Normals
This tool translates selected vertices/edges/faces along their own normal (perpendicular to the face), which, on
“standard normal meshes”, will shrink/fatten them.
This transform tool does not take into account the pivot point or transform orientation.
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mesh before shrink/flatten

Inflated using a positive value

Shrunk using a negative value

Smooth
Reference
Mode: Edit mode
Panel: Mesh Tools (Editing context)
Menu: Mesh ‣ Vertices ‣ Smooth vertex
This tool smooths the selected components by averaging the angles between faces. After using the tool, options
appear in the Tool Shelf:
Number of times to smooth
The number of smoothing iterations
Axes
Limit the effect to certain axes.
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mesh before smoothing

mesh after 1 smoothing iteration

mesh after 10 smoothing iterations

Laplacian Smooth
Reference
Mode: Edit mode
See the Laplacian Smooth Modifier for details.
Laplacian smooth is uses an alternative smoothing algorithm that better preserves the overall mesh shape.
Laplacian smooth exists as a mesh operation and as a non-destructive modifier.
Note
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The Smooth modifier, which can be limited to a Vertex Group, is a non-destructive alternative to the smooth
tool.

Note
Real Smoothing versus Shading Smoothing
Do not mistake this tool with the shading smoothing options described at this page, they do not work the
same! This tool modifies the mesh itself, to reduce its sharpness, whereas Set Smooth / AutoSmooth and co.
only control the way the mesh is shaded, creating an illusion of softness - but without modifying the mesh at
all...

Noise
Reference
Mode: Edit mode
Panel: Mesh Tools (Editing context)
Note
Noise is an old feature. The Displace Modifier is a non-destructive alternative to the Noise tool and is a more
flexible way to realize these sort of effects. The key advantages of the modifier are that it can be canceled at
any moment, you can precisely control how much and in which direction the displacement is applied, and
much more.... See also the ANT Landscape add-on.
The Noise function allows you to displace vertices in a mesh based on the grey values of the first texture slot of
the material applied to the mesh.
The mesh must have a material and a texture assigned to it for this tool to work. To avoid having the texture
affect the material’s properties, it can be disabled in the texture menu.
The Noise function displaces vertices along the object’s ±Z-Axis only.
Noise permanently modifies your mesh according to the material texture. Each click adds onto the current
mesh. For a temporary effect, map the texture to Displacement for a render-time effect. In Object / Edit mode,
your object will appear normal, but will render deformed.
The deformation can be controlled by modifying the Mapping panel and/or the texture’s own panel (e.g.
Clouds, Marble, etc.).
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mesh before noise is added

mesh after noise is added, using basic cloud texture

Push/Pull
Reference
Mode: Object and Edit modes
Menu: Object/Mesh ‣ Transform ‣ Push Pull

Description

Push/Pull distance.

Push/Pull will move the selected elements (Objects, vertices, edges or faces) closer together (Push) or further
apart (Pull). Specifically, each element is moved towards or away from the center by the same distance. This
distance is controlled by moving the mouse up (Push) or down (Pull), numeric input or through slider control.
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Usage
Select the elements you want to operate on and activate the Push/Pull transform function. The Push/Pull option
can be invoked from the Object/Mesh ‣ Transform ‣ Push/Pull menu option or by pressing Spacebar and
using the search menu to search for Push or Pull. The amount of movement given to the selection can be
determined interactively by moving the mouse or by typing a number. Pressing Return will confirm the
transformation. The confirmed transformation can be further edited by pressing F6 or by going into the
Toolshelf and altering the Distance slider provided that no other actions take place between the Push/Pull
transform confirmation and accessing the slider.

Note that the result of the Push/Pull transform is also dependant on the number and type of selected elements
(Objects, vertices, faces etc). See below for the result of using Push/Pull on a number of different elements.

Equidistant Objects being pushed together.

Random Objects being pushed together.
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Vertices being pushed together, then pulled apart.

Edges on separate meshes being pushed together, then pulled apart.

Shear
Reference
Mode: Object and Edit modes
Menu: Object/Mesh/Curve/Surface ‣ Transform ‣ Shear

Description

Shear Offset Factor.

Shearing is a form of movement where parallel surfaces move past one another. During this transform,
movement of the selected elements will occur along the horizontal axis of the current view. The axis location
will be defined by the Pivot Point. Everything that is “above” this axis will move (Shear) in the same direction
as your mouse pointer (but always parallel to the horizontal axis). Everything that is “below” the horizontal axis
will move in the opposite direction.
Read more about Pivot Points
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Usage
Select the elements you want to operate on and activate the Shear transform function. The Shear option can be
invoked from the Object/Mesh/Curve/Surface ‣ Transform ‣ Shear menu option or by pressing Shift-CtrlAlt-S. The amount of movement given to the selection can be determined interactively by moving the mouse
or by typing a number. Pressing Return will confirm the transformation. The confirmed transformation can be
further edited by going into the Toolshelf and altering the Offset slider provided that no other actions take place
between the Shear transform confirmation and accessing the slider.

Note that the result of the Shear transform is also dependant on the number and type of selected elements
(Objects, vertices, faces etc). See below for the result of using Shear on a number of different elements.

The effects of a Shear transform with different Pivot Points. See the text below for additional information.

The three frames of the image above show the effects of shearing on the selected vertices when the pivot point
is altered. In frame B, the Pivot Point is set to Median Point (indicated by the yellow line) and the mouse was
moved to the left during the transform. In frame C, the Pivot Point is set to the 3D cursor which is located
above the mesh (indicated again by the yellow line). When the mouse is moved to the left during a Shear
transform the selected vertices are moved to the right as they are below the horizontal axis.

Tip
Shear transform magnitude
The magnitude of the Shear transform applied to the selected elements is directly proportional to the distance
from the horizontal axis. i.e. the further from the axis, the greater the movement.
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The effects of a Shear transform on Objects with different Pivot Points. See the text below for additional information.

The three frames of the image above show the effects of shearing on the selected Objects when the Pivot Point
is altered. In frame B, the Pivot Point is set to Median Point (indicated by the yellow line) and the mouse was
moved to the left during the transform. In frame C, the Pivot Point is set to the 3D cursor which is located
above the Objects (indicated again by the yellow line). When the mouse is moved to the left during a Shear
transform all of the selected Objects are moved to the right as they are below the horizontal axis. Again, note
that the magnitude of the transform is proportional to the distance from the horizontal axis. In this case, the
lower Objects move further than the upper ones.

To Sphere
Reference
Mode: Edit mode
Menu: Mesh ‣ Transform ‣ To Sphere

Description
The To Sphere transformation will give the selection spherical qualities. The Suzanne with increasing sphericity
image below shows the results of applying the To Sphere transformation to the Suzanne mesh.

Suzanne with increasing sphericity.

The sequence above shows a Suzanne mesh with a 0, 0.25 (25%), 0.5 (50%) and 1 (100%) To Sphere transform
applied.
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Usage

To Sphere Factor.

Select the elements you want to operate on and activate the To Sphere transform function. The To Sphere option
can be invoked from the Mesh ‣ Transform ‣ To Sphere menu option or by pressing Shift-Alt-S. The
amount of sphericity given to the selection can be determined interactively by moving the mouse or by typing a
number between 0 and 1. Pressing Return will confirm the transformation. The confirmed transformation can
be further edited by pressing F6 or by going into the Toolshelf and altering the Factor slider provided that no
other actions take place between the To Sphere transform confirmation and accessing the slider.

Note that the result of the To Sphere transform is also dependant on the number of selected mesh elements
(vertices, faces etc). As can be seen in the below image, the result will be smoother and more spherical when
there are more mesh elements available to work with.

To Sphere applied to cubes with different subdivision levels. In this image sequence, To Sphere was applied to the entire
cube at levels of 0, 0.25 (25%), 0.5 (50%) and 1 (100%) respectively.

The To Sphere transform will generate different results depending on the number and arrangement of elements
that were selected (as shown by the below image).
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To Sphere applied to different selections.

Warp
Reference
Mode: Object and Edit modes
Menu: Object/Mesh/Curve/Surface ‣ Transform ‣ Warp

warp tool options

In Edit mode, the Warp transformation takes selected elements and warps them around the 3D cursor by a
certain angle. Note that this transformation is always dependent on the location of the 3D cursor. The Pivot
Point is not taken into account. The results of the Warp transformation are also view dependent.
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In Object mode, the Warp transformation takes the selected Objects and causes them to move in an orbit-like
fashion around the 3D cursor. Similar to Edit mode, the Pivot Point is not taken into account and the results are
view dependent.

Usage

In this example, a plane is warped around the 3D cursor by the indicated number of degrees.

Select the elements you want to operate on and activate the Warp transform function. The Warp option can be
invoked from the Object/Mesh/Curve/Surface ‣ Transform ‣ Warp menu option. The amount of warping given
to the selection can be determined interactively by moving the mouse or by typing a number. Pressing Return
will confirm the transformation. The confirmed transformation can be further edited by pressing F6 or by going
into the Toolshelf and altering the Angle slider provided that no other actions take place between the Warp
transform confirmation and accessing the slider.

Cursor position and view
The location of the 3D cursor can be used to alter the results of the Warp transformation. As can be seen from
the example in this section, the Warp radius is dependent on the distance of the cursor from the selected
elements. The greater the distance, the greater the radius.
The result of the Warp transform is also influenced by your current view. The example in this section shows the
results of a 180 degree Warp transform applied to the same Suzanne mesh when in different views. A 3D render
is also provided for comparison.

The left side of this image shows how the Warp transform is influenced by the location of the cursor. The right hand side
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shows the influence of the current view.

Note
Warping text
If you want to warp text, you will need to convert it from a Text Object to Mesh by pressing Alt-C and
selecting the Mesh from Curve/Meta/Surf/Text option.

Example

Text wrapped around logo. This was made by creating the Bforartists logo and text as separate Objects. The text was
converted to a mesh and then warped around the Bforartists logo.

Bend
Reference
Reference
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Mode: Object and Edit modes
Menu: Object/Mesh/Curve/Surface ‣ Transform ‣ Bend

Bend Transform with Clamp ON and OFF

This tool rotates a line of selected elements forming an arc between the mouse-cursor and the 3D-cursor.

Usage
The bend tool can be used in any case where you might want to bend a shape in two with a gradual transition
between both sides.
This may take a little getting used to, the basics are listed below controls are noted here.
• The initial position of the cursors define the axis to bend on.
• The distance of the mouse-cursor to the 3d-cursor controls how sharp the bend will be.
• The relative angle of the mouse-cursor to the initial axis defines the bend angle.
If this seems overly complicated, its probably best to try the tool where it becomes quickly apparent how the
tool reacts to your input.
Bend Angle
The amount of rotation.
Radius
The sharpness of the bend.
Clamp
Normally the arc turns through a clamped rotation angle with the selected elements extended along a
tangent line beyond that (see above left). When the clamp is OFF, the arc continues around aligning the
selected elements into a circle (right).
When OFF (Alt) all selected elements follow a circle, even when outside the segment between the 3d
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cursor and the mouse.
Note
Unlike most other transform modes Bend isn’t effected by Pivot Point or Transform Orientation, always using
the View Plane instead.
Hint
You can turn the bend angle through multiple rotations potentially forming a spiral shape.

Duplicating
Mesh Duplicating Tools
This section covers mesh editing tools that add additional geometry by duplicating existing geometry in some
way.
•
•
•
•

Duplicate Geometry.
Extrusion.
Spin.
Screw.

Note
Multiple Viewports
When you use one of the duplication tools in the Mesh Tools panel, Bforartists cannot guess which view you
want to work in - if you have more than one opened, of course... As the view is often important for these tools,
once you have activated one, your cursor turns into a sort of question mark - click with it inside the window
you want to use.

Duplicate
Reference
Mode: Edit mode
Menu: Mesh ‣ Duplicate

This tool simply duplicates the selected elements, without creating any links with the rest of the mesh (unlike
extrude, for example), and places the duplicate at the location of the original. Once the duplication is done, only
the new duplicated elements are selected, and you are automatically placed in grab/move mode, so you can
translate your copy elsewhere...
In the Tool Shelf are settings for Vector offset, Proportional Editing, Duplication Mode (non-functional?), and
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Axis Constraints.
Note that duplicated elements belong to the same vertex groups as the “original” ones. The same goes for the
material indices, the edge’s Sharp and Seam flags, and probably for the other vertex/edge/face properties...

Extrude
Extrude Region
Reference
Mode: Edit mode
Panel: Mesh Tools ‣ Extrude
Menu: Mesh ‣ Extrude Region

One tool of paramount importance for working with meshes is the Extrude tool. It allows you to create
parallelepipeds from rectangles and cylinders from circles, as well as easily create such things as tree limbs.
Extrude is one of the most frequently used modeling tools in Bforartists. It’s simple, straightforward, and easy
to use, yet very powerful.
The selection is extruded along the common normal of selected faces. In every other case the extrusion can be
limited to a single axis by specifying an axis (e.g. X to limit to the X axis or Shift-X to the YZ plane. When
extruding along the face normal, limiting movement to the global Z axis requires pressing Z twice, once to
disable the face normal Z axis limit, and once to enable the global Z axis limit.

Selected face

During extrude

Set to Z axis

Although the process is quite intuitive, the principles behind Extrude are fairly elaborate as discussed below:
• First, the algorithm determines the outside edge-loop of the extrude; that is, which among the selected
edges will be changed into faces. By default (see below), the algorithm considers edges belonging to
two or more selected faces as internal, and hence not part of the loop.
• The edges in the edge-loop are then changed into faces.
• If the edges in the edge-loop belong to only one face in the complete mesh, then all of the selected faces
are duplicated and linked to the newly created faces. For example, rectangles will result in
parallelepipeds during this stage.
• In other cases, the selected faces are linked to the newly created faces but not duplicated. This prevents
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undesired faces from being retained “inside” the resulting mesh. This distinction is extremely important
since it ensures the construction of consistently coherent, closed volumes at all times when using
Extrude.
• When extruding completely closed volumes (like e.g. a cube with all its six faces), extrusion results
merely in a duplication, as the volume is duplicated, without any link to the original one.
• Edges not belonging to selected faces, which form an “open” edge-loop, are duplicated and a new face
is created between the new edge and the original one.
• Single selected vertices which do not belong to selected edges are duplicated and a new edge is created
between the two.

Extrude Individual
Reference
Mode: Edit mode
Panel: Mesh Tools ‣ Extrude Individual
Menu: Mesh ‣ Extrude Individual

Extrude Individual allows you to extrude a selection of multiple faces as individuals, instead of as a region. The
faces are extruded along their own normals, rather than their average. This has several consequences: first,
“internal” edges (i.e. edges between two selected faces) are no longer deleted (the original faces are).

Selection of multiple faces

Extruded using extrude region

Extruded using Extrude Individual

Extrude Edges and Vertices Only
Reference
Mode: Edit mode, Vertex and Edge

If vertices are selected while doing an extrude, but they do not form an edge or face, they will extrude as
expected, forming a non-manifold edge. Similarly, if edges are selected that do not form a face, they will
extrude to form a face.
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Single vertex extruded

Single edge extruded

When a selection of vertices forms an edge or face, it will extrude as if the edge was selected. Likewise for
edges that form a face.
To force a vertex or edge selection to extrude as a vertex or edge, respectively, use Alt-E to access the
Extrude Edges Only and Vertices Only.

Vertex selected
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Vertices Only extrude

Edge selected

Edge Only extrude

Inset
Reference
Mode: Edit mode
Tool Shelf > Tools tab > Mesh Tools Panel
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This tool takes the currently selected faces and creates an inset of them, with adjustable thickness and depth.
The tool is modal, such that when you activate it, you may adjust the thickness with your mouse position.

Selection to inset

Selection with inset

Options

Inset Operator Settings

Boundary
Determines whether open edges will be inset or not.
Offset Even
Scale the offset to give more even thickness.
Offset Relative
Scale the offset by surrounding geometry.
Thickness
Set the size of the inset.
Depth
Raise or lower the newly inset faces to add depth.
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Outset
Create an outset rather than an inset.
Select Outer
Toggle which side of the inset is selected after operation.

Mirror
Reference
Mode: Object and Edit modes
Menu: Object/Mesh ‣ Mirror

Description

Mirroring a selection.

Mirroring an Object or Mesh selection will create a reversed version of the selection. The position of the
mirrored version of the selection is determined by the Pivot Point. A common use of mirroring is to model half
an object, duplicate it and then use the mirror transform to create a reversed version to complete the model.
Note that mirrored duplicates can also be created with a Mirror modifier.
Read more about the Pivot Point
Read more about the Mirror Modifier

Usage
To mirror a selection along a particular global axis use the mirror tool, followed by X, Y or Z.
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The image Mirroring a selection shows the results of this action after a mesh element has been duplicated.

In Mesh mode, you can mirror the selection on the currently selected Transform Orientation by pressing the
appropriate axis key a second time. For example, if the Transform Orientation is set to Normal, use the mirror
tool, followed by X and then X again
will mirror the selection along the X-axis of the Normal Orientation.
Read more about Transform Orientations

Interactive mirror.

You can alternatively hold the MMB to interactively mirror the object by moving the mouse in the direction of
the mirror axis.

Spin
Reference
Mode: Edit mode
Panel: Mesh Tools (Editing context)

Use the Spin tool to create the sort of objects that you would produce on a lathe (this tool is often called a
“lathe”-tool or a “sweep”-tool in the literature, for this reason). In fact, it does a sort of circular extrusion of
your selected elements, centered on the 3D cursor, and around the axis perpendicular to the working view...
• The point of view will determine around which axis the extrusion spins...
• The position of the 3D cursor will be the center of the rotation.
Here are its settings:
Steps
Specifies how many copies will be extruded along the “sweep”.
Dupli
When enabled, will keep the original selected elements as separated islands in the mesh (i.e. unlinked to
the result of the spin extrusion).
Angle
specifies the angle “swept” by this tool, in degrees (e.g. set it to 180 for half a turn).
Center
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Specifies the center of the spin. By default it uses the cursor position.
Axis
Specify the spin axis as a vector. By default it uses the view axis.

Example

Glass profile.

First, create a mesh representing the profile of your object. If you are modeling a hollow object, it is a good idea
to thicken the outline. (Glass profile) shows the profile for a wine glass we will model as a demonstration.
Go to the Edit mode and select all the vertices of the Profile with A.
We will be rotating the object around the cursor in the top view, so switch to the top view with Numpad7.

Glass profile, top view in Edit mode, just before spinning.

Place the cursor along the center of the profile by selecting one of the vertices along the center, and snapping
the 3D cursor to that location with Mesh ‣ Cursor ‣ Selection. (Glass profile, top view in Edit mode, just before
spinning) shows the wine glass profile from top view, with the cursor correctly positioned.
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Click the Spin button. If you have more than one 3D view open, the cursor will change to an arrow with a
question mark and you will have to click in the window containing the top view before continuing. If you have
only one 3D view open, the spin will happen immediately. (Spun profile) shows the result of a successful spin.

Angle

Spun profile using an angle of 360

Spun profile using an angle of 120
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Dupli

Result of spin operation

Result of Dupli enabled
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Merge Duplicates

Duplicate vertices

The spin operation leaves duplicate vertices along the profile. You can select all vertices at the seam with Box
select (B) shown in (Seam vertex selection) and perform a Remove Doubles operation.
Notice the selected vertex count before and after the Remove Doubles operation (Vertex count after removing
doubles). If all goes well, the final vertex count (38 in this example) should match the number of the original
profile noted in (Mesh data - Vertex and face numbers). If not, some vertices were missed and you will need to
weld them manually. Or, worse, too many vertices will have been merged.
Note
Merging two vertices in one
To merge (weld) two vertices together, select both of them by Shift-RMB clicking on them. Scale and hold
down Ctrl while scaling to scale the points down to 0 units in the X, Y and Z axis. LMB to complete the
scaling operation and click the Remove Doubles button in the Buttons window, Editing context.

Recalculate Normals
All that remains now is to recalculate the normals to the outside by selecting all vertices, and validating Recalc
Normals Outside.

Screw Tool
Reference
Mode: Edit Mode

Introduction
The Screw Tool is an effective way to revolve a profile, giving similar results to what you would expect from a
lathe, with the option to offset the operation to give a screw effect.
You can see some examples of Meshes generated with the Screw tool in Fig. 1 - Wood Screw tip done with the
screw tool and Fig. 2 - Spring done with the screw tool.
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Fig. 1 - Wood Screw tip done with the screw tool

Fig. 2- Spring done with the screw tool

Description
The Screw tool combines a repetitive Spin with a translation, to generate a screw-like, or spiral-shaped, object.
Use this tool to create screws, springs, or shell-shaped structures (Sea shells, Wood Screw Tips, Special
profiles, etc).
The main difference between the Screw Tool and the Screw Modifier is that the Screw Tool can calculate the
angular progressions using the basic profile angle automatically. Or it can adjusting the Axis angular vector
without using a second modifier (for example, using the Screw Modifier with a Bevel Modifier, Curve
Modifier, etc...), resulting in a much cleaner approach for vertex distribution and usage.
This tool works using open or closed profiles, as well as profiles closed with faces. You can use profiles like an
open-edge part that is a part of a complete piece, as well as a closed circle or a half-cut sphere, which will also
close the profile end.
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Usage
• This tool works only with Meshes.
• In Edit Mode, the button for the Screw tool operation is located in the Mesh Tools Panel, –> Add –>
Screw Button.
• To use this tool, you need to create at least one open profile or line to be used as a vector for the height,
angular vector and to give Bforartists a direction.
• The Screw function uses two points given by the open line to create an initial vector to calculate the
height and basic angle of the translation vector that is added to the “Spin” for each full rotation (see
examples below). If the vector is created with only two vertices at the same X, Y and Z location (which
won’t give Bforartists a vector value for height), this will create a normal “Spin”.
• Having at least one vector line, you can add other closed support profiles that will follow this vector
during the extrusions (See limitations).
• The direction of the extrusions is calculated by two determinant factors, your point of view in Global
Space and the position of your cursor in the 3DView Space using Global coordinates.
• The profile and the vector must be fully selected in Edit Mode before you click the Screw Button (See
Limitations.)
• When you have the vector for the open profile and the other closed profiles selected, click the Screw
Button.

Limitations
There are strict conditions about your profile selection when you want to use this tool. You must have at least
one open line or open profile, giving Bforartists the starting Vector for extrusion, angular vector and height.
(e.g. a simple edge, a half circle, etc...). You need only to ensure that at least one reference line has two “free”
ends. If two open Lines are given, Bforartists won’t determine which of them is the vector, and will then show
you an error message, “You have to select a string of connected vertices too”. You need to select all of the
profile vertices that will participate in the Screw Tool operation; if they are not properly selected, Bforartists
will also show you the same message.
Note that the open line is always extruded, so if you only use it to “guide” the screw, you will have to delete it
after the tool completion (use linked-selection to select the whole extrusion of the open line).
If there is any problem with the selection or profiles, the tool will warn you with the error message: “You have
to select a string of connected vertices too” as seen in Fig. 3 and 4, both in the info Window and at the place
where you clicked to start performing the operation (when you click the Screw Button).

Fig. 3 - Screw Error message in the Header of the Info Window

Fig. 4 - Error message when clicking in the Screw Tool with an incorrect or bad selection

You may have as many profiles as you like (like circles, squares, and so on) - Note that not all vertices in a
profile need to be in the same plane, even if this is the most common case. You may also have other, more
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complex, selected closed islands, but they have to be closed profiles because Bforartists will seek for only one
open profile for the translation, height and angular vector. Some closed meshes that overlap themselves may not
screw correctly (for example: Half UVsphere = OK, more than half = could cause the Screw Tool to have
wrong behavior or errors), and profiles that are closed with faces (like a cone or half sphere) will be closed
automatically at their ends, like if you were extruding a region.
Tip
Simple way to not result in error
Only one open Profile, all of the others can be closed, avoid volumes and some profiles closed with faces...

Options
This tool is an interactive and modal tool, and only works in the Edit Mode.
Once you click in the Screw tool in the Mesh Tools Panel, Bforartists will enter in the Screw interactive mode,
and the Operator Panel at the end of the Mesh Tools Panel will be replaced so you can adjust the values
explained below. To show the Mesh Tools Panel, use the shortcut T in the Edit Mode of the 3D View Window.
Once you perform any other operation, Bforartists leaves the interactive mode and accepts all of the values.
Because it’s modal, you can’t return to the interactive mode after completing/leaving the operation or changing
from Edit Mode to Object Mode. If you want to restart the operation from its beginning, you can press Ctrl-Z
at any time in Edit Mode.
• The basic location of the cursor at the point of view (using Global coordinates) will determine around
which axis the selection is extruded and spun at first (See Fig. 6 - Cursor Basic Location - Transform
Panel). Bforartists will copy your cursor location coordinates to the values present in the Center values
of the Screw interactive Panel. Depending on the Global View position, Bforartists will automatically
add a value of 1 to one of the Axis Vectors, giving the profiles a starting direction for the Screw
Operation and also giving a direction for the extrusions. (See examples below.)
• The position of the 3D cursor will be the starting center of the rotation. Subsequent operations (e.g.
pressing the Screw button again), will start from the last selected element. Continuous operations
without changing the selection will repeat the operation continuously from the last point.

Fig. 6 - Cursor Basic Location - Transform Panel
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Fig. 7 - Screw Interactive Panel - Mesh Tools Panel (Edit Mode)

Center
These numeric fields specify the center of the spin. When the tool is called for the first time, it will copy
the X, Y and Z location (Global Coordinates) of the cursor presently in the 3D View to start the operation.
You can specify the cursor coordinates using the Transform Panel in 3D View, using shortcut T to toggle
the Panel, and typing in the 3D Cursor Location coordinates. You can adjust these coordinates
interactively and specify another place for the spin center during the interactive session. (See Fig. 7 Screw Interactive Panel - Mesh Tools Panel (Edit Mode))
Steps
This numeric field specifies how many extrusion(s) will be done for each 360 turn. The steps are evenly
distributed by dividing 360 by the number of steps given. The minimum value is 3; the maximum is 256
(See Fig. 7)
Turns:
This numeric field specifies how many turns will be executed. Bforartists will add a new full 360 turn for
each incremental number specified here. The minimum value is 1; the maximum is 256. (See Fig. 7)
Axis
These 3 numeric fields vary from -1.0 to 1.0 and are clamped above those limits. These values
correspond to angular vectors from -90 to 90 degrees. Depending on the position where you started your
cursor location and Object operation in the viewport and its axis positions in Global View space and
coordinates, Bforartists will give the proper Axis vector a value of 1, giving the angular vector of the
profile a starting direction and giving the extrusions a starting direction based on your view. Bforartists
will let you adjust your axis angular vectors and you can tweak your object such that you can revert the
direction of the screw operation (by reverting the angular vector of the height), meaning you can revert
the clockwise and counterclockwise direction of some operations, and also adjust the angular vectors of
your profile, bending it accordingly. (See Fig. 7)
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Examples
The Spring example

Fig. 8 - Circle placed at X -3,0,0

• Open Bforartists and delete the default Cube.
• Change from perspective to orthographic view using shortcut Numpad5.
• Change your view from User Ortho to Front Ortho, using the shortcut Numpad1. You will see the X
(red) and Z (blue) coordinate lines.
• In case you have moved your cursor by clicking anywhere in the screen, again place your cursor at the
Center
• Add a circle
• Rotate this circle by 90
• Apply the Rotation
• Grab and move this circle to the left 3 Bforartists Units on the X Axis
• You will have to scale your circle by 5
• Now enter Edit Mode
• De-select all vertices
Now we will create a height vector for Bforartists:
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Fig. 9 - Profile and vector created

To Do
Removed original explanation text. for the upper image. It was a spelling lesson with press this press that
hotkey. Not a single hint of what tool was used. No way to convert this one into a useful text that explains
what tools are in use and how to reach the goal by menu. Bollocks. To Do!

Clockwise and Counterclockwise using the Spring Example
Still in the interactive session of the Screw Tool, you will see that the Z Axis Value of the Screw Panel is set to
1.000. Left click LMB in the middle of the Value and set this value to -1.000. At first, the Spring was being
constructed in a Counterclockwise direction, and you reverted the operation 180 degrees in the Z Axis. This is
because you have changed the angular vector of the height you have given to Bforartists to the opposite
direction (remember, -90 to 90 = 180 degrees ?). See Fig. 10 - Counterclockwise direction and Fig. 11 - Flipped
to Clockwise direction.
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Fig. 10 - Counterclockwise direction

Fig. 11 - Flipped to Clockwise direction.

It’s also important to note that this vector is related to the same height vector axis used for the extrusion and we
have created a parallel line with the Z Axis, so, the sensibility of this vector is in practical sense reactive only to
negative and positive values because it’s aligned with the extrusion axis. Bforartists will clamp the positive and
negative to its maximum values to make the extrusion follow a direction, even if the profile starts reverted. The
same rule applies to other Global axes when creating the Object for the Screw Tool; this means if you create
your Object using the Top View, the vector that gives the height for extrusion will also change abruptly from
negative to positive and vice versa to give the extrusion a direction, and you will have to tweak the
corresponding Axis accordingly to achieve the Clockwise and Counterclockwise effect.
Note
Vectors that aren’t parallel with Bforartists Axis
The high sensibility for the vector doesn’t apply to vectors that give the Screw Tool a starting angle (Ex: any
non-parallel vector), meaning Bforartists won’t need to clamp the values to stabilize a direction for the
extrusion, as the inclination of the vector will be clear for Bforartists and you will have the full degree of
freedom to change the vectors. Our example is important because it only changes the direction of the profile
without the tilt and/or bending effect, as there is only one direction for the extrusion, parallel to one of the
Bforartists Axes

Bending the Profiles using the Spring Example
Still using the Spring Example, we can change the remaining vector for the angles that aren’t related to the
extrusion Axis of our Spring, thus bending our spring with the remaining vectors and creating a profile that will
also open and/or close because of the change in starting angular vector values. What we are really doing is
changing the starting angle of the profile prior to the extrusions. It means that Bforartists will connect each of
the circles inclined with the vector you have given. Below we show two bent Meshes using the Axis vectors and
the Spring example. See Fig. 12 and Fig. 13. These two Meshes generated with the Screw tool were created
using the Top Ortho View.
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Fig. 12 - Bended Mesh, Example 1 - The Axis will give the profile a starting vector angle

Fig. 13 - Bended Mesh Example 2 - The vector angle is maintained along the extrusions

Creating perfect Screw Spindles
Using the Spring Example, it’s easy to create perfect Screw Spindles (like the ones present in normal screws
that we can buy in hardware stores). Perfect Screw Spindles use a profile with the same height as its vector, and
the beginning and ending vertex of the profile are placed at a straight parallel line with the axis of extrusion.
The easiest way of achieving this effect is to create a simple profile where the beginning and ending vertices
create a straight parallel line. Bforartists won’t take into account any of the vertices present in the middle but
those two to take its angular vector, so the spindles of the screw (which are defined by the turns value) will
assembly perfectly with each other.
To Do
Removed original explanation text. for the upper image. It was a spelling lesson with press this press that
hotkey. Not a single hint of what tool was used. No way to convert this one into a useful text that explains
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what tools are in use and how to reach the goal by menu. Bollocks. To Do!

Fig. 14 - Profile for a perfect screw spindle. The starting and ending vertices are forming a parallel line with the Bforartists
Axis

Fig. 15 - Generated Mesh. You can use this technique to perform normal screw modeling.

Here, in Fig. 16 and Fig. 17, we show you an example using a different profile, but maintaining the beginning
and ending vertices at the same position. The generated mesh looks like a medieval ramp!
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Fig. 16 - Profile with starting and ending vertices forming a parallel line with the Bforartists Axis

Fig. 17 - Generated Mesh with the profile at the left. We have inclined the visualization a bit.

As you can see, the Screw spindles are perfectly assembled with each other, and they follow a straight line from
top to bottom. You can also change the Clockwise and Counterclockwise direction using this example, to create
right and left screw spindles. At this point, you can give the screw another dimension, changing the Center of
the Spin Extrusion, making it more suitable to your needs or calculating a perfect screw and merging its
vertices with a cylinder, modeling its head, etc.

A Screw Tip
As we have explained before, the Screw tool generates clean and simple meshes to deal with; they are light,
well-connected and are created with very predictable results. This is due to the Bforartists calculations taking
into account not only the height of the vector, but also its starting angle. It means that Bforartists will connect
the vertices with each other in a way that they follow a continuous cycle along the extruded generated profile.
In this example, you will learn how to create a simple Screw Tip (like the ones we use for wood; we have
shown an example at the beginning of this page). To make this new example as short as possible, we will
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recycle our last example (again).
• Open Bforartists and click in File located in the header of the Info Window again; choose Open Recent
and the file we saved for this exercise. All of the things will be placed exactly the way you saved before.
Choose the last saved Bforartists file; in the last exercise, we gave it the name Screw Hardware
Example.blend.
• Grab the upper vertex and move a bit to the left, but no more than you have moved your last vertex. (See
Fig. 18 - Profile With Starting Vector Angle)
• Press the shortcut A twice to de-select and select all.
• Set Cursor to Center
• Press Screw.

Fig. 18 - Profile With Starting Vector Angle

Fig. 19 - Generated Mesh with the Profile

As you can see in Fig. 19, Bforartists follows the basic angular vector of the profile, and the profile basic angle
determines whether the extruded subsequent configured turns will open or close the resulting mesh following
this angle. The vector of the extrusion angle is determined by the starting and ending Vertex of the profile.
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Subdividing

Mesh Subdividing Tools
Subdividing adds resolution by cutting existing faces and edges into smaller pieces. There are several tools that
allow you to do this:
Subdivide
Divide a face or edge into smaller units, adding resolution.
Loop Subdivide
Insert a loop of edges between existing ones
Vertex Connect
Connects selected vertices with edges that split faces.
Knife Subdivide
Cut edges and faces interactively
Bevel
Subdivides edges or vertices, making them faceted or rounded

Subdivide
Reference
Mode: Edit mode
Panel: Mesh Tools (Editing context)
Menu: Mesh ‣ Edges ‣ Subdivide, Specials ‣ Subdivide/Subdivide Smooth
Subdividing splits selected edges and faces by cutting them in half or more, adding necessary vertices, and
subdividing accordingly the faces involved, following a few rules, depending on the settings:
• When only one edge of a face is selected (Tri mode), triangles are subdivided into two triangles, and
quads, into three triangles.
• When two edges of a face are selected:
• If the face is a triangle, a new edge is created between the two new vertices, subdividing the
triangle in a triangle and a quad.
• If the face is a quad, and the edges are neighbors, we have three possible behaviors, depending
on the setting of Corner Cut Type (the drop-down menu next to the Subdivide button, in Mesh
Tools panel) See below for details.
• If the face is a quad, and the edges are opposite, the quad is just subdivided in two quads by the
edge linking the two new vertices.
• When three edges of a face are selected:
• If the face is a triangle, this means the whole face is selected - it is then sub-divided in four
smaller triangles.
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• If the face is a quad, first the two opposite edges are subdivided as described above. Then, the
“middle” edge is subdivided, affecting its new “sub-quad” as described above for only one edge.
• When four edges of a face (a quad) are selected, the face is subdivided into four smaller quads.

Options
These options are available in the Tool Panel after running the tool;
Number of Cuts
Specifies the number of cuts per edge to make. By default this is 1, cutting edges in half. A value of 2 will
cut it into thirds, and so on.
Smoothness
Displaces subdivisions to maintain approximate curvature, The effect is similar to the way the subdivision
modifier might deform the mesh.

Mesh before subdividing

Subdivided with no smoothing

Subdivided with smoothing of 1

Quad/Tri Mode
Forces subdivide to create triangles instead of ngons, simulating old behavior (see examples below)
Corner Cut Type
This drop-down menu controls the way quads with only two adjacent selected edges are subdivided
Fan
the quad is sub-divided in a fan of four triangles, the common vertex being the one opposite to the
selected edges.
Innervert
(i.e. “inner vertex”), The selected edges are sub-divided, then an edge is created between the two
new vertices, creating a small triangle. This edge is also sub-divided, and the “inner vertex” thus
created is linked by another edge to the one opposite to the original selected edges. All this results
in a quad sub-divided in a triangle and two quad.
Path
First an edge is created between the two opposite ends of the selected edges, dividing the quad in
two triangles. Then, the same goes for the involved triangle as described above.
Straight Cut
Currently non functioning...
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Fan cut type

Innervert cut type

Path cut type

Fractal
Displaces the vertices in random directions after the mesh is subdivided

Plane before subdivision

Regular subdivision

Same mesh with fractal added

Along Normal
Causes the vertices to move along the their normals, instead of random directions

Along normal set to 1

Random Seed
Changes the random seed of the noise function, producing a different result for each seed value.

Same mesh with a different seed value
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Examples
Below are several examples illustrating the various possibilities of the Subdivide and Subdivide Multi tools.
Note the selection after subdivision.

The sample mesh.

One Edge

One Edges

Quad/Tri Mode
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Two Tri Edges

Quad/Tri Mode

Two Opposite Quad Edges

Quad/Tri Mode

Two Adjacent Quad Edges

Fan cut type

Quad/Tri Mode
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Innervert cut type

Quad/Tri Mode

Path cut type

Quad/Tri Mode

Three Edges

Quad/Tri Mode
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Tri

Quad/Tri Mode

Quad/Four Edges

Quad/Tri Mode

Multicut

Tri with two cuts

Quad with two cuts
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Loop Subdivide
Reference
Mode: Edit mode
Panel: Editing context –> Mesh Tools

Loop Cut splits a loop of faces by inserting a new edge loop intersecting the chosen edge. The tool is interactive
and has two steps:

Usage
Pre-visualizing the cut
After the tool is activated, move the cursor over a desired edge. The cut to be made is marked with a
magenta colored line as you move the mouse over the various edges. The to-be-created edge loop stops at
the poles (tris and ngons) where the existing face loop terminates.
Sliding the new edge loop
Once an edge is chosen via LMB, you can move the mouse along the edge to determine where the new
edge loop will be placed. This is identical to the Edge Slide tool. Clicking LMB again confirms and makes
the cut at the pre-visualized location, or clicking RMB forces the cut to exactly 50%. This step is skipped
when using multiple edge loops (see below)

mesh before inserting edge loop
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Preview of edge loop location

Interactive placement of edge loop between adjacent loops

Options
Options are only available while the tool is in use, and are displayed in the 3d view header
Even
Only available for single edge loops. This matches the shape of the edge loop to one of the adjacent edge
loops. (See Edge Slide tool for details)
Flip
When Even is enabled, this flips the target edge loop to match. (See Edge Slide tool for details)
Number of Cuts Wheel or NumpadPlus / NumpadMinus
After activating the tool, but before confirming initial loop location, you can increase and decrease the
number of cuts to create, by entering a number with the keyboard, scrolling Wheel or using
NumpadPlus and NumpadMinus. Note that when creating multiple loops, these cuts are uniformly
distributed in the original face loop, and you will not be able to control their positions.

Preview of multiple edge loops
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Result of using multiple cuts

Smoothing Alt-Wheel
Smoothing causes edge loops to be placed in an interpolated position, relative to the face it is added to,
causing them to be shifted outwards or inwards by a given percentage, similar to the Subdivide Smooth
command. When not using smoothing, new vertices for the new edge loop are placed exactly on the preexisting edges. This keeps subdivided faces flat, but can distort geometry, particularly when using
Subdivision Surfaces. Smoothing can help maintain the curvature of a surface once it is subdivided.

Added edge loops without smoothing

Same edge loops, but with smoothing value

Knife Tool
Reference
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Mode: Edit mode
Panel: Mesh Tools (Editing context)
The knife tool can be used to interactively cut up geometry by drawing lines or closed loops to create holes.

Usage
Click at the button, the Knife tool becomes active.
Drawing the cut line
When using Knife, the cursor changes to an icon of a scalpel and the header changes to display options for
the tool. You can draw connected straight lines by clicking LMB.

Mesh before knife cut

Knife cut active

After confirming knife cut
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Options
Knife selection
Activates the knife so only selected faces are cut.
New cut
Begins a new cut. This allows you to define multiple distinct cut lines. If multiple cuts have been defined,
they are recognized as new snapping points.

Creating multiple cuts

Result of starting new cuts while in the tool

Midpoint snap
Hold to snap the cursor to the midpoint of edges
Ignore snap
Hold to make the tool ignore snapping.
Cut through
Allow the cut tool to cut through to obscured faces, instead of only the visible ones.
Angle constrain
Constrains the cut to 45 degree increments.
Close loop
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This is a quick way to close the loop you’re currently cutting.
Draw a continuous line
So you can draw a freehand line over a surface, points will be created at edge intersections.

Constraining cut angle

Result of constraining cut angle

Confirming and selection
Pressing Esc or RMB at any time cancels the tool, and pressing LMB or Return confirms the cut, with the
following options:
Return will leave selected every edge except the new edges created from the cut.

Limitations
Cuts that begin or end in the middle of a face, will be ignored. This is a limitation of the current geometry that
can be modeled in Bforartists.
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Knife Project
Knife projection is a non-interactive tool where you can use objects to cookie-cut into the mesh rather than
hand drawing the line.
This works by using the outlines of other selected objects in edit-mode to cut into the mesh, resulting geometry
inside the cutters outline will be selected.
Outlines can be wire or boundary edges.
To use Knife Project, in ‘object’ mode select the “cutting object” first then shift select the “object to be cut”.
Now tab into edit mode and press “knife project”.

Examples

Before projecting from a text object

Resulting knife projection
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Before projecting from a mesh object

Resulting knife projection (extruded after)
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Before projecting from a 3D curve object

Resulting knife projection (extruded after)

Known Issues
Cutting holes into single faces may fail, this is the same limitation as with the regular knife tool but more
noticeable for text, this can be avoided by projecting onto more highly subdivided geometry.

Mesh Bisect
Reference
Mode: Edit mode
Menu: Mesh ‣ Bisect

The bisect tool is a quick way to cut a mesh in-two along a custom plane.
There are three important differences between this and the knife tool.
• The plane can be numerically adjusted in the operator panel for precise values.
• Cuts may remove geometry on one side.
• Cuts can optionally fill in the holes created, with materials and UV’s & vertex-colors based on the
surrounding geometry.
This means the bisect tool can cut off parts of a mesh without creating any holes.

135

Bforartists Reference Manual - © Copyright - This page is under OCL license

Example of a common use of bisect

Example of bisect with fill option

Vertex Connect
Reference
Mode: Edit mode
Menu: Mesh –> Vertices –> Connect
This tool joins selected vertices by edges, The main difference between this and creating edges is that faces are
split by the newly joined vertices.
When many vertices are selected, faces will be split by their selected vertices.
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Before

After

When there are only 2 vertices selected, a cut will be made across unselected faces, a little like the knife tool;
however this is limited to straight cuts across connected faces.

Before

After

Bevel
Reference
Mode: Edit mode
Menu: Mesh ‣ Edges ‣ Bevel or [Ctrl][E] ‣ Bevel
Menu (vertex-only): Mesh ‣ Vertices ‣ Bevel or [Ctrl][V] ‣ Bevel

With bevel and without bevel.

The bevel tool allows you to create chamfered or rounded corners to geometry. A bevel is an effect that smooths
out edges and corners. True world edges are very seldom exactly sharp. Not even a knife blade edge can be
considered perfectly sharp. Most edges are intentionally beveled for mechanical and practical reasons.
Bevels are also useful for giving realism to non-organic models. In the real world, the blunt edges on objects
catch the light and change the shading around the edges. This gives a solid, realistic look, as opposed to unbeveled objects which can look too perfect.
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Bevel Modifier
The Bevel Modifier is a non destructive alternative to the bevel tool. It gives you the same options, with
additional goodies, like the bevel width controlled by the vertices weight, and all the modifiers general
enhancements (non-destructive operations, ...).

Usage
The Bevel tool works only on selected edges. It will recognize any edges included in a vertex or face selection
as well, and perform the bevel the same as if those edges were explicitly selected. In “vertex only” mode, the
Bevel tool works on selected vertices instead of edges. The Bevel tool smooths the edges and/or “corners”
(vertices) by replacing them with faces making smooth profiles with a specified number of segments (see the
options below for details about the bevel algorithm).
Move the mouse to interactively specify the bevel offset, and scroll the Wheel to increase or decrease the
number of segments. (see below)

Selected edge before beveling

Result of bevel (one segment)
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Result of bevel (vertex only)

Note
Normal (edge) beveling only works on edges that have exactly two faces attached to them. Vertex bevel has no
such restriction.

Options

Amount
You can change the bevel amount by moving the mouse towards and away from the object, a bit like with
transform tools. The exact meaning of the value depends on the Amount Type option (see below). As
usual, the scaling can be controlled to a finer degree by holding Shift to scale in 0.001 steps. LMB
finalizes the operation, RMB or Esc aborts the action.
Amount Type
Selects how the Amount value controls the size of the bevel. According to the selection, the amount is: Offset - the distance of a new edge from the original - Width - the width of the bevel face - Depth - the
perpendicular distance from the original edge to the bevel face - Percent - the percentage of the length of
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adjacent edges that the new edges slide
Segments
The number of segments in the bevel can be defined by scrolling the mouse Wheel to increase or
decrease this value. The greater the number of segments, the smoother the bevel.
Alternatively, you can manually enter a segment number value while using the tool, or in the Mesh Tool
options panel after using the tool.

Bevel with 4 segments

Profile
This is a number between 0 and 1 that controls the shape of the profile (side view of a beveled edge). The
default value, 0.5, gives a circular arc (if the faces meet at right angles). Values less than that give a flatter
profile, with 0.25 being exactly flat, and values less than that giving a concave bevel. Values more than
0.5 give a more “bulged-out” profile.
Vertex Only
When selected, the tool is in “vertex only” mode, and only vertices will be beveled.
Clamp Overlap
When selected, the bevel amount is not allowed to go larger than an amount that causes overlapping
collisions with other geometry.
Material
The Material number specifies which material should be assigned to the new faces created by the Bevel
tool. With the default, -1, the material is inherited from the closest existing face (“closest” can be a bit
ambiguous). Otherwise, the number is the slot index of the material to use for all newly created faces.
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Examples

Result of beveling multiple edges

Another example of beveling multiple edges

An example using Profile=0.150

Miscellaneous Editing Tools
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Sort Elements
This tool (available from the Specials, Vertices, Edges and Faces menus) allows you to reorder the matching
selected mesh elements, following various methods. Note that when called from the Specials menu, the affected
element types are the same as the active select modes.
View Z Axis
Sort along the active view’s Z axis, from farthest to nearest by default (use Reverse if you want it the
other way).
View X Axis
Sort along the active view’s X axis, from left to right by default (again, there’s the Reverse option).
Cursor Distance
Sort from nearest to farthest away from the 3D cursor position (Reverse also available).
Material
Faces only! Sort faces from those having the lowest material’s index to those having the highest. Order of
faces inside each of those “material groups” remains unchanged. Note that the Reverse option only
reverses the order of the materials, not the order of the faces inside them.
Selected
Move all selected elements to the beginning (or end, if Reverse enabled), without affecting their relative
orders. Warning: this option will also affect unselected elements’ indices!
Randomize
Randomizes indices of selected elements (without affecting those of unselected ones). The seed option
allows you to get another randomization - the same seed over the same mesh/set of selected elements will
always give the same result!
Reverse
Simply reverse the order of the selected elements.

Vertex Groups

The Vertex Group Panel

Vertex Groups are mainly used to tag the vertices belonging to parts of a Mesh Object or Lattice. Think of the
legs of a chair or the hinges of a door, or hands, arms, limbs, head, feet, etc. of a character. In addition you can
assign different weight values (in the range [ 0.0, 1.0 ] ) to the vertices within a Vertex Group. Hence Vertex
Groups are sometimes also named Weight Groups.
Vertex Groups are most commonly used for Armatures (See also Skinning Mesh Objects). But they are also
used in many other areas of Bforartists, like for example:
• Shape keys
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• Modifiers
• Particle Generators
• Physics Simulations
Many more usage scenarios are possible. Actually you can use Vertex Groups for whatever makes sense to you.
In some contexts Vertex Groups can also be automatically generated (i.e. for rigged objects). However in this
section we will focus on manually created (user-defined) Vertex Groups.
Note
Vertex groups only apply to Mesh and Lattice Objects
Any other Object type has no vertices, hence it can not have Vertex Groups.

Typical usage scenarios for Vertex groups
Skinning an armature
If you want to animate your mesh and make it move, you will define an armature which consists of a
bunch of bones. Vertex Groups are used to associate parts of the Mesh to Bones of the Armature, where
you can specify an influence weight in the range [0.0 ... 1.0] for each vertex in the Vertex Group.
Working with Modifiers
Many modifiers contain the ability to control the modifier influence on each vertex separately. This is also
done via Vertex Groups and the weight values associated to the vertices.
Quickly select/edit/hide parts of a mesh
By defining mesh regions with Vertex Groups you can easily select entire parts of your mesh with 3 clicks
and work on them in isolation without having to create separate objects. With the hide function you can
even remove a vertex group from the view (for later unhide).
Cull out and duplicate parts of a mesh
Consider modeling a Lego block. The most simple brick consists of a base and a stud (the bump to
connect the bricks together). To create a four-stud block, you would want to be able to easily select the
stud vertices, and, still in Edit mode, duplicate them and position them where you want them.

Creating Vertex Groups

Empty Vertex Group Panel

Vertex Groups are maintained within the Object Data Properties window (1), and there in the Vertex Groups
panel. As long as no Vertex groups are defined (the default for new Mesh Objects), the Panel is empty (2).
You create a vertex group by LMB + on the right Panel border (3). Initially the group is named Group (or
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Group.nnn when the name already exists) and gets displayed in the Panel (2) (see next image).

Vertex Groups Panel Controls

One Vertex Group

Once a new Vertex Group has been added, the new Group appears in the vertex Groups panel. There you find 3
clickable elements:
Group Name
The Groupname can be changed by double clicking LMB on the name itself. Then you can edit the name
as you like.
Plus Icon
When the little icon in the left lower corner can be clicked, a new row opens up where you can enter a
search term. This becomes handy when the number of vertex groups gets big.
Drag Handle
If you have a large number of vertex groups and you want to see more then a few Groups, you can LMB
on the small drag handle to tear the vertex groups list larger or smaller.
Active Group
When a Vertex Group is created, then it is also automatically marked as the Active Group. This is
indicated by setting the background of the panel entry to a light blue color. If you have two or more
groups in the list, then you can change the active group by LMB on the corresponding entry in the Vertex
Group panel.

Deleting vertex Groups

Delete a Vertex Group

You delete a Vertex Group by first making it the active group (select it in the panel) and then LMB the - button
at the right Panel border.
Deleting a Vertex Group only deletes the vertex assignments to the Group. The vertices themselves are not
deleted.
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Locking Vertex Groups

Lock a Vertex Group

Right after creation of a Vertex Group, an open lock icon shows up on the right side of the Vertex Group List
entry. This icon indicates that the Vertex Group can be edited. You can add vertex assignments to the group or
remove assignments from the group. And you can change it with the weight paint brushes, etc.
When you click on the icon, it changes to a closed lock icon and all vertex group modifications get disabled.
You can only rename or delete the group, and unlock it again. No other operations are allowed on locked Vertex
Groups, thus all corresponding function buttons become disabled for locked Vertex Groups.

Working with Content of Vertex Groups

Vertex Group Panel in Edit Mode

When you switch either to Edit-Mode or to Weight-Paint Vertex Selection Mode, then the Vertex Group panel
expands and displays 2 more rows:
The first row contains 4 buttons for maintaining the Assign- and Select- status of vertices of the active Vertex
Group:
Assign
To assign the Selected vertices to the Group with the weight as defined in the “Weight:” input field (see
below)
Remove
To Remove the selected vertices from the Group (and thus also delete their weight values)
Select
To Select all vertices contained in the Group
Deselect
To deselect all verts contained in the group
Below this row of buttons you see a numeric “Weight:” input field where you specify the weight value that gets
assigned to the selected verts when you press the Assign Button.
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Assigning verts to a Group

Assign weights to active group

You add vertices to a group as follows:
•
•
•
•

Select the group from the group list, thus make it the Active Group (1).
From the 3D Viewport select Shift-RMB all vertices that you want to add to the group.
Set the weight value that shall be assigned to all selected verts (2).
LMB the Assign button to assign the selected verts to the active group using the given weight (3).

Note that weight Assignment is not available for locked Vertex Groups. The Assign button is grayed out in that
case.
Note
Assign is additive
The Assign button only adds the currently selected vertices to the active group. Vertices already assigned to the
group are not removed from the group.
Also keep in mind that a vertex can be assigned to multiple groups.

Checking Assignments
To be sure the selected verts are in the desired Vertex Group, you can try press the deselect button. If the
vertices remain selected then they’re not yet in the current Vertex Group.
At this point you may assign then, but take care since all selected vertices will have their weight set to the value
in the Weight: field.

Removing assignments from a Group
You remove vertices from a group as follows:
• Select the group from the group list (make it the active group).
• Select all vertices that you want to remove from the group.
• Press the Remove button.
Note that Removing weight Assignments is not available for locked Vertex Groups. The Remove button is
grayed out in that case.
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Using groups for Selecting/Deselecting
You can quickly select all assigned vertices of a group:
• (optionally) press A once or twice to unselect all vertices.
• Select the group from the group list (make it the active group).
• When you now LMB click the Select button, then the vertices assigned to the active group will be
selected and highlighted in the 3D Viewport.
• When you LMB click the Deselect button instead, then the vertices assigned to the active group will be
deselected in the 3D Viewport.
Note
Selecting/Deselecting is additive
If you already have verts selected in the 3D View, then selecting the verts of a group will add the verts but also
keep the already-selected verts selected. Vice versa, deselecting the verts of a vertex group will only deselect
the verts assigned to the group and keep all other verts selected.

Finding ungrouped verts
You can find ungrouped vertices as follows:
• Press A once or twice to unselect all vertices.
• In the footer of the 3D Viewport: Navigate to Select –> Ungrouped verts

Vertex Groups pop-up menu
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Vertex Group Management

Vertex groups panel’s dropdown menu

Vertex Groups provide a more complex set of functions inside a Pull down menu. This menu is accessible from
the Vertex Group Panel by clicking on the dark gray arrow down icon on the right panel border.
The following functions of the Pulldown Menu operate on the assigned vertices:
Sort Vertex Groups:
Sorts Vertex Groups Alphabetically
Copy Vertex Group:
Add a Copy of the active Vertex Group as a new Group. The new group will be named like the original
group with “_copy” appended at the end of its name. And it will contain associations to exactly the same
verts with the exact same weights as in the source vertex group.
Copy Vertex Groups to Linked:
Copy Vertex Groups of this Mesh to all linked Objects which use the same mesh data (all users of the
data).
Copy Vertex Group to Selected:
Copy all Vertex Groups to other Selected Objects provided they have matching indices (typically this is
true for copies of the mesh which are only deformed and not otherwise edited).
Mirror Vertex Group:
Mirror all Vertex Groups, flip weights and/or names, editing only selected vertices, flipping when both
sides are selected; otherwise copy from unselected. Note this function will be reworked (and fully
documented) in a future release.
Remove from All Groups:
(not available for locked groups) Unassigns the selected Vertices from all groups. After this operation has
been performed, the verts will no longer be contained in any vertex group.
Clear Active group (not available for locked groups):
Remove all assigned vertices from the active Group. The group is made empty. Note that the vertices may
still be assigned to other Vertex Groups of the Object.
Delete All Groups:
Remove all Vertex Groups from the Object.
The following functions operate only on the lock state settings:
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Lock All
Lock all groups
Unlock All
Unlock all groups
Lock_Invert All
Invert Group Locks

Hints
• Multiple objects sharing the same mesh data have the peculiar property that the group names are stored
on the object, but the weights in the mesh. This allows you to name groups differently on each object,
but take care because removing a vertex group will remove the group from all objects sharing this mesh.

Weight Editing

Vertex Weights Panel

As mentioned before in Vertex Groups each entry in a Vertex Group also contains a weight value in the range of
[0.0,1.0]. Bforartists provides a Vertex Weights panel from where you can get (and edit) information about the
weight values of each Vertex of a mesh. That is: to which Vertex Groups the vertex is assigned with which
weight value.
The Vertex Weights panel can be found in the right property sidebar of the 3D Viewport. It is available in Edit
mode and in Weight Paint mode (when Vertex Selection masking is enabled as well). The panel is separated into
the sections
• Vertex Group Categories (1)
• Weight Table (2)
• function bar (3)

Vertex Group Categories
Actually we do not have any strict categories of Vertex Groups in Bforartists. Technically they all behave the
same way. However we can identify 2 implicit categories of Vertex Groups:

The Deform Groups
These Vertex groups are sometimes also named Weight Groups. They are used for defining the weight tables of
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Armature bones. All Deform Groups of an Object are strictly related to each other via their weight values.
Strictly speaking, the sum of all deform weights for any vertex of a mesh should be exactly 1. 0. In Bforartists
this constraint is a bit relaxed (see below). Nevertheless, Deform Groups should always be seen as related to
each other. Hence we have provided a filter that allows restricting the Vertex Weight panel to display only the
Deform bones of an Object.

The Other Groups
All other usages of Vertex Groups are summarized into the Other category. These vertex groups can be found
within Shape keys, Modifiers, etc... There is really no good name for this category, so we kept it simple and
named it Other.

The Weight Table
The Weight Table shows all weights associated to the active vertex. Note that a vertex does not necessarily have
to be associated to any vertex groups. In that case the Vertex Weights Panel is not displayed.
Tip
The active Vertex
That is the most recently selected vertex. This vertex is always highlighted so that you can see it easily in the
mesh. If the active Vertex does not have weights, or there is no active vertex selected at the moment, then the
Vertex Weights Panel disappears.
Each row in the Weight table contains 4 active elements:

Change Active Group

Set the Active Group
As soon as you select any of the Vertex Group Names in the Weight table, the referenced Vertex Group
becomes the new Active group.

Enable display of Weights in Edit Mode

150

Bforartists Reference Manual - © Copyright - This page is under OCL license

Display Weights in Edit Mode
When you are in edit mode, you can make the Weights of the active Group visible on the mesh:
Search the Mesh Display panel in the Properties sidebar. And there enable the Show Weights option. Now you
can see the weights of the active Vertex Group displayed on the mesh surface.

Weights in Edit Mode

Edit Weights in Edit Mode
It is now very easy to work with weightmaps in Edit mode. All edit options of the mesh are available and you
have direct visual control over how your Weights change when you edit the weight values.

Change Weight Value

Change a weight
You can either enter a new weight value manually (click on the number and edit the value), or you can change
the weight by LMB and while holding down the mouse button, drag right or left to increase/decrease the weight
value. You also can use the right/left arrows displayed around the weight value to change the weight in steps.

Paste weights

Paste a weight to other verts
LMB the Paste Icon allows you to forward a single weight of the active Vertex to all selected vertices. But note
that weights are only pasted to verts which already have a weight value in the affected Vertex Group.
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Delete weights

Delete a weight from a Group
LMB the Delete Icon will instantly remove the weight from the active vertex. Thus the entire row disappears
when you click on the delete icon.

The Function bar

Vertex Weights panel Function Bar

The function bar contains 2 functions:
Normalize
Normalizes the weights of the active Vertex. That is all weights of the active vertex are recalculated such
that their relative weight is maintained and the weight sum is 1.0.
Copy
Copies all weights defined for the active Vertex to all selected Verts. Thus all previously defined weights
are overwritten.
Tip
The filter setting is respected
Note that both functions only work on the Vertex Groups currently displayed in the Weights Table. So if for
example only the Deform weights are displayed, then Normalize and Copy only affect the Deform bones.

About locked Vertex Groups

Vertex Weights panel Locked
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Whenever a Weight Group is locked, all data changing functions get disabled:
•
•
•
•

Normalize the vertex Weights.
Copy the Vertex weights.
Change the Weight of the active vert.
Paste to selected verts.

Tip
The filter setting is respected
If you have for example all deform weight groups unlocked and all other vertex groups locked, then you can
safely select Deform from the Filter row and use all available functions from the Weight table again.

Smoothing
Mesh Shading
Example mesh rendered flat, smoothed using edge split, and using Subdivision Surface. Note how edges are rendered
differently. Sample .blend
http://wiki.Bforartists.org/index.php/:File:25-manual-meshsmooth-example.blend

As seen in the previous sections, polygons are central to Bforartists. Most objects are represented by polygons
and truly curved objects are often approximated by polygon meshes. When rendering images, you may notice
that these polygons appear as a series of small, flat faces.
Sometimes this is a desirable effect, but usually we want our objects to look nice and smooth. This section
shows you how to visually smooth an object, and how to apply the Auto Smooth filter to quickly and easily
combine smooth and faceted polygons in the same object.
The last section on this page shows possibilities for smoothing a mesh’s geometry, not only its appearance.

Smooth shading
Reference
Mode: Edit and Object mode
Panel: Mesh Tools (Editing context)
Menu: Mesh ‣ Faces ‣ Shade Smooth / Shade Flat
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Same mesh smooth shaded

The easiest way is to set an entire object as smooth or faceted by selecting a mesh object, and in Object mode,
click Smooth in the Tool Shelf. This button does not stay pressed; it forces the assignment of the “smoothing”
attribute to each face in the mesh, including when you add or delete geometry.
Notice that the outline of the object is still strongly faceted. Activating the smoothing features doesn’t actually
modify the object’s geometry; it changes the way the shading is calculated across the surfaces, giving the
illusion of a smooth surface. Click the Flat button in the Tool Shelf ‘s Shading panel to revert the shading back
to that shown in the first image above.

Smoothing parts of a mesh
Alternatively, you can choose which edges to smooth by entering Edit mode, then selecting some faces and
clicking the Smooth button. The selected edges are marked in yellow.
When the mesh is in Edit mode, only the selected edges will receive the “smoothing” attribute. You can set
edges as flat (removing the “smoothing” attribute) in the same way by selecting edges and clicking the Flat
button.

Auto Smooth
Reference
Panel: Properties (Object Data context)
Example mesh with Auto Smooth enabled

It can be difficult to create certain combinations of smooth and solid faces using the above techniques alone.
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Though there are workarounds (such as splitting off sets of faces by selecting them and pressing Y), there is an
easier way to combine smooth and solid faces, by using Auto Smooth.
Auto smoothing can be enabled in the mesh’s panel in the Properties window. Angles on the model that are
smaller than the angle specified in the Angle button will be smoothed during rendering (i.e. not in the 3D view)
when that part of the mesh is set to smooth. Higher values will produce smoother faces, while the lowest setting
will look identical to a mesh that has been set completely solid.
Note that a mesh, or any faces that have been set as Flat, will not change their shading when Auto Smooth is
activated: this allows you extra control over which faces will be smoothed and which ones won’t by overriding
the decisions made by the Auto Smooth algorithm.

Edge Split Modifier
With the Edge Split Modifier we get a result similar to Auto Smooth with the ability to choose which edges
should be split, based on angle - those marked as sharp.

Edge Split modifier enabled, based on
angle

Edges marked as sharp

Resulting render with sharp edge
weighting

Smoothing the mesh geometry
The above techniques do not alter the mesh itself, only the way it is displayed and rendered. Instead of just
making the mesh look like a smooth surface, you can also physically smooth the geometry of the mesh with
these tools:

Mesh editing tools
You can apply one of the following in Edit mode:
Smooth
This relaxes selected components, resulting in a smoother mesh.
Laplacian Smooth
Smooths geometry by offers controls for better preserving larger details.
Subdivide Smooth
Adjusting the smooth parameter after using the subdivide tool results in a more organic shape. This is
similar to using the subdivide modifier.
Bevel
This Bevels selected edged, causing sharp edges to be flattened.
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Modifiers
Alternatively, you can smooth the mesh non-destructively with one or several of the following modifiers:
Smooth Modifier
Works like the Smooth tool in Edit mode; can be applied to specific parts of the mesh using vertex groups.
Laplactian Smooth Modifier
Works like the Laplacian Smooth tool in Edit mode; can be applied to specific parts of the mesh using
vertex groups.
Bevel Modifier
Works like the Bevel tool in Edit mode; Bevel can be set to work on an angle threshold, or on edge weight
values.
Catmull-Clark subdivision produces smooth results. Sharp edges can be defined with subdivision creases
or by setting certain edges to “sharp” and adding an EdgeSplit modifier (set to From Marked As Sharp)
before the Subsurf modifier.
Example mesh with Auto Smooth enabled

Subsurf

Using creased edges, and resulting subsurf artifacts

Extra edge loops added
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3D view showing creased edges (pink) and added
edges loops (yellow)

Mesh Clean-up
These tools are to help cleanup degenerate geometry and fill in missing areas of a mesh.

Fill Holes
Reference
Mode: Edit mode
Menu: Mesh ‣ Clean up ‣ Fill Holes
This tool is can take a large selection and detect the holes in the mesh, filling them in.
This is different from the face creation operator in three important respects.
• holes are detected, so there is no need to manually find and select the edges around the holes.
• holes can have a limit for the number of sides (so only quads or tris are filled in for example).
• mesh data is copied from surrounding geometry (UV’s, vertex-colors, multi-res, all layers), since
manually creating this data is very time consuming.

Split Non-Planar Faces
Reference
Mode: Edit mode
Menu: Mesh ‣ Clean up ‣ Split Non-Planar Faces
This tool avoids ambiguous areas of geometry by splitting non-flat faces when they are bent beyond a given
limit.

Delete Loose Geometry
Reference
Mode: Edit mode
Menu: Mesh ‣ Clean up ‣ Delete Loose
This tool removes disconnected vertices and edges (optionally faces - off by default).

Degenerate Dissolve
Reference
Mode: Edit mode
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Menu: Mesh ‣ Clean up ‣ Degenerate Dissolve
This tool collapses / removes geometry which you typically won’t want.
• Edges with no length.
• Faces with no areas (faces on a point or thin faces).
• Face corners with no area.
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Curves

Bird logo made from Bezier curves.

Curves and Surfaces are particular types of Bforartists Objects. They are expressed by mathematical functions
rather than a series of points.
Bforartists offers both Bezier Curves and Non-Uniform Rational B-Splines (NURBS). Both Bezier curves and
NURBS curves and surfaces are defined in terms of a set of “control points” (or “control vertices”) which
define a “control polygon”.
Both bezier and NURBs curves are named after their mathematical definitions, and choosing between them is
often more a matter of how they are computed behind the scenes than how they appear from a modeler’s
perspective. Bezier curves are generally more intuitive because they start and end at the control points that you
set, but NURBs curves are more efficient for the computer to calculate when there are many twists and turns in
a curve.
The main advantage to using curves instead of polygonal meshes is that curves are defined by less data and so
2
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can produce results using less memory and storage space at modeling time. However, this procedural approach
to surfaces can increase demands at render time.
Certain modeling techniques, such as extruding a profile along a path, are possible only using curves. On the
other hand, when using curves, vertex-level control is more difficult and if fine control is necessary, mesh
editing may be a better modeling option.
Bezier curves are the most commonly used curves for designing letters or logos. They are also widely used in
animation, both as paths for objects to move along and as F-curves to change the properties of objects as a
function of time.

Curve Primitives

Add Curve menu.

In Object mode, the Add Curve menu, Bforartists provides five different curve primitives:
Bezier Curve
Adds an open 2D Bezier curve with two control points.
Bezier Circle
Adds a closed, circle-shaped 2D Bezier curve (made of four control points).
NURBS Curve
Adds an open 2D NURBS curve, with four control points, with Uniform knots.
NURBS Circle
Adds a closed, circle-shaped 2D NURBS curve (made of eight control points).
Path
Adds a NURBS open 3D curve made of five aligned control points, with Endpoint knots and the
CurvePath setting enabled.

Bezier Curves
The main elements used in editing Bezier Curves are the Control Points and Handles. A Segment (the actual
Curve) is found between two Control Points. In the image below, the Control Points can be found in the middle
of the pink line while the Handles comprise the extensions from the Control Point. By default the arrows on the
Segment represents the direction and relative speed and direction of movement Objects will have when moving
along the curve. This can be altered by defining a custom Speed Ipo.

3
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Bezier Curve in Edit mode.

Editing Bezier Curves
A Bezier curve can be edited by moving the locations of the Control Points and Handles.
• Add a Curve by Shift-A to bring up the Add menu, followed by Curve ‣ Bezier.
• Press Tab to enter Edit mode.
• Select one of the Control Points and move it around. Use LMB to confirm the new location of the
Control Point, or use RMB to cancel.
• Now select one of the Handles and move it around. Notice how this changes the curvature of the curve.
To add more Control Points
• Select at least two adjacent Control Points.
• Press W and select Subdivide.
• Optionally, you can press F6 immediately after the subdivision to modify the number of subdivisions.
Note that while in Edit mode you cannot directly select a Segment. To do so, select all of the Control Points that
make up the Segment you want to move.
There are four Bezier curve handle types. They can be accessed by pressing V and selecting from the list that
appears, or by pressing the appropriate hotkey combination. Handles can be rotated, moved, scaled and
shrunk/fattened like any vertex in a mesh.

Bezier Curve Handle Types
Automatic V-A
This handle has a completely automatic length and direction which is set by Bforartists to ensure the
smoothest result. These handles convert to Aligned handles when moved.

Vector V-V
Both parts of a handle always point to the previous handle or the next handle which allows you to create
curves or sections thereof made of straight lines or with sharp corners. Vector handles convert to Free
handles when moved.
4
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Aligned V-L
These handles always lie in a straight line, and give a continuous curve without sharp angles.

Free V-F
The handles are independent of each other.

Additionally, the V-T shortcut can be used to toggle between Free and Aligned handle types.

Curve Properties
Curve Properties can be set from the Object Data option in the Properties Header (shown below in blue).

Shape

Curves Shape panel.

2D and 3D Curves
By default, new curves are set to be 3D, which means that Control Points can be placed anywhere in 3D
space. Curves can also be set to 2D which constrain the Control Points to the Curve’s local XY axis.
Resolution
The resolution property defines the number of points that are computed between every pair of Control
Points. Curves can be made more or less smooth by increasing and decreasing the resolution respectively.
5
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The Preview U setting determines the resolution in the 3D viewport while the Render U setting
determines the Curve’s render resolution. If Render U is set to zero (0), then the Preview U setting is used
for both the 3D viewport and render resolution.

Curves with a resolution of 3 (left) and 12 (right).

Twisting
A 3D Curve has Control Points that are not located on the Curve’s local XY plane. This gives the Curve a
twist which can affect the Curve normals. You can alter how the twist of the Curve is calculated by
choosing from Minimum, Tangent and Z-Up options from the drop-down menu.

Curves with a twist of minimum (left) and tangent (right).

Fill
Fill determines the way a Curve is displayed when it is Beveled (see below for details on Beveling).
When set to Half (the default) the Curve is displayed as half a cylinder. The Fill Deformed option allows
you to indicate whether the Curve should be filled before or after (default) applying any Shape Keys or
Modifiers.

Curves with a fill of half (left) and full (right).

Path/Curve-Deform
These options are primarily utilized when using a Curve as a Path or when using the Curve Deform
property. The Radius, Stretch and Bounds Clamp options control how Objects use the Curve and are dealt
with in more detail in the appropriate links below.
See also
• Basic Curve Editing
• Animation Paths

6
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Geometry

Curves Geometry panel.

Modification
Offset
By default, text Objects are treated as curves. The Offset option will alter the space between letters.
Extrude
Will extrude the curve along both the positive and negative local Z axes.
Bevel
Depth
Changes the size of the bevel

A Curve with different Bevel depths applied.

Resolution
Alters the smoothness of the bevel

A Curve with different resolutions applied.

Taper Object
Tapering a Curve causes it to get thinner towards one end. You can also alter the proportions of the Taper
throughout the tapered object by moving/scaling/rotating the Control Points of the Taper Object. The
Taper Object can only be another Curve. Editing the Handles and Control Points of the Taper Object will
cause the original Object to change shape.
7
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A Curve before (left) and after (right) a Bezier Curve Taper Object was applied.

Bevel Object
Beveling a Bezier Curve with a Bezier Curve as the Bevel Object generally gives it the appearance of a
plane, while using a Bezier Circle as the Bevel Object will give it the appearance of a cylinder. The Bevel
Object can only be another Curve. Editing the Handles and Control Points of the Bevel Object will cause
the original Object to change shape. Given the options available, it is best to experiment and see the
results of this operation.

A Curve with the Bevel Object as a Bezier Curve (left) and as a Bezier Circle (right).

Fill Caps
Seals the ends of a beveled Curve.
Map Taper
For Curves using a Taper Object and with modifications to the Start/End Bevel Factor the Map Taper
option will apply the taper to the beveled part of the Curve (not the whole Curve).

A Curve without (left) and with (right) Map Taper applied.

Start Bevel Factor and End Bevel Factor
These options determine where to start the Bevel operation on the Curve being beveled. Increasing the
8
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Start Bevel Factor to 0.5 will start beveling the Curve 50% of the distance from the start of the Curve (in
effect shortening the Curve). Decreasing the End Bevel Factor by 0.25 will start beveling the Curve 25%
of the distance from the end of the Curve (again, shortening the Curve).

A Curve with no Bevel factor applied (left), with a 50% Start Bevel Factor (middle) and with a 25% End Bevel Factor (right).

Path Animation
The Path Animation settings can be used to determine how Objects move along a certain path. See the link
below for further information.
Read more about utilizing Curves for paths during animation

Active Spline

Curves Active Spline panel.

The Active Spline panel becomes available during Edit mode.
Cyclic
Closes the Curve.
Resolution
Alters the smoothness of each segment by changing the number of subdivisions.
Interpolation
Tilt
Alters how the tilt of a segment is calculated.
Radius
Alters how the radius of a Beveled Curve is calculated. The effects are easier to see after
Shrinking/Fattening a control point Alt-S.
9
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Smooth
Smooths the normals of the Curve

Non-Uniform Rational B-Splines (NURBS)
One of the major differences between Bezier Objects and NURBS Objects is that Bezier Curves are
approximations. For example, a Bezier circle is an approximation of a circle, whereas a NURBS circle is an
exact circle. NURBS theory can be a very complicated topic. For an introduction, please consult the Wikipedia
page. In practice, many of the Bezier curve operations discussed above apply to NURBS curves in the same
manner. The following text will concentrate only on those aspects that are unique to NURBS curves.

Editing NURBS Curves
A NURBS Curve is edited by moving the location of the Control Points.
• Place a Curve by Shift-A to bring up the Add menu, followed by Curve ‣ NURBS curve.
• Press Tab to enter Edit mode.
• Select one of the Control Points and move it around. Use LMB to confirm the new location of the
Control Point, or use RMB to cancel.
• If you want to add additional Control Points, select both of them, press W and select Subdivide. Press F6
immediately after to determine how many subdivisions to make.

Active Spline

NURBS Active Spline panel.

Knots
One of the characteristics of a NURBS object is the knot vector. This is a sequence of numbers used to
determine the influence of the control points on the curve. While you cannot edit the knot vectors directly,
you can influence them through the Endpoint and Bezier options in the Active Spline panel. Note that the
Endpoint and Bezier settings only apply to open NURBS curves.
Cyclic
Makes the NURBS curve cyclic.

10
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A NURBS curve with Cyclic applied.

Bezier
Makes the NURBS curve act like a Bezier curve.
Endpoint
Makes the curve contact the end control points. Cyclic must be disabled for this option to work.

A NURBS curve with Endpoint enabled.

Order
The order of the NURBS curve determines the area of influence of the control points over the curve.
Higher order values means that a single control point has a greater influence over a greater relative
proportion of the curve. The valid range of Order values is 2-6 depending on the number of control points
present in the curve.

NURBS curves with orders of 2 (left), 4 (middle) and 6 (right).

Weight
TODO.

Path
As mentioned above, Curves are often used as paths. Any curve can be used as a Path if the Path Animation
option is selected.
The Path option available from the Add Curve menu is identical to a 3D NURBS curve, except that you do not
have access to the Active Spline panel.

Curve Selection
Curve selection in Edit mode is much less complex than with meshes! Mainly this is because you have only one
11
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selectable element type, the control points (no select mode needed here...). These points are a bit more complex
than simple vertices, however, especially for Béziers, as there is the central vertex, and its two handles...
The basic tools are the same as with meshes, so you can select a simple control point with a LMB -click, add to
current selection with Shift-LMB -clicks, B order-select, and so on.
One word about the Bézier control points: when you select the main central vertex, the two handles are
automatically selected too, so you can grab it as a whole, without creating an angle in the curve. However,
when you select a handle, only this vertex is selected, allowing you to modify this control vector...
L (or Ctrl-L) will add to the selection the cursor’s nearest control point, and all the linked ones, i.e. all points
belonging to the same curve. Note that for Bézier, using L with a handle selected will select the whole control
point and all the linked ones.

Select Menu
With curves, all “advanced” selection options are regrouped in the Select menu of the 3D views header. Let’s
detail them.
Random... Inverse Select/Deselect All
Border Select
All these options have the same meaning and behavior as in Object mode (and the specifics of Border
Select in Edit mode have already been discussed here).

Every Nth
Reference
Mode: Edit mode
Menu: Select ‣ Every Nth

This only works if you already have at least one control point selected. Using the current selection, it will add to
it every nth control point, before and after the initial selection. The “selection step” is specified in the N pop-up
numeric field shown during the tool start.

Select/Deselect First/Last
Reference
Mode: Edit mode
Menu: Select ‣ Select/Deselect First, Select ‣ Select/Deselect Last

These commands will toggle the selection of the first or last control point(s) of the curve(s) in the object. This is
useful to quickly find the start of a curve (e.g. when using it as path...).

12
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Select Next/Previous
Reference
Mode: Edit mode
Menu: Select ‣ Select Next, Select ‣ Select Previous
These commands will select the next or previous control point(s), based on the current selection (i.e. the control
points following or preceding the selected ones along the curve).

Select More / Less
Reference
Mode: Edit mode
Menu: Select ‣ More/Less

Their purpose, based on the currently selected control points, is to reduce or enlarge this selection.
More
for each selected control point, select all its linked points (i.e. one or two...).
Less
for each selected control point, if all points linked to this point are selected, keep this one selected.
Otherwise, de-select it.
This implies two points:
• First, when all control points of a curve are selected, nothing will happen (as for Less, all linked points
are always selected, and of course, More can’t add any). Conversely, the same goes when no control
points are selected.
• Second, these tools will never “go outside” of a curve (they will never “jump” to another curve in the
same object).

Curve Editing
This page covers the basics of curve editing. Curve basics, selecting and advanced editing are covered in the
following pages:
• Curve basics
• Curve Selecting

13
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Curve Display
Display Options

Curve Display panel

When in Edit mode, the Properties Shelf (N) contains options in the Curve Display panel for how curves are
displayed in the 3D viewport.
Handles
Toggles the display of Bezier handles while in edit mode. This does not affect the appearance of the curve
itself.
Normals
Toggles the display of Curve Normals.
Normal Size
Sets the display scale of curve normals.

Hiding Elements
When in Edit mode, you can hide and reveal elements from the display. This can be useful in complex models
with many elements on the Screen.
Hide Selected elements
Use H, or the Curve ‣ Show/Hide ‣ Hide Selected menu option from the 3D window header.
Show Hidden elements
Use Alt-H, or the Curve ‣ Show/Hide ‣ Show Hidden menu option from the 3D window header.
Hide Unselected elements
Use Shift-H, or the Curve ‣ Show/Hide ‣ Hide Unselected menu option from the 3D window
header.
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Basic Curve Editing (translation, rotation, scale)
Reference
Mode: Edit mode
Menu: Curve ‣ Transform ‣ Grab/Move, Rotate, Scale, ...
Like other elements in Bforartists, Curve control points can be grabbed/moved (G), rotated (R) or scaled (S) as
described in the Basic Transformations section. When in Edit mode, proportional editing is also available for
transformation actions.

Snapping
Reference
Mode: Edit mode
Panel: Curve Tools (Editing context)
Mesh snapping also works with curve components. Both control points and their handles will be affected by
snapping, except for within itself (other components of the active curve). Snapping works with 2D curves but
points will be constrained to the local XY axes.

Deforming Tools
Reference
Mode: Edit mode
Menu: Curve ‣ Transform
The To Sphere, Shear, Wrap and Push/Pull transform tools are described in the Transformations sections. The
two other tools, Tilt and Shrink/Fatten Radius are related to Curve Extrusion.

Smoothing
Reference
Mode: Edit mode
Curve smoothing is available through the specials menu. For Bézier curves, this smoothing operation currently
only smooths the positions of control points and not their tangents. End points are also constrained when
smoothing.

Mirror
Reference
Mode: Edit mode
Menu: Curve ‣ Mirror
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The Mirror tool is also available, behaving exactly as with mesh vertices,

Set Bézier Handle Type
Reference
Mode: Edit mode
Panel: Curve Tools ‣ Handles
Menu: Curve ‣ Control Points ‣ Set Handle Type
Handle types are a property of Bézier curves. and can be used to alter features of the curve. For example,
switching to Vector handles can be used to create curves with sharp corners. Read the Bézier curves page for
more details.

Extending Curves
Reference
Mode: Edit mode
Menu: Curve ‣ Extrude
Once a curve is created you can add new segments (in fact, new control points defining new segments), either
by extruding, or placing new handles with Ctrl-LMB clicks. Each new segment is added to one end of the
curve. A new segment will only be added if a single vertex, or handle, at one end of the curve is selected. If two
or more control points are selected, a new Bézier closed curve is started.

Subdivision
Reference
Mode: Edit mode
Panel: Curve Tools (Editing context)
Menu: Curve ‣ Segments ‣ Subdivide
Curve subdivision simply subdivides all selected segments by adding one or more control points between the
selected segments. To control the number of cuts, press W to make a single subdivision. Then press F6 to bring
up the Number of Cuts menu.

Duplication
Reference
Mode: Edit mode
Menu: Curve ‣ Duplicate
This command duplicates the selected control points, along with the curve segments implicitly selected (if any).
The copy is selected and placed in Grab mode, so you can move it to another place.
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Joining Curve Segments
Reference
Mode: Edit mode
Menu: Curve ‣ Make Segment
Two open curves can be combined into one by creating a segment between the two curves. To join two
separated curves, select one end control point from each curve then press F. The two curves are joined by a
segment to become a single curve.

Curves before and after joining

Additionally, you can close a curve by joining the endpoints but note that you can only join curves of the same
type (i.e. Bézier with Bézier, NURBS with NURBS)

Separating Curves
Reference
Mode: Edit mode
Menu: Curve ‣ Separate
Curve objects that are made of multiple distinct curves can be separated into their own objects by selecting the
desired segments and pressing P. Note, if there is only one curve in a Curve object, pressing P will create a new
Curve object with no control points.

Deleting Elements
Reference
Mode: Edit mode
Menu: Curve ‣ Delete...
The Erase pop-up menu of curves offers you three options:
Selected
This will delete the selected control points, without breaking the curve (i.e. the adjacent points will be
directly linked, joined, once the intermediary ones are deleted). Remember that NURBS order cannot be
higher than its number of control points, so it might decrease when you delete some control point. Of
17
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course, when only one point remains, there is no more visible curve, and when all points are deleted, the
curve itself is deleted.
Segment
This option is somewhat the opposite to the preceding one, as it will cut the curve, without removing any
control points, by erasing one selected segment. This option always removes only one segment (the last
“selected” one), even when several are in the selection. So to delete all segments in your selection, you’ll
have to repetitively use the same erase option...
All
As with meshes, this deletes everything in the object!

Deleting Curve Selected

Deleting Curve segments

Opening and Closing a Curve
Reference
Mode: Edit mode
Menu: Curve ‣ Toggle Cyclic
This toggles between an open curve and closed curve (Cyclic). Only curves with at least one selected control
point will be closed/open. The shape of the closing segment is based on the start and end handles for Bézier
curves, and as usual on adjacent control points for NURBS. The only time a handle is adjusted after closing is if
the handle is an Auto one. (Open curve) and (Closed curve) is the same Bézier curve open and closed.
This action only works on the original starting control-point or the last control-point added. Deleting a
segment(s) doesn’t change how the action applies; it still operates only on the starting and last control-points.
This means that Alt-C may actually join two curves instead of closing a single curve! Remember that when a
2D curve is closed, it creates a renderable flat face.

Open and Closed curves.

Switch Direction
Reference
18
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Mode: Edit mode
Menu: Curve ‣ Segments ‣ Switch Direction, Specials ‣ Switch Direction
This command will “reverse” the direction of any curve with at least one selected element (i. e. the start point
will become the end one, and vice versa). This is mainly useful when using a curve as path, or using the bevel
and taper options.

Converting Tools
Converting Curve Type
Reference
Panel: Curve Tools –> Set Spline type
Mode: Edit mode

Set Spline Type button

You can convert splines in a curve object between Bézier, NURBS, and Poly curves. Press T to bring up the
Toolshelf. Clicking on the Set Spline Type button will allow you to select the Spline type (Poly, Bézier or
NURBS).
Note, this is not a “smart” conversion, i.e. Bforartists does not try to keep the same shape, nor the same number
of control points. For example, when converting a NURBS to a Bézier, each group of three NURBS control
points become a unique Bézier one (center point and two handles).

Convert Curve to Mesh
Reference
Mode: Object mode
Menu: Object ‣ Convert to
There is also an “external” conversion, from curve to mesh, that only works in Object mode. It transforms a
Curve object in a Mesh one, using the curve resolution to create edges and vertices. Note that it also keeps the
faces and volumes created by closed and extruded curves.
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Convert Mesh to Curve
Reference
Mode: Object mode
Menu: Object ‣ Convert to
Mesh objects that consist of a series of connected vertices can be converted into curve objects. The resulting
curve will be a Poly curve type, but can be converted to have smooth segments as described above.

Curve Parenting
Reference
Mode: Edit mode
You can make other selected objects children of one or three control points Ctrl-P, as with mesh objects.
Select either 1 or 3 control points, then Ctrl-RMB another object and use Ctrl-P to make a vertex parent.

Hooks
Reference
Mode: Edit mode
Menu: Curve ‣ control points ‣ hooks
Hooks can be added to control one or more points with other objects.

Set Goal Weight
Reference
Mode: Edit mode
Menu: W ‣ Set Goal Weight
Set Goal Weight
This sets the “goal weight” of selected control points, which is used when a curve has Soft Body physics,
forcing the curve to “stick” to their original positions, based on the weight.

Curve Deform
Curve Deform provides a simple but efficient method of defining a deformation on a mesh. By parenting a
mesh object to a curve, you can deform the mesh up or down the curve by moving the mesh along, or
orthogonal to, the dominant axis. This is a most useful tool to make an object follow a complex path, like e.g. a
sheet of paper inside a printer, a film inside a camera, the water of a canal...
The Curve Deform works on a (global) dominant axis, X, Y, or Z. This means that when you move your mesh
20

Bforartists Reference Manual - © Copyright - This page is under OCL license

in the dominant direction, the mesh will traverse along the curve. Moving the mesh in an orthogonal direction
will move the mesh object closer or further away from the curve. The default settings in Bforartists map the Y
axis to the dominant axis. When you move the object beyond the curve endings the object will continue to
deform based on the direction vector of the curve endings.
If the “curve path” is 3D, the Tilt value of its control points will be used (see the Extrusion section above) to
twist the “curved” object around it. Unfortunately, the other Radius property is not used (it would have been
possible, for example, to make it control the size of the “curved” object...).
Tip
Try to position your object over the curve immediately after you have added it, before adding the curve
deform. This gives the best control over how the deformation works.
Note
Use modifiers!
The Curve Deform relationship is now also a modifier, called Curve. The Curve modifier function acts the
same as its counterpart, except that when the modifier is used, the “dominant axis” is set inside its properties and the Track X / Y / Z buttons no longer have an effect on it. And you have some goodies, like the possibility,
if “curving” a mesh, to only curve one of its vertex groups...

Interface

Make Parent menu.

When parenting an object (mesh, curve, meta, ...) to a curve (Ctrl-P), you will be presented with a menu
(Make Parent menu).
By selecting Curve Deform, you enable the curve deform function on the mesh object.
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Anim settings panel.

The dominant axis setting is set on the mesh object. By default the dominant axis in Bforartists is Y. This can be
changed by selecting one of the Track X, Y or Z buttons in the Anim Panel, (Anim settings panel), in Object
context.

Curve and Surface panel.

Cyclic (or closed) curves work as expected where the object deformations traverse along the path in cycles.
Note however that when you have more than one curve in the “parent” object, its “children” will only follow
the first one.
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The Stretch curve option allows you to let the mesh object stretch, or squeeze, over the entire curve. This option
is in Object Data properties, for the “parent” curve. See (Curve and Surface panel).

Example
Let’s make a simple example:

Add a Monkey!

• Remove default cube object from scene and add a Monkey (Add ‣ Mesh ‣ Monkey, Add a Monkey!)!
• Press Tab to exit Edit mode.

Add a Curve.

• Now add a curve (Add ‣ Curve ‣ Bezier Curve, Add a Curve).
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Edit Curve.

• While in Edit mode, move the control points of the curve as shown in (Edit Curve), then exit Edit mode
(Tab).
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Monkey on a Curve.

• Now, you can use the new, modern, modifier way of “curving” the Monkey:
• Select the Monkey (RMB).
• In the Object Modifiers properties, Modifiers panel, add a Curve modifier.
• Type the name of the curve (should be Curve) in the Ob field of the modifier, and optionally
change the dominant axis to Y.
• Or you can choose the old, deprecated method (note that it creates a “virtual” modifier...):
• Select the Monkey (RMB), and then shift select the curve (Shift-RMB).
• Press Ctrl-P to open up the Make Parent menu.
• Select Curve Deform (Make Parent menu).
• The Monkey should be positioned on the curve, as in (Monkey on a Curve).
• Now if you select the Monkey (RMB), and move it (G), in the Y-direction (the dominant axis by default),
the monkey will deform nicely along the curve.
Tip
If you press MMB (or one of the X / Y / Z keys) while moving the Monkey you will constrain the movement to
one axis only.
• In (Monkey deformations), you can see the Monkey at different positions along the curve. To get a
cleaner view over the deformation I have activated SubSurf with Subdiv to 2, and Set Smooth on the
Monkey mesh.
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Tip
Moving the Monkey in directions other than the dominant axis will create some odd deformations. Sometimes
this is what you want to achieve, so you’ll need to experiment and try it out!

Monkey deformations.

Curve Extrusion
This section covers methods for extruding curves, or giving them thickness, and how to control the thickness
along the path.

Extrusion
Reference
Mode: Object or Edit mode
Panel: Curve and Surface

Extrusion can be especially with the bevel/taper/Tilt/Radius options. Note that this isn’t related to Extrude used
in mesh edit-mode.
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We will see the different settings, depending on their scope of action:
Width
This controls the position of the extruded “border” of the curve, relative to the curve itself. With closed
2D curves (see below), it is quite simple to understand - with a Width greater than 1.0, the extruded
volume is wider, with a Width of 1.0, the border tightly follows the curve, and with a Width lower than
1.0, the volume is narrower? The same principle remains for open 2D and 3D curves, but the way the
“outside” and “inside” of the curve is determined seems a bit odd?
It has the same effect with extruded “bevel” objects...
Tilt
This setting - unfortunately, you can never see its value anywhere in Bforartists - controls the “twisting
angle” around the curve for each point - so it is only relevant with 3D curves! You set it using the Tilt
transform tool (T, or Curve ‣ Transform ‣ Tilt), and you can reset it to its default value (i.e.
perpendicular to the original curve plane) with Alt-T (or Curve ‣ Control Points ‣ Clear Tilt). With
NURBS, the tilt is always smoothly interpolated. However, with Bézier, you can choose the interpolation
algorithm to use in the Tilt Interpolation drop-down list of the Curve Tools panel (you will find the
classical Linear, Cardinal, B Spline and Ease options...).

Simple Extrusion
Let’s first see the “simple” extrusion of curves, without additional bevel/taper objects.
Extrude
This controls the width (or height) of the extrusion. The real size is of course dependent on the scale of
the underlying object, but with a scale of one, an Extrusion of 1.0 will extrude the curve one BU in both
directions, along the axis perpendicular to the curve’s plane (see below for specifics of 3D curves?).
If set to 0.0, there is no “simple” extrusion!
Bevel Depth
This will add a bevel to the extrusion. See below for its effects... Note that the bevel makes the extrusion
wider and higher. If set to 0.0, there is no bevel (max value: 2.0).
Bev Resol
Controls the resolution of the bevel created by a Bevel Depth higher than zero. If set the 0 (the default),
the bevel is a simple “flat” surface. Higher values will smooth, round off the bevel, similar to the
resolution settings of the curve itself...
We have three sub-classes of results, depending on whether the curve is open or closed or 3D:
Open 2D Curve
The extrusion will create a “wall” or “ribbon” following the curve shape. If using a Bevel Depth, the wall
becomes a sort of slide or gutter. Note the direction of this bevel is sometimes strange and unpredictable,
often the reverse of what you would get with the same curve closed? You can inverse this direction by
switching the direction of the curve.
This allows you, e.g., to quickly simulate a marble rolling down a complex slide, by combining an
extruded beveled curve, and a sphere with a Follow Path constraint set against this curve?
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Closed 2D Curve
This is probably the most useful situation, as it will quickly create a volume, with (by default) two flat
and parallel surfaces filling the two sides of the extruded “wall”. You can remove one or both of these
faces by disabling the Back and/or Front toggle buttons next to the 3D one.
The optional bevel will always be “right-oriented” here, allowing you to smooth out the “edges” of the
volume.
3D Curve
Here the fact that the curve is closed or not has no importance - you will never get a volume with an
extruded 3D curve, only a wall or ribbon, like with open 2D curves.
However, there is one more feature with 3D curves: the Tilt of the control points (see above). It will make
the ribbon twist around the curve ? to create a M?bius strip, for example!

Advanced Extrusion
These extrusions use one or two additional curve objects, to create very complex organic shapes.
To enable this type of extrusion, you have to type a valid curve object name in the BevOb field of the curve you
are going to use as the “spinal column” of your extrusion. The “bevel” curve will control the cross section of
the extruded object. Whether the BevOb curve is 2D or 3D has no importance, but if it is closed, it will create a
“tube-like” extrusion; otherwise you will get a sort of gutter or slide object...
The object is extruded along the whole length of all internal curves. By default, the width of the extrusion is
constant, but you have two ways to control it, the Radius property of control points, and the “taper” object.
The Radius of the points is set using the Shrink/Fatten Radius transform tool (Alt-S, or Curve ‣ Transform
‣ Shrink/Fatten Radius), or with the Set Radius entry in the Specials menu (W). Here again, you unfortunately
cannot visualize anywhere the Radius of a given control point...
The Radius allows you to directly control the width of the extrusion along the “spinal” curve. As for Tilt (see
above), you can choose the interpolation algorithm used for Bézier curves, in the Radius Interpolation dropdown list of the Curve Tools panel.
But you have another, more precise option: the “taper” object. As for the “bevel” one, you set its name in the
TaperOb field of the main curve - it must be an open curve. The taper curve is evaluated along the local X axis,
using the local Y axis for width control. Note also that:
• The taper is applied independently to all curves of the extruded object.
• Only the first curve in a TaperOb is evaluated, even if you have several separated segments.
• The scaling starts at the first control-point on the left and moves along the curve to the last control-point
on the right.
• Negative scaling, (negative local Y on the taper curve) is possible as well. However, rendering artifacts
may appear.
• It scales the width of normal extrusions based on evaluating the taper curve, which means sharp corners
on the taper curve will not be easily visible. You’ll have to heavily level up the resolution (DefResolU)
of the base curve.
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• With closed curves, the taper curve in TaperOb acts along the whole curve (perimeter of the object), not
just the length of the object, and varies the extrusion depth. In these cases, you want the relative height
of the TaperOb Taper curve at both ends to be the same, so that the cyclic point (the place where the
endpoint of the curve connects to the beginning) is a smooth transition.
Last but not least, with 3D “spinal” curves, the Tilt of the control points can control the twisting of the extruded
“bevel” along the curve!

Examples
Let’s taper a simple curve circle extruded object using a taper curve. Add a curve, then exit Edit mode. Add
another one (a closed one, like a circle); call it BevelCurve, and enter its name in the BevOb field of the first
curve (Editing context Curve and Surface panel). We now have a pipe. Add a third curve while in Object mode
and call it TaperCurve. Adjust the left control-point by raising it up about 5 units.
Now return to the Editing context, and edit the first curve’s TaperOb field in the Curve and Surface panel to
reference the new taper curve which we called TaperCurve. When you hit enter the taper curve is applied
immediately, with the results shown in (Taper extruded curve).

Taper extruded curve.

Taper solid mode.

You can see the taper curve being applied to the extruded object. Notice how the pipe’s volume shrinks to
nothing as the taper curve goes from left to right. If the taper curve went below the local Y axis the pipe’s inside
would become the outside, which would lead to rendering artifacts. Of course as an artist that may be what you
are looking for!

Taper example 1.

In (Taper example 1) you can clearly see the effect the left taper curve has on the right curve object. Here the
left taper curve is closer to the object center and that results in a smaller curve object to the right.
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Taper example 2.

In (Taper example 2) a control point in the taper curve to the left is moved away from the center and that gives a
wider result to the curve object on the right.

Taper example 3.

In (Taper example 3), we see the use of a more irregular taper curve applied to a curve circle.
TODO: add some “bevel” extrusion with Tilt examples.
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Surfaces

Surface.

Curves are 2D objects, and surfaces are their 3D extension. Note however that in Bforartists, you only have
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NURBS surfaces, no Bézier (you have the Bezier knot type, though; see below), nor polygonal (but for these,
you have meshes!). Even though curves and surfaces share the same object type (with texts also...), they are not
the same thing; for example, you cannot have in the same object both curves and surfaces.
As surfaces are 2D, they have two interpolation axes, U (as for curves) and V. It is important to understand that
you can control the interpolation rules (knot, order, resolution) independently for each of these two dimensions
(the U and V fields for all these settings, of course).
You may ask yourself “but the surface appears to be 3D, why is it only 2D?”. In order to be 3D, the object
needs to have “Volume,” and a surface, even when it is closed, doesn’t have volume; it is infinitely thin. If it
had a volume the surface would have a thickness (its third dimension). Hence, it’s only a 2D object, and has
only two interpolation dimensions or axes or coordinates (if you know a bit of math, think of non-euclidean
geometry - well, surfaces are just non-euclidean 2D planes...). To take a more “real life” example, you can roll a
sheet of paper to create a cylinder; well, even if it “draws” a volume, the sheet itself will remain a (nearly...) 2D
object!
In fact, surfaces are very similar to the results you get when extruding a curve

Finding Surface Tools

Surface Tools.

The panels of the Editing context are the same as for curves, just with fewer options... And as usual, you have
the Select and Surface menus in the 3D view headers, and the Specials (W) pop-up one.

Visualization
There is nearly no difference from NURBS curves, except that the U direction is indicated by yellow grid lines,
and the V one is materialized by pink grid lines, as you can see in (Surface).
You can hide and reveal control points just as with curves.

2
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Surface Structure
Many of the concepts from curves, especially NURBS ones, carry directly over to NURBS surfaces, such as
control points, Order, Weight, Resolution, etc. Here we will just talk about the differences.
It is very important to understand the difference between NURBS curves and NURBS surfaces: the first one has
one dimension, the latter has two. Bforartists internally treats NURBS surfaces and NURBS curves completely
differently. There are several attributes that separate them but the most important is that a NURBS curve has a
single interpolation axis (U) and a NURBS surface has two interpolation axes (U and V).
However, you can have “2D” surfaces made of curves (using the extrusion tools, or, to a lesser extent, the
filling of closed 2D curves. And you can have “1D” curves made of surfaces, like a NURBS surface with only
one row (either in U or V direction) of control points produces only a curve...
Visually you can tell which is which by entering Edit mode and looking at the 3D window’s header: either the
header shows Surface or Curve as one of the menu choices. Also, you can extrude a whole NURBS surface
curve to create a surface, but you can’t with a simple NURBS curve (we talk here about the “standard” Extrude
tool, the one activated with the E shortcut, not the quite-specific curve extrusion tools - yes, I know, it’s not
easy to follow...).

Control Points, Rows and Grid
Control points for NURBS surfaces are the same as for NURBS curves. However, their layout is quite
constraining. The concept of “segment” disappears, replaced by “rows” and the overall “grid”.
A “row” is a set of control points forming one “line” in one interpolation direction (a bit similar to edge loops
for meshes). So you have “U-rows” and “V-rows” in a NURBS surface. The key point is that all rows of a
given type (U or V) have the same number of control points. Each control point belongs to exactly one U-row
and one V-row.
All this forms a “grid”, or “cage”, the shape of which controls the shape of the NURBS surface. A bit like a
lattice ...
This is very important to grasp: you cannot add a single control point to a NURBS surface; you have to add a
whole U- or V-row at once (in practice, you will usually use the Extrude tool, or perhaps the Duplicate one, to
add those...), containing exactly the same number of points as the others. This also means that you will only be
able to “merge” different pieces of surfaces if at least one of their rows match together.

Surface Resolution
Just like NURBS curves, Resolution controls the detail of the surface. The higher the Resolution the more
detailed and smoother the surface is. The lower the Resolution the rougher the surface. However, here you have
two resolution settings, one for each interpolation axis (U and V). Note that unlike with curves, you have only
one resolution (the Resol U and V fields, in the Curve Tools panel)...
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Resolution 1x1.

Resolution 3x3.

(Resolution 1x1) is an example of a surface resolution of 3 for both U and V. (Resolution 3x3 surface) is an
example of a surface resolution of 12 for both U and V.

Resolution panel.

You can adjust the resolution separately for both preview and render, to not slow things down in the viewport,
but still get good render results.

Closed and Open Surfaces
Like curves, surfaces can be closed (cyclical) or open, independently in both directions, allowing you to easily
create a tube, donut or sphere shape, and they can be drawn as “solids” in Edit mode. This makes working with
surfaces quite easy.

Knots
Just like with NURBS curves, NURBS surfaces have two knot vectors, one for each U and V axis. Here again,
they can be one of Uniform, Endpoint, or Bezier, with the same properties as for curves. And as with curves,
only open surfaces (in the relevant direction) are affected by this setting...

Endpoint U.

In (Endpoint U), the U interpolation axis is labeled as U and the V interpolation axis is labeled as V. The U ‘s
interpolation axis has been set to Endpoint and as such the surface now extends to the outer edges from E1 to
E2 along the U interpolation axis.
To cause the surface to extend to all edges you would set the V ‘s axis to Endpoint as well.

Order
One more time, this property is the same as with NURBS Curves; it specifies how much the control points are
taken into account for calculating the curve of the surface shape. For high Orders, (1), the surface pulls away
4
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from the control points, creating a smoother surface - assuming that the Surface Resolution is high enough. For
lowest Orders, (2), the surface follows the control points, creating a surface that tends to follow the grid cage.

Order 2 and order 4 surface.

For illustration purposes, in both (Order 4 surface) and (Order 2 surface), the knot vectors were set to
Endpoint, causing the surface to extend to all edges.
You can set independently the order for each interpolation axis, and like curves, it cannot be lower than 2, and
higher than 6 or the number of control points on the relevant axis.

Weight

Surface Weight 5.

Guess what? Yes, it works exactly like NURBS Curves ! Weight specifies how much each control point “pulls”
on the curve.
In (Surface Weight 5), a single control point, labeled C, has had its Weight set to 5.0 while all others are at their
default of 1. 0. As you can see, that control point pulls the surface towards it.
If all the control points have the same Weight then each effectively cancels each other out. It is the difference in
the weights that cause the surface to move towards or away from a control point.
5

Bforartists Reference Manual - © Copyright - This page is under OCL license

The Weight of any particular control point is visible in the Transform Properties panel (N), in the W field (and
not the Weight field...).

Preset Weights

A sphere surface.

NURBS can create pure shapes such as circles, cylinders, and spheres (note that a Bézier circle is not a pure
circle). To create pure circles, globes, or cylinders, you must set to specific values the weights of the control
points - some of which are provided as presets in the Curve Tools panel (lower right corner). This is not
intuitive, and you should read more on NURBS before trying this.
To create a sphere with 2D surfaces, its the same principle as with a 2D circle - you’ll note that the four
different weights needed for creating a sphere (1.0, 0.707 = sqrt(0.5), 0.354 = sqrt(2)/4, and 0.25).

Primitives
To help get started in creating surfaces there are four preset NURBS surfaces, found in the Add ‣ Surface
menu: NURBS Surface, NURBS Tube, NURBS Sphere and NURBS Torus.

NURBS surface primitives.

There are also two preset NURBS surface curves (with only one control point on each V-row): NURBS Curve
and NURBS Circle.
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NURBS curve primitives.

Note how a circle NURBS surface is never filled, unlike its “real” curve counterpart...

Surface Selection
Surface selection in Edit mode is very similar to NURBS curve selection. The basic tools are the same as with
meshes, so you can select a simple control point with a LMB -click, add to current selection with Shift-LMB
-clicks, Border-select, and so on.

Select Menu
The Select menu (3D view headers) is even simpler than for curves...
All these options have the same meaning and behavior as in Object mode (and the specificities of
Border Select in Edit mode have already been discussed here).

frame[left].

Every Nth
Reference
Mode: Edit mode
Menu: Select ‣ Every Nth

This is the same option as for curve selection. However, the behavior of the N (“selection step”) parameter in
the 2D of a NURBS surface “cage” seems quite difficult to understand...
7
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Control Point Row
Reference
Mode: Edit mode
Menu: Select ‣ Control Point Row
This option works a bit like edge loop selection for meshes, inasmuch it selects a whole row of control points,
based on the active (the last selected) one. The first time you press Shift-R, the V-row passing through
(containing) the active point will be added to the current selection. If you use again this shortcut, you will
toggle between the U- and V-row of this point, removing everything else from the selection.

More and Less
Reference
Mode: Edit mode
Menu: Select ‣ More/Less
These two options are complementary and very similar to those for meshes. Their purpose, based on current
selected control points, is to reduce or enlarge this selection.
The algorithm is the same as with meshes:
More
for each selected control point, select all its linked points (i.e. two, three or four).
Less
for each selected control point, if all points linked to this point are selected, keep it selected. For all other
selected control points, de-select them.
This implies two points:
• First, when all control points of a surface are selected, nothing will happen (as for Less, all linked points
are always selected, and of course, More can’t add any). Conversely, the same goes when no control
point is selected.
• Second, these tools will never “go outside” of a surface (they will never “jump” to another surface in the
same object).

Surface Editing
Surface editing has even fewer tools and options than its curve counterpart - and has many common points with
it... So this page covers (or tries to cover) all the subjects, from the basics of surface editing to more advanced
topics, like retopology.

Basic Surface Editing (translation, rotation, scale)
Reference
Mode: Edit mode
Menu: Surface ‣ Transform ‣ Grab/Move, Rotate, Scale, ...
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Once you have a selection of one or more control points, you can grab/move, rotate or scale them, like many
other things in Bforartists, as described in the Manipulation in 3D Space section.
You also have in Edit mode an extra option when using these basic manipulations: the proportional editing.

Advanced Transform Tools
Reference
Mode: Edit mode
Menu: Surface ‣ Transform
The To Sphere, Shear, Warp and Push/Pull transform tools are described in the Mesh Deforming section.
Surfaces have no specific transform tools.

NURBS Control Points Settings
Reference
Mode: Edit mode
Panel: Curve Tools (Editing context), and Transform Properties
We saw in a previous page that NURBS control points have a weight, which is the influence of this point on the
surface. You set it either using the big Set Weight button in the Curve Tools panel (after having defined the
weight in the numeric field to the right), or by directly typing a value in the W numeric field of the Transform
Properties panel.

Adding or Extruding
Reference
Mode: Edit mode
Menu: Surface ‣ Extrude
Unlike meshes or curves, you cannot generally directly add new control points to a surface (with Ctrl-LMB
clicks), as you can only extend a surface by adding a whole U- or V-row at once. The only exception is when
working on a NURBS surface curve, i.e. a surface with only one control point on each U- or V-row. In this
special case, all works exactly as with curves.
Most of the time, only extrusion is available. As usual, once the tool is activated the extrusion happens
immediately and you are placed into Grab mode, ready to drag the new extruded surface to its destination.
There are two things very important to understand:
• Surfaces are 2D objects - so you can’t extrude anything inside a surface (e.g. “inner” row); it wouldn’t
make any sense!
• The control “grid” must remain “squarish”, which means that you can only extrude a whole row, not
parts of rows here and there...
To summarize, the Extrude tool will only work when one and only one whole border row is selected - otherwise
9
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nothing happens.
As for curves, you cannot create a new surface in your object out of nowhere, by just Ctrl-LMB -clicking with
nothing selected. However, unlike for curves, there is no “cut” option allowing you to separate a surface into
several parts, so you only can create a new surface by copying (Duplication) an existing one (Shift-D), or
adding a new one (Add menu...).

Examples
Images (Selecting control-point) to (Complete) show a typical extrusion along the side of a surface.

You can continue this process of extruding - or adding - new surface sections until you have reached the final
shape for your model.

Opening or Closing a Surface
Reference
Mode: Edit mode
Menu: Surface ‣ Toggle Cyclic
As in curves, surfaces can be closed (cyclic) or open. However, as surfaces are 2D, you can control this
property independently along the U and V axes.
To toggle the cyclic property of a surface along one axis, use C and choose either cyclic U or cyclic V from the
Toggle pop-up menu. The corresponding surface’s outer edges will join together to form a “closed” surface.
Note

10
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Inner and Outer
Surfaces have an “inner” and “outer” face, the first being black whereas the latter is correctly shaded - there
does not seem to be any “double sided” shading option for surfaces...). When you close a surface in one or two
directions, you might get an entirely black object! In this case, just Switch Direction of your surface...

Duplication
Reference
Mode: Edit mode
Menu: Curve ‣ Duplicate
Well, as with meshes and curves, this command just duplicates the selection. As usual, the copy is selected and
placed in Grab mode, so you can move it to another place.
However, with surfaces there are some selections that can’t be duplicated, in which case they will just be placed
in Grab mode... In fact, only selections forming a single valid sub-grid are copyable; let’s see this in practice:
• You can copy a single control point. From it, you will be able to “extrude” a “surface curve” along the U
axis, and then extrude this unique U-row along the V axis to create a real new surface.
• You can copy a single continuous part of a row (or a whole row, of course). This will give you a new Urow, even if you selected (part of) a V-row!
• You can copy a single whole sub-grid.
Note that trying to duplicate several valid “sub-grids” (even being single points) at once won’t work; you’ll
have to do it one after the other...

Deleting Elements
Reference
Mode: Edit mode
Menu: Curve ‣ Delete...
The Erase pop-up menu of surfaces offers you two options:
Selected
This will delete the selected rows, without breaking the surface (i.e. the adjacent rows will be directly
linked, joined, once the intermediary ones are deleted). The selection must abide by the following rules:
• Whole rows, and only whole rows must be selected.
• Only rows along the same axis must be selected (i.e. you can’t delete both U- and V-rows at the
same time).
Also remember that NURBS order cannot be higher than its number of control points in a given axis, so it
might decrease when you delete some control points... Of course, when only one row remains, the surface
becomes a “surface curve”; when only one point remains, there is no more visible surface; and when all
points are deleted, the surface itself is deleted.
11
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All
As with meshes or curves, this deletes everything in the object!

Example

Before and after

In (Before) a row of control points has been selected by initially selecting the control point labeled A and using
Shift-R to select the remaining control points. Then, using the Delete Menu (X), the selected row of control
points is erased, resulting in (After).

Joining or Merging Surfaces
Reference
Mode: Edit mode
Menu: Surface ‣ Make Segment
Just like curves, merging two surfaces requires that a single edge, a border row of control points, from two
separate surfaces are selected. This means that the surfaces must be part of the same object. For example, you
can’t join two surfaces while in Object mode - but you can of course, as with any objects of the same type, join
two or more Surface objects into one object. They just won’t be “linked” or merged in a single one... Yes, it’s a
bit confusing!
This command is equivalent to creating edges or F aces for meshes (hence its shortcut), and so it only works in
Edit mode. The selection must contains only border rows of the same resolution (with the same number of
control points), else Bforartists will try to do its best to guess what to merge with what, or the merge will fail
(either silently, or stating that Resolution doesn't match if rows with different number of points are
selected, or that there is Too few selections to merge if you only selected points in one surface...).
So to avoid problems, you should always only select border rows with the same number of points... Note that
you can join a border U-row of one surface with a border V-row of another one, Bforartists will automatically
“invert” the axis of one surface for them to match correctly.
NURBS surface curves are often used to create objects like hulls, as they define cross sections all along the
object, and you just have to “skin” them as described above to get a nice, smooth and harmonious shape.
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Examples
(Joining ready) is an example of two NURBS surface curves, not NURBS curves, in Edit mode, ready to be
joined. (Joining complete) is the result of joining the two curves.

Joining ready.

Subdivision
Reference
Mode: Edit mode
Panel: Curve Tools1 (Editing context)
Menu: Surface ‣ Segments ‣ Subdivide, Specials ‣ Subdivide
Surface subdivision is most simple: using either the Subdivide entry in the Specials menu (W), or the Subdivide
button of the Curve Tools1 panel, you will subdivide once all completely selected grids by subdividing each
“quad” into four smaller ones.
If you apply it to a 1D surface (a “surface curve”), this tool works exactly as with curves.

Spin
Reference
Mode: Edit mode
Panel: Curve Tools1 (Editing context)
This tool is a bit similar to its mesh counterpart - but with less control and options (in fact, there’s none!).
It only works on selected “surfaces” made of one U-row (and not with one V-row), so-called “surface curves”,
by “extruding” this “cross section” in a square pattern, automatically adjusting the weights of control points to
get a perfect circular extrusion (this also implies closing the surface along the V axis), following exactly the
same principle as for the NURBS Tube or NURBS Donut primitives.

Switch Direction
Reference
13
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Mode: Edit mode
Menu: Surface ‣ Segments ‣ Switch Direction, Specials ‣ Switch Direction
This command will “reverse” the direction of any curve with at least one selected element (i. e. the start point
will become the end one, and vice versa). Mainly useful when using a curve as path, or the bevel and taper
options...

Conversion
As there are only NURBS surfaces, there is no “internal” conversion here.
However, there is an “external” conversion available, from surface to mesh, that only works in Object mode. It
transforms a Surface object into a Mesh one, using the surface resolutions in both directions to create faces,
edges and vertices.

Misc Editing
You have some of the same options as with meshes, or in Object mode. You can separate a given surface (P),
make other selected objects children of one or three control points (Ctrl-P - note however that parenting to
three control points has a strange behavior with curves...), or add hooks to control some points with other
objects.
The Mirror tool is also available, behaving exactly as with mesh vertices.
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Text
Reference
Mode: Edit mode (Text)
Panel: Curve and Surface, Font and Char (Editing context)
Menu: Add ‣ Text
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Text Examples.

Text objects are exactly what they sound like: they contain some text. They share the same object type as curves
and surfaces, as modern fonts (OpenType, TrueType, etc.) are vectorial, made of curves (generally Béziers).
Bforartists uses a “Font System” to manage mapping “letter codes –> objects representing them in 3D views”.
This implies that not only does the font system have its own built-in font, but it can use external fonts too,
including PostScript Type 1, OpenType and TrueType fonts. And last but not least, it can use any objects
existing in the current .blend file as letters...
Texts in Bender allow you to create/render 2D or 3D text, shaded as you want, with various advanced layout
options (like justifying and frames), as we will see below. By default, letters are just flat filled surfaces, exactly
like any closed 2D curve. But you can of course extrude them... And texts can follow other curves.
Of course, once you are happy with the shape of your text, you can convert it (with Alt-C, in Object mode),
either to a curve, or directly to a mesh, allowing you to use all the powerful features of these types of objects on
it...
(Text Examples) shows some examples of various fonts in action, including the “blue” font that has been
applied to a curve path.

Note
A maximum of 50000 characters is allowed per text object; however, be forewarned that the more characters
a single text object has, the slower the object will respond interactively.
As you can see when you switch between Object and Edit modes, the Font panel remains the same. This
means that its settings can be applied equally in both modes ... and this implies that you cannot apply them to
just a part of the mesh. So font, size, and so on, are common to all letters in a Text object. There is just one
exception: the Bold / Italic buttons control properties specific to each letter (this is a way to use up to four
different fonts in a text).
For optimum resource usage, only characters that are being used consume memory (rather than the entire
2
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character set).

Editing Text
Reference
Mode: Edit mode

Text in Edit mode.

Editing text is quite different from other object types in Bforartists, and happens mainly in two areas. First, the
3D view, of course, where you type your text, and have a few shortcuts, e.g. for applying styles (see Character)
- note however that most Bforartists hotkeys you know in Edit mode do not exist for texts! The second place is
the Button window (Editing context), especially the Font panel.
The menu of the 3D view header has nearly no use, and there is no Specials menu... You have no transform nor
mirror tools, and so on. However, you can apply to texts the same modifiers as for curves.
Editing Text is similar to using a standard text editor but is not as full-featured and has some differences:
Exit Edit mode
Tab doesn’t insert a tab character in the text, but rather enters and exits Edit mode, as with other object
types.
Copy
To copy text to the buffer, use Ctrl-C or the Copy button in the tool shelf.
Cut and Copy
To cut and copy text to the buffer, use Ctrl-X or the Cut button in the tool shelf.
Paste
To paste text from the buffer, use Ctrl-V or the Paste button in the tool shelf.
Delete all text
To completely erase or delete all text, use Ctrl-Backspace.
Home/End
Home and End move the cursor to the beginning and end of a line respectively.
Next/Previous word
To move the cursor on a word’s boundary, use Ctrl-Left or Ctrl-Right.
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The text buffer does not communicate with the desktop. It only works within Bforartists. To insert text from
outside Bforartists, see Inserting Text below.

Inserting Text
You can insert text in three different ways: from the internal text buffer (Editing Text), or from a text file.
To load text from a text file, use the Text ‣ Paste File tool. This will bring up a File Browser window for
navigating to a valid UTF-8 file. As usual, be careful that the file doesn’t have too many characters, as
interactive response will slow down.

Special Characters
Reference
Mode: Edit mode
Menu: Text ‣ Special Characters

If you need special characters (such as accented chars, which aren’t on your keyboard) you can produce many
of them using a combination of two other characters. To do so, type the main char, press Alt-Backspace,
and then press the desired “modifier” to produce the special character. Some examples are given below:
A, Altã
Backspace, ~

A, Altá
Backspace, '

A, Altà
Backspace, `

A, Altå
Backspace, O

E, Altë
Backspace, "

O, Altø
Backspace, /

Convert Text to Text Object

Using an existing text-block, you can convert it to an object from the text editor’s header, select Edit ‣ Text to
3D Object, One Object or One Object per Line depending on your needs.
It is also possible to paste from the clipboard or a file from the Edit menu, while editing 3D Text.

3D Mesh
It is possible to convert a Text Object to a 3D Mesh object. This can be useful so that you may edit the vertices
in Edit Mode, but you will lose the ability to edit the text itself. To do this, go to Object Mode and select your
Text Object. Press Alt-C and select Mesh From Curve/Meta/Surf/Text. Now you can return to Edit Mode and
4
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manually edit the vertices. They are usually a bit messy, so it may be useful to use a Limited Dissolve deletion
or Remesh Object Modifier at a low threshold to clean up your mesh.

left normal text, right the made text object.

Text Selection

Text in Edit mode.

In Edit mode, your text has a white cursor, and as in any text editor, it determines where new chars will be
inserted! You move this cursor with the arrow keys or PageUp / PageDown and Home / End keys.
Hold Shift while using the arrow keys to select a part of the text. You can use it to specify different materials,
the normal/bold/italic state, and not much more...

Formatting Text
Fonts
Reference
Mode: Edit mode
Panel: Font (Editing context)

The Font panel has several options for changing the look of characters.

5
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Loading and Changing Fonts

Loading a Type 1 font file.

Bforartists comes with a built-in font by default and is displayed in each of the four font style choosers. The
built-in font is always present and shows in this list as Bfont. The first icon contains a drop-down list
displaying currently loaded fonts. Select one for each font style.
To load a different Font, click one of the Load buttons in the Font panel and navigate to a valid font. The File
Browser window will give all valid fonts a capital F icon, as seen in Loading a Type 1 font file.
Note
Unix note
Fonts are typically located under /usr/lib/fonts, or some variant like /usr/lib/X11/fonts, but
not always. They may be in other locations as well, such as /usr/share/local or
/usr/local/share, and possibly related sub-trees.
If you select a font that Bforartists can’t understand, you will get the error Not a valid font.
Remember the same font will be applied to all chars with same style in a text, but that a separate font is
required for each style. For example, you will need to load an Italics font in order to make characters or words
italic. Once the font is loaded you can apply that font “Style” to the selected characters or the whole object. In
all, you would need to load a minimum of four different types of fonts to represent each style (Normal, Italics,
Bold, Bold-Italics).
It is important to understand that Bforartists does not care what font you load for “normal”, “bold”, etc., styles.
This is how you can have up to four different fonts in use in the same text - but you have to choose between
different styles of a same font, or different fonts. Bforartists has a number of typographic controls for changing
the style and layout of text, found in the Font panel.

Size and Shear
Size
Controls the size of the whole text (no way to control each char size independently). Note however that
chars with different fonts (different styles, see below) might have different visible sizes.
6
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shear: ‘Bforartists’ has a shear value of 1, ‘2.59’ a shear value of 0

Shear
Controls the inclination of the whole text. Even if this seems similar to italics style, this is not the same
thing !

Objects as Fonts
You can also “create” your own “font” inside Bforartists! This is quite a complex process, so let’s detail it:
• First, you must create your chars. Each char is an object of any type (mesh, curve, meta...). They all
must have a name following the schema: common prefix followed by the char name (e.g. ft.a,
ft.b, etc.).
• Then, for the Text object, you must enable the Dupli Verts button (Object context - Anim Settings panel).
• Back in Editing context, in the Font panel, fill the Ob Family field with the common prefix of your
“font” objects.
Now, each time a char in your text matches the suffix part of a “font” object’s name, this object is duplicated on
this char. The original chars remain visible. The objects are duplicated so that their center is positioned at the
lower right corner of the corresponding chars.

Text on Curve
With the curve modifier you can let text follow a curve.

Text on curve.

In (Text on curve) you can see a text deformed by a curve (a 2D Bézier circle).
To apply the curve modifier, the text object first has to be converted to a mesh, using Alt-C and click mesh.
Note
There is also a Text on Curve feature, but the curve modifier offers more options.
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Underline
Underline
Toggled with the Underline button before typing. Text can also be set to Underlined by selecting it then
using the Underline button in the Tool Shelf.
Position
This allows you to shift vertically the position of the underline.
Thickness
This controls the thickness of the underline.

check a character option to, for example, type bold text

Character

Bold text.

Bold
Toggled with the Bold button before typing. Text can also be set to Bold by selecting it then using the
Bold button in the Tool Shelf.
8

Bforartists Reference Manual - © Copyright - This page is under OCL license

Italics
Toggled with the Italic button before typing. Text can also be set to Italic by selecting it then using the
Italic button in the Tool Shelf.
Underline
Enables underlining, as controlled by the Underline settings above.
Small Caps
type small capital text.
Bforartists’s Bold and Italic buttons don’t work the same way as other applications, as they also serve as
placeholders for you to load up other fonts manually, which get applied when you define the corresponding
style; see Fonts.
To apply the Bold/Italics/Underline attribute to a set of characters, you either turn on Bold / Italics / Underline
prior to typing characters, or highlight (select) first and then toggle Bold/Italics/Underline.

Setting Case
You can change the text case by selecting it then clicking the To Upper or To Lower in the tool shelf.
Enable the Small Caps option to type characters as small caps.
The size of the Small Caps can be changed with the Small Caps Scale setting. Note that the Small Caps Scale is
applied the same to all Small Caps formatted characters.

Paragraph
The Paragraph Panel has settings for the alignment and spacing of text.

the paragraph tab

Align
Left
Aligns text to left of frames when using them, else uses the center point of the Text object as the starting
point of the text (which grows to the right).
Center
Centers text in the frames when using them, else uses the center point of the Text object as the mid-point
of the text (which grows equally to the left and right).
Right
Aligns text to right of frames when using them, else uses the center point of the Text object as the ending
point of the text (which grows to the left).
Justify
Only flushes a line when it is terminated by a wordwrap (not by Return), it uses whitespace instead of
character spacing (kerning) to fill lines.
9
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Flush
Always flushes the line, even when it’s still being entered; it uses character spacing (kerning) to fill lines.
Both Justify and Flush only work within frames.

Spacing
Character
A factor by which space between each character is scaled in width
Word
A factor by which whitespace between words is scaled in width. You can also control it by pressing AltLeft or Alt-Right to decrease/increase spacing by steps of 0.1.
Line
A factor by which the vertical space between lines is scaled.

Offset
X offset and Y offset
Well, these settings control the X and Y offset of the text, regarding its “normal” positioning. Note that
with frames (see Text Boxes), it applies to all frames’ content...

Shape
Reference
Mode: Object or Edit modes
Panel: Curve and Surface (Editing context)

As you can see in the Curve and Surface panel, texts have most of the same options as curves.

Resolution
Preview, Render resolution. See curve resolution.

the shape settings

Fast Editing
disables curve filling while in edit mode.
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Fill
The fill options control how the text curves are filled in when text is Extruded or Beveled in the Geometry
Panel.
Front
Fills in the front side of the surface.
Back
Fills in the back side of the surface.
Fill Deformed
Fills the curves after applying shape keys and modifiers.

Textures

Texture Settings

Use UV for Mapping
Use UV values as generated texture coordinates.
Auto Texture Space
Adjusts the active object’s texture space automatically when transforming object.

Geometry
Text objects have all the curves extrusion features.

Text Editing
Text Boxes
Reference
Mode: Object or Edit modes
Panel: Font (Editing context)
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Text frame.

Text “Boxes” allow you to distribute the text amongst rectangular areas within a single text object. An arbitrary
number of freely positionable and re-sizable text frames are allowed per text object.
Text flows continuously from the lowest-numbered frame to the highest-numbered frame with text inside each
frame word-wrapped. Text flows between frames when a lower-numbered frame can’t fit any more text. If the
last frame is reached, text overflows out of it.
Text frames are very similar to the concept of frames from a desktop publishing application, like Scribus. You
use frames to control the placement and flow of text.
Frames are controlled in the Text Boxes panel.

Frame size
By default the first frame for a new text object, and any additional frames, has a size of zero for both Width and
Height, which means the frame is initially not visible.
Frames with a width of 0.0 are ignored completely during text flow (no wordwrap happens), and frames with a
height of 0.0 flow forever (no flowing to the next text frame).
In order for the frame to become visible, the frame’s Width must be greater than 0.0.
Note
Technically the height is never actually 0.0 because the font itself always contributes height.

Frame width.

(Frame width) is a text object with a width of 5.0. And because the frame width is greater than 0.0 it is now
visible and is drawn in the active theme color as a dashed rectangle. The text has overflowed because the text
has reached the end of the last frame, the default frame.

Adding/Deleting a Frame
To add a frame click the Add Textbox button on the Text Boxes panel. A new frame is inserted just after (in text
flow order) the current one, with its attributes (position and size). Be sure to modify the offset for the new
frame in the X and/or Y fields. Just an X modification will create a new column.
To delete the current frame, click the Delete button. Any text in higher frames will be re-flowed downward
into lower frames.
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Example: Text Flow

wrapping

With two or more frames you can organize text to a finer degree. For example, create a text object and enter
Bforartists is super duper. This text object has a frame; it just isn’t visible because its Width is 0.0.
Set the width to 5.0. The frame is now visible and text is wrapping according to the new width, as shown in
(Text 2). Notice that the text has overflowed out of the frame. This is because the text has reached the end of the
last frame, which just happens to be the default/initial frame.

text flowing from box 1 to box 2

When we add another frame and set its width and height, the text will flow into the new frame.

Example: Multiple columns

Text 5.

To create two columns of text just create a text object and adjust the initial frame’s Width and Height to your
requirements, then insert a new frame. The new frame will have the same size as the initial frame. Set the X
position to something greater or less than the width of the initial frame; see (Text 5).

Assigning Materials
Reference
Mode: Edit mode
Panel: Link and Materials (Editing context)
13
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Each character can have a different Material index in order to have different materials on different characters.
You can assign indices either as you type, or after by selecting blocks of text and clicking on the Assign button
in the Materials panel.

Red Green Blue.

For example, to create (Red Green Blue) you would need to create three separate materials and three separate
material indices. Each word would be assigned a Material index by selecting the characters for each word and
clicking the Assign button. (Red Green Blue) is still one single Text object.
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Metas
Reference
Mode: Object or Edit modes
Menu: Add ‣ Meta

Meta objects are implicit surfaces, meaning that they are not explicitly defined by vertices (as meshes are) or
control points (as surfaces are): they exist procedurally. Meta objects are literally mathematical formulas that
are calculated on-the-fly by Blender.
A very distinct visual characteristic of metas is that they are fluid mercurial, or clay-like forms that have a
“rounded” shape. Furthermore, when two meta objects get close to one another, they begin to interact with one
another. They “blend” or “merge”, as water droplets do, especially in zero-g (which, by the way, makes them
very handy for modeling streams of water when you don’t want to do a fluid simulation). If they subsequently
move away from one another, they restore their original shape.
Each of these is defined by its own underlying mathematical structure (Technical Details), and you can at any
time switch between them using the Active Element panel.
Typically Meta objects are used for special effects or as a basis for modeling. For example, you could use a
collection of metas to form the initial shape of your model and then convert it to another object type (well, only
meshes are available...) for further modeling. Meta objects are also very efficient for ray-tracing.
Note that Meta objects have a slightly different behavior in Object mode.
1
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Primitives
There are five predefined meta “primitives” (or configurations) available in the Add ‣ Meta sub-menu:
Meta Ball
adds a meta with a point underlying structure.
Meta Tube
adds a meta with a line segment underlying structure.
Meta Plane
adds a meta with a planar underlying structure.
Meta Ellipsoid
adds a meta with an ellipsoidal underlying structure.
Meta Cube
adds a meta with a volumetric cubic underlying structure.

Visualization
In Object mode, the calculated mesh is shown, along with a black “selection ring” (becoming pink when
selected).

Meta Ball example.

In Edit mode (Meta Ball example), a meta is drawn as a mesh (either shaded or as black wireframe, but without
any vertex of course), with two colored circles: a red one for selection (pink when selected), and a green one for
a direct control of the meta’s stiffness (light green when active). Note that except for the Scale (S)
transformation, having the green circle highlighted is equivalent to having the red one.

Meta Ball Options
All Meta objects in a scene interact with each other. The settings in the MetaBall section apply to all meta
objects. In Edit mode, the Active Element panel appears for editing individual meta elements.

2
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global meta properties.

individual meta properties.

Resolution
The Resolution controls the resolution of the resultant mesh as generated by the
Meta
object.
View
The 3D View resolution of the generated mesh. The range is from 0.05 (finest) to 1.0 (coarsest).
Render
The rendered resolution of the generated mesh. The range is from 0.05 (finest) to 1.0 (coarsest).
One way to see the underlying mathematical structure is to lower the Resolution, increase the Threshold and set
the Stiffness (see below) a fraction above the Threshold. (Underlying structure) is a (Meta cube) with the above
mentioned configuration applied as follows: Resolution of 0.410, Threshold of 5.0 and Stiffness a fraction above
at 5.01.

Left: Underlying structure, Right: the shape.

You can clearly see the underlying cubic structure that gives the meta cube its shape.

3
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Threshold (Influence)
Reference
Mode: Object or Edit modes
Panel: MetaBall (Editing context)

Threshold defines how much a meta’s surface “influences” other metas. It controls the field level at which the
surface is computed. The setting is global to a group of Meta objects. As the threshold increases, the influence
that each meta has on each other increases.
There are two types of influence: positive or negative. The type can be toggled on the Active Element panel
while in Edit mode, using the Negative button. You could think of positive as attraction and negative as
repulsion of meshes. A negative meta will push away or repel the meshes of positive Meta objects.

Positive.

A positive influence is defined as an attraction, meaning the meshes will stretch towards each other as the rings
of influence intersect. (Positive) shows two meta balls’ rings of influence intersecting with a positive influence.
Notice how the meshes have pulled towards one another. The area circled in white shows the green influence
rings intersecting.

Update
While transforming metas (grab/move, scale, etc.), you have four “modes” of visualization, located in the
Update buttons group of the MetaBall panel:
Always
fully draw the meta during transformations.
Half Res
During transformations, draw the meta at half its Wiresize resolution.
Fast
Do not show meta mesh during transformations.
Never
Never show meta mesh (not a very recommended option, as the meta is only visible at render time!).
4
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This should help you if you experience difficulties (metas are quite compute-intensive...), but with modern
computers, this shouldn’t happen, unless you use many metas, or very high resolutions...

Meta Structure

Technical Details
A more formal definition of a meta object can be given as a directing structure which can be seen as the source
of a static field. The field can be either positive or negative and hence the field generated by neighboring
directing structures can attract or repel.
The implicit surface is defined as the surface where the 3D field generated by all the directing structures assume
a given value. For example a meta ball, whose directing structure is a point, generates an isotropic (i.e. identical
in all directions) field around it and the surfaces at constant field value are spheres centered at the directing
point.
Meta objects are nothing more than mathematical formulae that perform logical operations on one another
(AND, OR), and that can be added and subtracted from each other. This method is also called Constructive
Solid Geometry (CSG). Because of its mathematical nature, CSG uses little memory, but requires lots of
processing power to compute.

Underlying Structure
Reference
Mode: Edit mode
Panel: MetaBall tools (Editing context), Transform Properties

Bforartistshas five types of metas, each determined by its underlying (or directing) structure. In Edit mode, you
can change this structure, either using the relevant buttons in the MetaBall tools panel, or the drop-down list in
the Transform Properties panel (N). Depending on the structure, you might have additional parameters, located
in both Transform Properties and MetaBall tools panels.
Ball (point, zero-dimensional structure)
This is the simplest meta, without any additional setting. As it is just a point, it generates an isotropic
field, yielding a spherical surface (this is why it is called Meta Ball or Ball in Blender).
Tube (straight line, uni-dimensional structure)
This is a meta which surface is generated by the field produced by a straight line of a given length. This
gives a cylindrical surface, with rounded closed ends. It has one additional parameter:
dx
The length of the line (and hence of the tube - defaults to 1.0).
Plane (rectangular plane, bi-dimensional structure)
This is a meta which surface is generated by the field produced by a rectangular plane. This gives a
parallelepipedal surface, with a fixed thickness, and rounded borders. It has two additional parameters:
dx, dy
5
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The length, width of the rectangle (defaults to 1.0).
Note that by default, the plane is a square.
Elipsoid (ellipsoidal volume, tri-dimensional structure)
This is a meta which surface is generated by the field produced by an ellipsoidal volume. This gives an
ellipsoidal surface. It has three additional parameters:
dx, dy, dz
The length, width, height of the ellipsoid (defaults to 1.0).
Note that by default, the volume is a sphere, producing a spherical meta, as the Ball option...
Cube (parallelepipedal volume, tri-dimensional structure)
This is a meta which surface is generated by the field produced by a parallelepipedal volume. This gives a
parallelepipedal surface, with rounded edges. As you might have guessed, it has three additional
parameters:
dx, dy, dz
The length, width, height of the parallelepiped (defaults to 1.0).
Note that by default, the volume is a cube.

the 5 meta primitives.

Editing Metas
When in Edit mode, the Active Element panel appears. These settings apply only to the selected meta element.
6
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the active element panel.

Meta Shape
The Type menu lets you change the shape of the meta object, as explained above.

Stiffness
Together with Threshold, Stiffness controls the influencing range. While the threshold is common to all metas in
the same object (or even the same Object Families), the stiffness is specific to each meta.
Scaling the inner green circle changes the Stiffness value. Stiffness defines how much the meta object is filled.
This essentially defines how sensitive a meta is to being affected by other metas. With a low stiffness, the meta
will begin to deform from further away. A higher value means the meta needs to be close to another one to
begin merging.
When a Meta object comes within “range” of another meta, the two will begin to interact with each other. They
don’t necessarily need to intersect, and depending on the Threshold and Stiffness settings, they most likely
won’t need to. Stiffness is materialized by the green ring
The range is from 0.0 to 10.0. But to be visible, the Stiffness must be slightly larger than the Threshold value.
You can also visually adjust the Stiffness ring by using the RMB to select it and activate Scale mode with S.

7
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Stiffness.

In (Stiffness), the meta ball labeled A, has a smaller Stiffness value than the one labeled B. As you can see, the
green ring radius is different for each of them.

Negative Influence

Negative.

The opposite effect of a positive influence would be a negative influence: the objects repel each other.
(Negative) shows a meta ball and a meta plane where the first is negative and the second, positive. Notice how
the negative meta is not visible: only the surrounding circles appear. This is how Bforartistsindicates that the
object is negative.
Moving the sphere to the plane causes the plane’s mesh to “cave in” or collapse inward. If you move the plane
away from the sphere, the plane’s mesh will restore itself.

8
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To make a meta negative, just select the meta in edit mode, and check negative in the active element panel.

Hiding Elements
As in Object mode, you can hide the selected meta(s), and then reveal what was hidden. This is very handy for
cleaning your views up a bit... Note that the two red and green rings always remain visible in Edit mode, as well
as the select circle (in Object mode...).
To hide the current selection, use H, the Hide toggle button in the MetaBall tools, or the Metaball ‣ Hide
MetaElems ‣ Hide Selected menu option.
To hide everything but the current selection, press Shift-H or use Metaball ‣ Hide MetaElems ‣ Hide
Deselected.
To reveal what was hidden, use Alt-H, or the relevant option in the same Metaball ‣ Hide MetaElems menu.
You can also un-toggle the Hide button in the (MetaBall tools panel).

Deleting Elements
There is no Erase menu for metas, just a confirmation pop-up asking you if you want to delete the selected
metas. Clear and simple!

Conversion

the convert menu

You can only convert metas to meshes, but here you have the option to keep the original Meta object (i.e. create
a new Mesh one, instead of a “real” conversion...). Note that the resolution used for the new mesh is the
Wiresize one, not the Rendersize one.

Object Families
Meta objects have different behavior in Object mode than other object types - they can be “regrouped” into socalled “families”.
9
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A “family” is a way to regroup several meta objects, producing something very similar to having several metas
inside the same object.
A family is defined by the left part of an object’s name (the one before the dot). Remember, an object’s name is
the one in the OB field, in most panels, not the MB field, which is the meta data-block’s name... For example,
the family part of MetaPlane.001 is MetaPlane. Each meta object in the same “family” is associated with
one another as discussed below.

Meta ball base.

Families of metas are controlled by a base Meta object which is identified by an Object name without a right
part. For example, if we have five metas called MetaThing ”, MetaThing.001, MetaThing.002,
MetaThing.003 and MetaThing.004, the base Meta object would be MetaThing.
The base Meta object determines the basis, the resolution, the threshold, and the transformations. It also has the
material and texture area. The base meta is effectively the parent of (or perhaps a better word to use is “the
owner of”) the other metas in the group (i.e. it is as if the other metas were “included” or joined into the base
one).

Examples
(Meta ball base) shows the base meta labeled B. The other two Meta objects are children. Children’s selection
rings are always black, while the group’s mesh is orange. Because the metas are grouped, they form a unified
mesh which can always be selected by selecting the mesh of any meta in the group. For example, in the
example (Meta ball base), only the lower sphere (the parent) has been selected, and you see that both the
parent’s mesh and all of the children’s meshes are now highlighted.

10
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Scaling the “base”.

The base Meta object controls the polygonalization (mesh structure) for the group, and as such, also controls
the polygonalization for the children (non-base) metas. If we transform the base meta, the children’s
polygonalization changes. However, if we transform the children, the polygonalization remains unchanged.

Hints
This discussion of “polygonization” doesn’t mean that the various meshes don’t deform towards or away from
each other (meta objects always influence one another in the usual way, whether or not they are members of the
same family). Rather, it means that the underlying mesh structure changes only when the base object
transforms. For example, if you scale the base, the children’s mesh structure changes. In (Scaling the “base”),
the base has been scaled down, which has the effect of scaling the mesh structure of each of the children. As
you can see, the children’s mesh resolution has increased, while the base decreased. The children did not
change size!
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5.6 Modeling - Empties
Empties....................................................................................................................................................................1
Settings...............................................................................................................................................................1
Usage and functions............................................................................................................................................2

Empties
The “Empty” is a null object. It contains no real Geometry, but can be used as a handle for many purposes.

Settings

Empty Draw Types.

Display
Plain Axes
Draws as six lines, initially with one pointing in each of the +X,-X,+Y,-Y,+Z,and -Z axis directions.
Arrows
Draws as arrows, initially pointing in the positive X,Y, and Z axis directions, each with a label.
Single Arrow
Draws as a single arrow, initially pointing in the +Z axis direction.
Circle
Draws as a circle initially in the XZ plane.
Cube
Draws as a cube, initially aligned to the XYZ axes.
Sphere
Draws as an implied sphere defined by 3 circles. Initially, the circles are aligned, one each, to the X,
Y, and Z axes.
1
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Cone
Draws as a cone, initially pointing in the +Y axis direction.
Image
Empties can display images. This can be used to create reference images, including blueprints or
character sheets to model from, instead of using background images. The image is displayed
regardless of the 3D display mode. The settings are the same as in Background Image Settings
Note
While alpha-images can be used, there is a known limitation with object draw order, where alphas
won’t always draw on top of other objects when unselected.
Size
Controls the local size of the empty. This does not change its scale, but simply resizes the shape.

Usage and functions
Empties can serve as transform handles which cannot be edited and do not render. Empties are important and
useful objects. Some examples of ways to use them include: Parent object for a group of objects
• An Empty can be parented to any number of other objects - This gives the user the ability to control a
group of objects easily, and without affecting a render.
Target for constraints
• An empty can also be used as a target for normal, or bone constraints.
• This gives the user far more control; for instance, a rig can easily be set up to enable a camera to point
towards an empty using the Track to constraint
Array offset
• An empty can be used to offset an array modifier, meaning complex deformations can be achieved by
only moving a single object.

An example of an empty being used to control an array

2
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An example of an empty being used to control the track to constraint

Other common uses.
•
•
•
•

Placeholders
Rigging controls
DOF distances
Reference Images
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Modifiers are added from the Modifiers context of the Properties Editor.
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Modifiers
Modifiers are automatic operations that affect an object in a non-destructive way. With modifiers, you can
perform many effects automatically that would otherwise be too tedious to do manually (such as subdivision
surfaces) and without affecting the base geometry of your object.
They work by changing how an object is displayed and rendered, but not the geometry which you can edit
directly. You can add several modifiers to a single object to form a Modifier Stack and Apply a modifier if you
wish to make its changes permanent.

Modifiers menu

There are four types of modifiers:

Modify
The Modify group of modifiers are tools similar to the Deform Modifiers (see below), but which do not directly
affect the shape of the object; rather they affect some other data, such as vertex groups.
Mesh Cache
Apply animated mesh data (from external file) to a mesh.
UV Project
Project UV coordinates on your mesh.
UV Warp
Dynamically edit the UV coordinates on your mesh.
Vertex Weight
Edit a vertex group of your mesh, in various ways.

Generate
The Generate group of modifiers are constructive tools that either change the general appearance of or
automatically add new geometry to an object.
Array
Create an array out of your basic mesh and similar (repeating) shapes.
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Bevel
Create a bevel on a selected mesh object.
Boolean
Combine/subtract/intersect your mesh with another one.
Build
Assemble your mesh step by step when animating.
Decimate
Reduce the polygon count of your mesh.
Edge Split
Add sharp edges to your mesh.
Mask
Allows you to hide some parts of your mesh.
Mirror
Mirror an object about one of its own axes, so that the resultant mesh is symmetrical.
Multiresolution
Sculpt your mesh at several levels of resolution.
Remesh
Can fix heavily triangulated meshes, and other issues, with careful Threshold adjustments.
Screw
Generate geometry in a helix-pattern from a simple profile. Similar to the Screw Tool in edit mode.
Skin
Automatically generate topology.
Solidify
Give depth to mesh faces.
Subdivision Surface
Subdivides your mesh using Catmull-Clark or Simple algorithms.
Triangulate
Converts all faces to Triangles.
Wireframe
Converts all faces into a wireframe.

Deform
The Deform group of modifiers only change the shape of an object without adding new geometry, and are
available for meshes, and often texts, curves, surfaces and/or lattices.
Armature
Use bones to deform and animate your object.
Cast
Shift the shape of a mesh, surface or lattice to a sphere, cylinder or cuboid.
Curve
Bend your object using a curve as guide.
Displace
Deform your object using a texture.
Hook
Add a hook to your vertice(s) (or control point(s)) to manipulate them from the outside.
Laplacian Smooth
Allows you to reduce noise on a mesh’s surface with minimal changes to its shape.
Laplacian Deform
allows you to pose a mesh while preserving geometric details of the surface.
Lattice
Use a Lattice object to deform your object.
6
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Mesh Deform
Allows you to deform your object by modifying the shape of another mesh, used as a “Mesh Deform
Cage” (like when using a lattice).
Shrinkwrap
Allows you to shrink/wrap your object to/around the surface of a target mesh object.
Simple Deform
Applies some advanced deformations to your object.
Smooth
Smooth the geometry of a mesh. Similar to the Smooth tool in the mesh editing context.
Warp
Warp a mesh by specifying two points the mesh stretches between.
Wave
Deform your object to form (animated) waves.

Simulate
The Simulate group of modifiers activate simulations. In most cases, these modifiers are automatically added to
the modifiers stack whenever a Particle System or Physics simulation is enabled. Their only role is to define the
place in the modifier stack used as base data by the tool they represent. Generally, the attributes of these
modifiers are accessible in separate panels.
Cloth
Simulates the properties of a piece of cloth. It is inserted in the modifier stack when you designate a mesh
as Cloth.
Collision
Simulates a collision between objects.
Dynamic Paint
Makes an object or a particle system paint a material onto another object.
Explode
Blows up your mesh using a particle system.
Fluid
The object is part of a fluid simulation... The modifier added when you designate a mesh as Fluid.
Particle Instance
Makes an object act similar to a particle but using the mesh shape instead.
Particle System
Represents a particle system in the stack, so it is inserted when you add a particle system to the object.
Smoke
Simulates realistic smoke.
Soft Body
The object is soft, elastic... Modifier added when you designate a mesh as Softbody.
Ocean
Quickly creates a realistic, animated ocean.

7

Bforartists Reference Manual - © Copyright - This page is under OCL license

Interface

Panel Layout (Subsurf as an example)

Each modifier has been brought in from a different part of Bforartists, so each has its own unique settings and
special considerations. However, each modifier’s interface has the same basic components, see (Panel Layout
(Subsurf as an example)).
At the top is the panel header. The icons each represent different settings for the modifier (left to right):
Arrow
Collapse modifier to show only the header and not its options.
Icon
A quick visual reference of the modifier’s type.
Name
Every modifier has a unique name per object. Two modifiers on one object must have unique names, but
two modifiers on different objects can have the same name. The default name is based off the modifier
type.
Camera
Toggles visibility of the modifier effect in the render.
Eye
Toggles visibility of the modifier effect in the 3D view.
Box
Displays the modified geometry in edit mode, as well as the original geometry which you can edit.
Triangle
When enabled, the final modified geometry will be shown in edit mode and can be edited directly.
Up arrow
Moves modifier up in the stack.
Down arrow
Moves modifier down in the stack.
Cross
Deletes the modifier.
Reference
The Box and Triangle icons may not be available depending on the type of modifier.

Below the header are two buttons:
Apply
8
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Makes the modifier “real” - converts the object’s geometry to match the applied modifier, and deletes the
modifier.
Copy
Creates a duplicate of the modifier at the bottom of the stack.
Reference
Applying a modifier that is not first in the stack will ignore the stack order and could produce undesired
results.

Below this header, all of the options unique to each modifier will be displayed.

The Stack
Modifiers are a series of non-destructive operations which can be applied on top of an objects geometry. They
can be applied in just about any order the users chooses.
This kind of functionality is often referred to as a “modifier stack” and is also found in several other 3D
applications.
In a modifier stack the order in which modifiers are applied has an effect on the result. Fortunately modifiers
can be rearranged easily by clicking the convenient up and down arrow icons. For example, the image below
shows SubSurf and Mirror modifiers that have switched places.

On the left, the Mirror modifier is the last item in the stack and the result looks like two surfaces. On the right,
the Subsurf modifier is the last item in the stack and the result is a single merged surface.
Modifiers are calculated from top to bottom in the stack. In this example, the desired result (on right) is
achieved by first mirroring the object, and then calculating the subdivision surface.

9
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Example

In this example a simple subdivided cube has been transformed into a rather complex object using a stack of modifiers.

Data Transfer Modifier
The Data Transfer modifier transfers several types of data from one mesh to another. Data types include vertex
groups, UV layers, vertex colors, custom normals...
Transfer works by generating a mapping between source mesh’s items (vertices, edges, etc.) and destination
ones, either on a one-to-one basis, or mapping several source items to a single destination one - interpolated
mapping.

From left to right, a flat-shaded beveled cube, a smooth-shaded beveled cube, and an autosmooth-shaded beveled cube
copying its normals from the reference, flat-shaded cube shown as wire here, to achieve the ‘fake round corners’ effect.

10

Bforartists Reference Manual - © Copyright - This page is under OCL license

Options

Data Transfer modifier.

Source Object
Mesh object to copy data from.
If the button to the right of the field is unset, source and destination geometries are considered in global
space when generating the mapping, otherwise they are evaluated in local space (i.e. as if both object’s
centers were at the same place).
Max Distance
When the icon “finger” button to the right is enabled, this is the maximum distance between source and
destination to get a successful mapping. If a destination item cannot find a source one withing that range,
then it will get no transfered data.
This allows to transfer a small sub-detailed mesh onto a more complete one (e.g. from a “hand” mesh
towards a “full body” one).
Ray Radius
For ray-casting-based mapping methods, the radius of the cast rays. Especially important for 1D and 2D
11
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items (i.e. vertices and edges), without some width there would be nearly no ray-casting matches...
Mix Mode
Controls how destination data are affected:
All
Replaces everything in destination (note that Mix Factor is still used).
Above Threshold
Only replaces destination value if it’s above given threshold (Mix Factor). How that threshold is
interpreted depends on data type, note that for boolean values this option fakes a logical AND.
Below Threshold
Only replaces destination value if it’s below given threshold (Mix Factor). How that threshold is
interpreted depends on data type, note that for boolean values this option fakes a logical OR.
Mix, Add, Subtract, Multiply
Apply that operation, using mix factor to control how much of source or destination value to use.
Only available for a few types (vertex groups, vertex colors).
Mix Factor
How much of the transfered data gets mixed into existing one (not supported by all data types).
Vertex Group
Allows per-item fine control of the mix factor. Vertex group influence can be reverted using the small
“arrow” button to the right.
Generate Data Layers
This modifier cannot generate needed data layers itself. Once the set of source data to transfer is selected,
this button shall be used to generate matching destination layers.

Selection of Data to Transfer
To keep the size of the modifier reasonable, the kind of items to be affected must be selected first (vertices,
edges, face corners and/or faces).
Mapping Type
How is generated the mapping between those source and destination items. Each type has its own options,
see Geometry Mapping below for details.
Data Types
The left column of toggle buttons, to select which data types to transfer.
Multi-layers Data Types Options
In those cases (vertex groups, vertex colors, UVs), one can select which source layers to transfer (usually,
either all of them, or a single specified one), and how to affect destination (either by matching names,
matching order/position, or, if a single source is selected, by specifying manually destination layer).
Islands Handling Refinement
This setting only affects UV transfer currently. It allows to avoid a given destination face to get UV
coordinates from different source UV islands. Keeping it at 0.0 means no island handling at all. Typically,
small values like 0.02 are enough to get good results, but if you are mapping from a very high poly source
towards a very low poly destination, you may have to raise it quite significantly.

Usage
First key thing to keep in mind when using this modifier is that it will not create destination data layers.
Generate Data Layers button shall always be used for this purpose, once set of source data to transfer is
selected. It should also be well understood that creating those data layers on destination mesh is not part of the
modifier stack, which means e.g. that they will remain even once the modifier is deleted, or if source data
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selection is modified.

Geometry Mapping
Geometry mapping is the process by which a given destination vertex/edge/... knows which part of the source
mesh to get its data from. It is crucial to understand this topic well to get good results with this modifier.
Topology
The simplest option, expects both meshes to have identical number of items, and match them by order
(indices). Useful e.g. between meshes that were identical copies, and got deformed differently.
One-To-One Mappings
Those always select only one source item for each destination one, often based on shortest distance.
Vertices
Nearest Vertex
Uses source’s nearest vertex.
Nearest Edge Vertex
Uses source’s nearest vertex of source’s nearest edge.
Nearest Face Vertex
Uses source’s nearest vertex of source’s nearest face.
Edges
Nearest Vertices
Uses source’s edge which vertices are nearest from destination edge’s vertices.
Nearest Edge
Uses source’s nearest edge (using edge’s midpoints).
Nearest Face Edge
Uses source’s nearest edge of source’s nearest face (using edge’s midpoints).
Face Corners
A face corner is not a real item by itself, it’s some kind of split vertex attached to a specific face.
Hence both vertex (location) and face (normal, ...) aspects are used to match them together.
Nearest Corner and Best Matching Normal
Uses source’s corner having the most similar split normal with destination one, from those
sharing the nearest source’s vertex.
Nearest Corner and Best Matching Face Normal
Uses source’s corner having the most similar face normal with destination one, from those
sharing the nearest source’s vertex.
Nearest Corner of Nearest Face
Uses source’s nearest corner of source’s nearest face.
Faces
Nearest Face
Uses source’s nearest face.
Best Normal-Matching:
Uses source’s face which normal is most similar with destination one.
Interpolated Mappings
Those use several source items for each destination one, interpolating their data during the transfer.
Vertices
Nearest Edge Interpolated
Uses nearest point on nearest source’s edge, interpolates data from both source edge’s
13
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vertices.
Nearest Face Interpolated
Uses nearest point on nearest source’s face, interpolates data from all that source face’s
vertices.
Projected Face Interpolated
Uses point of face on source hit by projection of destination vertex along its own normal,
interpolates data from all that source face’s vertices.
Edges
Projected Edge Interpolated
This is a sampling process. Several rays are cast from along the destination’s edge
(interpolating both edge’s vertex normals), and if enough of them hit a source’s edge, all hit
source edges’ data are interpolated into destination one.
Face Corners
A face corner is not a real item by itself, it’s some kind of split vertex attached to a specific face.
Hence both vertex (location) and face (normal, ...) aspects are used to match them together.
Nearest Face Interpolated
Uses nearest point of nearest source’s face, interpolates data from all that source face’s
corners.
Projected Face Interpolated
Uses point of face on source hit by projection of destination corner along its own normal,
interpolates data from all that source face’s corners.
Faces
Projected Face Interpolated
This is a sampling process. Several rays are cast from the whole destination’s face (along its
own normal), and if enough of them hit a source’s face, all hit source faces’ data are
interpolated into destination one.

Mesh Cache Modifier
The Mesh Cache modifier is used so animated mesh data can be applied to a mesh and played back, deforming
the mesh.
This works in a similar way to shape-keys but is aimed at playing back external files and is often used for
interchange between applications.
When using this modifier, the vertex locations are overwritten.
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Options

Mesh Cache modifier

Format
The input file format (currently MDD and PC2 are supported).
File Path
Path to the cache file.

Evaluation:
Influence
Factor to adjust the influence of the modifiers deformation, useful for blending in/out from the cache data.
Deform Mode
This setting defaults to ‘Overwrite’ which will replace the vertex locations with those in the cache file.
However you may want to use shape-keys, for example, and mix them with the mesh-cache. In this case
you can select the ‘Deform’ option which integrates deformations with the mesh-cache result.
Note
This feature is limited to making smaller, isolated edits and won’t work for larger changes such as re-
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posing limbs

Interpolation
None or Linear which will blend between frames; use linear when the frames in the cache file don’t match
up exactly with the frames in the blend file.

Time Mapping:
Time Mode
Select how time is calculated.
Frame
Allows you to control the frames, which will ignore timing data in the file but is often
useful since it gives simple control.
Time
Evaluates time in seconds, taking into account timing information from the file (offset
and frame-times).
Factor
Evaluates the entire animation as a value from [0 - 1].
Play Mode
Select how playback operates.
Scene
Use the current frame from the scene to control playback.
Frame Start
Play the cache starting from this frame.
Frame Scale
Scale time by this factor (applied after the start value).
Custom
Control animation timing manually.
Evaluation Value
Property used for animation time, this gives more control of timing - typically this
value will be animated.
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Axis Mapping:
Forward/Up Axis
The axis for forward and up used in the source file. Often different applications have different
axis defaults for up/down front/back, so it’s common to have to switch these on import.
Flip Axis
In rare cases you may also need to flip the coordinates on an axis.

Hints
• Both MDD and PC2 depend on the vertex order on the mesh remaining unchanged; this is a limitation
with the method used so take care not to add/remove vertices once this modifier is used.

Array Modifier
The Array modifier creates an array of copies of the base object, with each copy being offset from the previous
one in any of a number of possible ways. Vertices in adjacent copies can be merged if they are nearby, allowing
smooth subsurf frameworks to be generated.
This modifier can be useful when combined with tileable meshes for quickly developing large scenes. It is also
useful for creating complex repetitive shapes.
Multiple array modifiers may be active for an object at the same time (e.g. to create complex three dimensional
constructs).

Options
Fit Type menu
Controls how the length of the array is determined. There are three
choices, activating respectively the display of the Curve, Length or Count
settings explained below:.
Fit Curve
Generates enough copies to fit within the length of the curve object
specified in Curve.
Fit Length
Generates enough copies to fit within the fixed length given by
Length.
Fixed Count
Generates the number of copies specified in Count.
Curve
The Curve object to use for Fit Curve.
Length
The length to use for Fit Length.
Count
The number of duplicates to use for Fixed Count.
17
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Note
• Both Fit Curve and Fit Length use the local coordinate system size of the base object, which means
that scaling the base object in Object mode will not change the number of copies generated by the
Array modifier.
• Fit Length uses the local coordinate system length of the curve, which means that scaling the curve in
Object mode will not change the number of copies generated by the Array modifier.
• Applying the scale with Ctrl-A can be useful for each one.

Constant Offset, X, Y, Z
Adds a constant translation component to the duplicate object’s offset. X, Y and Z constant components
can be specified.
Relative Offset, X, Y, Z

Relative offset example.

Adds a translation equal to the object’s bounding box size along each axis, multiplied by a scaling factor,
to the offset. X, Y and Z scaling factors can be specified.
Object Offset

Object offset example.

Adds a transformation taken from an object (relative to the current object) to the offset. It is good practice
to use an Empty object centered or near to the initial object. E.g. by rotating this Empty a circle or helix
of objects can be created.
Merge
If enabled, vertices in each copy will be merged with vertices in the next copy that are within the given
Distance.
First Last
If enabled and Merge is enabled, vertices in the first copy will be merged with vertices in the last copy
(this is useful for circular objects).
First Last merge example.
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Subsurf discontinuity caused by
not merging vertices between first
and last copies (First Last off).
Distance
Controls the merge distance for Merge.
Start Cap / End Cap

Subsurf discontinuity eliminated
by merging vertices between first
and last copies (First Last on).

This allows either endpoints of the array to have a different mesh subsisted.
For the start: as if it was in position -1, i.e. one “array step” before the first “regular” array copy. For the
end: as if it was in position n+1, i.e. one “array step” after the last “regular” array copy.
When Merge is activated, and the cap vertices are within the distance threshold, they will be merged.
Note
The start/end cap objects currently don’t support the First Last option.

Hints
Offset Calculation
The transformation applied from one copy to the next is calculated as the sum of the three different components
(Relative, Constant and Object), all of which can be enabled/disabled independently of the others. This allows,
for example, a relative offset of 1.0, 0.0, 0.0 and a constant offset of 0.1, 0.0, 0.0, giving an array
of objects neatly spaced along the X axis with a constant 0.1 units between them, whatever the original
object’s size.
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Examples
Mechanical

A track. Sample blend file
A bridge made from a tileable mesh.

A cog created from a single segment. Blend

A crankshaft. Sample blend file

A chain created from a single link. Sample blend file

20

Bforartists Reference Manual - © Copyright - This page is under OCL license

Fractal

Fractal created with multiple arrays. Blend

Multi-level array animated with motion blur.

A fractal fern image created with 2 array modifiers
and 1 mirror applied to a cube.

Organic

Fig 02

Fig 01
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Fig 03

Fig 01
Subsurfed cube array with 1 object offset, 4 cubes and a high vertex merge setting to give the effect of
skinning.
Fig 02
A double spiral created with two array modifiers and one subsurf modifier applied to a cube. As above,
the vertex merge threshold is set very high to give the effect of skinning. Sample blend file
Fig 03
A tentacle created with an Array modifier followed by a Curve modifier. The segment in the foreground is
the base mesh for the tentacle; the tentacle is capped by two specially-modeled objects deformed by the
same Curve object as the main part of the tentacle. Sample blend file

Tutorials
• Neal Hirsig’s Array Modifier Screencast on Vimeo
• Creating A Double Helix With Modifiers
The ‘Double Helix’ tutorial explains the Array modifier. It is for an old Bforartists Version (2.44) but except for
the keyboard shortcuts it is still valid.

Normal Edit Modifier
The Normal Edit modifier affects (or generates) custom normals. It uses a few simple parametric methods to
compute normals (quite useful in game development and architecture areas), and mixes back those generated
normals with existing ones.
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Options

Normal Edit modifier.

Radial/Directional
The two modes currently available to generate normals.
Radial aligns normals with the (origin, vertex coordinates) vector, in other words all normals seems to
radiate from the given center point, as if they were emitted from an ellipsoid surface.
Directional makes all normals point (converge) towards a given target object.
Target Object
Uses this object’s center as reference point when generating normals.
Optional in Radial mode, mandatory in Directional one.
Parallel Normals
Makes all normals parallel to the line between both objects’ centers, instead of converging towards
target’s center.
Only relevant in Directional mode
Offset
Gives modified object’s center an offset before using it to generate normals.
Only relevant in Radial mode if no Target Object is set, and in Directional mode when Parallel Normals
is set.
Mix Mode
How to affect existing normals with newly generated ones.
Note the Multiply option is not a cross product, but a mere component-by-component multiplication.
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Mix Factor
How much of the generated normals get mixed into existing ones.
Vertex Group
Allows per-item fine control of the mix factor. Vertex group influence can be reverted using the small
“arrow” button to the right.

Usage
This modifier can be used to quickly generate radial normals for low-poly tree foliage, or “fix” shading of toonlike rendering by partially bending default normals...
The only mandatory prerequisite to use it is to enable Auto Smooth option in Mesh properties, Normals panel.
Tip
More complex normal manipulations can be achieved by copying normals from one mesh to another, see the
Data Transfer modifier.

UV Project Modifier

Projecting the Bforartists logo onto Suzanne.

The UV Project Modifier acts like a slide projector. It emits a UV map from the negative Z-axis of a controller
object (such as an empty), and applies it to the object as the “light” hits it. It can optionally override the objects
face texture.
Download an example
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Options

UV layer
Which UV layer to modify. Defaults to the active rendering layer.
Image
The image associated with this modifier. Not required; you can just project a UV for use elsewhere.
Override Image, below, defines how the image is used.
Override Image
• When true, the Face Texture of all vertices on the mesh is replaced with the Image. This will cause
the image to repeat, which is usually undesirable.
• When false, the modifier is limited to faces with the Image as their Face Texture.
Projectors
Up to ten projector objects are supported. Each face will choose the closest and aligned projector with it’s
surface normal. Projections emit from the negative Z-axis (i.e. straight down a camera or lamp). If the
projector is a camera, the projection will adhere to its perspective/orthographic setting.
Objects
Specify the projector Object
Aspect X/Y and Scale X/Y
These allow simple manipulation of the image. Only apply when a camera is used as projector Object.

Usage
General
UV Project is great for making spotlights more diverse, and also for creating decals to break up repetition.
The modifier’s Image property is not generally used - instead, a texture mapped to the UV layer that the
modifier targets is added to the object’s Material. This allows you to prevent the image from repeating by
setting Texture –> Image Mapping –> Extension to Clip.

Perspective Cameras
When using perspective cameras or spot lamps, you will likely want to enable the UV Project Material Option
(available in the materials panel), This uses a different UV interpolation to prevent distortion.
Note
This option is not yet available for Cycles
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UV Warp Modifier
The UV Warp modifier uses two objects to define a transformation which is applied to the chosen UV
coordinates.
Its purpose is to give you direct control over the object’s UVs in the 3D View, allowing you to directly translate,
rotate and scale existing UV coordinates using controller objects or bones.

Options

UV Center
The center point of the UV map to use when applying scale or rotation. With (0, 0) at the bottom left and
(1, 1) at the top right. Defaults to (0.5, 0.5).
UV Axis
The axes to use when mapping the 3D coordinates into 2D.
From/To
The two objects used to define the transformation. See Usage below.
Vertex Group
The vertex group can be used to scale the influence of the transformation per-vertex.
UV Map
Which UV map to modify. Defaults to the active rendering layer.

Usage
How the UVs are warped is determined by the difference between the transforms (location, rotation and scale)
of the from and to objects.
If the to object has the same transforms as the from object, the UVs will not be changed.
Assuming the UV Axis of the modifier is X/Y and the scale of the objects are (1, 1, 1), if the to object is one unit
away from the from object on the X-axis, the UVs will be transformed on the U-axis (horizontally) by one full
UV space (the entire width of the image)
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Vertex Weight Modifiers
The Vertex Weight modifiers work on a vertex group of the affected object, by modifying its weights and/or
which vertices belong to the vertex group.
Warning
These modifiers do implicit clamping of weight values in the standard [0.0, 1.0] range. All values
below 0.0 will be set to 0.0, and all values above 1.0 will be set to 1.0.

There are currently three Vertex Weight modifiers:
• Vertex Weight Edit Modifier
• Vertex Weight Mix Modifier
• Vertex Weight Proximity Modifier

Common Settings

The influence/masking part of Vertex Weight modifiers.

The three Vertex Weight modifiers share a few settings, controlling their influence on the affected vertex group.
Global Influence
The overall influence of the modifier (0.0 will leave the vertex group’s weights untouched,
1.0 is standard influence).

Warning
Influence only affects weights, adding/removing of vertices to/from vertex group is not prevented by
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setting this value to 0.0.

Vertex Group Mask
An additional vertex group, the weights of which will be multiplied with the global influence value for
each vertex. If a vertex is not in the masking vertex group, its weight will be not be affected.
Texture
An additional texture, the values of which will be multiplied with the global influence value for each
vertex.
This is a standard texture data-block control. When set, it reveals other settings:
Texture Coordinates
How the texture is mapped to the mesh.
Local
Use local vertex coordinates.
Global
Use vertex coordinates in global space.
Object
Use vertex coordinates in another object’s space.
UV
Use a UV layer’s coordinates.
Use Channel
Which channel to use as weight factor source/
Red/Green/Blue/Alpha
One of the color channels’ values.
Intensity
The average of the RGB channels (If RGB = 1.0, 0.0, 0.0, value is 0.33)
Value
The highest value of the RGB channels (If RGB = 1.0, 0.0, 0.0, value is 1.0)
Hue
Uses the hue value from the standard color wheel (e.g. blue has a higher hue value than
yellow)
Saturation
Uses the saturation value (e.g. pure red’s value is 1.0, gray is 0.0)

Note
All of the channels above are gamma corrected, except for Intensity.

Object
The object to be used as reference for Object mapping.
UV Layer
The UV layer to be used for UV mapping.
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Viewing Modified Weights
You can view the modified weights in Weight Paint mode. This also implies that you’ll have to disable the
Vertex Weight modifiers if you want to see the original weights of the vertex group you are editing.

Vertex Weight Edit Modifier

The Vertex Weight Edit modifier panel.

This modifier is intended to edit the weights of one vertex group.
The general process is the following, for each vertex:
• [Optional] It does the mapping, either through one of the predefined functions, or a custom mapping
curve.
• It applies the influence factor, and optionally the vertex group or texture mask (0.0 means original
weight, 1.0 means fully mapped weight).
• It applies back the weight to the vertex, and/or it might optionally remove the vertex from the group if
its weight is below a given threshold, or add it if it’s above a given threshold.

Options
Vertex Group
The vertex group to affect.
Default Weight
The default weight to assign to all vertices not in the given vertex group.
Falloff Type
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Type of mapping:
Linear
No mapping.
Custom Curve
Allows the user to manually define the mapping using a curve.
Sharp, Smooth, Root and Sphere
These are classical mapping functions, from spikiest to roundest.
Random
Uses a random value for each vertex.
Median Step
Creates binary weights (0.0 or 1.0), with 0.5 as cutting value.
Group Add
Adds vertices with a final weight over Add Threshold to the vertex group.
Group Remove
Removes vertices with a final weight below Remove Threshold from the vertex group.

Vertex Weight Mix Modifier

The Vertex Weight Mix modifier panel.

This modifier mixes a second vertex group (or a simple value) into the affected vertex group, using different
operations.

Options
Vertex Group A
The vertex group to affect.
Default Weight A
The default weight to assign to all vertices not in the given vertex group.
Vertex Group B
The second vertex group to mix into the affected one. Leave it empty if you only want to mix in a simple
value.
Default Weight B
The default weight to assign to all vertices not in the given second vertex group.
Mix Mode
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How the vertex group weights are affected by the other vertex group’s weights.
Replace weights
Replaces affected weights with the second group’s weights.
Add to weights
Adds the values of Group B to Group A.
Subtract from weights
Subtracts the values of Group B from Group A.
Multiply weights
Multiplies the values of Group B with Group A.
Divide weights
Divides the values of Group A by Group B.
Difference
Subtracts the smaller of the two values from the larger.
Average
Adds the values together, then divides by 2.
Mix Set
Choose which vertices will be affected.
All vertices
Affects all vertices, disregarding the vertex groups content.
Vertices from group A
Affects only vertices belonging to the affected vertex group.
Vertices from group B
Affects only vertices belonging to the second vertex group.
Vertices from one group
Affects only vertices belonging to at least one of the vertex groups.
Vertices from both groups
Affects only vertices belonging to both vertex groups.

Warning
When using All vertices, Vertices from group B or Vertices from one group, vertices might be added to
the affected vertex group.
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Vertex Weight Proximity Modifier

The Vertex Weight Proximity modifier panel.

This modifier sets the weights of the given vertex group, based on the distance between the object (or its
vertices), and another target object (or its geometry).

Options
Vertex Group
The vertex group to affect.
Target Object
The object from which to compute distances.
Proximity mode
Object Distance
Use the distance between the modified mesh object and the target object as weight for all vertices in
the affected vertex group.
Geometry Distance
Use the distance between each vertex and the target object, or its geometry.
The Geometry Distance mode has three additional options, Vertex, Edge and Face. If you enable more than one
of them, the shortest distance will be used. If the target object has no geometry (e.g. an empty or camera), it will
use the location of the object itself.
Vertex
This will set each vertex’s weight from its distance to the nearest vertex of the target object.
Edge
This will set each vertex’s weight from its distance to the nearest edge of the target object.
Face
This will set each vertex’s weight from its distance to the nearest face of the target object.
Lowest
Distance mapping to 0.0 weight.
Highest
Distance mapping to 1.0 weight.
Falloff Type
Some predefined mapping functions, see Vertex Weight Edit Modifier.
Tip
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Lowest can be set above Highest to reverse the mapping.

Examples
Using Distance from a Target Object
As a first example, let’s dynamically control a Wave modifier with a modified vertex group.
Add a Grid mesh, with many vertices (e.g. a 100×100 vertices), and 10 BU side-length. Switch to Edit mode
(Tab), and in the Object Data properties, Vertex Groups panel, add a vertex group. Assign to it all your mesh’s
vertices (with e.g. a 1.0 weight). Go back to Object mode.
Then, go to the Modifiers properties, and add a Vertex Weight Proximity modifier. Set the mode to Object
Distance. Select your vertex group, and the target object you want (here I used the lamp).
You will likely have to adjust the linear mapping of the weights produced by the Vertex Weight Proximity
modifier. To do so, edit Lowest Dist and Highest Dist so that the first corresponds to the distance between your
target object and the vertices you want to have lowest weight, and similarly with the second and highest
weight...
Now add a Wave modifier, set it to your liking, and use the same vertex group to control it.
Animate your target object, making it move over the grid. As you can see, the waves are only visible around the
reference object! Note that you can insert a Vertex Weight Edit modifier before the Wave one, and use its
Custom Curve mapping to get larger/narrower “wave influence’s slopes”.

Using Distance from a Target Object’s Geometry
We’re going to illustrate this with a Displace modifier.
Add a 10×10 BU 100×100 vertices grid, and in Edit mode, add to it a vertex group containing all of its vertices,
as above. You can even further sub-divide it with a first Subsurf modifier.
Now add a curve circle, and place it 0.25 BU above the grid. Scale it up a bit (e.g. 4.0).
Back to the grid object, add to it a Vertex Weight Proximity modifier, in Geometry Distance mode. Enable Edge
(if you use Vertex only, and your curve has a low U definition, you would get wavy patterns, see (Wavy
patterns)).
Wavy patterns.
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Distance from edges.

Distance from vertices.

Set the Lowest Dist to 0.2, and the Highest Dist to 2.0, to map back the computed distances into the regular
weight range.
Add a third Displace modifier and affect it the texture you like. Now, we want the vertices of the grid nearest to
the curve circle to remain undisplaced. As they will get weights near zero, this means that you have to set the
Midlevel of the displace to 0.0. Make it use our affected vertex group, and that’s it! Your nice mountains just
shrink to a flat plane near the curve circle.
As in the previous example, you can insert a Vertex Weight Edit modifier before the Displace one, and play with
the Custom Curve mapping to get a larger/narrower “valley”...
Curve Map variations.

Concave-type mapping curve.

No mapping curve (linear).

Convex-type mapping curve.

Vertices with a computed weight below 0.1 removed from the vertex group.

You can also add a fifth Mask modifier, and enable Vertex Weight Edit ‘s Group Remove option, with a Remove
Threshold of 0.1, to see the bottom of your valley disappear.
https://vimeo.com/30188564
The Bforartists file, TEST_2 scene.

Using a Texture and the Mapping Curve
Here we are going to create a sort of strange alien wave (yes, another example with the Wave modifier... but it’s
a highly visual one; it’s easy to see the vertex group effects on it...).
So as above, add a 100×100 grid. This time, add a vertex group, but without assigning any vertex to it - we’ll do
this dynamically.
Add a first Vertex Weight Mix modifier, set the Vertex Group A field with a Default Weight A of 0.0, and set
Default Weight B to 1.0. Leave the Mix Mode to Replace weights, and select All vertices as Mix Set. This way,
all vertices are affected. As none are in the affected vertex group, they all have a default weight of 0.0, which
is replaced by the second default weight (1.0). And all those vertices are also added to the affected vertex
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group.
Now, select or create a masking texture - here I chose a default Magic one. The values of this texture will
control how much of the “second weight” (1.0) replaces the “first weight” (0.0)... In other words, they are
taken as weight values!
You can then select which texture coordinates and channel to use. Leave the mapping to the default Local
option, and play with the various channels...
Texture channel variations.

Using intensity.

Using Red.

Using Saturation.

Don’t forget to add a Wave modifier, and select your vertex group in it!
You can use the weights created this way directly, but if you want to play with the curve mapping, you must add
the famous Vertex Weight Edit modifier, and enable its Custom Curve mapping.
By default, it’s a one-to-one linear mapping - in other words, it does nothing! Change it to something like in (A
customized mapping curve), which maps [0.0, 0.5] to [0.0, 0.25] and [0.5, 1.0] to [0.75,
1.0], thus producing nearly only weights below 0.25, and above 0.75 : this creates great “walls” in the
waves...
Custom mapping curve.

Custom Mapping disabled.

Custom Mapping enabled.

A customized mapping curve.

Array Modifier
The Array modifier creates an array of copies of the base object, with each copy being offset from the previous
one in any of a number of possible ways. Vertices in adjacent copies can be merged if they are nearby, allowing
smooth subsurf frameworks to be generated.
This modifier can be useful when combined with tileable meshes for quickly developing large scenes. It is also
useful for creating complex repetitive shapes.
35

Bforartists Reference Manual - © Copyright - This page is under OCL license

Multiple array modifiers may be active for an object at the same time (e.g. to create complex three dimensional
constructs).

Options

Array modifier.

Fit Type menu
Controls how the length of the array is determined. There are three choices, activating respectively the
display of the Curve, Length or Count settings explained below:.
Fit Curve
Generates enough copies to fit within the length of the curve object specified in Curve.
Fit Length
Generates enough copies to fit within the fixed length given by Length.
Fixed Count
Generates the number of copies specified in Count.
Curve
The Curve object to use for Fit Curve.
Length
The length to use for Fit Length.
Count
The number of duplicates to use for Fixed Count.
Note
• Both Fit Curve and Fit Length use the local coordinate system size of the base object, which means
that scaling the base object in Object mode will not change the number of copies generated by the
Array modifier.
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• Fit Length uses the local coordinate system length of the curve, which means that scaling the curve in
Object mode will not change the number of copies generated by the Array modifier.
• Applying the scale with Ctrl-A can be useful for each one.

Constant Offset, X, Y, Z
Adds a constant translation component to the duplicate object’s offset. X, Y and Z constant components
can be specified.
Relative Offset, X, Y, Z

Relative offset example.

Adds a translation equal to the object’s bounding box size along each axis, multiplied by a scaling factor,
to the offset. X, Y and Z scaling factors can be specified.
Object Offset

Object offset example.

Adds a transformation taken from an object (relative to the current object) to the offset. It is good practice
to use an Empty object centered or near to the initial object. E.g. by rotating this Empty a circle or helix
of objects can be created.
Merge
If enabled, vertices in each copy will be merged with vertices in the next copy that are within the given
Distance.
First Last
If enabled and Merge is enabled, vertices in the first copy will be merged with vertices in the last copy
(this is useful for circular objects).
First Last merge example.

Subsurf discontinuity caused by
not merging vertices between first
and last copies (First Last off).
Distance

Subsurf discontinuity eliminated
by merging vertices between first
and last copies (First Last on).
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Controls the merge distance for Merge.
Start Cap / End Cap
This allows either endpoints of the array to have a different mesh subsisted.
For the start: as if it was in position -1, i.e. one “array step” before the first “regular” array copy. For the
end: as if it was in position n+1, i.e. one “array step” after the last “regular” array copy.
When Merge is activated, and the cap vertices are within the distance threshold, they will be merged.
Note
The start/end cap objects currently don’t support the First Last option.

Hints
Offset Calculation
The transformation applied from one copy to the next is calculated as the sum of the three different components
(Relative, Constant and Object), all of which can be enabled/disabled independently of the others. This allows,
for example, a relative offset of 1.0, 0.0, 0.0 and a constant offset of 0.1, 0.0, 0.0, giving an array
of objects neatly spaced along the X axis with a constant 0.1 units between them, whatever the original
object’s size.

Examples
Mechanical

A track. Sample blend file
A bridge made from a tileable mesh.

38

Bforartists Reference Manual - © Copyright - This page is under OCL license

A cog created from a single segment. Blend

A crankshaft. Sample blend file

A chain created from a single link. Sample blend file

Fractal

Fractal created with multiple arrays. Blend

Multi-level array animated with motion blur.
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A fractal fern image created with 2 array modifiers
and 1 mirror applied to a cube.

Organic

Fig 02

Fig 01

Fig 03

Fig 01
Subsurfed cube array with 1 object offset, 4 cubes and a high vertex merge setting to give the effect of
skinning.
Fig 02
A double spiral created with two array modifiers and one subsurf modifier applied to a cube. As above,
the vertex merge threshold is set very high to give the effect of skinning. Sample blend file
Fig 03
A tentacle created with an Array modifier followed by a Curve modifier. The segment in the foreground is
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the base mesh for the tentacle; the tentacle is capped by two specially-modeled objects deformed by the
same Curve object as the main part of the tentacle. Sample blend file

Tutorials
• Neal Hirsig’s Array Modifier Screencast on Vimeo
• Creating A Double Helix With Modifiers
The ‘Double Helix’ tutorial explains the Array modifier. It is for an old Bforartists Version (2.44) but except for
the keyboard shortcuts it is still valid.

Bevel Modifier
The Bevel modifier adds the ability to bevel the edges of the mesh it is applied to, allowing control of how and
where the bevel is applied to the mesh.
The Bevel modifier is a non-destructive alternative to the Bevel Operation in edit mode.

Unbeveled

Beveled

The images above show the side views of a plain (unbeveled) cube and a beveled one.

Options

Bevel modifier panel.

Width
The size of the bevel affect. See Width Method below.
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Three Cubes with 0.1, 0.3 and 0.5 bevel Widths.

Segments
The number of edge loops added along the bevel’s face.
Profile
The shape of the bevel, from concave to convex - has no effect if Segments is less than 2.
Material
The index of the material slot to use for the bevel. When set to -1, the material of the nearest original
face will be used.
Only Vertices
When enabled, only the areas near vertices are beveled; the edges are left unbeveled.

Three cubes with 0.1, 0.3 and 0.5’ bevel Widths, with Only Vertices option enabled.

Clamp Overlap
When enabled, the width of each beveled edge will be limited such that they cannot intersect each other.
Edges that are far apart will still bevel with the full width, only edges too close to each other are affected.
Limit Method
Used to control where a bevel is applied to the mesh.
None
No limit, all edges will be beveled.
Angle
Only edges where the adjacent faces form an angle smaller than the defined threshold will be
beveled. Intended to allow you to bevel only the sharp edges of an object without affecting its
42

Bforartists Reference Manual - © Copyright - This page is under OCL license

smooth surfaces.
Weight
Use each edge’s bevel weight to determine the width of the bevel. When the bevel weight is 0.0,
no bevel is applied. See here about adjusting bevel weights.
Vertex Group
Use weights from a vertex group to determine the width of the bevel. When the vertex weight is
0.0, no bevel is applied. An edge is only beveled if both of its vertices are in the vertex group. See
here about adjusting vertex group weights.
Width Method
Used to control how the Width is measured.
Offset
Amount is offset of new edges from original.
Width
Amount is width of new face.
Depth
Amount is perpendicular distance from original edge to bevel face.
Percent
Amount is percent of adjacent edge length.

Boolean Modifier
Introduction
The Boolean modifier performs operations on meshes that are otherwise too complex to achieve with as few
steps by editing meshes manually, meaning you can achieve results with little effort to make mesh operations
like Unions, Differences and Intersections.
The Boolean modifier uses one of three Boolean operations (Difference (negation), Union (conjunction), and
Intersect (disjunction)) to create a single compound object out of two mesh objects.

The Union, Intersection and Difference between a Cube and a UV Sphere, with the modifier applied to the Sphere and using
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the cube as target.

Description
The Boolean modifier can only be used on mesh objects.
It performs one of the three Boolean Operations for the faces of open or closed volumes that creates a complete
topology in the faces it’s being used. This means that this modifier will only work properly for the intersection
of faces of the two meshes that will result in another closed loop of edges (filled with faces), creating a new
resulting face topology.
The Boolean modifier is non-destructive for the target; it uses the topology of the target to make the
calculations, but you will still have the target in the scene. In normal conditions, using face normals pointed
outside, when you apply the Boolean modifier operation, the modified mesh will receive changes in topology,
and you will have to move or hide the target to see the resulting mesh. The only exception is when you are
using inverted normals; in this case, depending on the calculations, you will also change the topology of the
target. You can see one example of a target being modified in the Materials section in this page.
The results of the mesh operation will only be shown in Object Mode of the 3D View.

Note
•
•
•
•
•
•

The Boolean modifier works with open and closed volumes.
The Boolean modifier doesn’t work on edges without faces.
The target topology determines the new topology of the modified mesh.
The face normals are taken into account for the calculations.
Whether faces are marked for smooth or flat for shading doesn’t affect the calculations of this modifier.
The line at which this modifier is calculated is delimited by the first tangential contact between faces of
the modified mesh and target.

Tip
This is a dynamic real-time modifier!
If you have marked your Objects to show the Edges (in Properties Window, Object context, Display panel,
enable Wire), you will see the Edge creation process while you’re moving your Objects. Depending on your
mesh topology, you can also enable X-Ray and Transparency and see the topology being created in real time.

Usage
Using the default Bforartists install, with the desired mesh Object selected, go to the Properties Window which
is located at the right of your Bforartists Screen, below the Outliner. Click on the Modifiers Context, which is
represented by a wrench - The Boolean modifier. Then, click on the Add Modifier Button and Bforartists will
show you a list of all of the available Modifiers. The Boolean modifier is located on the third row in the
Generate Column.
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You can also click on the Add Modifier Button and use N to add the Boolean modifier, or use Bforartists search
with the shortcut Spacebar and type “Add Modifier”, click on Add Modifier and press N.
When you add the Boolean modifier for an Object, Bforartists will need a second Object to perform the
operation. You can use open or closed Meshes, as long as they have faces for calculations.
You can add one or more modifiers of this type for an Object but you can only apply one operation for the
Boolean modifier at a time.

Options

Boolean Modifier Options

Operations
Operation
Which boolean operation will be used.
Difference
The modified mesh is subtracted from the target mesh.

Union

• If the target Mesh has inverted normals, Bforartists will Intersect the modified mesh.
• If the modified Mesh has inverted normals, Bforartists will add both meshes (Union).
• If both Meshes use inverted normals, Bforartists will Intersect the target Mesh.

The target mesh is added to the modified mesh.

Intersect

• If the target Mesh has inverted normals, Bforartists will Intersect the target Mesh.
• If the modified Mesh has inverted normals, Bforartists will subtract the target Mesh.
• If both Meshes use inverted normals, Bforartists will Intersect the modified Mesh.

The target mesh is subtracted from the modified mesh.
• If the target Mesh has inverted normals, Bforartists will subtract the target Mesh.
• If the modified Mesh has inverted normals, Bforartists will intersect the target Mesh.
• If both Meshes use inverted normals, Bforartists will add both meshes (Union).
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Object
The name of the target mesh object.

Materials
The Boolean modifier preserves the Materials of the participant Meshes, including their basic textures and
mappings, and the modified mesh will receive its first active material index assigned to its new topology (the
first active material).
Below, some examples are shown to exemplify how materials work with the Boolean modifier; we took the
cube as the modified mesh, and the icosphere as the target with one material (white). We added four different
indexes to one of the faces of the cube, leaving another basic material in the other faces. The top left image
shows how the Boolean modifier interacts with the materials. The other three images show the three different
Boolean operations applied to the modified mesh. In all the images the meshes have normals pointed outwards
with the Icosphere as the target, and the Cube being the modified mesh.

Cube with Multi-Materials and Icosphere with basic Material

Union: The first active Material of the Cube is added to the
new topology

Difference: The Icosphere was subtracted from the Cube

Intersect: The resulting Mesh was copied and rotated 180

The only exception is the difference operation when the normals of the target and modified mesh are inverted.
In this case, Bforartists will project the textures in an inverted direction over the target using the center contact
of the meshes as a pivot and the resulting mesh will have the modified mesh subtracted from the target. For
complex target meshes in some particular cases, you may have to reassign materials to faces because Bforartists
will use the possible projection, and this may result in a sub-optimal texture assignment. You can see this in the
last example below.
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Front of the target with the modified mesh materials

Back of the target with the modified mesh materials

UV Mappings
When you map UV Images to your target, Bforartists will add a map for each of the faces of the target. When
you apply the Boolean modifier, Bforartists will follow the UV maps already assigned to the faces of the target
topology that will be the result of the operation on the modified mesh. Bforartists will also use the same image
mapped to the target faces in the modified mesh.
Warning
Depending on the way you have assigned textures to the faces during the UV unwrap, and the complexity of
your meshes, the boolean operation may generate imperfect UVs for the new faces.
Below we have four Images, a UV sphere mapped with a test grid tinted blue and the other face tinted in purple,
one face of the cube tinted in a light orange and the other faces using the normal test grid. The firat image
shows the operation at the start (difference), and on to the right of that shows the resulting mesh. And in the
bottom row we show the unwrap in the Bforartists UV/Image Editor Window.

A UV Sphere and a Cube with different UV Maps

Difference operation applied

Faces of the modified mesh mapped

New topology mapped and UV faces assigned

Other Modifiers
The Boolean modifier calculation is performed using the target modified mesh topology and dimensions. Other
modifiers added to the modified mesh are bypassed. It means that if a target is using another modifier, like
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subsurf, the resulting topology for the modified mesh will take into account the subsurf of the target; but for the
modified mesh, the basic topology is used anyway (see examples).
If you add subsurf to the modified mesh with a Boolean modifier, Bforartists will visually add the subsurf for
the modified mesh, but not for its calculations; it will only take into account its basic mesh topology. If you
want to have a subsurf added to the modified mesh, you have to apply the subsurf to the Boolean modified
mesh before applying the Boolean operation.
The Boolean modifier can be added together with other modifiers in the modified mesh, but depending on the
modifier, the calculations can’t be done and/or the modifier cannot execute. When the modifier cannot execute,
it will show the message "Cannot execute boolean operation", and when the modifier cannot be
applied to the mesh, Bforartists will show the message "Modifier is disabled, Skipping
Apply.". In this case, you either have to remove some modifiers or apply the necessary ones.

Boolean Modifier with error message

The most common case is when you add or copy a Boolean modifier to use the modified mesh in conjunction
with another target later; Bforartists will place the warning in the subsequent Boolean modifiers in the stack
depending on the operation, because you may be creating concurrent Boolean operations for the same modified
mesh, which in most cases is impossible to execute depending on the chosen target. In this case, you can apply
the first Boolean modifier of the stack for the target and then use the other Boolean modifier(s) in the stack for
subsequent operations.
Also, if some other modifiers are placed above this modifier and you click on Apply, Bforartists will warn you
with the message "Applied Modifier was not first, results may not be as
expected". The best usage scenario for this modifier is to prepare your modified mesh and target to work
with the Boolean modifier.
When the Boolean modifier is the first of the stack and is applied, the other Modifiers will act over the resulting
meshes using the resulting topology and will remain in the modifiers stack.
Below are two images: one with the subsurf added to the target, and another with the resulting topology.
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Modifier with Subsurf Target

The Resulting Topology

As you can see, the added (not applied) subsurf to the target was taken into consideration. The topology of the
Icosphere with subsurf (Level 2) was completely transferred to the modified mesh.
Tip
The target topology determines the resulting topology
The target topology determines the results of the Boolean modifier operation. It means that any modifier added
to the target which modifies its topology will affect the resulting mesh of the operation.

Concurrent Operations
For the modified meshes, you can only apply one operation at a time, but you can use the same target for other
modified meshes and use modified meshes as a target for other meshes as well. Also, you can copy or add the
same modifier to the modifiers stack as many times as you wish to suit the number of operations you need, but
be aware that if you choose concurrent targets which are, at the same time, modified meshes pointing to each
other, you can cause Bforartists to crash with closed loops!

Hints
Be aware that other modifiers and their stack position could cause this modifier to fail in certain circumstances.
Tip
The best way to work with this modifier when you need to make lots of sequential operations of the same
modifier is to define the target at the time you need to apply the changes to the topology.

Face Normals
When using the Boolean modifier, Bforartists will use the face normal directions to calculate the three Boolean
operations. The direction of the normals will define the result of the three available operations. When one of the
participants has inverted normals, you’re in fact multiplying the operation by -1 and inverting the calculation
order. You can, at any time, select your modified mesh, enter Edit Mode and flip the normals to change the
behavior of the Boolean modifier. See Tips for Fixing Mixed Normals below.
Bforartists also cannot perform any optimal Boolean operation when one or more of the mesh Normals of the
participants that are touching has outwards/inwards normals mixed.
This means you can use the normals of the meshes pointed completely towards the inside or outside of your
participants in the operation, but you cannot mix normals pointed inwards and outwards for the faces of the
topology used for calculations. In this case, Bforartists will enable the modifier and you may apply the
modifier, but with bad to no effects. We made some examples with a cube and an icosphere showing the results.
In the images below, all face normals are pointing outwards (Normal meshes).
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Faces with normals pointing outwards

Normal Boolean modifier operation (Difference operation)

In the images below, all face normals are inverted and using the intersection operation

Boolean Operation with inverted normals

Normal Boolean modifier operation

Now, let’s see what happens when the normal directions are mixed for one of the participants in the Boolean
modifier operation. The images below show face normals mixed, pointed to different directions and the
resulting operation, you can see that the modifier has bad effects when applied, leaving faces opened:

Face normals mixed, pointed to different directions

Resulting operation leaves faces opened

As you can see, the normal directions can be pointing to any of the Mesh sides, but can’t be mixed in opposite
directions for the faces of the participants. The Library can’t determine properly what’s positive and negative
for the operation, so the results will be bad or you will have no effect when using the Boolean modifier
operation.
A quick way to fix this is to use Bforartists’s Recalculate Normals operation in Edit Mode.
If you still have some ugly black gouges you will have to Manually Flip the Normals.

Empty or Duplicated Faces
This modifier doesn’t work when the modified and/or the target mesh uses empty faces in the topology used for
calculations. If the modifier faces a situation where you have empty faces mixed with normal faces, the
modifier will try, as much as possible, to connect the faces and apply the operation. For situations where you
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have two concurrent faces at the same position, the modifier will operate on the target mesh using both faces,
but the resulting normals will get messed. To avoid duplicated faces, you can remove doubles for the vertices
before recalculating the normals outside or inside. The button for remove doubles is located in the Mesh Tools
Panel in the 3D View, while in Edit Mode.
The best usage scenario for this modifier is when you have clean meshes with faces pointing clearly to a
direction (inwards/outwards)
Below we show an example of meshes with open faces mixed with normal faces being used to create a new
topology. In this example, a difference between the cube and the icosphere is applied, but Bforartists connected
a copy of the icosphere to the Cube mesh, trying to apply what was possible.

Mesh with two empty faces mixed with normal faces

Result of a difference operation applied

Open Volumes
The Boolean Modifier permits you to use open meshes or non-closed volumes (not open faces).
When using open meshes or non-closed volumes, the Boolean modifier won’t perform any operation in faces
that don’t create a new topology filled with faces using the faces of the target.
In the images below, is the resulting operation when using two non-closed volumes with faces forming a new
topology.

Non-closed volumes forming a new topology

Resulting operation using two open volumes

Now, let’s see what happens when we use meshes that are partially open, incomplete, or meshes that aren’t
forming a new topology.
As you can see in the images below the faces of one participant in the Boolean operation gives incomplete
information to the modifier. The resulting edges get messy and there is not enough information to create faces
for the resulting Mesh. This example uses a smooth shaded UVsphere cut in half. As explained before, the
shading (smooth/flat) doesn’t affect the calculations of the modifier.
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Open volumes that aren’t forming a new topology

Resulting Operation of image on the left

Build Modifier
The Build modifier causes the faces of the mesh object to appear one after the other over time.
By default, faces appear in the order in which they are stored in memory (by default, the order of creation). The
face/vertex order can be altered in Edit Mode by selecting Sort Faces from the Search Menu (Spacebar)
Note
When using Bforartists Render, if the material of the mesh is a halo rather than a standard one, then the
vertices of the mesh, not the faces, appear one after another.

Options

Build modifier in action

Start
The start frame of the building process.
Length
The number of frames over which to rebuild the object.
Randomize
Randomizes the order in which the faces are built.
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Seed
The random seed. Changing this value gives a different “random” order when “Randomize” is checked this order is always the same for a given seed/object set.

Decimate Modifier
The Decimate modifier allows you to reduce the vertex/face count of a mesh with minimal shape changes.
This is not usually used on meshes which have been created by modeling carefully and economically (where all
vertices and faces are necessary to correctly define the shape). But if the mesh is the result of complex
modeling, sculpting and/or applied subsurf/multires modifiers, the Decimate modifier can be used to reduce the
polygon count for a performance increase, or simply remove unnecessary vertices and edges.
The Decimate modifier is a quick and easy way of reducing the polygon count of a mesh non-destructively.
This modifier demonstrates the advantages of a mesh modifier system because it shows how an operation which
is normally permanent and destroys original mesh data, can be done interactively and safely using a modifier.
Unlike the majority of existing modifiers, the Decimate modifier does not allow you to visualize your changes
in Edit Mode.
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Options

decimate modifier

Decimate Type
Collapse
Merge vertices together progressively, taking the shape of the mesh into account.
Ratio
The ratio of faces to keep after decimation.
• On 1.0, the mesh is unchanged.
• On 0.5, edges have been collapsed such that half the number of faces remain (See
Note below).
• On 0.0, all faces have been removed.
Note
Although the Ratio is directly proportional to the number of remaining faces, triangles
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are used when calculating the ratio.
This means that if your mesh contains quads, the number of remaining faces will be
larger than expected, because quads remain unchanged if their edges are not collapsed.
This is only true if the Triangulate option is disabled.

Un-Subdivide
Can be thought of as the reverse of subdivide. Attempts to remove edges that were the result of a
subdivide operation. If additional editing has been done after the subdivide operation, the results
may be unexpected.
Iterations
The number of times to perform the un-subdivide operation. Two iterations is the same as one
subdivide operation, so you will usually want to use even numbers.
Planar
Dissolve geometry on the same plane.
Angle Limit
Dissolve geometry which form angles lower than this setting.
All Boundaries
When enabled, all vertices along the boundaries of faces are dissolved. This can give nicer
results when using a high Angle Limit.
Delimit
Prevent dissolving geometry in certain places.
Normal
Does not dissolve edges on the borders of areas where the face normals are reversed.
Material
Does not dissolve edges on the borders of where different materials are assigned.
Seam
Does not dissolve edges marked as seams.
Face Count
This field shows the number of remaining faces as a result of applying the Decimate modifier.

Known Limitations
N-Gons
N-Gons are currently not supported when collapsing edges, the operation will still succeed, but edges
attached aren’t considered for reduction.

Edge Split Modifier
The Edge Split modifier splits edges within a mesh. The edges to split can be determined from the edge angle
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(i.e. angle between faces forming this edge), and/or edges marked as sharp.
Splitting an edge affects vertex normal generation at that edge, making the edge appear sharp. Hence, this
modifier can be used to achieve the same effect as Auto Smooth, making edges appear sharp when their angle is
above a certain threshold. It can also be used for manual control of the smoothing process, where the user
defines which edges should appear smooth or sharp (see Mesh Smoothing for other ways to do this). If desired,
both modes can be active at once.
The output of the Edge Split modifier is available to export scripts, making it quite useful for creators of game
content.

Options

Edge Split modifier.

Edge Angle
When enabled, edges will be split if the angle between its two adjacent faces is greater than the Split
Angle.
Split Angle
On 0, all edges are split. On 180, no edges are split.
Sharp Edges
When enabled, edges will be split if they were marked as sharp using ‣ Mark Sharp
Note
Non-manifold edges (edges shared by more than two faces) will always be split.
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Examples

Edge Split modifier output with From Marked As Sharp selected.

(From Left to right): Flat Shading, Smooth Shading, Smooth Shading with Edge Split.

Note
Splitting edges can also be performed manually in Edit Mode using: Edge Specials ‣ Edge Split

Mask Modifier
The Mask modifier allows vertices of an object to be hidden dynamically based on vertex groups.

Options
Mode
The Mask modifier can hide parts of a mesh based on two different modes, selectable from this dropdown list.
Vertex Group
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Vertex Group

When the Vertex Group option is selected, all vertices belonging to the chosen Vertex Group (with a
weight above zero) will be visible, and all other vertices will be hidden.
Armature

Armature

When in Pose Mode, vertices belonging to the Vertex Group associated with the active bone (same
names) will be visible. Vertices not in that group will be hidden.
Inverse
Normally, vertices belonging to the selected Vertex Group (or group associated with the active pose-bone)
will be shown. The Invert toggle allows you to reverse this behavior, instead showing all vertices which
do not belong to the Vertex Group, and hiding those that do.

Mirror Modifier

The corner of a cube mirrored across three axes to form... well... a cube.

The Mirror modifier mirrors a mesh along its local X, Y and/or Z axes, across the object’s center (the mirror
plane is then defined by the two other axes).
It can also use another object as the mirror center, then use that object’s local axes instead of its own.
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Options

Mirror modifier

Axis
The axis (X, Y, or Z) along which to mirror (i.e. the axis perpendicular to the mirror plane of symmetry).
To understand how the axis applies to the mirror direction, if you were to mirror on the X axis, the
positive X values of the original mesh would become the negative X values on the mirrored side.
You can select more than one of these axes - you’ll then get more mirrored copies. With one axis you get
a single mirror, with two axes four mirrors, and with all three axes eight mirrors.
Options:
Merge
Where a vertex is in the same place (within the Merge Limit distance) as its mirror it will be merged
with the mirrored vertex.
Clipping
Prevents vertices from moving through the mirror plane(s) while the user is transforming them in
Edit Mode.
If Clipping is enabled but vertices are beyond the mirror plane and outside of the Merge Limit, the
vertices will not be merged. But as soon as the vertices are within Merge Limit they are snapped
together and cannot be moved beyond the mirror plane.
Note
Vertices on the mirror plane will be unable to move away from the mirror plane as long as Clipping
is enabled. You must disable Clipping to be able to move the vertices along the mirror axis again.

Vertex Groups
When enabled, the Mirror modifier will try to mirror existing vertex groups.
A very nice feature, but one that has very specific prerequisites:
• The vertex groups you want to mirror must be named following the usual left/right pattern
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(i.e. suffixed by something like ”.R”, ”.right”, ”.L”, etc).
• The mirror side vertex group must already exist (it will not be created automatically). It must
also be completely empty (no vertices assigned to it).
Textures
The U and V options allows you to mirror the UV texture coordinates across the middle of the image.
E.g. if you have a vertex with UV coordinates of (0.3, 0.9), its mirror copy will have UV coordinates
of (0.7, 0.1).
Merge Limit
The maximum distance between a vertex and its mirror copy before they are merged together. In other
words, a vertex may be half this distance away from the mirror plane before it snaps to it.
Mirror Object
The name of another object (usually an empty), to be used as the reference for the mirror process: its
center and axes will drive the plane(s) of symmetry. You can of course animate its position/rotation to
animate the mirror effect.

Hints
Many modeling tasks involve creating objects that are symmetrical. However, there used to be no quick way to
model both halves of an object without using one of the workarounds that have been discovered by clever
Bforartists artists over the years. A common technique was to model one half of an object and use Alt-D to
create a linked duplicate which can then be scaled on one axis by -1 to produce a perfect mirror-image copy
which updates in real time as you edit.
The Mirror modifier offers a simpler way to do this. Once your modeling is completed you can either click
Apply to make a real version of your mesh or leave it as is for future editing.

Using the Mirror Modifier with a Subdivision Surface Modifier
When using the Mirror modifier along with a subsurf modifier, the order in which the modifiers are placed is
important.

Subsurf modifier before Mirror modifier

The above image shows the subsurf modifier placed before the Mirror one; as you can see the effect of this is
that the mesh is split down the center line of the mirror effect. This is because the subsurf calculation moves
vertices away from the mirror plane, too far away from the Merge Limit.
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Mirror modifier before Subsurf modifier

The above image shows the Mirror modifier placed before the subsurf modifier. In this order, the mirror
calculation is done and the vertices are merged together. Only after that does the subsurf modifier move any
vertices.

Accurately Positioning the Mirror Plane
To apply a Mirror modifier, it is common to have to move the object’s center onto the edge or face that is to be
the axis for mirroring. This can be tricky when attempted visually.
A good technique to achieve an exact position is to select the edge, then choosing Cursor to Selection. This
will position the 3D Cursor in the center of the edge. Finally, set Origin to 3D Cursor. This will move the
object’s center (and thus, the mirror plane) to where the 3D cursor is located, and the mirroring will be exact.
An alternative is to use an Empty as a Mirror Object that you move to the correct position.

Multiresolution Modifier

Multires modifier

The Multiresolution modifier (often shortened to Multires) gives you the ability to subdivide a mesh similarly
to the Subsurf Modifier, but also allows you to edit the new subdivision levels in sculpt mode.
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Note
The Multiresolution Modifier is the only modifier that cannot be repositioned in the stack if it means that there
will be geometry or other object data created or removed before it (i.e. all Generate, some Modify and some
Simulate modifiers cannot come before the Multiresolution modifier.)

Options
Catmull-Clark / Simple
Set the type of subdivision.
Simple
Maintains the current shape, and simply subdivides edges.
Catmull-Clark
Creates a smooth surface, usually smaller than the original, using the standard Catmull-Clark
subdivision surface algorithm.
Preview
Set the level of subdivisions to show in the 3D View.
Sculpt
Set the number of subdivisions to use in Sculpt Mode.
Render
Set the number of subdivisions to show when rendering.
Subdivide
Add another level of subdivision.
Delete Higher
Deletes all subdivision levels that are higher than the current one.
Reshape
Copies vertex coordinates from another mesh. To use, first select a different mesh object with matching
topology and vertex indexes, then Shift select the object you wish to copy vertex coordinates to and
click Reshape.
Apply Base
Modifies the original unsubdivided mesh to match the form of the subdivided mesh.
Subdivide UVs
When enabled, the UV maps will also be subdivided. (i.e. Bforartists will add “virtual” coordinates for all
sub-faces created by this modifier).
Optimal Display
When drawing the wireframe of this object, the wires of the new subdivided edges will be skipped (only
draws the edges of the original geometry).
Save External
Saves displacements to an external .btx file.

Remesh Modifier
The Remesh modifier is a tool for generating new mesh topology. The output follows the surface curvature of
the input, but its topology contains only quads.
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Options
Mode
There are three basic modes available in the remesh modifier: Blocks, Smooth and Sharp.

This example shows a cone with each of the different remesh modes. From left to right: original cone, Blocks, Smooth,
and Sharp

The output topology is almost identical between the three modes; what changes is the smoothing.
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Blocks
There is no smoothing at all.
Smooth
Output a smooth surface.
Sharp
Similar to Smooth, but preserves sharp edges and corners. In the above image, the circular bottom
of the cone and the top point of the cone are more accurately reproduced in Sharp mode.

Input mesh, and the low to high resolution output meshes

Octree Depth
The Octree Depth sets the resolution of the output. Low values will generate larger faces relative to the
input, higher values will generate a denser output.
Scale
The result can be tweaked further by setting the Scale; lower values effectively decrease the output
resolution.
Sharpness
Shown when using the Sharp Mode - Higher values produce edges more similar to the input, while lower
values filter out noise.
Smooth Shading
Output faces with smooth shading rather than flat shading. The smooth/flat shading of the input faces is
not preserved.
Remove Disconnected Pieces
Filter out small disconnected pieces of the output.
Threshold
Use this to control how small a disconnected component must be to be removed.
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The input mesh (left) is fairly noisy, so the initial output of the remesh modifier (center) contains small disconnected
pieces. Enabling Remove Disconnected Pieces (right) deletes those faces.

Usage
In the modifier panel, add a Remesh modifier. The input mesh should have some thickness to it; if the input is
completely flat, add a solidify modifier above the remesh modifier.

Examples
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Remesh modifier applied to text to improve topology

Screw Modifier
The Screw modifier is similar to the Screw tool in the Tool Shelf in that it takes a profile object, a Mesh or a
Curve, to create a helix-like shape.

Properly aligning the profile object is important

The profile should be properly aligned to the cardinal direction of the object rather than to the screw axis.

Options

Screw modifier

Axis
The axis along which the helix will be built.
Screw
The height of one helix iteration.
AxisOb
The name of an object to define the axis direction.
Object Screw
Use the distance from the AxisOb to define the height of one helix iteration.
Angle
Degrees for a single helix revolution.
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Steps
Number of steps used for a single revolution displayed in the 3D view. Beware of setting this higher than
Render Steps, which is the value used for rendering.
Render Steps
As above, but used during render time. Increase to improve quality.
Smooth Shading
Output faces with smooth shading rather than flat shading. The smooth/flat shading of the input geometry
is not preserved.
Calc Order
Order of edges is calculated to avoid problems with normals and shading. Only needed for meshes, not
curves.
Flip
Flip normals direction.
Iterations
Number of revolutions.
Stretch U/V
Stretch the UV coordinates from 0.0 to 1.0 when UVs are present.

Skin Modifier
The Skin Modifier uses vertices and edges to create a skinned surface, using a per-vertex radius to better define
the shape. The output is mostly quads, although some triangles will appear around intersections.
It is a quick way to generate base meshes for sculpting and/or smooth organic shapes with arbitrary topology.

Note
Faces in the original geometry are ignored by the Skin Modifier.

Options
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Skin Modifier.

Create Armature
Create an armature on top of the object. Each edge becomes a bone.

Note
If the root vertex has more than one adjacent edge, an extra bone will be created to serve as the root.

This function does the following:
1. A new armature object is added with bones matching the input mesh. The active selection is switched to
the new armature.
2. Weight groups are added to the input mesh. The Skin Modifier propagates these weights to the output as
well.
3. An Armature Modifier is added directly below the Skin Modifier. Note that the Armature Modifier is
being applied after the Skin Modifier because it should only deform the output, whereas if it were above
the Skin Modifier it might change the resulting topology.

Smoothing
Branch Smoothing
A branch point is a vertex with three or more connected edges. These areas tend to produce more
complicated topology, some of which may overlap. The Branch Smoothing setting relaxes the surface
around these points, with the side effect of shrinking the surface.
Smooth Shading
Output faces with smooth shading rather than flat shading. The smooth/flat shading of the input geometry
is not preserved.

Selected Vertices
Mark/Clear Loose
By default, a branch vertex (vertex with three or more connected edges) will generate extra edge loops
along adjacent edges in order to keep the output tight. Branches can be made loose by clicking Mark
Loose, which will allow the output to stretch between all adjacent vertices. This can be disabled again by
clicking Clear Loose with the vertex selected.
Mark Root
Marking a vertex as root causes that vertex to be used for calculating rotations for connected limbs. Root
vertices also affect the armature output; they will be used as the origin for the root bones.
Roots are shown in the 3D View with a red dashed circle around the vertex.
Each set of connected vertices should have one root node. Mark Root enforces the one-root per set rule,
so it is not necessary to manually unmark roots.
Equalize Radii
Makes the skin radii of selected vertices equal on each axis.
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Symmetry Axes
The Symmetry Axes checkboxes are used to keep the output topology symmetrical in their respective axes. In
other words, using it avoids merging triangles across an axis unless the triangles form a symmetric quad.
Note
These symmetry axes checkboxes do not add geometry flipped across an axis. For that, the Mirror Modifier
should be used, typically placed above the Skin Modifier.

Usage
Add the Skin Modifier to a mesh. Disable Limit selection to visible in the 3D View so that you can see the
vertices inside the new geometry. Ensure the modifier is enabled for display in Edit Mode (on by default).
The Skin Modifier uses ordinary vertices and edges as input. All of the regular Edit Mode tools (such as
extrude, subdivide, grab, scale, and rotate) can be used when building a skinned mesh.

Skin Resize
The radii of input vertices can be individually scaled in Edit Mode to alter the thickness of the skin by pressing
Ctrl-A. Non-uniform scaling of the X and Y axes is accessible by locking it with X or Y. The radius can also
be adjusted in the Transform panel of the Properties region.

Examples

Simple creature, made with only the Skin Modifier.
1. In the modifiers menu, add a Skin Modifier.
2. Tab into edit mode and start extruding.
3. Try to sketch results similar to Fig. Simple creature, made with only the Skin Modifier., through
extruding the vertices of the object.
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4. Use Ctrl-A to change the size of the different regions within the creature.
5. Use Mark Loose at regions like the neck, to merge these faces more together.
6. To get smoother results, activate Smooth Shading and add a Subdivision Surface

Solidify Modifier
The Solidify modifier takes the surface of any mesh and adds depth to it.

Options

Solidify modifier

Thickness
The depth to be solidified.
Offset
A value between -1 and 1 to locate the solidified output inside or outside the original mesh. Set to 0.0,
the solidified output will be centered on the original mesh.
Clamp
A value between 0 and 2 to clamp offsets to avoid self intersection.

Clamp Offset

Vertex Group
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Only vertices in this group are solidified - their weights are multiplied by the thickness, so vertices with
lower weights will be less thick.
Invert
Reverses the vertex group, so that only vertices which are not in the vertex group are solidified.
Factor
How much the vertex weights are taken into account.
• On 0.0, vertices with zero weight will have no thickness at all.
• On 0.5, vertices with zero weight will be half as thick as those with full weight.
• On 1.0, the weights are ignored and the thickness value is used for every vertex.
Crease
These options are intended for usage with the Subdivision Modifier.

Rim and edges. In this example, the object was assigned a second material used to color the rim red.

Inner
Set a crease to the inner edges.
Outer
Set a crease to the outer edges.
Rim
Set a crease to the rim.
Flip Normals
Reverse the normals of all geometry (both the inner and outer surfaces).
Even Thickness
Maintain thickness by adjusting for sharp corners. Sometimes improves quality but also increases
computation time.
High Quality Normals
Normals are calculated to produce a more even thickness. Sometimes improves quality but also increases
computation time.
Fill Rim
Fills the gap between the inner and outer edges.
Only Rim
TODO
Note
Fill Rim and Only Rim only make a difference on non-manifold objects, since the “rims” are generated from
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the borders of the original geometry.

Material Index Offset
Choose a different material to use for the new geometry; this is applied as an offset from the original
material of the face from which it was solidified.
• A value of 0 means it will use the same material.
• A value of 1 means it will use the material immediately below the original material.
• A value of -2 means the material two positions above the original material will be used.
These are clamped to the top-most and bottom-most material slots.
Rim
Similarly, you can give another material to the rim faces.

Warning
The modifier thickness is calculated using local vertex coordinates. If the object has non-uniform scale, the
thickness will vary on different sides of the object.
To fix this, either apply or clear scale.

Known Limitations
Even Thickness
Solidify thickness is an approximation. While “Even Thickness” and “High Quality Normals” should yield
good results, the final wall thickness isn’t guaranteed and may vary depending on the mesh topology.
In order to maintain precise wall thickness in every case, we would need to add/remove faces on the offset shell
- something this modifier doesn’t do since this would add a lot of complexity and slow down the modifier.

Solidify Modifier
The Solidify modifier takes the surface of any mesh and adds depth to it.
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Options

Solidify modifier

Thickness
The depth to be solidified.
Offset
A value between -1 and 1 to locate the solidified output inside or outside the original mesh. Set to 0.0,
the solidified output will be centered on the original mesh.
Clamp
A value between 0 and 2 to clamp offsets to avoid self intersection.

Clamp Offset

Vertex Group
Only vertices in this group are solidified - their weights are multiplied by the thickness, so vertices with
lower weights will be less thick.
Invert
Reverses the vertex group, so that only vertices which are not in the vertex group are solidified.
Factor
How much the vertex weights are taken into account.
• On 0.0, vertices with zero weight will have no thickness at all.
• On 0.5, vertices with zero weight will be half as thick as those with full weight.
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• On 1.0, the weights are ignored and the thickness value is used for every vertex.
Crease
These options are intended for usage with the Subdivision Modifier.

Rim and edges. In this example, the object was assigned a second material used to color the rim red.

Inner
Set a crease to the inner edges.
Outer
Set a crease to the outer edges.
Rim
Set a crease to the rim.
Flip Normals
Reverse the normals of all geometry (both the inner and outer surfaces).
Even Thickness
Maintain thickness by adjusting for sharp corners. Sometimes improves quality but also increases
computation time.
High Quality Normals
Normals are calculated to produce a more even thickness. Sometimes improves quality but also increases
computation time.
Fill Rim
Fills the gap between the inner and outer edges.
Only Rim
TODO
Note
Fill Rim and Only Rim only make a difference on non-manifold objects, since the “rims” are generated from
the borders of the original geometry.

Material Index Offset
Choose a different material to use for the new geometry; this is applied as an offset from the original
material of the face from which it was solidified.
• A value of 0 means it will use the same material.
• A value of 1 means it will use the material immediately below the original material.
• A value of -2 means the material two positions above the original material will be used.
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These are clamped to the top-most and bottom-most material slots.
Rim
Similarly, you can give another material to the rim faces.

Warning
The modifier thickness is calculated using local vertex coordinates. If the object has non-uniform scale, the
thickness will vary on different sides of the object.
To fix this, either apply or clear scale.

Known Limitations
Even Thickness
Solidify thickness is an approximation. While “Even Thickness” and “High Quality Normals” should yield
good results, the final wall thickness isn’t guaranteed and may vary depending on the mesh topology.
In order to maintain precise wall thickness in every case, we would need to add/remove faces on the offset shell
- something this modifier doesn’t do since this would add a lot of complexity and slow down the modifier.

Subdivision Surface Modifier
Subdivision Surface (Subsurf in short) is a method of subdividing the faces of a mesh to give a smooth
appearance, to enable modeling of complex smooth surfaces with simple, low-vertex meshes. This allows high
resolution mesh modeling without the need to save and maintain huge amounts of data and gives a smooth
organic look to the object.
This process creates virtual geometry that is generated non-destructively without modifying the original mesh,
but it can be converted to real geometry that you could edit with the Apply button.
Also, like the rest of the Modifiers, order of execution has an important bearing on the results. For this, see the
documentation on The Stack.
Keep in mind that this is a different operation than its companion, Smooth Shading. You can see the difference
between the two in the grid image below.
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Subsurfs levels 0 to 3, without and with Smooth Shading.

Tip
The Subsurf modifier does not allow you to edit the new subdivided geometry without applying it, but the
Multires modifier does (in sculpt mode).

Modifier Settings

Modifier’s Panel

Type
This toggle button allows you to choose the subdivision algorithm:
Catmull-Clark
The default option, subdivides and smooths the surfaces. According to its Wikipedia page, the
“arbitrary-looking formula was chosen by Catmull and Clark based on the aesthetic appearance of
the resulting surfaces rather than on a mathematical derivation.”
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Simple
Only subdivides the surfaces, without any smoothing (the same as W –> Subdivide, in Edit Mode).
Can be used, for example, to increase base mesh resolution when using displacement maps.
Subdivisions
Recursively adds more geometry. For details on polygon counts, see the Performance Considerations
section.
View
The number of subdivision levels shown in the 3D View.
Render
The number of subdivision levels shown in renders.
The right combination of these settings will allow you to keep a fast and lightweight approximation of your
model when interacting with it in 3D, but use a higher quality version when rendering.
Note
Be careful not to set the View subdivisions higher than the Render subdivisions, this would mean the 3D View
will be higher quality than the render.

Options:
Subdivide UVs
When enabled, the UV maps will also be subsurfed (i.e. Bforartists will add “virtual” coordinates
for all sub-faces created by this modifier).

Subdivide UVs on and off

Optimal Display
When drawing the wireframe of this object, the wires of the new subdivided edges will be skipped
(only draws the edges of the original geometry)
Opensubdiv
See the OpenSubdiv section.

OpenSubdiv
OpenSubdiv is a option of Subsurf modifier. When this option is enabled for Subsurf modifier from the very top
of the modifier stack, evaluation will happen on the compute device selected in the User Preferences. Best
performance will be achieved when using GLSL evaluation. As a result performance of the modifier will be
much higher which is great for animations.
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To enable OpenSubdiv you must first choose the fastest compute device. To do this see the OpenSubdiv
Compute section. To find more on OpenSubdiv read the Release Notes.

Improving Performance
In order to utilize maximum performance form OpenSubdiv the following things are required:
• Subsurf modifier must be last in the modifier stack.
• There should be no modifiers prior to Subsurf which changes mesh topology across the time.
• Other objects should not use geometry of OpenSubdiv mesh

Edit Cage
To view and edit the results of the subdivision while you’re editing the mesh, you must enable the Editing Cage
(the triangle button in the modifier’s header). This lets you grab the vertices as they lie in their new smoothed
locations, rather than on the original mesh.

Edit Cage Off (Default)

Edit Cage On

With the edit cage off, some vertices are buried under the subsurfed mesh. With dense vertex configurations,
you might even have to temporarily disable the modifier or view wireframe shading so that you can see these
vertices.
With the edit cage on, you do not have this problem. It does, however, have its own disadvantage—it can look
too nice, hiding irregularities. Notice the three quads running in the middle of Suzanne’s ear: you can only tell
how crooked they are in the “edit cage off” version. When you are modeling, you will more often want to see
your mesh deformities in their full ugliness so that you can apply your skills until it is sheer prettiness.

Control
Subsurf rounds off edges, and often this is not what you want. There are several solutions.

Weighted Edge Creases
Weighted edge creases for subdivision surfaces allows you to change the way Subsurf subdivides the geometry
to give the edges a smooth or sharp appearance.
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A Subsurfed Cube with Creased Edges

The crease weight of selected edges can be changed in the Transform panel of the properties region, and
moving the mouse closer or further from the selected edges to adjust the crease weight. A higher value makes
the edge “stronger” and more resistant to the smoothing effect of subdivision surfaces.

Edge Loops

A Subsurf Level 2 Cube, the same with an extra Edge Loop, and the same with six extra Edge Loops

The Subsurf modifier demonstrates why good, clean topology is so important. As you can see in the figure, the
Subsurf modifier has a drastic effect on a default Cube. Until you add in additional Loops, the shape is almost
unrecognizable as a cube.
A mesh with deliberate topology has good placement of Edge Loops, which allow the placement of more Loops
to control the sharpness/smoothness of the resultant mesh.

Performance Considerations
Higher levels of subdivisions mean more vertices, and more vertices means more memory will be used (both
video memory for display, and system RAM for rendering). Bforartists could potentially crash or hang if you do
not have enough memory.
When using high levels of subdivision with a graphics card that has a low total amount of Vram, some parts of
the geometry will disappear visually. Your mesh will actually be OK, because the render is generated using your
Object Data, (even though it cannot be shown by your graphics card).

Known Limitations
Non Contiguous Normals
Bforartists’s subdivision system produces nice smooth subsurfed meshes, but any subsurfed face (that is, any
small face created by the algorithm from a single face of the original mesh), shares the overall normal
orientation of that original face.
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Comparison of good normals and bad normals Side view of image on left
Abrupt normal changes can produce ugly black gouges even though these flipped normals are not an issue for
the shape itself.
A quick way to fix this is to use Bforartists’s Recalculate Normals operation in Edit Mode.
If you still have some ugly black gouges you will have to Manually Flip the Normals.

Concave NGons
While NGons are supported, concave ngons may give ugly overlapping results.

The ngons on the right show overlapping subsurf result.

Triangulate Modifier
The Triangulate modifier converts all faces in a mesh (whether it be quads or N-gons) to triangular faces. This
modifier does the exact same function as the triangulate function in Edit Mode.
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Mesh before Triangulate Modifier

Mesh after Triangulate Modifier

Options
Quad Method:
Beauty
Split the quads in nice triangles, slower method.
Fixed
Split the quads on the 1st and 3rd vertices.
Fixed Alternate
Split the quads on the 2nd and 4th vertices.
Shortest Diagonal
Split the quads based on the distance between the vertices.
Ngon Method:
Beauty
Arrange the new triangles nicely, slower method.
Scanfill
Split the ngons using a scanfill algorithm.

Wireframe Modifier

Wireframe Modifier

The Wireframe modifier transforms a mesh into a wireframe by iterating over its faces, collecting all edges and
turning those edges into 4 sided polygons. Be aware of the fact that your mesh needs to have faces to be
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wireframed. You can define the thickness, the material and several other parameters of the generated wireframe
dynamically via the given modifier options.

Options
Thickness
The depth or size of the wireframes.
Offset
A value between -1 and 1 to change whether the wireframes are generated inside or outside the original
mesh. Set to zero, Offset will center the wireframes around the original edges.
Vertex Group
Restrict the modifier to only this vertex group.
Invert
Inverts the vertex group weights.

Wireframes on a displaced plane. In this example, the wireframes carry a second (dark) material while the displaced plane
uses its original one.

Crease Edges
This option is intended for usage with the Subdivision Modifier. Enable this option to crease edges on
their junctions and prevent large curved intersections.
Crease Weight
Define how much crease (between 0 = no and 1 = full) the junctions should receive.
Even Thickness
Maintain thickness by adjusting for sharp corners. Sometimes improves quality but also increases
computation time.
Relative Thickness
Determine edge thickness by the length of the edge - longer edges are thicker.
Boundary
Creates wireframes on mesh island boundaries.
Replace Original
If this option is enabled, the original mesh is replaced by the generated wireframe. If not, the wireframe is
generated on top of it.
Material Offset
Uses the chosen material index as the material for the wireframe; this is applied as an offset from the first
material.
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Examples
When you got more Faces that meet at one point they are forming a star like pattern like seen in the examples
below.

Original / Wireframe / Original+Wireframe
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VGroup weighting: One half 0 weighted, one half 1 weighted
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Cube+Subsurf with 0 / 0.5 / 1 crease weight

Warning
Wireframe thickness is an approximation. While Even Thickness should yield good results in many cases,
skinny faces can cause ugly spikes. In this case you can either reduce the extreme angles in the geometry or
disable the Even Thickness option.

Armature Modifier
The Armature modifier is used for building skeletal systems for animating the poses of characters and anything
else which needs to be posed.
By adding an armature system to an object, that object can be deformed accurately so that geometry doesn’t
have to be animated by hand.
Note
For more details on armatures usage, see this chapter.
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Options

Armature modifier

Object
The name of the armature object used by this modifier.
Preserve Volume
Use quaternions for preserving volume of object during deformation. It can be better in many situations.
Vertex Group
The name of a vertex group of the object, the weights of which will be used to determine the influence of
this Armature modifier’s result when mixing it with the results from other Armature ones.
Only meaningful when having at least two of these modifiers on the same object, with Multi Modifier
activated.
Invert
Inverts the influence set by the vertex group defined in previous setting (i.e. reverses the weight
values of this group).
Multi Modifier
Use the same data as a previous modifier (usually also an Armature modifier) as input. This allows you to
use several armatures to deform the same object, all based on the “non-deformed” data (i.e. this avoids
having the second Armature modifier deform the result of the first one...).
The results of the Armature modifiers are then mixed together, using the weights of the Vertex Group as
“mixing guides”.
Bind To
Method to bind the armature to the mesh.
Vertex Groups
When enabled, bones of a given name will deform vertices which belong to vertex groups of the
same name.
Bone Envelopes
When enabled, bones will deform vertices near them (defined by each bones envelope radius)
Enable/Disable bone envelopes defining the deformation (i.e. bones deform vertices in their
neighborhood).
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Cast Modifier
This modifier shifts the shape of a mesh, curve, surface or lattice to any of a few pre-defined shapes (sphere,
cylinder, cuboid).
It is equivalent to the To Sphere tool in Edit Mode (Mesh ‣ Transform ‣ To Sphere) and what other programs
call “Spherify” or “Spherize”, but, as written above, it is not limited to casting to a sphere.
Tip
The Smooth modifier is a good companion to Cast, since the cast shape sometimes needs smoothing to look
nicer or even to fix shading artifacts.
Note
For performance reasons, this modifier only works with local coordinates. If the modified object looks wrong,
you may need to apply its rotation, especially when casting to a cylinder.

Options

Cast Modifier

Cast Type
Menu to choose cast type (target shape): Sphere, Cylinder or Cuboid.
X, Y, Z
Toggle buttons to enable/disable the modifier in the X, Y, Z axes directions (X and Y only for Cylinder
cast type).
Factor
The factor to control blending between original and cast vertex positions. It’s a linear interpolation: 0.0
gives original coordinates (i.e. modifier has no effect), 1.0 casts to the target shape. Values below 0.0 or
above 1.0 exaggerate the deformation, sometimes in interesting ways.
Radius
If non-zero, this radius defines a sphere of influence. Vertices outside it are not affected by the modifier.
Size
Alternative size for the projected shape. If zero, it is defined by the initial shape and the control object, if
any.
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From radius
If activated, calculate Size from Radius, for smoother results.
Vertex Group
A vertex group name, to restrict the effect to the vertices in it only. This allows for selective, real-time
casting, by painting vertex weights.
Control Object
The name of an object to control the effect. The location of this object’s center defines the center of the
projection. Also, its size and rotation transform the projected vertices.
Hint
Animating (keyframing) this control object also animates the modified object.

Example

Top: Suzanne without modifiers. Middle: Suzanne with each type of Cast Modifier (Sphere, Cylinder and Cuboid). Bottom:
Same as above, but now only X axis is enabled. Sample blend file

Corrective Smooth
This modifier is used to reduce highly distorted areas of a mesh by smoothing the deformations.
This is typically useful after an armature modifier, where distortion around joints may be hard to avoid, even
with careful weight painting.
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To use this modifier effectively, it’s useful to understand the basics of how it works.
Rest State
Used as a reference to detect highly distorted areas.
The original vertex locations are used by default.
Smoothing
Many options for this modifier relate to smoothing which is used internally to correct the distorted
regions.

Options

Corrective smooth modifier

The modifier also uses a Rest state, to use as a reference Internally this modifier uses smoothing, so some of the
options adjust the kind of smoothing.
Factor
The factor to control the smoothing amount. Higher values will increase the effect. Values outside this
range (above 1.0 or below 0.0) distort the mesh.
Repeat
The number of smoothing iterations.
Higher values generally improve the quality of the smoothing but slow down the operation also.
Smooth Type
Select the smoothing method used.
Simple
This simply relaxes vertices to their connected edges.
Length Weight
Uses a method of relaxing that weights by the distance of surrounding vertices.
Can give higher quality smoothing in some cases, better preserving the shape of the original form.
Vertex Group
Use to manually select regions to smooth.
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Only Smooth
This option is included to preview the smoothing used, before correction is applied.
Pin Boundaries
Prevent boundary vertices from smoothing.
Rest Source
Select the source for reference vertex positions that defines the undeformed state.
Original Coords
Use the original input vertex positions.
This relies on the original mesh having the same number of vertices as the original mesh
Bind Coords
Optionally you may bind the modifier to a specific state.
This is required if there are constructive modifiers such as subsurf or mirror being applied before
this modifier in the stack.

Example
Here is an example of a character using a simple rig using only bone envelopes (no weight painting).
Armature Only

Armature & Corrective Smooth

Curve Modifier
The Curve Modifier provides a simple but efficient method of deforming a mesh along a curve object.
The Curve Modifier works on a (global) dominant axis, X, Y, or Z. This means that when you move your mesh
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in the dominant direction (by default, the X-axis), the mesh will traverse along the curve. Moving the mesh
perpendicularly to this axis, the object will move closer or further away from the curve.
When you move the object beyond the curve endings the object will continue to deform based on the direction
vector of the curve endings.

Options

Curve modifier

Object
The name of the curve object that will affect the deformed object.
Vertex Group
A vertex group name within the deformed object. The modifier will only affect vertices assigned to this
group.
Deformation Axis
X, Y, Z, -X, -Y, -Z: This is the axis that the curve deforms along.

Example
Let’s make a simple example:
• Remove default cube object from scene and add a Monkey (Add ‣ Mesh ‣ Monkey)
• Now add a curve (Add ‣ Curve ‣ Bezier Curve)
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Edit Curve.

• While in Edit Mode, move the control points of the curve as shown in (Edit Curve), then exit Edit Mode
(Tab).
• Select the Monkey (RMB) in Object mode
• Assign the curve to the modifier, as shown below. The Monkey should be positioned on the curve:

Assign the Bezier curve to the Curve modifier (for Monkey)
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Monkey on a Curve.

• Now if you select the Monkey, and move it in the Y-direction (G, Y), the monkey will deform nicely
along the curve.
Tip
If you press MMB while moving the Monkey you will constrain the movement to one axis only.
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Monkey deformations.

• In the image above you can see the Monkey at different positions along the curve. To get a cleaner view
over the deformation, a Subsurf modifier with two subdivision levels was applied, and smooth shading
was used.

Displace Modifier
The Displace modifier displaces vertices in a mesh based on the intensity of a texture. Either procedural or
image textures can be used. The displacement can be along a particular local axis, along the vertex normal, or
the separate RGB components of the texture can be used to displace vertices in the local X, Y and Z directions
simultaneously (sometimes referred to as Vector Displacement).

Options

Displace modifier

Texture
The name of the texture from which the displacement for each vertex is derived. If this field is empty, the
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modifier defaults to 1.0 (white).
Direction
The direction along which to displace the vertices. Can be one of the following:
X, Y, Z
Displace along a local axis.
Normal
Displace along vertex normal.
RGB to XYZ
Displace along local XYZ axes individually using the RGB components of the texture (Red values
displaced along the X-axis, Green along the Y, Blue along the Z). This is sometimes referred to as
Vector Displacement.
Texture Coordinates
The texture coordinate system to use when retrieving values from the texture for each vertex. Can be one
of the following:
UV
Take texture coordinates from face UV coordinates.
UV Map
The UV coordinate layer from which to take texture coordinates. If the object has no UV
coordinates, it uses the Local coordinate system. If this field is blank, but there is a UV
coordinate layer available (e.g. just after adding the first UV layer to the mesh), it will be
overwritten with the currently active UV layer.
Note
Since UV coordinates are specified per face, the UV texture coordinate system currently determines the
UV coordinate for each vertex from the first face encountered which uses that vertex; any other faces
using that vertex are ignored. This may lead to artifacts if the mesh has non-contiguous UV coordinates.
Object
Take the texture coordinates from another object’s coordinate system (specified by the Object field).
Object
The object from which to take texture coordinates. Moving the object will therefore alter the
coordinates of the texture mapping.
Take note that moving the original object will also result in a texture coordinate update. As
such, if you need to maintain a displacement coordinate system while moving the modified
object, consider parenting the coordinate object to the modified object.
If this field is blank, the Local coordinate system is used.
Global
Take the texture coordinates from the global coordinate system.
Local
Take the texture coordinates from the object’s local coordinate system.
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Vertex Group
The name of a vertex group which is used to control the influence of the modifier. If left empty, the
modifier affects all vertices equally.
Midlevel
The texture value which will be treated as no displacement by the modifier. Texture values below this
value will result in negative displacement along the selected direction, while texture values above this
value will result in positive displacement.
This is achieved by the equation displacement = texture_value - Midlevel. Recall that
color/luminosity values are typically between 0.0 and 1.0 in Bforartists, and not between 0 and 255.
Strength
The strength of the displacement. After offsetting by the Midlevel value, the displacement will be
multiplied by the Strength value to give the final vertex offset. This is achieved by the equation
vertex_offset = displacement * Strength. A negative strength can be used to invert the
effect of the modifier.

Hook Modifier

Two spheres used as Hooks to deform a subdivided cube.

The Hook modifier is used to deform a Mesh, Curve a Lattice using another object (usually an Empty or a Bone
but it can be any object).
As the hook moves, it pulls vertices from the mesh with it. You can think of it as animated proportional editing.
While hooks do not give you the fine control over vertices movement that shape keys do, they have the
advantage that you can grab vertices directly for manipulation.
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Options

Hook modifier

Object
The name of the object to hook vertices to.
Vertex Group
Allows you to define the influence per-vertex.
Useful when you don’t something other than a spherical field of influence.
Radius
The size of the hooks influence.
Strength
Adjust this hooks influance on the vertices, were 0.0 makes no change and 1.0 follows the hook.
Since multiple hooks can work on the same vertices, you can weight the influence of a hook using this
property.
Falloff Type
This can be used to adjust the kind of curve that the hook has on the mesh, You can also define a customcurve to get a much higher level of control.
Uniform Falloff
This setting is useful when using hooks on scaled objects, especially in cases where non-uniform scale
would stretch the result of the hook.
This is especially useful for lattices, where its common to use non-uniform scaling.
The following settings are only available in Edit Mode:
Reset
Recalculate and clear the offset transform of hook.
Recenter
Set hook center to the 3D cursor position.
Select
Select the vertices affected by this hook.
Assign
Assigns selected vertices to this hook.
Note
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The hook modifier stores vertex indices from the original mesh to determine what to effect; this means that
modifiers that generate geometry, like subsurf, should always be applied after the hook modifier; otherwise
the generated geometry will be left out of the hook’s influence.

Laplacian Smooth Modifier
The Laplacian Smooth modifier allows you to reduce noise on a mesh’s surface with minimal changes to its
shape.
It can also exaggerate the shape using a negative Factor.
The Laplacian Smooth is useful for objects that have been reconstructed from the real world and contain
undesirable noise. It removes noise while still preserving desirable geometry as well as the shape of the original
model.
The Laplacian Smooth modifier is based on a curvature flow Laplace Beltrami operator in a diffusion equation.

Options

Laplacian Smooth modifier

Repeat
Repetitions allow you to run the Laplacian smoothing multiple times. Each repetition causes the flow
curvature of the mesh to be recalculated again, and as a result it removes more noise with every new
iteration using a small Factor < 1.0.
When on 0, no smoothing is done.
Note
More repetitions will take longer to calculate - beware of doing so on meshes with a large number of
vertices.
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(with a factor of 0.5)

Repeat: 0

Repeat: 1

Repeat: 5

Repeat: 10

(with a factor of 2.0)

Repeat: 0

Repeat: 1

Repeat: 5

Repeat: 10

(with a factor of -0.5)

Repeat: 0

Repeat: 1

Repeat: 5

Repeat: 10

Factor
Controls the amount of displacement of every vertex along the curvature flow.
•
•
•
•

Factor: 0.0

Using a small Factor, you can remove noise from the shape without affecting desirable geometry.
Using a large Factor, you get smoothed versions of the shape at the cost of fine geometry details.
Using a negative Factor, you can enhance the shape, preserving desirable geometry.
When the Factor is negative, multiple iterations can magnify the noise.

Factor: 0.5

Factor: 2.5
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Factor: 0.0

Factor: 1.0

Factor: 10.0

Factor: 50.0

Factor: 0.0

Factor: -20.0

Factor: -50.0

Factor: -300.0

Border
Since there is no way to calculate the curvature flow on border edges, they must be controlled separately.
Border edges are smoothed using a much simpler method, using this property to control the influence.
Positive values will smooth the vertex positions, while negative values will “enhance” them by
transforming them in the opposite direction.
(with a factor of 2.5)

Border: 0.0

Border: 1.0

Border: 2.5

Border: 10.0

(with a factor of 20.0)

Border: 0.0

Border: 1.0

Border: 5.0
(with a factor of -30.0)

100

Border: 20.0

Bforartists Reference Manual - © Copyright - This page is under OCL license

Border: 0.0

Border: -20.0

Border: -50.0

Border: -200.0

X, Y, Z
Toggle buttons to enable/disable deforming vertices in the X, Y and/or Z axis directions.

X, Y, Z: Unselected

X, Y, Z: Selected

X, Y: Selected

X: Selected

X, Y, Z: Unselected

X, Y, Z: Selected

X, Y: Selected

X: Selected

Preserve Volume
The smoothing process can produce shrinkage. That is significant for large Factor or large Repeat values;
to reduce that effect you can use this option.

Off

On

Off

On

Vertex Group
A vertex group name, to constrain the effect to a group of vertices only. Allows for selective, real-time
smoothing or enhancing, by painting vertex weights.
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Original Geometry

No Group Chosen

Vertex Weights

Result

Normalized
When enabled, the results will depend on face sizes. When disabled, geometry spikes may occur.

Original Geometry

On

Off

Off, High Factor

Hints
Meshes with a great number of vertices, more than ten thousand (10,000), may take several minutes for
processing; you can use small portions of the mesh for testing before executing the modifier on the entire
model.
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Examples

Femme Front blend file

Cube Smooth blend file

See Also
• Smooth Modifier

Laplacian Deform Modifier
The Laplacian Deform modifier allows you to pose a mesh while preserving geometric details of the surface.
The user defines a set of ‘anchor’ vertices, and then moves some of them around. The modifier keeps the rest of
the anchor vertices in fixed positions, and calculates the best possible locations of all the remaining vertices to
preserve the original geometric details.
This modifier captures the geometric details with the uses of differential coordinates. The differential
coordinates captures the local geometric information how curvature and direction of a vertex based on its
neighbors.
Note
You must define a Anchors Vertex Group. Without a vertex group modifier does nothing.

Options

Repeat
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Repetitions iteratively improve the solution found. The objective is to find the rotation of the differential
coordinates preserving the best possible geometric detail. Details are retained better if more repetitions
are used, however it will take longer to calculate.

Original Model

Repeat: 1

Repeat: 2

Repeat: 5

Original Model

Repeat: 1

Repeat: 2

Repeat: 10

Anchors Vertex Group
A vertex group name, to define the group of vertices that the user uses to transform the model. The weight
of each vertex does not affect the behavior of the modifier; the method only takes into account vertices
with weight greater than 0.
Bind
The Bind button is what tells the Laplacian Deform modifier to actually capture the geometry details of
the object, so that altering the anchors vertices actually alters the shape of the deformed object.
Unbind
After binding the modifier, you may later decide to make changes to the Anchors Vertex Group. To do so
you will first need to Unbind the modifier before binding again.

Error Messages
Vertex group group_name is not valid
This message is displayed when a user deletes a Vertex Group or when the user changes the name of the
Vertex Group.
Verts changed from X to Y
This message is displayed when a user add or delete verts to the mesh.
Edges changed from X to Y
This message is displayed when a user add or delete edges to the mesh.
The system did not find a solution
This message is displayed if the solver SuperLU did not find a solution for the linear system.
Note
If the mesh is dense, with a number of vertices greater than 100,000, then it is possible that the nonlinear
optimization system will fail.
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History
Laplacian Surface Editing is a method developed by Olga Sorkine and others in 2004. This method preserves
geometric details as much as possible while the user makes editing operations. This method uses differential
coordinates corresponding to the difference between a vector and the weighted average of its neighbors to
represent the local geometric detail of the mesh.

Differential Coordinate

See Also
• Laplacian Surface Editing (Original paper)
• Differential Coordinates for Interactive Mesh Editing

Lattice Modifier
The Lattice modifier deforms the base object according to the shape of a Lattice object.
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Options

Lattice modifier.

Object
The Lattice object with which to deform the base object.
Vertex Group
An optional vertex group name which lets you limit the modifier effect to a part of the base mesh.
Strength
A factor to control blending between original and deformed vertex positions.

Usage
A lattice consists of a three-dimensional non-renderable grid of vertices. Its main use is to give extra
deformation capabilities to the underlying object it controls (either via a modifier, or as its parent). Objects to
be deformed can be meshes, curves, surfaces, text, lattices and even particles.
The lattice should be scaled and moved to fit around your object in object mode. Any scaling applied to the
object in edit mode will result in the object deforming. This includes applying scale with Ctrl-A as this will
achieve the same result as scaling the lattice in edit mode, and therefore the object.
Tip
A Lattice Modifier can quickly be added to selected objects by selecting them all, then selecting the lattice
object last and parenting, and choosing Lattice Deform. This will both add Lattice modifiers to the selected
objects and parent them to the lattice.

Hints
Why would you use a lattice to deform a mesh instead of deforming the mesh itself in Edit Mode ? There are a
couple of reasons for that:
• If your object has a large number of vertices, it would be difficult to edit portions of it quickly in Edit
Mode. Using a lattice will allow you to deform large portions efficiently.
• The smooth deformation you get from a lattice modifier can be hard to achieve manually in Edit Mode.
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• Multiple objects can use the same lattice, thus allowing you to edit multiple objects at once.
• Like all modifiers, it is non-destructive. Meaning all changes happen on top of the original geometry,
which you can still go back and edit without affecting the deformation.
• A lattice does not affect the texture coordinates of a mesh’s surface.
Note
When using a lattice to deform particles, always remember to place the Lattice Modifier after the Particle
System Modifier. Read more about the importance of the modifier stack here.

Mesh Deform Modifier
The Mesh Deform modifier allows an arbitrary mesh (of any closed shape) to act as a deformation cage around
another mesh.

Options

Mesh Deform modifier

The Mesh Deform modifier is reasonably easy to use but it can be very slow to do the calculations needed to
properly map the deform mesh cage to the deformed object.
Object
The name of the mesh object to be used as a deforming mesh cage.
Vertex Group
An optional vertex group that will be affected by the deforming mesh cage. Vertices not in this group will
not be deformed.
Invert
Inverts the influence of the vertex group defined in the previous setting (reverses the weight values of this
group).
Bind
Links the current vertex positions of both the modified geometry and the deformer Object chosen
together. An unbound Mesh Deform modifier has no effect - it must be bound so that altering the shape of
the deform mesh cage actually alters the shape of the modified object.
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Warning
Depending on the settings of the Mesh Deform modifier and complexity of the deform mesh cage and/or
deformed object, it can take a long time for this operation to complete. This can result in Bforartists not
responding to user’s actions until it has completed.
It is also possible that Bforartists will run out of memory and crash.
To be safe, save your blend file before proceeding!

Unbind
When a deformed object has been associated to a deform mesh cage, it can later be disassociated by
clicking the Unbind button which replaced the Bind one. When Unbind is clicked, the deform mesh cage
will keep its current shape; it will not reset itself back to its original start shape.
If you need its original shape, you will have to save a copy of it before you alter it.
The deformed object will, however,reset back to its original shape that it had before it was bound to the
deform mesh cage.
Precision
The Precision numeric slider field controls the accuracy with which the deform mesh cage alters the
deformed object, when the points on the cage are moved. Raising this value higher can greatly increase
the time it takes the Mesh Deform modifier to complete its binding calculations, but it will get more
accurate cage mapping to the deformed object.
This setting becomes unavailable once a cage has been bound.
Dynamic
When activated, other mesh altering features (such as other modifiers and shape keys) are taken into
account when binding, increasing deformation quality.
It is deactivated by default to save memory and processing time when binding... Like with Precision, this
setting is unavailable once a cage has been bound.
Warning
Significant changes to the entire change mesh (such as rotating the cage upside down) can cause noticable
artifacts.
These can be reduced by binding with a higher Precision, however it is a known limitation with this modifier
and can’t be avoided entirely.

Hints
• Ensure that the normals on the cage mesh point to the outside; they are used to determine the inside and
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outside of the cage.
• Besides the outer cage, more faces within the cage, either loose or forming another smaller cage, can be
used for extra control. Such smaller cages may also overlap with the main cage; for example, to get
extra control over eyes, two small sphere cages could be added around them.

See Also
• The Lattice modifier.
• Original paper

Shrinkwrap Modifier
The Shrinkwrap modifier allows an object to “shrink” to the surface of another object. It moves each vertex of
the object being modified to the closest position on the surface of the given mesh (using one of the three
methods available).
It can be applied to meshes, lattices, curves, surfaces and texts.

Options

Nearest Surface Point

Target
Shrink target, the mesh to shrink to/wrap around.
Vertex Group
The vertex group to control whether and how much each vertex is displaced to its target position. If a
vertex is not a member of this group, it is not displaced (same as weight 0).
Offset
The distance that must be kept from the calculated target position, in Bforartists Units.
Mode
This drop-down list specifies the method to be used to determine the nearest point on the target’s surface
for each vertex of the modified object. Some options will add some extra, specific controls to the panel.
Nearest Surface Point
This will select the nearest point over the surface of the shrink target. It adds the extra option Above
surface, which always keep the computed vertices above their “floor faces”. This is only
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meaningful when Offset is not null.
Projection

This will project vertices along a chosen axis until they touch the shrink target. Vertices that never
touch the shrink target are left in their original position.
Subsurf Levels
This applies a (temporary) Catmull-Clark subsurf to the modified object, before computing
the wrap when using Projection mode.
Limit
This is a distance limit between original vertex and surface. If the distance is larger than this
limit vertex wouldn’t be projected onto the surface,
X, Y, Z
Along which local axis of the modified object the projection is done. These options can be
combined with each other, yielding a “median axis” of projection.
Negative, Positive
This allows you to select the allowed direction(s) of the shrink along the selected axis. With
more than one Shrinkwrap modifier, negative and positive axes can be combined.
Cull Faces
This allows you to prevent any projection over the “front side” (respectively the “back side”)
of the target’s faces. The “side” of a face is determined by its normal (front being the side
“from where” the normal “originates”).
Auxiliary Target
An additional object to project over.
Nearest Vertex
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This will snap vertices to the nearest vertex of the shrink target. It adds no extra options.

See also
Shrinkwrap Constraint

Simple Deform Modifier
The Simple Deform modifier allows easy application of a simple deformation to an object (meshes, lattices,
curves, surfaces and texts are supported).
Using another object, it’s possible to define the axis and origin of the deformation, allowing application of very
different effects.

Options

Simple Deform

Mode
This drop-down list defines the deform function applied, among four available:
Twist
Rotates around the Z axis.
Bend
Bends the mesh over the Z axis.
Taper
Linearly scales along Z axis.
Stretch
Stretches the object along the Z axis (negative Factor leads to squash), preserving volume by
scaling inversely on the X and Y axes..
Vertex Group
The name of the vertex group that indicates whether and how much each vertex is influenced by the
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deformation.
Origin
The name of an object that defines the origin of deformation (usually an empty). This object can be:
• Rotated to control the axis (its local Z-axis is now used as the deformation axis).
• Translated to control the origin of deformation.
• Scaled to change the deform factor.
Note
When the object controlling the origin (the one in the Origin field) is a child of the deformed object, this
creates a cyclic dependency in Bforartists’s data system. The workaround is to create a new empty and
parent both objects to it.

Angle/Factor
The amount of deformation. Can be negative to reverse the deformation.
Limits
These settings allow you to set the lower and upper limits of the deformation. The upper limit can’t be
lower than lower limit.
Lock X Axis / Lock Y Axis (Taper and Stretch modes only)
These controls whether the X and/or Y coordinates are allowed to change or not. Thus it is possible to
squash the X coordinates of an object and keep the Y coordinates intact.

Smooth Modifier

Smooth modifier applied to a subdivided cube

This modifier smooths a mesh by flattening the angles between adjacent faces in it, just like Specials ‣ Smooth
in Edit Mode. It smooths without subdividing the mesh - the number of vertices remains the same.
This modifier is not limited to smoothing, though. Its control factor can be configured outside the 0.0 - 1.0
range (including negative values), which can result in interesting deformations.

Options
X, Y, Z
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Toggle buttons to enable/disable the modifier in the X, Y and/or Z axes directions.
Factor
The factor to control the smoothing amount. Higher values will increase the effect. Values outside this
range (above 1.0 or below 0.0) distort the mesh.
Repeat
The number of smoothing iterations, equivalent to executing the smooth tool multiple times.
Vertex Group
A vertex group name, to restrict the effect to the vertices in it only. This allows for selective, real-time
smoothing, by painting vertex weights.

Algorithm
The calculation done by the Smooth Modifier is a simple and logical one, and can be thought of as the
geometric equivalent of blurring images.
Each new vertex position is simply the average position of surrounding vertices (the vertices connected to the
same edge as it).

Warp Modifier
This deformation modifier can be used to warp parts of a mesh to a new location in a very flexible way by using
2 objects to select the “from” and “to” regions, with options for using a curve falloff, texture and vertex group.

Warp modifier applied to a grid

The Warp Modifier is a bit tricky at first, but it helps to understand how it works. The modifier requires two
points, specified by object centers. The “from” point designates a point in space that is pulled toward the “to”
point. It is akin to using the Proportional Editing in Edit Mode.
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Options

Warp modifier

From:
Specify the origin object transformation of the warp.
To:
Specify the destination object transformation of the warp.
Preserve Volume
Enables volume preservation when rotating one of the transforms.
Vertex Group
Limit the deformation to a specific vertex group.
Strength
Sets how strong the effect is.
Radius
Sets the distance from the transforms that can be warped by the transform handles.
Falloff Type
Sets the way the strength of the warp change as it goes from the center of the transform to the Radius
value. See Proportional Editing for descriptions of the falloff types.
Texture
Specify a texture the strength is offset by to create variations in the displacement.
Texture Coordinates
Set the way textures are applied to the mesh when using a textured warp.
Object
Specify an object to use when set to Object.
UV Layer
Specify a UV layer when set to UV.

Wave Modifier
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Circular wave front

Linear wave front

Motion enabled for X, Normals enabled
for Y.

The Wave modifier adds a ripple-like motion to an object’s geometry.
This modifier is available for meshes, lattices, curves, surfaces and texts, with one restriction for non-mesh
objects: Activating Normals or typing a name in VGroup will simply deactivate the modifier.

Options

Wave modifier

Motion
X, Y
The wave effect deforms vertices/control points in the Z direction, originating from the given
starting point and propagating along the object with circular wave fronts (if both X and Y are
enabled), or with rectilinear wave fronts (if only one axis is enabled), then parallel to the axis
corresponding to the X or Y button activated.
Cyclic
Repeats the waves cyclically, rather than a single pulse.
Normals
For meshes only. Displaces the mesh along the surface normals (instead of the object’s Z-axis).
Time
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Settings to control the animation.
Offset
Time offset in frames. The frame at which the wave begins (if Speed is positive), or ends (if Speed
is negative). Use a negative frame number to prime and pre-start the waves.
Life
Duration of animation in frames. When set to zero, loops the animation forever.
Damping
An additional number of frames in which the wave slowly damps from the Height value to zero
after Life is reached. The dampening occurs for all the ripples and begins in the first frame after the
Life is over. Ripples disappear over Damping frames.
Position
X, Y
Coordinates of the center of the waves, in the object’s local coordinates.
Falloff
Controls how fast the waves fade out as they travel away from the coordinates above (or those of
the Start Position Object).
Start Position Object
Use another object as the reference for the starting position of the wave. Note that you then can animate
this object’s position, to change the wave’s origin across time.
Vertex Group
For meshes only. A vertex group name, used to control the parts of the mesh affected by the wave effect,
and to what extent (using vertex weights).
Texture
Use this texture to control the object’s displacement level. Animated textures can give very interesting
results here.
Texture Coordinates
This menu lets you choose the texture’s coordinates for displacement:
Local
Object’s local coordinates.
Global
Global coordinates.
Object
Adds an additional field just below, to type in the name of the object from which to get the texture
coordinates.
UV
Adds an extra UV Layer property, to select the UV layer to be used.
Speed
The speed, in BU (for “Bforartists Units”) per frame, of the ripple.
Height
The height or amplitude, in BU, of the ripple.
Width
Half of the width, in BU, between the tops of two subsequent ripples (if Cyclic is enabled). This has an
indirect effect on the ripple amplitude - if the pulses are too near to each other, the wave may not reach
the 0 Z-position, so in this case Bforartists actually lowers the whole wave so that the minimum is zero
and, consequently, the maximum is lower than the expected amplitude. See Technical Details and Hints
below.
Narrowness
The actual width of each pulse: the higher the value the narrower the pulse. The actual width of the area
in which the single pulse is apparent is given by 4/Narrowness. That is, if Narrowness is 1 the pulse
is 4 units wide, and if Narrowness is 4 the pulse is 1 unit wide.
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Warning
All the values described above must be multiplied with the corresponding Scale values of the object to get the
real dimensions.

Technical Details and Hints
The relationship of the above values is described here:

Wave front characteristics.

To obtain a nice wave effect similar to sea waves and close to a sinusoidal wave, make the distance between
following ripples and the ripple width equal; that is, the Narrowness value must be equal to 2/Width. E.g. for
Width = 1, set Narrow to 2.

Explode Modifier
The Explode Modifier is used to alter the mesh geometry by moving/rotating its faces in a way that roughly
tracks particles particles emitted by that object, making it look as if the mesh is being exploded (broken apart
and pushed outward).
For the Explode Modifier to have a visible effect, there needs to be particle system on it. The particle system on
the mesh is what controls how the mesh will be exploded, and therefore without the particle system the mesh
won’t appear to alter.
Both the number of emitted particles and number of faces determine how granular the Explode Modifier will
be. More faces and more particles will mean more individual pieces.
Here is a demo video showing a cube with a particle system and Explode Modifier. (Blend file)
Note
117

Bforartists Reference Manual - © Copyright - This page is under OCL license

The Explode modifier must come after the Particle System Modifier because the Particle System Modifier has
the information needed to drive the Explode Modifier.

Options

Explode Modifier panel with Particle System Modifier above it

Vertex group
Vertices in this group may not be affected by the Explode Modifier. Vertices with full weight are not
affected at all, while vertices with less weight have a higher chance of being affected.
Vertices with no weight will be treated like those which do not belong to the group at all and explode
normally.
Protect
Clean vertex group edges. Depending on the weights assigned to that vertex group; either completely
protect those faces from being affected by the Explode Modifier (which would happen if the faces had a
weight value of 1) or completely remove protection from those faces (which would happen if the faces
had a weight value 0).
Particle UV
UV map to change with particle age.
Cut Edges
Cut face edges for nicer shrapnel
Unborn
Show mesh when particles are unborn
Alive
Show mesh when particles are alive
Dead
Show mesh when particles are dead
Size
Use particle size for shrapnel
Refresh
Refresh data in the explode modifier
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Ocean Simulation
Bforartists’s ocean simulation tools take the form of a modifier, to simulate and generate a deforming ocean
surface, and associated texture, used to render the simulation data.
Ported from the open source Houdini Ocean Toolkit, it is intended to simulate deep ocean waves and foam.

Options

Ocean Modifier Panel

Geometry Options
Geometry
Generate
Creates a tiled mesh grid that exactly corresponds with the resolution of the simulation data
When generating a mesh surface, the existing mesh object is completely overridden with the ocean
grid. A UV channel is also added, mapping the 0.0 - 1.0 UV space to the simulation grid.
Displace
Uses the existing geometry rather than replacing it. Vertices are displaced along the local Z-axis.
Repeat X, Repeat Y
When generating a mesh surface, controls the number of times the grid is tiled in X and Y directions. UVs
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for these tiled mesh areas continue outside of the 0.0 - 1.0 UV space.

Simulator Options
Time
The time at which the ocean surface is being evaluated. To make an animated ocean, you will need to
insert keyframes (RMB) and animate this time value - the speed that the time value is changing will
determine the speed of the wave animation
Depth
The constant depth of the ocean floor under the simulated area. Lower values simulate shallower waters
by producing higher frequency details and smaller waves.
Random Seed
A different seed will produce a different simulation result.
Resolution
The main control of quality vs speed in the simulation engine. This determines the resolution of the
internal 2D grids generated by the simulation.
The internal grids are powers of two of the resolution value, so a resolution value of 16 will create
simulation data of size 256 x 256. The higher the resolution, the more detail will be produced, but the
slower it will be to calculate.
Note
When using the ‘Generate’ modifier geometry option, this resolution value also determines the resolution
of the generated mesh surface, equal to the resolution of the internal simulation data.

Size
A simple scaling factor that does not affect the height of the waves or behavior of the simulation.
Spatial Size
The width of the ocean surface area being simulated, in meters. This also determines the size of the
generated mesh, or the displaced area, in Bforartists units. Of course you can scale the object with ocean
modifier in object mode to tweak the apparent size in your scene.

Wave Options
Choppiness
The choppiness of the wave peaks. With a choppiness of 0, the ocean surface is only displaced up and
down in the Z direction, but with higher choppiness, the waves are also displaced laterally in X and Y, to
create sharper wave peaks.
Scale
An overall scale control for the amplitude of the waves. It approximates the height or depth of the waves
above or below zero. Rather than just scaling the ocean object in Z, it scales all aspects of the simulation,
displacement in X and Y, and corresponding foam and normals too.
Alignment
The directionality of the wave shapes due to wind. At a value of 0, the wind and waves are randomly,
uniformly oriented. With higher Alignment values, the wind is blowing in a more constant direction,
making the waves appear more compressed and aligned to a single direction.
Direction
When using Alignment, the direction in degrees that the waves are aligned to.
Damping
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When using Alignment, amount that inter-reflected waves are damped out. This has the effect of making
the wave motion more directional (not just the wave shape). With damping of 0.0, waves are reflected off
each other every direction, with damping of 1.0, these inter-reflected waves are damped out, leaving only
waves traveling in the direction of the wind.
Smallest Wave
A minimum limit for the size of generated waves. Acts similarly to a low-pass filter, removing higher
frequency wave detail.
Wind Velocity
Wind speed in meters/second. With a low velocity, waves are restricted to smaller surface waves.

Simulation Data Generation Options

Using foam vertex colors with a named data layer

By default, the simulator only generates displacement data, since it takes the least amount of work and gives the
fastest feedback. Additional simulation data can be generated for rendering as well.
Generate Normals
Simulates additional normal map data. This can be used by the Ocean texture, when mapped to Normals,
as a bump map, and enables generating normal map image sequences when baking.
Generate Foam
Simulates additional foam data. This can be retrieved by the Ocean texture for use in texturing (perhaps
as a mask), and enables generating foam map image sequences when baking.
Coverage
Tweaks the amount of foam covering the waves, negative values will reduce the amount of foam (leaving
only the topmost peaks), positive values will add it. Typically ranges from -1.0 to 1.0
Foam Data Layer Name
Optional name for the vertex data layer, used by the Ocean modifier to store foam maps as vertex colors.
This is required for accessing the foam data in the renderer.

Baking
Rather than simulating the ocean data live, the ocean data can be baked to disk. When a simulation is baked, the
simulator engine is completely bypassed, and the modifier/texture retrieves all information from the baked files.
Baking can be advantageous for a few reasons:
• It’s faster to use the stored data rather than re-calculating it
• Allows rendering ocean data in external renderers
• Enables more advanced foam maps
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Data Files
Simulation data is stored in disk as sequences of OpenEXR image maps, one for each of displacement, normal
and foam (if enabled to be generated). Upon loading the data from these baked files, when a frame of the bake
sequence is read from disk, it is cached in memory. This means that accessing loaded frames subsequent times
is fast, not incurring the overhead of disk access.
Since these baked files are plain OpenEXRs, they can also be opened and rendered in any other application or
renderer that supports them.

Baking Foam
Baking also provides improved foam capabilities. When simulating live, the ocean simulator retrieves data for
that current frame only. In the case of the foam map, this represents the tips of wave crests for that given frame.
In reality, after foam is created by wave interactions, it remains sitting on the top of the wave surface for a
while, as it dissipates. With baking, it’s possible to approximate that behaviour, by accumulating foam from
previous frames, leaving it remaining on the surface.
https://vimeo.com/17517981

Baking Options
Start, End
Frames of the simulation to bake (inclusive). The start and end frames of the bake are repeated when
accessing frames outside the baked range.
Cache Path
Folder to store the baked EXR files in. The sequences will be in the form disp_####.exr,
normal_####.exr, and foam_####.exr where #### is the four digit frame number. If the cache
path folder does not exist, it will be created.

Simulation Internals
The simulator itself uses FFT methods to generate 2D grids of simulation information internally, very similar to
2D texture maps. The simulator can generate three types of data - displacement, normals, and extra data that is
used to calculate wave crest intersections (i.e. foam). After simulation, these maps are used to displace the
ocean surface geometry in 3D, and also can be used for shading via the Ocean texture. The internal simulation
engine is multi threaded with OpenMP to take advantage of multiple cores.

Particle Instance Modifier
When a ParticleInstance modifier is added to an object, that object will be used as a particle shape on an object
which has a particle system associated with it. This means that to use this modifier you must also have another
object which has a particle system on it, otherwise the ParticleInstance modifier will appear to do nothing.
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Particle system on left has no ParticleInstance modified object associated with it. The one on the right is associated with
cube shown by using a ParticleInstance modifier on the cube.

Options

Particle Instance Modifier

Because of the co-dependant way in which the ParticleInstance modifier is influenced by the underlying
particle systems on other objects, some of the apparent effects generated by the ParticleInstance modifier can
look and act vastly different, depending on the underlying settings of the particle systems it is associated with.
This is worth taking account of if the ParticleInstance modifier settings don’t appear to be giving the results
expected, as it may indicate that the particle system settings may need altering rather than the ParticleInstance
modifier settings.
Object
The Object field, associates this ParticleInstance modifier with another object (usually an object having a
particle system...). This indicates that when the object named in this field emits particles, those particles
will have the mesh shape of the current ParticleInstance modifier’s mesh. If for example a sphere has a
ParticleInstance modifier added to it, when the Object field of this modifier is filled in with the name of
an object that emits particles, those particle will be sphere shaped. Even though most of the time the
Object field will have the name of an object with a particle system, this is not mandatory, you can enter an
object’s name which does not have a particle system, and it will be accepted by the Object field, as there
do not appear to be any checks made to make sure the object’s name entered into this field is “valid”.
Particle System
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The Particle System field is used to select which particle system number to apply the ParticleInstance
modifier to, when the mesh which has the particle system on it has more than one of these. The Particle
System field can have a value between 1 and 10. It is possible to select any of the ten particle system
numbers, however a check will not be made with the underlying particle emitting object specified
previously in the Object field. If you select a particle system number which does not exist on the particle
emitting object, then the particles on the emitting mesh will keep their normal particle shapes - no
warning will be given that the chosen particle system does not exist on a particular particle emitting mesh.
As an example, below is a single plane mesh with two areas (the first area shown in red and the second in
white), with different particle systems applied to each area. The left side using a ParticleInstance
modifier which has the shape of a sphere and the right side having a ParticleInstance modifier which has
the shape of a cube.

Render showing a single Plain mesh object assigned to two different vertex groups and each of those vertex groups is
assigned a separate and independent particle system, with each particle system being assigned a different ParticleInstance
modifier. In the case shown the ParticleInstance modifiers are a sphere and a cube. Example Blend file

Creation
Normal
When selected, the Normal button tells the ParticleInstance modifier to draw instances of itself wherever
normal particle types are emitted from the underlying particle system. So if the current ParticleInstance
modifier is a sphere shape, when normal particles are emitted they will be spheres.
Children
When selected, the Children button tells the ParticleInstance modifier to draw instances of itself
wherever children/child particles are emitted/used on the underlying particle system. So if the current
ParticleInstance modifier is a sphere shape, when children/child particles are emitted they will be
spheres.
Size
Scale the instanced objects by the particle size attribute. When this is disabled, all the copies appear the
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same size as the origin.

Display
Unborn
When selected, the Unborn button tells the ParticleInstance modifier to draw instances of itself wherever
unborn particles will be emitted/used on the underlying particle system. So if the current ParticleInstance
modifier is a sphere shape, when unborn particles are present they will be spheres.
Alive
When selected, the Alive button tells the ParticleInstance modifier to draw instances of itself wherever
alive particles will be emitted/used on the underlying particle system. So if the current ParticleInstance
modifier is a sphere shape, when alive particles are present they will be spheres.
Dead
When selected, the Dead button tells the ParticleInstance modifier to draw instances of itself wherever
dead particles will occur on the underlying particle system. So if the current ParticleInstance modifier is a
sphere shape, when dead particles are present they will be spheres.

Using Paths
Create Along Paths
This option tries to make the underlying mesh object of the Particle Instance modifier deform its mesh
shape in such a way as to try and match the path traveled by the particles/hair strands of the system
associated with it. For example, below is a screen shot showing the path of a single keyed particle as it
travels its way through each of the different way points 1 to 4 (target particle systems), when it reaches
way point 4 the particle dies and ends its journey.
X,Y,X Rotation Axis
Specify which pole axis to use for the rotation.
Keep Shape
Enabling this prevents the object from being deformed. It instead simply aligns to the end of the path at
the object’s center.
Position
Specify what percentage of the path the object fills. You could create a growing effect by animating this
value over time.
Random
Scales the position value of each instance a random value.
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Keyed particle following way points (showing one particle). Example Blend file

When a ParticleInstance modifier is added to a cylinder object and then associated with the way point particle
system, the particle position is copied by the cylinder and placed at the particles position. So the mesh object
follows the location of the particle. The cylinder does not alter any of its other properties when following the
particle, only the cylinders location gets altered, shape and rotation do not get altered. See screenshot below:

Keyed particle following way points showing a mesh object (ParticleInstance modifier) in place of the original particle.
Example Blend file

Both of the above examples had the ParticleInstance modifier Path button deactivated. When the Path button is
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activated the effect can be seen in the screenshot below:

Keyed particle following way points showing a mesh object (ParticleInstance modifier) in place of the original particle, that is
also being deformed to fit the travel path of the original particle. Example Blend file

Instead of the cylinder location just following the position of the particle (and not altering its shape), the
cylinder tries to fit its mesh to the shape of the path followed by the particle. The mesh geometry of the object
which is trying to deform can have an impact on how well the deformation is carried out. In the case of the
cylinder, it has many loop cuts along its length so that it can bend at those points to deform along the particle
path. For example here is the same scene with the number of loop cuts along the length of the cylinder reduced,
showing the effect on the deformation of the cylinder along the particle path.

The cylinder has most of its edge loops so most of the path

The cylinder has some of its edge loops removed so the path

deform is very regular apart from at the very end of the curve. of the deform starts to become less regular.
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Now the deform path is very rough.

At this point there aren’t any vertices to bend the cylinder to
follow the path, and instead the cylinder just goes directly to
the last way point 4.

Once all the extra edge loops around cylinder are removed so that there is only the top and bottom vertices left,
meaning that the cylinder doesn’t have enough geometry to bend, in that case it cannot follow the path of the
particle, so it just goes from the start way point 1 to the ending way point 4. The ParticleInstance modifier
Path button works for hair (strand) particles as well as with keyed particles. In this case the mesh of the
ParticleInstance modifier will follow the length and profile of the hair strands paths. Below is a screenshot
showing the effect of the Path button on hair:

Strand with a ParticleInstance modifier associated with it and deforming the cylinder along the hair profile. Example Blend file

Note
Strands when they are generated instantly die when created so for the Path button to be of any use, you must
also have the Dead button activated. Otherwise the path a mesh took will not be visible!
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See also
Particles
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TODO.

Painting

TODO.

Texture Paint
A UV Texture is a picture (image, sequence or movie) that is used to color the surface of a mesh. The UV
Texture is mapped to the mesh through one or more UV maps. There are three ways to establish the image used
by the UV Texture:
• Paint a flat image in the UV/Image Editor onto the currently selected UV Texture, using its UV map to
transfer the colors to the faces of the mesh.
• Paint the mesh in the 3D View, and let Bforartists use the currently selected UV map to update the UV
Texture (see Projection Painting).
• Use any image-editing (paint) program to create an image. In the UV/Image Editor, select the UV
Texture and load the image. Bforartists will then use that texture’s UV map to transfer the colors to the
faces of the mesh
Bforartists features a built-in paint mode called Texture Paint which is designed specifically to help you edit
your UV Textures and images quickly and easily in either the UV/Image Editor window or the 3D View
window. Since a UV Texture is just a special-purpose image, you can also use any external paint program. For
example, GIMP is a full-featured image manipulation program that is also open-source.
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Texture painting in Bforartists

Since a mesh can have layers of UV Textures, there may be many images that color the mesh. However, each
UV Texture only has one image.
Texture Paint works in both a 3D window and the UV/Image Editor window. In the 3D window in Texture Paint
mode, you paint directly on the mesh by projecting onto the UVs.

Getting Started
Once you have unwrapped your model to a UV Map (as explained in previous pages), you can begin the
texturing process. You cannot paint on a mesh in Texture Paint mode without first unwrapping your mesh, and
doing one of the following steps. Either:
See: Applying Textures.
After you have done one of these two things, you can modify the image using the Texture Paint mode:

Enabling paint mode

• In the 3D View window, select Texture Paint mode from the mode selector in the window header, and
you can paint directly onto the mesh.
• In the UV/Image Editor window, switch the editing context from View to Paint (shown to the right).
Note
Square Power of 2
Texture paint is very fast and responsive when working in the 3D window and when your image is sized as a
square where the side lengths are a power of two, e.g. 256x256, 512x512, 1024x1024, etc.

Once you enable Texture Painting, your mouse becomes a brush. To work with the UV layout (for example, to
move coordinates) you must go back to “View” mode.
As soon as you enable Texture Painting or switch to Texture Paint mode, brush settings become available in the
Toolbar Panel (T-key).
In the UV/Image Editor window, you paint on a flat canvas that is wrapped around the mesh using UV
coordinates. Any changes made in the UV/Image Editor window show up immediately in the 3D window, and
vice versa.
A full complement of brushes and colors can be selected from the Properties panel in the UV/Image Editor.
Brush changes made in either panel are immediately reflected in the other panel. However, the modified texture
will not be saved automatically; you must explicitly do so by Image–>Save in the UV/Image Editor window.
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Texture Preview
If your texture is already used to color, bump map, displace, alpha-transparent, etc., a surface of a model in your
scene (in other techie words, is mapped to some aspect of a texture via a texture channel using UV as a map
input), you can see the effects of your painting in the context of your scene as you paint.
To do this, set up side-by-side windows, one window in 3D View set to Textured display mode, and the second
UV/Image Editor window loaded with your image. Position the 3D View to show the object that is UV mapped
to the loaded image. Open a Preview window (see 3D View Options for more info) and position it over the
object. In the image to the right, the texture being painted is mapped to the “Normal” attribute, and is called
“bump mapping”, where the gray-scale image is used to make the flat surface appear bumpy. See Texture
Mapping Output for more information on bump mapping.

Brushes Settings
Press T in the UV/Image Editor to show the Toolbar panel. With this panel, you can create many brushes, each
with unique settings (such as color and width). Use the Brush selector to switch between brushes, or to create a
new brush. When you add a brush, the new brush is a clone of the current one. You can then change the setting
for the new brush. Texture paint has an unlimited number of brushes and unique user-defined controls for those
brushes which can be set in the Paint Tool panel.
To use a brush, click on its name. Use the selector up/down arrow, if there are more brushes on the flyout
window than can be displayed at once. Name your brush by clicking on the name field and entering any name
you wish, such as “Red Air” for a red airbrush. To toss out a brush, click the brush delete X button next to its
name. If you want to keep this brush around for the next time you run Bforartists, click the Fake user button (F)
next to the brush delete (X) button.
If you have a tablet pen with pressure sensitivity, toggle the small “P” button next to the opacity, size, falloff
and spacing buttons to control these parameters using the pressure of the pen. Using your pen’s eraser end will
toggle on the Erase Alpha mode.
Press S on any part of the image to sample that color and set it as the brush color.
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Brush

Brush Settings

Brush presets
Select a preset brush. Most brushes have common settings.

Types of brushes
There are four different types of brushes
Draw
the normal brush; paints a swath of color
Soften
blends edges between two colors
Smear
when you click, takes the colors under the cursor, and blends them in the direction you move the
mouse. Similar to the “smudge” tool of Gimp.
Clone
copies the colors from the image specified (Tex.Dirt in the example), to the active image. The
background image is shown when this brush is selected; use the B lend slider to control how
prominent the background image is.
Enable Pressure Sensitivity
The icon to the right of the following three settings will enable or disable tablet pressure sensitivity to
control how strong the effect is.
Color
The color of the brush
Radius
The radius of the brush in pixels
Strength
How powerful the brush is when applied}}
Blend
Set the way the paint is applied over the underlying texture
• Mix: the brush color is mixed in with existing colors
• Add: the brush color is added to the existing color; green added to red gives yellow.
6
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• Subtract: the brush color is subtracted; painting blue on purple gives red
• Multiply: the RGB value of the base is multiplied by the brush color
• Lighten: the RGB value of the base color is increased by the brush color
• Darken: tones down the colors
• Erase Alpha: makes the image transparent where painted, allowing background colors and lower-level
textures to show through. As you ‘paint’, the false checkerboard background will be revealed
• Add Alpha: makes the image more opaque where painted
In order to see the effects of the Erase and Add Alpha mix modes in the UV/Image Editor,
you must enable the alpha channel display by clicking the Display Alpha or the Alpha-Only
button. Transparent (no alpha) areas will then show a checkered background.
Image
When using the clone brush, this allows you to select an image as a clone source.
Alpha
Opacity of the clone image display

Texture

Texture options and example

Use the texture selector at the bottom of the paint panel to select a pre-loaded image or procedural texture to use
as your brush pattern. Note that in order to use it, you must have a placeholder material defined, and that
particular texture defined using the Material and Texture buttons. It is not necessary to have that material or
texture applied to any mesh anywhere; it must only be defined. The example to the right shows the effects of
painting with a flat (banded) wood texture. Switching the texture to Rings makes a target/flower type of brush
painting pattern.
Note
In Clone paint mode, this field changes to indicate the picture image or texture that you are cloning from.

Brush Mapping
Sets how the texture is applied to the brush
View Plane
In 2D painting, the texture moves with the brush
Tiled
The texture is offset by the brush location
7
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3D
Same as tiled mode
Stencil
Texture is applied only in borders of the stencil.
Random
Random applying of texture.
Angle
This is the rotation angle of the texture brush. It can be changed interactively via Ctrl-F in the 3D view.
While in the interactive rotation you can enter a value numerically as well. Can be set to:
User
Directly input the angle value.
Rake
Angle follows the direction of the brush stroke. Not available with 3D textures.
Random
Angle is randomized.
Offset
Offset the texture in x, y, and z.
Size
Set the scale of the texture in each axis.

Stroke
Stroke Method
Allows set the way applying strokes.
Airbrush
Flow of the brush continues as long as the mouse click is held, determined by the Rate setting. If
disabled, the brush only modifies the color when the brush changes its location.
Rate
Interval between paints for airbrush
Space
Creates brush stroke as a series of dots, whose spacing is determined by the Spacing setting.
Spacing
Represents the percentage of the brush diameter. Limit brush application to the distance
specified by spacing.
Dots
Apply paint on each mouse move step
Jitter
Jitter the position of the brush while painting
Smooth stroke
Brush lags behind mouse and follows a smoother path. When enabled, the following become active:
Radius
Sets the minimun distance from the last point before stroke continues.
Factor
8
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Sets the amount of smoothing.
Input Samples
Average multiple input samples together to smooth the brush stroke.
Wrap
wraps your paint to the other side of the image as your brush moves off the OTHER side of the canvas
(any side, top/bottom, left/right). Very handy for making seamless textures.

Curve
The paint curve allows you to control the falloff of the brush. Changing the shape of the curve will make the
brush softer or harder.
Note
• Read more about using the Curve Widget.

Paint options
Overlay
Allows you to customize the display of curve and texture that applied to the brush.

Appearance
Allows you to customize the color of the brush radius outline, as well as specify a custom icon.

Saving
If the header menu item Image has an asterisk next to it, it means that the image has been changed, but not
saved. Use the Image–>Save Image option to save your work with a different name or overwrite the original
image.
Note
UV Textures
Since images used as UV Textures are functionally different from other images, you should keep them in a
directory separate from other images.

The image format for saving is independent of the format for rendering. The format for saving a UV image is
selected in the header of the Save Image window, and defaults to PNG (.png).
If Packing is enabled in the window header, or if you manually Image–>Pack Image, saving your images to a
separate file is not necessary.

Using an External Image Editor
If you use an external program to edit your UV Texture, you must:
• run that paint program (GIMP, Photoshop, etc.)
9
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•
•
•
•

load the image or create a new one
change the image, and
re-save it within that program.
Back in Bforartists, you reload the image in the UV/Image Editor window.

You want to use an external program if you have teams of people using different programs that are developing
the UV textures, or if you want to apply any special effects that Texture Paint does not feature, or if you are
much more familiar with your favorite paint program.

Known Limitations
UV Overlap
In general overlapping UVs aren’t supported (as with texture baking).
However this is only a problem when a single brush stroke paints onto multiple faces that share a texture.

Perspective View & Faces Behind the View
When painting onto a face which is partially behind the view (in perspective mode), the face can’t be painted
on. To avoid, this zoom out or use an Ortho mode viewport.

Perspective View & Low Poly
When painting onto a face in perspective mode onto a low poly object with normals pointing away from the
view, painting may fail; to workaround disable the Normal option in the paint panel.
Typically this happens when painting onto the side of a cube

Vertex Paint
• Introduction
• Settings
• Options

Introduction
Vertex Painting is a simple way of painting color onto an object, by directly manipulating the color of vertices,
rather than textures, and is fairly straightforward.
When a vertex is painted, the color of the vertex is modified according to the rules of the ‘brush’. The color of
all visible planes and edges attached to the vertex are then modified with a gradient to the color of the other
connected vertices. (Note that the color of non-visible faces are not modified).
Vertex colors can be painted by first going into Edit Mode, then switching to Vertex Paint Mode; however, it
will not show up in the render unless you check “Vertex Color Paint” in the Materials Options Panel.
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Vertex Painting Mode

Check this box

Settings
The Tools Shelf, shortcut T contains most of the options for vertex painting. The following sections describe the
controls in each of the available panels.
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Settings for vertex painting

Brush
Brush Data-Block
The image, name panel and color selector at the top allows you to select brush presets, rename brushes, as
well as add custom brushes, and delete them.
Radius
Set the radius of the brush
Strength
Set the strength of the brush’s effect.

Mix overlay with full strength

Blend menu
Mix
Mixes RGB values. When set to a strength of 1.0, it will cover the underlying “paint”.
Add
Adds RGB values. Will eventually turn the entire object white as RGB values accumulate to
1.0-1.0-1.0: Pure White.
Subtract
Subtracts RGB values. Usually results in Black.
Multiply
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Multiplies brush colors by the vertex colors.
Blur
Blurs vertex colors.
Lighten
Lightens the color of the vertices.

Subtract with full strength

Darken
Darkens the color of the vertices.

Texture
Use the texture selector at the bottom of the paint panel to select a pre-loaded image or procedural texture to use
as your brush pattern. Note that in order to use it, you must have a placeholder material defined, and that
particular texture defined using the Material and Texture buttons. It is not necessary to have that material or
texture applied to any mesh anywhere; it must only be defined.
Brush Mapping Mode
Sets how the texture is applied to the brush
View Plane
In 2D painting, the texture moves with the brush
14
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Tiled
The texture is offset by the brush location
3D
Same as tiled mode
Stencil
Texture is applied only in borders of the stencil.
Random
Random applying of texture.
Angle
This is the rotation angle of the texture brush. It can be changed interactively via Ctrl-F in the 3D view.
While in the interactive rotation you can enter a value numerically as well. Can be set to:
User
Directly input the angle value.
Rake
Angle follows the direction of the brush stroke. Not available with 3D textures.
Random
Angle is randomized.
Offset
Offset the texture in x, y, and z.
Size
Set the scale of the texture in each axis.

Stroke
Stroke Method
Allows set the way applying strokes.
Airbrush
Flow of the brush continues as long as the mouse click is held, determined by the Rate setting. If
disabled, the brush only modifies the color when the brush changes its location.
Rate
Interval between paints for airbrush
Space
Creates brush stroke as a series of dots, whose spacing is determined by the Spacing setting.
Spacing
Represents the percentage of the brush diameter. Limit brush application to the distance
specified by spacing.
Dots
Apply paint on each mouse move step
Jitter
Jitter the position of the brush while painting
Smooth stroke
Brush lags behind mouse and follows a smoother path. When enabled, the following become active:
Radius
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Sets the minimun distance from the last point before stroke continues.
Factor
Sets the amount of smoothing.
Input Samples
Average multiple input samples together to smooth the brush stroke.

Various brush curves

Curve
Brush Curves affect how strongly the color is applied depending on distance from the center of the brush. In
other words, they allow you to edit the Falloff of the brush intensity.
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Options

Options for vertex painting

Overlay
Allows you to customize the display of curve and texture that applied to the brush.

Appearance
Allows you to customize the color of the brush radius outline, as well as specify a custom icon.

Options
Normals
Applies the Vertex Normal before painting. This does not usually affect painting.
Spray
Continues painting for as long as the mouse is held.
Unified Settings
Size
All brushes use the same size.
Strength
All brushes use the same strength.

Weight Paint
Vertex Groups can potentially have a very large number of associated vertices and thus a large number of
weights (one weight per assigned vertex). Weight Painting is a method to maintain large amounts of weight
17
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information in a very intuitive way. It is primarily used for rigging meshes, where the vertex groups are used to
define the relative bone influences on the mesh. But we use it also for controlling particle emission, hair
density, many modifiers, shape keys, etc.
The basic principle of the method is: the weight information is literally painted on top of the Mesh body by
using a set of Weight brushes. And since painting is always associated with color, we also need to define ...

Weight Paint in a nutshell

Weight Painted Vertex Group

• You enter Weight Paint mode from the Mode Menu (Ctrl-Tab). The selected Mesh Object is
displayed slightly shaded with a rainbow color spectrum.
• The color visualizes the weights associated to each vertex in the active Vertex Group. Blue means
unweighted; Red means fully weighted.
• You can customize the colors in the weight gradient by enabling Custom Weight Paint Range in the
System tab of the User Preferences.
• You assign weights to the vertices of the Object by painting on it with weight brushes. Starting to paint
on a mesh automatically adds weights to the active Vertex Group (a new Vertex Group is created if
needed).

The weighting Color Code
Weights are visualized by using a cold/hot color system, such that areas of low influence (with weights close to
0.0) are drawn in blue (cold) and areas of high influence (with weights close to 1.0) are drawn in red (hot). And
all in-between influences are drawn in rainbow colors, depending on their value (blue, green, yellow, orange,
red)

Image 3: The color spectrum and their respective weights.

In addition to the above described color code, Bforartists has added (as an option) a special visual notation for
unreferenced vertices: They are drawn in black. Thus you can see the referenced areas (drawn in cold/hot
colors) and the unreferenced areas (in black) at the same time. This is most practical when you look for
weighting errors (we will get back to this later).
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Brushes

The Brush panel in the Tool Shelf

Painting needs paint brushes and Bforartists provides a Brush Panel within the Tool Shelf when it operates in
Weight Paint Mode. You find predefined Brush Presets when you click on the large Brush Icon at the top of the
brush Panel. And you can make your own presets as needed. See below for the available brush presets and to
create custom presets.

The main brush properties
The most important and frequently modified properties are:
Weight
The weight (color) to be used by the brush. However, the weight value is applied to the Vertex Group in
different ways depending on the selected Brush Blending mode (see below).
Strength
This is the amount of paint to be applied per brush stroke. What that means exactly also depends on the
Brush Blending mode.
Radius
The radius defines the area of influence of the brush.
Note
You can also change the Brush radius with a keyboard shortcut while painting. Just press F at any time,
then drag the mouse to increase/reduce the brush radius. Finally click LMB to use the new setting. Or
press the Esc key at any time to return to the current settings.
Blend mode
The brush Blending mode defines in which way the weight value is applied to the Vertex Group while
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painting.
Mix
In this Blend mode the Weight value defines the target weight that will eventually be reached when
you paint long enough on the same location of the mesh. And the strength determines how many
strokes you need to arrive at the target weight. Note that for strength = 1.0 the target weight is
painted immediately, and for Weight = 0.0 the brush just does nothing.
Add
In this blend mode the specified weight value is added to the vertex weights. The strength
determines which fraction of the weight gets added per stroke. However, the brush will not paint
weight values above 1.0.
Subtract
In this blend mode the specified weight is subtracted from the vertex weights. The strength
determines which fraction of the weight gets removed per stroke. However the brush will not paint
weight values below 0.0.
Lighten
In this blend mode the specified weight value is interpreted as the target weight very similar to the
Mix Blend mode. But only weights below the target weight are affected. Weights above the target
weight remain unchanged.
Darken
This Blend mode is very similar to the Lighten Blend mode. But only weights above the target
weight are affected. Weights below the target weight remain unchanged.
Multiply
Multiplies the vertex weights with the specified weight value. This is somewhat like subtract, but
the amount of removed weight is now dependent on the Weight value itself.
Blur
tries to smooth out the weighting of adjacent vertices. In this mode the Weight Value is ignored. The
strength defines how effectively the blur is applied.

Normalize Options
Bforartists also provides Options regarding the automatic normalizing of all affected Vertex groups:
Auto Normalize
Ensures that all deforming vertex groups add up to 1 while painting. When this option is turned off, then
all weights of a vertex can have any value between 0.0 and 1.0. However, when Vertex Groups are used as
Deform Groups for character animation then Bforartists always interprets the weight values relative to
each other. That is, Bforartists always does a normalization over all deform bones. Hence in practice it is
not necessary to maintain a strict normalization and further normalizing weights should not affect
animation at all.
This option works most intuitively when used to maintain normalization while painting on top of weights
that are already normalized with some other tool.
Multi-Paint
Paint on all selected Vertex Groups simultaneously, in a way that preserves their relative influence. This
can be useful when tweaking weights in an area that is affected by more than 3 bones at once, e.g. certain
areas on a character’s face.
This option is only useful in the context of Armatures, where you can select multiple Vertex Groups by
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selecting multiple Pose bones. Once at least two Vertex Groups are selected, viewport colors and paint
logic switch to Multi-Paint mode, using the sum of the selected groups’ weights if Auto Normalize is
enabled, and the average otherwise. Any paint operations aimed at this collective weight are applied to
individual Vertex Group weights in such way that their ratio stays the same.
Since the ratio is undefined if all weights are zero, Multi-Paint can’t operate on vertices that don’t have
any weight assigned to the relevant Vertex Groups. For this reason it also doesn’t allow reducing the
weight all the way to zero. When used with X-Mirror, it only guarantees completely symmetrical result if
weights are initially symmetrical.

The Brush stroke definition

Stroke Panel

Stroke Method
Airbrush
Keep applying paint effect while holding mouse down (spray)
Space
Limit brush application to the distance specified by spacing (see below)
Dots
Apply paint on each mouse move step
Rate (only for Airbrush)
Interval between paints for airbrush
Spacing (only for Space)
Limit brush application to the distance specified by spacing
Jitter
Jitter the position of the brush while painting
Smooth Stroke
Brush lags behind mouse and follows a smoother path
Radius
Minimum distance from last point before stroke continues
Factor
Higher values give a smoother stroke
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The brush Falloff curve

Curve Panel

The brush falloff editor allows you to specify the characteristics of your brushes to a large extent. The usage
should be obvious and intuitive.

The brush appearance

Brush appearance

Show Brush
makes the brush visible as a circle (on by default)
Color setter
To define the color of the brush circle
Custom icon
Allows definition of a custom brush icon

Brush presets
Bforartists provides several Brush presets:
• Mix, Draw, Brush : uses the Mix Blending mode to draw the brush weight with varying strength and
brush falloff
• Add : uses the Add Blending mode
• Subtract : uses the Subtract Blending mode
• Lighten : uses the Lighten Blending mode
• Darken : uses the Darken Blending mode
• Multiply :uses the Multiply Blending mode
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• Blur : uses the Blur Blending mode

Customizing brush color space

Customizing the Color Band

Bforartists allows customization of the color range used for the Weight Paint colors. You can define the color
band as you like; for example, you can make it purely black/white if you prefer, you can even use alpha values
here.
You find the customizer in the User Properties section, in the System Tab.

Selection Masking
If you have a complex mesh, it is sometimes not easy to paint on all vertices in Weight Paint mode. Suppose
you only want to paint on a small area of the Mesh and keep the rest untouched. This is where selection
masking comes into play. When this mode is enabled, a brush will only paint on the selected verts or faces. The
option is available from the footer menu bar of the 3D viewport (see icons surrounded by the yellow frame):

You can choose between Face Selection masking (left icon) and Vertex selection masking (right icon).
Select mode has some advantages over the default Weight Paint mode:
• The original mesh edges are drawn, even when modifiers are active.
• You can select faces to restrict painting to the vertices of the selected faces.
• Selecting tools include:

Details about selecting
The following standard selection operations are supported:
•
•
•
•
•
•
•

RMB - Single faces. Use Shift-RMB to select multiple.
A - All faces, also to de-select.
B - Block/Box selection.
C - Select with brush.
L - Pick linked (under the mouse cursor).
Ctrl-L - Select linked.
Ctrl-I - Invert selection (Inverse).
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Tip
Selecting Deform Groups
When you are doing weight painting for deform bones (with an Armature), you can select a deform group by
selecting the corresponding bone. However, this Vertex Group selection mode is disabled when Selection
Masking is active!

Vertex Selection Masking

Vertex Selection masking

In this mode you can select one or more vertices and then paint only on the selection. All unselected vertices are
protected from unintentional changes.

Face Selection Masking

Face Selection masking
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hidden faces

The Face Selection masking allows you to select faces and limit the weight paint tool to those faces, very
similar to Vertex selection masking.

Hide/Unhide Faces
You also can hide selected faces as in Edit Mode, then paint on the remaining visible faces and finally unhide
the hidden faces again

Hide/Unhide Vertices
You cannot directly hide selected faces in vertex mask selection mode. However you can use a trick:
• First go to Face selection mask mode
• Select the areas you want to hide and then hide the faces (as explained above)
• Switch back to Vertex Selection mask mode
Now the verts belonging to the hidden Faces will remain hidden.

The Clipping Border
To constrain the paint area further you can use the Clipping Border. The selected area will be “cut out” as the
area of interest. The rest of the 3D window gets hidden.
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The Clipping Border is used to select interesting parts for local painting

You make the entire mesh visible again by calling the Clipping Border tool again. It's a toggle.
All weight paint tools that use the view respect this clipping, including border select, weight gradient and of
course brush strokes.

Weight Paint Options

Weight Paint Options

The Weight Paint Options modify the overall brush behavior:
Normals
The vertex normal (helps) determine the extent of painting. This causes an effect as if painting with light.
Spray
This option accumulates weights on every mouse move.
Restrict
This option limits the influence of painting to vertices belonging (even with weight 0) to the selected
vertex group.
X-mirror
Use the X-mirror option for mirrored painting on groups that have symmetrical names, like with
extension .R / .L, or _R / _L. If a group has no mirrored counterpart, it will paint symmetrically on the
active group itself. You can read more about the naming convention in Editing Armatures: Naming
conventions. The convention for armatures/bones apply here as well.
Topology Mirror
Use topology-based mirroring, for when both side of a mesh have matching mirrored topology.
Input Samples
not so sure
Show Zero Weights
• None
• Active
• All
Unified Settings: The Size, Strength and Weight of the brush can be set to be shared across different brushes, as
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opposed to per-brush.
• Spray: to constantly draw (opposed to drawing one stroke per mouse click).
• Restrict: to only paint on vertices which already are weighted in the active weight group. (No new
weights are created; only existing weights are modified.)
• x-mirror: to draw symmetrically. Note the this only works when the character symmetry plane is z-y
(character looks into y direction).
• Show Zero weights: To display unreferenced and zero weighted areas in black (by default).

Weight Paint Tools

Weight Paint Tools

Bforartists provides a set of helper tools for Weight Painting. The tools are located in the weight tools panel.
The weight paint tools are full described in the Weight Paint Tools page

Weight Painting for Bones
This is one of the main uses of weight painting. When a bone moves, vertices around the joint should move as
well, but just a little, to mimic the stretching of the skin around the joint. Use a “light” weight (10-40%) paint
on the vertices around the joint so that they move a little when the bone rotates. While there are ways to
automatically assign weights to an armature (see the Armature section), you can do this manually. To do this
from scratch, refer to the process below. To modify automatically assigned weights, jump into the middle of the
process where noted:
• Create an armature.
• Create a mesh that will be deformed when the armature’s bone(s) move.
• With the mesh selected, create an Armature modifier for your mesh (located in the Editing context,
Modifiers panel). Enter the name of the armature.
Pick up here for modifying automatically assigned weights.
• Select the armature in 3D View, and bring the armature to Pose mode
• Select a desired bone in the armature.
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• Select your mesh (using RMB) and change immediately to Weight Paint mode. The mesh will be colored
according to the weight (degree) that the selected bone movement affects the mesh. Initially, it will be
all blue (no effect).
• Weight paint to your heart’s content. The mesh around the bone itself should be red (generally) and fade
out through the rainbow to blue for vertices farther away from the bone.
You may select a different bone with RMB while weight painting, provided the armature was left in Pose mode
as described above. This will activate the vertex group sharing the name with the selected bone, and display
related weights. If the mesh skins the bones, you will not be able to see the bones because the mesh is painted.
If so, turn on X-Ray view (Buttons window, Editing context, Armature panel).
If you paint on the mesh, a vertex group is created for the bone. If you paint on vertices outside the group, the
painted vertices are automatically added to the vertex group.
If you have a symmetrical mesh and a symmetrical armature you can use the option X-Mirror. Then the
mirrored groups with the mirrored weights are automatically created.

Weight Painting for Particles

Weight painted particle emission.

Faces or vertices with zero weight generate no particles. A weight of 0. 1 will result in 10% of the amounts of
particles. This option “conserves” the total indicated number of particles, adjusting the distributions so that the
proper weights are achieved while using the actual number of particles called for. Use this to make portions of
your mesh hairier than others by weight painting a vertex group, and then calling out the name of the vertex
group in the VGroup: field (Particles panel, Object context).

Weight Tools
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Weight Paint Tools

Bforartists provides a set of helper tools for Weight Painting. The tools are accessible from the Tool Shelf in
Weight Paint mode. And they are located in the weight tools panel.

The Subset Option
Some of the tools also provide a Subset parameter (in the Operator panel, displayed after the tool is called) with
following options:
•
•
•
•

Active Group
Selected Pose Bones
Deform pose Bones
All Groups

All tools also work with Vertex Selection Masking and Face Selection masking. In these modes the tools
operate only on selected verts or faces.
Tip
About the Blend tool
The Blend tool only works when “Vertex selection masking for painting” is enabled. Otherwise the tool button
is grayed out.

Normalize All
For each vertex, this tool makes sure that the sum of the weights across all Vertex Groups is equal to 1. This
tool normalizes all of the vertex groups, except for locked groups, which keep their weight values untouched.
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Operator Parameters

Normalize All Options

Lock Active
Keep the values of the active group while normalizing all the others.
Note
Currently this tool normalizes ALL vertex groups except the locked vertex groups.

Normalize

Normalize All Options

This tool only works on the active Vertex Group. All vertices keep their relative weights, but the entire set of
weights is scaled up such that the highest weight value is 1.0

Mirror

Normalize All Options

This tool mirrors the weights from one side of the mesh to the opposite side (only mirroring along x-axis is
supported). But note, the weights are not transferred to the corresponding opposite bone weight group. The
mirror only takes place within the selected Vertex Group.
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Operator Parameters

Mirror Options

Mirror Weights
Mirrors the weights of the active group to the other side. Note, this only affects the active weight group.
Flip Group Names
Exchange the names of left and right side. This option only renames the groups.
All Groups
Operate on all selected bones.
Topology Mirror
Mirror for meshes which are not 100% symmetric (approximate mirror).
Tip
Mirror to opposite bone
If you want to create a mirrored weight group for the opposite bone (of a symmetric character), then you can
do this:
• Delete the target Vertex Group (where the mirrored weights will be placed)
• Create a copy of the source bone Vertex Group (the group containing the weights which you want to
copy)
• Rename the new Vertex Group to the name of the target Vertex Group (the group you deleted above)
• Select the Target Vertex Group and call the Mirror tool (use only the Mirror weights option and
optionally Topology Mirror if your mesh is not symmetric)

Invert

Invert

Replaces each Weight of the selected weight group by 1.0 - weight.
Examples:
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• original 1.0 converts to 0.0
• original 0.5 remains 0.5
• original 0.0 converts to 1.0

Operator Parameters

Mirror Options

Subset
Restrict the tool to a subset. See above (The Subset Option) about how subsets are defined.
Add Weights
Add verts that have no weight before inverting (these weights will all be set to 1.0)
Remove Weights
Remove verts from the Vertex Group if they are 0.0 after inverting.
Note
Locked vertex Groups are not affected.

Clean

Invert

Removes weights below a given threshold. This tool is useful for clearing your weight groups of very low (or
zero-) weights.
In the example shown, I used a cutoff value of 0.139 (see operator options below) so all blue parts (left side) are
cleaned out (right side).
Note, the images use the Show Zero weights =Active option so that unreferenced Weights are shown in Black.
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Operator Parameters

Mirror Options

Subset
Restrict the tool to a subset. See above (The Subset Option) for how subsets are defined.
Limit
This is the minimum weight value that will be kept in the Group. Weights below this value will be
removed from the group.
Keep Single
Ensure that the Clean tool will not create completely unreferenced verts (verts which are not assigned to
any Vertex Group), so each vertex will keep at least one weight, even if it is below the limit value!

Levels

Invert

Adds an offset and a scale to all weights of the selected Weight Groups. with this tool you can raise or lower the
overall “heat” of the weight group.
Note
No weight will ever be set to values above 1.0 or below 0.0 regardless of the settings.
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Operator Parameters

Mirror Options

Subset
Restrict the tool to a subset. See above (The Subset Option) for how subsets are defined.
Offset
A value from the range [-1.0,1.0]) to be added to all weights in the Vertex Group.
Gain
All weights in the Subset are multiplied with the gain. The drag sliders of this value allow only a range of
[-10.0, 10.0]. However, you can enter any factor you like here by typing from the keyboard.
Note
Whichever Gain and Offset you choose, in all cases the final value of each weight will be clamped to the range
[0.0, 1.0]. So you will never get negative weights or overheated areas (weight > 1.0) with this tool.

Blend
Blends the weights of selected vertices with adjacent unselected vertices. This tool only works in vertex select
mode.

Blending

To understand what the tool really does, let’s take a look at a simple example. The selected vertex is connected
to 4 adjacent vertices (marked with a gray circle in the image). All adjacent vertices are unselected. Now the
tool calculates the average weight of all connected and unselected verts. In the example this is:
(1 + 0 + 0 + 0) / 4 = 0.25
This value is multiplied by the factor given in the Operator parameters (see below).
• If the factor is 0.0 then actually nothing happens at all and the vertex just keeps its value.
• If the factor is 1.0 then the calculated average weight is taken (0.25 here).
• Dragging the factor from 0 to 1 gradually changes from the old value to the calculated average.
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Blending

Now let’s see what happens when we select all but one of the neighbors of the selected vert as well. Again all
connected and unselected verts are marked with a gray circle. When we call the Blend tool now and set the
Factor to 1.0, then we see different results for each of the selected verts:
• The topmost and bottommost selected verts:
are surrounded by 3 unselected verts, with an average weight of (1 + 0 + 0) / 3 = 0.333 So
their color has changed to light green.
• The middle vertex:
is connected to one unselected vert with weight = 1. So the average weight is 1.0 in this case, thus
the selected vert color has changed to red.
• The right vert:
is surrounded by 3 unselected verts with average weight = (0 + 0 + 0) / 3 = 0.0 So the
average weight is 0, thus the selected vert color has not changed at all (it was already blue before blend
was applied).

Blending

Finally let’s look at a practical example (and explain why this tool is named Blend). In this example I have
selected the middle edge loop. And I want to use this edge loop for blending the left side to the right side of the
area.
• All selected vertices have 2 unselected adjacent verts.
• The average weight of the unselected verts is (1 + 0) / 2 = 0.5
• Thus when the Blend Factor is set to 1.0 then the edge loop turns to green and finally does blend the
cold side (right) to the hot side (left).
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Operator Parameters

Blend Options

Factor
The effective amount of blending (range [0.0, 1.0]). When Factor is set to 0.0 then the Blend tool does not
do anything. For Factor > 0 the weights of the affected vertices gradually shift from their original value
towards the average weight of all connected and unselected verts (see examples above).

Transfer Weights
Copy weights from other objects to the vertex groups of the active Object. By default this tool copies all vertex
groups contained in the selected objects to the target object. However you can change the tool’s behavior in the
operator redo panel (see below).

Prepare the Copy

Blending

Blending

You first select all source objects, and finally the target object (the target object must be the active object).
It is important that the source objects and the target object are at the same location. If they are placed side by
side, then the weight transfer won’t work. You can place the objects on different layers, but you have to ensure
that all objects are visible when you call the tool.
Now ensure that the Target Object is in Weight Paint mode.

Call the Tool
Open the Tool Shelf and locate the Weight Tools panel. From there call the “Transfer weights” tool. The tool
will initially copy all vertex groups from the source objects. However the tool also has an operator redo panel
(which appears at the bottom of the tool shelf). From the redo panel you can change the parameters to meet
your needs. (The available Operator parameters are documented below.)
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Redo Panel Confusion
You may notice that the Operator Redo Panel (see below) stays available after the weight transfer is done. The
panel only disappears when you call another Operator that has its own redo Panel. This can lead to confusion
when you use Transfer weights repeatedly after you changed your vertex groups. If you then use the still-visible
redo panel, then Bforartists will reset your work to its state right before you initially called the Transfer Weights
tool.

Workaround
When you want to call the Transfer Weights tool again after you made some changes to your vertex groups,
then always use the “Transfer Weights” Button, even if the operator panel is still available. Unless you really
want to reset your changes to the initial call of the tool.

Operator Parameters
Note
This tool now uses the generic ‘data transfer’ one. Please refer to the Data Transfer Modifier for options
details and explanations.

Limit Total
Reduce the number of weight groups per vertex to the specified Limit. The tool removes lowest weights first
until the limit is reached.
Hint: The tool can only work reasonably when more than one weight group is selected.

Operator Parameters
Subset
Restrict the tool to a subset. See above (The Subset Option) for how subsets are defined.
Limit
Maximum number of weights allowed on each vertex (default:4)

Weight Gradient

example of the gradient tool being used with selected vertices.

This is an interactive tool for applying a linear/radial weight gradient; this is useful at times when painting
gradual changes in weight becomes difficult.
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The gradient tool can be accessed from the Toolbar as a key shortcut:
• Linear: Alt-LMB and drag
• Radial: Alt-Ctrl-LMB and drag
The following weight paint options are used to control the gradient:
• Weight - The gradient starts at the current selected weight value, blending out to nothing.
• Strength - Lower values can be used so the gradient mixes in with the existing weights (just like with the
brush).
• Curve - The brush falloff curve applies to the gradient too, so you can use this to adjust the blending.
Blends the weights of selected vertices with unselected vertices.
Hint
This tool only works in vertex select mode.

Operator Parameters
Type:
• Linear
• Radial
X Start: X End: Y Start: Y End:

Sculpting
Overview
Sculpt Mode is similar to Edit Mode in that it is used to alter the shape of a model, but Sculpt Mode uses a very
different workflow: instead of dealing with individual elements (vertices, edges, and faces), an area of the
model is altered using a brush. In other words, instead of selecting a group of vertices, Sculpt Mode
automatically selects vertices based on where the brush is, and modifies them accordingly.

Sculpt Mode
Sculpt mode is selected from the mode menu of the 3D View header. Once sculpt mode is activated the Toolbar
of the 3D View will change to sculpt mode specific panels. The panels in the toolbar will be Brush, Texture,
Tool, Symmetry, Stroke, Curve, Appearance, and Options. Also a red circle will appear that follows the location
of the cursor in the 3d view.
Note
To have a predictable brush behavior, apply the scale of your mesh.
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Sculpt Mode Dropdown.

The cursor in Sculpt Mode.

Sculpt Brushes
Brushes are brush presets. They are a combination of a ‘tool’, along with stroke, texture, and options.
Sculpt Mode has sixteen brushes, each of which operates on the model in a unique way. Many can be toggled to
have an additive or subtractive effect. They can be selected in the Tool menu.

Sculpt brushes
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Blob
Pushes mesh outward or inward into a spherical shape with settings to control the amount of pinching at
the edge of the sphere.
Clay
Similar to the Draw brush, but includes settings to adjust the plane on which the brush acts.
Clay Strips
Similar to the Clay brush, but it uses a cube test to define the brush area of influence rather than a sphere.
Crease
Creates sharp indents or ridges by pushing or pulling the mesh, while pinching the vertices together.
Draw
Moves vertices inward or outward, based the average normal of the vertices contained within the drawn
brush stroke.
Fill
The Fill brush works like the Flatten brush, but only brings vertices below the brush plane upwards. The
inverse of the Scrape brush is to Deepen by pushing vertices above the plane downward.
Flatten
The Flatten brush finds an ‘area plane’ located by default at the average height above/below the vertices
within the brush area. The vertices are then pulled towards this plane. The inverse of the Flatten brush is
the Contrast brush which pushes vertices up or down away from the brush plane.
Grab
Grab is used to drag a group of points around. Unlike the other brushes, Grab does not modify different
points as the brush is dragged across the model. Instead, Grab selects a group of vertices on mousedown,
and pulls them to follow the mouse. The effect is similar to moving a group of vertices in Edit mode with
proportional-editing enabled, except that Grab can make use of other Sculpt Mode options (like textures
and symmetry).
Inflate
Similar to Draw, except that vertices in Inflate mode are displaced in the direction of their own normals.
Layer
This brush is similar to Draw, except that the height of the displacement layer is capped. This creates the
appearance of a solid layer being drawn. This brush does not draw on top of itself; a brush stroke
intersects itself. Releasing the mouse button and starting a new stroke will reset the depth and paint on top
of the previous stroke.
Nudge
Moves vertices in the direction of the brush stroke.
Pinch
Pinch pulls vertices towards the center of the brush. The inverse setting is Magnify, in which vertices are
pushed away from the center of the brush.
Rotate
Rotates vertices within the brush in the direction the cursor is moved.
Scrape
The Scrape brush works like the Flatten brush, but only brings vertices above the plane downwards. The
inverse of the Scrape brush is to Peak by pushing vertices above the plane up away from the plane.
Smooth
As the name suggests, eliminates irregularities in the area of the mesh within the brush’s influence by
smoothing the positions of the vertices.
Snake Hook
Pulls vertices along with the movement of the brush to create long, snake-like forms.
Thumb
Similar to the Nudge brush, this one flattens the mesh in the brush area, while moving it in the direction
of the brush stroke.
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Sculpt Properties Panel
This panel appears in the tool palette on the left side of the 3D viewport.

Brush Panel
Radius
This option controls the radius of the brush, measured in pixels. F in the 3D view allows you to change
the brush size interactively by dragging the mouse and then left clicking (the texture of the brush should
be visible inside the circle). Typing a number then enter while in F sizing allows you to enter the size
numerically. Brush size can be affected by enabling the pressure sensitivity icon, if a supported tablet is
being used.
Strength
Strength controls how much each application of the brush affects the model. For example, higher values
cause the Draw brush to add depth to the model more quickly, and cause the Smooth brush to smooth the
model more quickly. This setting is not available for Grab, Snake Hook, or Rotate.
If the range of strengths doesn’t seem to fit the model (for example, if even the lowest strength setting still
makes too large of a change on the model) then you can scale the model (in Edit Mode, not Object Mode).
Larger sizes will make the brush’s effect smaller, and vice versa. You can change the brush strength
interactively by pressing Shift-F in the 3D view and then moving the brush and then left clicking. You can
enter the size numerically also while in Shift-F sizing. Brush strength can be affected by enabling the
pressure sensitivity icon, if a supported tablet is being used.
Autosmooth
Sets the amount of smoothing to be applied to each stroke.
Normal Weight
TODO.
Pinch Factor
TODO.
Rake Factor
TODO.
Sculpt Plane
Use this menu to set the plane in which the sculpting takes place.
Plane Offset
Adjusts the plane on which the brush acts toward or away from the viewer.
Height
TODO.
Trim
Enables trimming of the sculpt plane, determined by the Distance setting.
Front Faces Only
When enabled, the brush only affects vertices that are facing the viewer.
Accumulate
Causes stroke dabs to accumulate on top of each other.
Add/Subtract
TODO.
Persistent
TODO.

Stroke Panel
Stroke Method
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Defines the way brush strokes are applied to the mesh:
Dots
Standard brush stroke.
Drag Dot
Creates a single displacement in the brush shape. Click then drag on mesh to desired location, then
release.
Space
Creates brush stroke as a series of dots, whose spacing is determined by the Spacing setting. Spacing
represents the percentage of the brush diameter.
Anchored
Creates a single displacement at the brush location. Clicking and dragging will resize the brush diameter.
When Edge to Edge the brush location and orientation is determined by a two point circle, where the first
click is one point, and dragging places the second point, opposite from the first.
Airbrush
Flow of the brush continues as long as the mouse click is held, determined by the Rate setting. If disabled,
the brush only modifies the model when the brush changes its location. This option is not available for the
Grab brush.
The following parameters are available for the Dots, Space, and Airbrush strokes:
Jitter
Jitters the position of the brush while painting.
Smooth stroke
Brush lags behind mouse and follows a smoother path. When enabled, the following become active:
Radius
Sets the minimum distance from the last point before stroke continues.
Factor
Sets the amount of smoothing

Curve Panel
The Curve section allows you to use a curve control to the right to modify the intensity of the brush from its
centre (left part of the curve) towards its borders (right part of the curve).

See also
• Read more about using the Curve Widget.

Texture Panel
A texture can be used to determine the strength of brush effects as well. Select an existing texture from the
texture box, or create a new one by selecting the New button
Brush Mapping
Sets the way the texture is mapped to the brush stroke:
Fixed
If Fixed is enabled, the texture follows the mouse, so it appears that the texture is being dragged
42

Bforartists Reference Manual - © Copyright - This page is under OCL license

across the model.
Tiled
The Tile option tiles the texture across the screen, so moving the brush appears to move separately
from the texture. The Tile option is most useful with tileable images, rather than procedural textures.
3D
The 3D option allows the brush to take full advantage of procedural textures. This mode uses vertex
coordinates rather than the brush location to determine what area of the texture to use.
Angle
This is the rotation angle of the texture brush. It can be changed interactively via Ctrl-F in the 3D view.
While in the interactive rotation you can enter a value numerically as well. Can be set to:
User
Directly input the angle value.
Rake
Angle follows the direction of the brush stroke. Not available with 3D textures.
Random
Angle is randomized.
Offset
Fine tunes the texture map placement in the x, y, and z axes.
Size
This setting allows you to modify the scaling factor of the texture. Not available for Drag textures.
Sample Bias
Value added to texture samples.

Symmetry Panel
Mirror
Mirror the brush strokes across the selected local axes. Note that if you want to alter the directions the
axes point in, you must rotate the model in Edit Mode, not Object Mode
Radial
These settings allow for radial symmetry in the desired axes. The number determines how many times the
stroke will be repeated within 360 degrees around the central axes.
Feather
Reduces the strength of the stroke where it overlaps the planes of symmetry.
Lock
These three buttons allow you to block any modification/deformation of your model along selected local
axes, while you are sculpting it.
Tiling
Using this option allows you to seamlessly tile your strokes along the given axes.
Tile Offset
The default tile size is set to one BU (Bforartists Unit). The offset allows the option to alter the tile size
along all three axes.

Overlay Panel
When enabled, the brush texture is shown in the viewport
View
The eye icon is used as a toggle to show or hide the given brush texture
Alpha
You can change the amount of transparency used when showing the texture using the Alpha slider
Stroke Overlay
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The brush icon allows you to turn off the viewport overlay during strokes

Options Panel
Gravity
Factor
Setting the factor allows you to add gravity to your brush strokes, giving it a draping effect.
Orientation
Using another object, the gravity can be oriented to the set object’s local Z axis, changing the
direction of the gravity.
Threaded Sculpt
Takes advantage of multiple CPU processors to improve sculpting performance.
Fast Navigation
For Multires models, show low resolution while navigation the viewport.
Use Deform Only
Limits active modifiers on the active object to Deform modifiers, and Multiresolution
Show Diffuse Color
Allows the active object to show it’s diffuse color when sculpting
Unified Settings:
Size
Forces the brush size to be shared across brushes.
Strength
Forces the brush strength to be shared across brushes.
Color
Not Used in Sculpt Mode
Show Brush
Shows the brush shape in the viewport.
Color (Add/Subtract)
Set the color of the brush ring when its particular effect is active

Appearance Panel
Show Brush
Shows the brush shape in the viewport.
Color (Add/Subtract)
Set the color of the brush ring when its particular effect is active
Custom Icon
Append an image file to the active brush as an icon.

Sculpt Menus
Tool Menu
Here you can select the type of brush preset to use. Reset Brush will return the settings of a brush to its defaults.
You can also set Bforartists to use the current brush for Vertex Paint mode, Weight Paint mode, and Texture
Paint mode using the toggle buttons.

Hiding and Masking Mesh
It is sometimes useful to isolate parts of a mesh to sculpt on. To hide a part of a mesh, press H then click & drag
around the part you want to hide. To reveal a hidden part of a mesh, press Shift-H then click & drag around
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the part you want to reveal. To reveal all hidden parts, just press Alt-H. With the mask brush we can paint a
part of the mesh and hide it.

Black part is masked, down in the picture mask/hide menu

Adaptive Sculpting
Dynamic Topology
Dynamic topology (AKA dyntopo) is a dynamic tessellation sculpting method, adds and removes details on the
fly. Dyntopo is quick, just get a brush and start to sculpt. Dyntopo will add details base upon your brush size,
detail type and strength.
Detail Type
Dyntopo uses three different detail methods to create dynamic detail to an object. The methods available
are Relative Detail (Default), Constant Detail, and Brush Detail.
Relative Detail
This method uses a detail size based on the number of pixels, and in turn will create topology in that
size. Zoom out big details, zoom in small fines details.
Constant Detail
To keep detail uniform across the entire object, Constant Detail can be used. The Detail is based on
the percentage of a single BU (Bforartists Unit).
Brush Detail
Giving more control over the topology, with this method you can create topology based on the
brush size. You can increase and lower topology by simply resizing the brush itself. The detail size
is based the size of the brush itself, where 100% will create topology the size of the brush ring
itself.
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Detail Size
Each Detail Type’s detail is set here. Depending on the Detail Type being used this property will rather
show as a pixel count (px), or percentage.
Detail Refine Method
When using Dynamic Topology, a certain method will be used to tell how topology is handled. Setting the
option will determine which of the methods will be used when altering the topology.
Subdivide
Just like the subdivide command, this method will only subdivide topology to match the detail
given.
Collapse
When topology is too dense, and is smaller than the detail given, edges will be collapse to fit the
detail size appropriately.
Subdivide Collapse
This method combines the two methods, subdividing edges smaller than the detail size, and
collapsing topology.
Detail Flood Fill
When using Constant Detail mode, this option is made available, allowing you to fill the entire
object with a uniform detail, based on the detail size.
Direction
Determines which direction the model will be symmetrized.
Dyntopo Symmetrize
Uses direction orientation to symmetrize. Since Dyntopo adds details dynamical may happen that the
model goes asymmetric, so this a good tool for that.

Multi-Resolution Modifier
The multires modifier is needed to sculpt. The modifier will subdivide the mesh. The more subdivision the
more computing will be needed. With the Bforartists stack no-destructive data, multires sculpting will help
when you have a clean topology base mesh.
When sculpting with multires we have the ability sculpt in different level of subdivision, this mean we can
sculpt some details in subdivision level 1 and add more details in subdivision 2 and go back to subdivision 1
correct some mistakes. While this workflow is often used, multires modifier has some limitations. You may end
up with some mesh distortions. As an advice, add as more details as possible before adding more subdivisions.
Clay brush, SculptDraw work better with multires sculpting to sculpt secondary forms.
See also
Read more about the Multi Resolution Modifier.
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Rigging
Rigging makes animation possible. Without a good rig animation is incredibly frustrating. Imagine animating a
bouncing ball without the ability to squash it against the ground? Try animating a monkey swinging through the
trees with no control to make the monkey’s hands grab onto the branches. What if you had to animate an army
tank speeding through the desert by positioning each tread on the tank one at a time?

At its most basic level, rigging solves motion problems. Imagine a door that opens into a hallway. Without a rig,
the door won’t swing open properly (1). A rig is needed to help the door swing open on its hinges (2,3,4), and
there are many ways to rig the door. Door 2 gets rigged by repositioning the Object Center of the door. Door 3
gets rigged by Parenting the door to an Empty. Door 4 gets rigged by Weight Painting all of its Vertices to a
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Bone in an Armature.

Most production rigs are more complicated than a simple door, but be careful not to rush off building
complicated rigs until you have developed some experience. Rigging is a discipline that takes practice. Start by
building simple rigs (like a bouncing ball, a tumbling box, an odometer, a clock). Stay humble. Stay patient.
Study the fundamental concepts that make a bouncing ball bounce. Add one rigging tool to your toolbox at a
time. Test your simple rigs in actual animation projects. And only after much trial and error, consider putting
everything together into the sophisticated character rig of your dreams.
See also
The content of this chapter is simply a reference to how rigging is accomplished in Bforartists. It should be
paired with additional resources such as Nathan Vegdahl’s excellent (and free!) introduction to the
fundamental concepts of character rigging, Humane Rigging.

Constraints
Constraints control the behavior of one object with data from another. Constraints can make the eyes of a tennis
player track a tennis ball bouncing across the court. Constraints allow the wheels on a bus to all rotate together.
Constraints help a dinosaur’s legs bend at the knee automatically. Constraints make it easy for a hand to grip the
hilt of a sword and the sword to swing with the hand.
Constraints, in Bforartists, work with Objects and Bones.

Object Constraints.

Bone Constraints.

Constraints work in combination with each other to form a Constraint Stack.
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The Constraint Stack is evaluated from top to bottom.

Constraints are a fantastic way to add sophistication and complexity to a rig. But be careful not to rush in too
quickly, piling up constraint upon constraint until you lose all sense of how they interact with each other.
Start simply. Get to know a single constraint inside and out. Copy Location is a good first constraint to explore.
Take the time to understand every fundamental concept behind it, and the other constraints will make far more
sense.
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Adding/Removing a Constraint
To add a constraint in the Constraints Panel:
Click on the “Add Constraint” drop-down box.

To add a constraint in the 3D view:
Select the object you would like to constrain. Go to and choose a constraint from the pop-up menu. If the
chosen constraint needs a target, Bforartists will add an empty automatically as the target and position it
at the center of the constrained object.
To add a constraint in the 3D view and simultaneously give it a target:
Select the target first and then shift-select the object you would like to constrain. Go to and choose a
constraint from the menu.
To remove a constraint:
Click on the “X” button in the header.
To remove all constraints from all selected object(s):
Click Object ‣ Constraints ‣ Clear Object Constraints in the 3D View Header.
or Pose ‣ Constraints ‣ Clear Pose Constraints (for bone constraints).

Header
Every constraint has a header. The interface elements of the header are explained below using a Copy Location
constraint as an example.
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A Header sits at the top of every constraint.

Expansion Arrow (pointing down or right)
Show or Hide the settings of the constraint. Tidy up the constraint stack by hiding constraints that don’t
currently need attention. Constraints will continue to affect the scene even when hidden.
“Copy Location” (first occurrence)
The type of constraint. This is determined at the time the constraint is created.
“Copy Location” (second occurrence)
Give the constraint a meaningful name in this field, something that describes its intent. Meaningful names
help you and your team members understand what each constraint is supposed to do.
The red background is a warning that the constraint is not yet functional. The background will turn gray
when the constraint is functioning. When this Copy Location constraint has a valid target in the “Target
Field” it will turn gray and begin to function.
Eyeball (open or closed)
Enable or Disable (Mute/Unmute) the constraint. Disabling a constraint will stop its affect on the scene.
Disabling a constraint is useful for turning off a constraint without losing all of its settings. Disabling
means you can enable the constraint at a later time with the settings intact. Disabling is similar to setting
the influence slider to 0.0.
Up/Down Arrows
Move a constraint up or down in the constraint stack. Since the stack is evaluated from top to bottom,
moving a constraint in the stack can significantly affect the final outcome of the stack.
If there is only one constraint in the stack, the arrows will not be drawn. If the constraint is at the top of
the stack, only the down arrow will be drawn. If the constraint is at the bottom of the stack, only the up
arrow will be drawn.
Delete
Delete the constraint from the stack. The settings will be lost. The constraint will no longer affect the final
outcome of the stack.
6
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Target
The Target field lets you link the constraint to a Target object of your choosing. This link provides data to the
constraint so that it can begin to function. For example, the Copy Location Constraint needs location data to
function. Fill in the Target field, and the Copy Location constraint will begin to use location data from the
Target object.

The Target field must be filled in for the constraint to function.

By default, the Target will use the Object Center as the target point.
If the Target field links to a Mesh or Lattice object, a Vertex Group field will appear. Enter the name of a vertex
group and the constraint will target the median point of this vertex group instead of the object center.

If the Target field links to an Armature, a Bone field will appear along with a Head/Tail slider. Enter the name
7
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of a bone and the constraint will target the bone instead of the entire armature object center. Slide the slider and
the constraint will target the head, the tail or somewhere inbetween.

Space
Constraints need a frame of reference in order to function. This frame of reference is called the “space” of the
constraint. Choosing one space vs. another will change this frame of reference and substantially alter the
behavior of a constraint.
To understand how changing the space will change the behavior of the constraint, consider experimenting with
two empties. Make sure they display as arrows so that you can see the local axes for each empty. Make sure to
size one empty a little larger than the other so that they are both always visible even if directly on top of each
other. Then add a constraint to one empty that targets the other and experiment thoroughly by moving, rotating
and scaling the target in many different ways.
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This constraint is set to use World Space as the frame of reference for both its Target Space and its Owner Space.

Target Space & Owner Space
The space used to evaluate the target of the constraint is called the Target Space. The space used to evaluate the
constrained object (the object that owns the constraint) is called the owner space. Hover over the space dropdown box (or boxes) to learn whether it affects the space of the target or the space of the owner.
Some constraints don’t use Target or Owner space, so there won’t be a drop-down box. Some constraints use
only Target or only Owner space, so there will only be one drop-down box. Some constraints (like the Copy
Location constraint above) use both Target AND Owner space, so there will be two drop-down boxes.
When a constraint uses both Target and Owner space, the Target and Owner can be any combination of space
types.

Space Types
World Space
In this space type the world is the frame of reference for the object (or bone). Location is relative to the
world origin. Rotation and Scale are oriented to the world axes. Transformations to the object, the object’s
parent and any other constraints higher up in the constraint stack are all taken into account.
Local Space
In this space type the parent of the object (or bone) is the frame of reference. Location is relative to the
parent object origin. Rotation and Scale are oriented to the parent object axes. Only transformations to the
object istelf are taken into account. Transformations to the object’s parent and any other constraints higher
up in the constraint stack are NOT taken into account.
Local With Parent (bones only)
The bone properties are evaluated in its own local space, including the transformations due to a possible
parent relationship (i.e. due to the chain’s transformations above the bone).
Pose Space (bones only)
The bone properties are evaluated in the armature object local space (i.e. independently from the armature
transformations in Object mode). Hence, if the armature object has null transformations, Pose Space will
have the same effect as World Space.
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Influence
The influence slider determines how much the constraint will affect the constrained object.

An influence of 0.0 will have no effect. An influence of 1.0 will have the full effect.
Values between 0.0 and 1.0, will have a partial effect, but be careful. These partial effects can be difficult to
control, especially as the constraint stack grows in complexity.
The influence value is animatable, allowing constraints to be turned off, or or partially on as needed. (see

The Constraints Stack
The combination of all the constraints that affect an object are called the Constraints Stack. The Stack is in the
Constraints panel, below the “Add Constraint” drop-down box.
Constraints in the stack are evaluated from top to bottom. The order of each constraint has a substantial impace
on the final outcome of the stack. Changing the order of the constraints can change the behavior of the entire
stack.
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The 7 constraints in this example stack are evaluated from top to bottom starting with the “Action” constraint and ending with
the final “Transformation” constraint.

To change the order of a constraint use the up/down arrows in the header.

Camera Solver
TODO - see: https://developer.Bforartists.org/T46926

Object Solver
TODO - see: https://developer.Bforartists.org/T46926

Follow Track
TODO - see: https://developer.Bforartists.org/T46926
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Copy Location Constraint
Description
The Copy Location constraint forces its owner to have the same location as its target.
Warning
Note that if you use such a constraint on a connected bone, it will have no effect, as it is the
parent’s tip which controls the position of your owner bone’s root.

Options

Copy Location panel

Target
This constraint uses one target, and is not functional (red state) when it has none.
Bone
If Target is an Armature, a new field is displayed offering the optional choice to set an individual
bone as Target.
Head/Tail
If a Bone is set as Target, a new field is displayed offering the optional choice of where along
this bone the target point lies.
Vertex Group
If Target is a Mesh, a new field is displayed offering the optional choice to set a Vertex Group as
target.
X, Y, Z
These buttons control which axes (i.e. coordinates) are constrained - by default, all three ones are.
Invert
The Invert buttons invert their respective preceding coordinates.
Offset
12
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When enabled, this control allows the owner to be translated (using its current transform properties),
relative to its target’s position.
Space
This constraint allows you to choose in which space to evaluate its owner’s and target’s transform
properties.

Copy Rotation Constraint
The Copy Rotation constraint forces its owner to match the rotation of its target.

Options

Copy Rotation panel

Target
This constraint uses one target, and is not functional (red state) when it has none.
Bone
If Target is an Armature, a new field is displayed offering the optional choice to set an individual
bone as Target.
Head/Tail
If a Bone is set as Target, a new field is displayed offering the optional choice of where along
this bone the target point lies.
Vertex Group
If Target is a Mesh, a new field is displayed offering the optional choice to set a Vertex Group as
target.
X, Y, Z
These buttons control which axes are constrained - by default, all three are on.
Invert
The Invert buttons invert their respective rotation values.
Offset
When enabled, this control allows the owner to be rotated (using its current transform properties), relative
to its target’s orientation.
Space
This constraint allows you to choose in which space to evaluate its owner’s and target’s transform
13
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properties.

Copy Scale Constraint
Description
The Copy Scale constraint forces its owner to have the same scale as its target.
Warning
Here we talk of scale, not of size! Indeed, you can have two objects, one much bigger than the
other, and yet both of them have the same scale. This is also true with bones: in Pose mode, they
all have a unitary scale when they are in rest position, represented by their visible length.

Options

Copy Scale panel

Target
This constraint uses one target, and is not functional (red state) when it has none.
Bone
If Target is an Armature, a new field is displayed offering the optional choice to set an individual
bone as Target.
Head/Tail
If a Bone is set as Target, a new field is displayed offering the optional choice of where along
this bone the target point lies.
Vertex Group
If Target is a Mesh, a new field is displayed offering the optional choice to set a Vertex Group as
target.
X, Y, Z
These buttons control along which axes the scale is constrained - by default, it is enabled along all three.
Offset
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When enabled, this control allows the owner to be scaled (using its current transform properties),
relatively to its target’s scale.
Space
This constraint allows you to choose in which space to evaluate its owner’s and target’s transform
properties.

Copy Transforms Constraint
Description
The Copy Transforms constraint forces its owner to have the same transforms as its target.

Options

Copy Transforms panel

Target
This constraint uses one target, and is not functional (red state) when it has none.
Bone
If Target is an Armature, a new field is displayed offering the optional choice to set an individual
bone as Target.
Head/Tail
If a Bone is set as Target, a new field is displayed offering the optional choice of where along
this bone the target point lies.
Vertex Group
If Target is a Mesh, a new field is displayed offering the optional choice to set a Vertex Group as
target.
Space
This constraint allows you to choose in which space to evaluate its owner’s and target’s transform
properties.

Limit Distance Constraint
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Description
The Limit Distance constraint forces its owner to stay either further from, nearer to, or exactly at a given
distance from its target. In other words, the owner’s location is constrained either outside, inside, or at the
surface of a sphere centered on its target.
When you specify a (new) target, the Distance value is automatically set to correspond to the distance between
the owner and this target.
Warning
Note that if you use such a constraint on a connected bone, it will have no effect, as it is the
parent’s tip which controls the position of your owner bone’s root.

Options

Limit Distance panel

Target
This constraint uses one target, and is not functional (red state) when it has none.
Bone
If Target is an Armature, a new field is displayed offering the optional choice to set an individual
bone as Target.
Head/Tail
If a Bone is set as Target, a new field is displayed offering the optional choice of where along
this bone the target point lies.
Vertex Group
If Target is a Mesh, a new field is displayed offering the optional choice to set a Vertex Group as
target.
Distance
This numeric field sets the limit distance, i.e. the radius of the constraining sphere.
Reset Distance
When clicked, this small button will reset the Distance value, so that it corresponds to the actual distance
between the owner and its target (i.e. the distance before this constraint is applied).
Clamp Region
The Limit Mode drop-down menu allows you to choose how to use the sphere defined by the Distance
16
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setting and target’s center:
Inside (default)
The owner is constrained inside the sphere.
Outside
The owner is constrained outside the sphere.
Surface
The owner is constrained on the surface of the sphere.

Limit Location Constraint
Description
An object or unconnected bone can be moved around the scene along the X, Y and Z axes. This constraint
restricts the amount of allowed translations along each axis, through lower and upper bounds.
The limits for an object are calculated from its center, and the limits of a bone, from its root.
It is interesting to note that even though the constraint limits the visual and rendered location of its owner, its
owner’s data block still allows (by default) the object or bone to have coordinates outside the minimum and
maximum ranges. This can be seen in its Transform Properties panel. When an owner is grabbed and attempted
to be moved outside the limit boundaries, it will be constrained to those boundaries visually and when rendered,
but internally, its coordinates will still be changed beyond the limits. If the constraint is removed, its ex-owner
will seem to jump to its internally specified location.
Similarly, if its owner has an internal location that is beyond the limits, dragging it back into the limit area will
appear to do nothing until the internal coordinates are back within the limit threshold (unless you enabled the
For Transform option, see below).
Setting equal the min and max values of an axis, locks the owner’s movement along that axis... Although this is
possible, using the Transformation Properties axis locking feature is probably easier!

Options

Limit Location panel
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Minimum X, Minimum Y, Minimum Z
These buttons enable the lower boundary for the location of the owner’s center along, respectively, the X,
Y and Z axes of the chosen Space. The numeric field below them controls the value of their limit. Note
that if a min value is higher than its corresponding max value, the constraint behaves as if it had the same
value as the max one.
Maximum X, Maximum Y, Maximum Z
These buttons enable the upper boundary for the location of the owner’s center along, respectively, the X,
Y and Z axes of the chosen Space. Same options as above.
For Transform
We saw that by default, even though visually constrained, the owner can still have coordinates out of
bounds (as shown by the Transform Properties panel). Well, when you enable this button, this is no longer
possible - the owner’s transform properties are also limited by the constraint. Note however that the
constraint does not directly modify the coordinates: you have to grab its owner one way or another for
this to take effect...
Convert
This constraint allows you to choose in which space to evaluate its owner’s transform properties.

Limit Rotation Constraint
Description
An object or bone can be rotated around the X, Y and Z axes. This constraint restricts the amount of allowed
rotations around each axis, through lower and upper bounds.
It is interesting to note that even though the constraint limits the visual and rendered rotations of its owner, its
owner’s data block still allows (by default) the object or bone to have rotation values outside the minimum and
maximum ranges. This can be seen in the Transform Properties panel. When an owner is rotated and attempted
to be rotated outside the limit boundaries, it will be constrained to those boundaries visually and when rendered,
but internally, its rotation values will still be changed beyond the limits. If the constraint is removed, its exowner will seem to jump to its internally specified rotation.
Similarly, if its owner has an internal rotation that is beyond the limit, rotating it back into the limit area will
appear to do nothing until the internal rotation values are back within the limit threshold (unless you enabled
the For Transform option, see below).
Setting equal the min and max values of an axis, locks the owner’s rotation around that axis... Although this is
possible, using the Transformation Properties axis locking feature is probably easier.
This transform does not constrain the bone if it is manipulated by the IK solver. For constraining the rotation of
a bone for IK purposes, see the “Inverse Kinematics” section of Bone properties.
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Options

Limit Rotation panel

Limit X, LimitY, LimitZ
These buttons enable the rotation limit around respectively the X, Y and Z axes of the owner, in the
chosen Space. The Min and Max numeric fields to their right control the value of their lower and upper
boundaries, respectively.
Note that:
• If a min value is higher than its corresponding max value, the constraint behaves as if it had the
same value as the max one.
• Unlike the Limit Location constraint, you cannot enable separately lower or upper limits...
For Transform
We saw that by default, even though visually constrained, the owner can still have rotations out of bounds
(as shown by the Transform Properties panel). Well, when you enable this button, this is no more possible
- the owner transform properties are also limited by the constraint. Note however that the constraint does
not directly modifies the rotation values: you have to rotate one way or the other its owner, for this to take
effect...
Convert
This constraint allows you to chose in which space evaluate its owner’s transform properties.

Limit Scale Constraint
Description
An object or bone can be scaled along the X, Y and Z axes. This constraint restricts the amount of allowed
scalings along each axis, through lower and upper bounds.
Warning
This constraint does not tolerate negative scale values (those you might use to mirror an object...):
when you add it to an object or bone, even if no axis limit is enabled, nor the For Transform
button, as soon as you scale your object, all negative scale values are instantaneously inverted to
positive ones... And the boundary settings can only take strictly positive values.
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It is interesting to note that even though the constraint limits the visual and rendered scale of its owner, its
owner’s data block still allows (by default) the object or bone to have scale values outside the minimum and
maximum ranges (as long as they remain positive!). This can be seen in its Transform Properties panel. When
an owner is scaled and attempted to be moved outside the limit boundaries, it will be constrained to those
boundaries visually and when rendered, but internally, its coordinates will still be changed beyond the limits. If
the constraint is removed, its ex-owner will seem to jump to its internally-specified scale.
Similarly, if its owner has an internal scale that is beyond the limits, scaling it back into the limit area will
appear to do nothing until the internal scale values are back within the limit threshold (unless you enabled the
For Transform option, see below - or your owner has some negative scale values).
Setting equal the min and max values of an axis locks the owner’s scaling along that axis. Although this is
possible, using the Transformation Properties axis locking feature is probably easier.

Options

Limit Scale panel

Minimum / Maximum X, Y, Z
These buttons enable the lower boundary for the scale of the owner along respectively the X, Y and Z
axes of the chosen Space. The Min and Max numeric fields to their right control the value of their lower
and upper boundaries, respectively. Note that if a min value is higher than its corresponding max value,
the constraint behaves as if it had the same value as the max one.
For Transform
We saw that by default, even though visually constrained, and except for the negative values, the owner
can still have scales out of bounds (as shown by the Transform Properties panel). Well, when you enable
this button, this is no longer possible - the owner transform properties are also limited by the constraint.
Note however that the constraint does not directly modify the scale values: you have to scale its owner
one way or another for this to take effect.
Convert
This constraint allows you to choose in which space to evaluate its owner’s transform properties.

Maintain Volume Constraint
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Description
The Maintain Volume constraint limits the volume of a mesh or a bone to a given ratio of its original volume.

Option

Maintain Volume panel

Free X / Y / Z
The free-scaling axis of the object.
Volume
The bone’s rest volume. Default is 1.0.
Space
This constraint allows you to choose in which space to evaluate its owner’s transform properties.

See also
• Harkyman on the development of the Maintain Volume constraint, March 2010

Transformation Constraint
This constraint is more complex and versatile than the other “transform” constraints. It allows you to map one
type of transform properties (i.e. location, rotation or scale) of the target, to the same or another type of
transform properties of the owner, within a given range of values (which might be different for each target and
owner property). You can also switch between axes, and use the range values not as limits, but rather as
“markers” to define a mapping between input (target) and output (owner) values.
So, e.g. you can use the position of the target along the X axis to control the rotation of the owner around the Z
axis, stating that 1 BU along the target X axis corresponds to
10 around the owner Z axis. Typical uses for this include gears (see note below),
and rotation based on location setups.
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Options

Transformation panel

Target
This constraint uses one target, and is not functional (red state) when it has none.
Bone
If Target is an Armature, a new field is displayed offering the optional choice to set an individual
bone as Target.
Head/Tail
If a Bone is set as Target, a new field is displayed offering the optional choice of where along
this bone the target point lies.
Vertex Group
If Target is a Mesh, a new field is displayed offering the optional choice to set a Vertex Group as
target.
Extrapolate
By default, the min and max values bound the input and output values; all values outside these ranges are
clipped to them. When you enable this button, the min and max values are no longer strict limits, but
rather “markers” defining a proportional (linear) mapping between input and corresponding output values.
Let’s illustrate that with two graphs (The Extrapolate principles). In these pictures, the input range (in
abscissa) is set to [1.0, 4.0], and its corresponding output range (in ordinate), to [1.0, 2.0]. The
yellow curve represents the mapping between input and output.
The Extrapolate principles.
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Extrapolate disabled: the output values are bounded

Extrapolate enabled: the output values are “free” to

inside the [1.0, 2.0] range.

proportionally follow the input ones.

Warning
Note that:
• When mapping transform properties to location (i.e. Loc, Destination button is enabled), the owner’s
existing location is added to the result of evaluating this constraint (exactly like when the Offset button
of the Copy Location constraint is enabled...).
• Conversely, when mapping transform properties to rotation or scale, the owner’s existing rotation or
scale is overridden by the result of evaluating this constraint.
• When using the rotation transform properties of the target as input, whatever the real values are, the
constraint will always “take them back” into the -180, 180 range (e.g. if the target has a rotation of
420 around its X axis, the values used as X input by the constraint will be ((420 + 180) modulo
360) - 180 = 60- ...). This is why this constraint is not really suited for gears!
• Similarly, when using the scale transform properties of the target as input, whatever the real values are,
the constraint will always take their absolute values (i.e. invert negative ones).
• When a min value is higher than its corresponding max one, both are considered equal to the max one.
This implies you cannot create “reversed” mappings...
Source
It contains the input (from target) settings. The three Loc, Rot and Scale toggle buttons, mutually
exclusive, allow you to select which type of property to use. The X:, Y: and Z: min and max numeric fields
control the lower and upper bounds of the input value range, independently for each axis. Note that if a
min value is higher than its corresponding max value, the constraint behaves as if it had the same value as
the max one.
Destination
It contains the output (to owner) settings.
• The three Loc, Rot and Scale toggle buttons, mutually exclusive, allow you to select which type of
property to control.
• The three Axis Mapping drop-down lists allow you to select which input axis to map to,
respectively (from top to bottom), the X, Y and Z output (owner) axes.
• The min and max numeric fields control the lower and upper bounds of the output value range,
independently for each mapped axis. Note that if a min value is higher than its corresponding max
value, the constraint behaves as if it had the same value as the max one.
Space
23

Bforartists Reference Manual - © Copyright - This page is under OCL license

This constraint allows you to choose in which space to evaluate its owner’s and target’s transform
properties.

Clamp To Constraint
The Clamp To constraint clamps an object to a curve. The Clamp To constraint is very similar to the Follow
Path constraint, but instead of using the evaluation time of the target curve, Clamp To will get the actual
location properties of its owner (those shown in the Transform Properties panel, N), and judge where to put it
by “mapping” this location along the target curve.
One benefit is that when you are working with Clamp To, it is easier to see what your owner will be doing;
since you are working in the 3D view, it will just be a lot more precise than sliding keys around on a time Ipo
and playing the animation over and over.
A downside is that unlike in the Follow Path constraint, Clamp To doesn’t have any option to track your
owner’s rotation (pitch, roll, yaw) to the banking of the targeted curve, but you don’t always need rotation on,
so in cases like this it’s usually a lot handier to fire up a Clamp To, and get the bits of rotation you do need some
other way.
The mapping from the object’s original position to its position on the curve is not perfect, but uses the following
simplified algorithm (note, I am not the original code author so this may not be 100% accurate):
• A “main axis” is chosen, either by the user, or as the longest axis of the curve’s bounding box (the
default).
• The position of the object is compared to the bounding box of the curve in the direction of the main axis.
So for example if X is the main axis, and the object is aligned with the curve bounding box’s left side,
the result is 0; if it is aligned with the right side, the result is 1.
• If the cyclic option is unchecked, this value is clamped in the range 0-1.
• This number is used as the curve time, to find the final position along the curve that the object is
clamped to.
This algorithm does not produce exactly the desired result because curve time does not map exactly to the main
axis position. For example an object directly in the centre of a curve will be clamped to a curve time of 0.5
regardless of the shape of the curve, because it is halfway along the curve’s bounding box. However the 0.5
curve time position can actually be anywhere within the bounding box!

Options
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Clamp To panel

Target
The Target: field indicates which curve object the Clamp To constraint will track along. The Target: field
must be a curve object type. If this field is not filled in then it will be highlighted in red indicating that
this constraint does not have all the information it needs to carry out its task and will therefore be ignored
on the constraint stack.
Main Axis
This button group controls which global axis (X, Y or Z) is the main direction of the path. When clamping
the object to the target curve, it will not be moved significantly on this axis. It may move a small amount
on that axis because of the inexact way this constraint functions.
For example if you are animating a rocket launch, it will be the Z axis because the main direction of the
launch path is up. The default Auto option chooses the axis which the curve is longest in (or X if they are
equal). This is usually the best option.
Cyclic
By default, once the object has reached one end of its target curve, it will be constrained there. When the
Cyclic option is enabled, as soon as it reaches one end of the curve, it is instantaneously moved to its
other end. This is of course primarily designed for closed curves (circles & co), as this allows your owner
to go around it over and over.

Damped Track Constraint
The Damped Track constraint constrains one local axis of the owner to always point towards Target. In another
3D software you can find it with the name “Look at” constraint.

Options

Damped Track panel

Target (Mesh Object Type)
This constraint uses one target, and is not functional (red state) when it has none.
Vertex Group
If Target is a Mesh, a new field is displayed offering the optional choice to set a Vertex Group as
target.
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Damped Track for Bones

Target (Armature Object Type):
Bone
If Target is an Armature, a new field is displayed offering the optional choice to set an individual
bone as Target.
Head/Tail
If Target is an Armature, a new field is displayed offering the optional choice to set whether the
Head or Tail of a Bone will be pointed at by the Target. It is a slider value field which can have a
value between 0 and 1. A value of 0 will point the Target at the Head/Root of a Bone while a value
of 1 will point the Target at the Tail/Tip of a Bone.
To
Once the owner object has had a Damped Track constraint applied to it, you must then choose which axis
of the object you want to point at the Target object. You can choose between 6 axis directions (-X, -Y, -Z,
X, Y, Z). The negative axis direction cause the object to point away from the Target object along the
selected axis direction.

IK Solver Constraint
The Inverse Kinematics constraint implements the inverse kinematics armature posing technique. Hence, it is
only available for bones. To quickly create an IK constraint with a target, select a bone in pose mode, and press
Shift I.
This constraint is fully documented in the inverse kinematics page of the rigging chapter.
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Options

Inverse Kinematics panel

Target
Must be an armature
Bone
A bone in the armature
Pole Target
Object for pole rotation
Iterations
Maximum number of solving iterations
Chain Length
How many bones are included in the IK effect. Set to 0 to include all bones
Use Tail
Include bone’s tail as last element in chain
Stretch
Enable IK stretching
Weight:
Position
For Tree-IK: Weight of position control for this target
Rotation
Chain follow rotation of target
Target
Disable for targetless IK
Rotation
Chain follows rotation of target

Locked Track Constraint
The Locked Track constraint is a bit tricky to explain, both graphically and textually. Basically, it is a Track To
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constraint, but with a locked axis, i.e. an axis that cannot rotate (change its orientation). Hence, the owner can
only track its target by rotating around this axis, and unless the target is in the plane perpendicular to the locked
axis, and crossing the owner, this owner cannot really point at its target.
Let’s take the best real world equivalent: a compass. It can rotate to point in the general direction of its target
(the magnetic North, or a neighbor magnet), but it can’t point directly at it, because it spins like a wheel on an
axle. If a compass is sitting on a table and there is a magnet directly above it, the compass can’t point to it. If we
move the magnet more to one side of the compass, it still can’t point at the target, but it can point in the general
direction of the target, and still obey its restrictions of the axle.
When using a Locked Track constraint, you can think of the target as a magnet, and the owner as a compass.
The Lock axis will function as the axle around which the owner spins, and the To axis will function as the
compass’ needle. Which axis does what is up to you!
If you have trouble understanding the buttons of this constraint, read the tool-tips, they are pretty good. If you
don’t know where your object’s axes are, turn on the Axis button in the Object menu’s Draw panel. Or, if you’re
working with bones, turn on the Axes button in the Armature menu’s Display panel.
This constraint was designed to work cooperatively with the Track To constraint. If you set the axes buttons
right for these two constraints, Track To can be used to point the axle at a primary target, and Locked Track can
spin the owner around that axle to a secondary target.
This constraints also works very well for 2D billboarding.

Options

Locked track panel

Target
This constraint uses one target, and is not functional (red state) when it has none.
To
The tracking local axis (Y by default), i.e. the owner’s axis to point at the target. The negative options
force the relevant axis to point away from the target.
Lock
The locked local axis (Z by default), i.e. the owner’s axis which cannot be re-oriented to track
the target.
Warning
If you choose the same axis for To and Lock, the constraint will no longer be functional (red
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state).

Spline IK Constraint
The Spline IK constraint aligns a chain of bones along a curve. By leveraging the ease and flexibility of
achieving aesthetically pleasing shapes offered by curves and the predictability and well-integrated control
offered by bones, Spline IK is an invaluable tool in the riggers’ toolbox. It is particularly well suited for rigging
flexible body parts such as tails, tentacles, and spines, as well as inorganic items such as ropes.
To set up Spline IK, it is necessary to have a chain of connected bones and a curve to constrain these bones to.
• With the last bone in the chain selected, add a Spline IK constraint from the Bone Constraints tab in the
Properties Editor.
• Set the ‘Chain Length’ setting to the number of bones in the chain (starting from and including the
selected bone) that should be influenced by the curve.
• Finally, set Target to the curve that should control the curve.

Options

Spline IK panel

Target
The target curve
Spline Fitting:
Chain Length
How many bones are included in the chain
Even Division
Ignore the relative length of the bones when fitting to the curve
Chain Offset
Offset the entire chain relative to the root joint
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Chain Scaling:
Y stretch
Stretch the Y axis of the bones to fit the curve
XZ Scale Mode:
None
Don’t scale the X and X axes (default)
Bone Original
Use the original scaling of the bones
Volume Preservation
Scale of the X and Z axes is the inverse of the Y scale
Use Curve Radius
Average radius of the endpoints is used to tweak the X and Z scaling of the bones, on top of the X
and Z scale mode

Stretch To Constraint
The Stretch To constraint causes its owner to rotate and scale its Y axis towards its target. So it has the same
tracking behavior as the Track To constraint. However, it assumes that the Y axis will be the tracking and
stretching axis, and doesn’t give you the option of using a different one.
It also optionally has some raw volumetric features, so the owner can squash down as the target moves closer,
or thin out as the target moves farther away. Note however that it is not the real volume of the owner which is
thus preserved, but rather the virtual one defined by its scale values. Hence, this feature works even with nonvolumetric objects, like empties, 2D meshes or surfaces, and curves.
With bones, the “volumetric” variation scales them along their own local axes (remember that the local Y axis
of a bone is aligned with it, from root to tip).

Options

Stretch To panel for a Mesh Object

Target (Mesh Object Type)
This constraint uses one target, and is not functional (red state) when it has none.
Vertex Group
When Target is a mesh, a new field is display where a vertex group can be selected.
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Stretch To panel for a Armature Object

Target (Armature Object Type)
This constraint uses one target, and is not functional (red state) when it has none.
Bone
When Target is an armature, a new field for a bone is displayed.
Head/Tail
When using a Bone Target, you can choose where along this bone the target point lies.
Rest Length
This numeric field sets the rest distance between the owner and its target, i.e. the distance at which there
is no deformation (stretching) of the owner.
Reset
When clicked, this small button will recalculate the Rest Length value, so that it corresponds to the
actual distance between the owner and its target (i.e. the distance before this constraint is applied).
Volume Variation
This numeric field controls the amount of “volume” variation proportionally to the stretching amount.
Note that the 0.0 value is not allowed, if you want to disable the volume feature, use the None button (see
below).
Volume
These buttons control which of the X and/or Z axes should be affected (scaled up/down) to preserve the
virtual volume while stretching along the Y axis. If you enable the NONE button, the volumetric features
are disabled.
Plane
These buttons are equivalent to the Up ones of the Track To constraint: they control which of the X or Z
axes should be maintained (as much as possible) aligned with the global Z axis, while tracking the target
with the Y axis.

Track To Constraint
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Description
The Track To constraint applies rotations to its owner, so that it always points a given “To” axis towards its
target, with another “Up” axis permanently maintained as much aligned with the global Z axis (by default) as
possible. This tracking is similar to the “billboard tracking” in 3D (see note below).
This is the preferred tracking constraint, as it has a more easily controlled constraining mechanism.
This constraint shares a close relationship to the Inverse Kinematics constraint in some ways.
Tip
Billboard tracking
The term “billboard” has a specific meaning in real-time CG programming (i.e. video games!), where it is
used for plane objects always facing the camera (they are indeed “trackers”, the camera being their “target”).
Their main usage is as support for tree or mist textures: if they were not permanently facing the camera, you
would often see your trees squeezing to nothing, or your mist turning into a millefeuille paste, which would be
funny but not so credible.

Options

Track To panel

Targets
This constraint uses one target, and is not functional (red state) when it has none.
Bone
When Target is an armature, a new field for a bone is displayed.
Head/Tail
When using a bone target, you can choose where along this bone the target point lies.
Vertex Group
When Target is a mesh, a new field is display where a vertex group can be selected.
To
The tracking local axis (Y by default), i.e. the owner’s axis to point at the target. The negative options
force the relevant axis to point away from the target.
Up
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The “upward-most” local axis (Z by default), i.e. the owner’s axis to be aligned (as much as possible)
with the global Z axis (or target Z axis, when the Target button is enabled).
Target Z
By default, the owner’s Up axis is (as much as possible) aligned with the global Z axis, during the
tracking rotations. When this button is enabled, the Up axis will be (as much as possible) aligned with the
target’s local Z axis?
Space
This constraint allows you to choose in which space to evaluate its owner’s and target’s
transform properties.
Warning
If you choose the same axis for To and Up, the constraint will not be functional anymore (red state).

Action Constraint
The Action constraint is powerful. It allows you control an Action using the transformations of another object.
The underlying idea of the Action constraint is very similar to the one behind the Drivers, except that the former
uses a whole action (i.e. a bunch a Fcurves of the same type), while the latter controls a single Fcurve of their
“owner”...
Note that even if the constraint accepts the Mesh action type, only the Object, Pose and Constraint types are
really working, as constraints can only affect objects’ or bones’ transform properties, and not meshes’ shapes.
Also note that only the object transformation (location, rotation, scale) is affected by the action, if the action
contains keyframes for other properties they are ignored, as constraints do not influence those.
As an example, let’s assume you have defined an Object action (it can be assigned to any object, or even no
object at all), and have mapped it on your owner through an Action constraint, so that moving the target in the
[0.0, 2.0] range along its X axis maps the action content on the owner in the [0, 100] frame range.
This will mean that when the target’s X property is 0.0 the owner will be as if in frame 0 of the linked action;
with the target’s X property at 1.0 the owner will be as if in frame 50 of the linked action, etc.
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Options

Action panel

Target
This constraint uses one target, and is not functional (red state) when it has none.
Bone:
When target is an armature object, use this field to select the target bone.
Transform Channel
This drop-down list controls which transform property (location, rotation or scale along/around one of its
axes) from the target to use as “action driver”.
Target Space
This constraint allows you to choose in which space to evaluate its target’s transform properties.
To Action
Select the name of the action you want to use.
Warning
Even though it might not be in red state (UI refresh problems...), this constraint is obviously not
functional when this field does not contain a valid action.

Object Action
Bones only, when enabled, this option will make the constrained bone use the “object” part of the linked
action, instead of the “same-named pose” part. This allows you to apply the action of an object to a bone.
Target Range Min / Max
The lower and upper bounds of the driving transform property value. By default, both values
are set to 0.0
Warning
Unfortunately, here again we find the constraints limitations:
•

When using a rotation property as “driver”, these values are “mapped back” to the [-180.0- ,
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•

180.0- [ range.
When using a scale property as “driver”, these values are limited to null or positive values.

Action Range Start / End
The starting and ending frames of the action to be mapped. Note that:
• These values must be strictly positive.
• By default, both values are set to 0 which disables the mapping (i.e. the owner just gets the
properties defined at frame 0 of the linked action...).

Notes
• When the linked action affects some location properties, the owner’s existing location is added to the
result of evaluating this constraint (exactly as when the Offset button of the Copy Location constraint is
enabled...).
• When the linked action affects some scale properties, the owner’s existing scale is multiplied with the
result of evaluating this constraint.
• When the linked action affects some rotation properties, the owner’s existing rotation is overridden by
the result of evaluating this constraint.
• Unlike usual, you can have a Start value higher than the End one, or a Min one higher than a Max one:
this will reverse the mapping of the action (i.e. it will be “played” reversed...), unless you have both sets
reversed, obviously!
• When using a Constraint action, it is the constraint channel’s names that are used to determine to which
constraints of the owner apply the action. E.g. if you have a constraint channel named “trackto_empt1”,
its keyed Influence and/or Head/Tail values (the only ones you can key) will be mapped to the ones of
the owner’s constraint named “trackto_empt1”.
• Similarly, when using a Pose action (which is obviously only meaningful and working when
constraining a bone!), it is the bone’s name that is used to determine which bone channel’s names from
the action to use (e.g. if the constrained bone is named “arm”, it will use and only use the action’s bone
channel named “arm”...). Unfortunately, using a Pose action on a whole armature object (to affect all the
keyed bones in the action at once) won’t work...
• Note also that you can use the pose library feature to create/edit a Pose action data-block... just
remember that in this situation, there’s one pose per frame!

Child Of Constraint
Child Of is the constraint version of the standard parent/children relationship between objects
Parenting with a constraint has several advantages and enhancements, compared to the traditional method:
• You can have several different parents for the same object (weighting their respective influence with the
Influence slider).
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• As with any constraint, you can key (i.e. animate) its Influence setting. This allows the object which has
a Child Of constraint upon it to change over time which target object will be considered the parent, and
therefore have influence over the Child Of constrained object.
Warning
Don’t confuse this “basic” object parenting with the one that defines the chains of bones inside of
an armature. This constraint is used to parent an object to a bone (the so-called object skinning), or
even bones to bones. But don’t try to use it to define chains of bones.

Options

Child Of panel

Target
The target object that this object will act as a child of. This constraint uses one target, and is not
functional (red state) when it has none. If Target is an armature or a mesh, a new name field appears
where a name of a Bone or a Vertex Group can be selected.
Location X, Y, Z
Each of these buttons will make the parent affect or not affect the location along the corresponding axis.
Rotation X, Y, Z
Each of these buttons will make the parent affect or not affect the rotation around the corresponding axis.
Scale X, Y, Z
Each of these buttons will make the parent affect or not affect the scale along the corresponding axis.
Set Inverse
By default, when you parent your owner to your target, the target becomes the origin of the owner’s
space. This means that the location, rotation and scale of the owner are offset by the same properties of
the target. In other words, the owner is transformed when you parent it to your target. This might not be
desired! So, if you want to restore your owner to its before-parenting state, click on the Set Inverse button.
Clear Inverse
This button reverses (cancels) the effects of the above one, restoring the owner/child to its default state
regarding its target/parent.
Tips

When creating a new parent relationship using this constraint, it is usually necessary to click on the Set Inverse
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button after assigning the parent. As noted above, this cancels out any unwanted transform from the parent, so
that the owner returns to the location/rotation/scale it was in before the constraint was applied. Note that you
should apply Set Inverse with all other constraints disabled (their Influence set to 0.0) for a particular Child Of
constraint, and before transforming the target/parent (see example below).
About the toggle buttons that control which target’s (i.e. parent’s) individual transform properties affect the
owner, it is usually best to leave them all enabled, or to disable all three of the given Location, Rotation or
Scale transforms.

Technical Note
If you use this constraint with all channels on, it will use a straight matrix multiplication for the parent
relationship, not decomposing the parent matrix into loc/rot/size. This ensures any transformation correctly gets
applied, also for combinations of rotated and non-uniform scaled parents.

Examples

1. No constraint Note the position of Owner
empty - 1.0 BU along X and Y axes.

2. Child Of just added Here you can see that
Owner empty is now 1.0 BU away from
Target_1 empty along X and Y axes.

3. Offset set Set Inverse has been clicked, and
Owner is back to its original position.

4. Target/parent transformed Target_1 has
been translated in the XY plane, rotated around
the Z axis, and scaled along its local X axis.

5. Offset cleared Clear Inverse has been
clicked - Owner is fully again controlled by
Target_1.

6. Offset set again Set Offset has been clicked
again. As you can see, it does not gives the same
result as in (Target/parent transformed). As
noted above, use Set Inverse only once, before
transforming your target/parent.

Floor Constraint
Description
The Floor constraint allows you to use its target position (and optionally rotation) to specify a plane with a
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“forbidden side”, where the owner cannot go. This plane can have any orientation you like. In other words, it
creates a floor (or a ceiling, or a wall)! Note that it is only capable of simulating entirely flat planes, even if you
use the Vertex Group option. It cannot be used for uneven floors or walls.

Options

Floor panel

Targets
This constraint uses one target, and is not functional (red state) when it has none.
Bone
When Target is an armature, a new field for a bone is displayed.
Vertex Group
When Target is a mesh, a new field is display where a vertex group can be selected.
Sticky
This button makes the owner immovable when touching the “floor” plane (it cannot slide around on the
surface of the plane any more). This is fantastic for making walk and run animations!
Use Rotation
This button forces the constraint to take the target’s rotation into account. This allows you to have a
“floor” plane of any orientation you like, not just the global XY, XZ and YZ ones...
Offset
This numeric field allows you to offset the “floor” plane from the target’s center, by the given number of
Bforartists Units. Use it e.g. to account for the distance from a foot bone to the surface of the foot’s mesh.
Max / Min
This set of (mutually exclusive) buttons controls which plane will be the “floor”. The buttons’ names
correspond indeed to the normal to this plane (e.g. enabling Z means “XY plane”, etc.) By default, these
normals are aligned with the global axes. However, if you enable Use Rotation (see above), they will be
aligned with the local target’s axes. As the constraint does not only define an uncrossable plane, but also a
side of it which is forbidden to the owner, you can choose which side by enabling either the positive or
negative normal axis... E.g, by default (Z), the owner is stuck in the positive Z coordinates.
Space
This constraint allows you to choose in which space to evaluate its owner’s and target’s transform
properties.

Follow Path Constraint
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The Follow Path constraint places its owner onto a curve target object, and makes it move along this curve (or
path). It can also affect its owner’s rotation to follow the curve’s bends, when the Follow Curve option is
enabled.
The owner is always evaluated in the global (world) space:
• Its location (as shown in the Transform Properties panel, N) is used as an offset from its normal position
on the path. E.g. if you have an owner with the (1.0, 1.0, 0.0) location, it will be one BU away
from its normal position on the curve, along the X and Y axis. Hence, if you want your owner on its
target path, clear its location (Alt-G)!
• This location offset is also proportionally affected by the scale of the target curve. Taking the same
(1.0, 1.0, 0.0) offset as above, if the curve has a scale of (2.0, 1.0, 1.0), the owner will
be offset two BU along the X axis (and one along the Y one)...
• When the Curve Follow option is enabled, its rotation is also offset to the one given by the curve (i.e. if
you want the Y axis of your object to be aligned with the curve’s direction, it must be in rest, nonconstrained state, aligned with the global Y axis). Here again, clearing your owner’s rotation (Alt-R)
might be useful...
The movement of the owner along the target curve/path may be controlled in two different ways:
• The most simple is to define the number of frames of the movement, in the Path Animation panel of the
Object Data context, via the numeric field Frames, and its start frame via the constraint’s Offset option
(by default, start frame: 1 [= offset of 0)], duration: 100).
• The second way, much more precise and powerful, is to define a Evaluation Time interpolation curve for
the Target path (in the Graph Editor. See the animation chapter to learn more about Fcurves.
• If you don’t want your owner to move along the path, you can give to the target curve a flat Speed
FCurve (its value will control the position of the owner along the path).
Follow Path is another constraint that works well with the Locked Track one. One example is a flying camera
on a path. To control the camera’s roll angle, you can use a Locked Track and a target object to specify the up
direction, as the camera flies along the path.
Note
Follow Path and Clamp To
Do not confuse these two constraints. Both of them constraint the location of their owner along a curve, but
Follow Path is an “animation-only” constraint, inasmuch that the position of the owner along the curve is
determined by the time (i.e. current frame), whereas the Clamp To constraint determines the position of its
owner along the curve using one of its location properties’ values.

Note
Note that you also need to keyframe Evaluation Time for the Path. Select the path, go to the path properties,
set the overall frame to the first frame of the path (e.g. frame 1), set the value of Evaluation time to the first
frame of the path (e.g. 1), right click on Evaluation time, select create keyframe, set the overall frame to the
last frame of the path (e.g. frame 100), set the value of Evaluation time to the last frame of the path (e.g. 100),
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right click on Evaluation time, select create keyframe. .. Comment: <!– from http://overshoot.tv/node/1123
paragraph needs cleanup but this definitely needs to be in the documentation –> .

Options

Follow Path panel

Target
This constraint uses one target, which must be a curve object, and is not functional (red state) when it has
none.
Curve Radius
Objects scale by the curve radius. See Curve Editing
Fixed Position
Object will stay locked to a single point somewhere along the length of the curve regardless of time
Offset
The number of frames to offset from the “animation” defined by the path (by default, from frame 1).
Follow Curve
If this option is not activated, the owner’s rotation isn’t modified by the curve; otherwise, it’s affected
depending on the following options:
Forward
The axis of the object that has to be aligned with the forward direction of the path (i.e. tangent to the
curve at the owner’s position).
Up
The axis of the object that has to be aligned (as much as possible) with the world Z axis. In fact,
with this option activated, the behavior of the owner shares some properties with the one caused by
a Locked Track constraint, with the path as “axle”, and the world Z axis as “magnet”.

Pivot Constraint
Description
The Pivot constraint allows the owner to rotate around a target object.
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It was originally intended for foot rigs.

Options

Pivot panel

Target
The object to be used as a pivot point
Bone
When Target is an armature, a new field for a bone is displayed.
Head/Tail
When using a bone target, you can choose where along this bone the target point lies.
Vertex Group
When Target is a mesh, a new field is display where a vertex group can be selected.
Pivot Offset
Offset of pivot from target
Pivot When
Always, Z Rot, Y Rot...

Rigid Body Joint Constraint
Description
The Rigid Body Joint constraint is very special. Basically, it is used by the physical part of the Bforartists Game
Engine to simulate a joint between its owner and its target. It offers four joint types: hinge type, ball-and-socket
type, cone-twist, and generic six-DoF (degrees of freedom) type.
The joint point and axes are defined and fixed relative to the owner. The target moves as if it were stuck to the
center point of a stick, the other end of the stick rotating around the joint/pivot point...
This constraint is of no use in most “standard” static or animated projects. However, you can use its results
outside of the BGE, through the Game ‣ Record Animation menu entry (from the main menu of the User
Preferences window, see Rigid Bodies for more info on this topic).
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Note
In order for this constraint to work properly, both objects (so the owner and the target object) need to have
“Collision Bounds” enabled.

Options

Rigid Body Joint panel

Target
This constraint uses one target, and is not functional (red state) when it has none.
Joint Type:
Ball
works like an ideal ball-and-socket joint, i.e. allows rotations around all axes like a shoulder joint.
Hinge
works in one plane, like an elbow: the owner and target can only rotate around the X axis of the
pivot (joint point).
Limits
Angular limits for the X axis
Cone Twist
similar to Ball, this is a point-to-point joint with limits added for the cone and twist axis
Limits
Angular limits
Generic 6DOF
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works like the Ball option, but the target is no longer constrained at a fixed distance from the pivot
point, by default (hence the six degrees of freedom: rotation and translation around/along the three
axes). In fact, there is no longer a joint by default, with this option, but it enables additional settings
which allow you to restrict some of these DoF:
Limits
Linear and angular limits for a given axis (of the pivot) in Bforartists Units and degrees
respectively.
Child Object
normally, leave this blank. You can reset it to blank by right clicking and selecting Reset to Default Value.
Comment: <!– Is this right? 2.4 just had a ‘to object’. Now we have a ‘target’ and a ‘child object’. These
are not documented. It seems that we recreate the behaviour of 2.4 by leaving the child object blank. The
target seems to be the 2.4 ‘to object’. What is the child object? Please explain: m.e –> .
Linked Collision
When enabled, this will disable the collision detection between the owner and the target (in the physical
engine of the BGE).
Display Pivot
When enabled, this will draw the pivot of the joint in the 3D views. Most useful, especially with the
Generic 6DOF joint type!
Pivot
These three numeric fields allow you to relocate the pivot point, in the owner’s space.
Axis
These three numeric fields allow you to rotate the pivot point, in the owner’s space.

Shrinkwrap Constraint
The Shrinkwrap constraint is the “object counterpart” of the Shrinkwrap modifier. It moves the owner origin
and therefore the owner object’s location to the surface of its target.
This implies that the target must have a surface. In fact, the constraint is even more selective, as it can only use
meshes as targets. Hence, the Shrinkwrap option is only shown in the Add Constraint to Active Object menu, (or
its bone’s equivalent), when the selected inactive object is a mesh.

Options

Shrinkwrap panel

Target
This constraint uses one target, which must be a mesh object, and is not functional (red state) when it has
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none.
Distance
This numeric field controls the offset of the owner from the shrunk computed position on the target’s
surface. Positive values place the owner “outside” of the target, and negative ones, “inside” the target.
This offset is applied along the straight line defined by the original (i.e. before constraint) position of the
owner, and the computed one on the target’s surface.
Shrinkwrap Type
This drop-down list allows you to select which method to use to compute the point on the target’s surface
to which to translate the owner’s center. You have three options:
Nearest Surface Point
The chosen target’s surface’s point will be the nearest one to the original owner’s location. This is
the default and most commonly useful option.
Projection
The target’s surface’s point is determined by projecting the owner’s center along a given axis. This
axis is controlled by the three X, Y and Z toggle buttons that show up when you select this type. This
mean the projection axis can only be aligned with one of the global axes, median to both of them
(XY, XZ or YZ), or to the three ones (XYZ). When the projection of the owner’s center along the
selected direction does not hit the target’s surface, the owner’s location is left unchanged.
Nearest Vertex
This method is very similar to the Nearest Surface Point one, except that the owner’s possible
shrink locations are limited to the target’s vertices.
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Armatures
An “armature” is a type of object used for rigging. Armature object borrows many ideas from real life
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skeletons.

Your first armature
In order to see what we’re talking about, let’s try to add the default armature in Bforartists.
(Note that armature editing details are explained in the armatures editing section).
Open a default scene, then:
delete all objects in the scene
make sure the cursor is in the world origin with Shift-C
press Numpad1 to see the world in Front view
then, either: - in the Main Menu, Go to Add > Armature > Single Bone - -or- in the 3D view, add an
armature with Shift-A pop-up ‣ Armature ‣ Single Bone
• press NumpadDelete to see the armature at maximum zoom
•
•
•
•

The default armature Toolbox: –> Add Armature –> Single Bone

The armature object
As you can see, an armature is like any other object type in Bforartists:
•
•
•
•

It has a center, a position, a rotation and a scale factor.
It has an ObData data-block, that can be edited in Edit mode.
It can be linked to other scenes, and the same armature data can be reused on multiple objects.
All animation you do in Object mode is only working on the whole object, not the armature’s bones (use
the Pose mode to do this).

As armatures are designed to be posed, either for a static or animated scene, they have a specific state, called
“rest position”. This is the armature’s default “shape”, the default position/rotation/scale of its bones, as set in
Edit mode.
In Edit mode, you will always see your armature in rest position, whereas in Object and Pose mode, you usually
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get the current “pose” of the armature (unless you enable the Rest Position button of the Armature panel).

Armature chapter overview
In the “Armatures” section, we will only talk about armatures themselves, and specifically we will talk about:
•
•
•
•
•
•
•
•
•
•

the armature object panels
the basics of bones
the different armature visualizations
the armature structure types
how to select its parts,
how to edit an armature
how to Edit Bones
how to edit bones properties
how to sketch armatures with the Etch-a-Ton tool
how to use templates

Bones

The elements of a bone.

Bones are the base elements of armatures.
They have three elements:
• the “start point” named root or head,
• the “body” itself,
• and the “end point” named tip or tail.
With the default armature in edit-mode, you can select the root and the tip, and move them as you do with mesh
vertices.
Both root and tip (the “ends”) define the bone by their respective position.
They also have a radius property, only useful for the envelope deformation method (see below).

Bones Visualization
Bones can be visualized in various ways: Octahedron, Stick, B-Bone, Envelope and Wire. Custom shapes can be
4
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used, too!

Octahedral bone display.

Stick bone display.

B-Bone bone display.

Envelope bone display.

Since armatures are made of bones, you’ll find more about this when we’ll talk about Armatures Visualization.
Activating Axes checkmark on the Armature / Display panel, will show local axes for each bone’s tip. The Y
axis is always aligned along the bone, oriented from root to tip. So, this is the “roll” axis of the bones.

The Bone context.
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Bones properties
When bones are selected (hence in Edit mode and Pose mode), their properties are shown in the Bone button
context of the Properties window.
This shows different panels used to control features of each selected bone; the panels change depending on
which mode you’re working in.

Bones Rigidity
Even though bones are rigid (i.e. behave as rigid sticks), they are made out of segments. Segments are small,
rigid linked elements that can rotate between each other. By default, each new bone has only one segment and
as such it cannot “bend” along its length. It is a rigid bone.
You can see these segments in Object mode and in Pose mode, and only if bones are visualized as B-bones;
while in Edit mode bones are always drawn as rigid sticks. Note that in the special case of a single bone, you
can’t see these segments in Object mode, because they’re aligned.

An armature of B-Bones, in Edit mode

The Bézier curve superposed to the chain, with its handles placed at bones’ ends.

The same armature in Object mode

When you connect bones to form a chain, Bforartists calculates a Bezier curve passing through all the bones’
ends, and bones’ segments in the chain will bend and roll to follow this invisible curve.
You have no direct access to this curve; you can only control it to some extent using bone properties, as
explained in the editing pages.
In An armature of B-Bones in Edit mode we connected 3 bones, each one made of 5 segments. These are Bbones but as you see, in Edit mode they are shown as rigid elements. Look at The same armature in Object
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mode: now, in Object mode, we can see how the bones’ segments smoothly “blend” into each other, even for
roll.
Of course, a geometry influenced by the chain is smoothly deformed according to the Bezier curve! In fact,
smooth bones are an easy way to replace long chains of many small rigid bones posed using IK...
However, if the chain has an influence on objects rather than geometry, the segments’ orientation is not taken in
account (details are explained in the skinning part).
When not visualized as B-Bone s, bones are always shown as rigid sticks, even though the bone segments are
still present and effective (see skinning to ObData).
This means that even in e.g. Octahedron visualization, if some bones in a chain have several segments, they
will nonetheless smoothly deform their geometry...

Bones Influence
Basically, a bone controls a geometry when vertices “follow” the bone. This is like how the muscles and skin of
your finger follow your finger-bone when you move a finger.
To do this, you have to define how much a bone influences a certain vertex.
The simplest way is to have each bone affecting those parts of the geometry that are within a given range from
it. This is called the envelope technique, because each bone can control only the geometry “enveloped” by its
own influence area.

A bone in Envelope visualization, in Edit mode.

If a bone is visualized as Envelope, in Edit mode and in Pose mode you can see the area of influence, which
depends on:
• the distance property
• the root’s radius and the tip’s radius.
7
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Our armature in Envelope visualization, in Pose mode.

All these influence parameters are further detailed in the skinning pages.

Armature Editing
Reference
Mode: Edit mode
As with any other object, you edit your armature in Edit mode
Editing an armature means two main domains of action:
• Editing the bones - i.e. adding/inserting/deleting/extruding/sub-dividing/joining them...
• Editing the bones’ properties - this includes key features, like transform properties (i.e. grab, scale,
etc...) and relationships between bones (parenting and connecting), as well as bones’ names, influence,
behavior in Pose mode, etc.
These are standard editing methods, quite similar for example to meshes editing. Bforartists also features a
more advanced “armature sketching” tool, called Etch-a-Ton. The same tool might also be used in templating,
i.e. using another armature as template for the current one...
Warning
One important thing to understand about armature editing is that you edit the rest position of your armature,
i.e. its “default state”. An armature in its rest position has all bones with no rotation and scaled to 1.0 in their
own local space.

The different poses you might create afterwards are based on this rest position - so if you modify it in Edit
mode, all the poses already existing will also be modified. Thus you should in general be sure that your
armature is definitive before starting to skin and pose it!
Warning
Please note that some tools work on bones’ ends, while others work on bones themselves. Be careful not to get
confused.
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Armature Panels Overview
Reference
Reference
Mode: Object mode, Edit mode and Pose mode
Panel: All in Properties window, Object data property

Let’s first have a general overview of the various panels gathering the armature settings, in Properties window,
Object data context:

The Object data property in the Properties window.

Skeleton panel (all modes)

The Skeleton panel.

In this panel you can arrange sets of bones into different layers for easier manipulation.

Display panel (all modes)

The Display panel.
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This controls the way the bones appear in 3D view; you have 4 different options you can select.
There are several other options available which we will cover later on.

Bone groups panel (pose mode)

The Bone Groups panel.

Lets you assign sets of bones into groups for easy manipulation and management.

Pose Library panel (Pose mode)

The Pose Library panel.

Allows you to save different settings (location, rotation, scale) for selected bones for later use.

Ghost panel (all modes)

The Ghost panel.

Allows you to see a set of different consecutive poses, very useful when animating.

iTaSC parameters panel (all modes)
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The iTaSC parameters panel.

Defines the type of IK solver used in your animation.

Motion Paths panel (Pose mode)

The Motion Paths panel.

In this panel you can enable visualization of the motion path your skeleton leaves when animated.

Custom Properties panel (all modes)

The Custom Properties panel.

Panel for defining custom properties; this is used when scripting.

Bone Panels Overview
Reference
Mode: Object mode, Edit mode and Pose mode
Panel: All in Properties window, Bone property
Let’s first have a general grasp of the various panels gathering the bone settings, in Properties window, Bone
context:
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The Bone context.

Relations panel (edit mode)

The Relations panel.

In this panel you can arrange sets of bones in different layers for easier manipulation.

Display panel (object mode)

The Display panel.

Display panel lets you customize the look of your bones taking the shape of a another existing object.

Deform panel (all modes)

The Deform panel.

In this panel you can set basic properties of the bones.
Turning the Deform option on and off, includes the active bone in the Automatic Weight Calculation when the
Mesh is Parented to the Armature using the Armature Deform with the “With Automatic Weights” option.
Also it’s worth noting that by turning off a bone’s deform option, makes it not influence the mesh at all,
overriding any weights that it might have been assigned before; It mutes its influence.
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Custom Properties panel (all modes)

The Custom Properties panel.

Panel for defining custom properties, this is used when scripting.

Transform panel (edit and pose mode)

The Transform panel(edit mode).

When in edit mode you can use this panel to control position and roll of individual bones.
When in pose mode you can only set location for the main bone, and you can now set rotation and scale.

The Transform panel(pose mode).

Transform Locks panel (pose mode)

The Transform Locks panel.

This panel appears only in pose mode and allows you to restrict position, rotation and scale by axis on each
bone in the armature.
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Inverse Kinematics panel (pose mode)

The Inverse Kinematics panel.

This panel controls the way a bone or set of bones behave when linked in an inverse kinematic chain.

Selecting armature’s bones
Reference
Mode: Edit mode
Panel: Bone panel
You can select and edit bones of armatures in Edit mode and in Pose mode. Here, we will see how to select
bones in Edit mode. Selecting bones in Pose mode is similar to selecting in Edit mode with a few specific
differences that will be detailed in the posing part.
Similar to vertices/edges selection in meshes, there are two ways to select whole bones in Edit mode:
• directly, by selecting the bone’s body
• selecting both of its end points (root and tip)
This is an important point to understand, because selecting bones’ ends only might lead to non-obvious
behavior, with respect to which bone you actually select, see the.
Note that unlike the mesh draw type the armature draw type has no effect on selection behavior. In other words,
you can select a bone’s end or body the same way regardless of the bone visualization chosen.

Selecting bones’ ends
To select bones’ ends you have the standard selection methods.
action
Select a bone’s end
Add or Remove from the
current selection

shortcut

menu
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action
Box selection

Box selection tool OFF
Lasso selection

shortcut
Click and drag LMB the
box around the ends you
want to add to the current
selection
Click and drag LMB to
remove from the current
selection
release LMB to validate
press Esc or click RMB to
cancel
B or Esc
Click and drag Ctrl-LMB
the lasso around the ends
you want to add to the
current selection
Click and drag CtrlShift-LMB to remove
from the current selection
Release LMB to validate
Hit Esc or click RMB to
cancel

menu

mouse

RMB

Inverse selection
As stated above, you have to remember that these selection tools are for bones’ ends only, not the bones’ bodies.
For example, the Inverse selection option inverts the selection of bones’ ends, not of bones (see Inverse
selection).
Remember that a bone is selected only if both its ends are selected. So, when the selection status of bones’ ends
is inverted, a new set of bones is selected.
Inverse selection

Two bones selected.

The result of the inverse selection Ctrl-I the bones
ends selection has been inverted, and not the bones
selection.

Selecting connected bones’ ends
Another example is: when you select the root of a bone connected to its parent, you also implicitly select the tip
of its parent (and vice versa).
Remember: when selecting bones’ ends, the tip of the parent bone is the “same thing” as the root of its children
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bones.

Selecting Bones
By RMB -clicking on a bone’s body, you will select it (and hence you will implicitly select its root and tip).
To each selected bone corresponds a sub-panel in the Armature Bones panel (Editing context). These sub-panels
contain settings for some of the bones’ properties (regarding e.g. relationships between bones, bones’ influence
on deformed geometry, etc.), as we will see later.
Using Shift-click , you can add to/remove from the selection.
You also have some advanced selection options, based on their relations.
You can select at once all the bones in the chain which the active (last selected) bone belongs to by using the
linked selection tool, L.
Linked bones selection

A single selected bone.

Its whole chain selected with [L].

You can deselect the active bone and select its immediate parent or one of its children using respectively Select

Deselecting connected bones
There is a subtlety regarding connected bones.
When you have several connected bones selected, if you deselect one bone, you will in fact deselect its tip, but
not its root if it is also the tip of another selected bone.
To understand this, look at Bone deselection in a selected chain.
Bone deselection in a selected chain

A selected chain.

After Shift-RMB -clicking Bone.003:
• Bone.003 ‘s tip (which is same as Bone.004 ‘s root) is deselected
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• Bone is Bone.003 ‘s parent. Therefore Bone.003 ‘s root is same as the tip of Bone. Since Bone is
still selected, its tip is selected. Thus the root of Bone.003 remains selected.

Armature Structure

Example of a very basic armature.

Armatures mimic real skeletons. They are made out of bones, which are (by default) rigid elements. But you
have more possibilities than with real skeletons: In addition to the “natural” rotation of bones, you can also
translate and even scale them! And your bones do not have to be connected to each other; they can be
completely free if you want. However, the most natural and useful setups imply that some bones are related to
others, forming so-called “chains of bones”, which create some sort of “limbs” in your armature, as detailed in
Chains of Bones.

Chains of Bones

An armature with two chains of bones.

The bones inside an armature can be completely independent from each other (i.e. the modification of one bone
does not affect the others). But this is not often a useful set up: To create a leg, all bones “after” the thigh bone
should move “with” it in a well-coordinated manner. This is exactly what happens in armatures - by parenting a
bone to the next one in the limb, you create a “chains of bones”. These chains can be ramified. For example,
five fingers attached to a single “hand” bone.
Bones are chained by linking the tip of the parent to the root of the child. Root and tip can be connected, i.e.
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they are always exactly at the same point; or they can be free, like in a standard parent-child object relationship.
A given bone can be the parent of several children, and hence be part of several chains at the same time.
The bone at the beginning of a chain is called its root bone, and the last bone of a chain is the tip bone (don’t
confuse them with similar names of bones’ ends!).
Chains of bones are a particularly important topic in posing (especially with the standard forward kinematics
versus “automatic” inverse kinematics posing techniques). You create/edit them in Edit mode, but except in case
of connected bones, their relationships have no effect on bone transformations in this mode (i.e. transforming a
parent bone won’t affect its children).

Editing Bones Relationships
This is detailed in the editing pages, but let us have a quick look at this important feature.

The Armature Bones panel with two bones selected, and their Child of settings highlighted.

The easiest way to manage bones relationships is to use the Relations panel Bone context:
•
•
•
•
•

First, select the bones you want to edit (selection order does not matter here).
To parent a bone to another one, select the name of this parent in its drop-down Parent list.
To unparent a bone, just select the void entry in the same Parent list.
To connect a bone to its parent, enable its small Con button.
To unconnect a bone, disable its Con button.

Armature visualization
We have 4 basic bone visualization: Octahedral, Stick, B-Bone, Envelope and Wire:

Octahedral bone display.
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Stick bone display.

B-Bone bone display.

Envelope bone display.

Display Panel
Reference
Mode: Object, Edit and Pose modes
Panel: Display Object Data context

But let’s first see some general visualization properties of armatures, found in the Display panel of the Object
data context.

The Display panel.

Bone Types
Octahedral bone
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This is the default visualization, well suited for most of editing tasks. It materializes:
• The bone root (“big” end) and tip (“small” end).
• The bone “size” (its thickness is proportional to its length).
• The bone roll (as it has a square section).

Note the 40- rolled Bone.001 bone.

Stick bone
This is the simplest and most non-intrusive visualization. It just materializes bones by sticks of constant
(and small) thickness, so it gives you no information about root and tip, nor bone size or roll angle.

Note that Bone.001 roll angle is not visible (except by its XZ axes).

B-Bone bone
This visualization shows the curves of “smooth” multi-segmented bones; see the bone page for details.

Envelope bone
This visualization materializes the bone deformation influence. More on this in the bone page.

Draw Options
Names
When enabled, the name of each bone is drawn.
Colors
This is only relevant for Pose mode, and is described in detail there.
Axes
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When enabled, the (local) axes of each bone are drawn (only relevant for Edit and Pose modes).
X-Ray
When enabled, the bones of the armature will always be drawn on top of the solid objects (meshes,
surfaces, ...) - i.e. they will always be visible and selectable (this is the same option as the one found in
the Display panel of the Object data context. Very useful when not in Wireframe mode.
Shapes
When enabled, the default standard bone shape is replaced, in Object and Pose modes, by the shape of a
chosen object (see Shaped Bones for details).
Delay Refresh
When enabled, the bone doesn’t deform its children when manipulating the bone in pose mode.

Shaped Bones
Reference
Mode: Object and Pose modes
Panel: Display panel from Bone context.
Bforartists allows you to give to each bone of an armature a specific shape (in Object and Pose modes), using
another object as “template”. First of all, you have to enable the Shapes button (Armature panel).

The Display panel.

Attributes
Wireframe
When enabled, bone is displayed in wireframe mode regardless of the viewport drawing mode. Useful for
non-obstructive custom bone chains.
Hide
Bone is not visible when not in Edit mode.
Custom Shape
Object that defines the custom shape of the selected bone.
Custom At
Bone that defines the display transform of this shape bone
To assign a custom shape to a bone, you have to:
• Switch to Pose mode
• Select the relevant bone
• Go to the Display panel Custom Shape field and select the 3D object previously created in the scene; in
this example we are using a cube and a cone. Tou can optionally set the At field to another bone.
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The Display panel.

The armature with shapes assigned to two bones, in Object mode. Note the centers of the Cone and Cube objects.

The same armature in Pose mode...

Note that:
• These shapes will never be rendered - like any bone, they are only visible in 3D views.
• Even if any type of object seems to be accepted by the OB field (meshes, curves, even metas...), only
meshes really work - all other types just make the bone invisible; nothing is drawn...
• The center of the shape object will be at the root of the bone (see the bone page for root/tip).
• The object properties of the shape are ignored (i.e. if you make a parallelepiped out of a cube by
modifying its dimensions in Object mode, you’ll still have a cube shaped bone...).
• The “along bone” axis is the Y one, and the shape object is always scaled so that one Bforartists Unit
stretches along the whole bone length.
• If you need to remove the custom shape of the bone, just right click in the Custom Shape field and select
Reset to default value in the pop-up menu.
So to summarize all this, you should use meshes as shape objects, with their center at their lower-Y end, and an
overall Y length of 1.0 BU.

Armature Layers
Reference
Mode: Object, Edit and Pose modes
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Panel: Skeleton panel, Object data context

The Skeleton panel.

Each armature has 32 “Armature layers” which allow you to organize your armature by “regrouping” sets of
bones into layers; this works similar to scene layers (those containing your objects). You can then “move” a
bone to a given layer, hide or show one or several layers, etc.

Showing/hiding bone layers
Only bones in active layers will be visible/editable - but they will always be effective (i.e move objects or
deform geometry), whether in an active layer or not. To (de)activate a layer, you have several options,
depending in which mode you are in:
• In all modes, use the row of small buttons at the top of the Display Options group, Armature panel. If
you want to enable/disable several layers at once, as usual, hold Shift while clicking...
• In Edit and Pose modes, you can also do this from the 3D View s, by using the menu (Armature ‣
Switch Armature Layers or Pose ‣ Switch Armature Layers), to display a small pop-up dialog
containing the same buttons as described above (here again, you can use Shift-LMB clicks to
(de)select several layers at once).

Protected Layers
You can lock a given bone layer for all proxies of your armature, i.e. all bones in this layer won’t be editable.
To do so, in the Skeleton panel, Ctrl-LMB click on the relevant button, the layer lock will be enabled.
Protected layers in proxy are restored to proxy settings on file reload and undo.

Bone Layers
Reference
Mode: Object, Edit and Pose modes
Panel: Relations panel Bone context
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The Relations panel.

Moving bones between layers
Obviously, you have to be in Edit or Pose modes to move bones between layers - note that as with objects,
bones can lay in several layers at once, just use the usual Shift-LMB clicks... First of all, you have to select
the chosen bone(s)!
• In the Button window, use the “layer buttons” of each selected bone “sub-panel” (Armature Bones
panel) to control in which layer(s) it lays.
• In the 3D View window, use the menu (Armature ‣ Move Bone To Layer or Pose ‣ Move Bone To
Layer) to show the usual pop-up layers dialog. Note that this way, you assign the same layers to all
selected bones.

Hiding Bones
Reference
Mode: Edit and Pose modes
Panel: Display panel, Bone context

The Display panel.

You do not have to use bone layers to show/hide some bones. As with objects, vertices or control points, you
can use the Hide command.
You can also use the Hide check button of the Display panel, Bone context).
Note that hidden bones are specific to a mode - i.e. you can hide some bones in Edit mode, they will still be
visible in Pose mode, and vice-versa. Hidden bone in Pose mode are also invisible in Object mode. And in Edit
mode, the bone to hide must be fully selected, not just his root or tip...

Editing
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Editing Bones
Reference
Mode: Edit mode

You’ll learn here how to add (Adding Bones), delete (Deleting Bones) or subdivide (Subdividing Bones) bones.
We will also see how to prevent any bone transformation (Locking Bones) in Edit mode, and the option that
features an automatic mirroring (X-Axis Mirror Editing) of editing actions along the X axis.

Adding Bones
To add bones to your armature, you have more or less the same options as when editing meshes:
•
•
•
•
•

Add menu,
extrusion,
Ctrl-LMB clicks,
fill between joints,
duplication.

Add Menu
Reference
Mode: Edit mode
Menu: Tool Shelf > Tools > Armature Tools
This bone will be:
•
•
•
•

of one Bforartists Unit of length,
oriented towards the positive Y axis of the view,
with its root placed at the 3D cursor position,
with no relationship with any other bone of the armature.

Extrusion
Reference
Mode: Edit mode
Menu: Armature ‣ Extrude
You can create a new bone by extrude. This bone will be the child of “its” tip owner, and connected to it. As
usual, once extrusion is done, only the new bones’ tips are selected, and in grab mode, so you can place them to
your liking. See (Extrusion example).
Extrusion example
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An armature with three selected tips.
The three extruded bones.

You also can use the rotating/scaling extrusions, as with meshes, by pressing respectively E-R and E-S - as
well as locked extrusion along a global or local axis.
Mirror extrusion example

A single selected bone’s tip.

The two mirror-extruded bones.

Bones have an extra “mirror extruding” tool, it behaves exactly like the standard extrusion. But once you have
enabled the X-Axis mirror editing option (see X-Axis Mirror Editing), each extruded tip will produce two new
bones, having the same name except for the _L/_R suffix (for left/right, see the next page). The _L bone
behaves like the single one produced by the default extrusion - you can grab/rotate/scale it exactly the same
way. The _R bone is its mirror counterpart (along the armature’s local X axis), see (Mirror extrusion example).
Warning
Cancelling the extrude action causes the newly created bones to snap back to the source position, (creating
zero length bones). These will be removed when exiting editmode, however they can cause confusion and it’s
unlikely you want to keep them. If you realize the problem immediately undo the extrude action.
In case you’re wondering, you cannot just delete to solve this as you would in mesh editing, because extrusion
selects the newly created tips, and as explained below the delete command ignores bones’ ends. To get rid of
these extruded bones without undoing, you would have to move the tips, then select the bones and delete
(Deleting Bones) them.

Mouse Clicks
Reference
Mode: Edit mode
Hotkey: Ctrl-LMB
If at least one bone is selected, Ctrl-LMB -clicking adds a new bone.
About the new bone’s tip:
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• after you Ctrl-LMB -clicked it becomes the active element in the armature,
• it appears to be right where you clicked, but...
• ...(as in mesh editing) it will be on the plane parallel to the view and passing through the 3D cursor.
The position of the root and the parenting of the new bone depends on the active element:

Ctrl-clicking when the active element is a bone

If the active element is a bone
• the new bone’s root is placed on the active bone’s tip
• the new bone is parented and connected to the active bone (check the outliner in Ctrl-clicking when the
active element is a bone).

Ctrl-clicking when the active element is a tip

If the active element is a tip :
• the new bone’s root is placed on the active tip
• the new bone is parented and connected to the bone owning the active tip (check the outliner in Ctrlclicking when the active element is a tip).

Ctrl-clicking when the active element is a disconnected root

If the active element is a disconnected root :
• the new bone’s root is placed on the active root
• the new bone is NOT parented to the bone owning the active root (check the outliner in Ctrl-clicking
when the active element is a disconnected root).
And hence the new bone will not be connected to any bone.
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Ctrl-clicking when the active element is a connected root

If the active element is a connected root :
• the new bone’s root is placed on the active root
• the new bone IS parented and connected to the parent of the bone owning the active root (check the
outliner in Ctrl-clicking when the active element is a connected root).
This should be obvious because if the active element is a connected root then the active element is also the tip
of the parent bone, so it is the same as the second case.
As the tip of the new bone becomes the active element, you can repeat these ctrl-clicks several times, to
consecutively add several bones to the end of the same chain.

Fill between joints
Reference
Mode: Edit mode
Menu: Armature ‣ Fill Between Joints
The main use of this tool is to create one bone between two selected ends, similar to how in mesh editing you
can “create edges/faces”.
If you have one root and one tip selected, the new bone:
• will have the root placed on the selected tip
• will have the tip placed on the selected root
• will be parented and connected to the bone owning the selected tip
Fill between a tip and a root

Active tip on the left

Active tip on the right

If you have two tips selected, the new bone:
• will have the root placed on the selected tip closest to the 3D cursor
• will have the tip placed on the other selected tip
• will be parented and connected to the bone owning the tip used as the new bone’s root
Fill between tips
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3D cursor on the left

3D cursor on the right

If you have two roots selected, you will face a small problem due to the event system in Bforartists not updating
the interface in real time.
When clicking F, similar to the previous case, you will see a new bone:
• with the root placed on the selected root closest to the 3D cursor
• with the tip placed on the other selected root
• parented and connected to the bone owning the root used as the new bone’s root
If you try to move the new bone, Bforartists will update the interface and you will see that the new bone’s root
moves to the tip of the parent bone.
Fill between roots

Before UI update (3D cursor on the left)

After UI update, correct visualization

Clicking F with only one bone end selected will create a bone from the selected end to the 3D cursor position,
and it won’t parent it to any bone in the armature.
Fill with only one bone end selected

Fill with only one tip selected

Fill with only one root selected

You will get an error when:
• trying to fill two ends of the same bone, or
• trying to fill more than two bone ends.

Duplication
Reference
Mode: Edit mode
Menu: Armature ‣ Duplicate
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Note
This tool works on selected bones; selected ends are ignored.
As in mesh editing,
• the selected bones will be duplicated,
• the duplicates become the selected elements and they are placed in grab mode, so you can move them
wherever you like.
If you select part of a chain, by duplicating it you’ll get a copy of the selected chain, so the copied bones are
interconnected exactly like the original ones.
The duplicate of a bone which is parented to another bone will also be parented to the same bone, even if the
root bone is not selected for the duplication. Be aware, though, that if a bone is parented and connected to an
unselected bone, its copy will be parented but not connected to the unselected bone (see Duplication example).
Duplication example

An armature with three selected bones and a

The three duplicated bones. Note that the selected

selected single root.

chain is preserved in the copy, and that Bone.006 is
parented but not connected to Bone.001, as
indicated by the black dashed line. Similarly,
Bone.007 is parented but not connected to
Bone.003.

Deleting Bones
You have two ways to remove bones from an armature: the standard deletion, and merging several bones in one.

Standard deletion
Reference
Mode: Edit mode
Menu: Armature ‣ Delete
Note
This tool works on selected bones: selected ends are ignored.
To delete a bone, you can:
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• press the standard delete key and confirm, or
• use the menu Armature ‣ Delete and confirm.
If you delete a bone in a chain, its child(ren) will be automatically re-parented to its own parent, but not
connected, to avoid deforming the whole armature.
Deletion example

An armature with two selected bones, just before

The two bones have been deleted. Note that

deletion.

Bone.002, previously connected to the deleted
Bone.001, is now parented but not connected to
Bone.

Merge
Reference
Mode: Edit mode
Menu: Armature ‣ Merge
You can merge together several selected bones, as long as they form a chain. Each sub-chain formed by the
selected bones will give one bone, whose root will be the root of the root bone, and whose tip will be the tip of
the tip bone.
Confirm by clicking on Within Chains in the Merge Selected Bones pop-up.
If another (non-selected) chain origins from inside of the merged chain of bones, it will be parented to the
resultant merged bone. If they were connected, it will be connected to the new bone.
Here’s a strange subtlety (see Merge example): even though connected (the root bone of the unmerged chain has
no root sphere), the bones are not visually connected - this will be done as soon as you edit one bone,
differently depending in which chain is the edited bone (compare the bottom two images of the example to
understand this better).
Merge example
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An armature with a selected chain, and a single

Bones Bone, Bone.001 and Bone.002 have been

selected bone, just before merging.

merged in Bone.006, whereas Bone.005 wasn’t
modified. Note Bone.003, connected to Bone.006 but
not yet “really” connected.

Bone.004 has been rotated, and hence the tip of

The tip of Bone.006 has been translated, and hence

Bone.006 was moved to the root of Bone.003.

the root of Bone.003 was moved to the tip of
Bone.006

Subdividing Bones
Reference
Mode: Edit mode
Menu: Armature ‣ Subdivide, Armature ‣ Subdivide Multi
You can subdivide bones, to get two or more bones where there was just one bone. The tool will subdivide all
selected bones, preserving the existing relationships: the bones created from a subdivision always form a
connected chain of bones.
To create two bones out of each selected bone:
• select Armature ‣ Subdivide from the header menu
To create an arbitrary number of bones from each selected bone:
• select Armature ‣ Subdivide Multi from the header menu, an
Then specify the number of cuts you want in the pop-up. As in mesh editing, if you set n cuts, you’ll get n+1
bones for each selected bone.
Subdivision example

An armature with one selected bone, just before

The selected bone has been “cut” two times, giving

multi-subdivision.

three sub-bones.
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Locking Bones
You can prevent a bone from being transformed in Edit mode in several ways:
•
•
•
•

The active bone can be locked clicking on Lock in the Transform Properties panel (N in a 3D view);
all bones can be locked clicking on the Lock button of their sub-panels in the Armature Bones panel;
press Shift-Wpop-up ‣ Toggle Settings ‣ Locked
select Armature ‣ Bone Settings ‣ Toggle a Setting).

If the root of a locked bone is connected to the tip of an unlocked bone, it won’t be locked, i.e. you will be able
to move it to your liking. This means that in a chain of connected bones, when you lock one bone, you only
really lock its tip. With unconnected bones, the locking is effective on both ends of the bone.

X-Axis Mirror Editing
Another very useful tool is the X-Axis Mirror editing option (Tool panel > Armature Options, while Armature is
selected in Edit Mode), When you have pairs of bones of the same name with just a different “side suffix” (e.g.
.R / .L, or _right / _left ...), once this option is enabled, each time you transform (move/rotate/scale...) a
bone, its “other side” counterpart will be transformed accordingly, through a symmetry along the armature
local X axis. As most rigs have at least one axis of symmetry (animals, humans, ...), it’s an easy way to spare
you half of the editing work!
See also
• naming bones.

Separating Bones in a new Armature
You can, as with meshes, separate the selected bones in a new armature object - and of course, in Object mode,
you can join all selected armatures in one

Editing Bone Properties
In this page, you will learn how to edit and control most of the properties for Bforartists bones - For editing
bones in an armature, you should read the previous page first! We will see how to manage the bones’
relationships (Chain Editing), rename them (Naming Bones), etc.

Transforming Bones
We won’t detail here the various transformations of bones, nor things like axis locking, pivot points, and so on,
as they are common to most object editing, and already described here (note however that some options, like
snapping, do not seem to work, even though they are available...). The same goes for mirroring, as it’s nearly
the same as with mesh editing. Just keep in mind that bones’ roots and tips behave more or less like meshes’
vertices, and bones themselves act like edges in a mesh.
As you know, bones can have two types of relationships: They can be parented, and in addition connected.
Parented bones behave in Edit mode exactly as if they had no relations - you can grab, rotate, scale, etc. a
parent bone without affecting its descendants. However, connected bones must always have parent’s tips
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connected to child’s roots, so by transforming a bone, you will affect all its connected parent/children/siblings.

The Transform Properties panel for armatures in Edit mode.

Finally, you can edit in the Transform Properties panel (N) the positions and radius of both ends of the active
selected bone, as well as its roll rotation.

Radius and Scaling in Envelope Visualization
Reference
Mode: Edit mode, Envelope visualization
Menu: Armature ‣ Transform ‣ Scale

When bones are displayed using Octahedron, Stick or B-Bone visualizations, scaling will behave as expected,
similar to scaling mesh objects. When bones are displayed using Envelope visualization, scaling will have a
different effect: it will scale the radius of the selected bones’s ends. (see: skinning part). As you control only
one value (the radius), there is no axis locking here. And as usual, with connected bones, you scale at the same
time the radius of the parent’s tip and of the children’s roots.
Scaling of a bone in** Octahedron and Envelope visualizations.

A single selected bone...

...Scaled in Octahedron visualization.
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A single selected bone...

...Scaled in Envelope visualization - its length
remains the same, but its ends’ radius are bigger.

Note that when you resize a bone (either by directly scaling it, or by moving one of its ends), Bforartists
automatically adjusts the end-radii of its envelope proportionally to the size of the modification. Therefore, it is
advisable to place all the bones first, and only then edit these properties.

ScaleB and Envelope
Reference
Mode: Edit mode

Ctrl-Alt-Scale hotkey activates a transform tool that is specific to armatures. It has different behavior
depending on the active visualization, as explained below:
In Envelope visualization, it allows you to edit the influence of the selected bones (their Dist property, see the
skinning part) - as with the “standard” scaling with this visualization (see the previous section), this is a onevalue property, so there is no axis locking and such.
Envelope scaling example

A single bone selected in Envelope visualization.

Its envelope scaled with [ctrl][alt][Scale hotkey].

In the other visualizations, it allows you to edit the “bone size”. This seems to only have a visible effect in BBone visualization, but is available also with Octahedron and Stick ... This tool in this situation has another
specific behavior: While with other transform tools, the “local axes” means the object’s axes, here they are the
bone’s own axes (when you lock to a local axis, by pressing the relevant key twice, the constraint is applied
along the selected bone’s local axis, not the armature object’s axis).
WARNING! If you have more than one bone selected, using this tool crashes Bforartists!
“Bone size” scaling example

A single “default size” bone selected in

Its size scaled with [ctrl][alt][S].

B-Bone visualization.

The same armature in Object mode and
B-Bone visualization, with Bone.004’s
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size scaled up.

Bone Direction
Reference
Mode: Edit mode
Menu: Specials ‣ Switch Direction

This tool is not available from the Armature menu, but only from the Specials pop-up menu(W). It allows you to
switch the direction of the selected bones (i.e. their root will become their tip, and vice versa).
Switching the direction of a bone will generally break the chain(s) it belongs to. However, if you switch a
whole (part of a) chain, the switched bones will still be parented/connected, but in “reversed order”. See the
Switching example.
Switching example.

An armature with one selected bone, and one

The selected bones have been switched. Bone.005

selected chain of three bones, just before switching. is no more connected nor parented to anything. The
chain of switched bones still exists, but reversed
(Now Bone.002 is its root, and Bone is its tip).
Bone.003 is now a free bone.

Bone Roll
In Edit mode, you can control of the bones roll (i.e. the rotation around the Y axis of the bone).
However, after editing the armature, or when using euler rotation, you may want to set the bone roll.

Set Bone Roll
Reference
Mode: Edit mode
Menu: Armature ‣ Bone Roll ‣ Set

This is a transform mode where you can edit the roll of all selected bones.
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Recalculate Bone Roll
Reference
Mode: Edit mode
Menu: Armature ‣ Bone Roll ‣ Recalculate

Axis Orientation
Local (X,Z) Tangent
Align roll relative to the axis defined by the bone and it’s parent.
Global (X,Y,Z) Axis
Align roll to global X,Y,Z axis.
Active Bone
Follow the rotation of the active bone.
View Axis
Set the roll to align with the view-port.
Cursor
Set the roll towards the 3D cursor.
Flip Axis
Reverse the axis direction.
Shortest Rotation
Avoids rolling the bone over 90 degrees from its current value.

Properties
Reference
Mode: Edit mode
Panel: Armature Bones (Editing context)
Menu: Armature ‣ Bone Settings ‣ ...

The Armature Bones panel in Edit mode.

Most bones’ properties (excepted the transform ones) are regrouped in each bone’s sub-panel, in the Armature
Bones panel (Editing context`). Let’s detail them.
Note that some of them are also available in the 3D views, through the three pop-up menus Toggle Setting
(Shift-W or Armature ‣ Bone Settings ‣ Toggle a Setting), Enable Setting (Ctrl-Shift-W or Armature
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‣ Bone Settings ‣ Enable a Setting), and Disable Setting (Alt-W or Armature ‣ Bone Settings ‣ Disable a
Setting) - all three have the same entries, their respective effect should be obvious...
BO
The bone name field, see Naming Bones.
child of
These two settings control the bone relationship, as detailed in Chain Editing.
Segm
This setting controls the number of segments that a bone has; see Bone Rigidity.
Dist, Weight, Deform
These settings control how the bone influences its geometry - along with the bones’ ends radius. This will
be detailed in the skinning part.
Hinge
These settings affect the behavior of children bones while transforming their parent in Pose mode, so this
will be detailed in the posing part !
Hide
This will hide the bone (same as pressing H in the 3D views; see this page).
Lock
This will prevent all editing of the bone in Edit mode; see previous page.
Layers button
These small buttons allow you to control to which bone layer this bone belongs; see this page.

Bone Rigidity
Reference
Mode: Edit and Pose modes
Panel: Armature Bones (Editing context)

The Armature Bones panel in Pose mode.

Even though you have the Segm setting available in Edit mode (bones sub-panel, in the Armature Bones panel),
you should switch to the Pose mode to edit these “smooth” bones’ properties - one explanation to this strange
need is that in Edit mode, even in B-Bone visualization, bones are drawn as sticks, so you can’t visualize the
effects of these settings.
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An armature in Pose mode, B-Bone visualization: Bone.003 has one segment, Bone.004 has four, and Bone.005 has
sixteen.

We saw in this page that bones are made of small rigid segments mapped to a “virtual” Bézier curve. The Segm
numeric field allows you to set the number of segments inside a given bone - by default, it is 1, which gives a
standard rigid bone! The higher this setting (max 32), the smoother the bone, but the heavier the pose
calculations...
Each bone’s ends are mapped to its “virtual” Bezier curve’s “auto” handle. Therefore, you can’t control their
direction, but you can change their “length” using the In and Out numeric fields, to control the “root handle”
and “tip handle” of the bone, respectively. These values are proportional to the default length, which of course
automatically varies depending on bone length, angle with previous/next bones in the chain, and so on.
Bone In / Out settings example, with a materialized Bézier curve.

Look at Bone.004: it has the default In and Out values (1.0).

Bone.004 with In at 2.0, and Out at 0.0.

Chain Editing
Reference
Mode: Edit mode
Panel: Armature Bones (Editing context)
Menu: Armature ‣ Parent ‣ ...
You can edit the relationships between bones (and hence create/modify the chains of bones) both from the 3D
views and the Buttons window. Whatever method you prefer, it’s always a matter of deciding, for each bone, if
it has to be parented to another one, and if so, if it should be connected to it.
To parent and/or connect bones, you can:
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• In a 3D view, select the bone and then its future parent, and choose Armature ‣ Parent ‣ Make Parent.
In the small Make Parent menu that pops up, choose Connected if you want the child to be connected to
its parent, else click on Keep Offset. If you have selected more than two bones, they will all be parented
to the last selected one. If you only select one already-parented bone, or all selected bones are already
parented to the last selected one, your only choice is to connect them, if not already done. If you select
only one non-parented bone, you’ll get the Need selected bone(s) error message...
With this method, the newly-children bones won’t be scaled nor rotated - they will just be translated if
you chose to connect them to their parent’s tip.
• In the Buttons window, Armature Bones panel, for each selected bone, you can select its parent in the
Parent drop-down list to the upper right corner of its sub-panel. If you want them to be connected, just
enable the little Con button to the right of the list.
With this method, the tip of the child bone will never be translated - so if Con is enabled, the child bone
will be completely transformed by the operation.
Parenting example.

The starting armature, with Bone.005 parented and

Bone.005 re-parented to Bone.002, but not

connected to Bone.004.

connected to it (same result, using either [ctrl][P][2] in
3D view, or the Armature Bones panel settings).

Bone.005 parented and connected to Bone.002,

Bone.005 parented and connected to Bone.002,

using [ctrl][P][1] in 3D view.

using the Parent drop-down list of Bone.005 subpanel.

To disconnect and/or free bones, you can:
• In a 3D view, select the desired bones, and choose Armature ‣ Parent ‣ Clear Parent. In the small
Clear Parent menu that pops up, choose Clear Parent to completely free all selected bones, or
Disconnect Bone if you just want to break their connections.
• In the Buttons window, Armature Bones panel, for each selected bone, you can select no parent in the
Parent drop-down list of its sub-panel, to free it completely. If you just want to disconnect it from its
parent, disable the Con button.
Note that relationships with non-selected children are never modified.

Naming Bones
Reference
Mode: Edit mode
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Panel: Armature Bones (Editing context), Transform Properties
You can rename your bones, either using the Bone field of the Transform Properties panel in the 3D views, for
the active bone , or using the BO field in each bone sub-panel of the Armature Bones panel (Editing context).
Bforartists also provides you some tools that take advantage of bones named in a left/right symmetry fashion,
and others that automatically name the bones of an armature. Let’s look at this in detail.

Naming Conventions

An example of left/right bone naming in a simple rig.

Naming conventions in Bforartists are not only useful for you in finding the right bone, but also to tell
Bforartists when any two of them are counterparts.
In case your armature can be mirrored in half (i.e. it’s bilaterally symmetrical), it’s worthwhile to stick to a
left/right naming convention. This will enable you to use some tools that will probably save you time and effort
(like the X-Axis Mirror editing tool we saw above...).
• First you should give your bones meaningful base-names, like leg, arm, finger, back, foot, etc.
• If you have a bone that has a copy on the other side (a pair), like an arm, give it one of the following
separators:
• Left/right separators can be either the second position (L _ calfbone) or last-but-one
(calfbone . R)
• If there is a lower or upper case L, R, left or right, Bforartists handles the counterpart
correctly. See below for a list of valid separators. Pick one and stick to it as close as possible
when rigging; it will pay off. Examples of valid saparators:
•
•
•
•

(nothing): hand Left –> hand Right
_ (underscore): Hand _L –> Hand _R
. (point): hand .l –> hand .r
- (dash): Foot -l –> Foot -r
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• `` `` (space): pelvis LEFT –> pelvis RIGHT
Note that all examples above are also valid with the left/right part placed before the name. You
can only use the short L / R code if you use a separator (i.e. handL / handR won’t work!).
• Before Bforartists handles an armature for mirroring or flipping, it first removes the number extension,
if it’s there (like .001)
• You can copy a bone named bla.L and flip it over using [W] ‣ Flip Left-Right Names. Bforartists
will name the copy bla.L.001 and flipping the name will give you bla.R.

Bone name flipping
Reference
Mode: Edit mode
Menu: Armature ‣ Flip Left & Right Names
You can flip left/right markers (see above) in selected bone names, using either Armature ‣ Flip Left & Right
Names. This can be useful if you have constructed half of a symmetrical rig (marked for a left or right side) and
duplicated and mirrored it, and want to update the names for the new side. Bforartists will swap text in bone
names according to the above naming conventions, and remove number extensions if possible.

Auto bone naming
Reference
Mode: Edit mode
Menu: Armature ‣ AutoName Left-Right, Armature ‣ AutoName Front-Back, Armature ‣ AutoName TopBottom
The three AutoName entries of the Armature and Specials (W) menus allows you to automatically add a suffix to
all selected bones, based on the position of their root relative to the armature center and its local coordinates :
AutoName Left-Right
will add the .L suffix to all bones with a positive X-coordinate root, and the .R suffix to all bones with a
negative X-coordinate root. If the root is exactly at 0.0 on the X-axis, the X-coordinate of the tip is used.
If both ends are at 0.0 on the X-axis, the bone will just get a period suffix, with no L/R (as Bforartists
cannot decide whether it is a left or right bone...).
AutoName Front-Back
will add the .Bk suffix to all bones with a positive Y-coordinate root, and the .Fr suffix to all bones with
a negative Y-coordinate root. The same as with AutoName Left-Right goes for 0.0 Y-coordinate bones...
AutoName Top-Bottom
will add the .Top suffix to all bones with a positive Z-coordinate root, and the .Bot suffix to all bones
with a negative Z-coordinate root. The same as with AutoName Left-Right goes for 0.0 Z-coordinate
bones...

Skeleton Sketching
42

Bforartists Reference Manual - © Copyright - This page is under OCL license

If you think that creating a whole rig by hand, bone after bone, is quite boring,
be happy: some Bforartists developers had the same feeling, and created the
Skeleton Sketching tool, formerly the Etch-a-ton tool, which basically allows
you to “draw” (sketch) whole chains of bones at once.
Skeleton Sketching is obviously only available in Edit mode, in the 3D views.
You control it through its Skeleton Sketching panel in the Transform panel,
which you can open with N. Use mouse (LMB to draw strokes, and RMB for
gestures. Showing its tool panel won’t enable sketching - you must tick the checkbox next to Skeleton Sketching
to start drawing bone chains (otherwise, you remain in the standard Edit mode...).
Sketching is done in two steps:
• Drawing Chains (called “strokes”). Each stroke corresponds to a chain of bones.
• Converting to Bones, using different methods.
The point of view is important, as it determines the future bones’ roll angle: the Z axis of a future bone will be
aligned with the view Z axis of the 3D view in which you draw its “parent” stroke (unless you use the*
Template converting method...). Strokes are drawn in the current view plane passing through the 3D cursor, but
you can create somewhat “3D” strokes using the* Adjust drawing option in different views (see below).
If you enable the small* Quick Sketch option, the two steps are merged into one: once you have finalized the
drawing of a stroke (see Drawing Chains), it is immediately converted to bones (using the current active
method) and deleted. This option makes bone sketching quick and efficient, but you lose all the advanced stroke
editing possibilities.
Sketches are not saved into Bforartists files, so you can’t interrupt a sketching session without losing all your
work! Note also that the* sketching is common to the whole Bforartists session, i.e. there is only one set of
strokes (one sketch) in Bforartists, and not one per armature, or even per file...

Drawing Chains

Strokes example. From top to bottom: A selected polygonal stroke of four straight segments, oriented from left to right. An
unselected free stroke of two segments, oriented from left to right. A mixed stroke, with one straight segment between two
free ones, right to left.

So, each stroke you draw will be a chain of bones, oriented from the starting point (the reddest or most orange
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part of the stroke) to its end (its whitest part). A stroke is made of several segments, delimited by small black
dots - there will be at least one bone per segment (except with the* Template conversion method, see next
page), so all black points represents future bones’ ends. There are two types of segments, which can be mixed
together:

Straight Segments
To create a straight segment, click* LMB at its starting point. Then move the mouse cursor, without pressing any
button - a dashed red line represents the future segment. Click LMB again to finalize it. Each straight segment of
a stroke will always create one and only one bone, whatever convert algorithm you use (except for the*
Template conversion method).

The first segment has been started

The first segment has been finalized by Repeating these steps, we now have a

(LMB click) and the mouse moved to its a second LMB click, which also started a four-segment polygonal stroke.
end point.

new segment...

Free Segments
To create a free (curved) segment, click* and hold LMB at its starting point. Then draw your segment by moving
the mouse cursor - as in any paint program! Release LMB to finalize the segment - you will then be creating a
new straight segment, so if you would rather start a new free segment, you must immediately re-press LMB. The
free segments of a stroke will create different number of bones, in different manners, depending on the
conversion method used. The future bones’ ends for the current selected method are represented by small green
dots for each one of those segments, for the selected strokes only. The free segment drawing uses the same*
Manhattan Dist setting as the grease pencil tool (User Preferences window, Edit Methods “panel”, Grease
Pencil group) to control where and when to add a new point to the segment - so if you feel your free segments
are too detailed, raise this value a bit, and if you find them too jagged, lower it.
Drawing free segments example.

While drawing a first free segment (LMB click and drag).

The first free segment finalized (releasing LMB).

If you now move the mouse without pressing LMB again,

But if you immediately click again and drag LMB you’ll instead

you’ll create a straight segment...

start a new free segment.

You finalize a whole stroke by clicking* RMB. You can cancel the stroke you are drawing by pressing Esc. You
can also snap strokes to underlying meshes by holding* Ctrl while drawing. By the way, the Peel Objects
button at the bottom of the Bone Sketching panel is the same thing as the “monkey” button of the snapping
header bar controls shown when* Volume snap element is selected - see the snap to mesh page for details.
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Selecting Strokes
A stroke can be selected (materialized by a solid red-to-white line), or not (shown as a orange-to-white line) see (Strokes example) above. As usual, you select a stroke by clicking* RMB on it, you add one to/remove one
from the current selection with a* Shift-RMB click, and (de)selects all strokes...

Deleting
Clicking on the Delete button (Bone Sketching panel) deletes the selected strokes (be careful, no
warning/confirmation pop-up menu here). See also Gestures.

Modifying Strokes
You can adjust, or “redraw” your strokes by enabling the Overdraw Sketching option of the Bone Sketching
panel. This will modify the behavior of the strokes drawing (i.e. LMB clicks and/or hold): when you draw, you
won’t create a new stroke, but rather modify the nearest one. The part of the old stroke that will be replaced by
the new one are drawn in gray. This option does not take into account stroke selection, i.e. all strokes can be
modified this way, not just the selected ones... Note also that even if it is enabled, when you draw too far away
from any other existing stroke, you won’t modify any of them, but rather create a new one, as if* Overdraw
Sketching was disabled.

Adjusting a stroke: the gray part of the “unselected” (orange) Stroke adjusted.
stroke will be replaced by the currently drawn “replacement”.

Adjusting stroke example.
Finally, note that there is no undo/redo for sketch drawing...

Gestures
There quite a few things about strokes editing that are only available through gestures. Gestures are started by
clicking and holding Shift-LMB (when you are not already drawing a stroke), and materialized by blue-towhite lines. A gesture can affect several strokes at once.
There is no direct way to cancel a gesture once you’ve started “drawing” it. So the best thing to do, if you
change your mind (or made a “false move”), is to continue to draw until you get a disgusting scribble, crossing
your stroke several times - in short, something that the gesture system would never recognize!

Damn! I didn’t want to cut this stroke

Let’s doodle a bit...

Phew! That was close, but the stroke is

here!

still in one piece.
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Cut
To* cut a segment (i.e. add a new black dot inside it, making two segments out of one), “draw” a straight line
crossing the chosen segment where you want to split it.

Gesture.

Result.

Delete
To* delete a stroke, draw a “V” crossing the stroke to delete twice.

Gesture.

Result.

Reverse
To reverse a stroke (i.e. the future chain of bones will be reversed), draw a “C” crossing twice the stroke to
reverse.

Gesture.

Result.

Converting to Bones
Once you have one or more selected strokes, you can convert them to bones, using either the* Convert button
of the Bone Sketching panel, or the corresponding gesture (see Gestures). Each selected stroke will generate a
chain of bones, oriented from its reddest end to its whitest one. Note that converting a stroke does not delete it.
There are four different conversion methods - three “simple” ones, and one more advanced and complex,
Template, that reuses bones from the same armature or from another one as a template for the strokes to
convert, and which is detailed in the next page. Anyway, remember that* straight segments are always
converted to one and only one bone (except for the Template conversion method), and that the future bones’
ends are shown as green dots on selected free segments.
Remember also that the roll rotation of the created bones has been set during their “parent” stroke drawing
(except for the Template conversion method) - their Z axis will be aligned with the view Z axis of the active 3D
view at draw time.

Fixed
With this method, each free segment of the selected strokes will be uniformly divided in n parts (set in Num
numeric field), i.e. will give n bones.
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The Fixed conversion settings and its preview on selected

The Fixed conversion result.

strokes.

Adaptative
With this method, each free segment of the selected strokes will create as many bones as necessary to follow its
shape closely enough - this “closely enough” parameter being set by the Thres hold numeric field; higher values
giving more bones, following more closely the segments’ shape. So the more twisted a free segment, the more
bones it will generate.

The Adaptative conversion settings and its preview on

The Adaptative conversion result.

selected strokes.

Length
With this method, each free segment of the selected strokes will create as many bones as necessary, so that none
of them is longer than the Length numeric field value (in Bforartists Units).

The Length conversion settings and its

Using a larger length value.

The Length conversion result.

preview on selected strokes.

Retarget
Retarget template bone chain to stroke.
Template
Template armature that will be retargeted to the stroke. This is a more complex topic, detailed in its own
page.
Retarget roll mode
None
Don’t adjust roll.
View
Roll bones to face the view.
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Joint
Roll bone to original joint plane offset.
Autoname
...
Number
...
Side
...

Armature Templating
The idea of templating is to use an already existing armature as base (“template”) to create a new armature. It
differs from a simple copy in that you can directly define the new armature different in some aspects than its
reference rig.
In Bforartists, the only templating tool is the bone sketching one (Etch-a-ton, described in the previous page),
with its Template conversion method - so you should have read its page before this one!

Using Bone Sketching
Reference
Mode: Edit mode
Panel: Bone Sketching (3D View window)
Menu: Armature ‣ Bone Sketching

The Template conversion method of Bone Sketching tool maps a copy of existing bones to each selected stroke.
The new bones will inherit some of their properties (influence, number of segments, etc.) from the
corresponding bones in the template, but they will acquire their lengths, rolls and rotation from the sketch; so
these properties would be different as compared to the template.
This is easier to understand with some examples.
In the following image, armature.002 is set as the template, and the stroke maps with chain_a of this
template. None of the bones are selected in the template. Note that there is no second stroke to map with chain
chain_b of the template. The result is shown at right: Bforartists creates a copy of chain_a and matches the
bones with the stroke.
Bforartists also creates a copy of chain_b, but this chain is not altered in any way; because this command can
map only one selected chain with a stroke.
In the following example, no template is selected. (In other words, all the action is within the armature itself.)
Two bones are selected in chain_b, and the property panel is set to map the joints with the stroke. So these
two selected bones are copied and the newly created copy of the chain is matched with the stroke. (Note that the
newly created bones are named in continuation of the original chain.)
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Before conversion.

After conversion.

If you had selected both the chains (Chain_a and
Chain_b), you would have still got the same result as
in the example above, because the command maps to
stroke only one selected chain.
In the following example also, only one chain is
selected, but there are three strokes to map to. In this
case, the same chain is copied three times (once for
each stroke) and then mapped to individual strokes.
Note how a two-bone chain is fitted to a three-segment
stroke.
The newly created bones are numbered sequentially,
after the original bones’ names.

Before conversion.

After conversion.

OK now let us see some important ground rules:
• This conversion method can use as reference bones either the selected bones in the currently edited
armature, or all bones from another armature. In general, it is a better idea to create new “templated”
bones inside the “reference” armature, so you can precisely select which bones to use as template - if
you want the new bones in a different armature, you can then use the Separate and optionally Join
commands...
• This tool only considers one chain of bones, so it’s better to select only one chain of bones inside the
current armature (or use a single-chain armature object as template). Else, the chain of the template
containing the first created bones will be mapped to the selected strokes, and the other chains will just
be “copied” as is, without any modification.
• This tool maps the same chain of bones on all selected strokes, so you can’t use multiple strokes to map
a multi-chains template - you will rather get a whole set of new bones for each selected stroke!
• If you have strokes only made of straight segments, they must have at least as much segments as there
are bones in the template chain (else, the newly created chain is not mapped at all to the stroke, and
remains an exact duplicate of its template). If there are more segments than necessary, the conversion
algorithm will chose the best “joints” for the bones to fit to the reference chain, using the same influence
settings as for free segments (A, L and D settings, see below).
• If you try to Convert without template bones (i.e. either an empty armature selected as template, or no
bones selected in the current edited armature), you will get the error message No Template and no
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deforming bones selected, and nothing will occur.
The Bone Sketching panel with Template conversion method enabled.

With current edited armature as template.

With another armature as template.

Now, let us see the settings of this conversion method:
No, View, Joint buttons
These three toggle buttons (mutually exclusive) control how the roll angle of newly created bones is
affected:
No
Do not alter the bones roll (i.e. the new bones’ rolls fit their reference ones).
View
Roll each bone so that one of its X, Y or Z local axis is aligned (as much as possible) with the
current view’s Z axis.
Joint
New bones roll fit their original rotation (as No option), but with regards to the bend of the joint
with its parent.
Templating: bone roll example. The Bone.003 -to- Bone.005 chain is the mapped-to-stroke version of Bone -to- Bone.002
selected one, and Bone.001 has a modified roll angle.

With No roll option.

With View roll option.

With Joint roll option.

Template drop-down list
Here you select the armature to use as template. If you choose None, the selected bones from the currently
edited armature will be used as reference, else all bones of the other armature will be used.
A, L, D are numeric fields.
Think of them as A(ngle of bones), L(ength of bones) and D(efinition of stroke).
These settings control how the template is mapped to the selected strokes. Each one can have a
value between 0.0 and 10.0, the default being 1.0.
A
controls the influence of the angle of the joints (i.e. angle between bones) - the higher this
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value, the more the conversion process will try to preserve these joints angle in the new chain.
L
controls the influence of the bones’ length - the higher this value, the more the conversion
process will try to preserve these lengths in the new bones.
D
controls the influence of the stroke’s shape - the higher this value, the more the conversion
process will try to follow the stroke with the new chain.
Examples of Template conversions for various influence weights values, with one stroke quite similar to the template chain’s
shape, and one stroke very different.

A: 1.0; L: 1.0; D: 1.0.

A: 1.0; L: 0.0; D: 0.0.

A: 0.0; L: 1.0; D: 0.0.

A: 0.0; L: 0.0; D: 1.0.

S and N text fields, “auto” button
These control how the new bones are named. By default, they just take the same names as the originals
from the template - except for the final number, increased as needed. However, if the template bones have
&s somewhere in their name, this “placeholder” will be replaced in the “templated” bones’ names by the
content of the S text field (“S” for “side”). Similarly, a &n placeholder will be replaced by the N field
content (“N” for “number”). If you enable the small “auto” button, the N field content is auto-generated,
producing a number starting from nothing, and increased each time you press the Convert button, and the
&s placeholder is replaced by the side of the bone (relative to the local X axis: r for negative X values, l
for positive ones).
Naming and placeholders, using a simple leg template.

Before conversion (note the &n and &s placeholders in

After conversion: the placeholders have been replaced by the

template bones’ names).

content of the S and N text fields of the Bone Sketching
panel.

Auto naming and placeholders, using a simple leg template.
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Before conversion (note that, in the Bone Sketching panel,
the S and N fields are empty, and the small “auto” button is
enabled).

Static text line
The line just above the Peel Objects button gives you two informations:
• The n joints part gives you the number of joints (i.e. bones’ ends, with connected ends
considered as one joint), either from the selected bones of the edited armature, or in the whole
other template armature.
• The second part is only present when another armature has been selected as template - it gives you
the root bone’s name of the chain that will be mapped to the strokes. Or, while you are drawing a
stroke with straight segments, the name of the bone corresponding to the current segment (and
Done when you have enough segments for all bones in the template chain).
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Introduction
An Armature in Blender can be thought of as similar to the armature of a real skeleton, and just like a real
skeleton an Armature can consist of many bones. These bones can be moved around and anything that they are
attached to or associated with will move and deform in a similar way.
An “armature” is a type of object used for rigging. Armature object borrows many ideas from real life
skeletons.

Your first armature
In order to see what we are talking about, let us try to add the default armature in Blender.
(Note that armature editing details are explained in the armatures editing section).
Open a default scene, then:
1. Delete all objects in the scene.
2. Make sure the cursor is in the world origin
3. Press Numpad1 to see the world in Front view.
4. Add a Single Bone ( Add ‣ Armature ‣ Single Bone ).
5. Press NumpadDelete to see the armature at maximum zoom.

The default armature.

The Armature Object
As you can see, an armature is like any other object type in Blender:
• It has a center, a position, a rotation and a scale factor.
• It has an Object Data data-block, that can be edited in Edit Mode.
• It can be linked to other scenes, and the same armature data can be reused on multiple objects.
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• All animation you do in Object Mode is only working on the whole object, not the armature’s bones (use
the Pose Mode to do this).
As armatures are designed to be posed, either for a static or animated scene, they have a specific state, called
“rest position”. This is the armature’s default “shape”, the default position/rotation/scale of its bones, as set in
Edit Mode.
In Edit Mode, you will always see your armature in rest position, whereas in Object Mode and Pose Mode, you
usually get the current “pose” of the armature (unless you enable the Rest Position button of the Armature
panel).

Armature Chapter Overview
In the “Armatures” section, we will only talk about armatures themselves, and specifically we will talk about:
•
•
•
•
•
•
•
•
•

The basics of bones.
The different armature visualizations.
The armature structure types.
How to Select Bones,
How to Edit Armatures,
How to Edit Bones,
How to edit bones properties,
How to sketch armatures with the Etch-a-Ton tool,
How to use templates.

Introduction
Bones are the base elements of armatures. The visualization of bones can be set in the Armatures Display Panel.

Structure

The elements of a bone.
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They have three elements:
• The “start joint” named root or head,
• the “body” itself,
• and the “end joint” named tip or tail.
With the default armature in edit-mode, you can select the root and the tip, and move them as you do with mesh
vertices.
Both root and tip (the “joints”) define the bone by their respective position.
They also have a radius property, only useful for the envelope deformation method (see below).

Roll
Activating Axes checkbox on the Armature tab ‣ Display panel , will show local axes for each bone’s tip. The
Y axis is always aligned along the bone, oriented from root to tip. So, this is the “roll” axis of the bones.

Bones Influence

A bone in Envelope visualization, in Edit Mode.
Basically, a bone controls a geometry when vertices “follow” the bone. This is like how the muscles and skin of
your finger follow your finger-bone when you move a finger.
To do this, you have to define the strength of influences a bone has on a certain vertex.
The simplest way is to have each bone affecting those parts of the geometry that are within a given range from
it. This is called the envelope technique, because each bone can control only the geometry “enveloped” by its
own influence area.
If a bone is visualized as Envelope, in Edit Mode and in Pose Mode you can see the area of influence, which
depends on:
• The distance property and
• the root’s radius and the tip’s radius.
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Our armature in Envelope visualization, in Pose Mode.
All these influence parameters are further detailed in the skinning pages.

Selecting
You can select and edit bones of armatures in Edit Mode and in Pose Mode. Here, we will see how to select
bones in Edit Mode. Selecting bones in Pose Mode is similar to selecting in Edit Mode with a few specific
differences that will be detailed in the posing part.
Similar to vertices/edges selection in meshes, there are two ways to select whole bones in Edit Mode:
• Directly, by selecting the bone’s body.
• Selecting both of its joints (root and tip).
This is an important point to understand, because selecting bones’ joints only might lead to non-obvious
behavior, with respect to which bone you actually select, see the.
Note that unlike the mesh draw type the armature draw type has no effect on selection behavior. In other words,
you can select a bone’s joint or body the same way regardless of the bone visualization chosen.

Selecting Bone Joints
To select bones’ joints you have the standard selection methods.

Inverse selection
As stated above, you have to remember that these selection tools are for bones’ joints only, not the bones’
bodies.
For example, the Inverse selection option Ctrl-I inverts the selection of bones’ joints, not of bones (see
Inverse selection).
Remember that a bone is selected only if both its joints are selected. So, when the selection status of bones’
joints is inverted, a new set of bones is selected.
Inverse selection.
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Two bones selected.

The result of the inverse selection Ctrl-I the
bones joints selection has been inverted, and not
the bones selection.

Selecting connected Bone Joints
Another example is: when you select the root of a bone connected to its parent, you also implicitly select the tip
of its parent (and vice versa).
Note
Remember that when selecting bones’ joints, the tip of the parent bone is the “same thing” as the root of its
children bones.

Selecting Bones
By RMB -clicking on a bone’s body, you will select it (and hence you will implicitly select its root and tip).
Using Shift-RMB, you can add to/remove from the selection.
You also have some advanced selection options, based on their relations.
You can select at once all the bones in the chain which the active (last selected) bone belongs to by using the
linked selection tool, L.
Linked bones selection

A single selected bone.

Its whole chain selected with L.

Mirror Shift-Ctrl-M
Flip the selection from one side to another.
Pick Shortest Path Ctrl-RMB
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Selects the path from the active bone to the bone under the mouse.

Deselecting connected Bones
There is a subtlety regarding connected bones.
When you have several connected bones selected, if you deselect one bone, its tip will be deselected, but not its
root, if it is also the tip of another selected bone.
To understand this, look at Fig. Bone deselection in a selected chain..
Bone deselection in a selected chain.

A selected chain.

Two selected bones.

After Shift-RMB -clicking “Bone.003”:
• “Bone.003” ‘s tip (which is same as “Bone.004” ‘s root) is deselected.
• “Bone” is “Bone.003” ‘s parent. Therefore “Bone.003” ‘s root is same as the tip of “Bone”. Since
“Bone” is still selected, its tip is selected. Thus the root of “Bone.003” remains selected.

More/Less
Reference
Mode: Edit Mode
Menu: Select

More :kbd;`Ctrl-Numpad+`
ToDo.
Less :kbd;`Ctrl-Numpad-`
ToDo.
Parent [, Child ]
You can deselect the active bone and select its immediate parent or one of its children.
Extend Parent Shift-[, Extend Child Shift-]
Similar to Parent/Child but it keeps the active bone in the selection.

Similar
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Reference
Mode: Edit Mode
Menu: Select ‣ Similar
Hotkey: Shift-G
Children
Extends the selection to all hierarchical descendant bones.
Immediate Children
Extends the selection to all direct child bones.
Siblings
Selects bones that have the same parent as the active bone.
Length
Selects bones with a similar bone length (between tip and tail) under the specified Threshold.
Direction (Y axis)
ToDo.
Prefix
ToDo.
Suffix
ToDo.
Layer
ToDo.

Introduction
Reference
Mode: Edit Mode
As with any other object, you edit your armature in Edit Mode.
Editing an armature means two main domains of action:
• Editing the bones – i.e. adding/inserting/deleting/extruding/sub-dividing/joining them...
• Editing the bones’ properties – this includes key features, like transform properties (e.g. grab, scale,
etc...) and relationships between bones (parenting and connecting), as well as bones’ names, influence,
behavior in Pose Mode, etc.
These are standard editing methods, quite similar for example to meshes editing. Blender also features a more
advanced “armature sketching” tool, called Etch-a-Ton. The same tool might also be used in templating, i.e.
using another armature as template for the current one...
Important
One important thing to understand about armature editing is that you edit the rest position of your
armature, i.e. its “default state”. An armature in its rest position has all bones with no rotation and scaled to
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1.0 in their own local space.
The different poses you might create afterwards are based on this rest position. So if you modify it in Edit
Mode, all the poses already existing will also be modified. Thus you should in general be sure that your
armature is definitive before starting to skin and pose it!
Note
Please note that some tools work on bones’ joints, while others work on bones themselves. Be careful not to
get confused.

Transform
Transform

The Transform panel for armatures in Edit Mode.
We will not detail here the various transformations of bones, nor things like axis locking, pivot points, and so
on, as they are common to most object editing, and already described here (note however, that some options,
like snapping, do not seem to work, even though they are available...). The same goes for mirroring, as it is
nearly the same as with mesh editing. Just keep in mind that bones’ roots and tips behave more or less like
meshes’ vertices, and bones themselves act like edges in a mesh.
As you know, bones can have two types of relationships: They can be parented, and in addition connected.
Parented bones behave in Edit Mode exactly as if they had no relations. They can be grabbed, rotated, scaled,
etc. a parent bone without affecting its descendants. However, connected bones must always have parent’s tips
connected to child’s roots, so by transforming a bone, you will affect all its connected parent/children/siblings.
Finally, you can edit in the Transform panel in the Properties region the positions and radius of both joints of
the active selected bone, as well as its roll rotation.
11
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Radius and Scaling in Envelope Visualization
Reference
Mode: Edit Mode, Envelope visualization
Menu: Armature ‣ Transform ‣ Scale

When bones are displayed using Octahedron, Stick or B-Bone visualizations, scaling will behave as expected,
similar to scaling mesh objects. When bones are displayed using Envelope visualization, scaling will have a
different effect: it will scale the radius of the selected bones’s joints. (see: skinning part). As you control only
one value (the radius), there is no axis locking here. And as usual, with connected bones, you scale at the same
time the radius of the parent’s tip and of the children’s roots.
Scaling of a bone in Octahedron and Envelope visualizations.

A single selected bone...

...Scaled in Octahedron visualization.

A single selected bone...

...Scaled in Envelope visualization. Its length
remains the same, but its joints’ radius are bigger.

Note that when you resize a bone (either by directly scaling it, or by moving one of its joints), Blender
automatically adjusts the end-radii of its envelope proportionally to the size of the modification. Therefore, it is
advisable to place all the bones first, and only then edit these properties.

ScaleB and Envelope
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Reference
Mode: Edit Mode

activates a transform tool that is specific to armatures. It has different behavior depending on the active
visualization, as explained below:
In Envelope visualization, it allows you to edit the influence of the selected bones (their Distance property, see
the skinning part) – as with the “standard” scaling with this visualization (see the previous section), this is an
one-value property, so there is no axis locking and such.
Envelope scaling example.

A single bone selected in Envelope visualization. Its envelope scaled with Ctrl-Alt-S.
In the other visualizations, it allows you to edit the “bone size”. This seems to only have a visible effect in BBone visualization, but is available also with Octahedron and Stick... This tool in this situation has another
specific behavior: While with other transform tools, the “local axes” means the object’s axes, here they are the
bone’s own axes (when you lock to a local axis, by pressing the relevant key twice, the constraint is applied
along the selected bone’s local axis, not the armature object’s axis).
“Bone size” scaling example.

A single “default size” bone
selected in B-Bone
visualization.

Its size scaled with CtrlAlt-S.

The same armature in Object
Mode and B-Bone
visualization, with Bone.004’s
size scaled up.

Bone Roll
In Edit Mode, you can control of the bones roll (i.e. the rotation around the Y axis of the bone).
However, after editing the armature, or when using euler rotation, you may want to set the bone roll.
13
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Set Bone Roll
Reference
Mode: Edit Mode
Menu: Armature ‣ Bone Roll ‣ Set

This is a transform mode where you can edit the roll of all selected bones.

Recalculate Bone Roll
Reference
Mode: Edit Mode
Menu: Armature ‣ Bone Roll ‣ Recalculate

Axis Orientation
Local Tangent
Align roll relative to the axis defined by the bone and its parent.
X, Z
Global Axis
Align roll to global X, Y, Z axis.
X, Y, Z
Active Bone
Follow the rotation of the active bone.
View Axis
Set the roll to align with the view-port.
Cursor
Set the roll towards the 3D cursor.
Flip Axis
Reverse the axis direction.
Shortest Rotation
Avoids rolling the bone over 90 degrees from its current value.

Switch Direction
Reference
Mode: Edit Mode
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Menu: Armature ‣ Switch Direction, Specials ‣ Switch Direction

This tool is not available from the Armature menu, but only from the Specials pop-up menu W. It allows you to
switch the direction of the selected bones (i.e. their root will become their tip, and vice versa).
Switching the direction of a bone will generally break the chain(s) it belongs to. However, if you switch a
whole (part of a) chain, the switched bones will still be parented/connected, but in “reversed order”. See the
Fig. Switching example..
Switching example.

An armature with one selected bone, and one
selected chain of three bones, just before
switching.

The selected bones have been switched. Bone.005
is no more connected nor parented to anything.
The chain of switched bones still exists, but
reversed (Now Bone.002 is its root, and Bone is its
tip). Bone.003 is now a free bone.

Editing Bones
Reference
Mode: Edit Mode

You will learn here how to add (Adding Bones), delete (Deleting Bones) or subdivide (Subdividing Bones)
bones. We will also see how to prevent any bone transformation (Locking Bones) in Edit Mode, and the option
that features an automatic mirroring (X-Axis Mirror Editing) of editing actions along the X axis.

Adding Bones
To add bones to your armature, you have more or less the same options as when editing meshes:
• Add menu,
• extrusion,
15
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• Ctrl-LMB clicks,
• fill between joints,
• duplication.

Add Menu
Reference
Mode: Edit Mode
Tool Shelf

This bone will be:
•
•
•
•

of one Blender Unit of length,
oriented towards the global Z axis,
with its root placed at the 3D cursor position,
with no relationship with any other bone of the armature.

Extrusion
Reference
Mode: Edit Mode
Tool Shelf ‣ Extrude

When you press E, for each selected tip (either explicitly or implicitly), a new bone is created. This bone will be
the child of “its” tip owner, and connected to it. As usual, once extrusion is done, only the new bones’ tips are
selected, and in grab mode, so you can place them to your liking. See Fig. Extrusion example..
Extrusion example.

An armature with three selected tips.

The three extruded bones.
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You also can use the rotating/scaling extrusions, as with meshes, by pressing respectively E-R and E-S – as
well as locked extrusion along a global or local axis.
Mirror extrusion example.

A single selected bone’s tip.

The two mirror-extruded bones.

Bones have an extra “mirror extruding” tool. By default, it behaves exactly like the standard extrusion. But
once you have enabled the X-Axis mirror editing option (see X-Axis Mirror Editing), each extruded tip will
produce two new bones, having the same name except for the “_L”/ “_R” suffix (for left/right, see the next
page). The “_L” bone behaves like the single one produced by the default extrusion – you can grab/rotate/scale
it exactly the same way. The “_R” bone is its mirror counterpart (along the armature’s local X axis), see Fig.
Mirror extrusion example..

Warning
Canceling the extrude action causes the newly created bones to snap back to the source position, (creating zero
length bones). These will be removed when exiting Edit Mode, however, they can cause confusion and it’s
unlikely you want to keep them. If you realize the problem immediately undo the extrude action.
In case you are wondering, you cannot just press DEL to solve this as you would in mesh editing, because
extrusion selects the newly created tips, and as explained below the delete command ignores bones’ joints.
To get rid of these extruded bones without undoing, you would have to move the tips, then select the bones
and delete (Deleting Bones) them.

Mouse Clicks
Reference
Mode: Edit Mode
Hotkey: Ctrl-LMB

If at least one bone is selected, Ctrl-LMB -clicking adds a new bone.
17
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About the new bone’s tip:
• after you Ctrl-LMB -clicked it becomes the active element in the armature,
• it appears to be right where you clicked, but...
• ...(as in mesh editing) it will be on the plane parallel to the view and passing through the 3D cursor.
The position of the root and the parenting of the new bone depends on the active element:

Ctrl-clicking when the active element is a bone.
If the active element is a bone
• the new bone’s root is placed on the active bone’s tip
• the new bone is parented and connected to the active bone (check the Outliner in Fig. Ctrl-clicking when
the active element is a tip.).

Ctrl-clicking when the active element is a tip.
If the active element is a tip :
• the new bone’s root is placed on the active tip
• the new bone is parented and connected to the bone owning the active tip (check the Outliner in Fig.
Ctrl-clicking when the active element is a tip.).

Ctrl-clicking when the active element is a disconnected root.
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If the active element is a disconnected root :
• the new bone’s root is placed on the active root
• the new bone is not parented to the bone owning the active root (check the Outliner in Fig. Ctrl-clicking
when the active element is a disconnected root.).
And hence the new bone will not be connected to any bone.

Ctrl-clicking when the active element is a connected root.
If the active element is a connected root :
• the new bone’s root is placed on the active root
• the new bone is parented and connected to the parent of the bone owning the active root (check the
Outliner in Fig. Ctrl-clicking when the active element is a connected root.).
This should be obvious because if the active element is a connected root then the active element is also the tip
of the parent bone, so it is the same as the second case.
As the tip of the new bone becomes the active element, you can repeat these Ctrl-RMB several times, to
consecutively add several bones to the end of the same chain.

Fill between joints
Reference
Mode: Edit Mode
Menu: Armature ‣ Fill Between Joints

The main use of this tool is to create one bone between two selected joints by pressing F, similar to how in
mesh editing you can “create edges/faces”.
If you have one root and one tip selected, the new bone:
• Will have the root placed on the selected tip.
• Will have the tip placed on the selected root.
• Will be parented and connected to the bone owning the selected tip.
Fill between a tip and a root.
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Active tip on the left.

Active tip on the right.

If you have two tips selected, the new bone:
• Will have the root placed on the selected tip closest to the 3D cursor.
• Will have the tip placed on the other selected tip.
• Will be parented and connected to the bone owning the tip used as the new bone’s root.
Fill between tips.

3D cursor on the left.

3D cursor on the right.

If you have two roots selected, you will face a small problem due to the event system in Blender not updating
the interface in real time.
When clicking F, similar to the previous case, you will see a new bone:
• With the root placed on the selected root closest to the 3D cursor.
• With the tip placed on the other selected root.
• Parented and connected to the bone owning the root used as the new bone’s root.
If you try to move the new bone, Blender will update the interface and you will see that the new bone’s root
moves to the tip of the parent bone.
Fill between roots.
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Before UI update (3D cursor on the left).

After UI update, correct visualization.

Clicking F with only one bone joint selected will create a bone from the selected joint to the 3D cursor position,
and it will not parent it to any bone in the armature.
Fill with only one bone joint selected.

Fill with only one tip selected.

Fill with only one root selected.

You will get an error when:
• trying to fill two joints of the same bone, or
• trying to fill more than two bone joints.

Duplication
Reference
Mode: Edit Mode
Menu: Armature ‣ Duplicate

Note
This tool works on selected bones; selected joints are ignored.
As in mesh editing,
• the selected bones will be duplicated,
• the duplicates become the selected elements and they are placed in grab mode, so you can move them
wherever you like.
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If you select part of a chain, by duplicating it you will get a copy of the selected chain, so the copied bones are
interconnected exactly like the original ones.
The duplicate of a bone which is parented to another bone will also be parented to the same bone, even if the
root bone is not selected for the duplication. Be aware, though, that if a bone is parented and connected to an
unselected bone, its copy will be parented, but not connected to the unselected bone (see Fig. Duplication
example.).
Duplication example.

An armature with three selected bones and a
selected single root.

The three duplicated bones. Note that the selected
chain is preserved in the copy, and that Bone.006
is parented but not connected to Bone.001, as
indicated by the black dashed line. Similarly,
Bone.007 is parented but not connected to
Bone.003.

Split
Reference
Mode: Edit Mode
Menu: Armature ‣ Split

Disconnects the selection and clears the parent at the start and end. ToDo.

Deleting Bones
You have two ways to remove bones from an armature: the standard deletion, and merging several bones in one.

Standard deletion
Reference
Mode: Edit Mode
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Menu: Armature ‣ Delete
Hotkey: DEL

Note
This tool works on selected bones: selected joints are ignored.
To delete a bone, you can:
• press DEL
• use the menu Armature ‣ Delete
If you delete a bone in a chain, its child(ren) will be automatically re-parented to its own parent, but not
connected, to avoid deforming the whole armature.
Deletion example.

An armature with two selected bones, just before The two bones have been deleted. Note that
deletion.
Bone.002, previously connected to the deleted
Bone.001, is now parented but not connected to
Bone.

Dissolve
Reference
Mode: Edit Mode
Menu: none

ToDo.

Merge
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Reference
Mode: Edit Mode
Menu: Armature ‣ Merge

You can merge together several selected bones, as long as they form a chain. Each sub-chain formed by the
selected bones will give one bone, whose root will be the root of the root bone, and whose tip will be the tip of
the tip bone.
Confirm by clicking on Merge Selected Bones ‣ Within Chains .
If another (non-selected) chain origins from inside of the merged chain of bones, it will be parented to the
resultant merged bone. If they were connected, it will be connected to the new bone.
Here is a strange subtlety (see Fig. Merge example.): even though connected (the root bone of the unmerged
chain has no root sphere), the bones are not visually connected. This will be done as soon as you edit one bone,
differently depending in which chain is the edited bone (compare the bottom two images of the example to
understand this better).
Merge example.

An armature with a selected chain, and a single
selected bone, just before merging.

Bones Bone, Bone.001 and Bone.002 have been
merged in Bone.006, whereas Bone.005 was not
modified. Note Bone.003, connected to Bone.006
but not yet “really” connected.

Bone.004 has been rotated, and hence the tip of
Bone.006 was moved to the root of Bone.003.

The tip of Bone.006 has been translated, and hence
the root of Bone.003 was moved to the tip of
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“Bone.006”

Subdividing Bones
Reference
Mode: Edit Mode
Menu: Armature ‣ Subdivide

You can subdivide bones, to get two or more bones where there was just one bone. The tool will subdivide all
selected bones, preserving the existing relationships: the bones created from a subdivision always form a
connected chain of bones.
To create two bones out of each selected bone:
• select Armature ‣ Subdivide from the header menu.
To create an arbitrary number of bones from each selected bone in the Subdivide Multi Operator panel.
Number of Cuts
Specifies the number of cuts. As in mesh editing, if you set n cuts, you will get n + 1 bones for each
selected bone.
Subdivision example.

An armature with one selected bone, just before
multi-subdivision.

The selected bone has been “cut” two times,
giving three sub-bones.

Locking Bones
You can prevent a bone from being transformed in Edit Mode in several ways:
• All bones can be locked clicking on the Lock checkbox of their Transform panel in the Bones tab;
• Press Shift-W Toggle Bone Options ‣ Locked
• Select Armature ‣ Bone Settings ‣ Toggle a Setting ).
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If the root of a locked bone is connected to the tip of an unlocked bone, it will not be locked, i.e. you will be
able to move it to your liking. This means that in a chain of connected bones, when you lock one bone, you
only really lock its tip. With unconnected bones, the locking is effective on both joints of the bone.

X-Axis Mirror Editing
Another very useful tool is the X-Axis Mirror editing option by Tool panel ‣ Armature Options , while
Armature is selected in Edit Mode. When you have pairs of bones of the same name with just a different “side
suffix” (e.g. ”.R”/”.L”, or “_right”/”_left” ...), once this option is enabled, each time you transform
(move/rotate/scale...) a bone, its “other side” counterpart will be transformed accordingly, through a symmetry
along the armature local X axis. As most rigs have at least one axis of symmetry (animals, humans, ...), it is an
easy way to spare you half of the editing work!
See also
naming bones.

Separating Bones in a new Armature
You can, as with meshes, separate the selected bones in a new armature object Armature ‣ Separate , and of
course, in Object Mode, you can join all selected armatures in one Object ‣ Join Objects ,

Naming
Reference
Mode: Edit Mode
Panel: Properties region ‣ Item, Bones tab ‣ Bones panel

You can rename your bones, either using the name field of the Item panel in the 3D Views, for the active bone,
or using the name field in each bone of the Bones tab in Edit Mode.
Blender also provides you some tools that take advantage of bones named in a left/right symmetry fashion, and
others that automatically name the bones of an armature. Let us look at this in detail.

Naming Conventions
Naming conventions in Blender are not only useful for you in finding the right bone, but also to tell Blender
when any two of them are counterparts.
In case your armature can be mirrored in half (i.e. it is bilaterally symmetrical), it is worthwhile to stick to a
left/right naming convention. This will enable you to use some tools that will probably save you time and effort
(like the X-Axis Mirror editing tool we saw above...).
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An example of left/right bone naming in a simple rig.
1. First you should give your bones meaningful base-names, like “leg”, “arm”, “finger”, “back”, “foot”,
etc.
2. If you have a bone that has a copy on the other side (a pair), like an arm, give it one of the following
separators:
• Left/right separators can be either the second position “L_calfbone” or last-but-one “calfbone.R”
• If there is a lower or upper case “L”, “R”, “left” or “right”, Blender handles the counterpart
correctly. See below for a list of valid separators. Pick one and stick to it as close as possible
when rigging; it will pay off.
Examples of valid saparators:
•
•
•
•
•

(nothing): handLeft –> handRight
_ (underscore): hand_L –> hand_R
. (dot): hand.l –> hand.r
- (dash): hand-l –> hand-r
`` `` (space): hand LEFT –> hand RIGHT

Note
Note that all examples above are also valid with the left/right part placed before the
name. You can only use the short “L”/ “R” code if you use a separator (e.g “handL”/
“handR” will not work!).
3.
4. Before Blender handles an armature for mirroring or flipping, it first removes the number extension, e.g.
”.001”.
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5. You can copy a bone named “bla.L” and flip it over using Specials ‣ Flip Left-Right Names . Blender
will name the copy “bla.L.001” and flipping the name will give you “bla.R”.

Flip Name
Reference
Mode: Edit Mode
Menu: Armature ‣ Flip Name

You can flip left/right markers (see above) in selected bone names, using Armature ‣ Flip Name . This can be
useful if you have constructed half of a symmetrical rig (marked for a left or right side) and duplicated and
mirrored it, and want to update the names for the new side. Blender will swap text in bone names according to
the above naming conventions, and remove number extensions if possible.

AutoName
Reference
Mode: Edit Mode
Menu: Armature ‣ AutoName Left/Right, Armature ‣ AutoName Front/Back, Armature ‣ AutoName
Top/Bottom

The three AutoName entries of the Armature and Specials menu W allows you to automatically add a suffix to
all selected bones, based on the position of their root relative to the armature center and its local coordinates:
AutoName Left/Right
will add the ”.L” suffix to all bones with a positive X-coordinate root, and the ”.R” suffix to all bones
with a negative X-coordinate root. If the root is exactly at 0.0 on the X-axis, the X-coordinate of the tip is
used. If both joints are at 0.0 on the X-axis, the bone will just get a period suffix, with no “L”/ “R” (as
Blender cannot decide whether it is a left or right bone...).
AutoName Front/Back
will add the ”.Bk” suffix to all bones with a positive Y-coordinate root, and the ”.Fr” suffix to all bones
with a negative Y-coordinate root. The same as with AutoName Left-Right goes for 0.0 Y-coordinate
bones...
AutoName Top/Bottom
will add the ”.Top” suffix to all bones with a positive Z-coordinate root, and the ”.Bot” suffix to all bones
with a negative Z-coordinate root. The same as with AutoName Left-Right goes for 0.0 Z-coordinate
bones...

Parenting
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Reference
Mode: Edit Mode
Panel: Armature
Menu: Armature ‣ Parent ‣ ...

You can edit the relationships between bones (and hence create/modify the chains of bones) both from the 3D
Views and the Properties editor. Whatever method you prefer, it’s always a matter of deciding, for each bone, if
it has to be parented to another one, and if so, if it should be connected to it.
To parent and/or connect bones, you can:
• In a 3D View, select the bone and then its future parent, and press Ctrl-P (or Armature ‣ Parent ‣
Make Parent... ). In the small Make Parent menu that pops up, choose Connected if you want the child
to be connected to its parent, else click on Keep Offset. If you have selected more than two bones, they
will all be parented to the last selected one. If you only select one already-parented bone, or all selected
bones are already parented to the last selected one, your only choice is to connect them, if not already
done. If you select only one non-parented bone, you will get the Need selected bone(s) error message...
Note
With this method, the newly-children bones will not be scaled nor rotated – they will just be
translated if you chose to connect them to their parent’s tip.
• In the Properties editor, Bones tab, for each selected bone, you can select its parent in the Parent data-ID
to the upper right corner of its Relations panel. If you want them to be connected, just enable the
checkbox to the right of the list.
Note
With this method, the tip of the child bone will never be translated – so if Connected is
enabled, the child bone will be completely transformed by the operation.

Parenting example.
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The starting armature, with Bone.005 parented
and connected to Bone.004.

Bone.005 re-parented to Bone.002, but not
connected to it (same result, using either CtrlP-2 in 3D View, or the Bones tab settings).

Bone.005 parented and connected to Bone.002,
using Ctrl-P-1 in 3D View.

Bone.005 parented and connected to Bone.002.
Using the Parent data-ID of Bone.005 Relations
panel.

To disconnect and/or free bones, you can:
• In a 3D View, select the desired bones, and press Alt-P (or Armature ‣ Parent ‣ Clear Parent... ). In
the small Clear Parent menu that pops up, choose Clear Parent to completely free all selected bones, or
Disconnect Bone if you just want to break their connections.
• In the Properties editor, Bones tab, for each selected bone, you can select no parent in the Parent data-ID
of its Relations panel, to free it completely. If you just want to disconnect it from its parent, disable the
Connected checkbox.
Note that relationships with non-selected children are never modified.

Properties
Reference
Mode: Edit Mode
Menu: Armature ‣ Bone Settings ‣ ...
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Most bones’ properties (excepted the transform ones) are regrouped in each bone’s panels, in the Bones tab in
Edit Mode. Let us detail them.
Draw Wire
ToDo.
Deform
Multiply Vertex Group by Envelope
These settings control how the bone influences its geometry, along with the bones’ joints radius. This will
be detailed in the skinning part.
Inherit Rotation
These settings affect the behavior of children bones while transforming their parent in Pose Mode, so this
will be detailed in the posing part !
Inherit Scale
ToDo.
Lock
This will prevent all editing of the bone in Edit Mode;

Skeleton Sketching

The Bone Sketching panel.
If you think that creating a whole rig by hand, bone after bone, is quite boring, be happy: some Blender
developers had the same feeling, and created the Skeleton Sketching tool, formerly the Etch-a-ton tool, which
basically allows you to “draw” (sketch) whole chains of bones at once.
Skeleton Sketching is obviously only available in Edit Mode, in the 3D Views. You control it through its
Skeleton Sketching panel in the Transform panel, which you can open with N. Use the mouse LMB to draw
strokes, and RMB for gestures. Showing its tool panel will not enable sketching. You must tick the checkbox
next to Skeleton Sketching to start drawing bone chains (otherwise, you remain in the standard Edit Mode...).
Sketching is done in two steps:
• Drawing Chains (called “strokes”). Each stroke corresponds to a chain of bones.
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• Converting to Bones, using different methods.
The point of view is important, as it determines the future bones’ roll angle: the Z axis of a future bone will be
aligned with the view Z axis of the 3D View in which you draw its “parent” stroke (unless you use the Template
converting method...). Strokes are drawn in the current view plane passing through the 3D cursor, but you can
create somewhat “3D” strokes using the Adjust drawing option in different views (see below).
If you enable the small Quick Sketch option, the two steps are merged into one: once you have finalized the
drawing of a stroke (see Drawing Chains), it is immediately converted to bones (using the current active
method) and deleted. This option makes bone sketching quick and efficient, but you lose all the advanced stroke
editing possibilities.
Sketches are not saved into blend-files, so you cannot interrupt a sketching session without losing all your
work! Note also that the sketching is common to the whole Blender session, i.e. there is only one set of strokes
(one sketch) in Blender, and not one per armature, or even per file...

Drawing Chains
So, each stroke you draw will be a chain of bones, oriented from the starting point (the reddest or most orange
part of the stroke) to its end (its whitest part). A stroke is made of several segments, delimited by small black
dots. There will be at least one bone per segment (except with the Template conversion method, see next page),
so all black points represents future bones’ joints. There are two types of segments, which can be mixed
together:

Strokes example. From top to bottom: A selected polygonal stroke of four straight segments, oriented from left
to right. An unselected free stroke of two segments, oriented from left to right. A mixed stroke, with one straight
segment between two free ones, right to left.
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Straight Segments
To create a straight segment, click LMB at its starting point. Then move the mouse cursor, without pressing any
button, a dashed red line represents the future segment. Click LMB again to finalize it. Each straight segment of
a stroke will always create one and only one bone, whatever convert algorithm you use (except for the Template
conversion method).
Drawing straight segments example.

The first segment has been started
with a LMB click and the mouse
moved to its end point.

The first segment has been finalized Repeating these steps, we now have
by a second LMB click, which also a four-segment polygonal stroke.
started a new segment...

Free Segments
To create a free (curved) segment, click and hold LMB at its starting point. Then draw your segment by moving
the mouse cursor – as in any paint program! Release LMB to finalize the segment. You will then be creating a
new straight segment, so if you would rather start a new free segment, you must immediately re-press LMB.
The free segments of a stroke will create different number of bones, in different manners, depending on the
conversion method used. The future bones’ joints for the current selected method are represented by small green
dots for each one of those segments, for the selected strokes only.
The free segment drawing uses the same Manhattan Distance setting as the grease pencil tool (User
Preferences, Edit Methods “panel”, Grease Pencil group) to control where and when to add a new point to the
segment. So if you feel your free segments are too detailed, raise this value a bit, and if you find them too
jagged, lower it.
Drawing free segments example.

While drawing a first free segment with click
and drag LMB.

The first free segment finalized by releasing
LMB.
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If you now move the mouse without pressing But if you immediately click again and drag
LMB again, you will create a straight segment... LMB you will instead start a new free segment.
You finalize a whole stroke by clicking RMB. You can cancel the stroke you are drawing by pressing Esc. You
can also snap strokes to underlying meshes by holding Ctrl while drawing. By the way, the Peel Objects
button at the bottom of the Bone Sketching panel is the same thing as the “monkey” button of the snapping
header controls shown when Volume snap element is selected. See the snap to mesh page for details.

Selecting Strokes
A stroke can be selected (materialized by a solid red-to-white line), or not (shown as an orange-to-white line) see (Strokes example) above. As usual, you select a stroke by clicking RMB on it, you add one to/remove one
from the current selection with a Shift-RMB click, and A (de)selects all strokes...

Deleting
Clicking on the Delete button (Bone Sketching panel) deletes the selected strokes (be careful, no
warning/confirmation pop-up menu here). See also Gestures.

Modifying Strokes
You can adjust, or “redraw” your strokes by enabling the Overdraw Sketching option of the Bone Sketching
panel. This will modify the behavior of the strokes drawing (i.e. LMB clicks and/or hold): when you draw, you
will not create a new stroke, but rather modify the nearest one.
The part of the old stroke that will be replaced by the new one are drawn in gray. This option does not take into
account stroke selection, i.e. all strokes can be modified this way, not just the selected ones... Note also that
even if it is enabled, when you draw too far away from any other existing stroke, you will not modify any of
them, but rather create a new one, as if Overdraw Sketching was disabled.
Adjusting stroke example.

Adjusting a stroke: the gray part of the “unselected”
Stroke adjusted.
(orange) stroke will be replaced by the currently drawn
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“replacement”.

Warning
There is no undo/redo for sketch drawing...

Gestures
There quite a few things about strokes editing that are only available through gestures. Gestures are started by
clicking and holding Shift-LMB (when you are not already drawing a stroke), and materialized by blue-towhite lines. A gesture can affect several strokes at once.
There is no direct way to cancel a gesture once you have started “drawing” it. So the best thing to do, if you
change your mind (or made a “false move”), is to continue to draw until you get a disgusting scribble, crossing
your stroke several times. In short, something that the gesture system would never recognize!

An unwanted cut stroke.

Some random drawing.

The stroke is still in one piece.

Cut
To cut a segment (i.e. add a new black dot inside it, making two segments out of one), “draw” a straight line
crossing the chosen segment where you want to split it.

Gesture.

Result.

Delete
To delete a stroke, draw a “V” crossing the stroke to delete twice.
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Gesture.

Result.

Reverse
To reverse a stroke (i.e. the future chain of bones will be reversed), draw a “C” crossing twice the stroke to
reverse.

Gesture.

Result.

Converting to Bones
Once you have one or more selected strokes, you can convert them to bones, using either the Convert button of
the Bone Sketching panel, or the corresponding gesture (see Gestures). Each selected stroke will generate a
chain of bones, oriented from its reddest end to its whitest one. Note that converting a stroke does not delete it.
There are four different conversion methods with three “simple” ones, and one more advanced and complex,
Template, that reuses bones from the same armature or from another one as a template for the strokes to
convert, and which is detailed in the next page. Anyway, remember that straight segments are always converted
to one and only one bone (except for the Template conversion method), and that the future bones’ joints are
shown as green dots on selected free segments.
Remember also that the roll rotation of the created bones has been set during their “parent” stroke drawing
(except for the Template conversion method) - their Z axis will be aligned with the view Z axis of the active 3D
View at draw time.

Fixed
With this method, each free segment of the selected strokes will be uniformly divided in n parts (set in Number
number button), i.e. will give n bones.

The Fixed conversion preview on selected strokes. The Fixed conversion result.
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Adaptive
With this method, each free segment of the selected strokes will create as many bones as necessary to follow its
shape closely enough. This “closely enough” parameter being set by the Threshold number button; higher
values giving more bones, following more closely the segments’ shape. So the more twisted a free segment, the
more bones it will generate.

The Adaptive conversion preview on selected
strokes.

The Adaptive conversion result.

Length
With this method, each free segment of the selected strokes will create as many bones as necessary, so that none
of them is longer than the Length number button value (in Blender Units).

The Length conversion preview Using a larger length value.
on selected strokes.

The Length conversion result.

Retarget
Retarget template bone chain to stroke.
Template
Template armature that will be retargeted to the stroke. This is a more complex topic, detailed in its own
page.
Retarget roll mode
None
Do not adjust roll.
View
Roll bones to face the view.
Joint
Roll bone to original joint plane offset.
Autoname
Todo.
Number
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Todo.
Side
Todo.

Armature Templating
The idea of templating is to use an already existing armature as base (“template”) to create a new armature. It
differs from a simple copy in that you can directly define the new armature different in some aspects than its
reference rig.
In Blender, the only templating tool is the bone sketching one (Etch-a-ton, described in the previous page), with
its Template conversion method, so you should have read its page before this one!

Using Bone Sketching
Reference
Mode: Edit Mode
Panel: Bone Sketching (3D View editor)
Menu: Armature ‣ Bone Sketching

The Template conversion method of Bone Sketching tool maps a copy of existing bones to each selected stroke.
The new bones will inherit some of their properties (influence, number of segments, etc.) from the
corresponding bones in the template, but they will acquire their lengths, rolls and rotation from the sketch; so
these properties would be different as compared to the template.
This is easier to understand with some examples.
In the following image, “armature.002” is set as the template, and the stroke maps with “chain_a” of this
template. None of the bones are selected in the template. Note that there is no second stroke to map with chain
“chain_b” of the template. The result is shown at right: Blender creates a copy of “chain_a” and matches the
bones with the stroke.
Blender also creates a copy of “chain_b”, but this chain is not altered in any way; because this command can
map only one selected chain with a stroke.
In the following example, no template is selected. (In other words, all the action is within the armature itself.)
Two bones are selected in “chain_b”, and the property panel is set to map the joints with the stroke. So these
two selected bones are copied and the newly created copy of the chain is matched with the stroke. (Note that the
newly created bones are named in continuation of the original chain.)
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Conversion settings.

Before conversion.

After conversion.

If you had selected both the chains (“Chain_a” and “Chain_b”), you would have still got the same result as in
the example above, because the command maps to stroke only one selected chain.
In the following example also, only one chain is selected, but there are three strokes to map to. In this case, the
same chain is copied three times (once for each stroke) and then mapped to individual strokes. Note how a twobone chain is fitted to a three-segment stroke.
The newly created bones are numbered sequentially, after the original bones’ names.

Before conversion.

After conversion.

OK now, here are some important ground rules:
• This conversion method can use as reference bones either the selected bones in the currently edited
armature, or all bones from another armature. In general, it is a better idea to create new “templated”
bones inside the “reference” armature, so you can precisely select which bones to use as template – if
you want the new bones in a different armature, you can then use the Separate and optionally Join
commands...
• This tool only considers one chain of bones, so it is better to select only one chain of bones inside the
current armature (or use a single-chain armature object as template). Else, the chain of the template
containing the first created bones will be mapped to the selected strokes, and the other chains will just
be “copied” as is, without any modification.
• This tool maps the same chain of bones on all selected strokes, so you cannot use multiple strokes to
map a multi-chains template – you will rather get a whole set of new bones for each selected stroke!
• If you have strokes only made of straight segments, they must have at least as much segments as there
are bones in the template chain (else, the newly created chain is not mapped at all to the stroke, and
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remains an exact duplicate of its template). If there are more segments than necessary, the conversion
algorithm will chose the best “joints” for the bones to fit to the reference chain, using the same influence
settings as for free segments (Angle, Length and Definition settings, see below).
• If you try to Convert without template bones (i.e. either an empty armature selected as template, or no
bones selected in the current edited armature), you will get the error message No Template and no
deforming bones selected, and nothing will occur.
The Skeleton Sketching panel with Retarget conversion method enabled.

With current edited armature as
template.

With another armature as template.

Now, here are the settings of this conversion method:
No, View, Joint buttons
These three toggle buttons (mutually exclusive) control how the roll angle of newly created bones is
affected:
No
Do not alter the bones roll (i.e. the new bones’ rolls fit their reference ones).
View
Roll each bone so that one of its X, Y or Z local axis is aligned (as much as possible) with the
current view’s Z axis.
Joint
New bones roll fit their original rotation (as No option), but with regards to the bend of the joint
with its parent.
Templating: bone roll example.
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With No roll option.

With View roll option.

With Joint roll option.

The “Bone.003” to “Bone.005” chain is the mapped-to-stroke version of “Bone” to “Bone.002” selected one,
and “Bone.001” has a modified roll angle.
Template
In this data-ID you can select the armature to use as template. If you choose None, the selected bones
from the currently edited armature will be used as reference, else all bones of the other armature will be
used.
Angle, Length, Definition are numeric fields.
These settings control how the template is mapped to the selected strokes. Each one can have a value
between (0.0 and 10.0), the default being 1.0.
Angle
Controls the influence of the angle of the joints (i.e. angle between bones). The higher this value,
the more the conversion process will try to preserve these joints angle in the new chain.
Length
Controls the influence of the bones’ length. The higher this value, the more the conversion process
will try to preserve these lengths in the new bones.
Definition
Controls the influence of the stroke’s shape. The higher this value, the more the conversion process
will try to follow the stroke with the new chain.
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Examples of Template conversions for various influence weights values, with one stroke quite similar to the
template chain’s shape, and one stroke very different.
Side and Number text fields, auto button
These control how the new bones are named. By default, they just take the same names as the originals
from the template, except for the final number, increased as needed. However, if the template bones have
“&s” somewhere in their name, this “placeholder” will be replaced in the “templated” bones’ names by
the content of the Side text field. Similarly, a “&n” placeholder will be replaced by the Number field
content. If you enable the small auto button, the Number field content is auto-generated, producing a
number starting from nothing, and increased each time you press the Convert button, and the “&s”
placeholder is replaced by the side of the bone (relative to the local X axis: “r” for negative X values, “l”
for positive ones).
Naming and placeholders, using a simple leg template.

Conversion settings.

Before conversion (note the &n After conversion: the
and &s placeholders in
placeholders have been
template bones’ names).
replaced by the content of the S
and N text fields of the Bone
Sketching panel.
Auto naming and placeholders, using a simple leg template.

Before conversion (note that, in After conversion.
the Bone Sketching panel, the
S and N fields are empty, and
the small “auto” button is
enabled).
Conversion settings.
Static text line
The line just above the Peel Objects button gives you two informations:
• The n joints part gives you the number of joints (i.e. bones’ joints, with connected joints
considered as one joint), either from the selected bones of the edited armature, or in the whole
other template armature.
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• The second part is only present when another armature has been selected as template – it gives you
the root bone’s name of the chain that will be mapped to the strokes. Or, while you are drawing a
stroke with straight segments, the name of the bone corresponding to the current segment (and
“Done” when you have enough segments for all bones in the template chain).

Introduction
Reference
Mode: Object Mode, Edit Mode and Pose Mode
Panel: All in Properties editor, Bone property

When bones are selected (hence in Edit Mode and Pose Mode), their properties are shown in the Bone tab of the
Properties editor. This shows different panels used to control features of each selected bone; the panels change
depending on which mode you are working in.

The Bone tab.
Relations
In this panel you can arrange sets of bones in different layers for easier manipulation.
Display
Display panel lets you customize the look of your bones taking the shape of another existing object.
Deform
In this panel you can set basic deformation properties of the bones.

Transform

The Transform panel (edit mode).
When in edit mode you can use this panel to control position and roll of individual bones.
When in pose mode you can only set location for the main bone, and you can now set rotation and scale.
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The Transform panel (pose mode).

Note
This mode is only available in Edit Pose Modes.

Transform Locks

The Transform Locks panel.
This panel appears only in pose mode and allows you to restrict position, rotation and scale by axis on each
bone in the armature.
Note
This mode is only available in Pose Mode.
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Inverse Kinematics

The Inverse Kinematics panel.
This panel controls the way a bone or set of bones behave when linked in an inverse kinematic chain.

Note
This mode is only available in Pose Mode.

Custom Properties
See the Custom Properties page for more information.

Bendy Bones
Bendy Bones (B-Bones) are an easy way to replace long chains of many small rigid bones. A common use case
for curve bones is to model spine columns or facial bones.

Technical Details
Blender treats the bone as a section of a Bézier curve passing through the bones’ joints. Each Segments will
bend and roll the to follow this invisible curve representing a tessellated point of the Bézier curve. The control
points at each end of the curve are the endpoints of the bone. The shape of the B-Bones can be controlled using
a series of properties or indirectly through the neighboring bones (i.e. first child and parent). The properties
construct handles on either end of the bone to control the curvature.
When using the B-bone as a constraint target Data ID offers an option to follow the curvature.
Note
However, if the bone is used as an target rather than to deform geometry, the roll is not taken in account.
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Display
You can see these segments only if bones are visualized as B-bones.
When not visualized as B-Bone s, bones are always shown as rigid sticks, even though the bone segments are
still present and effective. This means that even in e.g. Octahedron visualization, if some bones in a chain have
several segments, they will nonetheless smoothly deform their geometry...

Rest Pose
The initial shape of a B-Bone can be defined in Edit Mode as a rest pose of that bone. This is useful for curved
facial features like curved eyebrows or mouths.
B-Bones have two sets of the Bendy Bone properties – one for Edit mode (i.e. the Rest Pose/Base Rig) and
another for Pose Mode – adding together their values to get the final transforms.

Example

The OLD B-Bones, in Edit Mode. ToDo.

The Bézier curve superposed to the chain, with its
handles placed at bones’ joints.

The same armature in Object Mode.
In Fig. The OLD B-Bones, in Edit Mode. ToDo. we connected three bones, each one made of five segments.
Look at Fig. The same armature in Object Mode., we can see how the bones’ segments smoothly “blend” into
each other, even for roll.
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An armature in Pose Mode, B-Bone visualization: Bone.003 has one segment, Bone.004 has four, and Bone.005
has sixteen.

Options
Segments
The Segments number button allows you to set the number of segments, which the given bone is subdivided
into. Segments are small, rigid linked child bones that interpolate between the root and the tip. The higher this
setting, the smoother “bends” the bone, but the heavier the pose calculations...

Curve XY Offsets
Applies an offsets the curve handle positions on the plane perpendicular to the bone’s primary (Y) axis. As a
result, the handle moves per-axis (XY) further from its original location, causing the curve to bend.

Roll
Roll In, Out
The roll value (or twisting around the main Y axis of the bone) is interpolated per-segment, between the
start and end roll values. It is applied as a rotational offsets on top of the previous rotation.
Inherit End Roll
ToDo.

Scale
Scale In, Out
Scaling factor that adjusts the thickness of each segment for X and Z axes only, i.e. length is not affected.
Similar to Roll it is interpolated per-segment.
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Easing
Ease In, Out
The Ease In/Out number buttons, change the “length” of the “auto” Bézier handle to control the “root
handle” and “tip handle” of the bone, respectively.
These values are proportional to the default length, which of course automatically varies depending on
bone length, angle with the handle reference, and so on.
Ease In/Out settings example, with a materialized Bézier curve.

Look at Bone.004: it has the default In and Out
values (1.0).

Bone.004 with In at 2.0, and Out at 0.0.

Custom Handle Reference
B-Bones can use custom bones as their reference bone handles, instead of only using the parent/child bones. To
do so, enable the Use Custom Reference Handles toggle in Pose Mode. If none are specified, then the BBone
will only use the Bendy Bone properties. When the option is on, just use the specified bones instead of using
trying looking at the bone’s neighbors.
Relative
Instead of using the endpoints of the bones as absolute points in 3D space it computes how far the
reference bone has moved away from its rest pose. The delta transformation is then applied as to the
bone’s own endpoints to get the handle locations. This is useful if the custom control bone is far away
from its target.
Tip
Keying Set
The “BBone Shape” Keying Set includes all Bendy Bones properties.
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Example

Visualization of the Bendy Bones properties.

Relations

The Relations panel.
In this panel you can arrange sets of bones in different layers for easier manipulation.

Bone Layers
Reference
Mode: Object, Edit and Pose Mode
Panel: Bone ‣ Relations

49

Bforartists Reference Manual - © Copyright - This page is under OCL license

Moving bones between layers
Obviously, you have to be in Edit Mode or Pose Mode to move bones between layers. Note that as with objects,
bones can lay in several layers at once, just use the usual Shift-LMB clicks... First of all, you have to select
the chosen bone(s)!
• In the Properties editor, use the “layer buttons” of each selected bone Relations panel (Bones tab) to
control in which layer(s) it lays.
• In the 3D View editor, use the menu Armature ‣ Move Bone To Layer or Pose ‣ Move Bone To Layer
or press M to show the usual pop-up layers menu. Note that this way, you assign the same layers to all
selected bones.

Bone Group
Reference
Mode: Pose Mode

The Bone Group data-ID.
To assign a selected bone to a given bone group use the Bone Group data-ID.

Object Children
Reference
Mode: Pose Mode
Relative Parenting
ToDo.

Parenting
Parent
A data-ID to select the bone to set as a parent.
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Connected
The Connected checkbox set the head of the bone to be connected with its parent root.

Transformations
Bones relationships have effects on transformations behavior.
By default, children bones inherit:
• Their parent position, with their own offset of course.
• Their parent rotation (i.e. they keep a constant rotation relatively to their parent).
• Their parent scale, here again with their own offset.
Examples of transforming parented/connected bones.

The armature in its rest
position.

Rotation of a root bone.

Scaling of a root bone.

Exactly like standard children objects. You can modify this behavior on a per-bone basis, using the Relations
panel in the Bones tab:

Relations panel in Pose Mode.
Inherit Rotation
When disabled, this will “break” the rotation relationship to the bone’s parent. This means that the child
will keep its rotation in the armature object space when its parent is rotated.
Inherit Scale
When disabled, this will “break” the scale relationship to the bone’s parent.
These inheriting behaviors propagate along the bones’ hierarchy. So when you scale down a bone, all its
descendants are by default scaled down accordingly. However, if you set one bone’s Inherit Scale or Inherit
Rotation property on in this “family”, this will break the scaling propagation, i.e. this bone and all its
descendants will no longer be affected when you scale one of its ancestors.
Examples of transforming parented/connected bones with Inherit Rotation disabled.
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The yellow outlined Inherit
Rotation disabled bone in the
armature.

Rotation of a bone with an
Scaling of a bone with an
Inherit Rotation disabled bone Inherit Rotation disabled bone
among its descendants.
among its descendants.

Connected bones have another specificity: they cannot be translated. Indeed, as their root must be at their
parent’s tip, if you do not move the parent, you cannot move the child’s root, but only its tip, which leads to a
child rotation. This is exactly what happens, when you press G with a connected bone selected, Blender
automatically switches to rotation operation.
Bones relationships also have important consequences on how selections of multiple bones behave when
transformed. There are many different situations which may not be included on this list, however, this should
give a good idea of the problem:
• Non-related selected bones are transformed independently, as usual.

Scaling bones, some of them related.
• When several bones of the same “family” are selected, only the “most parent” ones are really
transformed – the descendants are just handled through the parent relationship process, as if they were
not selected (see Fig. Scaling bones, some of them related. the third tip bone, outlined in yellow, was
only scaled down through the parent relationship, exactly as the unselected ones, even though it is
selected and active. Otherwise, it should have been twice smaller!).
• When connected and unconnected bones are selected, and you start a grab operation, only the
unconnected bones are affected.
• When a child connected hinge bone is in the selection, and the “most parent” selected one is connected,
when you press G, nothing happens, because Blender remains in grab operation, which of course has no
effect on a connected bone.
So, when posing a chain of bones, you should always edit its elements from the root bone to the tip bone. This
process is known as forward kinematics (FK). We will see in a later page that Blender features another pose
method, called inverse kinematics (IK), which allows you to pose a whole chain just by moving its tip.
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Note
This feature is somewhat extended/completed by the pose library tool.

Display Panel
Reference
Mode: Object and Pose Mode
Panel: Bone ‣ Display

The Display panel.
Display panel lets you customize the look of your bones taking the shape of another existing object.
Hide
Hides the selected bone.
Wireframe
When enabled, bone is displayed in wireframe mode regardless of the viewport drawing mode. Useful for
non-obstructive custom bone chains.

Custom Shape
Blender allows you to give to each bone of an armature a specific shape (in Object Mode and Pose Mode),
using another object as “template”. In order to be visible the Shapes checkbox has to be enabled ( Armature ‣
Display panel).

Options
Custom Shape
Object that defines the custom shape of the selected bone.
Bone Size
Option not to use bones length, so that changes in Edit Mode don’t resize the custom-shape.
Scale
Avoids having multiple custom-shapes at different sizes.
At
Bone that defines the display transform of this shape bone.

Workflow
To assign a custom shape to a bone, you have to:
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• Switch to Pose Mode
• Select the relevant bone by clicking on it with RMB.
• Go to the Display panel Custom Shape field and select the 3D object previously created in the scene; in
this example we are using a cube and a cone. You can optionally set the At field to another bone.

The Display panel.

The armature with shape assigned to bone. Note the center of the Cone object.
Note
• These shapes will never be rendered, like any bone, they are only visible in 3D Views.
• Even if any type of object seems to be accepted by the OB field (meshes, curves, even metas...), only
meshes really work. All other types just make the bone invisible; nothing is drawn...
• The center of the shape object will be at the root of the bone (see the bone page for root/tip).
• The object properties of the shape are ignored (i.e. if you make a parallelepiped out of a cube by
modifying its dimensions in Object Mode, you will still have a cube shaped bone...).
• The “along bone” axis is the Y one, and the shape object is always scaled so that one Blender Unit
stretches along the whole bone length.
• If you need to remove the custom shape of the bone, just right click in the Custom Shape field and
select Reset to default value in the pop-up menu.
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So to summarize all this, you should use meshes as shape objects, with their center at their lower -Y end, and an
overall Y length of 1.0 BU.

Deform

The Deform panel.
In this panel you can set basic properties of the bones.
Turning the Deform option on and off, includes the active bone in the Automatic Weight Calculation when the
Mesh is Parented to the Armature using the Armature Deform with the “With Automatic Weights” option.
Also it is worth noting that by turning off a bone’s deform option, makes it not influence the mesh at all,
overriding any weights that it might have been assigned before; It mutes its influence.

Envelope
ToDo.

Introduction
Reference
Mode: Object Mode, Edit Mode and Pose Mode
Panel: All in Properties editor, Object property
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Let us first have a general overview of the various panels gathering the armature settings, in Properties editor,
Object tab:

The Object property in the Properties editor.
Skeleton
In this panel you can arrange sets of bones into different layers for easier manipulation.
Display
This controls the way the bones appear in 3D View.
Bone Groups
Bone Groups are meant to be used during the rig creation to define and assign a color to a meaningful set
of bones.
Pose Library
Allows you to save different properties (location, rotation, scale) for selected bones for later use.
Ghost
Allows you to see a set of different poses, very useful when animating.
Motion Paths
In the Motion Paths panel you can enable visualization of the motion path your skeleton leaves when
animated.

Inverse Kinematics

The Inverse Kinematics panel.
Defines the type of IK solver used in your animation.

Custom Properties
See the Custom Properties page for more information.

Skeleton
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The Skeleton panel.
In this panel you can arrange sets of bones into different layers for easier manipulation.

Position
A radio button to switch between Pose Position and Rest Position.
Whereas in Edit Mode, you always see your armature in its rest position, in Object Mode and Pose Mode you
see it by default in its Pose Position (i.e. as it was transformed in the Pose Mode). If you want to see it in the
rest position in all modes, enable the Rest Position button in the Armature tab (Edit Mode).

Armature Layers
Reference
Mode: Object, Edit and Pose Mode
Panel: Object data ‣ Skeleton
Each armature has 32 “Armature layers” which allow you to organize your armature by “regrouping” sets of
bones into layers; this works similar to scene layers (those containing your objects). You can then “move” a
bone to a given layer, hide or show one or several layers, etc.

Showing/hiding bone layers
Only bones in active layers will be visible/editable, but they will always be effective (i.e move objects or
deform geometry), whether in an active layer or not. To (de)activate a layer, you have several options,
depending in which mode you are in:
• In all modes, use the row of small buttons at the top of the Display Options group, Armature panel. If
you want to enable/disable several layers at once, as usual, hold Shift while clicking...
• In Edit Mode and Pose Mode, you can also do this from the 3D View, either by using the menu
Armature ‣ Switch Armature Layers or Pose ‣ Switch Armature Layers , to display a small pop-up
menu containing the same buttons as described above (here again, you can use Shift-LMB clicks to
(de)select several layers at once).
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Protected Layers
You can lock a given bone layer for all proxies of your armature, i.e. all bones in this layer will not be editable.
To do so, in the Skeleton panel, Ctrl-LMB click on the relevant button, the layer lock will be enabled.
Protected layers in proxy are restored to proxy settings on file reload and undo.

Display Panel
Reference
Mode: Object, Edit and Pose Mode
Panel: Object Data ‣ Display

The Display panel.
This controls the way the bones appear in 3D View; you have four different visualizations you can select.

Bone Types
We have four basic bone visualization: Octahedral, Stick, B-Bone, Envelope and Wire:

Octahedral bone display.

Stick bone display.
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B-Bone bone display.

Envelope bone display.

Octahedral bone
This is the default visualization, well suited for most of editing tasks. It materializes:
• The bone root (“big” joint) and tip (“small” joint).
• The bone “size” (its thickness is proportional to its length).
• The bone roll (as it has a square section).

Note the 40° rolled Bone.001 bone.
Stick bone
This is the simplest and most non-intrusive visualization. It just materializes bones by sticks of constant
(and small) thickness, so it gives you no information about root and tip, nor bone size or roll angle.

Note that Bone.001 roll angle is not visible (except by its XZ axes).
B-Bone bone
This visualization shows the curves of “smooth” multi-segmented bones; see the Bendy Bones for details.
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An armature of B-Bones, in Edit Mode.

The same armature in Object Mode.

Envelope bone
This visualization materializes the bone deformation influence. More on this in the bone page.

Wire bone
This simplest visualization shows the curves of “smooth” multi-segmented bones.

An armature of Wire, in Pose Mode.

The same armature in Edit Mode.

Draw Options
Names
When enabled, the name of each bone is drawn.
Colors
This is only relevant for Pose Mode, and is described in detail there.
Axes
When enabled, the (local) axes of each bone are drawn (only relevant for Edit Mode and Pose Mode).
X-Ray
When enabled, the bones of the armature will always be drawn on top of the solid objects (meshes,
surfaces, ...) – i.e. they will always be visible and selectable (this is the same option as the one found in
the Display panel of the Object data tab. Very useful when not in Wireframe mode.
Shapes
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When enabled, the default standard bone shape is replaced, in Object Mode and Pose Mode, by the shape
of a chosen object (see Shaped Bones for details).
Delay Refresh
When enabled, the bone does not deform its children when manipulating the bone in pose mode.

Bone Groups
Reference
Mode: Pose Mode
Panel: Armature tab ‣ Motion Paths panel
Menu: Pose ‣ Bone Groups ‣ ...

The Bone Groups panel.
This panel allows the creation, deletion and editing of Bone Groups. The panel Bone Groups is available in the
tab Armature of the Properties editor.
Bone Groups can be used for selection or to assign a color theme to a set of bones. In example to color the left
parts of the rig as blue and right parts as red.
Active Bone Group
The Bone Group List view.
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Color Set

The Bone Color Set selector and the color buttons.
You can assign a “color theme” to a group (each bone will have these colors). Remember you have to enable
the Colors checkbox (Display panel) to see these colors.
Bone Color Set
A select menu.
• Default Colors: The default (gray) colors.
• nn - Theme Color Set: One of the twenty Blender presets by the theme.
• Custom Set: A custom set of colors, which is specific to each group.

Normal
The first color button is the color of unselected bones.
Selected
The second color button is the outline color of selected bones.
Active
The third color button is the outline color of the active bone.

As soon as you alter one of the colors, it is switched to the Custom Set option.

Assign and Select
In the 3D Views, using the Pose ‣ Bone Groups menu entries you can:
Assign
Assigns the selected bones to the active bone group. It is important to note that a bone can only belong to
one group.
Remove
Removes the selected bones from the active bone group.
Select
Selects the bones in the active bone group.
Deselect
Deselects the bones in the active bone group.

See also
A single bone can be assign to a group in the Relations panel.
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See also
Bones belonging to multiple groups is possible with this add-on Selection Sets.

Pose Library Panel

The Pose Library panel.
The Pose Library panel is used to save, apply, and manage different armature poses. Pose Libraries are saved to
Actions. They are not generally used as actions, but can be converted to and from.
Action
A Data-Block Menu for Actions or Pose Libraries.
Pose Libraries
A List Views & Presets of poses for the active Pose Library.
Add +
If a pose is added a pose marker is created.
Add New
Adds a new pose to the active Pose Library with the current pose of the armature.
Add New (Current Frame).
Will add a pose to the Pose Library based on the current frame selected in the Time line. In
contrast to Add New and Replace Existing which automatically allocate a pose to an action
frame.
Replace Existing
Replace an existing pose in the active Pose Library with the current pose of the armature.
Apply Pose (magnifying glass icon)
Apply the active pose to the selected pose bones.
Sanitize Action (livesaver icon)
Makes a action suitable for use as a Pose Library. This is used to convert an Action to a Pose Library. A
pose is added to the Pose Library for each frame with keyframes.
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Ghost
Reference
Mode: Pose Mode
Panel: Armature tab ‣ Ghost panel

Ghosts examples.

In traditional cartoon creation animators use tracing paper, to see several frames preceding the one they are
working on. This allows them to visualize the overall movement of their character, without having to play it
back.
Blender features something very similar for armatures in Pose Mode: the “ghosts”. The ghosts are black
outlines (more or less opaque) of the bones as they are at certain frames.

Options

The Ghost panel.
The ghosts settings are found in the Armature tab, only active in Pose Mode.
Type
Around Current Frame
This will display a given number of ghosts before and after the current frame. The ghosts are shaded
from opaque at the current frame, to transparent at the most distant frames.
In Range
This will display the ghosts of the armature’s bones inside a given range of frames. The ghosts are
shaded from transparent for the first frame, to opaque at the last frame. It has four options:
On Keyframes
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This is very similar to the In Range option, but there are ghosts only for keyframes in the armature
animation (i.e. frames at which you keyed one or more of the bones). So it has the same options as
above, except for the Step one (as only keyframes generate ghosts). Oddly, the shading of ghosts is
reversed compared to In Range - from opaque for the first keyframe, to transparent for the last
keyframe.
Range
This number button specifies how many ghosts you will have on both “sides” (i.e. a value of 5 will give
you ten ghosts, five before the current frame, and five after).
Start, End
This number button specifies the start/end frame of the range (exclusive). Note that unfortunately, it
cannot take a null or negative value, which means you can only see ghosts starting from frame 2
included...
Step
This number button specifies whether you have a ghost for every frame (the default value of 1), or one
each two frames, each three frames, etc.

Display
Selected Only
When enabled, you will only see the ghosts of selected bones (otherwise, every bone in the armatures has
ghosts...)
Finally, these ghosts are also active when playing the animation Alt-A – this is only useful with the Around
Current Frame option, of course...
Note
There is no “global switch” to disable this display feature. To do so, you have to either set Ghost to 0 (for
Around Current Frame option), or the same frame number in both Start and End (for the two other ghosts
types).

Structure
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Example of a very basic armature.
Armatures mimic real skeletons. They are made out of bones, which are (by default) rigid elements. But you
have more possibilities than with real skeletons: In addition to the “natural” rotation of bones, you can also
translate and even scale them! And your bones do not have to be connected to each other; they can be
completely free if you want. However, the most natural and useful setups imply that some bones are related to
others, forming so-called “chains of bones”, which create some sort of “limbs” in your armature, as detailed in
Chains of Bones.

Chains of Bones
The bones inside an armature can be completely independent from each other (i.e. the modification of one bone
does not affect the others). But this is not often a useful set up: To create a leg, all bones “after” the thigh bone
should move “with” it in a well-coordinated manner. This is exactly what happens in armatures by parenting a
bone to the next one in the limb, you create a “chains of bones”. These chains can be ramified. For example,
five fingers attached to a single “hand” bone.

An armature with two chains of bones.
Bones are chained by linking the tip of the parent to the root of the child. Root and tip can be connected, i.e.
they are always exactly at the same point; or they can be free, like in a standard parent-child object relationship.
A given bone can be the parent of several children, and hence be part of several chains at the same time.
The bone at the beginning of a chain is called its root bone, and the last bone of a chain is the tip bone (do not
confuse them with similar names of bones’ joints!).
Chains of bones are a particularly important topic in posing (especially with the standard forward kinematics
versus “automatic” inverse kinematics posing techniques). You create/edit them in Edit Mode, but except in
case of connected bones, their relationships have no effect on bone transformations in this mode (i.e.
transforming a parent bone will not affect its children).
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The easiest way to manage bones relationships is to use the Relations panel in the Bone tab.

Skinning Introduction
We have seen in previous pages how to design an armature, create chains of bones, etc. Now, having a good rig
is not the final goal, unless you want to produce a “Dance Macabre” animation, you will likely want to put
some flesh on your skeletons! Surprisingly, “linking” an armature to the object(s) it should transform and/or
deform is called the “skinning” process...

The human mesh skinned on its armature.
In Blender, you have two main skinning types:
• You can Parent/Constrain Objects to Bones - then, when you transform the bones in Pose Mode, their
“children” objects are also transformed, exactly as with a standard parent/children relationship... The
“children” are never deformed when using this method.
• You can Using the Armature Modifier on entire Mesh, and then, some parts of this object to some bones
inside this armature. This is the more complex and powerful method, and the only way to really deform
the geometry of the object, i.e. to modify its vertices/control points relative positions.

Hint
Retargeting
Retargeting which is a way to apply motion-capture data (acquired from real world) to a rig is available
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through add-ons and importers.

Armature Deform Parent
In Blender Armature Object Types are usually used to associate certain bones of an Armature to certain parts of
a Mesh Object Types Mesh Geometry. You are then able to move the Armature Bones and the Mesh Object will
deform.

Bone associated with Mesh Object.
Armature Deform Parenting is one of the most flexible ways of associating Bones in an Armature to another
Object, it gives a lot of freedom but that comes at the price of a little complexity, as there are multiple steps
involved in setting up Armature Deform Parenting such that deformations are actually carried out.
Blender has several different ways of Parenting an Armature to an object, most of them can automate several of
the steps involved, but all of them ultimately do all the steps we describe for Armature Deform Parenting.
Using the Armature Deform Parenting operator is the first step in setting up the relationship between an
Armature Object and its Child Objects.
To use Armature Deform Parenting you must first select all the Child Objects that will be influenced by the
Armature and then lastly, select the Armature Object itself. Once all the Child Objects and the Armature Object
are selected and select Armature Deform in the Set Parent To pop-up menu.
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Set Parent To menu with Armature Deform Parenting option highlighted.
Once this is done the Armature Object will be the Parent Object of all the other Child Objects, also we have
informed Blender that the Bones of the Armature Object can be associated with specific parts of the Child
Objects so that they can be directly manipulated by the Bones.
At this point however, all Blender knows is that the Bones of the Armature could be used to alter the Child
Objects, we have not yet told Blender which Bones can alter which Child Objects or by how much.
To do that we must individually select each Child Object individually and toggle into Edit Mode on that Child
Object. Once in Edit Mode we can then select the vertices we want to be influenced by the Bones in the
Armature. Then with the vertices still selected navigate to Properties Editor ‣ Object Data ‣ Vertex Groups
and create a new Vertex Group with the same name as the Bone that you want the selected vertices to be
influenced by.
Once the Vertex Group has been created we then assign the selected vertices to the Vertex Group by clicking the
Assign Button. By default when selected vertices are assigned to a Vertex Group they will have an Influence
Weight of 1.0 This means that they are fully influenced when a Bone they are associated with is moved, if the
Influence Weight had been 0.5 then when the bone moves the vertices would only move half as much.
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Vertex groups panel with Assign Button and influence Weight Slider highlighted.
Once all these steps have been carried out, the Bones of the Armature Object should be associated with the
Vertex Groups with the same names as the Bones. You can then select the Armature Object and switch to Pose
Mode in the 3D View Editor Header ‣ Mode Select menu.

Armature Bone in Pose Mode affecting the Mesh Object.
The bone is highlighted in Cyan.
Once in Pose Mode transforming one of the Bones of the Armature that has been associated with vertices of an
object will result in those vertices also being transformed.
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Armature Deform Parent With Empty Groups
The Armature Deform With Empty Groups parenting method works in almost the same way as Armature
Deform parenting with one difference. That difference is that when you parent a Child Object to an Armature
Object the names of the bones in the armature are copied to the Child Objects in the form of newly created
Vertex Groups, one for each different deforming armature bone name. The newly created Vertex Groups will be
empty this means they will not have any vertices assigned to those Vertex Groups. You still must manually
select the vertices and assign them to a particular Vertex Group of your choosing to have bones in the armature
influence them.
For example, if you have an Armature Object which consists of three bones named “BoneA”, “BoneB” and
“BoneC” and Cube Mesh Object type called “Cube”. If you parent the Cube Child Object to the Armature
Parent Object the Cube will get three new Vertex Groups created on it called “BoneA”, “BoneB” and “BoneC”.
Notice that each Vertex Group is empty.

Cube in Edit Mode using Armature Deform with empty groups.
Bones in an Armature can be generally classified into two different types:
• Deforming Bones
• Control Bones
Deforming Bones
Are bones which when transformed will result in vertices associated with them also transforming in a
similar way. Deforming Bones are directly involved in altering the positions of vertices associated with
their bones.
Control Bones
Are Bones which act in a similar way to switches, in that, they control how other bones or objects react
when they are transformed. A Control Bone could for example act as a sliding switch control when the
bone is in one position to the left it could indicate to other bones that they react in a particular way when
transformed, when the Control Bone is positioned to the right, transforming other bones or objects could
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do something completely different. Control Bones are not directly used to alter the positions of vertices,
in fact, Control Bones often have no vertices directly associated with themselves.
When using the Armature Deform With Empty Groups parenting method Vertex Groups on the Child Object
will only be created for Armature Bones which are setup as Deforming Bone types. If a Bone is a Control Bone
no Vertex Group will be created on the Child Object for that bone.
To check whether a particular bone in an armature is a Deforming Bone simply switch to Pose or Edit Mode on
the armature and select the bone you are interested in by RMB it. Once the bone of interest is selected navigate
to Properties Editor ‣ Bone ‣ Deform Panel and check if the Deform tickable option is ticked or not. If it is
the selected bone is a Deforming Bone, otherwise, it is a Control Bone.

Three Bone Armature in Pose Mode with 1st bone selected.

Armature Deform With Automatic Weights
Armature Deform With Automatic Weights parenting feature does everything Armature Deform With Empty
Groups does with one extra thing. That extra thing is that unlike Armature Deform With Empty Groups which
leaves the automatically created Vertex Groups empty with no vertices assigned to them; Armature Deform
With Automatic Weight will try to calculate how much Influence Weight a particular Armature Bone would
have on a certain collection of vertices based on the distance from those vertices to a particular Armature Bone.
Once Blender has calculated the Influence Weight vertices should have it will assign that Influence Weight to
the Vertex Groups that were previously created automatically by Blender on the Child Object when Armature
Deform With Automatic Weights parenting command was carried out.
If all went well it should be possible to select the Armature Object switch it into Pose Mode and transform the
bones of the Armature and the Child Object should deform in response. Unlike Armature Deform parenting you
will not have to create Vertex Groups on the Child Object, neither will you have to assign Influences Weights to
those Vertex Groups, Blender will try to do it for you.
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To activate Armature Deform With Automatic Weights you must be in Object Mode or Pose Mode, then select
all the Child Objects (usually Mesh Object Types) and lastly select the Armature Object; Once done press and
select the Armature Deform With Automatic Weights from the Set Parent To pop-up menu.
This method of parenting is certainly easier setup but it can often lead to Armatures which do not deform Child
Objects in ways you would want as Blender can get a little confused when it comes to determining which
Bones should influence certain vertices when calculating Influence Weights for more complex armatures and
Child Objects. Symptoms of this confusion are that when transforming the Armature Object in Pose Mode parts
of the Child Objects do not deform as you expect; If Blender does not give you the results you require you will
have to manually alter the Influence Weights of vertices in relation to the Vertex Groups they belong to and
have influence in.

Armature Deform With Envelope Weights
Works in a similar way to Armature Deform With Automatic Weights in that it will create Vertex Groups on the
Child Objects that have names matching those of the Parent Object Armature Bones. The created Vertex Groups
will then be assigned Influence Weights. The major difference is in the way those Influence Weights are
calculated.
Influence Weights that are calculated when using Armature Deform With Envelope Weights parenting are
calculated entirely visually using Bone Envelopes.

Single Armature Bone in Edit Mode with Envelope Weight display enabled.
The gray volume around the bone is the Bone Envelope.
Fig. Single Armature Bone in Edit Mode with Envelope Weight display enabled. shows a single Armature Bone
in Edit Mode with Envelope Weight activated. The gray semi-transparent volume around the bone is the Bone
Envelope.
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Any Child Object that has vertices inside the volume of the Bone Envelope will be influenced by the Parent
Object Armature when the Armature Deform With Envelope Weights operator is used. Any vertices outside the
Bone Envelope volume will not be influenced. When the bones are transformed in Pose Mode the results are
very different.

Two sets of Armatures each with three bones.
The default size of the Bone Envelope volume does not extend very far from the surface of a bone; You can
alter the size of the Bone Envelope volume by clicking on the body of the bone you want to alter, switch to Edit
Mode or Pose Mode and then pressing Ctrl-Alt-S then drag your mouse left or right and the Bone
Envelope volume will alter accordingly.
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Single Armature Bone with various different Bone Envelope sizes.
Envelope distance fields highlighted.
You can also alter the Bone Envelope volume by selecting the Bone you wish to alter and switching to Edit
Mode or Pose Mode, then navigate to Properties Editor ‣ Bone ‣ Deform ‣ Envelope ‣ Distance then enter a
new value into it.
Altering the Bone Envelope volume does not alter the size of the Armature Bone just the range within which it
can influence vertices of Child Objects.
You can alter the radius that a bone has by selecting the head, body or tail parts of a bone while in Edit Mode,
and then press Alt-S and move the mouse left or right. This will make the selected bone fatter or thinner
without altering the thickness of the Bone Envelope volume.

Three Armature Bones all using Envelope Weight.
The 1st with a default radius value, the two others with differing Tail and Head radius values.
You can also alter the bone radius by selecting the tail or head of the bone you wish to alter and switching to
Edit Mode, then navigate to Properties Editor ‣ Bone ‣ Deform ‣ Radius Section and entering new values for
the Tail and Head fields.
Note
If you alter the Bone Envelope volume of a bone so that you can have it include/exclude certain vertices after
you have already used Armature Deform With Envelope Weights, by default, the newly included/excluded
vertices will not be affected by the change. When using Armature Deform With Envelope Weights it only
calculates which vertices will be affected by the Bone Envelope volume at the time of parenting, at which
point it creates the required named Vertex Groups and assigns vertices to them as required. If you want any
vertices to take account of the new Bone Envelope volume size you will have to carry out the Armature
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Deform With Envelope Weights parenting again; In fact, all parenting used in the Set Parent To pop-up menu
which tries to automatically assign vertices to Vertex Groups works like this.

Posing Introduction
Once your armature is skinned by the needed object(s), you can start to pose it. Basically, by transforming its
bones, you deform or transform the skin object(s). But you do not do that in Edit Mode – remember that in this
mode, you edit the default, base, “rest” position of your armature. You cannot use the Object Mode either, as
here you can only transform whole objects...
So, armatures in Blender have a third mode, Pose, dedicated to this process. It is a sort of “object mode for
bones”. In rest position (as edited in Edit Mode), each bone has its own position/rotation/scale to neutral values
(i.e. 0.0 for position and rotation, and 1.0 for scale). Hence, when you edit a bone in Pose Mode, you create an
offset in its transform properties, from its rest position – this is quite similar to meshes relative shape keys, in
fact.

Posing Section Overview
In this section, we will see:
•
•
•
•
•

How to select and edit bones in this mode.
How to use pose library.
How to use constraints to control your bones’ DoF (degrees of freedom).
How to use inverse kinematics features.
How to use the Spline inverse kinematics features.

Even though it might be used for completely static purposes, posing is heavily connected with animation
features and techniques.
In this part, we will try to focus on animation-independent posing, but this is not always possible. So if you
know nothing about animation in Blender, it might be a good idea to read the animation features and techniques
chapter first, and then come back here.

Visualization
Bone State Colors
The color of the bones are based on their state. There are six different color codes, ordered here by precedence
(i.e. the bone will be of the color of the bottommost valid state):
•
•
•
•

Gray: Default.
Blue wireframe: in Pose Mode.
Green: with Constraint.
Yellow: with IK Solver constraint.
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• Orange: with Targetless Solver constraint.

Note
When Bone Groups colors are enabled, the state colors will be overridden.

Selecting
Selection in Pose Mode is very similar to the one in Edit Mode, with a few specificities:
You can only select whole bones in Pose Mode, not roots/tips...

Grouped
You can select bones based on their group and/or layer, through the Select Grouped menu .

Editing

Pose Tools.
In Pose Mode, bones behave like objects. So the transform actions (grab/rotate/scale, etc.) are very similar to
the same ones in Object mode (all available ones are regrouped in the Pose ‣ Transform sub-menu). However,
there are some important specificities:
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• Bones’ relationships are crucial (see Parenting).
• The “transform center” of a given bone (i.e. its default pivot point, when it is the only selected one) is
its root. Note by the way that some pivot point options seem to not work properly, In fact, except for the
3D Cursor one, all others appear to always use the median point of the selection (and not e.g. the active
bone’s root when Active Object is selected, etc.).

Basic Posing
As previously noted, bones’ transformations are performed based on the Rest Position of the armature, which is
its state as defined in Edit Mode. This means that in rest position, in Pose Mode, each bone has a scale of 1.0,
and null rotation and position (as you can see it in the Transform panel, in the 3D Views, N).

An example of locally-Y-axis locked rotation, with two bones selected. Note that the two green lines
materializing the axes are centered on the armature’s center, and not each bone’s root...
Moreover, the local space for these actions is the bone’s own one (visible when you enable the Axes option of
the Armature panel). This is especially important when using axis locking, for example, there is no specific
“bone roll” tool in Pose Mode, as you can rotate around the bone’s main axis just by locking on the local Y axis
R-Y-Y... This also works with several bones selected; each one is locked to its own local axis!
When you pose your armature, you are supposed to have one or more objects skinned on it! And obviously,
when you transform a bone in Pose Mode, its related objects or object’s shape is moved/deformed accordingly,
in real time. Unfortunately, if you have a complex rig set-up and/or a heavy skin object, this might produce lag,
and make interactive editing very painful. If you experience such troubles, try enabling the Delay Deform
button of the Armature panel the skin objects will only be updated once you validate the transform operation.

Auto IK
Reference
Mode: Pose Mode
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Panel: Tool Shelf ‣ Options ‣ Pose Options

The auto IK option in the tool shelf enables a temporary IK constraint when posing bones. The chain acts from
the tip of the selected bone to root of the uppermost parent bone. Note that this mode lacks options, and only
works by applying the resulting transform to the bones in the chain.

Clear Transform
Reference
Mode: Pose Mode
Menu: Pose ‣ Clear Transform

Once you have transformed some bones, if you want to return to their rest position, just clear their
transformations.
Note that in Envelope visualization, Alt-S does not clear the scale, but rather scales the Distance influence
area of the selected bones (also available through the Pose ‣ Scale Envelope Distance menu entry, which is
only effective in Envelope visualization, even though it is always available...).

Apply
Reference
Mode: Pose Mode
Menu: Pose ‣ Apply

Conversely, you may define the current pose as the new rest position (i.e. “apply” current transformations to the
Edit Mode), using the Pose ‣ Apply Pose as Restpose menu entry. When you do so, the skinned
objects/geometry is also reset to its default, undeformed state, which generally means you will have to skin it
again.

In-Betweens
There are several tools for editing poses in an animation.

Push Pose
Reference
Mode: Pose Mode
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Panel: Tool Shelf ‣ Tool ‣ Tool ‣ Pose Tools ‣ In-Betweens: Push
Menu: Pose ‣ In-Betweens ‣ Push Pose
Push pose exaggerates the current pose.

Relax Pose
Reference
Mode: Pose Mode
Panel: Tool Shelf ‣ Tool ‣ Pose Tools ‣ In-Betweens: Relax
Menu: Pose ‣ In-Betweens ‣ Relax Pose

Relax pose is somewhat related to the above topic, but it is only useful with keyframed bones. When you edit
such a bone (and hence take it “away” from its “keyed position”), using this command will progressively “bring
it back” to its “keyed position”, with smaller and smaller steps as it comes near it.

Breakdowner
Reference
Mode: Pose Mode
Panel: Tool Shelf ‣ Tool ‣ Pose Tools ‣ In-Betweens: Breakdowner
Menu: Pose ‣ In-Betweens ‣ Pose Breakdowner
Creates a suitable breakdown pose on the current frame.
There are also in Pose Mode a bunch of armature-specific editing options/tools, like auto-bones naming,
properties switching/enabling/disabling, etc., that we already described in the armature editing pages. See the
links above...

Copy/Paste Pose
Reference
Mode: Pose Mode

Panel: Tool Shelf ‣ Tool ‣ Pose Tools ‣ Pose: Copy, Paste
Menu: Pose ‣ Copy Current Pose , Pose ‣ Paste Pose , Pose ‣ Paste X-Flipped Pose
Blender allows you to copy and paste a pose, either through the Pose menu, or directly using the three
“copy/paste” buttons found at the right part of the 3D Views header:
Copy Current Pose
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To copy the current pose of selected bones into the pose buffer.
Paste Pose
Paste the buffered pose to the currently posed armature.
Paste X-Flipped Pose
Paste the X axis mirrored buffered pose to the currently posed armature.
Here are important points:
• This tool works at the Blender session level, which means you can use it across armatures, scenes, and
even files. However, the pose buffer is not saved, so you lose it when you close Blender.
• There is only one pose buffer.
• Only the selected bones are taken into account during copying (i.e. you copy only selected bones’ pose).
• During pasting, on the other hand, bone selection has no importance. The copied pose is applied on a
per-name basis (i.e. if you had a forearm bone selected when you copied the pose, the forearm bone
of the current posed armature will get its pose when you paste it – and if there is no such named bone,
nothing will happen...).
• What is copied and pasted is in fact the position/rotation/scale of each bone, in its own space. This
means that the resulting pasted pose might be very different from the originally copied one, depending
on: - The rest position of the bones, and - The current pose of their parents.

The rest position of our
original armature.

The rest position of our
destination armature.
Examples of pose copy/paste.
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The first copied pose (note
that only two bones are
selected and hence copied).

...pasted on the destination
armature...

...and mirror-pasted on the
destination armature.

The same pose as above is
...pasted on the destination
copied, but this time with all armature...
bones selected, ...

...and mirror-pasted on the
destination armature.

Propagate
Reference
Mode: Pose Mode
Panel: Tool Shelf ‣ Tool ‣ Pose Tools ‣ Pose: Propagate
Menu: Pose ‣ Propagate
The Propagate tool copies the pose of the selected bones on the current frame over to the keyframes delimited
by the Termination Mode. It automates the process of copying and pasting.
ToDo.
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Options
Termination Mode
Modes which determine how it decides when to stop overwriting keyframes.
While Held
The most complicated of the modes available, as it tries to guess when to stop propagating by
examining the pauses in the animation curves per control (i.e. all F-Curves for a bone, instead of per
F-Curve).
To Next Keyframe
Simply copies the pose to the first keyframe after (but not including any keyframe on) the current
frame.
To Last Keyframe
Will simply replace the last keyframe. (i.e. making action cyclic).
Before Frame
To all keyframes between current frame and the End frame option. This option is best suited for use
from scripts due to the difficulties in setting this frame value, though it is possible to set this
manually via the Operator panel if necessary.
Before Last Keyframe
To all keyframes from current frame until no more are found.
On Selected Keyframes
Will apply the pose of the selected bones to all selected keyframes.
On Selected Markers
To all keyframes occurring on frames with Scene Markers after the current frame.
End Frame
Defines the upper-bound for the frame range within which keyframes will be affected (with the lower
bound being the current frame).

Show/Hide
Reference
Mode: All Modes
Panel: Properties editor ‣ Bone ‣ Display
Menu: ... ‣ Show/Hide

You can also use the Hide checkbox of the Bone tab ‣ Display panel .
Note that hidden bones are specific to a mode, i.e. you can hide some bones in Edit Mode, they will still be
visible in Pose Mode, and vice-versa. Hidden bone in Pose Mode are also invisible in Object Mode. And in Edit
Mode, the bone to hide must be fully selected, not just his root or tip.

Bone Constraints Introduction
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The Constraints panel in Pose Mode, with one Limit Rotation constraint applied to the active bone.
As bones behave like objects in Pose Mode, they can also be constrained. This is why the Constraints tab is
shown in both Object Mode and Edit Mode. This panel contains the constraints of the active bone (its name is
displayed at the top of the panel, in the To Bone:... static text field).
Constraining bones can be used to control their degree of freedom in their pose transformations, using e.g. the
Limit constraints. You can also use constraints to make a bone track another object/bone (inside the same object,
or in another armature), etc. And the inverse kinematics feature is also mainly available through the IK Solver
constraint, which is specific to bones.
For example, a human elbow cannot rotate backward (unless the character has broken his hand), nor to the
sides, and its forward and roll rotations are limited in a given range (for example, depending on the rest position
of your elbow, it may be from (0 to 160) or from (-45 to 135).
So you should apply a Limit Rotation constraint to the forearm bone (as the elbow movement is the result of
rotating the forearm bone around its root).
Using bones in constraints, either as owners or as targets, is discussed in detail in the constraints pages.

IK Introduction
IK simplifies the animation process, and makes it possible to make more advanced animations with lesser
effort.
IK allows you to position the last bone in a bone chain and the other bones are positioned automatically. This is
like how moving someone’s finger would cause his arm to follow it. By normal posing techniques, you would
have to start from the root bone, and set bones sequentially till you reach the tip bone: When each parent bone
is moved, its child bone would inherit its location and rotation. Thus making tiny precise changes in poses
becomes harder farther down the chain, as you may have to adjust all the parent bones first.
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This effort is effectively avoided by use of IK.

Automatic IK
Automatic IK is a tool for quick posing, it can be enabled in the tool shelf in the 3D View, when in pose mode.
When the Auto IK option is enabled, translating a bone will activate inverse kinematics and rotate the parent
bone, and the parent’s parent, and so on, to follow the selected bone. The IK chain can only extend from a child
to a parent bone if the child is connected to it.
The length of the chain is increased (if there is a connected parent available to add to it) with Ctrl-PageUp
or Ctrl-WheelDown, and decreased with Ctrl-PageDown or Ctrl-WheelUp. However, the initial
chain length is 0, which effectively means follow the connections to parent bones as far as possible, with no
length limit. So pressing Ctrl-PageUp the first time sets the chain length to 1 (move only the selected bone),
and pressing Ctrl-PageDown at this point sets it back to 0 (unlimited) again. Thus, you have to press CtrlPageUp more than once from the initial state to set a finite chain length greater than 1.
This is a more limited feature than using an IK constraint, which can be configured, but it can be useful for
quick posing.

IK Constraints
IK is mostly done with bone constraints. They work by the same method but offer more choices and settings.
Please refer to these pages for detail about the settings for the constraints:
• IK Solver
• Spline IK

Armature IK Panel
This panel is used to select the IK Solver type for the armature. Standard or iTaSC.

Properties ‣ Armature ‣ Inverse Kinematics Panel
Most the time people will use the Standard IK solver. There is some documentation for the iTaSC
“instantaneous Task Specification using Constraints” IK solver here.
See also
Robot IK Solver.
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Bone IK Panel
This panel is used to control how the Pose Bones work in the IK chain.

Properties ‣ Bone ‣ Inverse Kinematics Panel
Lock
Disallow movement around the axis.
Stiffness
Stiffness around the axis. Influence disabled if using Lock.
Limit
Limit movement around the axis.
Stretch
Stretch influence to IK target.

Arm Rig Example
This arm uses two bones to overcome the twist problem for the forearm. IK locking is used to stop the forearm
from bending, but the forearm can still be twisted manually by pressing R-Y-Y in Pose Mode, or by using
other constraints.

IK Arm Example..
Note that, if a Pole Target is used, IK locking will not work on the root boot.
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Spline IK
Spline IK is a constraint which aligns a chain of bones along a curve. By leveraging the ease and flexibility of
achieving aesthetically pleasing shapes offered by curves and the predictability and well integrated control
offered by bones, Spline IK is an invaluable tool in the riggers’ toolbox. It is particularly well suited for rigging
flexible body parts such as tails, tentacles, and spines, as well as inorganic items such as ropes.
Full description of the settings for the spline IK are detailed on the Spline IK page.

Basic Setup
The Spline IK Constraint is not strictly an ‘Inverse Kinematics’ method (i.e. IK Constraint), but rather a
‘Forward Kinematics’ method (i.e. normal bone posing). However, it still shares some characteristics of the IK
Constraint, such as operating on multiple bones not being usable for Objects, and being evaluated after all other
constraints have been evaluated. It should be noted that if a Standard IK chain and a Spline IK chain both affect
a bone at the same time the Standard IK chain takes priority. Such setups are best avoided though, since the
results may be difficult to control.
To setup Spline IK, it is necessary to have a chain of connected bones and a curve to constrain these bones to:
• With the last bone in the chain selected, add a Spline IK Constraint from the Bone Constraints tab in the
Properties Editor.
• Set the ‘Chain Length’ setting to the number of bones in the chain (starting from and including the
selected bone) that should be influenced by the curve.
• Finally, set the ‘Target’ field to the curve that should control the curve.
Congratulations, the bone chain is now controlled by the curve.

Settings and Controls
Roll Control
To control the ‘twist’ or ‘roll’ of the Spline IK chain, the standard methods of rotating the bones in the chain
along their y-axes still apply. For example, simply rotate the bones in the chain around their y-axes to adjust the
roll of the chain from that point onwards. Applying copy rotation constraints on the bones should also work.

Offset Controls
The entire bone chain can be made to follow the shape of the curve while still being able to be placed at an
arbitrary point in 3D-space when the ‘Chain Offset’ option is enabled. By default, this option is not enabled,
and the bones will be made to follow the curve in its untransformed position.

Thickness Controls
The thickness of the bones in the chain is controlled using the constraint’s ‘XZ Scale Mode’ setting. This setting
determines the method used for determining the scaling on the X and Z axes of each bone in the chain.
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The available modes are:
None
this option keeps the X and Z scaling factors as 1.0.
Volume Preserve
the X and Z scaling factors are taken as the inverse of the Y scaling factor (length of the bone),
maintaining the ‘volume’ of the bone
Bone Original
this options just uses the X and Z scaling factors the bone would have after being evaluated in the
standard way.
In addition to these modes, there is an option, Use Curve Radius. When this option is enabled, the average
radius of the radii of the points on the curve where the joints of each bone are placed, are used to derive X and
Z scaling factors. This allows the scaling effects, determined using the modes above, to be tweaked as
necessary for artistic control.

Tips for Nice Setups
• For optimal deformations, it is recommended that the bones are roughly the same length, and that they
are not too long, to facilitate a better fit to the curve. Also, bones should ideally be created in a way that
follows the shape of the curve in its ‘rest pose’ shape, to minimize the problems in areas where the curve
has sharp bends which may be especially noticeable when stretching is disabled.
• For control of the curve, it is recommended that hooks (in particular, Bone Hooks) are used to control
the control-vertices of the curve, with one hook per control-vertex. In general, only a few controlvertices should be needed for the curve (e.g one for every 3-5 bones offers decent control).
• The type of curve used does not really matter, as long as a path can be extracted from it that could also
be used by the Follow Path Constraint. This really depends on the level of control required from the
hooks.
• When setting up the rigs, it is currently necessary to have the control bones (for controlling the curve) in
a separate armature to those used for deforming the meshes (i.e. the deform rig containing the Spline IK
chains). This is to avoid creating pseudo “Dependency Cycles”, since Blender’s Dependency Graph can
only resolve the dependencies the control bones, curves, and Spline IK’ed bones on an object by object
basis.
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Posing
Once your armature is skinned by the needed object(s), you can start to pose it. Basically, by transforming its
bones, you deform or transform the skin object(s). But you don’t do that in Edit mode - remember that in this
mode, you edit the default, base, “rest” position of your armature. You can’t use the Object mode either, as
here you can only transform whole objects...
So, armatures in Bforartists have a third mode, Pose, dedicated to this process. It’s a sort of “object mode for
bones”. In rest position (as edited in Edit mode), each bone has its own position/rotation/scale to neutral values
(i.e. 0.0 for position and rotation, and 1.0 for scale). Hence, when you edit a bone in Pose mode, you create
an offset in its transform properties, from its rest position - this is quite similar to meshes relative shape keys, in
fact.
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Posing Section Overview
In this section, we will see:
•
•
•
•
•
•

The visualization features specific to Pose mode.
How to select and edit bones in this mode.
How to use pose library.
How to use constraints to control your bones’ DoF (degrees of freedom).
How to use inverse kinematics features.
How to use the Spline inverse kinematics features.

Even though it might be used for completely static purposes, posing is heavily connected with animation
features and techniques.
In this part, we will try to focus on animation-independent posing, but this isn’t always possible. So if you
know nothing about animation in Bforartists, it might be a good idea to read the animation features and
techniques chapter first, and then come back here.

Applying Constraints to Bones

The Constraints panel in Pose mode, with one Floor constraint applied to the active bone (Bone.001).

As bones behave like objects in Pose mode, they can also be constrained. This is why the Constraints panel is
shown in both Object and Editing contexts in this mode... This panel contains the constraints of the active bone
(its name is displayed at the top of the panel, in the To Bone:... static text field).
Constraining bones can be used to control their degree of freedom in their pose transformations, using e.g. the
Limit constraints. You can also use constraints to make a bone track another object/bone (inside the same object,
or in another armature), etc. And the inverse kinematics feature is also mainly available through the IK Solver
constraint - which is specific to bones.
For example, a human elbow can’t rotate backward (unless the character has broken his hand), nor to the sides,
and its forward and roll rotations are limited in a given range (for example, depending on the rest position of
your elbow, it may be from 0 to 160, OR from -45 to 135).
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So you should apply a Limit Rotation constraint to the forearm bone (as the elbow movement is the result of
rotating the forearm bone around its root).
Using bones in constraints, either as owners or as targets, is discussed in detail in the constraints pages.

Editing Poses

Pose Tools

In Pose mode, bones behave like objects. So the transform actions (grab/rotate/scale, etc.) are very similar to
the same ones in Object mode (all available ones are regrouped in the Pose ‣ Transform sub-menu). However,
there are some important specificities:
• Bones’ relationships are crucial (see Effects of Bones Relationships).
• The “transform center” of a given bone (i.e. its default pivot point, when it is the only selected one) is
its root. Note by the way that some pivot point options seem to not work properly - in fact, except for
the 3D Cursor one, all others appear to always use the median point of the selection (and not e.g. the
active bone’s root when Active Object is selected, etc.).

Selecting Bones
Selection in Pose mode is very similar to the one in Edit mode, with a few specificities:
• You can only select whole bones in Pose mode, not roots/tips...
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The Select Grouped pop-up menu.

• You can select bones based on their group and/or layer, through the Select Grouped pop-up menu
• To select all bones belonging to the same group(s) as the selected ones, use the In Same Group
entry
• To select all bones belonging to the same layer(s) as the selected ones, use the In Same Layer
entry

Basic Posing
As previously noted, bones’ transformations are performed based on the rest position of the armature, which is
its state as defined in Edit mode. This means that in rest position, in Pose mode, each bone has a scale of 1.0,
and null rotation and position (as you can see it in the Transform Properties panel, in the 3D views).

An example of locally-Y-axis locked rotation, with two bones selected. Note that the two green lines materializing the axes
are centered on the armature’s center, and not each bone’s root...

Moreover, the local space for these actions is the bone’s own one (visible when you enable the Axes option of
the Armature panel). This is especially important when using axis locking - for example, there is no specific
“bone roll” tool in Pose mode, as you can rotate around the bone’s main axis just by locking on the local Y
axis ... This also works with several bones selected; each one is locked to its own local axis!
When you pose your armature, you are supposed to have one or more objects skinned on it! And obviously,
when you transform a bone in Pose mode, its related objects or object’s shape is moved/deformed accordingly,
in real time. Unfortunately, if you have a complex rig set-up and/or a heavy skin object, this might produce lag,
and make interactive editing very painful. If you experience such troubles, try enabling the Delay Deform
button of the Armature panel - the skin objects will only be updated once you validate the transform operation.

Auto IK
The auto IK option in the tool shelf enables a temporary ik constraint when posing bones. The chain acts from
the tip of the selected bone to root of the uppermost parent bone. Note that this mode lacks options, and only
works by applying the resulting transform to the bones in the chain.
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Rest Pose
Once you have transformed some bones, if you want to return to their rest position, just clear their
transformations
Note that in Envelope visualization, Alt-S does not clear the scale, but rather scales the Distance influence
area of the selected bones (also available through the Pose ‣ Scale Envelope Distance menu entry - only
effective in Envelope visualization, even though it is always available...).
Conversely, you may define the current pose as the new rest position (i.e. “apply” current transformations to the
Edit mode), using the Pose ‣ Apply Pose as Restpose menu entry When you do so, the skinned
objects/geometry is also reset to its default, undeformed state, which generally means you’ll have to skin it
again.
Whereas in Edit mode, you always see your armature in its rest position, in Object and Pose ones, you see it by
default in its pose position (i.e. as it was transformed in the Pose mode). If you want to see it in the rest position
in all modes, enable the Rest Position button in the Armature panel (Editing context).

In-Betweens
There are several tools for editing poses in an animation.
Relax Pose
Relax pose is somewhat related to the above topic - but it is only useful with keyframed bones (see the
animation chapter). When you edit such a bone (and hence take it “away” from its “keyed position”),
using this command will progressively “bring it back” to its “keyed position”, with smaller and smaller
steps as it comes near it.
Push Pose
Push pose exaggerates the current pose.
Breakdowner
Creates a suitable breakdown pose on the current frame
There are also in Pose mode a bunch of armature-specific editing options/tools, like auto-bones naming,
properties switching/enabling/disabling, etc., that we already described in the armature editing pages - follow
the links above...

Copy/Paste Pose
Reference
Mode: Pose mode
Panel: 3D View header
Menu: Pose ‣ Copy Current Pose, Pose ‣ Paste Pose, Pose ‣ Paste Flipped Pose
Copy and paste pose buttons in the 3D View header in Pose mode.

Bforartists allows you to copy and paste a pose, either through the Pose menu, or directly using the three
“copy/paste” buttons found at the right part of the 3D views header:
Pose ‣ Copy Current Pose
to copy the current pose of selected bones into the pose buffer.
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Pose ‣ Paste Pose
paste the buffered pose to the currently posed armature.
Pose ‣ Paste Flipped Pose
paste the X axis mirrored buffered pose to the currently posed armature.
Here are important points:
• This tool works at the Bforartists session level, which means you can use it across armatures, scenes,
and even files. However, the pose buffer is not saved, so you lose it when you close Bforartists.
• There is only one pose buffer.
• Only the selected bones are taken into account during copying (i.e. you copy only selected bones’ pose).
• During pasting, on the other hand, bone selection has no importance. The copied pose is applied on a
per-name basis (i.e. if you had a forearm bone selected when you copied the pose, the forearm bone
of the current posed armature will get its pose when you paste it - and if there is no such named bone,
nothing will happen...).
• What is copied and pasted is in fact the position/rotation/scale of each bone, in its own space. This
means that the resulting pasted pose might be very different from the originally copied one, depending
on: - The rest position of the bones, and - The current pose of their parents.
Examples of pose copy/paste.

The rest position of our destination
armature.
The rest position of our original
armature.

...and mirror-pasted on the destination
armature.
The first copied pose (note that only
forearm and finger2_a are selected and
hence copied).

...pasted on the destination armature...

6

Bforartists Reference Manual - © Copyright - This page is under OCL license

...and mirror-pasted on the destination
armature.

The same pose as above is copied, but
this time with all bones selected, ...

...pasted on the destination armature...

Effects of Bones Relationships
Bones relationships are crucial in Pose mode - they have important effects on transformations behavior.
By default, children bones inherit:
• Their parent position, with their own offset of course.
• Their parent rotation (i.e. they keep a constant rotation relatively to their parent).
• Their parent scale, here again with their own offset.
Examples of transforming parented/connected bones.

The armature in its rest position.

Rotation of a root bone.

Scaling of a root bone.

Exactly like standard children objects. You can modify this behavior on a per-bone basis, using their sub-panels
in the Armature Bones panel:

The Armature Bones panel in Pose mode.

Inherit Rotation
When disabled, this will “break” the rotation relationship to the bone’s parent. This means that the child
will keep its rotation in the armature object space when its parent is rotated.
Inherit Scale
When disabled, this will “break” the scale relationship to the bone’s parent.
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These inheriting behaviors propagate along the bones’ hierarchy. So when you scale down a bone, all its
descendants are by default scaled down accordingly. However, if you set one bone’s Inherit Scale or Inherit
Rotation property on in this “family”, this will break the scaling propagation, i.e. this bone and all its
descendants will no longer be affected when you scale one of its ancestors.
Examples of transforming parented/connected bones with** Inherit Rotation disabled.

The yellow outlined Inherit Rotation

Rotation of a bone with a Inherit

Scaling of a bone with a Inherit Rotation

disabled bone in the armature.

Rotation disabled bone among its

disabled bone among its descendants.

descendants.

Connected bones have another specificity: they cannot be translated. Indeed, as their root must be at their
parent’s tip, if you don’t move the parent, you cannot move the child’s root, but only its tip - which leads us to a
child rotation. This is exactly what happens - when you press G with a connected bone selected, Bforartists
automatically switches to rotation operation.
Bones relationships also have important consequences on how selections of multiple bones behave when
transformed. There are many different situations, so I’m not sure I list all possible ones below - but this should
anyway give you a good idea of the problem:
• Non-related selected bones are transformed independently, as usual.

Scaling bones, some of them related.

• When several bones of the same “family” are selected, only the “most parent” ones are really
transformed - the descendants are just handled through the parent relationship process, as if they were
not selected (see Scaling bones, some of them related - the third tip bone, outlined in yellow, was only
scaled down through the parent relationship, exactly as the unselected ones, even though it is selected
and active. Otherwise, it should have been twice smaller!).
• When connected and unconnected bones are selected, and you start a grab operation, only the
unconnected bones are affected.
• When a child connected hinge bone is in the selection, and the “most parent” selected one is connected,
when you press G, nothing happens - Bforartists remains in grab operation, which of course has no effect
on a connected bone. This might be a bug, in fact, as I see no reason for this behavior...
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So, when posing a chain of bones, you should always edit its elements from the root bone to the tip bone. This
process is known as forward kinematics, or FK. We will see in a later page that Bforartists features another
pose method, called inverse kinematics, or IK, which allows you to pose a whole chain just by moving its tip.
Note that this feature is somewhat extended/completed by the pose library tool.

Inverse Kinematics
Inverse Kinematics is used to animate a chain of bones of a bones system in reverse order. Forward kinematics
means that you adjust the skeleton joint by joint. And by doing so all the bones AFTER the current joint gets
affected by manipulation. Means, you rotate the shoulder, and the elbow down to hand and fingers follows this
movement.
Inverse kinematics does the opposite. It affects the bones BEFORE the current joint. Up to the lock point.
Means you pull at the tip of a finger for example. And the arm follows.
IK simplifies the animation process, and makes it possible to make more advanced animations with lesser
effort.
IK allows you to position the last bone in a bone chain and the other bones are positioned automatically. This is
like how moving someone’s finger would cause his arm to follow it. By normal posing techniques, you would
have to start from the root bone, and set bones sequentially till you reach the tip bone: When each parent bone
is moved, its child bone would inherit its location and rotation. Thus making tiny precise changes in poses
becomes harder farther down the chain, as you may have to adjust all the parent bones first.
This effort is effectively avoided by use of IK.

Automatic IK
Automatic IK is a tool for quick posing, it can be enabled in the tool shelf in the 3D view, when in pose mode.
When the Auto IK option is enabled, translating a bone will activate inverse kinematics and rotate the parent
bone, and the parent’s parent, and so on, to follow the selected bone. The IK chain can only extend from a child
to a parent bone if the child is connected to it.
The length of the chain is increased (if there is a connected parent available to add to it) with Ctrl-PageUp
or Ctrl-WheelDown, and decreased with Ctrl-PageDown or Ctrl-WheelUp. However, the initial
chain length is 0, which effectively means follow the connections to parent bones as far as possible, with no
length limit. So pressing Ctrl-PageUp the first time sets the chain length to 1 (move only the selected bone),
and pressing Ctrl-PageDown at this point sets it back to 0 (unlimited) again. Thus, you have to press CtrlPageUp more than once from the initial state to set a finite chain length greater than 1.
This is a more limited feature than using an IK constraint, which can be configured, but it can be useful for
quick posing.

IK Contraints
IK is mostly done with bone constraints. They work by the same method but offer more choices and settings.
Please refer to these pages for detail about the settings for the contraints:
9
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• IK Solver
• Spline IK

Armature IK Panel
This panel is used to select the IK Solver type for the armature. Standard or iTaSC.

Properties > Armature > Inverse Kinematics Panel.

Most the time people will use the Standard IK solver. There is some documentation for the iTaSC
“instantaneous Task Specification using Constraints” IK solver here.
Robot IK Solver

Bone IK Panel
This panel is used to control how the Pose Bones work in the IK chain.

Properties > Bone > Inverse Kinematics Panel.

Lock
Disallow movement around the axis.
Stiffness
Stiffness around the axis. Influence disabled if using Lock.
Limit
Limit movement around the axis.
Stretch
Stretch influence to IK target. 0.000 is the same as disabled.

10
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Arm Rig Example
This arm uses two bones to overcome the twist problem for the forearm. IK locking is used to stop the forearm
from bending, but the forearm can still be twisted manually by using other constraints.

IK Arm Example.

IK Arm Example.
Note that, if a Pole Target is used, IK locking will not work on the root boot.

Pose Library
Introduction
The Pose Library panel is used to save, apply, and manage different armature poses.
Pose Libraries are saved to Actions. They are not generally used as actions, but can be converted to and from.

Pose Library Panel

Properties > Armature > Pose Library.

1. Browse Action / Pose Library to be linked.
2. Name of the Pose Library.
11
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3. Set Fake User. This will make Bforartists save the Pose Library for if it has no users.
4. Add new Pose Library to the active object.
5. Remove the Pose Library from the active object.
6. A list of Poses for the active Pose Library.
7. Add Pose.
Add New.
Add a new Pose to the active Pose Library with the currect pose of the armature.
Add New (Current Frame).
Add New and Replace Existing automatically allocate a Pose to an Action frame. Add New
(Currect Frame) will add a Pose to the Pose Library based on the current frame of the Time
Cursor. Its not a well supported feature.
Replace Existing.
Replace an existing Pose in the active Pose Library with the currect pose of the armature.
8. Remove the active Pose from the Pose Library.
9. Apply the active Pose to the selected Pose Bones.
10.Sanitize Action. Make Action suitable for use as a Pose Library. This is used to convert an Action to a
Pose Library. A Pose is added to the Pose Library for each frame with keyframes.

Visualization
We talk in this page about the armature visualization options available in all modes (the visualization types, the
bones’ shapes, etc.).
In Pose mode, you have extra features, Colors to help you visually categorize your bones, Ghosts and Motion
Paths to help you visualize armatures’ animations.

Colors
In Pose mode, the bones can have different colors, following two different processes, controlled by the Color
button (Armature panel, Editing context):
• When it is disabled, bones are colored based on their “state” (i.e. if they use constraints, if they are
posed, etc.).
• When it is enabled, bones are colored depending on which bone group they belong to (or as above if
they belong to no group).
You can also mix both coloring methods, see Coloring from Bone Group below ).

12
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Coloring from Bone State
This is the default and oldest way - there are six different color codes, ordered here by precedence (i.e. the bone
will be of the color of the topmost valid state):
•
•
•
•
•

Orange: A bone with a targetless Solver constraint.
Yellow: A bone with an IK Solver constraint.
Green: A bone with any other kind of constraint.
Blue: A bone that is posed (i.e. has keyframes).
Gray: Default state.

Coloring from Bone Group

The Bone Groups panel with a bone group (default colors).

The bone groups panel is available in the Object data editor for an armature. Bone groups facilitate the coloring
(theming) of multiple bones. Bone groups are managed mostly in the Buttons window, Editing context.
To create a new bone group, click on the Add Group button in the Bone Groups: buttons set (Link and
Materials panel). Once created, you can use the top row of controls to select another group in the drop-down
list (“arrows” button), rename the current group (text field), or delete it

The Bone Group drop-down list of a bone sub-panel.

To assign a selected bone to a given bone group you can do one of the following:
13
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• In the Bone Groups, select an existing group, and click Assign
• In the Relations section of the Bones panel), use the Bone Group drop-down list to select the chosen
one.
In the 3D views, using the Pose ‣ Bone Groups menu entries, and/or the Bone Groups pop-up menu you can:
Assign to New Group
Assigns selected bones to a new bone group
Assign to Group
Assigns selected bones to the selected Bone Groups
Remove Selected from Bone Groups
Removes selected bones from all bone groups
Remove Bone Group
Removes the active bone group

The Bone Color Set list of the bone group, and the color swatch of the chosen color theme.

You can also assign a “color theme” to a group (each bone will have these colors). Remember you have to
enable the Colors button (Armature panel) to see these colors. Use the Bone Color Set drop-down list to select:
• The default (gray) colors (Default Colors).
• One of the twenty Bforartists presets (nn - Theme Color Set), common to all groups.
• A custom set of colors (Custom Set), which is specific to each group.
Below this list, you have three color swatches and a button.
• The first swatch is the color of unselected bones.
• The second swatch is the outline color of selected bones.
• The third swatch is the outline color of the active bone.
As soon as you click on a swatch (to change the color, through the standard color editing dialog), you are
automatically switched to the Custom Set option.
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Ghosts
Reference
Mode: Pose mode
Panel: Visualisations

Ghosts examples.

If you are a bit familiar with traditional cartoon creation, you might know that drawing artists use tracing paper
heavily, to see several frames preceding the one they are working on. This allows them to visualize the overall
movement of their character, without having to play it back... Well, Bforartists features something very similar
for armatures in Pose mode: the “ghosts”.

The Ghost panel showing the different options associated with different modes.

The ghosts are simply black drawings (more or less opaque) of the bones’ outlines as they are at certain frames.
The ghosts settings are found in the Visualisations panel (Editing context), only available in Pose mode. You
have three different types of ghosts, sharing more or less the same options:
Around Current Frame
15
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This will display a given number of ghosts before and after the current frame. The ghosts are shaded from
opaque at the current frame, to transparent at the most distant frames. It has three options:
Range
This numeric field specifies how many ghosts you’ll have on both “sides” (i.e. a value of 5 will give
you ten ghosts, five before the current frame, and five after).
Step
This numeric field specifies whether you have a ghost for every frame (the default 1 value), or one
each two frames, each three frames, etc.
Selected Only
When enabled, you will only see the ghosts of selected bones (otherwise, every bone in the
armatures has ghosts...)
In Range
This will display the ghosts of the armature’s bones inside a given range of frames. The ghosts are shaded
from transparent for the first frame, to opaque at the last frame. It has four options:
Start
This numeric field specifies the starting frame of the range (exclusive). Note that unfortunately, it
cannot take a null or negative value - which means you can only see ghosts starting from frame 2
included...
End
This numeric field specifies the ending frame of the range, and cannot take a value below GSta one.
Step
Same as above.
On Keyframes
This is very similar to the In Range option, but there are ghosts only for keyframes in the armature
animation (i.e. frames at which you keyed one or more of the bones). So it has the same options as above,
except for the GStep one (as only keyframes generate ghosts). Oddly, the shading of ghosts is reversed
compared to In Range - from opaque for the first keyframe, to transparent for the last keyframe.
Finally, these ghosts are also active when playing the animation (Alt-A) - this is only useful with the Around
Current Frame option, of course...
Note also that there is no “global switch” to disable this display feature - to do so, you have to either set Ghost
to 0 (for Around Current Frame option), or the same frame number in both GSta and GEnd (for the two other
ghosts types).

Motion Paths
Reference
Mode: Pose mode
Panel: Visualisations
Menu: Pose ‣ Motion Paths ‣ ...
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A motion paths example.

This feature allows you to visualize as curves the paths of bones’ ends (either their tips, by default, or their
roots).
Before we look at its options (all regrouped in the same Visualisations panel, in the Editing context), let’s first
see how to display/hide these paths. Unlike Ghosts, you have to do it manually - and you have to first select the
bones you want to show/hide the motion paths. Then,
• To show the paths (or update them, if needed), click on the Calculate Path button of the Visualisations
panel, or, in the 3D views, select the Pose ‣ Motion Paths ‣ Calculate Paths menu entry
• To hide the paths, click on the Clear Paths button, or, in the 3D views, do Pose ‣ Motion Paths ‣
Clear All Paths
Remember: only selected bones and their paths are affected by these actions!
The paths are drawn in a light shade of gray for unselected bones, and a slightly blueish gray for selected ones.
Each frame is materialized by a small white dot on the paths.
As with ghosts, the paths are automatically updated when you edit your poses/keyframes, and they are also
active during animation playback

17

Bforartists Reference Manual - © Copyright - This page is under OCL license

The Motion Paths Panel showing options for the different modes

And now, the paths options:
Around Frame
Around Frame, Display Paths of poses within a fixed number of frames around the current frame. When
you enable this button, you get paths for a given number of frames before and after the current one (again,
as with ghosts).
In Range
In Range, Display Paths of poses within specified range.
Display Range
Before/After
Number of frames to show before and after the current frame (only for ‘Around Current Frame’
Onion-skinning method)
Start/End
Starting and Ending frame of range of paths to display/calculate (not for ‘Around Current Frame’
Onion-skinning method)
Step
This is the same as the GStep for ghosts - it allows you to only display on the path one frame for
each n ones. Mostly useful when you enable the frame number display (see below), to avoid
cluttering the 3D views.
Frame Numbers
When enabled, a small number appears next to each frame dot on the path, which is of course the number
of the corresponding frame.
Keyframes
When enabled, big yellow square dots are drawn on motion paths, materializing the keyframes of their
bones (i.e. only the paths of keyed bones at a given frame get a yellow dot at this frame).
Keyframe Nums
When enabled, you’ll see the numbers of the displayed keyframes - so this option is obviously only valid
when Show Keys is enabled.
• Non-Grouped Keyframes
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For bone motion paths, search whole Action for keyframes instead of in group with matching
name only (is slower)
Calculate
Start / End
These are the start/end frames of the range in which motion paths are drawn. You have to Calculate
Paths again when you modify this setting, to update the paths in the 3D views. Note that unlike with
ghosts, the start frame is inclusive (i.e. if you set PSta to 1, you’ll really see the frame 1 as starting
point of the paths...).
Bake Location
By default, you get the tips’ paths. By changing this setting to Tails, you’ll get the paths of the
bone’s roots (remember that in Bforartists UI, bones’ roots are called “heads”...). You have to
Calculate Paths again when you modify this setting, to update the paths in the 3D views.

Spline IK
Spline IK is a constraint which aligns a chain of bones along a curve. By leveraging the ease and flexibility of
achieving aesthetically pleasing shapes offered by curves and the predictability and well integrated control
offered by bones, Spline IK is an invaluable tool in the riggers’ toolbox. It is particularly well suited for rigging
flexible body parts such as tails, tentacles, and spines, as well as inorganic items such as ropes.
Full description of the settings for the spline IK are detailed on the Spline IK page.
Basic Setup
The Spline IK Constraint is not strictly an ‘Inverse Kinematics’ method (i.e. IK Constraint), but rather a
‘Forward Kinematics’ method (i.e. normal bone posing). However, it still shares some characteristics of the IK
Constraint, such as operating on multiple bones not being usable for Objects, and being evaluated after all other
constraints have been evaluated. It should be noted that if a Standard IK chain and a Spline IK chain both affect
a bone at the same time the Standard IK chain takes priority. Such setups are best avoided though, since the
results may be difficult to control.
To setup Spline IK, it is necessary to have a chain of connected bones and a curve to constrain these bones to.
• With the last bone in the chain selected, add a Spline IK Constraint from the Bone Constraints tab in the
Properties Editor.
• Set the ‘Chain Length’ setting to the number of bones in the chain (starting from and including the
selected bone) that should be influenced by the curve.
• Finally, set the ‘Target’ field to the curve that should control the curve.
Congratulations, the bone chain is now controlled by the curve.

Settings and Controls
Roll Control
To control the ‘twist’ or ‘roll’ of the Spline IK chain, the standard methods of rotating the bones in the chain
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along their y-axes still apply. For example, simply rotate the bones in the chain around their y-axes to adjust the
roll of the chain from that point onwards. Applying copy rotation constraints on the bones should also work.

Offset Controls
The entire bone chain can be made to follow the shape of the curve while still being able to be placed at an
arbitrary point in 3D-space when the ‘Chain Offset’ option is enabled. By default, this option is not enabled,
and the bones will be made to follow the curve in its untransformed position.

Thickness Controls
The thickness of the bones in the chain is controlled using the constraint’s ‘XZ Scale Mode’ setting. This setting
determines the method used for determining the scaling on the X and Z axes of each bone in the chain.
The available modes are:
None
this option keeps the X and Z scaling factors as 1.0
Volume Preserve
the X and Z scaling factors are taken as the inverse of the Y scaling factor (length of the bone),
maintaining the ‘volume’ of the bone
Bone Original
this options just uses the X and Z scaling factors the bone would have after being evaluated in the
standard way.
In addition to these modes, there is an option, ‘Use Curve Radius’. When this option is enabled, the average
radius of the radii of the points on the curve where the endpoints of each bone are placed, are used to derive X
and Z scaling factors. This allows the scaling effects, determined using the modes above, to be tweaked as
necessary for artistic control.

Tips for Nice Setups
• For optimal deformations, it is recommended that the bones are roughly the same length, and that they
are not too long, to facilitate a better fit to the curve. Also, bones should ideally be created in a way that
follows the shape of the curve in its ‘rest pose’ shape, to minimise the problems in areas where the curve
has sharp bends which may be especially noticeable when stretching is disabled.
• For control of the curve, it is recommended that hooks (in particular, Bone Hooks) are used to control
the control-verts of the curve, with one hook per control-vert. In general, only a few control-verts should
be needed for the curve (i.e. 1 for every 3-5 bones offers decent control).
• The type of curve used does not really matter, as long as a path can be extracted from it that could also
be used by the Follow Path Constraint. This really depends on the level of control required from the
hooks.
• When setting up the rigs, it is currently necessary to have the control bones (for controlling the curve) in
a separate armature to those used for deforming the meshes (i.e. the deform rig containing the Spline IK
chains). This is to avoid creating pseudo “Dependency Cycles”, since Bforartists’s Dependency Graph
can only resolve the dependencies the control bones, curves, and Spline IK’ed bones on an object by
object basis.
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Lattice
Lattice – or commonly called deformation cage outside of Blender. A lattice consists of a three-dimensional
non-renderable grid of vertices. Its main use is to apply a deformation to the object it controls with a Lattice
Modifier. If the object is parented with Lattice Deform a Lattice Modifier is automatically applied.

Editing
Flip (Distortion Free)
Mirrors the vertexes displacement from their base position.
U, V, W
Make Regular
Resets the whole lattice to a regular grid, where the cells are scaled to one cubic Blender Unit.

Properties

Lattice properties.
Lattice
A Data-Block Menu.

Lattice
Points
Rate of subdivision in the axes:
U, V, W

1
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Interpolation Type
Selector for each axis. See Different types of interpolation..
Linear, Cardinal, Catmull-Rom, B-Spline
Outside
Takes only the vertices on the surface of the lattice into account.
Vertex Group
The strength of the influence assigned as a weight to the individual vertices in the selected vertex group.

Usage

Lattice around the cube object in Object Mode.
The lattice should be scaled and moved to fit around your object in Object Mode. Any scaling applied to the
object in Edit Mode will result in the object deforming. This includes applying scale with Ctrl-A as this will
achieve the same result as scaling the lattice in Edit Mode, and therefore the object.
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Skinning
We have seen in previous pages how to design an armature, create chains of bones, etc. Now, having a good rig
is not the final goal - unless you want to produce a “Dance Macabre” animation, you’ll likely want to put some
flesh on your skeletons! Surprisingly, “linking” an armature to the object(s) it should transform and/or deform
is called the “skinning” process...

The ginebread mesh skinned on its armature.

In Bforartists, you have two main skinning types:
• You can Parent/Constrain Objects to Bones - then, when you transform the bones in Pose mode, their
“children” objects are also transformed, exactly as with a standard parent/children relationship... The
“children” are never deformed when using this method.
• You can Using the Armature modifier on entire Mesh, and then, some parts of this object to some bones
inside this armature. This is the more complex and powerful method, and the only way to really deform
the geometry of the object, i.e. to modify its vertices/control points relative positions.

1
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Skinning to Shapes
We saw in the previous page how to link (parent) whole objects to armature bones - a way to control the
transform properties of this object via a rig. However, armatures are much more powerful: they can deform the
shape of an object (i.e. affect its ObData data-block - its vertices or control points...).
In this case, the child object is parented (skinned) to the whole armature, so that each of its bones controls a part
of the “skin” object’s geometry. This type of skinning is available for meshes, lattices, curves, surfaces, and
texts (with more options for the first two types).
Bones can affect the object’s shape in two ways:
• The Envelope process is available for all type of skinnable objects - it uses the “proximity” and
“influence” of the bones to determine which part of the object they can deform.
• The Vertex Groups method is (obviously) reserved to meshes and lattices - one bone only affect the
vertices in the group having the same name, using vertices’ weights as influence value. A much more
precise method, but also generally longer to set up.
Both methods have some Common Options, and can be mixed together.

Parenting to Whole Armatures
But before diving into this, let’s talk about the different ways to skin (parent) an object to a whole armature - as
with object skinning, there is an “old parenting” method and a new, more flexible and powerful one, based on
modifiers - which allows creation of very complex setups, with objects deformed by several armatures.
For meshes and lattices only, you can use the Ctrl-P parent shortcut in the 3D views (after having selected
first the “skin” object, then the armature). The Make Parent To menu pops up, select the Armature entry. If the
skinning object is a lattice, you’re done; no more options are available. But with a child mesh, another Create
Vertex Groups? menu appears, with the following options - all regarding the “vertex groups” skinning method:

Set Parent menu

With Empty Groups
will create, if they don’t already exist, empty groups, one for each bone in the skinned armature, with
these bones’ names. Choose this option if you have already created (and weighted) all the vertex groups
the mesh requires.
With Envelope Weights
will create, as with Name Groups option, the needed vertex groups. However, it will also weight them
2
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according to the bones’ envelope settings (i.e. it will assign to each groups the vertices that are inside its
bone’s influence area, weighted depending on their distance to this bone). This means that if you had
defined vertex groups using same names as skinned bones, their content will be completely overridden!
You’ll get the same behavior as if you used the envelopes skinning method, but with vertex groups?
Automatic Weights
Creates, as with Envelope Weights option, the needed vertex groups, with vertices assigned and weighted
using the newer “bone heat” algorithm.

The Armature modifier.

This “parenting” method will create an* Armature modifier in the skinning object’s modifiers stack. And so, of
course, adding an* Armature modifier to an object is the second, new skinning method (which also works for
curves/surfaces/texts...). Follow the above link to read more about this modifier’s specific options. Note that
there is a way with new Armature modifiers to automatically create vertex groups and weight them; see the
Vertex Groups description below.
Warning
A single object can have several Armature modifiers (with e.g. different armatures, or different
settings...), working on top of each other, or mixing their respective effects (depending whether
their* MultiModifier option is set, see their description for more details), and only one “virtual old
parenting” one, which will always be at the top of the stack.

Note finally that for settings that are present in both the armature’s Armature panel and in the objects’ Armature
modifier panel (namely, Vertex Groups / VertGroups , Envelopes, Quaternion and B-Bone Rest), the modifier
ones always override the armature ones. This means that if, for example, you only enable the Envelopes
deformation method of the armature, and then skin it with an object using an* Armature modifier, where only
VertGroups is enabled, the object will only be deformed based on its “bones” vertex groups, ignoring
completely the bones’ envelopes.

Common Options
There are two armature-global skinning options that are common to both envelopes and vertex groups
methods:*
Preserve Volume (Armature modifier)
3
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This affects the way geometry is deformed, especially at bones’ joints, when rotating them.
Without Preserve Volume, rotations at joints tend to scale down the neighboring geometry, up to nearly
zero at 180d from rest position. With* Preserve Volume, the geometry is no longer scaled down, but
there is a “gap”, a discontinuity when reaching* 180d from rest position.
Example of Quaternion option effects.

Initial state.

100- rotation, Preserve Volume

180- rotation, Preserve Volume disabled.

disabled.

100- rotation, Preserve Volume enabled. 179.9- rotation, Preserve Volume
enabled.

180.1- rotation, Preserve Volume
enabled.

Note that the IcoSphere is deformed
using the envelopes method.

Bone Deform Options

Bone Deform Options

The bones also have some deforming options in their sub-panels (* Armature Bones panel), that you can
therefore define independently for each of them
Deform
By disabling this setting (enabled by default), you can completely prevent a bone from deforming the
geometry of the skin object.
4
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Envelope

Bone influence areas for envelopes method.

Envelopes is the most general skinning method - it works with all available object types for skinning (meshes,
lattices, curves, surfaces and texts). It is based on proximity between bones and their geometry, each bone
having two different areas of influence, shown in the Envelope visualization:
• The inside area, materialized by the “solid” part of the bone, and controlled by both root and tip radius.
Inside this zone, the geometry if fully affected by the bone.
• The outside area, materialized by the lighter part around the bone, and controlled by the Dist setting.
Inside this zone, the geometry is less and less affected by the bone as it goes away - following a
quadratic decay.
See the* editing pages for how to edit these properties.
There is also a bone property, Weight (in each bone sub-panel, in* Edit mode only, defaults to 1.0), that controls
the global influence of the bone over the deformed object, when using the envelopes method. It is only useful
for the parts of geometry that are “shared”, influenced by more than one bone (generally, at the joints...) - a
bone with a high weight will have more influence on the result than one with a low weight... Note that when set
to* 0.0, it has the same effect as disabling the* Deform option.
Mult
Short for ‘Multiply’. This option controls how the two deforming methods interact when they are both
enabled. By default, when they are both active, all vertices belonging to at least one vertex group are only
deformed through the vertex groups method - the other “orphan” vertices being handled by the envelopes
one. When you enable this option, the “deformation influence” that this bone would have on a vertex
(based from its envelope settings) is multiplied with this vertex’s weight in the corresponding vertex
group. In other words, the vertex groups method is further “weighted” by the envelopes method.
Radius
Set the radius for the head and the tail of envelope bones.

Curved Bone
Curved Bones (previously known as B-bones) allow you make bones act like bezier curve segments, which
results in smoother deformations for longer bones.
See the editing pages for how to edit these properties.
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Vertex Groups
Vertex groups skinning method is only available for meshes and lattices - the only objects having vertex groups
Its principle is very simple: each bone only affects vertices belonging to a vertex group having the same name
as the bone. So if you have e.g. a forearm bone, it will only affect the forearm vertex group of its skin
object(s).
The influence of one bone on a given vertex is controlled by the weight of this vertex in the relevant group.
Thus, the Weight Paint mode (Ctrl-Tab with a mesh selected) is most useful here, to easily set/adjust the
vertices’ weights.
However, you have a few goodies when weight-painting a mesh already parented to (skinning) an armature. For
these to work, you must:
•
•
•
•

Select the armature.
Switch to** Pose mode
Select the mesh to weight.
Switch to Weight Paint mode.

Now, when you select a bone of the armature (which remained in Pose mode), you automatically activate the
corresponding vertex group of the mesh - Very handy! Obviously, you can only select one bone at a time in this
mode (so Shift-LMB clicking does not work).
This way, you can also apply to the active bone/vertex group one of the same “auto-weighting” methods as
available when doing an “old-parenting” to armature
• Select the bone (and hence the vertex group) you want.
• Hit W, and in the Specials menu that pops up, choose either Apply Bone Envelopes to Vertex Groups or
Apply Bone Heat Weights to Vertex Groups (names are self explanatory, I think). Once again, even
though these names are plural, you can only affect one vertex group’s weights at a time with these
options.
To automatically weight multiple bones, you can simply
•
•
•
•
•
•

Ctrl-Tab out of Weight Paint Mode
Select the Armature. It should be in Pose mode.
Select multiple bones Shift-LMB or by selecting all
Select Mesh again
If not in weight paint already, toggle back into
Use the Weight menu to automatic weight. This will weight all the bones you selected in Pose Mode.
Example of vertex groups skinning method.
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The weights of the arm vertex group.

The weights of the forearm vertex group.

The result when posing the armature.

The same pose, but using envelopes
method rather that vertex groups.

Obviously, the same vertex can belong to several groups, and hence be affected by several bones, with a fine
tuning of each bone’s influence using these vertex weights. Quite useful when you want to have a smooth joint.
For example, when you skin an elbow, the upperarm vertex group contains the vertices of this part at full
weight (** 1.0 ), and when reaching the elbow area, these weights decrease progressively to 0.0’ when
reaching the forearm zone - and vice versa for the forearm group weights... Of course, this is a very raw
example - skinning a realistic joint is a big job, as you have to carefully find good weights for each vertex, to
have the most realistic behavior when bending - and this is not an easy thing!

Objects
To Do

Retargeting
To Do
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Animation
Animation is making an object move or change shape over time. Objects can be animated in many ways:
Moving as a whole object
Changing their position, orientation or size in time;
Deforming them
Animating their vertices or control points;
Inherited animation
Causing the object to move based on the movement of another object (e.g. its parent, hook, armature,
2

Bforartists Reference Manual - © Copyright - This page is under OCL license

etc...).
In this chapter we will cover the first two, but the basics given here are actually vital for understanding the
following chapters as well.
Animation is typically achieved with the use of Key Frames.

Chapters
General Principles and Tools
• Key frames
• Using The Timeline
• Markers

The Graph Editor
• F-Curves
• F-Curve Editing
• F-Curve Modifiers

The Action Editor
• Actions
• Working with Actions

Animation Techniques
• Constraints
• Moving objects on a Path
• Game Engine Physics Recording

Animating Deformation
• Shape Keys
• Deforming by a Lattice
• Deforming with Hooks
See also Hook Modifier

Drivers
• Drivers
• Driven Shape Keys
The Introduction to Character Animation tutorial is a good starting point for learning character animation. Even
if you never used Bforartists before.

Animation Fundamentals
Actions
Actions are used to record the animation of objects and properties.
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Drivers
Drivers are used to control and animate properties.
Keying Sets
Keying Sets are used to record a set of properties at the same time.
Markers
Markers are used to mark key points/events within an animation.
Motion Paths
Motion Paths are used to visualize an animation.
Shape Keys
Shape Keys are used to deform objects into new shapes.

Animation Editors
Timeline
The Timeline Editor is a quick editor to set and control the time frame. This also has some tools for
animation.
Graph Editor
The Graph Editor is mostly used to edit the F-Curves and Keyframes for Channels and Drivers.
Dope Sheet
The Dopes Sheet contains a collection of animation editors.
NLA Editor
The NLA Editor is used to edit and blend Actions together.

Categories
Modifiers
Modifiers are automatic operations that affect an object in a non-destructive way. With modifiers, you can
perform many effects automatically that would otherwise be tedious to do manually.
Rigging
Rigging.
Constraints
Constraints are a way of connecting transform properties (position, rotation and scale) between objects.
Physical Simulation
This category covers various advanced Bforartists effects, often used to simulate real physical
phenomena. There is the Particle System for things like hair, grass, smoke, flocks. Soft Bodies are useful
for everything that tends to bend, deform, in reaction to forces like gravity or wind. Cloth simulation, to
simulate clothes or materials. Rigid Bodies can simulate dynamic objects that are fairly rigid. Fluids,
which include liquids and gasses, can be simulated, including Smoke. Force Fields can modify the
behavior of simulations.
Motion Tracking
Motion tracking is a new technique available in Bforartists. It is still under development, and currently
supports basic operations for 2D motion tracking, 3D motion tracking, and camera solution.
Animation Scripts
Add-on scripts for animation.
Rigging Scipts
Add-on scripts for rigging.

Key Frames
A Key Frame is simply a marker in time which stores the value of a property.
4
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For example, a key frame might indicate that the horizontal position of a cube is at 3m on frame 1.
The purpose of a key frame is to allow for interpolated animation, meaning, for example, that the user could
then add another key on frame 10, specifying the cube’s horizontal position at 20m, and Bforartists will
automatically determine the correct position of the cube for all the frames between frame 1 and 10 depending
on the chosen interpolation method (e.g. linear, bezier, quadratic, etc...).

Adding Key Frames
There are several methods of adding new keys. Namely:
• In the 3D View, pressing I will bring up a menu to choose what to add a key frame to.
• Hovering over a property and pressing I.
• RMB a value and choose Insert Keyframe from the menu.

Removing Key Frames
There are several methods of removing key frames
• In the 3D View press Alt-I to remove keys on the current frame for selected objects.
• When the mouse is over a value press Alt-I.
• RMB a value and choose Delete Keyframe from the menu.

Editing Key Frames
For editing key frames go to the Graph Editor or to the Dopesheet

Keyframe Visualization
There are some important visualization features in the 3D views that can help animation.
When the current frame is a keyframe for the current active object, the name of this object (shown in the bottom
left corner of the 3D views) turns yellow.

Left: Current frame at 0.
Right: Current frame is a keyframe for Cube

Motion Paths
Reference
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Mode: Object mode
Panel: Object

This feature allows you to visualize the animation of objects by displaying their position over a series of
frames.

An animated cube with its motion path displayed

Motion paths panel

Before we look at its options (all regrouped in the same Visualisations panel, in the Editing context, let’s first
see how to display/hide these paths. You have to do it manually - and you have to first select the objects you
want to show/hide the motion paths. Then,
• To show the paths (or update them, if needed), click on the Calculate Path button.
• To hide the paths, click on the Clear Paths button
Remember: only selected object and their paths are affected by these actions!
The paths are drawn in black with white dots indicating frames, and a blue glow around the current frame.

6
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Options

The Motion Paths Panel set to “Around Frame”

Around Frame
Around Frame, Display Paths of poses within a fixed number of frames around the current frame. When
you enable this button, you rather get paths for a given number of frames before and after the current one
(again, as with ghosts).

The Motion Paths Panel set to “In Range”

In Range
In Range, Display Paths of poses within specified range.
Display Range
Before/After
Number of frames to show before and after the current frame (only for ‘Around Current Frame’
Onion-skinning method)
Start/End
Starting and Ending frame of range of paths to display/calculate (not for ‘Around Current Frame’
Onion-skinning method)
Step
This is the same thing as the GStep for ghosts - it allows you the only materialize on the path one
frame each n ones. Mostly useful when you enable the frame number display (see below), to avoid
cluttering the 3D views.
Frame Numbers
When enabled, a small number appears next to each frame dot on the path, which is of course the number
of the corresponding frame...
Keyframes
When enabled, big yellow square dots are drawn on motion paths, materializing the keyframes of their
bones (i.e. only the paths of keyed bones at a given frame get a yellow dot at this frame).
Keyframe Numbers
When enabled, you’ll see the numbers of the displayed keyframes - so this option is obviously only valid
when Show Keys is enabled.
7
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Cache
From / To
These are the start/end frames of the range in which motion paths are drawn. You cannot modify
this range without deleting the motion path first.
Calculate Paths/ Update Paths
If no paths have been calculated, Calculate Paths will create a new motion path in cache. In the pop
up box, select the frame range to calculate. If a path has already been calculated, Update Paths will
update the path shape to the current animation. To change the frame range of the calculated path,
you need to delete the path and calculate it again.

Actions
When animating objects and properties in Bforartists, Actions record and contain the data.

Actions.

So when you animate an object by changing its location with keyframes, the animation is saved to the Action.
Each property has a channel which it is recorded to, for example, Cube.location.x is recorded to Channel X
Location.

Graph Editor. Each Channel has an F-Curve represented by the lines between the keyframes.

Actions
Record and contain animation data.
Groups
Are groups of channels.
Channels
Record properties.
8
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F-Curves
Are used to interpolate the difference between the keyframes.
Keyframes
Are used to set the values of properties.

F-Curve Interpolation

Graph Editor: Channel F-Curve.

The keyframes are set values by the user.
The F-Curve is used to interpolate the difference between the keyframes.
The F-Curve has different types of interpolation and also F-Curve Modifiers.
Most the settings for the F-Curve are found in the Graph Editor.

Basic Animation
These are some common ways to animate objects. These methods can be used on different objects, like
armature bones in pose mode.

Insert Keyframes
This example shows you how to animate a cubes location, rotation, and scale.
•
•
•
•
•
•
•

First, in the Timeline, or other animation editors, set the frame to 1.
With the Cube selected in Object Mode, press I in the 3D View.
From the Insert Keyframe Menu select LocRotScale.
This will record the location, rotation, and scale, for the Cube on frame 1.
Set the frame to 100.
Use Grab/Move G, Rotate R, Scale S, to transform the cube.
Press I in the 3D View. From the Insert Keyframe Menu select LocRotScale.

9

Bforartists Reference Manual - © Copyright - This page is under OCL license

Insert Keyframes.

To test the animation, press Alt-A to play.

The animation on frames 1, 50, 100.

Auto Keyframe

Timeline Auto Keyframe.

Auto Keyframe is the red record button in the Timeline header. Auto Keyframe adds keyframes automatically to
the set frame if the value for transform type properties changes.
See Timeline V Keyframe Control for more info.

Keying Sets

10
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Timeline Keying Sets.

Keying Sets are a set of keyframe channels. They are used to record multiple properties at the same time. There
are some built in keying sets, ‘LocRotScale’, and also custom keying sets can be made.
To use the keying set, first select a keying set from the Timeline header, or the Keying Sets Panel.
Now when you press I in the 3D view, Bforartists will add keyframes for all the properties in the active keying
set.
See Keying Sets for more info.

Properties

Keyframe properties.

Keyframes can be used to animate lots of different properties in Bforartists. To add keyframes to a property in
the UI, RMB the property, then select Insert Single Keyframe, or Insert Keyframes. Insert Keyframes I will add
a keyframes for the set of properties.

Properties, Drivers, Keyframes.

Properties have different colors and menu items for different states.
Gray - Property is not animated with Keyframes or Drivers.
Insert Keyframes I. Insert Single Keyframe. Add Drivers. Add Single Driver. Paste Driver.
Purple - Property value is controlled with a Driver.
Delete Drivers. Delete Single Driver. Copy Driver. Paste Driver.
Green - Property has Channel with Keyframes.
Insert Keyframes I. Insert Single Keyframe. Clear Keyframes Alt-Shift-I Clear Single Keyframes.
Yellow - Property has Keyframes on the current Frame.
Replace Keyframes I. Replace Single Keyframe. Delete Keyframes Alt-I. Delete Single Keyframe.
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Clear Keyframes Alt-Shift-I Clear Single Keyframes.
Each property also has some Keying Set options.
Add All to Keying Set K. Add Single to Keying Set. Remove from Keying Set.

Editing
3D View.
Insert Keyframes on current frame I Delete Keyframes on current frame Alt-I

Working with Actions

Action Browser.

When you first animate an object by adding keyframes, Bforartists creates an Action to record the data.
Actions can be managed with the Action Browser in the DopeSheet Action Editor header, or the properties
region of the NLA Editor.
If you are making multiple actions for the same object, press the F button for each action, this will give the
actions a Fake User and will make Bforartists save the unlinked actions.
Objects can only use one Action at a time for editing, the NLA Editor is used to blend mutiple actions together.

Drivers

Graph Editor: Driver example.

Drivers can use properties, numbers, transformations, and scripts, to control the values of properties.
Using a F-Curve, the driver reads the value of the Driver Value and sets the value of the selected property it was
added to.
So from this example, if the Driver Value is 2.0 the property will be 0.5.
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Bforartists Reference Manual - © Copyright - This page is under OCL license

The Driver Value is determined by Driver Variables or a Scripted Expression.
Most the settings for the drivers F-Curves are found in the Graph Editor.

Drivers Panel

Graph Editor: Drivers: Drivers Panel.

This panel is located in the Graph Editor with the mode set to Drivers.
The drivers panel is for setting up Driver Variables or a Scripted Expression which will determine the value of
the Driver Value.

Driver Settings
Update Dependencies
This will force an update for the Driver Value dependencies.
Remove Driver
Removes the driver from the object.
Type
The type of calculation to use on the set of Driver Variables. (If you only have one driver variable there is
no real difference between average, sum, minimum and maximum)
Average Value
Uses the average value of the referenced Driver Variables.
Sum Values
Uses the sum of the referenced Driver Variables.
Scripted Expression
Uses a Scripted Expression. See Expr. You must write a python expression which performs your
own calculations on the Driver Variables.
Minimum Value
Uses the lowest value from the referenced Driver Variables.
Maximum Value
Uses the highest value from the referenced Driver Variables.
13
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Expr
Scripted Expression. Here you can add real numbers, math operators, math functions, python properties,
driver functions. See Driver Expression below for some examples.
Show Debug Info
Shows the Driver Value. The current value of the variables or scripted expression.
Add Variable
Adds a new Driver Variable.

Setup of a Single Property.

Transform Channel Setup

Distance Setup

Driver Variables
Name
Name to use for scripted expressions/functions. No spaces or dots are allowed and must start with a letter.
Variable Type
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The type of variable to use.
Single Property
Use the value from some RNA property. For example, the Ambient shading color from a material.
First select the type of ID-block, then the ID of the ID-block, then copy and paste an RNA property
(Ctrl+V).
ID-Type
The ID-Block type, example, Key, Image, Object, Material.
ID
The ID of the ID-Block type, example, Material.001.
RNA Path
The RNA id name of the property, example, ‘ambient’ from material shading.
Transform Channel
Use one of the Transform channels from an object or bone.
ID
ID of the object, example, Cube, Armature, Camera.
Bone
ID of the Armature bone, example, Bone, Bone.002, Arm.r. This option is for armatures.
Type
Example, X Location, X Rotation, X Scale.
Space
World Space, Transform Space, Local Space.
Rotational Difference
Use the rotational difference between two objects or bones.
Distance
Use the distance between two objects or bones.
Value
Shows the value of the variable.

Workflow
There are some different ways to add drivers in Bforartists. These are some driver examples and workflow.
After adding drivers they are usually modified in the Graph Editor with the mode set the Drivers.

UI
The common way to add a driver to a property is to right click a property, then add a driver via the context
menu.
Add Drivers
This will add drivers to the set of properties related to the selected one. For example, it will add drivers to
X, Y, and Z for Rotation.
Add Single Driver
This will add a single driver to the selected property.
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Drivers can also be added by pressing D with the mouse over the property set.

Expression
This is quick way to add drivers with a scripted expression. First click the property you want add a driver to,
then add a hash # and a scripted expression.
Some examples.
•
•
•
•

#frame
#frame / 20.0
#sin(frame)
#cos(frame)

Copy Paste
Drivers can be copied and pasted in the UI, via the context menu. When adding drivers with the same settings,
this can save time modifying settings.

Transform Driver
This examples shows you how setup a transform driver. First make sure you are in the Front Ortho view.
Numpad5, Numpad1.
1.
2.
3.
4.
5.
6.
7.
8.

In object mode, select then duplicate the default Cube. Shift-D. Move Cube.001 to a new location.
With Cube.001 selected, add a single driver to the Rotation Y property.
Open the Graph Editor, set the Mode to Drivers.
Show Only Selected is useful disabled for drivers, marked green in the picture.
In the channels region, select the Y Euler Rotation property.
Press N to open the properties region, scroll down to Drivers panel.
Change the Type to Averaged Value, this will return the averaged value of the driver variables.
Modify the driver variable settings.

•
•
•
•

Type - Transform Channel
Ob/Bone - Cube
Transform Type - X Location
Transform Space - World Space

16

Bforartists Reference Manual - © Copyright - This page is under OCL license

When finished, Cube.001 should rotate on the Y axis when moving Cube left of right.

Examples
Some Driver Examples.

Driver Expression
Here are some examples using the scripted expression Expr to set the Driver Value.

Object Rotation.
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Orbit a point
Here two drivers have been added to the Cube, X Location and Y Location.
The scripted expressions are being used to set the object location.
X Location Expr
0 + (sin(frame / 8) * 4)
(frame/8) : is the current frame of the animation, divided by 8 to slow the orbit down.
(sin( )*4) : This returns the sine of (frame/8), then multiplies by 4 for a bigger circle. 0 + : is
used to control the X Location offset of the orbit.
Y Location Expr
0 + (cos(frame / 8) * 4)
(frame / 8) : is the current frame of the animation, divided by 8 to slow the orbit down.
(cos( ) * 4) : This returns the cosine of (frame/8), then multiplies by 4 for a bigger circle. 0
+ : is used to control the Y Location offset of the orbit.
frame is the same as bpy.context.scene.frame_current.

Driver Namespace
There is a list of built in driver functions and properties. These can be displayed via the python console.
>>> bpy.app.driver_namespace['

__builtins__']
__doc__']
__loader__']
__name__']
__package__']
acos']
acosh']
asin']
asinh']
atan']
atan2']
atanh']
bpy']
ceil']
copysign']
cos']
cosh']
..

This script will add a function to the driver namespace, which can then be used in the expression
driver_func(frame)
import bpy
def driver_func(val):
return val * val

# return val squared

# add function to driver_namespace
bpy.app.driver_namespace['driver_func'] = driver_func

Shape Key Driver
This example is a Shape Key Driver. The driver was added to the shape key Value.
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Shape Key Driver. Click to enlarge.

This example uses the Armature Bone ‘b’ Z Rotation to control the Value of a Shape Key. The bone rotation
mode is set to XYZ Euler.
The Driver F-Curve is mapped like so
Bone Z Rotation 0.0(0.0): Shape Key value 0.0 Bone Z Rotation -2.09(-120.0): Shape Key value 1.0
This kind of driver can also be setup with the Variable Type Rotational Difference.
See Shape Keys for more info.

Drivers And Multiple Relative Shape Keys
The following screenshots illustrate combining shape keys, bones, and drivers to make multiple chained relative
shape keys sharing a single root. While it lacks the convenience of the single Evaluation Time of an absolute
shape key, it allows you to have more complex relationships between your shape keys.
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Key1 must handle conflicting values from the two bones
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Key2A has different generator coefficients so it is activated in a different range of the bone’s position.
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Key2B is the same as Key2A, but is controlled by the second bone.
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when both bones are low, Key2B and Key2A are deactivated and Key1 is at low influence.
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The Basis shape key has the stacks fully retracted. Key1 has the base fully extended. Key2A has the left stack
fully extended. Key2B has the right stack fully extended. Key2A and Key2B are both relative to Key1 (as you
can see in the field in the bottom right of the Shape Keys panel.
The value of Key1 is bound to the position of bones by a driver with two variables. Each variable uses the
world Z coordinate of a bone and uses the maximum value to determine how much the base should be
extended. The generator polynomial is crafted such that the top of the dominant stack should line up with the
bone for that stack.
The value of Key2A is bound to the position of Bone.L. Its generator parameters are crafted such that when
Key1’s value reaches 1, the value of Key2A starts increasing beyond zero. In this way the top of the left stack
will move with bone.L (mostly).
The value of Key2B is bound to the position of Bone.R. Its generator parameters are similar to Key2A so that
the top of the right stack will move with bone.R (mostly).
Since it’s quite easy for bone.L and bone.R to be in positions that indicate conflicting values for Key1 there will
be times when the bones do not line up with the tops of their respective stacks. If the driver for Key1 were to
use Average or Minimum instead of Maximum to determine the value of the shape key then “conflicts” between
bone.L and bone.R would be resolved differently. You will chose according to the needs of your animation.
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Troubleshooting
Some common problems people may run in to when using drivers.

Scripted Expression

Graph Editor > Properties > Drivers.

Info Header.

By default Bforartists will not auto run python scripts.
If using a Scripted Expression Driver Type, you will have to open the file as Trusted Source, or set Auto Run
Python Scripts in User Preferences > File > Auto Execution.

File Browser.

User Preference > File > Auto Execution.

Rotational Properties are Radians
Parts of the User Interface may use different units of measurements for angles, rotation. In the Graph Editor
while working with Drivers, all angles are Radians.

Intra-armature Bone Drivers Can Misbehave
There is a well known limitation with drivers on bones that refer to another bone in the same armature. Their
values can be incorrectly calculated based on the position of the other bone as it was before you adjust the
current_frame. This can lead to obvious shape glitches when the rendering of frames has a jump in the frame
number (either because the .blend file is currently on a different frame number or because you’re skipping
already-rendered frames).
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See Also
•
•
•
•

Animation
Graph Editor
F-Curves
Extending Bforartists with Python.

Links
• Python and its documentation.
• functions.wolfram.com

Keying Sets

Timeline Keying Sets.

Keying Sets are a collection of properties. They are used to keyframe multiple properties at the same time,
usually by pressing I in the 3D View.
There are some built in Keying Sets, and also custom Keying Sets called Absolute Keying Sets.
To select and use a Keying Set, set the Active Keying Set in the Timeline Header, or the Keying Set Panel, or
press Ctrl-Alt-Shift-I in the 3D View.

Keying Set Panel
This panel is used to add, select, manage Absolute Keying Sets.

Properties > Scene > Keying Set Panel.
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Keying Set Name
The active Keying Set is highlighted in blue, press Ctrl-LMB to rename.
+
Add new (Empty) keying set to the active Scene.
Remove the active Keying Set.
Active Keying Set properties
Description
A short description of the keying set.
Export to File
Export Keying Set to a python script File.py. To re add the keying set from the File.py, open
then run the File.py from the Text Editor.
Keyframing Settings
These options control all properties in the Keying Set. Note, the same settings in User
Preferences override these settings if enabled.
Only Needed
Only insert keyframes where they’re needed in the relevant F-Curves.
Visual Keying
Insert keyframes based on the visual transformation.
XYZ=RGB Colors
For new F-Curves, set the colors to RGB for the property set, Location XYZ for
example.

Active Keying Set Panel
This panel is used to add properties to the active Keying Set.
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Properties > Scene > Active Keying Set Panel.

Properties > Graph Editor > Channels, Named Group.

Paths
A collection of Paths each with a Data Path to a property to add to the active Keying Set. The active Path
is highlighted in blue.
• Add new empty path to active Keying Set.
• Remove active path from the active Keying Set.
Active Path properties
ID-Block
Set the ID-Type + Object ID Data Path for the property.
28
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Data Path
Set the rest of the Data Path for the property.
Array Target
Use All Items from the Data Path or select the array index for a specific property.
F-Curve Grouping
This controls what Group to add the Channels to. Keying Set Name, None, Named Group.
Keyframing Settings
These options control individual properties in the Keying Set.
Only Needed
Only insert keyframes where they’re needed in the relevant F-Curves.
Visual Keying
Insert keyframes based on the visual transformation.
XYZ=RGB Colors
For new F-Curves, set the colors to RGB for the property set, Location XYZ for
example.

Adding Properties
Some ways to add properties to keying sets.
RMB the property in the User Interface, then select Add Single to Keying Set or Add All to Keying Set. This will
add the properties to the active keying set, or to a new keying set if none exist.
Hover the mouse over the properties, then press K, to add Add All to Keying Set.

Markers
Markers are used to denote frames at which something significant happens - it could be that a character’s
animation starts, the camera changes position, or a door opens, for example. Markers can be given names to
make them more meaningful at a quick glance. They are available in many of Bforartists’s windows, under
different forms. Unlike the keyframes, markers are always placed at a whole frame number, you cannot e.g. set
a marker at “frame 2.5 ”.
Markers can be created and edited in all of the following editors (including their different modes):
• The Graph Editor Window.
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•
•
•
•
•

The Action Editor window.
The The Dope Sheet.
The NLA Editor window.
The Video Sequence Editor window.
The Timeline window.When you create

A marker created in one of these windows will also appear in all others that support them, including:
• The 3D View window.

Pose markers
There is another type of markers, called “pose markers”, which are specific to the armatures and the Action
Editor window. They are related to the pose libraries, and are discussed in detail here.

Visualization
Standard

Markers: small but useful.

Most of the window types visualize markers the same way: as small triangles at their bottom, white if
unselected or yellow if selected.
If they have a name, this is shown to their right, in white when the marker is selected. See (Markers: small but
useful).

Sequencer

Markers in the Sequencer

The Video Sequence Editor just adds a vertical dashed line to each marker (gray if the marker is unselected, or
white if it’s selected).

3D View
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Marker in a 3D View.

The View do not allow you to create/edit/remove markers, they just show their name between <> at there
bottom left corner, near the active object’s name, when you are at their frame (see Marker in a 3D view).

Creating and Editing Markers
Unfortunately, there is no common shortcuts and menu for marker’s editing, across the different window types
that supports them... So in the refboxes of each action described below, I put the most-common shortcut and
menu entry, with the known exceptions between brackets.

Creating Markers
Reference
Mode: all modes
Menu: Marker ‣ Add Marker (Frame ‣ Add Marker in a timeline)
Hotkey: M (Ctrl-Alt-M in a VSE)

The simplest way to add a marker is to move to the frame where you would like it to appear, and press M (or
Ctrl-Alt-M in a video sequence editor).
Alternatively, you can press Alt-A (or the “playback” button of the Timeline window) to make the animation
play, and then press M (or Ctrl-Alt-M in VSE) at the appropriate points. This can be especially useful to
mark the beats in some music.

Selecting Markers
Reference
Mode: all modes
Hotkey: RMB, Shift-RMB, A / Ctrl-A, B / Ctrl-B
Click RMB on the marker’s triangle to select it. Use Shift-RMB to (de)select multiple markers.
In the Ipo Curve Editor, Action Editor, NLA Editor and Video Sequence Editor windows, you can also
(de)select all markers with Ctrl-A, and border-select them with Ctrl-B (as usual, LMB to select, RMB to
deselect). The corresponding options are found in the Select menu of these windows.
In the Timeline and Audio windows, you can (de)select all markers with A , and border (de)select them with
B ...

Naming Markers
Reference
Mode: all modes
Menu: Marker ‣ (Re)Name Marker ( Frame ‣ Name Marker in a timeline)
Hotkey: Ctrl-M
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Having dozens of markers scattered throughout your scene’s time won’t help you much unless you know what
they stand for. You can name a marker by selecting it, pressing Ctrl-M, typing the name, and pressing the OK
button.

Moving Markers
Reference
Mode: all modes
Menu: Marker ‣ Grab/Move Marker ( Frame ‣ Grab/Move Marker in a timeline)
Hotkey: Ctrl-G ( G in a timeline or audio)
Once you have one or more markers selected, press Ctrl-G (or G in Timeline or Audio windows) to move
them, and confirm the move with LMB or Return (as usual, cancel the move with RMB, or Esc).
By default, you grab the markers in one-frame steps, but if you hold Ctrl, the markers will move in steps
corresponding to one second (according to the scenes FPS).

Duplicating Markers
Reference
Mode: all modes
Menu: Marker ‣ Duplicate Marker ( Frame ‣ Duplicate Marker in a timeline)
Hotkey: Ctrl-Shift-D ( Shift-D in a timeline or audio)
You can duplicate the selected markers by pressing Ctrl-Shift-D (or Shift-D in a Timeline or Audio
window). Once duplicated, the new ones are automatically placed in grab mode, so you can move them where
(or rather when) you want.
Note that unlike most other duplications in Bforartists, the names of the duplicated markers are not altered at all
(no .001 numeric counter append...).

Deleting Markers
Reference
Mode: all modes
Menu: Marker ‣ Delete Marker ( Frame ‣ Delete Marker in a timeline)
Hotkey: Shift-X ( X in a timeline or audio)
To delete the selected marker(s) simply press Shift-X (or X in a Timeline or Audio’’ window), and confirm
the pop-up message with LMB.

Using Constraints in Animation
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Constraints are a way to control an object’s properties (its location/rotation/scale), using either plain static
values (like the “limit” ones), or (an)other object(s), called “targets” (like e.g. the “copy” ones).
Even though these constraints might be useful in static projects, their main usage is obviously in animation.
There are two different aspects in constraints’ animation:
• You can control an object’s animation through the targets used by its constraints (this is a form of
indirect animation).
• You can animate constraints’ settings

Controlling Animation with Constraints
This applies only to constraints using target(s). Indeed, these targets can then control the constraint’s owner’s
properties, and hence, animating the targets will indirectly animate the owner.
This indirect “constraint” animation can be very simple, like for example with the Copy Location constraint,
where the owner object will simply copy the location of its target (with an optional constant offset). But you
can also have very complex behaviors, like when using the Action constraint, which is a sort of Animation
Driver for actions!
We should also mention the classical Child Of constraint, which creates parent/child relationship. These
relationships indeed imply indirect animation (as transforming the parent affects by default all its children). But
the Child Of constraint is also very important, as it allows you to parent your objects to bones, and hence use
Armatures to animate them!
Back to our simple Copy Location example, you can have two different behaviors of this constraint:
• When its Offset button is disabled (the default), the location of the owner is “absolutely” controlled by
the constraint’s target, which means nothing (except other constraints below in the stack...) will be able
to control the owner’s position. Not even the object’s animation curves.
• However, when the Offset button is enabled, the location of the owner is “relatively” controlled by the
constraint’s target. This means that location’s properties of the owner are offset from the location of the
target. And these owner’s location properties can be controlled e.g. by its Loc... curves (or actions, or
NLA...)!

Example
Let’s use the Copy Location constraint and its Offset button. For example, you can make your owner (let’s call
it moon) describe perfect circles centered on the (0.0, 0.0, 0.0) point (using e.g. pydriven LocX / LocY
animation curves, see this page), and then make it copy the location of a target (called, I don’t know... earth,
for example) - with the Offset button enabled. Congratulation, you just modeled a satellite in a (simplified) orbit
around its planet... Just do the same thing with its planet around its star (which you might call sun, what do
you think?), and why not, for the star around its galaxy...
Here is a small animation of a “solar” system created using (among a few others) the technique described
above:
https://vimeo.com/15187945
Note that the this “solar” system is not realistic at all (wrong scale, the “earth” is rotating in the wrong direction
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around the “sun”, ...).
You can download the .blend file (download here) used to create this animation.

Animating Constraints Influence
More “classically”, you can also animate a few properties of each constraint using animation curves.
You only have two animation curves (see also: Graph Editor):
• You can animate the Influence of a constraint. For example, in the Example above, I used it to first stick
the camera to the “moon”, then to the “earth”, and finally to nothing, using two Copy Location
constraints with Offset set, and their Influence cross-fading together...
• More anecdotal, you can also, for some constraints using an armature’s bone as target, animate where
along this bone (between root and tip) lays the real target point (0.0 means “full-root”, and 1.0, “fulltip”).

Shape Keys
Shape Keys are used on Objects like Mesh, Curve, Surface, Lattice. They are used to deform the object vertices
into a new shape.

A mesh with different shape keys applied.

There are two types of Shape Keys.
Relative
Which are relative to the Basis or selected shape key. They are mainly used as, for limb joints, muscles, or
Facial Animation.
Absolute
Which are relative to the previous and next shape key. They are mainly used to deform the objects into
different shapes over time.
The shape key data, the deformation of the objects vertices, is usually modified in the 3D View by selecting a
shape key, then moving the object vertices to a new position.
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Shape Keys Panel
Reference
Mode: All modes
Panel: Properties, Object Data, Shape Keys

Shape Keys. Options.

Relative
Set the shape keys to Relative or Absolute.
Name
Name of the Shape Key.
Value
Current Value of the Shape Key (0.0 to 1.0).
Mute
This visually disables the shape key in the 3D view.
Add
Add a new shape key to the list.
Remove
Remove a shape key from the list.

Shape Keys Specials.

Specials
A menu with some operators.
Transfer Shape Key
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Transfer the active ‘Shape Key’ from a different object. Select two objects, the active Shape Key is
copied to the active object.
Join as Shapes
Transfer the ‘Current Shape’ from a different object. Select two objects, the Shape is copied to the
active object.
Mirror Shape Key
If your mesh is nice and symmetrical, in Object Mode, you can mirror the shape keys on the X axis.
This won’t work unless the mesh vertices are perfectly symmetrical. Use the Mesh ‣ Symmetrize
function in Edit Mode.
Mirror Shape Key (Topology)
This is the same as Mirror Shape Key though it detects the mirrored vertices based on the topology
of the mesh. The mesh vertices dont have to be perfectly symmetrical for this one to work.
New Shape From Mix
Add a new shape key with the current deformed shape of the object.
Delete All Shapes
Delete all shape keys.
Move
Move shape key up or down in the list.
Show Active
Show the shape of the active shape key in the 3D View. Show Active is enabled while the object is in Edit
Mode, unless the setting below is enabled.
Edit Mode
Modify the shape key settings while the object is in Edit mode.

Relative Shape Keys
Relative shape keys deform from a selected shape key. By default all relative shape keys deform from the first
shape key called the Basis shape key.

Relative Shape Keys. Options.

Clear Weights
Set all values to 0.
Name
Name of the active shape key.
Value
Value of the active shape key.
Range
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Min and Max range of the active shape key value.
Vertex Group
Limit the active shape key deformation to a vertex group.
Relative
Select the shape key to deform from.

Absolute Shape Keys
Absolute shape keys deform from the previous and to the next shape key. They are mainly used to deform the
object into different shapes over time.

Absolute Shape Keys. Options.

Reset Timing
Reset the timing for absolute shape keys. For example, if you have the shape keys, Basis, Key_1, Key_2,
in that order.
Reset Timing will loop the shapekeys, and set the shape key frames to +0.1.
Basis 0.1 Key_1 0.2 Key_2 0.3
Evaluation Time will show this as frame*100.
Basis 10.0 Key_1 20.0 Key_2 30.0
Name
Name of the active shape key.
Interpolation
This controls the interpolation between shape keys.

Different types of interpolation.

Evaluation Time
This is used to control the shape key influence.
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For example, if you have the shape keys, Basis, Key_1, Key_2, in that order,and you reset timing.
Basis 10.0 Key_1 20.0 Key_2 30.0
You can control the shape key influence with Evaluation Time. Here keyframes have been used to control
Evaluation Time for animation.

Animation with Evaluation Time.

Workflow For Relative Shape Keys
This example shows you how to make a cube mesh transform in to a sphere.
•
•
•
•
•
•

In Object Mode add two shape keys via the Shape Key Panel.
Basis is the rest shape. Key 1 will be the new shape.
With Key 1 selected, switch to Edit Mode.
Press Shift-Alt-S To Sphere, move the mouse right, then LMB.
Switch to Object Mode.
Set the Value for Key 1 to see the transformation between the shape keys.
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Shape Key workflow.

Workflow For Absolute Shape Keys
• Select the default Cube.
• Switch to Edit Mode.
• Switch to Face Select mode (if you are not already in it)

• Select the top face.
• Extrude up E 1 LMB.
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• Select a side face on the top half. (the one at x=1 if possible)
• Extrude out E 1 LMB.
• Switch back to Object Mode.

•
•
•
•

Add a basis shape keys and two more via the + button on the Shape Key Panel.
Uncheck the Relative checkbox.
Click the Reset Timing button.
Switch to Edit Mode.
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• Select shape key Key 2 to edit the third shape key.
• Select the extruded side face and G Z 1 LMB

•
•
•
•

Select shape key Basis to edit the first shape key.
Select the extruded size face and S 0.5 LMB, then G X Minus1 LMB.
Switch to Object Mode.
Drag the Evaluation Time slider to make its value vary from 10 to 30.

41

Bforartists Reference Manual - © Copyright - This page is under OCL license

More Details On Absolute Shape Keys
The thing to remember about absolute shape keys is that they are incomplete until you click the Reset Timing
button. When you create a shape key its “frame” property is zero (https://developer.Bforartists.org/T39897),
which is a completely useless value. This frame value is not displayed on the UI so you can’t easily tell if
something is wrong or screwy until your animation starts misbehaving.
The number displayed to the right of the key name is the value and is used in relative shape keys. It has no
effect on absolute shape keys, so ignore it.
When you reset the timings Bforartists iterates through the shape keys assigning them frame values
incrementing by 0.1 from key to key.
name

frame

evaluation time

Basis
0.1
10
Key 1
0.2
20
Key 2
0.3
30
Key 3
0.4
40
If you delete a shape key this does not automatically alter the frame values assigned to remaining shape keys.
name
Basis
Key 1
Key 3

frame
0.1
0.2
0.4

evaluation time
10
20
40

The Evaluation Time is how you choose which shape key is active, and how active it is. The interesting values
range from 10 .. (n*10) where n is the number of shape keys. (assuming you have not deleted or added any keys
since the last Reset Timing). If you are using shape keys for animation, 99% of the time you will be putting
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keyframes on this Evaluation Time field.
Remember: if you are having problems with your absolute shape keys, there is a good chance that you need to
Reset Timing.

Shape Key Operators
3D View > Edit Mode > Header > Mesh > Vertices > Shape Propagate
Apply selected vertex locations to all other shape keys.
3D View > Edit Mode > Header > Mesh > Vertices > Blend From Shape
Blend in shape from a shape key.

Animating Cameras
These are some basic tools and properties animators may use for the camera.

Switching Cameras
Switching cameras is done with the Timeline operator ‘Bind Camera to Markers’.
The triangle above the camera will become shaded when active.

First in the Timeline, add a set of markers used to switch cameras. Press M to add marker, then Ctrl M to
rename, duplicated markers should retain the same name.
1. In the 3D View, select the Camera the Markers will switch to.
2. In the Timeline, select the Marker(s) to switch to the Camera.
3. In the Timeline, press Ctrl-B to Bind Cameras to Markers.
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Moving Cameras
Move Along a Path
Sometimes its easier to move objects on path, see Moving Objects on a Path for more info.

Fly/Walk Modes
Fly/Walk Mode can be used in conjunction with the timeline record option.
To record your flight path as animation curves.

Lock Camera to View
Lock Camera to View can be used in conjunction with the timeline record option.
To record your view-port navigation as animation curves.

Dolly Zoom
The camera has a set of properties and tools via the Properties Editor.

While the camera is moving towards an object the Focal Length property can be decreased to produce a Dolly
Zoom camera effect, or vice versa.

Moving Objects on a Path
To make objects move along a path is a very common animation need. Think of a complex camera traveling, a
train on his rails - and most other vehicles can also use “invisible” tracks! -, the links of a bicycle chain, etc. All
these movements could obviously be done with standard Ipo curves, but this would be a nightmare! It’s much
more easy and intuitive to define a path materializing the desired movement, and make your object(s) follow it.
Bforartists features you two different constraints to make an object follow a path, which have different ways to

44

Bforartists Reference Manual - © Copyright - This page is under OCL license

determine/animate the position of their owner along their path.
In Bforartists, any curve object can become a path. A curve becomes a path when its Path Animation button is
enabled in the Curve data panel, but you don’t even have to bother about this: once a curve is selected as target
for a “path” constraint, it automatically is enabled.
You can also directly add a “path” from the Add ‣ Curve ‣ Path menu entry (in a 3D view). This will insert in
your scene a three-dimensional NURBS curve. This is an important point: by default, Bforartists’s curve are 2D
and won’t move on the Z axis. To turn a standard curve three-dimensional, enable its 3D button, in the same
Curve and Surface editing panel.
One last curve property that is important for a path is its direction, which is, for three-dimensional ones,
materialized by its small arrows. You can switch it with the Curve ‣ Segments ‣ Switch Direction menu entry
(or W, 2).
For more on editing path/curves, see the modeling chapter.
Note
Shapes on Curves
If you would rather like to have your object’s shape follow a path (like e.g. a sheet of paper inside a printer),
you should use the Curve Modifier

Parenting Method
Older versions of Bforartists did not have constraints to make an object follow a path. They used a different
method (deprecated, but still available), based on parenting.
To use this method, select the object that will follow the path, then Shift select the curve, and use Ctrl-P to
bring up the parenting menu. Choose Follow Path. The object will now be animated along the path.
The settings for the path animation are in the Path Animation panel of the Curve properties panel.
Frames
Defines the number of frames it takes for the object to travel the path.
Evaluation Time
Defines current frame of the animation. By default it is linked to the global frame number, but could be
keyframed to give more control over the path animation.
Follow
Causes the curve path children to rotate along the curvature of the path.
Radius
Causes the curve path child to be scaled by the set curve radius. See Curve Extruding
Offset Children
Causes the animation to be offset by the curve path child’s time offset value, which can be found in its
Animation Hacks section of the Object Panel.

The Follow Path Constraint
The Follow Path constraint implements the most “classical” technique. By default, the owner object will walk
the whole path only once, starting at frame one, and over 100 frames. You can set a different starting frame in
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the Offset field of the constraint panel, and change the length (in frames) of the path using its Frames property
(Curve and Surface panel).
But you can have a much more precise control over your object’s movement along its path by keyframing or
defining a Speed animation curve for the path’s Evaluation Time attribute. This curve maps the current frame to
a position along the path, from 0.0 (start point) to 1.0 (end point).
For more details and examples, see the Follow Path constraint page.

The Clamp To Constraint
Another method of keeping objects on a path is to use the Clamp To constraint, which implements a more
advanced technique. To determine where along the path should lay its owner, its uses the location of this owner
along a given axis. So to animate the movement of your owner along its target path, you have to animate some
way (Ipo curves or other indirect animation) its location.
This implies that here, the length of the path have no more any effect - and that by default, the object is static
somewhere on the path!
For more details and examples, see the Clamp To constraint page.
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Physics
The Physics chapter covers various advanced Bforartists effects, often used to simulate real physical
phenomena, such as:
•
•
•
•
•
•

Smoke
Rain
Dust
Cloth
Water
Jello

Particle Systems can be used to simulate many things: hair, grass, smoke, flocks.
Hair is a subset of the particle system, and can be used for strand-like objects, such as hair, fur, grass, quills,
etc.
Soft Bodies are useful for everything that tends to bend, deform, in reaction to forces like gravity or wind, or
when colliding with other objects... It can be used for skin, rubber, and even clothes, even though there is
separate Cloth Simulation specific for cloth-like objects.
Rigid Bodies can simulate dynamic objects that are fairly rigid.
Fluids, which include liquids and gases, can be simulated, including Smoke.
Force Fields can modify the behavior of simulations.

Gravity
Gravity is a global setting that is applied the same to all physics systems in a scene, which can be found in the
scene tab. This value is generally fine left at its default value, at -9.810 in the Z axis, which is the force of
gravity in the real world. Lowering this value would simulate a lower or higher force of gravity. Gravity
denoted g, measurement [m×s -2]).
Gravity is practically same around whole Earth. For rendering scenes from Moon use value 6 times smaller,
e.g. 1.622 m×s -2. The most popular and probably not colonized Mars has g = 3.69.
Note that you can scale down the gravity value per physics system in the Field Weights tab.
1
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Collisions
Particles, Soft Bodies and Cloth objects may collide with mesh objects. Boids try to avoid Collision objects.
•
•
•
•

The objects need to share at least one common layer to have effect.
You may limit the effect on particles to a group of objects (in the Field Weights panel).
Deflection for softbody objects is difficult, they often penetrate the colliding objects.
Hair particles ignore deflecting objects (but you can animate them as softbodies which take deflection
into account).

If you change the deflection settings for an object you have to recalculate the particle, softbody or cloth system
(Free Cache), this is not done automatically. You can clear the cache for all selected objects with Ctrl-B –>
Free cache selected.
Reference
Mode: Object Mode
Panel: Object context –> Physics sub-context –> Collision

Options

Collision Panel

Permeability
Fraction of particles passing through the mesh.
Stickiness
How much particles stick to the object.
Kill Particles
Deletes Particles upon impact.
Damping Factor
Damping during a collision (independent of the velocity of the particles).
Random damping
Random variation of damping.
Friction Factor
2
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Friction during movements along the surface.
Random friction
Random variation of friction.

Image 1b: A softbody vertex colliding with a plane.

Soft Body and Cloth Interaction
Outer
Size of the outer collision zone.
Inner
Size of the inner collision zone (padding distance).
Outside and inside is defined by the face normal, depicted as blue arrow in (Image 1b).
Damping Factor
Damping during a collision.
Softbody collisions are difficult to get perfect. If one of the objects move too fast, the soft body will penetrate
the mesh. See also the section about Soft Bodies.

Force Field Interaction
Absorption
A deflector can also deflect effectors. You can specify some collision/deflector objects which deflect a
specific portion of the effector force using the Absorption value. 100% absorption results in no force
getting through the collision/deflector object at all. If you have 3 collision object behind each other with
e.g. 10%, 43% and 3%, the absorption ends up at around 50% (100×(1-0.1)×(1-0.43)×(10.03)).
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Examples

Deflected Particles

Here is a Meta object, dupliverted to a particle system emitting downwards, and deflected by a mesh cube:

Hints
• Make sure that the normals of the mesh surface are facing towards the particles/points for correct
deflection.
• Hair particles react directly to force fields, so if you use a force field with a short range you don’t need
necessarily collision.
• Hair particles avoid their emitting mesh if you edit them in Particle mode. So you can at least model the
hair with collision.
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Cloth Simulations
Cloth simulation is one of the hardest aspects of CG, because it is a deceptively simple real-world item that is
taken for granted, yet actually has very complex internal and environmental interactions. After years of
development, Bforartists has a very robust cloth simulator that is used to make clothing, flags, banners, and so
on. Cloth interacts with and is affected by other moving objects, the wind and other forces, as well as a general
aerodynamic model, all of which is under your control.

Cloth Example
Cloth Example

Cloth on carved wooden
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men (made by motorsep).

Description
A piece of cloth is any mesh, open or enclosed, that has been designated as cloth. The Cloth panels are located
in the Physics sub-context and consist of three panels of options. Cloth is either an open or closed mesh and is
mass-less, in that all cloth is assumed to have the same density, or mass per square unit.
Cloth is commonly modeled as a mesh grid primitive, or a cube, but can also be, for example, a teddy bear.
However, Bforartists’s Softbody system provides better simulation of closed meshes; Cloth is a specialized
simulation of fabrics.
Once the object is designated as Cloth, a Cloth modifier will be added to the object’s modifier stack
automatically. As a modifier then, it can interact with other modifiers, such as Armature and Smooth. In these
cases, the ultimate shape of the mesh is computed in accordance with the order of the modifier stack. For
example, you should smooth the cloth after the modifier computes the shape of the cloth.
So you edit the Cloth settings in two places: use the Physics buttons to edit the properties of the cloth and use
the Modifier stack to edit the Modifier properties related to display and interaction with other modifiers.
You can Apply the cloth modifier to freeze, or lock in, the shape of the mesh at that frame, which removes the
modifier. For example, you can drape a flat cloth over a table, let the simulation run, and then apply the
modifier. In this sense, you are using the simulator to save yourself a lot of modeling time.
Results of the simulation are saved in a cache, so that the shape of the mesh, once calculated for a frame in an
animation, does not have to be recomputed again. If changes to the simulation are made, you have full control
over clearing the cache and re-running the simulation. Running the simulation for the first time is fully
automatic and no baking or separate step interrupts the workflow.
Computation of the shape of the cloth at every frame is automatic and done in the background; thus you can
continue working while the simulation is computed. However it is CPU-intensive and depending on the power
of your PC and the complexity of the simulation, the amount of CPU needed to compute the mesh varies, as
does the lag you might notice.
Note
Don’t jump ahead
If you set up a cloth simulation but Bforartists has not computed the shapes for the duration of the simulation,
and if you jump ahead a lot of frames forward in your animation, the cloth simulator may not be able to
compute or show you an accurate mesh shape for that frame, if it has not previously computed the shape for
the previous frame(s).

Workflow
A general process for working with cloth is to:
• Model the cloth object as a general starting shape.
• Designate the object as a “cloth” in the Physics tab of the Properties window.
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• Model other deflection objects that will interact with the cloth. Ensure the Deflection modifier is last on
the modifier stack, after any other mesh deforming modifiers.
• Light the cloth and assign materials and textures, UV-unwrapping if desired.
• If desired, give the object particles, such as steam coming off the surface.
• Run the simulation and adjust Options to obtain satisfactory results. The timeline window’s VCR
controls are great for this step.
• Optionally age the mesh to some point in the simulation to obtain a new default starting shape.
• Make minor edits to the mesh on a frame-by-frame basis to correct minor tears.
Tip
To avoid unstable simulation, ensure that the cloth object doesn’t penetrate any of the deflection objects or an
unstable simulation will result.

Cloth Panel
Presets
Contains a number of preset cloth examples, and allows you to add your own.
Quality
Set the number of simulation steps per frame. Higher values result in better quality, but is slower.

Material
Mass
The mass of the cloth material.
Structural
Overall stiffness of the cloth.
Bending
Wrinkle coefficient. Higher creates more large folds.

Damping
Spring
Damping of cloth velocity. Higher = more smooth, less jiggling.
Air
Air normally has some thickness which slows falling things down.
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Pinning

Cloth in action.

The first thing you need when pinning cloth is a Vertex Group. There are several ways of doing this including
using the Weight Paint tool to paint the areas you want to pin (see the Weight Paint section of the manual). The
weight of each vertex in the group controls how strongly it is pinned.
Once you have a vertex group set, things are pretty straightforward; all you have to do is press the Pinning of
cloth button in the Cloth panel and select which vertex group you want to use, and the stiffness you want it at.
Stiffness
Target position stiffness. You can leave the stiffness as it is; the default value of 1 is fine.

Pinning Clothing To An Armature
Clothing can be simulated and pinned to an armature. For example, a character could have a baggy tunic pinned
to the character’s waist with a belt.
The typical workflow for pinning:
• Set the armature to its bind pose.
• Model clothing that encloses but does not penetrate the character’s mesh.
• Parent the clothing objects to the armature. The armature will now have several child meshes bound to
it.
• Create a new vertex group on each cloth object for its pinned vertices
• Add vertexes to be pinned to this vertex group and give these vertices non-zero weights (you probably
want weight = 1). For example the belt area of the tunic would be in the vertex group and have weight
one.
• Designate the clothing objects as “cloth” in the Physics tab of the Properties window. Make sure the
Cloth modifier is below the Armature modifier in the modifier stack.
• press the Pinning of Cloth button in the Cloth panel and select the vertex group.
• Designate the character’s mesh as “collision” object in the Physics tab of the Properties window.
• The clothing is now ready. Non-pinned vertices will be under control of the Cloth modifier. Pinned
vertices will be under control of the Armature modifier.
Note
When animating or posing the character you must begin from the bind pose. Move the character to its initial
pose over several frames so the physics engine can simulate the clothing moving. Very fast movements and
teleport jumps can break the physics simulation.
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Cloth Sewing Springs
Another method of restraining cloth similar to pinning is sewing springs. Sewing springs are virtual springs that
pull vertices in one part of a cloth mesh toward vertices in another part of the cloth mesh. This is different from
pinning which binds vertices of the cloth mesh in place or to another object. A clasp on a cloak could be created
with a sewing spring. The spring could pull two corners of a cloak about a character’s neck. This could result in
a more realistic simulation than pinning the cloak to the character’s neck since the cloak would be free to slide
about the character’s neck and shoulders.
Sewing springs are created by adding extra edges to a cloth mesh. These extra edges do not need to be included
in faces. They should connect vertices in the mesh that should be pulled together. For example the corners of a
cloak. The vertexes of these extra edges are added to a vertex group.
Enable the Cloth Sewing Springs panel and select the vertex group. Give the springs a non-zero force value and
your cloth is ready to simulate.

Collisions
In most cases, a piece of cloth does not just hang there in 3D space, it collides with other objects in the
environment. To ensure proper simulation, there are several items that have to be set up and working together:
•
•
•
•
•
•
•
•
•
•

The Cloth object must be told to participate in Collision s.
Optionally (but recommended) tell the cloth to collide with itself.
Other objects must be visible to the Cloth object via shared layers.
The other objects must be mesh objects.
The other objects may move or be themselves deformed by other objects (like an armature or shape
key).
The other mesh objects must be told to deflect the cloth object.
The blend file must be saved in a directory so that simulation results can be saved.
You then Bake the simulation. The simulator computes the shape of the cloth for a frame range.
You can then edit the simulation results, or make adjustments to the cloth mesh, at specific frames.
You can make adjustments to the environment or deforming objects, and then re-run the cloth simulation
from the current frame forward.

Collision Settings

Cloth Collisions panel.

Now you must tell the Cloth object that you want it to participate in collisions. For the cloth object, locate the
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Cloth Collision panel, shown to the right:
Enable Collisions
LMB click this to tell the cloth object that it needs to move out of the way.
Quality
A general setting for how fine and good a simulation you wish. Higher numbers take more time but
ensure less tears and penetrations through the cloth.
Distance
As another object gets this close to it (in Bforartists Units), the simulation will start to push the cloth out
of the way.
Repel
Repulsion force to apply when cloth is close to colliding.
Repel Distance
Maximum distance to apply repulsion force. Must be greater than minimum distance.
Friction
A coefficient for how slippery the cloth is when it collides with the mesh object. For example, silk has a
lower coefficient of friction than cotton.

Self-collisions
Real cloth cannot permeate itself, so you normally want the cloth to self-collide.
Enable Self Collisions
Click this to tell the cloth object that it should not penetrate itself. This adds to simulation compute time,
but provides more realistic results. A flag, viewed from a distance does not need this enabled, but a closeup of a cape or blouse on a character should have this enabled.
Quality
For higher self-collision quality just increase the Quality and more self collision layers can be solved. Just
keep in mind that you need to have at least the same Collision Quality value as the Quality value.
Distance
If you encounter problems, you could also change the Min Distance value for the self-collisions. The best
value is 0.75; for fast things you better take 1.0. The value 0.5 is quite risky (most likely many
penetrations) but also gives some speedup.
Regression blend file: Cloth selfcollisions.

Shared Layers
Suppose you have two objects: a pair of Pants on layers 2 and 3, and your Character mesh on layers 1 and 2.
You have enabled the Pants as cloth as described above. You must now make the Character “visible” to the
Cloth object, so that as your character bends its leg, it will push the cloth. This principle is the same for all
simulations; simulations only interact with objects on a shared layer. In this example, both objects share layer 2.
To view/change an object’s layers, RMB click to select the object in Object mode in the 3D view. M to bring up
the “Move Layers” pop-up, which shows you all the layers that the object is on. To put the object on a single
layer, LMB click the layer button. To put the object on multiple layers, Shift-LMB the layer buttons. To
remove an object from a selected layer, simply Shift-LMB the layer button again to toggle it.

Mesh Objects Collide
If your colliding object is not a mesh object, such as a NURBS surface, or text object, you must convert it to a
6
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mesh object. To do so, select the object in object mode, and in the 3D View header, select Object –> Convert
Object Type (Alt-C), and select Mesh from the pop-up menu.

Cloth - Object collisions

Collision settings.

The cloth object needs to be deflected by some other object. To deflect a cloth, the object must be enabled as an
object that collides with the cloth object. To enable Cloth - Object collisions, you have to enable deflections on
the collision object (not on the cloth object).
In the Buttons window, Object context, Physics sub-context, locate the Collision panel shown to the right. It is
also important to note that this collision panel is used to tell all simulations that this object is to participate in
colliding/deflecting other objects on a shared layer (particles, soft bodies, and cloth).
Warning
There are three different Collision panels, all found in the Physics sub-context. The first (by default), a tab
beside the Fields panel, is the one needed here. The second panel, a tab in the Soft Body group, concern
softbodies (and so has nothing to do with cloth). And we have already seen the last one, by default a tab beside
the Cloth panel.

Mesh Object Modifier Stack

Collision stack.

The object’s shape deforms the cloth, so the cloth simulation must know the “true” shape of that mesh object at
that frame. This true shape is the basis shape as modified by shape keys or armatures. Therefore, the Collision
modifier must be after any of those. The image to the right shows the Modifiers panel for the Character mesh
object (not the cloth object).

Cloth Cache
Cache settings for cloth are the same as with other dynamic systems. See Particle Cache for details.
7
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Bake Collision

After Baking.

After you have set up the deflection mesh for the frame range you intend to run the simulation (including
animating that mesh via armatures), you can now tell the cloth simulation to compute (and avoid) collisions.
Select the cloth object and in the Object context, Physics sub-context, set the Start and End settings for the
simulation frames you wish to compute, and click the Bake button.
You cannot change Start or End without clearing the bake simulation. When the simulation has finished, you
will notice you have the option to free the bake, edit the bake and re-bake:
There’s a few things you’ll probably notice right away. First, it will bake significantly slower than before, and it
will probably clip through the box pretty badly as in the picture on the right.

Editing the cached simulation
The cache contains the shape of the mesh at each frame. You can edit the cached simulation, after you’ve baked
the simulation and pressed the Bake Editing button. Just go to the frame you want to fix and Tab into Edit
mode. There you can move your vertices using all of Bforartists’s mesh shaping tools. When you exit, the shape
of the mesh will be recorded for that frame of the animation. If you want Bforartists to resume the simulation
using the new shape going forward, LMB click Rebake from next Frame and play the animation. Bforartists will
then pick up with that shape and resume the simulation.
Edit the mesh to correct minor tears and places where the colliding object has punctured the cloth.
If you add, delete, extrude, or remove vertices in the mesh, Bforartists will take the new mesh as the starting
shape of the mesh back to the first frame of the animation, replacing the original shape you started with, up to
the frame you were on when you edited the mesh. Therefore, if you change the content of a mesh, when you
Tab out of Edit mode, you should unprotect and clear the cache so that Bforartists will make a consistent
simulation.

Troubleshooting
If you encounter some problems with collision detection, there are two ways to fix them:
• The fastest solution is to increase the Min Distance setting under the Cloth Collision panel. This will be
the fastest way to fix the clipping; however, it will be less accurate and won’t look as good. Using this
method tends to make it look like the cloth is resting on air, and gives it a very rounded look.
• A second method is to increase the Quality (in the first Cloth panel). This results in smaller steps for the
simulator and therefore to a higher probability that fast-moving collisions get caught. You can also
increase the Collision Quality to perform more iterations to get collisions solved.
8
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• If none of the methods help, you can easily edit the cached/baked result in Edit mode afterwards.
• My Cloth is torn by the deforming mesh - he “Hulks Out”: Increase its structural stiffness (StructStiff
setting, Cloth panel), very high, like 1000.

Note
Subsurf Modifier
A bake/cache is done for every subsurf level so please use the equal subsurf level for render and preview.

Examples
To start with cloth, the first thing you need, of course, is some fabric. So, let’s delete the default cube and add a
plane. I scaled mine up along the Y axis, but you don’t have to do this. In order to get some good floppy and
flexible fabric, you’ll need to subdivide it several times. I did it 8 times for this example. So Tab into Edit
mode, and press W –> Subdivide multi, and set it to 8.
Now, we’ll make this cloth by going to the Object context –> Physics sub-context. Scroll down until you see
the Cloth panel, and press the Cloth button. Now, a lot of settings will appear, most of which we’ll ignore for
now.
That’s all you need to do to set your cloth up for animating, but if you press Alt-A, your lovely fabric will just
drop very un-spectacularly. That’s what we’ll cover in the next two sections about pinning and colliding.

Using Simulation to Shape/Sculpt a Mesh
You can Apply the Cloth modifier at any point to freeze the mesh in position at that frame. You can then reenable the cloth, setting the start and end frames from which to run the simulation forward.
Another example of aging is a flag. Define the flag as a simple grid shape and pin the edge against the flagpole.
Simulate for 50 frames or so, and the flag will drop to its “rest” position. Apply the Cloth modifier. If you want
the flag to flap or otherwise move in the scene, re-enable it for the frame range when it is in camera view.

Smoothing of Cloth
Now, if you followed this from the previous section, your cloth is probably looking a little blocky. In order to
make it look nice and smooth like the picture you need to apply a Smooth and/or Subsurf modifier in the
Modifiers panel under the Editing context. Then, in the same context, find the Links and Materials panel (the
same one you used for vertex groups) and press Set Smooth.
Now, if you press Alt-A, things are starting to look pretty nice, don’t you think?
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Cloth on armature
Cloth deformed by armature and also respecting an additional collision object: Regression blend file.

Cloth with animated vertex groups
Cloth with animated pinned vertices: Regression blend file. UNSUPPORTED: Starting with a goal of 0 and
increasing it, but still having the vertex not pinned will not work (e.g. from goal = 0 to goal = 0.5).

Cloth with Dynamic Paint
Cloth with Dynamic Paint using animated vertex groups: Regression blend file. UNSUPPORTED: Starting with
a goal of 0 and increasing it, but still having the vertex not pinned will not work (e.g. from goal = 0 to goal =
0.5) because the necessary “goal springs” cannot be generated on the fly.

Using Cloth for Softbodies

Using cloth for softbodies.

Cloth can also be used to simulate softbodies. It’s for sure not its main purpose but it works nonetheless. The
example image uses standard Rubber material, no fancy settings, just Alt-A.
Blend file for the example image: Using Cloth for softbodies.

Cloth with Wind

Flag with wind applied.

Regression blend file for Cloth with wind and self collisions (also the blend for the image above): Cloth flag
with wind and selfcollisions.
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Dynamic Paint
Dynamic paint is a new modifier and physics system that can turn objects into paint canvases and brushes,
creating vertex colors, image sequences or displacement. This makes many effects possible that were
previously difficult to achieve, for example footsteps in the snow, raindrops that make the ground wet, paint
that sticks to walls, or objects that gradually freeze.
This guide explains the very basics of Dynamic Paint user interface and general features.

How to activate the Dynamic Paint

Activating the modifier
Dynamic Paint can be activated from the “Physics” tab of the “Properties” editor.
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Types
Modifier itself has two different types:
Canvas
Makes object receive paint from Dynamic Paint brushes.
Brush
Makes object apply paint on the canvas.
Note
You can also enable brush and canvas simultaneously. In that case same object’s “brush” doesn’t influence it’s
“canvas”, but can still interact with other objects in the scene.

See also
• A step-by step introduction
• A detailed guide that covers every setting with images and examples (Currently not up-to-date)

Dynamic Paint Brush
Main Panel

Brush main panel

From the first brush panel you can define how brush affects canvas color surfaces.
Absolute Alpha
This setting limits brush alpha influence. Without it, brush is “added” on surface over and over again each
frame, increasing alpha and therefore influence of brush on canvas. In many cases however, it’s preferred
to not increase brush alpha if it already is on brushes level.
Erase Paint
Makes brush dissolve exiting paint instead of adding it.
Wetness
Defines how “wet” new paint is. Wetness is visible on “Paint” surface “wetmap”. Speed of “Drip” and
“Spread” effects also depends on how wet the paint is.
Use object material
When enabled, you can define a material to be used as brush color. This includes material’s base color and
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all textures linked to it, eventually matching the rendered diffuse color. This setting is only available when
using “Bforartists Internal” renderer at the moment.
Otherwise you can define a color for the brush from the color box below.
Alpha
Defines brush alpha or visibility. Final wetness is also affected by alpha.

Source Panel

Brush source panel

Brush “Source” setting lets you define how brush influence/intersection is defined.
There are currently five brush behavior types to choose from, each having individual settings for further
tweaking:

Brush Source - Volume

Mesh Volume
This the default option. Brush affects all surface point inside the mesh volume.

Brush Source - Proximity. Brush affects all

“Project” setting enabled. See how brush only

canvas pixels around it

affects canvas in normal direction

Proximity
Only uses defined distance to the closest point on brush mesh surface. Note that inside of the volume is
3
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not necessarily affected because it’s not close to the surface.
Proximity falloff type can be “Smooth”, “Sharp” or tweaked with a color ramp.
Project
Projects brush to the canvas from a defined direction. Basically this can be considered as “direction
aligned” proximity.

“Volume + Proximity” brush with no additional

Inner Proximity. Proximity falloff is now visible

settings

inside the volume

Negate Volume. Inner side of the volume has

Inner Proximity and Negate Volume enabled

become completely transparent

together

Mesh Volume + Proximity
Same as volume type, but also has influence over defined distance. Same falloff types as for “Proximity”
type are available.
Inner Proximity
Applies proximity inside the mesh volume.
Negate Volume
Negates brush alpha within mesh volume.

Brush Source - Object Center

Object Center
Instead of calculating proximity to the brush object mesh, which can be quite slow in some cases, only
distance to only center is calculated. This is much faster and often good enough.
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Brush Source - Particle System

Particle System
Brush influence is defined by particles from a selected particle system.

Velocity Panel

Velocity panel

This panel shows brush options that are based on object velocity.
On top you have a color ramp and several related settings. Basically the color ramp represents brush velocity
values: left side being zero velocity and right side being the “Max velocity”. Speed is measured in “Bforartists
units per frame”.
Tick boxes above can be used to define color ramp influence.
Multiply Alpha
Uses color ramp’s alpha value depending on current velocity and multiplies brush alpha with it.
Replace Color
Replaces the brush color with the ramp color.
Multiply Depth
Multiplies brushes “depth intersection” effect. Basically you can adjust displace and wave strength
depending on brush speed.
Smudge settings
Enabling Smudge makes the brush “smudge” (or “smear”) existing colors on the surface as it moves. The
strength of this effect can be defined from the “Smudge Strength” property.
Even when smudge is enabled brush still does it’s normal paint effect. If you want a purely smudging
brush use zero alpha. It’s also possible to have “Erase” option enabled together with smudge.
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Waves Panel

Brush Waves panel

This panel is used to adjust brush influence to “Wave” surfaces.
You can use “Wave Type” menu to select what effect this brush has on the wave simulation. Below are two
settings for further adjustments.
Factor
Adjusts how strongly brush “depth” affects the simulation. You can also use negative values to make
brush pull water up instead of down.
Clamp Waves
In some cases the brush goes very deep inside the surface messing whole simulation up. You can use this
setting to “limit” influence to only certain depth.
There are four “Wave Type” options available:
Depth Change
This option makes brush create waves when the intersection depth with the surface is changed on that
point. If the brush remains still it won’t have influence.
Using a negative “Factor” with this type can create a nice looking “wake” for moving objects like ships.
Obstacle
Constantly affects surface whenever intersecting. Waves are also reflected off this brush type. However,
due the nature of wave simulation algorithm this type creates an unnatural “dent” in the surface if brush
remains still.
Force
Directly affects the velocity of wave motion. Therefore the effect isn’t one to one with brush intersection
depth, yet the force strength depends on it.
Reflect Only
This type has no visible effect on the surface alone but reflects waves that are already on the surface.

Dynamic Paint Canvas
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Main Panel

Canvas main panel

The first panel of canvas contains the list of Dynamic Paint surfaces. These surfaces are basically layers of
paint, that work independently from each other. You can define individual settings for them and bake them
separately.
If surface type/format allows previewing results in 3D-viewport, an eye icon is visible to toggle preview.
The checkbox toggles whether surface is active at all. If not selected, no calculations or previews are done.
You can also give each surface an unique name to easily identify them.
Below you can set surface type and adjust quality and timing settings.
Each surface has a certain format and type. Format determines how data is stored and outputted. Currently there
are two formats available:
• Image Sequences. Dynamic Paint generates UV wrapped image files of defined resolution as output.
• Vertex. Dynamic Paint operates directly on mesh vertex data. Results are stored by point cache and can
be displayed in viewports. However, using vertex level also requires a highly subdivided mesh to work.
From quality settings you can adjust image resolution (for image sequences) and anti-aliasing.
Then you can define surface processing start and end frame, and number of used sub-steps. Sub-steps are extra
samples between frames, usually required when there is a very fast brush.
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Advanced Panel

Canvas advanced panel

From “Advanced” panel you can adjust surface type and related settings.
Each surface has a “type” that defines what surface is used for. Available types are:
•
•
•
•

Paint
Displace
Waves
Weight

Common options
For each surface type there are special settings to adjust. Most types have the settings Dissolve and Brush :
Dissolve
used to make the surface smoothly return to its original state during a defined time period
Brush Group
used to define a specific object group to pick brush objects from

Paint

Paint Surface

“Paint” is the basic surface type that outputs color and wetness values. In case of vertex surfaces results are
outputted as vertex colors.
Wetmap is a black-and-white output that visualizes paint wetness. White being maximum wetness, black being
8
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completely dry. It is usually used as mask for rendering. Some “paint effects” affect wet paint only.

Displace

Displace Surface

This type of surface outputs intersection depth from brush objects.
Tip
If the displace output seems too rough it usually helps to add a “Smooth” modifier after Dynamic Paint in the
modifier stack.

Waves

Waves Surface

This surface type produces simulated wave motion. Like displace, wave surface also uses brush intersection
depth to define brush strength.
You can use following settings to adjust the motion:
Open Borders
Allows waves to pass through mesh “edges” instead of reflecting from them.
Timescale
Directly adjusts simulation speed without affecting simulation outcome. Lower values make simulation
go slower and otherwise.
Speed
Affects how fast waves travel on the surface. This setting is also corresponds to the size of the simulation.
Half the speed equals surface double as large.
9
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Damping
Reduces the wave strength over time. Basically adjusts how fast wave disappears.
Spring
Adjusts the force that pulls water back to “zero level”.
Tip
In some cases the wave motion gets very unstable around brush. It usually helps to reduce wave speed, brush
“wave factor” or even the resolution of mesh/surface.

Weight

Weight Surface

This is a special surface type only available for vertex format. It outputs vertex weight groups that can be used
by other Bforartists modifiers and tools.
Tip
It’s usually preferred to use “proximity” based brushes for weight surfaces to allow smooth falloff between
weight values.

Output Panel

Canvas output panel

From “Output” panel you can adjust how surface outputs its results.
For “Vertex” format surfaces, you can select a mesh data layer (color / weight depending on surface type) to
generate results to. You can use the “+”/”-” icons to add/remove a data layers of given name. If layer with given
name isn’t found, it’s shown as red.
For “Image Sequence” surfaces, you can define used “UV Layer” and output file saving directory, filenames
10
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and image format.

Effects Panel

Canvas effects panel

This is a special feature for “Paint” type surface. It generates animated movement on canvas surface.
Effects:
Spread
Paint slowly spreads to surrounding points eventually filling all connected areas.
Drip
Paint moves in specific direction specified by Bforartists force fields, gravity and velocity with user
defined influences.
Shrink
Painted area slowly shrinks until disappears completely.
For spread and drip effects, only “wet paint” is affected, so as the paint dries, movement becomes slower until it
stops.

Cache Panel

Canvas cache panel

This panel is currently only visible for “vertex” format surfaces. You can use it to adjust and bake point cache.
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Fluid Simulation
Fluid physics are used to simulate physical properties of liquids especially water. While creating a scene in
Bforartists, certain objects can be marked to participate in the fluid simulation. These can include but not
limited to, being a fluid or as an obstacle. For a fluid simulation you have to have a domain to define the space
that the simulation takes up. In the domain settings you will be be able to define the global simulation
parameters (such as viscosity and gravity).
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Example of Fluid Simulation

Workflow
In general, you follow these steps:
First you want to set the simulation domain,
Next set the fluid source(s), and specify there physical properties,
In some cases you may want to set other objects to Control the Flow of the fluid,
You can also depending on your scene add other objects related to the fluid, like:
• Obstacles,
• Particles floating on the fluid,
• And lastly you must Bake the Simulation.
•
•
•
•

Tip
Baking is done on the Domain object!
When you calculate the fluid simulation, you bake the simulation on the domain object.
For this reason:
• All the baking options are visible only when selecting the Domain Object,
• Baking options are explained in the the baking section of the Domain manual page.
See also
To know more about simulating fluids in Bforartists you can read the fluids appendix. Their you can find the
limitations and workarounds, and some additional links.

Fluid Types
Common Options
Animated Mesh/Export
Click this button if the network is animated (eg . Deformed by an armature , shape keys (shape keys) or lattice).
It can become very slow and is not necessary if the network is animated IPO position and rotation (ie only
object transformations).

Volume Initialization Type
A common option amoung the different fluid types is Volume Initialization.
Volume
The inside of the object is initialized as fluid all . This works only if the closed mesh .
2
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Shell
It is initialized as a thin fluid layer of the surface of the mesh . This can also be used in the
mesh open.
Both
It is a state , such as the sum of the Volume and Shell. This also must be a closed mesh.

Example of different types of initiation of volume

Fluid Domain
The Domain Object
The bounding box of the object serves as the boundary of the simulation. All fluid objects must be in the
domain. Fluid objects outside the domain will not bake. No tiny droplets can move outside this domain; it’s as
if the fluid is contained within the 3D space by invisible force fields. There can be only a single fluid simulation
domain object in the scene.
The shape of the object does not matter because it will always be treated like a box (The lengths of the
bounding box sides can be different). So, usually there won’t be any reason to use another shape than a box. If
you need obstacles or other boundaries than a box to interfere with the fluid flow, you need to insert additional
obstacle objects inside the domain boundary.
This object will be replaced by the fluid during the simulation.

Tip
Baking is done on the Domain object
When you calculate the fluid simulation, you bake the simulation on the domain object. For this reason all
the baking options are visible only when selecting the Domain Object.
For baking options, see Baking.

3

Bforartists Reference Manual - © Copyright - This page is under OCL license

Options

The fluid simulation options with Domain selected

Bake button
For baking options, see Baking.
Resolution
Render resolution
The granularity at which the actual fluid simulation is performed. This is probably the most
important setting for the simulation as it determines the amount of details in the fluid, the
memory and disk usage as well as computational time.

10cm mug at Resolution 70.

10cm mug at Resolution 200.

Note that the amount of required memory quickly increases: a resolution of 32 requires ca.
4MB, 64 requires ca. 30MB, while 128 already needs more than 230MB. Make sure to set the
resolution low enough, depending on how much memory you have, to prevent Bforartists
from crashing or freezing. Remember also that many operating systems limit the amount of
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memory that can be allocated by a single process, such as Bforartists, even if the machine
contains much more than this. Find out what limitations apply to your machine.

Note
Resolution and Real-size of the Domain
Be sure to set the resolution appropriate to the real-world size of the domain (see the Realworldsize in the Domain World). If the domain is not cubic, the resolution will be taken for the longest
side. The resolutions along the other sides will be reduced according to their lengths (therefore, a
non-cubic domain will need less memory than a cubic one, resolutions being the same).

Preview resolution
This is the resolution at which the preview surface meshes will be generated. So it does
not influence the actual simulation. Even if “there is nothing to see” in the preview,
there might be a thin fluid surface that cannot be resolved in the preview.
Display quality
How to display a baked simulation in the 3d view (menu Viewport Display) and for rendering (menu
Render Display):
Geometry
use the original geometry (before simulation).
Preview
use the preview mesh.
Final
use the final high definition mesh.
When no baked data is found, the original mesh will be displayed by default.
After you have baked a domain, it is displayed (usually) in the Bforartists window as the preview mesh.
To see the size and scope of the original domain box, select Geometry in the left dropdown.
Time
Start
It is the simulation start time (in seconds).
This option makes the simulation computation in Bforartists start later in the simulation. The
domain deformations and fluid flow prior to the start time are not saved.
For example, if you wanted the fluid to appear to already have been flowing for 4 seconds before
the actual first frame of data, you would enter 4.0 here.
End
It is the simulation ending time (in seconds).

5
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Tip
Start and end times have nothing to do with how many frames are baked
If you set Start time to 3.0, and End time to 4.0, you will simulate 1 second of fluid motion. That one
second of fluid motion will be spread across however-many frames are set in the Anim panel (Scene
context –> Render sub-context –> Anim and Output panel).
This means, for example, that if you have Bforartists set to make 250 frames at 25 fps, the fluid will look
like it had already been flowing for 3 seconds at the start of the simulation, but will play in slow motion
(one-tenth normal speed), since the 1 second fluid sim plays out over the course of 10 video seconds. To
correct this, change the end time to 13.0 (3.0 + 10.0) to match the 250 frames at 25 fps. Now, the
simulation will be real-time, since you set 10 seconds of fluid motion to simulate over 10 seconds of
animation. Having these controls in effect gives you a “speed control” over the simulation.

Generate Speed Vector
If this button is clicked, no speed vectors will be exported. So by default, speed vectors are generated and
stored on disk. They can be used to compute image based motion blur with the compositing nodes.
Reverse fluid frames
The simulation is calculated backward
Bake directory
For baking options see Baking.

Domain World

The Domain World options.

Viscosity
The “thickness” of the fluid and actually the force needed to move an object of a certain surface area
through it at a certain speed. You can either enter a value directly or use one of the presets in the drop
down (such as honey, oil, or water).
For manual entry, please note that the normal real-world viscosity (the so-called dynamic viscosity) is
measured in Pascal-seconds (Pa.s), or in Poise units (P, equal to 0.1 Pa.s, pronounced pwaz, from the
Frenchman Jean-Louis Poiseuille, who discovered the laws on “the laminar flow of viscous fluids”), and
commonly centiPoise units (cP, equal to 0.001 Pa.s, sentipwaz). Bforartists, on the other hand, uses the
kinematic viscosity (which is dynamic viscosity in Pa.s, divided by the density in kg.m -3, unit m2 .s-1).
The table below gives some examples of fluids together with their dynamic and kinematic viscosities.
6
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Manual entries are specified by a floating point number and an exponent. These floating point and
exponent entry fields (scientific notation) simplify entering very small or large numbers. The viscosity of
water at room temperature is 1.002 cP, ou 0.001002 Pa.s; the density of water is about 1000 kg.m -3,
which gives us a kinematic viscosity of 0.000001002 m 2.s -1 - so the entry would be 1.002 times 10 to
the minus six (1.002?10-6 in scientific notation). Hot Glass and melting iron is a fluid, but very thick;
you should enter something like 1.0?100 (= 1.0) as its kinematic viscosity (indicating a value of 1.0?
106 cP).
Note that the simulator is not suitable for non-fluids, such as materials that do not “flow”. Simply setting
the viscosity to very large values will not result in rigid body behavior, but might cause instabilities.

Note
Viscosity varies
The default values in Bforartists are considered typical for those types of fluids and “look right” when
animated. However, actual viscosity of some fluids, especially sugar-laden fluids like chocolate syrup and
honey, depend highly on temperature and concentration. Oil viscosity varies by SAE rating. Glass at room
temperature is basically a solid, but glass at 1500 degrees Celsius flows (nearly) like water.

Bforartists Viscosity Unit Conversion.

kinematic viscosity (Bforartists, in
Fluid

m 2.s -1)

dynamic viscosity (in cP)

Water (20- C)

1.002×10 0 (1.002)

1.002×10 -6 (0.000001002)

Oil SAE 50

5.0×10 2 (500)

5.0×10 -5 (0.00005)

Honey (20- C)

1.0×10 4 (10,000)

2.0×10 -3 (0.002)

Chocolate Syrup

3.0×10 4 (30,000)

3.0×10 -3 (0.003)

Ketchup

1.0×10 5 (100,000)

1.0×10 -1 (0.1)

Melting Glass

1.0×10 15

1.0×10 0 (1.0)

Realworld-size
Size of the domain object in the real world in meters. If you want to create a mug of coffee, this might be
10 cm (0.1 meters), while a swimming pool might be 10m. The size set here is for the longest side of the
domain bounding box.
Optimization
Gridlevel
How many adaptive grid levels to be used during simulation - setting this to -1 will perform
automatic selection.
Compressibility
7
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If you have problems with large standing fluid regions at high resolution, it might help to
reduce this number (note that this will increase computation times).

Domain Boundary

The Domain Boundary panel

This box has all the slip and surface options.
Boundary type
The stickiness of the surface of the obstacle, to determine the “tacky surface (Surface Adhesion).” In the
real world, and the tackiness and fluid, the granularity of the object surface, tack, determined by the
elasticity.
No Slip
Fluid will stick To snugly (speed 0).
Free Slip
Fluid will move on the object (0 normal direction of speed).
Part Slip
It is a two intermediate. It is almost Noslip, 1 in the Free exactly the same in 0.
Surface
Surface Smoothing
Amount of smoothing to be applied to the fluid surface. 1.0 is standard, 0 is off, while larger
values increase the amount of smoothing.
Subdivisions
Allows the creation of high-res surface meshes directly during the simulation (as opposed to
doing it afterwards like a subdivision modifier). A value of 1 means no subdivision, and each
increase results in one further subdivision of each fluid voxel. The resulting meshes thus
quickly become large, and can require large amounts of disk space. Be careful in combination
with large smoothing values - this can lead to long computation times due to the surface mesh
generation.
Hide fluid surface

Domain Particles

The Domain Particles Panel
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Here you can add particles to the fluid simulated, to enhance the visual effect.
Tracer Particles
Number of tracer particles to be put into the fluid at the beginning of the simulation. To display them
create another object with the Particle fluid type, explained below, that uses the same bake directory as
the domain.
Generate Particles
Controls the amount of fluid particles to create (0=off, 1=normal, >1=more). To use it, you have to have a
surface subdivision value of at least 2.

An example of the effect of particles can be seen here - the image to the left was simulated without, and the right one with
particles and subdivision enabled.

Fluid Object

Fluid object settings

All regions of this object that are inside the domain bounding box will be used as actual fluid in the simulation.
If you place more than one fluid object inside the domain, they should currently not intersect. Also make sure
the surface normals are pointing outwards. In contrast to domain objects, the actual mesh geometry is used for
fluid objects.
Volume Initialization Type
See Volume Initialization Type
Animated Mesh/Export
See Animated Mesh/Export
Initial velocity
Speed of the fluid at the beginning of the simulation, in meters per second.
9
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Tip
The direction of Surface Normals makes a big difference!
Bforartists uses the orientation of the Surface Normals to determine what is “inside of” the Fluid object and
what is “outside”. You want all of the normals to face outside. If the normals face the wrong way, you’ll be
rewarded with a “gigantic flood of water” because Bforartists will think that the volume of the object is
outside of its mesh! This applies regardless of the Volume init type setting.

Fluid Obstacle
This object will be used as an obstacle in the simulation. As with a fluid object, obstacle objects currently
should not intersect. As for fluid objects, the actual mesh geometry is used for obstacles. For objects with a
volume, make sure that the normals of the obstacle are calculated correctly, and radiating properly (use the Flip
Normal button, in Edit mode, Mesh Tools panel, Editing context), particularly when using a spinned container.
Applying a SubSurf Modifier before baking the simulation could also be a good idea if the mesh is not
animated.
Volume Initialization Type
See Volume Initialization Type
Boundary type
Determines the stickiness of the obstacle surface, called “Surface Adhesion”. Surface Adhesion depends
in real-world on the fluid and the graininess or friction/adhesion/absorption qualities of the surface.
No Slip
Causes the fluid to stick to the obstacle (zero velocity).
Free Slip
Allows movement along the obstacle (only zero normal velocity).
Part Slip
Mixes both types, with 0 being mostly no slip, and 1 being identical to free slip.
Note that if the mesh is moving, it will be treated as no slip automatically.

Example of the different boundary types for a drop falling onto the slanted wall. From left to right: no-slip, part-slip 0.3, partslip 0.7 and free-slip.

Animated Mesh/Export
See Animated Mesh/Export
PartSlip Amount
10
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Amount of mixing between no- and free-slip, described above.
Impact Factor
Amount of fluid volume correction for gain/loss from impacting with moving objects. If this object is not
moving, this setting has no effect. However, it if is and the fluid collides with it, a negative value takes
volume away from the Domain, and a positive number adds to it. Ranges from -2.0 to 10.0.

Fluid Inflow / Outflow
To control the volume of the fluid simulation, you can set objects in the scene to add or absorb fluid within the
Fluid Domain.

Inflow

Fluid Inflow Settings

Volume Initialization Type
See Volume Initialization Type
This object will put fluid into the simulation, like a water tap.
Inflow Velocity
Speed of the fluid that is created inside of the object.
Local Coords/Enable
Use local coordinates for the inflow. This is useful if the inflow object is moving or rotating, as the inflow
stream will follow/copy that motion. If disabled, the inflow location and direction do not change.
Animated Mesh/Export
See Animated Mesh/Export

Outflow
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Fluid Outflow Settings

Any fluid that enters the region of this object will be deleted (think of a drain or a black hole). This can be
useful in combination with an inflow to prevent the whole domain from filling up. When enabled, this is like a
tornado (waterspout) or “wet vac” vacuum cleaner, and the part where the fluid disappears will follow the
object as it moves around.
Volume Initialization Type
See Volume Initialization Type
Animated Mesh/Export
See Animated Mesh/Export

Fluid Particle

Fluid particle settings

This type can be used to display particles created during the simulation. For now only tracers swimming along
with the fluid are supported. Note that the object can have any shape, position or type - once the particle button
is pressed, a particle system with the fluid simulation particles will be created for it at the correct position.
When moving the original object, it might be necessary to delete the particle system, disable the fluidsim
particles, and enable them again. The fluidsim particles are currently also unaffected by any other particle
forces or settings.
Influence
Size Influence
The particles can have different sizes, if this value is 0 all are forced to be the same size.
Alpha Influence
If this value is >0, the alpha values of the particles are changed according to their size.
Particle type
Drops
Surface splashes of the fluid result in droplets being strewn about, like fresh water, with low
Surface Tension.
Floats
The surface tension of the fluid is higher and the fluid heavier, like cold seawater and soup.
Breakaways are clumpier and fall back to the surface faster than Drops, as with high Surface
Tension.
Tracer
Droplets follow the surface of the water where it existed, like a fog suspended above previous fluid
levels. Use this to see where the fluid level has been.
12
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Path (bake directory)
The simulation run from which to load the particles. This should usually have the same value as the fluid
domain object

Fluid Control
Description
Using the Lattice-boltzman method, the fluid is controlled using particles which define local force fields and
are generated automatically from either a physical simulation or a sequence of target shapes. At the same time,
as much as possible of the natural fluid motion is preserved.

Examples
In this examples, we use the Fluid Control option to control part of the fluid so that it has a certain shape (the
sphere drop or the teapot drop) before it falls in the rest of the fluid:

Falling drop

“Magic Fluid Control”
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Options

Fluid control options.

Quality
Higher quality result in more control particles for the fluid control object.
Reverse Frames
The control particle movement gets reversed.
Time
You specify the start and end time during which time the fluid control object is active.
Attraction force
The attraction force specifies the force which gets emitted by the fluid control object. Positive force
results in attraction of the fluid, negative force in avoidance.
Velocity force
If the fluid control object moves, the resulting velocity can also introduce a force to the fluid.

Baking

The fluid simulation options with Domain selected
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Bake Button
Perform the actual fluid simulation. Bforartists will continue to work normally, except there will be a status bar
in the top of the window, next to the render pulldown. Pressing Esc or the “x” next to the status bar will abort
the simulation. Afterwards two .bobj.gz (one for the Final quality, one for the Preview quality), plus one
.bvel.gz (for the Final quality) will be in the selected output directory for each frame.

Bake directory
Directory and file prefix to store baked surface meshes.
This is similar to the animation output settings, only selecting a file is a bit special: when you select any of the
previously generated surface meshes (e.g. test1_fluidsurface_final_0132.bobj.gz), the prefix
will be automatically set (test1_ in this example). This way the simulation can be done several times with
different settings, and allows quick changes between the different sets of surface data.

Notes
Unique domain
Because of the possibility of spanning and linking between scenes, there can only be one domain in an
entire .blend file.
Selecting a Baked Domain
After a domain has been baked, it changes to the fluid mesh. To re-select the domain so that you can bake
it again after you have made changes, go to any frame and select (RMB) the fluid mesh. Then you can
click the BAKE button again to recompute the fluid flows inside that domain.
Baking always starts at Frame #1
The fluid simulator disregards the Start setting in the Animation panel, it will always bake from frame 1.
If you wish the simulation to start later than frame 1, you must key the fluid objects in your domain to be
inactive until the frame you desire to start the simulation.
Baking always ends at the End Frame set in the Animation panel
If your frame-rate is 25 frames per second, and ending time is 4.0 seconds, then you should (if your start
time is 0) set your animation to end at frame 4.0 × 25 = 100
Freeing the previous baked solutions
Deleting the content of the “Bake” directory is a destructive way to achieve this. Be careful if more than
one simulation uses the same bake directory (be sure they use different filenames, or they will overwrite
one another)!
Reusing Bakes
Manually entering (or searching for) a previously saved (baked) computational directory and filename
mask will switch the fluid flow and mesh deformation to use that which existed during the old bake.
Thus, you can re-use baked flows by simply pointing to them in this field.
Baking processing time
Baking takes a lot of compute power (hence time). Depending on the scene, it might be preferable to bake
overnight.
If the mesh has modifiers, the rendering settings are used for exporting the mesh to the fluid solver.
Depending on the setting, calculation times and memory use might exponentially increase. For example,
when using a moving mesh with Subsurf as an obstacle, it might help to decrease simulation time by
switching it off, or to a low subdivision level. When the setup/rig is correct, you can always increase
settings to yield a more realistic result.
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Fluid Appendix
Hints
Some useful hints about fluid simulation in Bforartists:
• Don’t be surprised, but you’ll get whole bunch of mesh (.bobj.gz) files after a simulation. One set for
preview, and another for final. Each set has a .gz file for each frame of the animation. Each file contains
the simulation result - so you’ll need them.
• Currently these files will not be automatically deleted, so it is a good idea to e.g. create a dedicated
directory to keep simulation results. Doing a fluid simulation is similar to clicking the ANIM button you currently have to take care of organizing the fluid surface meshes in some directory yourself. If you
want to stop using the fluid simulation, you can simply delete all the *fluid*.bobj.gz files.
• Before running a high resolution simulation that might take hours, check the overall timing first by
doing lower resolution runs.
• Fluid objects must be completely inside the bounding box of the domain object. If not, baking may not
work correctly or at all. Fluid and obstacle objects can be meshes with complex geometries. Very thin
objects might not appear in the simulation, if the chosen resolution is too coarse to resolve them
(increasing it might solve this problem).
• Don’t try to do a complicated scene all at once. Bforartists has a powerful compositor that you can use
to combine multiple animations.
For example, to produce an animation showing two separate fluid flows while keeping your
domain small, render one .avi using the one flow. Then move the domain and render
another .avi with the other flow using an alpha channel (in a separate B&W .avi?). Then,
composite both .avi’s using the compositor’s add function. A third .avi is usually the
smoke and mist and it is laid on top of everything as well. Add a rain sheet on top of the mist
and spray and you’ll have quite a storm brewing! And then lightning flashes, trash blowing
around, all as separate animations, compositing the total for a truly spectacular result.

Limitations & Workarounds
• If the setup seems to go wrong, make sure all the normals are correct (hence, enter Edit mode, select all,
and recalculate normals once in a while).
• Currently there’s a problem with zero gravity simulation - simply select a very small gravity until this is
fixed.
• If an object is initialized as Volume, it has to be closed and have an inner side (a plane won’t work). To
use planes, switch to Shell, or extrude the plane.
• Bforartists freezes after clicking BAKE. Pressing Esc makes it work again after a while - this can
happen if the resolution is too high and memory is swapped to hard disk, making everything horribly
slow. Reducing the resolution should help in this case.
• Bforartists crashes after clicking BAKE - this can happen if the resolution is really high and more than
2GB are allocated, causing Bforartists to crash. Reduce the resolution. Many operating systems limit the
16
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•

•
•

•
•

total amount of memory that can be allocated by a process, such as Bforartists, even if the machine has
more memory installed.
The meshes should be closed, so if some parts of e.g. a fluid object are not initialized as fluid in the
simulation, check that all parts of connected vertices are closed meshes. Unfortunately, the Suzanne
(monkey) mesh in Bforartists is not a closed mesh (the eyes are separate).
If the fluid simulation exits with an error message (stating e.g. that the “init has failed”), make sure you
have valid settings for the domain object, e.g. by resetting them to the defaults.
Note that first frame may well take only a few hundred MBs of RAM memory, but latter ones go over
one GB, which may be why your bake fails after awhile. If so, try to bake one frame at the middle or
end at full res so you’ll see if it works.
Memory used doubles when you set surface subdivision from 1 to 2.
Using “generate particles” will also add memory requirements, as they increase surface area and
complexity. Ordinary fluid-sim generated particles probably eat less memory.
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Particles
Particles are lots of items emitted from mesh objects, typically in the thousands. Each particle can be a point of
light or a mesh, and be joined or dynamic. They may react to many different influences and forces, and have the
notion of a lifespan. Dynamic particles can represent fire, smoke, mist, and other things such as dust or magic
spells.
Hair type particles are a subset of regular particles. Hair systems form strands that can represent hair, fur, grass
and bristles.
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You see particles as a Particle modifier, but all settings are done in the Particle tab.

Some fur made from particles

Particles generally flow out from their mesh into space. Their movement can be affected by many things,
including:
Initial velocity out from the mesh.
Movement of the emitter (vertex, face or object) itself.
Movement according to “gravity” or “air resistance”.
Influence of force fields like wind, vortexes or guided along a curve.
Interaction with other objects like collisions.
Partially intelligent members of a flock (herd, school, ...), that react to other members of their flock,
while trying to reach a target or avoid predators.
• Smooth motion with softbody physics (only Hair particle systems).
• Or even manual transformation with Lattices.
•
•
•
•
•
•

Particles may be rendered as:
• Halos (for Flames, Smoke, Clouds).
• Meshes which in turn may be animated (e.g. fish, bees, ...). In these cases, each particle “carries”
another object.
• Strands (for Hair, Fur, Grass); the complete way of a particle will be shown as a strand. These strands
can be manipulated in the 3D window (combing, adding, cutting, moving, etc).
Every object may carry many particle systems. Each particle system may contain up to 100. 000 particles.
Certain particle types (Hair and Keyed) may have up to 10.000 children for each particle (children move and
emit more or less like their respective parents). The size of your memory and your patience are your practical
boundaries.

Workflow
The process for working with standard particles is:
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• Create the mesh which will emit the particles.
• Create one or more Particle Systems to emit from the mesh. Many times, multiple particle systems
interact or merge with each other to achieve the overall desired effect.
• Tailor each Particle System’s settings to achieve the desired effect.
• Animate the base mesh and other particle meshes involved in the scene.
• Define and shape the path and flow of the particles.
• For Hair particle systems: Sculpt the emitter’s flow (cut the hair to length and comb it for example).
• Make final render and do physics simulation(s), and tweak as needed.

Creating a Particle System

Adding a particle system.

To add a new particle system to an object, go to the Particles tab of the object Settings editor and click the
small + button. An object can have many Particle Systems.
Each particle system has separate settings attached to it. These settings can be shared among different particle
systems, so one doesn’t have to copy every setting manually and can use the same effect on multiple objects.
Using the Random property they can be randomized to look slightly different, even when using the same
settings.

Types of Particle systems

Particle System Types.

After you have created a particle system, the Property window fills with many panels and buttons. But don’t
panic! There are two different types of particle systems, and you can change between these two with the Type
drop-down list:
Emitter
This parallels the old system to the greatest extent. In such a system, particles are emitted from the
selected object from the Start frame to the End frame and have a certain lifespan.
Hair
This system type is rendered as strands and has some very special properties: it may be edited in the 3D
window in realtime and you can also animate the strands with Cloth Simulation.
The settings in the Particle System panel are partially different for each system type. For example, in Image 3
they are shown for only system type Emitter.

4

Bforartists Reference Manual - © Copyright - This page is under OCL license

Common Options
Each system has the same basic sets of controls, but options within those sets vary based on the system
employed. These sets of controls are:
Emission
Settings for the initial distribution of particles on the emitter and the way they are born into the scene.
Cache
In order to increase realtime response and avoid unnecessary recalculation of particles, the particle data
can be cached in memory or stored on disk.
Velocity
Initial speed of particles.
Rotation
Rotational behavior of particles.
Physics
How the movement of the particles behaves.
Render
Rendering options.
Display
Realtime display in the 3D View.
Children
Control the creation of additional child particles.
Field Weights
Factors for external forces.
Force Field Settings
Makes particles force fields.
Vertex Groups
Influencing various settings with vertex groups.

Particle Emission
The Emitter system works just like its name says: it emits/produces particles for a certain amount of time. In
such a system, particles are emitted from the selected object from the Start frame to the End frame and have a
certain lifespan. These particles are rendered default as Halos, but you may also render these kind of particles
as objects (depending on the particle system’s render settings, see Visualization).

5
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Options

Particle Emission Settings

The buttons in the Emission panel control the way particles are emitted over time:
Amount
The maximum amount of parent particles used in the simulation.
Start
The start frame of particle emission. You may set negative values, which enables you to start the
simulation before the actual rendering.
End
The end frame of particle emission.
Lifetime
The lifetime (in frames) of the particles.
Random
A random variation of the lifetime of a given particle. The shortest possible lifetime is Lifetime ×(1Rand ). Values above 1.0 are not allowed. For example with the default Lifetime value of 50 a Random
setting of 0.5 will give you particles with lives ranging from 50 frames to 50×(1.0-0.5) =25 frames,
and with a Random setting of 0.75 you’ll get particles with lives ranging from 50 frames to 50×(1.00.75) =12.5 frames.

Emission Location
Emit From parameters define how and where the particles are emitted, giving precise control over their
distribution. You may use vertex groups to confine the emission, that is done in the Vertexgroups panel.
Verts
Emit particles from the vertices of a mesh.
Faces
Emit particles from the surface of a mesh’s faces.
Volume
Emit particles from the volume of an enclosed mesh.

Distribution Settings
These settings control how the emissions of particles are distributed throughout the emission locations
Random
6
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The emitter element indices are gone through in a random order instead of linearly (one after the other).
For Faces and Volume, additional options appear:
Even Distribution
Particle distribution is made even based on surface area of the elements, i.e. small elements emit less
particles than large elements, so that the particle density is even.
Jittered
Particles are placed at jittered intervals on the emitter elements.
Particles/Face
Number of emissions per face (0 = automatic).
JitteringAmount
Amount of jitter applied to the sampling.
Random
Particles are emitted from random locations in the emitter’s elements.
Grid
Particles are set in a 3d grid and particles near/in the elements are kept.
Invert Grid
Invert what is considered the object and what is not.
Hexagonal
Uses a hexagonal shaped grid instead of a rectangular one.
Resolution
Resolution of the grid.
Random
Add a random offset to grid locations.
Tip
Your mesh must be manifold to emit particles from the volume.
Some modifiers like Edge Split break up the surface, in which case volume emission will not work correctly!

Use Modifier Stack
Take any Modifiers above the particle modifier in the Modifier Stack into account when emitting
particles.
Note that particles may differ in the final render if these modifiers generate different geometry between
the viewport and render.

Particle Physics
The movement of particles may be controlled in a multitude of ways. With particles physics: there are five
different systems:
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None (No Physics)
It doesn’t give the particles any motion, which makes them belong to no physics system.
Newtonian
Movement according to physical laws.
Keyed
Dynamic or static particles where the (animated) targets are other particle systems.
Boids
Particles with limited artificial intelligence, including behavior and rules programming, ideal for flocks of
birds or schools of fishes, or predators vs preys simulations.
Fluid
Movement according to fluid laws (based on Smoothed Particle Hydrodynamics technique).
Additional ways of moving particles:
• By softbody animation (only for Hair particle systems).
• By forcefields and along curves.
• By lattices.
Here we will discuss only the particle physics in the narrower sense, i.e. the settings in the Physics panel.

Velocity

Image 3: Initial velocity.

The initial velocity of particles can be set through different parameters, based on the type of the particle system
(see Particle System tab). If the particle system type is Emitter or Hair, then the following parameters give the
particle an initial velocity in the direction of...

Emitter Geometry
Normal
The emitter’s surface normals (i.e. let the surface normal give the particle a starting speed).
Tangent
Let the tangent speed give the particle a starting speed.
Rot
Rotates the surface tangent.

Emitter Object
Align X,Y,Z
Give an initial velocity in the X, Y, and Z axes.
Object
8
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The emitter objects movement (i.e. let the object give the particle a starting speed).
Random
Gives the starting speed a random variation. You can use a texture to only change the value, see
Controlling Emission, Interaction and Time).

Rotation

Particles rotation settings.

These parameters specify how the individual particles are rotated during their travel. To visualize the rotation of
a particle you should choose visualization type Axis in the Visualization panel and increase the Draw Size.
Initial Rotation Mode
Sets the initial rotation of the particle by aligning the x-axis in the direction of:
None
the global x-axis.
Normal
Orient to the emitter’s surface normal, the objects Y axis points outwards.
Normal-Tangent
As with normal, orient the Y axis to the surface normal. Also orient the X axis to the tangent for
control over the objects rotation about the normal. requires UV coordinates, the UV rotation effects
the objects orientation, currently uses the active UV layer. This allow deformation without the
objects rotating in relation to their surface.
Velocity
the particle’s initial velocity.
Global X/Global Y/Global Z
one of the global axes
Object X/Object Y/Object Z
one of the emitter object axes.
Random
Randomizes rotation.
Dynamic
If enabled, only initializes particles to the wanted rotation and angular velocity and let’s physics handle
the rest. Particles then change their angular velocity if they collide with other objects (like in the real
world due to friction between the colliding surfaces). Otherwise the angular velocity is predetermined at
all times (i.e. set rotation to dynamic/constant).
Phase
Initial rotation phase
Random
Rand allows a random variation of the Phase.
9
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Angular Velocity
The magnitude of angular velocity, the dropdown specifies the axis of angular velocity to be
None
a zero vector (no rotation).
Spin
the particles velocity vector.
Random
a random vector.
If you use a Curve Guide and want the particles to follow the curve, you have to set Angular Velocity to Spin
and leave the rotation on Constant (i.e. don’t turn on Dynamic). Curve Follow does not work for particles.

Common Physics Settings
Size
Sets the size of the particles.
Random Size
Give the particles a random size variation.
Mass
Specify the mass of the particles.
Multiply mass with particle size
Causes larger particles to have larger masses.

No Physics
At first a Physics type that makes the particles do nothing could seem a bit strange, but it can be very useful at
times. None physics make the particles stick to their emitter their whole life time. The initial velocities here are
for example used to give a velocity to particles that are affected by a harmonic effector with this physics type
when the effect of the effector ends.
Moreover, it can be very convenient to have particles at disposal (whose both Unborn and Died are visible on
render) to groom vegetation and/or ecosystems using Object, Group or Billboard types of visualization.

Field Weights
The Field Weight Panel allows you to control how much influence each type of external force field, or effector,
has on the particle system. Force fields are external forces that give dynamic systems motion. The force fields
types are detailed on the Force Field Page.
Effector Group
Limit effectors to a specified group. Only effectors in this group will have an effect on the current system.
Gravity
Control how much the Global Gravity has an effect on the system.
All
Scale all of the effector weights.

Force Fields
The Force Field Settings Panel allows you to make each individual act as a force field, allowing them to affect
10
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other dynamic systems, or even, each other.
Self Effect
Causes the particle force fields to have an effect on other particles within the same system.
Amount
Set how many of the particles act as force fields. 0 means all of them are effectors.
You can give particle systems up to 2 force fields. By default they do not have any. Choose an effector type
from the dropdowns to enable them. Settings are described on the Force Field Page.

Newtonian Physics
These are the “normal” particle physics. Particles start their life with the specified initial velocities and angular
velocities, and move according to Newtonian forces. The response to environment and to forces is computed
differently, according to any given integrator chosen by the animator.

Forces

Newtonian Physics Settings.

Brownian
Specify the amount of Brownian motion. Brownian motion adds random motion to the particles based on
a Brownian noise field. This is nice to simulate small, random wind forces.
Drag
A force that reduces particle velocity in relation to it’s speed and size (useful in order to simulate AirDrag or Water-Drag).
Damp
Reduces particle velocity (deceleration, friction, dampening).

Collision
Size Deflect
Use the particle size in deflections.
Die on Hit
Kill particle when it hits a deflector object.

11
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Integration
Integrators are a set of mathematical methods available to calculate the movement of particles. The following
guidelines will help to choose a proper integrator, according to the behavior aimed at by the animator.
Euler
Also known as “Forward Euler”. Simplest integrator. Very fast but also with less exact results. If no
dampening is used, particles get more and more energy over time. For example, bouncing particles will
bounce higher and higher each time. Should not be confused with “Backward Euler” (not implemented)
which has the opposite feature, energies decrease over time, even with no dampening. Use this integrator
for short simulations or simulations with a lot of dampening where speedy calculations is more important
than accuracy.
Varlet
Very fast and stable integrator, energy is conserved over time with very little numerical dissipation.
Midpoint
Also known as “2nd order Runge-Kutta”. Slower than Euler but much more stable. If the acceleration is
constant (no drag for example), it is energy conservative. It should be noted that in example of the
bouncing particles, the particles might bounce higher than they started once in a while, but this is not a
trend. This integrator is a generally good integrator for use in most cases.
RK4
Short for “4th order Runge-Kutta”. Similar to Midpoint but slower and in most cases more accurate. It is
energy conservative even if the acceleration is not constant. Only needed in complex simulations where
Midpoint is found not to be accurate enough.

Frame Settings
Timestep
The simulation time step per frame.
Subframes
Subframes to simulate for improved stability and finer granularity in simulations. Use higher values for
faster moving particles.

Keyed Particles

12
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Keyed Physics Settings.

The particle paths of keyed particles are determined from the emitter to another particle system’s particles. This
allows creation of chains of systems with keyed physics to create long strands or groovy moving particles.
Basically the particles have no dynamics but are interpolated from one system to the next at drawtime.

Setup
To setup Keyed particles you need at least two particle systems.
The first system has keyed physics, and it needs the option First activated. This will be the system thats is
visible.
• The second system may be another keyed system but without the option First,
or a normal particle system. This second system is the target of the keyed system.
Loops
Sets the number of times the keys are looped. Disabled if Use Timing is enabled.

Keys
Key Targets
You have to enter the name of the object which bears the target system and if there are multiple particle
systems the number of the system.
Click the Plus to add a key, then select the object.
If you use only one keyed system the particles will travel in their lifetime from the emitter to the target. A
shorter lifetime means faster movement. If you have more than one keyed system in a chain, the lifetime will be
split equally. This may lead to varying particle speeds between the targets.

Timing
Use Timing
Timing works together with the Time slider for the other keyed systems in a chain. The Time slider allows
to define a fraction of particle lifetime for particle movement.
An example: let’s assume that you have two keyed systems in a chain and a third system as target. The particle
lifetime of the first system shall be 50 keys. The particles will travel in 25 frames from the first keyed system to
the second, and in further 25 frames from the second system to the target. If you use the Timed button for the
first system, the Time slider appears in the second systems panel. It’s default value is 0.5, so the time is equally
split between the systems. If you set Time to 1, the movement from the first system to the second will get all the
lifetime (the particles will die at the second system).
If you set Time to 0 the particles will start at the second system and travel to the target.

Boids
13
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Boid Physics Settings.

Boids particle systems can be set to follow basic rules and behaviors. They are useful for simulating flocks,
swarms, herds and schools of various kind of animals, insects and fishes. They can react on the presence of
other objects and on the members of their own system. Boids can handle only a certain amount of information,
therefore the sequence of the Behaviour settings is very important. In certain situations only the first three
parameter are evaluated.
To view the subpanel to the right, add a Particle System of type Emitter and look in the middle area of the
Particle System tab.

Physics
Boids try to avoid objects with activated Deflection. They try to reach objects with positive Spherical fields,
and fly from objects with negative Spherical fields. The objects have to share one common layer to have effect.
It is not necessary to render this common layer, so you may use invisible influences.
Boids can different physics depending on whether they are in the air, or on land (on collision object)
Allow Flight
14
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Allow boids to move in the air.
Allow Land
Allow boids to move on land.
Allow Climbing
Allow boids to climb goal objects.
Max Air Speed
Set the Maximum velocity in the air.
Min Air Speed
Set the Minimum velocity in the air.
Max Air Acceleration
Lateral acceleration in air, percent of max velocity (turn). Defines how fast a boid is able to change
direction.
Max Air Angular Velocity
Tangential acceleration in air, percent 180 degrees. Defines how much the boid can suddenly accelerate in
order to fulfill a rule.
Air Personal Space
Radius of boids personal space in air. Percentage of particle size.
Landing Smoothness
How smoothly the boids land.
Max Land Speed
Set the Maximum velocity on land.
Jump Speed
Maximum speed for jumping
Max Land Acceleration
Lateral acceleration on land, percent of max velocity (turn). Defines how fast a boid is able to change
direction.
Max Land Angular Velocity
Tangential acceleration on land, percent 180 degrees. Defines how much the boid can suddenly accelerate
in order to fulfill a rule.
Land Personal Space
Radius of boids personal space on land. Percentage of particle size.
Land Stick Force
How strong a force must be to start effecting a boid on land.
Banking
Amount of rotation around velocity vector on turns. Banking of (1.0 == natural banking).
Pitch
Amount of rotation around side vector.
Height
Boid height relative to particle size.

Battle
Health
Initial boid health when born.
Strength
Maximum caused damage per second on attack.
Aggression
Boid will fight this times stronger than enemy.
Accuracy
Accuracy of attack.
Range
Maximum distance of which a boid can attack.
15
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Alliance
The relations box allows you to set up other particle systems to react with the boids. Setting the type to Enemy
will cause the systems to fight with each other. Friend will make the systems work together. Neutral will not
cause them to align or fight with each other.

Deflectors and Effectors
As mentioned before, very much like Newtonian particles, Boids will react to the surrounding deflectors and
fields, according to the needs of the animator:
Deflection: Boids will try to avoid deflector objects according to the Collision rule’s weight. It works best for
convex surfaces (some work needed for concave surfaces). For boid physics, Spherical fields define the way the
objects having the field are seen by others. So a negative Spherical field (on an object or a particle system) will
be a predator to all other boids particle systems, and a positive field will be a goal to all other boids particle
systems.
When you select an object with a particle system set on, you have in the Fields tab a little menu stating if the
field should apply to the emitter object or to the particle system. You have to select the particle system name if
you want prey particles to flew away from predator particles.
Spherical fields: These effectors could be predators (negative Strength) that boids try to avoid or targets
(positive Strength) that boids try to reach according to the (respectively) Avoid and Goal rules’ weights.
Spherical’s effective Strength is multiplied by the actual relevant weight (e.g. if either Strength or Goal is null,
then a flock of boids won’t track a positive Spherical field). You can also activate Die on hit (Extras panel) so
that a prey particle simply disappears when “attacked” by a predator particle which reaches it. To make this
work, the predator particles have to have a spherical field with negative force, it is not sufficient just to set a
positive goal for the prey particles (but you may set the predators force strength to -0.01). The size of the
predators and the prey can be set with the Size button in the Extras panel.

Boid Brain
The Boid Brain panel controls how the boids particles will react with each other. The boids’ behavior is
controlled by a list of rules. Only a certain amount of information in the list can be evaluated. If the memory
capacity is exceeded, the remaining rules are ignored.
The rules are by default parsed from top-list to bottom-list (thus giving explicit priorities), and the order can be
modified using the little arrows buttons on the right side.
The list of rules available are:
Goal
Seek goal (objects with Spherical fields and positive Strength)
Predict
Predict target’s movements
Avoid
Avoid “predators” (objects with Spherical fields and negative Strength)
Predict
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Predict target’s movements
Fear Factor
Avoid object if danger from it is above this threshold
Avoid Collision
Avoid objects with activated Deflection
Boids
Avoid collision with other boids
Deflectors
Avoid collision with deflector objects
Look Ahead
Time to look ahead in seconds
Separate
Boids move away from each other
Flock
Copy movements of neighboring boids, but avoid each other
Follow Leader
Follows a leader object instead of a boid
Distance
Distance behind leader to follow
Line
Follow the leader in a line
Average Speed
Maintain average velocity.
Speed
Percentage of maximum speed
Wander
How fast velocity’s direction is randomized
Level
How much velocity’s Z component is kept constant
Fight
Move toward nearby boids
Fight Distance
Attack boids at a maximum of this distance
Flee Distance
Flee to this distance

Rule Evaluation
There are three ways control how rules are evaluated.
Average
All rules are averaged.
Random
A random rule is selected for each boid.
Fuzzy
Uses fuzzy logic to evaluate rules. Rules are gone through top to bottom. Only the first rule that effect
17
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above fuzziness threshold is evaluated. The value should be considered how hard the boid will try to
respect a given rule (a value of 1.000 means the Boid will always stick to it, a value of 0.000 means it will
never). If the boid meets more than one conflicting condition at the same time, it will try to fulfill all the
rules according to the respective weight of each.
Please note that a given boid will try as much as it can to comply to each of the rules he is given, but it is more
than likely that some rule will take precedence on other in some cases. For example, in order to avoid a
predator, a boid could probably “forget” about Collision, Crowd and Center rules, meaning that “while
panicked” it could well run into obstacles, for example, even if instructed not to, most of the time.
As a final note, the Collision algorithm is still not perfect and in research progress, so you can expect wrong
behaviors at some occasion. It is worked on.

Fluid Physics

Fluid Physics Settings.

Fluid simulations are widely used in CG, and a very desired feature of any particle system, fluid particles are
similar to newtonian ones but this time particles are influenced by internal forces like pressure, surface tension,
18
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viscosity, springs, etc. Bforartists particle fluids use the SPH techniques to solve the particles fluid equations.
Smoothed-particle hydrodynamics (SPH) is a computational method used for simulating fluid flows. It has been
used in many fields of research, including astrophysics, ballistics, vulcanology, and oceanography. It is a meshfree Lagrangian method (where the co-ordinates move with the fluid), and the resolution of the method can
easily be adjusted with respect to variables such as the density.
From liquids to slime, goo to sand and wispy smoke the possibilities are endless.

Settings
Fluid physics share options with Newtonian Physics. These are covered on that page.

Fluid Properties
Stiffness
How incompressible the fluid is.
Viscosity
Linear viscosity. Use lower viscosity for thicker fluids.
Buoyancy
Artificial buoyancy force in negative gravity direction based on pressure differences inside the fluid.

Advanced
Repulsion Factor
How strongly the fluid tries to keep from clustering (factor of stiffness). Check box sets repulsion as a
factor of stiffness.
Stiff Viscosity
Creates viscosity for expanding fluid. Check box sets this to be a factor of normal viscosity.
Interaction Radius
Fluid’s interaction radius. Check box sets this to be a factor of 4*particle size.
Rest Density
Density of fluid when at rest. Check box sets this to be a factor of default density.

Springs
Force
Spring force
Rest Length
Rest length of springs. Factor of particle radius. Check box sets this to be a factor of 2*particle size.
Viscoelastic Springs
Use viscoelastic springs instead of Hooke’s springs.
Elastic Limit
How much the spring has to be stretched/compressed in order to change its rest length
Plasticity
How much the spring rest length can change after the elastic limit is crossed.
Initial Rest Length
Use initial length as spring rest length instead of 2*particle size.
Frames
Create springs for this number of frames since particle’s birth (0 is always).
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Particle Visualization
With the items in the Display and Render panel you can set the way the particles will be rendered or depicted in
the view ports in various ways. Some option are valid only for the 3D window, the particles then are rendered
always as Halos. Some of the options will be rendered as shown in the 3D window.

Viewport Display
The Display Panel controls how particles are displayed in the 3d viewport. This does not necessarily determine
how they will appear when rendered.
None
The particles are not shown in the 3D window and are not rendered. The emitter may be rendered though.
Point
Particles are displayed as square points. Their size is independent of the distance from the camera.
Circle
Particles are displayed as circles that face the view. Their size is independent of the distance from the
camera.
Cross
Particles are displayed as 6-point crosses that align to the rotation of the particles. Their size is
independent of the distance from the camera.
Axis
Particles are displayed as 3-point axes. This useful if you want to see the orientation and rotation of
particles in the view port. Increase the Draw Size until you can clearly distinguish the axis.
Particles visualized like Point, Circle, Cross and Axis don’t have any special options, but can be very useful
when you have multiple particle systems at play, if you don’t want to confuse particles of one system from
another (e.g. in simulations using Boids physics).
Display
Specifies the percentage of all particles to show in the viewport (all particles are still rendered).
Draw Size
Specifies how large (in pixels) the particles are drawn in the viewport (0 = default).
Size
Draw the size of the particles with a circle.
Velocity
Draw the velocity of the particles with a line that points in the direction of motion, and length relative to
speed.
Number
Draw the id-numbers of the particles in the order of emission.

Color
The Color Menu allows you to draw particles according to certain particle properties.
None
Particles are black.
Material
Particles are colored according to the material they are given.
Velocity
Color particles according to their speed. The color is a ramp from blue to green to red, Blue being the
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slowest, and Red being velocities approaching the value of Max or above. Increasing Max allows for a
wider range of particle velocities.
Acceleration
Color particles according to their acceleration.

Render Settings
The Render Panel controls how particles appear when they are rendered.
Material Index
Set which of the object’s material is used to shade the particles.
Parent
Use a different object’s coordinates to determine the birth of particles.
Emitter
When disabled, the emitter is no longer rendered. Activate the button Emitter to also render the mesh.
Parents
Render also parent particles if child particles are used. Children have a lot of different deformation
options, so the straight parents would stand between their curly children. So by default Parents are not
rendered if you activate Children.. See Children
Unborn
Render particles before they are born.
Died
Render particles after they have died. This is very useful if particles die in a collision (Die on hit), so you
can cover objects with particles.

None
When set to None particles are not rendered. This is useful if you are using the particles to duplicate objects.

Halo
Halo particles are rendered as Halo Type Materials.
Trail Count
Set the number of trail particles. When greater than 1, additional options appear.
Length in Frames
Path timing is in absolute frames.
Length
End time of drawn path.
Random
Give path lengths a random variation.

Line
The Line visualization mode creates (more or less thin) polygon lines with the strand renderer in the direction
of particles velocities. The thickness of the line is set with the parameter Start of the Strands shader (Material
sub-context, Links and Pipeline panel).
Back
Set the length of the particle’s tail.
Front
Set the length of the particle’s head.
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Speed
Multiply the line length by particles’ speed. The faster, the longer the line.
Trail Count
See description in Halo.

Path
The Path visualization needs a Hair particle system or Keyed
particles.
Strand render
[Keypointstrands] Use the strand primitive for
rendering. Very fast and effective renderer.
Adaptive render
Tries to remove unnecessary geometry from the paths
before rendering particle strands in order to make the
render faster and easier on memory.
Angle
How many degrees path has to curve to produce another render segment (straight parts of paths need
fewer segments).
Pixel
How many pixels path has to cover to produce another render segment (very short hair or long hair
viewed from far away need fewer parts). (only for Adaptive render).
B-Spline
Interpolate hair using B-Splines. This may be an option for you if you want to use low Render values.
You loose a bit of control but gain smoother paths.
Steps
Set the number of subdivisions of the rendered paths (the value is a power of 2). You should set this value
carefully, because if you increase the render value by two you need four times more memory to render.
Also the rendering is faster if you use low render values (sometimes drastically). But how low you can go
with this value depends on the waviness of the hair.(the value is a power of 2). This means 0 steps give 1
subdivision, 1 give 2 subdivisions, 2–>4, 3–>8, 4–>16, ... n -->2 n.

Timing Options
Absolute Path Time
Path timing is in absolute frames.
Start
Start time of the drawn path.
End
End time of the drawn path.
Random
Give the path length a random variation.
Please see also the manual page about Strands for an in depth description.

Object
In the Object visualization mode the specified object (Dupli Object: field) is duplicated in place of each
particle. The duplicated object has to be at the center of the coordinate system, or it will get an offset to the
particle.
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Global
Use object’s global coordinates for duplication.
Size
Size of the objects
Random Size
Give the objects a random size variation.

Group
In the Group visualization mode, the objects that belong to the group (GR: field) are duplicated sequentially in
the place of the particles.
WholeGroup
Use the whole group at once, instead of one of its elements, the group being displayed in place of each
particle.
Use Count
Use objects multiple times in the same groups. Specify the order and number of times to repeat each
object with the list box that appears. You can duplicate an object in the list with the Plus button, or
remove a duplicate with the Minus button.
Use Global
Use object’s global coordinates for duplication.
Pick Random
The objects in the group are selected in a random order, and only one object is displayed in place of a
particle. Please note that this mechanism fully replaces old Bforartists particles system using parentage
and DupliVerts to replace particles with actual geometry. This method is fully deprecated and doesn’t
work anymore.
Size
Size of the objects
Random Size
Give the objects a random size variation.

Billboard
Billboards are aligned square planes. They are aligned to the
camera by default, but you can choose another object that they
should be aligned to.
If you move a billboard around it’s target, it always faces the
center of it’s target. The size of a billboard is set with the
parameter Size of the particle (in Bforartists Units). You can
use them e.g. for Sprites, or to replace Halo visualization.
Everything that can be done with a halo can also be done with
a billboard. But billboards are real objects, they are seen by
raytracing, they appear behind transparent objects, they may have an arbitrary form and receive light and
shadows. They are a bit more difficult to set up and take more render time and resources.
Texturing billboards (including animated textures with alpha) is done by using uv coordinates that are generated
automatically for them so they can take an arbitrary shape. This works well for animations, because the
alignment of the billboards can be dynamic. The textures can be animated in several ways:
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• Depending on the particle lifetime (relative time).
• Depending on the particle starting time.
• Depending on the frame (absolute time).
You can use different sections of an image texture:
• Depending on the lifetime of the billboard.
• Depending on the emission time.
• Depending on align or tilt.
Since you use normal materials for the billboard you have all freedoms in mixing textures to your liking. The
material itself is animated in absolute time.
The main thing to understand is that if the object doesn’t have any UV Layers, you need to create at least one in
the objects Editing context, for any of these to work. Moreover, the texture has to be set to UV coordinates in
the Map Input panel. If you want to see examples for some of the animation possibilities, see the Billboard
Animation Tutorial.
An interesting alternative to billboards are in certain cases strands, because you can animate the shape of the
strands. Because this visualization type has so much options it is explained in greater detail below.
You can limit the movement with these options. How the axis is prealigned at emission time.
View
No prealignement, normal orientation to the target.
X/Y/Z
Along the global X/Y/Z-axis respectively.
Velocity
Along the speed vector of the particle.
Lock
Locks the align axis, keeps this orientation, the billboard aligns only along one axis to it’s target
Billboard Object
The target object that the billboards are facing. By default, the active camera is used.
Tilt Angle
Rotation angle of the billboards planes. A tilt of 1 rotates by 180 degrees (turns the billboard upside
down).
Random
Random variation of tilt.
Offset X
Offset the billboard horizontally in relation to the particle center, this does not move the texture.
Offset Y
Offset the billboard vertically in relation to the particle center.
UV Channels
Billboards are just square polygons. To texture them in different ways we have to have a way to set what
textures we want for the billboards and how we want them to be mapped to the squares. These can then be
set in the texture mapping buttons to set wanted textures for different coordinates. You may use three
different UV layers and get three different sets of UV coordinates, which can then be applied to different
(or the same) textures.
Billboard Normal UV
Coordinates are the same for every billboard, and just place the image straight on the square.
Billboard Time-Index (X-Y)
Coordinates actually define single points in the texture plane with the x-axis as time and y-axis as the
particle index. For example using a horizontal blend texture mapped to color from white to black will
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give us particles that start off as white and gradually change to black during their lifetime. On the other
hand a vertical blend texture mapped to color from white to black will make the first particle to be white
and the last particle to be black with the particles in between a shade of gray.
The animation of the UV textures is a bit tricky. The UV texture is split into rows and columns (N times N).
The texture should be square. You have to use UV Split in the UV channel and fill in the name of the UV layer.
This generated UV coordinates for this layer.
Split UV’s
The amount of rows/columns in the texture to be used. Coordinates are a single part of the UV Split grid,
which is a n?n grid over the whole texture. What the part is used for each particle and at what time is
determined by the Offset and Animate controls. These can be used to make each billboard unique or to use
an “animated” texture for them by having each frame of the animation in a grid in a big image.
Billboard Split UV
Set the name of the UV layer to use with billboards (you can use a different one for each UV Channel).
By default, it is the active UV layer (check the Mesh panel in the Editing context.
Animate
Dropdown menu, indicating how the split UVs could be animated (changing from particle to particle with
time):
None
No animation occurs on the particle itself, the billboard uses one section of the texture in it’s
lifetime.
Age
The sections of the texture are gone through sequentially in particles’ lifetimes.
Angle
Change the section based on the angle of rotation around the Align to axis, if View is used the
change is based on the amount of tilt.
Frame
The section is changes according to the frame.
Offset
Specifies how to choose the first part (of all the parts in the n×n grid in the texture defined by the UV
Split number) for all particles.
None
All particles start from the first part.
Linear
First particle will start from the first part and the last particle will start from the last part, the
particles in between will get a part assigned linearly from the first to the last part.
Random
Give a random starting part for every particle.
Trail Count
See the description in Halo.

Cache
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Particles Cache Settings.

Emitter systems use a unified system for caching and baking
(together with softbody and cloth). The results of the
simulation are automatically cached to disk when the
animation is played, so that the next time it runs, it can play
again quickly by reading in the results from the disk. If you
Bake the simulation the cache is protected and you will be
asked when you’re trying to change a setting that will make a
recalculating necessary.

Tip
Beware of the Start and End Settings
The simulation is only calculated for the positive frames in-between the Start and End frames of the Bake
panel, whether you bake or not. So if you want a simulation longer than 250 frames you have to change the
End frame!

Caching
• As animation is played, each physics system writes each frame to disk, between the simulation start and
end frames. These files are stored in folders with prefix blendcache, next to the .blend file. Note
that for the cache to fill up, one has to start playback before or on the frame that the simulation starts.
• The cache is cleared automatically on changes - but not on all changes, so it may be necessary to free it
manually e.g. if you change a force field.
• If it is impossible to write in the subdirectory there will be no caching.
• The cache can be freed per physics system with a button in the panels, or with the Ctrl-B shortcut key
to free it for all selected objects.
• If the file path to the cache is longer than what is possible with your operating system (more than 250
characters for example), strange things might happen.

Baking
• The system is protected against changes after baking.
• The Bake result is cleared also for all selected objects by click on Free Bake for a singular particle
system.
• If the mesh changes the simulation is not calculated anew.
• Sorry: no bake editing for particles like for softbodies and clothes.
Two notes at the end:
• For renderfarms, it is best to bake all the physics systems, and then copy the blendcache to the
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renderfarm as well.
• Be careful with the sequence of modifiers in the modifier stack (as always). You may have a different
number of faces in the 3D window and for rendering (e.g. when using subdivision surface), if so, the
rendered result may be very different from what you see in the 3D window.

Hair
When set to hair mode, particle system creates only static particles, which may be used for hair, fur, grass and
the like.

Particle hair systems example. Used for the grass and fur.

Growing
The first step is to create the hair, specifying the amount of hair strands and their lengths.
The complete path of the particles is calculated in advance. So everything a particle does a hair may do also. A
hair is as long as the particle path would be for a particle with a lifetime of 100 frames. Instead of rendering
every frame of the particle animation point by point there are calculated control points with an interpolation, the
segments.

Styling
The next step is to style the hair. You can change the look of base hairs by changing the Physics Settings.
A more advanced way of changing the hair appearance is to use Children. This adds child hairs to the original
ones, and has settings for giving them different types of shapes.
You can also interactively style hairs in Particle Mode. In this mode, the particle settings become disabled, and
you can comb, trim, lengthen, etc. the hair curves.
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Animating
Hair can now be made dynamic using the cloth solver. This is covered in the Hair Dynamics page.

Rendering
Bforartists can render hairs in several different ways. Materials have a Strand section, which is covered in the
materials section in the Strands Page.
Hair can also be used as a basis for the Particle Instance modifier, which allows you to have a mesh be
deformed along the curves, which is useful for thicker strands, or things like grass, or feathers, which may have
a more specific look.

Options

Hair particle system settings

Regrow
Regrow Hair for each frame.
Advanced
Enables advanced settings which reflect the same ones as working in Emitter mode.

Emission
Amount
Set the amount of hair strands. Use as little particles as possible, especially if you plan to use softbody
animation later. But you need enough particles to have good control. For a “normal” haircut I found some
thousand (very roughly 2000) particles to give enough control. You may need a lot more particles if you
plan to cover a body with fur. Volume will be produced later with Children.
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Hair Dynamics
Settings for adding movement to hair see Hair Dynamics.

Display
Rendered
Draw hair as curves.
Path
Draw just the end points if the hairs.
Steps
The number of segments (control points minus 1) of the hair strand. In between the control points the
segments are interpolated. The number of control points is important:
• for the softbody animation, because the control points are animated like vertices, so more control points
mean longer calculation times.
• for the interactive editing, because you can only move the control points (but you may recalculate the
number of control points in Particle Mode).
10 Segments should be sufficient even for very long hair, 5 Segments are enough for shorter
hair, and 2 or 3 segments should be enough for short fur.

Children
See Children.

Render
Hair can be rendered as a Path, Object, or Group. See Particle Visualization for descriptions.
See also
• Fur Tutorial, which produced The image above. It deals especially with short hair.
• Bforartists Hair Basics, a thorough overview of all of the hair particle settings.

Hair Dynamics
Hair particles can now be made dynamic using Cloth physics.
To enable hair physics, click the check box beside Hair Dynamics.

Material
Stiffness
Controls how stiff the root of the hair strands are.
Mass
Controls the mass of the cloth material.
Bending
Controls the amount of bend along the hairs. Higher values cause less bending.
Internal Friction
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Amount of friction between individual hairs.
Collider Friction
Amount of friction between hairs and external collision objects.

Damping
Spring
Damping of cloth velocity. (higher = more smooth, less jiggling).
Air
Air has normally some thickness which slows falling things down.

Quality
Steps
Quality of the simulation in steps per frame. (higher is better quality but slower).

Simulation
..TODO
Warning
If you use motion blur in your animation, you will need to bake one extra frame past the last frame which you
will be rendering.

Children
Children are Hair and Keyed particles assigned subparticles. They make it possible to work primarily with a
relatively low amount of Parent particles, for whom the physics are calculated. The children are then aligned to
their parents. Without recalculating the physics the number and visualization of the children can be changed.
• Children can be emitted from particles or from faces (with some different options). Emission from
Faces has some advantages, especially the distribution is more even on each face (which makes it better
suitable for fur and the like). However, children from particles follow their parents better, e.g. if you
have a softbody animation and don’t want the hair to penetrate the emitting mesh. But see also our
manual page about Hair.
• If you turn on children the parents are no longer rendered (which makes sense because the shape of the
children may be quite different from that of their parents). If you want to see the parents additionally
turn on the Parents button in the Visualization panel.
• Children carry the same material as their parents and are colored according to the exact place from
where they are emitted (so all children may have different color or other attributes).
The possible options depend from the type of particle system, and if you work with Children from faces or
Children from particles. We don’t show every possible combination, only the settings for a Hair particle
system.
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Settings
Simple
Children are emitted from the parent hairs.
Interpolated
Children are emitted between the Parent particles on the faces of a mesh. They interpolate between
adjacent parents. This is especially useful for fur, because you can achieve an even distribution. Some of
the children can become virtual parents, which are influencing other particles nearby.
Display
The number of children in the 3D window.
Render
The number of children to be rendered (up to 10.000).
For Simple Mode
Size
Only for Emitter. A multiplier for children size.
Random
Random variation to the size of child particles.
Interpolated Mode
Seed
Offset the random number table for child particles, to get a different result.
Virtual
Relative amount of virtual parents.
Long Hair
Calculate children that suit long hair well.

Effects

From left to right: Round: 0.0 / Round: 1.0 / Clump: 1.0 / Clump: -1.0 / Shape: -0.99.

Clump
Clumping. The children may meet at their tip (1.0) or start together at their root (-1.0).
Shape
Form of Clump. Either inverse parabolic (0.99) or exponentially (-0.99).
Length
Length of child paths
Threshold
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Amount of particles left untouched by child path length
Radius
The radius in which the children are distributed around their parents. This is 3D, so children may be
emitted higher or lower than their parents.
Roundness
The roundness of the children around their parents. Either in a sphere (1.0) or in-plane (0.0).
Seed
Offset in the random number table for child particles, to get a different randomized result

Roughness
Uniform, Size
It is based on children location so it varies the paths in a similar way when the children are near.
Endpoint, Shape
“Rough End” randomizes path ends (a bit like random negative clumping). Shape may be varied from <1
(parabolic) to 10.0 (hyperbolic).
Random, Size, Threshold
It is based on a random vector so it’s not the same for nearby children. The threshold can be specified to
apply this to only a part of children. This is useful for creating a few stray children that won’t do what
others do.

Kink

Child particles with Kink. From left to right: Curl / Radial / Wave / Braid / Roll.

With Kink you can rotate the children around the parent. See above picture for the different types of Kink.
Curl
Children grow in a spiral around the parent hairs.
Radial
Children form around the parent a wave shape that passes through the parent hair.
Wave
Children form a wave, all in the same direction.
Braid
Children braid themselves around the parent hair.
Amplitude
32

Bforartists Reference Manual - © Copyright - This page is under OCL license

The amplitude of the offset.
Clump
How much clump effects kink amplitude.
Flatness
How flat the hairs are.
Frequency
The frequency of the offset (1/total length). The higher the frequency the more rotations are done.
Shape
Where the rotation starts (offset of rotation).

Vertex Groups
The Vertexgroups panel allows you to specify vertex groups to use for several child particle settings. You can
also negate the effect of each vertex group with the check boxes. You can affect the following attributes:
•
•
•
•
•
•
•

Density
Length
Clump
Kink
Roughness 1
Roughness 2
Roughness End

Examples

Particle Mode
Using Particle Mode you can edit the key-points (key-frames) and paths of Baked Hair, Particle, Cloth, and
Soft Body simulations. (You can also edit and style hair before baking).
Since working in particle mode is pretty easy and very similar to working with vertices in the 3D window, we
will show how to set up a particle system and then give a reference of the various functions.

Usage
Ways to use Particle Mode
Tip
Only Frames Baked to Memory are Editable!
If you cannot edit the particles, check that you are not baking to a Disk Cache.
Setup for Hair Particles
• Create a Hair particle system - With your object selected, click the Particle System icon in the Properties
panel. Create a new particle system by clicking the Plus.
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• Give it an initial velocity in the Normal direction (first check the Advanced box, then modify the
Velocity sub-panel), or adjust the Hair Length.
• Create a simulation - Place the camera at a good position (pop-up ‣ View ‣ Cameras ‣ Active
Camera
• Check the Hair Dynamics box. Select pop-up ‣ Render ‣ Render OpenGL Animation in Render
Engine mode.

Editing hair strands in Particle Mode

Editing a baked particle simulation’s particle paths in Particle Mode

Setup for Particle, Cloth, and Soft Body Simulations
• Use Emitter particles, or a cloth/soft-body simulation
• Create a simulation - set up objects and or emitters, set your time range (use a small range if you are just
starting out and experimenting), set up the simulation how you want it, using Alt-A to preview it.
Bake the Simulation
• Once you are happy with the general simulation, bake the simulation from object mode. The simulation
must be baked to enable editing. (remember to bake to memory, a disk cache will not be editable in
Particle Mode)
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Edit the Simulation
• Switch to Particle Edit from the Mode dropdown menu in the bottom menu bar of the 3D View to edit
the particle’s paths/key-frames. You may need to press T from within the 3D viewport to see the
Particle Edit panel. Move to the frame you want to edit and use the various Particle Edit tools to edit
your simulation. Work slowly, previewing your changes and save often so that you can go back to the
previous version should something happen, or that you do not like the latest changes you have made.
To be able to clearly see what you are working on:
• Turn on the Particle Edit Properties (PEP) panel
• Select Point select mode

in the header of the 3D window. This will display key points along the particle path.

Using Particle Mode
Selecting Points
You may use the Select Menu.

Tip
Selections
Selections are extremely useful for modifying only the particles that you want.
The method to select individual points is the same as in edit mode. click to select, shift+click to add/remove a
point from the selection

Tip
Beware of Undo!
Using Undo in Particle Mode can have strange results. Remember to save often!

Moving keypoints or particles
• To move selected keypoints use one of the various other methods to grab vertices.
• To move a particle root you have to turn off Keep Root in the Tool Bar.
• You can do many of the things like with vertices, including scaling, rotating and removing (complete
particles or single keys).
• You may not duplicate or extrude keys or particles, but you can subdivide particles which adds new
keypoints
• Alternatively you can rekey a particle and choose the number of keys.
How smoothly the hair and particle paths are displayed depends on the Path Steps setting in the Tool Bar. Low
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settings produce blocky interpolation between points, while high settings produce a smooth curve.

Mirroring particles
• If you want to create an X-Axis symmetrical haircut you have to do following steps: - Select all particles
with A. - Mirror the particles - Turn on X-Axis Mirror Editing in the Particle menu.
It may happen that after mirroring two particles occupy nearly the same place. Since this would be a waste of
memory and rendertime, you can Remove doubles from the Particle menu.

Hiding/Unhiding
Hiding and unhiding of particles works similar as with vertices in the 3D window. The particle in fact doesn’t
vanish, only the key points.
Hidden particles (i.e. particles whose keypoints are hidden) don’t react on the various brushes. But:
If you use Mirror Editing even particles with hidden keypoints may be moved, if their mirrored counterpart is
moved.

Select Modes

Path
No keypoints are visible, you can select/deselect only all particles.
Point
You see all of the keypoints.
Tip
You can see and edit (including the brushes) only the tip of the particles, i.e. the last keypoint.

Brush
With the buttons you can select the type of “Comb” utility you want to use. Below the brush types, their
settings appear:
Common Options:
Radius
Set the radius if the brush.
Strength
Set the strength of the brush effect (not for Add brush).
Add/Sub Grow/Shrink
Sets the brush to add the effect or reverse it..
None
No special tool, just edit the keypoints as “normal” vertices.
Comb
Moves the keypoints (similar to “proportional editing”).
Smooth
Parallels visually adjacent segments.
Add
Adds new particles.
Count
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The number of new particles per step.
Interpolate
Interpolate the shape of new hairs from existing ones.
Steps
Amount of brush steps
Keys
How many keys to make new particles with.
Length
Scales the segments, so it makes the hair longer(Grow) or shorter(Shrink).
Puff
Rotates the hair around it’s first keypoint (root). So it makes the hair stand up (Add) or lay down (Sub).
Puff Volume
Apply puff to unselected end-points, (helps maintain hair volume when puffing root)
Cut
Scales the segments until the last keypoint reaches the brush.
Weight
This is especially useful for softbody animations, because the weight defines the softbody Goal. A
keypoint with a weight of 1 won’t move at all, a keypoint with a weight of 0 subjects fully to softbody
animation. This value is scaled by the GMin - GMax range of softbody goals...

Options
Deflect Emitter, Dist
Don’t move keypoints through the emitting mesh. Dist is the distance to keep from the Emitter.
Keep
Length
Keep the length of the segments between the keypoints when combing or smoothing the hair. This
is done by moving all the other keypoints.
Root
Keep first key unmodified, so you can’t transplant hair.
X Mirror
Enable mirror editing across the local x axis.
Draw
Path Steps
Drawing steps, sets the smoothness of the drawn path.
Show Children
Draws the children of the particles too. This allows to fine tune the particles and see their effects on
the result, but it may slow down your system if you have many children.
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Smoke Simulation
Smoke simulation is used to simulate the fluid movement of air and generate animated voxel textures
representing the density, heat, and velocity of other fluids or suspended particles (i.e. smoke) which can be used
for rendering.
Smoke and fire are emitted into a Domain from a mesh object or particle system. Smoke movement is
controlled by airflow inside the domain, which can be influenced by smoke collision objects. Smoke will also
be affected by scene gravity and force fields. Airflow inside the domain can affect other physics simulations via
the smoke flow force field.

Workflow
At least a Domain Object object and one Flow object are required to create a smoke simulation. A basic
workflow looks like this:
1.
2.
3.
4.
5.
6.

Create a Domain Object that defines the bounds of the simulation volume.
Define a Flow object or objects which will emit smoke and fire.
Set Collision objects to make the smoke interact with objects in the scene.
Assign a Volumetric material to the domain object.
Save the .blend.
Bake the simulation.
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Note
There is a Quick Smoke operator which will automatically create a domain object with a basic smoke/fire
material. It can be found in 3D View ‣ Object ‣ Quick Effects ‣ Quick Smoke, or in the Spacebar
search box.

Technical information
Bforartists’s smoke simulation is based on the paper Wavelet Turbulence for Fluid Simulation and associated
sample code.
It has been implemented in Bforartists by Daniel Genrich and Miika Hamalainen.

Smoke Domain
The domain object contains the entire simulation. Smoke and fire cannot leave the domain, it will either collide
with the edge or disappear, depending on the domain’s settings.
Keep in mind that large domains require higher resolutions and longer bake times. You’ll want to make it just
large enough that the simulation will fit inside it, but not so large that it takes too long to compute the
simulation.
To create a domain, add a cube and transform it until it encloses the area where you want smoke. Translation,
rotation, and scaling are all allowed. To turn it into a smoke domain, click Smoke in Properties ‣ Physics, then
select Domain as the Smoke Type.
Note
You can use other shapes of mesh objects as domain objects, but the smoke simulator will use the shape’s
bounding box as the domain bounds. In other words, the actual shape of the domain will still be rectangular.
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Smoke Domain settings.

Settings
Resolution
The smoke domain is subdivided into many “cells” called voxels (see voxel) which make up “pixels” of
smoke. This setting controls the number of subdivisions in the domain. Higher numbers of subdivisions
are one way of creating higher resolution smoke (See Smoke High Resolution)
Since the resolution is defined in terms of subdivisions, larger domains will need more divisions to get an
equivalent resolution to a small domain.
Also see Note on Divisions and High Resolution.
Time Scale
Controls the speed of the simulation. Low values result in a “slow motion” simulation, while higher
values can be used to advance the simulation faster (useful for generating smoke for use in still renders).
Border Collisions
Controls which sides of the domain will allow smoke “through” the domain, making it disappear without
influencing the rest of the simulation, and which sides will deflect smoke as if colliding with a Collision
Object.
Vertically Open
Smoke disappears when it hits the top or bottom of the domain, but collides with the walls.
Open
Smoke disappears when it hits any side of the domain.
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Collide All
Smoke collides with all sides of the domain.
Density
Controls how much smoke is affected by density.
• Values above 0 will cause the smoke to rise (simulating smoke which is lighter than ambient air).
• Values below 0 will cause smoke to sink (simulating smoke which is heavier than ambient air).
Temp. Diff.
The Temperature Difference setting controls how much smoke is affected by temperature.
The effect this setting has on smoke depends on the per flow object *Temp. Diff.* setting:
• Values above 0 will result in the smoke rising when the flow object Temp. Diff. is set to a positive
value, and smoke sinking when the flow object Temp. Diff. is set to a negative value.
• Values below 0 will result in the opposite of positive values, i.e. smoke emitted from flow objects
with a positive Temp. Diff. will sink, and smoke from flow objects with a negative Temp. Diff. will
rise.
Note that smoke from multiple flow objects with different temperatures will mix and warm up/cool down
until an equilibrium is reached.
Vorticity
Controls the amount of turbulence in the smoke. Higher values will make lots of small swirls, while lower
values make smoother shapes.

Comparison of different amounts of vorticity. The domain on the left has a vorticity of 3, while the domain on the right
has a vorticity of .01.
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Dissolve
Allow smoke to dissipate over time.
Time
Speed of smoke’s dissipation in frames.
Slow
Dissolve smoke in a logarithmic fashion. Dissolves quickly at first, but lingers longer.

Smoke Flames
Speed
How fast fuel burns. Larger values result in smaller flames (fuel burns before it can go very far), smaller
values result in larger flames (fuel has time to flow farther before being fully consumed).
Smoke
Amount of extra smoke created automatically to simulate burnt fuel.
Vorticity
Additional vorticity for flames.
Ignition
Minimum temperature of flames.
Maximum
Maximum temperature of flames.
Smoke Color
Color of smoke created by burnt fuel.

Smoke Adaptive Domain
When enabled, the domain will adaptively shrink to best fit the smoke, saving computation time by leaving
voxels without smoke out of the simulation. Unless the Additional option is used, the adaptive domain will not
exceed the bounds of the original domain.
Additional
Number of voxels to add around the outside of the domain.
Margin
Amount of extra space to leave around smoke, measured in voxels. With very fast moving smoke larger
margins may be required to prevent the smoke from being cut off by the adaptive boundary, but note this
will increase the number of voxels which need to be computed.
Threshold
Smallest amount of smoke a voxel can contain before it’s considered empty and the adaptive domain is
allowed to cut it out of the simulation.

Smoke High Resolution
The High Resolution option lets you simulate at low resolution and then uses noise techniques to enhance the
resolution without actually computing it. This allows animators to set up a low resolution simulation quickly
and later add details without changing the overall fluid motion. Also see Note on Divisions and High
Resolution.
Resolution/Divisions
Factor by which to enhance the resolution of smoke using the specified noise method.
Show High Resolution
Show high resolution in the viewport (may cause viewport responsiveness to suffer).
Noise Method
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The two options, Wavelet and FFT, are very similar.

Comparison of noise methods. Wavelet on the left, FFT on the right.

Note
Wavelet is an implementation of Turbulence for Fluid Simulation.

Strength
Strength of noise.
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From left to right, the domains’ high resolution strengths are set to 0, 2, and 6.

Smoke Groups
Flow Group
If set, only objects in the specified Group will be allowed to act as flow objects in this domain.
Collision Group
If set, only objects in the specified Group will be allowed to act as collision objects in this domain.

Smoke Cache
See Baking.

Smoke Field Weights
These settings determine how much gravity and Force Fields affect the smoke.
Effector Group
When set, smoke can only be influenced by force fields in the specified group.
Gravity
How much the smoke is affected by Gravity.
All
Overall influence of all force fields.
The other settings determine how much influence individual force field types have.

7
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Smoke with a wind force field.

Note on Divisions and High Resolution
High Resolution Divisions and Domain Subdivisions are not equivalent. By using different combinations of
these resolution settings you can obtain a variety of different styles of smoke.

Comparison between a domain with 24 divisions and 4 High Resolution divisions (left), and a domain with 100 divisions and
1 High Resolution division (right).

Low division simulations with lots of High Resolution divisions generally appear smaller in real-world scale
(larger flames etc.) and can be used to achieve pyroclastic plumes such as this:

8
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High Domain Division simulations tend to appear larger in real-world scale, with many smaller details.

Smoke Flow Object
Smoke Flow objects are used to add or remove smoke and fire to a Smoke Domain object.
To define any mesh object as a Smoke Flow object, add smoke physics by clicking Smoke in Properties ‣
Physics. Then select Flow as the Smoke Type. Now you should have a default smoke flow source object. You
can test this by playing the animation from the first frame. If your source object is inside your domain, you
should see smoke.

9
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Settings

Smoke Flow settings

Flow Type
Fire
Emit only fire. Note that the domain will automatically create some smoke to simulate smoke left by
burnt fuel.
Smoke
Emit only smoke.
Fire + Smoke
Emit both fire and smoke.
Outflow
Remove smoke and fire. Note that the shape of the outflow will use the object’s bounding box.

Flow Source
Source
This setting defines the method used to emit smoke and fire.
Mesh

10
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Create smoke/fire directly from the object’s mesh. With this option selected there two additional
settings, Surface and Volume.
Surface
Maximum distance in voxels from the surface of the mesh in which smoke is
created (see voxel). Since this setting uses voxels to determine distance, results
will vary depending on the domain’s resolution.
Volume
Amount of smoke to emit inside the emitter mesh, where 0 is none and 1 is Note
that emitting smoke based on volume may have unpredictable results if your mesh
is non-manifold.
Particle System
Create smoke/fire from a particle system on the flow object. Note that only Emitter type particle
systems can add smoke. See Particles for information on how to create a particle system.
With this option selected there is a box to select a particle system and one addition setting, Set Size.
Set Size
When this setting is enabled it allows the Size setting to define the maximum
distance in voxels at which particles can emit smoke, similar to the *Surface*
setting for mesh sources.
When disabled, particles will fill the nearest voxel with smoke.
Initial Velocity
When enabled, smoke will inherit the momentum of the flow source.
Source
Multiplier for inherited velocity. A value of 1 will emit smoke moving at the same speed as the
source.
Normal
When using a mesh source, this option controls how much velocity smoke is given along the
source’s normal.

Initial Values
Smoke Color
Color of emitted smoke. When smoke of different colors are mixed they will blend together, eventually
settling into a new combined color.
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Flame Rate:
Amount of “fuel” being burned per second. Larger values result in larger flames, smaller values result in
smaller flames:

Example showing two fire sources. The object on the left has a Flame Rate of 5, while the one on the right has 0.3.

Absolute Density
Maximum density of smoke allowed within range of the source.
Density
Amount of smoke to emit at once.
Temp. Diff.
Difference between the temperature of emitted smoke and the domain’s ambient temperature. This
setting’s effect on smoke depends on the domain’s *Temp. Diff.* setting.
Sampling
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Number of sub-frames used to reduce gaps in emission of smoke from fast-moving sources.

Example showing two fast moving sources. The object on the left uses 0 subframes, while the one on the right uses 6.

Smoke Flow Advanced
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When using a mesh as the Flow Source, you can use these settings to control where on the mesh smoke can be
emitted from. These settings have no effect on outflow objects.
Use Texture
When enabled, use the specified texture to control where smoke is emitted.
Vertex Group
When set, use the specified Vertex Group to control where smoke is emitted.
These settings are useful for effects like this:

Collisions
Smoke Collision objects are used to deflect smoke and influence airflow.
To define any mesh object as a Smoke Collision object, add smoke physics by clicking Smoke in Properties ‣
Physics. Then select Collision as the Smoke Type.
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Smoke Collision settings

Collision type
Static
Simple collision model which can be calculated quickly, but may be inaccurate for moving objects.
Animated
More complex collision model which takes into account impulse imparted to smoke when the
collider is moving. Calculations are slower, but more accurate for moving objects.
Rigid
Identical to Static (unfinished code).

Forces
Force Fields (such as wind or vortex) are supported, like most physics systems. The influence individual force
types have can be controlled per domain object.

Smoke Material
Bforartists has multiple render engines each with their own method of rendering smoke-data:
• Bforartists Internal
• Cycles Render

Baking Smoke Simulations
Baking is used to store the outcome of a simulation so it doesn’t need to be recalculated.
Smoke baking settings are in Properties ‣ Physics ‣ Smoke ‣ Smoke Cache. See Baking Physics
Simulations.
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Smoke Cache options

Note
Baking can only been done once your .blend is saved. If your .blend has not been saved, the Smoke Cache
panel will be disabled.
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Soft Body
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Image 1a: A softbody cloth uncovering a text. Animation - Blend file

A Soft Body in general, is a simulation of a soft or rigid deformable object. In Bforartists, this system is best for
simple cloth objects and closed meshes. There is dedicated Cloth Simulation physics that use a different solver,
and is better for cloth.
This simulation is done by applying forces to the vertices or controlpoints of the object. There are exterior
forces like gravity or forcefields and interior forces that hold the vertices together. This way you can simulate
the shapes that an object would take on in reality if it had volume, was filled with something, and was acted on
by real forces.
Soft Bodies can interact with other objects (Collision). They can interact with themselves (Self Collision).
The result of the Soft Body simulation can be converted to a static object. You can also bake edit the simulation,
i.e. edit intermediate results and run the simulation from there.

Typical scenarios for using Soft Bodies

Image 1b: A wind cone. The cone is a Soft Body, as the suspension. Animation - Blend file

Soft Bodies are well suited for:
• Elastic objects with or without collision.
2
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• Flags, fabric reacting to forces.
• Certain modeling tasks, like a cushion or a table cloth over an object.
• Bforartists has another simulation system for clothing (see Clothes). But you can sometimes use Soft
Bodies for certain parts of clothing, like wide sleeves.
• Hair (as long as you minimize collision).
• Animation of swinging ropes, chains and the like.
The following videos may give you some more ideas: http://youtube.com/watch?v=qdusMZlBbQ4,
http://de.youtube.com/watch?v=3du8ksOm9Fo

Creating a Soft Body
Soft Body simulation works for all objects that have vertices or control points:
•
•
•
•

Meshes.
Curves.
Surfaces.
Lattices.

To activate the Soft Body simulation for an object:
• In the Properties window, go to the Physics tab (it is all the way on the right, and looks like a bouncing
ball).
• Activate the Soft Body button.
A lot of options appear. For a reference of all the settings see this page.
• You start a Soft Body simulation with Play button
• You pause the simulation with Pause button
• You stop the simulation with Esc.

Simulation Quality
The settings in the Soft Body Solver panel determine the accuracy of the simulation.
Min Step
Minimum simulation steps per frame. Increase this value, if the Soft Body misses fast moving collision
objects.
Max Step
Maximum simulation steps per frame. Normally the number of simulation steps is set dynamically (with
the Error Limit) but you have probably a good reason to change it.
Auto-Step
Use Velocities for automatic step sizes.
Error Limit
Rules the overall quality of the solution delivered. Default 0.1. The most critical setting that says how
precise the solver should check for collisions. Start with a value that is 1/2 the average edge length. If
there are visible errors, jitter, or over-exaggerated responses, decrease the value. The solver keeps track of
how “bad” it is doing and the Error Limit causes the solver to do some “adaptive step sizing”.
Fuzzy
Simulation is faster, but less accurate.
Choke
3
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Calms down (reduces the exit velocity of) a vertex or edge once it penetrates a collision mesh.
Diagnostics
Print Performance to Console
Prints on the console how the solver is doing.
Estimate Matrix
Estimate matrix. Split to COM , ROT ,SCALE

Cache and Bake
Soft Bodies and other physic simulations use a unified system for caching and baking. See Particle Cache for
reference.
The results of the simulation are automatically cached to disk when the animation is played, so that the next
time it runs, it can play again quickly by reading in the results from the disk. If you Bake the simulation the
cache is protected and you will be asked when you’re trying to change a setting that will make a recalculating
necessary.
Tip
Beware of the Start and End settings
The simulation is only calculated for the frames in-between the Start and End frames (Bake panel), even if you
don’t actually bake the simulation! So if you want a simulation longer than the default setting of 250 frames
you have the change the End frame.

• Caching:
• As animation is played, each physics system writes each frame to disk, between the simulation
start and end frames. These files are stored in folders with prefix blendcache, next to the
.blend file.
• The cache is cleared automatically on changes - but not on all changes, so it may be necessary to
free it manually, e.g. if you change a force field. Note that for the cache to fill up, one has to start
playback before or on the frame that the simulation starts.
• If you are not allowed to write to the required sub-directory caching will not take place.
• The cache can be freed per physics system with a button in the panels, or with the Ctrl-B
shortcut key to free it for all selected objects.
• You may run into trouble if your .blend file path is very long and your operating system has a
limit on the path length that is supported.
• Baking:
• The system is protected against changes after baking.
• The Bake result is cleared for all selected objects or click on Free Bake for the current Soft Body
system.
• If the mesh changes the simulation is not calculated anew.
For renderfarms, it is best to bake all the physics systems, and then copy the blendcache to the renderfarm as
well.
4

Bforartists Reference Manual - © Copyright - This page is under OCL license

Interaction in real time
To work with a Soft Body simulation you will find it handy to use the Timeline window. You can change
between frames and the simulation will always be shown in the actual state. The option Continue Physics in the
Playback menu of the Timeline window lets you interact in real time with the simulation, e.g. by moving
collision objects or shake a Soft Body object. And this is real fun!
You can than select the Soft Body object while running the simulation and Apply the modifier in the Modifiers
panel of the Editing context. This makes the deformation permanent.

Tips
• Soft Bodies work especially well if the objects have an even vertex distribution. You need enough
vertices for good collisions. You change the deformation (the stiffness) if you add more vertices in a
certain region (see the animation of Image 1b).
• The calculation of collisions may take a long time. If something is not visible, why calculate it?
• To speed up the collision calculation it is often useful to collide with an additional, simpler, invisible,
somewhat larger object (see the example to Image 1a).
• Use Soft Bodies only where it makes sense. If you try to cover a body mesh with a tight piece of cloth
and animate solely with Soft Body, you will have no success. Self collision of Soft Body hair may be
activated, but that is a path that you have to wander alone. We will deal with Collisions in detail later.
• Try and use a Lattice or a Curve Guide Soft Body instead of the object itself. This may be magnitudes
faster.

Exterior Forces
Exterior forces are applied to the vertices (and nearly exclusively to the vertices) of Soft Body objects. This is
done using Newtons Laws of Physics:
• If there is no force on a vertex, it stays either unmoved or moves with constant speed in a straight line.
• The acceleration of a vertex depends on its mass and the force. The heavier the mass of a vertex the
slower the acceleration. The larger the force the greater the acceleration.
• For every action there is an equal and opposite reaction.
Well, this is done only in the range of computing accurateness, there is always a little damping to avoid
overshoot of the calculation.

Example
We will begin with a very simple example - the default cube.
• To judge the effect of the external forces you should at first turn off the Goal, so that the vertices are not
retracted to their original position.
• Click Play
What happens? The cube moves in negative Z-direction. Each of it’s eight vertices is affected by a global,
constant force - the gravitation. Gravitation without friction is independent from the weight of an object, so
each object you would use as a Soft Body here would fall with the same acceleration. The object does not
5
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deform, because every vertex moves with the same speed in the same direction.

Settings

Soft Body Panel
Friction
The friction of the surrounding medium. The larger the friction, the more viscous is the medium. Friction
always appears when a vertex moves relative to it’s surround medium.
Mass
Mass value for vertices. Larger mass slows down acceleration, except for gravity where the motion is
constant regardless of mass. Larger mass means larger inertia, so also braking a Soft Body is more
difficult.
Mass Vertex Group
You can paint weight values for an mesh’s mass, and select that vertex group here.
Speed
You can control the internal timing of the Softbody system with this value. It sets the correlation between
frame rate and tempo of the simulation. A free falling body should cover a distance of about five meters
after one second. You can adjust the scale of your scene and your simulation with this correlation. If you
render with 25 frames per second and 1 meter shall be 1 BU, you have to set Speed to 1.3.

Force Fields
To create other forces you have to use another object, often Empty objects are used for that. You can use some
of the forces on Soft Body vertices as on Particles. Soft Bodies react only to:
• Spherical
• Wind
• Vortex
Soft bodies do react on Harmonic fields, but not in a useful way. So if you use a Harmonic field for particles
move the Soft body to another layer.
See the section Force Fields for details. The force fields are quite strong, a Spherical field with a strength of
-1.0 has the same effect that gravity has - approximately - a force of 10 Newton.

Aerodynamics
This special exterior force is not applied to the vertices but to the connecting edges. Technically, a force
perpendicular to the edge is applied. The force scales with the projection of the relative speed on the edge (dot
product). Note that the force is the same if wind is blowing or if you drag the edge through the air with the same
speed. That means that an edge moving in its own direction feels no force, and an edge moving perpendicular to
its own direction feels maximum force.
Simple
Edges receive a drag force from surrounding media
Lift Force
Edges receive a lift force when passing through surrounding media.
Factor
How much aerodynamic force to use. Try a value of 30 at first.
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Using a Goal
A goal is a shape that a soft body object tries to conform to.
You have to confine the movement of vertices in certain parts of the mesh, e.g. to attach a Soft Body object at
other objects. This is done with the Vertex Group (target). The target position is the original position of the
vertex, like it would result from the “normal” animation of an object including Shape Keys, Hooks and
Armatures. The vertex tries to reach it’s target position with a certain, adjustable intensity.

Image 2b: Shock absorber description.

Imagine the vertex is connected with it’s target through a spring (Image 2b).
Default
This parameter defines how strong the influence of this spring is. A strength of 1 means, that the vertex
will not move as Soft Body at all, instead keep its original position. 0 Goal (or no Goal) means, that the
vertex moves only according to Soft Body simulation. If no vertex group is used/assigned, this numeric
field is the default goal weight for all vertices. If a vertex group is present and assigned, this button
instead shows an pop-up selector button that allows you to choose the name of the goal vertex group. If
you use a vertex group the weight of a vertex defines its goal.
Often Weight Paint is used to adjust the weight comfortably. For non-mesh objects the Weight parameter
of their vertices/controlpoints is used instead (W in Edit mode, or use the Transform Properties panel). The
weight of Hair particles can also be painted in Particle Mode.
Minimum / Maximum
When you paint the values in vertex-groups (using WeightPaint mode), you can use the G Min and G Max
to fine-tune (clamp) the weight values. The lowest vertex-weight (blue) will become G Min, the highest
value (red) becomes G Max (please note that the blue-red color scale may be altered by User
Preferences).
Tip
For now all is applied to single vertices
For now we have discussed vertex movement independent of each other, similar to particles. Every object
without Goal would collapse completely if a non uniform force is applied. Now we will move to the next step,
the forces that keep the structure of the object and make the Soft Body to a real Body.
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Stiffness
The spring stiffness for Goal. A low value creates very weak springs (more flexible “attachment” to the
goal), a high value creates a strong spring (a stiffer “attachment” to the goal).
Dampimg
The friction of the spring. With a high value the movement will soon come to an end (little jiggle).

Interior Forces

Image 1a: Vertices and forces along their connection edges.

To create a connection between the vertices of a Soft Body object there have to be forces that hold the vertices
together. These forces are effective along the edges in a mesh, the connections between the vertices. The forces
act like a spring. (Image 1a) illustrates how a 3×3 grid of vertices (a mesh plane in Bforartists) are connected in
a Soft Body simulation.
But two vertices could freely rotate if you don’t create additional edges between them. Have you ever tried
building a storage shelf out of 4 planks alone? Well - don’t do it, it will not be stable. The logical method to
keep a body from collapsing would be to create additional edges between the vertices. This works pretty well,
but would change your mesh topology drastically.

Image 1b: Additional forces with Stiff Quads enabled.

Luckily, Bforartists allows us to define additional virtual connections. On one hand we can define virtual
connections between the diagonal edges of a quad face (Stiff Quads, Image 1b), on the other hand we can define
virtual connections between a vertex and any vertices connected to it’s neighbors (Bending Stiffness). In other
words, the amount of bend that is allowed between a vertex and any other vertex that is separated by two edge
connections.
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Edges Settings
The characteristics of edges are set with the Soft Body Edge properties.
Use Edges
Allow the edges in a Mesh Object to act like springs.
Pull
The spring stiffness for edges (how much the edges are allowed to stretch). A low value means very weak
springs (a very elastic material), a high value is a strong spring (a stiffer material) that resists being pulled
apart. 0.5 is latex, 0.9 is like a sweater, 0.999 is a highly-starched napkin or leather. The Soft Body
simulation tends to get unstable if you use a value of 0.999, so you should lower this value a bit if that
happens.
Push
How much the Softbody resist being scrunched together, like a compression spring. Low values for
fabric, high values for inflated objects and stiff material.
Damp
The friction for edge springs. High values (max of 50) dampen the Push / Pull effect and calm down the
cloth.
Plastic
Permanent deformation of the object after a collision. The vertices take a new position without applying
the modifier.
Bending
This option creates virtual connections between a vertex and the vertices connected to it’s neighbors. This
includes diagonal edges. Damping also applies to these connections.
Length
The edges can shrink or been blown up. This value is given in percent, 0 disables this function. 100%
means no change, the body keeps 100% of his size.
Stiff Quads
For quad faces, the diagonal edges are used as springs. This stops quad faces to collapse completely on
collisions (what they would do otherwise).
Shear
Stiffness of the virtual springs created for quad faces.

Preventing Collapse
To show the effect of the different edge settings we will use two cubes (blue: only quads, red: only tris) and let
them fall without any goal onto a plane (how to set up collision is shown on the page Collisions).

Image 3a: Frame 1 without Stiff

Image 3b: Frame 36.

Image 3c: Frame 401.

Quads.

In (Image 3), the default settings are used (without Stiff Quads). The “quad only” cube will collapse completely,
the cube composed of tris keeps it’s shape, though it will deform temporarily because of the forces created
during collision.
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Image 4a: Frame 1 with Stiff

Image 4b: Frame 36.

Image 4c: Frame 401.

Quads.

In (Image 4), Stiff Quads is activated (for both cubes). Both cubes keep their shape, there is no difference for
the red cube, because it has no quads anyway.

Image 5a: Frame 1 with Bending
Stiffness. Blend file

Image 5b: Frame 36.

Image 5c: Frame 401.

The second method to stop an object from collapsing is to change it’s Bending Stiffness. This includes the
diagonal edges (Damping also applies to these connections).
In (Image 5), Be is activated with a strength setting of 1. Now both cubes are more rigid.

Image 6a: Two planes going to

Image 6b: No bending stiffness,

Image 6c: High bending stiffness

collide.

Frame 101.

(10), Frame 101.

Bending stiffness can also be used if you want to make a subdivided plane more plank like. Without Be the
faces can freely rotate against each other like hinges (Image 6b). There would be no change in the simulation if
you activated Stiff Quads, because the faces are not deformed at all in this example.
Bending stiffness on the other hand prevents the plane from being - well - bent.

Collisions
10
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There are two different collision types that you may use: collision between different objects and internal
collision. We should set one thing straight from the start: the primary targets of the collision calculation are the
vertices of a Soft Body. So if you have too few vertices too few collision takes place. Secondarily, you can use
edges and faces to improve the collision calculation.

Collisions with other objects
For a Soft Body to collide with another object there are a few prerequisites:
• Both objects have to share a layer, but the layer does not necessarily have to be visible.
• The collision object has to be a mesh object.
• You have to activate the option Collision in the Collision panel of the Physics sub-context (Image 1) for
the collision object. The collision object may also be a Soft Body.
• If you use modifiers such as Array and Mirror you have to activate EV.M.Stack to ensure that collision
calculation is based on the modified object. The sequence of Modifiers is not important.

Examples

Image 2a: A Soft Body cube

Image 2b: A Soft Body plane

Image 2c: Collision with CFace

colliding with a plane.

colliding with a cube - no

activated.

interaction at all.

A cube colliding with a plane works pretty well (Image 2a), but a plane falls right through a cube that it is
supposed to collide with (Image 2b). Why is that? Because the default method of calculation only checks to see
if the four vertices of the plane collides with the cube as the plane is pulled down by gravity. You can activate
CFace to enable collision between the face of the plane and the object instead (Image 2c), but this type of
calculation takes much longer.
Let’s have a closer look at the collision calculation, so you can get an idea of how we might optimize it.
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Calculating Collisions

Image 3a: Visualization of the collision of a Soft Body vertex with a

Image 3b: Six Soft Body vertices with different

plane.

speed. Blend file

Soft Body simulation is by default done on a per vertex basis. If the vertices of the Soft Body do not collide
with the collision object there will be no interaction between the two objects.
In (Image 3a), you can see a vertex colliding with a plane. If a vertex penetrates the zone between Outer and
Inner, it is repulsed by a force in the direction of the face normal. The position that a vertex finally ends up in is
dependent on the forces that act upon it. In the example gravity and the repulsion force of the face balance out.
The speed at which the vertex is pulled out of the collision zone is influenced by the Choke parameter (Image
4).
Now lets see what happens if we make vertices heavier and let them travel at a faster speed. In (Image 3b), you
can see vertices traveling at different speeds. The two on the far right (5 and 6) are traveling so fast that they
pass right through the collision zone (this is because of the default solver precision - which we can fix later).
You will notice that the fourth vertex also travels quite fast and because it is heavier it breaches the inner zone.
The first three vertices collide OK.

Image 3d: Also Edges and Faces can be used for the collision calculation.

You can set up your collision so that edges and even faces are included in the collision calculation (Image 3d).
The collision is then calculated differently. It is checked whether the edge or face intersects with the collision
object, the collision zones are not used.
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Good collisions

Image 4: Parameters for Soft Body calculation.

If the collision you have set up is not behaving properly, you can try the following:
Tip
The best way
Add Loop Cuts to your Soft Body object in strategic areas that you know are most likely to be involved in a
collision.

•
•
•
•
•
•
•
•

The Soft Body object must have more subdivisions than the collision object.
Check the direction of the face normals.
If the collision object has sharp spikes they might penetrate the Soft Body.
The resolution of the solver must match the speed at which Soft Body vertices are traveling. Lower the
parameter Error Lim and carefully increase Min S.
Outer and Inner should be large enough, but zones of opposite faces should not overlap, or you have
forces in opposite directions.
If you use strong forces you should use large zones.
Set Choke to a high enough value (all the way up if necessary) if you have difficulties with repelled
vertices.
Colliding faces are difficult to control and need long calculation times. Try not to use them.

Often it is better to create a simplified mesh to use as your collision object, however this may be difficult if you
are using an animated mesh.

Self Collision
Self Collision is working only if you have activated Use Edges.
When enabled, allows you to control how Bforartists will prevent the Soft Body from intersecting with itself.
Every vertex is surrounded with an elastic virtual ball. Vertices may not penetrate the balls of other vertices. If
you want a good result you may have to adjust the size of these balls. Normally it works pretty well with the
default options.
Ball Size Calculation
Man (“manual”)
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The Ball Size directly sets the ball size (in BU).
Av (“average”)
The average length of all edges attached to the vertex is calculated and then multiplied with the Ball
Size setting. Works well with evenly distributed vertices.
Min / Max
The ball size is as large as the smallest/largest spring length of the vertex multiplied with the Ball
Size.
AvMiMax (“average min/max”)
Size = ((Min + Max)/2) × Ball Size.
Ball Size
Default 0.49 BU or fraction of the length of attached edges. The edge length is computed based on the
algorithm you choose. You know how when someone stands too close to you, and feel uncomfortable?
We call that our “personal space”, and this setting is the factor that is multiplied by the spring length. It is
a spherical distance (radius) within which, if another vertex of the same mesh enters, the vertex starts to
deflect in order to avoid a self-collision.
Set this value to the fractional distance between vertices that you want them to have their own “space”.
Too high of a value will include too many vertices all the time and slow down the calculation. Too low of
a level will let other vertices get too close and thus possibly intersect because there won’t be enough time
to slow them down.
Stiffness
Default 1.0. How elastic that ball of personal space is.
Damping
Default 0.5. How the vertex reacts. A low value just slows down the vertex as it gets too close. A high
value repulses it.
Collisions with other objects are set in the (other) Collision panel. To collide with another object they have to
share at least one common layer.

Simple examples
some simple examples showing the power of softbody physics.

bouncing cube
change your start and end frames to 1 and 150.

The timeline

add a plane, and scale it 5 times. next go to the physics tab, and add a collision. the default settings are fine for
this example.
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now add a cube, or use the default cube. Tab into edit mode and subdivide it thrice. then add a bevel modifier to
it, to smoothen the edges. to add a little more, press r twice, and move your cursor a bit.
when finisht, your scene should look like this:

The scene, ready for softbody physics

Everything is ready to add the softbody physics. go to the physics tab and add ‘softbody’. uncheck the soft body
goal , and check softbody self collision. under soft body edges, increase the bending to 10.
playing tha animation with alt a will now give a slow animation of a bouncing cube. to speed things up, we
need to bake the softbody physics.
Under Soft Body Cache change start and end to your start and end frames. in this case 1 and 150. to test if
everything is working, you can take a cache step of 5 or 10, but for the final animation it’s better to reduce it to
1, to cache everything.
when finisht, your physics panel should look like this:
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The physics settings.

you can now bake the simulation, give the cube materials and textures and render the animation.

Combination With Armatures
To Do

Combination With Hair Particles
To Do

Soft Body settings
Soft Body
This creates the soft body modifier on the selected object
Render
Enable soft body during render
Display
Display soft body in real time.

Soft Body
Friction
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The friction of the surrounding medium. Generally friction dampens a movement.
Mass
Mass value for vertices. Larger mass slows down acceleration, except for gravity where the motion is
constant regardless of mass. Larger mass means larger inertia, so also braking a Soft Body is more
difficult.
Vertex Group Mass
Use a specified vertex group for mass values
Speed
You can control the internal timing of the Softbody system with this value.

Soft Body Cache
Note
Start- and Endframe
The Start and End settings in the Collision panel are not only valid for the baking, but for all Soft Body
simulations. So if your animation lasts longer than 250 frames, you have to increase the End value.

Cache
Select cache to use for simulation. Add, and remove caches.
Cache Name
Specify the name of the cache.
Start / End
First and last frame of the simulation. Always valid, not only for baking.
Cache Step
Number of frames between cache steps.
Disk Cache
Save cache files to disk. Blend file must be saved first.
Use Lib Path
Use this files path when library linked into another file.
Compression
Compression method to be used
No
No compression.
Light
Fast but not so effective compression.
Heavy
Effective but slow compression.
Bake
Calculates the simulation and protects the cache. You need to be in Object mode to bake.
Free Bake
Clears the cache.
Calculate to Frame
Bake physics to current frame
Current Cache to Bake
Bake from Cache.
Bake All Dynamics
Bake all physics
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Free All Bakes
Free all baked caches of all objects in the current scene
Update All To Frame
Update cache to current frame
If you haven’t saved the blend file the cache is created in memory, so save your file first or the cache may be
lost.

Soft Body Goal
Use Goal
Soft Body Goal acts like a pin on a chosen set of vertices; controlling how much of an effect soft body
has on them. Enabling this tells Bforartists to use the position / animated position of a vertex in the
simulation. Animating the vertices can be done in all the usual ways before the Soft Body simulation is
applied. The goal is the desired end-position for vertices. How a softbody tries to achieve this goal can be
defined using stiffness forces and damping.
Default
A Goal value of 1.0 means no Soft Body simulation, the vertex stays at its original (animated) position.
When setting Goal to 0.0, the object is only influenced by physical laws. By setting goal values between
0.0 and 1.0, you can blend between having the object affected only by the animation system, and having
the object affected only by the soft body effect.
Minimum / Maximum
When you paint the values in vertex-groups (using Weight Paint mode), you can use the G Min and G
Max to fine-tune (clamp) the weight values. The lowest vertex-weight (blue) will become G Min, the
highest value (red) becomes G Max (please note that the blue-red color scale may be altered by User
Preferences).
Stiffness
The spring stiffness for Goal. A low value creates very weak springs (more flexible “attachment” to the
goal), a high value creates a strong spring (a stiffer “attachment” to the goal).
Damping
The friction for Goal. Higher values dampen the effect of the goal on the soft body.
Vertex Group
Use a vertex group to allow per-vertex goal weights (multiplied by the Default goal).

Soft Body Edges
Use Edges
The edges in a Mesh Object can act as springs as well, like threads in fabric.
Pull
The spring stiffness for edges (how much the edges are stretched). A low value means very weak springs
(a very elastic material), a high value is a strong spring (a stiffer material) that resists being pulled apart.
0.5 is latex, 0.9 is like a sweater, 0.999 is a highly-starched napkin or leather.
Push
How much the Softbody resist being scrunched together, like a compression spring. Low values for
fabric, high values for inflated objects and stiff material.
Damp
The friction for edge springs. High values (max of 50) dampen the edge stiffness effect and calm down
the cloth.
Plastic
Plasticity, permanent deformation of the object.
Bending
This option creates virtual connections between a vertex and the one after the next. This includes diagonal
18
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edges. Damping applies also to these connections.
Length
The edges can shrink or been blown up. This value is given in percent, 0 disables this function. 100%
means no change, the body keeps 100% of his size.
Stiff Quads
For quad faces, the diagonal edges are used as springs. This stops quad faces to collapse completely on
collisions (what they would do otherwise).
Shear
Stiffness of the virtual springs for quad faces.
Aerodynamics
Simple
If you turn on Aero the force is not confined to the vertices, but has an effect also on the edges. The
angle and the relative speed between medium and edge is used to calculate the force on the edge.
This force results that vertices with little connecting edges (front of a plane) fall faster than vertices
with more connecting edges (middle of a plane). If all vertices have the same amount of edges in a
direction they fall with equal speed. An edge moving in its own direction feels no force, and an edge
moving perpendicular to its own direction feels maximum force (think of a straw moving through
air). Try it with an Factor of 30 at first.
Lift Force
Use an aerodynamic model that is closer to physical laws and looks more interesting. Disable for a
more muted simulation.
Factor
How much aerodynamic effect to use
Edge
Checks for edges of the softbody mesh colliding.
Face
Checks for any portion of the face of the softbody mesh colliding (compute intensive!). While CFace
enabled is great, and solves lots of collision errors, there doesn’t seem to be any dampening settings for it,
so parts of the softbody object near a collision mesh tend to “jitter” as they bounce off and fall back, even
when there’s no motion of any meshes. Edge collision has dampening, so that can be controlled, but
Deflection dampening value on a collision object doesn’t seem to affect the face collision.

Soft Body Self Collision
Self Collision is working only if you have activated Use Edges.
Self Collision
When enabled, allows you to control how Bforartists will prevent the Soft Body from intersecting with
itself. Every vertex is surrounded with an elastic virtual ball. Vertices may not penetrate the balls of other
vertices. If you want a good result you may have to adjust the size of these balls. Normally it works pretty
well with the default options.
Manual
The Ball Size directly sets the ball size (in BU).
Averavge (“average”)
The average length of all edges attached to the vertex is calculated and then multiplied with the Ball Size
setting. Works well with evenly distributed vertices.
Minimal / Maximal
The ball size is as large as the smallest/largest spring length of the vertex multiplied with the Ball Size.
AvMiMax
Size = ((Min + Max)/2) × Ball Size.
Size
Default 0.49 BU or fraction of the length of attached edges. The edge length is computed based on the
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algorithm you choose. You know how when someone stands too close to you, and feel uncomfortable?
We call that our “personal space”, and this setting is the factor that is multiplied by the spring length. It is
a spherical distance (radius) within which, if another vertex of the same mesh enters, the vertex starts to
deflect in order to avoid a self-collision. Set this value to the fractional distance between vertices that you
want them to have their own “space”. Too high of a value will include too many vertices all the time and
slow down the calculation. Too low of a level will let other vertices get too close and thus possibly
intersect because there won’t be enough time to slow them down.
Stiffness
Default 1.0. How elastic that ball of personal space is.
Dampening
Default 0.5. How the vertex reacts. A low value just slows down the vertex as it gets too close. A high
value repulses it.
Collisions with other objects are set in the (other) Collision panel. To collide with another object they have to
share at least one common layer.

Soft Body Solver
These settings determine the accurateness of the simulation.
Min Step
Minimum simulation steps per frame. Increase this value, if the Soft Body misses fast moving collision
objects.
Max Step
Maximum simulation steps per frame. Normally the number of simulation steps is set dynamically (with
the Error Limit) but you have probably a good reason to change it.
Auto-Step
helps the Solver figure out how much work it needs to do based on how fast things are moving.
Error Limit
Rules the overall quality of the solution delivered. Default 0.1. The most critical setting that says how
precise the solver should check for collisions. Start with a value that is 1/2 the average edge length. If
there are visible errors, jitter, or over-exaggerated responses, decrease the value. The solver keeps track of
how “bad” it is doing and the Error Limit causes the solver to do some “adaptive step sizing”.
Fuzzy
Fuzziness while on collision, high values make collision handling faster but less stable.
Choke
Calms down (reduces the exit velocity of) a vertex or edge once it penetrates a collision mesh.
Print Performance to Console
Prints on the console how the solver is doing.
Estimate Matrix
Estimate matrix... split to COM, ROT, SCALE
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Rigid Body
The rigid body simulation can be used to simulate the motion of solid objects. It affects the position and
orientation of objects and does not deform them.
Unlike the other simulations in Bforartists, the rigid body sim works closer with the animation system. This
means that rigid bodies can be used like regular objects and be part of parent-child relationships, animation
constraints and drivers.

Creating a Rigid Body
Creating the Rigid Body.
Right now only mesh objects can participate in the rigid body simulation. To create rigid bodies, either click on
Rigid Body button in the Physics context of the Properties window or use the Add Active/AddPassive buttons in
the Physics tab of the Tool Shelf.
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There are two types of rigid body: active and passive. Active bodies are dynamically simulated, while passive
bodies remain static. Both types can be driven by the animation system when using the Animated option.
During the simulation, the rigid body system will override the position and orientation of dynamic rigid body
objects. Note however that the location and rotation of the objects is not changed, so the rigid body sim acts
similar to a constraint. To apply the rigid body transformations you can use the Apply Transformation button in
the Physics tab of the Tool Shelf.
The scale of the rigid body object also influences the simulation, but is always controlled by the animation
system.
Rigid Body physics on the object can be removed with the Rigid Body button in the Physics context or Remove
button in the Physics tab of the Tool Shelf.

Rigid Body Properties
Main properties
Rigid Body panel.
Type
Role of the rigid body in the simulation. Active objects can be simulated dynamically, passive object
remain static.
Active
Object is directly controlled by simulation results. The possibility to select this type also available
with Add Active button in the Physics tab of the Tool Shelf.
Passive
Object is directly controlled by animation system. Thus, this type is not available for Rigid Body
Dynamics. The possibility to select this type also available with Add Passive button in the Physics
tab of the Tool Shelf.
Dynamic
Enables/disables rigid body simulation for object.
Animated
Allows the rigid body additionally to be controlled by the animation system.
Mass
Specifies how heavy the object is and “weights” irrespective of gravity. There are predefined mass preset
available with the Calculate Mass button in the Physics tab of the Tool Shelf.
Calculate Mass
Automatically calculate mass values for Rigid Body Objects based on volume. There are many
useful presets available from the menu, patching real-world objects.
Also you can have Custom mass material type, which is achieved by setting a custom density value
(kg/m3).
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Rigid Body Collisions
Rigid Body Collisions panel.

General settings
Surface Response
Friction
Resistence of object to movement. Specifies how much velocity is lost when objects collide with
each other.
Bounciness
Tendency of object to bounce after colliding with another (“0” - stays still, “1” - perfectly elastic).
Specifies how much objects can bounce after collisions.
Collision Groups
Allows rigid body collisions allocate on different groups (maximum 20).

Collision shapes
The Shape option determines the collision shape of the object. The following Collision Shapes are available:
• Primitive shapes : these are best in terms of memory/performance but don’t necessarily
reflect the actual shape of the object. They’re calculated based on the object’s bounding box.
The center of gravity is always in the middle for now.
• Box
Box-like shapes (i.e. cubes), including planes (i.e. ground planes).
The size per axis is calculated from the bounding box.
• Sphere
Sphere-like shapes. The radius is the largest axis of the bounding
box.
• Capsule
This points up the Z-Axis.
• Cylinder
This points up the Z-Axis. The height is taken from the z-axis,
while the radius is the larger of the x/y-axes.
• Cone
This points up the Z-Axis. The height is taken from the z-axis,
while the radius is the larger of the x/y-axes.
• Mesh based shapes : these are calculated based on the geometry of the object so they are a
better representation of the object. The center of gravity for these shapes is the object origin.
• Convex Hull
A mesh-like surface encompassing (i.e. shrinkwrap over) all
3
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vertices (best results with fewer vertices). Convex approximation
of the object, has good performance and stability.
• Mesh
Mesh consisting of triangles only, allowing for more detailed
interactions than convex hulls. Allows to simulate concave objects,
but is rather slow and unstable.
The changing collision shape is available also with Change Shape button in the Physics tab of the Tool Shelf.

Mesh source
Users can now specify the mesh Source for Mesh bases collision shapes:
Base
The base mesh of the object.
Deform
Includes any deformations added to the mesh (shape keys, deform modifiers).
Deforming
Rigid body deforms during simulation.
Final
Includes all modifiers.

Collision Margin
Margin
Threshold of distance near surface where collisions are still considered (best results when non-zero).
The collision margin is used to improve performance and stability of rigid bodies. Depending on the shape, it
behaves differently: some shapes embed it, while others have a visible gap around them.
The margin is embedded for these shapes:
•
•
•
•
•

Sphere
Box
Capsule
Cylinder
Convex Hull: Only allows for uniform scale when embedded.

The margin is not embedded for these shapes:
• Cone
• Active Triangle Mesh
• Passive Triangle Mesh: Can be set to 0 most of the time.

Rigid Body Dynamics
Rigid Body Dynamics panel.
This panel is available only for Active type of rigid bodies.
Deactivation:
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Enable Deactivation
Enable deactivation of resting rigid bodies. Allows object to be deactivated during the simulation
(improves performance and stability, but can cause glitches).
Start Deactivated
Starts objects deactivated. They are activated on collision with other objects.
Linear Vel
Specifies the linear deactivation velocity below which the rigid body is deactivated and simulation
stops simulating object.
Angular Vel
Specifies the angular deactivation velocity below which the rigid body is deactivated and simulation
stops simulating object.
Damping:
Translation
Amount of linear velocity that is lost over time.
Rotation
Amount of angular velocity that is lost over time.

Rigid Body World
Rigid Body World panel.
The rigid body world is a group of Rigid Body objects, which holds settings that apply to all rigid bodies in this
simulation and can be found in Rigid Body World panel of Scene context.
When you add Rigid Body physics on an object, primary there is created a group of objects with default
“RigidBodyWorld” name. Rigid body objects automatically are added to this group when you add Rigid Body
physics for them.
You can be create several Rigid Body World groups and allocate there yours Rigid Body objects with Groups
panel in Object context.
Rigid body objects and constraints are only taken into account by the simulation if they are in the groups
specified in Group field of the Rigid Body World panel in the Scene context.
Rigid Body World checkbox
Enable/disable evaluation of the Rigid Body simulation based on the rigid body objects participating in
the specified group of Rigid Body World.
Remove Rigid Body World button
Remove Rigid Body simulation from the current scene.
Group
Containing rigid body objects participating in this simulation.
Constraints
Containing rigid body object constraints participating in the simulation.
Simulation quality and timing settings:
Speed
Can be used to speed up/slow down the simulation.
Split Impulse
Enable/disable reducing extra velocity that can build up when objects collide (lowers simulation stability
5
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a little so use only when necessary). Limits the force with which objects are separated on collision,
generally produces nicer results, but makes the simulation less stable (especially when stacking many
objects).
Steps Per Second
Number of simulation steps made per second (higher values are more accurate but slower). This only
influences the accuracy and not the speed of the simulation.
Solver Iterations
Amount of constraint solver iterations made per simulation step (higher values are more accurate but
slower). Increasing this makes constraints and object stacking more stable.

Rigid Body caching and baking
Rigid Body Cache panel.
Specifies the frame range in which the simulation is active. Can be used to bake the simulation.
Start/End
First and last frame of the simulation.
Bake
Calculates the simulation and protects the cache. You need to be in Object mode to bake.
Free Bake
Active after the baking of simulation. Clears the baked cache.
Calculate to Frame
Bake physics to current frame.
Current Cache to Bake
Bake from Cache.
Bake All Dynamics
Bake all physics.
Free All Bakes
Free all baked caches of all objects in the current scene.
Update All To Frame
Update cache to current frame.
If you haven’t saved the blend file, the cache is created in memory, so save your file first or the cache may be
lost.

External Force Influence on Rigid Body
Rigid Body Cache panel.
As other physics dynamics systems, Rigid Body simulation are also influenced by external force effectors.

Rigid Body Constraints
Constraints (also known as joints) for rigid bodies connect two rigid bodies.
The physics constraints available in the non-game modes are meant to be attached to an Empty object. The
constraint then has fields which can be pointed at the two physics-enabled object which will be bound by the
constraint. The Empty object provides a location and axis for the constraint distinct from the two constrained
6
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objects. The location of the entity hosting the physics constraint marks a location and set of axes on each of the
two constrained objects. These two anchor points are calculated at the beginning of the animation and their
position and orientation remain fixed in the local coordinate system of the object for the duration of the
animation. The objects can move far from the constraint object, but the constraint anchor moves with the object.
If this feature seems limiting, consider using multiple objects with a non-physics Child-of constraint and
animate the relative location of the child.
The quickest way to constrain two objects is to select both and click the Connect button in the Physics tab of
the Tool Shelf. This creates a new Empty object (named “Constraint”) with a physics constraint already attached
and pointing at the two selected objects.
Also you can create Rigid Body Constaint on of the two constrained objects with Rigid Body Constaint button
of the Physics context in the Properties window. This constraint be depend on the object location and rotation
which on it created. Thereafterat, there are no Empty object created for the constraint. The role of the Empty
object is put on this object. The constrained object can be then set as Passive type for better driving the
constrain.
Additional parameters appear in the Rigid Body Constaint panel of the Physics context in the Properties
window for the selected Empty object or the one of the two constrained objects with the created constraint.

Common Options
Rigid Body Constraint panel.
Enabled
Specifies whether the constraint is active during the simulation.
Disable Collisions
Allows constrained objects to pass through one another.
Object 1
First object to be constrained.
Object 2
Second object to be constrained.
Breakable
Allows constraint to break during simulation. Disabled for the Motor constraint.
Threshold
Impulse strength that needs to be reached before constraint breaks.
Override Iterations
Allows to make constraints stronger (more iterations) or weaker (less iterations) than specified in the rigid
body world.
Iterations
Number of constraint solver iterations made per simulation step for this constraint.
Limits
By using limits you can constrain objects even more by specifying a translation/rotation range on/around
respectively axis (see below for each one individually). To lock one axis, set both limits to 0.
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Fixed

Options available to a Fixed constraint.

This constraint cause the two objects to move as one. Since the physics system does have a tiny bit of slop in it,
the objects don’t move as rigidly as they would if they were part of the same mesh.

Point

Options available to a Point constraint.

The objects are linked by a point bearing allowing any kind of rotation around the location of the constraint
object, but no relative translation is permitted. The physics engine will do its best to make sure that the two
points designated by the constraint object on the two constrained objects are coincident.
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Hinge

Options available to a Hinge constraint.

The hinge permits 1 degree of freedom between two objects. Translation is completely constrained. Rotation is
permitted about the Z axis of the object hosting the Physics constraint (usually an Empty, distinct from the two
objects that are being linked). Adjusting the position and rotation of the object hosting the constraint allows you
to control the anchor and axis of the hinge.
The Hinge is the only 1-axis rotational constraint that uses the Z axis instead of the X axis. If something is
wrong with your hinge, check your other constraints to see if this might be the problem.
Limits:
Z Angle
Enables/disables limit rotation around Z axis.
Lower
Lower limit of Z axis rotation.
Upper
Upper limit of Z axis rotation.

Slider
The Slider constraint allows relative translation along the X axis of the constraint object, but permits no relative
rotation, or relative translation along other axes.
Limits:
X Axis
Enables/disables limit translation around X axis.
Lower
Lower limit of X axis translation.
Upper
Upper limit of X axis translation.
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Piston
A piston permits translation along the X axis of the constraint object. It also allows rotation around the X axis
of the constraint object. It’s like a combination of the freedoms of a slider with the freedoms of a hinge (neither
of which is very free alone).
Limits:
X Axis
Enables/disables limit translation around X axis.
Lower
Lower limit of X axis translation.
Upper
Upper limit of X axis translation.
X Angle
Enables/disables limit rotation around X axis.
Lower
Lower limit of X axis rotation.
Upper
Upper limit of X axis rotation.

Generic
The generic constraint has a lot of available parameters.
The X, Y, and Z axis constraints can be used to limit the amount of translation between the objects. Clamping
the min/max to zero has the same effect as the Point constraint.
Clamping the relative rotation to zero keeps the objects in alignment. Combining an absolute rotation and
translation clamp would behave much like the Fixed constraint.
Using a non-zero spread on any parameter allows it to rattle around in that range throughout the course of the
simulation.
Limits:
X Axis/Y Axis/Z axis
Enables/disables limit translation on X, Y or Z axis respectively.
Lower
Lower limit of translation for X, Y or Z axis respectively.
Upper
Upper limit of translation for X, Y or Z axis respectively.
X Angle/Y Angle/Z Angle
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Enables/disables limit rotation around X, Y or Z axis respectively.
Lower
Lower limit of rotation for X, Y or Z axis respectively.
Upper
Upper limit of rotation for X, Y or Z axis respectively.

Generic Spring

Options available to a Generic Spring constraint.

The generic spring constraint adds some spring parameters for the X/Y/Z axes to all the options available on the
Generic constraint. Using the spring alone allows the objects to bounce around as if attached with a spring
anchored at the constraint object. This is usually a little too much freedom, so most applications will benefit
from enabling translation or rotation constraints.
If the damping on the springs is set to 1, then the spring forces are prevented from realigning the anchor points,
leading to strange behavior. If your springs are acting weird, check the damping.
Limits:
X Axis/Y Axis/Z axis
Enables/disables limit translation on X, Y or Z axis respectively.
Lower
Lower limit of translation for X, Y or Z axis respectively.
Upper
Upper limit of translation for X, Y or Z axis respectively.
X Angle/Y Angle/Z Angle
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Enables/disables limit rotation around X, Y or Z axis respectively.
Lower
Lower limit of rotation for X, Y or Z axis respectively.
Upper
Upper limit of rotation for X, Y or Z axis respectively.
Springs:
X/Y/Z
Enables/disables springs on X, Y or Z axis respectively.
Stiffness
Spring Stiffness on X, Y or Z axis respectively. Specifies how “bendy” the spring is.
Damping
Spring Damping on X, Y or Z axis respectively. Amount of damping the spring has.

Motor

Options available to a Motor constraint.

The motor constraint causes translation and/or rotation between two entities. It can drive two objects apart or
together. It can drive simple rotation, or rotation and translation (although it won’t be constrained like a screw
since the translation can be blocked by other physics without preventing rotation).
The rotation axis is the X axis of the object hosting the constraint. This is in contrast with the Hinge which uses
the Z axis. Since the Motor is vulnerable to confusing perturbations without a matching Hinge constraint,
special care must be taken to align the axes. Without proper alignment, the motor will appear to have no effect
(because the hinge is preventing the motion of the motor).
Linear motor/Angular motor:
Enable
Enable linear or angular motor respectively.
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Target Velocity
Target linear or angular motor velocity respectively.
Max Impulse
Maximum linear or angular motor impulse respectively.

Tips
As with all physics-enabled objects, pay close attention to the Animated check box in the Rigid Body panel of
the Physics context in the Properties window. A common mistake is to use keyframe animation on a Passive
physics object without checking the Animated box. The object will move, but the physics engine will behave as
if the Passive is still in its starting place, leading to disappointment.

Animation
The most common trick is to keyframe animate the location or rotation of an Active physics object as well as the
Animated checkbox. When the curve on the Animated property switches to disabled, the physics engine takes
over using the object’s last known location, rotation and velocities.
Animating the strengths of various other parameters (a Motor’s Target Velocity, a Hinge’s limits, etc) can be
used to accomplish a wide variety of interesting results.
Enabling a constraint during the physics simulation often has dramatic results as the physics engine tries to
bring into alignment two objects which are often dramatically out of alignment. It is very common for the
affected objects to build up enough kinetic energy to bounce themselves out of camera (and into orbit, although
the physics engine is not yet capable of simulating a planet’s gravity well, so scratch that).
Rigid Body dynamics can be baking to normal keyframes with Bake To Keyframes button in the Physics tab of
the Tool Shelf.

Simulation Stability
The simplest way of improving simulation stability is to increase the steps per second. However, care has to be
taken since making too many steps can cause problems and make the simulation even less stable (if you need
more than 1000 steps, you should look at other ways to improve stability).
Increasing the number of solver iterations helps making constraints stronger and also improves object stacking
stability.
It’s best to avoid small objects, as they’re currently unstable. Ideally, objects should be at least 20 cm in
diameter. If it’s still necessary, setting the collision margin to 0, while generally not recommended, can help
making small object behave more naturally.
When objects are small and/or move very fast, they can pass through each other. Besides what’s mentioned
above it’s also good to avoid using mesh shapes in this case. Mesh shapes consist of individual triangles and
therefore don’t really have any thickness, so objects can pass through more easily. You can give them some
thickness by increasing the collision margin.
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Combining Rigid Bodies with Other Simulations
Since the rigid body simulation is part of the animation system, it can influence other simulations just like the
animation system can.
In order for this to work, the rigid body object needs to have a collision modifier. Simply click on Collision in
the Physics context.

Scaling Rigid Bodies
Rigid body objects can be scaled, also during the simulation. This work well in most cases, but can sometimes
cause problems.
If dynamic scaling is not needed, rigid body objects should have the scale applied by using the Apply Scale
command
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Force Fields
Force Fields offer a way to add extra movement to dynamic systems. Particles, Soft Bodies, Rigid Bodies and
Cloth objects can all be affected by forces fields. Force Fields automatically affect everything. To remove a
simulation or particle system from their influence, simply turn down the influence of that type of Force Field in
its Field Weights panel.
• All types of objects and particles can generate fields, but only curve object can bear Curve Guides
fields.
• Force Fields can also be generated from particles. See Particle Physics
• The objects need to share at least one common layer to have effect.
You may limit the effect on particles to a group of objects (see the Particle Physics page).

Creating a Force Field
Reference
Mode: Object Mode
Panel: Object context –> Physics sub-context –> Fields

To create a single Force Field, you can select Add ‣ Force Field and select the desired force field. This method
creates an Empty with the force field attached.
To create a field from an existing object you have to select the object and change to the Physics sub-context.
1

Bforartists Reference Manual - © Copyright - This page is under OCL license

Select the field type in the Fields menu.
The fields have many options in common, these common options are explained for the Spherical field.
Note
After changing the fields (Fields panel) or deflection (Collision panel) settings, you have to recalculate the
particle, softbody or cloth system (Free Cache), this is not done automatically. You can clear the cache for all
selected objects with Free cache selected.
Particles react to all kind of Force Fields, Soft Bodies only to Spherical / Wind / Vortex (they react on
Harmonic fields but not in a useful way).

Common Field Settings
Most Fields have the same settings, even though they act very differently. Settings unique to a field type are
described below. Curve Guide and Texture Fields have very different options.
Shape
The field is either a Point, with omnidirectional influence, or a Plane, constant in the XY-plane, changes
only in Z direction.
Strength
The strength of the field effect. This can be positive or negative to change the direction that the force
operates in. A force field’s strength is scaled with the force object’s scale, allowing you to scale up and
down scene, keeping the same effects.
Flow
Convert effector force into air flow velocity.
Noise
Adds noise to the strength of the force.
Seed
Changes the seed of the random noise.
Effect Point
You can toggle the field’s effect on particle Location and Rotation
Collision Absorption
Force gets absorbed by collision objects.

Falloff
Here you can specify the shape of the force field (if the Fall-off Power is greater than 0).
Sphere
Falloff is uniform in all directions, as in a sphere.
Tube
Fall off results in a tube shaped force field. The Field’s Radial falloff can be adjusted, as well as the
Minimum and Maximum distances of the field.
Cone
Fall off results in a cone shaped force field. Additional options are the same as those of Tube options.
Z Direction
Fall-off can be set to apply only in the direction of the positive Z Axis, negative Z Axis, or both.
Power (Power)
How the power of the force field changes with the distance from the force field. If r is the distance from
2
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the center of the object, the force changes with 1/rPower. A Fall-off of 2 changes the force field with
1/r2, which is the falloff of gravitational pull.
Max Distance
Makes the force field only take effect within a specified maximum radius (shown by an additional circle
around the object).
Min Distance
The distance from the object center, up to where the force field is effective with full strength. If you have
a Fall-off of 0 this parameter does nothing, because the field is effective with full strength up to Max Dist
(or the infinity). Shown by an additional circle around the object.

Types
•
•
•
•
•
•
•
•
•
•
•
•
•

Force
Wind
Vortex Field
Magnetic
Harmonic
Charge
Lennard Jones
Texture Field
Curve Guide
Boid
Turbulence
Drag
Smoke Flow

Force
The Force field is the simplest of the fields. It gives a constant force towards (positive strength) or away from
(negative strength) the object’s center. Newtonian particles are attracted to a field with negative strength, and
are blown away from a field with positive strength.
For Boids a field with positive strength can be used as a Goal, a field with negative strength can be used as
Predator. Whether Boids seek or fly goals/predators depends on the Physics settings of the Boids.

Image 2b: Spherical field indicator.

Wind
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Image 3a: Wind field indicator.

Wind gives a constant force in a single direction, along the force object’s local Z axis. The strength of the force
is visualized by the spacing of the circles shown.

Vortex Field

Image 3b: Vortex field indicator.

Vortex fields give a spiraling force that twists the direction of points around the force object’s local Z axis. This
can be useful for making a swirling sink, or tornado, or kinks in particle hair.

Magnetic
This field depends on the speed of the particles. It simulates the force of magnetism on magnetized objects.

Harmonic
The source of the force field is the zero point of a harmonic oscillator (spring, pendulum). If you set the
Damping parameter to 1, the movement is stopped in the moment the object is reached. This force field is really
special if you assign it to particles.
Rest Length
Controls the rest length of the harmonic force.
Multiple Springs
4
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Causes every point to be affected by multiple springs.
Normally every particle of the field system influences every particle of the target system. Not with Harmonic !
Here every target particle is assigned to a field particle. So particles will move to the place of other particles,
thus forming shapes. Tutorial: Particles forming Shapes

Charge
It is similar to spherical field except it changes behavior (attract/repulse) based on the effected particles charge
field (negative/positive), like real particles with a charge. This mean this field has only effect on particles that
have also a Charge field (else, they have no “charge”, and hence are unaffected)!

Lennard Jones
This field is a very short range force with a behavior determined by the sizes of the effector and effected
particle. At a distance smaller than the combined sizes the field is very repulsive and after that distance it’s
attractive. It tries to keep the particles at an equilibrium distance from each other. Particles need to be at a close
proximity to each other to be effected by this field at all.
Particles can have for example both a charge and a Lennard-Jones potential - which is probably something for
the nuclear physicists amongst us.

Texture Field
You can use a texture force field to create an arbitrarily complicated force field, which force in the 3 directions
is color coded. Red is coding for the x-axis, green for the y-axis and blue for the z-axis (like the color of the
coordinate axes in the 3D window). A value of 0.5 means no force, a value larger than 0.5 acceleration in
negative axis direction (like -Z), a value smaller than 0.5 acceleration in positive axis direction (like +Z).
Texture mode
This sets the way a force vector is derived from the texture.
RGB
Uses the color components directly as the force vector components in the color encoded directions.
You need an RGB texture for this, e.g. an image or a colorband. So a Blend texture without a
colorband would not suffice.
Gradient
Calculates the force vector as the 3d-gradient of the intensity (grayscale) of the texture. The
gradient vector always points to the direction of increasing brightness.
Curl
Calculates the force vector from the curl of the 3d-rgb texture (rotation of rgb vectors). This also
works only with a color texture. It can be used for example to create a nice looking turbulence force
with a color clouds texture with perlin noise.
5
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Nabla
It is the offset used to calculate the partial derivatives needed for Gradient and Curl texture modes.
Use Object Coordinates
Uses the emitter object coordinates (and rotation & scale) as the texture space the particles use. Allows
for moving force fields, that have their coordinates bound to the location coordinates of an object.
Root Texture Coordinates
This is useful for hair as it uses the texture force calculated for the particle root position for all parts of the
hair strand.
2D
The 2D button disregards the particles z-coordinate and only uses particles x&y as the texture
coordinates.
Remember that only procedural texture are truly 3D.

Examples
• A single colored texture 0.5/0.0/0.5 creates a force in the direction of the positive y-axis, e.g. hair is
orientated to the y-axis.
• A blend texture with colorband can be used to created a force “plane”. E.g. on the left side 0.5/0.5/0.5,
on the right side 1.0/0.5/0.5 you have a force plane perpendicular to XY (i.e. parallel to Z). If you use an
object for the coordinates, you can use the object to push particles around.
• An animated wood texture can be used to create a wave like motion.

Curve Guide
The Curve Guild is used to force particles to follow a certain path defined by a Curve Object.

Example of Curve Guide.

A typical scenario would be to move a red blood cell inside a vein, or to animate the particle flow in a motor.
6
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You can use Curve Guide s also to shape certain hair strands.
Note
You can also use the Particle Mode to define a path.

Since you can animate curves as Softbody or any other usual way, you may build very complex animations
while keeping great control and keeping the simulation time to a minimum.
The option Curve Follow does not work for particles. Instead you have to set Angular Velocity (in the Physics
panel of the Particle sub-context) to Spin and leave the rotation constant (i.e. don’t turn on Dynamic).
Curve Guide s affect all particles on the same layer, independently from their distance to the curve. If you have
several guides in a layer, their fields add up to each other (the way you may have learned it in your physics
course). But you can limit their influence radius by changing there Minimum Distance (see below).
Note
The Curve Guide does not effect Softbodys.

Options

Curve Guide Settings.

Minimum Distance
The distance from the curve, up to where the force field is effective with full strength. If you have a Falloff of 0 this parameter does nothing, because the field is effective with full strength up to MaxDist (or the
infinity). MinDist is shown with a circle at the endpoints of the curve in the 3D window.
Free
Fraction of particle life time, that is not used for the curve.
Fall-off
This setting governs the strength of the guide between MinDist and MaxDist. A Fall-off of 1 means a
linear progression.
A particle follows a Curve Guide during it’s lifetime, the velocity depends from it’s lifetime and the length of
the path.

7
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Additive
If you use Additive, the speed of the particles is also evaluated depending on the Fall-off.
Weights
Use Curve weights to influence the particle influence along the curve.
Maximum Distance / Use Max
The maximum influence radius. Shown by an additional circle around the curve object.
The other settings govern the form of the force field along the curve.
Clumping Amount
The particles come together at the end of the curve (1) or they drift apart (-1).
Shape
Defines the form in which the particles come together. +0.99: the particles meet at the end of the curve. 0:
linear progression along the curve. -0.99: the particles meet at the beginning of the curve.
Kink
Changes the shape that the particles can take:
Curl
The radius of the influence depends on the distance of the curve to the emitter.
Radial
A three dimensional, standing wave.
Wave
A two dimensional, standing wave.
Braid
Braid.
Roll
A one dimensional, standing wave.
It is not so easy to describe the resulting shapes, so have a look at the example below.

Kink options of a curve guide. From left to right: Radial, Wave, Braid, Roll. Animation

Frequency
The frequency of the offset.
Shape
8
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Adjust the offset to the beginning/end.
Amplitude
The Amplitude of the offset.

Boid
Boid probably comes from theoretical works. Boids is an artificial life program, developed by Craig Reynolds
in 1986, which simulates the flocking behaviour of birds. His paper on this topic was published in 1987 in the
proceedings of the ACM SIGGRAPH conference. The name refers to a “bird-like object”, but its pronunciation
evokes that of “bird” in a stereotypical New York accent. As with most artificial life simulations, Boids is an
example of emergent behavior; that is, the complexity of Boids arises from the interaction of individual agents
(the boids, in this case) adhering to a set of simple rules. The rules applied in the simplest Boids world are as
follows: separation: steer to avoid crowding local flockmates alignment: steer towards the average heading of
local flockmates cohesion: steer to move toward the average position (center of mass) of local flockmates More
complex rules can be added, such as obstacle avoidance and goal seeking.

Turbulence
Creates a random & chaotic 3d noise effect, similar to jets of water or geysers under the ocean.

Turbulence force field affecting a particle system.

Size
9
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Indicates the scale of the noise.
Global
Makes the size and strength of the noise relative to the world, instead of the object it is attached to.

Drag
Drag is a force that works to resist particle motion by slowing it down.
Linear
Drag component proportional to velocity.
Quadratic
Drag component proportional to the square of the velocity.

Smoke Flow
Todo.
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9.10 Physics - Baking Physics Simulations
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Baking Physics Simulations
Baking refers to the act of storing or caching the results of a calculation.
It’s generally recommended to bake your physics simulations before rendering. Aside from no longer needing to
go through the time-consuming process of simulating again, baking can help prevent potential glitches and
ensure that the outcome of the simulation remains exactly the same every time.
Note
Most physics simulators in Bforartists use a similar system, but not all have exactly the same settings
available. All the settings are covered here, but individual physics types may not provide all these options.

Compression
Compression level for cache files. Some physics caches can be very large (such as smoke). Bforartists can
compress these caches in order to save space.
Light compression optimizes speed of compressing/decompressing operations over file size. Heavy
compression will result in smaller cache files more than Light, however requires more CPU time to
compress/decompress.
External
Read and write the cache to disk using a user-specified file path.
Index Number
This number specifies which cache should be used when the specified cache directory contains
multiple caches. 0 refers to the top-most cache, 1 to the second from the top, 2 to the third, and so
on.
Use Lib Path
Share the disk cache when the physics object is linked into another blendfile.
When this option is enabled, linked versions of the object will reference the same disk cache. When
disabled, linked versions of the object will use independent caches.
Start
Frame on which to start the simulation.
End
Frame on which to stop the simulation.
Cache Step
Interval for storing simulation data.
1
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Some physics systems (such as particles) allow for positions to be stored only on every nth frame, letting
the positions for in-between frames be interpolated. Using a cache step greater than 1 will result in a
smaller cache, but the result may differ from the original simulation.
Bake
Start baking. Bforartists will become unresponsive during most baking operations. The cursor will display
as a number representing the bakes’ progress.
Free Bake
Mark the baked cache as temporary. The data will still exist, but will be removed with the next object
modification and frame change. This button is only available when the physics system has been baked.
Calculate To Frame
Bake only up to the current frame. Limited by End frame set in the cache settings.
Current Cache to Bake
Store any temporarily cached simulation data as a bake. Note that playing the animation will try to
simulate any visible physics simulations. Depending on the physics type, this data may be temporarily
cached. Normally such temporary caches are cleared when an object or setting is modified, but converting
it to a bake will “save” it.
Bake All Dynamics
Bake all physics systems in the scene, even those of different types. Useful for baking complex setups
involving interactions between different physics types.
See Bake
Free All Bakes
Free bakes of all physics systems in the scene, even those of different types.
See Free Bake.
Update All To Frame
Bake all physics systems in the scene to the current frame.
See Calculate To Frame

Multiple Caches
Bforartists allows for storing and managing multiple caches at once for the same physics object.

Two different caches stored simultaneously.

2

Bforartists Reference Manual - © Copyright - This page is under OCL license

Caches can be added and removed with the Plus and Minus buttons. Renaming a cache can be done by either
double clicking or pressing Ctrl-LMB on the desired cache.
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Rendering
Rendering is the process of creating a 2D image (or video) from your 3D scene. What that image looks like is
based on four factors which the user can control:
•
•
•
•

A Camera
The Lighting in your scene
The Material of each object
Various render settings (quality, image size, layers etc)

Your computer will perform various complex calculations based on those factors in order to give you your
rendered image. This process may take some time depending on the complexity of the scene and your hardware.
Once the render is complete, it is possible to do additional manipulation of the image, called Post Processing.
Finally, the output can be saved to an image or video file using one of the Output Formats.
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Workflow
In general, the process for rendering is:
1.
2.
3.
4.
5.
6.
7.
8.

Position the camera
Light the scene
Setup materials
Render a test image using lower quality settings
Change or fix anything you noticed in the render
Repeat the above two steps until you are satisfied
Render a high quality image, change or fix any issues and repeat until satisfied
Save your image to a file, or render the animation to a video or image sequence.

Render Engines
The Render Engine is the set of code which controls how your materials and lighting are used, and ultimately
what the rendered image looks like.
Some engines may be better at certain things than others due to the math they use or core principles around
which they were written.
Bforartists includes two render engines by default:
• Bforartists Render
• Cycles
More render engines from third-party developers can also be added using Add-ons

Render Output
The render output is what the render engines have produced. The result depends of the chosen render method.
You can display the result, you can post process it in various ways, and you can save the result.

Displaying and Saving Images
Rendering still images is fairly simple. Rendering Animations is a bit more complex and is covered in the next
sections.
To render an image from the active camera, in the Render Panel, press the Render button. By default the 3D
view is replaced with the UV/Image Editor and the render appears.

Displaying Renders
Renders are displayed in the Image Editor. You can set the way this is displayed to several different options in
the Display menu:
Keep UI
3
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The image is rendered to the Image Editor, but the UI remains the same. You will need to open the Image
Editor manually to see the render result.
New Window
A new floating window opens up, displaying the render.
Image Editor
One of the existing editors is replaced with the Image Editor, showing the render.
Full Screen
The Image editor replaces the UI, showing the render.
For each of these options, pressing Esc will close the render view and return to the previous view.

Saving
Rendered images can be saved like any other image: Using Image ‣ Save As Image or by pressing F3

Display Options
When a rendered image is displayed in the Image Editor, several new menu items become available.
Slot Menu
You can save successive renders into the render buffer by selecting a new slot before rendering. If an
image has been rendered to a slot, it can be viewed by selecting that slot. Empty slots appear as blank
grids in the image editor. Use the J and Alt-J to cycle forwards and backwards through saved renders.
Render Layer
If you are using Render Layers, use this menu to select which layer is displayed.
Render Pass
If you are using Render Passes, use this menu to select which pass is displayed.
Display Mode
The last four buttons set how the image is displayed.
RGB
Draw image as rendered, without alpha channel.
RGBA
Replaces transparent pixels with background checkerboard, denoting the alpha channel.
Alpha Channel
Displays a gray-scale image. White areas are opaque, black areas have an alpha of 0.
Z Depth
Display the depth from the camera, from Clip Start to Clip End, as specified in the Camera settings.

Animation Playback
The ‘Play’ button in the render panel will play back your rendered animation in a new window.
You can also drop images or movie files in a running animation player. It will then restart the player with the
new data.
A external player can be used instead by selecting it in the User Preferences.

Output Options
4

Bforartists Reference Manual - © Copyright - This page is under OCL license

The first step in the rendering process is to determine and set the output options. This includes render size,
frame rate, pixel aspect ratio, output location, and file type.

Dimensions
Resolution
X/Y
The number of pixels horizontally and vertically in the image.
Percentage slider
Reduce or increase the size of the rendered image relative to the X/Y values above. This is useful
for small test renders that are the same proportions as the final image.
Aspect Ratio
Older televisions may have non-square pixels, so this can be used to control the shape of the pixels along
the respective axis.
See Video Output for details on pixel aspect ratio.
Border
You can render just a portion of the view instead of the entire frame. While in
Camera View, choose Render Border in the View menu. Then in the viewport
drag a rectangle around the area that you want to render. When you render
the image now, then just this area gets rendered.
To remove the render border choose the menu item Clear Render Border.

This works also in the Image Editor at the
rendered result. The menu item is also in the
View menu here. But here you don't have the red
rectangle that shows the area to render.

Note
This disables the Save Buffers option in Performance and Full Sample option in Anti-Aliasing.

Enabling Crop will crop the rendered image to the Border size, instead of rendering a black region around
it.
5
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Frame Range
Set the Start and End frames for Rendering Animations. Step controls the number of frames to advance by
for each frame in the timeline.
Frame Rate
For an Animation the frame rate is how many frames will be displayed per second.
Time Remapping
Use to remap the length of an animation.

Presets
To make life easier the topmost menu provides some common presets. You can add your own or remove one
with the + and - buttons:

Output Panel
This panel provides options for setting the location of rendered frames for animations, and the quality of the
saved images.
File Path
Choose the location to save rendered frames.
When rendering an animation, the frame number is appended at the end of the file name with 4 padded
zeros (e.g. image0001.png). You can set a custom padding size by adding the appropriate number of #
at the end of the file name (e.g. image_##.png would translate to image_01.png).
Overwrite
Overwrite existing files when rendering
Placeholders
Create empty placeholder frames while rendering
File Extensions
Adds the correct file extensions per file type to the output files
Cache Result
Saves the rendered image to your hard drive. This is helpful for heavy compositing.
Output Format
Choose the file format to save to. Based on which format is used, other options such as channels, bitdepth and compression level are available.
Hint
Primitive Render-Farm
An easy way to get multiple machines to share the rendering workload is to:
• Set up a shared directory over a network file-system.
• Disable Overwrite, enable Placeholders in the Render Output panel.
• Start as many machines as you wish rendering to that directory
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Video Output
Preparing your work for video
Once you have mastered the trick of animation you will surely start to produce wonderful animations, encoded
with your favorite codecs, and possibly you’ll share them on the Internet with the rest of the community.
Sooner or later you will be struck with the desire to build an animation for television, or maybe burn your own
DVDs. To spare you some disappointment, here are some tips specifically targeted at Video preparation. The
first and principal one is to remember the double-dashed white lines in the camera view!
If you render for PC then the whole rendered image which lies within the outer dashed rectangle will be shown.
For television, some lines and some part of the lines will be lost due to the mechanics of the electron beam
scanning in your TV’s cathode ray tube. You are guaranteed that what is within the inner dashed rectangle in
camera view will be visible on the screen. Everything within the two rectangles may or may not be visible,
depending on the given TV set that your audience watches the video on.

Dimensions Presets

The rendering size is strictly dictated by the TV standard. There are various popular presets included, more can
be added for your convenience.
Saved information is:
Resolution:
Aspect ratio:
Frame rate:
See also Dimensions

X, Y & percentage scale
pixel aspect ratio
frames per second, for animation

Pixel Aspect Ratio
Unlike regular computer monitors, some screens (typically older TV sets) do not have the square pixels making
it it necessary to generate pre-distorted images which will look stretched on a computer but which will display
correctly on a TV set. It is important that you use the correct pixel aspect ratio when rendering to prevent rescaling, resulting in lowered image quality.
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Color Saturation
Most video tapes and video signals are not based on the RGB model but on the YCrCb model: more precisely,
the YUV in Europe (PAL), and the YIQ in the USA (NTSC), the latter being quite similar to the former. Hence
some knowledge of this is necessary too.
The YCrCb model sends information as ‘Luminance’, or intensity (Y) and two ‘Crominance’ signals, red and
blue (Cr and Cb). Actually a Black and White TV set shows only luminance, while color TV sets reconstruct
color from Crominances (and from luminance). Construction of the YCrCb values from the RGB ones takes
two steps (the constants in italics depend on the system: PAL or NTSC):
First, the Gamma correction (g varies: 2.2 for NTSC, 2.8 for PAL):
• R’ = R 1/g :*G’ = G 1/g
• B’ = B 1/g
Then, the conversion itself:
• Y = 0.299R’ + 0.587G’ + 0.114B’
• Cr = a 1 (R’ - Y) + b 1 (B’ - Y)
• Cb = a 2 (R’ - Y) + b 2 (B’ - Y)
Whereas a standard 24 bit RGB picture has 8 bits for each channel, to keep bandwidth down, and considering
that the human eye is more sensitive to luminance than to chrominance, the luminance signal is sent with more
bits than the two chrominance signals. This bit expansion results in a smaller dynamic of colors in video, than
what you are used to on monitors. You hence have to keep in mind that not all colors can be correctly displayed.
A rule of thumb is to keep the colors as ‘grayish’ or ‘unsaturated’ as possible; this roughly means keeping the
dynamics of your colors within 80% of one another. In other words, the difference between the highest RGB
value and the lowest RGB value should not exceed 0.8 ([0-1] range) or 200 ([0-255] range).
This is not strict - something more than 0.8 is acceptable - but an RGB display with color contrast that ranges
from 0.0 to 1.0 will appear to be very ugly (over-saturated) on video, while appearing bright and dynamic on a
computer monitor.

8
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Rendering to fields

Field Rendering result.

The TV standards prescribe that there should be 25 frames per second (PAL) or 30 frames per second (NTSC).
Since the phosphors of the screen do not maintain luminosity for very long, this could produce a noticeable
flickering.
To minimize this, a TV does not represent frames as a computer does (‘progressive’ mode), but rather
represents half-frames, or fields at a double refresh rate, hence 50 half frames per second on PAL and 60 half
frames per second on NTSC. This was originally bound to the frequency of power lines in Europe (50Hz) and
the US (60Hz).
In particular, fields are “interlaced” in the sense that one field presents all the even lines of the complete frame
and the subsequent field the odd ones.
Since there is a non-negligible time difference between each field (1/50 or 1/60 of a second) merely rendering a
frame the usual way and splitting it into two half frames does not work. A noticeable jitter of the edges of
moving objects would be present.

9
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Options

Field Rendering setup.

Fields
Enable field rendering. When the Fields button in the Render Panel is pressed (Post Processing section),
Bforartists prepares each frame in two passes. On the first it renders only the even lines, then it advances
in time by half a time step and renders all the odd lines. This produces odd results on a PC screen (Field
Rendering result). but will show correctly on a TV set.
Upper First / Lower First
Toggles between rendering the even and odd frames first.
Still
Disables the half-frame time step between fields (x).
Note
Setting up the correct field order
Bforartists’s default setting is to produce Even fields before Odd fields; this complies with European PAL
standards. Odd fields are scanned first on NTSC.
Of course, if you make the wrong selection things are even worse than if no Field rendering at all was used!
If you are really confused, a simple trick to determine the correct field order is to render a short test animation
of a white square moving from left to right on a black background. Prepare one version with odd field order
and another with even field order, and look at them on a television screen. The one with the right field order
will look smooth and the other one horrible. Doing this simple test will save you hours of wasted rendering
time...

Note
Fields and Composite Nodes
Nodes are currently not field-aware. This is partly due to the fact that in fields, too much information is
missing to do good neighborhood operations (blur, vector blur etc.). The solution is to render your animation
at double the frame rate without fields and do the interlacing of the footage afterwards.

Post Processed Effects
10
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There are several effects you can enable in the Render Settings that add visual elements to rendered images,
after the rendering has completed. These are not done in camera, but rather composited on top of the image.
Composited and Sequence are discussed in Output Options.
Fields are discussed in Video Output.
• Render Layers
• Layer List
• Layer Panel
• Using Render Layers
• Post Processing Panel
• Dithering
• Metadata
• Color Management
• Scene Linear Color Space
• Settings
• Image Files
• OpenColorIO Configuration
• Compatibility

Render Layers
Reference
Editor: Properties
Context: Render Layers

Render layers allow you to render your scene in separate layers, usually with the intension of compositing them
back together afterwards.
This can be useful for several purposes, such as color correcting certain elements differently, blurring the
foreground as a fast manual method of creating DoF, or reducing the render quality for unimportant objects.
Using Render Layers can also save you from having to re-render your entire image each time you change
something, allowing you to instead re-render only the layer(s) that you need.

Layer List
This is a list of all the Render Layers in the current scene.
Only layers which are enabled (checkbox on right is ticked) will be rendered. If the Pin icon at the bottom right
of the list is enabled, only the active (highlighted) layer will be rendered.
Render Layers can be added and removed using the + and - buttons on the right, and existing layers can be
renamed by double clicking on their name.
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Layer Panel
The Layer Panel shows the settings of the active Render Layer from the list above.
You can select multiple layers using Shift-LMB.
Scene
The Scene Layers, showing which are currently visible and will be rendered.
Layer
The Scene Layers which are associated with the active Render Layer. Objects in those Scene Layers will
be rendered in that Render Layer. When an object is in the Scene Layers but not the Render Layer, it will
still cast shadows and be visible in reflections, so it is still indirectly visible.
Mask Layer
Objects on these will mask out other objects appearing behind them.
Material Override
Overrides all material settings to use the Material chosen here.
Examples of where this might be used:
• To check lighting by using a plain diffuse material on all objects
• Render a wireframe of the scene
• Create a custom render pass such as an anti-aliased matte or global coordinates.
See also
Additional options shown in this panel are different for each render engine. See these options for:
• Bforartists Render
• Cycles

Using Render Layers
Each Render Layer has an associated set of Scene Layers. Objects which are on one of the associated Scene
Layers are shown in that Render Layer, as long as that Scene Layer is also visible.
Warning
Only the objects in visible Scene Layers will be rendered. So, if only Scene Layer 1 is visible and your Render
Layer set specifies to render only Layers 2 and 3, nothing will be rendered.

Post Processing Panel
Compositing
Use compositing for the final image.
Sequencer
If sequencer strips are used render them instead of an image.
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Dithering
Dithering is a technique for blurring pixels to prevent banding that is seen in areas of gradients, where stairstepping appears between colors. Banding artifacts are more noticeable when gradients are longer, or less steep.
Dithering was developed for graphics with low bit depths, meaning they had a limited range of possible colors.
Dithering works by taking pixel values and comparing them with a threshold and neighboring pixels then does
calculations to generate the appropriate color. Dithering creates the perceived effect of a larger color palette by
creating a sort of visual color mixing. For example, if you take a grid and distribute red and yellow pixels
evenly across it, the image would appear to be orange.
The Dither value ranges from 0 to 2.

Metadata
The Metadata panel includes options for writing meta-data into render output.
Stamping can include the following data:
Time
Include the current scene time and render frame as HH:MM:SS.FF
Date
Include the current date and time.
RenderTime
Include the render time in the stamp image.
Frame
Include the frame number.
Scene
Include the name of the active scene.
Camera
Include the name of the active camera.
Lens
Include the name of the active camera’s lens value.
Filename
Include the filename of the .blend file.
Marker
Include the name of the last marker.
Seq. Strip
Include the name of the foreground sequence strip.
Note
Include a custom note.
Note
Only some image formats support metadata: See image formats.

Stamp Output
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You can optionally stamp this into the image its self (adding text over the rendered image) which can be
useful for test renders and animation previews.
Stamp Text Color
Set the color and alpha of the stamp text.
Stamp Background
Set the color and alpha of the color behind the text.
Font Size
Set the size of the text.
Hint
It can be useful to use the Note field if you’re setting up a render-farm.
Since you can script any information you like into it, such as an identifier for the render-node or the jobnumber.
For details on stamping arbitrary values, see: this page

Color Management

Different views and exposures of the same render

OpenColorIO is integrated into Bforartists, meaning many color spaces are supported with fine control over
which color transformations are used.

Scene Linear Color Space
For correct results, different color spaces are needed for rendering, display and storage of images. Rendering
and compositing is best done in scene linear color space, which corresponds more closely to nature, and makes
14
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computations more physically accurate.

Example linear workflow

If the colors are linear, it means that if in reality we double the amount of photons, the color values are also
doubled. Put another way, if we have two photos/renders each with one of two lights on, and add those images
together, the result would be the same as a render/photo with both lights on. It follows that such a
radiometrically linear space is best for photorealistic rendering and compositing.
However these values do not directly correspond to human perception or the way display devices work, and
image files are often stored in different color spaces, so we have to take care to do the right conversion into and
out of this linear color space.

Settings

Scene settings for color management

These settings are found in the scene context of the properties editor, under the Color Management panel.

Display
Correct display of renders requires a conversion to the display device color space, which can be configured
here. A computer monitor works differently from a digital cinema project or HDTV. The scene properties have
these settings:
Display Device
The device that the image is being viewed on.
Most computer monitors are configured for the sRGB color space, and so when working on a computer
usually this option should just be left to the default. It would typically be changed when viewing the
image on another display device connected to the computer, or when writing out image files intended to
15
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be displayed on another device.
Rec709 is commonly used for HDTVs, while XYZ and DCI-P3 are common for digital projectors.
Color management can be disabled by setting the device to None.

Conversion from linear to display device space

Render
There is also an artistic choice to be made for renders. Partially that’s because display devices can’t display the
full spectrum of colors and only have limited brightness, so we can squeeze the colors to fit in the gamut of the
device. Besides that it can also be useful to give the renders a particular look, e.g. as if they have been printed
on real film.
Another common use case is when you want to inspect renders, to see details in dark shadows or bright
highlights, or identify render errors. Such settings would be only used temporarily and not get used for final
renders.
View
These are different ways to view the image on the same display device.
Default
Does no extra conversion besides the conversion for the display device.
RRT
Uses the ACES Reference Rendering Transform, to simulate a film-like look.
Film
This option is another film-like look.
Raw and Log
Intended for inspecting the image but not for final export. Raw gives the image without any color
space conversion, while Log gives a more “flat” view of the image without very dark or light areas.
Exposure
Used to control the image brightness (in stops) applied before color space conversion.
Gamma
Extra gamma correction applied after color space conversion. Note that the default sRGB or Rec709 color
space conversions already include a gamma correction of approximately 2.2 (except the Raw and Log
views), so this would be applied in addition to that.
Look
Choose an artistic effect from set of measured film response data which roughly emulates the look of
certain film types. Applied before color space conversion.
Use Curves
Adjust RGB Curves to control image colors before color space conversion. Read more about using the
Curve Widget.
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Sequencer
Color Space
The color space that the sequencer operates in. By default the sequencer operates in sRGB space, but it
can also be set to work in Linear space like the Compositing nodes, or another color space. Different
color spaces will give different results for color correction, cross fades, and other operations.

Image Files
The other place to keep color management in mind is when loading and saving image files. File formats such
as PNG or JPEG will typically store colors in a color space ready for display, not in a linear space. When they
are, for example, used as textures in renders, they need to be converted to linear first, and when saving renders
for display on the web, they also need to be converted to a display space. Other file formats like OpenEXR
store linear color spaces and as such are useful as intermediate files in production.
When working with image files, the default color space is usually the right one. If this is not the case, the color
space of the image file can be configured in the image settings. A common situation where manual changes are
needed is when working with or baking normal maps or displacement maps, for example. Such maps do not
actually store colors, just data encoded as colors. In such cases they should be marked as Non-Color Data.
Image data-blocks will always store float buffers in memory in the scene linear color space, while a byte buffer
in memory and files on disk are stored in the color space specified with this setting:
Color Space
The color space of the image on disk. This depends on the file format, for example PNG or JPEG images
are often stored in sRGB, while OpenEXR images are stored in a linear color space. Some images such as
normal, bump or stencil maps do not strictly contain ‘colors’, and on such values no color space
conversion should ever be applied. For such images the color space should be set to None.

Image settings for color management

By default only renders are displayed and saved with the render view transformations applied. These are the
Render Result and Viewer image data-blocks, and the files saved directly to disk with the Render Animation
operator. However when loading a render saved to an intermediate OpenEXR file, Bforartists can’t detect
automatically that this is a render (it could be e.g. an image texture or displacement map). We need to specify
that this is a render and that we want the transformations applied, with these two settings:
View as Render
Display the image data-block (not only renders) with view transform, exposure, gamma, RGB curves
applied. Useful for viewing rendered frames in linear OpenEXR files the same as when rendering them
directly.
Save as Render
Option in the image save operator to apply the view transform, exposure, gamma, RGB curves. This is
useful for saving linear OpenEXR to e.g. PNG or JPEG files in display space.
17
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OpenColorIO Configuration
Bforartists comes with a standard OpenColorIO configuration that contains a number of useful display devices
and view transforms. The reference linear color space used is the linear color space with Rec. 709
chromaticities and D65 white point.
However OpenColorIO was also designed to give a consistent user experience across multiple applications, and
for this a single shared configuration file can be used. Bforartists will use the standard OCIO environment
variable to read an OpenColorIO configuration other than the default Bforartists one. More information about
how to set up such a workflow can be found on the OpenColorIO website.
We currently use the following color space roles:
scene_linear
color space used for rendering, compositing, and storing all float precision images in memory.
default_sequencer
default color space for sequencer, scene_linear if not specified
default_byte
default color space for byte precision images and files, texture_paint if not specified.
default_float
default color space for float precision images and files, scene_linear if not specified.
The standard Bforartists configuration also includes some support for ACES (code and documentation), even
though we have a different linear color space. It’s possible to load and save EXR files with the Linear ACES
color space, and the RRT view transform can be used to view images with their standard display transform.
However the ACES gamut is larger than the Rec. 709 gamut, so for best results an ACES specific configuration
file should be used. OpenColorIO provides an ACES configuration, though it may need a few more tweaks to
be usable in production.

Compatibility
Compatibility with existing files should mostly be preserved. Files that had color management enabled should
be entirely compatible, while older files with the color management option disabled are mostly compatible but
different for vertex colors and viewport colors.

Workflows
The workflow to render depends of the chosen render and what you want to render. A still or an animation for
example.

Rendering Animations
While rendering stills will allow you to view and save the image from the render buffer when it’s complete,
animations are a series of images, or frames, and are automatically saved directly out to disk after being
rendered.
After rendering the frames, you may need to edit the clips, or first use the Compositor to do green-screen
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masking, matting, color correction, DOF, and so on to the images. That result is then fed to the Sequencer
where the strips are cut and mixed and a final overlay is done.
Finally you can render out from the Sequencer and compress the frames into a playable movie clip.

Workflow
Generally, you do a lot of intermediate renders of different frames in your animation to check for timing,
lighting, placement, materials, and so on. At some point, you are ready to make a final render of the complete
animation for publication.
There are two approaches you can use when making a movie, or animation, with or without sound. The
approach you should use depends on the amount of CPU time you will need to render the movie. You can
render a “typical” frame at the desired resolution, and then multiply by the number of frames that will
ultimately go into the movie, to arrive at an total render time.
If the total render time is an hour or more, you want to use the “Frame Sequence” approach. For example, if
you are rendering a one-minute video clip for film, there will be (60 seconds per minute) * (24 frames per
second) or 1440 frames per minute. If each frame takes 30 seconds to render, then you will be able to render
two frames per minute, or need 720 minutes (12 hours) of render time.
Rendering takes all available CPU time; you should render overnight, when the computer is not needed, or set
Bforartists to a low priority while rendering, and work on other things (be careful with the RAM space!).
The Direct Approach - highly not recommended and not a standard practice - is where you set your output
format to an AVI or MOV format, and click ANIM to render your scene directly out to a movie file. Bforartists
creates one file that holds all the frames of your animation. You can then use Bforartists’s VSE to add an audio
track to the animation and render out to an MPEG format to complete your movie.
The Frame Sequence is a much more stable approach, where you set your output format to a still format (such
as JPG, PNG or MultiLayer), and click ANIM to render your scene out to a set of images, where each image is
the frame in the sequence.
Bforartists creates a file for each frame of the animation. You can then use Bforartists’s compositor to perform
any frame manipulation (post processing). You can then use Bforartists’s VSE to load that final image
sequence, add an audio track to the animation, and render out to an MPEG format to complete your movie. The
Frame Sequence approach is a little more complicated and takes more disk space, but gives you more
flexibility.
Here are some guidelines to help you choose an approach.
Direct Approach
• short segments with total render time < 1 hour
• stable power supply
• computer not needed for other uses
Frame Sequence Approach
• total render time > 1 hour
• post-production work needed
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• Color/lighting adjustment
• Green screen / matte replacement
• Layering/compositing
• Multiple formats and sizes of ultimate product
• intermediate frames/adjustments needed for compression/codec
• precise timing (e.g. lip-sync to audio track) needed in parts
• may need to interrupt rendering to use the computer, and want to be able to resume rendering where you
left off.

Frame Sequence Workflow
• First prepare your animation.
• In the Dimensions panel, choose the render size, Pixel Aspect Ratio, and the Range of Frames to use, as
well as the frame rate, which should already be set.
• In the Output panel set up your animation to be rendered out as images, generally using a format that
does not compromise any quality (I prefer PNG or MultiLayer because of their loss-less nature).
• Choose the output path and file type in the Output panel as well, for example //render/my-anim-.
• Confirm the range of your animation frame Start and End.
• Save your .blend file.
• Press the big Animation button. Do a long task [like sleeping, playing a video game, or cleaning your
driveway] while you wait for your computer to finish rendering the frames.
• Once the animation is finished, use your OS file explorer to navigate into the output folder (“render in
this example). You will see lots of images (.png or .exr, etc... depending on the format you chose to
render) that have a sequence number attached to them ranging from 0000 to a max of 9999. These are
your single frames.
• In Bforartists, now go into the video sequence editor.
• Choose Add Image from the add menu. Select all the frames from your output folder that you want to
include in your animation (Press A to Select All easily). They will be added as a strip to the sequence
editor.
• Now you can edit the strip and add effects or simply leave it like it is. You can add other strips, like an
audio strip.
• Scrub through the animation, checking that you have included all the frames.
• In the Scene Render buttons, in the Post Processing panel, activate Sequencer.
• In the Format panel, choose the container and codec you want (e.g. MPEG H.264) and configure it. The
video codecs are described on the previous page: Output Options.
• Click the ANIMATION render button and Bforartists will render out the sequence editor output into
your movie.
Why go through all this hassle? Well, first of all, if you render out single frames you can stop the render at any
time by pressing Esc in the render window. You will not lose the frames you have already rendered, since they
have been written out to individual files. You can always adjust the range you want to continue from where you
left off.
You can edit the frames afterwards and post-process them. You can add neat effects in the sequence editor. You
can render the same sequence into different resolutions (640x480, 320x240, etc) and use different codecs (to get
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different file sizes and quality) with almost no effort whatsoever.

Options
Post Processing Panel
Sequencer
Renders the output of the sequence editor, instead of the view from the 3D scene’s active camera. If
the sequence contains scene strips, these will also be rendered as part of the pipeline. If Do
Composite is also enabled, the Scene strip will be the output of the Compositor.
Compositing
Renders the output from the Compositing noodle, and then pumps all images through the
Composite node map, displaying the image fed to the Composite Output node.

Hints
You accidentally turned off you’re PC right in the middle of rendering my movie!
Unless your animation renders in a few minutes, it’s best to render the animation as separate image files.
Instead of rendering directly to a compressed movie file, use a loss-less format (PNG for example).
This allows you an easy recovery if there is a problem and you have to re-start the rendering, since the
frames you have already rendered will still be in the output directory.
Just disable the Overwrite option to start rendering where you left off.
You can then make a movie out of the separate frames with Bforartists’s sequence editor or using 3rd
party encoding software.
Animation Preview
It can be useful to render a subset of the animated sequence, since only part of an animation may have an
error.
Using an image format for output, you can use the Frame Step option to render every N’th frame. Then
disable Overwrite and re-render with Frame Step set to 1.

Command Line
In some situations we want to increase the render speed, access Bforartists remotely to render something or
build scripts that use the command line.
One advantage of using the command line is that we don’t need the X server (in the case of Linux) and
consequently we can render remotely by SSH or telnet.
To see a list of available flags (for example to specify which scene to render, the end frame number, etc...),
simply run:
Bforartists --help

Note
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Arguments are executed in the order they are given!
The following command won’t work, since the output and extension is set after Bforartists is told to render:
Bforartists -b file.blend -a -x 1 -o //render

The following command will behave as expected.
Bforartists -b file.blend -x 1 -o //render -a

Always position -f or -a as the last arguments.

Platforms
How to actually execute Bforartists from the command line depends on the platform and where you have
installed Bforartists. Here are basic instructions for the different platforms.

Linux
Open a terminal, then go to the directory where Bforartists is installed, and run the Bforartists command like
this.
cd <Bforartists installation directory>
./Bforartists

If you have Bforartists installed in your PATH (usually when Bforartists is installed through a distribution
package), you can simply run:
Bforartists

Mac OSX
Open the terminal application, go to the directory where Bforartists is installed, and run the executable within
the app bundle, with commands like this:
cd /Applications/Bforartists
./Bforartists.app/Contents/MacOS/Bforartists

If you need to do this often, you can make an alias so that typing just Bforartists in the terminal works.
For that you can run a command like this in the terminal (with the appropriate path).
echo "alias
Bforartists=/Applications/Bforartists/Bforartists.app/Contents/MacOS/Bforartists" >>
~/.profile

If you then open a new terminal, the following command will work:
Bforartists

MS-Windows
Open the Command Prompt, go to the directory where Bforartists is installed, and then run the Bforartists
command.
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cd c:\<Bforartists installation directory>
Bforartists

You can also add the Bforartists folder to your system PATH so that do you do not have to change to it each
time.

Examples
Here are some common examples of command line rendering:

Single Image
Bforartists -b file.blend -f 10

-b
Render in the background (without UI).
file.blend
Path to the blend file to render.
-f 10
Render only the 10th frame.
Bforartists -b file.blend -o /project/renders/frame_##### -F EXR -f -2

-o /project/renders/frame_#####
Path of where to save the rendered image, using 5 padded zeros for the frame number.
-F EXR
Override the image format specified in the blend file and save to an OpenEXR image.
-f -2
Render only the second last frame.
Warning
Arguments are case sensitive! -F and -f are not the same.

Animation
Bforartists -b file.blend -a

-a
Render the whole animation using all the settings saved in the blend file.
Bforartists -b file.blend -E Bforartists_RENDER -s 10 -e 500 -t 2 -a

-E Bforartists_RENDER
Use the “Bforartists Render” engine. For a list of available renderers, run Bforartists -E help.
-s 10 -e 500
Set the start frame to 10 and the end frame to 500.
-t 2
Use only two threads.
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Render Baking
Baking, in general, is the act of pre-computing something in order to speed up some other process later down
the line. Rendering from scratch takes a lot of time depending on the options you choose. Therefore, Bforartists
allows you to “bake” some parts of the render ahead of time, for select objects. Then, when you press Render,
the entire scene is rendered much faster, since the colors of those objects do not have to be recomputed.
Render baking creates 2D bitmap images of a mesh object’s rendered surface. These images can be re-mapped
onto the object using the object’s UV coordinates. Baking is done for each individual mesh, and can only be
done if that mesh has been UV-unwrapped. While it takes time to set up and perform, it saves render time. If
you are rendering a long animation, the time spent baking can be much less than time spent rendering out each
frame of a long animation.
Use Render Bake in intensive light/shadow solutions, such as AO or soft shadows from area lights. If you bake
AO for the main objects, you will not have to enable it for the full render, saving render time.
Use Full Render or Textures to create an image texture; baked procedural textures can be used as a starting
point for further texture painting. Use Normals to make a low-resolution mesh look like a high-resolution mesh.
To do that, UV-unwrap a high-resolution, finely sculpted mesh and bake its normals. Save that normal map, and
Mapping (texture settings) the UV of a similarly unwrapped low-resolution mesh. The low-resolution mesh will
look just like the high-resolution, but will have much fewer faces/polygons.
Advantages
•
•
•
•

Can significantly reduce render times
Texture painting made easier
Reduced polygon count
Repeated renders are made faster, multiplying the time savings

Disadvantages
•
•
•
•

Object must be UV-unwrapped.
If shadows are baked, lights and object cannot move with respect to each other.
Large textures (eg 4096x4096) can be memory intensive, and be just as slow as the rendered solution.
Human (labor) time must be spent unwrapping and baking and saving files and applying the textures to
a channel.

Options
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Ambient Occlusion

Bake Mode
Full Render
Bakes all materials, textures, and lighting except specularity and SSS.

Ambient Occlusion
Bakes ambient occlusion as specified in the World panels. Ignores all lights in the scene.
Normalized
Normalize without using material’s settings.

Shadow
Bakes shadows and lighting.

Normals

Normal Space

Normals
Bakes tangent and camera-space normals (amongst many others) to an RGB image.
Normal Space
Normals can be baked in different spaces:
Camera space
Default method.
World space
Normals in world coordinates, dependent on object transformation and deformation.
Object space
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Normals in object coordinates, independent of object transformation, but dependent on deformation.
Tangent space
Normals in tangent space coordinates, independent of object transformation and deformation. This
is the new default, and the right choice in most cases, since then the normal map can be used for
animated objects too.
For materials the same spaces can be chosen as well, in the image texture options, next to the existing Normal
Map setting. For correct results, the setting here should match the setting used for baking.

Textures
Bakes colors of materials and textures only, without shading.

Displacement

Displacement
Similar to baking normal maps, displacement maps can also be baked from a high-res object to an unwrapped
low-res object, using the Selected to Active option.
Normalized
Normalize to the distance.
When using this in conjunction with a subsurf and displacement modifier within Bforartists, it’s necessary to
temporarily add a heavy subsurf modifier to the ‘low res’ model before baking. This means that if you then use
a displacement modifier on top of the subsurf, the displacement will be correct, since it’s stored as a relative
difference to the subsurfed geometry, rather than the original base mesh (which can get distorted significantly
by a subsurf). The higher the render level subsurf while baking, the more accurate the displacements will be.
This technique may also be useful when saving the displacement map out for use in external renderers.

Emission
Bakes Emit, or the Glow color of a material.

Alpha
Bakes Alpha values, or transparency of a material.

Mirror Color and Intensity
Bakes Mirror color or intensity values.
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Specular Color and Intensity
Bakes specular color or specular intensity values.

Full Render

Additional Options
Clear
If selected, clears the image to selected background color (default is black) before baking render.
Margin
Baked result is extended this many pixels beyond the border of each UV “island,” to soften seams in the
texture.
Split
Fixed
Slit quads predictably (0,1,2) (0,2,3).
Fixed alternate
Slit quads predictably (1,2,3) (1,3,0).
Automatic
Split quads to give the least distortion while baking.
Select to Active
Enable information from other objects to be baked onto the active object.
Distance
Controls how far a point on another object can be away from the point on the active object. Only
needed for Selected to Active. A typical use case is to make a detailed, high poly object, and then
bake it’s normals onto an object with a low polygon count. The resulting normal map can then be
applied to make the low poly object look more detailed.
Bias
Bias towards further away from the object (in Bforartists units)
Note
Mesh Must be Visible in Render
If a mesh is not visible in regular render, for example because it is disabled for rendering in the Outliner or has
the DupliVerts setting enabled, it cannot be baked to.

Workflow
• In a 3D View window, select a mesh and enter UV/Face Select mode
• Unwrap the mesh object
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• In a UV/Image Editor window, either create a new image or open an existing one. If your 3D view is in
textured display mode, you should now see the image mapped to your mesh. Ensure that all faces are
selected.
• In the Bake panel at the bottom of the Render menu, bake your desired type of image (Full Render
etcetera.)
• When rendering is complete, Bforartists replaces the image with the Baked image.
• Save the image.
• Apply the image to the mesh as a UV texture. For displacement and normal maps, refer to Bump and
Normal Maps. For full and texture bakes, refer to Textures.
• Refine the image using the process described below, or embellish with Texture Paint or an external
image editor.

Multi-View Render
For this 5-minute guide we will take an existent .blend file that was made for monoscopic rendering and
transform it in stereo-3d ready.
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Creature Factory 2 by Andy Goralczyk Rendered in Stereo 3D (anaglyph)

Note
Multi-View drawing requires capable graphics card and drivers with Triple Buffer support. If the Automatic
mode doesn’t work, set the Window Draw Method in the System User Preferences.

Introduction
Start opening up your project file, in this case turntable.blend from the Creature Factory 2 Open Movie
Workshop series from the Bforartists Institute by Andy Goralczyk.
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Turn Table Creature Factory 2

Views Setup
Go to the Render Layers panel and enable Views for this scene.

Scene Render Views

Note
When you turn on Views in the scene you get 3d preview in the viewport, as well as multiple panels that are
now accessible all over the user interface.
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Viewport with 3D visualization

Camera
To tweak the stereo 3d parameters select the camera in the Outliner. In the Camera panel go to the Stereoscopy
tab and change the Convergence Distance.
The viewport will respond in real-time to those changes allowing you to preview the current depth value of the
scene.

Stereo Convergence Distance
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Viewport
Before fine-tuning the camera parameters you can set the convergence plane in the viewport based in your
scene depth layout. Go outside the camera view and you will instantly see the convergence plane in front of the
camera.
You can toggle this and other display settings in the Stereoscopy tab of the viewport properties panel. In the
following image the cameras frustum volumes are also visible.

Viewport Plane and Volume Stereo Preview

Stereo 3D Display
If you have a real 3d display at some point you can change the 3D display mode in the Window menu, by
calling the Stereo 3D operator. Be aware that some modes require a fullscreen editor to work.

Window Menu, Stereo 3D Operator
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OpenGL Preview

Turn Table OpenGL Rendering Preview

Before rendering your scene you can save an OpenGL preview of the animation for testing in the final display.
In the Render Output panel you can chose the output Views Format.
The options include individual files per view, top-bottom, anaglyph among others. Pick the one that fits your
display requirements.

Rendering and Image Editor
Once you are happy with the results you can render out the final animation. In the Image Editor you can inspect
the individual views and the stereo result.

Image Formats
Your final animation can be saved in more robust formats than the ones used by the OpenGL render preview. In
this example we saved as cross-eyed side-by-side stereo 3d.
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Side by Side Cross-Eye Format

Final Considerations
As this guide showed, there is more to stereo 3d rendering than just generate two images. The earlier the stereo
pipeline is considered the smoother it will get. The following sections are a more in-depth view of the
individual components we visited in the workflow.

Window Stereo 3D Display
An essential component of the Stereoscopy pipeline is the ability to display the stereo image in a proper display.
Bforartists supports from high-end 3D displays to simple red-cyan glasses. On top of that you can set a different
display mode for each window.
The display mode can be changed via the Window menu or if you create your own shortcuts for the
wm.set_stereo_3d operator.

Window Menu, Stereo 3D Operator

Display Mode
Anaglyph
Render two differently filtered colored images for each eye. Anaglyph glasses are required. We support
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Red-Cyan, Green-Magenta and Yellow-Blue glasses.
Interlace
Render two images for each eye into one interlaced image. A 3D-ready monitor is required. We support
Row, Column and Checkerboard Interleaved. An option to Swap Left/Right helps to adjust the image for
the screen. This method works better in fullscreen.
Time Sequential
Renders alternate eyes. This method is also known as Page Flip. This requires the graphic card to support
Quad Buffer and it only works in fullscreen.
Side-by-Side
Render images for left and right eye side-by-side. There is an option to support Cross-Eye glasses. It
works only in fullscreen, and it should be used with the Full Editor operator.
Top-Bottom
Render images for left and right eye one above another. It works only in fullscreen, and it should be used
with the Full Editor operator.
Note
Full Screen Stereo 3D Modes
If you have a 3D display most of the time you will use it to see in stereo 3D you will have to go to the
fullscreen mode. In fact some modes will only work in the full window mode that hides most of the user
interface from the work area. In this case it is recommended to work with two monitors, using the 3D screen
for visualizing the stereo result while the other screen can be used for the regular Bforartists work.

Stereo 3D Camera
When using the Stereo 3D scene view setup a stereo pair is created on-the-fly and used for rendering and
previsualization. For all the purposes this works as two cameras that share most parameters (focal length,
clipping, ...). The stereo pair, however, is offsetted, and can have unique rotation and shift between itself.

Stereo 3D Camera Settings

Interocular Distance
Set the distance between the camera pair. Although the convergence of a stereo pair can be changed in
post-production, different interocular distances will produce different results due to the parts of the scene
being occluded from each point of view.
Convergence Plane Distance
The converge point for the stereo cameras. This is often the distance between a projector and the
projection screen. You can visualize this in the 3D Viewport.

Convergence Mode
Off-Axis
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The stereo camera pair is separated by the interocular distance, and shifted inwards so it converges in the
convergence plane. This is the ideal format since it is the one closest to how the human vision works.
Parallel
This method produces two parallel cameras that do not converge. Since this method needs to be manually
converged it can’t be used for viewing. This method is common when combining real footage with
rendered elements.
Toe-in
A less common approach is to rotate the cameras instead of shifting their frustum. The Toe-in method is
rarely used in modern 3D productions.
Pivot
The stereo pair can be constructed around the active camera with a new camera built for each eye (Center
Pivot) or using the existing camera and creating (Left or Right). The latter is what is used when only one
eye needs to be rendered for an existing mono 2D project.

Viewport Stereo 3D
When you enable ‘Views’ in the Render Layer panel a new are is available in the 3D Viewport properties panel.
In this panel you can pick whether to see the stereo 3d in the viewport, or which camera to see. It also allow
you to see the Cameras, the Plane and the Volume of the stereo cameras.

Viewport Stereo 3D Settings

Cameras
When working with the Stereo 3D views setup you can inspect what each individual generated camera is
looking or the combined result of them. In the Multi-View mode you can see the combined result of the
left and right cameras (when available) or the current selected camera.
Plane
The convergence plane represents the screen as it is perceived by the audience. Visualizing it in the 3D
Viewport allows you to layout your scene based on your depth script outside the camera view.
Volume
The intersection of the stereo cameras frustums helps planning the show by avoiding elements being
visible by only one camera. The volume is defined by the cameras start and end clipping distances. The
areas that are in the frustum of one camera only are known as retinal rivalry areas. They are tolerated in
the negative space (the region from the convergence plane into the image) but are to be avoided at all
costs in the positive space (the area from the convergence plane to the camera).
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Viewport 3D: Convergence Plane and Volume Display

Multi-View and Stereo 3D Image I/O
Multi-View and Stereo 3D
Multi-View images can be saved in special formats according to the production requirements. By default
the system saves each view as an individual file, thus generating as many files as views to be rendered. In
stereo 3d productions, for the final deployment or even intermediary previews it’s convenient to save
stereo 3d images, that are ready to use with 3D displays or simple anaglyph glasses. The formats
supported match the display modes available for the window.
Lossy-Formats
Some stereo 3D formats represent a considerable loss of data. For example, the Anaglyph format will cap
out entire color channels from the original image. The Top-Bottom compressed will discard half of your
vertical resolution data. The Interlace will mash your data considerably. Once you export in those formats,
you can still import the image back in Bforartists, for it to be treated as Stereo 3D. You will need to match
the window stereo 3d display mode to the image stereo 3d format though.
Lossless Formats
Some formats will preserve the original data, leading to no problems on exporting and importing the files
back in Bforartists. The Individual option will produce separate images that (if saved in a lossless
encoding such as PNG or OpenEXR) can be loaded back in production with no loss of data. For the Stereo
3D formats the only lossless options are Top-Bottom and Side-by-Side without the Squeezed Frame
option.
Multi-View Openexr
Another option is to use Multi-View OpenEXR files. This format can save multiple views in a single file
and is backward compatible with old OpenEXR viewers (you see only one view though). Multi-View
native support is only available to OpenEXR.
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Image Editor
View Menu
After you render your scene with Stereo 3D you will be able to see the rendered result in the combined
stereo 3d or to inspect the individual views. This works for Viewer nodes, render results or opened
images.

Stereo 3D and View menu

Views Format
When you drag and drop an image into the Image Editor, Bforartists will open it as a individual images at
first. If your image was saved with one of the Stereo 3D formats you can change how Bforartists should
interpret the image by switching the mode to Stereo 3D, turning on Use Multi-View and picking the
corresponding stereo method.

Views Formats and Stereo 3D

Compositor
The compositor works smoothly with Multi-View. The compositing of a view is completed before the
remaining views start to be composited. The pipeline is the same as the single-view workflow, with the
difference that you can use Image, Movies or Image Sequences in any of the supported Multi-View formats.
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Compositor, Backdrop and Split Viewer Node

The views to render are defined in the current scene views, in a similar way as you define the composite output
resolution in the current scene render panel, regardless of the Image nodes resolutions or RenderLayers from
different scenes.
Note
Single-View Images
If the image from an Image Node does not have the view you are trying to render, the image will be treated as a
single-view image.
Switch View Node
If you need to treat the views separately you can use the Switch View node to combine the views before
an output node.

Switch View Node

Performance
By default when compositing and rendering from the user interface all views are rendered and then
composited. During test iterations you can disable all but one view from the Scene Views panel, and reenable it after you get the final look.
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Camera
A Camera is an object that provides a means of rendering images from Bforartists. It defines which portions of
a scene is visible in the rendered image. By default a scene contains one camera. However, A scene can contain
more than one camera, but only one of them will be used at a time. So you will only need to add a new camera
if you are making cuts between them. See Animating Cameras.

Changing the Active Camera
Reference
Mode: Object mode
Hotkey: Ctrl-Numpad0

Active camera (left one).

The active camera is the camera that is currently being used for rendering and camera view (Numpad0).
1
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Select the camera you would like to make active and press Ctrl-Numpad0 (by doing so, you also switch the
view to camera view). In order to render, each scene must have an active camera.
The active camera can also be set in the Scene context of the Properties Editor
The camera with the solid triangle on top is the active camera.
Warning
The active camera, as well as the layers, can be specific to a given view, or global (locked) to the whole scene
- see Local Camera.

Camera Settings
Reference
Mode: Object mode
Editor: Properties
Context: Object Data
Cameras are invisible in renders, so they don’t have any material or texture settings. However, they do have
Object and Editing setting panels available which are displayed when a camera is the selected (active!) object.

Lens
The camera lens options control the way 3D objects are represented in a 2D image. See Camera Lens for
details.

Camera

Camera Presets panel.

Sensor size
This setting is an alternative way to control the focal-length, it’s useful to match the camera in Bforartists
to a physical camera & lens combination, e.g. for motion tracking.
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Depth of Field

Camera Depth of Field Panel

Real world cameras transmit light through a lens that bends and focuses it onto the sensor. Because of this,
objects that are a certain distance away are in focus, but objects in front and behind that are blurred.
The area in focus is called the focal point and can be set using either an exact value, or by using the distance
between the camera and a chosen object:
Focus Object
Choose an object which will determine the focal point. Linking an object will deactivate the distance
parameter. Typically this is used to give precise control over the position of the focal point, and also
allows it to be animated or constrained to another object.
Distance
Sets the distance to the focal point when no Focus Object is specified. If Limits are enabled, a yellow
cross is shown on the camera line of sight at this distance.
Hint
Hover the mouse over the Distance property and press E to use a special Depth Picker. Then click on a
point in the 3D View to sample the distance from that point to the camera.

High Quality
In order for the viewport to offer an accurate representation of depth of field, like a render, you must
enable High Quality. Without it, you may notice a difference in shading.
Viewport F-stop
Controls the real-time focal blur effect used during sequencer or OpenGL rendering and, when enabled,
camera views in the 3D viewport. The amount of blur depends on this setting, along with Focal Length
and Sensor Size. Smaller Viewport F-stop values result in more blur.
Blades
Add a number of polygonal blades to the blur effect, in order to achieve a a bokeh effect in the viewport.
To enable this feature, the blades must be set to at least 3 (3 sides, triangle)
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The viewport bokeh effect with the blades set to 3

Display

Camera Display panel

Limits
Shows a line which indicates Start and End Clipping values.
Mist
Toggles viewing of the mist limits on and off. The limits are shown as two connected white dots on the
camera line of sight. The mist limits and other options are set in the World panel, in the Mist section.
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Camera view displaying safe areas, sensor and name

Sensor
Displays a dotted frame in camera view.
Name
Toggle name display on and off in camera view.
Size
Size of the camera icon in the 3D view. This setting has no effect on the render output of a camera, and is
only a cosmetic setting. The camera icon can also be scaled using the standard Scale S transform key.
Passepartout, Alpha
This mode darkens the area outside of the camera’s field of view, based on the Alpha setting.

Composition Guides
Composition Guides are available from the drop-down menu, which can help when framing a shot. There are 8
types of guides available:
Center
Adds lines dividing the frame in half vertically and horizontally.
Center Diagonal
Adds lines connecting opposite corners.
Thirds
Adds lines dividing the frame in thirds vertically and horizontally.
Golden
Divides the width and height into Golden proportions (About 0.618 of the size from all sides of the
frame).
Golden Triangle A
Draws a diagonal line from the lower-left to upper-right corners, then adds perpendicular lines that pass
through the top left and bottom right corners.
Golden Triangle B
Same as A, but with the opposite corners.
Harmonious Triangle A
Draws a diagonal line from the lower-left to upper-right corners, then lines from the top left and bottom
right corners to 0.618 the lengths of the opposite side.
Harmonious Triangle B
Same as A, but with the opposite corners.
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Safe Areas
When this is enabled, extra dotted frames are drawn when in camera view, delimiting the area considered as
“safe” for important elements. More information about them in the safe areas section.

Render Border
Reference
Mode: All modes
Menu: View ‣ Render Border
Hotkey: Ctrl-B

Render Border toggle

While in camera view, you can define a subregion to render by drawing out a rectangle within the cameras
frame. Your renders will now be limited to the part of scene visible within the render border. This can be very
useful for reducing render times for quick previews on an area of interest.
The border can be disabled by disabling the Border option in the Dimensions panel of the Render context or by
activating the option again and selecting Render Border larger than the camera view.
Note
Anti-Aliasing and blur options with borders
Note that when Render Borders are activated, Full Sampling Anti-Aliasing will be disabled while Sampled
Motion Blur will become available.
Read more about Anti-Aliasing Read more about Motion Blur
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Render border and associated render.

Camera Lens

Camera Lens panel.

The camera lens options control the way 3D objects are represented in a 2D image.

Lens Types
There are three different lens types:
• Perspective
• Orthographic
• Panoramic

Perspective
This matches how you view things in the real-world. Objects in the distance will appear smaller than objects in
the foreground, and parallel lines (such as the rails on a railroad) will appear to converge as they get farther
away.
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Render of a train track scene with a Perspective camera.

Settings which adjust this projection include:
• Focal length
• Shift
• Sensor size
Focal length
The focal length setting controls the amount of zoom, i.e. the amount of the scene which is visible all at
once. Longer focal lengths result in a smaller FOV (more zoom), while short focal lengths allow you to
see more of the scene at once (larger FOV, less zoom).

Render of the same scene as above, but with a focal length of 210mm instead of 35mm.

Lens Unit
The focal length can be set either in terms of millimeters or the actual Field of View as an angle.
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Orthographic
With Orthographic perspective objects always appear at their actual size, regardless of distance. This means
that parallel lines appear parallel, and do not converge like they do with Perspective.

Render from the same camera angle as the previous examples, but with orthographic perspective.

Orthographic Scale
This controls the apparent size of objects in the camera.
Note that this is effectively the only setting which applies to orthographic perspective. Since parallel lines
do not converge in orthographic mode (no vanishing points), the lens shift settings are equivalent to
translating the camera in the 3D view.

Panoramic
Panoramic cameras are only supported in the Cycles render engine. See the Cycles documentation.

Shift
The Shift setting allows for the adjustment of vanishing points. Vanishing points refer to the positions to which
parallel lines converge. In this example, the most obvious vanishing point is at the end of the railroad.
To see how this works, take the following examples:
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Render of a train track scene with a horizontal lens shift of 0.330.

Render of a train track scene with a rotation of the camera object instead of a lens shift.

Notice how the horizontal lines remain perfectly horizontal when using the lens shift, but do get skewed when
rotating the camera object.
Using lens shift is equivalent to rendering an image with a larger FOV and cropping it off-center.

Clipping
Set the clipping limits with the Start and End values.
Only objects within the limits are rendered.
For OpenGL display, setting clipping distances to limited values is important to ensure sufficient rasterization
precision. Ray tracing renders don’t suffer from this issue so much, and as such more extreme values can safely
be set.
When Limits in the Display panel is enabled, the clip bounds will be visible as two yellow connected dots on
the camera line of sight.
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Note
The 3D View window contains settings similar to the camera, see the 3D view options page for more details.

Safe Areas
Safe areas are guides used to position elements to ensure that the most important parts of the content can be
seen across all screens.
Different screens have varying amounts of overscan. (specially older TV sets). That means that not all content
will be visible to all viewers, since parts of the image surrounding the edges are not shown. To work around this
problem TV producers defined two areas where content is guaranteed to be shown: action safe and title safe.
Modern LCD/plasma screens with purely digital signals have no overscan, yet safe areas are still considered
best practice and may be legally required for broadcast.
In Bforartists, safe areas can be set from the Camera and Sequencer views.

The Safe areas panel found in the camera properties, and the view mode of the sequencer.
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Main Safe Areas

Red line: Action safe. Green line: Title safe

Title Safe
Also known as Graphics Safe. Place all important information (graphics or text) inside this area to ensure
it can be seen by the majority of viewers.
Action Safe
Make sure any significant action or characters in the shot are inside this area. This zone also doubles as a
sort of “margin” for the screen which can be used to keep elements from piling up against the edges.
Tip
Legal Standards
Each country sets a legal standard for broadcasting. These include, among other things, specific values for safe
areas. Bforartists defaults for safe areas follow the EBU (European Union) standard. Make sure you’re using
the correct values when working for broadcast to avoid any trouble.
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Center-Cuts

Cyan line: action center safe. Blue line: title center safe

Center-cuts are a second set of safe areas to ensure content is seen correctly on screens with a different aspect
ratio. Old TV sets receiving 16:9 or 21:9 video will cut off the sides. Position content inside the center-cut
areas to make sure the most important elements of your composition can still be visible in these screens.
Bforartists defaults show a 4:3 (square) ratio inside 16:9 (wide-screen).
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Bforartists Render Engine
The Bforartists render engine is the first render engine that existed in Bforartists. It's the old render engine,
present since pre 2.5 days. It still delivers some good results. But it is aged. And not longer in active
development. The render engine under active development is Cycles.

Introduction to Materials
A material defines the artistic qualities of the substance that an object is made of. In its simplest form, you can
use materials to show the substance an object is made of, or to “paint” the object with different colors. Usually,
the substance is represented by its surface qualities (color, shininess, reflectance, etc.) but it can also exhibit
more complicated effects such as transparency, diffraction and sub-surface scattering. Typical materials might
be brass, skin, glass, or linen.

Various basic materials (single, multiple material, transparency, vertex paint).

The basic (un-textured) Bforartists material is uniform across each face of an object (although the various pixels
of each face of the object may appear differently because of lighting effects). However, different faces of the
object may use different materials (see Multiple Materials).
In Bforartists, materials can (optionally) have associated textures. Textures describe the substance: e.g. polished
brass, dirty glass or embroidered linen. The Textures chapter describes how to add textures to materials.
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How Materials Work
Before you can understand how to design effectively with materials, you must understand how simulated light
and surfaces interact in Bforartists’s rendering engine and how material settings control those interactions. A
deep understanding of the engine will help you to get the most from it.
The rendered image you create with Bforartists is a projection of the scene onto an imaginary surface called the
viewing plane. The viewing plane is analogous to the film in a traditional camera, or the rods and cones in the
human eye, except that it receives simulated light, not real light.
To render an image of a scene we must first determine what light from the scene is arriving at each point on the
viewing plane. The best way to answer this question is to follow a straight line (the simulated light ray)
backwards through that point on the viewing plane and the focal point (the location of the camera) until it hits a
renderable surface in the scene, at which point we can determine what light would strike that point.
The surface properties and incident light angle tell us how much of that light would be reflected back along the
incident viewing angle (Rendering engine basic principle).

Rendering engine basic principle.

Two basic types of phenomena take place at any point on a surface when a light ray strikes it: diffusion and
specular reflection. Diffusion and specular reflection are distinguished from each other mainly by the
relationship between the incident light angle and the reflected light angle.
The shading (or coloring) of the object during render will then take into account the base color (as modified by
the diffusion and specular reflection phenomenon) and the light intensity.
Using the internal ray tracer, other (more advanced) phenomena could occur. In ray-traced reflections, the point
of a surface struck by a light ray will return the color of its surrounding environment, according to the rate of
reflection of the material (mixing the base color and the surrounding environment’s) and the viewing angle.
On the other hand, in ray-traced refractions, the point of a surface struck by a light ray will return the color of
its background environment, according to the rate of transparency (mixing the base color and the background
environment’s along with its optional filtering value) of the material and the optional index of refraction of the
material, which will distort the viewing angle.
Of course, shading of the object hit by a light ray will be about mixing all these phenomena at the same time
during the rendering. The appearance of the object, when rendered, depends on many inter-related settings:
• World (Ambient color, Radiosity, Ambient Occlusion)
• Lights
• Material settings (including ambient, emission, and every other setting on every panel in that context)
6
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•
•
•
•
•
•
•
•
•

Texture(s) and how they are mixed
Material Nodes
Camera
Viewing angle
Obstructions and transparent occlusions
Shadows from other opaque/transparent objects
Render settings
Object dimensions (SS settings are relevant to dimensions)
Object shape (refractions, fresnel effects)

Using Materials
Tip
Check your Render
When designing materials (and textures and lighting), frequently check the rendered appearance of your scene,
using your chosen render engine/shader settings. The appearance might be quite different from that shown in
the texture display in the 3D panel.

As stated above, the material settings usually determine the surface properties of the object. There are several
ways in which materials can be set up in Bforartists. Generally speaking, these are not compatible - you must
choose which method you are going to use for each particular object in your scene.
First, you can set the Properties in the various Material panels.
Second, you can use Nodes; a graphical nodes editor is available.
Last, you can directly set the color of object surfaces using various special effects. Strictly speaking,
these are not materials at all, but they are included here because they affect the appearance of your
objects. These include Vertex Painting, Wire Rendering, Volume Rendering, and Halo Rendering.
The exact effect of Material settings can be affected by a number of system settings. First and foremost is the
Render Engine used - Cycles and the Bforartists Render Engine (aka Bforartists Internal or BI) require quite
different illumination levels to achieve similar results, and even then the appearance of objects can be quite
different. Also, the material properties settings can be affected by the texture method used (Single Texture,
Multitexture or GLSL). So it is recommended to always select the appropriate system settings before starting
the design of materials.

Assigning a Material
Materials available in the currently-open Bforartists file can be investigated by clicking on the Materials button

in the Properties Window Header. In this section we look at how to assign or remove a material to/from the Active Object in
Bforartists, either by:

7
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• creating a new material,
• re-using an existing material, or
• deleting a material.
We also give hints about practical material usage.

Creating a new Material
Every time a new Object is created it has no material linked to it. You can create a new material for the object
by
• Selecting the object
• In the Properties window, click on the object button
• Click on the Materials button in the Properties Panel Header (1)
The Shading context window then appears. This contains the following elements:

Add new material

• Context - The currently-selected scene and object
• Object Material Slots (3) - this window shows the “slots” for the material (or materials) that this object
data contains.
• Active Material (2). Initially empty, asking for “New”.
To add a new material, click “+” in the Active Material box. This action has a series of effects:

8
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Materials Panel with New Entry

opens the new material in the Active Material box,
brings up additional buttons in the immediate panel,
adds the new material to the Available Materials list,
adds the new material to the Object Material Slots list for the active object (or its object data - see
below)
• brings up a preview of the new material,
• provides you with a range of panels allowing you to select the properties of the new material.
•
•
•
•

New Material Panel Buttons
Details of the additional buttons which appear in the Material panel for a new Active Material are as follows:
Active Material

Available Materials See Reusing Existing Materials below.

Name
Like other data-blocks, Bforartists will automatically set the name of the new material to Material,
Material.001 and so on. You can change this by over-typing with your own choice of name.
Number of Users
Specifies the number of meshes which use this material.
F - Fake User
When enabled, this material will always be saved within the Bforartists file, even if it has no meshes
which use it (see Deleting a Material).
X
Delete this material (see Deleting a Material).
Tip
Naming materials
It’s a very good idea to give your materials clear names so you can keep track of them, especially when they’re
linked to multiple objects. Try to make your names descriptive of the material, not its function (e.g. “Yellow
Painted” rather than “Kitchen Table Color”)

Nodes

If dark, use the Shader Nodes to generate the material.

Data
Specifies whether the material is to be linked to the Object or to the Object Data.
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Link material to object or to object’s data

The Link pop-up menu has two choices, Data and Object. These two menu choices determine whether the
material is linked to the object or to the data, (in this case) the mesh (or curve, nurbs, etc.). The Data menu item
determines that this material will be linked to the mesh’s data-block which is linked to the object’s data-block.
The Object menu item determines that the material will be linked to the object’s data block directly. This has
consequences of course. For example, different objects may share the same mesh data-block. Since this datablock defines the shape of the object, any change in edit mode will be reflected on all of those objects.
Moreover, anything linked to that mesh data-block will be shared by every object that shares that mesh. So, if
the material is linked to the mesh, every object will share it. On the other hand, if the material is linked directly
to the object data-block, the objects can have different materials and still share the same mesh. Short
explanation: If connected to the object, you can have several instances of the same obData using different
materials. If linked to mesh data, you can’t. See Data System for more information.
Object Render Format (menu)
This menu has four options which define how the object is to be rendered:
Surface
Material applied to object planes.
Wire
Material applied to wires following the object edges
Volume
Material applied to the object volume.
Halos
Material applied to halos around each object vertex.

Surface
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Wire

Volume

Halo

Reusing Existing Materials
Bforartists is built to allow you to reuse anything, including material settings, between many objects. Instead of
creating duplicate materials, you can simply re-use an existing material. There are several ways to do this using
the Available Materials menu:
Single Object - With the object selected, click the sphere located to the left of the Material name. A
drop-down list appears showing all the materials available in the current Bforartists file. To use one,
just click on it.

11
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Select an existing material.

List of available materials

Tip
Searching for Materials
The search field at the bottom of the material list allows you to search the names in the list. For example, by
entering “wood” all existent materials are filtered so that only materials containing “wood” are displayed in
the list.
Multiple Objects - In the 3D View, with Ctrl-L you can quickly link all selected objects to the material (and
other aspects) of the active object. Very useful if you need to set a large number of objects to the same
material; just select all of them, then the object that has the desired material, and Ctrl-L link them to that
“parent”. (See Tip on Linking Data in Creating about data linking.)

Deleting a Material
To delete a material, select the material and click X in the Available Materials List entry.
Although the material will seem to disappear immediately, the Delete action can depend on how the material is
used elsewhere.
If the material is linked to the Object and there are other objects which use this material, then the material will
be removed from that object (but remain on all its other objects).
12
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If the “Fake User” button (F) has been lit in the Available Materials list, then the material will be retained when
the file is saved, even if it has no users.
Only if it has 0 “real” users, and no “Fake” user, will the material be permanently deleted. Note that it will still
remain in the Materials list until the Bforartists file is saved, but will have disappeared when the file is
reloaded.

Multiple Materials
Normally, different colors or patterns on an object are achieved by adding textures to your materials. However,
in some applications you can obtain multiple colors on an object by assigning different materials to the
individual faces of the object.

Add new material

To apply several materials to different faces of the same object, you use the Material Slots options (3) in the
Materials header panel.

Material menu in edit mode

The workflow for applying a second material to some faces of an object covered by a base material is as
follows:
13
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•
•
•
•
•
•
•
•

In Object mode, apply the base material to the whole object (as shown in Assigning a material)
Create/select the second material (the whole object will change to this new material).
In the Active Material box (2), re-select the base material.
Go to Edit Mode - Face Select (a new box appears above the Active Material box with
Assign/Select/Deselect).
Select the face/faces to be colored with the second material.
In the Object Material Slots box (3), click the Plus to create a new slot, and while this is still active,
click on the second material in the Available Materials list.
Click the Assign button, and the second material will appear on the selected object faces.
You can also make this new material a copy of an existing material by adding the data block:

Select object, get the material, (R Click) - Copy data to clipboard. When you have renamed the material, click
“Data - Data” to link to the existing material. Proceed to assign faces as required. NB: If you change the
material on the original object, the new object color changes too.

Introduction to Properties
Material Properties
Materials can have a wide array of properties. It is the combination of all of these things that define the way a
material looks, and how objects using that material will appear when rendered. These properties are set using
the various Properties panels.
Remember that the appearance of your materials are affected by the way that they are rendered (surface, wire,
volume or halo), and by the rendering engine (Bforartists, Cycles, or Game) used. Most properties for images
rendered using Cycles can only be controlled using the Node system.
The list below sets out the various Properties panels available in Bforartists Render and Game Engine, and brief
details of their scope. Details of their controls and settings are given on the relevant pages.
Preview
A preview of the current material mapped on to one of several basic objects.
Diffuse Shaders
The basic color of the material, together with different models for dispersion.
Specular Shaders
The reflected highlights: color, strength and different models for dispersion.
Color Ramps
How to vary the base color over a surface in both Diffuse ans Specular shaders.
Shading
Properties of various characteristics of the shading model for the material.
Transparency
Can other objects be seen through the object, and if so, how?
Mirror
(Only Bforartists Render): Reflective properties of the material.
SubSurface Scattering
(Only Bforartists Render): Simulates semi-translucent objects in which light enters, bounces around, then
exits in a different place.
Strand
14
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(Only Bforartists Render): For use when surfaces are covered with hair, fur, etc.
Options
Various options for shading and coloring the object.
Shadow:
Controls how objects using this material cast and receive shadows.
Game Settings
(Only Bforartists Render): Controls settings for real-time rendering of Game Engine objects.

Material Preview
Reference
Mode: All Modes
Panel: Shading/Material Context –> Preview

The Preview panel gives a quick visualization of the active material and its properties, including its Shaders,
Ramps, Mirror Transp properties and Textures. It provides several shapes that are very useful for designing new
shaders: for some shaders (like those based on Ramp colors, or a Diffuse shader like Minnaert), one needs fairly
complex or specific previewing shapes to decide if the shader being designed achieves its goal.

Options
Flat XY plane
Useful for previewing textures and materials of flat objects, like walls, paper and such.
Sphere
Useful for previewing textures and materials of sphere-like objects, but also to design metals and other
reflective/transparent materials, thanks to the checkered background.
Cube
Useful for previewing textures and materials of cube-like objects, but also to design procedural textures.
Features a checkered background.
Monkey
Useful for previewing textures and materials of organic or complex non-primitive shapes. Features a
checkered background.
Hair strands
Useful for previewing textures and materials of strand-like objects, like grass, fur, feathers and hair.
Features a checkered background.
Large Sphere with Sky
Useful for previewing textures and materials of sphere-like objects, but also to design metals and other
reflective materials, thanks to the gradient Sky background.
Preview uses OSA (oversampling). Whatever the preview option, it will make use of OSA (oversampling) in
order to provide better quality. Disable this option if your computer is already slow or old.
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Examples

Plane preview.

Sphere preview.

Cube preview.

Monkey preview.

Hair Strands preview.

Sky Sphere preview.

Diffuse Shaders
Reference
Mode: All Modes
Panel: Shading/Material Context –> Diffuse

A diffuse shader determines, simply speaking, the general color of a material when light shines on it. Most
shaders that are designed to mimic reality give a smooth falloff from bright to dark from the point of the
strongest illumination to the shadowed areas, but Bforartists also has other shaders for various special effects.

Common Options
All diffuse shaders have the following options:
Color
Select the base diffuse color of the material.
Intensity
The shader’s brightness, or more accurately, the amount of incident light energy that is actually diffusely
reflected towards the camera.
Ramp
Allows you to set a range of colors for the Material, and define how the range will vary over a surface.
See Color Ramps for details.
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Technical Details
Light striking a surface and then re-irradiated via a Diffusion phenomenon will be scattered, i.e., re-irradiated in
all directions isotropically. This means that the camera will see the same amount of light from that surface point
no matter what the incident viewing angle is. It is this quality that makes diffuse light viewpoint independent.
Of course, the amount of light that strikes the surface depends on the incident light angle. If most of the light
striking a surface is reflected diffusely, the surface will have a matte appearance (Light re-irradiated in the
diffusion phenomenon.).

Light re-irradiated in the diffusion phenomenon.

Tip
Shader Names
Some shaders’ names may sound odd - they are traditionally named after the people who first introduced the
models on which they are based.

Lambert
Reference
Mode: All Modes
Panel: Shading/Material Context –> Shaders
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Lambert Shader

This is Bforartists’s default diffuse shader, and is a good general all-around workhorse for materials showing
low levels of specular reflection.
Johann Heinrich Lambert (1728-1777)
was a Swiss mathematician, physicist and astronomer who published works on the reflection of light,
most notably the Beer-Lambert Law which formulates the law of light absorption.
This shader has only the default option, determining how much of available light is reflected. Default is 0.8, to
allow other objects to be brighter.

The Lambert diffuse shader settings.

Oren-Nayar
Reference
Mode: All Modes
Panel: Shading/Material Context –> Shaders

Oren-Nayar Shader

Oren-Nayar takes a somewhat more ‘physical’ approach to the diffusion phenomena as it takes into account the
amount of microscopic roughness of the surface. Michael Oren and Shree K. Nayar Their reflectance model,
developed in the early 1990s, is a generalization of Lambert’s law now widely used in computer graphics.

Options
Roughness
The roughness of the surface, and hence, the amount of diffuse scattering.
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The Oren-Nayar diffuse shader settings.

Toon

Reference
Mode: All Modes
Panel: Shading/Material Context –> Shaders

Toon Shader, Different Spec

Toon Shader Variations

The Toon shader is a very ‘un-physical’ shader in that it is not meant to fake reality but to produce cartoon cel
styled rendering, with clear boundaries between light and shadow and uniformly lit/shadowed regions.
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Options
Size
The size of the lit area
Smooth
The softness of the boundary between lit and shadowed areas

The Toon diffuse shader settings.

Minnaert
Reference
Mode: All Modes
Panel: Shading/Material Context –> Shaders

Minnaert Shader

Minnaert works by darkening parts of the standard Lambertian shader, so if Dark is 1 you get exactly the
Lambertian result. Higher darkness values will darken the center of an object (where it points towards the
viewer). Lower darkness values will lighten the edges of the object, making it look somewhat velvet. Marcel
Minnaert (1893-1970) was a Belgian astronomer interested in the effects of the atmosphere on light and images
who in 1954 published a book entitled The Nature of Light and Color in the Open Air.

Options
Dark
The darkness of the ‘lit’ areas (higher) or the darkness of the edges pointing away from the light source
(lower).
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The Minnaert diffuse shader settings.

Fresnel
Reference
Mode: All Modes
Panel: Shading/Material Context –> Shaders

Various settings for the Fresnel shader, Cook-Torr Specular shader kept at Intensity 0.5, Hardness: 50

Fresnel Shader, Different Spec

With a Fresnel shader the amount of diffuse reflected light depends on the incidence angle, i. e. from the
direction of the light source. Areas pointing directly towards the light source appear darker; areas perpendicular
to the incoming light become brighter. Augustin-Jean Fresnel (1788-1827) was a French physicist who
contributed significantly to the establishment of the theory of wave optics.
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Options
Fresnel
Power of the Fresnel effect, 5.0 is max.
Factor
Blending factor of the Fresnel factor to blend in, 5.0 is max.

The Fresnel diffuse shader settings.

Specular Shaders
Reference
Mode: All Modes
Panel: Shading/Material Context –> Specular
Specular shaders create the bright highlights that one would see on a glossy surface, mimicking the reflection of
light sources. Unlike diffuse shading, specular reflection is viewpoint dependent. According to Snell’s Law,
light striking a specular surface will be reflected at an angle which mirrors the incident light angle (with regard
to the surface’s normal), which makes the viewing angle very important.
Tip
Not a Mirror!
It is important to stress that the specular reflection phenomenon discussed here is not the reflection we would
see in a mirror, but rather the light highlights we would see on a glossy surface. To obtain true mirror-like
reflections you would need to use the internal raytracer. Please refer to section RENDERING of this manual.

Common Options
Each specular shader share the following common options:
Specular Color
The color of the specular highlight
Intensity
The intensity, or brightness of the specular highlight. This has a range of [0-1].
Ramp
Allows you to set a range of specular colors for Material, and define how the range will vary over a
surface. See Ramps for details.
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As a result, a material has at least two different colors, a diffuse, and a specular one. The specular color is
normally set to pure white (the same “pure white” as the reflected light source), but it can be set to different
values for various effects (e.g. metals tend to have colored highlights).

Technical Details

Specular Reflection.

In reality, the quality of Diffuse and Specular reflection are generated during the same process of light
scattering, but are not the same. Diffusion is actually subsurface scattering at a very small scale.
Imagine that a surface is made up of extremely microscopic semi-transparent, reflective facets. The sharpness
of Specular reflection is determined by the distribution of the angle of these microfacets on the surface of an
object. The more deep and jagged these facets are, the more the light spreads when it hits the surface. When
these facets are flatter against the “macrosurface”, the surface will have a tighter reflection, closer to a mirror.
This is a condensed explanation of the generally accepted microfacet theory of reflectance, which is the basis of
all modern BRDFs (Bi-directional Reflectance Distribution Functions), or shading models.
Because these microfacets are transparent, some light that hits them travels into the surface and diffuses. The
light that makes it back out is roughly Lambertian most of the time, meaning that it spreads evenly in all
directions. It is also attenuated by the pigmentation in the surface, hence creating what we perceive as diffuse,
and the color of an object.
Note that at glancing angles, the reflectivity of a surface will always go to 1.
If it is difficult for you to understand this relationship, try to imagine a ball (say, of centimeter scale): if you
throw it against a wall of raw stones (with a scale of roughness of a decimeter), it will bounce in a different
direction each time, and you will likely quickly lose it! On the other hand, if you throw it against a smooth
concrete wall (with a roughness of, say, a millimeter scale), you can quite easily anticipate its bounce, which
follow (more or less!) the same law as the light reflection.

CookTorr
Reference
Mode: All Modes
Panel: Shading/Material Context –> Shaders
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CookTorr Shader (Lambert 0.8)

CookTorr (Cook-Torrance) is a basic specular shader that is most useful for creating shiny plastic surfaces. It is
a slightly optimized version of Phong. Robert L. Cook (LucasFilm) and Kenneth E. Torrance (Cornell
University) In their 1982 paper A Reflectance Model for Computer Graphics (PDF), they described “a new
reflectance model for rendering computer synthesized images” and applied it to the simulation of metal and
plastic.

Options
Hardness
Size of the specular highlight

Phong
Reference
Mode: All Modes
Panel: Shading/Material Context –> Shaders

Phong Shader (Lambert 0.8)

Phong is a basic shader that’s very similar to CookTorr, but is better for skin and organic surfaces. Bui Tuong
Phong (1942-1975) was a Vietnamese-born computer graphics pioneer that developed the first algorithm for
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simulating specular phenomenon. His model included components not only for specular lighting, but also
diffuse and ambient lighting.

Options
Hardness
Size of the specular highlight.
Tip
Planet Atmosphere
Because of its fuzziness, this shader is good for atmosphere around a planet. Add a sphere around the planet,
slightly larger than the planet. For its material, use a phong specular shader. Set it to a very low alpha (.05),
zero diffuse, low hardness (5) but high specularity (1).

Blinn
Reference
Mode: All Modes
Panel: Shading/Material Context –> Shaders

Blinn Shader (Oren-Nayar Int 0.8, Rough 0.5)

Blinn is a more ‘physical’ specular shader, often used with the Oren-Nayar diffuse shader. It can be more
controllable because it adds a fourth option, an index of refraction, to the aforementioned three. James F. Blinn
worked at NASA’s Jet Propulsion Laboratory and became widely known for his work on Carl Sagan’s TV
documentary Cosmos. The model he described in his 1977 paper Models of Light Reflection for Computer
Synthesized Pictures (PDF) included changes in specular intensity with light direction and more accurately
positioned highlights on a surface.
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Options
Hardness
Size of the specular highlight. The Blinn shader is capable of much tighter specular highlights than Phong
or CookTorr.
IOR
‘Index of Refraction’. This parameter is not actually used to compute refraction of light rays through the
material (a ray tracer is needed for that), but to correctly compute specular reflection intensity and
extension via Snell’s Law.

Toon
Reference
Mode: All Modes
Panel: Shading/Material Context –> Shaders

Toon Specular Shader (Toon Diffuse, Int 0.8, Size & Smooth match)

The Toon specular shader matches the Toon diffuse shader. It is designed to produce the sharp, uniform
highlights of cartoon cels.

Options
Size
Size of the specular highlight.
Smooth
Softness of the highlight’s edge.
Tip
Alternative Method
The Toon shader effect can also be accomplished in a more controllable way using ColorRamps.
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WardIso
Reference
Mode: All Modes
Panel: Shading/Material Context –> Shaders

WardIso Shader

WardIso is a flexible specular shader that can be useful for metal or plastic.
Gregory J. Ward
developed a relatively simple model that obeyed the most basic laws of physics. In his 1992 paper,
Measuring and modeling anisotropic reaection, Ward introduced a Bidirectional Re?ectance Distribution
Function (BRDF) since then widely used in computer graphics because the few parameters it uses are
simple to control. His model could represent both isotropic surfaces (independent of light direction) and
anisotropic surfaces (direction dependent). In Bforartists, the Ward specular shader is still called Ward
Isotropic but is actually anisotropic. (PDF)

Options
Slope
Standard deviation for of surface slope. Previously known as the root-mean-square or rms value, this
parameter in effect controls the size of the specular highlight, though using a different method to that of
the other specular shaders. It is capable of extremely sharp highlights.

Color Ramps
Reference
Mode: All Modes
Panel: Context Shading –> sub-context Material –> Ramps
In many real life situations - like skin or metals - the color of diffuse and specular reflections can differ slightly,
based on the amount of energy a surface receives or on the light angle of incidence. The Ramp Shader options
27

Bforartists Reference Manual - © Copyright - This page is under OCL license

in Bforartists allow you to set a range of colors for a Material, and define how the range will vary over a
surface, and how it blends with the ‘actual color’ (typically from a material or as output of a texture).
Ramps allow you to precisely control the color gradient across a material, rather than just a simple blend from a
brightened color to a darkened color, from the most strongly lit area to the darkest lit area. As well as several
options for controlling the gradient from lit to shadowed, ramps also provide ‘normal’ input, to define a
gradient from surfaces facing the camera to surfaces facing away from the camera. This is often used for
materials like some types of metallic car paint that change color based on viewing angle.
Since texture calculations in Bforartists happen before shading, the Ramp Shader can completely replace
texture or material color. But by use of the mixing options and Alpha values it is possible to create an additional
layer of shading in Bforartists materials.

Options

Ramps Panel

The separate Ramp panels for the Diffuse shader and the Specular shader respectively can be toggled on and off
using the

button.

By default the Ramp panel opens with two colors; the first stop (0) is black and transparent (Alpha=0) and the
second stop (1) is white and opaque (Alpha=1).
The position of the color stop markers can be altered by either (1) dragging the stop marker in the colorband or
(2) by changing the Pos value in the

box.

Color and alpha values for each marker can be set by clicking the

box.

Input
The input menu contains the following options for defining the gradient:
Shader
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The value as delivered by the material’s shader (Lambert, CookTorr) defines the color. Here the
amount of light doesn’t matter for color, only the direction of the light.
Energy
As Shader, now also lamp energy, color, and distance are taken into account. This makes the
material change color when more light shines on it.
Normal
The surface normal, relative to the camera, is used for the Ramp Shader. This is possible with a
texture as well, but added for convenience.
Result
While all three previous options work per lamp, this option only works after shading calculations.
This allows full control over the entire shading, including ‘Toon’ style results. Using alpha values
here is most useful for tweaking a finishing touch to a material.

Blend pop-up menu

Blend
A list of the various blending modes available for blending the ramp shader with the color from Input.
Factor
This slider denotes the overall factor of the ramp shader with the color from Input.

Colorbands
Reference
Mode: All Modes
Panel: Context Shading –> sub-context Material –> Ramps
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A colorband can contain a gradient through a sequence of many colors (with alpha), each color acting across a
certain position in the spectrum. Colorbands are used in both materials and textures, as well in other places
where a range of colors can be computed and displayed.

Options
Add
Add a new mark to the center of the colorband with the default color (neutral gray). New marks can also
be added by Ctrl-LMB clicking in the colorband itself, which will add the mark at the position of the
click with the same color that already exists underneath the mouse pointer.
Delete
Remove the currently selected mark from the colorband.
F
Flip the colorband.
0
The number of the active mark. The values for this mark are those being displayed, and in the colorband,
the active mark is displayed as a dashed line. Another marker can be selected (1) using the arrows in the

slider, (2) by clicking on the number being displayed and entering a number of a color mark, or (3) by LMB clicking a marker
in the colorband.

Pos
The position of the active color mark in the colorband (range 0.0–1.0). The position of the color marks
can also be changed by LMB dragging them in the colorband.
Note
Reordering colors
If the position of the color marks are reordered, they will be automatically renumbered so that they always
start with 0 from the left and increment to the right.
The Colorswatch right of the Position slider displays the color of the active mark. LMB click it to display a
color picker in which values for color (RGB) and transparency (Alpha) can be set.

Interpolation pop-up menu

Interpolation
Various modes of interpolation between marker’s values can be chosen in the Interpolation menu:
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Ease
Ease by quadratic equation.
Cardinal
Cardinal.
Linear
Linear (default). A smooth, consistent transition between colors.
B-Spline
B-Spline.
Constant
Constant.

Color Ramps
Reference
Mode: All Modes
Panel: Context Shading –> sub-context Material –> Ramps
In many real life situations - like skin or metals - the color of diffuse and specular reflections can differ slightly,
based on the amount of energy a surface receives or on the light angle of incidence. The Ramp Shader options
in Bforartists allow you to set a range of colors for a Material, and define how the range will vary over a
surface, and how it blends with the ‘actual color’ (typically from a material or as output of a texture).
Ramps allow you to precisely control the color gradient across a material, rather than just a simple blend from a
brightened color to a darkened color, from the most strongly lit area to the darkest lit area. As well as several
options for controlling the gradient from lit to shadowed, ramps also provide ‘normal’ input, to define a
gradient from surfaces facing the camera to surfaces facing away from the camera. This is often used for
materials like some types of metallic car paint that change color based on viewing angle.
Since texture calculations in Bforartists happen before shading, the Ramp Shader can completely replace
texture or material color. But by use of the mixing options and Alpha values it is possible to create an additional
layer of shading in Bforartists materials.

Options

Ramps Panel

The separate Ramp panels for the Diffuse shader and the Specular shader respectively can be toggled on and off
using the
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button.

By default the Ramp panel opens with two colors; the first stop (0) is black and transparent (Alpha=0) and the
second stop (1) is white and opaque (Alpha=1).
The position of the color stop markers can be altered by either (1) dragging the stop marker in the colorband or
(2) by changing the Pos value in the

box.

Color and alpha values for each marker can be set by clicking the

box.

Input
The input menu contains the following options for defining the gradient:
Shader
The value as delivered by the material’s shader (Lambert, CookTorr) defines the color. Here the
amount of light doesn’t matter for color, only the direction of the light.
Energy
As Shader, now also lamp energy, color, and distance are taken into account. This makes the
material change color when more light shines on it.
Normal
The surface normal, relative to the camera, is used for the Ramp Shader. This is possible with a
texture as well, but added for convenience.
Result
While all three previous options work per lamp, this option only works after shading calculations.
This allows full control over the entire shading, including ‘Toon’ style results. Using alpha values
here is most useful for tweaking a finishing touch to a material.
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Blend pop-up menu

Blend
A list of the various blending modes available for blending the ramp shader with the color from Input.
Factor
This slider denotes the overall factor of the ramp shader with the color from Input.

Colorbands
Reference
Mode: All Modes
Panel: Context Shading –> sub-context Material –> Ramps
A colorband can contain a gradient through a sequence of many colors (with alpha), each color acting across a
certain position in the spectrum. Colorbands are used in both materials and textures, as well in other places
where a range of colors can be computed and displayed.

Options
Add
Add a new mark to the center of the colorband with the default color (neutral gray). New marks can also
be added by Ctrl-LMB clicking in the colorband itself, which will add the mark at the position of the
click with the same color that already exists underneath the mouse pointer.
Delete
Remove the currently selected mark from the colorband.
F
33

Bforartists Reference Manual - © Copyright - This page is under OCL license

Flip the colorband.
0
The number of the active mark. The values for this mark are those being displayed, and in the colorband,
the active mark is displayed as a dashed line. Another marker can be selected (1) using the arrows in the

slider, (2) by clicking on the number being displayed and entering a number of a color mark, or (3) by LMB clicking a marker
in the colorband.

Pos
The position of the active color mark in the colorband (range 0.0–1.0). The position of the color marks
can also be changed by LMB dragging them in the colorband.
Note
Reordering colors
If the position of the color marks are reordered, they will be automatically renumbered so that they always
start with 0 from the left and increment to the right.
The Colorswatch right of the Position slider displays the color of the active mark. LMB click it to display a
color picker in which values for color (RGB) and transparency (Alpha) can be set.

Interpolation pop-up menu

Interpolation
Various modes of interpolation between marker’s values can be chosen in the Interpolation menu:
Ease
Ease by quadratic equation.
Cardinal
Cardinal.
Linear
Linear (default). A smooth, consistent transition between colors.
B-Spline
B-Spline.
Constant
Constant.
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Shading
In the separate Shading tab six more options are available:

Shading menu, default settings

Emit
Amount of light to emit
Ambient
Amount of global ambient color the material receives. Each material has an Ambient slider that lets you
choose how much ambient light that object receives. Set to 1.0 by default.
You should set this slider depending on the amount of ambient light you think the object will receive.
Something deep in the cave will not get any ambient light, whereas something close to the entrance will
get more. Note that you can animate this effect, to change it as the object comes out of the shadows and
into the light.
Settings for Ambient Occlusion and Environment Lighting can be found in the World menu, with parameters
affecting both these lighting components found in the World Gather menu.
Translucency
Amount of diffuse shading on the back side
Shadeless
Make this material insensitive to light or shadow; gives a solid, uniform color to the whole object.
Tangent Shading
Use the material’s tangent vector instead of the normal for shading - for anisotropic shading effects (e.g.
soft hair and brushed metal). This shading was introduced in 2.42, see also settings for strand rendering in
the menu further down and in the Particle System menu.
Cubic Interpolation
Use cubic interpolation for diffuse values. Enhances the contrast between light areas and shadowed areas

Without Cubic enabled.

With Cubic enabled.

35

Bforartists Reference Manual - © Copyright - This page is under OCL license

Transparency
Reference
Mode: All Modes
Panel: Shading/Material Context –> Transparency

Materials in Bforartists can be set to be transparent, so that light can pass through any objects using the
material. Transparency is controlled using an “alpha” channel, where each pixel has an additional value, range
0-1, in addition to its RGB color values. If alpha=0, then the pixel is transparent, and the RGB values for the
surface contribute nothing to the pixel’s appearance; for alpha=1, the surface is fully opaque, and the color of
the surface determines the final color of the pixel.

Transparency Panel

In Bforartists, there are three ways in which the transparency of a material can be set: Mask, Z-Buffer and Raytrace. Each of these is explained in more detail below. The Material Preview option with a sphere object gives a
good demonstration of the capabilities of these three options.

Common Options
The following property controls are available for all transparency options:
Alpha
Sets the transparency of the material by setting all pixels in the alpha channel to the given value.
Fresnel
Sets the power of the Fresnel effect. The Fresnel effect controls how transparent the material is,
depending on the angle between the surface normal and the viewing direction. Typically, the larger the
angle, the more opaque a material becomes (this generally occurs on the outline of the object).
Specular Controls the alpha/falloff for the specular color.
Blend
Controls the blending between transparent and non-transparent areas. Only used if Fresnel is greater than
0.
Mask

This option simply masks the Background. It uses the alpha channel to mix the color of each pixel on the active
object plane with the color of the corresponding background pixel, according to the alpha channel of the pixel.
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Thus for alpha = 1, the object color is seen - the object is completely opaque; but if alpha = 0, only the
background is seen - the object is transparent (but note that any other object behind the active object
disappears).
This is useful for making textures of solid or semi-transparent objects from photographic reference material - a
mask is made with alpha opaque for pixels within the object, and transparent for pixels outside the object.
See Mask Transparency.

Z Buffer
This uses the alpha buffer for transparent faces. The alpha value of each pixel determines the mix of the basic
color of the material, and the color of the pixel is determined from the objects/background behind it. Only basic
settings are available with this option; it does not calculate refractions.

Raytraced Transparency
Uses ray tracing to calculate refractions. Ray tracing allows for complex refractions, falloff, and blurring, and is
used for simulating the refraction of light rays through a transparent material, like a lens.
Note that the RayTrace option is only available in the Bforartists Render and Cycles render engines, but not in
the Game Engine.
A ray is sent from the camera and travels through the scene until it encounters an object. If the first object hit by
the ray is non-transparent, then the ray takes the color of the object.
If the object is transparent, then the ray continues its path through it to the next object, and so on, until a nontransparent object is finally encountered which gives the whole chain of rays its color. Eventually, the first
transparent object inherits the colors of its background, proportional to its Alpha value (and the Alpha value of
each transparent Material hit in between).
But while the ray travels through the transparent object, it can be deflected from its course according to the
Index of Refraction (IOR) of the material. When you actually look through a plain sphere of glass, you will
notice that the background is upside-down and distorted: this is all because of the Index of Refraction of glass.
Note
Enable Raytracing
To get ray-traced transparency, you need to:
• enable ray tracing in your Render settings. This is done in the Render context –> Shading Panel. Ray
tracing is enabled by default.
• set your Alpha value to something other than 1.0.
• in order for the background material to receive light passing through your transparent object, Receive
Transparent must be turned on for that material in the Material –> Shadow panel.
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Options

The Transparency Panel.

In addition to the common options given above, the following property controls are available:
IOR
Index of Refraction. Sets how much a ray traveling through the material will be refracted, hence
producing a distorted image of its background. See IOR values for Common Materials below.
Filter
Amount of filtering for transparent ray trace. The higher this value, the more the base color of the
material will show. The material will still be transparent but it will start to take on the color of the
material. Disabled (0.0) by default.
Falloff
How fast light is absorbed as it passes through the material. Gives ‘depth’ and ‘thickness’ to glass.
Limit
Materials thicker than this are not transparent. This is used to control the threshold after which the filter
color starts to come into play.
Depth
Sets the maximum number of transparent surfaces a single ray can travel through. There is no typical
value. Transparent objects outside the Depth range will be rendered pitch black if viewed through the
transparent object that the Depth is set for. In other words, if you notice black areas on the surface of a
transparent object, the solution is probably to increase its Depth value (this is a common issue with ray
tracing transparent objects). You may also need to turn on transparent shadows on the background object.
Gloss
Settings for the glossiness of the material.
Amount
The clarity of the refraction. Set this to something lower than zero to get a blurry refraction.
Threshold
Threshold for adaptive sampling. If a sample contributes less than this amount (as a percentage),
sampling is stopped.
Samples
Number of cone samples averaged for blurry refraction.
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Examples
Index of Refraction
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Influence of the IOR of an Object on the distortion of the background: spheres of Water, Glass and Diamond (top to bottom).

(Influence of the IOR of an Object on the distortion of the background: spheres of Water, Glass and Diamond
(top to bottom).). There are different values for typical materials: Air is 1.000 (no refraction), Alcohol is 1.329,
Glass is 1.517, Plastic is 1.460, Water is 1.333 and Diamond is 2.417.

Fresnel

16 pieces of glass rotated in various directions
demonstrate the angle-dependent Fresnel effect
with ray-traced (left) and alpha buffered
transparency (right). Note that the major
difference is the lack of IOR effect in the latter
case. (Download .blend.)

Settings for Fresnel using ray-traced (left) and Z
transparency (right).
Note the specular highlight in the F4 glass tile (which is facing midway between the light and the camera); the
Fresnel effect can be seen in row C and column 6 where the faces are turned away from the camera.
The amount of Fresnel effect can be controlled by either increasing the Blend value or decreasing the Alpha
value.
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Depth

A simple scene with three glasses on a surface, and three lamps. Depth was set to 4, 8, 12, and 14, resulting in render times
of 24 sec, 34 sec, 6 min, and 11 min respectively. (Download .blend.)

Increasing Depth also considerably increases render time. Each time a light ray passes through a surface, the
ray-tracing algorithm is called recursively. In the example above, each side of each glass has an exterior and an
interior surface. Light rays thus have to pass through four surfaces for each glass.
But not only that, at every point on a surface, some of the light can be reflected, or mirrored off the surface in
various directions. This results in multiple rays needing to be calculated for each point (often referred to as a
tree of rays). In each of the rendered images above there are 640×400=256 000 pixels. By increasing Depth, at
least one tree of rays is added to each pixel.
Be kind to your computer. Carefully placing objects in a scene to avoid overlapping transparent objects is often
an interesting alternative.

Hints

Transparent shadows
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No transparent shadows

No transparent shadows, environment lighting enabled

Transparent shadows enabled, alpha set to 0.0

As previous, alpha set to 0.25

Transparent shadows with ambient occlusion set to multiply,

As previous, distance increased to 2 (diameter of sphere)

distance 1 (radius of sphere)

By default, the shadows of transparent objects are rendered solid black, as if the object was not transparent at
all. But in reality, the more transparent an object is, the lighter its shadow will be.
In Bforartists, transparent shadows are set on the materials that receive the shadows from the transparent object.
This is enabled and disabled with the Receive Transparent button, in the Material context –> Shadow panel.
The shadow’s brightness is dependent on the Alpha value of the shadow casting material.
Alternatives to transparent ray-traced shadows can be found in the World context, namely the Ambient
Occlusion, Environment Lighting, and Gather panels. Alternatively, a texture can be used to control the
Intensity value of the shadow-receiving material.

IOR values for Common Materials
The following list provides some index of refraction values to use when ray-traced transparency is used for
various liquids, solids (gems), and gases:

Gasses
• Air 1.000

• Carbon Dioxide 1.000449

• Oxygen 1.000276

• Water (0- C) 1.33346
• Water (100- C) 1.31766
• Water (20- C) 1.33283

• Water (gas) 1.000261
• Water (35- C, room temp)
1.33157
• Vodka 1.363

Common Liquids
•
•
•
•

Alcohol 1.329
Milk 1.35
Oil, vegetable (50- C) 1.47
Shampoo 1.362
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Common Transparent Materials
• Glass 1.51714

• Ice 1.309

• Rock Salt 1.544

• Plastic 1.46
• Rubber, Natural 1.5191

• Silicon 4.24

• Opal 1.45

• Ruby 1.757 - 1.779

• Iron 1.51
• Lead 2.01
• Platinum 2.33

• Silver 0.18
• Steel 2.50
• Titanium 2.16

Common Opaque Materials
• Asphalt 1.635
• Chalk 1.510

Gemstones
• Diamond 2.417
• Jade, Nephrite 1.61

Metals
•
•
•
•

Aluminum 1.44
Bronze 1.18
Copper 1.10
Gold 0.47

Mirror Reflections
Mirror reflections are computed in the Bforartists Render and Cycles render engines using ray tracing. (NB:
Reflections are not available in the Game Engine.) Ray tracing can be used to make a material reflect its
surroundings, like a mirror. The principle of ray-traced reflections is very simple: a ray is fired from the camera
and travels through the scene until it encounters an object. If the first object hit by the ray is not reflective, then
the ray takes the color of the object. If the object is reflective, then the ray bounces from its current location and
travels up to another object, and so on, until a non-reflective object is finally met and gives the whole chain of
rays its color.
Eventually, the first reflective object inherits the colors of its environment, proportional to its Reflectivity value.
Obviously, if there are only reflective objects in the scene, then the render could last forever. This is why a
mechanism for limiting the travel of a single ray is set through the Depth value: this parameter sets the
maximum number of bounces allowed for a single ray.
Note
You need to enable ray tracing in your scene settings if you want to use ray-traced reflections. This is done in
the Scene/Render context –> Render Panel. Ray tracing is enabled by default in Bforartists 2.37 and higher.

The Color Swatch in the mirror panel is the color of the light reflected back. Usually, for normal mirrors, use
white. However, some mirrors color the reflection (e.g. metals), so you can change the color by clicking on the
swatch. The amount of mirrored reflection is determined by the Reflectivity value. If set to something greater
than 0, mirrored reflectivity will be activated and the reflection will be tinted the color set in the swatch.
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Options

The Mirror Panel

Enable ray-traced reflections
Enable or disable ray-traced reflections
Reflectivity
Sets the amount of reflectiveness of the object. Use a value of 1.0 if you need a perfect mirror, or set it to
0.0 if you don’t want any reflection.

Picking a mirror color

Color swatch
Color of mirrored reflection By default, an almost perfectly reflective material like chrome, or a mirror
object, will reflect the exact colors of its surrounding. But some other equally reflective materials tint the
reflections with their own color. This is the case for well-polished copper and gold, for example. In order
to replicate this within Bforartists, you have to set the Mirror Color accordingly. To set a mirror color,
simply click the color swatch in the mirror panel and select a color.
Fresnel
Sets the power of the Fresnel effect. The Fresnel effect controls how reflective the material is, depending
on the angle between the surface normal and the viewing direction. Typically, the larger the angle, the
more reflective a material becomes (this generally occurs on the outline of objects).
Blend
A controlling factor to adjust how the blending happens between the reflective and non-reflective areas.
Depth
Maximum allowed number of light inter-reflections. If your scene contains many reflective objects and/or
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if the camera zooms in on such a reflective object, you will need to increase this value if you want to see
surrounding reflections in the reflection of the reflected object (!). In this case, a Depth of 4 or 5 is
typically a good value.
Max Dist
Maximum distance of reflected rays away from camera (Z-Depth) in Bforartists units. Reflections further
than this range fade out to reduce compute time.
Fade to
The color that rays with no intersection within the Max Distance take. Material color can be best for
indoor scenes, Sky color (World settings) for outdoor scenes.

Suzanne in the Fun House (.blend)

Gloss
In paint, a high-gloss finish is very smooth and shiny. A flat, or low gloss, finish disperses the light and
gives a very blurry reflection. Also, uneven or waxed-but-grainy surfaces (such as car paint) are not
perfect and therefore slightly need a Gloss < 1.0. In the example to the right, the left mirror has a Gloss of
0.98, the middle is Gloss = 1.0, and the right one has Gloss of 0.90. Use this setting to make a realistic
reflection, all the way up to a completely foggy mirror. You can also use this value to mimic depth of field
in mirrors.
Amount
The shininess of the reflection. Values < 1.0 give diffuse, blurry reflections and activate the settings
below.
Threshold
Threshold for adaptive sampling. If a sampling contributes less than this amount (as percentage),
sampling is stopped. Raising the threshold will make the adaptive sampler skip more often, however
the reflections could become noisier.
Samples
Number of cone samples averaged for blurry reflection. More samples will give a smoother result,
but will also increase render time.
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Anisotropic tangent reflecting spheres with anisotropic set to 0.0, 0.75, 1.0. (.blend)

Anisotropic
The shape of the reflection, from 0.0 (circular) to 1.0 (fully stretched along the tangent). If the Tangent
Shading is on, Bforartists automatically renders blurry reflections as anisotropic reflections. When
Tangent is switched on, the Anisotropic slider controls the strength of this anisotropic reflection, with a
range of 1.0 (default) being fully anisotropic and 0.0 being fully circular, as is when tangent shading on
the material is switched off. Anisotropic ray-traced reflection uses the same tangent vectors as for tangent
shading, so you can modify the angle and layout the same way, with the auto-generated tangents, or based
on the mesh’s UV co-ordinates.
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Examples
Fresnel
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Demonstration of Fresnel effect with values equal to (from top to bottom) 0.0, 2.5 and 5.0

Let’s undertake a small experiment in order to understand what Fresnel is really about. After a rainy day, go out
and stand over a puddle of water. You can see the ground through the puddle. If you kneel just in front of the
puddle, your face close to the ground, and look again at a distant point on the puddle of water, the liquid surface
part which is closer to you lets you see the ground, but if you move your gaze towards the other end of the
puddle, then the ground is gradually masked until all you see is the reflection of the sky. This is the Fresnel
effect: having a surface sharing reflective and non-reflective properties according to the viewing angle and the
surface normal.
In Demonstration of Fresnel effect with values equal to (from top to bottom) 0.0, 2.5 and 5.0, this behavior is
demonstrated for a perfectly reflective Material (Mirror Reflectivity 1.0).
Fresnel 0.0 stands for a perfect mirror Material, while Fresnel 5. 0 could stand for a glossy Material. It’s barely
noticeable but in the lower picture, the Material is perfectly reflective around the edges.
The smoothness of the Fresnel limit can be further controlled using the Blend slider.

Subsurface Scattering
Many organic and inorganic materials are not totally opaque right at the surface, so light does not just bounce
off the top surface. Instead, some light also penetrates the skin surface deeply, and scatters around inside, taking
on the color of the insides and emerging back out at a different location. Human/animal skin, the skin of grapes,
tomatoes, fruits, wax, gels (like honey, or Jello) and so on all have subsurface scattering (SSS), and photorealism really cannot be achieved without it.
It is important to understand that subsurface scattering and diffuse are one and the same. The difference is in
how far light can diffuse beneath the surface before it is absorbed or transmitted back out.

How it works
Actually calculating the light path beneath the surface of an object is not practical. But it has been shown that it
is not necessary to do this, and that one can use a different approach.
Bforartists calculates SSS in two steps:
• At first the irradiance, or brightness, of the surface is calculated, from the front side of the object as well
as from its back side. This is pretty much the same as in a normal render. Ambient Occlusion, Radiosity,
the type of diffuse Shader, the light color, etc. are taken into account.
• In the second step, the final image is rendered, but now the SSS shader replaces the diffuse shader.
Instead of the lamps, the calculated lightmap is used. The brightness of a surface point is the calculated
“Average” of the brightness of its surrounding points. Depending on your settings the whole surface
may be taken into account, and it’s a bit more complicated than simply calculating the average, but don’t
bother too much with the math behind it.
Instead let’s see what SSS does to a distinct light point.
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Image 3a: No SSS.

Image 3b: Small SSS radius.

Image 3c: SSS radius enlarged.

Image 3d: SSS with very large red radius value.

If you turn on SSS, the light is distributed over a larger area. The size of this area depends on the radius values.
Instead of distributing all colors with the same amount, you may choose different radius values for each of the
RGB colors.
If you use a very large radius value for a color, its light is evenly distributed over the whole object.
Note
Note about scatter radius
Because of the way this scattering is calculated, when using large radius values, you will notice fringing
artifacts that appear as the complementary color to the predominant color of the scattering. Above, you see in
the last image a bluish band in the illuminated area. This is an unfortunate limitation. A way to lessen this
effect is use multiple passes with different scatter radii, and average them.
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Enabling Subsurface Scattering

Image 4: The SSS Panel. SSS is already enabled.

• Enable SSS by clicking on the Subsurface Scattering button.
• Accessible at the top are various presets. Add new or remove old presets by clicking the + and - buttons.
When you select a preset, the Radius values, the RGB Radius and the IOR are set for you. The
remaining options are not set (because they are mostly dependent on the size of your object).
SubSurface Scattering doesn’t need ray tracing. But since it is dependent on the incident light and shadows,
[you need proper shadow calculation (which may need ray tracing).

Options
The numeric sliders control how the light is scattered:
IOR
The Index Of Refraction value determines the falloff of incident light. Higher values means that light falls
off faster. The effect is quite subtle and changes the distribution function only a little bit. By the
examination of many different materials, values of 1.3 to 1.5 have been found to work well for most
materials. If you know the exact material you are trying to simulate, see IOR values for Common
Materials.
Scale
The scale of your object, in Bforartists units, across which you want the scattering effect to take place.
Scale 1.0 means 1 Bforartists unit equals 1 millimeter, scale 0.001 means 1 Bforartists unit equals 1
meter. If you want to work out what scale value to use in your scene, just use the formula: (size in
Bforartists units)/(real world size in millimeters)=scale.
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The SSS Color Swatch

Scattering Color (Albedo)
Albedo is the probability that light will survive a scattering event. If you think of scattering as a filter, this
is the height of the filter. It is multiplied by the surface color. In practice, this is unintuitive. It should be
the same as the surface color, however changing this value has unintuitive results on the scattering effect:
The darker the color the more light is scattered. A value of 1 will produce no scattering effect.
So if you set it to green, the lit areas of the object will appear as green, and green is scattered only a little.
Therefore the darker areas will appear in red and blue. You can compensate the different scattering by
setting a larger radius for the color.
RGB Radius
This is not in fact the radius of the subsurface scattering, but the average path length between scattering
events. As the light travels through the object it bounces around then emerges from the surface at some
other point. This value corresponds to the average length the light travels between each bounce. The
longer the path length is, the further the light is allowed to scatter. This is the main source of a material’s
perceived “scatter color.” A material like skin will have a higher red radius than green and blue.
Subsurface scattering is the diffusion of light beneath the surface. You control how far the light spreads to
achieve a specific result.
Blend :
Color
This controls how much the R, G, B option modulates the diffuse color and textures. Note that even
with this option set to 0.0, the R, G, B option still influences the scattering behavior.
Texture
How much the surface texture is blurred along with the shading.
Scattering Weight :
Front
Factor to increase or decrease the front scattering. When light enters through the front of the object,
how much is absorbed or added? (Normally 1.0 or 100%).
Back
Factor to increase or decrease the back scattering. Light hitting an object from behind can go all the
way through the object and come out on the front of the object. This happens mostly on thin objects,
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like hands and ears.
Error
This parameter controls how precisely the algorithm samples the surrounding points. Leaving it at 0.05
should give images without artifacts. It can be set higher to speed up rendering, potentially with errors.
Setting it at 1.0 is a good way to quickly get a preview of the look, with errors.

Developing your own SSS material
The Traditional Approach
A more common but less intuitive approach is to use “layering”. This is a simplified version of the layering
approach. See the external links for more information:
• Set the SSS color on a value of your choice, normally the predominant color of the object. If you want to
use different radii for the colors, don’t make it too dark.
• Set the scale factor. If you want to see much translucency you need small objects or large scale values.
• Set the radius values.
• Adjust the brightness with the Front and Back values.

A more intuitive approach
• Set the Scattering color to .5
• Set the Front weight to 2.
• Set the scale factor based on the size of your object relative to the scene. If you want to see much
translucency you need small objects or large scale values.
• Set the radius values appropriately.

Examples
Skin
Increasing SSS scale (.blend)

1

2

3

4

See also
• Development Release Log: Subsurface Scattering
• Ben Simonds: Three Layer SSS in Bforartists Demystified
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Strands
The Strand section of the Material editor is specific to the rendering of Hair particles. There are two different
strand methods available:
Polygon strands
This is the default (old) method. The strands are rendered as flat polygons. The number of polygons
depend on the Steps settings in the Render panel of the Object context, Particles sub-context.
Strand Primitive
You activate Strand Primitive with the button Strand render in the Render panel of the particle system.
The hair curves are not stored as polygons; only the key points are stored, which are then converted to
polygons on the fly. A second difference is the way transparency works. Rather than rendering using the
existing system, all strand segments in a part are sorted front to back and rendered in that order.
Strand Primitives:
• Are more memory efficient and faster, to make rendering of large amounts of fur and grass
possible. For good performance, the render steps button should be lowered (e.g. 2 should be
good enough fur), since the result will be a smoothed curve anyway. You need 1 to 2 render
steps less than steps in the 3D window. Also, using more render parts helps to reduce
memory usage.
• Have a distance of vision reduction (in the Render panel under Child Simplification) for
children from faces.
• May be faded out towards the tip without an additional texture.
• Are not ray traced. So they are not visible through ray-transparent materials or in a ray
mirror (you can use Environment Mapping for that).
• Have shape problems if they are rendered with a greater width.
• Cannot carry a UV-Texture along the strand.
Polygon strands:
• Work well with greater width, so you can use them as an alternative to billboards because
the strands may have an animated shape.
• Can be textured with a UV-Texture along the strands.
• Are seen by ray tracing.

Strands Shading

Image 1: Strands Panel.

Strands are rendered with the material of the underlying face/vertex, including shading with a UV-Texture.
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Since you can assign more than one material to each face, each particle system may have its own material and
the material of the underlying face can be different from the material of the strands.
Additionally strands can be shaded along the strand (from root to tip) with a mono-dimensional texture; only
polygon strands can carry a two-dimensional UV-Texture.
The options for strand shading are in the Strands section of the Material context.
Root
Width of the hair at the root.
Tip
Width of the hair at the tip.
Minimum
This is the minimum thickness (in pixels) of the strands. Strands below that size are not rendered
smaller, but are faded to alpha (well, the fading works only for strand primitives). This gives a much
better rendering result for thin hair.
Bforartists Units
Normally strands are quite thin; the thickness is given in screenpixels. If you use Bforartists units (BU)
you may set the root value up to 2 BU, and the tip value up to 1 BU. You have to consider the overall
object size, because the smallest possible size is 0.001 BU. So if you use 1 BU for 1 meter the smallest
possible size would be 1 mm (too thick for thin hair).
Use Tangent Shading
Calculates the light as if the strands were very thin and round. This makes the hair appear brighter and
shinier. Disabling the “Tangent Shading” option will still render nicely, but resembles more solid strands,
as though made of metal or wood.
Shape
This slider allows you to control the interpolation. Default (0.0) is a linear interpolation between Root and
Tip. A negative value will make the strand narrower (spiky), a positive value will make it fatter.

Width Fade
To fade out along the width of the strand. This works only for Strand Primitives. 0.0 is no fading at all,
1.0 linear fading out.
UV Layer
You can texture polygon strands with a UV-Texture. Fill in the name of the UV-Set (not the texture) here.
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You also have to load the texture in the Shading context, Texture and Material sub-contexts (Mapping:
UV; you may use every Influence setting you like - especially the alpha value; see Image 3).
Surface Diffuse
Computes the strand normal, taking the normal at the surface into account. This eases the coloring and
lighting of hair a lot, especially for Strand Primitives. Essentially hair reacts similar to ordinary surfaces
and don’t show exaggerated strong and large specular highlights.
Distance
The distance in Bforartists units over which to blend in the normal at the surface (if you want to use
Surface Diffuse only for Grass/Fur at greater distances).

Texturing along the Strand

Image 4: Fading a strand to alpha...

Image 5: ...And the render result.

Strands can be textured along the strand, i.e. from root to tip. To do that you have to select Strand/Particle in
the Coordinates drop-down in the Mapping panel of the Material sub-context.
Pretty much the most important setting is shown in (Image 4), how to fade the tip of a strand to alpha to make
nice, fuzzy-looking hair. Normally you would use a linear blend texture for this.
You may of course set any attribute you like, especially color. Be careful with specularity; hairs tend to get too
shiny.

57

Bforartists Reference Manual - © Copyright - This page is under OCL license

Strand render Simplification

Image 5: Strand render child simplification.

If you use Strand Primitives (Strand render button) and have activated Interpolated Children, the Child
Simplification option appears. The strand render has options to remove child strands as the object’s faces
become smaller.
Reference Size
This is the approximate size of the object on screen (in pixels), after which simplification starts.
Rate
How fast strands are removed.
Transition
The transition period for fading out strands as they are removed.
Viewport
This removes strands on faces that are outside of the viewport.
Rate
Controls how fast these are removed.

Options

Material Options Panel

This panel provides a series of control options concerning how objects using this material will appear in the
rendered image. All controls are default “Off” unless otherwise stated.
Traceable (default On)
Include this material and the geometry that uses it in ray-tracing calculations. See Transparency for
details of ray-tracing.
Full Oversampling
Force this material to render full shading/textures for all anti-aliasing samples.
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Sky
Render this material with zero alpha, but with sky background in place (scanline only)
Use Mist
Use mist on this material (see “World Settings” for more details)
Invert Z depth
Render material’s faces with an inverted Z buffer (scanline only)
Z Offset
Give faces an artificial Z offset for Z transparency.
Light Group
Limit lighting to lamps in this light group.
Exclusive
Uses the light group exclusively - these lamps are excluded from other scene lighting
Local
When linked in, uses local light group with the same name.
Face Textures
Replace object’s base color with color from UV map image textures.
Face Textures Alpha
Replace object’s base alpha with alpha from UV map image textures.
Vertex Color Paint
Replace object’s base color with vertex paint colors (multiply with ‘texture face’ face assigned textures)
Vertex Color Light
Add vertex paint colors as additional lighting. (This can be used to produce good incandescence effects).
Object Color
Modulate the result with a per object color
UV Project (default On)
Use to ensure UV interpolation is correct for camera projections (use with UV project modifier).
Pass Index
Index number for the IndexMA render pass.

Shadows
The shadows that appear in a scene are affected by a combination of the layout of objects, the shape of the
objects, the materials of the objects, and the lighting. In Bforartists, the Display Mode (Single Texture,
Multitexture,or GLSL) also affects the appearance of shadows. See Shadows for a more complete description of
this subject.
Tip
Shadows in 3D mode
To see shadows in 3D (textured) mode, you must have switched to GLSL mode before making any materials.
In MultiTexture mode, shadows only appear in the rendered image: none of these can be seen in the preview
image.
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Fig. 1: Shadow Panel.

The Shadow panel in the Materials Properties window (Fig. 1) controls the effects that the material can have on
the shadows that appear in the scene. The various properties are described in the sections below.

Fig. 2: Scene- all shadow properties off.

Options
The following properties can be set for each individual material with which objects in the scene are shaded. The
effects are illustrated with rendered images for a simple scene (Fig. 2) consisting of two “posts”, one with a red
(totally non-transparent) material; one green (partially transparent) material, set up on a light blue plane to
receive the shadows. The illustrations were all taken in Bforartists Render engine, with Multitexture mode.

Shadow Receiving Object Material
The following options affect the material that receives shadows:
Receive
Allows this material to receive full-intensity shadows (Fig. 3).
Receive Transparent
Allows this material to receive shadows whose intensity is modified by the transparency and color of the
shadow-casting object (Fig. 4).
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Fig. 3: Plane - Receive.

Fig. 4: Plane - Receive + Receive Transparency.

Shadow Casting Object Material
The following options affect the material that casts shadows:
Cast Only
Material appears transparent, but it still casts shadows (Fig. 5).
Casting Alpha
??
Shadows Only
Material appears transparent except for where it receives shadows from other objects, and also it retains
its own transparency (Fig. 6). Note the faint image of the partly-transparent post.
Shadow and Distance
???

Fig. 5: Posts - Cast Only.
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Fig. 6: Posts - Shadows Only.

Buffered Shadow Options
In addition to the shadow options described above, there are further material properties which control buffered
shadow features. See section on Spot Buffered Shadows for further discussion of these techniques.
Cast Buffer Shadow
Casts shadows from shadow buffer lamps.
Buffer Bias
Multiplication factor for Buffer shadows (0 = ignore)
Auto Ray Bias Prevent raytraced shadow errors on surfaces with smooth shaded normals.
Ray Bias
Bias value to be used.
Cast Approximate
Allow this material to cast shadows when using approximate ambient occlusion.

Introduction to Material Nodes
In addition to creating materials as just described using all the settings on all the materials panels, Bforartists
allows you to create a material by routing basic materials through a set of nodes. Each node performs some
operation on the material, changing how it will appear when applied to the mesh, and passes it on to the next
node. In this way, very complex material appearances can be achieved.
You should already be familiar with general material concepts and how to create materials/textures using the
material menu. You should also have a general understanding of the texture coordinate systems available in
Bforartists (e.g. Generated, UV, etc.). Also, many aspects of a node will be skipped here because in later
sections you will see the function expanded upon. Each section builds off the previous.
To start, the node system does not make the material menu obsolete. Many features and material settings are
still only accessible through the material panel (e.g. Ray Mirror). However with the advent of nodes, more
complex and fantastic materials can be created since we now have greater control.
Just in case you’re not (yet) familiar with the concepts: when you create a system of nodes (otherwise known as
a “noodle”), you’re describing a data-processing pipeline of sorts, where data “flows from” nodes which
describe various sources, “flows through” nodes which represent various processing and filtering stages, and
finally “flows into” nodes which represent outputs or destinations. You can connect the nodes to one another in
many different ways, and you can adjust “knobs, ” or parameters, that control the behavior of each node. This
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gives you a tremendous amount of creative control. And, it will very quickly become intuitive.
Having said all that, let’s begin with a normal material.
Here we have the standard material we have added to a cube mesh. We could, as we have in the past, add color
and other settings to this material and it would certainly look nice. But let’s say we are just not getting what we
are looking for? What if we want to control the creation more tightly or add more complexity? Here is where
nodes come in.
Making this node map is accomplished by working in a Node Editor window. This section covers:
• Enabling Material Nodes.
• The Node Editor window, its basic controls, and working with nodes.
• The specific types of nodes available for materials.

Accessing The Node Editor
First lets enter the node editor and make sure that the node editor has the material node button (the sphere icon)
pressed, not the composite or texture node buttons.

Enabling Node Materials in the Material Buttons

Default nodes

Material’s menu with Nodes enabled

Let’s take the base material and hit the Nodes button next to the material name in the material panel or the node
editor. You will see a change in the material panel.
What you have just done is told Bforartists to make the material you were on to become the node tree. Most of
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the panels we normally find in the material menu are now gone.

Accessing the Compositing screen

If you switch to the Compositing screen (Ctrl-Left if you are on the default screen) you’ll find a Node
Editor on the top half of the screen. When you enabled material nodes, a material node and an output node were
automatically added to the node editor.
You can also split the 3D view in the default screen in two and change one into a Node Editor.

Material’s menu with a first material added to the Node Editor

A first material added to the noodle

It is important to note that you can add a new material (which you can edit and change like any other material in
64

Bforartists Reference Manual - © Copyright - This page is under OCL license

the material panel), add an already created material or append a material from another Bforartists file, and also
use the material that you used to create the node tree.
Here, we added a new material in the Node editor (Material.001), and as we did, we can access the properties
of this material in the material’s menu.

Types of Material Nodes
This section is organized by type of node, which are grouped based on similar functions:
Input
Introduces a material or component to the node map.
Output
Displays the result in progress as a small image.
Color
Manipulates the colors of the material.
Vector
Change the way light is reflected off the material.
Convertors
Convert colors to other material colors.

Node Types
• Color Nodes
• MixRGB
• RGB Curves
• Invert
• Hue Saturation Value
• Convertor Nodes
• ColorRamp Node
• RGB to BW Node
• Math Node
• Vector Math Node
• Squeeze Value Node
• Separate RGB Node
• Combine RGB Node
• Separate HSV Node
• Combine HSV Node
• Input Nodes
• Material Node
• Extended Material Node
• Camera Data Node
• Lamp Data Node
• Value Node
• RGB Node
• Texture Node
• Geometry Node
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• Output Node
• Vector Nodes
• Normal Node
• Mapping Node
• Vector Curves

Color Nodes
MixRGB

MixRGB node

This node mixes a base color or image (threaded to the top socket) together with a second color or image
(bottom socket) by working on the individual and corresponding pixels in the two images or surfaces. The way
the output image is produced is selected in the drop-down menu. The size (output resolution) of the image
produced by the mix node is the size of the base image. The alpha and Z channels (for compositing nodes) are
mixed as well.
Not one, not two, but count ‘em, sixteen mixing choices include:
See also
Color Blend Modes for details on each blending mode.

Inputs
Fac
The amount of mixing of the bottom socket is selected by the Factor input field (Fac:). A factor of zero
does not use the bottom socket, whereas a value of 1.0 makes full use. In Mix mode, 0.5 is an even mix
between the two, but in Add mode, 0.5 means that only half of the second socket’s influence will be
applied.
Color 1
Input color value. The value can be provided by another node or set manually. Includes a color swatch,
allowing you to select the color directly on the node.
Color 2
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Input color value. The value can be provided by another node or set manually. Includes a color swatch,
allowing you to select the color directly on the node.

Outputs
Color
Value of the color, combined by the node.

Controls
Clamp
Clamp result of the node to 0...1 range.

RGB Curves

RGB Curves node

For each color component channel (RGB) or the composite (C), this node allows you to define a bezier curve
that varies the input (x-axis) to produce an output value (y-axis). Clicking on one of the C R G B components
displays the curve for that channel.
Note
• Read more about using the Curve Widget.
• RGB Curves node in the compositor (includes examples)
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Invert

Invert node

This node simply inverts the input values and colors.

Inputs
Fac:
Factor. The degree of node’s influence in node tree. The value can be provided by another node or set
manually.
Color
Input color value. The value can be provided by another node or set manually. Includes a color swatch,
allowing you to select the color directly on the node.

Outputs
Color
Value of the color, combined by the node.

Hue Saturation Value

Hue Saturation Value node

Use this node to adjust the Hue, Saturation, and Value of an input.

Inputs
Fac
Factor. The degree of node’s influence in node tree. The value can be provided by another node or set
manually.
Hue
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Input hue value of color. The value can be provided by another node or set manually.
Saturation
Input saturation value of color. The value can be provided by another node or set manually.
Value
Input HSV-Value of color. The value can be provided by another node or set manually.
Fac
Factor. The degree of node’s influence in node tree. The value can be provided by another node or set
manually.
Color
Input color value. The value can be provided by another node or set manually. Includes a color swatch,
allowing you to select the color directly on the node.

Outputs
Color
Value of the color, combined by the node.

Convertor Nodes
As the name implies, these nodes convert the colors in the material in some way.

ColorRamp Node

ColorRamp node

The ColorRamp Node is used for mapping values to colors with the use of a gradient. It works exactly the same
way as a Colorband for textures and materials, using the Factor value as a slider or index to the color ramp
shown, and outputting a color value and an alpha value from the output sockets.
By default, the ColorRamp is added to the node map with two colors at opposite ends of the spectrum. A
completely black black is on the left (Black as shown in the swatch with an Alpha value of 1.00) and a
whitewash white is on the right.
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To select a color, LMB click on the thin vertical line/band within the colorband. The example picture shows the
black color selected, as it is highlighted white. The settings for the color are shown above the colorband as (left
to right): color swatch, Alpha setting, and interpolation type.

Inputs
Fac:
Factor. The degree of node’s influence in node tree. The value can be provided by another node or set
manually.

Outputs
Color
Value of the color, combined by the node.
Alpha
Value of the alpha, combined by the node.

Controls

Add a new mark to the center of the colorband with the default color (neutral gray).

Remove the currently selected mark from the colorband.

Flip the colorband.

Modes of interpolation between marker’s values color ramp

Interpolation
Various modes of interpolation between marker’s values can be chosen in the Interpolation menu:
Ease
Ease by quadratic equation.
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Cardinal
Cardinal.
Linear
Linear (default). A smooth, consistent transition between colors.
B-Spline
B-Spline.
Constant
Constant.

Colorband

Colorband
Contain a gradient through a sequence of many colors (with alpha), each color acting across a certain
position in the spectrum.

The number of the active mark.

Pos. The position of the active color mark in the colorband (range 0.0–1.0). The position of the color marks can also be
changed by LMB dragging them in the colorband.

Color swatch to color selection for a mark

Color Selector
Allows set color and alpha values for each marker.
See more details about node controls’ functions here.

RGB to BW Node

RGB to BW node

This node converts a color image to black-and-white.
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Inputs
Color:
Input color value. Includes a color swatch, allowing you to select the color directly on the node.

Outputs
Value
Black-and-white value of the input color, converted by the node.

Math Node

Math node

This node performs the selected math operation on an image or buffer. All common math functions are
supported. If only an image is fed to one Value socket, the math function will apply the other Value consistently
to every pixel in producing the output Value. Select the math function by clicking the up-down selector where
the “Add” selection is shown.

Inputs
Value
Input value 1 (upper). The value can be provided by another node or set manually.
Value
Input value 2 (lower). The value can be provided by another node or set manually.

Outputs
Value
Output value, converted by the node.

Controls
Clamp
Clamps the result between 0 and 1.
Operation
Selector the math function for conversion.
Add
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Add the two inputs
Subtract
Subtract input 2 from input 1
Multiply
Multiply the two inputs
Divide
Divide input 1 by input 2
Sine
The sine of input 1 (degrees)
Cosine
The cosine of input 1 (degrees)
Tangent
The tangent of input 1 (degrees)
Arcsine
The arcsine (inverse sine) of input 1 (degrees)
Arccosine
The arccosine (inverse cosine) of input 1 (degrees)
Arctangent
The arctangent (inverse tangent) of input 1 (degrees)
Power
Input 1 to the power of input 2 (input1^input2)
Logarithm
Log base input 2 of input 1
Minimum
The minimum of input 1 and input 2
Maximum
The maximum of input 1 and input 2
Round
Rounds input 1 to the nearest integer
Less Than
Test if input 1 is less than input 2, returns 1 for true, 0 for false
Greater Than
Test if input 1 is greater than input 2, returns 1 for true, 0 for false
Modulo
Division of input 1 by input 2 with remainder.
Absolute
Always return non-negative value from any operation input 2 between input 1.

Vector Math Node
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Vector Math node

This node performs the selected math operation on vectors. Select the math function by clicking the up-down
selector where the “Add” selection is shown.

Inputs
Vector
Input vector 1 (upper). The value can be provided by another node or set manually.
Vector
Input vector 2 (lower). The value can be provided by another node or set manually.

Outputs
Vector
Output vector, converted by the node.
Value
Output value, converted by the node.

Controls
Operation
Selector the math function for conversion.
Add
Adding input 1 and 2.
Subtract
Subtracting input 1 and 2.
Average
Averaging input 1 and 2.
Dot Product
Algebraic operation that takes two equal-length sequences of vectors 1 and 2 and returns a single
number. Result - scalar.
Cross Product
Geometric binary operation on two vectors 1 and 2 in three-dimensional space. It results in a vector
which is perpendicular to both and therefore normal to the plane containing them. Result - vector.
Normalize
Normalizing input 1 and 2.

Squeeze Value Node
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Squeeze Value node

This node is used primarily in conjunction with the Camera Data node used. The camera data generate large
output values, both in terms of the depth information as well as the extent in the width. With the squeeze Node
high output values to an acceptable material for the node degree, ie to values between 0.0 - 1.0 scaled down.

Inputs
Value
Any numeric value. The value can be provided by another node or set manually.
Width
Determines the curve between sharp S-shaped (width = 1) and stretched (Width = 0.1). Negative values
reverse the course. The value can be provided by another node or set manually.
Center
The center of the output value range. This input value is replaced by the output value of 0.5. The value
can be provided by another node or set manually.

Outputs
Value
A value between 0 and 1, converted by the node.

Separate RGB Node

Separate RGB node

This node separates an image into its red, green and blue channels. The colors are then converted to intensity,
which returns a greyscale to the output. For example, if you have an image with pure green, then the red and
blue outputs will be black and the green output will be completely white. Mixed colors will return mixed values
according to their RGB intensity.

Inputs
Image
Input color value. Includes a color swatch, allowing you to select the color directly on the node.

Outputs
R
Value of the red color channel, separated out by the node.
G
Value of the green color channel, separated out by the node.
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B
Value of the blue color channel, separated out by the node.

Combine RGB Node

Combine RGB node

This node combines a color (image) from separated red, green, blue channels.

Inputs
R
Input value of red color channel. The value can be provided by another node or set manually.
G
Input value of green color channel. The value can be provided by another node or set manually.
B
Input value of blue color channel. The value can be provided by another node or set manually.

Outputs
Image
Output value of the color, combined by the node.

Separate HSV Node

Separate HSV node

This node separates an image into image maps for the hue, saturation, value channels. Three values, often
considered as more intuitive than the RGB system (nearly only used on computers)
Use and manipulate the separated channels for different purposes; i.e. to achieve some compositing/color
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adjustment result. For example, you could expand the Value channel (by using the multiply node) to make all
the colors brighter. You could make an image more relaxed by diminishing (via the divide or map value node)
the Saturation channel. You could isolate a specific range of colors (by clipping the Hue channel via the
Colorramp node) and change their color (by the Add/Subtract mix node).

Inputs
Color
Input color value. Includes a color swatch, allowing you to select the color directly on the node.

Outputs
H
Value of the hue color channel, separated out by the node (choose a color of the rainbow).
S
Value of the saturation color channel, separated out by the node (the quantity of hue in the color (from
desaturate - shade of gray - to saturate - brighter colors)).
V
Value of the value color channel, separated out by the node (the luminosity of the color (from ‘no light’ black - to ‘full light’ - ‘full’ color, or white if Saturation is 0.0)).

Combine HSV Node

Combine HSV node

This node combines a color from separated hue, saturation, value color channels.

Inputs
H
Input value of hue color channel. The value can be provided by another node or set manually.
S
Input value of saturation color channel. The value can be provided by another node or set manually.
V
Input value of value color channel. The value can be provided by another node or set manually.

Outputs
Color
Output value of the color, combined by the node.
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Input Nodes
A starting material is created in the Materials Panel. The Nodes button is enabled to add that material to the list
of noded materials shown in the Node Editor window header. Other inputs to the node map include:
•
•
•
•
•
•
•

A value
A color
A texture
Geometry
Material
Camera Data
Lamp Data

Material Node
Reference
Panel: Node Editor –> Material Nodes
Menu: Input –> Material
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Material node

The Material node is used to add a material to the node program. Materials can be anything from pure shading
to fully layered with textures. It inputs the main attributes of a material (color, alpha and normal vector) into the
map.

Output
Materials can output color (which includes shading and any textures assigned to it), alpha, and the final normal
calculated from any textures it has.
Color
value of the color, combined by the node.
Alpha
value of the alpha, combined by the node.
Normal
direction of the normal, combined by the node.

Input
Materials can take inputs for colors, inputs for diffuse color and specularity color, a value for reflectivity, and a
normal.
Color
The base color of the paint. Can be set
• manually by LMB clicking on the color swatch applet next to the socket, choosing a color using the
control panel that pops up, and pressing Return
• based on an Active Material which is specified using the material panels, or
• plugged in from an RGB color generator.
Spec
The color that is reflected as you get perpendicular to the light source reflecting off the surface. The color
can be
• plugged in from another node or...
• set manually by LMB clicking on and using the color swatch applet.
Refl:
The degree to which the material reflects light and gives off its color. The value can be provided by
another node or set manually.
Normal
The lighting condition.

Controls
Material field
You can browse and select materials here.
Diffuse toggle
Turn on/off Diffuse Color.
Specular toggle
Turns on/off Specularity calculation.
Invert Normal toggle
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Inverts the material input normal when activated (which, of course, is a combination of the 3D normal
given to it by the 3D object plus the normal input point).
Note
Normal Override
The normal input socket does not in any way blend the source normal with the underlying geometry. Any
plugged in Geometry here overrides the Normal lighting conditions.

Using the Material Node with Specularity

Material Node using Specularity

To make a material node actually generate a color, you have to specify at least a basic input color, and
optionally a specularity color. The specularity color is the color that shines under intense light.
For example, consider the mini-map to the right. The base color, a dark blue, is connected from an RGB color
generator node to the Color input socket. The specular color, yellow, is connected to the Spec input. Under
Normal lighting conditions on a flat surface, this material will produce a deep blue color and, as you approach a
spot perpendicular to the light, you will see the yellow specular color mix in.
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Note
Enable Spec
To see specularity, you have to enable it by clicking the blue Spec button located just below the material color
swatch in the node.
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Extended Material Node

Extended Material node

Adds additional input and output channels to the material node.
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Input
Color
Includes a color swatch, allowing you to select the color directly on the node.
Mirror Color
Color of mirrored reflection.
Ambient
Amount of global ambient color the material receives.
Emit
Amount of light to emit.
SpecTra
Alpha for the specular color.
Ray Mirror
Amount of reflectiveness of the object.
Alpha
Transparency of the material by setting all pixels in the alpha channel to the given value.
Translucency
Amount of diffuse shading on the back side

Output
Materials can additionaly output the followings:
Diffuse
value of the diffuse color, combined by the node.
Spec
value of the specular color, combined by the node.
AO
value of the Ambient Occlusion, combined by the node.

Camera Data Node

Camera Data node

View Vector
A Camera space vector from the camera to the shading point.
View Z Depth
How far away each pixel is from the camera
View Distance
Distance from the camera to the shading point.
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Lamp Data Node

Lamp Data node

The Lamp Data node is used to obtain information related to a specified lamp object. Select a lamp object listed
in the Lamp field, then the following outputs will be available:
Color
Lamp color multiplied by the lamp energy.
Light Vector
An unit vector in the direction from the shading point to the lamp.
Distance
Distance from the shading point to the lamp.
Shadow
Shadow color that the other objects cast on the shading point.
Visibility Factor
Light falloff ratio at the shading point.
The light textures and the shadow textures affect the Color and Shadow outputs, respectively.
Note
Portability to Various Scenes
If multiple materials use a Lamp Data node linking to the same lamp object, including the Lamp Data node
into a node group is recommended. Otherwise, when the mesh objects are imported to the other scene, all the
materials may need to be modified.

Value Node

Value node

The Value node has no inputs; it just outputs a numerical value (floating point spanning 0.00 to 1.00) currently
entered in the NumButton displayed in its controls selection.
84

Bforartists Reference Manual - © Copyright - This page is under OCL license

Use this node to supply a constant, fixed value to other nodes’ value or factor input sockets.

RGB Node

RGB node

The RGB node has no inputs. It just outputs the value Color currently selected in its controls section.

Texture Node

Texture node

A texture, from the list of textures available in the current blend file, is selected and introduced through the
value and/or color socket.
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Example of the applying Texture node

Input
Vector
Uses for map the texture to a specific geometric space.

Outputs
Value
Straight black-and-white value of the texture, combined by the node.
Color
Texture color output, combined by the node.
Normal
Direction of normal texture, combined by the node.
In the example to the right, a cloud texture, as it would appear to a viewer, is added to a base purple material,
giving a velvet effect.
Note that you can have multiple texture input nodes. With nodes, you simply add the textures to the map and
plug them into the map.
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Geometry Node

Geometry node

The geometry node is used to specify how light reflects off the surface. This node is used to change a material’s
Normal response to lighting conditions.
Use this node to feed the Normal vector input on the Material node, to see how the material will look (i.e. shine,
or reflect light) under different lighting conditions. Your choices are:
Global
Global position of the surface.
Local
Local position of the surface.
View
Viewed position of the surface.
Orco
Using the Original Coordinates of the mesh.
UV
Using the UV coordinates of the mesh, selected in the field in bottom node.
Normal
Surface Normal; On a flat plane with one light above and to the right reflecting off the surface.
Vertex Color
Allows for output value of group vertex colors, selected in the field in bottom node.
Vertex Alpha
Allows for output alpha value of vertex.
Front/Back
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Allows for output to take into account front or back of surface is light relative the camera.
Note
These are exactly the same settings as in the Mapping panel for Textures, though a few settings - like Stress or
Tangent - are missing here. Normally you would use this node as input for a Texture Node.

Geometry Node Example using a UV image

Setup to render an UV-Mapped Image Texture.

E.g.: To render an UV-mapped image, you would use the UV output and plug it into the Vector Input of a
texture node. Then you plug the color output of the texture node into the color input of the material node which corresponds to the setting on the Map To panel.

Output Node
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Output material node

At any point, you may want to see the work in progress, especially right after some operation by a node. Simply
create another thread from the output socket of the node to the picture input socket of an Output node to see a
mini-picture.
Connect the alpha channel to set/see transparency.
Note
Effective Output Node
The only Output node that is used for the Material in the end (i.e the only non-Preview) has a little red sphere
on the upper right.

Vector Nodes
Vector nodes manipulate information about how light interacts with the material, multiplying vector sets, and
other wonderful things which can become quite advanced. Even if you don’t have experience with vector
maths, you’ll find these nodes to be very useful.
Vectors, in general, are two or three element values, for example, surface normals are vectors. Vectors are also
important for calculating shading.

Normal Node

Normal node

The Normal node generates a normal vector and a dot product. Click and Drag on the sphere to set the direction
of the normal.
This node can be used to input a new normal vector into the mix. For example, use this node as an input to a
Color Mix node. Use an Image input as the other input to the Mixer. The resulting colorized output can be
easily varied by moving the light source (click and dragging the sphere).
The (face) normal is the direction of the face in relation to the camera. You can use it to do the following:
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• Use this node to create a fixed direction –> output Normal.
• Calcuate the Dot -Product with the Normal -Input. The Dot -Product is a scalar value (a number).
• If two normals are pointing in the same direction the Dot -Product is 1.
• If they are perpendicular the Dot -Product is zero (0).
• If they are antiparallel (facing directly away from each other) the Dot -Product is -1. And you
never thought you would use the Vector Calculus class you took in college - shame on you!
So now we can do all sorts of things that depends on the viewing angle (like electron scanning microscope
effect). And the best thing about it is that you can manipulate the direction interactively.
Note
One caveat
The normal is evaluated per face, not per pixel. So you need enough faces, or else you don’t get a smooth
result

Inputs
Normal
3D-direction of the face in relation to the camera. The value can be provided by another node or set
manually.

Outputs
Normal
Fixed 3D-direction, combined by the node.
Dot
Scalar value (a number), combined by the node.

Controls

Interactive Normal node preview

Interactive node preview
Allows click and drag on the sphere in node center to set the direction of the normal.
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Mapping Node

Mapping node

Essentially mapping node allows the user to modify a mapping of system of 3D-coordinates. Typically used for
modifying texture coordinates.
Mapping can be rotated and clamped if desired.

Inputs
Vector
The input vector (3D-direction in relation to the camera) of some the coordinates’ mapping. The value can
be provided by another node or set manually.

Outputs
Vector
The output vector, combined by the node.

Controls
The controls of the node have been ordered in X, Y, Z order. If you want to use the clamping options, try
enabling Min and Max.

Mapping Node Vector Types controls
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Vector type selector
Type of vector that the mapping transforms.
Texture
Transform a texture by inverse mapping the texture coordinates.
Point
Transform a point.
Vector
Transform a direction vector.
Normal
Transform a normal vector with unit length.

Mapping Node Transforms controls

Location
Transform position vector.
Rotation
Transform rotation vector.
Scale
Transform scale vector.

Mapping Node Clipping controls

Min
Minimum clipping value.
Max
Maximum clipping value.
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Vector Curves

Vector Curves node

The Vector Curves node maps an input vector X, Y, and Z components to a diagonal curve. Use this node to
remap a vector value using curve controls.
See also
• Read more about using the Curve Widget.

Inputs
Fac:
Factor. The degree of node’s influence in node tree. The value can be provided by another node or set
manually.
Vector
The input vector (3D-direction in relation to the camera). The value can be provided by another node or
set manually.

Outputs
Vector
The output vector, combined by the node.

Options
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Materials
Materials can be linked to objects and Object’s data in the materials panel, of the Shading/Material context.
Here is where you can manage how materials are linked to objects, meshes, etc. and activate a material for
editing in the rest of the panels.

Context

Material panel

At the top of the material menu a list of icons explains the context in which the material is being edited. In the
example above, the material Material is linked to the object Cube which is linked to the scene Scene.
By toggling the pin symbol on the left side on and off, Bforartists can be told to display only the selected
material or to follow context.

Material slots
With a material linked or created, one or several material slots can be created and further options become
available:
Plus sign
Add a new material slot or copy the one selected
Minus sign
Remove selected material slot
Down arrow
Copy and paste the selected material slot

Multiple materials
Meshes can handle having more than one material. Materials can be mapped on a per-face basis, as detailed on
the Multiple Materials page. In edit mode, the following tools appear:
Assign
Assign the material in the selected material slot to selected vertices
Select
Select vertices assigned to the selected material slot
Deselect
Deselect vertices assigned to the selected material slot
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Material naming and linking

Link material to object or to object’s data

Material’s name field
click into this field to rename your material
Number of users (number field)
The number of objects or object’s data that use the material. This material is linked between the various
objects, and will update across all of them when edited. Clicking this number will make a ‘single user
copy’, duplicating the material, with it linked only to the active object/object’s data.
F (Fake user)
Gives the material a ‘fake user’, to keep the material data-block saved in the .blend file, even if it has no
real users.
Plus sign
Add a new material.
X sign
Remove link to this material.
Nodes
Designates this material to be a material node noodle, and not from the Material/Ramps/Shaders settings.
Data-block links
The Link pop-up menu has two choices, Data and Object. These two menu choices determine whether the
material is linked to the object or to the data, (in this case, the mesh). The Data menu item determines that
this material will be linked to the mesh’s data-block which is linked to the object’s data-block. The Object
menu item determines that the material will be linked to the object’s data block directly.
This has consequences of course. For example, different objects may share the same mesh data-block.
Since this data-block defines the shape of the object any change in edit mode will be reflected on all of
those objects. Moreover, anything linked to that mesh data-block will be shared by every object that
shares that mesh. So, if the material is linked to the mesh, every object will share it.
On the other hand, if the material is linked directly to the object data-block, the objects can have different
materials and still share the same mesh.
Short explanation: If connected to the object, you can have several instances of the same obData using
different materials. If linked to mesh data, you can’t.

Material type
Material added in edit mode These toggles tell Bforartists where this material fits into the Render Pipeline, and
what aspects of the material are to be rendered.
Surface
Render object as a surface
Wire
Render the edges of faces as wires (not supported in ray tracing)
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Volume
Render object as a volume. See Volume Material
Halo
Render object as halo particles. See Halo Material

Material Properties Overview
The usage of each section of the material properties are detailed in the next section.

Surface and Wire materials
Surface material types are the most common materials. They represent objects with a defined surface.
Wire materials simply turn all of an object’s edges into rods, which then become renderable, but uses the same
shading options as surface materials.

Preview
This is a preview of the current material mapped on to one of several objects.
•
•
•
•
•
•

Flat Plane
Sphere
Cube
Monkey
Strands
Large Sphere with Sky

See Preview

Diffuse
Diffuse shading simulates light hitting a surface and bouncing off in a very wide angle. You can set the color of
the diffuse shading, and set what model is used for the diffuse calculation.
See Diffuse Shaders

Specular
Specularity simulates reflections of light sources, that are often sharp, bright spots. You can set the color of the
specular shading, and set what model is used for the specular calculation.
See Specular Shaders

Shading
Emit
Adds extra illumination, as if the material is glowing.
Ambient
Sets the global amibient light the material receives
Translucency
Amount of shading on the back side that shows through. Use to simulate thin objects, like leaves or paper.
Shadeless
This disables the calculation of any shading, so only color information is visible. This is essentially makes
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it a “surface shader”
Tangent Shading
Use the material’s tangent vector instead of the normal for shading - for anisotropic shading effects (e.g.
soft hair and brushed metal). This shading was introduced in 2.42, see also settings for strand rendering in
the menu further down and in the Particle System menu.
Cubic Interpolation
Use cubic interpolation for diffuse values, for smoother transitions between light areas and dark areas

Transparency
Set options for objects in which light can pass through
See Transparency

Mirror
Here you can set options for materials that are reflective
See Mirror

Subsurface Scattering
Subsurface scattering simulates semi translucent objects in which light enters, bounces around, then exits in a
different place. Examples are candles, human skin, cheese, etc.
See Subsurface Scattering

Strand
These settings are used when rendering the material on fur or hair
See Strands

Options
Traceable
Allows material to calculated raytracing, for reflections and refractions.
Full Oversampling
Forces material to render full shading and textures for all Anti-Aliasing Samples.
Sky
Renders material with no alpha, replacing the background with the sky
Use Mist
Uses Mist with this material.
Invert Z Depth
Renders materials faces with an inverted Z buffer.
Z Offset
If using Invert Z Depth, this is an artificial offset to z values.
Light Group
Limit material’s lighting calculation to a specific light group
Exclusive
Material uses light group exclusively
Face Textures
Replaces object’s base color with color from face assigned image textures.
Face Textures Alpha
Replaces object’s base alpha value with alpha from face assigned image textures.
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Vertex Color Paint
Replaces object’s base color with vertex colors.
Vertex Color Light
Adds vertex color as additional light.
Object Color
Modulate the result with a per object color.

Shadow
Receive
Allows the material to receive shadows cast by other objects
Receive Transparent
Allows material to receive transparent shadows cast by other transparent objects.
Cast Only
Causes objects with the material to only cast a shadow, and not appear in renders.
Casting Alpha
Sets the Alpha of shadow casting. Used for irregular and deep shadow buffering.
Shadows Only
Renders shadows as materials alpha value, making materials transparent, except for shadowed areas.
Shadow Only Type
Set the type of shadows used when Shadows Only is enabled
• Shadow and Distance
• Shadow Only
• Shadows and Shading
Cast Buffer Shadow
Allows material to cast shadows from buffer lamps.
Buffer Bias
Factor to multiply shadow buffer by.
Auto Ray Bias
Prevents raytraced shadow errors on surfaces with smooth normals
Ray Bias
Shadow raytracing bias value to prevent terminator artifacts on shadow boudary.
Cast Approximate
Allow material to cast shadows when using Approximate Ambient Occlusion}}

Volume Material
Volume materials represent volumes of tiny particles, like clouds or smoke. They are very different from
standard materials, but are detailed in the Volume Page.

Halo Material
Halo materials renders each of the objects points as glowing dots. This is a useful material for simulating
particle effects or lens flares. They are detailed on the Halo Page.

Special Material Effects
• Halo Rendering
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• Options
• Halo Texturing
• Examples
• Volume Rendering
• Options
• Wire Render

Halo Rendering

Activating helo rendering

Bforartists provides a set of materials which do not obey the face-shader paradigm and which are applied on a
per-vertex rather than on a per-face basis. These are called Halos because you can see them, but they do not
have any substance. They are like little clouds of light; although they are not really lights because they do not
cast light into the scene like a lamp.
Halos come in very handy when creating certain special effects, when making an object glow, or when creating
a viewable light or fog/atmospherics around an actual light.

Options
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Halo panels

To enable Halos, press the Halo button in the Material menu’s top panel.
As you will see in the 3D View, the mesh faces are no longer rendered. Instead just the vertex is rendered, since
that is where each halo will originate. Halos can be hard to find in a crowded scene, so name it well for easy
location in the outliner.
In the properties window, where we normally find the Diffuse, Specular, and Shading panels, we now see panels
relative to the Halo characteristics:

Halo Panel
Alpha
The transparency
Color Swatch
The color of the halo itself
Seed
If non-zero, randomizes the ring dimension and line location. To use, give any (integer) number to start
the random-number generator.
Size
Sets the dimension of the halo
Hardness
Sets the hardness of the halo. Similar to specular hardness

Effect of Add

Add
The Add slider determine how much the halo colors are ‘added to’, rather than mixed with, the colors of
the objects behind and together with other halos. By increasing Add, the Halo will appear to light up
objects that move behind it or through the Halo field.
Texture
Gives halo a texture. By default, textures are applied to objects with Object coordinates and reflects on
the halos by affecting their color, as a whole, on the basis of the color of the vertex originating the halo.
Enable this feature to have the texture take effect within the halo, and hence to have it with varying colors
or transparencies; this will map the whole texture to every halo. This technique proves very useful when
you want to create a realistic rain effect using particle systems, or similar.
Vertex Normal
Use the vertex normal to specify the dimension of the halo
Extreme Alpha
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Boosts alpha
Shaded
Lets halo receive light and shadows from external objects
When shaded is enabled, the Halo will be affected by local light; a lamp will make it brighter
and affect its diffuse color and intensity.
Soft
Softens the edges of the halos at intersections with other geometry
In addition, several other special effects are available. To enable some or all of these effects, set the number of
points/rings, or set the color of each effect individually:
Rings
Adds circular rings around to the halo.
Lines
Adds lines from the center of the halo.
Star tips
Gives the halo a star shape.
You can not use color ramps. Lines, Rings and an assortment of special effects are available with the relevant
toggle buttons, which include Flare, Rings, Lines, Star, Texture, Extreme Alpha, and Shaded. Halo Variations
shows the result of applying a halo material to a single vertex mesh.

Halo Variations

The halo size, hardness and alpha can be adjusted with the pertinent sliders. These are very similar to traditional
material settings
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The Add slider determine how much the halo colors are ‘added to’, rather than mixed with, the colors of the
objects behind and together with other halos. By increasing Add, the Halo will appear to light up objects that
move behind it or through the Halo field.
To set the number of rings, lines, and star points independently, once they are enabled with the relative Toggle
Button, use the Num Buttons Rings:, Lines: and Star:. Rings and lines are randomly placed and oriented, to
change their pattern you can change the Seed: Num Button which sets the random numbers generator seed.

Flare Panel
Enabling Flare Renders the halo as a lens flare
Size
Sets the factor by which the flare is larger than the halo
Boost
Give the flare extra strength.
Seed
Specifies an offset in the flare seed table
Subflares
Sets the number of subflares
Subsize
Sets the dimensions of the subflares, dots, and circles

Lens Flares
Our eyes have been trained to believe that an image is real if it shows artifacts that result from the mechanical
process of photography. Motion blur, Depth of Field, and lens flares are just three examples of these artifacts.
The first two are discussed in the chapter_rendering; the latter can be produced with special halos. A simulated
lens flare tells the viewer that the image was created with a camera, which makes the viewer think that it is
authentic.
We create lens flares in Bforartists from a mesh object using first the Halo button and then the Flare options in
the Shaders Panel of the material settings. Try turning on Rings and Lines, but keep the colors for these settings
fairly subtle. Play with the Flares: number and Fl. seed: settings until you arrive at something that is pleasing to
the eye. You might need to play with Boost: for a stronger effect (Lens Flare settings).
Note that this tool does not simulate the physics of photons traveling through a glass lens; it’s just a eye candy.
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Bforartists’s lens flare looks nice in motion, and disappears when another object occludes the flare mesh.

Lens Flare

Halo Texturing
By default, textures are applied to objects with Object coordinates and reflects on the halos by affecting their
color, as a whole, on the basis of the color of the vertex originating the halo. To have the texture take effect
within the halo, and hence to have it with varying colors or transparencies press the Texture button; this will
map the whole texture to every halo. This technique proves very useful when you want to create a realistic rain
effect using particle systems, or similar.
Another Option is Shaded. When shaded is enabled, the Halo will be affect by local light; a lamp will make it
brighter and affect its diffuse color and intensity.

Examples
Dotmatrix display
Let’s use a halo material to create a dotmatrix display.
• To begin, add a grid with the dimensions 32x16. Then add a camera and adjust your scene so that you
have a nice view of the billboard.
• Use a 2D image program to create some red text on a black background, using a simple and bold font (if
you are a lazy lizard [I hope this not offensive, I just like how it sounds!], you can just save the picture
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below on your hard drive...). Dot matrix image texture. shows an image 512 pixels wide by 64 pixels
high, with some black space at both sides.

Dot matrix image texture.

• Add a material for the billboard, and set it to the type Halo. Set the HaloSize to 0.06 and when you
render the scene you should see a grid of white spots.
• Add a Texture, then change to the Texture Buttons and make it an image texture. When you load your
picture and render again you should see some red tinted dots in the grid.
• Return to the Material Buttons and adjust the sizeX parameter to about 0.5 then render again; the text
should now be centered on the Billboard.
• To remove the white dots, adjust the material color to a dark red and render. You should now have only
red dots, but the billboard is still too dark. To fix this enter EditMode for the board and copy all vertices
using the Shift-D shortcut (take care not to move them!). Then adjust the brightness with the Add
value in the MaterialButtons.

Dot Matrix display.

You can now animate the texture to move over the billboard, using the ofsX value in the Texture panel of the
MaterialButtons. (You could use a higher resolution for the grid, but if you do you will have to adjust the size of
the halos by shrinking them, or they will overlap. (Dot Matrix display).
Note
Note about material indices
Halo materials only work when applied using the first material index. Any material(s) in a subsequent material
index will not be rendered.
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Volume Rendering

Activation volume rendering

Volume rendering is a method for rendering light as it passes through participating media, within a 3d region.
The implementation in Bforartists a physically based model, which represents the various interactions of light
in a volume relatively realistically.

Volume rendering

Rendering a volume is different then Solid Render. For volume light enters a 3D region of space (defined as the
volume) that may be filled with small particles, such as smoke, mist or clouds. The light bounces around off the
various molecules, being scattered or absorbed, until some light passes through the volume and reaches the
camera. In order for that volume to be visible, the renderer must figure out how much material the light has
passed through and how it has acted and reacted within that volume, the volume object needs to contain a 3D
region of space, for example a manifold closed mesh, such as a cube, not just a flat surface like a plane. To get
an image, the renderer has to step through that region, and see how much ‘stuff’ is there (density) in order to see
how light is absorbed or scattered or whatever. This can be a time consuming process since it has to check a lot
of points in space and evaluate the density at each.
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Options
Density

Constant density vs textured density

Many things can happen to the light as it passes through the volume, which will influence the final color that
arrives at the camera. These represent physical interactions that happen in the real world, and most of these are
dependent on the density of the volume, which can either be a constant density throughout, or varied, controlled
by a texture. It is by controlling the density that one can get the typical ‘volumetric’ effects such as clouds or
thick smoke.
Density
The base density of the material - other density from textures is added on top
Density Scale
A global multiplier to increase or decrease the apparent density. This can be useful for getting consistent
results across different scene scales.
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Shading

Spot lamp scattering in a constant volume

When light enters a volume from an external source, it doesn’t just pass straight through. Light gets scattered
off tiny particles in the volume, and some proportion of that light reaches the camera. This property makes it
possible to see light beams as they travel though a volume and are scattered towards the eye.

Shading options

Scattering
The amount of light that is scattered out of the volume. The more light that is scattered out of the volume,
the less it will penetrate through the rest of the volume. Raising this parameter can have the effect of
making the volume seem denser, as the light is scattered out quickly at the ‘surface’ of the volume,
leaving the areas internal to the volume darker, as the light doesn’t reach it.
Note in the examples below, the less light that is scattered out of the volume, the more easily it penetrates
throughout the volume and to the shadow.
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Scattering: 0.5

Scattering: 1.0

Scattering: 2.0

Scattering: 5.0

Asymmetry

Isotropic and Anisotropic scattering

The default method for scattering light in a volume is for the light to be deflected evenly in all directions known as Isotropic scattering. In real life different types of media can scatter light in different angular
directions, known as Anisotropic scattering. Back-scattering means that light is scattered more towards the
incoming light direction, and forward-scattering means it’s scattered along the same direction as the light is
traveling.
Asymmetry
Asymmetry controls the range between back-scattering (-1.0) and forward-scattering (1.0). The default
value of 0.0 gives Isotropic scattering (even in all directions).

Transmission
Transmission is a general term for light that is transmitted throughout a volume.
This transmitted light can be the result of various different interactions, for example:
• the left over result of incoming light after it has reflected/scattered out of the volume
• the left over result of light after being absorbed by the volume (and converted to heat)
Here, the transmission color is used to set the end result color that light becomes after it is transmitted through
the volume.
Transmission Color
The resultant color of light that is transmitted through the volume.
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Note in the examples below, as more light is scattered out of the volume, there is less available to be transmitted
through.

Transmission color: Yellow,

Transmission color: Yellow,

Transmission color: Yellow,

Transmission color: Yellow,

Scattering: 0.5

Scattering: 1.0

Scattering: 2.0

Scattering: 5.0

Emission
Some volumes can emit light where there was none before, via chemical or thermal processes, such as fire. This
light is generated from the volume itself and is independent of light coming from external sources.
Currently, this emitted light does not affect other volumes or surfaces (similar to surface material type, ‘Emit’
option).
Emission Color
The color of light that is emitted by the volume.
Emission
An intensity multiplier for the emitted color, for scaling up and down.

Emission 0.25, Scattering: 0.5 Emission 0.25, Scattering: 1.0 Emission 0.25, Scattering: 2.0 Emission 0.25, Scattering: 5.0

Reflection
The ‘reflection’ parameters can be used to tint or scale the light that’s scattered out of the volume. This only
affects light that has come from lamps and been scattered out, it doesn’t affect the color of transmitted or
emitted light and is.
These settings are not physically correct because they don’t conserve energy - the light scattering out doesn’t
affect the remaining light that is transmitted throughout the rest of the volume. For example, physically
speaking, if the orange components of the light are scattered out of the volume towards the camera, only the
inverse of that (blue) will remain to continue penetrating through the volume, causing the volume to take on a
multi-colored appearance, which can be difficult to use. To make it a bit easier to plainly set the color of the
volume, you can use the reflection parameters to quickly set an overall tint.
Reflection Color
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The color of light that is scattered out of the volume.
Reflection
An intensity multiplier for the reflection, for scaling up and down.

Hints
Ideally try to accomplish as much as you can with the other volume settings and lighting before using the
reflection controls. If you stick to what’s physically plausible, the material will act correctly, and be more
predictable and usable in a wider range of lighting scenarios. Of course you can always break the rules too!

Reflection: Green, Scattering: Reflection: Green, Scattering: Reflection: Green, Scattering: Reflection: Green, Scattering:
0.5

1.0

2.0

5.0

Reflection: Green,

Reflection: Green,

Reflection: Green,

Reflection: Green,

Transmission: Yellow,

Transmission: Yellow,

Transmission: Yellow,

Transmission: Yellow,

Scattering: 0.5

Scattering: 1.0

Scattering: 2.0

Scattering: 5.0

Lighting

Lighting options

Several shading modes are available, providing a range of options between fast to render and physically
accurate.
Lighting Mode
Shadeless
Shadeless is the simplest, useful for thin, wispy mist or steam.
Shadowed
Shadowed is similar, but with shadows of external objects.
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Shaded
Shaded uses a volumetric single-scattering method, for self-shading the volume as light penetrates
through.
Multiple Scattering
Allows multiple scatter calculations.
Shaded+Multiple Scattering
Combines Shaded and Multiple Scattering functionality.
Shaded Options:
External Shadows
Receive shadows from sources outside the volume (temporary).
Light Cache
Pre-calculate the shading information into a voxel grid, speeds up shading at slightly less accuracy.
Resolution
Resolution of the voxel grid, low resolutions are faster, high resolutions use more memory.
Multiple Scattering Options:
Diffusion
Diffusion factor, the strength of the blurring effect.
Spread
Proportional distance over which the light is diffused.
Intensity
Multiplier for multiple scattered light energy.
Transparency
The transparency settings are the same as Solid Render except you have less settings. For volume rendering you
only have:

• Mask
• Z Transparency
• Raytrace
Integration

Integration options

Step Calculation Method
Method of calculating the step through the volume.
Randomized
Randomized method of calculating the step.
Constant
Constant method of calculating the step.
Step Size
Distance between subsequent volume depth samples. Step Sizes determine how noisy the volume is.
Higher values result in lower render times and higher noise.
Depth Cutoff
Stop ray marching early if transmission drops below this luminance - higher values give speedups in
111

Bforartists Reference Manual - © Copyright - This page is under OCL license

dense volumes at the expense of accuracy.
Options

Material volume options

Traceable
Allow this material to calculate raytracing.
Full Oversample
Force this material to render full shading/textures for all anti-aliasing samples.
Use Mist
Use mist with this material (in world settings).
Light Group
Limit lighting of this material to lamps in this group.
Exclusive
Material uses this group exclusively. Lamps are excluded from other scene lighting.
Smoke and Fire

Create the Material
The material must be a volumetric material with a Density of 0, and a high Density Scale.
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The Material Settings

Smoke requires a complex material to render correctly. Select the big cube and go to the material tab. There
change the material to ‘Volume’ and set the density to 0. If you set the density to values bigger than 0 the
domain cube will be filled with the volume material. The other settings will affect the smoke, though. We’ll
cover those later.

Add the Texture
In addition, Smoke requires its own texture, you can use a volumetric texture known as Voxel Data. You must
remember to set the domain object and change the influence.

113

Bforartists Reference Manual - © Copyright - This page is under OCL license

114

Bforartists Reference Manual - © Copyright - This page is under OCL license
The texture settings.

Go to the texture tab and change the type to Voxel Data. Under the Voxel Data-Settings set the domain object to
our domain cube (it should be listed just as ‘Cube’ since we are using Bforartists’s default cube. Under
Influence check ‘Density’ and leave it at 1.000 (Emission should be automatically checked, too). Now you
should be able to render single frames. You can choose to color your smoke as well, by turning Emission Color
back on.

Finished Result

Tip
To see the smoke more clearly
Under the world tab, chose a very dark color for the horizon.

Extending the Smoke Simulator: Fire!
You can also turn your smoke into fire with another texture! To make fire, turn up the Emission Value in the
Materials panel.
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The Fire material.

Then, add another texture (Keep the old texture or the smoke won’t show). Give it a fiery color ramp- which
colors based on the alpha, and change the influence to emission and emission color. Change the blend to
Multiply.
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The fire texture settings.

The fire render.

Wire Render

Wire Render

The Wire Render option in the Materials section provides a way of showing a rendered image of the edges in an
object. Each edge is rendered as a single-pixel image of the edges which make up the mesh. The colors, alpha
and other relevant properties of the lines are selected with the same control panels as provided by the Surface
rendered image.
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Wire Render
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Introduction to Textures
In CGI, texture mapping is a method to add detail to surfaces by projecting images and patterns onto those
surfaces. The projected images and patterns can be set to affect not only color, but also specularity, reflection,
transparency, and even fake 3-dimensional depth. Most often, the images and patterns are projected during
render time, but texture mapping is also used to sculpt, paint and deform objects.
In Bforartists, Texture s can be:
•
•
•
•
•

applied to a Material
applied to a light, that coming from lamp
applied to the World Background
applied to a Brush, see for example: - Sculpting - Texture Paint
associated with Modifiers, see: - Particles textures - Ocean textures

Material Textures
The material settings that we’ve seen so far produce smooth, uniform objects, but such objects aren’t
particularly true to reality, where uniformity tends to be uncommon and out of place. In order to deal with this
unrealistic uniformity, Bforartists allows the user to apply textures which can modify the reflectivity,
specularity, roughness and other surface qualities of a material.

Textures Layer on base Material
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Textures are like additional layers on top of the base material. Textures affect one or more aspects of the
object’s net coloring. The net color you see is a sort of layering of effects, as shown in this example image. The
layers, if you will, are:
• Your object, lit with ambient light based on your world settings.
• Your base material, which colors the whole surface in a uniform color that reacts to light, giving
different shades of the diffuse, specular, and mirror colors based on the way light passes through and
into the surface of the object.
• A primary texture layer that overlays a purple marble coloring.
• A second cloud texture that makes the surface transparent in a misty/foggy sort of way by affecting the
Alpha value.
• These two textures are mixed with the base material to provide the net effect: a cube of purplish-brown
fog.

Some Metal Textures

This notion of using more than one texture, to achieve a combined effect, is one of the “hidden secrets” of
creating realistic-looking objects. If you carefully “look at the light” while examining any real-life object, you
will observe that the final appearance of that object is best described as the combination, in different ways and
in different amounts, of several distinct underlying visual characteristics. These characteristics might be more
(or less) strongly apparent at different angles, under different lighting conditions, and so forth. Bforartists
allows you to achieve this in many ways. You can use “a stack of texture layers” as described in this section, or
you can also use arbitrarily-complex networks (“noodles”...) of “texture nodes” as discussed here; the choice is
yours.
Materials Textures fall into three primary categories:
Procedural Textures
Textures generated by a mathematical formula. For example, Wood, Clouds, and Distorted Noise
Images or Movies
Photos and films projected onto objects. For example, a flat map of Earth mapped to a sphere.
Environment Maps
Textures used to create the impression of reflections and refractions. For example, an image of a street
reflected in a car window.
Data or Modifiers Textures
Textures obtained from raw data or obtained by a certain modifier in the scene. For example:
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• volumetric materials use Voxel Data textures, or Point Density textures
• textures can be obtained from an Ocean Modifier
CRL 02:25, 26 May 2014 (UTC)(Sign)

World Textures
Reference
Mode: All Modes
Panel: Shading/World Context –> Preview
Hotkey:

Description
The world buttons let you set up the shading of your scene in general. It can provide ambient color, and special
effects such as mist, but a very common use of a World is to shade a background color.

Textures Layer on base Material

HoR, HoG, HoB
The RGB color at the horizon
ZeR, ZeG, ZeB
The RGB color at the zenith (overhead)
These colors are interpreted differently, according to the Buttons in the Preview Panel (Background colors):
None Enabled
If none of these three buttons is checked, your background will just be plain flat color (using the horizon
one).
Blend
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The background color is blended from horizon to zenith. If only this button is pressed, the gradient runs
from the bottom to the top of the rendered image regardless of the camera orientation.
Real
If this option is added, the gradient produced has two transitions, from nadir (same color as zenith) to
horizon to zenith; the blending is also dependent on the camera orientation, which makes it more realistic.
The horizon color is exactly at the horizon (on the x-y plane), and the zenith color is used for points
vertically above and below the camera.
Paper
If this option is added, the gradient keeps its characteristics, but it is clipped in the image (it stays on a
horizontal plane (parallel to x-y plane): what ever the angle of the camera may be, the horizon is always
at the middle of the image).
CRL 02:31, 26 May 2014 (UTC)(Sign)

Brush Textures
Image textures can be loaded into Bforartists. These images can then be applied to a mesh model that has been
unwrapped and assigned an image of user defined size.

Applied Brush texture in different painting modes

• Brush textures can be used to Texture Paint textures.
• Brush textures can be used to Vertex Paint vertices.
• Brush textures can also be used in Sculpting to create topology.

Assigning a Texture
This page just shows how to add a texture to a slot. The textures’ commons options are explained here.
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Choosing the Texture context

Texture panel

In the Properties editor, choose the Texture context: this will show the Texture panel.

Choosing the Texture data type

Texture panel with buttons for Material, World, and Brush textures highlighted

The three buttons Material, World, Brush at the top of the texture panel indicate the texture data type, that is,
the kind of texture that is being edited.

Texture panel with button for Lamp textures highlighted
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Textures Slots

Texture panel

The list below these buttons represent the Stack of textures that we can manage. It can have up to eighteen
Texture Slots:
• Tick or untick a texture to enable/disable it.
• Use the three buttons on the right side to move individual textures up and down in the stack or to
copy/paste material’s settings between slots.

Creating a new Texture Data-Block in a new Texture Slot
Select an empty slot, then click on the New button.
This will do two things:
• it will create a new texture data-block
• also, it will add a new slot in the textures stack

Creating a new Texture Data-Block in a non-empty slot
Select a non-empty slot, then click on the Plus button.
This will do two things:
• it will create a new texture data-block, with a new name, making a copy of the texture data-block
assigned to the selected slot
• it will assign this new data-block to the selected slot

Sharing a Texture Data-Block in a non-empty slot
• Select a non-empty slot, then click on the Browse button. This will open a menu showing all the
available Texture data-blocks in this file.
• Choose a texture data-block in the menu to assign it to the selected slot. This will share the chosen
texture with more than one object, hence the Number of users shown in the texture data-block will
increase by one.
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Textures common options
In the Properties editor, choose the Texture context: this will show the Texture panel.

Textures Stack

Textures Stack

The list below these buttons represents the Stack of textures that we can manage. It can have up to eighteen
Texture Slots:
• Tick or untick a texture to enable/disable it.
• Use the three buttons on the right side to move individual textures up and down in the stack or to
copy/paste material’s settings between slots.
The order in the Stack Textures defines how textures overlay each other for finally result image.

Texture Data-Block

Active Texture Data-Block

Select a slot in the Textures Stack to see its settings.
The first group of buttons below the stack displays the texture currently selected in the stack.
Browse
The first button below the stack displays the all available textures in the current file. Textures are stored
globally, and can be linked to more than one material. If you have already created a texture that you want
to reuse, select from this list.
Name
A name field where the name of the material can be changed.
Number of users
If the active texture is used by another material, a 2 button appears that can be used to make a single-user
copy of the active texture. Use this button to quickly create a new texture based on an existing texture.
Fake
The F button assigns the active texture to a “Fake” material, so that the texture is saved with the file even
if it has no “real” users.
Add
Replaces the texture of the active slot with a new texture.
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Unlink
Removes the texture from the active slot.

Texture Type

Texture Types

Choose the type of texture that is used for the current texture data-block.
•
•
•
•
•

Procedural Textures
Image and Video Textures
Environment Map
Volume Textures
Ocean Texture

These types are described in detail in this section.
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Preview

Preview panel

The texture preview panel provides a quick pre-visualisation of how the texture looks on its own, without
mapping.
Texture, Material, or Both
Choose to display only the texture, only the material, or both.
Show Alpha
Show alpha in preview. If Alpha: Use is checked in the Image Sampling panel, the image’s alpha channel
is displayed. If Alpha: Use is unchecked, an alpha channel based on averaged rgb values is displayed like
it would be used by the Alpha slider in the Influence panel.

Colors

Colors panel

The Ramp button activates a color ramp which allows you to remap the colors of a texture to new ones. See
Ramps for information on using ramps.
The color of a texture can be modified with the Brightness, Contrast, and Saturation buttons. All textures with
RGB-Values - including Images and Environment Maps - may be modified with the RGB sliders.
R, G, B
Tint the color of a texture by brightening each red, green and blue channel.
Brightness
Change the overall brightness/intensity of the texture
Contrast
Change the contrast of the texture
Saturation
Change the saturation of the texture
11
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Mapping
Here you can control how the texture will be mapped on the object.
Note
Brushes
These options are not available for brushes because they wouldn’t make sense
See Mapping section for details.

Influence
Here you can control what properties the texture will affect, and by how much.
They are detailed on the Influence section.
Note
Brushes
These options are not available for brushes because they wouldn’t make sense

Texture types
These are the available texture types:
• Procedural Textures

12
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Textures generated by a mathematical formula.

• Image Textures
• Video Textures

Photos and films projected onto objects.

13
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• Combined Textures

Combined textures based on nodes.

• Volume Textures

14
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Textures that can be applied to volumetric data.

• Ocean Textures

Texture generated by an Ocean modifier.

Image Textures
15
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The term Image Texture simply means that a graphic image - a pixel grid composed of R, G, B, and sometimes
Alpha values - is used as the input source to the texture. As with other types of textures, this information can be
used in a number of ways, not only as a simple “decal”.
When the Texture Type Image or Movie is selected, three new panels present themselves allowing us to control
most aspects of how image textures are applied: Image, Image Sampling, and Image Mapping.

About Image Based Texturing
Texture images take up precious memory space, often being loaded into a special video memory bank that is
very fast and very expensive, so it is often very small. So, keep the images as small as possible. A 64x64 image
takes up only one fourth the memory of a 128x128 image.
For photo-realistic rendering of objects in animations, often larger image textures are used, because the object
might be zoomed in on in camera moves. In general, you want to use a texture sized proportionally to the
number of pixels that it will occupy in the final render. Ultimately, you only have a certain amount of physical
RAM to hold an image texture and the model and to provide work space when rendering your image.
For the most efficient memory usage, image textures should be square, with dimensions as powers of 2, such as
32x32, 64x64, 128x128, 256x256, 1024x1024, 2048x2048, and 4096x4096.
If you can re-use images across different meshes, this greatly reduces memory requirements. You can re-use
images if you map those areas of the meshes that “look alike” to a layout that uses the common image. In the
overview below, the left image is re-used for both the sphere and a portion of the monkey. The monkey uses
two layouts, one which has one UV map of a few faces, and another that has three maps.

How all the parts of UV Texturing work together

When using file textures, it is very important that you have Mapped the UVs of the mesh, and they are laid out
appropriately.
You don’t have to UV map the entire mesh. The sphere above on the left has some faces mapped, but other
faces use procedural materials and textures. Only use UV Textures for those portions of your mesh where you
want very graphic, precise detail. For example, a model of a vase only needs UV Texture for the rim where
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Bforartists Reference Manual - © Copyright - This page is under OCL license

decorative artwork is incorporated. A throw pillow does not need a different image for the back as the front; in
fact many throw pillows have a fabric (procedural material) back.
As another example, you should UV map both eyes of a head to the same image (unless you want one
bloodshot and the other clear). Mapping both sides of a face to the same image might not be advisable, because
the location of freckles and skin defects are not symmetrical. You could of course change the UV map for one
side of the face to slightly offset, but it might be noticeable. Ears are another example where images or section
of an images can be mapped to similar faces.

Workflow
The process consists of the following steps.
• Create the Mesh. Unwrap it into one or more UV Layouts.
• Create one or more Materials for the Mesh.
• Create one or more images for each UV Layout and aspect of the texture. Either - paint directly on the
mesh using Texture Paint in the 3D window, - load and/or edit an image in the UV Editor window, or Bake the existing materials into an image for the UV Editor window.
• Apply those images as UV Textures to the mesh to affect one or more aspects of the mesh. This is done
by using one or more of the numerous Map To options. For example, - map to Color to affect the diffuse
coloring of the mesh, - map to Nor to affect the normal direction to give the surface a bumpy or creased
look, or - map to Spec (specularity) to make certain areas look shiny and oily.
• Layer the Textures to create a convincing result.

Using Images and Materials
To use an image as the color and alpha (transparency) of the texture, you can create an image in an external
paint program and tell the UV/Image Editor to Open that file as the texture, or you can create a New image and
save it as the texture.
If you want to start off by creating an image using an external paint program, you will want to save an outline
of your UV faces by using the Save UV Face Layout tool located in the UVs menu. This is discussed here.

Creating an Image Texture
To create an image within Bforartists, you have to first create a New Blank Image with a uniform color or test
grid. After that, you can color the image using the:
• Vertex colors as the basis for an image
• Render Bake image based on how the mesh looks in the scene
After you have created your image, you can modify it using Bforartists’s built-in Texture Paint or any external
image painting program.
Note
See Texture in 3D View but does not Render
You may be able to see the texture in Textured display mode in the 3D View; this is all that is required to have
textures show up in Bforartists’s Game Engine. Rendering, however, requires a material. You must have a
Face Textures material assigned to the mesh for it to render using the UV Texture. In the Material settings,
17
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ADD NEW material to a selected object and enable Face Textures.

Examples
There may be one UV Layout for the face of a character, and another for their clothes. Now, to texture the
clothes, you need to create an image at least for the Color of the clothes, and possible a “bump” texture to give
the fabric the appearance of some weave by creating a different image for the Normal of the clothes. Where the
fabric is worn, for example at the elbows and knees, the sheen, or Specularity, of the fabric will vary and you
will want a different image that tells Bforartists how to vary the Specularity. Where the fabric is folded over or
creased, you want another image that maps Displacement to the mesh to physically deform the mesh. Each of
these are examples of applying an image as a texture to the mesh.
As another example, the face is the subject of many questions and tutorials. In general, you will want to create a
Material that has the basic skin color, appropriate shaders, and sub-surface scattering. Then you will want to
layer on additional UV Textures for:
•
•
•
•
•
•
•
•

Freckle map for Color and Normal aspects
Subdermal veins and tendons for Displacement
Creases and Wrinkles and skin cell stratification for Normal
Makeup images for Color
Oily maps for Specularity
For a zombie, Alpha transparency where the flesh has rotted away (ewwww....)
Under chin and inside nostrils that receive less Ambient light
Thin skin is more translucent, so a map is needed for that

Each image is mapped by using another Texture Channel. Each of these maps are images which are applied to
the different aspects (Color, Normal, Specularity) of the image. Tileable images can be repeated to give a
smaller, denser pattern by using the Texture controls for repeat or size.

Layering UV Textures

Base UV Texture
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Layered UV Texture

Great textures are formed by layering images on top of one another. You start with a base layer, which is the
base paint. Each successive layer on top of that is somewhat transparent to let the bottom layers show through,
but opaque where you want to add on to details.
To avoid massive confusion, all image textures for a mesh usually use the same UV map. If you do, each image
will line up with the one below it, and they will layer on top of one another like the examples shown to the
right. To do this, just create one UV Texture (map) as described in this section. Then, create material image
textures as described in the procedural materials section. Instead of mapping to Original Coordinates (OrCo),
map to UV.
Use that map name repeatedly in the Material–>Textures–>Map Input panel by selecting UV and typing the
name in the text field. In the example to the right, our UV Texture is called “Head” (you may have to expand
the image to see the panel settings). Then, the image texture shown will be mapped using the UV coordinates.
In the “Base UV Texture” example to the right, the face has two textures UV mapped; one for a base color, and
another for spots, blemishes and makeup.
Both textures use the same UV Texture map as their Map Input, and both affect Color. The Makeup texture is
transparent except where there is color, so that the base color texture shows through. Note that the colors were
too strong on the image, so they amount of Col affects is turned down to 60% in the second layer (the blemish
layer).
Normally, we think of image textures affecting the color of a mesh. Realism and photo-realistic rendering is a
combination of many different ways that light interacts with the surface of the mesh. The image texture can be
Mapped To not only color, but also Normal (bumpiness) or Reflection or any of the other attributes specified in
the Map To panel.
If you paint a grey-scale image (laid out according to the UV Layout) with white where the skin is oily and
shiny, and dark where it is not, you would map that input image according to the UV Layout, but have it affect
Specularity (not color).
To make portions of a mesh transparent and thus reveal another mesh surface underneath, you would paint a
grey-scale image with black where you want the texture transparent, map input to UV, and map it to Alpha (not
color). To make portions of a mesh, like a piece of hot metal, appear to glow, you would use a grey-scale image
mapped to Emit.
Believe it or not, this is only “the tip of the iceberg!” If everything that’s been described here just isn’t enough
for you, the texture nodes feature, introduced in recent versions of Bforartists, enables you to layer and combine
textures in almost any way you can imagine.
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Mix and Match Materials

You can mix and match procedural materials and textures, vertex paint, and UV textures onto the same mesh.
The image to the right has a world with a red ambient light. The material has both VCol Paint and Face
Textures enabled, and receives half of ambient light. A weak cloud texture affects color, mixing in a tan color.
The right vertices are vertex painted yellow and the left is unpainted procedural gray. The UV Texture is a stock
arrow image from the public domain texture CD. Scene lighting is a white light off to the right. From this
information and the User Manual thus far, you should now be able to recreate this image.
You can also assign multiple materials to the mesh based on which faces you want to be procedural and which
you want to be texture-mapped. Just don’t UV map the faces you want to be procedural.
You can use UV Textures and VertexPaint (V in the 3D View window) simultaneously, if both are enabled in the
Material settings. The vertex colors are used to modulate the brightness or color of the UV image texture:
•
•
•
•
•

UV Texture is at the base (Face Textures)
Vertex paint affects its colors, then
Procedural textures are laid on top of that,
Area lights shine on the surface, casting shadows and what not, and finally
Ambient light lights it up.

Vertex colors modulate texture.

A UV Layout can only have one image, although you can tile and animate the image. Since a layout is a bunch
of arranged UV Maps, and a UV Map maps many mesh faces, a face can therefore only have one UV Texture
image, and the UV coordinates for that face must fit entirely on the image. If you want a face to have multiple
20
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images, split the face into parts, and assign each part its own image. (Or you can get fancy with Nodes, but
that’s another story ...)

Using Alpha Transparency

Alpha UV Textures

Alpha 0.0 (transparent) areas of a UV Image render as black. Unlike a procedural texture, they do not make the
base material transparent, since UV Textures do not operate on the base procedural material. The UV texture
overrides any procedural color underneath. Procedural Textures are applied on top of UV Textures, so a
procedural image texture would override any UV Texture. Transparent (black) areas of a procedural texture
mapped to alpha operate on top of anything else, making the object transparent in those places. The only thing
that modulates visible parts of a UV Texture are the Vertex Colors. In the example to the right, the finger image
is transparent at the cuff and top of the finger and is used as a UV Texture. All three balls have a base material
of blue and a marbling texture. The base material color is not used whenever Face Textures is enabled.
The top left ball has not had any vertex painting, and the finger is mapped to the middle band, and the texture is
mapped to a pink color. As you can see, the base material has VCol Paint and Face Textures enabled; the base
color blue is not used, but the texture is. With no vertex painting, there is nothing to modulate the UV Texture
colors, so the finger shows as white. Transparent areas of the UV Image show as black.
The top right ball has had a pink vertex color applied to the vertical band of faces (in the 3D View window,
select the faces in UV Paint mode, switch to Vertex Paint mode, pick a pink color, and Paint–>Set Vertex
Colors). The finger is mapped to the middle vertical band of faces, and VCol and Face Textures are enabled.
The texture is mapped to Alpha black and multiplies the base material alpha value which is 1.0. Thus, white
areas of the texture are 1.0, and 1.0 times 1.0 is 1.0 (last time I checked, at least), so that area is opaque
and shows. Black areas of the procedural texture, 0.0, multiply the base material to be transparent. As you can
see, the unmapped faces (left and right sides of the ball) show the vertex paint (none, which is gray) and the
painted ones show pink, and the middle stripe that is both painted and mapped change the white UV Texture
areas to pink. Where the procedural texture says to make the object transparent, the green background shows
through. Transparent areas of the UV Texture insist on rendering black.
The bottom ball uses multiple materials. Most of the ball (all faces except the middle band) is a base material
that does not have Face Textures (nor Vertex Color Paint - VCol Paint) enabled. Without it enabled, the base
blue material color shows and the pink color texture is mixed on top. The middle band is assigned a new
material (2 Mat 2) that does have vertex paint and Face Textures enabled. The middle band of faces were vertex
painted yellow, so the white parts of the finger are yellow. Where the pink texture runs over the UV texture, the
mixed color changes to green, since pink and yellow make a green.
If you want the two images to show through one another, and mix together, you need to use Alpha. The base
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material can have an image texture with an Alpha setting, allowing the underlying UV Texture to show through.
To overlay multiple UV images, you have several options:
• Create multiple UV Textures which map the same, and then use different images (with Alpha) and
Bforartists will overlay them automatically.
• Use the Composite Nodes to combine the two images via the AlphaOver node, creating and saving the
composite image. Open that composited image as the UV Texture.
• Use an external paint program to alpha overlay the images and save the file, and load it as the face’s UV
Texture
• Define two objects, one just inside the other. The inner object would have the base image, and the outer
image the overlaid image with a material alpha less than one (1.0).
• Use the Material nodes to combine the two images via the AlphaOver or Mix node, thus creating a third
noded material that you use as the material for the face. Using this approach, you will not have to UV
map; simply assign the material to the face using the Multiple Materials

UV Textures vs. Procedural Textures
A Material Texture, that has a Map Input of UV, and is an image texture that is mapped to Color, is equivalent
to a UV Texture. It provides much more flexibility, because it can be sized and offset, and the degree to which it
affects the color of your object can be controlled in the Map To panel. In addition, you can have different
images for each texture channel; one for color, one for alpha, one for normals, one for specularity, one for
reflectivity, etc. Procedural textures, like Clouds, are INCREDIBLY simple and useful for adding realism and
details to an image.
UV Texture
Image maps to precise coordinates on the selected
faces of the mesh
The Image maps once to a range of mesh faces
specifically selected
Image is mapped once to faces.

Procedural Texture
Pattern is generated dynamically, and is mapped to the
entire mesh (or portion covered by that material)
Maps once to all the faces to which that material is
assigned; either the whole mesh or a portion
Size XYZ in the MapInput allows tiling the texture
many times across faces. Number of times depends on
size of mesh
Affect the color and the alpha of the object.
Can also affect normals (bumpiness), reflectivity, emit,
displacement, and a dozen other aspects of the mesh’s
appearance; can even warp or stencil subsequent
textures.
Can have many for a mesh
Can be layered, up to 10 textures can be applied,
layering on one another. Many mix methods for mixing
multiple channels together.
Any Image type (still, video, rendered). Preset test grid Many different presents: clouds, wood grain, marble,
available
noise, and even magic.
Provides the UV layout for animated textures
Noise is the only animated procedural texture
Takes very limited graphics memory
Uses no or little memory; instead uses CPU compute
power
So, in a sense, a single UV texture for a mesh is simpler but more limited than using multiple textures (mapped
to UV coordinates), because they do one specific thing very well: adding image details to a range of faces of a
mesh. They work together if the procedural texture maps to the UV coordinates specified in your layout. As
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discussed earlier, you can map multiple UV textures to different images using the UV Coordinate mapping
system in the Map Input panel.

Settings
Image Settings

Image panel

In the Image Sampling panel we tell Bforartists which source file to use.
Image or Movie Data-block:
Browse
Select an image or video among linked to the .blend file
Name field
Internal name of image
F
Create a fake user for the image texture
+
Replace active texture with a new one
Folder
Browse for an image on your computer
X
Unlink this image or movie.
Source:
Where the image come from. What kind of source file to use.
Generated
Generated image in Bforartists.
Movie
Movie file.
Image Sequence
Multiple image files as a sequence.
Single Image
Single image file.
File for Image or Movie texture:
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See about supported Image formats.
Pack image
Embed image into current .blend file
Path
Path to file
File Browser
Find a file on your computer. Hold Shift to open the selected file and Ctrl to browse a
containing directory.
Reload
Reloads the file. Useful when an image has been rework in an external application.
Input Color Space
Color space of the image or movie on disk
XYZ
XYZ space.
VD16
The simple video conversion from a gamma 2.2 sRGB space.
sRGB
Standart RGB display space.
Raw
Raw space.
Non-Color
Color space used for images which contains non-color data (i.e. normal maps).
Linear ACES
ACES linear space.
Linear
709 (full range). Bforartists native linear space.
View as Render
Apply render part of display transformation when displaying this image on the screen.
Use Alpha
Use the alpha channel information from the image or make image fully opaque
Straight
Transparent RGB and alpha pixels are unmodified.
Premultiplied
Transparent RGB pixels of an image are multiplied by the image’s alpha value.
Fields
Work with field images. Video frames consist of two different images (fields) that are merged. This option
ensures that when Fields are rendered, the correct field of the image is used in the correct field of the
rendering. MIP Mapping cannot be combined with Fields.
Upper First
Order of video fields - upper field first.
Lower First
Order of video fields - lower field first.

24

Bforartists Reference Manual - © Copyright - This page is under OCL license

Image panel for Generated source of Image texture

For Generated source there are the specific options: X and Y size
Width and height of image to be generated.
Generated Image Type
Which kind of image to be generated
Blank
Generate a blank image.
UV Grid
Generated grid to test UV mappings.
Color Grid
Generated improved UV grid to test UV mappings.
Float Buffer
Generate floating point buffer.
About specific options for movie and image sequence source. see here

Image Sampling
In the Image Sampling panel we can control how the information is retrieved from the image.

Background image
Foreground image
The two images presented here are used to demonstrate the different image options. The background image is
an ordinary JPG-file, the foreground image is a PNG-file with various alpha and greyscale values. The vertical
bar on the right side of the foreground image is an Alpha blend, the horizontal bar has 50% alpha.

Foreground image with Use alpha. The alpha values of Foreground image with Calculate alpha
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the pixels are evaluated
Alpha
Options related to transparency
Use
Works with PNG and TGA files since they can save transparency information (Foreground Image
with UseAlpha). Where the alpha value in the image is less than 1.0, the object will be partially
transparent and stuff behind it will show.
Calculate
Calculate an alpha based on the RGB values of the Image. Black (0,0,0) is transparent, white (1,1,1)
opaque. Enable this option if the image texture is a mask. Note that mask images can use shades of
gray that translate to semi-transparency, like ghosts, flames, and smoke/fog.
Invert
Reverses the alpha value. Use this option if the mask image has white where you want it transparent
and vice-versa.
Flip X/Y Axis
Rotates the image 90 degrees counterclockwise when rendered.

Image Sampling panel

Normal Map
This tells Bforartists that the image is to be used to create the illusion of a bumpy surface, with each of
the three RGB channels controlling how to fake a shadow from a surface irregularity. Needs specially
prepared input pictures. See Bump and Normal Maps.
Normal Map Space:
Tangent: Object: World: Camera:
Derivative Map
Use red and green as derivative values.
MIP Map
MIP Maps are pre-calculated, smaller, filtered Textures for a certain size. A series of pictures is generated,
each half the size of the former one. This optimizes the filtering process. By default, this option is enabled
and speeds up rendering (especially useful in the game engine). When this option is OFF, you generally
get a sharper image, but this can significantly increase calculation time if the filter dimension (see below)
becomes large. Without MIP Maps you may get varying pictures from slightly different camera angles,
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when the Textures become very small. This would be noticeable in an animation.
MIP Map Gaussian filter
Used in conjunction with MIP Map, it enables the MIP Map to be made smaller based on color
similarities. In the game engine, you want your textures, especially your MIP Map textures, to be as
small as possible to increase rendering speed and frame rate.
Enlarged Image texture without and with Interpolation

Interpolation
This option interpolates the pixels of an image. This becomes visible when you enlarge the picture. By
default, this option is on. Turn this option OFF to keep the individual pixels visible and if they are
correctly anti-aliased. This last feature is useful for regular patterns, such as lines and tiles; they remain
‘sharp’ even when enlarged considerably. When you enlarge this 10x10 pixel Image

the difference with and without Interpolation is clearly visible. Turn this image off if you are using digital
photos to preserve crispness.
Filter
The filter size used in rendering, and also by the options MipMap and Interpolation. If you notice gray
lines or outlines around the textured object, particularly where the image is transparent, turn this value
down from 1.0 to 0.1 or so.
Texture Filter Type
Texture filter to use for image sampling. Just like a pixel represents a pic ture el ement, a texel
represents a tex ture el ement. When a texture (2D texture space) is mapped onto a 3D model (3D
model space), different algorithms can be used to compute a value for each pixel based on
samplings from several texels.
Box
A fast and simple nearest-neighbor interpolation known as Monte Carlo integration
EWA (Elliptical Weighted Average)
One of the most efficient direct convolution algorithms developed by Paul Heckbert and Ned
Greene in the 1980s. For each texel, EWA samples, weights, and accumulates texels within an
elliptical footprint and then divides the result by the sum of the weights.
Eccentricity
Maximum Eccentricity. Higher values give less blur at distant/oblique angles, but is
slower
FELINE (Fast Elliptical Lines)
Uses several isotropic probes at several points along a line in texture space to produce an
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anisotropic filter to reduce aliasing artifacts without considerably increasing rendering time.
Probes
Number of probes to use. An integer between 1 and 256. Further reading: McCormack,
J; Farkas, KI; Perry, R; Jouppi, NP (1999) Simple and Table Feline: Fast Elliptical Lines
for Anisotropic Texture Mapping, WRL
Area
Area filter to use for image sampling
Eccentricity
Maximum Eccentricity. Higher values give less blur at distant/oblique angles, but is
slower
Filter Size
The filter size used by MIP Map and Interpolation
Minimum Filter Size
Use Filter Size as a minimal filter value in pixels

Image Mapping

Image Mapping panel

In the Image Mapping panel, we can control how the image is mapped or projected onto the 3D model.
Extension:
Extend
Outside the image the colors of the edges are extended
Clip
Clip to image size and set exterior pixels as transparent. Outside the image, an alpha value of
0.0 is returned. This allows you to ‘paste’ a small logo on a large object.
Clip Cube
Clips to cubic-shaped area around the images and sets exterior pixels as transparent. The same
as Clip, but now the ‘Z’ coordinate is calculated as well. An alpha value of 0.0 is returned
outside a cube-shaped area around the image.
Repeat
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The image is repeated horizontally and vertically
Repeat
X/Y repetition multiplier
Mirror
Mirror on X/Y axes. This buttons allow you to map the texture as a mirror, or automatic
flip of the image, in the corresponding X and/or Y direction.
Checker
Checkerboards quickly made. You can use the option size on the Mapping panel as well to
create the desired number of checkers.
Even / Odd
Set even/odd tiles
Distance
Governs the distance between the checkers in parts of the texture size
Crop Minimum / Crop Maximum
The offset and the size of the texture in relation to the texture space. Pixels outside this space are ignored.
Use these to crop, or choose a portion of a larger image to use as the texture.

Video Textures

Video texture

Video textures are a some kind of Image textures and based on movie file or sequence of successive numbered
separate images. They are added in the same way that image textures are.
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Options
Image

Image panel for video texture

Source
For video texture the kind of source file to use is
Movie
See about supported Movie formats.
Image Sequence
See about supported Image formats. To load image sequence in any of the supported image file
formats first click on the first frame and then Accept. Then change the Source to Image Sequence,
and enter the ending frame number of this sequence.
More about loading source file for video texture see here.
Fields
Work with field images. Video frames consist of two different images (fields) that are merged. This option
ensures that when Fields are rendered, the correct field of the image is used in the correct field of the
rendering.
Upper First
Order of video fields - upper field first.
Lower First
Order of video fields - lower field first.
Fields
Number of fields per rendered frame. Used with Fields and interlaced video, it says whether each
image has both odd and even, or just one.
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Frames
Number of frames/images in the movie or sequence to use
Start
Global starting frame of the sequence/movie
Offset
Offset the number of the frame to use in the animation. What frame number inside the movie/sequence to
start grabbing.
Match Movie Length
This button set image’s user’s length to the one of selected movie/sequence.
Auto Refresh
Automatically refresh images on frame changes
Cyclic
When the video ends, it will loop around the to the start and begin playing again.
For Movie source:
Use Alpha
Use the alpha channel information from the image or make image fully opaque
Straight
Transparent RGB and alpha pixels are unmodified.
Premultiplied
Transparent RGB pixels of an image are multiplied by the image’s alpha value.
See also
For sampling and mapping documentation see Image Texture

Texture Nodes
As an alternative to using the Texture Stack, Bforartists includes a node-based texture generation system which
enables you to create textures by combining colors, patterns and other textures in much the same way that you
combine Material Nodes.
You can use these textures wherever you can use regular textures: you can place them in texture channels, in
material nodes, in particle systems, and even inside other textures.
Note
Node-based textures do not work for realtime display, they will only be visible in rendered images.

Using Texture Nodes
To use texture nodes with the current texture, open a Node Editor window, set it to Texture mode by clicking the
“Texture” icon (
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Texture

) in its header.
To start adding nodes, you first need to select a material. Now you can either click the New button in the Node
editor, or the New button in the texture panel. Once you have a texture selected, you can toggle it to function as
a regular texture or a node texture by clicking the Use Nodes option in the Node Editor.
The default node setup will appear: a red-and-white checkerboard node connected to an Output named
Default. For texture nodes, you can create as many Outputs as you like in your node setup. (Other types of
node networks, as you may recall, are limited to only one Output node.) See the next section for details.
For instructions on how to add, remove and manipulate the nodes in the tree, see the Node Editor manual.

Using Multiple Outputs
Each texture that you define with Texture Nodes can have several outputs, which you can then use for different
things. For example, you might want your texture to define both a diffuse (color) map and a normal map. To do
this, you would:
• Create two texture slots in the texture list, and set them to the same texture data-block.
• Add two Output nodes to the node tree, and type new names into their Name text-boxes: e.g. Diffuse
for one and Normal ” for the other.
• Underneath the texture picker in the texture panel, you’ll see a dropdown list with the names of your
outputs. For each entry in the texture list, select the desired output by changing the menu entry e.g. set
on to Diffuse and the other to Normal).
You can also use these named outputs if you’ve decided to define your material using Material Nodes. In this
case, you probably won’t be using Texture Channels. Instead, you’ll insert Texture nodes into your Material
Node tree using Add –> Input –> Texture. Then, inside the texture node that you’ve just added, you can select
which output you want to use (e.g. Diffuse or Normal).

Input Nodes
Input nodes provide input data for other nodes.
Time
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Time node

The time node uses a frame range to output a value between 0 and 1. By default the node output a linear
transition from 0 to 1 from frame 1 to 250. The shape of the curve can be manipulated to vary the output over
time in different ways.
Plus:Zoom in. Minus:Zoom out Tools:
Reset View
Resets curve view
Vector Handle
Breaks tangent at curve handle, making a angle.
Auto Handle
Default smooth interpolation of curve segments
Extend Horizontal
Causes the curve to stay horizontal before the first point and after the last point.

Extend Horizontal

Extend Extrapolated
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Causes the curve to extrapolate before the first point and after the last point, based on the shape of the
curve.

Extend Extrapolate

Reset Curve
Resets shape of curve to original linear shape.
Clipping Options:
Use Clipping
Forces curve points to stay between specified values.
Min X/Y and Max X/Y
Set the minimum and maximum bounds of the curve points.
X:Delete curve points. The first and last points cannot be deleted. X and Y The coordinates of the selected edit
point. Sta:Specify the start frame to use. End:Specify the end frame to use.

Coordinates

Coordinates node

The Coordinates node outputs the geometry local coordinates, relative to its bounding box as RGB colors:
• Red channel corresponds to X value.
• Green channel corresponds to Y value.
• Green channel corresponds to Z value.
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Texture Node

Texture node

The texture node can be used to load a another node based or non-node based texture.
Color 1 and Color 2
These can be used to remap a greyscale texture using two colors.

Image Node

Image node

The image node can be used to load an external image.
Browse for image
Select an image that already exists in the scene.
Data-block name
Set the name of the image data-block.
F
Save this image data-block, even if it has no users.
Open image
Select image to use from file browser.
Unlink data-block
Remove the image data-block from the node.

Output Nodes
These node serves a outputs for node textures
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Output
This node contains the result of the node texture. Multiple output nodes can exist in a node texture, however
only one of them is active. The active one is set in the Texture Panel in the Output drop down.
Color
The color data that the texture renders
Normal
The normal map that the texture will output.

Viewer
The viewer node can be used to preview the results of a node.

Texture Color Nodes
Mix

mix node

This node mixes a base color or image (threaded to the top socket) together with a second color or image
(bottom socket) by working on the individual and corresponding pixels in the two images or surfaces. The way
the output image is produced is selected in the drop-down menu. The size (output resolution) of the image
produced by the mix node is the size of the base image. The alpha and Z channels (for compositing nodes) are
mixed as well.
See also
Color Blend Modes for details on each blending mode.
Note
Color Channels
There are two ways to express the channels that are combined to result in a color: RGB or HSV. RGB stands
for the Red,Green,Blue pixel format, and HSV stands for Hue,Saturation,Value pixel format.
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Clamp
Clamps the result of the mix operation between 0 and 1. Some of the mix types can produce reults above
1 even if the inputs are both between 0 and 1, such as Add.
Factor
The amount of mixing of the bottom socket is selected by the Factor input field (Fac:). A factor of zero
does not use the bottom socket, whereas a value of 1.0 makes full use. In Mix mode, 0.5 is an even mix
between the two, but in Add mode, 0.5 means that only half of the second socket’s influence will be
applied.

RGB Curves

RGB Curves node

For each color component channel (RGB) or the composite (C), this node allows you to define a bezier curve
that varies the input (x-axis) to produce an output value (y-axis). Clicking on one of the C R G B components
displays the curve for that channel.
See also
• Read more about using the Curve Widget.
• RGB Curves node in the compositor (includes examples)

Invert
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invert node

This node simply inverts the input values and colors.

Hue Saturation Value

Hue Saturation Value node

Use this node to adjust the Hue, Saturation, and Value of an input.

Combine and Separate RGB

Combine RGB node

These two nodes allow you to convert between float values and color values. Colors are composed of 3 or 4
channels; red, green, blue, and sometimes alpha.
With Combine RGB, you can specify the values of each channel, and the node will combine them into a color
value.

Separate RGB node

With Separate RGB, you can specify a color value, and get each channel value out of it.
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Pattern Nodes
Checker

Checker node

The checker node creates a checkerboard pattern
color 1/color 2
Sets the color of the squares
Size
The scale of the checker pattern

39

Bforartists Reference Manual - © Copyright - This page is under OCL license

Bricks

Bricks node

The Bricks node creates a brick like pattern
Offset
The relative offset of the next row of bricks
Frequency
Offset every N rows. The brick pattern offset repeats every N rows.
Squash
Scales the bricks in every N rows by this amount.
Frequency
Squash every N rows.
Bricks 1, Bricks 2
Sets the color range of the bricks. Brick colors are chosen randomly between these two colors.
Mortar
Sets the mortar color, in between the bricks.
Thickness
Sets the thickness of the mortar
Bias
The bias of randomly chosen colors, between -1 and 1. -1 Makes all bricks Color 1, and a value of 1
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makes them all Color 2.
Brick Width
Sets the horizontal size of all the bricks.
Row Height
Sets the verticalsize of all the bricks.

Texture Nodes
These nodes generat procedural textures, and function just like their non node based counterparts.

Common Options
Color 1/Color 2
Remaps the procedural texture with these colors. These do not function in the Magic node.

Voronoi

Voronoi node

See Here
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Blend

Blend node

See Here

Magic

Magic node

See Here
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Marble

Marble node

See Here
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Clouds

Clouds node

See Here
Wood
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Wood node

See Here
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Musgrave

Musgrave

See Here

Noise

Noise

See Here
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Stucci

Stucci

See Here

Distorted Noise
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Distorted Noise node

See Here

Texture Convertor Nodes
As the name implies, these nodes convert the colors in the material in some way.
Math

math node

The math node performs one of several math functions on one or two inputs
Clamp
Clamps the result between 0 and 1.
Add
Add the two inputs
Subtract
Subtract input 2 from input 1
Multiply
Multiply the two inputs
Divide
Divide input 1 by input 2
Sine
The sine of input 1 (degrees)
Cosine
The cosine of input 1 (degrees)
Tangent
The tangent of input 1 (degrees)
Arcsine
The arcsine (inverse sine) of input 1 (degrees)
Arccosine
The arccosine (inverse cosine) of input 1 (degrees)
Arctangent
The arctangent (inverse tangent) of input 1 (degrees)
Power
Input 1 to the power of input 2 (input1^input2)
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Logarithm
log base input 2 of input 1
Minimum
The minimum of input 1 and input 2
Maximum
The maximum of input 1 and input 2
Round
Rounds input 1 to the nearest integer
Less Than
Test if input 1 is less than input 2, returns 1 for true, 0 for false
Greater Than
Test if input 1 is greater than input 2, returns 1 for true, 0 for false

ColorRamp Node

ColorRamp Node

The ColorRamp Node is used for mapping values to colors with the use of a gradient. It works exactly the same
way as a Colorband for textures and materials, using the Factor value as a slider or index to the color ramp
shown, and outputting a color value and an alpha value from the output sockets.
By default, the ColorRamp is added to the node map with two colors at opposite ends of the spectrum. A
completely black black is on the left (Black as shown in the swatch with an Alpha value of 1.00) and a
whitewash white is on the right.
See Color Ramp Widget for editing info.

RGB to BW Node

RGB to BW Node

This node converts a color image to black-and-white by computing the luminance of the rgb values.
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Value to Normal

Value to Normal node

Computes a normal map based on greyscale values of an input
Val
The texture to compute the normal map from
Nabla
Size of derivative offset used for calculating normals.

Distance

Distance node. Coordinate 2 dropdown is displayed

Computes the distance between two 3d coordinates.

Distort Nodes
These nodes allow you to change the mapping of a texture.

Rotate
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Rotate node

Rotate the texture coordinates of an image or texture.
Turns
The number of times to rotate the coordinates 360 degrees about the specified axis.
Axis
The axis to rotate the mapping about

Translate

Translate node

Translate the texture coordinates of an image or texture.
Offset
The amount to offset the coordinates in each of the 3 axes.

Scale

Scale node

Scale the texture coordinates of an image or texture.
Scale
The amount to scale the coordinates in each of the 3 axes.

At

At node
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Returns the color of a texture at the specified coordinates. If the coordinates are not spatially varying, the node
will return a single color.
Coordinates
The point at which to sample the color. For images, the space is between -1 and 1 for x and y.

Volume Textures
Bforartists has two textures that can be applied to volumetric data:
Voxel Data
Voxel data renders a voxel source. It can be used for rendering Bforartists’s internal smoke simulations.
Other sources include binary raw formats, and Image Sequence, which can be used to stack a sequence of
images into a 3D representation
Point Density
Point density renders a given point cloud (object vertices or particle system) as a 3D volume
• Voxel Data
• Point Density Texture

Voxel Data
Voxel data renders a voxel source, working very similarly to an image texture, but in 3d. Various input data
source types are available (such as smoke voxel data, or external files), as well as various interpolation
methods.
The voxels are stored in a flat z/y/x grid of floats. Functions for sampling this based on location within the (0,1)
bounds are available in:
• source/Bforartists/blenlib/intern/voxel.c
The default voxel data source, Smoke, is used for rendering Bforartists’s internal smoke simulations. Other
sources include binary raw formats, and Image Sequence, which can be used to stack a sequence of images into
a 3D representation, which is a common format for medical volume data such as CT scans.

Settings
File Format
Bforartists Voxel
Default binary voxel file format.
8 bit RAW
8 bit grayscale binary data.
Image Sequence
Generate voxels from a sequence of image slices.
Smoke
Render voxels from a Bforartists smoke simulation.
Source Path
The external source data file to use for 8 bit Raw data and Bforartists Voxel formats
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Domain Object (Smoke)
Object used as the smoke simulation domain
Source
Smoke
Use smoke density and color as texture data.
Flame
Use flame temperature as texture data.
Heat
Use smoke heat as texture data. Values from -2.0 to 2.0 are used.
Velocity
Use smoke velocity as texture data.
Resolution
Resolution of the voxel grid when using 8 bit Raw data.
Interpolation
Nearest Neighbor
No interpolation, fast but blocky and low quality.
Linear
Good smoothness and speed.
Quadratic
Mid-range quality and speed.
Cubic Catmull-Rom
Smoothed high quality interpolation, but slower.
Extension
Extend
Extend by repeating edge pixels of the image.
Clip
Clip to image size and set exterior pixels as transparent.
Repeat
Cause the image to repeat horizontally and vertically.
Intensity
Multiplier for intensity values

Point Density Texture
Point density renders a given point cloud (object vertices or particle system) as a 3D volume, using a userdefined radius for the points. Internally, the system uses a BVH data structure for fast range lookups.
The rendered points are spherical by default, with various smooth falloff options, as well as simple Turbulence
options for displacing the result with noise, adding fine detail. When using Point Density with a particle system,
additional particle info such as particle velocity, age, and speed, can be visualized using a color/alpha ramp
gradient.

Options
Particle System
Particle System, Generate point density from a particle system.
Object Vertices
Object Vertices, Generate point density from an object’s vertices.
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Object Radius System Falloff
Standard Smooth Soft Softness
Constant
Density is constant within lookup radius.
Root Particle Age Particle Velocity Velocity Scale
Falloff Curve
Use a custom falloff
Cache
Coordinate system to cache particles in Global Space Emit Object Space Emit Object Location
Color Source
Data to derive the color results from
Constant
Constant color
Particle Age
Lifetime mapped as 0.0 - 1.0 intensity.
Particle Speed
Particle speed (absolute magnitude of velocity) mapped as 0.0-1.0 intensity.
Scale
Multiplier to bring particle speed within an acceptable range.
Particle Velocity
XYZ velocity mapped to RGB colors.
Scale
Multiplier to bring particle speed within an acceptable range.

Turbulence
Adds directed noise to the density at render time
Influence
Method for driving added turbulent noise
Static
Noise patterns will remain unchanged, faster and suitable for stills.
Particle Velocity
Turbulent noise driven by particle velocity.
Particle Age
Turbulent noise driven by the particle’s age between birth and death.
Global Time
Turbulent noise driven by the global current frame.
Noise Basis
See Here
Size
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Scale of the turbulent noise
Depth
Level of detail in the added turbulent noise
Turbulence Strength
Strength of the added turbulent noise

Texture Mapping
Textures need mapping coordinates, to determine how they are applied to the object. The mapping specifies
how the texture will ultimately wrap itself to the object.
For example, a 2D image texture could be configured to wrap itself around a cylindrical shaped object.

Coordinates

Mapping Coordinate menu

Coordinates
Mapping works by using a set of coordinates to guide the mapping process. These coordinates can come
from anywhere, usually the object to which the texture is being applied to.
Global
The scene’s global 3D coordinates. This is also useful for animations; if you move the object, the texture
moves across it. It can be useful for letting objects appear or disappear at a certain position in space.
Object
Uses an object as source for coordinates. Often used with an Empty, this is an easy way to
place a small image at a given point on the object. This object can also be animated, to move a
texture around or through a surface.
Object
Select the name of an object.
Generated
The original undeformed coordinates of the object. This is the default option for mapping textures.
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UV
UV mapping is a very precise way of mapping a 2D texture to a 3D surface. Each vertex of a
mesh has its own UV co-ordinates which can be unwrapped and laid flat like a skin. You can
almost think of UV coordinates as a mapping that works on a 2D plane with its own local
coordinate system to the plane on which it is operating on. This mapping is especially useful
when using 2D images as textures, as seen in UV Mapping. You can use multiple textures
with one set of UV coordinates.
Layer
Select your UV layer to use it for mapping.
Strand/Particle
Uses normalized 1D strand texture coordinate or particle age(X) and trail position (Y). Use when texture
is applied to hair strands or particles.
Window
The rendered image window coordinates. This is well suited to blending two objects.
Normal
Uses the direction of the surface’s normal vector as coordinates. This is very useful when creating certain
special effects that depend on viewing angle.
Reflection
Uses the direction of the reflection vector as coordinates. This is useful for adding reflection maps - you
will need this input when Environment Mapping.
Stress
Uses the difference of edge length compared to original coordinates of the mesh. This is useful, for
example, when a mesh is deformed by modifiers.
Tangent
Uses the optional tangent vector as texture coordinates.

Projection
Flat
Flat mapping gives the best results on single planar faces. It does produce interesting effects on the
sphere, but compared to a sphere-mapped sphere the result looks flat. On faces that are not in the mapping
plane the last pixel of the texture is extended, which produces stripes on the cube and cylinder.
Cube
Cube mapping often gives the most useful results when the objects are not too curvy and organic (notice
the seams on the sphere).
Tube
Tube mapping maps the texture around an object like a label on a bottle. The texture is therefore more
stretched on the cylinder. This mapping is of course very good for making the label on a bottle or
assigning stickers to rounded objects. However, this is not a cylindrical mapping so the ends of the
cylinder are undefined.
Sphere
Sphere mapping is the best type for mapping a sphere, and it is perfect for making planets and similar
objects. It is often very useful for creating organic objects. It also produces interesting effects on a
cylinder.

Inheriting coordinates from the parent object
From Dupli
Duplis instanced from vertices, faces, or particles, inherit texture coordinates from their parent.
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Todo: explaination

Coordinate Offset, Scaling and Transformation

Offset panel

Offset
The texture co-ordinates can be translated by an offset. Enlarging of the Ofs moves the texture towards
the top left.

Size panel

Size
These buttons allow you to change the mapping of axes between the texture’s own coordinate system, and
the mapping system you choose (Generated, UV, etcetera.) More precisely, to each axis of the texture
corresponds one of four choices, that allow you to select to which axis in the mapping system it maps!
This implies several points:
• For 2D textures (such as images), only the first two rows are relevant, as they have no Z data.
• You can rotate a 2D picture a quarter turn by setting the first row (i.e. X texture axis) to Y, and the
second row (Y texture axis) to X.
• When you map no texture axis (i.e. the three “void” buttons are set), you’ll get a solid uniform
texture, as you use zero dimension (i.e. a dot, or pixel) of it (and then Bforartists extends or
repeats this point’s color along all axes.)
• When you only map one texture axis (i.e. two “void” buttons are enabled) you’ll get a “striped”
texture, as you only use one dimension (i.e. a line of pixel) of it, (and then Bforartists stretches this
line along the two other axes).
• The same goes, for 3D textures (i.e. procedural ones), when one axis is mapped to nothing,
Bforartists extends the plan (“slice”) along the relevant third axis.
So, all this is a bit hard to understand and master. Fortunately, you do not have to change these settings often,
except for some special effects... Anyway, the only way to get used to them is to practice!

Environment Maps
Environment maps take a render of the 3D scene and apply it to a texture, to use for faking reflections. If you
want to achieve a very realistic result, raytraced reflections are a good solution. Environment Maps are another
way to create reflective surfaces, but they are not so simple to set up.
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So why should one use Environment Maps?
• The main reason is probably that they can be much faster than raytracing reflections. In certain
situations they need to be calculated only once, and may be reused like any ordinary texture. You may
even modify the precalculated Environment Map in an image editor.
• Environment maps can also be blurred and render even faster because the resolution can then be
lowered. Blurring a reflection with the raytracer always adds to the render time, sometimes quite a lot.
• Halos (a visualization type for particles) are not visible to raytraced reflections, so you need to setup
environment maps to reflect them.
• Keypoint strands (another visualization type for particles) are also not visible to raytraced reflections, so
you need to setup environment maps to reflect them.
Just as we render the light that reaches the viewing plane using the camera to define a viewpoint, we can render
the light that reaches the surface of an object (and hence, the light that might ultimately be reflected to the
camera). Bforartists’s environment mapping renders a cubic image map of the scene in the six cardinal
directions from any point. When the six tiles of the image are mapped onto an object using the Refl input
coordinates, they create the visual complexity that the eye expects to see from shiny reflections.
Note
It’s useful to remember here that the true goal of this technique is believability, not accuracy. The eye doesn’t
need a physically accurate simulation of the light’s travel; it just needs to be lulled into believing that the scene
is real by seeing the complexity it expects. The most unbelievable thing about most rendered images is the
sterility, not the inaccuracy.

Options
Important
For correct results, the mapping of an environment map texture must be set to ‘Refl’ (reflection co-ordinates)
in the Map Input panel of the Material context.
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Reflecting plane EnvMap settings.

Bforartists allows three types of environment maps, as you can see in Reflecting plane EnvMap settings. :
Static
The map is only calculated once during an animation or after loading a file.
Animated
The map is calculated each time a rendering takes place. This means moving Objects are displayed
correctly in mirroring surfaces.
Image File
When saved as an image file, environment maps can be loaded from disk. This option allows the fastest
rendering with environment maps, and also gives the ability to modify or use the environment map in an
external application.
When using planar reflections, if the camera is the only moving object and you have a reflecting plane,
the Empty must move too and you must use Anim environment map. If the reflecting object is small and
the Empty is in its center, the environment map can be Static, even if the object itself rotates since the
Empty does not move. If, on the other hand, the Object translates the Empty should follow it and the
environment map be of Anim type.
Options in dropdown menu:
Clear Environment Map
Clears the currently rendered environment map from memory. This is useful to refresh a Static
environment maps and you have changed things in your scene since the last time the environment map
was rendered. Anim environment maps do this automatically on every render.
Save Environment Map
Saves the currently stored static environment map to disk as an image file. This can be loaded again with
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Load.
Clear All Environment Maps
Does the same as Free Data, but with all environment maps in the scene. This is a useful shortcut when
using recursive environment maps (when the Depth is greater than 0).
Note
EnvMap calculation can be disabled at a global level by the EnvMap Tog Button in the Render Panel of the
Rendering Buttons.
Viewpoint Object
Environment maps are created from the perspective of a specified object. The location of this object will
determine how ‘correct’ the reflection looks, though different locations are needed for different reflecting
surfaces. Usually, an Empty is used as this object.
• For planar reflections, the object should be in a location mirrored from the camera, on the other
side of the plane of reflection (see Examples). This is the most accurate usage of Environment
maps.
• For spherical reflections, the object should be in the center of the sphere. Generally, if the
reflecting sphere’s object center point is in the center of its vertices, you can just use the name of
the actual sphere object as the Ob:
• For irregular reflections, there’s no hard and fast rule, you will probably need to experiment and
hope that the inaccuracy doesn’t matter.
Ignore Layers
The layers to exclude from the environment map creation. Since environment maps work by rendering the
scene from the location of the Ob: object, you will need to exclude the actual reflecting surface from the
environment map, otherwise it will occlude other objects that should be reflected on the surface itself.
Eg. If you are rendering an environment map from the center of a sphere, all the environment map will
show by default is the inside of the sphere. You will need to move the sphere to a separate layer, then
exclude that layer from the environment map render, so that the environment map will show (and hence
reflect) all the objects outside the sphere.
Resolution
The resolution of the cubic environment map render. Higher resolutions will give a sharper texture
(reflection), but will be slower to render.
Depth
The number of recursive environment map renders. If there are multiple reflecting objects using
environment maps in the scene, some may appear solid, as they won’t render each other’s reflections. In
order to show reflections within reflections, the environment maps need to be made multiple times,
recursively, so that the effects of one environment map can be seen in another environment map. See
Examples.
Clipping Start/End
The clipping boundaries of the virtual camera when rendering the environment map. Sets the minimum
and maximum distance from the camera that will be visible in the map.

Environment Map Sampling
Filter
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Box
Box Filter
EWA
Elliptical Weighted Average - one of the most efficient direct convolution algorithms developed by
Paul Heckbert and Ned Greene in the 1980s. For each texel, EWA samples, weights, and
accumulates texels within an elliptical footprint and then divides the result by the sum of the
weights.
Eccentricity
Maximum eccentricity (higher gives less blur at distant/oblique angles, but is also slower)
FELINE
FELINE (Fast Elliptical Lines), uses several isotropic probes at several points along a line in texture
space to produce an anisotropic filter to reduce aliasing artifacts without considerably increasing
rendering time.
Probes
Maximum number of samples (higher gives less blur at distant/oblique angles, but is also
slower)
Area
Eccentricity
Maximum eccentricity (higher gives less blur at distant/oblique angles, but is also
slower)
Filter Size
The amount of blurring applied to the texture. Higher values will blur the environment map to fake blurry
reflections.
Minimum Filter Size
Use Filter Size as a minimal filter value in pixels

Examples
In this example, an empty is used as the Ob: of the reflecting plane’s environment map. It is located in the
specular position of the camera with respect to the reflecting surface. (This is possible, strictly speaking, only
for planar reflecting surfaces.) Ideally, the location of the empty would mirror the location of the camera across
the plane of the polygon onto which it is being mapped.

Planar reflection example. 1: Camera, 2: Empty, 3: Reflecting
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Plane.

Sphere on a reflecting surface.

The following images show the effect of the Depth. The first render has depth set to 0. This means the
environment map on the plane has rendered before the environment map of the sphere, so the sphere’s
reflection isn’t shown. By raising the Depth, the environment map is rendered recursively, in order to get
reflections of reflections.

Reflecting sphere on a reflecting surface.

Reflecting sphere on a reflecting surface with
multiple reflections.

Limitations
Because environment maps are calculated from the exact location of the Viewpoint Object’s object center, and
not from actual reflecting surface, they can often be inaccurate, especially with spheres. In the following image,
the rectangular prism and the smaller spheres are touching the sides of the large reflecting sphere, but because
the environment map is calculated from the center of the sphere, the surrounding objects look artificially far
away.

Inaccurate spherical reflection, the colored objects are artificially offset

Material Textures Influence
Not only can textures affect the color of a material, they can also affect many of the other properties of a
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material. The different aspects of a material that a texture influences are controlled in the Influence panel.
Note
Texture options for Surface and Wire materials and in some cases also for Volume and Halo materials.

Surface and Wire materials

Texture Influence panel for a Surface material

Diffuse
Intensity
Amount texture affects affects diffuse reflectivity
Color
Amount texture affect the basic color or RGB value of the material
Alpha
Influences the opacity of the material. Also use Z Transparency for light and if combining multiple
channels.
Translucency
Influences the Translucency amount.

Specular
Intensity
Amount texture affect specular reflectivity
Color
Influences the Specular color, the color of the reflections created by the lamps on a glossy material.
Hardness
Influences the specular hardness amount. A DVar of 1 is equivalent to a Hardness of 130, a DVar of 0.5 is
equivalent to a Hardness of 65.
63

Bforartists Reference Manual - © Copyright - This page is under OCL license

Shading
Ambient
Influences the amount of Ambient light the material receives.
Emit
Influences the amount of light Emitted by the material.
Mirror
Influences the mirror color. This works with environment maps and raytraced reflection.
Ray Mirror
Influences the strength of raytraced mirror reflection.

Geometry
Normal
Commonly called bump mapping, this alters the direction of the surface normal. This is used to fake
surface imperfections or unevenness via bump mapping, or to create reliefs.
Warp
Warp allows textures to influence/distort the texture coordinates of a next texture channel. The distortion
remains active over all subsequent channels, until a new Warp has been set. Setting the factor at zero
cancels out the effect.
Displace
Influences the Displacement of vertices, for using Displacement Maps.

Other Controls
Blend
Blending operation to perform. See Texture Blending Modes for details.
RGB to intensity
With this option enabled, an RGB texture (affects color) is used as an intensity texture (affects a value).
Blend Color
If the texture is mapped to Col, what color is blended in according to the intensity of the texture? Click on
the swatch or set the RGB sliders.
Negative
The effect of the Texture is negated. Normally white means on, black means off, Negative reverses that.
Stencil
The active texture is used as a mask for all following textures. This is useful for semitransparent textures
and “Dirt Maps”. Black sets the pixel to “untexturable”. The Stencil mode works similar to a layer mask
in a 2D program. The effect of a stencil texture can not be overridden, only extended. You need an
intensity map as input.
DVar
Destination Value (not for RGB). The value with which the Intensity texture blends with the current
value. Two examples:
• The Emit value is normally 0. With a texture mapped to Emit you will get maximal effect, because DVar
is 1 by default. If you set DVar to 0 no texture will have any effect.
• If you want transparent material, and use a texture mapped to Alpha, nothing happens with the default
settings, because the Alpha value in the Material panel is 1. So you have to set DVar to 0 to get
transparent material (and of course Z Transparency also). This is a common problem for beginners. Or
do it the other way round - set Alpha to 0 and leave Dvar on 1. Of course the texture is used inverted
then.
Bump Mapping
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Settings for bump mapping. Method Best Quality, Default, Compatible, Original Space
Texture Space, Object Space, View Space

Volume materials

Texture Influence panel for Volume material

Special texture options for Volume materials
Density
Causes the texture to affect the volume’s density.
Emission
Causes the texture to affect the volume’s emission.
Scattering
Amount the texture affects scattering.
Reflection
Amount the texture affects brightness of out-scattered light
Emission Color
Amount the texture affects emission color.
Transmission
Amount the texture affects result color after light has been scattered/absorbed.
Reflection Color
Amount the texture affects color of out-scattered light.
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Halo materials

Texture Influence panel for a Halo material

Special texture options for Halo materials
Size
Amount the texture affects ray mirror.
Hardness
Amount the texture affects hardness.
Add
Amount the texture affects translucency.

Texture Blending Modes
Blending Modes are different methods of controlling how the texture influences material properties. While a
blending mode defines the specific operation performed, blending factor controls the amount, the overall
“strength” of this operation. For textures such blending factor is set via sliders in the Influence panel.
Throughout this section, the term base layer refers to the base material color being manipulated (as defined by
texture’s Influence) and blend layer refers to the texture. Following is a list of available texture blending modes:
See also
Color Blend Modes for details on each blending mode.

Bump and Normal Maps
Description
Normal Maps and Bump Maps both serve the same purpose: they simulate the impression of a detailed 3D
surface, by modifying the shading as if the surface had lots of small angles, rather than being completely flat.
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Because it’s just modifying the shading of each pixel, this will not cast any shadows and will not obstruct other
objects. If the camera angle is too flat to the surface, you will notice that the surface is not really shaped.
Both Bump Maps and Normal Maps work by modifying the normal angle (the direction pointing perpendicular
from a face), which influences how a pixel is shaded. Although the terms Normal Map and Bump Map are often
used synonymously, there are certain differences.
Bump maps
These are textures that store an intensity, the relative height of pixels from the viewpoint of the camera.
The pixels seem to be moved by the required distance in the direction of the face normals. (The “bump”
consists only of a displacement, which takes place along the existing, and unchanged, normal-vector of
the face.) You may either use greyscale pictures or the intensity values of a RGB-Texture (including
images).
Normal maps
These are images that store a direction, the direction of normals directly in the RGB values of an image.
They are much more accurate, as rather than only simulating the pixel being away from the face along a
line, they can simulate that pixel being moved at any direction, in an arbitrary way. The drawbacks to
normal maps are that unlike bump maps, which can easily be painted by hand, normal maps usually have
to be generated in some way, often from higher resolution geometry than the geometry you’re applying
the map to.
Normal maps in Bforartists store a normal as follows:
• Red maps from (0-255) to X (-1.0 - 1.0)
• Green maps from (0-255) to Y (-1.0 - 1.0)
• Blue maps from (0-255) to Z (0.0 - 1.0)
Since normals all point towards a viewer, negative Z-values are not stored (they would be invisible
anyway). In Bforartists we store a full blue range, although some other implementations also map blue
colors (128-255) to (0.0 - 1.0). The latter convention is used in “Doom 3” for example.

Workflow
The steps involved in making and using Bump and Normal Maps is:
•
•
•
•

Model a highly detailed (“hi-poly”) model
Bake the Bump and/or Normal maps
Make a low-poly, less detailed model
Map the map to the low-poly model using a common coordinate system

Consult the Modeling section for how to model a highly detailed model using the Mesh tools. How much detail
you put in is totally up to you. The more ridges and details (knobs, creases, protrusions) you put in, the more
detailed your map will be.
Baking a map, simply put, is to take the detail of a high polygon mesh, and apply it to a similar object. The
similar object is identical to the high-poly mesh except with less vertices. Use the Render Bake feature in
Bforartists to accomplish this.
Modeling a low-poly using Bforartists’s Mesh editing tools. In general, the same or similar faces should exist
that reflect the model. For example, a highly detailed ear may have 1000 faces in the high-poly model. In the
67

Bforartists Reference Manual - © Copyright - This page is under OCL license

low-poly model, this may be replaced with a single plane, oriented in the same direction as the detailed ear
mesh. (Tip: Bforartists’s multi-resolution mesh modeling feature can be used to good effect here.)
Mapping is the process of applying a texture to the low-poly mesh. Consult the Textures Mapping section for
more information on applying a texture to a mesh’s material.Special considerations for Bump and Normal Maps
is:
• When using a Bump map, map the texture to Normal and enable No RGB.
• When using a Normal map, map the texture to Normal.
The coordinate systems of the two objects must match. For example, if you bake using a UV map of the highpoly model, you must UV map the low poly model and line up its UV coordinates to match the outline of the
high-poly image (see UV unwrapping to line up with the high-poly map edges.

Displacement Maps
Description
Displacement mapping allows a texture input to manipulate the position of vertices on rendered geometry.
Unlike Normal or Bump mapping, where the shading is distorted to give an illusion of a bump (discussed on the
previous page), Displacement Maps create real bumps, creases, ridges, etc in the actual mesh. Thus, the mesh
deformations can cast shadows, occlude other objects, and do everything that changes in real geometry can do,
but, on the other hand, requires a lot more vertices to work.

Options
In the Influence panel, the strength of the displacement is controlled by the Displace and Normal sliders.
• If a texture provides only normal information (e.g. Stucci), vertices move according to the texture’s
normal data. The normal displacement is controlled by the Normal slider.
• If a texture provides only intensity information (e.g. Magic, derived from color), vertices move along
the directions of their normals (a vertex has no normal itself, it’s the resulting vector of the adjacent
faces). White pixels move outward in the direction of the normal, black pixels move in the opposite
direction. The amount of displacement is controlled with the Displace slider.
The two modes are not exclusive. Many texture types provide both information (Clouds, Wood, Marble, Image).
The amount of each type can be mixed using the respective sliders. Intensity displacement gives a smoother,
more continuous surface, since the vertices are displaced only outward. Normal displacement gives a more
aggregated surface, since the vertices are displaced in multiple directions.
The depth of the displacement is scaled with an object’s scale, but not with the relative size of the data. This
means if you double the size of an object in object mode, the depth of the displacement is also doubled, so the
relative displacement appears the same. If you scale inside Edit Mode, the displacement depth is not changed,
and thus the relative depth appears smaller.
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Hints
Displacement maps move the rendered faces, not the physical mesh faces. So, in 3D View the surface may
appear smooth, but render bumpy. To give a detailed surface, there has to be faces to displace and have to be
very small. This creates the trade-off between using memory and CPU time versus render quality.
From best to worst, displacement works with these object types using the methods listed to control the render
face size:
Subdivision Surface Meshes
Rendered face size is controlled with render subsurf level. Displacement really likes smooth normals.
Manually ( Edit Mode ) subdivided meshes
Control render faces with number of subdivides. (This can be combined with the above methods).
Displaces exactly the same Simple Subsurf, however the overhead of drawing extra faces can slow down
editing.
Meta Objects
Control render faces with render wiresize. Small wire == more faces.
The following are available, but currently don’t work well. It is recommended that you convert these to meshes
before rendering.
Open NURBS Surfaces
Control render faces with U/V Surface Resolution. Higher numbers give more faces. (Note normal
errors).
Closed NURBS Surfaces
Control with Surface Resolution controls. (Note the normal errors, and how implicit seam shows).
Curves and Text
Control with Surface Resolution controls. Higher gives more render faces. (Note that the large flat
surfaces have few render faces to displace).
Note
Displace Modifier
If you want more control over your displacement, you’ll probably want to use the Displace Modifier. This
feature has lots of different options so that you can customize the displacement exactly to your liking.

World
TODO: https://developer.Bforartists.org/T46363

Particles
TODO: https://developer.Bforartists.org/T46363
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Lighting
Lighting is a very important topic in rendering, standing equal to modeling, materials and textures. The most
accurately modeled and textured scene will yield poor results without a proper lighting scheme, while a simple
model can become very realistic if skillfully lit.

Viewing Restrictions
The color of an object and the lighting of your scene is affected by:
Your ability to see different colors (partial color blindness is common).
The medium in which you are viewing the image (e.g. an LCD panel versus printed glossy paper).
The quality of the image (e.g. a JPEG at 0.4 compression versus 1.0).
The environment in which you are viewing the image (e.g. a CRT monitor with glare versus in a dark
room, or in a sunshiny blue room).
• Your brain’s perception of the color and intensity relative to those objects around it and the world
background color, which can be changed using color manipulation techniques using Bforartists
Composite Nodes.
•
•
•
•

Global Influences
In Bforartists, the elements under your control which affect lighting are:
•
•
•
•
•

The color of the world ambient light.
The use of Ambient Occlusion as a way to cast that ambient light onto the object.
The degree to which the ambient light colors the material of the object.
The use of Indirect lighting, where the color of one object radiates onto another.
The lamps in your scene.

The physics of light bouncing around in the real world is simulated by Ambient Occlusion (a world setting),
buffer shadows (which approximate shadows being cast by objects), ray tracing (which traces the path of
photons from a light source). Also, within Bforartists you can use Indirect lighting. Ray tracing, ambient
occlusion, and indirect lighting are computer-intensive processes. Bforartists can perform much faster rendering
with its internal scan line renderer, which is a very good scan line renderer indeed. This kind of rendering
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engine is much faster since it does not try to simulate the real behavior of light, assuming many simplifying
hypotheses.

Lighting Settings
Only after the above global influences have been considered, do you start adding light from lamps in your
scene. The main things under your control are the:
•
•
•
•

Type of light used (Sun, Spot, Lamp, Hemi, etc.).
Color of the light.
Position of the light and its direction.
Settings for the light, including energy and falloff.

Then you are back to how that material’s shader reacts to the light.
This chapter attempts to address the above, including how lights can work together in rigs to light your scene.
In this chapter we will analyze the different type of lights in Bforartists and their behavior; we will discuss their
strong and weak points. We also describe many lighting rigs, including the ever-popular three-point light
method.

Lighting in the Workflow
In this user manual we have placed Lighting before Materials; you should set up your lighting before assigning
materials to your meshes. Since the material shaders react to light, without proper lighting, the material shaders
will not look right, and you will end up fighting the shader, when it is really the bad lighting that is causing you
grief. All of the example images in this section do not use any material setting at all on the ball, cube or
background.

Overriding Materials to Reset Lighting
Material field in the Render Layers panel

If you have started down the road of assigning materials,
and are now fiddling with the lighting, we suggest that you
create a default, generic gray material–no Vertex Color, no
Face Texture, no Shadeless, just plain old middle gray with
RGB of (0.8, 0.8, 0.8). Name this Gray.
Next go to the Render context. In the Render Layers panel,
select your new Gray material in the Material field. This
will override any materials you may have set, and render
everything with this color. Using this material, you can
now go about adjusting the lighting. Just empty this field to
get back to your original materials.

4
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Lights
As previously stated, there are multiple types of lighting in Bforartists, like indirect light or ambient light.
However, one of the most used are “lights”, or “lamps”. In this section, we will discuss general info and settings
for these lights (you will find more lamp-specific details in the Lamps section):
•
•
•
•
•

Light Properties - settings common to all lamps.
Light Attenuation.
Textures - how to apply texture(s) to lamps.
What Light Affects.
Lights In Other Contexts - lamp-related setting in other contexts.

Lights Common Options

Lamp Properties panels

There are five types of lamps in Bforartists. They share all or some of the options listed here:
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Object Data
Browse Light Object Data
Click to view all lights in the current scene.
Name
The name of the currently selected light object data. Edit to change the name.
Number of Users
The number of light objects sharing the light object data.
F
Create a fake user for this object data.

Preview
A quick preview of the light settings.
Lamp

Distance
The Dist field indicates the number of Bforartists Units (BU) at which the intensity of the current light
source will be half of its intensity. Objects less than the number of BU away from the lamp will get more
light, while objects further away will receive less light. Certain settings and lamp falloff types affect how
the Distance field is interpreted, meaning that it will not always react the same; see the page about light
falloff.
• The Sun and Hemi Lamps are another class of Lamps which uses a constant falloff. Those lamps don’t
have a Dist field, and are often called “Base Lighting Lamps”.
Energy
The intensity of the light source’s illumination (from 0.0 to 10.0).
Color
The color of the light source’s illumination. Opens a color swatch.
Negative
Let the lamp cast negative light.
This Layer Only
The Lamp only illuminates objects on the same layer the lamp is on.
Specular
The Lamp creates specular highlights.
Diffuse
The Lamp does diffuse shading.

Light Attenuation
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Description

Lamp panel, falloff options highlighted

There are two main controls for light falloff for Point and Spot lamps.
• The lamp Falloff type drop-down list, and
• The Sphere button.

Falloff types
Lin/Quad Weighted

Lamp panel with Lin/Quad Weighted Falloff options highlighted

When this setting is chosen, two sliders are shown, Linear and Quadratic, which control respectively the
“linearness” and “quadraticness” of the falloff curve.
This lamp falloff type is in effect allowing the mixing of the two light attenuation profiles (linear and quadratic
attenuation types).

Linear
This slider input field can have a value between 0.0 and 1.0. A value of 1.0 in the Linear field and 0.0 in
the Quadratic field in effect means that the light from this source is completely linear. This means that at the
7
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number of Bforartists Units distance specified in the Distance field, this light source’s intensity will be half the
value it was originally.
When the Quadratic slider is set to 0.0, the formula for working out the attenuation at a particular range for
full linear attenuation is:
I = E × (D / (D + L × r))
Where
•
•
•
•
•

I is the calculated Intensity of light.
E is the current Energy slider setting.
D is the current setting of the Dist field.
L is the current setting of the Linear slider.
r is the distance from the lamp where the light intensity gets measured.

Quadratic

Lamp with Lin/Quad Weighted falloff default settings

This slider input field can have a value between 0.0 and 1.0. A value of 1.0 in the Quadratic field and 0.0
in the Linear field means that the light from this source is completely quadratic.
Quadratic attenuation type lighting is considered a more accurate representation of how light attenuates (in the
real world). In fact, fully quadratic attenuation is selected by default for Lin/Quad Weighted lamp fallout (see
Lamp with Lin/Quad Weighted falloff default settings).
Here again, the light intensity is half when it reaches the Distance value from the lamp. Comparing the
quadratic falloff to the linear falloff, the intensity decays much slower at distances lower than the set Distance,
but it attenuates much quicker after Distance is reached.
When the Linear slider is set to 0.0, the formula for working out the attenuation at a particular range for full
quadratic attenuation is:
I = E × (D2 / (D2 + Q × r2 ))
Where
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•
•
•
•
•

I is the calculated Intensity of light.
E is the current Energy slider setting.
D is the current setting of the Dist field.
Q is the current setting of the Quad slider.
r is the distance from the lamp where the light intensity gets measured.

Mixing “Linear” and “Quad”
If both the Linear and Quad slider fields have values greater than 0.0, then the formula used to calculate the
light attenuation profile changes to this:
I = E × (D / (D + L × r)) × (D2 / (D2 + Q × r2 ))
Where
•
•
•
•
•
•

I is the calculated Intensity of light.
E is the current Energy slider setting.
D is the current setting of the Dist field.
L is the current setting of the Linear slider.
Q is the current setting of the Quad slider.
r is the distance from the lamp where the light intensity gets measured.

Zeroing both “Linear” and “Quad”
If both the Linear and Quadratic sliders have 0.0 as their values, the light intensity will not attenuate with
distance. This does not mean that the light will not get darker - it will, but only because the energy the light has
is spread out over a wider and wider distance. The total amount of energy in the spread-out light will remain the
same, though. The light angle also affects the amount of light you see. It is in fact the behavior of light in the
deep space vacuum.
If what you want is a light source that doesn’t attenuate and gives the same amount of light intensity to each
area it hits, you need a light with properties like the Constant lamp Falloff type.
Also, when the Linear and Quad sliders are both 0.0 values the Distance field ceases to have any influence on
the light attenuation, as shown by the equation above.

Graphical Summary
Below is a graph summarizing the lin/quad attenuation type, showing attenuation with or without the Sphere
option (described later).

9
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Custom Curve
The Custom Curve lamp Falloff type is very flexible.
Most other lamp falloff types work by having their light intensity start at its maximum (when nearest to the
light source) and then with some predetermined pattern decrease their light intensity when the distance from the
light source increases.
When using the Custom Curve Lamp Falloff type, a new panel is created called Falloff Curve. This Falloff
Curve profile graph allows the user to alter how intense light is at a particular point along a light’s attenuation
profile (i.e. at a specific distance from the light source).
The Falloff Curve profile graph has two axes, the Distance axis and the Intensity axis.
Distance axis
It represents the position at a particular point along a light source’s attenuation path. The far left is at the
position of the light source and the far right is the place where the light source’s influence would normally
be completely attenuated. I say “normally would” because the Falloff Curve can be altered to do the exact
opposite if required.
Intensity axis
It represents the intensity at a particular point along a light source’s attenuation path. Higher intensity is
represented by being higher up the intensity axis, while lower intensity light is represented by being lower
down on the intensity axis.
Altering the Falloff Curve profile graph is easy. Just LMB click on a part of the graph you want to alter and drag
it where you want it to be. If when you click you are over or near one of the tiny black square handles, it will
turn white, indicating that this handle is now selected, and you will be able to drag it to a new position. If when
you click on the graph you are not near a handle, one will be created at the point that you clicked, which you
can then drag where you wish. You can also create handles at specific parts of the graph, clicking with LMB
while holding Ctrl key; it will create a new handle at the point you have clicked.
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In the example below (the default for the Falloff Curve Profile Graph), the graph shows that the intensity of the
light starts off at its maximum (when near the light), and linearly attenuates as it moves to the right (further
away from the light source).

Default Falloff Curve panel graph.

Render showing the Custom Curve lamp falloff type effect
with default settings.

If you want to have a light attenuation profile that gets more intense as it moves away from the light source, you
could alter the graph as below:

Falloff Curve for reversed attenuation.

Falloff Curve for reversed attenuation rendered.

You are obviously not just limited to simple changes such as reversing the attenuation profile, you can have
almost any profile you desire.
Here is another example of a different Falloff Curve profile graph, along with its resultant render output:
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Oscillating attenuation profile.

Render showing the effects of a “wavelet” profile graph on the
light attenuation.

Inverse Square

Render showing the Inverse Square lamp falloff type effect with default settings.

This lamp falloff type attenuates its intensity according to inverse square law, scaled by the Distance value.
Inverse square is a sharper, realistic decay, useful for lighting such as desk lamps and street lights. This is
similar to the old Quad option (and consequently, to the new Lin/Quad Weighted option with Linear to 0.0 and
Quad to 1.0), with slight changes.
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Inverse Linear

Render showing the Inverse Linear lamp falloff type effect with default settings.

This lamp falloff type attenuates its intensity linearly, scaled by the Dist value. This is the default setting,
behaving the same as the default in previous Bforartists versions without Quad switched on, and consequently,
like the new Lin/Quad Weighted option with Linear to 1.0 and Quad to 0.0. This isn’t physically accurate,
but can be easier to light with.

Constant

Render showing the Constant lamp falloff type effect with default settings.

This lamp falloff type does not attenuate its intensity with distance. This is useful for distant light sources like
the sun or sky, which are so far away that their falloff isn’t noticeable. Sun and Hemi lamps always have
constant falloff.
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Sphere

Screenshot of the 3D view window, showing the Sphere light clipping circle.

The Sphere option restricts the light illumination range of a Lamp or Spot lamp, so that it will completely stop
illuminating an area once it reaches the number of Bforartists Units away from the Lamp, as specified in the
Dist field.
When the Sphere option is active, a dotted sphere will appear around the light source, indicating the
demarcation point at which this light intensity will be null.
The Sphere option adds a term to the chosen attenuation law, whatever it is:
I' = I × (D - r) / D if r < D; 0 otherwise
Where:
•
•
•
•

I' is the required Intensity of light (with the Sphere option activated).
I is the intensity of light calculated by the chosen attenuation law (without the Sphere option).
D is the current setting of the Dist field.
r is the distance from the lamp where the light intensity gets measured.

See the graphic at the end of the description of the Lin/Quad Weighted attenuation option.

Render showing the light attenuation of a Constant falloff light Render showing the light attenuation of a Constant falloff light
type with the Sphere option active.

type with the Sphere option deactivated.
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Examples
Distance Example
In this example, the Lamp has been set pretty close to the group of planes. This causes the light to affect the
front, middle and rear planes more dramatically. Looking at (Various Dist ance settings), you can see that as the
Dist is increased, more and more objects become progressively brighter.
Various Distance settings (shadows disabled).

Distance: 10.

Distance: 100.

Distance: 1000.

The Distance parameter is controlling where the light is falling - at a linear rate by default - to half its original
value from the light’s origin. As you increase or decrease this value, you are changing where this half falloff
occurs. You could think of Distance as the surface of a sphere and the surface is where the light’s intensity has
fallen to half its strength in all directions. Note that the light’s intensity continues to fall even after Distance.
Distance just specifies the distance where half of the light’s energy has weakened.
Notice in (Distance : 1000) that the farthest objects are very bright. This is because the falloff has been
extended far into the distance, which means the light is very strong when it hits the last few objects. It is not
until 1000 units that the light’s intensity has fallen to half of its original intensity.
Contrast this with (Distance : 10), where the falloff occurs so soon that the farther objects are barely lit. The
light’s intensity has fallen by a half by time it even reaches the tenth object.
You may be wondering why the first few planes appear to be dimmer? This is because the surface angle
between the light and the object’s surface normal is getting close to oblique. That is the nature of a Lamp light
object. By moving the light infinitely far away you would begin to approach the characteristics of the Sun lamp
type.

Inverse Square Example
Inverse Square makes the light’s intensity falloff with a non-linear rate, or specifically, a quadratic rate. The
characteristic feature of using Inverse Square is that the light’s intensity begins to fall off very slowly but then
starts falling off very rapidly. We can see this in the (Inverse Square selected) images.
Inverse Square selected (with the specified distances).
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Inverse Square with 10.

Inverse Square with 100.

Inverse Square with 1000.

With Inverse Square selected, the Distance field specifies where the light begins to fall off faster, roughly
speaking; see the light attenuation description in Falloff types for more info.
In (Inverse Square with 10), the light’s intensity has fallen so quickly that the last few objects aren’t even lit.
Both (Inverse Square with 100) and (Inverse Square with 1000) appear to be almost identical and that is
because the Distance is set beyond the farthest object’s distance which is at about 40 BU out. Hence, all the
objects get almost the full intensity of the light.
As above, the first few objects are dimmer than farther objects because they are very close to the light.
Remember, the brightness of an object’s surface is also based on the angle between the surface normal of an
object and the ray of light coming from the lamp.
This means there are at least two things that are controlling the surface’s brightness: intensity and the angle
between the light source and the surface’s normal.

Sphere Example

Clipping Sphere.

Sphere indicates that the light’s intensity is null at the Distance distance and beyond, regardless of the chosen
light’s falloff. In (Clipping Sphere) you can see a side view example of the setup with Sphere enabled and a
distance of 10.
Any objects beyond the sphere receive no light from the lamp.
The Distance field is now specifying both where the light’s rays become null, and the intensity’s ratio falloff
setting. Note that there is no abrupt transition at the sphere: the light attenuation is progressive (for more details,
see the descriptions of the Sphere and Falloff types above).
Sphere enabled with the specified distances, Inverse Linear light falloff.
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Sphere with 10.

Sphere with 20.

Sphere with 40.

In (Sphere with 10), the clipping sphere’s radius is 10 units, which means the light’s intensity is also being
controlled by 10 units of distance. With a linear attenuation, the light’s intensity has fallen very low even
before it gets to the first object.
In (Sphere with 20), the clipping sphere’s radius is now 20 BU and some light is reaching the middle objects.
In (Sphere with 40), the clipping sphere’s radius is now 40 units, which is beyond the last object. However, the
light doesn’t make it to the last few objects because the intensity has fallen to nearly 0.
Hint
If a Lamp light is set to not cast shadows, it illuminates through walls and the like. If you want to achieve
some nice effects like a fire, or a candle-lit room interior seen from outside a window, the Sphere option is a
must. By carefully working on the Distance value you can make your warm firelight shed only within the
room, while illuminating outside with a cool moonlight, the latter achieved with a Sun or Hemi light or both.

Lamps Textures
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Lamp Texture panels

When a new lamp is added, it produces light in a uniform, flat color. While this might be sufficient in simple
renderings, more sophisticated effects can be accomplished through the use of textures. Subtle textures can add
visual nuance to a lamp, while hard textures can be used to simulate more pronounced effects, such as a disco
ball, dappled sunlight breaking through treetops, or even a projector. These textures are assigned to one of ten
channels, and behave exactly like material textures, except that they affect a lamp’s color and intensity, rather
than a material’s surface characteristics.
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Options
The lamp textures settings are grouped into two panels. Here we will only talk about the few things that differ
from object material textures; see the Materials and Textures chapters for details about the standard options.
The texture-specific and the Mapping panels remain the same. However, you’ll note there are much fewer
Mapping options - you can only choose between Global, View or another Object ‘s texture coordinates (since a
lamp has no texture coordinates by itself), and you can scale or offset the texture.
The Mapping panel is also a subset of its regular material’s counterpart. You can only map a lamp texture to its
regular, basic Color and/or to its Shadow color. As you can only affect colors, and a lamp has no texture
coordinates on its own, the Diffuse, Specular, Shading, and Geometry options have disappeared.

What the Light Affects

Lamp panel with the light affecting options highlighted

Every lamp has a set of switches that control which objects receive its light, and how it interacts with materials.
Negative
The light produced by the lamp is subtracted from the one “available” on the surfaces it hits, which
darkens these surfaces instead of brightening them.
This Layer Only
Causes the lamp to only light objects on the same layer.
Diffuse
Prevents the lamp from producing diffuse light (it doesn’t really “light” things).
Specular
Prevents the lamp from producing specular highlights.

Lamps Related Settings
Here are some options closely related to light sources, without being lamps settings.
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Lighting Groups
Materials

Light Group options for Materials

By default, materials are lit by all lamps in all visible layers, but a material (and thus all objects using that
material) can be limited to a single group of lamps. This sort of control can be incredibly useful, especially in
scenes with complex lighting setups. To enable this, navigate to the Material menu’s Options panel and select a
group of lamps in the Light Group field. Note that a light group must be created first.
If the Exclusive button is enabled, lights in the specified group will only affect objects with this material.
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Render Layers

Light Group options for Render Layers

There’s a similar control located in the Layer panel of the context Render Layers. If a light group name is
selected in this Light field, the scene will be lit exclusively by lamps in the specified group.

See Also
• Lamps Introduction
• Shadows
• Materials Introduction

Shadows
Light wouldn’t even exist without its counterpart: shadows. Shadows are a darkening of a portion of an object
because light is being partially or totally blocked from illuminating the object. They add contrast and volume to
a scene; there is nearly no place in the real world without shadows, so to get realistic renders, you will need
them. Bforartists supports the following kinds of shadows:
•
•
•
•

Lamps: Ray-traced Shadows
Lamps: Buffered Shadows
Ambient occlusion
Indirect lighting

Ambient occlusion really isn’t a shadow based on light per se, but based on geometry. However, it does mimic
an effect where light is prevented from fully and uniformly illuminating an object, so it is mentioned here. Also,
21

Bforartists Reference Manual - © Copyright - This page is under OCL license

it is important to mention ambient lighting, since increasing Ambient decreases the effect of a shadow.
You can use a combination of ray-traced and buffer shadows to achieve different results. Even within ray-traced
shadows, different lamps cast different patterns and intensities of shadow. Depending on how you arrange your
lamps, one lamp may wipe out or override the shadow cast by another lamp.
Shadows is one of those trifectas in Bforartists, where multiple things have to be set up in different areas to get
results:
•
•
•
•

The lamp has to cast shadows (ability and direction).
An opaque object has to block light on its way (position and layer).
Another object’s material has to receive shadows (Shadow and Receive Transparent enabled).
The render engine has to calculate shadows (Shadow for buffered shadows, Shadow and Ray for raytraced shadows).

For example, the simple Lamp, Area, and Sun light has the ability to cast ray shadows, but not buffer shadows.
The Spot light can cast both, whereas the Hemi light does not cast any. If a Sun lamp is pointing sideways, it
will not cast a shadow from a sphere above a plane onto the plane, since the light is not traveling that way. All
lamps able to cast shadows share some common options, described here.
Just to give you more shadow options (and further confuse the issue), lamps and materials can be set to
respectively only cast and receive shadows, and not light the diffuse/specular aspects of the object. Also, render
layers can turn on/off the shadow pass, and their output may or may not contain shadow information...

Lamps: Ray-traced Shadows

Ray Shadow enabled for a lamp

Ray-traced shadows produce very precise shadows with very low memory use, but at the cost of processing
time. This type of shadowing is available to all lamp types except Hemi.
As opposed to buffered shadows (Lamps: Buffered Shadows), ray-traced shadows are obtained by casting rays
from a regular light source, uniformly and in all directions. The ray-tracer then records which pixel of the final
image is hit by a ray light, and which is not. Those that are not are obviously obscured by a shadow.
Each light casts rays in a different way. For example, a Spot light casts rays uniformly in all directions within a
cone. The Sun light casts rays from a infinitely distant point, with all rays parallel to the direction of the Sun
light.
For each additional light added to the scene, with ray-tracing enabled, the rendering time increases. Ray-traced
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shadows require more computation than buffered shadows but produce sharp shadow borders with very little
memory resource usage.
To enable ray-traced shadows, three actions are required:
• Enable Shadows globally in the Render menu’s Shading panel.
• Enable Ray tracing globally from the same panel.
• Enable ray-traced shadows for the light using the Ray Shadow button in the Light menu’s Shadow panel.
This panel varies depending on the type of light.
• All lamps able to cast ray-traced shadows share some common options, described in
Ray-traced Properties.
Ray-traced shadows can be cast by the following types of lamp:
•
•
•
•

Point lamp
Spot lamp
Area lamp
Sun lamp

Lamps: Buffered Shadows

Buffer Shadow enabled for a Spot lamp

Cast Buffer Shadows enabled for a material
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Buffered shadows provide fast-rendered shadows at the expense of precision and/or quality. Buffered shadows
also require more memory resources as compared to ray tracing. Using buffered shadows depends on your
requirements. If you are rendering animations or can’t wait hours to render a complex scene with soft shadows,
buffer shadows are a good choice.
For a scanline renderer - and Bforartists’s built-in engine is, among other things, a scanline renderer - shadows
can be computed using a shadow buffer. This implies that an “image”, as seen from the spot lamp’s point of
view, is “rendered” and that the distance - in the image - for each point from the spot light is saved. Any point
in the “rendered” image that is farther away than any of those points in the spot light’s image is then considered
to be in shadow. The shadow buffer stores this image data.
To enable buffered shadows these actions are required:
•
•
•
•

Enable shadows globally from the Scene menu’s Gather panel by selecting Approximate.
Enable shadows for the light using the Buffer Shadow button in the Lamp menu’s Shadow panel.
Make sure the Cast Buffer Shadows options is enabled in each Material ‘s Shadow panel.
The Spot lamp is the only lamp able to cast buffered shadows.

Common Shadowing Lamps Options

Common shadowing options for lamps

All lamps able to cast shadows (Lamp, Spot, Area and Sun) share some options, described below:
This Layer Only
When this option is enabled, only the objects on the same layer as the light source will cast shadows.
Only Shadow
The light source will not illuminate an object but will generate the shadows that would normally appear.
This feature is often used to control how and where shadows fall by having a light which illuminates but
has no shadow, combined with a second light which doesn’t illuminate but has Only Shadow enabled,
allowing the user to control shadow placement by moving the “Shadow Only” light around.
Shadow color
This color picker control allows you to choose the color of your cast shadows (black by default). The
images below were all rendered with a white light and the shadow color was selected independently.
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Red colored shadow example

Green colored shadow example

Blue colored shadow example

Although you can select a pure white color for a shadow color, it appears to make a shadow disappear.

See Also
•
•
•
•
•
•
•

Shadows
Common Raytraced Options
Lamp Light Raytraced Shadows
Spot Light Raytraced Shadows
Area Light Raytraced Shadows
Sun Light Raytraced Shadows
Spot Light Buffered Shadows

Lamps Raytraced Shadows

Ray shadowing options for lamps

Most lamp types (Lamp, Spot and Sun) share the same options for the ray-traced shadows generation, which are
described below. Note that the Area lamp, even though using most of these options, have some specifics
described in its own ray-traced shadows page.
Ray Shadow
The Ray Shadow button enables the light source to generate ray-traced shadows. When the Ray Shadow
button is selected, another set of options is made available, those options being:
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Shadow sample generator type
Method for generating shadow samples: Adaptive QMC is fastest, Constant QMC is less noisy but slower.
This allows you to choose which algorithm is to be used to generate the samples that will serve to
compute the ray-traced shadows (for now, mainly two variants of Quasi-Monte Carlo, see What is QuasiMonte Carlo?):
Constant QMC
The Constant QMC method is used to calculate shadow values in a very uniform, evenly distributed
way. This method results in very good calculation of shadow value but it is not as fast as using the
Adaptive QMC method; however, Constant QMC is more accurate.
Adaptive QMC
The Adaptive QMC method is used to calculate shadow values in a slightly less uniform and
distributed way. This method results in good calculation of shadow value but not as good as
Constant QMC. The advantage of using Adaptive QMC is that it is in general much quicker while
being not much worse than Constant QMC in terms of overall results.
Samples
Number of extra samples taken (samples x samples). This slider sets the maximum number of samples
that both Constant QMC and Adaptive QMC will use to do their shadow calculations. The maximum
value is 16 - the real number of samples is actually the square of it, so setting a sample value of 3 really
means 32 = 9 samples will be taken.
Soft Size
Light size for ray shadow sampling. This slider determines the size of the fuzzy/diffuse/penumbra area
around the edge of a shadow. Soft Size only determines the width of the soft shadow size, not how graded
and smooth the shadow is. If you want a wide shadow which is also soft and finely graded, you must also
set the number of samples in the Samples field higher than 1; otherwise this field has no visible effect and
the shadows generated will not have a soft edge. The maximum value for Soft Size is 100.0.
Below is a table of renders with different Soft Size and Samples settings showing the effect of various
values on the softness of shadow edges:

Soft Size: 1.0, Samples: 2.

Soft Size: 1.0, Samples: 4.
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Soft Size: 2.0, Samples: 2.

Soft Size: 2.0, Samples: 4.

Soft Size: 2.0, Samples: 6.

Soft Size: 3.0, Samples: 2.

Soft Size: 3.0, Samples: 4.

Soft Size: 3.0, Samples: 6.

Below is an animated version of the above table of images showing the effects:

Animated version renders with different Soft Size and Samples settings showing the effect of various values on the
softness of shadow edges.
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Threshold
Threshold for Adaptive Sampling. This field is used with the Adaptive QMC shadow calculation method.
The value is used to determine if the Adaptive QMC shadow sample calculation can be skipped based on a
threshold of how shadowed an area is already. The maximum Threshold value is 1.0.

What is Quasi-Monte Carlo?
The Monte Carlo method is a method of taking a series of samples/readings of values (any kind of values, such
as light values, color values, reflective states) in or around an area at random, so as to determine the correct
actions to take in certain calculations which usually require multiple sample values to determine overall
accuracy of those calculations. The Monte Carlo method tries to be as random as possible; this can often cause
areas that are being sampled to have large irregular gaps in them (places that are not sampled/read). This in turn
can cause problems for certain calculations (such as shadow calculation).
The solution to this was the Quasi-Monte Carlo method.
The Quasi-Monte Carlo method is also random, but tries to make sure that the samples/readings it takes are also
better distributed (leaving less irregular gaps in its sample areas) and more evenly spread across an area. This
has the advantage of sometimes leading to more accurate calculations based on samples/reading.

Volumetric Lighting
According to Wikipedia, volumetric lighting
is a technique used in 3D computer graphics to add lighting effects to a rendered scene. It allows the
viewer to see beams of light shining through the environment; seeing sunbeams streaming through an
open window is an example of volumetric lighting, also known as God rays. The term seems to have been
introduced from cinematography and is now widely applied to 3D modeling and rendering especially in
the field of 3D gaming. In volumetric lighting, the light cone emitted by a light source is modeled as a
transparent object and considered as a container of a “volume”: as a result, light has the capability to
give the effect of passing through an actual three dimensional medium (such as fog, dust, smoke, or
steam) that is inside its volume, just like in the real world.
A classic example is the search light with a visible halo/shaft of light being emitted from it as the search light
sweeps around.
By default Bforartists does not model this aspect of light. For example when Bforartists lights something with a
Spot light, you see the objects and area on the floor lit but not the shaft/halo of light coming from the spotlight
as it progresses to its target and would get scattered on the way.
The halo/shaft of light is caused in the real world by light being scattered by particles in the air, some of which
get diverted into your eye and that you perceive as a halo/shaft of light. The scattering of light from a source
can be simulated in Bforartists using various options, but by default is not activated.
The only lamp able to create volumetric effects is the Spot lamp (even thought you might consider some of the
“Sky & Atmosphere” effects of the Sun lamp as volumetric as well).
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See also
• Mist
• Smoke
• Volumetric Materials

Lamps
Bforartists comes equipped with five different lamp types, each with its own unique strengths and limitations.
Here are the available lamps:
•
•
•
•
•

Point is an omni-directional point light source, similar to a light bulb.
Spot is a directional point light source, similar to ... a spot.
Area is a source simulating an area which is producing light, as windows, neons, TV screens.
Hemi simulates a very wide and far away light source, like the sky.
Sun simulates a very far away and punctual light source, like the sun.

Visual height and shadow markers of two points lamps. Ray Shadow is enabled on the left lamp.

You can add new lamps to a scene using the Add menu in the top header, or with ([Shift][A] ‣ Add ‣ Lamp).
Once added, a lamp’s position is indicated in the 3D View by a solid dot in a circle, but most types also feature
dashed wire-frames that help describe their orientation and properties. While each type is represented
differently, there are some visual indicators common to all of them:
Shadows
If shadows are enabled, an additional dashed circle is drawn around the solid circle. This makes it easier
to quickly determine if a lamp has shadows enabled.
Vertical Height Marker
This is a dim gray line, which helps locate the lamp’s position relative to the global X-Y plane.
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Point

Point lamp

The Point lamp is an omni-directional point of light, that is, a point radiating the same amount of light in all
directions. It’s visualized by a plain, circled dot. Being a point light source, the direction of the light hitting an
object’s surface is determined by the line joining the lamp and the point on the surface of the object itself.
Light intensity/energy decays based on (among other variables) distance from the Point lamp to the object. In
other words, surfaces that are further away are rendered darker.

Lamp Options
Distance, Energy and Color
These settings are common to most types of lamps, and are described in Light Properties.
Negative, This Layer Only, Specular, and Diffuse
These settings control what the lamp affects, as described in What Light Affects.
Falloff and Sphere
These settings control how the light of the Lamp decays with distance. See Light Attenuation for details.

Shadows

Without ray shadows
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Point lamp with ray shadows and Adaptive QMC sample generator enabled

The Point light source can only cast ray-traced shadows. It shares with other lamp types the common shadow
options described in Shadow Properties.
The ray-traced shadows settings of this lamp are shared with other lamps, and are described Raytraced
Properties.

Raytraced Shadows

Shadow panel

The Point light source can only cast raytraced shadows. It shares with other lamp types the same common
shadowing options, described in Shadows Properties.
The raytraced shadows settings of this lamp are shared with other ones, and are described in Raytraced
Properties.

Spot
A Spot lamp emits a cone-shaped beam of light from the tip of the cone, in a given direction.
The Spot light is the most complex of the light objects and indeed, for a long time, among the most used thanks
to the fact that it was the only one able to cast shadows. Nowadays, with a ray tracer integrated into
31

Bforartists Reference Manual - © Copyright - This page is under OCL license

Bforartists’s internal render engine, all lamps can cast shadows (except Hemi). Even so, Spot lamps’ shadow
buffers are much faster to render than ray-traced shadows, especially when blurred/softened, and spot lamps
also provide other functionality such as “volumetric” halos.

Lamp options

Common Lamp options of a Spot

Distance, Energy and Color
These settings are common to most types of lamps, and are described in Light Properties.
This Layer Only, Negative, Diffuse and Specular
These settings control what the lamp affects, as described in What Light Affects.
Light Falloff and Sphere
These settings control how the light of the Spot decays with distance. See Light Attenuation for details.

Changing the Spot options also changes the appearance of the spotlight as displayed in the 3D View
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Shadows

Shadow panel set to Ray Shadow

Spotlights can use either ray-traced shadows or buffered shadows. Either of the two can provide various extra
options. Ray-traced shadows are generally more accurate, with extra capabilities such as transparent shadows,
although they are quite slower to render.
No Shadow
Choose this to turn shadows off for this spot lamp. This can be useful to add some discreet directed light
to a scene.
Buffer Shadow
Buffered Shadows are also known as depth map shadows. Shadows are created by calculating differences
in the distance from the light to scene objects. See Buffered Shadows for full details on using this feature.
Buffered shadows are more complex to set up and involve more faking, but the speed of rendering is a
definite advantage. Nevertheless, it shares with other lamp types common shadow options described in
Shadows Properties.
Ray Shadow
The ray-traced shadows settings of this lamp are shared with other lamps, and are described in Raytraced
Properties.

Spot Shape
Size
The size of the outer cone of a Spot, which largely controls the circular area a Spot light covers.
This slider in fact controls the angle at the top of the lighting cone, and can be between 1.0- ``
and ``180.0.
Changing the spot Size option
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Blend
The Blend slider controls the inner cone of the Spot. The Blend value can be between 0.0 and 1.0. The
value is proportional and represents that amount of space that the inner cone should occupy inside the
outer cone (Size).
The inner cone boundary line indicates the point at which light from the Spot will start to blur/soften;
before this point its light will mostly be full strength. The larger the value of Blend the more blurred/soft
the edges of the spotlight will be, and the smaller the inner cone’s circular area will be (as it starts to
blur/soften earlier).
To make the Spot have a sharper falloff rate and therefore less blurred/soft edges, decrease the value of
Blend. Setting Blend to 0.0 results in very sharp spotlight edges, without any transition between light
and shadow.
The falloff rate of the Spot lamp light is a ratio between the Blend and Size values; the larger the circular
gap between the two, the more gradual the light fades between Blend and Size.
Blend and Size only control the Spot light cone’s aperture and softness (“radial” falloff); they do not
control the shadow’s softness as shown below.
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Render showing the soft edge spotlighted area and the sharp/hard object shadow

Notice in the picture above that the object’s shadow is sharp as a result of the ray tracing, whereas the
spotlight edges are soft. If you want other items to cast soft shadows within the Spot area, you will need
to alter other shadow settings.
Square
The Square button makes a Spot light cast a square light area, rather than the default circular one.
Show Cone
Draw a transparent cone in 3D view to visualize which objects are contained in it.
Halo
Adds a volumetric effects to the spot lamp. See Spot Halos.

Raytraced Shadows

Shadow panel

The Spot light source can only cast raytraced shadows. It shares with other lamp types the same common
shadowing options, described in Shadows Properties.
The raytraced shadows settings of this lamp are shared with other ones, and are described in Raytraced
Properties.

Spot Buffered Shadows
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Buffer Shadow enabled for a Spot lamp

Spotlights can use either Raytraced Shadows or buffered shadows. Either of the two can provide various extra
options.
Raytraced shadows are generally more accurate, with extra capabilities such as transparent shadows, although
they are quite slower to render.
Buffered shadows are more complex to set up and involve more faking, but the speed of rendering is a definite
advantage. Nevertheless, it shares with other lamp types common shadows options described in Shadows
Properties.

Shadow Buffer Types
When the Buffer Shadow button is activated, the currently selected Spot light generates shadows, using a
“shadow buffer” rather than using raytracing, and various extra options and buttons appear in the Shadow panel.
Buffer Type
There more than one way to generate buffered shadows. The shadow buffer generation type controls
which generator to use.
There are four shadow generation types, those being:
• Classical
• Classic-Halfway
• Irregular
• Deep
For more information on the different shadow generation methods see these links:
• Development Release Logs 2.43: Irregular Shadow Buffer
• Bforartists Nation: Bforartists Gets Irregular Shadow Buffers
• Development Release Logs 2.43: Shadow Buffer Halfway Average
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“Classical” and “Classic-Halfway”

Buffer Shadowset to Classic-Halfway

Classical
A shadow generation which used to be the Bforartists default and unique method for generation of
buffered shadows. It used an older way of generating buffered shadows, but it could have some problems
with accuracy of the generated shadows and can be very sensitive to the resolution of the shadow buffer
(Shadow Buffer –> Size), different Bias values, and all the self-shadowing issues that brings up.
The Classical method of generating shadows is obsolete and is really only still present to allow for
backward compatibility with older versions of Bforartists. In most other cases you will want to use
Classic-Halfway instead.
Classic-Halfway
This shadow buffer type is an improved shadow buffering method and is the default option selected in
Bforartists. It works by taking an averaged reading of the first and second nearest Z depth values allowing
the Bias value to be lowered and yet not suffer as much from self-shadowing issues.
Not having to increase Bias values helps with shadow accuracy, because large Bias values can mean small
faces can lose their shadows, as well as preventing shadows being overly offset from the larger Bias
value.
Classic-Halfway doesn’t work very well when faces overlap, and biasing problems can happen.
Here are now the options specific to these generation methods:
Size
The Size numeric field can have a value from 512 to 10240. Size represents the resolution used to create
a shadow map. This shadow map is then used to determine where shadows lay within a scene.
As an example, if you have a Size with a value of 1024, you are indicating that the shadow data will be
written to a buffer which will have a square resolution of 1024×1024 pixels/samples from the selected
spotlight.
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The higher the value of Size, the higher resolution and accuracy of the resultant shadows, assuming all
other properties of the light and scene are the same, although more memory and processing time would be
used. The reverse is also true - if the Size value is lowered, the resultant shadows can be of lower quality,
but would use less memory and take less processing time to calculate.
As well as the Size value affecting the quality of generated shadows, another property of Spot lamps that
affects the quality of their buffered shadows is the angle of the spotlights lighted area (given in the Spot
Shape panel’s Size field).
As the spot shape Size value is increased, the quality of the cast shadows degrades. This happens because
when the Spot lighted area is made larger (by increasing spot shape Size), the shadow buffer area has to be
stretched and scaled to fit the size of the new lighted area.
The Size resolution is not altered to compensate for the change in size of the spotlight, so the quality of
the shadows degrades. If you want to keep the generated shadows the same quality, as you increase the
spot shape Size value, you also need to increase the buffer Size value.

Note
The above basically boils down to
If you have a spotlight that is large you will need to have a larger buffer Size to keep the shadows good quality.
The reverse is true also - the quality of the generated shadows will usually improve (up to a point) as the Spot
lamp covers a smaller area.

Filter Type
The Box, Tent, and Gauss filter types control what filtering algorithm to use to anti-alias the buffered
shadows.
They are closely related to the Samples numeric field, as when this setting is set to 1, shadow filtering is
disabled, so none of these buttons will have any effect what soever.
Box
The buffered shadows will be anti-aliased using the “box” filtering method. This is the original
filter used in Bforartists. It is relatively low quality and is used for low resolution renders, as it
produces very sharp anti-aliasing. When this filter is used, it only takes into account oversampling
data which falls within a single pixel, and doesn’t take into account surrounding pixel samples. It is
often useful for images which have sharply angled elements and horizontal/vertical lines.
Tent
The buffered shadows will be anti-aliased using the “tent” filtering method. It is a simple filter that
gives sharp results, an excellent general purpose filtering method. This filter also takes into account
the sample values of neighboring pixels when calculating its final filtering value.
Gauss
The buffered shadows will be anti-aliased using the “Gaussian” filtering method. It produces a very
soft/blurry anti-aliasing. As result, this filter is excellent with high resolution renders.
The Anti-Aliasing page in the Render chapter will give more information on the various
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filtering/distribution methods and their uses.
Samples
The Samples numeric field can have a value between 1 and 16. It controls the number of samples taken
per pixel when calculating shadow maps.
The higher this value, the more filtered, smoothed and anti-aliased the shadows cast by the current lamp
will be, but the longer they will take to calculate and the more memory they will use. The anti-aliasing
method used is determined by having one of the Box, Tent or Gauss buttons activated (see above).
Having a Samples value of 1 is similar to turning off anti-aliasing for buffered shadows.
Soft
The Soft numeric field can have a value between 1.0 and 100.0. It indicates how wide an area is
sampled when doing anti-aliasing on buffered shadows. The larger the Soft value, the more graduated/soft
the area that is anti-aliased/softened on the edge of generated shadows.
Sample Buffers
The Sample Buffers setting can be set to values 1, 4 or 9, and represents the number of shadow buffers
that will be used when doing anti-aliasing on buffered shadows.
This option is used in special cases, like very small objects which move and need to generate really small
shadows (such as strands). It appears that normally, pixel width shadows don’t anti-alias properly, and
that increasing Buffer Size doesn’t help much.
So this option allows you to have a sort of extra sample pass, done above the regular one (the one
controlled by the Box / Tent / Gauss, Samples and Soft settings).
The default 1 value will disable this option.
Higher values will produce a smoother anti-aliasing - but be careful: using a Sample Buffers of 4 will
require four times as much memory and process time, and so on, as Bforartists will have to compute that
number of sample buffers.

“Irregular”

Buffer Shadow set to Irregular

Irregular shadow method is used to generate sharp/hard shadows that are placed as accurately as raytraced
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shadows. This method offers very good performance because it can be done as a multi-threaded process.
This method supports transparent shadows. To do so, you will first need to setup the shadow setting for the
object which will receive the transparent shadow. (Material –> Shadow –> Cat Buffer Shadows and Buffer
Bias)

Deep generation method

Buffer Shadow set to Deep

Deep Shadow buffer supports transparency and better filtering, at the cost of more memory usage and
processing time
Compress
Deep shadow map compression threshold.

Common options
The following settings are common to all buffered shadow generation method.
Bias
The Bias numeric field can have a value between 0.001 and 5.0. Bias is used to add a slight offset
distance between an object and the shadows cast by it. This is sometimes required because of inaccuracies
in the calculation which determines weather an area of an object is in shadow or not.
Making the Bias value smaller results in the distance between the object and its shadow being smaller. If
the Bias value is too small, an object can get artifacts, which can appear as lines and interference patterns
on objects. This problem is usually called “self shadowing”, and can usually be fixed by increasing the
Bias value, which exists for that purpose!
Other methods for correcting self shadowing include increasing the size of the Shadow Buffer Size or
using a different buffer shadow calculation method such as Classic-Halfway or Irregular.
Self shadowing interference tends to affect curved surfaces more than flat ones, meaning that if your
scene has a lot of curved surfaces it may be necessary to increase the Bias value or Shadow Buffer Size
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value.
Having overly large Bias values not only places shadows further away from their casting objects, but can
also cause objects that are very small to not cast any shadow at all. At that point altering Bias, Shadow
Buffer Size or Spot Size values, among other things, may be required to fix the problem.
Note
Finer Bias tuning
You can now refine the Bias value independently for each Material, using the Bias slider (Material menu,
Shadow panel). This value is a factor by which the Bias value of each Spot buffered shadows lamp is
multiplied, each time its light hits an object using this material. The 0.0 and 1.0 values are equivalent - they
do not alter the lamp’s Bias original value.
Clip Start & Clip End
When a Spot light with buffered shadows is added to a scene, an extra line appears on the Spot 3D view
representation.
The start point of the line represents Clip Start ‘s value and the end of the line represents Clip End ‘s
value. Clip Start can have a value between 0.1 and 1000.0, and Clip End, between 1.0 and 5000.0.
Both values are represented in Bforartists Units.
Clip Start indicates the point after which buffered shadows can be present within the Spot light area. Any
shadow which could be present before this point is ignored and no shadow will be generated.
Clip End indicates the point after which buffered shadows will not be generated within the Spot light area.
Any shadow which could be present after this point is ignored and no shadow will be generated.
The area between Clip Start and Clip End will be capable of having buffered shadows generated.
Altering the Clip Start and Clip End values helps in controlling where shadows can be generated. Altering
the range between Clip Start and Clip End can help speed up rendering, save memory and make the
resultant shadows more accurate.
When using a Spot lamp with buffered shadows, to maintain or increase quality of generated shadows, it
is helpful to adjust the Clip Start and Clip End such that their values closely bound around the areas
which they want to have shadows generated at. Minimizing the range between Clip Start and Clip End,
minimizes the area shadows are computed in and therefore helps increase shadow quality in the more
restricted area.
Autoclip Start & Autoclip End
As well as manually setting Clip Start and Clip End fields to control when buffered shadows start and
end, it is also possible to have Bforartists pick the best value independently for each Clip Start and Clip
End field.
Bforartists does this by looking at where the visible vertices are when viewed from the Spot lamp
position.
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Hints
Any object in Bforartists can act as a camera in the 3D view. Hence you can select the Spot light and switch to a
view from its perspective by pressing Ctrl-Numpad0.

Spot Volumetric Effects

Spot lamps’s Halo options

Spot lights also can produce “volumetric” effects. See Volumetric Light for more information about what it
means.
Halo
The Halo button allows a Spot lamp to have a volumetric effect applied to it. This button must be active if
the volumetric effect is to be visible. Note that if you are using buffered shadows, you have extra options
described in the Spot Buffered Shadows page.
Intensity
The Intensity slider controls how intense/dense the volumetric effect is that is generated from the light
source. The lower the value of the Intensity slider, the less visible the volumetric effect is, while higher
Intensity values give a much more noticeable and dense volumetric effect.
Step
This field can have a value between 0 and 12. It is used to determine whether this Spot will cast
volumetric shadows, and what quality those volumetric shadows will have. If Step is set to a value of 0,
then no volumetric shadow will be generated. Unlike most other controls, as the Step value increases, the
quality of volumetric shadows decreases (but take less time to render), and vice versa.

Tip
Step values
A value of 8 for Halo Step is usually a good compromise between speed and accuracy.
Bforartists only simulates volumetric lighting in Spot lamps when using its internal renderer. This can lead to
some strange results for certain combinations of settings for the light’s Energy and the halo’s Intensity. For
example, having a Spot light with null or very low light Energy settings but a very high halo Intensity setting
can result in a dark/black halo, which would not happen in the real world. Just be aware of this possibility
when using halos with the internal renderer.
Note
The halo effect can be greatly enhanced when using buffered shadows: when the halo’s Step is not null, they
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can create “volumetric shadows”. See the page about Spot Buffered Shadows for more information.

See Also
• Shadows
• Spot Lamp
• Spot Buffered Shadows

Area
The Area lamp simulates light originating from a surface (or surface-like) emitter. For example, a TV screen,
your supermarket’s neon lamps, a window, or a cloudy sky are just a few types of area lamp. The area lamp
produces shadows with soft borders by sampling a lamp along a grid the size of which is defined by the user.
This is in direct contrast to point-like artificial lights which produce sharp borders.

Commons Options

Lamp options
Distance, Energy and Color
These settings are common to most types of lamps, and are described in Light Properties.
Note that the Distance setting is much more sensitive and important for Area lamps than for others;
usually any objects within the range of Distance will be blown out and overexposed. For best results, set
the Distance to just below the distance to the object that you want to illuminate.
Gamma
Amount to gamma correct the brightness of illumination. Higher values give more contrast and shorter
falloff.
The Area lamp doesn’t have light falloff settings. It uses an “inverse quadratic” attenuation law. The only
way to control its falloff is to use the Distance and/or Gamma settings.
This Layer Only, Negative, Specular and Diffuse
These settings control what the lamp affects, as described in What Light Affects.
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Shadows
Area light ray-traced shadows are described here: Raytraced Shadows.
When an Area light source is selected, the Shadow panel has the following default layout:
The Shadow panel when Area light source is selected.

Adaptive QMC settings

Constant Jittered settings

Area Shape
The shape of the area light can be set to Square or Rectangle.

Square options

Rectangle options

Square / Rectangular
Emit light from either a square or a rectangular area
Size / Size X / Size Y
Dimensions for the Square or Rectangle
Note
Shape Tips
Choosing the appropriate shape for your Area light will enhance the believability of your scene. For example,
you may have an indoor scene and would like to simulate light entering through a window. You could place a
Rectangular area lamp in a window (vertical) or from neons (horizontal) with proper ratios for Size X and Size
Y. For the simulation of the light emitted by a TV screen a vertical Square area lamp would be better in most
cases.
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Area Raytraced Shadows

Adaptive QMC settings

The Area light source can only cast ray-traced shadows. The ray-traced shadows settings of this lamp are mostly
shared with other lamps, as described in Raytraced Properties. However, there are some specifics with this
lamp, which are detailed below:

Shadow Samples
Samples
This have the same role as with other lamps, but when using a Rectangle Area lamp, you have two
samples settings: Samples X and Samples Y, for the two axes of the area plane. Note also that when using
the Constant Jittered sample generator method, this is more or less equivalent to the number of virtual
lamps in the area. With QMC sample generator methods, it behaves similarly to with Lamp or Spot lamps.

Sample Generator Types
Adaptive QMC / Constant QMC
These common setting are described in Shadow Properties.

Constant Jittered settings

Constant Jittered
The Area lamp has a third sample generator method, Constant Jittered, which is more like simulating an
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array of lights. It has the same options as the old one: Umbra, Dither and Jitter.
The following three parameters are only available when using the Constant Jittered sample generator
method, and are intended to artificially boost the “soft” shadow effect, with possible loss in quality:
Umbra
Emphasizes the intensity of shadows in the area fully within the shadow rays. The light transition
between fully shadowed areas and fully lit areas changes more quickly (i.e. a sharp shadow
gradient). You need Samples values equal to or greater than 2 to see any influence of this button.
Dither
Applies a sampling over the borders of the shadows, similar to the way anti-aliasing is applied by
the OSA button on the borders of an object. It artificially softens the borders of shadows; when
Samples is set very low, you can expect poor results, so Dither is better used with medium Samples
values. It is not useful at all with high Samples values, as the borders will already appear soft.
Jitter
Adds noise to break up the edges of solid shadow samples, offsetting them from each other in a
pseudo-random way. Once again, this option is not very useful when you use high Samples values
where the drawback is that noise generates quite visible graininess.

Technical Details

Principles behind the Area light

The (Principles behind the Area light) picture helps to understand how the soft shadows are simulated.
(a) is the Area light as defined in Bforartists. If its shape is Square, then the softness of the shadow is defined
by the number of light Samples in each direction of the shape. For example, (b) illustrates the equivalent case
of an Area light (Square shape), with Samples set at 3 on the Shadow and Spot panel.
The Area lamp is then considered as a grid with a resolution of three in each direction, and with a light
“dupliverted” at each node for a total of nine lights.
In case (a), the energy (E) is E/1, and in case (b), the energy of each individual pseudo-light is equal to E/
(Nbr of lights). Each pseudo-light produces a faint shadow (proportional to its energy), and the overlay
of the shadows produces the soft shadow (it is darker where the individual shadows overlap, and lighter
everywhere else).

Hints
You will note that changing the Size parameter of your area lamp doesn’t affect the lighting intensity of your
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scene. On the other hand, rescaling the lamp using the S in the 3D View could dramatically increase or decrease
the lighting intensity of the scene. This behavior has been coded this way so that you can fine tune all your light
settings and then decide to scale up (or down) the whole scene without suffering from a drastic change in the
lighting intensity. If you only want to change the dimensions of your Area lamp, without messing with its
lighting intensity, you are strongly encouraged to use the Size button(s) instead.
If your computer isn’t very fast, when using the Constant Jittered sample generator method, you could find it
useful to set a low Samples value (like 2) and activate Umbra, Dither, and/or Jitter in order to simulate slightly
softer shadows. However, these results will never be better than the same lighting with high Samples values.

Hemi Lamp

Hemi light conceptual scheme

The Hemi lamp provides light from the direction of a 180- hemisphere,
designed to simulate the light coming from a heavily clouded or otherwise uniform sky. In other words, it is a
light which is shed, uniformly, by a glowing dome surrounding the scene.
Similar to the Sun lamp, the Hemi ‘s location is unimportant, while its orientation is key.
The Hemi lamp is represented with four arcs, visualizing the orientation of the hemispherical dome, and a
dashed line representing the direction in which the maximum energy is radiated, the inside of the hemisphere.

Options

Hemi lamp’s panel

Energy and Color
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These settings are common to most types of lamps, and are described in Light Properties.
Layer, Negative, Specular, and Diffuse
These settings control what the lamp affects, as described in What Light Affects.
The Hemi lamp has no light falloff settings: it always uses a constant attenuation (i.e. no attenuation).
Since this lamp is the only lamp which cannot cast any shadow, the Shadow panel is absent.

Sun
A Sun lamp provides light of constant intensity emitted in a single direction. A Sun lamp can be very handy for
a uniform clear daylight open-space illumination. In the 3D view, the Sun light is represented by an encircled
black dot with rays emitting from it, plus a dashed line indicating the direction of the light.
This direction can be changed by rotating the Sun lamp, like any other object, but because the light is emitted in
a constant direction, the location of a Sun lamp does not affect the rendered result (unless you use the “sky &
atmosphere” option).

Sun lamp panel

Lamp options
Energy and Color
These settings are common to most types of lamps, and are described in Light Properties.
Negative, This Layer Only, Specular, and Diffuse
These settings control what the lamp affects, as described in What Light Affects.
The Sun lamp has no light falloff settings: it always uses a constant attenuation (i.e. no attenuation!).
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Sky & Atmosphere

Sky & Atmosphere panel

Various settings for the appearance of the sun in the sky, and the atmosphere through which it shines, are
available. For details, see Sky and Atmosphere.

Shadow

Shadow panel

The Sun light source can only cast ray-traced shadows. It shares with other lamp types the same common
shadowing options, described in Shadows Properties.
The ray-traced shadows settings of this lamp are shared with other lamps, and are described in Raytraced
Properties.

Raytraced Shadows
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Shadow panel

The Sun light source can only cast raytraced shadows. It shares with other lamp types the same common
shadowing options, described in Shadows Properties.
The raytraced shadows settings of this lamp are shared with other ones, and are described in Raytraced
Properties.

Sun: Sky & Atmosphere

Sky & Atmosphere panel

This panel allows you to enable an effect that simulates various properties of real sky and atmosphere: the
scattering of sunlight as it crosses the kilometers of air overhead. For example, when the Sun is high, the sky is
blue (and the horizon, somewhat whitish). When the Sun is near the horizon, the sky is dark blue/purple, and
the horizon turns orange. The dispersion of the atmosphere is also more visible when it is a bit foggy: the
farther away an object is, the more “faded” in light gray it is... Go out into the countryside on a nice hot day,
and you will see.
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To enable this effect, you have to use a Sun light source. If, as usual, the position of the lamp has no
importance, its rotation is crucial: it determines which hour it is. As a starting point, you should reset rotation of
your Sun (with Alt-R, or typing 0 in each of the three Rotation fields X / Y / Z in the Transform Properties
panel - N). This way, you’ll have a nice mid-day sun (in the tropics).
Now, there are two important angles for the Sky/Atmosphere effect: the “incidence” angle (between the light
direction and the X-Y plane), which determines the “hour” of the day (as you might expect, the default rotation
- straight down - is “mid-day”, a light pointing straight up is “midnight”, and so on...). And the rotation around
the Z axis determines the position of the sun around the camera.

The dashed “light line” of the Sun lamp crossing the camera focal point.

In fact, to have a good idea of where the sun is in your world, relative to the camera in your 3D view, you
should always try to have the dashed “light line” of the lamp crossing the center of the camera (its “focal”
point), as shown in (The dashed “light line” of the Sun lamp crossing the camera focal point). This way, in
camera view (Numpad0, center window in the example picture), you will see where the “virtual” sun created
by this effect will be.
It is important to understand that the position of the sun has no importance for the effect: only its orientation is
relevant. The position just might help you in your scene design.

Options
Sun & Sky Presets:
• Classic
• Desert
• Mountain

Sky
Sky
This button enables the sky settings: it will create a “sky”, with a “sun” if visible, and mix it with the
background as defined in World settings.
Turbidity
This is a general parameter that affects sun view, sky and atmosphere; it’s an atmosphere parameter where
low values describe clear sky, and high values shows more foggy sky. In general, low values give a clear,
deep blue sky, with “little” sun; high values give a more reddish sky, with a big halo around the sun. Note
that this parameter is one which can really modify the “intensity” of the sun lighting. See examples below.
Here are its specific controls:
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Blending
The first drop-down list shows you a menu of various mix methods. The one selected will be used
to blend the sky and sun with the background defined in the World settings. The mixing methods are
the same as described e.g. in the Mix Compositing Node page.
Factor
Controls how much the sky and sun effect is applied to the World background.
Color space
These buttons allows you to select which color space the effect uses, with the following choices:
•
•
•
•

CIE
REC709
SMPTE
Exposure

This numeric field allows you to modify the exposure of the rendered Sky and Sun (0.0 for no
correction).
Horizon
Brightness
Controls brightness of colors at the horizon. Its value should be in the range 0.0 to 10.0; values
near zero means no horizontal brightness, and large values for this parameter increase horizon
brightness. See examples below.
Spread
Controls spread of light at the horizon. Its value should be in the range 0.0 to 10.0; values low in
the range result in less spread of light at horizon, and values high in the range result in horizon light
spread in through all the sky.
Sun
Brightness
Controls the sun brightness. Its value should be in the range 0.0 to 10.0; with low values the sky
has no sun and with high values the sky only has sun.
Size
Controls the size of sun. Its values should be in the range 0.0 to 10.0, but note that low values
result in large sun size, and high values result in small sun size. Note that the overall brightness of
the sun remains constant (set by Brightness), so the larger the sun (the smaller Size), the more it
“vanishes” in the sky, and vice versa.
Back Light
For “Back Scatter Light”, result on sun’s color, high values result in more light around the sun. Its
values range is -1.0 to 1.0. Negative values result in less light around sun.

Atmosphere
Atmosphere
This button enables the atmosphere settings. It will not modify the background, but it tries to simulate the
effects of an atmosphere: scattering of the sunlight in the atmosphere, its attenuation, ...
Intensity
Sun
Sets sun intensity. Its values are in range 0.0 to 10.0. High values result in bluer light on far
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objects.
Distance
This factor is used to convert Bforartists units into an understandable unit for atmosphere effect, it
starts from 0 and high values result in more yellow light in the scene.
Scattering
Inscattering
This factor can be used to decrease the effect of light inscattered into atmosphere between the
camera and objects in the scene. This value should be 1.0 but can be changed to create some nice,
but not realistic, images.
Extinction
This factor can be use to decrease the effect of extinction light from objects in the scene. Like
Inscattering factor, this parameter should be 1.0 but you can change it; low values result in less
light extinction. Its value is in the range 0.0 to 1.0.

Examples
First, let’s see what happens when we modify the orientation of the sun:
Variations in Sun orientation, Sun Size to 5.0, all other settings to default.

With sun right overhead (mid-day).

With sun deep “under the Earth” (midnight).

Sun slightly above the horizon (start of twilight).

Sun slightly below the horizon (end of twilight).

The 2.4 .blend file of these examples.
And now, the effects of various settings (examples created with this 2.4 .blend file):
Variations in Turbidity parameter, all other settings to default.
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Turbidity: 2.0.

Turbidity: 2.3.

Turbidity: 5.0.

Turbidity: 10.0.

Sky
Variations in Horizon Brightness parameter, all other settings to default.

Horizon Brightness: 0.0.

Horizon Brightness: 0.85.
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Horizon Brightness: 1.04.

Horizon Brightness: 1.13.
Variations in Horizon Spread parameter, all other settings to default.

Horizon Spread: 0.7.

Horizon Spread: 1.2.

Horizon Spread: 2.2.

Horizon Spread: 5.0.
Variations in Sun Brightness parameter, all other settings to default.

Sun Brightness: 0.2.

Sun Brightness: 0.5.

55

Bforartists Reference Manual - © Copyright - This page is under OCL license

Sun Brightness: 0.75.

Sun Brightness: 1.0.
Variations in Sun Size parameter, all other settings to default.

Sun Size: 2.0.

Sun Size: 4.0.

Sun Size: 7.0.

Sun Size: 10.0.
Variations in Back Light parameter, Sun Bright to 2.5, all other settings to default.
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Back Light: -1.0.

Back Light: -0.33.

Back Light: 0.33.

Back Light: 1.0.

Atmosphere
For all renders below, Hor.Bright is set to 0.2, and Sun Bright to 2.0.
Variations in Sun Intensity parameter, all other settings to default.

Sun Intensity: 1.0.

Sun Intensity: 3.33.

Sun Intensity: 6.66.

Sun Intensity: 10.0.
Variations in Inscattering parameter, all other settings to default.
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Inscattering: 0.1.

Inscattering: 0.33.

Inscattering: 0.66.

Inscattering: 1.0.
Variations in Extinction parameter, all other settings to default.

Extinction: 0.0.

Extinction: 0.33.

Extinction: 0.66.

Extinction: 1.0.
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Variations in Distance parameter, all other settings to default.

Distance: 1.0.

Distance: 2.0.

Distance: 3.0.

Distance: 4.0.

Hints and limitations
To always have the Sun pointing at the camera center, you can use a TrackTo constraint on the sun object, with
the camera as target, and -Z as the “To” axis (use either X or Y as “Up” axis). This way, to modify
height/position of the sun in the rendered picture, you just have to move it; orientation is automatically handled
by the constraint. Of course, if your camera itself is moving, you should also add e.g. a Copy Location
constraint to your Sun lamp, with the camera as target - and the Offset option activated... This way, the sun light
won’t change as the camera moves around.
If you use the default Add mixing type, you should use a very dark-blue world color, to get correct “nights”...
This effect works quite well with a Hemi lamp, or some ambient occlusion, to fill in the Sun shadows.
Atmosphere shading currently works incorrectly in reflections and refractions and is only supported for solid
shaded surfaces. This will be addressed in a later release.

Lighting Rigs
A rig is a standard setup and combination of objects; there can be lighting rigs, or armature rigs, etc. A rig
provides a basic setup and allows you to start from a known point and go from there. Different rigs are used for
different purposes and emulate different conditions; the rig you start with depends on what you want to convey
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in your scene. Lighting can be very confusing, and the defaults do not give good results. Further, very small
changes can have a dramatic effect on the mood and colors.
In all the lighting rigs, the default camera is always positioned nearly 15 degrees off dead-on, about 25 BU
(Bforartists Units) back and 9 BU to the side of the subject, at eye level, and uses a long lens (80mm). Up
close, a 35mm lens will distort the image. A long lens takes in more of the scene. A dead-on camera angle is too
dramatic and frames too wide a scene to take in. So now you know; next time you go to a play, sit off-center
and you won’t miss the action happening on the sidelines and will have a greater appreciation for the depth of
the set. Anyway, enough about camera angles; this is about lighting.

Environment or Ambient Only

Environment (Ambient) lighting only.

In the World context, there is a panel Environment Lighting, where you enable environment or ambient lighting
of your scene. Ambient light is the scattered light that comes from sunlight being reflected off every surface it
hits, hitting your object, and traveling to camera.

Ambient occlusion.

Ambient light illuminates, in a perfectly balanced, shadeless way, without casting shadows. You can vary the
intensity of the ambient light across your scene via ambient occlusion. The ambient color is a sunny white.

60

Bforartists Reference Manual - © Copyright - This page is under OCL license

Single Rig

Standard Spot light rig.

The sole, or key, spot light rig provides a dramatic, showy, yet effective illumination of one object or a few
objects close together. It is a single Spot light, usually with a hard edge. Halos are enabled in this render to
remind you of a smoky nightclub scene. It is placed above and directly in front of the subject; in this case 10
BU in front and 10 BU high, just like a stage, it shines down at about a 40 degrees angle. We use quadratic
attenuation.
You can make the spot wider by increasing Size Spot Shape and softening the edge by increasing Blend Spot
Shape, and parent it to the main actor, so that the spot follows him as he moves around. Objects close to the
main actor will naturally be more lit and your viewer will pay attention to them.
Moving this spot directly overhead and pointing down gives the interrogation effect. At the opposite end of the
show-off emotional spectrum is one soft candlelight (Point lamp, short falloff Distance, yellow light) placed
really up close to the subject, dramatizing the fearful “lost in the darkness” effect.
Somewhere in the macabre spectrum is a hard spot on the floor shining upward. For fun, grab a flashlight, head
into the bathroom and close the door. Turn out the light and hold the flashlight under your chin, pointing up.
Look in the mirror and turn it on. Ghoulies! Don’t blame me for nightmares, and I hope you get the point:
lighting, even with a single light, varying the intensity, location and direction, changes everything in a
scene.
Use this rig, with Environment Lighting light (and props receiving and being lit by ambient light in their
material settings) for scenes that feature one main actor or a product being spotlighted. Do not use this rig for
big open spaces or to show all aspects of a model.

Two-Point Rig
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Standard two-point light rig.

The two-point lighting rig provides a balanced illumination of an object. Shown to the right are the views of the
standard two-point lighting rig. It is called the two-point because there are two points of light. The standard
two-point lighting rig provides a balanced illumination of untextured objects hanging out there in 3D space.
This rig is used in real studios for lighting a product, especially a glossy one.
Both lights are almost the same but do different things. Both emulate very wide, soft light by being Hemi. In
real life, these lights bounce light off the inside of a silver umbrella.
Notice how we use low Energy to bring out the dimensionality of the sphere; I can’t stress that enough. Hard,
bright lights actually flatten it and make you squint. Soft lights allow your eye to focus. We disable specular for
right Hemi, so we don’t get that shiny forehead or nose.
The lamp on the left however, lets it be known that it is there by enabling specular; specular flare is that bright
spot that is off center above midline on the sphere.
Use this rig to give even illumination of a scene, where there is no main focus. The Hemi ‘s will light up
background objects and props, so Environment Lighting is not that important. At the opposite end of the lighting
spectrum, two narrow Spot lights at higher power with a hard edge gives a “This is the Police, come out with
your hands up” kind of look, as if the subject is caught in the crossfire.

Three-Point Rigs
The standard three-point lighting rig is the most common illumination of objects and scenes bar none. If you
want to show off your model, use this rig. As you can see, the untextured unmaterialized sphere seems to come
out at you. There are multiple thesis on this rig, and you will use one of two:
• Studio - used in a real studio to film in front of a green screen or backdrop. Use this rig when you are
rendering your CG objects to alpha into the scene so that the lighting on the actors and your CG objects
is the same.
• Standard - used in real life to light actors on a set, and gives some backlighting to highlight the sides of
actors, making them stand out more and giving them depth.

Studio rig

Studio three-point light rig.

Shown to the right are the “Studio” top, front, and side views of the standard three-point lighting rig. It changes
the dynamics of the scene, by making a brighter “key” light give some highlights to the object, while two side
“fill” lights soften the shadows created by the key light.
62

Bforartists Reference Manual - © Copyright - This page is under OCL license

In the studio, use this rig to film a talking head (actor) in front of a green screen, or with multiple people,
keeping the key light on the main actor. This rig is also used to light products from all angles, and the side fill
lights light up the props.
The key light is the Area light placed slightly above and to the left of the camera. It allows the specular to come
out. It is about 30 BU back from the subject, and travels with the camera. A little specular shine lets you know
there’s a light there, and that you’re not looking at a ghost. In real life, it is a spot with baffles, or blinders, that
limit the area of the light.
The two sidelights are reduced to only fill; each of them are Hemi lights placed 20 BU to the side and 5 BU in
front of the subject, at ground level. They don’t cause a spotshine on the surface by disabling specular, and at
ground level, light under the chin or any horizontal surfaces, countering the shadows caused by the key light.
Use this rig to give balanced soft lighting that also highlights your main actor or object. It combines the best of
both the single rig and the two-point rig, providing balanced illumination and frontal highlights. For a wide
scene, you may have to pull the sidelights back to be more positioned like the two-point rig.

Standard Rig

Standard three-point light rig.

Without a curtain in back of your main subject, you have depth to work with. The left fill light has been moved
behind the subject (so it is now called a backlight) and is just off-camera, while the right side fill light remains
the same. The keylight gives you specular reflection so you can play with specularity and hardness in your
object’s material settings. The key light gives that “in-the-spotlight” feel, highlighting the subject, while the
backlight gives a crisp edge to the subject against the background. This helps them stand out.
In this rig, the key light is a fairly bright spot light. Use a slighter tinge of yellow because the light is so bright;
it is the only light for that side. The other sidelight has been moved in back and raised to eye (camera) level.
You need to cut the energy of the backlight in half, or when it is added to the remaining sidelight, it will light up
the side too much and call too much attention to itself. You can vary the angle and height of the backlight to
mimic a sun lighting up the objects.
Use this rig in normal 3D animations to light the main actor. Use this rig especially if you have transparent
objects (like glass) so that there is plenty of light to shine through them to the camera. The tricky part here is
balancing the intensities of the lights so that no one light competes with or overpowers the others, while making
sure all three work together as a team.
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Four-point Rig

Four-point light rig.

The four-point lighting rig provides a better simulation of outside lighting, by adding a Sun lamp 30 Bforartists
Units above, 10 to the side, and 15 BU behind the subject. This sunlight provides backlighting and fills the top
of the subject; even producing an intentional glare on the top of their head, telling you there is a sun up there.
Notice it is colored yellow, which balances out the blue sidelights.
Changing the key light to a Spot, select Inverse Square, disable Specular and pure white light combines with
and softens the top sun flare while illuminating the face, resulting in a bright sunshine effect. Two lights above
means sharper shadows as well, so you might want to adjust the side fill lights. In this picture, they are still
Hemi, disable Specular.
Use this rig when the camera will be filming from behind the characters, looking over their shoulder or
whatnot, because the sun provides the backlight there. Also use this rig when you have transparent objects, so
there is light to come through the objects to the camera.
Another spot for the fill light is shining up onto the main actor’s face, illuminating the underside of his chin and
neck. This gets rid of a sometimes ugly shadow under the chin, which if not corrected, can make the actor look
fat or like they have a double chin; otherwise distracting. It evens out the lighting of the face.

Troubleshooting
If you run into a problem with your render, where there are really bright areas, or really dark ones, or strange
shadows, or lines on your objects, here is what I suggest you do:
• First, try deactivating all materials (create a default, gray one, and enter its name in the Mat field, Layer
panel, Render Layers context - to get back all your normal materials, just erase this text field!). See if
you get those problems with just grayness objects. If you don’t have the problem anymore, that should
tell you that you’ve got a materials-interacting-with-light problem. Check the material settings,
especially ambient, reflection and all those little buttons and sliders in the Material context. You can set
some lights to affect only certain materials, so if there’s an issue with only a few objects being really
bright, start with those.
• Then start “killing” lights (e.g. moving them to an unused layer); regress all the way back to one light,
make sure it’s smooth, then add them in one by one. As they add together, reduce power in the tested
ones so they merge cleanly, or consider not adding it at all, or, especially, reduce the energy of the lamp
you just introduced.
• You can also set lights to only light objects on a layer, so again, if some of the gray spheres have
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weirdness, check for that as well. Again, you may have done some of this accidentally, so sometimes
deleting the light and re-adding it with defaults helps you reset to a known-good situation.
• Negative lights can be very tricky, and make your model blotchy, so pay special attention to your use of
those special lights. Shadow-only lights can throw off the look of the scene as well. Overly textured
lights can make your scene have random weird colors. Don’t go too far off a slight tinge of blue or
yellow or shades of white, or your material may show blue in the Material context but render green, and
you will be very confused.
• Look at your environment settings World context: Horizon, Zenith, and Environment Lighting.

Environment Lighting
Environment light provides light coming from all directions.
Light is calculated with a ray-traced method which is the same as that used by Ambient Occlusion. The
difference is that Environment lighting takes into account the “ambient” parameter of the material shading
settings, which indicates the amount of ambient light/color that that material receives.

Environment Lighting panel.

Also, you can choose the environment color source (white, sky color, sky texture) and the light energy.
Energy
Defines the strength of environment light.
Environment Color
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Defines where the color of the environment light comes from.
Using both settings simultaneously produces better global lighting.
It’s good for mimicking the sky in outdoor lighting. Environment lighting can be fairly noisy at times.

Ambient Occlusion
Ambient Occlusion is a sophisticated ray-tracing calculation which simulates soft global illumination shadows
by faking darkness perceived in corners and at mesh intersections, creases, and cracks, where ambient light is
occluded, or blocked.
There is no such thing as AO in real life; AO is a specific not-physically-accurate (but generally nice-looking)
rendering trick. It basically samples a hemisphere around each point on the face, sees what proportion of that
hemisphere is occluded by other geometry, and shades the pixel accordingly.
It’s got nothing to do with light at all; it’s purely a rendering trick that tends to look nice because generally in
real life surfaces that are close together (like small cracks) will be darker than surfaces that don’t have anything
in front of them, because of shadows, dirt, etc.
The AO process, though, approximates this result; it’s not simulating light bouncing around or going through
things. That’s why AO still works when you don’t have any lights in the scene, and it’s why just switching on
AO alone is a very bad way of “lighting” a scene.
You must have ray tracing enabled as a Render panel option in the Shading section for this to work.
You must have an ambient light color set as you desire. By default, the ambient light color (world) is black,
simulating midnight in the basement during a power outage. Applying that color as ambient will actually darken
all colors. A good outdoor mid-day color is RGB (0.9, 0.9, 0.8) which is a whitish yellow sunny kind of
color on a bright-but-not-harshly-bright day.

Options

The World panel with ambient color sliders highlighted.

Factor
The strength of the AO effect, a multiplier for addition.
Ambient Occlusion is composited during the render. Two blending modes are available:
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Add
The pixel receives light according to the number of non-obstructed rays. The scene is lighter. This
simulates global illumination.
Multiply
Ambient occlusion is multiplied over the shading, making things darker.

Note
If Multiply is chosen, there must be other light sources; otherwise the scene will be pitch black. In the other
two cases the scene is lit even if no explicit light is present, just from the AO effect. Although many people
like to use AO alone as a quick shortcut to light a scene, the results it gives will be muted and flat, like an
overcast day. In most cases, it is best to light a scene properly with Bforartists’s standard lamps, then use AO
on top of that, set to Multiply, for the additional details and contact shadows.

The Gather panel contains settings for the ambient occlusion quality. Note that these settings also apply to
Environment Lighting and Indirect Lighting.
Ambient occlusion has two main methods of calculation: Raytrace and Approximate.

Gather
Raytrace

The Amb Occ panel, Raytrace method.

The Raytrace method gives the more accurate, but also the more noisy results. You can get a nearly noiseless
image, but at the cost of render time... It is the only option if you want to use the colors of your sky’s texture.
Attenuation
Length of rays defines how far away other faces may be and still have an occlusion effect. The longer this
distance, the greater impact that far-away geometry will have on the occlusion effect. A high Distance
value also means that the renderer has to search a greater area for geometry that occludes, so render time
can be optimized by making this distance as short as possible for the visual effect that you want.
Sampling
Samples
The number of rays used to detect if an object is occluded. Higher numbers of samples give
smoother and more accurate results, at the expense of slower render times. The default value
of 5 is usually good for previews. The actual number of rays shot out is the square of this
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number (i.e. Samples at 5 means 25 rays). Rays are shot at the hemisphere according to a
random pattern (determined by the sample methods described above); this causes differences
in the occlusion pattern of neighboring pixels unless the number of shot rays is big enough to
produce good statistical data.

Ambient Occlusion with 3 Samples. Ambient Occlusion with 6 Samples. Ambient Occlusion with 12
Samples.

You have the three standard sampling options:
Constant QMC
The base Quasi-Monte Carlo, gives evenly and randomly distributed rays.
Adaptive QMC
An improved method of QMC, that tries to determine when the sample rate can be lowered or
the sample skipped, based on its two settings:
Threshold
The limit below which the sample is considered fully occluded (“black”) or un-occluded
(“white”), and skipped.
Adapt to Speed
A factor to reduce AO sampling on fast-moving pixels. As it uses the Vec render pass,
that must also be enabled (see render passes page).

Note
About QMC
See also the raytraced shadows page for more info about the Quasi-Monte Carlo sampling method.
Constant Jittered
The historical sample method, more prone to “bias” artifacts...
Bias
The angle (in radians) the hemisphere will be made narrower (i.e. the hemisphere will no longer be
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a real hemisphere: its section will no longer be a semicircle, but an arc of a circle of pi - bias
radians).
The bias setting allows you to control how smooth “smooth” faces will appear in AO rendering.
Since AO occurs on the original faceted mesh, it is possible that the AO light makes faces visible
even on objects with “smooth” on. This is due to the way AO rays are shot, and can be controlled
with the Bias slider. Note that while it might even happen with QMC sampling methods, it is much
more visible with the Constant Jittered one - and anyway, you have no Bias option for QMC.

24×24 UV Sphere with Bias: 0.05

Raising the Bias to 0.15 removes

(default). Note the facets on the

the faceted artifacts.

sphere’s surface even though it is
set to smooth.

Approximate

The Amb Occ panel, Approximate method.

The Approximate method gives a much smoother result for the same amount of render time, but as its name
states, it is only an approximation of the Raytrace method, which implies it might produce some artifacts - and
it cannot use the sky’s texture as the base color
This method seems to tend to “over-occlude” the results. You have two complementary options to reduce this
problem:
Passes
Set the number of pre-processing passes, between 0 (no pre-processing) to 10. Keeping the preprocessing passes high will increase render time but will also clear some artifacts and over-occlusions.
Error
This is the tolerance factor for approximation error (i.e. the max allowed difference between
approximated result and fully computed result). The lower, the slower the render, but the more accurate
the results... Ranges between 0.0 and 10.0, defaults to 0.250.
Pixel Cache
When enabled, it will keep values of computed pixels to interpolate it with its neighbors. This further
speeds up the render, generally without visible loss in quality...
Correction
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A correction factor to reduce over-occlusion. Ranges between 0.0 (no correction) to 1.0.

Common Settings
Falloff
When activated, the distance to the occluding objects will influence the “depth” of the shadow. This
means that the further away the occluding geometry is, the lighter its “shadow” will be. This effect only
occurs when the Strength factor is higher than 0.0. It mimics light dispersion in the atmosphere...
Strength
Controls the attenuation of the shadows enabled with Use Falloff. Higher values give a shorter
shadow, as it falls off more quickly (corresponding to a more foggy/dusty atmosphere). Ranges
from 0.0 (default, no falloff) to 10.0.

Technical Details
Ambient occlusion is calculated by casting rays from each visible point, and by counting how many of them
actually reach the sky, and how many, on the other hand, are obstructed by objects.
The amount of light on the point is then proportional to the number of rays which have “escaped” and have
reached the sky. This is done by firing a hemisphere of shadow rays around. If a ray hits another face (it is
occluded) then that ray is considered “shadow”, otherwise it is considered “light”. The ratio between “shadow”
and “light” rays defines how bright a given pixel is.

Hints
Ambient occlusion is a ray-tracing technique (at least with the Raytrace method), so it tends to be slow.
Furthermore, performance severely depends on octree size, see the rendering chapter for more information.

Indirect Lighting
Indirect Lighting adds indirect light bouncing of surrounding objects. It’s modes the light that is reflected from
other surfaces to the current surface. Is more comprehensive, more physically correct, and produces more
realistic images. It is also more computationally expensive. Take a look at the following examples of a scene lit
with Direct Lighting and both Direct+Indirect Lighting:
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Direct Lighting Schematic.

Direct Lighting Render
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Direct+Indirect Lighting Schematic

Direct+Indirect Lighting Render

Images courtesy of rastermon.com
Indirect Lighting only works with Approximate gather method.
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Indirect Lighting parameters.

Options
The Indirect Lighting panel contains two options:
Factor
Defines how much surrounding objects contribute to light.
Bounces
Number of indirect diffuse light bounces.
The Gather panel contains settings for the indirect lighting quality. Note that these settings also apply to
Environment Lighting and Ambient Occlusion.

Approximate

The Indirect Lighting panel, Approximate method.

The Approximate method gives a much smoother result for the same amount of render time, but as its name
states, it is only an approximation of the Raytrace method, which implies it might produce some artifacts - and
it cannot use the sky’s texture as the base color
This method seems to tend to “over-occlude” the results. You have two complementary options to reduce this
problem:
Passes
Set the number of pre-processing passes, between 0 (no pre-processing) to 10. Keeping the preprocessing passes high will increase render time but will also clear some artifacts and over-occlusions.
Error
This is the tolerance factor for approximation error (i.e. the max allowed difference between
approximated result and fully computed result). The lower, the slower the render, but the more accurate
the results... Ranges between 0.0 and 10.0, defaults to 0.250.
Pixel Cache
When enabled, it will keep values of computed pixels to interpolate it with its neighbors. This further
speeds up the render, generally without visible loss in quality...
Correction
A correction factor to reduce over-occlusion. Ranges between 0.0 (no correction) to 1.0.

Exposure and Range
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Reference
Mode: All modes
Panel: World (Shading context, World sub-context)

Description
Exposure and Range are similar to the “Color Curves” tool in Gimp or Photoshop.
These controls affect the rendered image, and the results are baked into the render. For information on
achieving similar affects with render controls, see Color Management and Exposure.
Previously Bforartists clipped color directly with 1.0 (or 255) when it exceeded the possible RGB space. This
caused ugly banding and overblown highlights when light overflowed (An overexposed teapot).
Using an exponential correction formula, this now can be nicely corrected.

Options

Exposure and Range sliders.

Exposure
The exponential curvature, with 0.0 being linear, and 1.0 being curved.
Range
The range of input colors that are mapped to visible colors (0.0 - 1.0).
So without Exposure we will get a linear correction of all color values:
Range` > 1.0
the picture will become darker; with Range = 2.0, a color value of 1.0 (the brightest by default) will be
clipped to 0.5 (half bright) (Range : 2.0).
Range` < 1.0
the picture will become brighter; with Range = 0.5, a color value of 0.5 (half bright by default) will be
clipped to 1.0 (the brightest) (Range : 0.5).

Examples
With a linear correction every color value will get changed, which is probably not what we want. Exposure
brightens the darker pixels, so that the darker parts of the image won’t be changed at all (Range : 2.0,
Exposure : 0.3).

74

Bforartists Reference Manual - © Copyright - This page is under OCL license

An overexposed teapot.

Range: 2.0.

Range: 0.5.

Range: 2.0, Exposure: 0.3.

Hints
Try to find the best Range value, so that overexposed parts are barely not too bright. Now turn up the Exposure
value until the overall brightness of the image is satisfying. This is especially useful with area lamps.
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World Panel

Bforartists provides a number of very interesting settings to complete your renderings by adding a nice
background, and some interesting ‘depth’ effects. These are accessible via the World context. By default a very
2
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plain uniform world is present. You can edit it or add a new World.
You have:
Background
The color and texture of the world background, with special settings for mapping coordinates.
Mist
Add a mist to your scene to enhance the feeling of depth.
While these world settings offers a simple way of adding effects to a scene, compositing nodes are often
preferred, though more complex to master, for the additional control and options they offer. For example,
filtering the Z value (distance from camera) or normals (direction of surfaces) through compositing nodes can
further increase the depth and spacial clarity of a scene.
Note
Some of the settings under the World panel in Bforartists affect lighting so you find them under the Lighting
chapter (see Ambient Light, Exposure and Ambient Occlusion). When using a Sun Lamp options for Sky &
Atmosphere are available in the Lamp menu.

World
A Sun lamp provides light of constant intensity emitted in a single direction. A Sun lamp can be very handy for
a uniform clear daylight open-space illumination. In the 3D view, the Sun light is represented by an encircled
black dot with rays emitting from it, plus a dashed line indicating the direction of the light.
This direction can be changed by rotating the Sun lamp, like any other object, but because the light is emitted in
a constant direction, the location of a Sun lamp does not affect the rendered result (unless you use the “sky &
atmosphere” option).

Sun lamp panel

Lamp options
Energy and Color
These settings are common to most types of lamps, and are described in Light Properties.
Negative, This Layer Only, Specular, and Diffuse
These settings control what the lamp affects, as described in What Light Affects.
The Sun lamp has no light falloff settings: it always uses a constant attenuation (i.e. no attenuation!).
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Sky & Atmosphere

Sky & Atmosphere panel

Various settings for the appearance of the sun in the sky, and the atmosphere through which it shines, are
available. For details, see Sky and Atmosphere.

Shadow

Shadow panel

The Sun light source can only cast ray-traced shadows. It shares with other lamp types the same common
shadowing options, described in Shadows Properties.
The ray-traced shadows settings of this lamp are shared with other lamps, and are described in Raytraced
Properties.

World Background
4
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Description
The world buttons let you set up the shading of your scene in general. It can provide ambient color, and special
effects such as mist, but a very common use of a World is to shade a background color.
Note
Background Image in Render
To use an image as your render background, see BackBuf images specified in the Output Panel
Note
Background Image in 3D
To use an image as a background image in your 3D view, for example as a reference when doing a model, see
using a Background Image

Options

World panel

Horizon Color
The RGB color at the horizon
Zenith Color
The RGB color at the zenith (overhead)
How these colors are interpreted depends on which kind of Sky is chosen.
None Enabled
If none of these three buttons is checked, your background will just be plain flat color (using the horizon
one).
Paper Sky
If this option is added, the gradient keeps its characteristics, but it is clipped in the image (it stays on a
horizontal plane (parallel to x-y plane): what ever the angle of the camera may be, the horizon is always
at the middle of the image).
Blend Sky
The background color is blended from horizon to zenith. If only this button is pressed, the gradient runs
from the bottom to the top of the rendered image regardless of the camera orientation.
Real Sky
If this option is added, the gradient produced has two transitions, from nadir (same color as zenith) to
horizon to zenith; the blending is also dependent on the camera orientation, which makes it more realistic.
The horizon color is exactly at the horizon (on the x-y plane), and the zenith color is used for points
vertically above and below the camera.
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Textures
Instead of a color, or blend of two colors, Bforartists can use an 2D image which it maps to a very large Box or
sphere which encompasses the entire scene, or which it maps to a virtual space around the scene.

Texture Coordinates pop-up menu

The World textures are accessible in the texture menu (just select World first, then Texture. They are used much
like the Materials textures, except for a couple of differences. The textures can be mapped according to:
View
The default orientation, aligned with the co-ordinates of the final render
Global
Uses global coordinates
AngMap
Used to wrap a standard hemisphere angular map around the scene in a dome. This can be used for image
based lighting with Ambient Occlusion set to sky color. You’ll generally need a high dynamic range image
(HDRI) angular map. (It will look like a weird spherical image).
Sphere
Sphere mapping, similar to that of materials
Tube
Wrap the rectangular texture around in a cylinder, similar to that of materials
Object
Position the texture relative to a specified object’s local texture space

Texture Influence panel

The texture affects color only, but in four different ways:
Blend
Makes the Horizon color appear where the texture is non-zero
Horizon
Affect the color of the horizon
Zenith Up
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Affect the zenith color overhead
Zenith Down
Affect the zenith color underneath
If you are disappointed that your camera appears to carry the texture with it rather than rotate through the
texture, you should check the Real Sky checkbox in the World tab of the Properties view.

Mist
Description
Mist can greatly enhance the illusion of depth in your rendering. To create mist, Bforartists makes objects
farther away more transparent (decreasing their Alpha value) so that they mix more of the background color
with the object color. With Mist enabled, the further the object is away from the camera the less it’s alpha value
will be.

Option

Mist panel

Mist check box
Toggles mist on and off
Minimum
An overall minimum intensity, or strength, of the mist.
Start
The distance from the camera at which the mist starts to fade in
Depth
The distance from Start of the mist, that it fades in over. Objects further from the camera than
Start+Depth are completely hidden by the mist.
Height
Makes the mist intensity decrease with height, for a more realistic effect. If greater than 0, it sets, in
Bforartists units, an interval around z=0 in which the mist goes from maximum intensity (below) to zero
(above).
Falloff
The decay rate of the mist (Quadratic / Linear / Inverse Quadratic). These settings control the rate of
change of the mist’s strength further and further into the distance.
Note
Mist distances
To visualize the mist distances in the 3D View, select your camera, go to the camera menu, and enable Show
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Mist.
The camera will show mist limits as a line projecting from the camera starting from Start and of distance
Depth.
To get a better view to evaluate the Mist visualization, Shift-Numpad1 with the camera selected
(Numpad5 to toggle perspective view on and off). This will place the 3D view right over the camera looking
down.

Transparency
Because Mist works by adjusting transparency, this can sometimes cause objects to be partially transparent
when they shouldn’t be. One workaround is to set the Mist settings as desired, but turn Mist off. The Mist data
is still available for compositing even though it is off. Use Do Composite and the Node Editor to feed the Mist
pass to an AlphaOver to blend the background color (or a render layer with just the sky) with the rendered
image. This produces the mist effect but since Mist is off the object transparency (or lack of) is preserved.

Examples

Mist example

In this example the Mist Height options has been limited to create smoke covering the floor.
This simple scene was inspired by Stefan Morell’s Arc Sci-Fi Corridor.
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10.2.5 Render - Blender Render Engine - Render Layers
Render Layers..........................................................................................................................................................1
Include Options...................................................................................................................................................1

Render Layers
This section covers only the Render Layer settings appropriate for the Bforartists Render engine. For the
engine-independent settings, see this section.
Light Override
Enter the name of a light group, and the scene will be lit with only those lights.
Examples of where this might be used:
• Using multiple Render Layers with different light group overrides can allow you to tweak light
intensity and color in the compositor (avoiding re-renders).
• Speed up a draft render by using only a few lights instead of all of them.

Include Options
Each render layer has its own set of features which can be enabled/disabled to save time and give you control
when working with passes:
Zmask
Only render what’s in front of the solid Z values.
Negate
Only render what’s Behind the solid Z values.
All Z
Z-values are computed for everything in view, not just those things that are rendered. When disabled,
objects not included in the render have no (“infinite”) z value.
Solid
Solid faces are rendered. All normal meshes are solid faced.
Halo
Halo materials are rendered.
ZTransp
Transparency may be Z-based or Ray-traced. If Z-based, enabling Ztra renders transparent areas with the
z-value of what is behind the transparent area.
Sky
Turning on Sky renders the sky, as defined in your material world settings. Otherwise, a black alpha
transparent background is rendered.
Edge
If Edge is enable in the Output panel, objects in this Render Layer are given an outline edge. Turning on
Edge pulls in the Edge settings from the Output tab, and adds an outline to the objects. Edges also have to
be enabled on the Output tab.
Strand
Strands are strings of static particles that are colored as part of the material settings; they look like strands
1
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of hair or grass.
Freestyle
Render the Freestyle strokes on this layer.
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10.2.6 Render - Blender Render Engine - Render Passes
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Render Passes
Render Passes are necessary because of the different things the Bforartists Render Engine must calculate to give
you the final image. In each ‘pass’ the engine calculates different interactions between objects.

Render Passes In Detail
Everything you see in a render must be calculated for the final image. All interactions between objects in your
scene, lighting, cameras, background images, world settings, etc., must all be separately calculated in different
passes for different reasons, such as calculating shadows.
In a render, every pixel has been calculated several times to make sure it will show the right color for the right
part of the image. Various things that are calculated in a standard render include:
• Where are shadows cast?
• How is ambient light in the environment blocked ( occluded ) by objects in the scene?
• How is light reflected off mirrored surfaces? Like shadows, lines are calculated, except this time they
come from the camera and bounce off mirrored surfaces, so that when these lines hit an object, the
engine calculates that this is what the camera should see.
• How is light bent ( refracted ) as is passes through transparent objects?
Does it go straight through? Does it bend? If so, at what depth in the object?
• What designated objects are in the scene, and what is their outline? Should the object appear blurred, or
should it appear in sharp focus?
• How fast is something moving ( velocity )?
Should it appear blurred given our frame rate or is it slow enough to still be focused on properly?
• How far away from the camera are objects’ surfaces ( Z-depth )?
Can the object’s surfaces be seen at all, or are they being blocked by another object’s geometry?
• Does an object have a normal vector (bumpmap)?
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Do shadows and apparent geometry need to be calculated for any objects?
• Is there any specularity ? Are objects with textures such as metal shiny at all?
The answer to each of the above questions is an image or map, as shown below:

Each Render Pass puts out an image or a map. For the purposes of this example, a Render Layer was defined to
produce all possible outputs. When a Render Layer input-node was added to the node diagram and the Render
Layer input-node was subsequently associated with the Render Layer, all of the layer’s outputs appeared as
connection points on the right-hand (output) side of the node.
Render Passes that produce Images can be directly viewed in a viewer, or, if they are the only pass that is
rendered, saved as the render image. If the pass is enabled, it can be saved in a multilayer OpenEXR format.
If the Render Pass output is not an image but is a map, it needs to be translated into something that we can see.
For example, the Z-depth map is an array of values that specifies how far away from the camera each pixel is;
values range between +/-3,000,000 Bforartists Units or so. The intermediate node you see above, between the
Render Layer output socket and the Viewer node input socket (such as Map Value) does this translation or
scaling. You must use that specific kind of translation node to get good results if you intend on operating on that
map as an image. You must then, after making any adjustments, run the map back through that node to re-scale
it back to the original before saving.

2

Bforartists Reference Manual - © Copyright - This page is under OCL license

Selecting Render Passes

Render Passes are the various distinct outputs that the renderer is able to generate. All of the following render
outputs are normally combined into a single output known, appropriately enough, as the Combined output. But
you can also select any of them to be output as a separate pass. (If you do so, in most cases you can choose
whether to also continue to include it in the Combined output.)
Some of these outputs must be enabled and used within your scene (and not just selected in the Render Layer
panel) in order to show anything. For example, if you do not have any lights in your scene, or those lights have
been set to not cast shadows, or objects in the limelight do not have materials which have been set to receive
shadows, the Shadow pass will be blank; there’s simply nothing to show you. If you have not enabled Ambient
Occlusion in your World environment settings, the AO pass will be blank, even if you select it here.
To save time and disk space, you have to tell Bforartists each of the passes to render in the Render Layers panel
(which we first introduced on the previous page):
Combined
This renders everything in the image, even if it’s not necessary. (“The whole enchilada,” so to speak.)
This is all the options below, blended into a single output, except those options which you’ve indicated
should be omitted from this pass, as indicated with the camera button.
Z
The Z-depth map; how far away each pixel is from the camera. Used for Depth-Of-Field (DOF). The
depth map is inverse linear (1/distance) from the camera clip start.
Vector
The direction and speed things are moving. Used with Vector Blur.
Normal
Calculates lighting and apparent geometry for a bumpmap (an image which is used to fake detail on an
object) or for changing the apparent direction of light falling on an object.
UV
Allows texturing after rendering. See UV node.
Mist
Deliver Mist factor pass.
Object Index
Masks selected objects. See MaskObj node.
Color
The color of materials without shading.
Diffuse
The diffuse shading of materials.
Specular
Specular highlights.
Shadow
Shadows cast. Make sure shadows are cast by your lights (positive or negative), and received by
materials. To use this pass, mix multiply it with the Diffuse pass.
3
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Emit
Emission pass.
AO
Ambient Occlusion. Make sure it’s turned on in your environment and that RayTracing is enabled.
Environment
Environment lighting.
Indirect
Indirect lighting pass.
Reflection
Reflection off mirrors and other reflective surfaces (highly waxed white floors, for example). Mix Add
this pass to Diffuse to use it.
Refraction
Refraction of colors through transparent meshes. Mix Add this pass to the Diffuse pass to use it.
When you enable a pass, the appropriate socket on the Render Layers node shows up like magic, and can be
used as shown in the example above.

Excluding Render Passes
As we said, the Combined output is an amalgam of several outputs which are also available separately. When
you select one of these outputs, they will be provided separately and also included in the Combined pass.
When you enable the Camera icon that is beside several of the pass options, the particular pass will be excluded
from the combined pass. They will be made available separately but not included in the combined pass.

Using Render Passes
The primary purpose of Render Passes is to enable you to process the various outputs in different ways, by
constructing networks of render nodes. You can achieve many special effects, and economize considerably on
the render times of complicated scenes, by creative and effective use of this facility. We’ll show you a few
examples of this in just a moment.
Quite a bit of information about the typical uses for some of the passes is discussed elsewhere:
•
•
•
•
•

Image: Since this is the main product, all of Bforartists uses it.
Alpha: See the AlphaOver node and all of the Matte nodes.
Z: See the Defocus node.
Vec: See the Vector Blur node.
Normal: See the Normal node.
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Recoloring Shadows

Let’s run the Shadow buffer through a colorization noodle, then recombine it; all your shadows will be
artificially colored. Lots of threads in this noodle are shown to the right, so let’s walk through it. On the left is
the Render Layer input node: it refers to one of the Render Layers that we have defined for our scene. In the
scene, we have a reflective ball on a pedestal standing in front of a backdrop. Everything (except the ball) is
gray. We use a standard four-light rig: backfill placed high, two sidefills at ground level, and a key light above
and to the left of camera. Suzanne, a monkey-shaped geometry, is standing in front of the key light, so her
shadow is cast into the scene on the floor. The ball casts shadows onto the backdrop and floor.
The output channels of the Render Layer node are determined by which buttons we selected when defining our
Render Layer. The top two viewers show you the image output using the Shadow as the Alpha channel, and the
node next to it just the Shadow channel. Where the Shadow is dark, the image in the left viewer is transparent.
We have used the Shadow to cut out parts of the image.
We then take the shadow through an RGB Curve, which is set to magnify just the Blue by 75%; so a gray
shadow of (R:40, G:40, B:40) becomes (R:40, G:40, B:40x1.75=70). That blue-tinged shadow is shown in the
bottom viewer. Now we have two options: AlphaOver and Mix. For either option:
• Use the Shadow map as a Factor.
• Feed the Blue Shadow to the Top Socket.
• Feed the core or base image to the Bottom Socket.
The resulting image is the same in either case; a blue shadow. Note that Suzanne’s reflection is not blue; there’s
a different Render Pass for that.
You could just as easily swap in another image entirely; for example, the shadow map from another render
layer. You can even take an image from another project entirely and use that instead (using the Image Input
node), to get a different effect. (For example, an effect similar to a Star Wars Episode One movie poster, where
Anakin Skywalker already casts the shadow of Darth Vader.)
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Compositing Ambient Occlusion

AO is a geometry-based dirt shader, making corners darker. It is separately enabled in the World settings and
computed as a separate pass. When enabled, it has one of three Modes (Add, Subtract, Both), and variable
Energy level (which changes the intensity of the shading). The third variable is the amount of Ambient light that
the material receives. If it does not receive any, then ambient occlusion does not affect it. Based on these
variables, Bforartists computes an AO pass. If you call it out as a separate pass and wish to composite it back
into your image, you will need to enable the Color and Diffuse pass as well.
To configure your noodle, consider the example image above.
• First, depending on the AO mode do one of the following: If AO mode is Add: directly use the AO pass.
If AO mode is Sub: Calculate AO - 1, or if AO mode is Both: Calculate 2*AO - 1.
• Multiply the output of Step 1 with the AO energy level.
• Multiply the output of Step 2 with the material’s ambience value. If you have materials which receive
different ambience light levels (0.5 is the default), one would have to create an ambience map based on
Object ID.
• Multiply the output of Step 3 with the color pass.
• Add the output of Step 4 to the diffuse pass.
If shadows, colored ambient light, specularity, reflections, and/or refractions are involved they have to be added
to the diffuse pass before adding the converted AO pass.

6

Bforartists Reference Manual - © Copyright - This page is under OCL license

Vector Blurring Shadows

When using Vector Blur instead of Motion Blur, objects in motion are blurred, but objects at rest (with respect
to the camera) are not blurred. The crossover is the shadow of the object in motion. Above, we have a cube in
motion across a ground plane. If we just ran the combined pass through Vector Blur, you can see the result in
the lower right-hand corner; the box is blurred, but its shadow is sharply in focus, and thus the image does not
look realistic.
Therefore, we need to separate out the diffuse and shadow passes from the floor by creating a “Floor” render
layer. That render layer has Diffuse and Shadow passes enabled, and only renders the floor object (layer 2).
Another render layer (“Cube”) renders the Z and Vector passes, and only renders the cube (on layer 1). Using
the Blur node, we blur the shadow pass, and then combine the diffuse and blurred shadow by multiplying them
together in a Mix Multiply node; we then have a blurred shadow on a crisp ground plane. We can then mix the
vector-blurred object to provide a realistic-looking image.

Conclusion
Render Passes can be manipulated to give you almost complete control over your final image. Causing objects
to cast shadows that aren’t really their shadows, making objects appear out of focus or sharply in focus like a
real camera, manipulating colors just for final post-processing or just reconfiguring your render passes to save
render time, are all things which you might wish to manipulate the render engine for.
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10.2.7 Render - Blender Render Engine - Motion Blur
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Motion Blur
Bforartists’s animations are by default rendered as a sequence of perfectly still images. While great for stopmotion and time-lapses, this is unrealistic, since fast-moving objects do appear to be blurred in the direction of
motion, both in a movie frame and in a photograph from a real-world camera.
Bforartists has two ways to achieve motion blur:

Sampled Motion Blur
Bforartists can be made to render the current frame and some more ‘virtual’ frames in between it and the next
frame, then merge them all together to obtain an image where moving objects are ‘blurred’.
This method is slow, but produces good results. It can be activated in the Sampled Motion Blur panel of the
render settings. This kind of motion blur is done during the render.
Motion Samples
Set the number of samples to take for each frame. The higher the samples, the smoother the blur effect,
but the longer the render, as each virtual intermediate frame has to be rendered.
Shutter
Time (in frames) the shutter is open. If you are rendering at 24 fps, and the Shutter is set to 0.5, the time
in between frames is 41.67 ms, so the shutter is open for half that, 20.83 ms.
Note
Samples are taken only from the next frame, not the previous one. Therefore the blurred object will appear to
be slightly ahead of how it would look without motion blur.

Vector Blur
Vector Blur is faster but sometimes has unwanted side-effects which are sometimes difficult to avoid.
Vector blur is a process done in compositing (post-render time), by rendering the scene without any blur, plus a
pass that has movement information for each pixel. This information is a vector map which describes a 2d or 3d
direction and magnitude. The compositor uses that data to blur each pixel in the given direction.

Examples
To better grasp the concept, let’s assume that we have a cube 2 units wide, uniformly moving 1 unit to the right
at each frame.
1
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Image 1 shows a render of frame 1 without Motion Blur; Image 2 shows a render of frame 2. The scale beneath
the cube helps in appreciating the movement of 1 Bforartists unit.

Image 1. Frame 1 of moving cube without Motion Blur.

Image 2. Frame 2 of moving cube without Motion Blur.

Image 3 shows the rendering of frame 1 when Sampled Motion Blur is enabled and 8 ‘intermediate’ frames are
computed. Shutter is set to 0.5 - thus the image 8 samples are rendered between frame 1 and halfway to frame
2.
Image 4 and Image 5 show the effect of increasing shutter values. A value greater than 1 is physically
impossible in a real-world camera, but can be used to exaggerate the effect.

Better results than those shown can be obtained by using higher samples than 8, but, of course, since as many
separate renders as samples are needed, a Motion Blur render takes that many times more time than a nonMotion Blur one.

Hints
Sampled Motion Blur can be used as an additional form of Anti-Aliasing, since aliasing artifacts are computed
differently for each sample and averaged together at the end.
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10.2.8 Render - Blender Render Engine - Anti-Aliasing
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Anti-Aliasing
A computer generated image is made up of pixels; each pixel can of course only be a single color. In the
rendering process the rendering engine must therefore assign a single color to each pixel on the basis of what
object is shown in that pixel. This often leads to poor results, especially at sharp boundaries, or where thin lines
are present, and it is particularly evident for oblique lines.
To overcome this problem, which is known as Aliasing, it is possible to resort to an Anti-Aliasing technique.
Basically, each pixel is ‘oversampled’, by rendering it as if it were 5 pixels or more, and assigning an ‘average’
color to the rendered pixel.
The buttons to control Anti-Aliasing, or OverSampling (OSA), are below the rendering button in the Render
Panel (Render Panel.).

Options
Anti-Aliasing (check box)
Enables oversampling
5 / 8 / 11 / 16
The number of samples to use. The values 5, 8, 11, 16 are preset numbers in specific sample patterns; a
higher value produces better edges, but slows down the rendering.
By default, we use in Bforartists a fixed “Distributed Jitter” table. The samples within a pixel are distributed
and jittered in a way that guarantees two characteristics:
• Each sample has equal distances to its neighbor samples
• The samples cover all sub-pixel positions equally, both horizontally and vertically
The images below show Bforartists sample patterns for 5, 8, 11 and 16 samples. To show that the distribution is
equalized over multiple pixels, the neighbor pixel patterns were drawn as well. Note that each pixel has an
identical pattern.
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5 samples

8 samples

11 samples

16 samples

Full Sample
For every anti-aliasing sample, save the entire Render Layer results. This solves anti-aliasing issues with
compositing.

Filtering
When the samples have been rendered, we’ve got color and alpha information available per sample. It then is
important to define how much each sample contributes to a pixel.
The simplest method is to average all samples and make that the pixel color. This is called using a “Box Filter”.
The disadvantage of this method is that it doesn’t take into account that some samples are very close to the edge
of a pixel, and therefore could influence the color of the neighbor pixel(s) as well.
Filter menu: Set The filter type to use to ‘average’ the samples:
Box
A low-quality box-shaped curve
Note
This filter is relatively low quality. you can see that only the samples within the pixel itself are added to
the pixel’s color. For the other filters, the formula ensures that a certain amount of the sample color gets
distributed over the other pixels as well.
Tent
A simplistic filter that gives sharp results
Quadratic
A Quadratic curve
Cubic
A Cubic curve
Gauss
Gaussian distribution, the most blurry
Catmull-Rom
Catmull-Rom filter, gives the most sharpening
Mitchell-Netravali
a good all-around filter that gives reasonable sharpness

Box

Tent

Quadratic
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Gaussian

Catmull-Rom

Mitchell-Netravali

Filter Size
Making the filter size value smaller will squeeze the samples more into the center, and blur the image more. A
larger filter size makes the result sharper. Notice that the last two filters also have a negative part; this will give
an extra sharpening result.

Examples

AA 8, Box filter
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AA 8, Tent filter

AA 8, Quadratic filter

AA 8, Cubic filter
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AA 8, Gaussian filter

AA 8, Catmull-Rom filter

AA 8, Mitchell-Netravali filter
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10.2.9 Render - Blender Render Engine - Edge (Toon) Rendering
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Edge (Toon) Rendering

A scene with Toon materials.

Bforartists’s toon shaders can give your rendering a comic-book-like or manga-like appearance, affecting the
shades of colors. The effect is not perfect since real comics and manga also usually have china ink outlines.
Bforartists can add this feature as a post-processing operation.

Options

Toon edge buttons.

Edge
This makes Bforartists search for edges in your rendering and add an ‘outline’ to them.

1
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Toon edge settings.

Before repeating the rendering it is necessary to set some parameters:
Threshold
The threshold of the angle between faces for drawing edges, from 0 to 255. A value of 10 would just give
outline of object against the background, whereas higher settings start to add outlines on surface edges,
starting with sharper angles. At maximum intensity, Edge will even faintly display geometry subsurf edge
lines in areas of imperfect smoothing.
Color / R/G/B
The color of the rendered edges (black by default). Click on the swatch to see the color picker

Examples

Scene re-rendered with toon edge set.
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Post-processing Edge and Renderlayers

It is possible to separate out the edge layer using a render layer dedicated to that purpose. The alpha channel is
0 where there is no edge, and 1 where the edge is. By separating out the edge layer, you can blur it, change its
color, mask it, etc. The image to the right shows how to do this. I created an Edge render layer that only has the
Sky and Edge layers (I included sky so that we get the world color later on in the composite output). The other
render layer omits the Edge layer, so it returns just the normal image. On the output panel I enabled Edge with a
width of 10 in black. I run that layer through a blur node. Using the Alphaover node, I then composite the cube
on top of the blurred edge. The result gives a soft-shadow kind of effect. Note that Premultiply is set because
the Edge image already has an alpha of 1.0 set.

3

Bforartists Reference Manual - © Copyright - This page is under OCL license

10.2.10 Render - Blender Render Engine - Render Quality
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Render Quality
Many factors go into the quality of the rendered image. Rendering a scene without changing any of the render
settings is probably going to produce a rather unpleasant image. In previous chapters, you have learned how to
model, shade, texture, and light scenes. Optimizing settings with respect to those areas will help to produce
quality images, but there are some important settings that come into play before pressing the render button.
These can directly affect the look of the rendered image.
The next section covers render layers and render passes, both of which allow you to compose an image from
several elements of a scene. In some cases it is necessary to render effects straight out of the renderer, rather
than creating them in “post.”

Color Management and Exposure
One important aspect of 3D rendering that is often overlooked is color management. Without color
management, or more commonly, linear rendering, render engines interpret scene lighting correctly, but display
them incorrectly on your monitor. Bforartists simplifies this workflow, but it is important to know how the color
space of a rendered image factors into your pipeline.

Anti-Aliasing
Anti-Aliasing removes jagged edges that appear in contrasting areas of color. This is a very important aspect of
render quality. Without this render setting, images usually appear particularly CG and amateur.

Exposure (Lighting)
Exposure is, in physical terms, the length of time a camera’s film or sensor is exposed to light. Longer exposure
times create a brighter image. In CG, the recorded light values are offset to simulate longer or shorter
exposures. This can be achieved through lighting settings, or better, through Color Management settings

Motion Blur
Cameras have a certain shutter speed, or the length of time the film is exposed to the image. Things that are in
motion while the picture is taken will have some degree of blurring. Faster-moving objects will appear more
blurred than slower objects. This is an important effect in CG because it is an artifact that we expect to see, and
when it is missing, an image may not be believable.
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Performance Considerations
Optimizing Render Performance
“A watched pot never boils” is the old saying, but you may wonder why your render takes so long to create, or
worse, crashes mid-way through! Well, there is lots going on and lots you can do to speed up rendering or
enable a complicated render to complete. Also, it is possible to render a very complicated scene on a mediocre
PC by being “render-smart”. Here’s a “top ten” list of things to do or not do in order to speed up rendering or
even avoid crashes during scene render. Some options may decrease the quality of your render, but for draft
renders you may not care.
If you get the message “Malloc returns nil”, in plain English that means the memory allocator tried to get more
physical memory for Bforartists but came back empty-handed. This means that you do not have enough
memory available to render the scene, and Bforartists cannot continue. You will need to do one or more of the
following tasks on this page in order to render.

Hardware Improvements
•
•
•
•
•

Install more system memory.
Upgrade your CPU to a multi-core/multiprocessor
Upgrade your OpenGL video drivers
Get faster memory, up to your PC’s motherboard limit.
Use or set up a render farm using all available PCs in your house, or use a render farm.

Operating System Configuration
• Increase Bforartists’s processing priority through your OS.
• Increase your swap file space used by the OS for memory swapping. Also called virtual memory
pagefile size, up to the size of your physical memory.
• Use a system-monitor to check if any other processes are using significant CPU or RAM, which can be
closed.
• Render in background mode (from the command line), saves extra memory.
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Bforartists Settings
• Increase the MEM Cache Limit in the User Preferences System & OpenGL tab.
• Switch to an Orthographic camera, and render your own “parts” of the scene as separate images, and
then paste those parts together in GIMP. An old trick in making your own panorama with a real camera
is to take three or so pictures of a very wide (beach sunset) scene, where you take one picture, rotate to
the right, snap another, then another, and when you get the pictures developed, you overlap them to
make a very wide landscape image. Do the same in Bforartists: render out one shot to a file, then move
the camera to look at a different area of the scene, and render that shot. Each shot will be of a smaller
area and thus take in fewer polygons/faces. Be sure that when you position your camera that you snap
overlapping shots, so that you can then match them up. If you don’t want to use GIMP, you can use
compositing nodes and the Translate node to match them up in Bforartists.
• Minimize the render window (and Bforartists if rendering to an internal window). ATI users report
dramatic speedup on a per frame basis, which adds up over the frame range.
• Use the Big Render script to render sub-sections of the overall image, and then paste them together.

Scene and Specific Objects
• Remove lamps, or move them to unrendered layers, or tie them to layers.
• Turn off some lamp’s shadows, using only one or two main sun lamps to cast shadows. A few “shadows
only” lights will render faster than every light having shadows on.
• Use Buffer Shadows rather than ray-traced Shadows
• Bake your shadows using Render Baking Full Render bake on surfaces that do not move. Use that
texture for that mesh, then disable shadows for that material.
• Simplify meshes (remove polygons). The more vertices you have in camera, the more time it takes to
render.
• Remove Doubles, or use the Decimator mesh edit feature.
• Remove Subsurf and Multires modifiers.
• Delete backsides of meshes (removing unseen geometry).
• Render just a few objects at a time; in the beginning of your project, render the background objects and
sets that will not change and will always be in the background.
• Put the buildings on another layer, and through render layers, don’t render them. Then composite them
back in later.
• Make the camera static so that you can better accomplish the above two ideas.
• Avoid use of Area lights.
• Make materials Shadeless.
• Render Bake AO and textures, and then make those materials Shadeless.
• Decrease the Clip distance for spot lights.
• Decrease the Clip distance for the camera.
• Turn off world AO.
• Turn off Material SSS.
• Use smaller image textures. A 256x256 image takes only 1% of the memory that a 2k image does, often
with no loss of quality in the ultimate render.
• Reduce Subsurf. Each level quadruples (4x) the number of faces from the previous level.
• Reduce Multires.
2
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• Make a matte render of background objects, like buildings, and put the image of them on a billboard in
the scene instead of the object themselves. This will reduce vertex/face count.
• if you have lots of linked instances of an object, use DupliFaces, as these are instanced. If you have 100
of them, Bforartists will only store the geometry for 1 (Instances themselves take a small amount of
memory).

Render Settings
• Output Panel - Disable Edge rendering. - Save Buffers.
• Render to an Image Editor window, not a pop-up. Render Window.
• Use multiple Threads on a multi-core CPU (with multiple Parts).
• Render Layers Panel - Render only the Layers of interest. - Render with all lights set to one simple spot
(enter its name in the Light: field). - Render with one material override (enter its name in the Mat: field).
• Disable unnecessary Render Passes, such as Z, or only render the pass of interest, such as
Diffuse.
• Render Panel - Turn off Shadows. - Turn off Environment Mapping. - Turn off Panoramic Rendering. Turn off Raytracing. - Turn off SSS Subsurface Scattering. - Turn off or lower oversampling/aliasing
OSA. - Turn off or lower Motion Blur.
• Render in Parts. This will also allow you to render HUGE images on a weak PC. On a multi-core
PC, it will assign a thread to each part as well.
• Increase the octree resolution.
• Render at a percentage size of your final resolution (like 25%).
• Turn off Fields rendering.
• Use Border rendering to render a subset of the full image.
• Anim Panel
• Decrease the frame count of the animation (and use a lower framerate for the same duration of
animation). For example, render 30 frames at 10 frames per second for a 3-second animation,
instead of 75 frames at 25 frames per second.
• Bake Panel
• Bake Full Render - create a UV Texture that colors the objects based on materials, and then use
that UV Texture shadeless instead of the material.
• Bake Ambient Occlusion only.
• Bake textures for objects.
• Baking Normals or Displacement does not speed up render time, and are used for other things.
• Format Panel - Render at a lower resolution. Smaller pictures take less time to render. - Choose a faster
CODEC or CODEC settings. - Render in black and white (BW button). - If using FFMPEG, do not
activate Multiplex audio. - If using FFMPEG, Autosplit Output (Video panel button).
• Render only RGB if you just need color; the A channel (RGBA button) takes more memory and
is unused when saving a movie file.

Multi-Pass Compositing
Another strategy that can be used to address the problem of long (re-)render times is to structure your workflow
from the ground up so that you make aggressive use of compositing, as described in the “Post-Production”
section. In this approach, you break down each shot into components that can be rendered separately, then you
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combine those separately-rendered elements to achieve the finished clip. For instance:
• If the camera isn’t moving, then neither is the background: only a single frame is needed. (The same is
true of any non-moving object within the frame.) These individual elements, having been generated
once, can be re-used as many times as necessary over as many frames as necessary.
• Both shadows and highlights can be captured separately from the objects that are being illuminated or
shadowed, such that the intensity, color, and depth of the effect can be adjusted later without rerendering.
• Start by using lights that do not cast shadows. (Shadow calculations are big time-killers.) Then, use
“shadow-only” lights (which cast shadows, but do not cast light) to create shadows only where you
judge that they are actually necessary. (It is very often the case that only a few of the shadows which
could exist in the scene actually matter, and that the rest of them simply won’t be noticed.)
• Tricky lighting situations can be avoided by handling the objects separately, then combining the
individually-rendered clips and “tweaking” the result.
This is a very familiar idea. Modern sound recordings, for example, always use a “multi-track” approach.
Individual components of the song are captured separately and in isolation, then the components are “mixed”
together. The “final mix” then goes through additional processing stages, called mastering, to produce the
finished product(s). (In fact, the features and design of modern sound-processing software are directly
comparable to that of Bforartists’s node-based compositor.)
There are compelling advantages to this approach:
• You have options. If something is “not quite right,” you don’t necessarily have to start over from
scratch.
• In practice, the deadline-killer is re- rendering, which ordinarily must be done (in its entirety) just
because “‘one little thing’ about the shot is wrong.” Compositing helps to avoid this, because (ideally...)
only the specific parts that are found to be in error must be repeated. (Or, maybe, the error can be
blocked out with a “garbage matte” and a corrected version can be inserted in its place. No one will ever
know!)
• It’s also possible that you find yourself saying, “okay, that’s almost what I wanted, but now I’d like to
add this and maybe take away that.” A compositing-based approach enables you to do just that, and
furthermore, to do so non-destructively. In other words, having generated the “addition” (or the “mask”)
as a separate channel of information, you can now fine-tune its influence in the overall “mix, ” or even
change your mind and remove it altogether, all without permanently altering anything.
• By and large, these stages work two- dimensionally, manipulating what is by that time “a raster bitmap
with R, G, B, Alpha (transparency...) and Z-Depth information,” so they’re consistently fast.
• Since each discrete rendering task has been simplified, the computer can carry them out using much
fewer resources.
• The tasks can be distributed among several different computers ... even less-powerful ones
• “After all, the scene doesn’t actually have to be physically perfect, to be convincing. ” A compositingbased approach lets you take full advantage of this. You can focus your attention (and Bforartists’s) upon
those specific aspects of the scene which will actually make a noticeable difference. It is possible to save
a considerable amount of time by consciously choosing to exclude less-important aspects which
(although “technically correct”) probably won’t be noticed.
Of course, this approach is not without its own set of trade-offs. You must devise a workable asset-management
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system for keeping track of exactly what material you have, where it is, whether it is up-to-date, and exactly
how to re-create it. You must understand and use the “library linking” features of Bforartists to allow you to
refer to objects, nodes, materials, textures and scenes in a carefully-organized collection of other files. You need
to have a very clear notion, in advance, of exactly what the finished shot must consist of and what the task
breakdown must be. You must be a scrupulous note-taker and record-keeper. But sometimes this is the best way,
if not the only way, to accomplish a substantial production.
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10.3.1 Render - Cycles Render Engine - Introduction
Introduction.............................................................................................................................................................1

Introduction

Cycles is a unbiased* ray tracing renderer focused on interactivity and ease of use, while still supporting many
production features.
*A unbiased renderer fires rays wildly from the light source until you tell him to stop. It will not stop
automatically. But continue to fire rays until you tell him to stop. A biased renderer follows some special
algorithms when fiering the rays. And it stops at one point as done. Cycles is a special beast here. It's a unbiased
renderer with some bias algorithms to speed things up. This would normally qualify it as a biased renderer. But
it still mainly shows the behaviour of a unbiased renderer.
Cycles is bundled as an add-on that is enabled by default. To use Cycles, it must be set as the active render
engine. Bforartists comes with Cycles set as the default renderer. Once that is done, interactive rendering can be
started by setting a 3D view editor to draw mode Rendered using the render command from the file menu. The
render will keep updating as modifications are done, such as changing a material color, changing a lamp’s
intensity or moving objects around.
Cycles may be able to use your GPU to render. To see if and how you can use your GPU for rendering, see the
documentation on GPU Rendering.
See also
Developer documentation is also available.
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http://wiki.Bforartists.org/index.php/Dev:2.6/Source/Render/Cycles
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Materials
Materials define the appearance of meshes, curves and other objects. They consist of three shaders, defining the
appearance of the surface of the mesh, the volume inside the mesh, and displacement of the surface of the mesh.

Surface Shader
The surface shader defines the light interaction at the surface of the mesh. One or more BSDF s specify if
incoming light is reflected back, refracted into the mesh, or absorbed.
Emission defines how light is emitted from the surface, allowing any surface to become a light source.
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Volume Shader
When the surface shader does not reflect or absorb light, it enters into the volume. If no volume shader is
specified, it will pass straight through to the other side of the mesh.
If it is defined, a volume shader describes the light interaction as it passes through the volume of the mesh.
Light may be scattered, absorbed, or emitted at any point in the volume.
A material may have both a surface and a volume shader, or only one of either. Using both may be useful for
materials such as glass, water or ice, where you want some of the light to be absorbed as it passes through the
surface, combined with e.g. a glass or glossy shader at the surface.

Displacement
The shape of the surface and the volume inside it may be altered by displacement shaders. This way, textures
can then be used to make the mesh surface more detailed.
Depending on the settings, the displacement may be virtual, only modifying the surface normals to give the
impression of displacement, which is known as bump mapping, or a combination of real and virtual
displacement.

Energy Conservation
The material system is built with physics-based rendering in mind, cleanly separating how a material looks and
which rendering algorithm is used to render it. This makes it easier to achieve realistic results and balanced
lighting, though there are a few things to keep in mind.
In order for materials to work well with global illumination, they should be, speaking in terms of physics,
energy conserving. That means they cannot reflect more light than comes in. This property is not strictly
enforced, but if colors are in the range 0.0 to 1.0, and BSDF s are only mixed together with the Mix Shader
node, this will automatically be true.
It is however possible to break this, with color values higher than 1.0 or using the Add Shader node, but one
must be careful when doing this to keep materials behaving predictably under various lighting conditions. It can
result in a reflection adding light into the system at each bounce, turning a BSDF into a kind of emitter.

Displacement
Implementation not finished yet, marked as an experimental feature.
The shape of the surface and the volume inside its mesh may be altered by the displacement shaders. This way,
textures can then be used to make the mesh surface more detailed.
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Type

Depending on the settings, the displacement may be virtual, only modifying the surface normals to give the
impression of displacement, known as bump mapping, or a combination of real and virtual displacement. The
displacement type options are:
True Displacement
Mesh vertices will be displaced before rendering, modifying the actual mesh. This gives the best quality
results, if the mesh is finely subdivided. As a result this method is also the most memory intensive.
Bump Mapping
When executing the surface shader, a modified surface normal is used instead of the true normal. This is a
quick alternative to true displacement, but only an approximation. Surface silhouettes will not be accurate
and there will be no self-shadowing of the displacement.
Displacement + Bump
Both methods can be combined, to do displacement on a coarser mesh, and use bump mapping for the
final details.

Subdivision
Implementation not finished yet, marked as an experimental feature.
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When using True Displacement or Displacement + Bump and enabling Use Subdivision you can reduce the
Dicing Rate to subdivide the mesh. This only affects the render and does not show in the viewport (but does
show in Rendered Shading Mode). Displacement can also be done manually by use of the Displacement
Modifier.

Subdivision Off - On, Dicing Rate 1.0 - 0.3 - 0.05 (Monkeys look identical in viewport, no modifiers)

Surface
The surface shader defines the light interaction at the surface of the mesh. One or more BSDF s specify if
incoming light is reflected back, refracted into the mesh, or absorbed.
Emission defines how light is emitted from the surface, allowing any surface to become a light source.

Terminology
BSDF stands for bidirectional scattering distribution function.
It defines how light is reflected and refracted at a surface.
Reflection BSDF s
Reflect an incoming ray on the same side of the surface.
Transmission BSDF s
Transmit an incoming ray through the surface, leaving on the other side.
Refraction BSDF s are a type of Transmission,
Transmitting an incoming ray and changing its direction as it exits on the other side of the surface.

BSDF Parameters
A major difference from non-physically based renderers is that direct light reflection from lamps and indirect
light reflection of other surfaces are not decoupled, but rather handled using a single BSDF. This limits the
possibilities a bit, but we believe overall it is helpful in creating consistent-looking renders with fewer
parameters to tune.
For glossy BSDF s, roughness parameters control the sharpness of the reflection, from 0.0 (perfectly sharp) to
1.0 (very soft). Compared to hardness or exponent parameters, it has the advantage of being in the range
0.0..1.0, and as a result gives more linear control and is more easily textureable. The relation is roughly:
roughness = 1 - 1/hardness
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Volume
Volume rendering can be used to render effects like fire, smoke, mist, absorption in glass, and many other
effects that can’t be represented by surface meshes alone.
To set up a volume, you create a mesh that defines the bounds within which the volume exists. In the material
you typically remove the surface nodes and instead connect volume nodes to define the shading inside the
volume. For effects such as absorption in glass you can use both a surface and volume shader. The world can
also use a volume shader to create effects such as mist.

Volume Shaders
We support three volume shader nodes, that model particular effects as light passes through the volume and
interacts with it.
• Volume Absorption will absorb part of the light as it passes through the volume. This can be used to
shade for example black smoke or colored glass objects, or mixed with the volume scatter node. This
node is somewhat similar to the transparent BSDF node, it blocks part of the light and lets other light
pass straight through.
• Volume Scatter lets light scatter in other directions as it hits particles in the volume. The anisotropy
defines in which direction the light is more likely to scatter. A value of 0 will let light scatter evenly in
all directions (somewhat similar to the diffuse BSDF node), negative values let light scatter mostly
backwards, and positive values let light scatter mostly forward. This can be used to shade white smoke
or clouds for example.
• Emission will emit light from the volume. This can be used to shade fire for example.

Volume Shader: Absorption / Absorption + Scatter / Emission

Density
All volume shaders have a density input. The density defines how much of the light will interact with the
volume, getting absorbed or scattered, and how much will pass straight through. For effects such as smoke you
would specify a density field to indicate where in the volume there is smoke and how much (density bigger than
0), and where there is no smoke (density equals 0).
Volumes in real life consist of particles, a higher density means there are more particles per unit volume. More
particles means there is a higher chance for light to collide with a particle and get absorbed or scattered, rather
5

Bforartists Reference Manual - © Copyright - This page is under OCL license

than passing straight through.

Volume Material
Interaction with the Surface Shader
A material may have both a surface and a volume shader, or only one of either. Using both may be useful for
materials such as glass, water or ice, where you want some of the light to be absorbed as it passes through the
surface, combined with e.g. a glass or glossy shader at the surface.
When the surface shader does not reflect or absorb light, it enters into the volume. If no volume shader is
specified, it will pass straight through to the other side of the mesh. If it is defined, a volume shader describes
the light interaction as it passes through the volume of the mesh. Light may be scattered, absorbed, or emitted at
any point in the volume.

Mesh Topology
Meshes used for volume render should be closed and manifold. That means that there should be no holes in the
mesh. Each edge must be connected to exactly 2 faces such that there are no holes or T-shaped faces where 3 or
more faces are connected to an edge.
Normals must point outside for correct results. The normals are used to determine if a ray enters or exits a
volume, and if they point in a wrong direction, or there is a hole in the mesh, then the renderer is unable to
decide what is the inside or outside of the volume.
These rules are the same as for rendering glass refraction correctly.

Volume World
A volume shader can also be applied to the entirely world, filling the entire space.
Currently this is most useful for night time or other dark scenes, as the world surface shader or sun lamps will
have no effect if a volume shader is used. This is because the world background is assumed to be infinitely far
away, which is accurate enough for the sun for example. However for modeling effects such as fog or
atmospheric scattering, it is not a good assumption that the volume fills the entire space, as most of the distance
between the sun and the earth is empty space. For such effects it is be better to create a volume object
surrounding the scene. The size of this object will determine how much light is scattered or absorbed.

Smoke
Creating a smoke material for cycles can be difficult however the image below shows a good setup on how to
do this.
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Smoke and Fire Material

Scattering Bounces
Real world effects such as scattering in clouds or subsurface scattering require many scattering bounces.
However unbiased rendering of such effects is slow and noisy. In typical movie production scenes only 0 or 1
bounces might be used to keep render times under control. The effect you get when rendering with 0 volume
bounces is what is known as “single scattering”, the effect from more bounces is “multiple scattering”.
For rendering materials like skin or milk, the subsurface scattering shader is an approximation of such multiple
scattering effects that is significantly more efficient but not as accurate.
For materials such as clouds or smoke that do not have a well defined surface, volume rendering is required.
These look best with many scattering bounces, but in practice one might have to limit the number of bounces to
keep render times acceptable.

Limitations
Currently we do not support:
• Correct ray visibility for volume meshes
Not available on GPU:
• Smoke/Fire rendering
• Equi Angular / MIS Volume Sampling
• Volume Multi Light sampling

Texture Editing
3D viewport draw types, UV mapping, and texture painting work somewhat differently when Cycles is enabled.
UV Maps no longer get image textures assigned themselves; rather they must always be assigned by adding an
image texture node to a material.
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3D Viewport Draw Types
The Texture draw types used for Bforartists Internal have been replaced by three others in Cycles:
Texture
This draw mode is used for editing, painting and mapping individual textures. Lighting is the same as in
solid mode, so this is similar to the existing textured solid for Bforartists Internal. The texture drawn is
the active image texture node for the material.
Material
A simplified version of the entire material is drawn using GLSL shaders. This uses solid lighting, and also
is mostly useful for editing, painting and mapping textures, but while seeing how they integrate with the
material.
Rendered
In this draw mode the render engine does the drawing, interactively refining the full rendered image by
taking more samples. Unlike offline rendering, objects still use the viewport rather than render resolution
and visibility.

Texture Properties

In the texture properties, the texture can now be selected from a list that contains all texture nodes from the
world, lamps and materials, but also from e.g. modifiers, brushes and physics fields.
For shading nodes, the available textures are Cycles textures. For others, Bforartists textures are still used, but
this will change in the future.
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Painting & UV Editing

For texture paint mode, the image that is painted on is taken from the active image texture node. This can be
selected in the node editor or the texture properties, and it is indicated as blue in the material properties.
For UV mapping, the active UV map as specified in the mesh properties is used. Assigning images in the image
editor also affects the active image texture node.
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Lamps
Next to lighting from the background and any object with an emission shader, lamps are another way to add
light into the scene. The difference is that they are not directly visible in the rendered image, and can be more
easily managed as objects of their own type.
Type
Currently Point, Spot, Area and Sun lamps are supported. Hemi lamps are not supported, and will be
rendered as point and sun lamps respectively, but they may start working in the future, so it’s best not to
enable them to preserve compatibility.
Size
Size of the lamp in Bforartists Units; increasing this will result in softer shadows and shading.
Max Bounces
Maximum number of times light from the lamp is allowed to bounce. Limited by scene-wide bounce
settings
Cast Shadow
By disabling this option, light from lamps will not be blocked by objects in-between. This can speed up
rendering by not having to trace rays to the light source.

Point Lamp
Point lamps emit light equally in all directions. By setting the Size larger than zero, they become spherical
lamps, which give softer shadows and shading. The strength of point lamps is specified in Watts.

Spot Lamp
Spot lamps emit light in a particular direction, inside a cone. By setting the Size larger than zero, they can cast
softer shadows and shading. The size parameter defines the size of the cone, while the blend parameter can
soften the edges of the cone.

Area Lamp
Area lamps emit light from a square or rectangular area with a Lambertian distribution.

Light Portals
Area lamps can also function as light portals to help sample the environment light, and significantly reduce
noise in interior scenes. Note that rendering with portals is usually slower, but as it converges more quickly, less
samples are required.
1
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Light portals work by enabling the Portal option, and placing areas lamps in windows, door openings, and any
place where light will enter the interior.

Sun Lamp
Sun lamps emit light in a given direction. Their position is not taken into account; they are always located
outside of the scene, infinitely far away, and will not result in any distance falloff.
Because they are not located inside the scene, their strength uses different units, and should typically be set to
lower values than other lights.
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Introduction
Materials, lights and backgrounds are all defined using a network of shading nodes. These nodes output values,
vectors, colors and shaders.

Shaders
An important concept to understand when building node setups is that of the shader socket. The output of all
surface and volume shaders is a shader, describing lighting interaction at the surface or of the volume, rather
than the color of the surface.
There are a few types of shaders available as nodes:
•
•
•
•

BSDF shader describing light reflection, refraction and absorption at an object surface.
Emission shader describing light emission at an object surface or in a volume.
Volume shader describing light scattering inside a volume.
Background shader describing light emission from the environment.
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Each shader node has a color input, and outputs a shader. These can then be mixed and added together using
Mix and Add Shader nodes. No other operations are permitted. The resulting output can then be used by the
render engine to compute all light interactions, for direct lighting or global illumination.

Textures
Each texture type in Cycles corresponds to a node, with a texture coordinate and various parameters as input,
and a color or value as output. No texture data-blocks are needed; instead node groups can be used for reusing
texture setups.
For UV mapping and texture painting in the viewport, the Image texture node must be used. When setting such
a node as active, it will be drawn in Textured draw mode, and can be painted on in texture paint mode.
The default texture coordinates for all nodes are Generated coordinates, with the exception of Image textures
that use UV coordinates by default. Each node includes some options to modify the texture mapping and
resulting color, and these can be edited in the texture properties.

More
Nodes for geometric data, texture coordinates, layering shaders and non-physically based tricks.

Open Shading Language
Custom nodes can be written using the Open Shading Language.

Input Nodes
Camera Data
View Vector
A Camera space vector from the camera to the shading point.
View Z Depth
TODO
View Distance
Distance from the camera to the shading point.

Value
Input a scalar value.
Value
Value output.

RGB
Input an RGB color.
Color
3
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RGB color output.

Attribute
Retrieve attribute attached to the object or mesh. Currently UV maps and vertex color layers can be retrieved
this way by their names, with layers and attributes planned to be added. Also internal attributes like P
(position), N (normal), Ng (geometric normal) may be accessed this way, although there are more convenient
nodes for this.
Name
Name of the attribute.
Color output
RGB color interpolated from the attribute.
Vector output
XYZ vector interpolated from the attribute.
Fac output
Scalar value interpolated from the attribute.

Wireframe
Retrieve the edges of an object as it appears to cycles. As meshes are triangulated before being processed by
cycles, topology will always appear triangulated when viewed with the Wireframe node.
Pixel Size
When enabled, set the size of edge lines in screen space.
Size
Thickness of edge lines.
Fac output
Black and white mask showing white lines representing edges according to the object’s topology.

Geometry
Geometric information about the current shading point. All vector coordinates are in World Space. For volume
shaders, only the position and incoming vector are available.
Position
Position of the shading point.
Normal
Shading normal at the surface (includes smooth normals and bump mapping).
Tangent
Tangent at the surface.
True Normal
Geometry or flat normal of the surface.
Incoming
Vector pointing towards the point the shading point is being viewed from.
Parametric
Parametric coordinates of the shading point on the surface.
Backfacing
1.0 if the face is being viewed from the back side, 0.0 for the front side.
Pointiness
An approximation of the curvature of the mesh per-vertex. Lighter values indicate convex angles, darker
4
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values indicate concave angles.

Light Path
Node to find out for which kind of incoming ray the shader is being executed; particularly useful for nonphysically based tricks. More information about the meaning of each type is in the Light Paths documentation.
Is Camera Ray output
1.0 if shading is executed for a camera ray, 0.0 otherwise.
Is Shadow Ray output
1.0 if shading is executed for a shadow ray, 0.0 otherwise.
Is Diffuse Ray output
1.0 if shading is executed for a diffuse ray, 0.0 otherwise.
Is Glossy Ray output
1.0 if shading is executed for a glossy ray, 0.0 otherwise.
Is Singular Ray output
1.0 if shading is executed for a singular ray, 0.0 otherwise.
Is Reflection Ray output
1.0 if shading is executed for a reflection ray, 0.0 otherwise.
Is Transmission Ray output
1.0 if shading is executed for a transmission ray, 0.0 otherwise.
Ray Length output
Distance traveled by the light ray from the last bounce or camera.
Ray Depth
Number of times the ray has “bounced”, i.e. been reflected or transmitted on interaction with a surface.
Note
Passing through a transparent shader does not count as a normal “bounce”.

Transparent Depth
Number of times the ray has passed through a transparent shader.

Object Info
Information about the object instance. This can be useful to give some variation to a single material assigned to
multiple instances, either manually controlled through the object index, based on the object location, or
randomized for each instance. For example a Noise texture can give random colors or a Color ramp can give a
range of colors to be randomly picked from.
Location
Location of the object in world space.
Object Index
Object pass index, same as in the Object Index pass.transformed.
Material Index
Material pass index, same as in the Material Index pass.
Random
Random number unique to a single object instance.

5
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Fresnel
Dielectric fresnel, computing how much light is refracted through and how much is reflected off a layer. The
resulting weight can be used for layering shaders with the Mix Shader node. It is dependent on the angle
between the surface normal and the viewing direction.
IOR input
Index of refraction of the material being entered.
Fresnel output
Fresnel weight, indicating the probability with which light will reflect off the layer rather than passing
through.

Layer Weight
Output weights typically used for layering shaders with the Mix Shader node.
Blend input
Blend between the first and second shader.
Fresnel output
Dielectric fresnel weight, useful for example for layering diffuse and glossy shaders to create a plastic
material. This is like the Fresnel node, except that the input of this node is in the often more-convenient
0.0 to 1.0 range.
Facing output
Weight that blends from the first to the second shader as the surface goes from facing the viewer to
viewing it at a grazing angle.

Texture Coordinate
Commonly used texture coordinates, typically used as inputs for the Vector input for texture nodes.
Generated output
Automatically-generated texture coordinates from the vertex positions of the mesh without deformation,
keeping them sticking to the surface under animation. Range from 0.0 to 1. 0 over the bounding box of
the undeformed mesh.
Normal output
Object space normal, for texturing objects with the texture staying fixed on the object as it transformed.
UV output
UV texture coordinates from the active render UV map.
Object output
Position coordinate in object space.
Camera output
Position coordinate in camera space.
Window output
Location of shading point on the screen, ranging from 0.0 to 1. 0 from the left to right side and bottom to
top of the render.
Reflection output
Vector in the direction of a sharp reflection, typically used for environment maps.
Object
Specific object to use for object space coordinates. This only affects the Object output.
From Dupli
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If the material is applied to a dupli object, use texture coordinates from the parent object. This only affects
the Generated and UV outputs.

From left to right: Sphere with UV mapped texture. Small spheres duplicated to the faces of the textured sphere using
duplifaces. Small spheres with From Dupli enabled, using the UV map of the large sphere.

Note
From Dupli only works with the UV output when the dupli object is instanced from faces, either with
particles or duplifaces.

UV Map
Retrieve specific UV maps. Unlike the Texture Coordinate node which only provides the active UV map, this
node can retrieve any UV map belonging to the object using the material.
From Dupli
See the From Dupli option of the Texture Coordinate node.
UV Map
UV map to use.
UV output
UV mapping coordinates from the specified UV layer.

Particle Info
For objects instanced from a particle system, this node give access to the data of the particle that spawned the
instance.
Index
Index number of the particle (from 0 to number of particles).
Age
Age of the particle in frames.
Lifetime
Total lifespan of the particle in frames.
Location
Location of the particle.
Size
Size of the particle.
Velocity
Velocity of the particle.
Angular Velocity
Angular velocity of the particle.
7
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Hair Info
This node gives access to strand information.
Is strand
Returns 1 when the shader is acting on a strand, otherwise 0.
Intercept
The point along the strand where the ray hits the strand (1 at the tip and 0 at the root).
Thickness
The thickness of the strand at the point where the ray hits the strand.
Tangent Normal
Tangent normal of the strand.

Tangent
Generates a tangent direction for the Anisotropic BSDF.
Direction Type
The tangent direction can be derived from a cylindrical projection around the X, Y or Z axis (Radial), or
from a manually created UV Map for full control.
Tangent Output
The tangent direction vector.

Output Nodes
Output nodes are the final node in every node tree. Although you can add more than one, only one will be used
(indicated by a colored or darkened header). Output nodes are always preceded by Shaders except in the case of
the Displacement of a Material Output.

Material Output
Surface
The surface output of the material
Volume
Currently under independent development, does nothing
Displacement
Used to create bump mapping or actual subdivided Displacement

Lamp Output
Surface
Not an actual surface, but the final output of a Lamp Object

World Output
Surface
The appearance of the environment, usually preceded by a Background shader
Volume
Currently under independent development, does nothing
8
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Shader Nodes
Diffuse
Lambertian and Oren-Nayar diffuse reflection.
Color input
Color of the surface, or physically speaking, the probability that light is reflected or transmitted for each
wavelength.
Roughness input
Surface roughness; 0.0 gives standard Lambertian reflection, higher values activate the Oren-Nayar
BSDF.
Normal input
Normal used for shading; if nothing is connected the default shading normal is used.
BSDF output
Diffuse BSDF shader.

Diffuse behavior

Translucent
Lambertian diffuse transmission.
Color input
Color of the surface, or physically speaking, the probability that light is transmitted for each wavelength.
Normal input
Normal used for shading; if nothing is connected the default shading normal is used.
BSDF output
Translucent BSDF shader.
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Translucent Shader

Glossy
Glossy reflection with microfacet distribution, used for materials such as metal or mirrors.
Distribution
Microfacet distribution to use. Sharp results in perfectly sharp reflections like a mirror, while Beckmann,
GGX and Ashikhmin-Shirley can use the Roughness input for blurry reflections.
Color input
Color of the surface, or physically speaking, the probability that light is reflected for each wavelength.
Roughness input
Influences sharpness of the reflection; perfectly sharp at 0.0 and smoother with higher values.
Normal input
Normal used for shading; if nothing is connected the default shading normal is used.
BSDF output
Glossy BSDF shader.
Sharp Glossy

Rough Glossy

Anisotropic
Anisotropic glossy reflection, with separate control over U and V direction roughness. The tangents used for
shading are derived from the active UV map. If no UV map is available, they are automatically generated using
a sphere mapping based on the mesh bounding box.
Distribution
Microfacet distribution to use. Sharp results in perfectly sharp reflections like a mirror, while Beckmann,
GGX and Ashikhmin-Shirley can use the Roughness input for blurry reflections.
Color input
Color of the surface, or physically speaking, the probability that light is reflected for each wavelength.
Roughness input
Sharpness of the reflection; perfectly sharp at 0.0 and smoother with higher values.
10
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Anisotropy input
Amount of anisotropy in the reflection; 0.0 gives a round highlight. Higher values give elongated
highlights orthogonal to the tangent direction; negative values give highlights shaped along the tangent
direction.
Rotation input
Rotation of the anisotropic tangent direction. Value 0.0 equals 0- rotation, 0.25 equals 90- and 1.0 equals
360- = 0- . This can be used to texture the tangent direction.
Normal input
Normal used for shading; if nothing is connected the default shading normal is used.
Tangent input
Tangent used for shading; if nothing is connected the default shading tangent is used.
BSDF output
Anisotropic glossy BSDF shader.

Anisotropic rotation on 0

Anisotropic rotation on 0.25
(90- )

Toon
Diffuse and Glossy Toon BSDF for creating cartoon light effects.
Color input
Color of the surface, or physically speaking, the probability that light is reflected for each wavelength.
Size input
Parameter between 0.0 and 1.0 that gives a angle of reflection between 0- and 90- .
Smooth input
This value specifies an angle over which a smooth transition from full to no reflection happens.
Normal input
Normal used for shading; if nothing is connected the default shading normal is used.
BSDF output
Toon BSDF shader.

Toon Shader

Transparent
Transparent BSDF without refraction, passing straight through the surface, as if there were no geometry there.
Useful with alpha maps, for example. This shader affects light paths somewhat differently than other BSDF s.
Note that only pure white transparent shaders are completely transparent.
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Color input
Color of the surface, or physically speaking, the probability for each wavelength that light is blocked or
passes straight through the surface.
BSDF output
Transparent BSDF shader.

Transparent behaviour

Transparent Shader (pure

Transparent Shader (gray)

white)

Glass
Glass-like shader mixing refraction and reflection at grazing angles. Like the transparent shader, only pure
white will make it transparent. The glass shader tends to cause noise due to caustics. Since the Cycles path
tracing integrator is not very good at rendering caustics, it helps to combine this with a transparent shader for
shadows; for more details see here
Distribution
Microfacet distribution to use. Sharp results in perfectly sharp refractions like clear glass, while
Beckmann and GGX can use the Roughness input for rough glass.
Color input
Color of the surface, or physically speaking, the probability that light is transmitted for each wavelength.
Roughness input
Influences sharpness of the refraction; perfectly sharp at 0.0 and smoother with higher values.
IOR input
Index of refraction defining how much the ray changes direction. At 1. 0 rays pass straight through like
transparent; higher values give more refraction.
Normal input
Normal used for shading; if nothing is connected the default shading normal is used.
BSDF output
Glass BSDF shader.
Sharp Glass

Rough Glass
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Sharp Glass

Rough Glass

Refraction
Glossy refraction with sharp or microfacet distribution, used for materials that transmit light. For best results
this node should be considered as a building block and not be used on its own, but rather mixed with a glossy
node using a fresnel factor. Otherwise it will give quite dark results at the edges for glossy refraction.
Distribution
Microfacet distribution to use. Sharp results in perfectly sharp refractions, while Beckmann and GGX can
use the Roughness input for blurry refractions.
Color input
Color of the surface, or physically speaking, the probability that light is refracted for each wavelength.
Roughness input
Influences sharpness of the refraction; perfectly sharp at 0.0 and smoother with higher values.
Normal input
Normal used for shading; if nothing is connected the default shading normal is used.
BSDF output
Glossy BSDF shader.

Refraction Shader.

Velvet
Velvet reflection shader for materials such as cloth. It is meant to be used together with other shaders (such as a
Diffuse Shader) and isn’t particularly useful on it’s own.
Color input
Color of the surface, or physically speaking, the probability that light is reflected for each wavelength.
Sigma input
Variance of the normal distribution, controlling the sharpness of the peak - can be thought of as a kind of
roughness.
Normal input
Normal used for shading; if nothing is connected the default shading normal is used.
BSDF output
Velvet BSDF shader.
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The Velvet Shader

Subsurface Scattering
Simple subsurface multiple scattering, for materials such as skin, wax, marble, milk and others. For these
materials, rather than light being reflect directly off the surface, it will penetrate the surface and bounce around
internally before getting absorbed or leaving the surface at a nearby point.
How far the color scatters on average can be configured per RGB color channel. For example, for skin, red
colors scatter further, which gives distinctive red-colored shadows, and a soft appearance.
Falloff
Lighting distance falloff function. Cubic is a sharp falloff useful for many simple materials. The function
is (radius - x) 3 Gaussian gives a smoother falloff following a normal distribution, which is particularly
useful for more advanced materials that use measured data that was fitted to one or more such Gaussian
functions. The function is e -8x2/radius2, such that the radius roughly matches the maximum falloff
distance. To match a given measured variance v, set radius = sqrt(16*v).
Color input
Color of the surface, or physically speaking, the probability that light is reflected for each wavelength.
Scale input
Global scale factor for the scattering radius.
Radius input
Scattering radius for each RGB color channel, the maximum distance that light can scatter.
Sharpness input
Used only with Cubic falloff. Values increasing from 0 to 1 prevents softening of sharp edges and reduces
unwanted darkening.
Normal input
Normal used for shading; if nothing is connected the default shading normal is used.
Texture Blur input
How much of the texture will be blurred along with the lighting, mixing the texture at the incoming and
outgoing points on the surface. Note that the right choice depends on the texture. Consider for example a
texture created from a photograph of skin, in this cases the colors will already be pre-blurred and texture
blur could be set to 0. Even for hand painted textures no or minimal blurring might be appropriate, as a
texture artist would likely paint in softening already, one would usually not even know what an unblurred
skin texture looks like, we always see it blurred. For a procedural texture on the other hand this option
would likely have a higher value.
BSSRDF output
BSSRDF shader.
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A skin-toned SSS shader with color radius: 1.0, 0.8, 0.5.

Emission
Lambertian emission, to be used for material and lamp surface outputs.
Color input
Color of the emitted light.
Strength input
Strength of the emitted light. For point and area lamps, the unit is Watts. For materials, a value of 1.0 will
ensure that the object in the image has the exact same color as the Color input, i.e. make it ‘shadeless’.
Emission output
Emission shader.

Emission shader, with strength

Emission shader, with strength

at 1.0

at 3.0

Cycles uses a physically correct light falloff by default, whereas Bforartists Internal uses a smoothed falloff
with a Distance parameter. A similar effect can be found by using the Light Falloff node with the Smooth
parameter.
Lamp strength for point, spot and area lamps is specified in Watts. This means you typically need higher values
than Bforartists Internal, as you couldn’t use a 1W lamp to light a room; you need something stronger like a
100W lamp.
Sun lamps are specified in Watts/m^2, which require much smaller values like 1 W/m^2. This can be confusing,
but specifying strength in Watts wouldn’t have been convenient; the real sun for example has strength
384600000000000000000000000W. Emission shaders on meshes are also in Watts/m^2.

Background
Background light emission. This node should only be used for the world surface output; it is ignored in other
cases.
Color input
Color of the emitted light.
Strength input
Strength of the emitted light.
Background output
Background shader.
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Holdout
The holdout shader creates a “hole” in the image with zero alpha transparency, which is useful for compositing
(see alpha channel).
Note that the holdout shader can only create alpha when Properties ‣ Render ‣ Film ‣ Transparent is
enabled. If it’s disabled, the holdout shader will be black.
Holdout output
Holdout shader.

The checkered area is a region with zero alpha.

Ambient Occlusion
The ambient occlusion node gives per-material control for the amount of AO. When AO is enabled in the world,
it affects all diffuse BSDFs in the scene. With this option it’s possible to let only some materials be affected by
AO, or to let it influence some materials more or less than others.
Color input
surface reflection color.
AO output
Ambient Occlusion shader.

White AO shader.

Mix and Add
Mix or add shaders together. Mixing can be used for material layering, where the Fac input may, for example,
be connected to a Blend Weight node.
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Shader inputs
Shaders to mix, such that incoming rays hit either with the specified probability in the Fac socket.
Fac input
Blend weight to use for mixing two shaders; at zero it uses the first shader entirely and at one the second
shader.
Shader output
Mixed shader.

A mix of a glossy and a diffuse shader makes a nice ceramic material.

Texture Nodes
Image Texture

Image texture from GoodTextures.com

Use an image file as a texture.
Image Data-Block
Image data-block used as the image source. Currently not all images supported by Bforartists can be used
by Cycles. In particular, generated, packed images or animations are not supported currently.
Projection
Projection to use for mapping the textures.
• Flat will use the XY coordinates for mapping.
• Box will map the image to the 6 sides of a virtual box, based on the normal, using XY, YZ and
XYZ coordinates depending on the side.
• Sphere will map the image to the sphere using Z axis as central.
• Tube will map the tube to the sphere using Z axis as central.
Projection Blend
For Box mapping, the amount to blend between sides of the box, to get rid of sharp transitions between
17
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the different sides. Blending is useful to map a procedural-like image texture pattern seamlessly on a
model. 0.0 gives no blending; higher values give a smoother transition.
Color Space
Type of data that the image contains, either Color or Non-Color Data. For most color textures the default
of Color should be used, but in case of e.g. a bump or alpha map, the pixel values should be interpreted as
Non-Color Data, to avoid doing any unwanted color space conversions.
Extension Type
Extension type defines how the image is extrapolated past the original bounds:
• Repeat will repeat the image horizontally and vertically giving tiled-looking result.
• Extend will extend the image by repeating pixels on it’s edges.
• Clip will set all the extended pixels values to transparent black.
Vector input
Texture coordinate for texture lookup. If this socket is left unconnected, UV coordinates from the active
UV render layer are used.
Color output
RGB color from image. If the image has alpha, the color is premultiplied with alpha if the Alpha output is
used, and unpremultiplied or straight if the Alpha output is not used.
Alpha output
Alpha channel from image.

Environment Texture

HDR image from OpenFootage.net

Use an environment map image file as a texture. The environment map is expected to be in Latitude/Longitude
or ‘latlong’ format.
Image Data-Block
Image data-block used as the image source. Currently not all images supported by Bforartists can be used
by Cycles. In particular, generated, packed images or animations are not supported currently.
Color Space
Type of data that the image contains, either Color or Non-Color Data. For most color textures the default
of Color should be used, but in case of e.g. a bump or alpha map, the pixel values should be interpreted as
Non-Color Data, to avoid doing any unwanted color space conversions.
Vector input
Texture coordinate for texture lookup. If this socket is left unconnected, the image is mapped as
environment with the Z axis as up.
Color output
RGB color from the image. If the image has alpha, the color is premultiplied with alpha if the Alpha
18
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output is used, and unpremultiplied if the Alpha output is not used.
Alpha output
Alpha channel from image.

Sky Texture

Sky Texture

Procedural Sky texture.
Sky Type
Sky model to use (Preetham or Hosek / Wilkie).
Sun Direction
Sun direction vector.
Turbidity
Atmospheric turbidity. (2: Arctic like, 3: clear sky, 6: warm/moist day, 10: hazy day)
Ground Albedo
Amount of light reflected from the planet surface back into the atmosphere. (RGB 0,0,0 is black, 1,1,1 is
white).
Vector
Texture coordinate to sample texture at; defaults to Generated texture coordinates if the socket is left
unconnected.
Color output
Texture color output.

Noise Texture

Noise Texture with high detail
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Procedural Perlin noise texture, similar to the Clouds texture in Bforartists Internal.
Vector input
Texture coordinate to sample texture at; defaults to Generated texture coordinates if the socket is left
unconnected.
Scale input
Overall texture scale.
Detail input
Amount of noise detail.
Distortion input
Amount of distortion.
Color output
Texture color output.
Fac output
Texture intensity output.

Wave Texture

Default wave texture

Procedural bands or rings texture with noise distortion.
Type
Bands or Rings shaped waves.
Vector input
Texture coordinate to sample texture at; defaults to Generated texture coordinates if the socket is left
unconnected.
Scale input
Overall texture scale.
Distortion input
Amount of distortion of the wave (similar to the Marble texture in Bforartists Internal).
Detail input
Amount of distortion noise detail.
Detail Scale input
Scale of distortion noise.
Color output
Texture color output.
Fac output
Texture intensity output.
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Voronoi Texture

Voronoi texture, type: Intensity

Voronoi texture, type: Cells

Procedural texture producing Voronoi cells.
Type
Intensity or Cells output.
Vector input
Texture coordinate to sample texture at; defaults to Generated texture coordinates if the socket is left
unconnected.
Scale input
Overall texture scale.
Color output
Texture color output.
Fac output
Texture intensity output.

Musgrave Texture
Advanced procedural noise texture. Note that it often needs some adjustments (multiplication and addition) in
order to see more detail.

Nodes for the image to the right

Remapped Musgrave texture such
that most values are visible

Type
Multifractal, Ridged Multifractal, Hybrid Multifractal, fBM, Hetero Terrain.
Vector input
Texture coordinate to sample texture at; defaults to Generated texture coordinates if the socket is left
unconnected.
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Scale input
Overall texture scale.
Detail input
Amount of noise detail.
Dimension input
The highest fractal dimension, specified as the highest scale for the steps of the intensity.
Lacunarity input
The space of the lacunarity, specified as a frequency factor.
Offset input
The offset of the fractal, specified between black and white values (Intensity)
Gain input
A multiplier for the gain input
Color output
Texture color output.
Fac output
Texture intensity output.

Gradient Texture

Gradient texture using object coordinates

A gradient texture.
Type
The gradient can be Linear, Quadratic, Easing, Diagonal, Spherical, Quadratic Sphere or Radial.
Vector input
Texture coordinate to sample texture at; defaults to Generated texture coordinates if the socket is left
unconnected.
Color output
Texture color output.
Fac output
Texture intensity output.
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Magic Texture

Magic texture: Depth 10, Distortion 2.0

Psychedelic color texture.
Depth
Number of iterations.
Vector input
Texture coordinate to sample texture at; defaults to Generated texture coordinates if the socket is left
unconnected.
Distortion input
Amount of distortion.
Color output
Texture color output.
Fac output
Texture intensity output.

Checker Texture

Default Checker texture

Checkerboard texture.
Vector input
Texture coordinate to sample texture at; defaults to Generated texture coordinates if the socket is left
unconnected.
Color1/2 input
Color of the checkers.
Scale input
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Overall texture scale. The scale is a factor of the bounding box of the face divided by the scale. For
example, a scale of 15 will result in 15 alternate patterns over the overall UV bounding box. Different
patterns could be achieved using other nodes to give different input patterns to this socket. For example,
using the Math Node.
Color output
Texture color output.
Fac output
Checker 1 mask (1 = Checker 1).

Brick Texture

Brick texture: Colors changed, Squash 0.62, Squash Frequency 3.

Procedural texture producing Bricks.

Options
Offset
Determines the brick offset of the various rows.
Frequency
Determines the offset frequency. A value of 2 gives a even/uneven pattern of rows.
Squash
Amount of brick squashing.
Frequency
Brick squashing frequency.

Sockets
Color 1/2 and Mortar
Color of the bricks and mortar.
Scale
Overall texture scale.
Mortar Size
The Mortar size; 0 means no Mortar.
Bias
The color variation between Brick color 1 / 2. Values of -1 and 1 only use one of the two colors; values in
between mix the colors.
Brick Width
The width of the bricks.
Row Height
The height of the brick rows.
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Color output
Texture color output.
Fac output
Mortar mask (1 = mortar).

Point Density

Domain object with Point Density texture using vertices from ball as points.

Used to add volumetric points for each particle or vertex of another object.

Options
Point Data
Where to get points from.
Particle System
Use each particle position from the specified particle system.
Object Vertices
Use each vertex position from the specified object.
Object
Which object’s vertices or particle system will be used.
Particle System
Particle positions from this system will be used.
Space
The coordinate system for mapping points.
World Space
Map each point exactly where the source particle/vertex is.
Object Space
Fit the points from the source particles/vertices inside the bounding box of the object with the point
density texture. .. TODO As far as I can tell this is how it works, but should be checked with a
developer.
Radius
Radius from the shaded sample to look for points within. .. TODO Same as tooltip, this does not make
much sense to me.
Interpolation
Texel filtering type.
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Closest
No interpolation, use nearest texel. Produces blocky looking points.
Linear
Interpolate linearly between texels, producing soft, round points.
Cubic
Use cubic falloff, producing very soft points. Useful when points are very densely packed.
Resolution
The dimensions of the texture holding the point data.
Color Source
Which attribute of the particle system is used to color the output.

Sockets
Vector
Texture coordinate to sample texture at; defaults to global position (Position output of Geometry node) if
the socket is left unconnected.
Color output
Texture color output.
Density output
Density of volume.

More Nodes
Value
Input a scalar value.
Value
Value output.

RGB
Input an RGB color.
Color
RGB color output.

Geometry
Geometric information about the current shading point. All vector coordinates are in World Space. For volume
shaders, only the position and incoming vector are available.
Position
Position of the shading point.
Normal
Shading normal at the surface (includes smooth normals and bump mapping).
Tangent
Tangent at the surface.
True Normal
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Geometry or flat normal of the surface.
Incoming
Vector pointing towards the point the shading point is being viewed from.
Parametric
Parametric coordinates of the shading point on the surface.
Backfacing
1.0 if the face is being viewed from the backside, 0.0 for the frontside.

Wireframe
Node for a wireframe shader (Triangles only for now).
Pixel Size
Use screen pixel size instead of world units.
Size
Controls the thickness of the wireframe.
Fac output
1.0 if shading is executed on an edge, 0.0 otherwise.

Wavelength
A wavelength to rgb converter.
Wavelength
The color wavelength from 380 to 780 nanometers.
Color
RGB color output.

Blackbody
A blackbody temperature to RGB converter.
Temperature
The temperature in Kelvin.
Color
RGB color output.

Texture Coordinates
Commonly used texture coordinates, typically used as inputs for the Vector input for texture nodes.
Generated
Automatically-generated texture coordinates from the vertex positions of the mesh without deformation,
keeping them sticking to the surface under animation. Range from 0.0 to 1. 0 over the bounding box of
the undeformed mesh.
Normal
Object space normal, for texturing objects with the texture staying fixed on the object as it transformed.
UV
UV texture coordinates from the active render UV layer.
Object
Position coordinate in object space.
Camera
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Position coordinate in camera space.
Window
Location of shading point on the screen, ranging from 0.0 to 1. 0 from the left to right side and bottom to
top of the render.
Reflection
Vector in the direction of a sharp reflection, typically used for environment maps.

Bump
Generate a perturbed normal from a height texture, for bump mapping. The height value will be sampled at the
shading point and two nearby points on the surface to determine the local direction of the normal.
Invert
Invert the bump mapping, to displace into the surface instead of out.
Strength Input
Strength of the bump mapping effect, interpolating between no bump mapping and full bump mapping.
Distance Input
Multiplier for the height value to control the overall distance for bump mapping.
Height Input
Scalar value giving the height offset from the surface at the shading point; this is where you plug in
textures.

Vector Transform
Allows converting a Vector, Point or Normal between World <=> Camera <=> Object coordinate space.
Type
Specifies the input/output type: Vector, Point or Normal.
Convert From
Coordinate Space to convert from: World, Object or Camera.
Convert To
Coordinate Space to convert to: World, Object or Camera.
Vector Input
The input vector.
Vector Output
The transformed output vector.

Tangent
Generate a tangent direction for the Anisotropic BSDF.
Direction Type
The tangent direction can be derived from a cylindrical projection around the X, Y or Z axis (Radial), or
from a manually created UV Map for full control.
Tangent Output
The tangent direction vector.

Normal Map
Generate a perturbed normal from an RGB normal map image. This is usually chained with an Image Texture
node in the color input, to specify the normal map image. For tangent space normal maps, the UV coordinates
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for the image must match, and the image texture should be set to Non-Color mode to give correct results.
Space
The input RGB color can be in one of 3 spaces: Tangent, Object and World space. Tangent space normal
maps are the most common, as they support object transformation and mesh deformations. Object space
normal maps keep sticking to the surface under object transformations, while World normal maps do not.
UV Map
Name of the UV map to derive normal mapping tangents from. When chained with an Image Texture
node, this UV map should be the same as the UV map used to map the texture.
Strength
Strength of the normal mapping effect.
Color Input
RGB color that encodes the normal in the specified space.
Normal Output
Normal that can be used as an input to BSDF nodes.

Object Info
Information about the object instance. This can be useful to give some variation to a single material assigned to
multiple instances, either manually controlled through the object index, based on the object location, or
randomized for each instance. For example a Noise texture can give random colors or a Color ramp can give a
range of colors to be randomly picked from.
Note that this node only works for material shading nodes; it does nothing for lamp and world shading nodes.
Location
Location of the object in world space.
Object Index
Object pass index, same as in the Object Index pass.transformed.
Material Index
Material pass index, same as in the Material Index pass.
Random
Random number between 0 and 1 unique to a single object instance.

Particle Info
For objects instanced from a particle system, this node give access to the data of the particle that spawned the
instance. This node currently only supports parent particles, info from child particles is not available.
Index
Index number of the particle (from 0 to number of particles).
Age
Age of the particle in frames.
Lifetime
Total lifespan of the particle in frames.
Location
Location of the particle.
Size
Size of the particle.
Velocity
Velocity of the particle.
Angular Velocity
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Angular velocity of the particle.

Hair Info
This node gives access to strand information.
Is strand
Returns 1 when the shader is acting on a strand, otherwise 0.
Intersect
The point along the strand where the ray hits the strand (1 at the tip and 0 at the root).
Thickness
The thickness of the strand at the point where the ray hits the strand.
Tangent Normal
Tangent normal of the strand.

Attribute
Retrieve attribute attached to the object or mesh. Currently UV maps and vertex color layers can be retrieved
this way by their names, with layers and attributes planned to be added. Also internal attributes like P
(position), N (normal), Ng (geometric normal) may be accessed this way, although there are more convenient
nodes for this.
Name
Name of the attribute.
Color output
RGB color interpolated from the attribute.
Vector output
XYZ vector interpolated from the attribute.
Fac output
Scalar value interpolated from the attribute.

Mapping
Transform a coordinate; typically used for modifying texture coordinates.
Location
Vector translation.
Rotation
Rotation of the vector along XYZ axes.
Scale
Scale of the vector.
Vector input
Vector to be transformed.
Vector output
Transformed vector.

Layer Weight
Output weights typically used for layering shaders with the Mix Shader node.
Blend input
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Blend between the first and second shader.
Fresnel output
Dielectric fresnel weight, useful for example to layer diffuse and glossy shaders to create a plastic
material. This is like the Fresnel node, except that the input of this node is in the often more-convenient
0.0 to 1.0 range.
Facing output
Weight that blends from the first to the second shader as the surface goes from facing the viewer to
viewing it at a grazing angle.

Fresnel
Dielectric fresnel, computing how much light is reflected off a layer, where the rest will be refracted through
the layer. The resulting weight can be used for layering shaders with the Mix Shader node. It is dependent on
the angle between the surface normal and the viewing direction.
The most common use is to mix between two BSDFs using it as a blending factor in a mix shader node. For a
simple glass material you would mix between a glossy refraction and glossy reflection. At grazing angles more
light will be reflected than refracted as happens in reality.
For a two-layered material with a diffuse base and a glossy coating, you can use the same setup, mixing
between a diffuse and glossy BSDF. By using the fresnel as the blending factor you’re specifying that any light
which is refracted through the glossy coating layer would hit the diffuse base and be reflected off that.
IOR input
Index of refraction of the material being entered.
Fresnel output
Fresnel weight, indicating the probability with which light will reflect off the layer rather than passing
through.

Light Path
Node to find out for which kind of incoming ray the shader is being executed; particularly useful for nonphysically based tricks. More information about the meaning of each type is in the Light Paths documentation.
Is Camera Ray output
1.0 if shading is executed for a camera ray, 0.0 otherwise.
Is Shadow Ray output
1.0 if shading is executed for a shadow ray, 0.0 otherwise.
Is Diffuse Ray output
1.0 if shading is executed for a diffuse ray, 0.0 otherwise.
Is Glossy Ray output
1.0 if shading is executed for a glossy ray, 0.0 otherwise.
Is Singular Ray output
1.0 if shading is executed for a singular ray, 0.0 otherwise.
Is Reflection Ray output
1.0 if shading is executed for a reflection ray, 0.0 otherwise.
Is Transmission Ray output
1.0 if shading is executed for a transmission ray, 0.0 otherwise.
Ray Length output
Distance travelled by the light ray from the last bounce or camera.
Ray Depth output
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Returns the current light bounce.
Transparent Depth output
Returns the number of transparent surfaces passed through.

Light Falloff
Manipulate how light intensity decreases over distance. In reality light will always fall off quadratically;
however it can be useful to manipulate as a non-physically based lighting trick. Note that using Linear or
Constant falloff may cause more light to be introduced with every global illumination bounce, making the
resulting image extremely bright if many bounces are used.
Strength input
Light strength before applying falloff modification.
Smooth input
Smooth intensity of light near light sources. This can avoid harsh highlights, and reduce global
illumination noise. 0.0 corresponds to no smoothing; higher values smooth more. The maximum light
strength will be strength/smooth.
Quadratic output
Quadratic light falloff; this will leave strength unmodified if smooth is 0.0 and corresponds to reality.
Linear output
Linear light falloff, giving a slower decrease in intensity over distance.
Constant output
Constant light falloff, where the distance to the light has no influence on its intensity.

Nodes shared with the Compositor
Some nodes are common with Composite nodes, their documentation can be found at their relevant pages rather
than repeated here.
•
•
•
•
•
•
•
•
•
•
•
•
•

Brightness Contrast
Separate RGB
Combine RGB
Separate HSV
Combine HSV
Gamma
Hue Saturation Value
Invert
Math
Mix RGB
RGB Curves
RGB to BW
Vector Curve
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10.3.5 Render - Cycles Render Engine - World
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World

Lighting with an HDR image

The world environment can emit light, ranging from a single solid color, physical sky model, to arbitrary
textures.

Surface Shader
The surface shader defines the light emission from the environment into the scene. The world surface is
rendered as if it is very distant from the scene, and as such there is no two-way interacting between objects in
the scene and the environment, only light coming in. The only shader accepted is the Background node with a
color input and strength factor for the intensity of the light.

Image Based Lighting
For image based lighting, use the Environment Texture node rather than the Image Texture node for correct
mapping. This supports Equirectangular (also known as Lat/Long) for environment maps, and Mirror Ball
mapping for converting photos of mirror balls to environment maps.

Volume Shader
A volume shader can be applied to the entirely world, filling the entire space.
Currently this is most useful for night time or other dark scenes, as the world surface shader or sun lamps will
have no effect if a volume shader is used. This is because the world background is assumed to be infinitely far
1
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away, which is accurate enough for the sun for example. However for modeling effects such as fog or
atmospheric scattering, it is not a good assumption that the volume fills the entire space, as most of the distance
between the sun and the earth is empty space. For such effects it is be better to create a volume object
surrounding the scene. The size of this object will determine how much light is scattered or absorbed.

Ambient Occlusion
Ambient occlusion is a lighting method based on how much a point on a surface is occluded by nearby surfaces.
This is a trick that is not physically accurate, but it is useful to emphasize shapes of surfaces, or as a cheap way
to get an effect that looks a bit like indirect lighting.
Factor
The strength of the ambient occlusion; value 1.0 is like a white world shader.
Distance
Distance from shading point to trace rays. A shorter distance emphasizes nearby features, while longer
distances make it also take objects further away into account.
Lighting from ambient occlusion is only applied to diffuse reflection BSDFs; glossy or transmission BSDFs are
not affected. Transparency of surfaces will be taken into account, i.e. a half-transparent surface will only half
occlude.
An alternative method of using Ambient Occlusion on a per-shader basis is to use the Ambient Occlusion
shader.

Sampling
Multiple Importance Sample
Enabling this will sample the background texture such that lighter parts are favored, producing less noise
in the render. It is almost always a good idea to enable this when using an image texture to light the scene,
otherwise noise can take a very long time to converge.
Map Resolution
Sets the resolution of the ‘Multiple Importance Sample’ map. Higher values may produce less noise when
using high-res images, but will take up more memory and render slightly slower.
Below is a comparison between Multiple Importance Sample Off and On - both images rendered for 25 seconds
(Off: 1500 samples, On: 1000 samples)

Multiple Importance Sample Off

Multiple Importance Sample On

For interior scenes, noise can be significantly reduce by setting up area lamps as light portals.
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Without Light Portals

With Light Portals

Ray Visibility
As with other objects, Ray Visibility allows you to control which other shaders can “see” the environment.

Tricks
Sometimes it may be useful to have a different background that is directly visible versus one that is indirectly
lighting the objects. A simple solution to this is to add a Mix node, with the Blend Factor set to Is Camera Ray.
The first input color is then the indirect color, and the second the directly visible color. This is useful when
using a high-res image for the background and a low-res image for the actual lighting.
Similarly, adding the Is Camera and Is Glossy rays will mean that the high-res image will also be visible in
reflections.

Nodes for the trick above
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10.3.6 Render - Cycles Render Engine - Camera
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Perspective..........................................................................................................................................................1
Orthographic.......................................................................................................................................................1
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Equirectangular..............................................................................................................................................2
Fisheye...........................................................................................................................................................2
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Clipping..............................................................................................................................................................3

Camera
Perspective
Lens Size and Angle
Control the field of view angle.

Orthographic
Scale
Controls the size of objects projected on the image.

Panoramic
Cycles supports Equirectangular and Fisheye panoramic cameras. Note that these can’t be displayed with
OpenGL rendering in the view-port; they will only work for rendering.
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Equirectangular
Render a panoramic view of the scenes from the camera location and use an equirectangular projection, always
rendering the full 360- over the X-axis and 180- over the Y-axis.
This projection is compatible with the environment texture as used for world shaders, so it can be used to render
an environment map. To match the default mapping, set the camera object rotation to (90, 0, -90) or pointing
along the positive X-axis. This corresponds to looking at the center of the image using the default environment
texture mapping.

Fisheye
Fisheye lenses are typically wide angle lenses with strong distortion, useful for creating panoramic images for
e.g. dome projection, or as an artistic effect. The Fisheye Equisolid lens will best match real cameras. It
provides a lens focal length and field of view angle, and will also take the sensor dimensions into account.
The Fisheye Equidistant lens does not correspond to any real lens model; it will give a circular fish-eye that
doesn’t take any sensor information into account but rather uses the whole sensor. This is a good lens for full
dome projection.
Lens
Lens focal length in millimeter.
Field of View
Field of view angle, going to 360 and more to capture the whole environment.

Depth of Field

Focus
Set an object to be used as a focal point by the camera, causing the camera to focus on the selected object.
Distance
When an object is not used, the camera can be set to focus on an area in 3D space set by the distance from
the camera. Using the Limit Display option, you are able to view the distance in the 3D space.
High Quality
Enables the High Quality view-port depth of field, giving a more accurate representation of depth of field.
This allows the view-port depth of field to be closely represented to that of the render and render preview
depth of field.
F-Stop
Viewport depth of field aperture measured in F-Stops. Smaller numbers will cause more blur in the viewport, OpenGL renders, and sequencer.
Blades
The number of polygonal sides to give blurred objects in the view-port. The minimum number of blades
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needed to enable the bokeh effect is 3 (triangle). Only available with High Quality
Aperture
Use F-Stop or Radius to set the aperture for the render, and render preview. F-Stop is the focal ratio,
where Radius is the the raidus of the focal point.
Size/Number
Aperture radius size, or F-Stop number used for the render, and render preview. Using the F-Stop with a
low number, or Radius with a large size will result in a strong blur, also allowing the use of the bokeh
effect.
Blades
Total number of polygonal blades used to alter the shape of the blurred objects in the render, and render
preview. As with the view-port, the minimum amount of blades to enable the bokeh effect is 3, resulting
in a triangle shaped blur.
Rotation
Rotate the polygonal blades along the facing axis, and will rotate in a clockwise, and counter-clockwise
fashion.
Ratio
Change the amount of distortion to simulate the anamorphic bokeh effect. A setting of 1.0 shows no
distortion, where a number below 1.0 will cause a horizontal distortion, and a higher number will cause a
vertical distortion.

Clipping
Clip Start and End
The interval in which objects are directly visible, Any objects outside this range still influence the image
indirectly, as further light bounces are not clipped.
See also
Camera Clipping.
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10.3.7 Render - Cycles Render Engine - Render Features
Features...................................................................................................................................................................1
Experimental Features........................................................................................................................................1

Features
This page offers a comparison of available features on CPU, CUDA and OpenCL.
Feature

CPU

CUDA (NVIDIA GPU)

OpenCL (AMD GPU)

Basic Shading

✔

✔

✔

Transparent Shadows

✔

✔

✗

Motion Blur

✔

✔

✔

Hair

✔

✔

✔

Volume

✔

✔

✗

Smoke / Fire

✔

✗

✗

Subsurface Scattering

✔

✔

✗

Open Shading Language

✔

✗

✗

CMJ sampling

✔

✔

✗

Branched Path integrator

✔

✔

✗

Displacement /
Subdivision

✔ (experimental)

✔ (experimental)

✔ (experimental)

Experimental Features
Experimental features are disabled / hidden by default, but can be enabled by setting Feature Set to
Experimental in the Render properties. They may not work properly, crash Bforartists or change their behaviour
in later versions.
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Introduction
Simplify
Reference
Menu: Properties editor ‣ Scene ‣ Simplify

Texture Limit
Automatically scales textures down textures so they are no larger than the values chosen. This can help
large scenes that use huge textures to still fit into the computer’s memory resources.
Use Camera Cull
Automatically culls objects based on the camera frustum defined by the Margin.
Use Distance Cull
Automatically culls objects based on their distance from the active camera. This is set via the Distance
property.

Integrator
The integrator is the rendering algorithm used to compute the lighting. Cycles currently supports a path tracing
integrator with direct light sampling. It works well for various lighting setups, but is not as suitable for caustics
and some other complex lighting situations.
Rays are traced from the camera into the scene, bouncing around until they find a light source such as a lamp,
an object emitting light, or the world background. To find lamps and surfaces emitting light, both indirect light
sampling (letting the ray follow the surface BSDF) and direct light sampling (picking a light source and tracing
a ray towards it) are used.

Sampling
Reference
Panel: Properties editor ‣ Render ‣ Sampling
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Sample Method
There are two integrator modes that can be used: Path Tracing and Branched Path Tracing.
Square Samples
Square the amount samples.
Seed
Seed value for integrator to get different noise patterns.
Animate Seed (clock icon)
This button which can be found on the right side of the Seed value can be used to give different seed
values. It is a good idea to enable this when making animation because in the real world each frame
has a different noise pattern.
Clamp Direct
This option limits the maximum intensity a sample from rays which have not yet bounced can contribute
to a pixel. It reduces noise at the cost of accuracy. Setting this option to 0.0 disables clamping altogether.
Lower have a greater affect (dimmer samples) on the resulting image than higher values.
Note
A common issue encountered with Path Tracing is the occurrence of “fireflies”: improbable samples that
contribute very high values to pixels. This option provides a way to limit that. However, note that as you
clamp out such values, other bright lights/reflections will be dimmed as well.
Care must be taken when using this setting to find a balance between mitigating fireflies and losing
intentionally bright parts. It is often useful to clamp indirect bounces separately, as they tend to cause
more fireflies than direct bounces. See the Clamp Indirect setting.

Clamp Indirect
The same as Clamp Direct, but for rays which have bounced multiple times.
Light Sampling Threshold
Probabilistically terminates light samples when the light contribution is below this threshold (more noise
but faster rendering). Zero disables the test and never ignores lights. This is useful because in large scenes
with many light sources, some might only contribute a small amount to the final image, and increase
render times. Using this setting can decease the render times needed to calculate the rays which in the end
have very little affect on the image.
Pattern
Random sampling pattern used by the integrator.
Sobol
Uses a Sobol pattern to decide the random sapling pattern used by the integrator. See Sobol
sequence on Wikipedia for more information.
Correlated Multi-Jitter
Uses a Correlated Multi-Jitter pattern to decide the random sapling pattern used by the integrator.
See this Pixar paper for more information.
Layer Samples
When render layers have per layer number of samples set, this option specifies how to use them.
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Use
ToDo
Bounded
Bound render layer samples by scene samples.
Ignore
Ignore render layer sample settings.

Path Tracing
The Path Tracing integrator is a pure path tracer; at each hit it will bounce light in one direction and pick one
light to receive lighting from. This makes each individual sample faster to compute, but will typically require
more samples to clean up the noise.
Render Samples
Number of paths to trace for each pixel in the final render. As more samples are taken, the solution
becomes less noisy and more accurate.
Preview Samples
Number of samples for viewport rendering.

Branched Path Tracing
The non-progressive Branched Path Tracing integrator offers finer control over sampling. It is similar to Path
Tracing, but at the first hit it will split the path for different surface components and will take all lights into
account for shading instead of just one.
This makes each sample slower, but will reduce noise, especially in scenes dominated by direct or one-bounce
lighting. To get the same number of diffuse samples as in the path tracing integrator, note that e.g. 250 path
tracing samples = 10 AA samples x 25 diffuse samples. The Sampling panel shows this total number of
samples.
AA Render Samples
Number of samples to take for each pixel in the final render. More samples will improve antialiasing.
AA Preview Samples
Number of samples for viewport rendering.
Diffuse Samples
Number of diffuse bounce samples to take for each AA sample.
Glossy Samples
Number of glossy bounce samples to take for each AA sample.
Transmission Samples
Number of transmission bounce samples to take for each AA sample.
AO Samples
Number of ambient occlusion samples to take for each AA sample.
Mesh Light Samples
Number of mesh light samples to take for each AA sample.
Subsurface Samples
Number of subsurface scattering samples to take for each AA sample.
Volume Samples
Number of volume scattering samples to take for each AA sample.
Sample All Direct Lights
When enabled, Cycles will samples all lights in the scene for direct bounces, instead of randomly picking
one. Disabling this can improve performance, when using a lot of AA Samples anyway, to clear up the
render.
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Sample All Indirect Lights
Similar to direct light, but for indirects lights. This can reduce noise in scenes with many lights.

Light Paths
Reference
Panel: Properties editor ‣ Render ‣ Light Paths

Bounces
Max Bounces
Maximum number of light bounces. For best quality, this should be set to the maximum. However, in
practice, it may be good to set it to lower values for faster rendering. Setting it to maximum 0 bounces
results in direct lighting only.
Min Bounces
Minimum number of light bounces for each path, after which the integrator uses Russian Roulette to
terminate paths that contribute less to the image. Setting this higher gives less noise, but may also
increase render time considerably. For a low number of bounces, it is strongly recommended to set this
equal to the maximum number of bounces.
Diffuse Bounces
Maximum number of diffuse bounces.
Glossy Bounces
Maximum number of glossy bounces.
Transmission Bounces
Maximum number of transmission bounces.
Volume Bounces
Maximum number of volume scattering bounces.

Transparency
Transparency Max
Maximum number of transparency bounces.
Transparency Min
Minimum number of transparency bounces, after which Russian Roulette termination is used.
Transparent Shadows
For direct light sampling, use transparency of surfaces in between to produce shadows affected by
transparency of those surfaces.

Caustics & Filter Glossy
Reflective Caustics
While in principle path tracing supports rendering of caustics with a sufficient number of samples, in
practice it may be inefficient to the point that there is just too much noise. This option can be unchecked,
to disable reflective caustics.
Refractive Caustics
The same as above, but for refractive caustics.
Filter Glossy
When using a value higher than 0.0, this will blur glossy reflections after blurry bounces, to reduce noise
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at the cost of accuracy. 1.0 is a good starting value to tweak.
Some light paths have a low probability of being found while contributing much light to the pixel. As a
result these light paths will be found in some pixels and not in others, causing fireflies. An example of
such a difficult path might be a small light that is causing a small specular highlight on a sharp glossy
material, which we are seeing through a rough glossy material. In fact in such a case we practically have a
caustic.
With path tracing it is difficult to find the specular highlight, but if we increase the roughness on the
material, the highlight gets bigger and softer, and so easier to find. Often this blurring will hardly be
noticeable, because we are seeing it through a blurry material anyway, but there are also cases where this
will lead to a loss of detail in lighting.

Geometry
Reference
Panel: Properties editor ‣ Render ‣ Geometry

Volume Sampling
Step Size
Distance between volume shader samples when rendering the volume. Lower values give more accurate
and detailed results but also increased render time.
Max Steps
Maximum number of steps through the volume before giving up, to protect from extremely long render
times with big objects or small step sizes.

Subdivision Rate
These settings are used to control the True Displacement.
Note
These Options are only available if Experimental Feature Set is turned on.

Render
Size of micropolygons in pixels.
Preview
Size of micropolygons in pixels while preview rendering.
Max Subdivisions
Stop subdividing when this level is reached even if the dice rate would produce finer tessellation.

Hair
These are global settings that apply to all instances of hair systems. The resolution of the strands is controlled
by the step values in particle settings. Each hair system uses the material identified in the particle settings in the
same way as Blender Internal.
Use Hair
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Enables rendering of hair particle systems.
Primitive
Triangles
Uses a triangle mesh.
Resolution
ToDo.
Line Segments
Uses a straight curve primitive.
Curve Segments
Uses a smooth Cardinal curve primitive. These interpolate a path through the curve keys. However,
it renders slower than line segments.
Curve Subdivisions
The interpolated path is subdivided to give points to connect. The parameter subdivisions sets
the number of divisions used.
Shape
Thick
Cylindrical segments between two points.
Cull back-faces
Excludes strands emitted from the mesh back facing the camera.
Ribbons
Are flat planes following the strand direction facing the camera.
Min Pixels
Strands that are further away will be made wider, which is compensated with transparency to keep the
look similar. This effect is only applied for camera rays. It works best with ribbon primitives.

Light Paths
Ray Types
Ray types can be divided into four categories:
•
•
•
•

Camera: the ray comes straight from the camera.
Reflection: the ray is generated by a reflection off a surface.
Transmission: the ray is generated by a transmission through a surface.
Shadow: the ray is used for (transparent) shadows.

Reflection and transmission rays can further have these properties:
• Diffuse: the ray is generated by a diffuse reflection or transmission (translucency).
• Glossy: the ray is generated by a glossy specular reflection or transmission.
• Singular: the ray is generated by a perfectly sharp reflection or transmission.
The Light Path node can be used to find out the type of ray the shading is being computed for.

7
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Bounce Control
The maximum number of light bounces can be controlled manually. While ideally this should be infinite, in
practice a smaller number of bounces may be sufficient, or some light interactions may be intentionally left out
for faster convergence. The number of diffuse reflection, glossy reflection and transmission bounces can also be
controlled individually.
Light paths are terminated probabilistically when specifying a minimum number of light bounces lower than
the maximum. In that case paths longer than minimum will be randomly stopped when they are expected to
contribute less light to the image. This will still converge to the same image, but renders faster while possibly
being noisier.
A common source of noise is caustics, which are diffuse bounces followed by a glossy bounce (assuming we
start from the camera). An option is available to disable these entirely.

Transparency
The transparent BSDF shader is given special treatment. When a ray passes through it, light passes straight on,
as if there was no geometry there. The ray type does not change when passing through a transparent BSDF.
Alpha pass output is also different for the transparent BSDF. Other transmission BSDFs are considered opaque,
because they change the light direction. As such they cannot be used for alpha-over compositing, while this is
possible with the transparent BSDF.
The maximum number of transparent bounces is controlled separately from other bounces. It is also possible to
use probabilistic termination of transparent bounces, which might help rendering many layers of transparency.
Note that while semantically the ray passes through as if no geometry was hit, rendering performance is
affected as each transparency step requires executing the shader and tracing a ray.

Ray Visibility
Objects can be set to be invisible to particular ray types:
•
•
•
•
•

Camera
Diffuse reflection
Glossy reflection
Transmission
Shadow

Properties Editor Object ‣ Cycles Settings ‣ Ray visibility.
8
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This can be used, for example, to make an emitting mesh invisible to camera rays. For duplicators, visibility is
inherited; if the parent object is hidden for some ray types, the children will be hidden for these too.
In terms of performance, using these options is more efficient that using a shader node setup that achieves the
same effect. Objects invisible to a certain ray will be skipped in ray traversal already, leading to fewer rays cast
and shaders executed.

Motion Blur & Film
Motion Blur
Reference
Panel: Properties editor ‣ Render ‣ Motion Blur

Blender’s animations are by default rendered as a sequence of perfectly still images. While great for stopmotion and time-lapses, this is unrealistic, since fast-moving objects do appear to be blurred in the direction of
motion, both in a movie frame and in a photograph from a real-world camera.

Cycles Motion Blur Example.
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Note
If there are particles or other physics system in a scene, be sure to bake them before rendering, otherwise you
might not get correct or consistent motion.

Options

Cycles Motion Blur Settings.
Position
Controls at what point the shutter opens in relation to the frame.
• End on frame
• Center on frame
• Start on frame
Shutter Speed
Time between frames over which motion blur is computed. Shutter time 1.0 blurs over the length of 1
frame, 2.0 over the length of two frames, from the previous to the next.
Shutter Curve
Curve defining how the shutter opens and closes.
Shutter Type
Replicates CMOS cameras by rendering a rolling shutter effect using scanlines.
• Top Bottom: Renders rolling shutter from the top of the image to the bottom.
Rolling Shutter Duration
Controls balance between pure rolling shutter effect and pure motion blur effect. With zero being no
rolling shutter and one being all rolling shutter.
Warning
10
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An object modifier setup that changes mesh topology over time will cause severe problems.
Common examples of this are animated Booleans, Deformation before Edge Split, Remesh, Skin or Decimate
modifiers.

Each object has its own settings to control motion blur. These options can be found in the Object tab of the
Properties editor.

Film
Reference
Panel: Properties editor ‣ Render ‣ Film

Exposure
This can be used to change the brightness of an image. Different then the Exposure option found in the
Color management panel this exposure option works is on the data while the Color management exposure
is on the view.
Transparent
ToDo
Pixel Filter
Blackman-Harris, Box, Gaussian
Width
ToDo.

Performance
Threads
Mode
Auto-detect
Automatically chooses the amount threads to match the number of logical processors on your
computer.
Fixed
Manually choose the amount threads to use for rendering. This can be useful for example, if you
want to use your computer while rendering you can set the property to a thread count lower the
amount of logical processors on your computer.

Tiles
Tile Order
Order of rendering tiles. This does not significantly affect performance.
Tile size X/Y
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The size of the tiles for rendering.
Depending on what device you are using for rendering, different tile sizes can give faster renders. For
CPU rendering smaller tiles sizes (like 32 x 32) tend to be faster, while for GPU rendering larger tile sizes
give better performance (like 256 x 256).
Progressive Refine
Instead of rendering each tile until it has finished every sample, refine the whole image progressively.
Note that progressive rendering is slightly slower than tiled rendering, but time can be saved by manually
stopping the render when the noise level is low enough.
For rendering animations it is best to disable this feature, as stopping a frame early is not possible.
Save Buffers
Saves all render layers and passes to the temp directory on a drive, and read them back after rendering has
finished. This saves memory usage during rendering, particularly when using many render layers and
passes.

Viewport
Viewport BVH Type
Dynamic BVH
Objects can be transformed, added and deleted interactively, at the cost of slower renders.
Static BVH
Object modifications require a complete BVH rebuild which reduces interactivity but renders faster.
Start Resolution
Resolution to start rendering preview at, progressively increase it to the full viewport size.

Final Render
Persistent Images
Keep image data in memory after rendering, for faster re-renders at the cost of extra memory usage when
performing other tasks in Blender.

Acceleration Structure
Use Spatial Splits
Spatial splits improve rendering performance in scenes with a mix of large and small polygons. The
downsides are longer BVH build times and slightly increased memory usage.
Use Hair BVH
Use a special type of BVH for rendering hair. The bounding boxes are not axis aligned allowing a
spatially closer fit to the hair geometry. Disabling this option will reduce memory, at the cost of
increasing hair render time.

Layers
Reference
12
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Panel: Properties editor ‣ Render Layers ‣ Layer

This section covers only the Render Layer settings appropriate for the Blender Render engine. For the engineindependent settings, see this section.
Exclude
Scene layers are shared between all render layers; however, sometimes it is useful to leave out some
object influence for a particular render layer. That is what this option allows you to do.
Material
Overrides all materials in the render layer.
Samples
Render layer samples to override the scene samples. Controlled by the layer samples in the sampling
panel.
Use Environment
Disables rendering the Environment render pass in the final render.
Use AO
Disables rendering the Ambient Occlusion render pass in the final render.
Use Surfaces
Disables rendering object materials in the final render.
Use Hair
Disables rendering hair strands in the final render.

Passes
Reference
Panel: Properties editor ‣ Render Layers ‣ Passes

Passes can be used to split rendered images into colors, direct and indirect light to edit them individually, and
also to extract data such as depth or normals.

Lighting Passes
Diffuse Direct
Direct lighting from diffuse BSDFs. We define direct lighting as coming from lamps, emitting surfaces,
the background, or ambient occlusion after a single reflection or transmission off a surface. BSDF color is
not included in this pass.
Diffuse Indirect
Indirect lighting from diffuse BSDFs. We define indirect lighting as coming from lamps, emitting
surfaces or the background after more than one reflection or transmission off a surface. BSDF color is not
included in this pass.
Diffuse Color
Color weights of diffuse BSDFs. These weights are the color input socket for BSDF nodes, modified by
any Mix and Add Shader nodes.
Glossy Direct, Indirect, Color
Same as above, but for glossy BSDFs.
Transmission Direct, Indirect, Color
Same as above, but for transmission BSDFs.
13
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Subsurface Direct, Indirect, Color
Same as above, but for subsurface BSDFs.
Emission
Emission from directly visible surfaces.
Environment
Emission from the directly visible background. When the film is set to transparent, this can be used to get
the environment color and composite it back in.
Shadow
Shadows from lamp objects. Mostly useful for compositing objects with shadow into existing footage.
Ambient Occlusion
Ambient occlusion from directly visible surfaces. BSDF color or AO factor is not included; i.e. it gives a
‘normalized’ value between 0 and 1.

Note
Transparent BSDFs are given special treatment. A fully transparent surface is treated as if there is no surface
there at all; a partially transparent surface is treated as if only part of the light rays can pass through. This
means it is not included in the Transmission passes; for that a glass BSDF with index of refraction 1.0 can be
used.

Combining
All these lighting passes can be combined to produce the final image as follows:

14
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Data Passes
Combined
The final combination of render passes with everything included.
Z
Distance in BU to any visible surfaces.
Note
The Z pass only uses one sample. When depth values need to be blended in case of motion blur or DOF,
use the mist pass.
Mist
Distance to visible surfaces, mapped to the 0.0-1.0 range. When enabled, settings are in World tab. This
pass can be used in compositing to add fade out object that are further away.
Normal
Surface normal used for shading.
Vector
Motion vectors for the vector blur node. The four components consist of 2D vectors giving the motion
towards the next and previous frame position in pixel space.
UV
Default render UV coordinates.
Object Index
Creates a mask of the object that can be later read by the ID Mask Node in the compositor.
Material Index
Creates a mask of the material that can be later read by the ID Mask Node in the compositor.
Note
The Z, Object Index and Material Index passes are not anti-aliased.

Alpha Threshold
Z, Index, normal, UV and vector passes are only affected by surfaces with alpha transparency equal to or
higher than this threshold. With value 0.0 the first surface hit will always write to these passes, regardless
of transparency. With higher values surfaces that are mostly transparent can be skipped until an opaque
surface is encountered.

Denoising
Reference
Panel: Properties editor ‣ Render Layers ‣ Denoising

Denoising filters the resulting image using information (known as feature passes) gathered during rendering to
get rid of noise while preserving visual detail as well as possible.
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To use the option, enable it in the render layers tab of the properties editor. On rendering, it will denoise tile by
tile once all the surrounding tiles are finished rendering. The default settings fit a wide range of scenes, but the
user can tweak individual settings to control the tradeoff between a noise-free image, image details, and
calculation time.
See also
See the other ways to reduce noise on the general Noise Optimization page.

Options

Denoising panel.
Radius
Size of the image area that’s used to denoise a pixel. Higher values are smoother, but might lose detail
and are slower.
Strength
Controls how different the area around a neighbor pixel can look compared to the center pixel before it’s
no longer used for denoising. Lower values preserve more detail, but aren’t as smooth.
Feature Strength
Controls removal of noisy and redundant image feature passes before the actual denoising. This is
required in some cases like DoF or Motion Blur to avoid splotchy results, but might cause fine
texture/geometrical detail to be lost. Lower values preserve more detail, but aren’t as smooth.
Relative Filter
When removing features that don’t carry information, decide which to keep based on the total amount of
information in the features. This can help to reduce artifacts, but might cause detail loss around edges.
Passes
You can choose to selectively choose which Render Passes you want to denoise.

Notes and issues
The denoiser will change in the future and some features are not implemented yet. If denoising fails to produce
good results, more samples or clamping will often resolve the issue.
• Setting the radius too high is generally not advisable. It increases denoising time a lot and, while the
result might be smoother, it is not more accurate since there isn’t any additional info coming out of the
renderer. Beyond a radius of ~15, the additional rendering time is probably better spent on increasing the
amount of samples.
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• Denoising cannot be used for baking yet.
• For animation denoising can be used, however it still requires high sample counts for good results. With
low sample counts low frequency (blurry) noise can be visible in animation, even if it is not immediately
apparent in still images.
• When using GPU rendering, the denoising process may use a significant amount of vRAM. If the GPU
runs out of memory but renders fine without denoising, try reducing the tile size.

Examples
Below is an example render by The Pixelary.

Example render before denoising.

Example render after denoising.

Object Data
Motion Blur
Reference
Panel: Properties editor ‣ Object ‣ Motion Blur

Each object has its own motion blur settings along with the Scene Level Motion Blur These settings can be
found in the Object Properties tab of the Properties editor.
Deformation
Enables motion blur for deformed meshes such as animated characters, including hair.
Steps
Controls accuracy of deformation motion blur, more steps gives more memory usage. The actual number
of time steps is 2steps−1
.
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Cycles Settings
Ray Visibility
Camera
Makes the object visible in camera rays.
Diffuse
Makes the object visible in diffuse rays.
Glossy
Makes the object visible in glossy rays.
Transmission
Makes the object visible in transmission rays.
Volume Scatter
Makes the object visible in transmission rays.
Shadow
Enables the object to cast shadows.
Shadow Catcher
Enables the object to only receive shadow rays. It is to be noted that shadow catcher objects will interact
with other CG objects via indirect light interaction. This feature makes it really easy to combine CGI
elements into a real-life footage.

Example of the shadow catcher. Note how the material of the plane can still be viewed in the spheres.

Performance
Use Camera Cull
TODO.
Use Distance Cull
TODO.

Adaptive Subdivision
Note
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Implementation not finished yet, marked as an Experimental Feature Set

When using the Experimental Feature Set the Subdivision Surface Modifier gets changed to control the
subdivision of a mesh at the time of rendering. For this, all the other settings are the same except the View and
Render settings. These previously mentioned settings get removed/renamed and the following settings are
added:

Subdivision Surface Modifier.
Preview
Levels
The levels of subdivision to see in the 3D View, this works the same as the View setting on the original
Subdivision Modifier.
Render
Adaptive
Use OpenSubdiv to give different subdivision levels to near and far objects automatically. This allows
nearer object to get more subdivisions and far objects to get less.
Dicing Rate
When using Adaptive the Render Levels property gets changed to Dicing Rate, this property is used
to multiply the scene dicing rate.
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Subdivision Off/On, Dicing Rate: 1.0 - 0.3 - 0.05 (Monkeys look identical in viewport, no
modifiers).
Levels
The levels of subdivision to see in the final render, this works the same as the Render setting on the
original Subdivision Modifier.

Known limitations
• Missing support for UV subdivision.
• Creases do not match Blender creases currently.
• Multi-user object data are currently made single users, leading to increased memory usage. For those it
is better to use non-adaptive subdivision still.
• Multi-view renders can have some inconsistencies between views.
• Editing displacement shaders while using True Displacement does not update the viewport.
Warning
Particle instances, Group instances, Dupliverts and Dupligroups are not tessellated individually. Instead, the
original object is tessellated and then duplicated on all instances. To take advantage of both adaptive
subdivision and instancing you should place the original object at the position of the instance that is closest
from the camera.

Hair Particles
These are extra settings for Hair Particles used by Cycles.
There are also scene level hair settings which can be found with the Geometry settings.

Hair Settings
The Cycles Hair Settings, under the particle tab, are used to control each hair particle system’s strand
properties.
Shape
A shape parameter that controls the transition in thickness between the root and tip. Negative values make
the primitive rounded more towards the top, the value of zero gives makes the primitive linear, and
positive values makes the primitive rounded more towards the bottom.

Thickness
Root
Multiplier of the hair width at the root.
Tip
Multiplier of the hair width at the tip.
Scaling
Multiplier for the Root and Tip values. This can be used to change the thickness of the hair.
Close tip
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Sets the thickness at the tip to zero, even when using a non-zero tip multiplier.

Texture
ToDo
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GPU Rendering
Introduction
GPU rendering makes it possible to use your graphics card for rendering, instead of the CPU. This can speed up
rendering, because modern GPUs are designed to do quite a lot of number crunching. On the other hand, they
also have some limitations in rendering complex scenes, due to more limited memory, and issues with
interactivity when using the same graphics card for display and rendering.
Cycles has two GPU rendering modes: CUDA, which is the preferred method for NVIDIA graphics cards; and
OpenCL, which supports rendering on AMD graphics cards.

Configuration
To enable GPU rendering, go into the User Preferences, and under the System tab, select the Compute
Device(s) to use. Next, for each scene, you can configure to use CPU or GPU rendering in the Render
properties.

CUDA
NVIDIA CUDA is supported for GPU rendering with NVIDIA graphics cards. We support graphics cards
starting from GTX 4xx (computing capability 2.0).
Cycles requires recent NVIDIA drivers to be installed, on all operating systems.
List of CUDA cards with shader model
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OpenCL
OpenCL is supported for GPU rendering with AMD graphics cards. We only support graphics cards with
GCN architecture (HD 7xxx and above). Not all HD 7xxx cards are GCN cards though, you can check if your
card is here.
Cycles requires recent AMD drivers to be installed, on all operating systems.

Supported Features and Limitations
For an overview of supported features, check the comparison in the Features.
CUDA:
The maximum amount of individual textures is limited to 95 byte-image textures (PNG, JPEG, ..) and 5
float-image textures (OpenEXR, 16 bit TIFF, ..) on GTX 4xx/5xx cards, and 145 byte-image textures and
5 float-image textures on GTX6xx cards and above.
OpenCL:
No support for HDR (float) textures at the moment.

Frequently Asked Questions
Why is Bforartists unresponsive during rendering?
While a graphics card is rendering, it can not redraw the user interface, which makes Bforartists unresponsive.
We attempt to avoid this problem by giving back control over the GPU as often as possible, but a completely
smooth interaction can’t be guaranteed, especially on heavy scenes. This is a limitation of graphics cards for
which no true solution exists, though we might be able to improve this somewhat in the future.
If possible, it is best to install more than one GPU, using one for display and the other(s) for rendering.

Why does a scene that renders on the CPU not render on the GPU?
There maybe be multiple causes, but the most common is that there is not enough memory on your graphics
card. We can currently only render scenes that fit in graphics card memory, and this is usually smaller than that
of the CPU. Note that, for example, 8k, 4k, 2k and 1k image textures take up respectively 256MB, 64MB,
16MB and 4MB of memory.
We do intend to add a system to support scenes bigger than GPU memory, but this will not be added soon.

Can I use multiple GPUs for rendering?
Yes, go to User Preferences > System > Compute Device Panel, and configure it as you desire.

Would multiple GPUs increase available memory?
No, each GPU can only access its own memory.

What renders faster, NVIDIA or AMD, CUDA or OpenCL?
Currently NVIDIA with CUDA is rendering faster. There is no fundamental reason why this should be so - we
don’t use any CUDA - specific features - but the compiler appears to be more mature, and can better support big
kernels. OpenCL support is still in an early stage and has not been optimized as much.
2
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Error Messages
Unsupported GNU version! gcc 4.7 and up are not supported!
On Linux, depending on your GCC version you might get this error.
If so, delete the following line in /usr/local/cuda/include/host_config.h
#error -- unsupported GNU version! gcc 4.7 and up are not supported!

CUDA Error: Invalid kernel image
If you get this error on MS-Windows 64-bit, be sure to use the 64-bit build of Bforartists, not the 32-bit version.

CUDA Error: Out of memory
This usually means there is not enough memory to store the scene on the GPU. We can currently only render
scenes that fit in graphics card memory, and this is usually smaller than that of the CPU. See above for more
details.

The NVIDIA OpenGL driver lost connection with the display driver
If a GPU is used for both display and rendering, MS-Windows has a limit on the time the GPU can do render
computations. If you have a particularly heavy scene, Cycles can take up too much GPU time. Reducing Tile
Size in the Performance panel may alleviate the issue, but the only real solution is to use separate graphics cards
for display and rendering.
Another solution can be to increase the timeout, although this will make the user interface less responsive when
rendering heavy scenes. Learn More Here.

CUDA error: Unknown error in cuCtxSynchronize()
An unknown error can have many causes, but one possibility is that it’s a timeout. See the above answer for
solutions.
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10.3.10 Render - Cycles Render Engine - Render Baking
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Open Shading Language
Render Baking
Refer to the Blender Render page for general baking guidelines
Cycles uses the render settings (samples, bounces, …) for baking. This way the quality of the baked textures
should match the result you get from the rendered scene.
The baking happens into the respective active textures of the object materials. The active texture is the last
selected Image Texture node of the material node tree. That means the active object (or the selected objects,
when not baking ‘Selected to Active’) needs a material, and that material needs at least an Image Texture node,
with the image to be used for the baking. Note, the node does not need to be connected to any other node. The
active texture is what projection painting and the viewport use as a criteria to which image to use. This way
after the baking is done you can automatically preview the baked result in the Texture mode.

Options

Ambient Occlusion Pass.

Bake Mode
Combined
Bakes all materials, textures, and lighting except specularity.
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Combined Pass Options.
The passes that contribute to the combined pass can be toggled individually to form the final map.
Ambient Occlusion
Bakes ambient occlusion as specified in the World panels. Ignores all lights in the scene.
Shadow
Bakes shadows and lighting.
Normals
Bakes normals to an RGB image.

Normal Pass Options.
Normal Space
Normals can be baked in different spaces:
Object space
Normals in object coordinates, independent of object transformation, but dependent on
deformation.
Tangent space
Normals in tangent space coordinates, independent of object transformation and deformation.
This is the default, and the right choice in most cases, since then the normal map can be used
for animated objects too.
Normal Swizzle
Axis to bake into the red, green and blue channel.
For materials the same spaces can be chosen in the image texture options next to the existing Normal
Map setting. For correct results, the setting here should match the setting used for baking.
UV
Bakes colors of materials and textures only, without shading.
Emit
Bakes Emission, or the Glow color of a material.
Environment
Bakes the environment as seen from the center of the object.
Diffuse, Glossy, Transmission, Subsurface
Bakes the diffuse, glossiness, transmission of subsurface pass of a material.
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Diffuse Pass Options.
• If only color is selected you get the pass color, which is a property of the surface and independent
of sampling refinement.
• If color is not selected, you get the direct and/or indirect contributions in grayscale.
• If color and either direct or indirect are selected, you get the direct and/or indirect contributions
colored.

Additional Options
Margin
Baked result is extended this many pixels beyond the border of each UV “island,” to soften seams in the
texture.
Clear
If selected, clears the image before baking render.
Select to Active
Bake shading on the surface of selected objects to the active object. The rays are cast from the lowpoly
object inwards towards the highpoly object. If the highpoly object is not entirely involved by the lowpoly
object, you can tweak the rays start point with Ray Distance or Cage Extrusion (depending on whether or
not you are using cage). For even more control you can use a Cage Object.
Note
Memory Usage
There is a CPU fixed memory footprint for every object used to bake from. In order to avoid crashes due to
lack of memory, the highpoly objects can be joined before the baking process. The render tiles parameter also
influence the memory usage, so the bigger the tile the less overhead you have, but the more memory it will
take during baking (either in GPU or CPU).

Cage
Cast rays to active object from a cage. A cage is a ballooned-out version of the lowpoly mesh created
either automatically (by adjusting the ray distance) or manually (by specifying an object to use). When
not using a cage the rays will conform to the mesh normals. This produces glitches on the edges, but it is
a preferable method when baking into planes to avoid the need of adding extra loops around the edges.
Ray Distance
Distance to use for the inward ray cast when using selected to active. Ray distance is only available when
not using Cage.
Cage Extrusion
Distance to use for the inward ray cast when using Selected to Active and Cage. The inward rays are
casted from a version of the active object with disabled Edge Split Modifiers. Hard splits (e.g., when the
Edge Split Modifier is applied) should be avoided because they will lead to non-smooth normals around
the edges.
Cage
Object to use as cage instead of calculating the cage from the active object with the Cage Extrusion.
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Note
When the base mesh extruded does not give good results, you can create a copy of the base mesh and
modify it to use as a Cage. Both meshes need to have the same topology (number of faces and face
order).
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Reducing Noise
When performing a final render, it is important to reduce noise as much as possible. Here we’ll discuss a
number of tricks that, while breaking the laws of physics, are particularly important when rendering animations
within a reasonable time. Click to enlarge the example images to see the noise differences well.

Path Tracing
Cycles uses path tracing with next event estimation, which is not good at rendering all types of light effects,
like caustics, but has the advantage of being able to render more detailed and larger scenes compared to some
other rendering algorithms. This is because we do not need to store, for example, a photon map in memory, and
because we can keep rays relatively coherent to use an on-demand image cache, compared to e.g. bidirectional
path tracing.

We do the inverse of what reality does, tracing light rays from the camera into the scene and onto lights, rather
than from the light sources into the scene and then into the camera. This has the advantage that we do not waste
light rays that will not end up in the camera, but also means that it is difficult to find some light paths that may
contribute a lot. Light rays will be sent either according to the surface BRDF, or in the direction of known light
sources (lamps, emitting meshes with Sample as Lamp).
For more details, see the Light Paths and Integrator documentation.

Where Noise Comes From
To understand where noise can come from, take for example this scene. When we trace a light ray into the
1
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specified location, this is what the diffuse shader “sees”. To find the light that is reflected from this surface, we
need to find the average color from all these pixels. Note the glossy highlight on the sphere, and the bright spot
the lamp casts on the nearby wall. These hotspots are 100x brighter than other parts of the image and will
contribute significantly to the lighting of this pixel.

The lamp is a known light source, so it will not be too hard to find, but the glossy highlight (s) that it causes are
a different matter. The best we can do with path tracing is to distribute light rays randomly over the hemisphere,
hoping to find all the important bright spots. If for some pixels we miss some bright spot, but we do find it for
another, that results in noise. The more samples we take, the higher the probability that we cover all the
important sources of light.
With some tricks we can reduce this noise. If we blur the bright spots, they become bigger and less intense,
making them easier to find and less noisy. This will not give the same exact result, but often it’s close enough
when viewed through a diffuse or soft glossy reflection. Below is an example of using Filter Glossy and
Smooth Light Falloff.

Bounces
In reality light will bounce a huge number of times due to the speed of light being very high. In practice more
bounces will introduce more noise, and it might be good to use something like the Limited Global Illumination
preset that uses fewer bounces for different shader types. Diffuse surfaces typically can get away with fewer
bounces, while glossy surfaces need a few more, and transmission shaders such as glass usually need the most.
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Also important is to use shader colors that do not have components of value 1.0 or values near that; try to
keep the maximum value to 0.8 or less and make your lights brighter. In reality, surfaces are rarely perfectly
reflecting all light, but there are of course exceptions; usually glass will let most light through, which is why we
need more bounces there. High values for the color components tend to introduce noise because light intensity
then does not decrease much as it bounces off each surface.

Caustics and Filter Glossy
Caustics are a well-known source of noise, causing fireflies. They happen because the renderer has difficulty
finding specular highlights viewed through a soft glossy or diffuse reflection. There is a No Caustics option to
disable glossy behind a diffuse reflection entirely. Many render engines will typically disable caustics by
default.

However using No Caustics will result in missing light, and it still does not cover the case where a sharp glossy
reflection is viewed through a soft glossy reflection. There is a Filter Glossy option to reduce the noise from
such cases at the cost of accuracy. This will blur the sharp glossy reflection to make it easier to find, by
increasing the shader Roughness.
The above images show default settings, no caustics, and filter glossy set to 1.0.

Light Falloff
In reality light in a vacuum will always fall off at a rate of 1/(distance^2). However as distance goes to zero,
this value goes to infinity and we can get very bright spots in the image. These are mostly a problem for indirect
lighting, where the probability of hitting such a small but extremely bright spot is low and so happens only
rarely. This is a typical recipe for fireflies.
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To reduce this problem, the Light Falloff node has a Smooth factor, that can be used to reduce the maximum
intensity a light can contribute to nearby surfaces. The images above show default falloff and smooth value 1.0.

Sample as Lamp
Materials with emission shaders can be configured to be sampled as lamp (Material Settings). This means that
they will get rays sent directly towards them, rather than ending up there based on rays randomly bouncing
around. For very bright mesh light sources, this can reduce noise significantly. However when the emission is
not particularly bright, this will take samples away from other brighter light sources for which it is important to
find them this way.
The optimal setting here is difficult to guess; it may be a matter of trial and error, but often it is clear that a
somewhat glowing object may be only contributing light locally, while a mesh light used as a lamp would need
this option enabled. Here is an example where the emissive spheres contribute little to the lighting, and the
image renders with slightly less noise by disabling Sample as Lamp on them.

The world background also has a Sample as Lamp (World Settings) option. This is mostly useful for
environment maps that have small bright spots in them, rather than being smooth. This option will then, in a
preprocess, determine the bright spots, and send light rays directly towards them. Again, enabling this option
may take samples away from more important light sources if it is not needed.

Glass and Transparent Shadows
With caustics disabled, glass will miss shadows, and with filter glossy they might be too soft. We can make a
glass shader that will use a Glass BSDF when viewed directly, and a Transparent BSDF when viewed
indirectly. The Transparent BSDF can be used for transparent shadows to find light sources straight through
surfaces, and will give properly-colored shadows, but without the caustics. The Light Path node is used to
determine when to use which of the two shaders.
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Above we can see the node setup used for the glass transparency trick; on the left the render has too much
shadow due to missing caustics, and on the right the render with the trick.

Window Lights
When rendering a daylight indoor scene where most of the light is coming in through a window or door
opening, it is difficult for the integrator to find its way to them. We can replace the opening with a plane with an
emission shader, so that the integrator knows in which direction to fire rays. For camera rays we can make this
mesh light invisible, so that we can still look into the outside scene. This is done either by disabling camera ray
visibility on the object, or by switching between glass and emission shaders in the material.
The two renders below have the same render time, with the second render using a mesh light positioned in the
window.

In newer versions, light portals provide a better solution.

Clamp Fireflies
Ideally with all the previous tricks, fireflies would be eliminated, but they could still happen. For that, the
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intensity that any individual light ray sample will contribute to a pixel can be clamped to a maximum
value with the integrator Clamp setting. If set too low this can cause missing highlights in the image, which
might be useful to preserve for camera effects such as bloom or glare.
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Render Panel

Render panel.
Render F12
Starts rendering a still image of the current frame.
Animation Ctrl-F12
Starts rendering an animation. See Rendering Animations for more detail.
Audio
Mixes all the audio found in a scene and saves into one file. See Introduction.
By default the biggest area is replaced with the UV/Image Editor and the render appears.
To cancel the rendering process click the cancel button X besides the progressbar in the Info Editor, or press
Esc.

Display
Renders are displayed in the UV/Image Editor. You can set the way this is displayed to several different options
in the Display menu:
Display
1
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Keep UI
The image is rendered to the UV/Image Editor, but the UI remains the same. You will need to open
the UV/Image Editor manually to see the render result.
New Window
A new floating window opens up, displaying the render.
Image Editor
One of the existing editors is replaced with the UV/Image Editor, showing the render.
Full Screen
The UV/Image Editor replaces the UI, showing the render.
Lock Interface
Lock interface during rendering in favor of giving more memory to the renderer.

Output Options
The first step in the rendering process is to determine and set the output options. This includes render size,
frame rate, pixel aspect ratio, output location, and file type.

Dimensions panel

Dimensions Panel.
Render Presets
Common format presets for TVs and screens.
Resolution
X/Y
The number of pixels horizontally and vertically in the image.
Percentage
Slider to reduce or increase the size of the rendered image relative to the X/Y values above. This is
useful for small test renders that are the same proportions as the final image.
Aspect Ratio
Older televisions may have non-square pixels, so this can be used to control the shape of the pixels along
the respective axis. This will pre-distorted the images which will look stretched on a computer screen, but
which will display correctly on a TV set. It is important that you use the correct pixel aspect ratio when
rendering to prevent re-scaling, resulting in lowered image quality.
See Video Output for details on pixel aspect ratio.
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Border
You can render just a portion of the view instead of the entire frame. While in Camera View, press CtrlB and drag a rectangle to define the area you want to render. Ctrl-Alt-B is the shortcut to disable the
border.
Note
This disables the Save Buffers option in Performance and Full Sample option in Anti-Aliasing.
Enabling Crop will crop the rendered image to the Border size, instead of rendering a black region around
it.
Frame Range
Set the Start and End frames for Rendering Animations. Step controls the number of frames to advance by
for each frame in the timeline.
Frame Rate
For an Animation the frame rate is how many frames will be displayed per second.
Time Remapping
Use to remap the length of an animation.

Output Panel

Output panel.
This panel provides options for setting the location of rendered frames for animations, and the quality of the
saved images.
File Path
Choose the location to save rendered frames.
When rendering an animation, the frame number is appended at the end of the file name with four padded
zeros (e.g. image0001.png). You can set a custom padding size by adding the appropriate number of #
anywhere in the file name (e.g. image_##_test.png translates to image_01_test.png).
This setting expands relative paths where a // prefix represents the directory of the current blend-file.
Overwrite
Overwrite existing files when rendering.
Placeholders
Create empty placeholder frames while rendering.
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File Extensions
Adds the correct file extensions per file type to the output files.
Cache Result
Saves the rendered image and passes to a Multilayer EXR-file in temporary location on your hard drive.
This allows the compositor to read these to improve performance, especially for heavy compositing.
Output Format
Choose the file format to save to. Based on which format is used, other options such as channels, bitdepth and compression level are available.
For rendering out to images see: saving images for rendering to videos see rendering to videos
Color Mode
Choose the color format to save the image to. Note that RGBA will not be avaible for all image formats.
BW, RGB, RGBA
Hint
Primitive Render-Farm
An easy way to get multiple machines to share the rendering workload is to:
• Set up a shared directory over a network file-system.
• Disable Overwrite, enable Placeholders in the Render Output panel.
• Start as many machines as you wish rendering to that directory

Video Output

Preparing your work for video
Once you master the art of 3D animation, you will probably want to share your work with others; either on the
internet (YouTube, Vimeo, etc) or with family and friends (DVD/Bluray) or even possibly for television
broadcast.
To spare you some disappointment, here are some tips specifically targeted at video preparation.

Safe Areas and Overscan
For anyone creating motion graphics or simple text overlays, overscan is an important consideration. Although
its origins are rooted in historic analog TV systems, unfortunately even in 2017, for various reasons it can still
be an issue with modern digital flatscreen TVs.
Note
Due to various limitations in analog TV equipment, the displayed image could sometimes end up shifted
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horizontally or vary in size, which could lead to the area beyond the intended visible picture being shown. This
hidden area sometimes contained junk noise, timing signals or closed-caption/subtitle data. To avoid this being
visible to the viewer, the standard approach for TV manufacturers was to ‘overscan’ (zoom in) the displayed
picture by a small amount (between 5-10% edge crop) to ensure that at no time would the hidden areas be
visible.
Although modern digital electronics have eliminated the issue of shifting image position, unfortunately, some
TV manufacturers have included overscan on their flatscreen TVs. Why? Because for many years it was given
that the edge of the visible image would rarely be seen, so broadcasters would sometimes overlay ‘hidden’ data
to the very edge of the image (e.g. some types of closed captions). Also, legacy analog recordings might still
contain unwanted noise around the edge. To avoid consumer complaints, overscan is quite often enabled by
default. For some flatscreen TVs, it is not possible to disable it.

Enabling Safe Areas
Blender has configurable safe-area markings which can be made visible by selecting the scene camera, then in
the camera settings by enabling Safe Areas. Several presets are available. If you are producing work for a
television network or indeed any client, they may have their own rules and requirements on safe area
dimensions – so consult with them.

Color Reproduction
When exporting to many of the common video formats, the rendered RGB(A) images go through a conversion
process whereby they are translated to the YCbCr color model. Y corresponds to a grayscale representation of
the image, Cb and Cr contain data for the blue and red channels respectively. Green is encoded into the Y and
Cb, Cr channels with some clever math.
Importantly, the color components are often stored at a lower resolution to the Y (grayscale) channel. This can
cause blurring/smearing which can be a problem with small text and some saturated color combinations – so it
is well worth doing test encodes to make sure that text remains legible. As with safe areas, a TV network or
client might have their own rules on minimum text size and positioning, so always seek clarification when
unsure.

Encoding Panel
Reference
Panel: Properties editor ‣ Render ‣ Encoding
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Encoding panel.
Here you choose which video container, codec, and compression settings you want to use. With all of these
compression choices, there is a tradeoff between file size, compatibility across platforms, and playback quality.
Tip
When you view the System Console, you can see some of the output of the encoding process. You will see
even more output if you execute Blender as blender -d.

Presets
You can use the presets, which choose optimum settings for you for that type of output.
Container
Video container or file type. For a list of all available options, see video formats.
Autosplit Output
If your video is huge and exceeds 2GiB, enable Autosplit Output. This will automatically split the output
into multiple files after the first file is 2Gig.
Codec
Chooses the method of compression and encoding. For a list of all available options see video formats.
Note
Standards
Some containers and codecs are not compatible with each other, so if you are getting errors check that your
container and codec are compatible. Like containers and codecs are sometimes not compatible with each other,
some codecs do not work with arbitrary dimensions. So, try to stick with common dimensions or research the
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limitations of the codec you are trying to use.

Output Quality
These are preset Rates
Encoding Speed
Presets to change between a fast encode (bigger file size) and more compression (smaller file size)
Key Frame Interval
The number of pictures per Group of Pictures. Set to 0 for “intra_only”, which disables inter-frame video.
A higher number generally leads to a smaller file but needs a higher-powered device to replay it.
Max B-frames
Enables the use of B-frames.
Interval
The maximum number of B-frames between non-B-frames.

Rate
Bitrate
Sets the average bitrate (quality), which is the count of binary digits per frame. See also: FFmpeg -b:v.
Rate
Video files can use what is called variable bitrate (VBR). This is used to give some segments of the video
less compressing to frames that need more data and less to frames with less data. This can be controlled
by the Minimum and a Maximum values.
Buffer
The decoder bitstream buffer size.

Mux
Multiplexing <http://www.afterdawn.com/glossary/term.cfm/multiplexing>`__ is the process of combining
separate video and audio streams into a single file, similar to packing a video file and .mp3 audio file in a zipfile.
Rate
Maximum bit rate of the multiplexed stream.
Packet Size
Reduces data fragmentation or muxer overhead depending on the source.

Audio
Audio Codec
Audio format to use. For a list of all available options, see video formats.
Bitrate
For each codec, you can control the bitrate (quality) of the sound in the movie. Higher bitrates are bigger
files that stream worse but sound better. Use powers of 2 for compatibility.
Volume
Sets the output volume of the audio.
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Tips
The choice of video format depends on what you are planning to do.
It’s not recommended to render directly to a video format in the first instance. If a problem occurs while
rendering, the file might become unplayable and you will have to re-render all frames from the beginning. If
you first render out a set of static images such as the default PNG format or the higher-quality OpenEXR
(which can retain HDR pixel data), you can combine them as an Image Strip in the Video Sequence Editor
(VSE). This way, you can easily:
• Restart the rendering from the place (the frame) where any problem occurred.
• Try out different video encoding options in seconds, rather than minutes or hours as encoding is usually
much faster than rendering the 3d scene.
• Enjoy the rest of the features of the VSE, such as adding Image Strips from previous renders, audio,
video clips, etc.
You shouldn’t post-process a lossy-compressed file as the compression artifacts may become visible. Lossy
compression should be reserved as a final ‘delivery format’.
If you are planning on doing significant post-processing and color correction, it is best to output a frameset
rendered in OpenEXR format. If you plan to do only minimal changes after rendering and would prefer a single
file, choose lossless H.264 for high quality, or regular H.264 for lower quality.

Metadata

Metadata panel.
The Metadata panel includes options for writing meta-data into render output.
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Note
Only some image formats support metadata: See image formats.

Stamp Output
Add metadata as text to the render.
Stamp Text Color
Set the color and alpha of the stamp text.
Stamp Background
Set the color and alpha of the color behind the text.
Font Size
Set the size of the text.
Draw Labels
Draws the labels before the metadata text. For example, “Camera” infront of camera name etc.
Enabled Metadata
Stamping can include the following data.
Time
Includes the current scene time and render frame at HH:MM:SS.FF
Date
Includes the current date and time.
Render Time
Includes the render time.
Frame
Includes the frame number.
Scene
Includes the name of the active scene.
Memory
Includes the peak memory usage.
Note
Includes a custom note.
Hint
It can be useful to use the Note field if you are setting up a render-farm.
Since you can script any information you like into it, such as an identifier for the render-node or the jobnumber.
For details on stamping arbitrary values, see: this page.
Camera
Includes the name of the active camera.
Lens
Includes the name of the active camera’s lens value.
Filename
Includes the filename of the blend-file.
Marker
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Includes the name of the last marker.
Seq. Strip
Includes the name of the foreground sequence strip.
Sequencer
Strip Metadata
Use metadata from the strips in the sequencer.

Animation Player
The Info Editor ‣ Render ‣ Play Rendered Animation menu will play back the rendered animation in a new
window.
You can also drop images or movie files in a running animation player. It will then restart the player with the
new data.
An external player can also be used instead of the one included in Blender. To do this, select it in the User
Preferences.

Shortcuts
The following table shows the available hotkeys for the animation player.
Playback
Action
Hotkey
Start/Pau Spacebar
se:
Enter
Start
playback
(when
paused):
Esc
Quit:
Timeline
Action
Scrub in
time:
Step
back one
frame:
Step
forward
one
frame:
Step
back 10
frames:

Hotkey
LMB
Left

Right

Down
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Action
Hotkey
Up
Step
forward
10
frames:
Manual NumpadPeriod
frame
stepping
:
Playback Options
Action
Backward
playback:
Forward
playback
Slow
down
playback:
Speed up
playback:
Toggle
looping:
Toggle
frame
skipping:
Toggle
pingpong:
Display

Hotkey
Shift-Down

Action
Toggle
Time
Cursor
(Indicator
):
Flip
drawing
on the X
axis:
Flip
drawing
on the Y
axis:
Hold to
show
frame
numbers:

Hotkey

Shift-Up
Minus

Plus
Numpad0
A

P

I

F

Shift-F

Shift
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Action
Hotkey
Zoom in: Ctrl-Plus
Zoom out: Ctrl-Minus
Frame rate
•
•
•
•
•
•
•
•
•
•
•

60 fps Numpad1
50 fps Numpad2
30 fps Numpad3
25 fps Numpad4
24 fps Shift-Numpad4
20 fps Numpad5
15 fps Numpad6
12 fps Numpad7
10 fps Numpad8
6 fps Numpad9
5 fps NumpadSlash
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Render Layers
Render layers allow you to render your scene in separate layers, usually with the intension of compositing them
back together afterwards.
This can be useful for several purposes, such as color correcting certain elements differently, blurring the
foreground as a fast manual method of creating DoF, or reducing the render quality for unimportant objects.
Using Render Layers can also save you from having to re-render your entire image each time you change
something, allowing you to instead re-render only the layer(s) that you need.

Layer List
Reference
Panel: Properties editor ‣ Scene ‣ Scene

Layer list.
This is a list of all the Render Layers in the current scene.
Only layers which are enabled (checkbox on right is ticked) will be rendered. If the Pin icon at the bottom right
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of the list is enabled, only the active (highlighted) layer will be rendered.
Render Layers can be added and removed using the + and - buttons on the right, and existing layers can be
renamed by double clicking on their name.

Layer Panel
Reference
Panel: Properties editor ‣ Scene ‣ Layer

Layer panel.
The Layer Panel shows the settings of the active Render Layer from the list above.
You can select multiple layers using Shift-LMB.
Scene
The Scene Layers, showing which are currently visible and will be rendered.
Layer
The Scene Layers which are associated with the active Render Layer. Objects in those Scene Layers will
be rendered in that Render Layer. When an object is in the Scene Layers but not the Render Layer, it will
still cast shadows and be visible in reflections, so it is still indirectly visible.
Mask Layer
Objects on these will mask out other objects appearing behind them. This can be used for compositing
objects into footage, to take into account objects in front of the virtual objects blocking the view from the
camera.
Material Override
Overrides all material settings to use the Material chosen here.
Examples of where this might be used:
• To check lighting by using a plain diffuse material on all objects
• Render a wireframe of the scene
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• Create a custom render pass such as an anti-aliased matte or global coordinates.
See also
Additional options shown in this panel are different for each render engine. See these options for:
• Blender Render
• Cycles

Usage
Each Render Layer has an associated set of Scene Layers. Objects which are on one of the associated Scene
Layers are shown in that Render Layer, as long as that Scene Layer is also visible.
Warning
Only the objects in visible Scene Layers will be rendered. So, if only Scene Layer 1 is visible and your Render
Layer set specifies to render only Layers 2 and 3, nothing will be rendered.

Post Processing Panel
Reference
Panel: Properties editor ‣ Render ‣ Post Processing

The Post Processing panel is used to control different options used to process your image after rendering.

Post Processing Panel.
Sequencer
Renders the output of the sequence editor, instead of the view from the 3D scene’s active camera. If the
sequence contains scene strips, these will also be rendered as part of the pipeline. If Compositing is also
enabled, the Scene strip will be the output of the Compositor.
Compositing
Renders the output from the compositing node setup, and then pumps all images through the Composite
node map, displaying the image fed to the Composite Output node.

Dithering
Dithering is a technique for blurring pixels to prevent banding that is seen in areas of gradients, where stairstepping appears between colors. Banding artifacts are more noticeable when gradients are longer, or less steep.
Dithering was developed for graphics with low bit depths, meaning they had a limited range of possible colors.
Dithering works by taking pixel values and comparing them with a threshold and neighboring pixels then does
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calculations to generate the appropriate color. Dithering creates the perceived effect of a larger color palette by
creating a sort of visual color mixing. For example, if you take a grid and distribute red and yellow pixels
evenly across it, the image would appear to be orange.
The Dither value ranges from 0 to 2.
Note
When using Blender Internal Render you get a few more options and these are discussed here.

Color Management
Color management is one of the most important tools that an artist can use. It allows an artist to make sure that
an image stays the same from rendering, to saving, to post processing. Color management also allows an artist
to tweak things like exposure, gamma, or the overall color grade.

Different views and exposures of the same render.
To achieve color management in Blender, the OpenColorIO (OCIO) library has been integrated into Blender.
This library offers fine control over different LUT along with integrating your own set of color profiles to keep
your work linearized with other software.

Scene Linear Color Space
For correct results, different color spaces are needed for rendering display and storage of images. Rendering
and compositing is best done in scene linear color space, which corresponds more closely to nature, and makes
computations more physically accurate.
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An example of a linear workflow.
If the colors are linear, it means that if in reality, we double the number of photons, the color values are also
doubled. Put another way, if we have two photos/renders each with one of two lights on, and add those images
together, the result would be the same as a render/photo with both lights on. It follows that such a
radiometrically linear space is best for photo-realistic rendering and compositing.
However, these values do not directly correspond to human perception or the way display devices work and
image files are often stored in different color spaces, so we have to take care to do the right conversion into and
out of this linear color space.

Settings
Reference
Panel: Properties editor ‣ Scene ‣ Color Management

Scene settings for color management.

Display
Correct display of renders requires a conversion to the display device color space, which can be configured
here. A computer monitor works differently from a digital cinema projector HDTV. The scene properties have
these settings:
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Display Device
The device that the image is being viewed on.
Most computer monitors are configured for the sRGB color space, and so when working on a computer
usually this option should just be left to the default. It would typically be changed when viewing the
image on another display device connected to the computer, or when writing out image files intended to
be displayed on another device.
Rec709 is commonly used for HDTVs, while XYZ and DCI-P3 are common for digital projectors.
Color management can be disabled by setting the device to None.

Conversion from linear to display device space.

Render
There is also an artistic choice to be made for renders. Partially that is because display devices cannot display
the full spectrum of colors and only have limited brightness, so we can squeeze the colors to fit in the gamut of
the device. Besides that, it can also be useful to give the renders a particular look, e.g. as if they have been
printed on real film.
Another common use case is when you want to inspect renders, to see details in dark shadows or bright
highlights, or identify render errors. Such settings would be only used temporarily and not get used for final
renders.
View
These are different ways to view the image on the same display device.
Default
Does no extra conversion besides the conversion for the display device.
RRT
Uses the ACES Reference Rendering Transform, to simulate a film-like look.
Film
Uses a technique known as film emulation to give renders a look similar to what might be expected
from a film based camera. This is usually done by crushing the blacks and decreasing the contrast of
the image.
Raw
Intended for inspecting the image but not for final export. Raw gives the image without any color
space conversion.
Log
Intended for inspecting the image but not for final export. Log works similar to Raw but gives a
more “flat” view of the image without very dark or light areas.
Exposure
Used to control the image brightness (in stops) applied before color space conversion. 2(stops)×value
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Gamma
Extra gamma correction applied after color space conversion. Note that the default sRGB or Rec709 color
space conversions already include a gamma correction of approximately 2.2 (except the Raw and Log
views), so this would be applied in addition to that.
Look
Choose an artistic effect from a set of measured film response data which roughly emulates the look of
certain film types. Applied before color space conversion.
Use Curves
Adjust RGB Curves to control image colors before color space conversion. Read more about using the
Curve Widget.

Sequencer
Color Space
The color space that the sequencer operates in. By default, the sequencer operates in sRGB space, but it
can also be set to work in Linear space like the Compositing nodes, or another color space. Different
color spaces will give different results for color correction, crossfades, and other operations.

Image Files
When loading and saving media formats it is important to have color management in mind. File formats such as
PNG or JPEG will typically store colors in a color space ready for display, not in a linear space. When they are,
for example, used as textures in renders, they need to be converted to linear first, and when saving renders for
display on the web, they also need to be converted to a display space. Other file formats like OpenEXR store
linear color spaces and as such are useful as intermediate files in production.
When working with image files, the default color space is usually the right one. If this is not the case, the color
space of the image file can be configured in the image settings. A common situation where manual changes are
needed is when working with or baking normal maps or displacement maps, for example. Such maps do not
actually store colors, just data encoded as colors. In such cases, they should be marked as Non-Color Data.
Image data-blocks will always store float buffers in memory in the scene linear color space, while a byte buffer
in memory and files in a drive are stored in the color space specified with this setting:
Color Space
The color space of the image file on a drive. This depends on the file format, for example, PNG or JPEG
images are often stored in sRGB, while OpenEXR images are stored in a linear color space. Some images
such as normal, bump or stencil maps do not strictly contain ‘colors’, and on such values, no color space
conversion should ever be applied. For such images, the color space should be set to None.

Image settings for color management.
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By default only renders are displayed and saved with the render view transformations applied. These are the
Render Result and Viewer image data-blocks, and the files saved directly to a drive with the Render Animation
operator. However, when loading a render saved to an intermediate OpenEXR file, Blender cannot detect
automatically that this is a render (it could be e.g. an image texture or displacement map). We need to specify
that this is a render and that we want the transformations applied, with these two settings:
View as Render
Display the image data-block (not only renders) with view transform, exposure, gamma, RGB curves
applied. Useful for viewing rendered frames in linear OpenEXR files the same as when rendering them
directly.
Save as Render
Option in the image save operator to apply the view transform, exposure, gamma, RGB curves. This is
useful for saving linear OpenEXR to e.g. PNG or JPEG files in display space.

OpenColorIO Configuration
Blender comes with a standard OpenColorIO configuration that contains a number of useful display devices
and view transforms. The reference linear color space used is the linear color space with Rec. 709
chromaticities and D65 white point.
However, OpenColorIO was also designed to give a consistent user experience across multiple applications,
and for this, a single shared configuration file can be used. Blender will use the standard OCIO environment
variable to read an OpenColorIO configuration other than the default Blender one. More information about how
to set up such a workflow can be found on the OpenColorIO website.
We currently use the following color space rules:
scene_linear
Color space used for rendering, compositing, and storing all float precision images in memory.
default_sequencer
Default color space for sequencer, scene_linear if not specified
default_byte
Default color space for byte precision images and files, texture_paint if not specified.
default_float
Default color space for float precision images and files, scene_linear if not specified.
The standard Blender configuration also includes some support for ACES (code and documentation), even
though we have a different linear color space. It is possible to load and save EXR files with the Linear ACES
color space, and the RRT view transform can be used to view images with their standard display transform.
However, the ACES gamut is larger than the Rec. 709 gamut, so for best results, an ACES specific
configuration file should be used. OpenColorIO provides an ACES configuration file, though it may need a few
more tweaks to be usable in production.
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Freestyle
What is FreeStyle?
Freestyle is an edge- and line-based non-photorealistic (NPR) rendering engine. It relies on mesh data and zdepth information to draw lines on selected edge types. Various line styles can be added to produce artistic
(“hand drawn”, “painted”, etc.) or technical (hard line) looks.
The two operating modes - Python Scripting and Parameter Editor - allow a powerful diversity of line styles
and results. Line styles such as Japanese big brush, cartoon, blueprint, thickness-with-depth are already prescripted in Python. The Parameter Editor mode allows intuitive editing of features such as dotted lines and easy
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setup of multiple line types and edge definitions. On top of all of that, with the introduction of line style
modifiers, the sky is the limit!

A cartoon scene from OHA Studio (the .blend file). © Mechanimotion Entertainment.

Blueprint render of Martin M-130 from 1935 by LightBWK. CC0. WARNING: HEAVY FILE! DESIGNED FOR STRESS TEST
Bforartists TO THE LIMITS & MAY CRASH Bforartists. (File:M-130Blueprint.zip)
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HVAC Pre-Viz by Lee Posey. CC0 (File:HVACPreViz.zip)

Kitchen by Vicente Carro. © AnigoAnimation

More artwork can be found at
http://wiki.Bforartists.org/index.php/Dev:Ref/Release_Notes/2.67/FreeStyle#Freestyle_Artwork_Showcase
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The Big Picture
• Activate FreeStyle by Properties window –> Render tab –> FreeStyle panel, tick check box. Please note
that FreeStyle is only available for the Bforartists Internal renderer.
• Freestyle settings are located in the new Render Layers context.
• One render layer can only have one viewmap. A viewmap holds the edge detection settings (Crease
Angle, Culling toggle, Face Smoothness toggle, Material Boundaries toggle, Sphere Radius and Kr
Derivative Epsilon advanced options).
• A viewmap can have multiple line sets.
• A line set controls which line types and selections will be rendered, from lines based on your scene.
• Each line set uses one line style (which can be shared between multiple line sets).
• A line style tells Freestyle how to render the linked line sets in terms of color, alpha, thickness and other
aspects.

block diagram of Freestyle view map and processes

Known Limitations
• Highly memory demanding: All mesh objects in a render layer are loaded at once.
• Only faced mesh objects are supported. The following kinds of meshes are ignored:
• Mesh faces with wire materials.
• Mesh faces with completely transparent materials.
• Mesh faces with the Cast Only material option enabled.
• Transparent faces are treated as opaque faces.
• No edges at face intersections are detected yet.
• Layer masks do not work with Freestyle.
• Freestyle rendering results do not have any Z depth information.
• Panoramic cameras are not supported.
5
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Core Options

Freestyle core options.

Activating Freestyle in the Render context of the Buttons window will give you the following options:
Line Thickness
There are two different modes for defining the base line thickness:
Absolute
The line thickness is given by a user-specified number of pixels. The default value is 1.0.
Relative
The unit line thickness is scaled by the proportion of the present vertical image resolution to 480
pixels. For instance, the unit line thickness is 1.0 with the image height set to 480, 1.5 with 720, and
2.0 with 960.
Line Thickness
Only for Absolute line thickness: base line thickness in pixels, 1.0 by default.

Viewmaps
There is only one viewmap per render layer. It controls the edge detection parameters. Which detected edges are
actually rendered, and how, can be controlled either through the user-friendly parameter editor, or powerful but
complex Python scripting.
Face Smoothness
When enabled, Face Smoothness will be taken into account for edges calculation.

Parameter Editor Mode UI

Crease Angle
If two adjacent faces form an angle less than the defined Crease Angle, the edge between them will be
rendered when using Crease edge type selection in a line set. The value also affects Silhouette edge type
selection.
6
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Culling
Ignore the edges that are out of view (saves some processing time and memory, but may reduce the
quality of the result in some cases).

Advanced Options

Advanced Options

Sphere Radius It affects the calculation of curvatures for Ridge, Valley and Suggestive Contour edge type
selection in a line set.
Kr Derivative Epsilon
It provides you with control over the output of Suggestive Contour and Silhouette edge type selection (further
information in this pdf).

Parameter Editor
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Parameter Editor

The Freestyle Parameter Editor is a user-friendly interface to define and control line sets and line styles.
Line Sets
control which of the edges detected by Freestyle will actually be used (rendered).
Line Styles
control how the selected edges are rendered.
A view map (hence a render layer) can have multiple line sets, and each line set is linked to one line style.

Line Set
A line set selects, among the lines (edges) detected by Freestyle, which ones will be rendered using its attached
line style, through various methods.

8
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Examples of some basic edge types by LightBWK (File:EdgeType.zip)

Selection by Visibility
There are three choices for selecting edges by visibility.
Visible
Only lines occluded by no surfaces are rendered.
Hidden
Lines occluded by at least one surface are rendered.

Proof of concept of visible and hidden edges by LightBWK (Sample .blend)
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QI Range
QI stands for Quantitative Invisibility. Lines occluded by a number of surfaces in the given range are
rendered.
Start and End
Only with QI Range, min/max number of occluding surfaces for a line to be rendered.

QI Range proof of concept demo, Start: 3, End: 7, by LightBWK (Sample .blend)

Selection by Edge Types
Edge types are basic algorithms for the selection of lines from geometry. When using the parameter editor you
have to choose at least one edge type in order to get a render output, but several edge types can be combined in
one line set. Edge types can also be excluded from calculation by pressing the X next to them.
Silhouette
Draws silhouettes around your closed objects; it is often good for organic objects (like Suzanne &
Sphere), and bad for sharp edges, like a box. It can’t render open mesh objects like open cylinders and flat
planes. The output is affected by the Kr Derivative Epsilon viewmap setting.
Crease
Shows only edges whose adjacent faces form an angle greater than the defined viewmap’s Crease Angle.
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Crease Angle proof of concept for 121º by LightBWK ( the .blend file)

Border
Border is for open/unclosed edge meshes; an open cylinder has an open edge at the top and bottom, and a
plane is open all around. Suzanne’s eye socket is an open edge. All open edges will have lines rendered.
This depends on the mesh structure.
Edge Marks
Renders marked edges. See Edge Marks for details.
Contour
Draws the outer edges and inner open border.
External Contour
Draws the contour lines, but only on the outer edges.

Left pair: Contour; Right pair: External Contour
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Suggestive Contour
Draws some lines which would form the contour of the mesh if the viewport was shifted. Depends on
your viewmap settings for Kr Derivative Epsilon and Sphere Radius (further information: File:Manual2.6-Render-Freestyle-PrincetownLinestyle.pdf).
Material Boundary
Draws lines where two materials meet on the same object. Must be activated in the viewmap settings.
Ridge & Valley
Draws ridges and valleys. Depends on your Sphere Radius viewmap settings.

Edge Marks

Select and mark Freestyle edges.

12
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Edge Mark setting in the Line Sets tab.

In edit mode you can mark “Freestyle Edges” in the same manner you can mark “Seams” for UV unwrapping
or “Sharp” for edge split. These marked edges are available to render when you select Edge Mark.
This is done as follows:
• Select your mesh and tab into Edit mode.
• Select the edges you want to be marked.
• Press Ctrl-E and select Mark Freestyle Edge.
Edge marks are useful when you want to draw lines along particular mesh edges. The examples below explain
the use of edge marks.

Render without Edge Marks.

Render with Edge Marks enabled.

Marking Freestyle Edges in edit mode.

The image on the left shows a sphere in Edit mode. The green lines are the edge marks. On the right you see a
render without edge marks enabled.
13
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With edge marks enabled, the previously-marked lines are always rendered. You can see the black contour lines
and the blue lines that are made with edge marks.
What are edge marks good for?
• When you need to render marks on an almost-flat plane, when other edge types can’t detect any line.
• When you want full control of edge rendering. Often used for edges of squarish shapes.
• Mark the whole base mesh to be rendered for base mesh preview.
What are edge marks not good for?
• Round outer edges (use instead Contour / External Contour / Silhouette).

Selection by Face Marks

Mark Freestyle Faces.

To set a face mark:
• Select a mesh and tab into Edit mode.
• Select the faces you want to be marked.
• Press Ctrl-F and select Mark Freestyle Face.
Face marks are useful for removing lines from certain areas of a mesh.
In this example, two faces of the default cube are marked like the image on the left. On the right is a render
without face marks activated.
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Render Output.

Marked Faces.

Face mark options.

The line selection can be controlled via inclusion and faces options:
Inclusive / Exclusive
Whether to include or exclude edges matching defined face mark conditions from the line set.
One Face
(De)select all edges which have one or both neighbor faces marked.
Both Faces
(De)select all edges which have both of their neighbor faces marked.
The image below shows the resulting combinations.
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Inclusive, One Face.

Inclusive, Both Faces.

Exclusive, One Face.

Exclusive, Both Faces.

Selection by Group
You can include or exclude objects for line calculation, based on their belonging to a group.
Group
The name of the object group to use.
Inclusive / Exclusive
Whether to include or exclude lines from those objects in this line set.

Selection by Image Border
If enabled, Freestyle only takes geometry within the image border into consideration for line calculation. This
reduces render times but increases continuity problems when geometry is moved out of and into camera view.

Line Style & Modifiers

Line Style UI

In Freestyle, the line style settings define the appearance of a line set using five main aspects:
•
•
•
•
•

stroke
color
alpha
thickness
geometry

These allow you to get many different styles of renders (technical draw, rough sketch, cartoon, oriental
16
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calligraphy, etc.).
You can create as many line styles as you wish, and reuse a given line style for several line sets by selecting it
from the dropdown menu next to its name.
Note
Length Unit
Unless otherwise specified, all lengths in line style settings are in pixels (either relative or absolute, as
specified in the core options).

Line Style demo

Stroke
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Stroke Line Style

Strokes are the final rendered lines. Yet you can tweaks them, for example, by removing the ones longer/shorter
than some threshold, chaining lines into a single stroke or breaking a stroke into several ones based on angles,
dashed pattern, etc.

Chaining
By default all retrieved lines from the line set are chained together. There are two basic chaining methods:
Plain
The default chaining method; it creates simple chains.
Sketchy
This chaining option allows for generating chains of feature edges with sketchy multiple strokes.
Basically, it generates Round strokes instead of a single one. It is only really useful if you use some
random-driven modifiers in the line style!
Rounds
It specifies the number of rounds in sketchy strokes.
Chaining can also be turned off to render each line separately, which can be useful for line styles which depend
on accurate representation of the line set.

Chaining

Splitting
You can split up chains of Freestyle lines by checking one of the following:
Material Boundary
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Splits chains of feature edges if they cross from one material to another.
Min 2D Angle and Max 2D Angle
Splits chains of feature edges when they make a 2D angle above (or below) a minimum (or maximum)
threshold.

Splitting

2D Length
Splits chains when they are longer than the given value.
D1 / G1 / D2 / G2 / D3 / G3
Splits the chains using the given dashed pattern (“D” stands for “dash”, “G” stands for “gap”; see also
Dashed Line).

Sorting

You can sort the order of your strokes, allowing the lines to stack in the order given.
Sort key
Choose which way you would like to sort your strokes.
Integration Type
Use in tandem with the Sort Key to determine the range for sorting
Sort Order
With the given result you can choose to “Reverse” the sort order

Selection

Selection

You can also choose to only select (i.e. render) chains longer than Min 2D Length and/or shorter than Max 2D
Length.

Caps
You can choose between three types of line caps:
Butt
Flat cap, exactly at the point the line ends.
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Line tip caps

Round
A half circle centered on the end point of the line.
Square
A square centered on the end point of the line (hence, like the circle, the drawn end of the line is slightly
extended compared to its computed value).

Dashed Line

Dashes Line UI

By enabling the Dashed Line check box, you can specify three pairs of dash and gap lengths. Dash values
define the lengths of dash strokes, while gap values specify intervals between two dashes.
If a zero gap is specified, then the corresponding dash is ignored even if it has a non-zero value.
Dashes are treated as separate strokes, meaning that you can apply line caps, as well as color, alpha and
thickness modifiers.

Color

Line Style Color UI

In this tab you control the color of your strokes.
Base Color
The base color for this line style.

Modifiers
There are four color modifiers available, which can be mixed with the base color using the usual methods (see
for example the Mix compositing node for further discussion of this topic). As with other modifier stacks in
Bforartists, they are applied from top to bottom.
Influence
How much the result of this modifier affects the current color.
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Along Stroke

The Along Stroke modifier alters the base color with a new one from a given color ramp mapped along each
stroke’s length. In other words, it applies a color ramp along each stroke.
Color Ramp
A standard Bforartists color ramp.

Distance from Camera
The Distance from Camera color modifier alters the base color with a new one from a given color ramp, using
the distance to the active camera as the parameter.

Range Min and Range Max
The limits of the mapping from “distance to camera” to “color in ramp”. If the current point of the stroke
is at Range Min or less from the active camera, it will take the start color of the ramp, and conversely, if it
is at Range Max or more from the camera, it will take the end color of the ramp. These values are in the
current scene’s units, not in pixels!
Fill Range by Selection
Set the min/max range values from the distances between the current selected objects and the camera.
The other settings are those of the standard Bforartists color ramp!

Distance from Object
The Distance from Object color modifier alters the base color with a new one from a given color ramp, using
the distance to a given object as the parameter.

Target
The object to measure distance from.
Range Min and Range Max
The limits of the mapping from “distance to object” to “color in ramp”. If the current point of the stroke is
at Range Min or less from the target, it will take the start color of the ramp, and conversely, if it is at
Range Max or more from the target, it will take the end color of the ramp. These values are in the current
scene’s units, not in pixels!
Fill Range by Selection
Set the min/max range values from the distances between the current selected objects and the target.
The other settings are those of the standard Bforartists color ramp!
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Material
The Material color modifier alters the base color with a new one taken from the current material under the
stroke.

You can use various properties of the materials, among which many are mono-component (i.e. give B&W
results). In this case, an optional color ramp can be used to map these grayscale values to colored ones.
If used with the Split by Material option in the Stroke tab, the result will not be blurred between materials along
the strokes.

Material modifiers demo by T.K. File:Lilies_Color_Material.zip

Noise
The Noise modifier uses a pseudo-random number generator to variably distribute color along the stroke.

Amplitude
The maximum value of the noise. A higher amplitude means a less transparent (more solid) stroke.
Period
22
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The period of the noise. This means how quickly the color value can change. A higher value means a
more smoothly changing color along the stroke.
Seed
Seed used by the pseudo-random numer generator.
Color Ramp
A standard Bforartists color ramp that maps noise values to a stroke color.

Tangent
This modifier bases its effect on the traveling direction of the stroke evaluated at the stroke’s vertices.

Color Ramp
A standard Bforartists color ramp that maps the traveling directio to a stroke color.
Min Angle and Max Angle
The range of input values to the mapping. Out-of-range input values will be clamped by the Min and Max
angles and their corresponding color values.

3D Curvature

3D Curvature modifier demo by T.K. File:Render_freestyle_modifier_curvature_3d.blend
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A modifier based on radial curvatures of the underlying 3D surface. The curvature of a 2D curve at a point is a
measure of how quickly the curve turns at the point. The quicker the turn is, the larger the curvature is at the
point. The curvature is zero if the curve is a straight line. Radial curvatures are those computed for a 2D curve
that appears at the cross-section between the 3D surface and a plane defined by the view point (camera
location) and the normal direction of the surface at the point.
For radial curvatures to be calculated (and therefore for this modifier to have any effect), the Face Smoothness
option has to be turned on and the object needs to have Smooth Shading.

Color Ramp
A standard Bforartists color ramp that maps the radial curvature to a stroke color.
Min Curvature and Max Curvature
The limits of the color ramp. If the current
of the stroke is at Min Curvature or less from
target, it will take the start color of the
mapping, and conversely, if it is at Max
Curvature or more from the target, it will take
end color of the mapping.

Crease Angle
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Crease Angle modifier demo by T.K. File:Render_freestyle_modifier_crease_angle.blend

A modifier based on the Crease Angle (angle between two adjacent faces). If a stroke segment doesn’t lie on a
crease (i.e., the edge doesn’t have the Crease Angle
nature), its color values are not touched by the modifier.
Color Ramp
A standard Bforartists color ramp that maps the
crease angle to a stroke color.
Min Angle and Max Angle
The range of input values to the mapping. Out-ofrange crease angle values will be clamped by the
Min and Max angles and their corresponding color
values.

Alpha
25
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Line Style Alpha UI

In this tab you control the alpha (transparency) of your strokes.
Base Transparency
The base alpha for this line style.

Modifiers
There are four alpha modifiers available, which can be mixed with the base alpha using a subset of the usual
methods (see for example the Mix compositing node for further discussion of this topic). As with other modifier
stacks in Bforartists, they are applied from top to bottom.
Influence
How much the result of this modifier affects the current transparency.

Along Stroke

The Along Stroke modifier alters the base alpha with a new one from either a linear progression or a custom
curve, mapped along each stroke’s length. In other words, it applies the selected progression along each stroke.
Mapping
Either a linear progression (from 0.0 to 1.0, which may be inverted with the Invert option), or a custom
mapping curve.
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Distance from Camera
The Distance from Camera modifier alters the base alpha with a new one from either a linear progression or a
custom curve, using the distance to the active camera as parameter.

Mapping
Either a linear progression (from 0.0 to 1.0, which may be inverted with the Invert option), or a custom
mapping curve.
Range Min and Range Max
The limits of the mapping from “distance to camera” to “alpha in mapping”. If the current point of the
stroke is at Range Min or less from the active camera, it will take the start alpha of the mapping, and
conversely, if it is at Range Max or more from the camera, it will take the end alpha of the mapping.
These values are in the current scene’s units, not in pixels!
Fill Range by Selection
Set the min/max range values from the distances between the current selected objects and the camera.

Distance from Object
The Distance from Object modifier alters the base alpha with a new one from either a linear progression or a
custom curve, using the distance to a given object as parameter.

Target
The object to measure distance from.
Mapping
Either a linear progression (from 0.0 to 1.0, which may be inverted with the Invert option), or a custom
mapping curve.
Range Min and Range Max
The limits of the mapping from “distance to object” to “alpha in mapping”. If the current point of the
stroke is at Range Min or less from the target, it will take the start alpha of the mapping, and conversely, if
it is at Range Max or more from the target, it will take the end alpha of the mapping. These values are in
the current scene’s units, not in pixels!
Fill Range by Selection
Set the min/max range values from the distances between the current selected objects and the target.
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Material
The Material modifier alters the base alpha with a new one taken from the current material under the stroke.
You can use various properties of the materials, among which some are multi-components (i.e. give RGB
results). In that case, the mean value will be used.

Mapping
Either a linear progression (from 0.0 to 1.0, which may be inverted with the Invert option), or a custom
mapping curve. Note the linear non-inverted option is equivalent to “do nothing”, as original values from
materials are already in the [0.0, 1.0] range.
If used with the Split by Material option in the Stroke tab, the result will not be blurred between materials along
the strokes.

Noise
The Noise modifier uses a pseudo-random number generator to variably distribute transparency along the
stroke.

Amplitude
The maximum value of the noise. A higher amplitude means a less transparent (more solid) stroke.
Period
The period of the noise. This means how quickly the alpha value can change. A higher value means a
more smoothly changing transparency along the stroke.
Seed
Seed used by the pseudo-random numer generator.
Mapping
Either a linear progression (from 0.0 to 1.0, which may be inverted with the Invert option), or a custom
mapping curve. Note the linear non-inverted option is equivalent to “do nothing”, as original values from
materials are already in the [0.0, 1.0] range.
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Tangent

This modifier bases its effect on the traveling direction of the stroke evaluated at the stroke’s vertices.
Mapping
Either a linear progression (from 0.0 to 1.0, which may be inverted with the Invert option), or a custom
mapping curve. Note the linear non-inverted option is equivalent to “do nothing”, as original values from
materials are already in the [0.0, 1.0] range.
Min Angle and Max Angle
The range of input values to the mapping. Out-of-range input values will be clamped by the Min and Max
angles and their corresponding alpha values.

3D Curvature
A modifier based on radial curvatures of the underlying 3D surface. The curvature of a 2D curve at a point is a
measure of how quickly the curve turns at the point. The quicker the turn is, the larger the curvature is at the
point. The curvature is zero if the curve is a straight line. Radial curvatures are those computed for a 2D curve
that appears at the cross-section between the 3D surface and a plane defined by the view point (camera
location) and the normal direction of the surface at the point.
For radial curvatures to be calculated (and therefore for this modifier to have any effect), the Face Smoothness
option has to be turned on and the object needs to have Smooth Shading.
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Mapping
Either a linear progression (from 0.0 to 1.0, which may be inverted with the Invert option), or a custom
mapping curve. Note the linear non-inverted option is equivalent to “do nothing”, as original values from
materials are already in the [0.0, 1.0] range.
Min Curvature and Max Curvature
The limits of the mapping. If the current point of the stroke is at Min Curvature or less from the target, it
will take the start alpha of the mapping, and conversely, if it is at Max Curvature or more from the target,
it will take the end alpha of the mapping.

Crease Angle

Crease Angle modifier demo by T.K. File:Render_freestyle_modifier_crease_angle.blend

A modifier based on the Crease Angle (angle between two adjacent faces). If a stroke segment doesn’t lie on a
crease (i.e., the edge doesn’t have the Crease Angle nature), its alpha value is not touched by this modifier.
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Mapping
Either a linear progression (from 0.0 to 1.0, which may be inverted with the Invert option), or a custom
mapping curve. Note the linear non-inverted option is equivalent to “do nothing”, as original values from
materials are already in the [0.0, 1.0] range.
Min Angle and Max Angle
The range of input values to the mapping. Out-of-range input values will be clamped by the Min and Max
angles and their corresponding alpha values.

Thickness
In this tab you control the thickness of your strokes.

Base Thickness
The base thickness for this line style.
Thickness Position
Control the position of stroke thickness from the original (backbone) stroke geometry. There are four
choices:
Center
The thickness is evenly split to the left and right side of the stroke geometry.
Inside
The strokes are drawn within object boundary.
Outside
The strokes are drawn outside the object boundary.
Relative
This allows you to specify the relative position by a number between 0.0 (inside) and 1.0
(outside), in the Thickness Ratio numeric field just below.
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The thickness position options are applied only to strokes of edge types Silhouette and Border, since these are
the only edge types defined in terms of the object boundary. Strokes of other edge types are always drawn using
the Center option.

Modifiers
There are five thickness modifiers available, which can be mixed with the base thickness using a subset of the
usual methods (see for example the Mix compositing node for further discussion of this topic). As with other
modifier stacks in Bforartists, they are applied from top to bottom.
Influence
How much the result of this modifier affects the current thickness.

Along Stroke
The Along Stroke modifier alters the base thickness with a new one from either a linear progression or a custom
curve, mapped along each stroke’s length. In other words, it applies the selected progression along each stroke.

Mapping
Either a linear progression (from 0.0 to 1.0 which may be inverted with the Invert option), or a custom
mapping curve.

Calligraphy
The Calligraphy modifier mimics some broad and flat pens for calligraphy. It generates different thickness
based on the orientation of the stroke.
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Orientation
The angle (orientation) of the virtual drawing tool, from the vertical axis of the picture. For example, an
angle of 0.0 mimics a pen aligned with the vertical axis, hence the thickest strokes will be the vertical
ones, and the thinnest, the horizontal ones.
Min Thickness and Max Thickness
The minimum and maximum generated thickness (as explained above, minimum is used when the
stroke’s direction is perpendicular to the main Orientation, and maximum, when aligned with it).

Calligraphy modifier demo by T.K. File:Toycar_Calligraphy.zip

Distance from Camera
The Distance from Camera modifier alters the base thickness with a new one from either a linear progression or
a custom curve, using the distance to the active camera as the parameter.

Mapping
Either a linear progression (from 0.0 to 1.0 which may be inverted with the Invert option), or a custom
mapping curve.
Range Min and Range Max
The limits of the mapping from “distance to camera” to “thickness in mapping”. If the current point of the
stroke is at Range Min or less from the active camera, it will take the start thickness of the mapping, and
conversely, if it is at Range Max or more from the camera, it will take the end thickness of the mapping.
These values are in the current scene’s units, not in pixels!
Fill Range by Selection
Set the min/max range values from the distances between the current selected objects and the camera.

33

Bforartists Reference Manual - © Copyright - This page is under OCL license

Distance from Object
The Distance from Object modifier alters the base thickness with a new one from either a linear progression or
a custom curve, using the distance to a given object as parameter.

Target
The object to measure distance from.
Mapping
Either a linear progression (from 0.0 to 1.0 which may be inverted with the Invert option), or a custom
mapping curve.
Range Min and Range Max
The limits of the mapping from “distance to object” to “alpha in mapping”. If the current point of the
stroke is at Range Min or less from the target, it will take the start thickness of the mapping, and
conversely, if it is at Range Max or more from the target, it will take the end thickness of the mapping.
These values are in the current scene’s units, not in pixels!
Fill Range by Selection
Set the min/max range values from the distances between the current selected objects and the target.

Material
The Material modifier alters the base thickness with a new one taken from the current material under the stroke.
You can use various properties of the materials, among which some are multi-components (i.e. give RGB
results). In that case, the mean value will be used.

Mapping
Either a linear progression (from 0.0 to 1.0 which may be inverted with the Invert option), or a custom
mapping curve. Note the linear non-inverted option is equivalent to “do nothing”, as original values from
materials are already in the [0.0, 1.0] range...
If used with the Split by Material option in the Stroke tab, the result will not be blurred between materials along
the strokes.
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Noise

Effect generated with a noise thickness modifier using asymmetric thickness.

The Noise modifier uses a pseudo-random number generator to variably distribute thickness along the stroke.

Min Thickness and Max Thickness
The minimum and maximum assigned thickness.
Asymmetric
Allows the thickness to be distributed unevenly at every point. Internally, the stroke is represented as a
backbone with a thickness to the right and left side. All other thickness shaders make sure that the left and
right thickness values are equal. For the Noise shader however, a meaningful (and good-looking) result
can be created by assigning different values to either side of the backbone.

Tangent
This modifier bases its effect on the traveling direction of the stroke evaluated at the stroke’s vertices.
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Min Thickness and Max Thickness
The minimum and maximum assigned thickness.
Mapping
Either a linear progression (from Min Thickness to Max Thickness, which may be inverted with the Invert
option), or a custom mapping curve (on the same range).
Min Angle and Max Angle
The range of input values to the mapping. Out-of-range input values will be clamped by the Min and Max
angles and their corresponding thickness values.

3D Curvature
A modifier based on radial curvatures of the underlying 3D surface. The curvature of a 2D curve at a point is a
measure of how quickly the curve turns at the point. The quicker the turn is, the larger the curvature is at the
point. The curvature is zero if the curve is a straight line. Radial curvatures are those computed for a 2D curve
that appears at the cross-section between the 3D surface and a plane defined by the view point (camera
location) and the normal direction of the surface at the point.
For radial curvatures to be calculated (and therefore for this modifier to have any effect), the Face Smoothness
option has to be turned on and the object needs to have Smooth Shading.

Min Thickness and Max Thickness
The minimum and maximum assigned thickness.
Mapping
Either a linear progression (from Min Thickness to Max Thickness, which may be inverted with the Invert
option), or a custom mapping curve (on the same range).
Min Curvature and Max Curvature
The limits of the mapping of the Min and Max Thickness. If the current point of the stroke is at Min
Curvature or less from the target, it will take the start thickness of the mapping, and conversely, if it is at
Max Curvature or more from the target, it will take the end thickness of the mapping.
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Crease Angle

Crease Angle modifier demo by T.K. File:Render_freestyle_modifier_crease_angle.blend

A modifier based on the Crease Angle (angle between two adjacent faces). If a stroke segment doesn’t lie on a
crease (i.e., the edge doesn’t have the Crease Angle nature), its thickness value is not touched by this modifier.

Min Thickness and Max Thickness
The minimum and maximum assigned thickness.
Mapping
Either a linear progression (from Min Thickness to Max Thickness, which may be inverted with the Invert
option), or a custom mapping curve (on the same range).

Geometry
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Line Style Geometry Overall UI

In this tab you control the geometry of your strokes.

Modifiers
There are thirteen geometry modifiers available. These modifiers have no mix nor influence settings, as they
always completely apply to the strokes’ geometry (like object modifiers do). They take the resulting twodimensional strokes from the Freestyle line set and displace or deform them in various ways.
As with other modifier stacks in Bforartists, they are applied from top to bottom.

2D Offset
The 2D Offset modifier adds some two-dimensional offsets to the stroke backbone geometry. It has two sets of
independent options/effects:

Start and End
These two options add the given amount of offset to the start (or end) point of the stroke, along the (2D)
normal at those points. The effect is blended over the whole stroke, so if you, for example, set only Start
to 50, the start of the stroke is offset 50 pixels along its normal, the middle of the stroke, 25 pixels along
its own normal, and the end point isn’t moved.
X and Y
These two options simply add a constant horizontal and/or vertical offset to the whole stroke.
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2D Transform
The 2D Transform modifier applies two-dimensional scaling and/or rotation to the stroke backbone geometry.
Scale is applied before rotation.
The center (pivot point) of these 2D transformations can be:

Stroke Center
The median point of the stroke.
Stroke Start
The beginning point of the stroke.
Stroke End
The end point of the stroke.
Stroke Point Parameter
The Stroke Point Parameter factor controls where along the stroke the pivot point is (0.0 means start
point; 1.0 end point).
Absolute 2D Point
The Pivot X and Pivot Y allows you to define the position of the pivot point in the final render (from the
bottom left corner). WARNING : Currently, you have to take into account the real render size, i.e.
resolution and resolution percentage!
Scale X and Scale Y
The scaling factors, in their respective axes.
Rotation Angle
The rotation angle.

2D Transform modifier File:Toycar_Three_Contours.zip
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Backbone Stretcher

The Backbone Stretcher modifier stretches (adds some length to) the beginning and end of the stroke.
Backbone Length
Length to add to the strokes’ ends.

Bezier Curve

The Bezier Curve modifier replaces the stroke by a Bezier approximation of it.
Error
The maximum distance allowed between the new Bezier curve and the original stroke.

Bezier Curve modifier demo by T.K. File:toycar_bezier.zip

Blueprint
The Blueprint modifier produces blueprint-like strokes using either circular, elliptical, or square contours. A
blueprint here refers to those lines drawn at the beginning of free-hand drawing to capture the silhouette of
objects with a simple shape such as circles, ellipses and squares.
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Shape
Which base shapes to use for this blueprint: Circles, Ellipses or Squares.
Rounds
How many rounds are generated, as if the pen draws the same stroke several times (i.e. how many times
the process is repeated).
Random Radius and Random Center
For the Circles and Ellipses shapes. Adds some randomness to each round in the relevant aspect. Using
more than one round with no randomness would be meaningless, as they would draw over each other
exactly.
Backbone Length and Random Backbone
For the Squares shapes. The first adds some extra length to each edge of the generated squares (also
affected by the second parameter). The second adds some randomness to the squares.
Note that the Min 2D Length feature from the Strokes settings is quite handy here, to avoid the noise generated
by small strokes...

Guiding Lines
The Guiding Lines modifier replaces a stroke by a straight line connecting both of its ends.

Offset
Offset the start and end points along the original stroke, before generating the new straight one.
This modifier will produce reasonable results when strokes are short enough, because shorter strokes are more
likely to be well approximated by straight lines. Therefore, it is recommended to use this modifier together with
one of the splitting options (by 2D angle or by 2D length) from the Strokes panel.

Guiding Lines modifier Demo by T.K. File:Toycar_Guiding_Line.zip

Perlin Noise 1D
The Perlin Noise 1D modifier adds one-dimensional Perlin noise to the stroke. The curvilinear abscissa (value
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between 0 and 1 determined by a point’s position relative to the first and last point of a stroke) is used as the
input to the noise function to generate noisy displacements.
This means that this modifier will give an identical result for two strokes with the same length and sampling
interval.

Frequency
How dense the noise is (kind of a scale factor along the stroke).
Amplitude
How much the noise distorts the stroke in the Angle direction.
Seed
The seed of the random generator (the same seed over a stroke will always give the same result).
Octaves
The “level of detail” of the noise.
Angle
In which direction the noise is applied (0.0 is fully horizontal).

Perlin Noise 2D

The Perlin Noise 2D modifier adds one-dimensional Perlin noise to the stroke. The modifier generates noisy
displacements using 2D coordinates of stroke vertices as the input of the noise generator.
Its settings are exactly the same as the Perlin Noise 1D modifier.

Polygonization

The Polygonization modifier simplifies strokes as much as possible (in other words, it transforms smooth
strokes into jagged polylines).
Error
The maximum distance allowed between the new simplified stroke and the original one (the larger this
value is, the more jagged/approximated the resulting polylines are).

Sampling
The Sampling modifier changes the definition, precision of the stroke, for the following modifiers.
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Sampling
The smaller this value, the more precise are the strokes. Be careful; too small values will require a huge
amount of time and memory during render!

Sinus Displacement
The Sinus Displacement modifier adds a sinusoidal displacement to the stroke.

Wavelength
How wide the undulations are along the stroke.
Amplitude
How high the undulations are across the stroke.
Phase
Allows “offsetting” (“moving”) the undulations along the stroke.

Sinus Displacement modifier demo by T.K. File:Toycar_Sinus.zip

Spatial Noise
The Spatial Noise modifier adds some spatial noise to the stroke. Spatial noise displacements are added in the
normal direction (i.e., the direction perpendicular to the tangent line) evaluated at each stroke vertex.

Amplitude
How much the noise distorts the stroke.
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Scale
How wide the noise is along the stroke.
Octaves
The level of detail of the noise.
Smooth
When enabled, apply some smoothing over the generated noise.
Pure Random
When disabled, the next generated random value depends on the previous one; otherwise they are
completely independent. Disabling this setting gives a more “consistent” noise along a stroke.

Tip Remover
The Tip Remover modifier removes a piece of the stroke at its beginning and end.

Tip Length
Length of stroke to remove at both of its tips.

Simplification

The Simplification modifier merges stroke vertices that lie close to one another, like the Decimate modifier for
meshes.

Tolerance
Measure for how close points have to be to each other to be merged. A higher tolerance means more
vertices are merged.

Python Scripting Mode
The Python Scripting mode offers full programmability for line stylization. In this control mode, all stylization
operations are written as Python scripts referred to as style modules in the Freestyle terminology. The input to a
style module is a view map (i.e., a set of detected feature edges), and the output is a set of stylized strokes.
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A style module is composed of successive calls of five basic operators: selection, chaining, splitting, sorting and
stroke creation. The selection operator identifies a subset of input feature edges based on one or more userdefined selection conditions (predicates). The selected edges are processed with the chaining, splitting and
sorting operators to build chains of feature edges. These operators are also controlled by user-supplied
predicates and functions in order to determine how to transform the feature edges into chains. Finally, the
chains are transformed into stylized strokes by the stroke creation operator, which takes a list of user-defined
stroke shaders.
Python style modules are stored within .blend files as text data-blocks. External style module files first need to
be loaded in the Text Editor window. Then the pull-down menu within an entry of the style module stack allows
you to select a module from the list of loaded style modules.

A screen capture of a style module (cartoon.py) loaded in the Text Editor window (left), as well as Freestyle options in the
Python Scripting mode in the Render Layers buttons (right)

Freestyle for Bforartists comes with a number of Python style modules that can serve as a starting point of your
own style module writing. See also the section of the Freestyle Python API in the Bforartists Python API
reference manual for the full detail of style module constructs.
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By T.K. using the Python Scripting mode

By T.K. using the Python Scripting mode

(File:Turning_Pages.zip, CC0)

(File:Lily_Broken_Topology.zip, CC0)

Writing Style Modules
A style module is a piece of code responsible for the stylization of Freestyle line drawing. The input of a style
module is a set of feature edges called view map (ViewMap). The output is a set of stylized lines also referred
to as strokes. A style module is structured as a pipeline of operations that allow for building strokes from the
input edges within the view map.
There are five kinds of operations (listed with corresponding operator functions):
•
•
•
•
•

Selection Operators.select()
Chaining Operators.chain(), Operators.bidirectional_chain()
Splitting Operators.sequential_split(), Operators.recursive_split()
Sorting Operators.sort()
Stroke creation Operators.create()

The input view map is populated with a set of ViewEdge objects. The selection operation is used to pick up
ViewEdges of interest to artists based on user-defined selection conditions (predicates). Chaining operations
take the subset of ViewEdges and build Chains by concatenating ViewEdges according to user-defined
predicates and functions. The Chains can be further refined by splitting them into smaller pieces (e.g., at points
where edges make an acute turn) and selecting a fraction of them (e.g., to keep only those longer than a length
threshold). The sorting operation is used to arrange the stacking order of chains to draw one line on top of
another. The chains are finally transformed into stylized strokes by the stroke creation operation applying a
series of stroke shaders to individual chains.
ViewEdges, Chains and Strokes are generically referred to as one-dimensional (1D) elements. A 1D element is
a polyline that is a series of connected straight lines. Vertices of 1D elements are called 0D elements in general.
All the operators act on a set of active 1D elements. The initial active set is the set of ViewEdges in the input
view map. The active set is updated by the operators.

Selection
The selection operator goes through every element of the active set and keeps only the ones satisfying a certain
predicate. The Operators.select() method takes as the argument a unary predicate that works on any
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Interface1D that represents a 1D element. For example:
Operators.select(QuantitativeInvisibilityUP1D(0))

This selection operation uses the QuantitativeInvisibilityUP1D predicate to select only the visible
ViewEdge (more precisely, those whose quantitative invisibility is equal to 0). The selection operator is
intended to selectively apply the style to a fraction of the active 1D elements.
It is noted that QuantitativeInvisibilityUP1D is a class implementing the predicate that tests line
visibility, and the Operators.select() method takes an instance of the predicate class as argument. The
testing of the predicate for a given 1D element is actually done by calling the predicate instance, that is, by
invoking the __call__ method of the predicate class. In other words, the Operators.select() method
takes as argument a functor which in turn takes an Interface0D object as argument. The Freestyle Python
API employs functors extensively to implement predicates, as well as functions.

Chaining
The chaining operators act on the set of active ViewEdge objects and determine the topology of the future
strokes. The idea is to implement an iterator to traverse the ViewMap graph by marching along ViewEdges. The
iterator defines a chaining rule that determines the next ViewEdge to follow at a given vertex (see
ViewEdgeIterator). Several such iterators are provided as part of the Freestyle Python API (see
ChainPredicateIterator and ChainSilhouetteIterator). Custom iterators can be defined by
inheriting the ViewEdgeIterator class. The chaining operator also takes as argument a UnaryPredicate
working on Interface1D as a stopping criterion. The chaining stops when the iterator has reached a
ViewEdge satisfying this predicate during the march along the graph.
Chaining can be either unidirectional Operators.chain() or bidirectional
Operators.bidirectional_chain(). In the latter case, the chaining will propagate in the two
directions from the starting edge.
The following is a code example of bidirectional chaining:
Operators.bidirectional_chain(
ChainSilhouetteIterator(),
NotUP1D(QuantitativeInvisibilityUP1D(0)),
)

The chaining operator uses the ChainSilhouetteIterator as the chaining rule and stops chaining as
soon as the iterator has come to an invisible ViewEdge.
The chaining operators process the set of active ViewEdge objects in order. The active ViewEdges can be
previously sorted using the Operators.sort() method (see below). It starts a chain with the first
ViewEdge of the active set. All ViewEdges that have already been involved in the chaining process are
marked (in the case of the example above, the time stamp of each ViewEdge is modified by default), in order
not to process the same ViewEdge twice. Once the chaining reaches a ViewEdge that satisfies the stopping
predicate, the chain is terminated. Then a new chain is started from the first unmarked ViewEdge in the active
set. This operation is repeated until the last unmarked ViewEdge of the active set was processed. At the end of
the chaining operation, the active set is set to the Chains that have just been constructed.
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Splitting
The splitting operation is used to refine the topology of each Chain. Splitting is performed either sequentially or
recursively. Sequential splitting Operators.sequentialSplit() in its basic form, parses the Chain at a
given arbitrary resolution and evaluates a unary predicate (working on 0D elements) at each point along the
Chain. Every time the predicate is satisfied, the chain is split into two chains. At the end of the sequential split
operation, the active set of chains is set to the new chains.
Operators.sequentialSplit(TrueUP0D(), 2)

In this example, the chain is split every 2 units. A more elaborated version uses two predicates instead of one:
One to determine the starting point of the new chain and the other to determine its ending point. This second
version can lead to a set of Chains that are disjoint or that overlap if the two predicates are different. (see
Operators.sequentialSplit() for more details).
Recursive splitting Operators.recursiveSplit() evaluates a function on the 0D elements along the
Chain at a given resolution and find the point that gives the maximum value for the function. The Chain is then
split into two at that point. This process is recursively repeated on each of the two new Chains, until the input
Chain satisfies a user-specified stopping condition.
func = Curvature2DAngleF0D()
Operators.recursive_split(func, NotUP1D(HigherLengthUP1D(5)), 5)

In the code example above, the Chains are recursively split at points of the highest 2D curvature. The curvature
is evaluated at points along the Chain at a resolution of 5 units. Chains shorter than 5 units won’t be split
anymore.

Sorting
The sorting operator Operators.sort() arranges the stacking order of active 1D elements. It takes as
argument a binary predicate used as a “smaller than” operator to order two 1D elements.
Operators.sort(Length2DBP1D())

In this code example, the sorting uses the Length2DBP1D binary predicate to sort the Interface1D objects
in the ascending order in terms of 2D length.
The sorting is particularly useful when combined with causal density. Indeed, the causal density evaluates the
density of the resulting image as it is modified. If we wish to use such a tool to decide to remove strokes
whenever the local density is too high, it is important to control the order in which the strokes are drawn. In this
case, we would use the sorting operator to insure that the most “important” lines are drawn first.

Stroke creation
Finally, the stroke creation operator Operators.create() takes the active set of Chains as input and build
Strokes. The operator takes two arguments. The first is a unary predicate that works on Interface1D that is
designed to make a last selection on the set of chains. A Chain that doesn’t satisfy the condition won’t lead to a
Stroke. The second input is a list of shaders that will be responsible for the shading of each built stroke.
shaders_list = [
SamplingShader(5.0),
ConstantThicknessShader(2),
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ConstantColorShader(0.2,0.2,0.2,1),
]
Operators.create(DensityUP1D(8,0.1, IntegrationType.MEAN), shaders_list)

In this example, the DensityUP1D predicate is used to remove all Chains whose mean density is higher than
0.1. Each chain is transformed into a stroke by resampling it so as to have a point every 5 units and assigning to
it a constant thickness of 2 units and a dark gray constant color.

User control on the pipeline definition
Style module writing offers different types of user control, even though individual style modules have a fixed
pipeline structure. One is the sequencing of different pipeline control structures, and another is through the
definition of functor objects that are passed as argument all along the pipeline.
Different pipeline control structures can be defined by sequencing the selection, chaining, splitting, and sorting
operations. The stroke creation is always the last operation that concludes a style module.
Predicates, functions, chaining iterators, and stroke shaders can be defined by inheriting base classes and
overriding appropriate methods. See the reference manual entries of the following base classes for more
information on the user-scriptable constructs.
•
•
•
•
•
•
•
•
•
•
•
•

•
•
•
•
•
•
•
•
•
•
•
•

UnaryPredicate0D
UnaryPredicate1D
BinaryPredicate0D
BinaryPredicate1D
UnaryFunction0DDouble
UnaryFunction0DEdgeNature
UnaryFunction0DFloat
UnaryFunction0DId
UnaryFunction0DMaterial
UnaryFunction0DUnsigned
UnaryFunction0DVec2f
UnaryFunction0DVec3f

Freestyle SVG Exporter
SVG exporting for Freestyle is available through an addon.
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UnaryFunction0DVectorViewShape
UnaryFunction0DViewShape
UnaryFunction1DDouble
UnaryFunction1DEdgeNature
UnaryFunction1DFloat
UnaryFunction1DUnsigned
UnaryFunction1DVec2f
UnaryFunction1DVec3f
UnaryFunction1DVectorViewShape
UnaryFunction1DVoid
ViewEdgeIterator
StrokeShader
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An example of a .svg result produced by the Freestyle SVG Exporter. Model by Bforartistsgoodies

This addon can be enabled via User Preferences > Addons > Render:Freestyle SVG Exporter. The GUI for the
exporter should now be visible in the render tab of the properties window. The exported .svg file is written to
the default output path (Properties > Render > Output).

Options

Mode
Option between Frame and Animation. Frame will render a single frame, Animation will bundle all
rendered frames into a single .svg file.
Split at Invisible
By default the exporter won’t take invisible vertices into account and export them like they are visible.
Some stroke modifiers, like Blueprint, mark vertices as invisible to achieve a certain effect. Enabling this
option will make the paths split when encountering an invisible vertex, which leads to a better result.
Fill Contours
The contour of objects is filled with their material color. Note that this features is somewhat unstable especially with animations.
Stroke Cap Style
Defines the style the stroke caps will have in the SVG output.

Exportable Properties
Because the representation of Freestyle strokes and SVG path objects is fundamentally different, a one on one
translation between Freestyle and SVG is not possible. The main shortcoming of SVG compared to Freestyle is
that Freestyle defines style per-point, where SVG defines it per-path. This means that Freestyle can produce
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much more complex results that are impossible to achieve in SVG.
The properties that can be exported are:
•
•
•
•

Base color
Base alpha
Base thickness
Dashes

Animations
The exporter supports the creation of SVG animations. When the Mode is set to Animation, all frames from a
render - one when rendering a frame (f12) or all when rendering an animation (shift f12) - into a single file.
Most modern browsers support the rendering of SVG animations.

An SVG animation rendered with the exporter.
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Exporting Fills
Fills are colored areas extracted from a Freestyle render result. Specifically, they are defined by a combination
of the Contour and External Contour edge type, combined with some predicates. The fill result can be
unexpected, when the SVG renderer cannot correctly draw the path that the exporter has generated. This
problem is extra apparent in animations.

An example of a .svg result produced by the Freestyle SVG Exporter. Model by Julien Deswaef

Fills support holes and layering. When using layers, the exporter tries to render objects with the same material
as the patch. The exporting of fills and especially the order in which they are layered is by no means perfect. In
most cases, these problems can be easily solved in Inkscape or a text editor.

Link
Here are some links to external data regarding Freestyle.

Video
https://www.youtube.com/watch?v=IY1L76WwOHg
The Light At The End.
https://www.youtube.com/watch?v=4pOsmLV0-BA
mmd_tools test2 with Bforartists+Freestyle (未来時計 AM4:30)

Video Tutorial
https://www.youtube.com/watch?v=1T_impeCV-0
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Using freestyle in Bforartists
https://www.youtube.com/watch?v=Uq1-KoZ7Uv4
Tutorial: Bforartists 3D - Freestyle and Composite
https://www.youtube.com/watch?v=J3LI_MTnY7U
Bforartists Tutorial: Freestyle

Tutorial
Freestyle basics
http://studiollb.wordpress.com/2012/02/29/freestyle-introductory-tutorial/ http://jikz.net/archives/364
http://jikz.net/archives/329
Edge types
https://studiollb.wordpress.com/2012/09/08/freestyle-101-edge-types/
Line style basic
http://studiollb.wordpress.com/2012/09/08/freestyle-101-line-style-basic/
Line style modifiers
http://studiollb.wordpress.com/2012/09/08/freestyle-101-line-style-modifier-part-1/
http://studiollb.wordpress.com/2012/09/08/freestyle-101-line-style-modifier-part-2/
http://studiollb.wordpress.com/2012/09/15/freestyle-101-planning-and-along-stroke-line-style-modifier/
Tips and tricks
http://studiollb.wordpress.com/2012/02/03/freestyle-tips/ (Old)
Misc

• FreeStyle Users’ improvement suggestions.
• FreeStyle integration into Bforartists blog
Early documentation of FreeStyle
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10.7 Render - Workflows
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Rendering Animations
While rendering stills will allow you to view and save the image from the render buffer when it is complete,
animations are a series of images, or frames, and are automatically saved directly out to a drive after being
rendered.
After rendering the frames, you may need to edit the clips, or first use the Compositor to do green-screen
masking, matting, color correction, DOF, and so on to the images. That result is then fed to the Sequencer
where the strips are cut and mixed and a final overlay is done.
Finally you can render out from the Sequencer and compress the frames into a playable movie clip.

Workflow
Generally, you do a lot of intermediate renders of different frames in your animation to check for timing,
1
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lighting, placement, materials, and so on. At some point, you are ready to make a final render of the complete
animation for publication.
There are two approaches you can use when making a movie, or animation, with or without sound. The
approach you should use depends on the amount of CPU time you will need to render the movie. You can
render a “typical” frame at the desired resolution, and then multiply by the number of frames that will
ultimately go into the movie, to arrive at a total render time.
If the total render time is an hour or more, you want to use the “Frame Sequence” approach. For example, if
you are rendering a one-minute video clip for film, there will be (60 seconds per minute) X (24 frames per
second) or 1440 frames per minute. If each frame takes 30 seconds to render, then you will be able to render
two frames per minute, or need 720 minutes (12 hours) of render time.
Rendering takes all available CPU time; you should render overnight, when the computer is not needed, or set
Blender to a low priority while rendering, and work on other things (be careful with the RAM space!).
Direct Approach
The Direct Approach, which is highly not recommended and not a standard practice, is where you set your
output format to an AVI or MOV format, and click Animation to render your scene directly out to a movie file.
Blender creates one file that holds all the frames of your animation. You can then use Blender’s VSE to add an
audio track to the animation and render out to an MPEG format to complete your movie.
Frame Sequence
The Frame Sequence is a much more stable approach, where you set your output format to a still format (such
as JPG, PNG or MultiLayer), and click Animation to render your scene out to a set of images, where each
image is a frame in the sequence.
Blender creates a file for each frame of the animation. You can then use Blender’s compositor to perform any
frame manipulation (post processing). You can then use Blender’s VSE to load that final image sequence, add
an audio track to the animation, and render out to an MPEG format to complete your movie. The Frame
Sequence approach is a little more complicated and takes more drive space, but gives you more flexibility.
Here are some guidelines to help you choose an approach.
Direct Approach
• short segments with total render time < 1 hour
• stable power supply
• computer not needed for other uses
Frame Sequence Approach
• total render time > 1 hour
• post-production work needed
• Color/lighting adjustment
• Green screen/matte replacement
• Layering/compositing
• Multiple formats and sizes of ultimate product
• intermediate frames/adjustments needed for compression/codec
• precise timing (e.g. lip-sync to audio track) needed in parts
2
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• may need to interrupt rendering to use the computer, and want to be able to resume rendering where you
left off.

Frame Sequence Workflow
1. First prepare your animation.
2. In the Dimensions panel, choose the render size, Pixel Aspect Ratio, and the Range of Frames to use, as
well as the frame rate, which should already be set.
3. In the Output panel set up your animation to be rendered out as images, generally using a format that
does not compromise any quality.
4. Choose the output path and file type in the Output panel as well, for example //render/my-anim-.
5. Confirm the range of your animation frame Start and End.
6. Save your blend-file.
7. Press the big Animation button. Do a long task [like sleeping, playing a video game, or cleaning your
driveway] while you wait for your computer to finish rendering the frames.
8. Once the animation is finished, use your OS file explorer to navigate into the output folder (“render in
this example). You will see lots of images (.png or .exr, etc… depending on the format you chose to
render) that have a sequence number attached to them ranging from 0000 to a max of 9999. These are
your single frames.
9. In Blender, now go into the video sequence editor.
10.Choose Add Image from the add menu. Select all the frames from your output folder that you want to
include in your animation (Press A to Select All easily). They will be added as a strip to the sequence
editor.
11.Now you can edit the strip and add effects or simply leave it like it is. You can add other strips, like an
audio strip.
12.Scrub through the animation, checking that you have included all the frames.
13.In the Scene Render buttons, in the Post Processing panel, activate Sequencer.
14.In the Output panel, choose the container and codec you want (e.g. MPEG H.264) and configure them.
The video codecs are described on the previous page: Output Options.
15.Click the Animation render button and Blender will render out the sequence editor output into your
movie.
Why go through all this hassle? Well, first of all, if you render out single frames you can stop the render at any
time by pressing Esc in the render window or UV/image editor. You will not lose the frames you have already
rendered, since they have been written out to individual files. You can always adjust the range you want to
continue from where you left off.
You can edit the frames afterwards and post-process them. You can add neat effects in the sequence editor. You
can render the same sequence into different resolutions (640×480, 320×240, etc) and use different codecs (to
get different file sizes and quality) with almost no effort whatsoever.

Hints
Your computer accidentally turns off in the middle of rendering your movie!
Unless your animation renders in a few minutes, it is best to render the animation as separate image files.
3
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Instead of rendering directly to a compressed movie file, use a loss-less format (e.g. PNG).
This allows you an easy recovery if there is a problem and you have to re-start the rendering, since the
frames you have already rendered will still be in the output directory.
Just disable the Overwrite option to start rendering where you left off.
You can then make a movie out of the separate frames with Blender’s sequence editor or use 3rd party
encoding software.
Animation Preview
It can be useful to render a subset of the animated sequence, since only part of an animation may have an
error.
Using an image format for output, you can use the Frame Step option to render every N’th frame. Then
disable Overwrite and re-render with Frame Step set to 1.

Command Line
In some situations we want to increase the render speed, access Blender remotely to render something or build
scripts that use the command line.
One advantage of using the command line is that we do not need a graphical display (no need for X server on
Linux for example) and consequently we can render via a remote shell (typically SSH).
See Command Line Arguments for a full list of arguments (for example to specify which scene to render, the
end frame number, etc…), or simply run:
blender --help

Note
Arguments are executed in the order they are given!
The following command will not work, since the output and extension are set after Blender is told to render:
blender -b file.blend -a -x 1 -o //render

The following command will behave as expected:
blender -b file.blend -x 1 -o //render -a

Always position -f or -a as the last arguments.

Platforms
How to actually execute Blender from the command line depends on the platform and where you have installed
Blender. Here are basic instructions for the different platforms.

Linux
Open a terminal, then go to the directory where Blender is installed, and run Blender like this:
cd <blender installation directory>

4
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./blender

If you have Blender installed in your PATH (usually when Blender is installed through a distribution package),
you can simply run:
blender

macOS
Open the terminal application, go to the directory where Blender is installed, and run the executable within the
app bundle, with commands like this:
cd /Applications/Blender
./blender.app/Contents/MacOS/blender

If you need to do this often, you can make an alias so that typing just blender in the terminal works. For that
you can run a command like this in the terminal (with the appropriate path).
echo "alias blender=/Applications/Blender/blender.app/Contents/MacOS/blender" >>
~/.profile

If you then open a new terminal, the following command will work:
blender

MS-Windows
Open the Command Prompt, go to the directory where Blender is installed, and then run Blender:
cd c:\<blender installation directory>
blender

You can also add the Blender folder to your system PATH so that do you do not have to cd to it each time.

Examples
Single Image
blender -b file.blend -f 10

-b
Render in the background (without UI).
file.blend
Path to the blend-file to render.
-f 10
Render only the 10th frame.
blender -b file.blend -o /project/renders/frame_##### -F EXR -f -2

-o /project/renders/frame_#####
Path of where to save the rendered image, using five padded zeros for the frame number.
-F EXR
Override the image format specified in the blend-file and save to an OpenEXR image.
-f -2
5
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Render only the second last frame.
Warning
Arguments are case sensitive! -F and -f are not the same.

Animation
blender -b file.blend -a

-a
Render the whole animation using all the settings saved in the blend-file.
blender -b file.blend -E BLENDER_RENDER -s 10 -e 500 -t 2 -a

-E BLENDER_RENDER
Use the “Blender Render” engine. For a list of available render engines, run blender -E help.
-s 10 -e 500
Set the start frame to 10 and the end frame to 500.
-t 2
Use only two threads.

Multiview Introduction

Since version 2.75, Blender has come with a new feature called Multiview. Multiview is a complete toolset for
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working with stereoscopic rendering in Blender. It works with both the Blender Internal and Cycles rendering
engines and it also supports many different stereo 3D visualization types.

Note
If you have a real 3D display at some point you can change the 3D display mode in the Window menu, by
calling the Stereo 3D operator. Be aware that some modes require a fullscreen editor to work, and this can be
taxing on your CPU.

Usage

For example, we will take an existing blend file that was made for monoscopic rendering and transform it to be
stereo 3D ready.

7
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Creature Factory 2 by Andy Goralczyk Rendered in Stereo 3D (anaglyph).

Note
Multi-View drawing requires capable graphics card and drivers with Triple Buffer support. If the Automatic
mode does not work, set the Window Draw Method in the System User Preferences.

Introduction
Start opening up your project file, in this case turntable.blend from the Creature Factory 2 Open Movie
8
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Workshop series from the Blender Institute by Andy Goralczyk.

Turn Table Creature Factory 2.

Views Setup
Go to the Render Layers panel and enable Views for this scene.

Scene Render Views.
Note
When you turn on Views in the scene, you get 3D preview in the viewport, as well as multiple panels that are
now accessible all over the user interface.

9
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Viewport with 3D visualization.

Camera
To tweak the stereo 3D parameters, select the camera in the Outliner. In the Camera panel go to the Stereoscopy
tab and change the Convergence Distance.
The viewport will respond in real-time to those changes allowing you to preview the current depth value of the
scene.

Stereo Convergence Distance.

Viewport
Before fine-tuning the camera parameters, you can set the convergence plane in the viewport based in your
scene depth layout. Go outside the camera view and you will instantly see the convergence plane in front of the
camera.
You can toggle this and other display settings in the Stereoscopy panel of the 3D Views properties region. In the
10
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following image, the camera’s frustum volumes are also visible.

Viewport Plane and Volume Stereo Preview.

Stereo 3D Display
If you have a real 3D display at some point, you can change the 3D display mode in the Window menu, by
calling the Stereo 3D operator. Be aware that some modes require a fullscreen editor to work.

Window Menu, Stereo 3D Operator.

OpenGL Preview
Before rendering your scene, you can save an OpenGL preview of the animation for testing in the final display.
In the Render Output panel you can choose the output Views Format.
11

Bforartists Reference Manual - © Copyright - This page is under OCL license

The options include individual files per view, top-bottom, anaglyph among others. Pick the one that fits your
display requirements.

Object 1

Rendering and UV/Image Editor
Once you are happy with the results, you can render out the final animation. In the UV/Image Editor you can
inspect the individual views and the stereo result.

Image Formats
Your final animation can be saved in more robust formats than the ones used by the OpenGL render preview. In
this example we saved as cross-eyed side-by-side stereo 3D.

12
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Side by Side Cross-Eye Format.

Final Considerations
As this guide showed, there is more to stereo 3D rendering than just generate two images. The earlier the stereo
pipeline is considered the smoother it will get. The following sections are a more in-depth view of the
individual components we visited in the workflow.

Window Stereo 3D Display
An essential component of the Stereoscopy pipeline is the ability to display the stereo image in a proper display.
Blender supports from high-end 3D displays to simple red-cyan glasses. On top of that, you can set a different
display mode for each window.
The display mode can be changed via the Window menu or if you create your own shortcuts for the
wm.set_stereo_3d operator.

Window Menu, Stereo 3D Operator.

Display Mode
Anaglyph
Render two differently filtered colored images for each eye. Anaglyph glasses are required. We support
Red-Cyan, Green-Magenta and Yellow-Blue glasses.
Interlace
Render two images for each eye into one interlaced image. A 3D-ready monitor is required. We support
Row, Column and Checkerboard Interleaved. An option to Swap Left/Right helps to adjust the image for
the screen. This method works better in fullscreen.
Time Sequential
Render alternate eyes. This method is also known as Page Flip. This requires the graphic card to support
Quad Buffer and it only works in fullscreen.
Side-by-Side
Render images for left and right eye side-by-side. There is an option to support Cross-Eye glasses. It
works only in fullscreen, and it should be used with the Full Editor operator.
Top-Bottom
Render images for left and right eye one above another. It works only in fullscreen, and it should be used
with the Full Editor operator.

Note

13

Bforartists Reference Manual - © Copyright - This page is under OCL license

Full Screen Stereo 3D Modes
If you have a 3D display most of the time, you will use it to see in stereo 3D, you will have to go to the
fullscreen mode. In fact some modes will only work in the full window mode that hides most of the user
interface from the work area. In this case it is recommended to work with two monitors, using the 3D screen
for visualizing the stereo result while the other screen can be used for the regular Blender work.

Stereo 3D Camera
When using the Stereo 3D scene view setup, a stereo pair is created on-the-fly and used for rendering and
previsualization. For all the purposes this works as two cameras that share most parameters (focal length,
clipping, …). The stereo pair, however, is offsetted, and can have unique rotation and shift between itself.

Stereo 3D Camera Settings.
Interocular Distance
Set the distance between the camera pair. Although the convergence of a stereo pair can be changed in
post-production, different interocular distances will produce different results due to the parts of the scene
being occluded from each point of view.
Convergence Plane Distance
The converge point for the stereo cameras. This is often the distance between a projector and the
projection screen. You can visualize this in the 3D View.

Convergence Mode
Off-Axis
The stereo camera pair is separated by the interocular distance, and shifted inwards so it converges in the
convergence plane. This is the ideal format since it is the one closest to how the human vision works.
Parallel
This method produces two parallel cameras that do not converge. Since this method needs to be manually
converged it cannot be used for viewing. This method is common when combining real footage with
rendered elements.
Toe-in
A less common approach is to rotate the cameras instead of shifting their frustum. The Toe-in method is
rarely used in modern 3D productions.
Pivot
The stereo pair can be constructed around the active camera with a new camera built for each eye (Center
Pivot) or using the existing camera and creating (Left or Right). The latter is what is used when only one
eye needs to be rendered for an existing mono 2D project.
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Viewport Stereo 3D
When you enable ‘Views’ in the Render Layer panel, a new area is available in the 3D View properties region.
In this panel you can pick whether to see the stereo 3D in the viewport, or which camera to see. It also allow
you to see the Cameras, the Plane and the Volume of the stereo cameras.

Viewport Stereo 3D Settings.
Cameras
When working with the Stereo 3D Views setup, you can inspect what each individual generated camera is
looking or the combined result of them. In the Multi-View mode you can see the combined result of the
left and right cameras (when available) or the current selected camera.
Plane
The convergence plane represents the screen as it is perceived by the audience. Visualizing it in the 3D
View allows you to layout your scene based on your depth script outside the camera view.
Volume
The intersection of the stereo cameras frustums helps planning the show by avoiding elements being
visible by only one camera. The volume is defined by the camera’s start and end clipping distances. The
areas that are in the frustum of one camera only are known as retinal rivalry areas. They are tolerated in
the negative space (the region from the convergence plane into the image) but are to be avoided at all
costs in the positive space (the area from the convergence plane to the camera).
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Viewport 3D: Convergence Plane and Volume Display.

Multi-View and Stereo 3D Image I/O
Multi-View and Stereo 3D
Multi-View images can be saved in special formats according to the production requirements. By default
the system saves each view as an individual file, thus generating as many files as views to be rendered. In
stereo 3D productions, for the final deployment or even intermediary previews it is convenient to save
stereo 3D images, that are ready to use with 3D displays or simple anaglyph glasses. The formats
supported match the display modes available for the window.
Lossy-Formats
Some stereo 3D formats represent a considerable loss of data. For example, the Anaglyph format will cap
out entire color channels from the original image. The Top-Bottom compressed will discard half of your
vertical resolution data. The Interlace will mash your data considerably. Once you export in those formats,
you can still import the image back in Blender, for it to be treated as Stereo 3D. You will need to match
the window stereo 3D display mode to the image stereo 3D format though.
Lossless Formats
Some formats will preserve the original data, leading to no problems on exporting and importing the files
back in Blender. The Individual option will produce separate images that (if saved in a lossless encoding
such as PNG or OpenEXR) can be loaded back in production with no loss of data. For the Stereo 3D
formats the only lossless options are Top-Bottom and Side-by-Side without the Squeezed Frame option.
Multi-View OpenEXR
Another option is to use Multi-View OpenEXR files. This format can save multiple views in a single file
and is backward compatible with old OpenEXR viewers (you see only one view though). Multi-View
native support is only available to OpenEXR.
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Image Editor
View Menu
After you render your scene with Stereo 3D you will be able to see the rendered result in the combined
stereo 3D or to inspect the individual views. This works for Viewer nodes, render results or opened
images.

Stereo 3D and View menu.
Views Format
When you drag and drop an image into the UV/Image Editor, Blender will open it as an individual images
at first. If your image was saved with one of the Stereo 3D formats, you can change how Blender should
interpret the image by switching the mode to Stereo 3D, turning on Use Multi-View and picking the
corresponding stereo method.

Views Formats and Stereo 3D.

Compositor
The compositor works smoothly with Multi-View. The compositing of a view is completed before the
remaining views start to be composited. The pipeline is the same as the single-view workflow, with the
difference that you can use Images, Movies or Image Sequences in any of the supported Multi-View formats.
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Compositor, Backdrop and Split Viewer Node.
The views to render are defined in the current scene views, in a similar way as you define the composite output
resolution in the current scene render panel, regardless of the Image nodes resolutions or Render Layers from
different scenes.
Note
Single-View Images
If the image from an Image Node does not have the view you are trying to render, the image will be treated as
a single-view image.

Switch View Node
If you need to treat the views separately, you can use the Switch View node to combine the views before
an output node.

Performance Tip
By default, when compositing and rendering from the user interface all views are rendered and then
composited. During test iterations you can disable all but one view from the Scene Views panel, and re-enable
it after you get the final look.
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10.8 Render - OpenGL Render
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OpenGL Render
OpenGL rendering uses the 3d-views drawing for quick preview renders.
This allows you to inspect your animatic (for object movements, alternate angles, etc.).
This can also be used to preview your animations - in the event your scene is too complex for your system to
play back in real-time in the 3d-view.
You can use OpenGL to render both images and animations.
Below is a comparison between the OpenGL render and a final render using the Bforartists Internal engine.

OpenGL Render

Full Render

Tip
Showing Only Rendered Objects
To access this option, enable the Only Render in the Display Panel.
While this option is not specific to OpenGL rendering, its often useful to enable, since it removes data such as
rigs and empties that can be a distraction.
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Settings
For the most part, OpenGL Render uses view-port, however some render settings are used too.
•
•
•
•
•

Render Dimensions
Render Aspect
Anti-Aliasing, Samples & Full Sample (for slower, higher quality output).
Alpha (Sky background is only used when the 3D view has World Background enabled).
File Format & Output (file-path, format, compression settings... etc).

Rendering
Activating OpenGL render from the menu will render from the active camera.

You can also render any view-port, from the header of the 3D View, using the small button showing a Camera
(together with a small image showing a slate)
As with a normal render, you can abort it with Esc.
Render a Still Image
Click on the small button showing a camera in the header of the 3D View.
Or from the menu: Render ‣ OpenGL Render Image from the header of the Info Window
Render an Animation
Click on the small button showing a slate in the header of the 3D View.
Or from the menu: Render ‣ OpenGL Render Animation from the header of the Info Window
Render from the Sequencer
Click on the small button showing a slate in the header of Sequencer preview window.
Using scene strips in the sequencer you can edit together scenes to quickly render an entire sequence of
shots.
This can be activated using the render icons in the sequencer’s playback window header.

Known Limitations
OpenGL Anti-Aliasing Support
Some graphics cards don’t support this feature (known as the frame-buffer multi-sample OpenGL extensions).
In this case rendering works but no anti-aliasing is performed.
Enabling Full Sample, can be used to workaround this limit, because it doesn’t rely on hardware multi-sample
support.
Hint
2
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Exact extensions needed, as listed in output from Save System Info (OpenGL section).
•
•
•
•

GL_ARB_texture_multisample
GL_EXT_framebuffer_blit
GL_EXT_framebuffer_multisample_blit_scaled
GL_EXT_framebuffer_multisample
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10.9 Render - Audio Rendering
Introduction.............................................................................................................................................................1
Options................................................................................................................................................................1
Speaker....................................................................................................................................................................1
Options................................................................................................................................................................2
Sound.............................................................................................................................................................2
Distance..........................................................................................................................................................2
Cone...............................................................................................................................................................3

Introduction
Audio can be rendered from the Render menu in the Info Editor.

Options
The options can be found downleft in the Save dialog.
Relative Path
Select the file relative to the blend-file.
Accuracy
Sample accuracy, important for animation data (the lower the value, the more
accurate).
Audio Containers
See here.
Codec
Some Audio Containers also have option to choose a codec. For more information see here.
Split Channels
Each audio channel will be rendered into a separate file.

Speaker
The speaker object is used to give sound in the 3D View. After adding the object the various settings can be
changed in the properties editor.

1
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Options
Sound
Mute
Toggles whether or not the sound can be heard.
Volume
Adjust the loudness of the sound.
Pitch
Can be used to bend the pitch of the sound to be either deeper or higher.

Distance

Volume
Minimum
Minimum volume, no matter how far the object is.
Maximum
Maximum volume, no matter how far the object is.
Attenuation
How strong the distance affects the volume.
Distance
Maximum
Maximum distance for volume calculation.
Reference
Reference distance at which volume is 100%.
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Cone
Angle
Outer
Angle of the outer cone in degrees. Outside this cone the volume is the outer cone volume (see below).
Between the inner and outer cone the volume is interpolated.
Inner
Angle of the inner cone in degrees. Inside the cone the volume is 100%.
Volume
Outer
Volume outside the outer cone.
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Compositing
Compositing Nodes allow you to assemble and enhance an image (or movie). Using composition nodes, you
can glue two pieces of footage together and colorize the whole sequence all at once. You can enhance the colors
of a single image or an entire movie clip in a static manner or in a dynamic way that changes over time (as the
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clip progresses). In this way, you use composition nodes to both assemble video clips together, and enhance
them.
Note
Term: Image
The term Image may refer to a single picture, a picture in a numbered sequence of images, or a frame of a
movie clip. A node layout processes one image at a time, no matter what kind of input you provide.

Default Composition Noodle

To process your image, you use nodes to import the image into Bforartists, change it, optionally merge it with
other images, and finally save it.
The example to the right shows the simplest node setup; an input node links the camera view to an output node
so it can be saved.

Getting Started
Access the Node Editor and enable Composite Nodes by clicking on the Image icon.

Node Editor Header with Composite Nodes enabled

To activate nodes for compositing, click the Use Nodes checkbox. Bforartists creates a default node setup,
consisting out of two nodes linked together.
Note
After clicking Use Nodes the Compositor is enabled however, it can also be disabled in the Post Processing
Panel.

You now have your first node setup, a RenderLayer input node linked to a Composite output node. From here,
you can add and connect many types of compositing nodes, in a sort of map layout, to your heart’s content (or
physical memory constraints, whichever comes first).
Note
Nodes and node concepts are explained in more detail in the Node Editor

Options
Free Unused Button
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This button frees up memory space when you have a very complex node map.

Backdrop
Use the active viewer node output as a backdrop. When enabled, additional settings appear in the Header and
the Properties Panel:

Backdrop Channels.

Backdrop Channels
Set the image to be displayed with Color, Color and Alpha, or just Alpha.
Zoom
Sets how big the backdrop image is.
Offset
Change the screen space position of the backdrop, or click the Move button, or
shortcut Alt-MMB to manually move it.
Auto Render
Re-render and composite changed layer when edits to the 3d scene are made.

Performance Settings

Backdrop Options

Render
Set quality when rendering in Node Editor.
Edit
Set quality when editing in Node Editor
Chunk Size
Max size of a title (smaller values give better distribution of multiple threads,
but more overhead).
OpenCL
Enable GPU calculations when working in Node Editor.
Buffer Groups
Enable buffering of group nodes.
Two Pass
Use two pass execution during editing: first calculate fast nodes, second pass
calculate all nodes.
Viewer Border
Use boundaries for viewer nodes and composite backdrop.
Highlight
Highlight nodes that are being calculated.

Performance Settings

Examples
You can do just about anything with images using nodes.
Raw footage from a foreground actor in front of a blue screen, or a rendered object doing something, can be
layered on top of a background. Composite both together, and you have composited footage.
You can change the mood of an image:
• To make an image ‘feel’ colder, a blue tinge is added.
6
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• To convey a flashback or memory, the image may be softened.
• To convey hatred and frustration, add a red tinge or enhance the red. The film ‘Sin City’ is the most
extreme example of this I have ever seen.
• A startling event may be sharpened and contrast-enhanced.
• A happy feeling - you guessed it - add yellow (equal parts red and green, no blue) for bright and sunny.
• Dust and airborne dirt is often added as a cloud texture over the image to give a little more realism.

Types of Nodes
This section is organized by type of nodes, which are grouped based on similar functions:
•
•
•
•
•
•
•
•
•

Input Nodes
Output Nodes
Color Nodes
Converter Nodes
Filter Nodes
Vector Nodes
Matte Nodes
Distort Nodes
Layout Nodes

Input Nodes
Input nodes produce information from some source. For instance, an input could be:
•
•
•
•

Taken directly from the active camera in a selected scene,
from a JPG, PNG, etc. file as a static picture,
a movie clip (such as an image sequence or video), or
just a color or value.

These nodes generate the information that feed other nodes. As such, they have no input-connectors; only
outputs.
•
•
•
•
•
•
•
•
•
•

Render Layers Node
Image Node
Movie Clip
Mask
RGB Node
Value Node
Texture Node
Bokeh Image
Time Node
Track Position
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Render Layers Node

Render Layers Node

This node is the starting place to getting a picture of your scene into the compositing node map.
This node inputs an image from a scene within your blend file. Select the scene and the active render layer from
the yellow selection list at the bottom of the node. Bforartists uses the active camera for that scene to create an
image of the objects specified in the RenderLayer.
The Image is input into the map, along with the following data:
• Alpha (transparency) mask
Depending on the Renderlayer passes that are enabled, other sockets are available. By default the Z is enabled:
• Z depth map (how far away each pixel is from the camera)
The example shows that two other passes are enabled:
• Normal vector set (how light bounces off the surface)
• Speed vector set (how fast an object is moving from one frame to the next)
Use the re-render button (Small landscape icon - to the right of the Renderlayer name) to re-render the scene
and refresh the image and map.
You may recall that a .blend file may contain many scenes. The Renderlayer node can pick up the scene info
from any available scene by selecting the scene from the left-hand selector. If that other scene also uses the
compositor and/or sequencer, you should note that the scene information taken is the raw information (precompositing and pre-sequencing). If you wish to use composited information from another scene, you will have
to render that scene to a multilayer OpenEXR frameset as an intermediate file store, and then use the Image
input node instead.
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Using the Alpha Socket
Using the Alpha output socket is crucial in overlaying images on top of one another and letting a background
image “show through” the image in front of it.
In a Bforartists scene, your objects are floating out there in virtual space. While some objects are in front of one
another (Z depth), there is no ultimate background. Your world settings can give you the illusion of a horizon,
but it’s just that: an illusion. Further, some objects are semi-transparent; this is called having an Alpha value. A
semi-transparent object allows light (and any background image) to pass through it to the camera. When you
render an image, Bforartists puts out, in addition to a pretty image, a map of what solid objects actually are
there, and where infinity is, and a map of the alpha values for semi-transparent objects. You can see this map by
mapping it to a blue screen:

Viewing the Alpha values

In the little node map above, we have connected the Alpha output socket of the RenderLayer node to a Map
Value node (explained later, but basically this node takes a set of values and maps them to something we can
use). The Color Ramp node (also explained later in detail) takes each value and maps it to a color that we can
see with our eyes. Finally, the output of the Color Ramp is output to a Composite viewer to show you, our dear
reader, a picture of the Alpha values. Notice that we have set up the map so that things that are perfectly solid
(opaque) are white, and things that are perfectly transparent (or where there is nothing) are blue.

Optional Sockets
For any of the optional sockets to appear on the node, you MUST have the corresponding pass enabled. In order
for the output socket on the RenderLayer node to show, that pass must be enabled in the RenderLayer panel in
the Buttons window. For example, in order to be able to have the Shadow socket show up on the RenderLayer
input node, you must have the “Shad” button enabled in the Buttons window, Scene Render buttons,
Renderlayer panel. See the RenderLayer tab (Buttons window, Output frame, Render Layers tab, Passes
selector buttons) for Bforartists to put out the values corresponding to the socket.
For a simple scene, a monkey and her bouncy ball, the following picture expertly provides a great example of
what each pass looks like:
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The available sockets are:
•
•
•
•
•
•
•
•
•
•
•
•
•

Z: distance away from the camera, in Bforartists Units
Normal (Nor): How the color is affected by light coming from the side
UV: how the image is distorted by the UV mapping
Speed (Vec): How fast the object is moving, and in what direction
Color (Col): the RGB values that color the image that you see
Diffuse: the softening of colors as they diffuse through the materials
Specular: the degree of shininess added to colors as they shine in the light
Shadow: shadows cast by objects onto other objects
AO: how the colors are affected by Ambient Occlusion in the world
Reflect (Ref): for mirror type objects, the colors they reflect and are thus not part of their basic material
Refract: how colors are bent by passing through transparent objects
Radio (Radiosity): colors that are emitted by other objects and cast onto the scene
IndexOB: a numeric ordinal (index) of each object in the scene, as seen by the camera.

Using the Z value Socket
Using the Z output socket is crucial in producing realistic images, since items farther away are blurrier (but
more on that later).
Imagine a camera hovering over an X-Y plane. When looking through the camera at the plane, Y is up/down
and X is left/right, just like when you are looking at a graph. The camera is up in the air though, so it has a Z
10
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value from the X-Y plane, and, from the perspective of the camera, the plane, in fact all the objects that the
camera can see, have a Z value as a distance that they are away from it. In addition to the pretty colors of an
image, a RenderLayer input node also generates a Z value map. This map is a whole bunch of numbers that
specify how far away each pixel in the image is away from the camera. You can see this map by translating it
into colors, or shades of gray:

Viewing the Z values

In the little node map above, we have connected the Z output socket of the RenderLayer node to a Map Value
node (explained later). This node takes a set of values and maps them to something we can use. The Color
Ramp node (also explained later in detail) takes each value and maps it to a shade of gray that we can see with
our eyes. Finally, the output of the colorramp is output to a Composite viewer to show you, our dear reader, a
picture of the Z values. Notice that we have set up the Map Value node so that things closer to the camera
appear blacker (think: black is 0, less Z means a smaller number) and pixels/items farther away have an
increasing Z distance and therefore get whiter. We chose a Size value of 0.05 to see Z values ranging from 0 to
20 (20 is 1/0.05).

Using the Speed Socket
Even though things may be animated in our scene, a single image or frame from the animation does not portray
any motion; the image from the frame is simply where things are at that particular time. However, from the
Render Layers node, Bforartists puts out a vector set that says how particular pixels are moving, or will move,
to the next frame. You use this socket to create a blurring effect..

Image Node
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Image Node

The Image node injects any image format that is supported by Bforartists. Besides inputting the actual image,
this node can also input Alpha and depth (Z) values if the image has them. If the image is a MultiLayer format,
all saved render passes are input. Use this node to input:
•
•
•
•
•

A single image from a file (such as a JPG picture)
Part or all of an animation sequence (such as the 30th to 60th frame)
Part or all of a movie clip (such as an AVI file)
the image that is currently in the UV/Image Editor (and possibly being painted)
an image that was loaded in the UV/Image Editor

Animated image sequences or video files can also be used. See Animations below.
To select an image file or generated image from the UV/Image Editor, click on the small arrow selector button
to the left of the name and pick an existing image (e.g. loaded in the UV editor or elsewhere) or click on LOAD
NEW to select a file from your hard disk via a file-browser. These images can be e.g. previously rendered
images, matte paintings, a picture of your cat, whatever. Bforartists really doesn’t care.
If the image is part of a sequence, manually click the Image Type selector to the right of the name, and select
Sequence. Additional controls will allow you to define how much of the sequence to pull in (see Animations
below). If the file is a video file, these controls will automatically appear.

Image Channels
When the image is loaded, the available channels will be shown as sockets on the node. As a minimum, the
Image, Alpha, and Z channels are made available. The picture may or may not have an alpha (transparency)
and/or Z (depth) channel, depending on the format. If the image format does not support A and/or Z, default
values are supplied (1.0 for A, 0.0 for Z).
Alpha/Transparency Channel
• If a transparency channel is detected, the Alpha output socket will supply it.
• If it does not have an Alpha channel (e.g. JPG images), Bforartists will supply one, setting the
whole image to completely opaque (an Alpha of 1.00, which will show in a Viewer node as white if connected to the Image input socket).
Z/depth Channel
• If a Z (depth) channel is detected, the Z output socket will supply it.
• If it does not have a Z channel (e.g. JPG or PNG images), Bforartists will supply one, setting the
whole image to be at the camera (a depth of 0.00). To view the Z-depth channel, use the Map
Value to ColorRamp noodle given above in the Render Layer input node (see Using the Z value
Socket ).
Note
Formats
Bforartists supports many image formats. Currently only the OpenEXR image format stores RGB (color), A
(alpha), and Z (depth) buffer information in a single file, if enabled.
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Saving/Retrieving Render Passes

Bforartists can save the individual Render Layers and specific passes in a MultiLayer file format, which is an
extension of the OpenEXR format. In this example, we are reading in frames 50 to 100 of a RenderLayer that
were generated some time ago. The passes that were saved were the Image, Alpha, Z, Specular and AO passes.
To create a MultiLayer image set when initially rendering, simply disable Do Composite, set your Format to
MultiLayer, enable the Render Layer passes you wish to save over the desired frame range, and Animate. Then,
in Bforartists, enable Compositing Nodes and Do Composite, and use the Image input node to read in the EXR
file. When you do, you will see each of the saved passes available as sockets for you to use in your compositing
noodle.

Image Size
Size matters - Pay attention to image resolution and color depth when mixing and matching images. Aliasing
(rough edges), color flatness, or distorted images can all be traced to mixing inappropriate resolutions and color
depths.
The compositor can mix images with any size, and will only perform operations on pixels where images have
an overlap. When nodes receive inputs with differently sized Images, these rules apply:
• The first/top Image input socket defines the output size.
• The composite is centered by default, unless a translation has been assigned to a buffer using a
Translate node.
So each node in a composite can operate on different sized images, as defined by its inputs. Only the Composite
13
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output node has a fixed size, as defined by the Scene buttons (Format Panel). The Viewer node always shows
the size from its input, but when not linked (or linked to a value) it shows a small 320x256 pixel image.

Animations

To use image sequences or movies within your composition, press the face or little film strip button located to
the right of the selector. As you click, a pop-up will offer you four choices:
•
•
•
•

Generated - a image generated from the UV Editor
Sequence - a sequence of frames, each frame in a separate file.
Movie - a sequence of frames packed into a single .avi or .mov file
Image - a single frame or still image in a file

A Movie or Image can be named anything, but a Sequence must have a digit sequence somewhere in its
filename, for example fire0001set.jpg, fire0002set.jpg, fire0003set.jpg and so on. The number indicates the
frame.
If a Sequence or Movie is selected, an additional set of controls will appear that allows you to select part or all
of the sequence. Use these controls to specify which frames, out of the original sequence, that you want to
introduce into the animation you are about to render. You can start at the beginning and only use the beginning,
or even pick out a set of frames from the middle of an existing animation.
The Frs number button is the number of frames in the sequence that you want to show. For example, if you
want to show 2 seconds of the animation, and are running 30 fps, you would put 60 here.
The SFra number button sets the start frame of the animation; namely, at what point in the animation that you
are going to render do you want this sequence to start playing. For example, if you want to introduce this clip
ten seconds into the composite output, you would put 300 here (at 30 fps).
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The First number button sets the first number in the animated sequence name. For example, if your images
were called “credits-0001.png”, “credits-0002.png” through “credits-0300.png” and you wanted to start picking
up with frame 20, you’d put 20 here.
To have the movie/sequence start over and repeat when it is done, press the Cycl ic button. For example, if you
were compositing a fan into a room, and the fan animation lasted 30 frames, the animation would start over at
frame 31, 61, 91, and so on, continuously looping. As you scrub from frame to frame, to see the actual video
frame used for the current frame of animation, press the auto button to the right of the Cycl ic button.

Generated Images
Using the Nodes to modify a painting in progress in the UV/Image window Bforartists features Texture Paint
which works in the UV/Image Editor, that allows you to paint on the fly, and the image is kept in memory or
saved. If sync lock is enabled (the lock icon in the header), changes are broadcast throughout Bforartists as soon
as you lift the mouse button. One of the places that the image can go is to the Image Input node. The example
shows a painting session going on in the right-hand UV/Image Editor window for the painting “Untitled”.
Create this image via Image?New in the UV/Image Editor. Refer to the texture paint section of the user maual
for more info on using Texture Paint.
In the left-hand window, the Image input node was used to select that “Untitled” image. Notice that the Image
type icon is blank, indicating that it is pulling in a Generated image. That image is colorized by the noodle, with
the result used as a backdrop in the Node Editor Window.
Using this setup and the Generated Image type is like painting and post-processing as you continue painting.
Changes to either the painting or the post-pro noodle are dynamic and real-time.

Movie Clip

Mask Node

TODO - see: https://developer.Bforartists.org/T43469
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Mask

Mask Node

TODO - see: https://developer.Bforartists.org/T43469

RGB Node

RGB Node

The RGB node has no inputs. It just outputs the Color currently selected in its controls section; a sample of it is
shown in the top box. In the example to the right, a gray color with a tinge of red is slected.
To change the brightness and saturation of the color, LMB click anywhere within the square gradient. The
current saturation is shown as a little circle within the gradient. To change the color itself, click anywhere along
the rainbow Color Ramp.
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Example

In this example, our corporate color is teal, but the bozo who made the presentation forgot. So, we multiply his
lame black and white image with our corporate color to save him from embarrassment in front of the boss when
he gives his boring presentation.

Value Node

Value Node

The Value node has no inputs; it just outputs a numerical value (floating point spanning 0.00 to 1.00) currently
entered in the NumButton displayed in its controls selection.
Use this node to supply a constant, fixed value to other nodes’ value or factor input sockets.

Texture Node

17
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Texture Node

The Texture node makes 3D textures available to the compositor.
The Texture node makes 3D textures available to the compositor. A texture, from the list of textures available in
the current blend file, is selected and introduced through the value and/or color socket.
Note
Please read up on the Bforartists Library system for help on importing and linking to textures in other
Bforartists files.

Note
You cannot edit the textures themselves in the node window. To use this node, create and edit the texture in
the normal texture buttons, then select the texture from the menu button on the node.

You can change the Offset and a Scale (which is called Offs XYZ and Size XYZ in the Materials Texture Map
Input panel) for the texture by clicking on the label and setting the sliders, thus affecting how the texture is
applied to the image. For animation, note that this is a vector input socket, because the XYZ values are needed.
Texture nodes can output a straight black-and-white Value image (don’t mistake this for alpha) and an image
(Color).

18
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Example

In the example above, we want to simulate some red plasma gas out there in space. So, we fog up an image
taken from the Hubble telecscope of Orion and take the ever-so-useful Cloud texture and use it to mix in red
with the image.

Bokeh Image

Bokeh Image Node

Bokeh Image generates a special input image for use with the Bokeh Blur filter node.
Bokeh Image is designed to create a reference image which simulates optical parameters such as aperture shape
and lens distortions which have important impacts on bokeh in real cameras.
The first three settings simulate the aperture of the camera. Flaps sets an integer number of blades for the
cameras iris diaphragm. Angle gives these blades an angular offset relative to the image plane and Rounding
sets the curvature of the blades with a 0 being straight and 1 bringing them to a perfect circle.
Catadioptric provides a type of distortion found in mirror lenses and some telescopes. This can be useful to
19
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produce a ‘busy’ bokeh.
Lens Shift introduces chromatic aberration into the blur such as would be caused by a tilt-shift lens.

Example of a bokeh image with 5 flaps.

Time Node

Time Node

The Time node generates a fac tor value (from 0.00 to 1.00) (that changes according to the curve drawn) as time
progresses through your movie (frames).
The Start and End NumButtons specify the range of time the values should be output along, and this range
becomes the X-axis of the graph. The curve defines the Y-value and hence the factor that is output. In the
example to the right, since the timespan is 250 frames and the line is straight from corner to corner, 0.50 would
be output at frame 125, and 0.75 will be output at frame 187.
Note
Note on output values
The Map Value node can be used to map the output to a more appropriate value. With some time curves, it is
possible that the Time node may output a number larger than one or less than zero. To be safe, use the
20
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Min/Max clamping function of the Map Value node to limit output.

You can reverse time (unfortunately, only in Bforartists and not in the real world) by specifying a Start frame
greater than the End frame. The net effect of doing so is to flip the curve around. Warning: doing so is easily
overlooked in your node map and can be very confusing (like meeting your mother when she was/is your age in
“Back to the Future”).
Note
Time is Relative
In Bforartists, time is measured in frames. The actual duration of a time span depends on how fast those
frames whiz by (frame rate). You set the frame rate in your animation settings (Render Dimensions Panel).
Common settings range from 5 seconds per frame for slideshows (0.2 fps), to 30 fps for US movies.

Time Node Examples
In the picture below, over the course of a second of time (30 frames), the following time controls are made:

See:

1.
2.
3.
4.
5.

No Effect
Slow Down
Freeze
Accelerate
Reverse

Common uses for this include a “fade to black”, wherein the accelerate time curve (typically exponentiallyshaped) feeds a mix value that mixes a constant black color in, so that the blackness accelerates and eventually
darkens the image to total black. Other good uses include an increasing soften (blur-out or -in) effect, or fade-in
a background or foreground, instead of just jumping things into or out of the scene.
You can even imagine hooking up one blur to a background renderlayer, another inverted blur to a foreground
renderlayer, and time-feeding both. This node group would simulate someone focusing the camera lens.

Usage
As your imagination runs wild, consider a few ideas that came to me just now on my couch: mixing a clouds
texture with a time input to fog up a piece of glass or show spray paint building up on a wall. Consider mixing
red and the soften with time (decreasing output) to show what someone sees when waking up from a hard hit on
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the head. Mix HSV input with a starfield image with time (decreasing output) to show what we might see
someday as we accelerate our starship and experience red-shift.

Track Position Node

Track Position Node.
The Track Position node is used to return information about a tracking marker to the compositor.

Inputs
This node as no inputs.

Properties
Movie Clip
Used to select a Movie Clip data-block to use, for controls see Data-Block Menu.
Tracking Object
Camera object to get track information from.
Track Name
The name of the track to get track information from.
Position
Which marker position to use for output.
Absolute
Outputs a absolute position of a marker.
Relative Start
Outputs the positions of a marker relative to the first marker of a track.
Relative Frame
Outputs the positions of a marker relative to the markers of the given Frame.
Absolute Frame
Outputs the absolute positions of a marker at the given Frame.

Outputs
X/Y
The markers X and Y location.
Speed
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The velocity of the marker, measured in pixels per frame. This could be used to fake effects like motion
blur by connecting it to the Vector Blur Node.

Examples
TODO.

Output Nodes
These nodes are used to output the composited result in some way.
•
•
•
•
•

Composite Node
Viewer Node
Split Viewer Node
File Output Node
Levels Node

Composite Node

Composite Node

The Composite node is where the actual output from the compositor is connected to the renderer. Connecting a
node to the Composite node will output the result of that node’s full tree to the Renderer; leaving this node
unconnected will result in a blank image. This node is updated after each render, but also if you change things
in your node-tree (provided at least one finished input node is connected).
You can connect three channels: the actual RGBA image, the Alpha image, and the Z (depth) image. You should
only have one Composite node in your map so that only one final image is rendered when the Compositing
button is pressed on the Render Options Post-Processing panel. Otherwise, unpredictable results may occur.
Note
If multiple Composite nodes are added, only the active one (last selected, indicated with a slightly darker
header) will be used.

23

Bforartists Reference Manual - © Copyright - This page is under OCL license

Saving your Composite Image
The RENDER button renders a single frame or image. Save your image using F3 or the File→Save Image
menu. The image will be saved using the image format settings on the Render panel.
To save a sequence of images, for example, if you input a movie clip or used a Time node with each frame in its
own file, use the ANIM button and its settings. If you might want to later overlay them, be sure to use an image
format that supports an Alpha channel (such as PNG). If you might want to later arrange them front to back or
create a depth of field effect, use a format that supports a Z-depth channel (such as EXR).
To save a composition as a movie clip (all frames in a single file), use an AVI or Quicktime format, and use the
ANIM button and its settings.

Viewer Node

Viewer Node

The Viewer node is a temporary, in-process viewer. Plug it in wherever you would like to see an image or valuemap in your node-tree.
LMB click on the image to update it, if it wasn’t done automatically. You can use as many of these as you would
like. It is possible to automatically plug a Viewer node to any other node by pressing Shift-Ctrl-LMB on it.
Note
It is possible to add multiple Viewer nodes, though only the active one (last selected, indicated with a slightly
darker header) will be shown on the backdrop or in the UV/Image editor.

Border Compositing
A border for the viewer node can be defined using Ctrl-B and selecting a rectangular area.
This border is used to define the area of interest of the viewer node which restricts compositing to this area.
Used for faster previews by skipping compositing outside of the defined area of interest. This is only a preview
option, final compositing during a render ignores this border.
Use Ctrl-Alt-B to discard the defined border and see a full preview.
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Tile order
The tile order can be defined for the backdrop image, using the Tile order field in the properties of the viewer
node (Properties panel in Properties sidebar, with the viewer node selected):
Rule of thirds
Calculates tiles around each of the 9 zones defined by the rule of thirds (see Rule of Thirds for more
information).
Bottom up
Tiles are calculated from the bottom up.
Random
Calculates tiles in a non-specific order.
Center
Calculates the tiles around a specific center, defined by X and Y fields.

Using the UV/Image Editor Window
The viewer node allows results to be displayed in the UV/Image Editor. The image is facilitated by selecting
Viewer Node on the window’s header linked image selector. The UV/Image Editor will display the image from
the currently selected viewer node.
To save the image being viewed, use Image ‣ Save As Image (F3) to save the image in a file.
The UV/Image Editor also has three additional options in its header to view Images with or without Alpha, or to
view the Alpha or Z itself. Holding LMB in the Image display allows you to sample the values.

Split Viewer Node

Split Viewer Node

The SplitViewer node takes two images and displays one half of each on each side (top socket on the right half,
bottom socket input on the left). Use this node for making side-by-side comparisons of two renderings/images,
perhaps from different renderlayers or from different scenes. When transitioning between scenes, you want to
be sure the stop action is seamless; use this node to compare the end of one scene with the beginning of another
to ensure they align.

File Output Node
25

Bforartists Reference Manual - © Copyright - This page is under OCL license

File Output Node

This node puts out an RGBA image, in the format selected, for each frame range specified, to the filename
entered, as part of a frameset sequence. This means that the name of the file will be the name you enter plus a
numeric frame number, plus the filename extension (based on format). Based on the format you choose, various
quality/compression options may be shown.
To support subsequent arrangement and layering of images, the node can supply a Z-depth map. However,
please note that only the OpenEXR image formats save the Z information.
The image is saved whenever Bforartists feels like it. Just kidding; whenever you press the Render button, the
current frame image is saved. When you press the Anim button, the frameset sequence (specified in the Start
and End frame) is saved.
This node saves you from doing (or forgetting to do) the Save Image after a render; the image is saved
automagically for you. In addition, since this node can be hooked in anywhere in the noodle, you can save
intermediate images automatically. Neat, huh?
Note
Filespecs
As with all filename entries, use // at the beginning of the field to shorthand reference the current directory of
the .blend file. You can also use the .. breadcrumb to go up a directory.

Levels Node

Levels Node

The Levels Node takes an image as an input, and can output a 1D value based on the levels of an image. It can
read the input’s Combined RGB, Red, Green, Blue, or Luminance channels.
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It can output a Mean value, or average of values, or a Standard deviation, which measures the diversity of
values.

Color Nodes
These nodes adjust the image’s colors, for example increasing the contrast, making it warmer, overlaying
another image, etc.
•
•
•
•
•
•
•
•
•
•
•
•

Mix Node
Alpha Over Node
Invert Node
RGB Curves Node
Hue Saturation Node
Color Balance
Hue Correct Node
Bright/Contrast Node
Gamma Node
Color Correction Node
Tone Map Node
Z-Combine Node

Mix Node

Mix Node

This node mixes a base image (threaded to the top socket) together with a
second image (bottom socket) by working on the individual and corresponding pixels in the two images or
surfaces. The way the output image is produced is selected in the drop-down menu. The size (output resolution)
of the image produced by the mix node is the size of the base image. The alpha and Z channels are mixed as
well.
See also
Color Blend Modes for details on each blending mode.
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Note
Color Channels
There are two ways to express the channels that are combined to result in a color: RGB or HSV. RGB stands
for the Red/Green/Blue pixel format, and HSV stands for the Hue/Saturation/Value pixel format.

Alpha
Click the Alpha button to make the mix node use the Alpha (transparency) values of the second (bottom)
node. If enabled, the resulting image will have an Alpha channel that reflects both images’ channels.
Otherwise, (when not enabled, light green) the output image will mix the colors by considering what
effect the Alpha channel has of the base (top input socket) image. The Alpha channel of the output image
is not affected.
Fac
The amount of mixing of the bottom socket is selected by the Factor input field (Fac:). A factor of zero
does not use the bottom socket, whereas a value of 1.0 makes full use. In Mix mode, 0.5 is an even mix
between the two, but in Add mode, 0.5 means that only half of the second socket’s influence will be
applied.

Examples
Below are
samples of
common mix
modes and uses,
mixing a color or
checker with a
mask.
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Some explanation of the mixing methods above might help you use the Mix node effectively:
• Add - adding blue to blue keeps it blue, but adding blue to red makes purple. White already has a full
amount of blue, so it stays white. Use this to shift a color of an image. Adding a blue tinge makes the
image feel colder.
• Subtract : Taking Blue away from white leaves Red and Green, which combined make Yellow (and you
never thought you’d need a color wheel again, eh?). Taking Blue away from Purple leaves Red. Use this
to de-saturate an image. Taking away yellow makes an image bluer and more depressing.
• Multiply : Black (0.00) times anything leaves black. Anything times White (1.00) is itself. Use this to
mask out garbage, or to colorize a black-and-white image.
• Hue : Shows you how much of a color is in an image, ignoring all colors except what is selected: makes
a monochrome picture (style ‘Black & Hue’).
• Mix : Combines the two images, averaging the two.
• Lighten : Like bleach, makes your whites whiter. Use with a mask to lighten up a little.
• Difference : Kinda cute in that it takes out a color. The color needed to turn Yellow into White is Blue.
Use this to compare two verrry similar images to see what had been done to one to make it the other;
sorta like a change log for images. You can use this to see a watermark (see Using Mix to Watermark
images) you have placed in an image for theft detection.
• Darken, with the colors set here, is like looking at the world through rose-colored glasses (sorry, I just
couldn’t resist).

Contrast Enhancement using Mix
Here is a small map showing the effects of two other common uses for the RGB Curve: Darken and Contrast
Enhancement. You can see the effect each curve has independently, and the combined effect when they are
mixed equally.
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Example node setup showing
“Darken”, “Enhance Contrast”
and “Mix” nodes for composition.

As you can hopefully see, our
original magic monkey was overexposed by too much light. To cure an overexposure, you must both darken the
image and enhance the contrast. Other paint programs usually provide a slider type of control, but Bforartists,
ah the fantastic Bforartists, provides a user-definable curve to provide precise control.
In the top RGB curve, Darken, only the right side of the curve was lowered; thus, any X input along the bottom
results in a geometrically less Y output. The Enhance Contrast RGB ‘S’ curve scales the output such that
middle values of X change dramatically; namely, the middle brightness scale is expanded, and thus whiter
whites and blacker blacks are output. To make this curve, simply click on the curve and a new control point is
added. Drag the point around to bend the curve as you wish. The Mix node combines these two effects equally,
and Suzanne feels much better. And NOBODY wants a cranky monkey on their hands.

Using Mix to Watermark images
In the old days, a pattern was pressed into the paper mush as it dried, creating a mark that identified who made
the paper and where it came from. The mark was barely perceptible except in just the right light. Probably the
first form of subliminal advertising. Nowadays, people watermark their images to identify them as personal
intellectual property, for subliminal advertising of the author or hosting service, or simply to track their image’s
proliferation throughout the web. Bforartists provides a complete set of tools for you to both encode your
watermark and to tell if an image has your watermark.

Encoding Your Watermark in an Image
First, construct your own personal watermark. You can use your name, a word, or a shape or image not easily
replicated. While neutral gray works best using the encoding method suggested, you are free to use other colors
or patterns. It can be a single pixel or a whole gradient; it’s up to you. In the example below, we are encoding
the watermark in a specific location in the image using the Translate node; this helps later because we only have
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to look in a specific location for the mark. We then use the RGB to BW node to convert the image to numbers
that the Map Value node can use to make the image subliminal. In this case, it reduces the mark to one-tenth of
its original intensity. The Add node adds the corresponding pixels, make the ones containing the mark ever-soslightly brighter.

Embedding your mark in an Image using a Mark and Specific Position

Of course, if you want people to notice your mark, don’t scale it so much, or make it a contrasting color. There
are also many other ways, using other mix settings and fancier rigs. Feel free to experiment!
Note
Additional uses
You can also use this technique, using settings that result in visible effects, in title sequences to make the words
appear to be cast on the water’s surface, or as a special effect to make words appear on the possessed girl’s
forearm. yuk.

Decoding an Image for your Watermark
When you see an image that you think might be yours, use the node map below to compare it to your stock
image (pre-watermarked original). In this map, the Mix node is set to Difference, and the Map Value node
amplifies any difference. The result is routed to a viewer, and you can see how the original mark stands out,
clear as a bell:

31

Bforartists Reference Manual - © Copyright - This page is under OCL license

Checking an image for
your watermark

Various image
compression algorithms lose some of the original; the difference shows as noise. Experiment with different
compression settings and marks to see which works best for you by having the encoding map in one scene, and
the decoding map in another. Use them while changing Bforartists’s image format settings, reloading the
watermarked image after saving, to get an acceptable result. In the example above, the mark was clearly visible
all the way up to JPEG compression of 50%.

Using Dodge and Burn (History Lesson)
Use the dodge and burn mix methods in combination with a mask to affect only certain areas of the image. In
the old darkroom days, when, yes, I actually spent hours in a small stinky room bathed in soft red light, I used a
circle cutout taped to a straw to dodge areas of the photo as the exposure was made, casting a shadow on the
plate and thus limiting the light to a certain area.
To do the opposite, I would burn in an image by holding a mask over the image. The mask had a hole in it,
letting light through and thus ‘burning’ in the image onto the paper. The same equivalent can be used here by
mixing an alpha mask image with your image using a dodge mixer to lighten an area of your photo. Remember
that black is zero (no) effect, and white is one (full) effect. And by the way, ya grew to like the smell of the
fixer, and with a little soft music in the background and the sound of the running water, it was very relaxing. I
kinda miss those dayz.

Alpha Over Node
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Alpha Over Node

Use this node to layer images on top of one another. This node takes two images as
input, combines them by a factor, and outputs the image. Connect the Background image to the top input, and
the foreground image to the lower input. Where the foreground image pixels have an alpha greater than 0
(namely, have some visibility), the background image will be overlaid.
Use the Factor slider to ‘merge’ the two pictures. A factor less than 1.00 will make the foreground more
transparent, allowing the background to bleed through.

Examples

Assembling a composite Image using AlphaOver

In this example, an image of a Toucan is
superimposed over a wooden background. Use the PreMultiply button when the foreground image and
background images have a combined Alpha that is greater than 1.00; otherwise you will see an unwanted halo
effect. The resulting image is a composite of the two source images.

Animated See-
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Through/Sheer SFX using AlphaOver - Frame 11

In this example, we use the Factor control to make a sheer cloth or onion-skin effect. You can animate this
effect, allowing the observer to ‘see-through’ walls (or any foreground object) by hooking up a Time node to
feed the Factor socket as shown below. In this example, over the course of 30 frames, the Time node makes the
AlphaOver node produce a picture that starts with the background wood image, and slowly bleeds through the
Toucan. This example shows frame 11 just as the Toucan starts to be revealed.
AlphaOver does not work on the colors of an image, and will not output any image when one of the sockets is
unconnnected.

Strange Halos or Outlines
To clarify the premultiplied-alpha button: An alpha channel has a value of between 0 and 1. When you make an
image transparent (to composite it over another one), you are really multiplying the RGB pixel values by the
alpha values (making the image transparent (0) where the alpha is black (0), and opaque (1) where it is white
(1)).
So, to composite image A over image B, you get the alpha of image A and multiply it by image A, thus making
the image part of A opaque and the rest transparent. You then inverse the alphas of A and multiply image B by
it, thus making image B transparent where A is opaque and vice versa. You then add the resultant images and
get the final composite.
A pre-multiplied alpha is when the image (RGB) pixels are already multiplied by the alpha channel, therefore
the above compositing op doesn’t work too well, and you have to hit ‘convert pre-mult’. This is only an issue in
semi transparent area, and edges usually. The issue normally occurs in Nodes when you have combined, with
alpha, two images, and then wish to combine that image with yet another image. The previously combined
image was previously multiplied (pre-mult) and needs to be converted as such (hence, Convert PreMul).
If you don’t pay attention and multiply twice, you will get a white or clear halo around your image where they
meet, since your alpha value is being squared or cubed. It also depends on whether or not you have rendered
your image as a pre-mult, or straight RGBA image.

Layering Images using AlphaOver Premul
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Invert Node

Invert Node

This handy node inverts the colors in the input image, producing a negative.

Options
Factor
Controls the amount of influence the node exerts on the output image
Color
The input image. In this case, a red sphere on a black transparent background
RGB
Invert the colors from white. In this example, red inverted is cyan (teal).
A
Invert the alpha (transparency) channel as well. Handy for masking.
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RGB Curves Node

RGB Curves Node

For each color component channel (RGB) or the composite (C), this
node allows you to define a bezier curve that varies the input (x-axis) to produce an output value (y-axis).
Clicking on one of the C R G B components displays the curve for that channel.
See also
• Read more about using the Curve Widget.

Here are some common curves you can use to achieve desired effects:

Identifiers: A) Lighten B)
Negative C) Decrease Contrast D) Posterize

Options
Fac
How much the node should factor in its settings and affect the output.
Black Level
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Defines the input color that is mapped to black. Default is black, which does not change the image.
White Level
Defines the input color that is mapped to white. Default is white, which does not change the image.
The levels work exactly like the ones in the image viewer. Input colors are scaled linearly to match black/white
levels.
To define the levels, either use LMB on the color patch to bring up the color selection widget or connect some
RGBA input to the sockets.
To only affect the value/contrast (not hue) of the output, set the levels to shades of gray. This is equivalent to
setting a linear curve for C.
If you set any level to a color with a saturation greater than 0, the output colors will change accordingly,
allowing for basic color correction or effects. This is equivalent to setting linear curves for R, G and B.

Examples
Color correction using Curves

Color correction with curves

In this example, the image has way too much red in it, so we run it through an RGB node and reduce the Red
channel by about half.
We added a middle dot so we could make the line into a sideways exponential curve. This kind of curve evens
out the amount of a color in an image as it reaches saturation. Also, read on for examples of the Darken and
Contrast Enhancement curves.

Color correction using Black/White Levels
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Color correction with Black/White Levels

Manually adjusting the RGB curves for color correction can be difficult. Another option for color correction is
to use the Black and White Levels instead, which really might be their main purpose.
In this example, the White Level is set to the color of a bright spot of the sand in the background, and the Black
Level to the color in the center of the fish’s eye. To do this efficiently it’s best to bring up an image viewer
window showing the original input image. You can then use the levels’ color picker to easily choose the
appropriate colors from the input image, zooming in to pixel level if necessary. The result can be fine-tuned
with the R,G, and B curves like in the previous example.
The curve for C is used to compensate for the increased contrast that is a side-effect of setting Black and White
Levels.

Effects
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Changing colors

Curves and Black/White Levels can also be used to completely change the colors of an image.
Note that e.g. setting Black Level to red and White Level to blue does not simply substitute black with red and
white with blue as the example image might suggest. Levels do color scaling, not substitution, but depending on
the settings they can result in the described color substitution.
(What really happens when setting Black Level to pure red and White Level to pure blue is that the red channel
gets inverted, green gets reduced to zero and blue remains unchanged.)
Because of this the results of setting arbitrary Black/White Levels or RGB curves is hard to predict, but can be
fun to play with.

Hue Saturation Node
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Hue Saturation Node

As an alternative to RGB editing, color can be thought of as a mix of Hues, namely a normalized value along
the visible spectrum from infra-red to ultraviolet (the rainbow, remember “Roy G. Biv”). The amount of the
color added depends on the saturation of that color; the higher the saturation, the more of that pigment is added.
Use the saturation slider of this node to “bring out” the colors of a washed-out image.
This node takes an input image and runs the color of the image (and the light it reflects and radiates) ‘up’
through a factor (0.0-1.0) and applies a saturation of color effect of a hue to the image:
Hue:
The Hue slider specifies how much to shift the hue of the image. Hue 0.5 (in the middle) does not shift
the hue or affect the color of the image. As Hue shifts left, the colors shift as more cyan is added; a blue
image goes bluer, then greener, then yellow. A red image goes violet, then purple, blue, and finally teal.
Shifting right (increasing Hue from 0.5 to 1.0) introduces reds and greens. A blue image goes purple,
plum, red, orange, and then yellow. A red image goes golden, olive, green, and cyan.
Sat:
Saturation affect the amount of pigment in the image. A saturation of 0 actually removes hues from the
color, resulting in a black-and-white grayscale image. A saturation of 1.0 blends in the hue, and 2.0
doubles the amount of pigment and brings out the colors.
Val:
Value affects the overall amount of the color in the image. Increasing values make an image lighter;
decreaing values shift an image darker.
Fac:
Factor determines how much this node affects the image. A factor of 0 means that the input image is not
affected by the Hue and Saturation settings. A factor of 1 means they rule, with .5 being a mix.

Hue/Saturation tips
Some things to keep in mind that might help you use this node better:
Hues are vice versa.
A blue image, with a Hue setting at either end of the spectrum (0 or 1), is output as yellow (recall that
white, minus blue, equals yellow). A yellow image, with a Hue setting at 0 or 1, is blue.
Hue and Saturation work together.
So, a Hue of .5 keeps the blues the same shade of blue, but the saturation slider can deepen or lighten the
intensity of that color.
Gray & White are neutral hues.
A gray image, where the RGB values are equal, has no hue. Therefore, this node can only affect it with
the Val slider. This applies for all shades of gray, from black to white; wherever the values are equal.
Changing the effect over time.
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The Hue and Saturation values are set in the node by the slider, but you can feed a Time input into the
Factor to bring up (or down) the effect change over time.
Note
Tinge
This HSV node simply shifts hues that are already there. To colorize a gray image, or to ADD color to an
image, use a mix node to add in a static color from an RGB input node with your image.

HSV Example

Here, the image taken by a cheap digital camera in
poor lighting at night using a flash (can we do it any worse, eh?) is adjusted by decreasing the Hue (decreasing
reds and revealing more blues and greens), decreasing Saturation (common in digital cameras, and evens out
contrast) and increasing Value (making it all lighter).

Color Balance
The Color Balance node can adjust the color and values of an image using two different correction formulas.

Bright/Contrast Node

The Lift, Gammma, Gain
formula uses Lift, Gamma, and Gain calculations to adjust an image. Lift increases the value of dark colors,
Gamma will adjust midtones, and Gain adjusts highlights.
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The Offset, Power, Slope formula uses Offset, Power, and Slope: out = (i * s + o) ^ p
where:
out
The color graded pixel code value.
i
The input pixel code value (0=black, 1=white).
s
Slope (any number 0 or greater, nominal value is 1.0).
o
Offset (any number, nominal value is 0).
p
Power (any number greater than 0, nominal value is 1.0).
Factor
Controls the amount of influence the node exerts on the output image

Hue Correct Node
The Hue Correct node is able to adjust the Hue, Saturation, and Value of an image, with an input curve.

Color Balance Node

By default, the curve is a straight line,
meaning there is no change. The spectrum
allows you to raise or lower HSV levels for each range of pixel colors. To change a H, S, or V level, move the
curve points up or down. Pixels with hue values each point in the horizontal position of the graph will be
changed depending on the shape of the curve.
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Bright/Contrast Node

Bright/Contrast Node

Bright
A multiplier-type factor by which to increase the overall brightness of the image. Use a negative number
to darken an image.
Contrast
A scaling type factor by which to make brighter pixels brighter but keeping the darker pixels dark. Higher
values make details stand out. Use a negative number to decrease the overall contrast in the image.

Notes

It is possible that this node will put out a value set that has
values beyond normal range, i. e. values > 1 or < 0. If you will be using the output to mix with other images in
the normal range, you should clamp the values using the Map Value node (with the Min and Max enabled), or
put through a ColorRamp node (with all normal defaults).
Either of these nodes will scale the values back to normal range. In the example image, we want to amp up the
specular pass. The bottom thread shows what happens if we do not clamp the values; the specular pass has
valued much less than 1 in the dark areas; when added to the medium gray, it makes black. Passing the
brightened image through either the Map Value or the ColorRamp produces the desired effect.

43

Bforartists Reference Manual - © Copyright - This page is under OCL license

A basic example

Gamma Node

Gamma Node

A reason for applying gamma correction to the final render is to correct lighting issues. Lighting issues that can
be corrected by a gamma correction node are light attenuation with distance, light falloff at terminators, and
light and shadow superpositions. Simply think about the renderer as a virtual camera. By applying a gamma
correction to your render, you are just replicating what digital camera do with photos. Digital cameras gamma
correct their photos, so you do the same thing. The gamma correction is, indeed, 0.45, not 2.2.
But reverse gamma correction on textures and colors have another very important consequence when you are
using rendering techniques such as radiosity or GI. When doing the GI calculations, all textures and colors are
taken to mean reflectance. If you do not reverse gamma correct your textures and colors, then the GI render will
look way too bright because the reflected colors are all way too high and thus a lot more light is bouncing
around than it should.
Gamma correction in Bforartists enters in a few places. The first is in this section with the nodes, both this node
and the Tonemap node, and the second is in calculating Radiosity. In the noodle to the left, the split viewer
shows the before and after effect of applying a gamma correction.
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Color Correction Node

Color Balance Node

TODO - see:
https://developer.Bforartists.org/T43469

Tone Map Node

Tone Map Node

Tone mapping is a technique used in image processing and computer graphics to map one set of colors to
another in order to approximate the appearance of high dynamic range images in a medium that has a more
limited dynamic range.
Essentially, tone mapping addresses the problem of strong contrast reduction from the scene values (radiance)
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to the displayable range while preserving the image details and color appearance important to appreciate the
original scene content.
The Tone Map node has two methods of calculation:
Rh Simple
Key
The value the average luminance is mapped to.
Offset
Normally always 1, but can be used as an extra control to alter the brightness curve
Gamma
If not used, set to 1
R/D Photoreceptor
Intensity
If less than zero, darkens image; otherwise, makes it brighter
Contrast
Set to 0 to use estimate from input image
Adaptation
If 0, global; if 1, based on pixel intensity
Color Correction
If 0, same for all channels; if 1, each independent

Z-Combine Node

Z Combine Node

The Z-Combine node takes two images and two Z-value sets as input. It overlays the images using the provided
Z values to detect which parts of one image are in front of the other. If both Z values are equal, it uses the top
image. It puts out the combined image, with the combined Z-depth map, allowing you to thread multiple Zcombines together.
Z-Combine chooses whichever Z-value is less when deciding which image pixel to use. Normally, objects are
in front of the camera and have a positive Z value. If one Z-value is negative, and the other positive, ZCombine will use the image corresponding to the negative value. You can think of a negative Z value as being
behind the camera. When choosing between two negative Z-values, Z-Combine will use whichever is more
negative.
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Alpha values carry over from the input images. Not only is the image pixel chosen, but also its alpha channel
value. So, if a pixel is partially or totally transparent, the result of the Z-Combine will also be partially
transparent; in which case the background image will show through the foreground (chosen) pixel. Where there
are sharp edges or contrast, the alpha map will automatically be anti-aliased to smooth out any artifacts.
However, you can obtain this by making an AlphaOver of two Z-Combine, one normal, the other having
inverted (reversed?) Z-values as inputs, obtained using for each of them a MapValue node with a Size field set
to -1.0:

Alpha and Z-Combine node.

Examples

Choosing closest pixels

In the example to the right, render output from two scenes are mixed using the Z-Offset node, one from a
sphere of size 1.30, and the other a cube of size 1.00. The sphere and square are located at the same place. The
cube is tipped forward, so the corner in the center is closer to the camera than the sphere surface; so Z-Offset
chooses to use the cube’s pixels. But the sphere is slightly larger (a size of 1.30 versus 1.00), so it does not fit
totally ‘inside’ the cube. At some point, as the cube’s sides recede back away from the camera, the sphere’s
sides are closer. When this happens, Z-offset uses the sphere’s pixels to form the resulting picture.
This node can be used to combine a foreground with a background matte painting. Walt Disney pioneered the
use of multi-plane mattes, where three or four partial mattes were painted on glass and placed on the left and
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right at different Z positions; mininal camera moves to the right created the illusion of depth as Bambi moved
through the forest.
Note
Valid Input
Z Input Sockets do not accept fixed values; they must get a vector set (see Map Value node). Image Input
Sockets will not accept a color, since it does not have UV coordinates.

Mix and Match
Images

You can use Z-Combine to merge two images as well, using the Z-values put out by two renderlayers. Using the
Z-values from the sphere and cube scenes above, but threading different images, yields the example to the right.

Z-Combine in action

In this noodle (you may click the little expand-o-matic icon in the bottom right to view it to full size), we mix a
render scene with a flat image. In the side view of the scene, the purple cube is 10 units away from camera, and
the gray ball is 20. The 3D cursor is about 15 units away from camera. We Z-in the image at a location of 15,
thus inserting it in-between the cube and the ball. The resulting image appears to have the cube on the table.
Note
Invisible Man Effect
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If you choose a foreground image which has a higher Alpha than the background, and then mix the Z-combine
with a slightly magnified background, the outline of the transparent area will distort the background, enough
to make it look like you are seeing part of the background through an invisible yet Fresnel-lens object.

Converter Nodes
As the name implies, these nodes convert the colors or other properties of various data (e.g. transparency) in
some way.
They also split out or re-combine the different color channels that make up an image, allowing you to work on
each channel independently. Various color channel arrangements are supported, including traditional RGB,
HSV and High Definition Media Interface (HDMI) formats.
•
•
•
•
•
•
•
•

Math Node
ColorRamp Node
Set Alpha Node
Alpha Convert Node
ID Mask Node
RGB to BW Node
Combine/Separate Nodes
Switch View Node

Math Node

Math Node

This node performs the selected math operation on an image or buffer. All common math functions are
supported. If only an image is fed to one Value socket, the math function will apply the other Value consistently
to every pixel in producing the output Value. Select the math function by clicking the up-down selector where
the “Add” selection is shown.
The trig functions of Sine, Cosine, Tangent use only the top socket and accept values in radians between 0 and
2*pi for one complete cycle.
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Examples
Manual Z-Mask

Example

This example has one scene input by the top RenderLayer node, which has a cube that is about 10 BU from the
camera. The bottom RenderLayer node inputs a scene (FlyCam) with a plane that covers the left half of the
view and is 7 BU from the camera. Both are fed through their respective Map Value nodes to divide the Z
buffer by 20 (multiply by .05, as shown in the Size field) and clamped to be a Min/Max of 0.0/1.0 respectively.
For the Minimum function, the node selects those Z values where the corresponding pixel is closer to the
camera; so it chooses the Z values for the plane and part of the cube. The background has an infinite Z value, so
it is clamped to 1.0 (shown as white). In the maximum example, the Z values of the cube are greater than the
plane, so they are chosen for the left side, but the plane (FlyCam) Renderlayer’s Z are infinite (mapped to 1.0)
for the right side, so they are chosen.

Using Sine Function to Pulsate
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This example has a Time node putting out a linear sequence from 0 to 1 over the course of 101 frames. The
green vertical line in the curve widget shows that frame 25 is being put out, or a value of .25. That value is
multiplied by 2*pi and converted to 1.0 by the Sine function, since we all know that
Sine(2*pi/4)=Sine(pi/2)=+1.0.
Since the Sine function can put out values between -1.0 and 1.0, the Map Value node scales that to 0.0 to 1.0 by
taking the input (-1 to 1), adding 1 (making 0 to 2), and multiplying the result by one half (thus scaling the
output between 0 and 1). The default ColorRamp converts those values to a grayscale. Thus, medium gray
corresponds to a 0.0 output by the sine, black to -1.0, and white to 1.0. As you can see, Sine(pi/2)=1.0. Like
having your own visual color calculator! Animating this noodle provides a smooth cyclic sequence through the
range of grays.
Use this function to vary, for example, the alpha channel of an image to produce a fading in/out effect. Alter the
Z channel to move an scene in/out of focus. Alter a color channel value to make a color “pulse”.

Brightening/Scaling a Channel

This example has a Multiply node increasing the luminance channel (Y) of the image to make it brighter. Note
that you should use a Map Value node with Min() and Max () enabled to clamp the output to valid values. With
this approach you could use a logarithmic function to make a high-dynamic range image. For this particular
example, there is also a Brighten/Contrast node that might give simpler control over brightness.

Quantize/Restrict Color Selection
In this example, we want to restrict the color output to only 256 possible values. Possible use of this is to see
what the image will look like on an 8-bit cell phone display. To do this, we want to restrict the R, G and B
values of any pixel to be one of a certain value, such that when they are combined, will not result in more than
256 possible values. The number of possible values of an output is the number of channel values multiplied by
each other, or Q = R * G * B.
Since there are 3 channels and 256 values, we have some flexibility how to quantize each channel, since there
are a lot of combinations of R*G*B that would equal 256. For example, if {R,G,B} = {4,4,16}, then 4 * 4 * 16
= 256. Also, {6,6,7} would give 252 possible values. The difference in appearance between {4,4,16} and
{6,6,7} is that the first set (4,4, 16} would have fewer shades of red and green, but lots of shades of blue. The
set {6,6, 7} would have a more even distribution of colors. To get better image quality with fewer color values,
give more possible values to the predominant colors in the image.
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Theory
Two Approaches to Quantizing to 6 values
To accomplish this quantization of an image to 256 possible values, lets use the set {6,6,7}. To split up a
continuous range of values between 0 and 1 (the full Red spectrum) into 6 values, we need to construct an
algorithm or function that takes any input value but only puts out 6 possible values, as illustrated by the image
to the right. We want to include 0 as true black, with five other colors in between. The approach shown
produces {0,.2,.4,.6,.8,1}. Dividing 1.0 by 5 equals .2, which tells us how far apart each quantified value is
from the other.
So, to get good even shading, we want to take values that are 0.16 or less and map them to 0.0; values between
0.16 and 0.33 get fixed to 0.2; colorband values between 0.33 and 0.5 get quantized to 0.4, and so on up to
values between 0.83 and 1.0 get mapped to 1.0.
Note
Function f(x)
An algebraic function is made up of primitive mathematical operations (add, subtract, multiply, sine, cosine,
etc) that operate on an input value to provide a desired output value.

Spreadsheet showing a function
The theory behind this function is scaled truncation. Let us suppose we want a math function that takes in a
range of values between 0 and 1, such as .552, but only outputs a value of 0.0, 0.2, 0.4, etc. We can imagine
then that we need to get that range 0 to 1 powered up to something 0 to 6 so that we can chop off and make it a
whole number. So, with six divisions, how can we do that? The answer is we multiply the range by 6. The
output of that first math multiply node is a range of values between 0 and 6. To get even divisions, because we
are using the rounding function (see documentation above), we want any number plus or minus around a whole
number will get rounded to that number. So, we subtract a half, which shifts everything over. The Round()
function then makes that range 0 to 5. We then divide by 5 to get back a range of numbers between 0 and 1
which can then be combined back with the other color channels. Thus, you get the function
f(x,n)=round[ x*n-1/2 ] /(n-1)
where n is the number of possible output values, and x is the input pixel color and f(x,n) is the output value.
There’s only one slight problem, and that is for the value exactly equal to 1, the formula result is 1.2, which is
an invalid value. This is because the round function is actually a roundup function, and exactly 5.5 is rounded
up to 6. So, by subtracting .501, we compensate and thus 5. 499 is rounded to 5. At the other end of the
spectrum, pure black, or 0, when .501 subtracted, rounds up to 0 since the Round() function does not return a
negative number.
Sometimes using a spreadsheet can help you figure out how to put these nodes together to get the result that you
want. Stepping you through the formula for n=6 and x=0.70, locate the line on the spreadsheet that has the 8-bit
value 179 and R value 0.7. Multiplying by 6 gives 4.2. Subtracting 1/2 gives 3.7, which rounds up to 4. 4
divided by 5 = .8. Thus, f(0.7, 6) = 0.8 or an 8-bit value of 204. You can see that this same 8-bit value is output
for a range of input values. Yeah! Geeks Rule! This is how you program Bforartists to do compositing based on
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Algebra. Thank a Teacher if you understand this.

Reality

To implement this function in Bforartists, consider the noodle above. First, feed the image to the Separate RGB
node. For the Red channel, we string the math nodes into a function that takes each red color, multiplies (scales)
it up by the desired number of divisions (6), offsets it by 0.5, rounds the value to the nearest whole number, and
then divides the image pixel color by 5. So, the transformation is {0..1} becomes {0..6}, subtracting centers the
medians to {-0.5...5.5} and the rounding to the nearest whole number produces {0,1,2,3,4, 5} since the function
rounds down, and then dividing by five results in six values {0.0,0.2,0.4,0.6,0.8,1.0}.
The result is that the output value can only be one of a certain set of values, stair-stepped because of the
rounding function of the math node noodle. Copying this one channel to operate on Green and Blue gives the
noodle below. To get the 6:6:7, we set the three multiply nodes to {6,6,7} and the divide nodes to {5,5,6}.
If you make this into a node group, you can easily re-use this setup from project to project. When you do,
consider using a math node to drive the different values that you would have to otherwise set manually, just to
error-proof your work.
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Summary
Normally, an output render consists of 32- or 24-bit color depth, and each pixel can be one of millions of
possible colors. This noodle example takes each of the Red, Green and Blue channels and normalizes them to
one of a few values. When all three channels are combined back together, each color can only be one of 256
possible values.
While this example uses the Separate/Combine RGB to create distinct colors, other Separate/Combine nodes
can be used as well. If using the YUV values, remember that U and V vary between -0.5 and +0.5, so you will
have to first add on a half to bring the range between 0 and 1, and then after dividing, subtract a half to bring in
back into standard range.
The JPG or PNG image format will store each of the colors according to their image standard for color depth
(e.g. JPG is 24-bit), but the image will be very very small, since reducing color depth and quantizing colors is
essentially what the JPEG compression algorithm accomplishes.
You do not have to reduce the color depth of each channel evenly. For example, if blue was the dominant color
in an image, to preserve image quality, you could reduce Red to 2 values, Green to 4, and let the blue take on
256/(2*4) or 32 values. If using the HSV, you could reduce the Saturation and Value to 2 values (0 or 1.0) by
Multiply by 2 and Divide by 2, and restrict the Hue to 64 possible values.
You can use this noodle to quantize any channel; alpha, speed (vector), z-values, and so forth.

ColorRamp Node
The ColorRamp Node is used for mapping values to colors with the use of a gradient. It works exactly the same
way as a Colorband for textures and materials, using the Factor value as a slider or index to the color ramp
shown, and outputting a color value and an alpha value from the output sockets.

Color Ramp Node

By default, the ColorRamp is added to the node map with two colors at opposite ends of the spectrum. A
completely black black is on the left (Black as shown in the swatch with an Alpha value of 1.00) and a
whitewash white is on the right.
See Color Ramp Widget for editing info.
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Using ColorRamp to create an Alpha Mask
A powerful but often overlooked feature of the ColorRamp is to create an Alpha Mask, or a mask that is
overlaid on top of another image, and, like a mask, allows some of the background to show through. The
example map below shows how to use the Color Ramp node to do this:

Using the ColorRamp
node to create an alpha
mask

In the map above, a black and white swirl image, which is lacking an alpha channel, is fed into the ColorRamp
node as a Fac tor. (Technically, we should have converted the image to a value using the RGB-to-BW node,
buy hey, this works just as well since we are using a BW image as input.)
We have set the ColorRamp node to a purely transparent color on the left end of the spectrum, and a fully Red
color on the right. As seen in the viewer, the ColorRamp node puts out a mask that is fully transparent where
the image is black. Black is zero, so ColorRamp uses the ‘color’ at the left end of the spectrum, which we have
set to transparent. The ColorRamp image is fully red and opaque where the image is white (1.00).
We verify that the output image mask is indeed transparent by overlaying it on top of a pumpkin image. For
fun, we made that AlphaOver output image 0.66 transparent so that we can, in the future, overlay the image on
a flashing white background to simulate a scary scene with lighting flashes.

Using ColorRamp to Colorize an Image
The real power of ColorRamp is that multiple colors can be added to the color spectrum. This example
compositing map takes a boring BW image and makes it a flaming swirl!

In this example, we have mapped the
shades of gray in the input image to three colors, blue, yellow, and red, all fully opaque (Alpha of 1.00). Where
the image is black, ColorRamp substitutes blue, the currently selected color. Where it is some shade of gray,
ColorRamp chooses a corresponding color from the spectrum (bluish, yellow, to reddish). Where the image is
fully white, ColorRamp chooses red.
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Set Alpha Node

Set Alpha Node

This node adds an alpha channel to a picture. Some image formats, such as JPEG, do not support an alpha
channel. In order to overlay a JPEG image on top of a background, you must add an alpha channel to it using
this node.
The Image input socket is optional. If an input image is not supplied, the base color shown in the swatch will be
used. To change the color, LMB click the swatch and use the color-picker control to choose or specify a color
you want.
The amount of Alpha (1.00 being totally opaque and 0.00 being totally transparent) can be set for the whole
picture using the input field. Additionally, the Alpha factor can be set by feeding its socket.
Note
This is not, and is not intended to be, a general-purpose solution to the problem of compositing an image that
doesn’t contain Alpha information. You might wish to use “Chroma Keying” or “Difference Keying” (as
discussed elsewhere) if you can. This node is most often used (with a suitable input being provided by means
of the socket) in those troublesome cases when you can’t, for some reason, use those techniques directly.

Using SetAlpha to Fade to Black
To transition the audience from one scene or shot to another, a common technique is to “fade to black”. As its
name implies, the scene fades to a black screen. You can also “fade to white’ or whatever color you wish, but
black is a good neutral color that is easy on the eyes and intellectually “resets” the viewer’s mind. The node
map below shows how to do this using the Set Alpha node.

Fade To Black

In the example above, the alpha channel of the swirl image is ignored. Instead, a time node introduces a factor
from 0.00 to 1.00 over 60 frames, or about 2 seconds, to the Set Alpha node. Note that the time curve is
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exponentially-shaped, so that the overall blackness will fade in slowly and then accelerate toward the end. The
Set Alpha node does not need an input image; instead the flat (shadeless) black color is used. The Set Alpha
Node uses the input factor and color to create a black image that has an alpha set which goes from 0.00 to 1.00
over 60 frames, or completely transparent to completely opaque. Think of alpha as a multiplier for how vivid
you can see that pixel. These two images are combined by our trusty AlphaOver node completely (a Fac tor of
1.00) to produce the composite image. The SetAlpha node will thus, depending on the frame being rendered,
produce a black image that has some degree of transparency. Set up and Animate, and you have an image
sequence that fades to black over a 2-second period.
Note
No Scene information used
This example node map does not use the RenderLayer. To produce this 2 second animation, no Bforartists
scene information was used. This is an example of using Bforartists’s powerful compositing abilities separate
from its modeling and animation capabilities. (A Render Layer could be substituted for the Image layer, and
the “fade-network” effect will still produce the same effect)

Using SetAlpha to Fade In a Title
To introduce your animation, you will want to present the title of your animation over a background. You can
have the title fly in, or fade it in. To fade it in, use the SetAlpha node with the Time node as shown below.

Using Set
Alpha to Fade
in a Title

In the above
example, a
Time curve
provides the
Alpha value to the input socket. The current RenderLayer, which has the title in view, provides the image. As
before, the trusty AlphaOver node mixes (using the alpha values) the background swirl and the alphaed title to
produce the composite image. Notice the ConvertPre -Multiply button is NOT enabled; this produces a
composite where the title lets the background image show through where even the background image is
transparent, allowing you to layer images on top of one another.

Using SetAlpha to Colorize a BW Image
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Using Set Alpha to Colorize an Image

In the example above, notice how the blue tinge of the
render input colors the swirl. You can use the Set Alpha node’s color swatch with this kind of node map to add a
consistent color to a BW image.
In the example map to the right, use the Alpha value of the SetAlpha node to give a desired degree of
colorization. Thread the input image and the Set Alpha node into an AlphaOver node to colorize any black and
white image in this manner. Note the ConvertPre -Multiply button is enabled, which tells the AlphaOver node
not to multiply the alpha values of the two images together.

Alpha Convert Node

Alpha Convert Node

This node converts the alpha channel interpretation of an image from pre-multiplied to straight or the reverse.
For details on the difference between both kinds of alpha channels see Alpha Channel.

ID Mask Node

ID Mask Node

This node will use the Object Index pass (see RenderLayers) to produce an anti-aliased alpha mask for the
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object index specified. The mask is opaque where the object is, and transparent where the object isn’t. If the
object is partially transparent, the alpha mask matches the object’s transparency. This post-process function fills
in the jaggies with interpolated values.
Note
Object Index
Object indices are only output from a RenderLayers node or stored in a multilayer OpenEXR format image.

Setting an Object Index

You can specify, for any of the objects in your scene, an Object Index as shown
the right (the currently select object has an index of 2). When rendered, if Object Index passes are enabled, its
index will be 2, and setting the ID Mask node to 2 will show where that object is in the scene.
This node is extremely well suited to removing the aliases shown as output from the Defocus node or DOF
noodles caused by some objects being close to camera against objects far away.

Example

Example

In this example, the left
rear red cube is
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assigned PassIndex 1, and the right cube PassIndex 2. Where the two cubes intersect, there is going to be
noticeable pixelation (jaggies) because they come together at a sharp angle and are different colors. Using the
mask from object 1, which is smoothed (anti-aliased) at the edges, we use a Mix node set on Multiply to
multiply the smoothed edges against the image, thus removing those nasty (Mick) Jaggies. Thus, being
smoothed out, the Rolling Stones gather no moss. (I really hope you get that obscure reference :)
Note that the mask returns white where the object is fully visible to the camera (not behind anything else) and
black for the part of the object that is partially or totally obscured by a fully or partially opaque object in front
of it. If something else is in front of it, even if that thing is partially transparent and you can see the object in a
render, the mask will not reflect that partially obscured part.

RGB to BW Node

RGB to BW Node

This node converts an RGB input and outputs a greyscale image.

Combine/Separate Nodes
All of these node do essentially the same thing: they split out an image into (or recombine an image from) its
composite color channels. Each format supports the Alpha (transparency) channel. The standard way of
representing color in an image is called a color space. There are several color spaces supported:
RGB
Red-Green-Blue traditional primary colors, also broadcast directly to most computer monitors
HSV
Three values, often considered as more intuitive than the RGB system (nearly only used on computers):
Hue
the Hue of the color (in some way, choose a ‘color’ of the rainbow);
Saturation
the quantity of hue in the color (from desaturate - shade of gray - to saturate - brighter colors)
Value: the luminosity of the color
(from ‘no light’ - black - to ‘full light’ - ‘full’ color, or white if Saturation is 0.0).
YUV
Luminance-Chrominance standard used in broadcasting analog PAL (European) video.
YCbCr
Luminance-ChannelBlue-ChannelRed Component video for digital broadcast use, whose standards have
been updated for HDTV and commonly referred to as the HDMI format for component video.
See also color space.
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Separate/Combine RGBA Node

Separate RGBA Node

This node separates an image into its red, green, blue and alpha channels. There’s a socket for each channel on
the right.

Combine RGBA Node

This node combines separate input images as each color and alpha channel,
producing a composite image. You use this node combine the channels after working on each color channel
separately.

Examples

In this first example, we take the Alpha channel and blur it, and then combine it back with the colors. When
placed in a scene, the edges of it will blend in, instead of having a hard edge. This is almost like anti-aliasing,
but in a three-dimensional sense. Use this noodle when adding CG elements to live action to remove any hard
edges. Animating this effect over a broader scale will make the object appear to “phase” in and out, as a “outof-phase” time-traveling sync effect.
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In this fun little noodle we make all the reds become green, and all the green both Red and Blue, and remove
Blue from the image completely. Very cute. Very fun.

Separate/Combine HSVA Nodes

Separate HSVA Node

This node separates an image into image maps for the hue, saturation, value and alpha channels.
Use and manipulate the separated channels for different purposes; i.e. to achieve some compositing/color
adjustment result. For example, you could expand the Value channel (by using the multiply node) to make all
the colors brighter. You could make an image more relaxed by diminishing (via the divide or map value node)
the Saturation channel. You could isolate a specific range of colors (by clipping the Hue channel via the
Colorramp node) and change their color (by the Add/Subtract mix node).

Separate HSVA Node

Separate/Combine YUVA Node
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Separate YUVA Node

This node converts an RGBA image to YUVA color space, then splits each
channel out to its own output so that they can be manipulated independently. Note that U and V values range
from -0.5 to +0.5.

Combine YUVA Node

Combines the channels back into a composite image. If you do not connect any input socket, you can set a
default value for the whole image for that channel using the numeric controls shown.

Separate/Combine YCbCrA Node

Separate YCbCrA Node

This node converts an RGBA image to YCbCrA color space, then splits each channel out to its own output so
that they can be manipulated independently:
• Y: Luminance, 0=black, 1=white
• Cb: Chrominance Blue, 0=Blue, 1=Yellow
• Cr: Chrominance Red, 0=Red, 1=Yellow
Note
If running these channels through a ColorRamp to adjust value, use the Cardinal scale for accurate
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representation. Using the Exponential scale on the luminance channel gives high-contrast effect.

Combine YCbCrA Node

So, I kinda think you get the idea, and I was trying to think of some other creative way to write down the same
thing, but I can’t. So, you’ll have to figure this node out on your own.

Switch View Node

Switch View Node

TODO - see: https://developer.Bforartists.org/T43469

Filter Nodes
Filters process the pixels of an image to highlight additional details or perform some sort of post-processing
effect on the image.
•
•
•
•
•
•
•
•
•

Blur Node
Bilateral Blur Node
Dilate/Erode Node
Despeckle Node
Filter Node
Bokeh Blur
Vector (Motion) Blur Node
Defocus Node
Glare Node
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•
•
•
•

Inpaint Node
Directional Blur Node
Pixelate Node
Sun Beams

Blur Node

Blur Node

The Blur node blurs an image, using one of seven blur modes (set using the
upper-left pop-up button), and a radius defined by the X and Y number buttons. By default these are set to zero,
so to enable the node you must set one or both to a value greater than 0. You can optionally connect a value
image to the Size input node, to control the blur radius with a mask. The values must be mapped between 0-1
for best effect, as they will be multiplied with the X and Y number button values.

Options
The X and Y values are the number of pixels over which to spread the blur effect.
The Bokeh button (only visible as Bok or Bo on some screen setups) will force the blur node to use a circular
blur filter. This gives higher quality results, but is slower then using a normal filter. The Gam button (for
“gamma”) makes the Blur node gamma-correct the image before blurring it.

Blur node blur modes using 20% of image size as XY, no Bokeh/Gamma

The difference between them is how they handle sharp edges and smooth gradients and preserve the highs and
the lows. In particular (and you may have to closely examine the full-resolution picture to see this):
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Flat
Simply blurs everything uniformly
Tent
Preserves the high and the lows better making a linear falloff
Quadratic
CatRom keeps sharp-contrast edges crisp.
Cubic, Mitch
Preserve the highs but give almost a out-of-focus blur while smoothing sharp edges

Example
An example blend file, in fact the one used to create the image above, is available here. The .blend file takes
one image from the RenderLayer “Blurs” and blurs it while offsetting it (Translate) and then combining it
(AlphaOver) to build up the progressive sequence of blurs. Play with the Value and Multiply nodes to change
the amount of blurring that each algorithm does.

Bilateral Blur Node

Bilateral Blur Node

The Bilateral Blur node performs a high quality adaptive blur on the source image. It can be used for various
purposes like: smoothing results from Bforartistss raytraced ambient occlusion smoothing results from various
unbiased renderers, to fake some performance-heavy processes, like blurry refractions/reflections, soft
shadows, to make non-photorealistic compositing effects.

Inputs
Bilateral blur has two inputs:
Image, for the image to be blurred. Determinator, which is non-obligatory, and is used only if connected.
if only 1st input is connected, the node blurs the image depending on the edges present in the source image. If
the Determinator is connected, it serves as the source for defining edges/borders for the blur in the image. This
has great advantage in case the source image is too noisy, but normals in combination with zbuffer can still
define exact borders/edges of objects.
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Options
Iterations
Defines how many times the filter should perform the operation on the image. It practically defines the
radius of blur.
Color Sigma
Defines the threshold for which color differences in the image should be taken as edges.
Space Sigma
A fine-tuning variable for blur radius.

Examples

Bilateral smoothed buffered shadow

Bilateral smoothed AO

Bilateral faked blurry refraction+smoothed
raytraced soft shadow
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Dilate/Erode Node

Dilate/Erode Node

This node blurs individual color channels. The color channel (or a black and white image) is connected to the
Mask input socket, and the Distance is set manually (by clicking on the arrows or the value) or automatically
from a value node or a time-and-map-value noodle. A positive value of Distance expands the influence of a
pixel on its surrounding pixels, thus blurring that color outward. A negative value erodes its influence, thus
increases the constrast of that pixel relative to its surrounding pixels, thus sharpening it relative to surrounding
pixels of the same color.

Example
In this example image, we wanted to take the rather boring array of ball bearings and spruce it up; make it hot,
baby. So, we dilated the red and eroded the green, leaving the blue alone. If we had dilated both red and green...
(hint: red and green make yellow). The amount of influence is increased by increasing the Distance values.
Blend file available here.

Despeckle Node
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Despeckle Node.
The Despeckle node is used to smooth areas of an image in which noise is noticeable, while leaving complex
areas untouched.
This works by the standard deviation of each pixel and its neighbors is calculated to determine if the area is one
of high complexity or low complexity. If the complexity is lower than the threshold then the area is smoothed
using a simple mean filter.

Inputs
Factor
Controls the amount the filter effects the image.
Image
Standard image input.

Properties
Threshold
The threshold to control high/low complexity.
Neighbor
The threshold to control the number of pixels that must match.

Outputs
Image
Standard image output.

Filter Node
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Filter Node

The Filter node implements various common image enhancement filters. The supported filters are, if not
obvious, named after the mathematical genius who came up with them:
Soften
Slightly blurs the image.
Sharpen
Increases the contrast, especially at edges
Laplace
Softens around edges
Sobel
Creates a negative image that highlights edges
Prewitt
Tries to do Sobel one better.
Kirsch
Improves on the work done by those other two flunkies, giving a better blending as you approach an edge.
Shadow
Performs a relief emboss/bumpmap effect, darkening outside edges.

The Filter node has seven modes, shown here.

The Soften, Laplace, Sobel, Prewitt and Kirsch all perform edge-detection (in slightly different ways) based on
vector calculus and set theory equations that would fill six blackboards with gobbledy gook. Recommended
reading for insomniacs.

Bokeh Blur
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Bokeh Blur Node

The Bokeh Blur node generates a bokeh type blur similar to Defocus. Unlike defocus an in-focus region is
defined in the compositor. There is also more flexibility in the type of blur applied through the Bokeh Image
node.
Several performance optimizations are also available such as OpenCL support, calculation area restriction and
masking.

Sockets
Max blur
Max blur is intended to act as an optimization tool by limiting the number of pixels across which the blur
is calculated.
Bokeh
This is an input for the Bokeh Image node.
Size
Size controls the amount of blur. Size can either be a single value across the entire image or a variable
value controlled by an input image. In order to use the latter the Variable Size option must be selected.
See the examples section below for more on how to use this.
Bounding Box
This can be used with a Box Mask matte node or with a Mask input node to restrict the area of the image
the blur is applied to. This could be helpful, for example, when developing a node system by allowing
only a small area of the image to be filtered thus saving composite time each time adjustments are made.

Examples
Three examples of how the size input may be used follow.
An ID masked alpha image can be used so that a background is blurred while foreground objects remain in
focus. To prevent strange edges the Dilate Node should be used.
The Z pass can be visualized using a Map Value node and ColorRamp node as described in Render Layers. A
multiply Math node can be used following the color-ramp so that a blur value greater than 1 is used for objects
outside the focal range.
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A manually created greyscale image can be used to define the sharp and blurry areas of a pre existing image.
Again, a multiply node can be used so that a blur value greater than 1 is used.
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Vector (Motion) Blur Node

Vector Blur Node

Motion blur is the effect of objects moving so fast they blur. Because CG animations work by rendering
individual frames, they have no real knowledge of what was where in the last frame, and where it is now.
In Bforartists, there are two ways to produce motion blur. The first method (which produces the most correct
results) works by rendering a single frame up to 16 times with slight time offsets, then accumulating these
images together; this is called Motion Blur and is activated on the Render panel. The second (and much faster)
method is the Compositor node Vector Blur.
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To use, connect the appropriate passes from a Render Result node.
Note
Make sure to enable the Speed (called Vec) pass in the Render Layers panel for the render layer you wish to
perform motion blur on.

Make sure to enable the Speed (called Vec) pass in the Render Layers panel for the render layer you wish to
perform motion blur on.
Maximum Speed: Because of the way vector blur works, it can produce streaks, lines and other artifacts. These
mostly come from pixels moving too fast; to combat these problems, the filter has minimum and maximum
speed settings, which can be used to limit which pixels get blurred (e.g. if a pixel is moving really, really fast
but you have maximum speed set to a moderate amount, it won’t get blurred).
Minimum Speed: Especially when the camera itself moves, the mask created by the vectorblur node can
become the entire image. A very simple solution is to introduce a small threshold for moving pixels, which can
efficiently separate the hardly-moving pixels from the moving ones, and thus create nice looking masks. You
can find this new option as ‘min speed’. This minimum speed is in pixel units. A value of just 3 will already
clearly separate the background from foreground.

Hint
You can make vector blur results a little smoother by passing the Speed pass through a blur node (but note that
this can make strange results, so it’s only really appropriate for still images with lots of motion blur).

Examples
An in-depth look at how to use the Vector Blur node can be found here.
As far as we know, this node represents a new approach to calculating motion blur. Use vector blur in
compositing with confidence instead of motion blur. In face, when compositing images, it is necessary to use
vector blur since there isn’t “real” motion. In this example blend file, you will find a rigged hand reaching
down to pick up a ball. Based on how the hand is moving (those vectors), the image is blurred in that direction.
The fingers closest to the camera (the least Z value) are blurred more, and those farther away (the forearm) is
blurred the least.
Note
Does not work when reading from a multilayer OpenEXR sequence set
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Defocus Node

Defocus Node

This single node can be used to emulate depth of field using a postprocessing method. It can also be used to
blur the image in other ways, not necessarily based on ‘depth’ by connecting something other than a Zbuffer. In
essence, this node blurs areas of an image based on the input zbuffer map/mask.

Camera Settings

DofDist setting for the camera.
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The Defocus node uses the actual camera data in your scene if supplied by a RenderLayer node.
To set the point of focus, the camera now has a Distance parameter, which is shorthand for Depth of Field
Distance. Use this camera parameter to set the focal plane of the camera (objects Depth of Field Distance away
from the camera are in focus). Set Distance in the main Camera edit panel; the button is right below the Depth
of Field.
To make the focal point visible, enable the camera Limits option, the focal point is then visible as a yellow cross
along the view direction of the camera.

Node Inputs
The node requires two inputs, an image and a zbuffer, the latter does not need to be an actual zbuffer, but can
also be another (grayscale) image used as mask, or a single value input, for instance from a time node, to vary
the effect over time.

Node Setting
The settings for this node are:
Bokeh Type menu
Here you set the number of iris blades of the virtual camera’s diaphragm. It can be set to emulate a perfect
circle (Disk) or it can be set to have 3 (Triangle), 4 (Square), 5 (Pentagon), 6 (Hexagon), 7 (Heptagon) or
8 blades (Octagon). The reason it does not go any higher than 8 is that from that point on the result tends
to be indistinguishable from a Disk shape anyway.
Rotate
This button is not visible if the Bokeh Type is set to Disk. It can be used to add an additional rotation
offset to the Bokeh shape. The value is the angle in degrees.
Gamma Correct
Exactly the same as the Gamma option in Bforartists’s general Blur node (see Blur Node). It can be useful
to further brighten out of focus parts in the image, accentuating the Bokeh effect.
f-Stop
This is the most important parameter to control the amount of focal blur: it simulates the aperture f of a
real lens(‘ iris) - without modifying the luminosity of the picture, however! As in a real camera, the
smaller this number is, the more-open the lens iris is, and the shallower the depth-of-field will be. The
default value 128 is assumed to be infinity: everything is in perfect focus. Half the value will double the
amount of blur. This button is not available if No zbuffer is enabled.
Maxblur
Use this to limit the amount of blur of the most out of focus parts of the image. The value is the maximum
blur radius allowed. This can be useful since the actual blur process can sometimes be very slow. (The
more blur, the slower it gets.) So, setting this value can help bring down processing times, like for
instance when the world background is visible, which in general tends to be the point of maximum blur
(not always true, objects very close to the lens might be blurred even more). The default value of 0 means
there is no limit to the maximum blur amount.
BThreshold
The defocus node is not perfect: some artifacts may occur. One such example is in-focus objects against a
blurred background, which have a tendency to bleed into the edges of the sharp object. The worst-case
scenario is an object in-focus against the very distant world background: the differences in distance are
very large and the result can look quite bad. The node tries to prevent this from occurring by testing that
the blur difference between pixels is not too large, the value set here controls how large that blur
difference may be to consider it ‘safe.’ This is all probably quite confusing, and fortunately, in general,
there is no need to change the default setting of 1. Only try changing it if you experience problems around
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any in-focus object.
Preview
As already mentioned, processing can take a long time. So to help make editing parameters somewhat
‘interactive’, there is a preview mode which you can enable with this button. Preview mode will render
the result using a limited amount of (quasi)random samples, which is a lot faster than the ‘perfect’ mode
used otherwise. The sampling mode also tends to produce grainy, noisy pictures (though the more
samples you use, the less noisy the result). This option is on by default. Play around with the other
parameters until you are happy with the results, and only then disable the preview mode for the final
render.
Samples
Only visible when Preview is set. Sets the amount of samples to use to sample the image. The higher, the
smoother the image, but also the longer the processing time. For preview, the default of 16 samples
should be sufficient and is also the fastest.
No zbuffer
Sometimes you might want to have more control to blur the image. For instance, you may want to only
blur one object while leaving everything else alone (or the other way around), or you want to blur the
whole image uniformly all at once. The node therefore allows you to use something other than an actual
zbuffer as the Z input. For instance, you could connect an image node and use a grayscale image where
the color designates how much to blur the image at that point, where white is maximum blur and black is
no blur. Or, you could use a Time node to uniformly blur the image, where the time value controls the
maximum blur for that frame. It may also be used to obtain a possibly slightly-better DoF blur, by using a
fake depth shaded image instead of a zbuffer. (A typical method to create the fake depth shaded image is
by using a linear blend texture for all objects in the scene or by using the ‘fog/mist’ fake depth shading
method.) This also has the advantage that the fake depth image can have anti-aliasing, which is not
possible with a real zbuffer. No zbuffer will be enabled automatically whenever you connect a node that is
not image based (e.g. time node/value node/etc).
Zscale
Only visible when No zbuffer enabled. When No zbuffer is used, the input is used directly to control the
blur radius. And since usually the value of a texture is only in the numeric range 0.0 to 1.0, its range is too
narrow to control the blur properly. This parameter can be used to expand the range of the input (or for
that matter, narrow it as well, by setting it to a value less than one). So for No zbuffer, this parameter
therefore then becomes the main blur control (similar to f-Stop when you do use a zbuffer).

Examples

In this blend file example, the ball array image is blurred as if it was taken by a camera with a f-stop of 2.8
resulting in a farily narrow depth of field centered on 7.5 Bforartists units from the camera. As the balls recede
into the distance, they get blurrier.

Hints
Preview
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In general, use preview mode, change parameters to your liking, only then disable preview mode for the
final render. This node is compute intensive, so watch your console window, and it will give you status as
it computes each render scan line.
Edge Artifacts
For minimum artifacts, try to setup your scene such that differences in distances between two objects that
may visibly overlap at some point are not too large.
“Focus Pull”
Keep in mind that this is not ‘real’ DoF, only a post-processing simulation. Some things cannot be done
which would be no problem for real DoF at all. A typical example is a scene with some object very close
to the camera, and the camera focusing on some point far behind it. In the real world, using shallow depth
of field, it is not impossible for nearby objects to become completely invisible, in effect allowing the
camera to see ‘behind’ it. Hollywood cinematographers use this visual characteristic to good effect to
achieve the popular “focus pull” effect, where the focus shifts from a nearby to a distant object, such that
the “other” object all but disappears. Well, this is simply not possible to do with the current postprocessing method in a single pass. If you really want to achieve this effect, quite satisfactorily, here’s
how:
• Split up your scene into “nearby” and “far” objects, and render them in two passes.
• Now, combine the two the two results, each with their own “defocus” nodes driven by the same
Time node, but with one of them inverted. (e.g. using a “Map Value” node with a Size of -1.) As
the defocus of one increases, the defocus on the other decreases at the same rate, creating a smooth
transition.
Aliasing at Low f-Stop Values
At very low values, less than 5, the node will start to remove any oversampling and bring the objects at
DoFDist very sharply into focus. If the object is against a constrasting background, this may lead to
visible stairstepping (aliasing) which OSA is designed to avoid. If you run into this problem:
• Do your own OSA by rendering at twice the intended size and then scaling down, so that adjacent
pixels are blurred togther
• Use the blur node with a setting of 2 for x and y
• Set DoFDist off by a little, so that the object in focus is blurred by the tiniest bit.
• Use a higher f-Stop, which will start the blur, and then use the Z socket to a Map Value to a Blur
node to enhance the blur effect.
• Rearrange the objects in your scene to use a lower-contrast background
No ZBuffer
A final word of warning, since there is no way to detect if an actual zbuffer is connected to the node, be
VERY careful with the No ZBuffer switch. If the Zscale value happens to be large, and you forget to set it
back to some low value, the values may suddenly be interpreted as huge blur-radius values that will cause
processing times to explode.

Glare Node
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Glare Node

Glare Node.
The Glare node is used add lens flares, fog, glows around exposed parts of an image an much more.

Inputs
Image
Standard image input.

Properties
Glare Type
Ghosts
Creates a haze over the image.
Streaks
Creates bright streaks used to simulate lens flares.
Streaks
Total number of streaks.
Angle Offset
The rotation offset factor of the streaks.
Fade
Fade out factor for the streaks.
Fog Glow
Looks similar to Ghost however, it is much smaller in size and gives more of a atmospheric haze or
“glow” around the image.
Size
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Scale of the glow relative to the size of the original bright pixels.
Simple Star
Works similar to Streaks but gives a simpler shape looking like a star.
Fade
Fade out factor for the streaks.
Rotate 45
Rotate the streaks by 45°.

Common Options
Quality
If not set to something other the High, then the glare effect will only be applied to a low resolution copy
of the image. This can be helpful to save render times while only doing preview renders.
Iterations
The number of times to run through the filter algorithm. Higher values will give more accurate results but
will take longer to compute. Note, that this is not available for Fog Glow as it does not use an iterative
based algorithm.
Color Modulation
Used for Streaks and Ghosts to create a special dispersion effect.
Johannes Itten describes this effect, Color Modulation, as subtle variations in tones and chroma.
Mix
Value to control how much of the effect is added on to the image. A value of -1 would give just the
original image, 0 gives a 50/50 mix, and 1 gives just the effect.
Threshold
Pixels brighter than this value will be affected by the glare filter.

Outputs
Image
Standard image output.

Example
TODO.

Inpaint Node
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Inpaint Node.
The Inpaint node is used to extend borders of an image into transparent or masked regions. This can be useful
to solve problems like “wire removal” and holes created during chroma-keying.

Inputs
Image
Standard image input.

Properties
Distance
The number of times to extend the image.

Outputs
Image
Standard image output.

Examples
In the left image shows the “wire” in place and after chroma-key has been applied you will see you’re left with
a blank space – it’s shown as a black line here but it will be alpha in your Blender output.

Inpaint Node Example.
Inpainting fills in a couple of pixels using the surrounding image and voila... your wire is removed.
81

Bforartists Reference Manual - © Copyright - This page is under OCL license

Note
The wider your “hole” is, the more noticeable this effect is! If you use more than a few pixels of infill, the
effect is almost as irritating as the wire and your viewers won’t be impressed.

Inpainting can also cover up a multitude of other minor sins such as control points for motion capture: use it
sparingly and it will amaze.

Directional Blur Node

Dilate/Erode Node

Blurs an image in a specified direction and magnitude. Can be used to fake motion blur.

Options
Iterations
Controls how may times the image is duplicated to create the blur effect. Higher values give smoother
results.
Wrap
Wraps the image on the X and Y axis to fill in areas that become transparent from the blur effect.
Center
Sets the position where the blur center is. This makes a difference if the angle, spin, and/or zoom are
used.
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Distance
How large the blur effect is.
Angle
Image is blurred at this angle from the center
Spin
Rotates the image each iteration to create a spin effect, from the center point.
Zoom
Scales the image each iteration, creating the effect of a zoom.

Pixelate Node

Pixelate Node

Add this node in front of a scale node to get a pixelated (non smoothed) image from the resultant up scaled
image.

Example
In the node editor, set the node tree to compositing in the menu bar and check the ‘Use Nodes’ checkbox. Add
an input Image node and an output Viewer node. Connect the Input node to the viewer node and check the
‘Backdrop’ checkbox in the menu bar. Open an image you would like to pixelate using the open button on the
image node. This image should now appear in the backdrop. Now add two scale nodes between the input and
output (Add>Distort>Scale). Change the values of X and Y to 0.2 in the first scale box and to 5 in the second.
The background image will be unchanged.
Now add a Pixelate node between the two scale nodes.
(note: you can use alt-v and v to zoom the backdrop in and out respectively if needed)
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Sun Beams

Sun Beams Node

Sun Beams is a 2D effect for simulating the effect of bright light getting scattered in a medium (Crepuscular
Rays). This phenomenon can be created by renderers, but full volumetric lighting is a rather arduous approach
and takes a lot of render time. Also when working with 2D images only the volumetric data may not be
available. In these cases the “Sun Beams” node provides a computationally cheap way of creating a convincing
effect based on image brightness alone.

Usage
Usually the first step is to define the area from which rays are cast. Any diffuse reflected light from surfaces is
not going to contribute to such scattering in the real world, so should be excluded from the input data. Possible
ways to achieve this are
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•
•
•
•

entirely separate image as a light source
brightness/contrast tweaking to leave only the brightest areas
muting shadow and midtone colors, which is a bit more flexible
masking for ultimate control

After generating the sun beams from such a light source image they can then be overlayed on the original
image. Usually a simple “Add” mix node is sufficient, and physically correct because the scattered light adds to
the final result.

Vector Nodes
These nodes can be used to manipulate various types of vectors, such as surface normals and speed vectors.
•
•
•
•

Normal Node
Map Value Node
Map Range Node
Normalize
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• Vector Curves Node

Normal Node

Normal Node

The Normal node generates a normal vector and a dot product. Click and Drag on the sphere to set the direction
of the normal.
This node can be used to input a new normal vector into the mix. For example, use this node as an input to a
Color Mix node. Use an Image input as the other input to the Mixer. The resulting colorized output can be
easily varied by moving the light source (click and dragging the sphere).

Map Value Node

Map Value Node

Map Value node is used to scale, offset and clamp values (value refers to each vector in the set). The formula
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for how this node works is:
Offs
will add a number to the input value
Size
will scale (multiply) that value by a number
Min/Max
you can set the minimum and maximum numbers to clamp (cut off) the value too. Min and Max must be
individually enabled by LMB clicking on the label for them to clamp. Shift-LMB on the value to change
it.
• If Min is enabled and the value is less than Min, set the output value to Min.
• If Max is enabled and the input value is greater than Max, set the output value to Max.
This is particularly useful in achieving a depth-of-field effect, where you can use the Map Value node to map a
Z value (which can be 20 or 30 or even 500 depending on the scene) to to range between 0-1, suitable for
connecting to a Blur node.

Using Map Value to Multiply values
You can also use the map value node to multiply values to achieve an output number that you desire. In the
mini-map to the right, the Time node outputs a value between 0.0 and 1. 00 evenly scaled over 30 frames. The
first Map Value node multiplies the input by 2, resulting in an output value that scales from 0.0 to 2.0 over 30
frames. The second Map Value node subtracts 1 from the input, giving working values between -1.00 and 1.0,
and multiplies that by 150, resulting in an output value between -150 and 150 over a 30-frame sequence.

Using Map Value to multiply

Map Range Node
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Map Range Node

TODO - see: https://developer.Bforartists.org/T43469

Normalize

Normalize Node

Normalizing a vector scales its magnitude, or length, to a value of 1, but keeps its direction intact.

Vector Curves Node
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Vector Curves Node

The Vector Curves node maps an input vector image’s x, y, and z components to a diagonal curve. The three
channels are accessed via the X, Y, and Z buttons at the top of the node. Add points to the curve by clicking on
it.
Note that dragging a point across another will switch the order of the two points (e.g. if point A is dragged
across point B, then point B will become point A and point A will become point B).
Use this curve to slow things down or speed them up from the original scene.

Matte Nodes
These nodes give you the essential tools for working with blue-screen or green-screen footage, where live
action is shot in front of a blue or green backdrop for replacement by a matte painting or virtual background.
In general, hook up these nodes to a viewer, set your UV/Image Editor to show the viewer node, and play with
the sliders in real-time using a sample image from the footage, to get the settings right. In some cases, small
adjustments can eliminate artifacts or foreground image degredation. For example, taking out too much green
can result in foreground actors looking ‘flat’ or blueish/purplish.
You can and should chain these nodes together, refining your color correction in successive refinements, using
each node’s strengths to operate on the previous node’s output. There is no “one stop shopping” or one “does-itall” node; they work best in combination.
Usually, green screen is shot in a stage with consistent lighting from shot to shot, so the same settings will work
across multiple shots of raw footage. Footage shot outside under varying lighting conditions (and wind blowing
the background) will complicate matters and mandate lower falloff values.
Note
Garbage Matte
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Garbage matte is not a node, but a technique where the foreground is outlined using a closed curve (bezier or
nurbs). Only the area within the curve is processed using these matte nodes; everything else is garbage and
thus discarded.

•
•
•
•
•
•
•
•
•
•
•
•

Keying Node
Keying Screen Node
Channel Key Node
Color Spill Node
Box Mask Node
Ellipse Mask Node
Luminance Key Node
Difference Key Node
Distance Key Node
Chroma Key Node
Color Key Node
Double Edge Mask Node

Keying Node
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Keying Node.
The Keying node is an one-stop-shop for “green screen” / “blue screen” removal. It performs both chroma
keying to remove the backdrop and despill to correct color cast from the backdrop. Additionally, you can
perform common operations used to tweak the resulting matte.

Inputs
Image
Standard image input.
Key Color
The color of content to be removed. This may be a single color using the, or a reference image such as
generated by the Keying Screen Node.
Garbage Matte
An optional mask of area(s) to always exclude from the output. This is removed from the chroma key
generated matte.
Core Matte
An optional mask of area(s) to always include in the output. This is merged with the chroma key
generated matte.

Properties
Pre Blur
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Reduce the effects of color noise in the image by blurring only color by the given amount, leaving
luminocity intact. This will affect matte calculation only, not the result image.
Screen Balance
This is the balance between color channels compared with the key color. 0.5 will average the other
channels (red and blue in the case of a green screen).
This may be tweaked in tandem with Clip Black and Clip White while checking the Matte output to create
a mask with optimal separation.
Despill Factor
Controls how much color bleed from the key color is removed from the input image: 0 means no
despilling, 1 means all possible spilling will be removed. The underlying implementation is the same as
adjusting the Unspill amount of the Color Spill Node.
Despill Balance
This controls how the color chanels are compared when computing spill, affecting the hue and shade of
the corrected colors. It is similar to setting the Limiting Channel in the Color Spill Node.
Edge Kernel Radius
Defines the radius in pixel used to detect an edge.
Edge Kernel Tolerance
Defines threshold used to check if pixels in radius are the same as current pixel: If the difference between
pixel colors is higher than this threshold then the point will be considered an edge.
Clip Black
This sets the threshold for what becomes fully transparent in the output (black in the matte). It should be
set as low as possible. Uneven backdrops will require this value to be increased. Use of the Keying
Screen Node can help keep this value low. You may also use a Garbage Matte to exclude problematic
areas.
This value does not impact areas detected as edges to ensure edge detail is preserved.
Clip White
This sets the threshold for what becomes fully opaque in the output (white in the matte). It should be set
as high as possible. Colors close to green in the foreground may require lowing this and/or adjusting the
Screen Balance. Particularly problematic parts can fixed with a Core Matte instead of a low Clip White.
This value does not impact areas detected as edges to ensure edge detail is preserved.
Dilate/Erode
Enlarge (positive numbers) or shrink (negative numbers) the matte by the specified number of pixels. This
is similar to using the Dilate/Erode Node on the matte.
This a simple way to include more or less along the edges of the matte, particularly combined with Post
Blur.
Feather Falloff
The rate of fall off at the edges of the matte when feathering, to manage edge detail.
Feather Distance
Controls how much the matte is feathered inwards (negative number) or outwards (positive number).
Post Blur
Make the matte less sharp, for smoother transitions to the background and noise reduction.
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Outputs
Image
Processed image with the Matte applied to the images’s alpha channel.
Matte
Output matte to use for checking the quality of the key, or to manually apply using a Set Alpha Node or
Mix Node.
Edges
Shows what edges were detected on the matte. Useful for adjusting the Edge Kernel Radius and Edge
Kernel Tolerance.
Tip
If there are problems with the edges of the matte, it may help to start with adjusting the Edge Kernel
parameters before adjusting feathering. Detected edges are not subject to Clip Black / Clip White thresholds to
preserve fine edge detail. You can check edge detection by connecting a Viewer Node to the Edges output.
Sharper detected edges (smaller Edge Kernel Radius, like 2 / larger Edge Kernel Tolerance, like 0.4) will
create a sharper matte, but may loose some detail like stray hairs. A sharp matte is good, but disappearing or
flickering hairs are distracting.
Fat edges (larger Edge Kernel Radius, like 8 / smaller Edge Kernel Tolerance, like 0.05) will capture more
edge detail, but may also produce a halo around the subject. The halo can be adjusted with Feather controls
along with Dilate/Erode.

Keying Screen Node

Keying Screen Node.
The Keying Screen node creates plates for use as a color reference for keying nodes. It generates gradients from
sampled colors on motion tracking points on movie clips.

Example
Consider a node setup for green screen removal, using a Color Key:
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Often, lighting is uneven across the backdrop.

Example from the Mango Open Movie, Tears of Steel.
That can result in a bad matte.
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Exanple of a poor mask: Some of the backdrop is opaque, and some parts of the gun in the foreground are
transparent.
If you increase the tolerances on the keying node, it will accept mores shades of green to mask out. But it may
also incorrectly mask out more of the foreground.
Instead of increasing the range of accepted shades to be masked out, the Keying Screen node lets you change
what shade of green (or other color) to use for different parts of the image.
Start in the Movie Clip Editor. Open the Properties Region and Tool Shelf to show tracking configuration.
Tracks used for gradients are not useful for camera solving, because they do not track well. So create a new
object track in the Objects selector. Place tracking markers on the clip to sample different parts of the backdrop.
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These tracks may be tracked or moved manually, so gradients can be updated over time. If the marker is not
enabled for a frame, it will not be used creating the gradient. (Such as the red-colored marker on the arm in the
screen shot above)
Once the tracks are created, add the node to your compositing setup, and select the tracking object used for the
backdrop.

Node configuration with Keying Screen‘s generated gradient plate connected to the Color input of the Keying
node.
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Gradient plate generated by Keying Screen.
The resulting image now has a better matte.
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Channel Key Node

Channel Key Node

The Channel Key node determines background objects from foreground objects by the difference in the selected
channel’s levels. For example in YUV color space, this is useful when compositing stock footage of explosions
(very bright) which are normally shot against a solid, dark background.
There is one input to this node, the Image that is to be keyed.
Control this node using:
Color Space
buttons selects what color space the channels will represent.
Channel
buttons selects the channel to use to determine the matte.
High
value selector determines the lowest values that are considered foreground. (which is supposed to be relatively - height values: from this value to 1.0).
Low
value selector determines the highest values that are considered to be background objects. (which is
supposed to be - relatively - low values: from 0.0 to this value).
It is possible to have a separation between the two values to allow for a gradient of transparency between
foreground and background objects.
The outputs of this node are the Image with an alpha channel adjusted for the keyed selection and a black and
white Matte (i.e the alpha mask).
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Color Spill Node

Color Spill Node

The Color Spill node reduces one of the RGB channels so that it is not greater than any of the others. This is
common when compositing images that were shot in front of a green or blue screen. In some cases, if the
foreground object is reflective, it will show the green or blue color; that color has “spilled” onto the foreground
object. If there is light from the side or back, and the foreground actor is wearing white, it is possible to get
“spill” green (or blue) light from the background onto the foreground objects, coloring them with a tinge of
green or blue. To remove the green (or blue) light, you use this fancy node.
There is one input to this node, the Image to be processed.
The Enhance slider allows you to reduce the selected channel’s input to the image greater than the color spill
algorithm normally allows. This is useful for exceptionally high amounts of color spill.
The outputs of this node are the image with the corrected channels.

Box Mask Node

Box Mask Node

TODO - see: https://developer.Bforartists.org/T43469
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Ellipse Mask Node

Ellipse Mask Node

TODO - see: https://developer.Bforartists.org/T43469

Luminance Key Node

Luminance Key Node

The Luminance Key node determines background objects from foreground objects by the difference in the
luminance (brightness) levels. For example, this is useful when compositing stock footage of explosions (very
bright) which are normally shot against a solid, dark background.
There is one input to this node, the Image that is to be keyed.
Control this node using:
• The High value selector determines the lowest values that are considered foreground. (which is
supposed to be - relatively - light: from this value to 1.0).
• The Low value selector determines the hightes values that are considered to be background objects.
(which is supposed to be - relatively - dark: from 0.0 to this value).
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It is possible to have a separation between the two values to allow for a gradient of transparency between
foreground and background objects.
The outputs of this node are the Image with an alpha channel adjusted for the keyed selection and a black and
white Matte (i.e the alpha mask).

Example

Using Luma Key...with a twist

For this example, let’s throw you a ringer. Here, the model was shot against a white background. Using the
Luminance Key node, we get a matte out where the background is white, and the model is black; the opposite
of what we want. If we wanted to use the matte, we have to switch the white and the black. How to do this?
ColorRamp to the rescue - we set the left color White Alpha 1.0, and the right color to be Black Alpha 0.0.
Thus, when the Colorramp gets in black, it spits out white, and vice versa. The reversed mask is shown; her
white outline is useable as an alpha mask now.
Now to mix, we don’t really need the AlphaOver node; we can just use the mask as our Factor input. In this
kinda weird case, we can use the matte directly; we just switch the input nodes. As you can see, since the matte
is white (1.0) where we don’t want to use the model picture, we feed the background photo to the bottom socket
(recall the mix node uses the top socket where the factor is 0.0, and the bottom socket where the factor is 1.0).
Feeding our original photo into the top socket means it will be used where the Luminance Key node has spit out
Black. Voila, our model is teleported from Atlanta to aboard a cruise ship docked in Miami.

Difference Key Node
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Difference Key Node

This node produces a matte that isolates foreground content by comparing it with a reference background
image.
There are two inputs:
Image 1
contains foreground content against the background that is to be removed
Image 2
is the reference background image
Where pixels match the reference background to within the specified Tolerance, the matte is made transparent.
Increase Falloff to make nearby pixels partially transparent producing a smoother blend along the edges.
Outputs are:
Image
with its alpha channel adjusted for the keyed selection
Matte
a monochrome representation of the mask

Distance Key Node
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Distance Key Node

TODO - see: https://developer.Bforartists.org/T43469

Chroma Key Node

Chroma Key Node

The Chroma Key node determines if a pixel is foreground or background (and thereby should be transparent)
based on its chroma values. Use this, for example, to composite images that have been shot in front of a green
or blue screen.
Inputs:
Image
that is to be keyed.
Key Color
the background color usually selected using the color picker and the original image.
Control this node using:
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Acceptance
An angle on the color wheel that represents how tolerant the keying color is. Larger angles allow for
larger variation in the keying color to be considered background pixels.
Cutoff
controls the level that is considered pure background. Higher cutoff levels means more pixels will be
100% transparent if they are within the angle tolerance.
Falloff
Increase to make nearby pixels partially transparent producing a smoother blend along the edges.
Outputs are:
Image
with its alpha channel adjusted for the keyed selection
Matte
a monochrome representation of the mask

Color Key Node

Color Key Node

The color key node creates a matte based on a specified color of the input image. The sliders represent
threshold values for Hue, Saturation, and Value. Higher values in this node’s context mean a wider range of
colors from the specified will be added to the matte.

Double Edge Mask Node

104

Bforartists Reference Manual - © Copyright - This page is under OCL license

Double Edge Mask Node

TODO - see: https://developer.Bforartists.org/T43469

Distort Nodes
These nodes distort the image in some fashion, operating either uniformly on the image, or by using a mask to
vary the effect over the image.
•
•
•
•
•
•
•
•
•
•
•
•
•

Scale Node
Lens Distortion Node
Movie Distortion Node
Translate Node
Rotate Node
Flip Node
Crop Node
Displace Node
Map UV Node
Transform Node
Stabilize 2D
Plane Track Deform Node
Corner Pin Node

Scale Node

105

Bforartists Reference Manual - © Copyright - This page is under OCL license

Scale Node

This node scales the size of an image. Scaling can be either absolute or relative. If Absolute toggle is on, you
can define the size of an image by using real pixel values. In relative mode percents are used.
For instance X: 0.5 and Y: 0.5 would produce image which width and height would be half of what they used
to be. When expanding an image greatly, you might want to blur it somewhat to remove the square corners that
might result. Unless of course you want that effect; in which case, ignore what I just said.
Use this node to match image sizes. Most nodes produce an image that is the same size as the image input into
their top image socket. So, if you want to uniformly combine two images of different size, you must scale the
second to match the resolution of the first.

Lens Distortion Node

Lens Distortion Node

Use this node to simulate distortions that real camera lenses produce.
Distort
This creates a bulging or pinching effect from the center of the image.
Dispersion
This simulates chromatic aberration, where different wavelengths of light refract slightly differently,
creating a rainbow colored fringe.
Projector
Enable or disable slider projection mode. When on, distortion is only applied horizontally. Disables Jitter
and Fit.
Jitter
Adds jitter to the distortion. Faster, but noisier.
Fit
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Scales image so black areas are not visible. Only works for positive distortion.

Movie Distortion Node

Movie Distortion Node

TODO - see: https://developer.Bforartists.org/T43469

Translate Node

Transform Node

The translate node translates (moves) an image by the specified amounts in the
X and Y directions. X and Y are in pixels, and can be positive or negative. To shift an image up and to the left,
for example, you would specify a negative X offset and a positive Y.

Usage
This node can be used for:
• Movie credits.
• Moving a matte.
• Camera shake.

Rotate Node
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Rotate Node

This node rotates an image. Positive values rotate clockwise and negative ones counterclockwise.

Flip Node

Flip Node

This node flips an image at defined axis that can be either X or Y. Also flipping can be done on both X and Y
axis’ simultaneously.
You can use this node to just flip or use it as a part of mirror setting. Mix half of the image to be mirrored with
its flipped version to produce mirrored image.

Crop Node

Crop Node

The Crop Node takes an input image and crops it to a selected region.
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Crop Image Size
When enabled, the image size is cropped to the specified region. When disabled, image remains the same
size, and uncropped areas become transparent pixels.
Relative
When enabled, crop dimensions are a percentage of the image’s width and height. When disabled, the
range of the sliders are the width and height of the image in pixels.
Crop Region Values
These sliders define the lower, upper, left, and right borders if the crop region.

Displace Node

Displace Node

Ever look down the road on a hot summer day? See how the image is distorted by the hot air? That’s because
the light is being bent by the air; the air itself is acting like a lens. This fancy little node does the same thing; it
moves an input image’s pixels based on an input vector mask (the vector mask mimics the effect of the hot air).
This can be useful for a lot of things, like hot air distortion, quick-and-dirty refraction, compositing live footage
behind refracting objects like looking through bent glass or glass blocks, and more! Remember what HAL saw
in 2001:Space Odyssey; that distorted wide-angle lens? Yup, this node can take a flat image and apply a mask
to produce that image.
The amount of displacement in the X and Y directions is determined by
• The value of the mask’s channels:
• The scaling of the mask’s channels
The (red) channel 1’s value determines displacement along the positive or negative X axis. The (green) channel
2’s value determines displacement along the positive or negative Y axis.
If both the channels’ values are equal (i.e. a greyscale image), the input image will be displaced equally in both
X and Y directions, and also according to the X scale and Y scale buttons. These scale button act as multipliers
to increase or decrease the strength of the displacement along their respective axes. They need to be set to nonzero values for the node to have any effect.
Because of this, you can use the displace node in two ways, with a greyscale mask (easy to paint, or take from a
procedural texture), or with a vector channel or RGB image, such as a normal pass, which will displace the
pixels based on the normal direction.
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Example
In this example, she’s singing about dreams of the future. So, to represent this, we use a moving clouds texture
(shot just by rendering the cloud texture on a moving plane) as the displacement map. Now, the colors in a
black and white image go from zero (black) to one (white), which, if fed directly without scaling would only
shift the pixels one position. So, we scale their effect in the X and Y direction.
Upon reviewing it, sometimes stretching in both the X and Y direction made her face look fat, and we all can
guess her reaction to looking fat on camera. SO, we scale it only half as much in the X so her face looks longer
and thinner. Now, a single image does not do justice to the animation effect as the cloud moves, and this simple
noodle does not reflect using blur and overlays to enhance (and complicate) the effect, but this is the core.
Photos courtesy of Becca, no rights reserved. See also some movies of this node in action, made by the wizard
programmer himself, by following this external link

Music Video Distortion Example Using Displace

Map UV Node

Map UV Node

So, I think we all agree that the problem is...we just don’t know what we want. The same is true for directors.
Despite our best job texturing our models, in post-production, inevitably the director changes their mind. “Man,
I really wish he looked more ragged. Who did makeup, anyway?” comes the remark. While you can do quite a
bit of coloring in post-production, there are limits. Well, now this little node comes along and you have the
power to re-texture your objects after they have been rendered. Yes, you read that right; it’s not a typo and
I’m not crazy. At least, not today.
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Using this node (and having saved the UV map in a multilayer OpenEXR format image sequence), you can
apply new flat image textures to all objects (or individual objects if you used the very cool ID Mask Node to
enumerate your objects) in the scene.
Thread the new UV Texture to the Image socket, and the UV Map from the rendered scene to the UV input
socket. The resulting image is the input image texture distorted to match the UV coordinates. That image can
then be overlay mixed with the original image to paint the texture on top of the original. Adjust alpha and the
mix factor to control how much the new texture overlays the old.
Of course, when painting the new texture, it helps to have the UV maps for the original objects in the scene, so
keep those UV texture outlines around even after all shooting is done.

Examples
In the example below, we have overlaid a grid pattern on top of the two Emo heads after they have been
rendered. During rendering, we enabled the UV layer in the RenderLayer tab (Buttons window, Render
Context, RenderLayer tab). Using a mix node, we mix that new UV Texture over the original face. We can use
this grid texture to help in any motion tracking that we need to do.

Adding a Grid UV Textures for Motion
Tracking

In the next example, we overlay a
flag on top of a cubie-type thing, and we ensure that we Enable the Alpha pre-multiply button on the Mix node.
The flag is used as additional UV Texture on top of the grid. Other examples include the possibility that we
used an unauthorized product box during our initial animation, and we need to substitute in a different product
sponsor after rendering.
Of course, this node does NOT give directors the power to rush pre-production rendering under the guise of
“we’ll fix it later”, so maybe you don’t want to tell them about this node. Let’s keep it to ourselves for now.
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Adding UV Textures in
Post-Production

Transform Node

Transform Node

This node combines the functionality of three other nodes: Scale, translate, and
rotate nodes.
X, Y
Used to move the input image horizontally and vertically.
Angle
Used to rotate an image around its center. Positive values rotate counter-clockwise and negative ones
clockwise.
Scale
Used to resize the image. The scaling is relative, meaning a value of 0.5 gives half the size and a value of
2.0 gives twice the size of the original image.
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Stabilize 2D

Scale Node

TODO - see: https://developer.Bforartists.org/T43469

Plane Track Deform Node

Plane Track Deform Node

TODO - see: https://developer.Bforartists.org/T43469

Corner Pin Node
Corner Pin Node
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Corner Pin Node.
The Corner Pin node uses explicit corner values for a plane warp transformation. It works like the Plane Track
Deform node, but without using “plane track” data from the Movie Clip Editor.

Inputs
Image
Standard image input.
Corners
Four vector inputs to define the plane warping. (Z-component of vector inputs is ignored.)

Properties
This node has no properties.

Outputs
Image
Standard image output. (The image after distorting.)
Plane
A black and white alpha mask of the plane.

Example
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An example of the Conner Pin node.
In the example above, the image of the bird is distorted by the vectors specified by the Corner Pin node.

Layout Nodes
These are nodes which help you control the layout and connectivity of nodes within the Compositor.
• Frame Node
• Reroute Node
• Switch Node

Frame Node
The Frame node is a useful tool for organizing nodes by collecting related nodes together in a common area.
Frames are useful when a node setup becomes large and confusing yet the re-usability of a Node Group is not
required.

Adding and Removing Nodes
Once a Frame node is placed in the editor, nodes can be added by simply dropping them onto the frame or by
selecting the node(s) then the frame and using Ctrl-P.
To remove them select the node(s) and use the Alt-P shortcut. This uses the same default keyboard bindings
as Parenting and can be thought of as a similar concept.

Resizing Frame
When the Frame node is first placed in the node editor workspace it may be resized by dragging one of the
edges.
Once a node is placed in the Frame, the Frame shrinks around it so as to remove wasted space. At this point it is
no longer possible to grab the edge of the Frame to resize it, instead resizing occurs automatically when nodes
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within the Frame are rearranged.
This behavior can be changed by disabling the Shrink option in the Properties tab of the Properties region (N).

Label and Color
Frame Nodes can be given a title by modifying the Label field in the properties panel. Label size can be
changed as well so that, for example, subordinate Frames have smaller titles.
Frame Node colors can be applied from the properties panel which can be used to provide a powerful visual
cue.
Once a satisfactory color is found it may be saved as a preset for re-use in other Frame nodes. To do this press
the + button next to the Color Presets drop down in the properties panel and add a name for the preset. To
delete a preset first choose that preset for the active Frame and press the - button in the properties panel.

Reroute Node
A node used primarily for organization. Reroute looks and behaves much like a socket on other nodes in that it
supports one input connection while allowing multiple output connections.
To quickly add a Reroute node into an existing connection, hold Shift and LMB while sweeping across the
link to ‘cut’ in a new node.
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Switch Node

Switch Node

Switch between two images using a checkbox. When the checkbox is checked, the ‘On’ input is output. When it
is unchecked the ‘Off’ input is output instead. Switch state may be animated by adding a keyframe This makes
the Switch node useful for bypassing nodes which are not wanted during part of a sequence.
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User Preferences
This chapter explains how to change Bforartists’s default configuration with the User Preferences editor.
The Bforartists User Preferences editor contains settings to to control how Bforartists behaves.

Open User Preferences
To open a Bforartists User Preferences editor go to File ‣ User Preferences.

Configure
Now that you have opened the User Preferences editor, you can configure Bforartists to your liking. At the top
of the window, the available options are grouped into seven tabs:
Interface
Change how UI elements are displayed and how they react.
Editing
Control how several tools will interact with your input.
Input
Customize how Bforartists reacts to the mouse and keyboard as well as define your own keymap.
2
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Add-ons
Manage Bforartists’s Add-ons, allowing you to access features not built-in as well as install new features.
Themes
Customize interface appearance and colors.
File
Configure auto-save preferences and set default file paths for .blend files, rendered images, and more.
System
Set resolution, scripting console preferences, sound, graphics cards, and internationalization.

Save the new preferences
Once you have set your preferences, you will need to manually save them, otherwise the new configuration will
be lost after a restart. Bforartists saves its preferences to userpref.blend in your user folder (see next section,
“Load Factory Settings”, for details).
In the User Preferences window, click on the Save User Settings button in the bottom left. This will save all of
the new preferences.

Load Factory Settings
Go to File ‣ Load Factory Settings then save the preferences via the User Preferences editor.
Hint
It can be valuable to make a backup of your preferences the event that you lose your configuration.
See the directory layout section to see where your preferences are stored.

Interface
Interface configuration lets you change how UI elements are displayed and how they react.
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Display
Tooltips
When enabled, a tooltip will appear when your mouse pointer is over a control. This tip explains the
function of what’s under the pointer, gives the associated hotkey (if any) and the Python function that
refers to it.
Object Info
Display the active Object name and frame number at the bottom left of the 3D view.
Large Cursors
Use large mouse cursors when available.
View Name
Display the name and type of the current view in the top left corner of the 3D window. For example: User
Persp or Top Ortho.
Playback FPS
Show the frames per second screen refresh rate while an animation is played back. It appears in the
viewport corner, displaying red if the frame rate set can’t be reached.
Global Scene
Forces the current scene to be displayed in all screens (a project can consist of more than one scene).
Object Origin Size
Diameter of 3D Object centers in the view port (value in pixels from 4 to 10).
Display Mini Axis
Show the mini axis at the bottom left of the viewport.
Size
Size of the mini axis.
Brightness
Adjust brightness of the mini axis.

View manipulation
Cursor Depth
4
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Use the depth under the mouse when placing the cursor.
Auto Depth
Use the depth under the mouse to improve view pan/rotate/zoom functionality.
Zoom to Mouse Position
When enabled, the mouse pointer position becomes the focus point of zooming instead of the 2D window
center. Helpful to avoid panning if you are frequently zooming in and out.
Rotate Around Selection
The selected object becomes the rotation center of the viewport. When there is no selection the last
selection will be used.
Hint
This may seem ideal behavior, however it can become problematic with larger objects such as a terrainmesh, where the center isn’t necessarily your point of interest.
Global Pivot
Lock the same rotation/scaling pivot in all 3D views.
Auto Perspective
Automatically to perspective Top/Side/Front view after using User Orthographic. When disabled,
Top/Side/Front views will retain Orthographic or Perspective view (whichever was active at the time of
switching to that view).
Smooth View
Length of time the animation takes when changing the view with the numpad (Top/Side/Front/Camera...).
Reduce to zero to remove the animation.
Rotation Angle
Rotation step size in degrees, when Numpad4, Numpad6, Numpad8, or Numpad2 are used to rotate the
3D view.

2D Viewports
Minimum Grid Spacing
The minimum number of pixels between grid lines in a 2D (i.e. top orthographic) viewport.
TimeCode Style
Format of Time Codes displayed when not displaying timing in terms of frames. The format uses ‘+’ as
separator for sub-second frame numbers, with left and right truncation of the timecode as necessary.

Manipulator
Permits configuration of the 3D transform manipulator which is used to drag, rotate and resize objects (Size,
Handle size).

Menus
Open on Mouse Over
Select this to have the menu open by placing the mouse pointer over the entry instead of clicking on it.
Menu Open Delay
Time for the menu to open.
5
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Top Level
Time delay in 1/10 second before a menu opens (Open on Mouse Over needs to be enabled).
Sub Level
Same as above for sub menus (for example: File ‣ Open Recent).

Editing
These preferences control how several tools will interact with your input.

Link Materials To

Example for a Mesh

To understand this option properly, you need to understand how Bforartists works with Objects. Almost
everything in Bforartists is organized in a hierarchy of data-blocks. A data-block can be thought of as containers
for certain pieces of information. For example, the Object data-block contains information about the Object’s
location while the Object Data (ObData) data-block contains information about the mesh.
A material may be linked in two different ways:

A material linked to ObData (left) and Object (right).

ObData
6
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Any created material will be created as part of the ObData data-block.
Object
Any created material will be created as part of the Object data-block.
Read more about Bforartists’s Data System

New objects
Enter Edit Mode
If selected, Edit Mode is automatically activated when you create a new object.
Align To
World
New objects align with world coordinates.
View
New object align with view coordinates.

Undo
Global Undo
This enables Bforartists to save actions done when you are not in Edit Mode. For example, duplicating
Objects, changing panel settings or switching between modes.
Warning
While disabling this option does save memory, it stops the redo panel from functioning, also preventing
tool options from being changed in some cases.
For typical usage, its best to keep this enabled.

Step
Number of Undo steps available.
Memory Limit
Maximum memory usage in Mb (0 is unlimited).
Read more about Undo and Redo options

Grease Pencil
Grease Pencil permits you to draw in the 3D viewport with a pencil-like tool.
Manhattan Distance
The minimum number of pixels the mouse has to move horizontally or vertically before the movement is
recorded.
Euclidian Distance
The minimum distance that mouse has to travel before movement is recorded.
Eraser Radius
The size of the eraser used with the grease pencil.
Smooth Stroke
Smooths the pencil stroke after it’s finished.

7
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Playback
Allow Negative Frame
If set, negative framenumbers might be used.

Keyframing
In many situations, animation is controlled by keyframes. The state of a value (e.g. location) is recorded in a
keyframe and the animation between two keyframes is interpolated by Bforartists.
Visual Keying
Use Visual keying automatically for constrained objects.
Only Insert Needed
When enabled, new keyframes will be created only when needed.
Auto Keyframing
Automatic keyframe insertion for Objects and Bones. Auto Keyframe is not enabled by default.
Only Insert Available
Automatic keyframe insertion in available curves.
New F-Curve Defaults
Interpolation
This controls how the state between two keyframes is computed. Default interpolation for new
keyframes is Bezier which provides smooth acceleration and de-acceleration whereas Linear or
Constant is more abrupt.
XYZ to RGB
Color for X, Y or Z animation curves (location, scale or rotation) are the same as the color for the
X, Y and Z axis.

Transform
Release confirm
Dragging LMB on an object will move it. To confirm this (and other) transforms, a LMB is necessary by
default. When this option is activated, the release of LMB acts as confirmation of the transform.

Sculpt Overlay Color
This color selector allows the user to define a color to be used in the inner part of the brushes circle when in
sculpt mode, and it is placed as an overlay to the brush, representing the focal point of the brush influence. The
overlay color is visible only when the overlay visibility is selected (clicking at the eye to set its visibility), and
the transparency of the overlay is controled by the alpha slider located at the brush selector panel, located at the
top of the tool shelf, when in sculpt mode.

Duplicate Data
The ‘Duplicate Data’ check-boxes define what data is copied with a duplicated Object and what data remains
linked. Any boxes that are checked will have their data copied along with the duplication of the Object. Any
boxes that are not checked will instead have their data linked from the source Object that was duplicated.
For example, if you have Mesh checked, then a full copy of the mesh data is created with the new Object, and
8
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each mesh will behave independently of the duplicate. If you leave the mesh box unchecked then when you
change the mesh of one object, the change will be mirrored in the duplicate Object.
The same rules apply to each of the check-boxes in the ‘Duplicate Data’ list.

Input
In the Input preferences, you can customize how Bforartists reacts to the mouse and keyboard as well as define
your own keymap.

Managing presets
Bforartists lets you define multiple Preset input configurations. Instead of deleting the default keymap to create
yours, you can just add new Presets for both the mouse and keyboard. Mouse options can be found on the left
hand side of the window and keyboard options to the right in the above picture.

Adding and deleting presets

Before changing anything in the default configuration, click on the “plus” symbol shown in the picture to add a
new Preset. Bforartists will ask you to name your new preset after which you can select the Preset from the list
to edit it. If you want to delete your Preset, select it from the list and then click the “minus” symbol.

Selecting presets
You can change the preset you are using by doing one of the following:
9
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• Selecting the configuration from the Interaction menu of the splash screen at startup or by selecting
Help ‣ Splash Screen.
• Selecting the configuration from the User Preferences Input window.
Note
Note that either of the above options will only change the preset for the current file. If you select File ‣ New
or File ‣ Open, the default preset will be re-loaded.

Setting presets to default

Once you’ve configured your mouse and keyboard Presets, you can make this the default configuration by:
• Opening the User Preferences Input editor and select your presets from the preset list or,
• Selecting your preset configuration from the splash screen.
• Saving your configuration using the Save As Default option from a User Preferences window or by
pressing Ctrl-U.

Export/Import key configuration
In some cases, you may need to save your configuration in an external file (e.g. if you need to install a new
system or share your keymap configuration with the community). Simply LMB Export Key Configuration on the
Input tab header and a file browser will open so that you can choose where to store the configuration. The
Import Key Configuration button installs a keymap configuration that is on your computer but not in
Bforartists.

Mouse
Emulate 3 Button Mouse
Bforartists can be configured to work with pointing devices which don’t have a middle-mouse button
(such as a two-button mouse, Apple single-button mouse, or laptop touch-pad). The functionality of the 3
mouse buttons will then be be emulated with key/mouse-button combinations as shown in the table
below.
Shortcuts for supported mouse hardware

3-button Mouse
LMB
MMB
RMB

2-button Mouse
LMB
Alt-LMB
RMB
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Mouse/Keyboard combinations refrenced in this manual can be expressed with the combinations shown
in the table. For Example.
• MMB drag becomes Alt-LMB drag.
• Shift-Alt-RMB becomes Shift-Alt-Cmd-LMB on a single-button mouse.
Continuous Grab
This feature is used to prevent the problem where an action such as grabbing or panning a view, is limited
by your screen bounds.
This is done by warping the mouse within the view.
Note
Cursor warping is only supported by relative input devices (mouse, trackball, trackpad).
Graphics tablets however, typically use absolute positioning, this feature is disabled when a tablet is
being used
This is detected for each action, so the presence of a tablet wont disable continuous-grab for mouse
cursor input.

Drag Threshold
The number of pixels that a User Interface element has to be moved before it is recognized by Bforartists.
Select with
You can choose which button is used for selection (the other one is used to place the 3D cursor).
Double Click
The time for a double click (in ms).
Note
The Mouse emulate option is only available if Select With is set to Right.

Graphic Tablets
Graphic tablets can be used to provide a more traditional method of controlling the mouse cursor using a pen.
This can help to provide a more familiar experience for artists who are used to painting and drawing with
similar tools, as well as provide additional controls such as pressure sensitivity.
Note
If you are using a graphic tablet instead of a mouse and pressure sensitivity doesn’t work properly, try to place
the mouse pointer in the Bforartists window and then unplug/replug your graphic tablet. This might help.

Numpad Emulation
The Numpad keys are used quite often in Bforartists and are not the same keys as the regular number keys. If
you have a keyboard without a Numpad (e.g. on a laptop), you can tell Bforartists to treat the standard number
11
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keys as Numpad keys. Just check Emulate Numpad.

View Manipulation
Orbit Style
Select how Bforartists works when you rotate the 3D view by default when holding MMB.
Turntable
Rotates the view keeping the horizon horizontal.
This behaves like a potters wheel or record player where you have two axes of rotation available,
and the world seems to have a better definition of what is “Up” and “Down” in it.
The drawback to using the Turntable style is that you lose some flexibility when working with your
objects. However, you gain the sense of “Up” and “Down” which can help if you are feeling
disoriented.
Orbit
Is less restrictive, allowing any orientation.
Zoom Style
Choose your preferred style of zooming in and out with Ctrl-MMB
Scale
Scale zooming depends on where you first click in the view. To zoom out, hold Ctrl-MMB while
dragging from the edge of the screen towards the center. To zoom in, hold Ctrl-MMB while
dragging from the center of the screen towards the edge.
Continue
The Continue zooming option allows you to control the speed (and not the value) of zooming by
moving away from the initial click-point with Ctrl-MMB. Moving up from the initial click-point or
to the right will zoom out, moving down or to the left will zoom in. The further away you move, the
faster the zoom movement will be. The directions can be altered by the Vertical and Horizontal
radio buttons and the Invert Zoom Direction option.
Dolly
Dolly zooming works similarly to Continue zooming except that zoom speed is constant.
Vertical
Moving up zooms out and moving down zooms in.
Horizontal
Moving left zooms in and moving right zooms out.
Invert Zoom Direction
Inverts the Zoom direction for Dolly and Continue zooming.
Invert Wheel Zoom Direction
Inverts the direction of the mouse wheel zoom.
NDOF device
Set the sensitivity of a 3D mouse.
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Keymap editor

The Keymap editor lets you change the default Hotkeys. You can change keymaps for each window.
• Select the keymap you want to change and click on the white arrows to open up the keymap tree.
• Select which Input will control the function
• Keyboard: Only hotkey or combo hotkey (E or Shift-E).
• Mouse: Left/middle/right click. Can be combined with Alt, Shift, Ctrl, Cmd.
• Tweak: Click and drag. Can also be combined with the 4 previous keys.
• Text input: Use this function by entering a text
• Timer: Used to control actions based on a time period. e.g. By default, Animation Step uses
Timer 0, Smooth view uses Timer 1.
• Change hotkeys as you want. Just click on the shortcut input and enter the new shortcut.
If you want to restore the default settings for a keymap, just click on the Restore button at the top right of this
keymap.

Add-ons
The Add-ons tab lets you manage secondary options which are not enabled in Bforartists by default. New
features may be added with Install Add-ons. There will be a growing number of such Add-ons, generated by the
Bforartists-community so look out for that one feature you were missing (or maybe simply create it yourself).
See the Add-ons Page for more on using Add-ons.
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Bforartists Reference Manual - © Copyright - This page is under OCL license

Themes
The Themes tab allows you to customize interface appearance and colors.

The colors for each editor can be set separately - simply select the editor you wish to change in the multi-choice
list at the left, and adjust colors as required. Notice that changes appear in real-time on your screen. In addition,
14
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details such as the dot size in the 3D View or the Graph Editor can also be changed.
Themes use Bforartists’s preset system. To save a theme, click the + button next to the preset selection dropdown and enter a name. This will save the theme to an XML file in the
./scripts/presets/interface_theme/ subdirectory of one of the configuration directories.

Bforartists comes bundled with a small selection of themes.

This is an example of the theme Elsyiun.

File Preferences
The File Preferences tab allows you to configure auto-save preferences and set default file paths for .blend files,
rendered images, and more.

15
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File Paths
Locations for various external files can be set for the following options:
Fonts
Default location when searching for font files.
Textures
Default location when searching for image textures.
Render Output
Where rendered images/videos are saved.
Scripts
An additional location to search for Python scripts. See Scripts Path below.
Sounds
Default location when searching for sound files.
Temp
The location where temporary files are stored.
Render Cache
The location where cached render images are stored.
I18n Branches
The path to the /branches directory of your local svn-translation copy, to allow translating from the
UI.
Image Editor
The path to an external program to use for image editing.
Animation Player
The path to an external program to use for playback of rendered animations.

Note
If these folders do not exist, they will not be created automatically.
16
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Scripts Path
By default Bforartists looks in several directories (OS dependant) for scripts. By setting a user script path in the
preferences an additional directory is looked in. This can be used to store certain scripts/templates/presets
independently of the currently used Bforartists Version.
Inside the specified folder specific folders have to be created to tell Bforartists what to look for where. This
folder structure has to mirror the structure of the scripts folder found in the installation directory of Bforartists:
•
•
•
•
•
•
•
•
•
•
•
•

scripts
add-ons
modules
presets
camera
cloth
interface_theme
operator
render
...
startup
templates Not all of the folders have to be present.

Auto Execution
Python scripts (including driver expressions) are not executed by default for security reasons.
Auto Run Python Scripts
You may choose to ignore these security issues and allow scripts to be executed automatically.
Excluded Paths
Blend files in these folders will not automatically run Python scripts. This can be used to define where
blend files from untrusted sources are kept.
See also
Scripting & Security

Save & Load
Relative Paths
By default, external files use a relative path.
Compress File
Compress .blend file when saving.
Load UI
Default setting is to load the Window layout (the Screens) of the saved file. This can be changed
individually when loading a file from the Open Bforartists File panel of the File Browser window.
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File extension filter

Filter File Extensions
By activating this, file dialog windows will only show appropriate files (i.e. .blend files when loading a
complete Bforartists setting). The selection of file types may be changed in the file dialog window.
Hide Dot File/Data-blocks
Hide file which start with . on file browsers (in Linux and Apple systems, . files are hidden).
Hide Recent Locations
Hides the Recent panel of the File Browser window which displays recently accessed folders.
Show Thumbnails
Displays a thumbnail of images and movies when using the File Browser.

Auto Save
Save Versions
Number of versions created for the same file (for backup).
Recent Files
Number of files displayed in File ‣ Open Recent.
Save Preview Images
Previews of images and materials in the File Browser window are created on demand. To save these
previews into your .blend file, enable this option (at the cost of increasing the size of your .blend
file).
Auto Save Temporary File
Enable Auto Save (create a temporary file).
Timer
Time to wait between automatic saves.

System Preferences
The System tab allows you to set resolution, scripting console preferences, sound, graphics cards, and
internationalization.
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General
DPI
Value of the screen resolution which controls the size of Bforartists’s interface fonts and internal icons
shown. Useful for taking screen shots for book printing and use of high resolution monitors. During
typical usage, you may prefer to use zoom which is a available in many parts of Bforartists interface.
Virtual Pixel Mode
Allows you to select global scaling. While the DPI only scales the interface, this will scale line width,
vertex-size.
This is intended for hi-dpi monitors.
Note
This is auto-detected on OSX.

Frame Server Port
TCP/IP port used in conjunction with the IP Address of the machine for frameserver rendering. Used
when working with distributed rendering. Avoid changing this port value unless it is conflicting with
already existing service ports used by your Operating System and/or softwares. Always consult your
operating system documentation and services or consult your system administrator before changing this
value.
Console Scrollback
The number of lines, buffered in memory of the console window. Useful for debugging purposes and
command line rendering.
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Sound
Sound
Set the audio output device or no audio support:
None
No Audio support (no audio output, audio strips can be loaded normally)
SDL
Uses Simple Direct Media Layer API from libsdl.org to render sounds directly to the sound device
output. Very useful for sequencer strips editing.
OpenAL
This API provides buffered sound rendering with 3D/spatial support.
Used for 3D source support by Speaker Objects and the Game Engine.
‘Specific sound options’ (With SDL or OpenAL enabled)
Channels
Set the audio channel count. Available options are: Stereo (Default) , 4 Channels , 5.1
Surround , 7.1 Surround
Mixing Buffer
Set the number of samples used by the audio mixing buffer. Available options are:
512 , 1024 , 2048 (Default), 4096 , 8192, 16384, and 32768
Sample Rate
Set the audio sample rate. Available options are: 44.1 Khz (Default), 48 Khs , 96 Khz and
192Khz
Sample Format
Set the audio sample format. Available options are: 32 bit float (Default), 8 bit Unsigned , 16
Bits Signed , 24 Bits Signed , 32 Bits Signed , 32 Bits Float and 64 Bits Float

Screencast
TODO

Compute Device
The Options here will set the compute device used by the Cycles render engine.
None
When set to None or the only option is None: your CPU will be used as a computing device for Cycles
Render Engine
CUDA
If the system has a compatible CUDA enabled graphics card and appropriate device drivers installed.
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When one or both of the options are available, the user will be able to choose whether to use CPU or
other computing device for Cycles Rendering.
OpenCL
Note that this currently has limited support unsupported, see: Cycles Render engine page

OpenSubdiv Compute
The Options here will set the compute device used by OpenSubdiv for the Subdivision Surface Modifier.
None
Disables any OpenSubdiv compute devices, makes sure legacy subsurf code from Bforartists is used. Use
this option when OpenSubdiv causes any bugs or regressions.
CPU
Single threaded CPU implementation. It is mainly useful in cases when GPU compute is possible and
threaded CPU option causes artifacts (it is unlikely to happen, but still possible).
OpenMP
Multi-threaded CPU implementation. It is similar to threading model of old subsurf code. Use it for
maximum performance in cases when GPU compute is not available.
GLSL Transform Feedback
Uses GPU to perform calculations, has minimal requirements to video card and driver.
GLSL Compute
Uses GPU to perform calculations, supposed to be more efficient than Transform Feedback but also has
higher requirements to video card and driver.

Open GL
Clip Alpha
Clip alpha below this threshold in the 3D viewport. Minimum: 0.000 (No Clip) , Maximum: 1.000 ,
Default 0.000 (No Clip)
Mipmaps
Scale textures for 3D view using mipmap filtering. This increases display quality, but uses more memory.
GPU MipMap Generation
Generate MipMaps on the GPU. Offloads the CPU Mimpap generation to the GPU.
16 Bit Float Textures
Enables the use of 16 Bit per component Texture Images (Floating point Images).
Anisotropic Filtering
Set the level of anisotropic filtering. Available Options are: Off’’ (No Filtering) , 2x (Default) , 4x , 8x ,
16x

Window Draw Method
Window Draw Method
Specifies the Window Draw Method used to display Bforartists Window(s).
Automatic (Default)
Automatically set based on graphics card and driver.
Triple Buffer
Use a third buffer for minimal redraws at the cost of more memory. If you have a capable GPU, this
is the best and faster method of redraw.
Overlap
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Redraw all overlapping regions. Minimal memory usage, but more redraws. Recommended for
some graphics cards and drivers combinations.
Overlap Flip
Redraw all overlapping regions. Minimal memory usage, but more redraws (for graphics drivers
that do flipping). Recommended for some graphic cards and drivers combinations.
Full
Do a full redraw each time. Only use for reference, or when all else fails. Useful for certain cards
with bad to no OpenGL acceleration at all.
Multi-Sampling
This enables FSAA for smooth drawing, at the expense of some performance.
Note
This is known to cause selection issues on some configurations, see: Invalid Selection.

Region Overlap
This checkbox will enable Bforartists to draw regions overlapping the 3D Window. It means that the
Object Tools and Transform Properties Tab, which are opened by using the shortcuts T and N will be
drawn overlapping the 3D View Window.
If you have a capable graphics card and drivers with Triple Buffer support, clicking the checkbox will
enable the overlapping regions to be drawn using the Triple Buffer method, which will also enable them
to be drawn using Alpha, showing the 3D View contents trough the Object Tools and Transform
Properties Tab.

Text Draw Options
Text Draw Options
Enable interface text anti-aliasing. When disabled, texts are drawn using text straight render (Filling only
absolute Pixels). Default: Enabled.

Textures
Limit Size
Limit the maximum resolution for pictures used in textured display to save memory. The limit options are
specified in a square of pixels, (e.g.: the option 256 means a texture of 256x256 pixels) This is useful for
game engineers, whereas the texture limit matches paging blocks of the textures in the target graphic card
memory. Available Options are: Off (No limit - Default) , 128, 256, 512, 1024, 2048, 4096, 8192.
Time Out
Time since last access of a GL texture in seconds, after which it is freed. Set to 0 to keep textures
allocated. Minimum: 0 , Maximum: 3600 , Default: 120
Collection Rate
Number of seconds between each run of the GL texture garbage collector. Minimum: 0 , Maximum:
3600 , Default: 120

22

Bforartists Reference Manual - © Copyright - This page is under OCL license

Sequencer/Clip Editor
Memory Cache Limit
Upper limit of the sequencer’s memory cache (megabytes). For optimum clip editor and sequencer
performance, high values are recommended. Minimum: 0 (No cache) , Maximum: 1024 (1 Gigabyte),
Default: 128

Solid OpenGL lights
Solid OpenGL Lights are used to light the 3D Window, mostly during Solid view. Lighting is constant and
position “world” based. There are three virtual light sources, also called OpenGL auxiliary lamps, used to
illuminate 3D View scenes, which will not display in renders.
The Lamp Icons allows the user to enable or disable OpenGL Lamps. At least one of the three auxiliary
OpenGL Lamps must remain enabled for the 3D View. The lamps are equal, their difference is their positioning
and colors. You can control the direction of the lamps, as well as their diffuse and specular colors. Available
Options are:
Direction
Clicking with LMB in the sphere and dragging the mouse cursor let’s the user change the direction of the
lamp by rotating the sphere. The direction of the lamp will be the same as shown at the sphere surface.
Diffuse
This is the constant color of the lamp. Clicking on the color widget, opens the color picker mini window
and allows the user to change colors using the color picker.
Specular
This is the highlight color of the lamp Clicking on the color widget, opens the color picker mini window
and allows the user to change colors using the color picker.

Color Picker Type
Choose which type of color dialog you prefer - it will show when clicking LMB on any color field.
See the different color picker types at the Extended Controls page.

Custom Weight Paint Range
Mesh skin weighting is used to control how much a bone deforms the mesh of a character. To visualize and
paint these weights, Bforartists uses a color ramp (from blue to green, and from yellow to red). Enabling the
checkbox will enable an alternate map using a ramp starting with an empty range. Now you can create your
custom map using the common color ramp options. For detailed information about how to use color ramps, see:
to the Extended Controls page.

Internationalization
Bforartists supports a wide range of languages, enabling this check box will enable Bforartists to support
International Fonts. International fonts can be loaded for the User Interface and used instead of Bforartists
default bundled font.
This will also enable options for translating the User Interface through a list of languages and Tips for
Bforartists tools which appears whenever the user hovers a mouse over Bforartists tools.
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Bforartists supports I18N for internationalization. For more Information on how to load International fonts, see:
Editing Texts page.

Startup File
Reference
Mode: All modes
Menu: File ‣ Save Startup File
When you start Bforartists or start a new project with the menu entry File ‣ New, a new scene is created from
the default scene included with Bforartists.
This default scene can instead be your own customized setup.
To change the default scene, make all of the desired changes to the current scene or current file and File ‣
Save Startup File.

Restoring to Factory Settings
Reference
Mode: All modes
Menu: File ‣ Load factory Settings
To restore the startup file to the factory settings, open File ‣ Load Factory Settings. This will restore the
Startup File and User Preferences back to the original factory settings. After this you can save the startup file to
overwrite any customizations permanently.
Note
User Preferences Window
For more information about the Editor Window for User Preferences or how to clean your preferences
manually, see User Preferences
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Command Line Arguments
Bforartists 2.76 Usage: Bforartists [args ...] [file] [args ...]

Render Options
-b, --background
Run in background (often used for UI-less rendering)
-a, --render-anim
Render frames from start to end (inclusive)
-S, --scene <name>
Set the active scene <name> for rendering
-f, --render-frame <frame>
Render frame <frame> and save it. +<frame> start frame relative, -<frame> end frame relative.
-s, --frame-start <frame>
Set start to frame <frame>, supports +/- for relative frames too.
-e, --frame-end <frame>
Set end to frame <frame>, supports +/- for relative frames too.
-j, --frame-jump <frames>
Set number of frames to step forward after each rendered frame
-o, --render-output <path>
Set the render path and file name. Use // at the start of the path to render relative to the blend file.
The # characters are replaced by the frame number, and used to define zero padding.
• ani_##_test.png becomes ani_01_test.png
• test-######.png becomes test-000001.png
When the filename does not contain #, The suffix #### is added to the filename.
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The frame number will be added at the end of the filename, eg:
Bforartists -b foobar.blend -o //render_ -F PNG -x 1 -a

//render_ becomes //render_####, writing frames as //render_0001.png
-E, --engine <engine>
Specify the render engine use -E help to list available engines
-t, --threads <threads>
Use amount of <threads> for rendering and other operations [1-64], 0 for systems processor count.

Format Options
-F, --render-format <format>
Set the render format, Valid options are...
TGA IRIS JPEG MOVIE IRIZ RAWTGA AVIRAW AVIJPEG PNG BMP FRAMESERVER
(formats that can be compiled into Bforartists, not available on all systems)
HDR TIFF EXR MULTILAYER MPEG AVICODEC QUICKTIME CINEON DPX DDS
-x, --use-extension <bool>
Set option to add the file extension to the end of the file

Animation Playback Options
-a <options> <file(s)>
Playback <file(s)>, only operates this way when not running in background.
-p <sx> <sy> Open with lower left corner at <sx>, <sy> -m Read from disk (Don’t buffer) -f
<fps> <fps-base> Specify FPS to start with -j <frame> Set frame step to <frame> -s
<frame> Play from <frame> -e <frame> Play until <frame>

Window Options
-w, --window-border
Force opening with borders (default)
-W, --window-borderless
Force opening without borders
-p, --window-geometry <sx> <sy> <w> <h>
Open with lower left corner at <sx>, <sy> and width and height as <w>, <h>
-con, --start-console
Start with the console window open (ignored if -b is set), (Windows only)
--no-native-pixels
Do not use native pixel size, for high resolution displays (MacBook Retina)

Game Engine Specific Options
-g Game Engine specific options
-g fixedtime

Run on 50 hertz without dropping frames

-g vertexarrays
Use Vertex Arrays for rendering (usually faster)
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-g nomipmap

No Texture Mipmapping

-g linearmipmap
Linear Texture Mipmapping instead of Nearest (default)

Python Options
-y, --enable-autoexec
Enable automatic Python script execution
-Y, --disable-autoexec
Disable automatic Python script execution (pydrivers & startup scripts), (default).
-P, --python <filename>
Run the given Python script file
--python-text <name>
Run the given Python script text block
--python-expr <expression>
Run the given expression as a Python script
--python-console
Run Bforartists with an interactive console
--python-exit-code
Set the exit-code in [0..255] to exit if a Python exception is raised (only for scripts executed from the
command line), zero disables.
--addons
Comma separated list of addons (no spaces)

Debug Options
-d, --debug
Turn debugging on
• Enables memory error detection
• Disables mouse grab (to interact with a debugger in some cases)
• Keeps Python’s sys.stdin rather than setting it to None
--debug-value <value>
Set debug value of <value> on startup
--debug-events
Enable debug messages for the event system
--debug-ffmpeg
Enable debug messages from FFmpeg library
--debug-handlers
Enable debug messages for event handling
--debug-libmv
Enable debug messages from libmv library
--debug-cycles
Enable debug messages from Cycles
--debug-memory
Enable fully guarded memory allocation and debugging
3
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--debug-jobs
Enable time profiling for background jobs.
--debug-python
Enable debug messages for Python
--debug-depsgraph
Enable debug messages from dependency graph
--debug-depsgraph-no-threads
Switch dependency graph to a single threaded evaluation
--debug-gpumem
Enable GPU memory stats in status bar
--debug-wm
Enable debug messages for the window manager, also prints every operator call
--debug-all
Enable all debug messages (excludes libmv)
--debug-fpe
Enable floating point exceptions
--disable-crash-handler
Disable the crash handler

Misc Options
--factory-startup
Skip reading the startup.blend in the users home directory
--env-system-datafiles
Set the Bforartists_SYSTEM_DATAFILES environment variable
--env-system-scripts
Set the Bforartists_SYSTEM_SCRIPTS environment variable
--env-system-python
Set the Bforartists_SYSTEM_PYTHON environment variable
-nojoystick
Disable joystick support
-noglsl
Disable GLSL shading
-noaudio
Force sound system to None
-setaudio
Force sound system to a specific device NULL SDL OPENAL JACK
-h, --help
Print this help text and exit
-R
Register .blend extension, then exit (Windows only)
-r
Silently register .blend extension, then exit (Windows only)
-v, --version
Print Bforartists version and exit
-Ends option processing, following arguments passed unchanged. Access via Python’s sys.argv
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Other Options
/?
Print this help text and exit (windows only)
--debug-freestyle
Enable debug/profiling messages from Freestyle rendering
--debug-gpu
Enable gpu debug context and information for OpenGL 4.3+.
--disable-abort-handler
Disable the abort handler
--enable-new-depsgraph
Use new dependency graph
--verbose <verbose>
Set logging verbosity level.

Experimental features
--enable-new-depsgraph
Use new dependency graph

Argument Parsing
Arguments must be separated by white space, eg:
Bforartists -ba test.blend

...will ignore the a
Bforartists -b test.blend -f8

...will ignore 8 because there is no space between the -f and the frame value

Argument Order
Arguments are executed in the order they are given. eg:
Bforartists --background test.blend --render-frame 1 --render-output '/tmp'

...will not render to /tmp because --render-frame 1 renders before the output path is set
Bforartists --background --render-output /tmp test.blend --render-frame 1

...will not render to /tmp because loading the blend file overwrites the render output that was set
Bforartists --background test.blend --render-output /tmp --render-frame 1

...works as expected.
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Environment Variables
Bforartists_USER_CONFIG:
Directory for user configuration files.
Bforartists_USER_SCRIPTS:
Directory for user scripts.
Bforartists_SYSTEM_SCRIPTS:
Directory for system wide scripts.
Bforartists_USER_DATAFILES:
Directory for user data files (icons, translations, ..).
Bforartists_SYSTEM_DATAFILES:
Directory for system wide data files.
Bforartists_SYSTEM_PYTHON:
Directory for system python libraries.
TEMP:

Store temporary files here.

TMP:

or $TMPDIR Store temporary files here.

SDL_AUDIODRIVER:
LibSDL audio driver - alsa, esd, dma.
PYTHONHOME:

Path to the python directory, eg. /usr/lib/python.
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Scripting & Extending Bforartists
Note
Bforartists relies at the Blender Python API.
Python is an interpreted, interactive, object-oriented programming language. It incorporates modules,
exceptions, dynamic typing, very high level dynamic data types, and classes. Python combines remarkable
power with very clear syntax.
Python scripts are a powerful and versatile way to extend Bforartists functionality. Most areas of Bforartists can
be scripted, including Animation, Rendering, Import and Export, Object Creation and the scripting of repetitive
tasks.
To interact with Bforartists, scripts can make use of the tightly integrated API (Application Programming
Interface).

General information
Links that are useful while writing scripts.
• http://www.python.org/ - Python.org - General information about Python.
• http://www.blender.org/documentation/250PythonDoc/ - Blender Python API - Official API
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documentation. Use this for referencing while writing scripts.
• http://www.blender.org/documentation/blender_python_api_2_72_release/info_quickstart.html - API
introduction - A short introduction to get you started with the API. Contains examples.
• http://wiki.blender.org/index.php/Dev:2.5/Py/Scripts/Cookbook - CookBook - A section of handy code
snippets (yet to be written)
Links that deal with distributing your scripts.
• http://wiki.blender.org/index.php/Dev:Py/Sharing - Sharing scripts - Information on how to share your
scripts and get them included in the official Blender distribution.
• http://wiki.blender.org/index.php/Dev:2.5/Py/Scripts/Guidelines/Addons - Creating Add-ons - Add-ons
are used to encapsulate and distribute scripts.
• https://projects.blender.org/projects/bf-extensions/ - Extensions project - Project to maintain a central
repository of extensions to Blender.

Getting Started - Manual links
The following links take you from the basics to the more advanced concepts of Python scripting for Bforartists.
• Text Editor
• Python Console

Getting Started - External links
Here are external links containing a lot of good information to start learning how to write scripts for Bforartists.
• http://sites.google.com/site/satishgoda/blender/learningblender25/introduction-to-blender-python-api Introductory tutorial by Satish Goda - Takes you from the beginning and teaches how to do basic API
manipulations.
• http://www.youtube.com/watch?v=vmhU_whC6zw - Ira Krakow’s video tutorials - First video in a
series of video tutorials.
• http://en.wikibooks.org/wiki/Blender_3D:_Blending_Into_Python/2.5_quickstart - Quickstart guide - A
quickstart guide for people who already have some familiarity with Python and Blender.
• http://blenderartists.org/forum/showthread.php?t=164765 - Examples thread - A forum thread containing
many short working script examples.
• http://cgcookie.com/blender/2011/08/26/introduction-to-scripting-with-python-in-blender/ - Introduction
to Python - A one hour video tutorial introducing Python and the Blender API.

Extending Bforartists
Add-ons
Add-ons are scripts you can enable to gain extra functionality within Bforartists, they can be enabled from the
user preferences.
Outside of the Bforartists executable, there are literally hundreds of add-ons written by many people:
• Officially supported add-ons are bundled with Bforartists.
• Other Testing add-ons are included in development builds but not official releases, many of them work
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reliably and are very useful but are not ensured to be stable for release.
For an overview of all add-ons is available in, see Scripts Catalog and Extensions tracker.
http://wiki.blender.org/index.php/Extensions:2.6/Py/Scripts
https://projects.blender.org/projects/bf-extensions/

Scripts
Apart from add-ons there are also scripts you can use to extend Bforartists functionality:
• Modules: Utility libraries for import into other scripts.
• Presets: Settings for Bforartists tools and key configurations.
• Startup: These files are imported when starting Bforartists. They define most of Bforartists UI, as well
as some additional core operators.
• Custom scripts: In contrast to add-ons they are typically intended for one-time execution via the text
editor

Saving your own scripts
File location
All scripts are loaded from the scripts folder of the local, system and user paths.
You can setup an additional search path for scripts in File Paths (User Preferences –> File Paths).

Installation
Add-ons are conveniently installed through Bforartists in the User Preferences –> Add-ons window. Click the
Install from File... button and select the .py or .zip file.
To manually install scripts or add-ons place them in the add-ons, modules, presets or startup
directory according to their type. See the description above.
You can also run scripts by loading them in the text editor window.

Add-ons
Add-on is the general term for a script that extends Bforartists functionality. They are found in the Add-ons tab
of the User Preferences window. This tab allows to search, install, enable and disable Add-ons.

Searching
Bforartists comes with some useful Add-ons already, ready to be enabled, but you can also add your own, or
any interesting ones you find on the web.
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Add-ons tab in the User Preferences

The Scripts Catalog provides an index of Add-ons that are included with Bforartists as well as listing a number
of external Add-ons.

Enabling and Disabling
Enable and disable and add-on by checking or unchecking the box on the right of the add-on you chose, as
shown on the figure.

Enabling an Add-on

The add-on functionality should be immediately available. If the Add-on does not activate when enabled, check
the Console window for any errors that may have occurred.
You can click the arrow at the left of the add-on box to see more information, such as where it is located, a
description and a link to the documentation. Here you can also find a button to report a bug specific of this addon.
Tip
Saving Add-on Preferences
If you want an Add-on to be enabled every time you start Bforartists, you will need to Save User Settings.
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Installation of a 3rd party Add-on
For add-ons that you found on the web or your own to show on the list, you have to install them first by
clicking Install from File... and providing a .zip or .py file.
Alternatively you can manually install an Add-on, which is useful when developing your own add-ons. Move or
link the files to ../scripts/addons folder (where .. is the path to your Bforartists configuration folder).

File locations
For information on the location of Bforartists directories see: Configuration & Data Paths
You can also create a personal folder containing new add-ons and configure your files’ path in the File panel of
the User Preferences. To create a personal script folder:
•
•
•
•
•

Create an empty folder (i.e. ‘script_addon_2-7x’)
Add one folder named ‘addons’. It has to named like this for Bforartists to recognize it.
Put your new add-ons in this ‘addons’ folder.
open the File panel of the User Preferences.
Fill the Scripts entry with the path to your script folder (i.e. ‘script_addon_2-7x’).

Development guidelines
If you are a script developer, you may be interested in the Add-ons development guidelines

Scripting & Security
The ability to include Python scripts within blend files is valuable for advanced tasks such as rigging,
automation and using the game-engine, however it poses a security risk since Python doesn’t restrict what a
script can do.
Therefore, you should only run scripts from sources you know and trust.
Automatic execution is disabled by default, however some blend files need this to function properly.
When a blend file tries to execute a script and is not allowed, a message will appear in the header with the
option to Reload Trusted or Ignore the message.

Scripts in Blend Files
Auto Execution
Here are the different ways blend files may automatically run scripts.
Registered Text-Blocks
A text block can have its Register option enabled which means it will load on start.
Animation Drivers
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Python expressions can be used to Drive values and are often used in more advanced rigs and animations.
Game Engine Auto-Start
Scripts are often used for game logic, blend files can have Auto Start enabled with runs the game on load.

Manual Execution
There are other ways scripts in a blend file may execute that require user interaction (therefor will run even
when auto-execution is off), but you should be aware that this is the case since it’s not necessarily obvious.
• Running a script in the text editor (ok, this is obvious!).
• Rendering with FreeStyle - FreeStyle uses scripts to control line styles
• Running the Game-Engine.

Controlling Script Execution
Bforartists provides a number of ways to control whether scripts from a blend file are allowed to automatically
execute.
First of all, the file-selector has the option Trusted Source which you can use on a case-by-case basis to control
auto-execution.
However you may forget to set this, or open a file without going through the file selector - so you can change
the default (described next).

Setting Defaults
In the File section of the user-preferences there is the toggle Auto-Run Python Scripts.
This means the Trusted Source option in the file-selector will be enabled by default, and scripts can run when
blend files are loaded without using the file selector.
Once enabled you have the option to exclude certain directories, a typical configuration would be to trust all
paths except for the download directory.
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Command Line
You may want to perform batch rendering or some other task from the command line - running Bforartists
without an interface.
In this case the user-preferences are still used but you may want to override them.
• Enable with -y or --enable-autoexec
• Disable with -Y or --disable-autoexec
Example - rendering an animation in background mode, allowing drivers and other scripts to run:
Bforartists --background --enable-autoexec my_movie.blend --render-anim

Note
These command line arguments can be used to start a regular Bforartists instance and will still override the
user-preferences.
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Application Templates
Application Templates
Usage
Application templates are a feature that allows you to define a re-usable configuration that can be selected to
replace the default configuration, without requiring a separate Bforartists installation or overwriting your
personal settings.

Using templates from the file menu

1
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Selecting a template from the splash screen.
Application templates can be selected from the splash screen or the file menu (as shown above).
When there are no templates found the menu will not be displayed on the splash screen.
New application-templates can be installed from the file menu.
If you would like to keep the current application-template active on restarting Blender, save your userpreferences.

Motivation
In some cases its not enough to write a single script or add-on, and expect someone to replace his userpreferences and startup file, install scripts and change his key-map.
The goal of application-templates is to support switching to a customized configuration without disrupting your
existing settings & installation.
This means people can build their own applications on top of Bforartists that can be easily distributed.

Details
An application-template may define its own:
Startup File
The default file to load with this template.
User Preferences
Only certain user-preferences from a template are used:
• Themes.
• Add-ons.
• Keymaps.
• Viewport lighting.
Splash Screen
Templates may provide their own splash screen image.
Python Scripts
While templates have access to the same functionality as any other scripts, typical operations include:
2
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• Modifying and replacing parts of the user-interface.
• Defining new menus, key-maps & tools.
• Defining a custom add-on path for template specific add-ons.
Templates also have their own user configuration so saving startup while using a template won’t overwrite your
default startup file.

Directory Layout
Templates may be located in one of two locations within the scripts directory.
Template locations:
{BLENDER_USER_SCRIPTS}/startup/bl_app_templates_user
{BLENDER_SYSTEM_SCRIPTS}/startup/bl_app_templates_system
User configuration is stored in a sub directory,
Without a template:
./config/startup.blend
./config/userpref.blend
With a template:
./config/{APP_TEMPLATE_ID}/startup.blend
./config/{APP_TEMPLATE_ID}/userpref.blend
See Configuring Directories for details on script and configuration locations.

Template Contents
Each of the following files can be used for application templates but are optional.
startup.blend
Factory startup file to use for this template.
userpref.blend
Factory user-preferences file to use for this template.
(As noted previously, this is only used for a subset of preferences).
splash.png, splash_2x.png
Splash screen do override Blender’s default artwork (not including header text).
Must be 501x230 or 1002x460 (used for HiDPI monitors).
__init__.py
A Python script which must contain register and unregister functions.

Note
Bundled blend files startup.blend and userpref.blend are considered Factory Settings and are
never overwritten.
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The user may save his own startup/preferences while using this template which will override them.
The original template settings can be loaded using: Load Template Factory Settings from the file menu in
much the same way Load Factory Settings works.
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Working Limits
Working Limits
Space
While object positions, vertex locations are not clamped, larger values become increasingly imprecise.
To get an idea of the precision you can work with using different scales.
Here’s a table of scales and their associated accuracy.
10:

1/1,048,576th

100:

1/131,072th

1,000:

1/16,384th

10,000: 1/1,024th
100,000: 1/128th
1,000,000: 1/16th
Hint
For a rough rule of thumb, values within -5,000/+5,000 are typically reliable (range of 10,000).
Internally single precision floating point calculations are used.

Time
The maximum number of frames for each scene is currently 500,000, and allows for continuous shots for
durations of:
24 fps: 5 hours, 47 seconds.
25 fps: 5 hours, 33 seconds.
30 fps: 4 hours, 37 seconds.
60 fps: 2 hours, 18 seconds.
Note
1
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In practice, a finished work is typically composted of output from many scenes. So this limit does not prevent
you from creating longer works.

Text Fields
Fixed strings are used internally, and while it is not useful to list all limits, here are some common limits.
directory: 767
file-name: 255
file-path: 1023
identifier: 63
Used for data-block names, modifiers, vertex-groups, UV-layers…
Note
Multi-byte encoding means some unicode characters use more than a single ASCII character.
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Troubleshooting
•
•
•
•
•

Startup
3D Viewport
Graphics Hardware
Crashes
Recovering Lost Work

Compatibility
Some applications which integrate themselves into your system can cause problem’s with Bforartists.
Here are some known compatibility issues listed by platform.
• Compatibility (Linux)
• Compatibility (OSX)
• Compatibility (Windows)
1
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Troubleshooting Startup
There are some common causes for problems when using Bforartists. If you can not find a solution for your
problem here, try asking the community for help.
If Bforartists crashes on startup there are a few things to check for:
• See if you computer meets the minimum requirements
• Confirm that your graphics card is supported and that the drivers support at least OpenGL 1.4
• Make sure you are using the correct Bforartists version (32 or 64 bit) for your architecture.
Known causes listed below.

Python Crashes on Startup
If you get an error on startup
Fatal Python error: Py_Initialize: unable to load the file system codec

you may have set your systems PYTHONPATH environment variable.
In this case Bforartists’s bundled Python will attempt to use the PYTHONPATH. If the Python version is
different from the version used by Bforartists, this will crash Bforartists on startup.
To solve the problem, either clear the PYTHONPATH before starting Bforartists (can be done in a launcher
script), or set it to a compatible Python version.

Troubleshooting the 3D View
TODO
See: https://developer.Bforartists.org/T43810

Drawing
Depth Buffer Glitches
TODO, see: http://Bforartists.stackexchange.com/questions/1385

Objects Invisible in Camera View
If you have a large scene, viewing it through Camera View may not display all of the Objects in the scene. One
possibility may be that the clipping distance of the camera is too low. The camera will only show objects that
fall within the clipping range.
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Performance
Slow Drawing
TODO.

Slow Selection
Bforartists uses OpenGL drawing for selection, some graphics card drivers are slow at performing this
operation.
This becomes especially problematic on dense geometry.
Possible Solutions:
OpenGL Occlusion Queries (User Preference)
See User Preferences ‣ System ‣ Selection
This option defaults Automatic, try setting this to OpenGL Occlusion Queries, since there is a significant
performance difference under some configurations.
Upgrade OpenGL Driver
In some cases slow selection is resolved by using updated drivers. It’s generally good to use recent
drivers when using 3D software.
Select Centers (Workaround)
In Object Mode, holding Ctrl while selecting uses the object center point. While this can be useful on its
own, its has the side-effect of not relying on OpenGL selection.
Change Draw Modes (Workaround)
Using Wireframe or even Bounding Box draw modes can used to more quickly select different objects.
Note
Obviously the workarounds listed here aren’t long term solutions, but its handy to know if you’re stuck using a
system with poor OpenGL support.
Ultimately, if none of these options work out it may be worth upgrading your hardware.

Navigation
Lost in Space
When navigating your scene, you may accidentally navigate away from your scene and find yourself with a
blank view-port
TODO.

Invisible Limit Zooming In
TODO, see: http://Bforartists.stackexchange.com/questions/644
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Tools
Invalid Selection
There are times when selection fails under some configurations, often this is noticeable in mesh Edit Mode,
selecting vertices/edges/faces where random elements are selected.
Internally Bforartists uses OpenGL for selection, so the graphics card driver is relied on giving correct results.
Possible Solutions:
Disable Anti-Aliasing (FSAA, Multi-Sampling)
This is by far the most common cause of selection issues.
There are known problems with some graphics cards when using FSAA/multi-sampling.
You can disable this option by:
• Turning FSAA/multi-sampling off in your graphics card driver options.
• Turning Multi-Sampling off in the system preferences.
Change Anti-Aliasing Sample Settings
Depending on your OpenGL configuration, some specific sample settings may work, while others fail.
Unfortunately finding working configuration involves trial & error testing.
Upgrade OpenGL Driver
As with any OpenGL related issues, using recent drivers can resolve problems.
However it should be noted that this is a fairly common problem and remains unresolved with many
drivers.

Troubleshooting Graphics Hardware
Bforartists makes use of OpenGL, which is typically hardware accelerated.
This means issues with the graphics card hardware and drivers can impact on Bforartists’s behavior. This page
lists some known issues using Bforartists on different graphics hardware and how to trouble-shoot them.

Performance
When the entire interface very slow and unresponsive (even with the default startup scene). This is likely a
problem with the OpenGL configuration.
Unfortunately in this situation you may have to do some of your own tests to find the cause, here are some
common causes and possible solutions.
Upgrade your OpenGL Driver
If you’re experiencing any strange graphics problems with Bforartists, its always good to double check
4
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you’re using the latest drivers.
Disable Anti-Aliasing (FSAA, Multi-Sampling)
See Invalid Selection, Disable Anti-Aliasing.
Change the Window Draw Method
This is set in the system preferences. Its selected automatically, however when experiencing problems its
worth checking if changing this resolves interface drawing problems.

Troubleshooting Crashes
The most common causes of Bforartists crashes.
• Running out of memory.
• Issues with graphics hardware/drivers.
• Bugs in Bforartists.
Firstly, you may be able to recover your work with File ‣ Recover Last Session.
To prevent the problem from happening again, you can check that the graphics drivers are up to date, upgrade
your machine’s hardware (the RAM or graphics card), and disable some options that are more memory
intensive:
• Disable Region Overlap and Triple buffering at User Preferences ‣ System ‣ Window Draw Method.
• Using multisample, anti-aliasing also increase the memory usage and make display slower.
• On Linux, the Window Manager (KDE, Gnome, Unity) may be using hardware accelerated effects (eg.
window shadows and transparency) that are using up the memory that Bforartists needs. Try disabling
the desktop effects or switch to a light-weight Window Manager.

Recovering from mistakes or problems
Bforartists provides a number of ways for the user to recover from mistakes, and reduce the chance of losing
their work in the event of operation errors, computer failures, or power outages. There are two ways for you to
recover from mistakes or problems:
At the User Level (Relating to Actions)
• For your actions, there are options like Undo, Redo and an Undo History, used to roll back from
mistakes under normal operation, or return back to a specific action.
• Bforartists also has new features like Repeat and Repeat History, and the new Redo Last which you can
use in conjunction with the options listed.
At the System Level (Relating to Files)
• There are options to save your files like Auto Save that saves your file automatically over time, and Save
on Quit, which saves your Bforartists file automatically when you exit Bforartists.
Note
In addition to these functions being enabled by default, the Save on Quit functionality cannot be
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disabled.

Options for Files (System Level)
Save and Auto Save

Auto Save options

Computer crashes, power outages or simply forgetting to save can result in the loss or corruption of your work.
To reduce the chance of losing files when those events occur, Bforartists can use an Autosave function. The File
tab of the User Preferences window allows you to configure the two ways that Bforartists provides for you to
regress to a previous version of your work.
Save on Quit
The function Save on Quit is enabled by default in Bforartists. Bforartists will always save your files
when you quit the application under normal operation.
Save Versions
This option tells Bforartists to keep the indicated number of saved versions of your file in your current
working directory when you manually save a file. These files will have the extension: .blend1,
.blend2, etc., with the number increasing to the number of versions you specify. Older files will be
named with a higher number. e.g. With the default setting of 2, you will have three versions of your file:
*.blend (your last save), *.blend1 (your second last save) and *.blend2 (your third last save).
Auto Save Temporary Files
Checking this box tells Bforartists to automatically save a backup copy of your work-in-progress to the
Temp directory (refer to the File panel in the User Preferences window for its location). This will also
enable the Timer (mins) control which specifies the number of minutes between each Auto Save. The
default value of the Bforartists installation is 5 (5 minutes). The minimum is 1, and the Maximum is 60
(Save at every one hour).The Auto Saved files are named using a random number and have a .blend
extension.
6
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Tip
Compress Files
The option to Compress files will try to compact your files whenever Bforartists is saving them. Large Scenes,
dense Meshes, big Textures or lots of elements in your Scene will result in a big .blend being created. This
option could slow down Bforartists when you quit, or under normal operation when Bforartists is saving your
backup files. In fact, using this option you will trade processor time for file space.

Recovering Auto Saves
Recover Last Session
File ‣ Recover Last Session will open the quit.blend that is saved into the Temp directory when you
exit Bforartists. Note that files in your Temp directory are deleted when you reboot.

Bforartists File Browser

Tip
When recovering files, you will navigate to your temporary folder. It is important, when browsing, to enable
the detailed list view. Otherwise, you will not be able to figure out the dates of the auto-saved .blends. (See
Figure: Bforartists File Browser)

Recover Auto Save
File ‣ Recover Auto Save... allows you to open the Auto Saved file. After loading the Auto Saved
version, you may save it over the current file in your working directory as a normal .blend file.
Important
When recovering an Auto Saved file, you will lose any changes made since the last Auto Save was
performed.Only one Auto Saved file exists for each project (i.e. Bforartists does not keep older versions hence you won’t be able to go back more than a few minutes with this tool).

Other options
Recent Files
This setting controls how many recent files are listed in the File ‣ Open Recent sub-menu.
7
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Save Preview Images
Previews of images and materials in the File Browser window are created on demand. To save these
previews into your .blend file, enable this option (at the cost of increasing the size of your .blend
file).

Compatibility (Linux)

Compatibility (OSX)
Mouse Motion Jitters (SmoothMouse)
Problem
When grabbing an object or orbiting the view, cursor motion is jittery.
See bug report
Solutions
• Uninstall SmoothMouse.
• Disable Continuous Grab

Compatibility (Windows)
Bforartists Hangs on Window Duplication (Nahimic for MSI)
Problem
Accessing Window ‣ Duplicate Window, hangs Bforartists, using 100% of one core.
See bug report https://developer.Bforartists.org/T47224
Solution
Uninstall Nahimic·for·MSI

8
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Glossary
This page lists definitions for terms used in Bforartists and this manual. Also see
• About this manual
For other common conventions used throughout the manual.
Active
One of the three selection states. Only one object or item can be active at any given time.
Action Safe
Area of the screen visible on most devices. Place content inside it to ensure it doesn’t get cut off.
Actuator
A logic brick that acts like a muscle of a lifeform. It can move the object, or also make a sound.
Aliasing
Rendering artifacts in the form of jagged lines.
Alpha Channel
Additional channel in 2D image for transparency.
Straight Alpha
Method where RGBA channels are stored as (R, G, B, A) channels, with the RGB channels
unaffected by the alpha channel. This is the alpha type used by paint programs such as Photoshop or
Gimp, and used in common file formats like PNG, BMP or Targa. So, image textures or output for
the web are usually straight alpha.
Premultiplied Alpha
Method where RGBA channels are stored as (R*A, G*A, B*A, A), with the alpha multiplied
into the RGB channel.
This is the natural output of render engines, with the RGB channels representing the amount of light
that comes toward the viewer, and alpha representing how much of the light from the background is
blocked. The OpenEXR file format uses this alpha type. So, intermediate files for rendering and
compositing are often stored as premultiplied alpha.
Conversion (Straight/Premultiplied) Alpha
Conversion between the two alpha types is not a simple operation and can involve data loss, as both
alpha types can represent data that the other can not, though it is often subtle.
Straight alpha can be considered to be an RGB color image with a separate alpha mask. In areas
where this mask is fully transparent, there can still be colors in the RGB channels. On conversion to
premultiplied alpha this mask is ‘applied’ and the colors in such areas become black and are lost.
1
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Premultiplied alpha on the other hand can represent renders that are both emitting light and letting
through light from the background. For example a transparent fire render might be emitting light,
but also letting through all light from objects behind it. On converting to straight alpha this effect is
lost.
Ambient Light
Light that comes from the surrounding environment as a whole.
Ambient Occlusion
A ratio of how much ambient light a surface point would be likely to receive. If a a surface point is under
a foot or table, it will end up much darker than the top of someone’s head or the tabletop.
Animation
Simulation of motion.
Anti-aliasing
See oversampling.
Armature
An Object consisting of bones. Used to rig characters, props, etc.
Axis
A reference line which defines coordinates along one cardinal direction in n-D space.
Baking
The process of computing and storing the result of a potentially time-consuming calculation so as to avoid
needing to calculate it again.
Bevel
Operation to chamfer or bevel edges of an object.
BU
Bforartists Units
Internal units used by Bforartists, equivalent to meters. Often abbreviated to “BU”.
Bone
The building block of an Armature. Made up of a Head, Tail and Roll Angle which define a set of local
axes and a point of rotation at the Head.
Boolean
A type of logic dealing with binary true/false states.
See also boolean modifier
Bounce
Refers to the reflection or transmission of a light ray upon interaction with a material. See also Light
Paths.
Bounding Box
Box that encloses the shape of an object. The box is aligned with the local space of the object.
Bump Mapping
Technique for simulating slight variations in surface height using a grayscale “height-map” texture.
Bézier
A computer graphics technique for generating and representing curves.
Caustics
Bright concentrations of light focused by specularly reflecting or refracting objects.
Child
An Object that is affected by its Parent.
Color Blend Modes
Methods for blending two colors together.
See also Blend Modes on Wikipedia.
2
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Color Space
TODO.
See also Color Spaces on Wikipedia.
Concave face
Face in which one vert is inside a triangle formed by other vertices of the face.
Constraint
A way of controlling one object with data from another.
Controller
A logic brick that acts like the brain of a lifeform. It makes decisions to activate muscles (actuators),
either using simple logic or complex Python scripts.
Convex face
Face where, if lines were drawn from each vertex to every other vertex, all lines would remain within the
face. Opposite of a concave face.
Coplanar
Refers to any set of elements that are all aligned to the same 2D plane in 3D space.
Crease
Property of an edge. Used to define the sharpness of edges in subdivision surface meshes.
Curve
A type of object defined in terms of a line interpolated between Control Vertices. Available types of
curves include Bézier and NURBS.
DOF
Depth Of Field
The distance in front of and behind the subject which appears to be in focus. For any given lens setting,
there is only one distance at which a subject is precisely in focus, but focus falls off gradually on either
side of that distance, so there is a region in which the blurring is tolerable. This region is greater behind
the point of focus than it is in front, as the angle of the light rays change more rapidly; they approach
being parallel with increasing distance.
Diffuse Light
Even, directed light coming off a surface. For most things, diffuse light is the main lighting we see.
Diffuse light comes from a specific direction or location, and creates shading. Surfaces facing towards the
light source will be brighter, while surfaces facing away from the light source will be darker.
Directional Light
Light that has a specific direction, but no location. It seems to come from an infinitely far away source,
like the sun. Surfaces facing the light are illuminated more than surfaces facing away, but their location
doesn’t matter. A Directional Light illuminates all objects in the scene, no matter where they are.
Displacement Mapping
Method for distorting vertices based on an image or texture. Similar to Bump Mapping, but instead
operates on the mesh’s actual geometry. This relies on the mesh having enough geometry to represent
details in the image.
Double Buffer
Technique for drawing and displaying content on screen. Bforartists uses two buffers (images) to draw the
interface in. The content of one buffer is displayed, while drawing occurs on the other buffer. When
drawing is complete, the buffers are switched.
Edge
Straight segment (line) that connects two vertices, and can be part of a face.
Edge Loop
Chain of edges belonging to consecutive quads. An edge loop ends at a pole or a boundary. Otherwise it is
cyclic.
Edge Ring
Path of all edges along a face loop that share two faces belonging to that loop.
3
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Empty
An Object without any Vertices, Edges or Faces.
Environment Map
Method of calculating reflections. It involves rendering images at strategic positions and applying them as
textures to the mirror. Now in most cases obsoleted by Raytracing, which though slower is easier to use
and more accurate.
Euler Rotation
TODO.
Face
Mesh element that defines a piece of surface. It consists of 3 or more edges.
Face Loop
Chain of consecutive quads. A face loop stops at a triangle or Ngon (which don’t belong to the loop), or at
a boundary. Otherwise it’s cyclic.
Face Normal
The normalized vector perpendicular to the plane that a face lies in. Each face has its own normal.
FCurve
Curve that holds the animation values of a specific property.
Field of View
The area in which objects are visible to the camera. Also see Focal Length
Focal Length
Distance required by a lens to focus collimated light. Defines the magnification power of a lens. Also see
Field of View
FSAA
Full-Screen Anti-Aliasing
Method of Anti-aliasing on the graphics card, so the entire image is displayed smooth. Also known as
Multi-Sampling.
This can be enabled in the user preferences. On many graphics cards this can also be enabled in the driver
options.
Gamma
An operation used to adjust brightness of an image.
See also Gamma correction on Wikipedia.
Geometric Center
Mean average of the positions of all vertices making up the object.
Gimbal Lock
The limitation where axes of rotation can become aligned, loosing the ability to rotate on an axis
(typically assosiated with euler rotation).
• See also Gimbal lock on Wikipedia.
• See also Gimbal lock on Stackexchange.
Global Illumination
A superset of radiosity and ray tracing. The goal is to compute all possible light interactions in a given
scene, and thus obtain a truly photo realistic image. All combinations of diffuse and specular reflections
and transmissions must be accounted for. Effects such as color bleeding and caustics must be included in
a global illumination simulation.
Global Space
See World Space.
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Gouraud Shading
Used to achieve smooth lighting on low-polygon surfaces without the heavy computational requirements
of calculating lighting for each pixel. The technique was first presented by Henri Gouraud in 1971.
Head
A subcomponent of a Bone. The point of rotation for that Bone. Has X, Y and Z coordinates measured in
the Local Space of the Armature Object. Used in conjunction with the Tail to define the local Y axis of the
Bone in Pose Mode. The larger of the two ends when drawn as an Octahedron.
HDRI
High Dynamic Range Image
A set of techniques that allow a far greater dynamic range of exposures than normal digital imaging
techniques. The intention is to accurately represent the wide range of intensity levels found in real scenes,
ranging from direct sunlight to the deepest shadows.
See also HDRI on Wikipedia.
IOR
Index Of Refraction
A property of transparent materials. When a light ray travels through the same volume it follows a straight
path. However if it passes from one transparent volume to another, it bends. The angle by which the ray is
bent can be determined by the IOR of the materials of both volumes.
Interpolation
Method of calculating new data between points of known value, like keyframes.
Inverse Kinematics
The process of determining the movement of interconnected segments of a body or model. Using ordinary
Kinematics on a hierarchically structured object you can for example move the shoulder of a puppet. The
upper and lower arm and hand will automatically follow that movement. IK will allow you to move the
hand and let the lower and upper arm go along with the movement. Without IK the hand would come off
the model and would move independently in space.
Keyframe
A frame in an animated sequence drawn or otherwise constructed directly by the user. In classical
animation, when all frames were drawn by animators, the senior artist would draw these frames, leaving
the “in between” frames to an apprentice. Now, the animator creates only the first and last frames of a
simple sequence (keyframes); the computer fills in the gap.
Keyframing
Inserting Keyframes to build an animated sequence.
Lattice
A type of object consisting of a non-renderable three-dimensional grid of vertices.
See also Lattice Modifier.
Layer
A device for organizing objects. See also Layers.
Local Space
A 3D coordinate system that originates (for Objects) at the Object Center or (for Bones) at the Head of the
Bone.
Compare to World Space.
Logic brick
A graphical representation of a functional unit in Bforartists’s game logic. A Logic brick can be a Sensor,
Controller or Actuator.
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Manifold
Manifold meshes, also called water tight meshes, define a closed non-self-intersecting volume (see also
non-manifold). A manifold mesh is a mesh in which the structure of the connected faces in a closed
volume will always point the normals (and their surfaces) to the outside or to the inside of the mesh
without any overlaps. If you recalculate those normals, they will always point at a predictable direction
(To the outside or to the inside of the volume). When working with non-closed volumes, a manifold mesh
is a mesh in which the normals will always define two different and non-consecutive surfaces. A manifold
mesh will always define an even number of non overlapped surfaces.
Mesh
Type of object consisting of vertices, edges and faces.
Motion Blur
The phenomenon that occurs when we perceive a rapidly moving object. The object appears to be blurred
because of our persistence of vision. Simulating motion blur makes computer animation appear more
realistic.
Multi-sampling
See FSAA
Ngon
A face that contains more than four vertices.
Non-linear animation
Animation technique that allows the animator to edit motions as a whole, not just the individual keys.
Nonlinear animation allows you to combine, mix, and blend different motions to create entirely new
animations.
Non-manifold
Non-Manifold meshes essentially define geometry which cannot exist in the real world. This kind of
geometry is not suitable for several types of operations, specially those where knowing the volume
(inside/outside) of the object is important (refraction, fluids, booleans, or 3D printing, to name a few). A
non-manifold mesh is a mesh in which the structure of a non-overlapped surface (based on it’s connected
faces) won’t determine the inside or the outside of a volume based on it’s normals, defining a single
surface for both sides, but ended with flipped normals. When working with non-closed volumes, a nonmanifold mesh will always determine at least one discontinuity at the normal directions, either by an
inversion of a connected loop, or by an odd number of surfaces. A non manifold mesh will always define
an odd number of surfaces.
There are several types of non-manifold geometry:
•
•
•
•

Some borders and holes (edges with only a single connected face), as faces have no thickness.
Edges and vertices not belonging to any face (wire).
Edges connected to 3 or more faces (interior faces).
Vertices belonging to faces that are not adjoining (e.g. 2 cones sharing the vertex at the apex).

See also: Select Non-Manifold tool.
Normal
The normalized vector perpendicular to a surface.
Normals can be assigned to vertices, faces and modulated across a surface using normal mapping.
Normal mapping
Is similar to Bump mapping, but instead of the image being a greyscale heightmap, the colors define in
which direction the normal should be shifted, the 3 color channels being mapped to the 3 directions X, Y
6
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and Z. This allows more detail and control over the effect.
NURBS
A computer graphics technique for generating and representing curves and surfaces.
Object
Container for a type (Mesh, Curve, Surface, Metaball, Text, Armature, Lattice, Empty, Camera, Lamp)
and basic 3D transform data(Object Center).
Object Center
Object Origin
A reference point used to position, rotate, and scale an Object and to define its Local Space coordinates.
Octahedron
An eight-sided figure commonly used to depict the Bones of an Armature.
OpenGL
The graphics system used by Bforartists (and many other graphics applications) for drawing 3D graphics,
often taking advantage of hardware acceleration.
See also OpenGL on Wikipedia.
Oversampling
Is the technique of minimizing aliasing when representing a high-resolution signal at a lower resolution.
Also called Anti-Aliasing.
Overscan
The term used to describe the situation when not all of a televised image is present on a viewing screen
See also Overscan on Wikipedia.
Parent
An Object that affects its Child objects.
Parenting
Creating a Parent-Child relationship between two objects.
Particle system
Technique that simulate certain kinds of fuzzy phenomena, which are otherwise very hard to reproduce
with conventional rendering techniques. Common examples include fire, explosions, smoke, sparks,
falling leaves, clouds, fog, snow, dust, meteor tails, stars and galaxies, or abstract visual effects like
glowing trails, magic spells. Also used for fur, grass or hair.
Phong
Local illumination model that can produce a certain degree of realism in three-dimensional objects by
combining three elements: diffuse, specular and ambient for each considered point on a surface. It has
several assumptions - all lights are points, only surface geometry is considered, only local modelling of
diffuse and specular, specular color is the same as light color, ambient is a global constant.
Pivot Point
Reference point used by many mesh manipulation tools.
See also Pivot Point.
Pixel
The smallest unit of information in a 2D raster image, representing a single color made up of red, green,
and blue channels. If the image has an alpha channel, the pixel will contain a corresponding fourth
channel.
Pole
7
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Vertex where three, five, or more edges meet. A vertex connected to one, two, or four edges is not a pole.
Pose Mode
Used for posing, keyframing, weight painting, constraining and parenting the bones of an armature.
Posing
Moving, Rotating and Scaling the bones of an armature to achieve an aesthetically pleasing pose for a
character.
Premultiplied Alpha
See Alpha Channel
Primitive
A basic object that can be used as a basis for modeling more complicated objects.
Procedural Texture
Computer generated (generic) textures. Procedural textures can be configured via parameters.
Projection
In computer graphics there are two common camera projections used.
Perspective
A perspective view is geometrically constructed by taking a scene in 3D and placing an observer at
point O. The 2D perspective scene is built by placing a plane (e.g. a sheet of paper) where the 2D
scene is to be drawn in front of point O, perpendicular to the viewing direction. For each point P in
the 3D scene a PO line is drawn, passing by O and P. The intersection point S between this PO line
and the plane is the perspective projection of that point. By projecting all points P of the scene you
get a perspective view.
Orthographic
In an orthographic projection, you have a viewing direction but not a viewing point O. The line is
then drawn through point P so that it is parallel to the viewing direction. The intersection S between
the line and the plane is the orthographic projection of the point P. By projecting all points P of the
scene you get the orthographic view.
Quad
Quadrilateral
Quadrangle
Face that contains exactly four vertices.
Radiosity
A global lighting method that calculates patterns of light and shadow for rendering graphics images from
three-dimensional models. One of the many different tools which can simulate diffuse lighting in
Bforartists.
See also Radiosity (computer graphics) on Wikipedia.
Raytracing
Rendering technique that works by tracing the path taken by a ray of light through the scene, and
calculating reflection, refraction, or absorption of the ray whenever it intersects an object in the world.
More accurate than scanline, but much slower.
Refraction
The change in direction of a wave due to a change in velocity. It happens when waves travel from a
medium with a given index of refraction to a medium with another. At the boundary between the media,
the wave changes direction; its wavelength increases or decreases but frequency remains constant.
Render
The process of computationally generating a 2D image from 3D geometry.
Rig
A system of relationships that determine how something moves. The act of building of such a system.
8
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Roll
Roll Angle
The orientation of the local X and Z axes of a Bone. Has no effect on the local Y axis as local Y is
determined by the location of the Head and Tail.
Scanline
Rendering technique. Much faster than raytracing, but allows fewer effects, such as reflections,
refractions, motion blur and focal blur.
Sensor
A logic brick that acts like a sense of a lifeform. It reacts to touch, vision, collision etc.
Shading
Process of altering the color of an object/surface in the 3D scene, based on its angle to lights and its
distance from lights to create a photorealistic effect.
Smoothing
Defines how faces are shaded. Face can be either solid (faces are rendered flat) or smooth (faces are
smoothed by interpolating the normal on every point of the face).
Specular light
Light which is reflected precisely, like a mirror. Also used to refer to highlights on reflective objects.
Straight Alpha
See Alpha Channel
Sub surface scattering
Mechanism of light transport in which light penetrates the surface of a translucent object, is scattered by
interacting with the material, and exits the surface at a different point. All non-metallic materials are
translucent to some degree. In particular, materials such as marble, skin, and milk are extremely difficult
to simulate realistically without taking subsurface scattering into account.
Subdividing
Technique for adding more geometry to a mesh. It creates new vertices on subdivided edges, new edges
between subdivisions and new faces based on new edges. If new edges cross a new vertex is created on
their crossing point.
Subsurf
Subdivision surface
Method of creating smooth higher poly surfaces which can take a low polygon mesh as input.
Sometimes abbreviated to Subsurf.
See also Catmull-Clark subdivision surface on Wikipedia
Tail
A subcomponent of a Bone. Has X, Y and Z coordinates measured in the Local Space of the Armature
Object. Used in conjunction with the Head to define the local Y axis of a Bone in Pose Mode. The smaller
of the two ends when drawn as an Octahedron.
Texture
Specifies visual patterns on surfaces and simulates physical surface structure.
Timecode
A coded signal on videotape or film giving information about the frame number, time of recording, or
exposure.
Title Safe
Area of the screen visible on all devices. Place text and graphics inside this area to make sure they don’t
get cut off.
Topology
Arrangement of Vertices, Edges, and Faces which define the shape of a mesh. See vertex, edge, and face.
Transforms
The combined idea of location, rotation and scale.
9
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Triangle
Face with exactly 3 vertices.
UV map
Defines a relation between the surface of a 3 dimensional mesh and a 2D texture. In detail, each face of
the mesh is mapped to a corresponding face on the texture. It is possible and often common practice to
map several faces of the mesh to the same or overlapping areas of the texture.
Vertex
Vertices
A point in 3D space containing a location. It may also have a defined color. Vertices are the terminating
points of edges.
Vertex Group
Collection of vertices. Vertex groups are useful for limiting operations to specific areas of a mesh.
Voxel
A cubicle 3D equivalent to the square 2D pixel. The name is a combination of the terms “Volumetric” and
“Pixel”. Used to store smoke and fire data from physics simulations.
Weight Painting
Assigning vertices to Vertex Groups with a weight of 0.0 - 1.0.
World Space
A 3D coordinate system that originates at a point at the origin of the world. Compare to Local Space.

About this manual
In this manual aims to be a complete and concise source of information to help you to become familiar with the
application.
You can find links to the particular areas of interest in the navigation bar on the left.

Conventions used
The mouse buttons are referred to as:
LMB
Left Mouse Button
RMB
Right Mouse Button
If your mouse has a wheel
MMB
Middle Mouse Button
Wheel
Scrolling the wheel.
Hotkey letters are shown in this manual like they appear on a keyboard; for example,
G
refers to the lowercase g.
Shift, Ctrl, Alt
are specified as modifier keys.
Ctrl-W, Shift-Alt-A, ...
10
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indicates that these keys should be pressed simultaneously
Numpad0 to Numpad9, NumpadPlus
refer to the keys on the separate numeric keypad.
Other keys are referred to by their names, such as Esc, Tab, F1 to F12. Of special note are the arrow keys,
Left, Right and so on.

Get Involved
If you would like to contribute to this manual, see About this Manual, check for open tasks, or join the mailing
list and #Bforartistswiki channel on IRC.

11
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About this Manual
Bforartists is a Blender fork. And so also the Bforartists Manual is based at the Blender manual. Most of the
text and the images are still the images from the Blender manual.
This will change over time when Bforartists evolves more and more away from Blender. But it is very likely
that some old Blender manual parts will remain parts of the Bforartists manual. Freestyle documentation for
example.

Manipulating Bforartists Manual
The Bforartists Manual is a community driven effort to which anyone can contribute.
And this very easy, since the manual comes not only as pdf files, but also as editable *.odt files. That's the file
format for Libre and Open Office. Both free and open source Office solutions. To manipulate or to fix a typoe, a
word, a sentence or even a whole chapter is as easy as manipulating the text in Libre Office or Open Office,
export to PDF, and tell the Bforartists developers to put it online.

License
The Bforartists’s Manual is free and published under Public Domain*
This means that anyone is free to download, edit and share the manual. It also means that when contributing to
the manual you don’t hold exclusive copyright to your text. You are, of course, acknowledged and appreciated
for your contribution. However others can change and improve your text in order to keep the manual consistent
and up to date.
* As of writing this part here the Blender manual for 2.77 and below was put under a Public Domain AS
CC0 license. Which is simply invalid. You can have either Public domain. Or CC0. Those two licenses
contradicts each other.
It also seems that the Blender manual was put under CC0 without asking all involved persons if they
wanted to do so. Another license breach.
So i choose the license type that seems to fit most here, especially when looking at the old licensing. Public
Domain.
The Blender developers are currently at looking under what license the manual will be in the future since
the current license doesn't fit. I will adjust the license when needed to the new license type then.
1
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Pipeline
This section of the manual focuses on the integration of Blender into a production pipeline. This is a vast topic
that covers many areas of the software, but here we will focus on file/asset management and data I/O.
Note
The tools and workflows documented here require familiarity with working with a command line interface and
are mostly aimed at TDs and technical users.

BAM Asset Manager
Refactoring linked .blend files is a common practice in a production environment. While some basic operations
can be accomplished within Blender, sometimes it is more practical to perform them on the command line or
via a script. During the production of Cosmos Laundromat (Gooseberry Open Movie Project) the BAM Asset
Manager (BAM) was developed. The original scope of BAM included client-server asset management tools
going beyond Blender, but it was later refocused on core utilities to perform two operations:
• blendfile packing
• automatic dependencies remapping
The following section of the manual focuses on how to use BAM.

Installing BAM
BAM is a standalone Python package, that can be run on any system without any particular configuration. The
1
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only requirement is Python 3 (and pip, the Python package manager, to easily install BAM).
Windows, Linux and macOS provide different ways to install Python 3 and pip. Check out the online docs to
learn more about a specific platform.
Once Python 3 and pip are available, BAM can be installed via command line by typing:
pip3 install blender-bam

After a successful installation, the bam command will be available. By typing it and pressing the Enter key, all
the available subcommands will be displayed.

bam pack
This command is used for packing a .blend file and all its dependencies into a .zip file for redistribution.
usage: bam pack [-h] [-o FILE] [-m MODE] [-e PATTERNS] [-a] [-q] [-c LEVEL]
paths [paths ...]

You can simply pack a blend file like this to create a zip-file of the same name.
bam pack /path/to/scene.blend

You may also want to give an explicit output directory. The example shows how to pack a blend with maximum
compression for online downloads
bam pack /path/to/scene.blend --output my_scene.zip --compress=best

The command provides several options to adapt to different workflows (final distribution, partial extraction,
rendering).
-o, --output <FILE>
Output file or a directory when multiple inputs are passed
-m, --mode <MODE>
Output file or a directory when multiple inputs are passed. Possible choices: ZIP, FILE
-e, --exclude <PATTERN(S)>
Optionally exclude files from the pack.
--exclude="*.png"
Using Unix shell-style wildcards (case insensitive).
--exclude="*.txt;*.avi;*.wav"
Multiple patterns can be passed using the ; separator.
-a, --all-deps
Follow all dependencies (unused indirect dependencies too)
-q, --quiet
Suppress status output
-c, --compress <LEVEL>
Compression level for resulting archive Possible choices: default, fast, best, store
--repo <DIR PATH>
Specify a “root” path from where to pack the selected file. This allows for the creation of a sparse copy of
the production tree, without any remapping.
2
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--warn-external
Report external libraries errors (missing paths)

Examples
Consider the following directory layout, and in particular the file 01_01_A.lighting.blend with its linked
libraries.
~/agent327/
└─ lib/
├─ chars/
| ├─ agent.blend ------------->|
| ├─ boris.blend ------------->|
| └─ barber.blend
|
└─ scenes/
|
├─ 01-opening
|
├─ 01_01_A.lighting.blend <--|
└─ 01_01_A.anim.blend ------>|

< BAM pack this file

Once we run bam pack /scenes/01-opening/01_01_A.lighting.blend we obtain a
01_01_A.lighting.zip inside of which we find the following structure.
~/01_01_A.lighting
├─ 01_01_A.lighting.blend
└─ __/
├─ 01_01_A.anim.blend
└─ __/
└─ lib/
└─ chars/
├─ agent.blend
└─ boris.blend

Note how all paths have been remapped relative to the placement of 01_01_A.lighting.blend in the root of the
output. If we run bam pack /scenes/01-opening/01_01_A.lighting.blend --repo
~/agent327, the output will be different.
~/01_01_A.lighting
├─ lib/
| └─ chars/
|
├─ agent.blend
|
└─ boris.blend
└─ scenes
└─ 01-opening/
├─ 01_01_A.lighting.blend
└─ 01_01_A.anim.blend

< The BAM packed file

In this case no path is remapped, and we simply strip out any file that is not referenced as a direct or indirect
dependency of 01_01_A.lighting.blend. This is effectively a sparse copy of the original production tree.

bam remap
Remap blend file paths
usage: bam remap [-h] {start,finish,reset} ...

This command is a 3 step process:
3
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• first run bam remap start . which stores the current state of your project (recursively).
• then re-arrange the files on the filesystem (rename, relocate).
• finally run bam remap finish to apply the changes, updating the .blend files internal paths.
cd /my/project
bam remap start .
mv photos textures
mv barbershop_v14_library.blend barberhop_libraray.blend
bam remap finish

Note
Remapping creates a file called bam_remap.data in the current directory. You can relocate the entire
project to a new location but on executing finish, this file must be accessible from the current directory.

Note
This command depends on files unique contents, take care not to modify the files once remap is started.

Subcommands
remap start
Start remapping the blend files
usage: bam remap start [-h] [-j] [paths [paths ...]]

-j, --json
Generate JSON output
remap finish
Finish remapping the blend files
usage: bam remap finish [-h] [-r] [-d] [-j] [paths [paths ...]]

-r, --force-relative
Make all remapped paths relative (even if they were originally absolute)
-d, --dry-run
Just print output as if the paths are being run
-j, --json
Generate JSON output
remap reset
Cancel path remapping
usage: bam remap reset [-h] [-j]
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Alembic
From the Alembic home page:
Alembic is an open computer graphics interchange framework. Alembic distills complex, animated
scenes into a non-procedural, application-independent set of baked geometric results. This
‘distillation’ of scenes into baked geometry is exactly analogous to the distillation of lighting and
rendering scenes into rendered image data.
Alembic is focused on efficiently storing the computed results of complex procedural geometric
constructions. It is very specifically NOT concerned with storing the complex dependency graph of
procedural tools used to create the computed results. For example, Alembic will efficiently store the
animated vertex positions and animated transforms that result from an arbitrarily complex
animation and simulation process which could involve enveloping, corrective shapes, volumepreserving simulations, cloth and flesh simulations, and so on. Alembic will not attempt to store a
representation of the network of computations (rigs, basically) which are required to produce the
final, animated vertex positions and animated transforms.
TL;DR: Alembic can be used to write an animated mesh to disk, and read it back quickly & efficiently. This
means that a mesh can be animated with a very CPU-heavy rig, ‘baked’ to an Alembic file, and loaded into the
shot file for shading and lighting with only moderate CPU usage.
Support for the Alembic file format was introduced in Blender 2.78.
Due to the Open Source nature of the Alembic standard, as well as the C++ library implementing that standard,
Blender can be used in a hybrid pipeline. For example, other software, such as Houdini or Maya, can export
files to Alembic, which can then be loaded, shaded, and rendered in Blender. It is also possible to animate
characters (or other models) in Blender, export to Alembic, and load those files into other software for further
processing.

Exporting to Alembic files
This section describes the effect of the different export options.

5
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Alembic Export options.

Manual Transform
Scale
This sets the global scale of the Alembic file. Keep it at the default value of 1.0 to use Blender’s units.

6

Bforartists Reference Manual - © Copyright - This page is under OCL license

Scene Options
Start Frame and End Frame
Sets the frame range to export to Alembic. This defaults to the current scene frame range.
Sub-frame sampling: Transform & Geometry Samples, Shutter Open & Close
These options control the sub-frame sampling of animations. Transform Samples sets the number of times
per frame at which animated transformations are sampled and written to Alembic. Geometry Samples sets
the same, but then for animated geometry. Shutter Open & Close define the interval [open, close) over
which those samples are taken. The valid range is -1 to 1, where -1 indicates the previous frame, 0
indicates the current frame, and 1 indicates the next frame. For example, if information for detailed mesh
motion blur is desired, some subframes around the current frame can be written to Alembic by using a
sample count of 5, Shutter Open at -0.25 and Shutter Close at 0.25. This mimicks a “180 degree” shutter,
opening 90 degrees before the frame and closing 90 degrees after the frame.
Selected Objects Only
When enabled, exports only the selected objects. When disabled, all objects are exported.
Renderable Objects Only
This is useful to, for example, avoid exporting custom bone shapes.
Visible Layers Only
Limits the export to scene layers that are currently visible.
Flatten Hierarchy
When disabled, parent/child relations between objects are exported too. Any parent object that is not
exported itself, but with children that are exported, is replaced by an Empty. When enabled, parent/child
relations are not exported, and transformations are all written in world coordinates.

Object Options
UVs
When enabled, UV maps are exported. Although the Alembic standard only supports a single UV map,
Blender exports all UV maps in a way that should be readable by other software.
Pack UV Islands
TODO: figure out & describe what this does
Normals
TODO: figure out & describe what this does
Vertex Colors
When enabled, exports vertex colours. At this moment, this only supports static vertex colors, and not
dynamically animated vertex colors.
Face Sets
TODO: figure out & describe what this does
Use Subdivision Schema
When enabled, writes polygonal meshes using the “SubD” Alembic schema, rather than the “PolyMesh”
schema.
Apply Subsurf
TODO: figure out & describe what this does
Triangulate
Triangulates the mesh before writing to Alembic.

Particle Systems
Alembic has no support for Particle Systems, in the same way that it does not support armatures. Hair is
exported as animated zero-width curves. Particles are exported as animated points.

7
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The Game Engine
Blender has its own built in Game Engine. Bforartists is a fork of Blender, and so the game engine exists also in
Bforartists.
The Blender Game Engine is aged to say the least. And it is very limited. We recommend NOT to use it
anymore. As with the video sequence editor, everything is better than the Blender solution. Use Unity, Unreal,
Godot or anything else state of the art instead.
BFORARTISTS DOES NOT GIVE ANY SUPPORT FOR THE GAME ENGINE!
You have to use the Blender manual when you want to work with the game engine.
It can be found here: https://docs.blender.org/manual/en/dev/game_engine/introduction.html

1
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Bforartists History
Preface:
Welcome to Bforartists, the free and open source 3D modeling, rendering and animation suite.
Bforartists is a fork of the popluar open source 3d software Blender. And, similar to Blender, of course also
open source and under the GPL license. The primary goal of the Bforartists fork is to deliver a better graphical
UI and a better usability. This means a complete switch in the useage philosophy. Away from the hotkey and
speed centered useage. Away from crazy decisions like RMB select. Towards a user friendly and intuitive
graphical UI that can be used with a mouse and one hand when neccessary. And that is much closer to the
common UI standards of many other software.
The idea to solve the UI dilemma of Blender and to fork it was long around since years. It was no easy decision
to really start it. Blender is a code monster. And so the answer to the question shall i really start a fork was
always no. But at one point it was simply enough how the user interface gots treaten by the Blender developers.
The answer if Blender should be forked turned from *no* to *possible with some big caveats*. And then the
decision was made to fork Blender.
The Bforartists project itself started officially at July the 2nd 2015. That's when the first real steps were done.

History:
2.6.2015 - Decision day. The first pages for the UI proposal were written. The work at the homepage started.
Which was the official start of the whole project.
2.7.2015 - The domain bforartists was registered.
13.8.2015 - The Bforartists page was finished and went live.
22.8.2015 - Github account was created and went live.
21.9.2015 - The first Bforartists version 0.1 was released. It was based at Blender 2.75. And containted not this
much more than the changed branding.
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14.10.2015 - Version 0.2 brought the changes for Blender 2.76. And that was the moment when Bforartists
started to walk alone.
19.12.2015 - Version 0.2.1 introduced a new keymap and a new navigation scheme. And already quite a few
changes at the UI layout. Blender has a ton of missing UI entries and a ton of double and even triple menu
entries. It also brought in the Blender 2.76 a and b patches to Bforartists
27.01.2016 - Bforartists 0.2.2 was mainly around a plugin to display the most needed hotkeys up left.
18.03.2016 - Bforartists 0.3.0 introduced the first incarnation of icon buttons in the tool shelf.
26.03.2016 - Bforartists 0.3.1 came with some small fixes that were overlooked for version 0.3.0. The splash
screen was changed because of ongoing trolling.
02.08.2016 - Bforartists 0.4.0 was a small refinement release that was the final stroke below the try to
implement Qt and new editor types. Which did simply not work.
04.09.2016 - Bforartists 0.4.1 brought mainly changes to the tooltips. Nearly every tooltip contains the tool
name now too.
16.09.2016 - 0.4.2 is another small release mainly around catching some more tooltips and small quirks. New
is the Materials Library FX addon, which is also natively included into Blender 2.78 now.
24.09.2016 - 0.5.0 is a milestone release. It marks the end of the first big development cycle. The tracker is
empty for the first time since development start.
02.11.2016 - 0.6.0 brings fixes to the addons, first subtabs in the panels, and the Mini lightlib addon.
01.12.2016 - 0.7.0 was mainly cleanup work in the Properties editor.
08.01.2017 - Version 0.8.0 brings the new Toolbar editor.
27.02.2017 - Version 0.9.0 is the merge of the actual Blender version 2.78 C into Bforartists.
13.03.2017 - Version 0.9.1 is a bug fix release that fixes some show stoppers from version 0.9.0.
10.4.2017 - Version 0.9.2 is around cleaning up the menus and connecting some loose ends. And it introduces a
Mac build.
13.9.2017 - Version 0.9.3 is the merge of Blender 2.79 into Bforartists. Plus a few smaller adjustments and
fixes.
14.9.2017 - An emergency release because of a showstopper bug. The bake panels were missing.
02.03.2018 - Version 0.9.6 brings the changes from Blender 2.79a, and adds 260 changes from Bforartists side.
19.04.2018 - Version 0.9.7 brings the full keymap, the changes from Blender 2.79b, and lots of small
improvements and fixes. More compact brush panels for example.
04.05.2018 - Version 1.0.0 RC1 marks the end of this development cycle. All initial development goals that
could be fulfilled are fulfilled.
11.05.2018 - Version 1.0.0 is live.
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Blender’s History
In 1988 Ton Roosendaal co-founded the Dutch animation studio NeoGeo. NeoGeo quickly became the largest
3D animation studio in the Netherlands and one of the leading animation houses in Europe. NeoGeo created
award-winning productions (European Corporate Video Awards 1993 and 1995) for large corporate clients such
as multi-national electronics company Philips. Within NeoGeo Ton was responsible for both art direction and
internal software development. After careful deliberation Ton decided that the current in-house 3D toolset for
NeoGeo was too old and cumbersome to maintain, and needed to be rewritten from scratch. In 1995 this rewrite
began and was destined to become the 3D software creation we all know as Blender. As NeoGeo continued to
refine and improve Blender it became apparent to Ton that Blender could be used as a tool for other artists
outside of NeoGeo.
In 1998, Ton decided to found a new company called Not a Number (NaN) as a spin-off of NeoGeo to further
market and develop Blender. At the core of NaN was a desire to create and distribute a compact, cross platform
3D application for free. At the time this was a revolutionary concept as most commercial 3D applications cost
thousands of dollars. NaN hoped to bring professional level 3D modeling and animation tools within the reach
of the general computing public. NaN’s business model involved providing commercial products and services
around Blender. In 1999 NaN attended its first SIGGRAPH conference in an effort to more widely promote
Blender. Blender’s first SIGGRAPH convention was a huge success and gathered a tremendous amount of
interest from both the press and attendees. Blender was a hit and its huge potential confirmed!
Following the success of the SIGGRAPH conference in early 2000, NaN secured financing of €4.5M from
venture capitalists. This large inflow of cash enabled NaN to rapidly expand its operations. Soon NaN boasted
as many as fifty employees working around the world trying to improve and promote Blender. In the summer of
2000, Blender 2.0 was released. This version of Blender added the integration of a game engine to the 3D
application. By the end of 2000, the number of users registered on the NaN website surpassed 250,000.
Unfortunately, NaN’s ambitions and opportunities didn’t match the company’s capabilities and the market
realities of the time. This over-extension resulted in restarting NaN with new investor funding and a smaller
company in April 2001. Six months later NaN’s first commercial software product, Blender Publisher was
launched. This product was targeted at the emerging market of interactive web-based 3D media. Due to
disappointing sales and the ongoing difficult economic climate, the new investors decided to shut down all NaN
operations. The shutdown also included discontinuing the development of Blender. Although there were clearly
shortcomings in the then current version of Blender, such as a complex internal software architecture,
unfinished features and a non-standard way of providing the GUI, the enthusiastic support from the user
community and customers who had purchased Blender Publisher in the past meant that Ton couldn’t justify
leaving Blender to fade into insignificance. Since restarting a company with a sufficiently large team of
developers wasn’t feasible, Ton Roosendaal founded the non-profit organization Blender Foundation in March
2002.
The Blender Foundation’s primary goal was to find a way to continue developing and promoting Blender as a
community-based open source project. In July 2002, Ton managed to get the NaN investors to agree to a unique
Blender Foundation plan to attempt to release Blender as open source. The “Free Blender” campaign sought to
raise €100,000 so that the Foundation could buy the rights to the Blender source code and intellectual property
rights from the NaN investors and subsequently release Blender to the open source community. With an
enthusiastic group of volunteers, among them several ex-NaN employees, a fund raising campaign was
3
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launched to “Free Blender”. To everyone’s surprise and delight the campaign reached the €100,000 goal in only
seven short weeks. On Sunday October 13, 2002, Blender was released to the world under the terms of the
GNU GPL. Blender development continues to this day driven by a team of dedicated volunteers from around
the world led by Blender’s original creator, Ton Roosendaal.

Video: From Blender 1.60 to 2.50
https://vimeo.com/8567074

Version/Revision Milestones
The start!
•
•
•
•
•
•
•
•
•
•
•
•
•
•

1.00 - January 1994: Blender in development at animation studio NeoGeo.
1.23 - January 1998: SGI version published on the web, IrisGL.
1.30 - April 1998: Linux and FreeBSD version, port to OpenGL and X11.
1.3x - June 1998: NaN founded.
1.4x - September 1998: Sun and Linux Alpha version released.
1.50 - November 1998: First Manual published.
1.60 - April 1999: C-key (new features behind a lock, $95), MS-Windows version released.
1.6x - June 1999: BeOS and PPC version released.
1.80 - June 2000: End of C-key, Blender full freeware again.
2.00 - August 2000: Interactive 3D and real-time engine.
2.10 - December 2000: New engine, physics, and Python.
2.20 - August 2001: Character animation system.
2.21 - October 2001: Blender Publisher launch.
2.2x - December 2001: Mac OSX version.

Blender goes Open Source
•
•
•
•
•
•
•
•
•
•
•

13 October 2002: Blender goes Open Source, 1st Blender Conference.
2.25 - October 2002: Blender Publisher becomes freely available.
Tuhopuu1 - Oct 2002: The experimental tree of Blender is created, a coder’s playground.
2.26 - February 2003: The first true open source Blender release.
2.27 - May 2003: The second open source Blender release.
2.28x - July 2003: First of the 2.28x series.
2.30 - October 2003: Preview release of the 2.3x UI makeover presented at the 2nd Blender Conference.
2.31 - December 2003: Upgrade to stable 2.3x UI project.
2.32 - January 2004: Major overhaul of internal rendering capabilities.
2.33 - April 2004: Game Engine returns, ambient occlusion, new procedural textures.
2.34 - August 2004: Particle interactions, LSCM UV mapping, functional YafRay integration, weighted
creases in subdivision surfaces, ramp shaders, full OSA, and many many more.
• 2.35 - November 2004: Another version full of improvements: object hooks, curve deforms and curve
tapers, particle duplicators and much more.
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• 2.36 - December 2004: A stabilization version, much work behind the scene, normal and displacement
mapping improvements.
• 2.37 - June 2005: Transformation tools and widgets, softbodies, force fields, deflections, incremental
subdivision surfaces, transparent shadows, and multi-threaded rendering.
• 2.40 - December 2005: Full rework of armature system, shape keys, fur with particles, fluids and rigid
bodies.
• 2.41 - January 2006: Lots of fixes, and some game engine features.
• 2.42 - July 2006: The nodes release, array modifier, vector blur, new physics engine, rendering, lip sync,
and many other features. This was the release following Project Orange.
• 2.43 - February 2007: Multi-resolution meshes, multi-layer UV textures, multi-layer images and multipass rendering and baking, sculpting, retopology, multiple additional matte, distort and filter nodes,
modeling and animation improvements, better painting with multiple brushes, fluid particles, proxy
objects, sequencer rewrite, and post-production UV texturing.
• 2.44 - May 2007: The big news, in addition to two new modifiers and re-awakening the 64-bit OS
support, was the addition of subsurface scattering, which simulates light scattering beneath the surface
of organic and soft objects.
• 2.45 - September 2007: Serious bug fixes, with some performance issues addressed.
• 2.46 - May 2008: The Peach release was the result of a huge effort of over 70 developers providing
enhancements to provide hair and fur, a new particle system, enhanced image browsing, cloth, a
seamless and non-intrusive physics cache, rendering improvements in reflections, AO, and render
baking, a mesh deform modifier for muscles and such, better animation support via armature tools and
drawing, skinning, constraints and a colorful Action Editor, and much more. It was the release following
Project Peach.
• 2.47 - August 2008: Bugfix release.
• 2.48 - October 2008: The Apricot release, cool GLSL shaders, lights and GE improvements, snap, sky
simulator, shrinkwrap modifier, and Python editing improvements. This was the release following
Project Apricot.
• 2.49 - June 2009: Node-based textures, armature sketching (called Etch-a-Ton), boolean mesh operation
improvements, JPEG2000 support, projection painting for direct transfer of images to models, and a
significant Python script catalogue. GE enhancements included video textures, where you can play
movies in-game, upgrades to the Bullet physics engine, dome (fish-eye) rendering, and more API GE
calls made available.

Blender 2.5x - The Recode!
• 2.5x - From 2009 to August 2011: This series released four pre-version (from Alpha 0 in November
2009 to Beta in July 2010) and three stable versions (from 2.57 - April 2011 - to 2.59 - August 2011). It
is one of the most important development projects, with a total refactor of the software with new
functions, redesign of the internal window manager and event/tool/data handling system, and new
Python API. The final version of this project was Blender 2.59 in August 2011.

Blender 2.6x to 2.7x - Improvements & Stabalizing
• 2.60 - October 2011: Internationalization of the UI, improvements in animation system and the GE,
vertex weight groups modifiers, 3D audio and video, bug fixes, and the UI internationalization.
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• 2.61 - December 2011: The Cycles renderer was added in trunk, the camera tracker was added, dynamic
paint for modifying textures with mesh contact/approximation, the Ocean Sim modifier to simulate
ocean and foam, new add-ons, bug fixes, and more extensions added for the Python API.
• 2.62 - February 2012: The Carve library was added to improve boolean operations, support for object
tracking was added, the Remesh modifier was added, many improvements in the GE, matrices and
vectors in the Python API were improved, new add-ons, and many bug fixes.
• 2.63 - April 2012: Bmesh was merged to trunk with full support for n-sided polygons, sculpt hiding, a
panoramic camera for Cycles, mirror ball environment textures and float precision textures, render layer
mask layers, ambient occlusion and viewport display of background images and render layers, new
import and export add-ons were added, and 150 bug fixes.
• 2.64 - October 2012: Mask editor, improved motion tracker, OpenColorIO, Cycles improvements,
sequencer improvements, better mesh tools (Inset and Bevel were improved), new keying nodes, sculpt
masking, Collada improvements, new skin modifier, new compositing nodes backend, and many bugs
were fixed.
• 2.65 - December 2012: Fire and smoke improvements, anisotropic shader for Cycles, modifier
improvements, bevel tool now includes rounding, new add-ons, and over 200 bug fixes.
• 2.66 - February 2013: Dynamic topology, rigid body simulation, improvements in UI and usability
(including retina display support), Cycles now supports hair, the bevel tool now supports individual
vertex bevelling, new Mesh Cache modifier and the new UV Warp modifier, new SPH particle fluid
solver. More than 250 bug fixes.
• 2.67 - May 2013: Freestyle was added, paint system improvements, subsurface scattering for Cycles,
Ceres library in the motion tracker, new custom python nodes, new mesh modeling tools, better support
for UTF8 text and improvements in text editors, new add-ons for 3D printing, over 260 bug fixes.
• 2.68 - July 2013: New and improved modeling tools, three new Cycles nodes, big improvements in the
motion tracker, Python scripts and drivers are disabled by default when loading files for security
reasons, and over 280 bug fixes.
• 2.69 - October 2013: Even more modeling tools, Cycles improved in many areas, plane tracking is
added to the motion tracker, better support for FBX import/export, and over 270 bugs fixed.
• 2.70 - March 2014: Cycles gets basic volumetric support on the CPU, more improvements to the motion
tracker, two new modeling modifiers, some UI consistency improvements, and more than 560 bug fixes.
• 2.71 - June 2014: Deformation motion blur and fire/smoke support is added to Cycles, UI popups are
now draggable, performance optimizations for sculpting mode, new interpolation types for animation,
many improvements to the GE, and over 400 bug fixes.
• 2.72 - October 2014: Cycles gets volume and SSS support on the GPU, pie menus are added and tooltips
greatly improved, the intersection modeling tool is added, new sun beam node for the compositor,
Freestyle now works with Cycles, texture painting workflow is improved, and more than 220 bug fixes.
• 2.73 - January 2015: Cycles gets improved volumetric support, major upgrade to grease pencil, MSWindows gets Input Method Editors (IMEs) and general improvements to painting, freestyle, sequencer
and add-ons.
• 2.74 - March 2015: Support for custom-normals, viewport compositing and improvements to hair
dynamics.
• 2.75 - July 2015: Integrated stereo/multi-view pipeline, corrective smooth modifier and new dependency
graph (enable as a command line option).
• 2.76 - November 2015: Pixar OpenSubdiv support, Viewport and File Browser performance boost, node
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auto-offset, and a text effect strip for the Sequencer.

About Free Software and the GPL

When one hears about “free software”, the first thing that comes to mind might be “no cost”. While this is
typically true, the term “free software” as used by the Free Software Foundation (originators of the GNU
Project and creators of the GNU General Public License) is intended to mean “free as in freedom” rather than
the “no cost” sense (which is usually referred to as “free as in free beer” or gratis). Free software in this sense is
software which you are free to use, copy, modify, redistribute, with no limit. Contrast this with the licensing of
most commercial software packages, where you are allowed to load the software on a single computer, are
allowed to make no copies, and never see the source code. Free software allows incredible freedom to the end
user. Since the source code is universally available, there are also many more chances for bugs to be caught and
fixed.
When a program is licensed under the GNU General Public License (the GPL):
•
•
•
•

You have the right to use the program for any purpose.
You have the right to modify the program, and have access to the source codes.
You have the right to copy and distribute the program.
You have the right to improve the program, and release your own versions.

In return for these rights, you have some responsibilities if you distribute a GPL’d program, responsibilities that
are designed to protect your freedoms and the freedoms of others:
• You must provide a copy of the GPL with the program, so that recipients are aware of their rights under
the license.
• You must include the source code or make the source code freely available.
• If you modify the code and distribute the modified version, you must license your modifications
available under the GPL (or a compatible license).
• You may not restrict the licensing of the program beyond the terms of the GPL. (you may not turn a
GPL’d program into a proprietary product.)
For more on the GPL, check the its page on the GNU Project web site.
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Note
The GPL only applies to the Bforartists application and not the artwork you create with it; for more info see the
Bforartists or Blender License.
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Manual Update History
09.10.2018 - Rewrite of the chapter 3.5 Editors - Movie Clip Editor.pdf
06.08.2018 - Added the new chapter 3.3.1 Editors - UV-Image Editor by tools.pdf- Fixed some
small issues in chapter 3.1.1 - 3D View by tools - Tool Shelf.pdf
28.07.2018 - Added new chapter 3.13.1 Editors - User Preferences by tools
04.07.2018 - Added new chapter 3.11.1 Editors - File browser by tools.pdf
29.06.2018 - Added new chapter 3.6.1 Editors - Text Editor by tools.pdf. Changes in chapter 1
- Installing Bforartists. Path adjustments. And added the chapter 21 Manual Update History.
24.06.2018 - Added new chapter 3.12.1 Python Console by tools.pdf
11.05.2018 - Update to Bforartists 1.0.0 - Just the history pdf changed.
04.05.2018 - Update to Bforartists 1.0.0 RC1
Files modified:
2 Interface
3.1.1 - 3D View by tools - Tool Shelf
3.1.2 - 3D View by tools - Header
3.1.3 - 3D View by tools - Properties Sidebar
3.14 Editors - Toolbar Editor
3.3 Editors - UV-Image Editor
20 Bforartists History
23.04.2018 - Update to Bforartists 0.9.7
Files modified:
2.1 Bforartists Standard Keymap.odt
2.2 Layouts.odt
3.1.1 - 3D View by tools - Tool Shelf.odt
3.1.2 - 3D View by tools - Header.odt
3.1.3 - 3D View by tools - Properties Sidebar.odt
1

Bforartists Reference Manual - © Copyright - This page is under OCL license

3.14 Editors - Toolbar Editor.odt
3.3 Editors - UV-Image Editor.odt
20 Bforartists History.odt
03.03.2018 - Update to Bforartists 0.9.6
Files added:
3.1.2 - 3D View by tools - Header.pdf
Bforartists_096_Manual.pdf
Files removed:
Bforartists_095_Manual.pdf
Files modified:
2.1 Bforartists Standard Keymap.pdf
3.1.1 - 3D View by tools - Tool Shelf.pdf
3.1.3 - 3D View by tools - Properties Sidebar.pdf
3.5 Editors - Movie Clip Editor.pdf
3.6 Editors - Text Editor.pdf
3.9 Editors - Outliner.pdf
3.14 Editors - Toolbar Editor.pdf
20 Bforartists History.pdf
05.12.2017 - Chapter 5.1 Modeling Meshes - Removed the hotkey hint for Inset, and changed
the menu location hint.
11.11.2017 - Added new chapter 3.1.2 - 3D View by tools - Properties Sidebar, fixed small issue
in 3.0 Editors
13.10.2017 - Fixed menu location for normals in chapter 5.1 Modeling - Meshes.pdf
10.10.2017 - Removed hotkey hints for render border in chapter 10.1.1 Render - General. We
don't have hotkeys for it.
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18.09.2017 - added the missing chapter Skin modifier in the pdf 5.7 Modeling - Modifiers.pdf,
updated the Bforartists_094_Manual.pdf download
15.09.2017 - The update to Bforartist 0.9.4 brings quite a few changes. The structure has
changed.
Files added:
10.3.3 Render - Cycles Render Engine - Lamps.pdf
10.3.7 Render - Cycles Render Engine - Render Features.pdf
10.3.8 Render - Cycles Render Engine - Cycles Settings.pdf
10.3.9 Render - Cycles Render Engine - GPU Rendering.pdf
10.3.10 Render - Cycles Render Engine - Render Baking.pdf
10.3.11 Render - Cycles Render Engine - Optimizing Rendering.pdf
10.4 Render - Render Output.pdf
10.5 Render - Post Processing.pdf
10.6 Render - Freestyle.pdf
10.7 Render - Workflows.pdf
10.8 Render - OpenGL Render.pdf
10.9 Render - Audio Rendering.pdf
13.1 Advanced - Command Line.pdf
13.2 Advanced - Scripting & Extending Bforartists.pdf
13.3 Advanced - Application Templates.pdf
13.4 Advanced - Working Limits.pdf
Files deleted:
10.3.2 Render - Cycles Render Engine - Render Settings.pdf
10.3.6 Render - Cycles Render Engine - Lamp.pdf
10.3.7 Render - Cycles Render Engine - Camera.pdf
10.3.9 Render - Cycles Render Engine - Features.pdf
10.3.10 Render - Cycles Render Engine - GPU Rendering.pdf
10.3.11 Render - Cycles Render Engine - Open Shading Language OSL.pdf
10.4 Render - Freestyle.pdf
10.5 Render - OpenGL Render.pdf
13 Scripting & Extending Bforartists.pdf
14 Command Line Arguments.pdf
Files modified:
2 Interface.pdf
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2.1 Bforartists Standard Keymap.pdf
2.2 Layouts.pdf
3.1.1 - 3D View by tools - Tool Shelf.pdf
3.14 Editors - Toolbar Editor.pdf
10.3.2 Render - Cycles Render Engine - Materials.pdf
10.3.4 Render - Cycles Render Engine - World.pdf
10.3.5 Render - Cycles Render Engine - Nodes.pdf
10.3.6 Render - Cycles Render Engine - Camera.pdf
10.3.11 Render - Cycles Render Engine - Optimizing Rendering.pdf
13.2 Advanced - Scripting & Extending Bforartists.pdf
18 pipeline.pdf
20 Bforartists history
20.7.2017 - Fixed the chapter 2.2 Layouts. It contained images with the old blue layout
30.06.2017. Modified the chapter 3.1.1 - 3D View by tools - Tool Shelf.pdf. Deleted the chapter
10.3.12 Render - Cycles Render Engine - Render Baking.pdf as obsolete. This informations are
now in the chapter 3.1.1 - 3D View by tools - Tool Shelf
11.06.2017. Modified the chapter 3.1.1 - 3D View by tools - Tool Shelf.pdf
03.05.2017. Added the new chapter 3.1.1 - 3D View by tools - Tool Shelf.pdf
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